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	Object: eSale Order line (esale_joomla.order.line)
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	OScommerce Interface / ZenCart (esale_osc)
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	Object: esale_oscom Tax (esale.oscom.tax)

	Object: esale_oscom Status (esale.oscom.status)

	Object: esale_oscom Category (esale.oscom.category)

	Object: esale_oscom PayType (esale.oscom.paytype)

	Object: esale_oscom Language (esale.oscom.lang)

	Object: esale_oscom Product (esale.oscom.product)

	Object: Product Manufacturer that produces the product (product.manufacturer)
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	Event Certificate (event_certificate)
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	Fleet Management System (fleet_manager)
	Description

	Download links

	Dependencies
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	Scenario of games (game_scenario)
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	Download links

	Dependencies
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	Object: game.scenario (game.scenario)

	Object: game.scenario.step (game.scenario.step)









	generalize account report module (generalize_account_report)
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	Download links

	Dependencies
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	Object: Generalize Account Report (generalize.account.report)

	Object: Group Configuration (group.detail.configuration)









	Module for Import from file (gnucash)
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	Download links

	Dependencies
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	Object: gnucash.index (gnucash.index)









	Google Blogger (google_blogger)
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	Dependencies
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	Google calendar (google_calendar)
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	Dependencies
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	Google Earth/Map Module (google_earth)
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	Download links

	Dependencies
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	Google Map (google_map)
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	Dependencies
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	Google translation (google_translate)
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	Dependencies
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	Dependencies
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	Object: Semestre (health.semestre)

	Object: religion (health.religion)

	Object: situation (health.situation)

	Object: Room Rate (health.room.tarif)

	Object: Localisation (health.room.localisation)

	Object: Chambres (health.room)

	Object: Rate Dependence (health.tarif.dependance)

	Object: Drug Form (health.drugform)

	Object: Drug Family (health.drugfamilly)

	Object: Profils Pathos (health.pathosprofils)

	Object: Category States Pathologique Pathos (health.pathoscategetats)

	Object: States Patholohgique Pathos (health.pathosetatspatho)

	Object: Facturation (health.facturation)

	Object: Aggir (health.aggir)

	Object: Drugs (health.drug)

	Object: category (health.category)

	Object: soins (health.care)

	Object: Type Evenement (health.evenement.type)

	Object: evenement (health.patient.evenement)

	Object: prescription (health.prescription)

	Object: Tarif Absences (health.tarif.absences)

	Object: Regime (health.regime)

	Object: Output Type (health.exit)
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	Object: Resident (health.patient)
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	Hotel Housekeeping Management (hotel_housekeeping)
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	Hotel Restaurant Management (hotel_restaurant)
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	Object: Hotel Menucard (hotel.menucard)

	Object: Includes Hotel Restaurant Table (hotel.restaurant.tables)

	Object: Includes Hotel Restaurant Reservation (hotel.restaurant.reservation)

	Object: Includes Hotel Restaurant Order (hotel.restaurant.kitchen.order.tickets)

	Object: Includes Hotel Restaurant Order (hotel.restaurant.order)

	Object: Reservation Order (hotel.reservation.order)

	Object: Includes Hotel Restaurant Order (hotel.restaurant.order.list)









	Hotel Management (hotel)
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	Dependencies
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	Object: Floor (hotel.floor)

	Object: Room Type (hotel.room_type)

	Object: amenities Type (hotel.room_amenities_type)

	Object: Room amenities (hotel.room_amenities)

	Object: Hotel Room (hotel.room)

	Object: hotel folio new (hotel.folio)

	Object: hotel folio1 room line (hotel_folio.line)

	Object: hotel Service line (hotel_service.line)

	Object: Service Type (hotel.service_type)

	Object: Hotel Services and its charges (hotel.services)
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	Dependencies
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	Human Resources/Change password (hr_change_password)
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	Human Resources Contracts - Human resources Reservations Management (hr_contract_available)
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	Dependencies
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	Download links

	Dependencies
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	Object: Wage Period (hr.contract.wage.type.period)

	Object: Wage Type (hr.contract.wage.type)

	Object: Contract (hr.contract)









	Human Resources Timesheets on contracts (hr_contract_timesheet)
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	Download links

	Dependencies
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	Human Resources Evaluation (hr_evaluation)
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	Download links

	Dependencies
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	Object: Employee Evaluation (hr_evaluation.evaluation)

	Object: Employee Evaluation Type (hr_evaluation.type)

	Object: Evaluation Type Value (hr_evaluation.type.value)

	Object: Employee Evaluation Quote (hr_evaluation.quote)









	Human Resources Expenses Tracking (hr_expense)
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	Download links

	Dependencies

	Reports

	Menus

	Views

	Objects
	Object: Expense (hr.expense.expense)

	Object: Expense Line (hr.expense.line)









	HR Expenses Supplier (hr_expenses_supplier)
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	Download links

	Dependencies
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	Human Resources: Holidays management (hr_holidays_cci)
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	Download links

	Dependencies
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	Hr holidays evaluation (hr_holidays_evaluation)
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	Download links

	Dependencies
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	Object: Holidays note (hr.holidays.note)

	Object: wizard.hr.holidays.evaluation (wizard.hr.holidays.evaluation)









	HR Holiday Request (hr_holidays_request)
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	Download links

	Dependencies
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	Object: Holidays history (hr.holidays.history)

	Object: Holidays history (days.holidays.days)

	Object: Public Holidays (public.holidays.days)

	Object: Holidays history (days.holidays.days.history)
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	Download links

	Dependencies
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	Object: Holidays Status (hr.holidays.status)

	Object: Holidays Per User (hr.holidays.per.user)

	Object: Holidays (hr.holidays)

	Object: hr.holidays.log (hr.holidays.log)









	Human Resources (Interview Evaluation) (hr_interview)
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	Download links

	Dependencies
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	Menus
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	Object: Category Of Candidate (candidate.category)

	Object: Question Category (Question Belongs to Which Category) (category.question)

	Object: Candidate Experience (candidate.experience)

	Object: Interview Evaluation (hr.interview)

	Object: Technical Skill Of Candidate (technical.skill)

	Object: HR interview log (hr.interview.log)









	Human Resources Medical Exam (hr_medical)
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	Download links

	Dependencies
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	Performance Review (hr_performance)
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	Download links

	Dependencies
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	Object: Performance Review Points (hr.performance.line)

	Object: Review Attributes (hr.performance.line.attribute)
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	Human Resources (hr)
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	Object: Working Time (hr.timesheet.group)

	Object: Employee Category (hr.employee.category)

	Object: Employee (hr.employee)

	Object: Timesheet Line (hr.timesheet)

	Object: hr.department (hr.department)









	Skill Management (hr_skill)
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	Download links

	Dependencies
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	Object: hr_skill.weight.category (hr_skill.weight.category)

	Object: hr_skill.weight (hr_skill.weight)

	Object: hr_skill.skill (hr_skill.skill)

	Object: hr_skill.experience.category (hr_skill.experience.category)

	Object: hr_skill.experience (hr_skill.experience)

	Object: hr_skill.evaluation.category (hr_skill.evaluation.category)

	Object: hr_skill.evaluation (hr_skill.evaluation)

	Object: hr_skill.profile (hr_skill.profile)

	Object: hr_skill.position (hr_skill.position)

	Object: hr_skill.position.profile (hr_skill.position.profile)

	Object: hr_skill.experience.skill (hr_skill.experience.skill)

	Object: hr_skill.profile.skill (hr_skill.profile.skill)

	Object: hr_skill.evaluation.experience (hr_skill.evaluation.experience)

	Object: hr_skill.evaluation.skill (hr_skill.evaluation.skill)

	Object: Languages (hr.lang)

	Object: Languages (emp.lang)

	Object: Pay Scales (hr.scale)

	Object: employee.status (employee.status)









	Complete timesheet from an iCal server (hr_timesheet_ical)
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	Download links
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	Invoice on analytic lines (hr_timesheet_invoice)
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	Download links

	Dependencies
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	Human Resources (Timesheet encoding from project tasks) (hr_timesheet_project)
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	Download links
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	Human Resources (Timesheet encoding) (hr_timesheet)
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	Download links

	Dependencies

	Reports

	Menus

	Views

	Objects
	Object: Timesheet line (hr.analytic.timesheet)









	Timesheets (hr_timesheet_sheet)
	Description

	Download links
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	Download links
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	Dependencies
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	Poland - Chart of Accounts (l10n_chart_pl)
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	Download links
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	Venezuela -Chart of Account (l10n_chart_ve)
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	Download links
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	Download links
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	Pilot Human Resource Management (md_hr_contract)
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	Object: HR Contract Availability (md.hr.contract.availability)
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前言

近些年来，信息系统在提高企业竞争力中日益发挥着显著的作用。
它们经常被用到指导和推进企业的日常活动，而不仅是用来处理重复性的任务。
现今，综合管理软件往往是重要的竞争优势的关键来源。

创建一个基于部门的、具有清晰结构的组织，需要有一套系统化的响应流程，
而且必须具有响应性（译者注：指提供服务的自发性）、可靠性和快速增长的预期。
提高效率需要包括销售部，财务部，后勤部等所有部门对你的问题有普遍一致的认识。

关于这一点，你需要有一个普遍的沟通语言用来共享资讯，策略和通讯。
ERP（企业资源规划）系统是提供这种沟通语言的理想平台。


企业管理之开源软件

风险与整合的成本是企业从ERP系统中获利的重要的障碍。这就是现在的中小型企业很少使用ERP的原因。
另外，像SAP、微软和Oracle这样的大型ERP软件供应商仍然不能解决ERP软件强大的处理能力与用户对ERP系统的简单性和
灵活性的普遍需求。但这却正是中小型企业所需要的。

开源软件的开发过程与开发人员所采用的新的商业模式为解决这类企业软件的成本与质量问题提供了一种新的思路。

要让一个ERP系统在中小企业里完全有效的运行，降低成本是第一要务。开源软件利用强大的可重用软件库
使大幅度降低开发成本成为可能；它减少了批发商的中间环节同时也相应降低了他们高昂的销售费用所引发的成本；而且
软件的免费发布也减少了高昂的销售和市场费用。

因为有成千上万的贡献者与合作伙伴在同一个项目上通力合作，所以软件的质量极大地得益于彼此之间的审查。
你不可能同时做所有的事情：会计，软件开发，销售，ISO9001质量管理，农产品专家，药品专家，这些只是其中的一部分
而已。

面对这些广泛的需求，还有什么能比建立起一个全球范围内的合作伙伴和贡献者网络更好的方式呢？
每个人都根据他或她的专业能力，提供自己的才能。
通过本书，你会了解到当这些工作被良好的组织到一起时，结果将超出任何合理的预期。

但是开发中真正的挑战是确保该方法的简单、灵活和完整。
要达到这种层次的质量要求你需要一个领导者和协调者，他可以组织所有这些活动。
所以TinyERP的开发团队，现在叫OpenERP，主要负责组织，同步和软件的一致性。

OpenERP在所有这些方面都表现得非常出色！




OpenERP 解决方案

由于OpenERP采用模块化，并且协同开发已完全集成在里面，所以任何公司都可以从它庞大的功能列表中找到适合自己的功能。
对于大多数开源软件来说，可访问性，灵活性和易用性是重要的关键词。经验表明没有必要在系统上培训用户数个月，
因为他们可以直接下载并使用它。

所以你将找到适合各种需求的模块，可供选择的模块有上百种，你可以通过简单的分组和配置找到最适合的模块，利用它们
为你的公司建立起量身定制的系统。

这些模块的范围从能和勒克莱尔商店对接的农产品的EDI接口模块，
到可以照顾你的员工的饮食偏好的订购三明治通用演示自动化模块。

结果非常优秀。OpenERP（原本称作Tiny ERP）是一个管理软件，在全世界范围内它比其它的同类软件获得更多的下载次数，
每天超过600次。现在它支持18种语言并且有一个世界范围的合作伙伴和贡献者网络。超过800名开发者共同参与并开发了这
个项目。

据我们所知，OpenERP是唯一的一个不是仅仅被大公司使用的管理系统，它还被很多小公司和独立公司所采用。
这个不同是一个很好的例证，说明了OpenERP的灵活性：在人们广泛希望的功能性与易用性之间优雅的进行协调。

这种多样性还发生在不同的部门和行业中，他们都使用OpenERP，包括农产品，纺织品，公开拍卖，IT，和行业协会。

最后我们希望说明的是，本软件诞生于高质量的代码，良好的体系结构和免费的技术。事实上，你可能惊讶的（如果你从事IT
行业）发现OpenERP的下载包只有差不多6MB. 在安装时展开后，它的大小会改变，这主要是由于官方的翻译也被打包在里面，
而不是因为代码的原因。但是我们希望表达的远不止于此。自从那些地处偏远的工厂的所有者预期可以从ERP受益开始至今，我
们已经走过了如此长的一段路。


本书的意义？

很多书告诉读者该如何管理企业，同样也有很多书致力于指导读者如何使用一款特定的软件。我们并不想像他们那样，因为
我们的方向是不同的。

我们已经帮助很多企业进行了改建和重组，我们希望我们的管理经验可以在理论和实践上都给读者带来改进。我们并不是要写一本OpenERP
的手册，而是通过这种IT工具来介绍一种先进的管理技术。你会看到什么样的管理实践是有效的，具备可能性的，还有如何用OpenERP来实现他们。

这也是我们OpenERP所希望做到的: 不仅限于软件本身而是为您提供一个可以提升管理的工具。




谁是本书的读者？

本书由两个非常成功的CEO撰写，他们的成功得益于新技术的运用。这本书的目标读者是希望改进整个公司管理团队的主管和经理们。
他们可能已经有重要的责任，并且在公司里有重要的影响力。

从功能需求上来看，多数读者可能来自中小型企业（100多人）和独立的公司（independent companies）。但是它也适用于较大的公司。






本书结构

第一章，OpenERP 第一步 安装：从OpenERP的安装开始。如果你已经安装了OpenERP，你可以直接从 OpenERP 漫游指南 节开始。如果你已经非常熟悉OpenERP或者
Tiny ERP，你可以从 如何应用到你的业务中? 节找到如何快速的在一个空数据库中创建一个新的工作流。或者你可以直接略过 ch-crm 从 part2-crm 开始了解
OpenERP中具体的功能模块。

第二章，part2-crm CRM：供应商和客户关系管理（SRM & CRM），你可以在这里找到管理一个高效的销售部门所需要的要素， 自动化处理可以监视任务的执行情况。

第三章，管理你的账簿 一般会计：讲解一般会计和一般会计在企业管理中的主要规则。

第四章，有效的运营管理：处理企业管理中所有的营运职能：通过在analytic(or cost) accounts基础上进行财务上的分析，
以进行项目中的人力资源管理，你可以看到使用了OpenERP后，它是如何帮助你的公司保持领先地位的。

第五章，管理仓库和搞定制造：描述了库存和生产过程中物料的移动过程，包括物料和作为服务的人力等转变为产品的过程。

第六章，基本的业务流程：处理商品和服务的购买与销售。

第七章，流程与文档管理： 本章专注于OpenERP所管理的过程描述和文档、知识管理。

第八章，系统管理与实施: 本章包含两节，首先解释如何管理和配置OpenERP，接下来提供一套在您的企业中实施OpenERP的方法。



Note

关于作者

Fabien Pinckaers

Fabien Pinckaers 18岁开始创业。10年后的今天，他已经创立并管理着几个高科技公司，
都是关于免费/开源软件的。

他组建了Tiny ERP，现在叫OpenERP。他是包括Tiny sprl在内的两家公司的董事，OpenERP的校订者。
三年来他从一个人发展到65人的Tiny团队。在此过程中，没有任何贷款和外部募捐，并且实现了盈利。

他已经开发了多个大型的项目，例如：Auction-in-Europe.com，它已经是比利时艺术品市场的领导者了。
每天在这上面成交的艺术品甚至超过了ebay.be。

他也是Louvain-la-Neuve上LUG（Linux User Group）和多个免费项目（如：OpenReport, OpenStuff and Tiny Report）的建立者
，土木工程师专业(综合技术), 他在IT方面已经多次获得欧洲的奖项，例如Wired
和 l’Inscene。

作为一个对于在企业中使用免费软件的狂热拥护者，他长期在各种讨论中作为演讲人宣传免费软件，不仅如此，
他写了很多的文章介绍企业如何使用免费软件进行管理。

如果您对他感兴趣，可以访问他的博客http://fptiny.blogspot.com/ 或者twitter账号fpopenerp。

Geoff Gardiner

Geoff曾在国际性的制造类公司担任服务和IT系统总监职位。
他是英国剑桥大学制造研究所高级工业研究院研究员，他专注于过程创新。

他建立了Seath公司（http://www.seathsolutions.com/）来为开源软件的使用提供服务， 特别是OpenERP在企业中的应用.
他是文章和书籍的作者，专注于流程和技术的创新，
Geoff也是OpenERP项目的贡献者。
他持有克兰菲尔德管理学院的MBA证书和剑桥大学圣三一堂的工程和电子科学硕士学位。
他同时是工程及科技学会和作家协会的会员。

经过观察，亲身感受，和领导各种组织的流程实施项目，他有很多关于如何成功地通过采用一个管理自动化工具有效的进行管理的想法与大家分享。

Els Van Vossel

Els Van Vossel始终致力于语言方面的工作，包括口头的和书面的。在她看来清楚、明确的交流是最关键的。

毕业于安特卫普的专业翻译，她的工作是作为一个独立翻译将主流ERP软件本地化。 通过这些工作Els获得了ERP知识，
她决定开始作一名ERP顾问和ERP软件的技术交流者。
因此开源软件的世界变的越来越有吸引力。她开始利用业余时间从事OpenERP方面的工作，Els真的很想
与Fabien Pinckaers见一面，以告诉他她对于有关文档和培训策略的想法。
在合作者大会上，她听到Fabien正在找人来管理培训和文档。

这绝对是一个证明自己的机会，现在Els是OpenERP的培训计划经理,负责全球OpenERP的培训和认证计划。

做个多个软件手册的作者，要从事于OpenERP文档的工作和不断的把它带到一个更高的水平是非常有挑战的。请注意，这是一个苦差事，但Els认为做的很高兴！

如果您对她感兴趣，可以访问她的博客http://training-openerp.blogspot.com/ 或者twitter账号elsvanvossel









献辞


Geoff Gardiner


我还要感谢我的合著者，Fabien Pinckaers，为了他在发展Tiny ERP和OpenERP方面的远见和坚韧，同时感谢OpenERP团队出色的工作。

OpenERP依靠的是开源哲学和技术，这些技术已经由大批的天才开发出来并且多年来不断完善。非常感谢他们的努力。

也感谢家人对我的鼓励，包容和一直以来对我的支持。


Els Van Vossel


Fabien，感谢你给我一个与OpenERP共事的机会。感谢我的文档团队帮助我拿到第一份OpenERP 6.0的文档。
在不久的将来，我会致力于重新组织这些文档，使其成为一个真正可以用于实际业务的版本。在这里我预先感谢OpenERP团队的支持。


Fabien Pinckaers


我要对OpenERP团队的全体成员表达我的感谢。感谢他们在准备，翻译和各种形式的校对工作中辛勤的付出。
我要特别感谢Laurence Henrion和我的家人，感谢他们自始至终对我的支持。
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OpenERP 第一步


OpenERP是一个非常棒的应用系统，它容易上手操作而且可以很好地帮助你管理公司。
相比其他企业级的应用软件，它可以很简单地安装在Windows和Linux操作系统上，并提供很多实用的功能。



本书第一章的目的是帮助你开始在练习中了解OpenERP。



第一节, 安装与初始配置 , OpenERP的详细安装配置指导.
如果你不是系统管理员，或者你已经安装好OpenERP，或者你打算选择在线SaaS服务商，那么你可以跳过这章，阅读下一节  OpenERP 漫游指南 。
我们会一步一步地带领你浏览使用demo数据。

如果你曾经使用过OpenERP（或者Tiny ERP），那么你可以直接阅读第三节。
在 如何应用到你的业务中? ，你可以尝试根据实际案例创建一个新的帐套，并模拟运行一个从采购到销售的完整业务流程。


[image: ../../_images/sect1_outline.png]
如何选择阅读本书第一章的内容








	在线订购 & 开始

	安装与初始配置

	OpenERP 漫游指南

	如何应用到你的业务中?
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在线订购 & 开始

无论是测试OpenERP或是布署到生产环境，你至少有两个途径：


	您可以使用OpenERP的在线服务,网址为http://www.openerp.com/online/;

	你可安装到自己的计算机以便使用自己公司的环境来测试。



本章将简要说明简单易用的*OpenERP在线服务*。 有关安装OpenERP在您计算机上的更多信息, 请参阅 part5-crm-install.


Note

OpenERP 相关的一些网站地址:


	官网: http://www.openerp.com,

	OpenERP 在线: http://www.openerp.com/online,

	在线 demo: http://demo.openerp.com,

	文档: http://doc.openerp.com/,

	你可以在社区论坛里得到帮助: http://www.openerp.com/forum/.






Tip

当前文档

安装OpenERP的过程在每个新版本都有所改变和改进,
因此你应当在网站上为最新的安装程序查找相应的发行文档.




OpenERP 在线使用

你想要了解OpenERP,没有比OpenERP在线提供的更容易的了. 你只需要一个浏览器就可以开始了.

在线服务对小公司特别有益, 花费很低的成本就可以快速的使用.
你能立即进入可管理多组织架构的类型的企业的OpenERP完整的管理系统.

OpenERP的在线版本包括以下几种服务：高带宽的主机，数据库管理，稳定的安全更新，备份，7x24小时的维护，错误修复和迁移。

OpenERP保证在线版本同官方的开源版本完全一致。在线版本包含OpenERP的任何改进，这对用户从在线版顺利切换到本地版非常有好处。

所以即使今天OpenERP在线方案可以非常好的满足您的需要，如果以后你的公司变大了或者需求改变了，
你也可以在任何时候很容易的切换到本地安装版本，你也可以在需要时更换服务商而继续使用相同的系统。
因此你不必依靠你的主机。而且，OpenERP以标准和开放的方式运行，所使用的优秀的编程语言允许你导出数据并在任何软件中使用。

这些好处可以让用户完全控制自己的数据，软件和平台。


[image: ../../../_images/start_saas.jpeg]
订购并开始使用在线服务



如果你希望从在线平台开始，你可以访问这个网址 http://www.openerp.com/online。在成功注册后，你就可以配置和使用OpenERP在线版了。
登录进你的OpenERP在线账户后，你会收到你的用户名密码。你可以按照自己的步调来建立适合自己的软件。

OpenERP在线——软件及服务——由OpenERP提供服务，按月订购. 定价模型非常简单。OpenERP按每月每用户收取固定的费用。
根据这段时间你的系统中的注册用户数，你每个月会收到一个发票。如果你在今后的30天内添加了新用户，他们会被算在下次的发票中。
你可以在 http://www.openerp.com/online 找到现行的价格和支付选项的明细。
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安装与初始配置


要熟悉OpenERP,可以自己在Windows或Linux下安装OpenERP，安装过程大概只需要半个小时左右。

第一步是在一台服务器PC（即Windows或Linux或Macintosh电脑）上安装OpenERP和数据库服务器（即PostgreSQL）。





第二步你可以选择使用网页浏览器或在用户的电脑上安装OpenERP客户端软件来访问OpenERP服务器


当你安装完OpenERP后，接下来就要创建一个包含一些演示数据的数据库，以便测试安装是否成功。


Note

Tiny ERP 更名为 OpenERP

早在2008年，Tiny ERP更名为OpenERP，所有使用过Tiny ERP的用户应该同样熟悉OpenERP。两个名字所指的是同一个软件，
因此OpenERP的4.2.X版本和Tiny ERP的4.2.X版本在功能上没有差别。本书适用于OpenERP 6.1.0以及之后的版本，但也会
时常参考到6.1之前的版本。




Note

SaaS或按需提供

SaaS (软件即服务 ) 由托管服务商提供服务，客户按月缴纳服务费的形式使用。包括硬件（服务器），系统维护，提供托管服务和支持。

在你这里你可以获得OpenERP一个月的免费试用 http://www.openerp.com/online，它可以让你在不增加系统费用投入的情况下快速的开始试用。
很多OpenERP的合作伙伴都是用它，其中有一些还提供类似的服务。

这项服务对于小公司特别有用，他们往往希望用尽量少的花费，最快的将系统运行起来。
SaaS让你可以快捷的访问一个集成的管理系统，该系统是以银行和其它大型组织的企业架构建立起来的。
OpenERP就是这样的系统，本书会详细介绍具体功能。



无论你是想测试OpenERP还是想把它投入正式生产，至少需要三starting点：


	无需安装，可通过这里进行测试 http://demo.openerp.com,

	在线评估地址 http://www.openerp.com OpenERP SaaS 测试地址 http://ondemand.openerp.com，
或者在OpenERP合作伙伴处体验这些内容，

	在你自己的电脑上安装测试。



在Windows上安装OpenERP和在Linux上安装略有不同，但是一旦安装上，系统提供的功能都是一样的，所以你不必在意你用的是那种服务器。


Note

Linux, Windows, Mac

虽然这本书只涉及在Windows和Linux系统上安装，但是OpenERP的官方网站上相同的版本也可用于Macintosh。




Note

OpenERP的网站


	主站: http://www.openerp.com,

	SaaS 或 OpenERP在线: http://www.openerp.com/online,

	文档站: http://doc.openerp.com/,

	社区论坛，在那里你可以经常得到其他人的帮助:
http://www.openobject.com/forum.






Tip

当前文档



OpenERP的每个新版本的程序安装都会有所改进，所以你应该经常检查文档 - 包括打包的和发布在网站上的 - 以保证能够正确的安装。

一旦你已经安装完成，就可以创建数据库了，并确认您的OpenERP的进程在运行。您可以按照本书前面的章节来实现。



	OpenERP 架构

	OpenERP的安装
	Windows 独立安装
	从其它计算机访问 OpenERP Server

	解决 Windows 安装中的错误





	Linux (Ubuntu) 安装
	技术过程: 初始化安装和配置

	手动安装 OpenERP Server

	手动安装 OpenERP GTK 客户端

	创建数据库

	检查您的 Linux 安装









	数据库的创建
	创建数据库

	数据库 openerp_ch01

	管理数据库





	为OpenERP添加新功能
	扩展OpenERP
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OpenERP 架构

要使用 OpenERP ，你可以:


	使用浏览器指向 OpenERP 服务器，或是

	使用在电脑上安装的应用程序客户端(GTK)。



两种使用方法提供了类似的使用界面和功能，而且你可以同时用两种方法连上同一台服务器使用。
如果 OpenERP 服务器离使用者有段距离(例如服务器在另一洲)，最好是使用浏览器，因为浏览器对时间延迟的容忍度
比 GTK 客户端要好。网页客户端也比较容易维护，因为通常使用者的电脑上已经安装了浏览器。

相反地如果你是使用本地的服务器(例如在同一栋建筑内)，应用程序的客户端(被称为 GTK 客户端，因为内建 GTK 的技术)会较佳)。这种状况下 GTK 客户端响应速度较快，使用满意度也会较高。


Note

网页客户端和 GTK 客户端

网页客户端和 GTK 客户端，这两种 OpenERP 客户端有一点点功能上的不同。
网页客户端提供较多功能，例如，企业情报 的功能和 甘特图。

OpenERP 公司将会在可见的未来里继续支持这两种客户端，所以这两种客户端，你可以爱用哪种就用哪种。



OpenERP 系统是由2部分组成:


	PostgreSQL 数据库服务器，包含了所有数据库，其中每个数据库都包含了所有数据以及OpenERP系统组态大部分的要素。

	OpenERP 应用程序服务器，包含了所有企业的工作逻辑，服务器同时也确保 OpenERP 在最佳状态运行。这其中也包含了网页服务器。




[image: ../../../_images/terp_arch_1.png]
OpenERP 的架构




Note

PostgreSQL 是一种关系型，也是物件型的数据库管理系统。

这是一种免费，开源，高效能的系统，与其他数据库管理系统比起来毫不逊色，例如
MySQL，FirebirdSQL (都是免费系统)， Sybase， DB2，微软 SQL Server (都是有版权的)。
这个系统在各种作业系统上都可以运行，从 Unix/Linux 到许多不同版本的 Windows，也包含了
Mac OS X， Solaris， SunOS 和 BSD.



这两部分可以安装在同一个服务器上，如果有考虑运作的效能需要，也可以分布在不同的电脑服务器上。
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OpenERP的安装

也许您是来自一个小型公司，想要看看OpenERP能否有效帮助公司成长，或是来自大型机构的IT职员，想要评估OpenERP的综合功能和性能，
您的第一步就是要安装上她或者找到一个已经安装好的实例来进行测试。

下表中简要列出了各种安装方法，之后会做详细描述。


Windows或Linux上各种安装方法对比







	方法
	平均所需时间
	复杂程度
	说明




	OpenERP Demo
	无需安装
	简单
	对于快速评估非常有用，无需安装。


	All-in-one Windows Installer
	约几分钟
	简单
	对于快速评估非常有用，会在一台电脑上安装所有的预先配置好的组件（使用GTK客户端）。


	Independent installation on Windows
	约半小时
	中级难度
	可是你在不同电脑上安装各部分组件。可投入生产环境使用。


	Ubuntu Linux packages
	约几分钟
	简单
	简单而快捷，但Ubuntu包不是一直都是最新的。


	From source, for all Linux systems
	超过1小时
	中级~高级难度
	此方法建议在生产环境中使用，容易保持最新。





每当OpenERP发布新版本时，也会提供完整的Windows自动安装包下载。它包含所有必需的组件包括PostgreSQL数据库服务器、OpenERP应用服务器以及GTK应用客户端。

只需点击几次鼠标，此安装包就能帮你安装好整个系统。初始配置已经在安装过程中设置好，如果你不想改变源代码，
就可以立即投入使用。此方法在一台电脑上安装所有的组件，但你可以通过GTK客户端从其它电脑上，包括PC、Mac和Linux，
进行连接访问。

第一步是下载OpenERP安装文件。在这个阶段你需要确定选择哪个版本——稳定版还是开发板。如果你打算直接把它用在生产
环境中，我们强烈建议你选择稳定版。


Note

稳定版和开发版

OpenERP的发展采取两个平行的轨道，稳定的版本和开发版本。

新功能被集成到开发分支中。这个分支比稳定版更加先进，但是它里面包含了一些未被发现的和没有修复的错误。
几乎每个月都会发布一个新的开发版本，OpenERP建立了一个代码仓库，如果需要你可以下载很老的版本。

稳定分支是为生产环境设计的。基本上每年发布一次新版本，新版本中的功能都是经过长期测试和确认正确的。
但是稳定分支中的错误修复仍然会在第一时间发布，不用等到第二年的发布版本。



通过以下步骤下载OpenERP Windows版：


	打开以下网址 http://openerp.com.

	点击右边的 Downloads 按钮，然后在 Windows Auto-Installer 下选择 All-in-One。

	你会看到Windows安装版的示范样例，当前版本为 openerp-allinone-setup-6.0.0.

	将这个文件保存到你的电脑上 —— 文件可能比较大，因为它里面包含了PostgreSQL数据库系统，所以下载所需的时间可能会比较长。



安装OpenERP和它的数据库，你必须以管理员用户登录到你的电脑。双击安装文件后，一路默认安装即可。

如果你以前曾经尝试安装过OpenERP的all-in-one版本，你必选首先卸载它，因为之前的安装可能会影响到你新的安装。
确认所有的Tiny ERP，OpenERP和PostgreSQL程序都卸载掉，这个过程可能需你要重启电脑。

OpenERP客户端可以保持打开状态，一旦你完成了 all-in-one的安装，就可以连接并使用OpenERP系统了。下一步是安装数据库，
将会在本章的最后部分 创建数据库 中介绍。


Windows 独立安装

系统管理员非常有理由想要单独安装某个组件。比如，你的公司可能不支持自动安装的PostgreSQL或者Python，
或者你可能已经在服务器上安装了PostgreSQL，或者你想将数据库服务器和应用服务器分开安装到不同的硬件设备上。

这种情况下，你可以从相同的地址下载一个 all-in-one 自动安装程序，它里面只包含了OpenERP服务器的内容。你还需要单独
下载安装一个合适版本的PostgreSQL数据库。

你必须在安装OpenERP服务器之前安装PostgreSQL，必须设置好用户和密码，这样OpenERP服务器才能连接它。OpenERP的网络文档给出了详细说明。


从其它计算机访问 OpenERP Server

要让其他电脑连接到OpenERP服务器，你必须安装好服务，以便其他电脑可以发现它，可以再每个电脑上安装一个GTK客户端：

#. 打开OpenERP所在服务器的Windows防火墙，可以在控制面板中找到它，然后设置一条例外，以允许别的电脑访问此服务器上的OpernERP服务。在Windows防火墙
的 Exceptions 页中点击  click Add a program... 然后在列表中选择 OpenERP Server 即可。

#. 安装OpenERP客户端(openerp-client-6.X.exe), 你可以和下载其它OpenERP软件一样下载这个程序，然后在所有需要使用
OpenERP的电脑上安装


Tip

版本匹配
你必须保证客户端的版本与服务器匹配。版本号在下载的文件名中有所体现。虽然不同版本的客户端和服务器可能可以
配合工作，但是这个并不是必然的，如果出现这种情况，请更新客户端版本，使之与服务器匹配。



你需要管理员权限才能在PC上安装客户端。安装过程是自动的，你只需要关注各个安装步骤即可。

在服务器上打开OpenERP的客户端测试安装是否成功，需要注意的是这个时候你仍然以管理员身份在运行。


Note

为什么需要以管理员身份登录?

平时使用OpenERP客户端时无需使用管理员身份，但是在安装过程中如果有任何问题，使用管理员来进行必要的修改比
切换到测试用户或者软件安装用户要容易和方便的多。



在服务器上点击Windows开始菜单，选择GTK客户端后出现客户端的主界面，确定你要连接的服务器（默认情况下它是 localhost ——你自己的电脑）
。如果出现 No database found, you must create one 消息和你已经 成功连接 到OpenERP服务器，说明没有数据库。


[image: ../../../_images/new_login_dlg.png]
GKT客户端连接到OpenERP服务器时的对话框




Note

连接方式

在默认情况下，Linux下的当前版本（写作时）的OpenERP客户端会使用XML-RPC协议连接服务器的8069端口而Windows下的则
使用NET-RPC协议连接8070端口。无论从哪个操作系统你都可以使用任何协议。虽然在使用GTK客户端时你可能没有注意到，但是
使用NET-RPC会快一些。OpenERP可以使用XML-RPC，而不是NET-RPC，作为安全连接。






解决 Windows 安装中的错误

如果你在Windows上安装完OpenERP，它却不能工作，下面的内容对你会有帮助：

#. OpenERP服务器是否工作？以管理员身份登录到服务器，在菜单 Start ‣ Programs ‣ OpenERP Server 中
使用 Stop Service 停止服务，然后 Start Service 重新启动服务。

#.OpenERP安装是否正确？以管理员身份登录到服务器，打开 C:\Program Files\OpenERP AllInOne下的文件openerp-server.conf检查它的内容。这个文件实在安装时产生的，它里面包含了数据库相关的信息。如果你看到比较奇怪的内容，最好重新安装服务而不是尝试去修改。



[image: ../../../_images/terp_server_conf.png]
典型的OpenERP设置文件







	PostgreSQL在运行吗？以管理员用户登录，通过开始菜单 Start ‣ Programs ‣ PostgreSQL 选择 Stop Service。
如果几秒钟后你读到 The PostgreSQL4OpenERP service has stopped 则你可以确定数据库服务器在工作。请重启PostgreSQL。

	数据库可以访问吗？还是在PostgreSQL菜单中，启动pgAdmin III 程序，你可以用这个程序查看数据库。双击 PostgreSQL4OpenERP 连接。你可以看到OpenERP服务器配置文件中记录的密码。如果可以访问数据库，你就可以看到这个空数据库
中的一些信息。如果不能，系统会显示一个错误信息。

	你的客户端程序安装是否正确？如果你的GTK客户端没有启动，最简单的方法就是重新安装它。

	Can remote client computers see the server computer at all? Check this by opening a command prompt
window (enter cmd in the window Start ‣ Run... ) and enter ping
<address of server> there (where <address of server> represents the IP address of the
server). The server should respond with a reply.

	Have you changed any of the server’s parameters? At this point in the installation the port
number of the server must be 8069 using the protocol XML-RPC.

	Is there anything else in the server’s history that can help you identify the problem? Open the file
openerp-server.log in C:\Program Files\OpenERP AllInOne(which you can only do when the server is stopped) and scan through the
history for ideas. If something looks strange there, contributors to the OpenERP forums can often
help identify the reason.








Linux (Ubuntu) 安装

这一部分知道你如何在Ubuntu上安装OpenERP服务器和客户端，Ubuntu是Linux最流行的版本之一。后面的操作均建立在假设你已经在
台式机或笔记本上安装了较新的带有图形界面的Ubuntu桌面版


Note

其它Linux发行版

在其它Linux发行版上安装和在Ubuntu上类似。阅读本部分并理解相关原则，使用在线文档和论坛来了解在其它发行版上安装的相关事项。



要了解在其它发行版上安装的相关信息，访问OpenERP网站http://www.openerp.com的以下文档 Services ‣ Documentation 。
这里有针对不同发行版的具体指导，你最好也检查一下是否有关于Ubuntu版本的最新指导。


技术过程: 初始化安装和配置

升级Ubuntu包与OpenERP和pgadmin的安装:

$ sudo apt-get update

$ sudo apt-get upgrade

$ sudo apt-get install openerp-server openerp-client pgadmin3





安装language-pack-gnome-YOURLANG-base包可以避免GTK客户端里出现翻译的标签。


$ sudo apt-get install language-pack-gnome-es-base


写作本书时PostgreSQL采用的是8.4版。如果你使用不同的版本，可能需要替换命令中的版本号以适合你使用的PosttreSQL版本。Postgres数据库配置:

$ sudo vi /etc/postgresql/8.4/main/pg_hba.conf





替换下面的行:

# “local” is for Unix domain socket connections only
local all all ident





为:

#”local” is for Unix domain socket connections only
local all all md5





重启 Postgres:

$ sudo /etc/init.d/postgresql-8.4 restart

* Restarting PostgreSQL 8.4 database server [ OK ]





下面的两个命令可以避免/etc/init.d/openerp-web 初始化脚本中的问题:

$ sudo mkdir /home/openerp

$ sudo chown openerp.nogroup /home/openerp





建立一个用户账户叫做“openerp”，密码设置为“openerp”,让它有权利创建Postgres数据库:

$ sudo su postgres

$ createuser openerp -P

Enter password for new role: (openerp)

Enter it again:

Shall the new role be a superuser? (y/n) n

Shall the new role be allowed to create databases? (y/n) y

Shall the new role be allowed to create more new roles? (y/n) n





从postgres用户退出:

$ exit

exit





编辑OpenERP配置文件:

$ sudo vi /etc/openerp-server.conf





替换掉下面的两行(我们不必设定特定的数据库，但是需要输入登录postgres的用户和密码):

db_name =

db_user = openerp

db_password = openerp





现在我们可以重启openerp-server:

$ sudo /etc/init.d/openerp-server restart

Restarting openerp-server: openerp-server.





检查log文件:

$ sudo cat /var/log/openerp.log

[2009-06-14 21:06:39,314] INFO:server:version – 6.0.0

[2009-06-14 21:06:39,314] INFO:server:addons_path – /usr/lib/openerp-server/addons

[2009-06-14 21:06:39,314] INFO:server:database hostname – localhost

[2009-06-14 21:06:39,315] INFO:server:database port – 5432

[2009-06-14 21:06:39,315] INFO:server:database user – openerp

[2009-06-14 21:06:39,315] INFO:objects:initialising distributed objects services

[2009-06-14 21:06:39,502] INFO:web-services:starting XML-RPC services, port 8069

[2009-06-14 21:06:39,502] INFO:web-services:starting NET-RPC service, port 8070

[2009-06-14 21:06:39,502] INFO:web-services:the server is running, waiting for connections…





现在OpenERP已经启动并运行，连接到Postgres数据库的5432端口，监听8069和8070端口

$ ps uaxww | grep -i openerp

openerp      5686  0.0  1.2  84688 26584 pts/7    Sl+  12:36   0:03 /usr/bin/python ./openerp-server.py





$ sudo lsof -i :8069

COMMAND  PID USER    FD   TYPE DEVICE SIZE/OFF NODE NAME

python  5686 openerp 3u  IPv4 116555      0t0  TCP *:8069 (LISTEN)





$ sudo lsof -i :8070

COMMAND  PID USER    FD   TYPE DEVICE SIZE/OFF NODE NAME

python  5686 openerp 5u  IPv4 116563      0t0  TCP *:8070 (LISTEN)





点击 Applications ‣ Internet‣ OpenERP Client 菜单中的OpenERP GTK客户端图标，
或者打开一个终端窗口，输入 openerp-client 。OpenERP登录窗口就会打开，并且显示消息 No database found you must create one! 。

虽然这个安装方法很简单,却是一个很有吸引力的选择，它比从http://openerp.com 下载一个OpenERP版本进行安装要好的多。
下载的版本可能无法直接运行在你的Linux发行版上。


Note

包版本

包维护是一个开发，测试和发布的过程，整个过程需要时间。所以OpenERP发布包并不总是包含最新的可用包。
在安装一个包之前首先要从网站上检查它的版本号。如果只有第三级版本号（比如：用6.0.2代替6.0.1）不同你就
可以考虑安装，因为区别可能很小——两个包之间不太可能是功能上的修改，更可能的是修复Bug。






手动安装 OpenERP Server

这一部分你会看到如果从http://openerp.com 下载并安装OpenERP和它所依赖的库和包。安装平台是Ubuntu桌面版。
这里是整个过程的一个总结：


	在浏览器中打开页面 http://openerp.com ，

	点击右侧的 Download 按钮，

	从 Sources 部分下载客户端和服务器文件到你的 home 目录
(或者其它你已经定义的下载目录)。



下载PostgreSQL数据库和其它OpenERP所依赖的包：


	打开 Synaptic包管理器，按照提示输入root用户密码。

	Check that the repositories main , universe and restricted  are enabled.

	Search for a recent version of PostgreSQL (such as postgresql-8.4  then select it for
installation along with its dependencies.

	Select all of OpenERP’s dependencies, an up-to-date list of which should be
found in the installation documents on OpenERP’s website,
then click Apply to install them.




Note

Python 编程语言

Python是用来开发OpenERP的编程语言。它是一种动态的，无类型的面相对象的语言，优点是可以在很短的时间内被掌握。
不仅NASA的大量使用Python，Google和其它很多公司的代码也是用它写的。

要了解Python的更多信息，请访问 http://www.python.org。



一旦所有这些依赖和数据库安装完毕，就可以使用网站上的指令安装服务器程序了。

打开一个终端使用命令 openerp-server 启动服务器，当服务起来后会出现一些log消息。如果服务被正确安装，30秒内
会出现消息 [...] waiting for connections... 或者类似消息，用来提示服务器正在等待客户端连接。


[image: ../../../_images/terps_startup_log.png]
控制台上的OpenERP开始日志






手动安装 OpenERP GTK 客户端

跟据你的操作系统，按照网站上的安装文档介绍的步骤安装0penERP GTK客户端。


[image: ../../../_images/terp_client_startup.png]
启动时的OpenERP客户端



打开一个终端窗口使用命令 openerp-client 启动客户端。当你在Linux服务器上启动客户端时你会发现不需要修改任何连接参数
客户端就可以正常工作。消息 No database found, you must create one! 可以告诉你已经成功连接到服务器，你需要在服务器
上创建一个数据库。




创建数据库


	你可以使用其它的GTK客户端连接到你的Linux服务器。在你离开服务器时，确认你知道它的网络地址——无论是服务器名

	(例如 ``mycomputer.mycompany.net`` ) 还是IP地址(例如 192.168.0.123 )。




Note

不同的网络

OpenERP客户端和服务器之间的通信是建立在标准协议至上的。你可以用Windows上的客户端连接一个Linux服务器，或者
反过来都没有问题。OpenERP的Mac版本也一样——你用Windows和Linux的客户端或者服务器都可以连接它。



在Linux下安装OpenERP客户端，参照本部分之前的过程。你可以通过修改连接参数使不同的客户端连接到OpenERP服务器。
要修改参数，请在连接对话框中点击 Change 按钮，并且启用下面的内容：


	服务器上的 Server : name  或者  IP address  ，

	端口 Port : , 默认是 8069  或者  8070，

	Connection protocol : XML-RPC  或者  NET-RPC ，




[image: ../../../_images/terp_client_server.png]
定义连接服务器参数对话框



在从客户端连接到服务器时有可能需要使用安全协议以防止网络上其他用户的侦听，但是这里描述的仅是无加密的直接链接。

如果你的Linux服务器有防火墙保护，你需要打开 8069 or 8070 端口以便其它电脑上的用户使用OpenERP GTK客户端访问。


[image: ../../../_images/web_welcome.png]
使用OpenERP Web客户端



你可以通过在浏览器中打开http://localhost:8069来修改OpenERP Web版的安装，如图 使用OpenERP Web客户端。
你也可以通过另一台电脑连接到相同的网络来测试如果你知道服务器名或者IP地址——你应该在浏览器中输入类似于http://<server_address>:8069
的地址来访问。




检查您的 Linux 安装

你在安装各组件过程中已经使用了默认参数。如果你有问题或者你想进行不同的设置，下面的部分会指导你进行相应的安装。


Tip

psql 和 pgAdmin 工具

psql是一个简单的客户端，从命令行执行，它由PostgreSQL提供。它允许你执行SQL命令在你的OpenERP数据库上。

如果你习惯使用图形工具操作你的数据库你可以安装pgAdmin III（在Windows系统上，它通常会随着PostgreSQL自动安装，
你也可以从这里 http://www.pgadmin.org/ 自行下载）。




	PostgreSQL数据库启动启动并且默认监听本地的5432端口: 你可以在终端中输入 sudo netstat -anpt 检查5432端口是否可见。



	数据库系统有一个默认规则 postgres ，它是运行在Linux postgres 用户下的: 在终端中输入 sudo su postgres -c psql查看psql的启动消息——然后输入 \q 退出程序。



	如果你要从终端启动OpenERP，但是收到消息 socket.error: (98,
'Address already in use') 可能是已经有一个OpenERP的实例在运行并且使用了你已经定义的接口
（默认为8069和8070）。你需要首先停止并卸载掉之前安装的OpenERP或者Tiny ERP，或者其它占用了这两个端口的程序。

输入 sudo netstat -anpt 以查看当前运行的进程，记录下PID。通过输入 ps aux | grep <PID>你可以看到这个PID对应的程序，
然后你可以通过输入 sudo kill <PID>来停止它。当你重启服务器时你需要通过其它方式停止它。



	OpenERP服务器有大量的配置选项。 你可以在启动服务器时输入 –help进行查看。默认情况下，服务器的配置文件
保存在用户的home目录下的 .terp_serverrc文件中（对于postgres用户来说目录是 /var/lib/postgresql）



	你可以删除配置文件使OpenERP以默认方式启动。升级后的系统经常会因为新版本的服务端程序不能和旧版本的参数配合工作而表现不佳。
当采用无配置文件启动服务时，它会自动创建一个默认配置文件——除非采用了非默认方式这个配置文件才会被重写。



	判断系统工作是否正常，抛开防火墙的问题，你可以在服务器上再开一个终端窗口，打开OpenERP客户端（这样可以避免防火墙过滤）。
在端口8069上使用XML-RPC协议或者在8070端口上使用NET-RPC协议进行连接。服务器可以同时使用这两个端口。当以这种形式启动时窗口会显示日志文件。



	客户端安装在用户的home目录下的 .terprc文件里。因为任何用户都可以启动GTK客户端，所以每个用户
都会在他们的目录中保存一份配置文件。



	你可以删除配置文件使OpenERP客户端只使用默认选项启动。当客户端发现没有配置文件它会自动创建一个。



	Web服务器使用 NET-RPC 协议。如果GTK客户端工作正常，但是Web服务却不行，问题可能出在NET-RPC端口上也可能是Web服务器自身
的问题，但不是OpenERP服务器的问题。






Hint

多公司使用同一服务器

你可以在一台物理机上启动多个OpenERP服务端，但它们要使用不同的端口。如果你已经在PostgreSQL中定义了多个数据库角色，
每一个通过一个OpenERP实例连接到不同的端口，你就可以使用一台物理服务器同时为多个公司提供服务。
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数据库的创建

使用这个章节里概述的技巧来创建一个新的数据库， openerp_ch01 . 这个数据库将包含 OpenERP 提供的示范数据以及
大部分的 OpenERP 核心功能。你需要知道超级管理员的密码才能使用这个数据库，或者你可以请具有超级管理员权限的人创建这个数据库。


Note

超级管理员密码

任何人只要知道超级管理员的密码，都对服务器上的数据有完整的存取权力 – 可读取，修改或删除任何服务器上任何数据库的任何数据。
在第一次安装完成后，密码是 admin 。 这是写在程序里的缺省值，如果找不到可以存取的服务器组态文件，就会使用这个缺省值。
如果你的系统有配置服务器可写入的组态文件，你就可以透过客户端修改密码；或者，你可以刻意把组态文件设置成只读，这样以后就没有
人可以从客户端修改密码。不论是这两种方式的哪一种，如果你忘记密码，服务器的系统管理员都可以修改密码。

所以你的系统设置是可以从客户端修改密码，你可以从 GTK 客户端的菜单里进行修改 文件 ‣ 数据库 ‣ 管理员密码 ，或是从
网页客户端登出 (单击 登出 链接), 在登入画面单击 数据库 ，然后在管理画面中单击 密码 。

服务器上的配置文件位置，通常是在启动服务器时用 --config 命令的选项来指定。




[image: ../../../_images/change_superadmin_pwd.png]
用网页客户端来修改超级管理员密码




创建数据库

如果你是使用 GTK 客户端， 在菜单的左上方选择 文件 ‣ 数据库 ‣ 新数据库 。
输入超级管理员密码以及要创建的新数据库名称。


[image: ../../../_images/create_new_db_GTK.png]
使用 GTK 客户端创建新资料库



如果你是是用网页客户端，在登入画面单击 数据库 ，然后在数据库管理页面 创建 。
输入超级管理员密码，以及你要创建的数据库名称。

在两种方法里你都会看到核取方块；核取方块是用来确认是否要载入演示数据。不论是否有选取核取方块，结果都不会影响数据库的 整体应用 。

在两种方法里你也都会看到，你可以选择管理员密码。管理员密码可以相当程度确保数据库的安全性，因为从一开始就可以确保数据库的密码是唯一的。
(实际上许多人会难以抗拒使用 admin 作为密码!)




数据库 openerp_ch01

等到信息显示数据库及用户账号及密码 (admin/XXXX  和 demo/demo ) 已经成功创建，你就已经创建了这个数据库，而且你可以不需要知道超级管理员密码，就可以扩充这个数据库。


Tip

用户存取

对每一个数据库来说，用户名称/密码 都是唯一的组合；如果你有管理员的权限，你可以修改全部的用户。

另外，你可以安装 users_ldap 模块，用于管理用户在 LDAP (轻量级目录访问协议， Lightweight Directory Access Protocol， 一个标准系统)，
以及连接到数个 OpenERP 数据库。透过 LDAP 许多数据库可以共享相同的用户账号资讯。




Note

创建数据库失败

如何知道是否已经成功创建你的新数据库？
如果创建数据库不成功，系统会通知你。
如果你用了禁止使用的字符当做数据库的名称 (或数据库没有名称，或名称太短)，系统会用对话框提出警告 不合格的数据库名称! ，
同时会说明如何修正错误。如果你输入了错误的超级管理员密码或是某个已经在使用中的名称 (有些名称是在你不知道的情形下保留的)，系统会用以下对话
框提出警告 数据库创建过程中错误! 。



如果这是你第一次连结到这个数据库，系统会问你一系列的问题来确认数据库的参数。你可以选择 跳过配置向导 或
开始配置 。如果你选择设定应用程序的组态，可以依照以下步奏进行:



	配置你的界面 : 选择 简单化界面 然后单击 下一步 。

	配置你的公司讯息 : 把系统建议的默默认值 OpenERP S.A. 改成你自己公司的名称以你的喜好尽量把地址填完整。
你可以设置你公司使用的币别，或是直接使用默认值。你也可以加上你公司的商标；商标可以显示在报表或其他文件上。单击 下一步 。

	安装应用程序 : 选取你需要的应用程序然后单击 安装 。现在，不要安装任何应用程序。






一旦配置完成，你就已经连接到你的 OpenERP 系统。 现在的系统功能非常有限，因为你选择了 简单化界面 ，
而且没有安装任何应用程序；但是现在这个演示已经足够告诉你安装完成了。


[image: ../../../_images/define_main_co_dlg.png]
在初始数据库配置中定义你的公司






管理数据库

作为超级管理员，你不仅有权利创建数据库，还可以：


	备份数据库

	删除数据库

	恢复数据库



在GTK客户端中，所有这些操作都可以在 File ‣ Databases... 中实现，在网页客户端中通过 Login 界面的 Databases 按钮实现。


Tip

备份（复制数据库）

要复制数据库，可以在网页的 Login 界面上点击 Databases 按钮。然后点击 Backup 按钮，
选择你想要备份的数据库，然后输入超级管理员密码。点击 Backup 确认。




Tip

删除数据库

要删除数据库，可以在网页上的 Login 界面点击 Databases 按钮。然后点击 Drop 按钮，选择你想要删除的数据库，
然后输入超级管理员密码。点击 Drop 确认删除。




Tip

恢复数据库

要恢复数据库，可以在网页上的 Login 界面上点击 Databases 按钮。然后点击 Restore
按钮，点击 Choose File 选择一个要恢复的数据库。给数据库起个名字然后输入超级管理员密码。
点击 Restore 按钮确认。当然，要恢复一个数据库，你需要有一个已经存在的拷贝。




Tip

建立数据库复本

要建立一个数据库副本，你可以：


	从原数据库生成一个备份文件。

	恢复这个备份文件，并且重新命名。



这对于从一个生产数据库建立一个测试库是很有用的。你可以尝试重新配置，新建模块或者仅仅导入新的数据，



在正常生产使用中，系统管理员可以通过配置OpenERP来限制访问这些数据库中的某些功能以提高安全性。

现在你可以利用安装的数据库来熟悉OpenERP的管理和使用了。






为OpenERP添加新功能

你创建和管理的数据库是建立在OpenERP核心功能至上的。核心系统安装在OpenERP应用服务器的文件系统上。只有当你要求的时候，
才会安装到OpenERP数据库中，详情参考下一章节， OpenERP 漫游指南。

如果你想更新或扩展额外的模块该怎么做？


	要进行更新，你的使用本部分前面提到的技术重新安装一个新的OpenERP实例，参照 数据库的创建。

	要进行扩展，你得安装新模块到你现有的OpenERP系统的 addons 目录下，具体操作可以有多种方式。



在这两种情况下你都需要你的OpenERP应用服务器的 root 用户或者 Administrator 用户权限。


扩展OpenERP

要扩展OpenERP，你需要把模块复制到 addons 目录。它在你的服务器 openerp-server 目录（这个目录
在Windows，Mac和不同版本的Linux版本之间会略有不同，在Windows all-in-one版本中则完全不同（not available at all））下。

在哪个目录下你会看到现有系统中已经安装的模块，比如： product and purchase。一个模块可以以
文件、文件夹的形式或者是zip包的形式存在。如果是zip包，那里面的文件结构也是和文件、文件夹类型相同的。

基本上，你可以通过两种方式添加模块 —— 通过服务器或者通过客户端。

通过服务器添加模块是一个传统的系统管理任务。 以 root 用户或者其他合适的用户，你可以把模块放到 addons 目录下并且修改权限以便可以和其它模块一样正确执行。

通过客户端添加模块，你必须首先修改服务器上 addons 目录的权限，将此目录设为可写。只有这样才可以通过OpenERP客户端安装模块。
（应用服务器上的服务软件最终将执行一个任务来完成该操作）


Tip

修改权限

在安装OpenERP系统的Linux服务器上修改权限的最简单的办法是执行命令 sudo chmod 777 <addons文件夹路径>
(<addons文件夹路径>需要使用完整路径，例如： /usr/lib/python2.5/site-packages/openerp-
server/addons)。



OpenERP的所有用户只要进入了管理菜单就可以上传任何新功能，所以在生产环境中你必须慎重考虑该功能。你会在本书
后面的内容中看到上传文件的事例。
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OpenERP 漫游指南


Starting to discover OpenERP, using demonstration data supplied with the system, is a good way to
familiarize yourself with the user interface.
This guided tour provides you with an introduction to many of the available system features.


You would be forgiven a flicker of apprehension when you first sit at your computer to connect to
OpenERP, since ERP systems are renowned for their complexity and for the time it takes to learn
how to use them. These are, after all, Enterprise Resource Planning systems, capable of managing
most elements of global enterprises, so they should be complicated, should not they? But even if this
is often the case for proprietary software, OpenERP is a bit of an exception in the class of
management software.

Even though OpenERP is a comprehensive software, the user interface and workflow management facilities are quite
simple and intuitive to use. For this reason, OpenERP is one of the few software packages with
reference customers in both very small businesses (typically requiring simplicity) and large
accounts (typically requiring wide functional coverage).

A two-phase approach provides a good guide for your first steps with OpenERP:


	Using a database containing demonstration data to get an overview of OpenERP’s functionality
(described in this chapter, OpenERP 漫游指南)

	Setting up a clean database to configure and populate a limited system for yourself (described in
the next chapter, 如何应用到你的业务中?).



To read this chapter effectively, make sure that you have access to an OpenERP server. The
description in this chapter assumes that you are using the OpenERP web client unless it states
otherwise. The general functionality differs little from one client to the other.



	创建数据库

	连接到 OpenERP
	工具栏首选项
	安装新的语言

	站内信





	配置用户

	管理业务伙伴
	业务伙伴列表

	业务伙伴分类









	添加系统新业务
	更新模块列表

	配置及重运行配置向导

	安装新模块及应用

	安装模块及其依赖模块

	安装附加功能





	OpenERP 6.1 新改进
	软件改进

	业务流程改进





	开始使用OpenERP
	基本概念
	业务伙伴及其联系人

	快速定位业务伙伴

	业务伙伴信息窗口

	与业务伙伴操作交互
	产品









	提升销售能力

	管理各种账本

	管理提升员工士气

	掌控项目管理

	掌控销售管理

	掌控采购管理

	优化仓库管理

	提升生产能力

	随时随时分享各种管理文档

	衡量您的业务性能

	工艺流程跟踪

	还不满足？

	提示与技巧
	快捷键概述

	过滤器
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创建数据库

在 安装与初始配置 中使用概要的技术来创建一个新的数据库，openerp_ch02 。这个
数据库将包含由OpenERP提供的演示数据以及绝大多数的OpenERP核心功能。
您需要知道系统的超级管理员密码 – 又或找到拥有它的人来创建此种子数据库。

要启动数据库的创建进程，请从 Login 页点击
Databases 然后填写并完成 Create Database 表单项:


	Super admin password : 缺省是 admin , 如果你的系统管理员没有更改,

	New database name : openerp_ch02 ,

	Load Demonstration data checkbox: checked ,

	Default Language : English (US) ,

	Administrator password : admin (因为它在目前阶段最容易记住，但很明显：非常不安全),

	Confirm password : admin .
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连接到 OpenERP

由于这是您第一次连接到 OpenERP, 你将有机会来配置系统.
你可以选择其中一种 Skip Configuration Wizards
或 Start Configuration. 我们将继续通过点击系统配置
Start Configuration.

配置包括一组向导，它可以帮助你通过选项来安装模块。
安装过程在这块是一个非常简单的.



	Configure Your Interface : 选择 Simplified 并点击 Next.








	在 Company Configuration 步骤, 输入你自己的 Company Name 和
Currency. 这里可以加公司地址, 联系方式等其他详细信息和公司 Logo,
如果你有的话, Logo将在报表上展示. 然后, 点击 Next.

	在 Install Applications 部分将允许你添加应用到你的
系统中. 眼下, 点击 Skip 不安装任何应用.
你现在连接到 OpenERP 可以开始以管理员用户来使用系统.






第一屏显示的是下图所示的主菜单 The Main Menu of the openerp_ch02 database:


	在登陆的帐套名提示下面是你当前的登陆用户.

	ONLINE SUPPORT 按钮， 给你一个OpenERP提供的支持服务的总览，他对会员开放，

	右上角的 Preferences 工具栏，用来显示 HOME 页的链接，
EDIT PREFERENCES 页, ABOUT, HELP
和 LOGOUT 按钮,

	下面就是所安装程序的菜单条目的链接图标（用户可以自定义），

	在主页的右侧，主菜单的旁边是一组小工具（widgets）的快捷菜单。




[image: ../../../_images/main_window_openerp_ch02.png]
The Main Menu of the openerp_ch02 database



当前有两个可用菜单:


	Sales

	Administration




工具栏首选项

当你连接到OpenERP，最上面的工具栏指出你是使用哪一个用户进行的连接。所以当前它显示 Administrator
（如果你使用另一个用户登录，它会相应的显示另一个用户名）。

你能看到顶端工具栏右侧包含了一组有用的链接。首先，你会看到一个:guilabel:HOME 页的链接。
This takes you to either the
Home page containing links to the available menus or to another window or dashboard, depending on the
user configuration. In the case of the openerp_ch02 database, so far the Home page
is the Main Menu. But in general each user of the
system is presented with a dashboard that is designed to show performance indicators and urgent
documents that are most useful to someone of the user’s position in the company. You will see how to
assign dashboards to different users in a later chapter, 配置与系统管理.


Tip

Multi-nationals and Time Zones

If you have users in different countries, they can configure their own timezone. Timestamp displays
are then adjusted by reference to the user’s own localization setting.

So if you have a team in India and a team in England, the times will automatically be converted. If
an Indian employee sets her working hours from 9 to 6, that will be converted and saved in the
server’s timezone. When the English users want to set up a meeting with an Indian user, the Indian
user’s available time will be converted to English time.



The next element in the toolbar is a link to EDIT PREFERENCES. By clicking that link, you
get a dialog box where the current user can set his interface in the Current Activity tab;
and in the Preferences tab, set his password, a timezone, a working language,
e-mail and a signature:


	The Interface field in the Current Activity tab allows the user to switch
between the Simplified and Extended interfaces.

	The Language field enables the user’s working language to be changed. But first, the
system must be loaded with other languages for the user to be able to choose an alternative, which
is described in the next subsection of this chapter. This is a mandatory field.

	The Timezone setting indicates the user’s location to OpenERP. This can be different
from that of the server. All of the dates in the system are converted to the user’s timezone
automatically.

	The Menu Tips checkbox gives the user the choice to have tips displayed on each menu action.

	The Change Password button gives users the opportunity to change their own password.
It opens a new dialog box where users may change the password and must logout and login again after the change.
You should take steps (perhaps written policies) to prevent users making these too trivial.

	The Email field is for storing the current user’s default e-mail address.

	The Signature field gives the user a place for the signature attached to messages sent
from within OpenERP.



The ABOUT link gives information about the development of the OpenERP software and
various links to other information.

The HELP link directs the user to the online documentation of OpenERP, where extensive help is available on a host of topics.

The LOGOUT link enables you to logout and return to the original login page. You can
then login to another database, or to the same database as another user. This page also gives you
access to the super-administrator functions for managing databases on this server.


安装新的语言

Each user of the system can work in his or her own language. More than twenty languages are
currently available besides English. Users select their working language using the Preferences link.
You can also assign a language to a partner (customer or supplier), in which case all the documents
sent to that partner will be automatically translated into that language.


Attention

More about Languages

The base version of OpenERP is translated into the following languages: English, German, Chinese,
Spanish, Italian, Hungarian, Dutch, Portuguese, Romanian, Swedish and Czech.

But other languages are also available: Arabic, Afghan,
Austrian, Bulgarian, Indonesian, Finnish, Thai, Turkish and Vietnamese..



As administrator, you can install a new main working language into the system.



	Select Administration in the Menu Toolbar and click
Translations ‣ Load an Official Translation in the main menu window,

	Select the language to install, French for example, and click Load,

	The system will intimate you when the selected language has been successfully installed.
Click Close to return to the menu.






To see the effects of this installation, change the preferences of your user to change the working
language (you may first need to ensure that you have explicitly selected English as your language,
rather than keep the default, before you are given the French option).
You may have to reload the page to see the effects. The main menu is immediately translated in
the selected language. If you are using the GTK
client, you will first have to close the menu then open a new main menu to start seeing things in the
new language.


Note

Navigating the Menu

From this point in the book navigation from the main menu is written as a series of menu entries
connected by the ‣ character. Instead of seeing “Select Administration in
the Menu toolbar then click Translations > Load an Official Translation” you will just get “use menu
Administration ‣ Translations ‣ Load an Official Translation”.






站内信

Requests have been removed in OpenERP 6.1 - a new internal communication system will be added in 7.0.






配置用户

The database you created contains minimal functionality but can be extended to include all of the
potential functionality available to OpenERP. About the only functions actually available in this
minimal database are Customers and Currencies – and these only because the definition of your main
company required this. And because you chose to include demonstration data, both Customers and
Currencies were installed with some samples.

Because you logged in as Administrator, you have all the access you need to configure users. Click
Administration ‣ Users ‣ Users to display the list of users defined in the
system. A second user, Demo User , is also present in the system as part of the
demonstration data. Click the Demo User name to open a non-editable form on that user.

Click the Groups  tab to see that the demo user is a member of only the Employee group,
and is subject to no specialized rules.
The user Administrator is different, as you can see if you
follow the same sequence to review its definition. It is a member of the Administration / Configuration and the Administration / Access Rights groups,
which gives it more advanced rights to configure new users.


Tip

Groups and Users

Users and groups provide the structure for specifying access rights to different documents. Their
setup answers the question “Who has access to what?”



Click Administration ‣ Users ‣ Groups to open the list of
groups defined in the system. If you open the form view of the Administration / Configuration group by clicking its name in the list, the first tab Users gives you the list of
all the users who belong to this group.

You can also see in the Menus tab, the list of menus reserved for this group. By convention,
the Administration / Configuration in OpenERP has rights of access to
the Configuration menu in each section. So Sales / Configuration is
found in the list of access rights but Sales is not found there because it is accessible
to all users. Click the Access Rights tab and it gives you details of the access rights
for that group. These are detailed later in 配置与系统管理.

You can create some new users to integrate them into the system. Assign them to predefined groups to
grant them certain access rights. Then try their access rights when you login as these users.
Management defines these access rights as described in 配置与系统管理.


Note

Changes to Default Access Rights

New versions of OpenERP differ from earlier versions of OpenERP and Tiny ERP in this area:
many groups have been predefined and access to many of the menus and objects are keyed to these
groups by default.
This is quite a contrast to the rather liberal approach in 4.2.2 and before, where access rights
could be defined but were not activated by default.






管理业务伙伴

In OpenERP, a partner represents an entity that you do business with. That can be a prospect, a
customer, a supplier, or even an employee of your company.


业务伙伴列表

Click Sales ‣ Address Book ‣ Customers in the main menu to open the list of partners who are customers. Then click the name of the first partner to get hold of the details – a form appears with
information about the company, such as its corporate name, its primary language, its reference and whether it is a
Customer and/or a Supplier . You will also find several other tabs on it:


	the General tab contains information about different contacts at that partner, postal information,
communication information and the categories it belongs to.

	the Sales & Purchases tab contains information that is slightly less immediate.

	the History tab (visible if you install other modules like crm)
contains the history of all the events that the partner has
been involved in. These events are created automatically by different system documents: invoices,
orders, support requests and so on, from a list that can be configured in the system.
These give you a rapid view of the partner’s history on a single
screen.

	the Notes tab is an area for free text notes.



To the right of the form is a list of Reports, Actions, Links and Attachments related to a partner. Click some of
them to get a feel for their use.


[image: ../../../_images/partner.png]
Partner form




Tip

Partner Categories

Partner Categories enable you to segment different partners according to their relation with you
(client, prospect, supplier, and so on). A partner can belong to several categories – for example
it may be both a customer and supplier at the same time.

But there are also Customer and Supplier checkboxes on the partner form, which are different.
These checkboxes are designed to enable OpenERP to quickly select what should appear on some of the
system drop-down selection boxes. They, too, need to be set correctly.






业务伙伴分类

You can list your partners by category using the menu Sales ‣ Configuration ‣
Address Book ‣ Partners Categories. Click a category to obtain a list of partners in that category.


[image: ../../../_images/main_window_partner_menu_config.png]
Categories of partner



The administrator can define new categories. So you will create a new category and link it to a
partner:



	Use Sales ‣ Configuration ‣ Address Book ‣ Partners Categories
to reach the list of categories in a list view.

	Click New to open an empty form for creating a new category

	Enter My Prospects in the field Category Name. Then click on the
Search icon to the right of the Parent Category field and select
Prospect in the list that appears.

	Then save your new category using the Save button.






You may add exiting partners to this new category using the Add button in the
Partners section.


Tip

Required Fields

Fields colored blue are required. If you try to save the form while any of these fields are empty,
the field turns red to indicate that there is a problem. It is impossible to save the form until
you have completed every required field.



You can review your new category structure using the list view.
You should see the new structure of Prospects / My Prospects  there.


[image: ../../../_images/main_window_partner_tab.png]
Creating a new partner category



To create a new partner and link it to this new category, open a new partner form to modify it.



	Type New Partner into the Name field.

	In the General tab, click the Add button under the
Categories section and select your
new category from the list that appears: Prospect / My Prospects .

	Then save your partner by clicking Save. The partner now belongs in the category
Prospect / My Prospects .

	Monitor your modification in the menu Sales ‣ Configuration ‣ Address Book ‣
Partners Categories. Select the category Prospect / My Prospects. The list of partners opens
and you will find your new partner there in that list.







Tip

Searching for Documents

If you need to search through a long list of partners, it is best to use the available search
criteria rather than scroll through the whole partner list. It is a habit that will save you a lot of
time in the long run as you search for all kinds of documents.




Note

Example Categories of Partners

A partner can be assigned to several categories. These enable you to create alternative
classifications as necessary, usually in a hierarchical form.

Here are some structures that are often used:


	geographical locations,

	interest in certain product lines,

	subscriptions to newsletters,

	type of industry.
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添加系统新业务

All of OpenERP’s functionality is contained in its many and various modules. Many of these, the
core modules, are automatically loaded during the initial installation of the system and can be
updated online later. Although they are mostly not installed in your database at the outset, they are
available on your computer for immediate installation. Additional modules can also be loaded online
from the official OpenERP site http://openerp.com. These modules are inactive when they are loaded
into the system, and can then be installed in a separate step.

You will start by checking if there are any updates available online that apply to your initial
installation. Then you will install a CRM module to complete your existing database.


更新模块列表

Click Administration ‣ Modules ‣ Update Modules List to start the
updating tool. The Module Update window opens notifying the user that
OpenERP will look at the server side for adding new modules and updating
existing ones.

Click Update to start the update on the server side. When it is
complete, you will see a Module update result section indicating how many new modules were added
and how many existing modules were updated. Click Open Modules to return to the updated list.


Note

Modules

All the modules available on your computer can be found in the addons directory of your OpenERP
server. Each module there is represented by a directory carrying the name of the module or by a
file with the module name and .zip appended to it. The file is in ZIP archive format and replicates
the directory structure of unzipped modules.




Tip

Searching through the whole list

The list of modules shows only the first available modules. In the web client you can search or
follow the First / Previous / Next / Last links to get to any point in the whole list, and you can
change the number of entries listed by clicking the row number indicators between Previous
and Next
and selecting a different number from the default of 20.

If you use the GTK client you can search, as you would with the web client, or use the selection field
(currently showing 80) to
the top right of the window to change the number of entries returned by the search from its default
limit of 80, or its default offset of 0 (starting at the first entry) in the whole list.






配置及重运行配置向导

One of the new features of OpenERP is the Configuration wizard. Once run, the Reconfigure shortcut will appear. This wizard provides an easy way to install modules, thanks to its user-friendly and easy-to-use interface. The user may invoke this wizard at his own convenience using the shortcut Reconfigure, found just below the database and user name in the web interface or in the Shortcut menu in the GTK client. The same Configuration dialog box appears that you may have encountered at the time of installing a new database. Why did we call it the Reconfigure wizard? Indeed, because it allows the user to review installed applications and install related additional features or simply to install new applications on the fly.

When you go through the various steps in the wizard, you will come across some options that are checked and greyed. These are applications already installed. In the openerp_ch02 database configuration, you may see that the Customer Relationship Management option is already checked because this Business Application has been installed in this database.
Install extra applications simply by checking the corresponding options and clicking Install or click Skip to stop the configuration. You will eventually also come across the CRM Application Configuration step which you may use to add features to your CRM application. For now, select the Claims option and click Configure. This will in turn install the crm_claim module.


[image: ../../../_images/reconfigure_wizard.png]
Reconfigure wizard showing Customer Relationship Management application as installed



You may continue adding features this way, skip configuration steps or simply exit from this wizard. When you feel the need to
load your system with additional features, you may invoke the Reconfigure wizard again at any point.


Note

You can also change the Configuration Wizard through the Administration ‣ Configuration ‣ Configuration Wizards ‣ Configuration Wizards.






安装新模块及应用

You will now install a module named google_map, which will enable you to add a feature to the partner form to open the location directly in Google Maps. This is part of the core installation, so you do not need to load anything to make this work.

Open the list of modules from Administration ‣ Modules ‣ Modules. Search for the module by entering the name google_map in the Name field on the search screen then clicking it in the list that appears to open it. The form that describes the module gives you useful information such as its version number, its status and a review of its
functionality. Click Schedule for Installation and the status of the module changes to To be installed.


Tip

From now on you can schedule and install modules from list view too. Notice the buttons on the right side and the action button to install.




[image: ../../../_images/install_google_map_module.png]
Installation of the Google Maps module




Tip

Technical Guide

If you select a module in any of the module lists by clicking on a module line and then on
Technical Guide at the top right of the window, OpenERP produces a technical report
on that module. It is helpful only if the module is installed.

This report comprises a list of all the objects and all the fields along with their descriptions.
The report adapts to your system and reflects any modifications you have made and all the other
modules you have installed.



Then, either use the menu Administration ‣ Modules ‣ Apply Scheduled Upgrades, or from the Actions section click Apply Scheduled Upgrades, then Start update on the Module Upgrade
form that appears. Close the window when the operation has completed. Return to the Sales menu; you will
see the new menu Products has become available.


Tip

Refreshing the menu in the GTK Client

After an update in the GTK client you will have to open a new menu to refresh the content –
otherwise you will not see the new menu item. To do that, use the window menu Form ‣
Reload / Undo or use the shortcut Ctrl+R.






安装模块及其依赖模块

Now install the Warehouse Management module using the same process as before.
Start from Administration ‣ Modules ‣ Modules.



	Get the list of modules, and search for the stock module in that list.

	Schedule the module for installation by clicking Schedule for Installation.

	Do the same for account.

	Click Apply Scheduled Upgrades on the action toolbar to the right.

	Click Start update to install both modules.

	After a few seconds, when the installation is complete, you may close this dialog box.

	You will see details of all the features installed by the modules on a new
Features tab on the module form.






When you return to the Warehouse menu, you will find the new menu items under it like
Warehouse ‣ Warehouse Management ‣ Incoming Shipments, Warehouse ‣ Products Moves,  which are a part of the Warehouse management system. You will also see all the accounting functions that are now available in the Accounting menu.

There is no particular relationship between the modules installed and the menus added. Most of the
core modules add complete menus but some also add sub-menus to menus already in the system. Other
modules add menus and sub-menus as they need. Modules can also add additional fields to existing
forms, or simply additional demonstration data or some settings specific to a given requirement.


Note

Dependencies Between Modules

The module form shows two tabs before it is installed.
The first tab gives basic information about the module, and the
second gives a list of modules that this module depends on. So when you install a module, OpenERP
automatically selects all the necessary dependencies to install this module.

That is also how you develop the profile modules: they simply define a list of modules that you want
in your profile as a set of dependencies.



Although you can install a module and all its dependencies at once, you cannot remove them in one
fell swoop – you would have to uninstall module by module. Uninstalling is more complex than
installing because you have to handle existing system data.


Note

Uninstalling Modules

Although it works quite well, uninstalling modules is not perfect in OpenERP. It is not guaranteed
to return the system exactly to the state it was in before installation.

So it is recommended that you make a backup of the database before installing your new modules so
that you can test the new modules and decide whether they are suitable or not. If they are not, then
you can return to your backup. If they are, then you will probably still reinstall the modules on
your backup so that you do not have to delete all your test data.

If you wanted to uninstall, you would use the menu Administration ‣ Modules
‣ Modules and then uninstall them in the inverse order of their
dependencies: stock, account.






安装附加功能

To discover the full range of OpenERP’s possibilities, you can install many additional modules.
Installing them with their demonstration data provides a convenient way of exploring the whole core
system. When you build on the openerp_ch02  database, you will automatically include
demonstration data because you checked the Load Demonstration Data checkbox when you originally
created the database.

Click Administration ‣ Modules ‣ Modules to give you an
overview of all of the modules available for installation.

To test several modules, you will not have to install them all one by one. You can use the dependencies
between modules to load several at once.
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OpenERP 6.1 新改进


软件改进


	OpenERP has been structured as Business Applications and its menu has been changed to match this,

	Major improvements in usability, especially in the Web version,

	Simplified versus Extended view,

	When you search for a record, e.g. a customer / supplier, the web version will propose to create the new partner when no existing partner is found,

	When you click a Business Application in the Web version, the related Dashboard will be opened,

	To display the process view, click the Question Mark next to the title in the web version,

	Menutips & Tooltips will be displayed to explain more about the active screen,

	Dynamic Filters which allow you to easily create and save your own filters, with Group by options, Extended filters, and much more,

	User Roles are no longer used, they have been integrated in the User Groups,

	The Administrator will now only have the rights according to the user groups that have been assigned to him,

	Multicompany has been integrated in the core of OpenERP and does not require the installation of modules. You just have to add the User Group Useability / Multi-Company,

	Perform actions, such as update status, confirm, delete, ... directly from List View,

	Use communication tools such as Fetchmail, Outlook & Thunderbird integration and CalDAV / WebDAV (also available on Android & Iphone),

	Create your own e-mail templates for use throughout OpenERP,

	Use the Scheduler for objects other than Manufacturing too,

	Click the star in the web version to quickly create a shortcut for a screen you often use,

	When you perform an action in List view in the web version, (i.e. change the status of a lead), OpenERP will display a bar containing information about this change. You can click the link to open the lead concerned,

	Updated configuration wizard to install new features using OpenERP modules in user friendly way.






业务流程改进

销售管理


	CRM has been integrated in the Sales Management Business Application,

	Geolocalization module, also allowing you to send qualified opportunities directly to external partners,

	Manage your Marketing Campaigns and send automated e-mails based on your own templates,

	For Leads, OpenERP will check the email address of the contact and when found for an existing partner, it will propose to merge the new contact with the corresponding partner,

	Create your company wiki for Sales FAQ,

	History tab in the Customer form to keep track of all events,

	When you convert a lead to an opportunity, you now have the option to not create a partner, but just keep the contact data in the opportunity,

	Create a new partner from a lead or an opportunity, or merge with an existing partner.



仓储管理


	Push & Pull rules for stock locations have been extended and integrated with multicompany,

	Configure units of measure by reference unit, bigger than / smaller then reference unit,

	Update stock level from the Product form and automatically create a physical inventory for it.



财务管理


	By default, only one Entry Sequence is available for a journal. If you want to use two sequences for your journal numbering, please install the account_sequence module,

	Separate numbering is now also available for Bank Journals,

	Quickly enter Journal Entries from List View from the Journal Items menu. Configure your journal with default debit & credit accounts, select the journal in the Journal Items List View, click New and start creating new entries,

	Chart of Accounts and Chart of Taxes can be displayed for a selected period,

	OpenERP has added a flexible, easy Invoicing module allowing you to keep track of your accounting, even when you are not an accountant. If you install the Invoicing module, in Simplified view, you will only have the Invoicing items. You should not use both Invoicing and Accounting,

	Use the Financial Management Configuration Wizard to easily select features you want to use,

	On installation of a predefined Chart of Accounts, the wizard also proposes default bank and cash accounts, and default Sales and Purchase taxes,

	On a journal you can set whether OpenERP should check if the invoice date is in the current period. This used to be a separate module,

	Different journal types for Refunds and Invoices,

	When creating a new journal, parameters are preset according to the journal type. The Entry Sequence for the journal is automatically created on Save,

	Cash Box, possible to keep a real cash register.



项目管理


	Improved Gantt chart in the Web version,

	Long Term Planning that can be calculated according to the working time of each employee involved in the project with the new Scheduler feature,

	On creation of a new project, OpenERP automatically creates the corresponding Analytic Account in the Projects chart of accounts. You no longer have access to the analytic account from the Project.



生产管理


	Scrap consumed or finished goods and have the related stock moves automatically,

	Consume products partially or completely.



人力资源管理


	Manage your evaluation process,

	Keep track of your recruitments and receive applicant mails directly in OpenERP, including attachments,

	A complete integration of payroll management system with accounting application.
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开始使用OpenERP

You will now explore the database openerp_ch02  with these profile modules installed to give
you an insight into the coverage of the core OpenERP software.


Tip

翻译新模块

When you have installed a new module and are using additional languages to English, you have to reload
the translation file. New terms introduced in these modules are not translated by default. To do
this use Administration ‣ Translations ‣ Load an Official Translation.



Depending on the user you are connected as, the page appears differently.
Using the installation sequence above, certain dashboards may be assigned as various
users’ home pages. They show a summary of the information required to start the day effectively. A
project dashboard might contain:


	a list of the tasks to carry out,

	a list of the tasks which is assigned to current user,

	a list of sprints,

	a list of issues assigned to current user,

	a graph of Planned vs Total hours,

	a graph of Remaining hours by Project,

	a graph of Open Issues by Creation Date.



Each of the lists can be reordered simply by clicking the heading of a column – first in ascending, then in descending order as you click repeatedly. To get more information about any particular entry, click on the name in the first column, or if you want to show a particular panel, click Zoom above it.


[image: ../../../_images/admin_project_dashboard.png]
Project Dashboard



A user’s home page is automatically reassigned during the creation or upgrading of a database. It is
customary to assign a dashboard to someone’s home page, but any OpenERP screen can be assigned to the
home page of any user.


Tip

Creating Shortcuts

Each user has access to many menu items from the menu. But in
general, an employee uses only a small part of the system’s functions.

So you can define shortcuts for the most-used menus. These shortcuts are personal for each user. To
create a new shortcut, just click the ‘*’ of the header of the view in web client.

To remove a shortcut just click the link and again click ‘*’ of the header of the view.



The following sections present an overview of the main functions of OpenERP. Some areas are
covered in more detail in the following chapters of this book and you will find many other functions
available in the optional modules. Functions are presented in the order that they appear on the main
menu.


基本概念


业务伙伴及其联系人

To get familiar with the OpenERP user interface, you will start working with information about
partners. Clicking Sales ‣ Address Book ‣ Customers brings up a list of partners that were
automatically loaded when you created the database with Load Demonstration Data checked.




快速定位业务伙伴

Above the partner list you will see a search form that enables you to quickly filter the partners.

The Customers filter is enabled by default showing partners who are customers. If you have applied no filter, the list shows every partner in the system. For space reasons, this list shows only the first few partners. If you want to display other records, you can search for them or navigate through the whole list using the First, Previous, Next, Last arrows.


[image: ../../../_images/partner_search_tab.png]
Standard partner search




Note

List Limits

By default, the list in the GTK client shows only the first 80 records, to avoid overloading the
network and the server.

But you can change that limit by clicking the selection widget (showing 80 by default) to the
right of the search criteria.

Similarly, the list in the web client shows only the first 20, 50, 100, 500 or unlimited records.

The actual number can be switched by clicking the link between the PREVIOUS and NEXT buttons
and selecting one of the other limits.



In the web version, if you click the name of a partner, the form view corresponding to that partner opens in Read-Only
mode. In the list you could alternatively click the pencil icon to open the same form in Edit mode.
Once you have a form, you can toggle between the two modes by clicking Save or Cancel when in
Edit mode and Edit when in Read-Only mode.




业务伙伴信息窗口

The partner form contains several tabs, all referring to the current record:


	General,

	Sales & Purchases,

	Accounting,

	History,

	Notes.



The fields in a tab are not all of the same type – some (such as Name) contain free
text, some (such as the Language) enable you to select a value from a list of options,
others give you a view of another object (such as Partner Contacts – because a partner
can have several contacts) or a list of links to another object (such as Partner Categories).
There are checkboxes (such as the Active field in the Sales & Purchases tab),
numeric fields (such as Credit Limit in the Accounting tab) and date fields (such as Date).

The History tab gives a quick overview of partner activities – an overview of useful information such as Leads and Opportunities, Meetings, Phone Calls, Emails and Tasks. Events are generated automatically by OpenERP from changes in other documents that refer to this partner.

It is possible to add events manually which directly relate to the corresponding form, such as a note recording a phone call. To add a new event click New in the Phone Calls section. That opens a new Phone Call pop-up form enabling a phone-call event to be created and added to the current partner.




与业务伙伴操作交互

To the right of the partner form is a toolbar containing a list of possible Reports ,
Actions and quick Links about the partner displayed in the form.

You can generate PDF documents for the selected object (or, in list view, about one or more
selected objects) using certain buttons in the Reports section of the toolbar:


	Labels : print address labels for the selected partners,

	Overdue Payments : print a letter to notify the selected partners of overdue payments,



Certain actions can be started by the following buttons in the Actions section of the
toolbar:


	SMS Send: enables you to send an SMS to selected partners. This system uses the bulk
SMS facilities of the Clickatell® company http://clickatell.com,

	Mass Mailing: enables you to send an email to a selection of partners,

	Create Opportunity: opens a window to create an opportunity for the partner.




Tip

Reports, Actions and Links in the GTK Client

When you are viewing a form in the GTK client, the buttons to the right of the form are shortcuts to
the same Reports, Actions and Links as described in the text. When you are viewing a list (such as
the partner list), those buttons are not available to you. Instead, you can reach Reports and Actions
through two of the buttons in the toolbar at the top of the list – Print and Action.



Partners are used throughout the OpenERP system in other documents. For example, the menu
Sales ‣ Sales Orders brings up all the Sales Orders in list view. Open an order in form view and click the name of a partner, even when the form is read-only. The Partner form will open.


Tip

Right-clicks and Shortcuts

In the GTK client you do not get hyperlinks to other document types. Instead, you can right-click in
a list view to show the linked fields (that is fields having a link to other forms) on that line.

In the web client you will see hyperlink shortcuts on several of the fields on a form in Read-
Only mode, allowing you to be taken directly to the corresponding form. When the web form is in Edit mode,
you can instead right-click the mouse button
in the field, to get all of the linked fields in a pop-up menu just as you would with the GTK
client.

You can quickly give this a try by going to any one of the sales orders in Sales
‣ Sales Orders. See where you can go from the
Customer field using either the web client with the form in
both read-only and in edit mode, or with the GTK client.




[image: ../../../_images/familiarization_sale_partner.png]
Links for a partner appear in an order form



Before moving on to the next topic, take a quick look at the Sales ‣
Configuration ‣ Address Book  menu, particularly Partner Categories  and  Localisation menus.
They contain some of the demonstration data that you installed when you created the database.


产品

In OpenERP, product is used to define a raw material, a stockable product, a consumable or a service. You can
work with whole products or with templates that separate the definition of products and variants (extra module).

For example, if you sell t-shirts in different sizes and colors:


	the product template is the “T-shirt” which contains information common to all sizes and all
colors,

	the variants are “Size:S” and “Color:Red”, which define the parameters for that size and
color,

	the final product is thus the combination of the two – T-shirt in size S and color Red.



The value of this approach, for some sectors, is that you can just define a template in detail and all
of its available variants briefly, rather than every item as an entire product.



Note

Example Product Templates and Variants

A product can be defined as a whole or as a product template and several variants. The variants
can be in one or several dimensions, depending on the installed modules.

For example, if you work in textiles, the variants on the product template for “T-shirt” are:


	Size (S, M, L, XL, XXL),

	Colour (white, grey, black, red),

	Quality of Cloth (125g/m2, 150g/m2, 160g/m2, 180g/m2),

	Collar (V, Round).



This separation of variant types requires the optional module product_variant_multi.
Using it
means that you can avoid an explosion in the number of products to manage in the database. If you
take the example above, it is easier to manage a template with 15 variants in four different types
than 160 completely different products. This module is available in extra-addons.






The Sales ‣ Products menu gives you access to the definition of products and their templates and variants.


Tip

Consumables

In OpenERP, a consumable is a physical product which is treated like a stockable product, with the exception
that stock management is not taken into account by the system. You could buy it, deliver it or
produce it but OpenERP will always assume that there is enough of it in stock. It never triggers a
procurement exception.



Open a product form to see the information that describes it. The demonstration data show several types of products, which gives quite a good overview of the options.

Price lists (Sales ‣ Configuration ‣ Pricelists) determine the purchase and selling prices and
adjustments derived from the use of different currencies. The Default Purchase
Pricelist uses the product’s Cost Price field for the Purchase price to be calculated. The
Public Pricelist uses the product’s Sale Price field to calculate the Sales price in quotations.

Price lists are extremely flexible and enable you to put a complete price management policy in place.
They are composed of simple rules that enable you to build up a rule set for most complex situations:
multiple discounts, selling prices based on purchase prices, price reductions, promotions on product ranges and so on.

You can find many optional modules to extend product functionality, such as:


	membership : for managing the subscriptions of members of a company,








	product_electronic : for managing electronic products,








	product_extended : for managing production costs,








	product_expiry : for agro-food products where items must be retired after a certain
period,








	product_lot_foundry : for managing forged metal products.



All of the above modules are found in extra-addons, except for the membership and the product_expiry module.








提升销售能力

OpenERP provides many tools for managing relationships with partners. These are available through
the Sales menu.


Tip

CRM & SRM

CRM stands for Customer Relationship Management, a standard term for systems that manage client and
customer relations. SRM stands for Supplier Relationship Management, and is commonly used for
functions that manage your communications with your suppliers.



Through Customer Relationship Management, OpenERP allows you to keep track of:


	Leads

	Opportunities

	Meetings

	Phone Calls

	Claims

	Helpdesk and Support

	Fund Raising



OpenERP ensures that each case is handled effectively by the system’s users, customers and
suppliers. It can automatically reassign a case, track it for the new owner, send reminders by email
and raise other OpenERP documentation and processes.

All operations are archived, and an email gateway lets you update a case automatically from emails
sent and received. A system of rules enables you to set up actions that can automatically improve
your process quality by ensuring that open cases never escape attention.

As well as those functions, you have got tools to improve the productivity of all staff in their daily
work:


	an email client plugin for Outlook and Thunderbird enabling you to automatically store your emails and their attachments in the
Knowledge Management (previously Document Management System) integrated with OpenERP,

	interfaces to synchronize your Contacts and Calendars with OpenERP,

	sync your meetings on your mobile phone,

	build a 360° view on your Customer,

	integration with Google applications.



You can implement a continuous improvement policy for all of your services, by using some of the
statistical tools in OpenERP to analyze the different communications with your partners. With
these, you can execute a real improvement policy to manage your service quality.

The management of customer relationships is detailed in the second section of this book (see
part2-crm).




管理各种账本

The chapters in 管理你的账簿 in this book are dedicated to general and analytic accounting.
Following is a  brief overview of the functions to introduce you to this Business Application.

Accounting is totally integrated into all of the company’s functions, whether it is general,
analytic, budgetary or auxiliary accounting. OpenERP’s accounting function is double-entry and
supports multiple company divisions and multiple companies, as well as multiple currencies and
languages.

Accounting that is integrated throughout all of the company’s processes greatly simplifies the work
of entering accounting data, because most of the entries are generated automatically while other
documents are being processed. You can avoid entering data twice in OpenERP, which is commonly a
source of errors and delays.

So OpenERP’s accounting is not just for financial reporting – it is also the anchor-point for many
of the company’s management processes. For example, if one of your accountants puts a customer on
credit hold, then that will immediately block any other action related to that company’s credit (such
as sales or delivery).

OpenERP also provides integrated analytical accounting, which enables management by business
activity or project and provides very detailed levels of analysis. You can control your operations
based on business management needs, rather than on the charts of accounts that generally meet only
statutory requirements.

OpenERP has added a flexible, easy Invoicing module allowing you to keep track of your documents and payments, even when you are not an accountant. This will allow smaller businesses to keep track of their payments without having to implement a complete accounting system.

Keep track of your Cash Moves by using the new OpenERP Cash Box.




管理提升员工士气

OpenERP’s Human Resources Management Business Application provides functionality such as:


	Manage your Employees, Contracts & Staff Performance,

	Talent Acquisition,

	Keep track of Holidays and Sickness Leaves,

	Manage the Evaluation Process,

	Keep track of Attendances & Timesheets,

	Track Expenses.



Most of these functions are provided from optional modules whose name starts with hr_ rather than the core hr module, but they are all loaded into the main Human
Resources menu.

The different issues are handled in detail in the fourth part of this book 有效的运营管理, dedicated to internal
organization and to the management of a services business.




掌控项目管理

OpenERP’s project management tools enable you to define tasks and specify requirements for those tasks, efficient allocation of resources to the requirements, project planning, scheduling and automatic communication with partners.

All projects are hierarchically structured. You can review all of the projects from the menu Project ‣ Projects. Then select Gantt view to obtain a graphical representation of the project.


[image: ../../../_images/project_gantt.png]
Project Planning



You can run projects related to Services or Support, Production or Development – it is a universal
module for all enterprise needs.

Project management is described in 很棒的项目管理.




掌控销售管理

The Sales menu gives you roughly the same functionality as the
Purchases menu – the ability to create new orders and to review the
existing orders in their various states – but there are important differences in the workflows.

Confirmation of an order triggers the delivery of goods, and invoicing timing is defined by a
setting in each individual order.

Delivery charges can be managed using a grid of tariffs for different carriers.




掌控采购管理

Purchases enables you to track your suppliers’ price quotations and convert them into
Purchase Orders as you require. OpenERP has several methods of monitoring invoices and tracking
the receipt of ordered goods.

You can handle partial deliveries in OpenERP, so you can keep track of items that are still to be
delivered on your orders, and you can issue reminders automatically.

OpenERP’s replenishment management rules enable the system to generate draft purchase orders
automatically, or you can configure it to run a lean process, driven entirely by current production
needs.

You can also manage purchase requisitions to keep track of quotations sent to a multitude of suppliers.




优化仓库管理

The various sub-menus under Warehouse together provide operations you need to manage stock.
You can:


	define your warehouses and structure them around locations you choose,

	manage inventory rotation and stock levels,

	execute packing orders generated by the system,

	execute deliveries with delivery notes and calculate delivery charges,

	manage lots and serial numbers for traceability,

	calculate theoretical stock levels and automate stock valuation,

	create rules for automatic stock replenishment.



Packing orders and deliveries are usually defined automatically by calculating requirements based on
sales. Stores staff use picking lists generated by OpenERP, produced automatically in order of
priority.

Stock management is, like accounting, double-entry. So stocks do not appear and vanish magically
within a warehouse, they just get moved from place to place. And, just like accounting, such a
double-entry system gives you big advantages when you come to audit stock because each missing item
has a counterpart somewhere.

Most stock management software is limited to generating lists of products in warehouses. Because of
its double-entry system, OpenERP automatically manages customer and suppliers stocks as well, which
has many advantages: complete traceability from supplier to customer, management of consigned stock,
and analysis of counterpart stock moves.

Furthermore, just like accounts, stock locations are hierarchical, so you can carry out analyses at
various levels of detail.




提升生产能力

OpenERP’s production management capabilities enable companies to plan, automate and track manufacturing and product assembly. OpenERP supports multi-level bills of materials and lets you substitute sub-assemblies dynamically, at the time of sales ordering. You can create virtual sub-assemblies for re-use on several products with phantom bills of materials.


Note

BOMs, Routing, Workcenters

These documents describe the materials that make up a larger assembly. They are commonly called
Bills of Materials or BOMs.

They are linked to routings which list the operations needed to carry out the manufacturing or
assembly of the product.

Each operation is carried out at a workcenter, which can be a machine or a person.



Production orders based on your company’s requirements are scheduled automatically by the system,
but you can also run the schedulers manually whenever you want. Orders are worked out by calculating
the requirements from sales, through bills of materials, taking current inventory into account. The
production schedule is also generated from the various lead times defined throughout the system, using the same
route.

The demonstration data contain a list of products and raw materials with various classifications
and ranges. You can test the system using this data.




随时随时分享各种管理文档

OpenERP integrates a complete document management system that not only
carries out the functions of a standard DMS, but also integrates with all
of its system-generated documents such as Invoices and Quotations. Moreover, it
it keeps all of this synchronized. You can define your own directory structure and tell OpenERP to automatically store documents such as Invoices in the DMS.

OpenERP provides an FTP Interface for the Document Management System. You will not only be able to access documents from OpenERP, but you can also use a regular file system with the FTP client.
FTP is just a way of getting access to files without needing to use an OpenERP client, to allow you to access files from anywhere.
You can also add documents to be stored in OpenERP directly through the FTP system in the corresponding OpenERP directory. These documents will automatically be accessible from the form concerned in OpenERP.

The Knowledge system is also well-integrated with e-mail clients such as Thunderbird and Outlook. It also allows you to sync your calendars (CalDAV).




衡量您的业务性能

To measure your business performance OpenERP, provides two interesting features:


	Dashboards

	Statistical Reports



On a single page, Dashboards give you an overview of all the information that is important to you.
In OpenERP, each application has its own dashboard which opens by default when you select the specific application.
For example, Administration Dashboard will open when you click the Administration menu.


Note

Dashboards

Unlike most other ERP systems and classic statistic-based systems,
OpenERP can provide dashboards for all system users, and not just managers and accountants.

Each user can have his own dashboard, adapted to his needs,
enabling him to manage his own work effectively.
For example, a developer using the Project Dashboard can see information such
as a list of open tasks, tasks delegated to him and an analysis of the progress of
the relevant projects.



Dashboards are dynamic, letting you navigate easily around the entire information base.
Using the icons above a graph, for example, you can filter the data or zoom into the graph. You can
click any element of the list to get detailed statistics on the selected element.

Dashboards can be customized to fit the needs of each user and each company.


Note

Creating or Customizing Dashboards

OpenERP contains a Dashboard Editor. Create your own dashboard to fit your
specific needs in only a few clicks. Go to the Administration ‣ Customization ‣ Reporting ‣ Dashboard Definition menu to define your own dashboard.



The Statistical Analysis is one of the crucial thing for decision making process in any business. OpenERP provides
Statistical Reports for each application. For example, you can access the statistical analysis of Sales-related information
from the menu Sales ‣ Reporting ‣ Sales Analysis. You can search and group the data using this
Statistical Report.




工艺流程跟踪

Many documents have a workflow of their own, and also take part in cross-functional processes.
Take a document that could be expected to have a workflow, such as a Sales Order, and
then click the ? button above its form to see the full process.


[image: ../../../_images/guided_tour_process.png]
Process for a Sales Order



You can see where a particular document is in its process, if you have selected
a single document, by the solid bar on one of the process nodes. You also link
to documents and menus for each of the stages.

There is a clear distinction between a cross-functional process (that is currently only
shown in the web client) and the detailed document workflow (that is shown in both the
web client from a process node, and the GTK client from the
Plugins > Execute a Plugin... menu and clicking either
the Print Workflow or the Print Workflow (Complex) option.


[image: ../../../_images/purchase_workflow.png]
Workflow for a Purchase Order



Alongside the document management system, the process visualization features make OpenERP
far better for documentation than similar systems.




还不满足？

You have been guided through a brisk, brief overview of many of the main functional areas of OpenERP.
Some of these – a large proportion of the core modules – are treated in more detail
in the following chapters.

You can use the menu Administration ‣ Modules ‣ Modules
to find the remaining modules that have been loaded into your installation but
not yet installed in your database. Some modules have only minor side-effects to OpenERP (such as
google_maps), some have quite extensive effects (such as the various charts of accounts), and
some make fundamental additions.

But there are now more than hundred modules available. You can install them according to your needs.

A brief description is available for each module, but the most thorough way of understanding their
functionality is to install one and try it. So, pausing only to prepare another test database to try
it out on, just download and install the modules that appear interesting.




提示与技巧


快捷键概述


	OpenERP 的快捷键









	Shortcut Key
	What does it do?




	Ctrl+H
	Contextual Help


	Ctrl+O
	Connect


	Ctrl+Q
	Quit






	OpenERP 表单的快捷键









	Shortcut Key
	What does it do?




	Ctrl+D
	Delete


	Ctrl+F
	Find


	Ctrl+G
	Go To Resource ID


	Ctrl+L
	Switch to List/Form


	Ctrl+N
	New


	Ctrl+P
	Preview in PDF


	Ctrl+Page Down
	Next Tab


	Ctrl+Page Up
	Previous Tab


	Ctrl+R
	Reload/Undo


	Ctrl+S
	Save


	Ctrl+T
	Menu


	Ctrl+W
	Close Tab


	Page Down
	Next


	Page Up
	Previous


	Shift+Ctrl+D
	Duplicate


	Shift+Ctrl+H
	New Home Tab


	Shift+Ctrl+Y
	Repeat latest action






	Shortcuts for OpenERP when editing a resource in a popup window









	Shortcut Key
	What does it do?




	Ctrl+Enter
	Save and Close window


	Ctrl+Esc
	Close window without Saving






	Shortcuts in a relation field









	Shortcut Key
	What does it do?




	F1
	Add new Field/Line on the fly


	F2
	Look up information


	F3
	Zoom on current field






	Shortcuts in text entries









	Shortcut Key
	What does it do?




	Ctrl+C
	Copy selected text


	Ctrl+V
	Paste selected text


	Ctrl+X
	Cut selected text


	Enter
	Auto-complete text field


	Shift+Tab
	Previous editable widget


	Tab
	Next editable widget








过滤器

The Advanced Search View is a new feature of OpenERP v6 which provides a very user-friendly filtering mechanism
for the end user to easily look up desired records from the list.

The perfect example of an advanced search view is the Statistical Report of OpenERP.
Such a report shows the statistical summary with filtered results to the end user.

Usually an Advanced Search is composed of three elements, the Filter buttons at the top, the Extended Filters, and the Group by option.
These filters are dynamic, so according to filters you apply, extra columns may be added to the view.

You can also easily combine filters; an arrow will be displayed and you will get a structure according to the order in which you clicked the Filter buttons.

Let’s show an example.
The statistical report for project tasks is Task Analysis which can be displayed using the
menu Project ‣ Reporting ‣ Tasks Analysis when you have installed the Project Management module.


[image: ../../../_images/filter_task_analysis.png]
Task Analysis



You can see the Advanced Search View in the light green shaded area.

You can filter the information of a task according to the Group by features.

Click, for instance, the Stage button in Group by, and then click Task to analyse your tasks by stage and then by task.

This Advanced Search View can also be attached to any List View of an object and hence increase the
search facility when a user looks up the record in list view.


[image: ../../../_images/filter_task_list_view.png]
Search the Tasks which are `In Progress` with Group by Project and State
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如何应用到你的业务中?


Now that you have discovered some of the many possibilities of OpenERP from a tour of the
demonstration database, you will develop a real case. An empty database provides the starting point
for testing a classic workflow from product sales to purchase,
completing your guided tour and your getting familiar with OpenERP.


A database loaded with demonstration data is very useful to understand OpenERP’s general
capabilities. But to explore OpenERP through a lens of your own company’s needs, you should start
with an empty database. You will work in this chapter on a minimal database containing no
demonstration data, so that there is no confusion about what you created. You will keep the
database you have created, to allow you to build on it throughout the rest of this book
if you want to.

You will develop a real case through the following phases:



	Specify a real case;

	Describe the functional needs;

	Configure the system with the essential modules;

	Carry out the necessary data loading;

	Test the system with your database.






The case is deliberately simple to provide you with a foundation for the more complex
situations you might have to handle in your company. Throughout this chapter, we assume that you access OpenERP through its web interface. And it is also assumed (as in the rest of this book) that you are using the latest download of OpenERP version 6, the stable production version at the time of writing (not the trunk version, which is likely to have new and potentially unstable features).



	业务案例

	基本设置

	让你的数据库在没有演示数据的情况下运行起来

	满足你的需求

	帐套配置
	配置会计科目
	科目类型

	科目

	属性





	配置账簿

	配置公司信息

	新建业务伙伴,伙伴分类及伙伴联系人

	新建商品信息及其分类

	配置库位信息

	设置会计科目表

	备份数据库帐套





	优化 采购/销售 业务流程
	采购

	收货

	开票管理

	支付货款

	商机产生销售

	发货备货

	进销存

	客户收款
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业务案例

在本案例中,你要配置系统以达成以下目的:


	从供应商处购买产品,

	在仓库中暂存产品,

	将产品出售给客户.



系统将完成发票到支付的各个业务.




基本设置

在本案例中, 你需要定义下面的这些数据:


	供应商以及该供应商的分类,

	客户以及该客户的分类,

	几个产品以及这些产品的分类定义,

	一次盘点,

	一张采购单,

	一张销售单,

	各种发票,

	各种支付单.



要完成本次测试, 你需要创建至少一个 供应商, 客户, 产品, 仓库, 财务科目表 和 银行帐号 .




让你的数据库在没有演示数据的情况下运行起来

Use the technique outlined in 数据库的创建 to create a new database, openerp_ch03 . This
database will be free of data and contain the least possible amount of functionality as a starting
point. You will need to know your super administrator password for this – or you will have to find
somebody who does have it to create this seed database. You will not be able to use the openerp_ch01  or openerp_ch02  databases that you might have created so far in this book
because they both contain demonstration data.

在新 启动 页面, 点击下面的 管理帐套 并在新窗体中点击 创建帐套 完成财套的新建操作. 创建一个干净的帐套 :


	超级管理员密码 : 默认密码为 admin 

	新帐套名称 : openerp_ch03 ,

	载入演示数据 勾选框: 不勾选 (不勾选很重要, 很多人豆是这步搞错老.),

	默认语言 : English (US) ,

	管理员密码 : admin (这个密码就是你后面登陆OpenERP的管理员密码,请牢记,并设置复杂一些),

	重复密码 : admin .




[image: ../../../_images/openerp_ch03.png]
创建一个干净的帐套



在 新帐套配置从头开始 - 第一步 界面点击 新建 按钮.


[image: ../../../_images/openerp_ch03_s1.png]
新帐套配置从头开始 - 第一步



使用 帐号 admin  以及前面创建帐套时你设置的密码 登陆帐套 openerp_ch03 后, 会弹出帐套配置向导,你可以有两个选择:


	如果你点击开始设置按键, OpenERP将会让你操作以下几步: 设置你的界面 -这一步选择默认的 简单 (另外一个选项是``拓展``); and 设置公司信息 - 输入 公司名 选择一个适合你公司的 币种.
接下来OpenERP将会根据设置中选项的功能，相应安装一些程序 Configuring a database with other applications and functionality when you select Extended view option :




[image: ../../../_images/openerp_ch03_config.png]
Configuring a database with other applications and functionality when you select Extended view option




	或者 -




	点击 跳过向导 进入页面 Starting the minimal database , 你就可以开始使用这个最小化安装的帐套了.




[image: ../../../_images/openerp_ch03_start.png]
Starting the minimal database






满足你的需求

Functional needs can be provided by core modules from OpenERP. You just have to decide which functionality
you want in your system. Click the Check Box of the corresponding application in the Configuration Wizard with the Simplified view option.

For this instance, we need the following applications:


	仓库管理 ( stock 模块),

	财务与会计 ( account 模块),

	采购管理 ( purchase 模块),

	销售管理 ( sale 模块).



To get OpenERP to install these business applications, the Configuration Wizard should look as follows:


[image: ../../../_images/openerp_feature.png]
Configuration Wizard with the Simplified view option



在弹出配置会计一览表的时候, 点击 跳过 按钮. OpenERP 就进入默认已安装模块图标列表页面.


[image: ../../../_images/openerp_ch03_main.png]
Database with all required functionality for this example



If you want to reconfigure your system, then click the Reconfigure link that appears in the header of Database with all required functionality for this example.
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帐套配置

You will create all the elements in the database that you need to carry out the use case. These are
specified in the functional requirements.


配置会计科目

You need to start off with a minimal set of accounts, and to do that you will need a couple of
account types. You can structure your accounts into a chart at any time (and, in fact, you can
structure them into several additional charts at the same time as you will see in the chapter
一步一步配置会计), so you do not need to be concerned unduly about structure.


科目类型

Create account types using Accounting ‣ Configuration ‣
Financial Accounting ‣ Accounts ‣ Account Types and then clicking the
New button. You will need the following four types, the first of which is shown
in figure New Account Type.


Defining Account Types







	科目类型
	类型CODE
	P&L / BS Category
	Deferral Method




	View
	view
	/
	None


	Income
	income
	Profit & Loss (Income Accounts)
	Unreconciled


	Expense
	expense
	Profit & Loss (Expense Accounts)
	Unreconciled


	Cash
	cash
	Balance Sheet (Assets Accounts)
	Balance






[image: ../../../_images/openerp_ch03_acctype.png]
New Account Type






科目

新建科目 Accounting ‣ Configuration ‣
Financial Accounting ‣ Accounts ‣ Accounts and then clicking the
New button.

You need accounts to handle the purchase and sales orders that have not yet been paid,
two more for the receipt and shipping of goods, and one for the payment and receipt of funds.
And one ‘organizing’ account that is just a view of the other five. So
you will need the following six accounts, one of which is shown
in New Account.


Defining Accounts









	Name
	Code
	Internal Type
	Parent
	Account Type
	Reconcile




	Minimal Chart
	0
	View
	
	View
	unchecked


	Payable
	AP
	Payable
	0 Minimal Chart
	Expense
	checked


	Receivable
	AR
	Receivable
	0 Minimal Chart
	Income
	checked


	Cash
	C
	Liquidity
	0 Minimal Chart
	Cash
	unchecked


	Purchases
	P
	Regular
	0 Minimal Chart
	Expense
	unchecked


	Sales
	S
	Regular
	0 Minimal Chart
	Income
	unchecked






[image: ../../../_images/openerp_ch03_accts.png]
New Account



The Account Type entry is taken from the list of types that you just created.
Although it looks a bit like a text box, it does not behave in quite the same way.
A single Del or Backspace keystroke is all you need to delete the whole text,
and when you type the name (or part of the name), you still need to associate that text
with the entry by clicking the Search icon to the right of the field.




属性

You now define some default properties, so that you do not have to think about
which account is used for which transaction every time you do something.
The main new properties are the four that associate accounts payable and receivable
to partners, and expenses and income to product categories.

Create properties using Administration ‣ Configuration ‣
Parameters ‣ Configuration Parameters and then clicking the New button.
You may have switch to Extended view to be able to access this menu.


Defining Properties







	Name
	Field
	Type
	Value




	property_account_payable
	Account Payable
	Many2One
	(account.account) AP Payable


	property_account_receivable
	Account Receivable
	Many2One
	(account.account) AR Receivable


	property_account_expense_categ
	Expense Account
	Many2One
	(account.account) P Purchases


	property_account_income_categ
	Income Account
	Many2One
	(account.account) S Sales






Tip

Mistakes in configuring accounts and properties

It is easy to make mistakes in configuring accounts and their properties, but the consequences
are not immediately obvious. You will mostly discover mistakes when trying to make a Purchase or
Sale Order (see later, for example, 采购), where the accounts are required fields or,
if you are diligent, when you set up Partners.

If you configure them correctly at this stage, then fields will be completed automatically and you will
never know a thing. If you do not configure all this correctly, then you will not be able to save the
order form until you have corrected the problem or until you manually set the accounts.

Since this configuration is quite tedious, you would do best by finding a certified Chart of Accounts
that has already been set up to meet your needs, if you can find one.








配置账簿

You will also need to configure some journals, which are used to record the transactions from one account
to another when invoices are raised and then paid. Create journals from the menu
Accounting ‣ Configuration ‣
Financial Accounting ‣ Journals ‣ Journals and then click the New button.


Defining Journals










	Journal Name
	Code
	Type
	Display Mode
	Entry Sequence
	Default Debit Account
	Default Credit Account




	Purchase Journal
	PUJ
	Purchase
	Sale/Purchase Journal View
	Purchase Journal
	P Purchases
	P Purchases


	Sale Journal
	SAJ
	Sale
	Sale/Purchase Journal View
	Sale Journal
	S Sales
	S Sales


	Bank Journal
	BNK
	Cash
	Cash Journal View
	Account Journal
	C Cash
	C Cash






Tip

Mistakes in configuring journals

It is easy to make mistakes in configuring the journals, too, and the consequences
are also not immediately obvious. You will mostly discover mistakes when creating an invoice
(which happens at different points in the process, depending on your configuration).
In this example, validating a Purchase Order creates a draft invoice
(see later, again for example, 采购), where a journal is required.

As with accounts and properties, if you configure them correctly at this stage, then
the fields will be completed automatically and you will never know a thing.
If you do not configure all this correctly, then there will be errors with the
order form or corresponding draft invoice,
until you have corrected the problem or until you manually set the journal.






配置公司信息

In case you had chosen to Skip Configuration Wizards when you first created the database, you may configure your company information in the following manner.
Start configuring your database by renaming the Main Company from its default of OpenERP S.A.  to the name of your own company or (in this case) another example company. When you
print standard documents such as quotations, orders and invoices you will find this configuration
information used in the document headers and footers.

To do this, click Sales ‣ Address Book ‣ Customers and click the name of the only company
there, which is OpenERP S.A. . This gives you a read-only form view of the company, so
make it editable by clicking the Edit button to the upper left of the form.


Tip

Editable form in the web interface

When toggling from the list view to the form view of an item, you can generally click its name in
the list view to show a non-editable view, or the pencil icon by the left-hand edge of the line to
open it in an editable view. You can toggle between editable and non-editable once you are in form
view.



Change the following:


	Name : Ambitious Plumbing Enterprises ,

	Contact Name : George Turnbull .



Before you save this, look at the partner’s accounting setup by clicking the tab
Accounting. The fields Account Receivable and Account Payable
have account values in them that were taken from the account properties you just created.
You do not have to accept those values: you can enter any suitable account you like at this stage,
although OpenERP constrains the selection to ones that make accounting sense.

Back at the first tab, General, change any other fields you like,
such as the address and phone numbers, then Save. This
changes one Contact for the Partner, which is sufficient for the example.

From the MAIN MENU, click Administration ‣ Companies ‣ Companies
and edit the only entry there:


	Company Name : AmbiPlum ,

	Partner : should already show Ambitious Plumbing Enterprises ,

	Report Header : Ambitious Plumbing ,

	Report Footer 1 : Best Plumbing Services, Great Prices ,

	Report Footer 2 : Ambitious – our Registered Company Details .



Figure Changing company details shows the effect of this.
You can also change various other company-wide parameters for reports and scheduling in the other tabs,
and you can upload a company logo of a specific size for the reports. Click Save to store this.


[image: ../../../_images/openerp_ch03_co.png]
Changing company details



You can leave the currency at its default setting of EUR for this example. Or you can
change it in this Company and the two default Pricelists (Sales ‣ Configuration ‣ Pricelists ‣ Pricelists) if you feel compelled to do that.


Note

Currency

The examples in this book are in USD and EUR. You, the reader, could use your home currency
(perhaps CAD, CNY, GBP, or Rs) in their place.






新建业务伙伴,伙伴分类及伙伴联系人

You will now create a suppliers category and a customers category. Partner categories are useful for
organizing groups of partners but have no special behavior that affects partners, so you can assign
them as you like. Then you will define one supplier and one customer, with a contact for each.

To do this, use the menu Sales ‣ Configuration ‣ Address Book ‣ Partner Categories and
click New to open a new form for defining Partner Categories.
Define the two categories that follow by just entering their Category Name and saving
them:


	Suppliers ,

	Customers .



Then create two partners from the menu Sales ‣ Address Book ‣ Customers. Click on the
New button to open a blank form and then add the following data for the first partner
first:


	Name : Plumbing Component Suppliers ,

	Customer checkbox : unchecked ,

	Supplier checkbox : checked ,

	Contact Name : Jean Poolley ,

	Address Type : Default ,

	add Suppliers  to the Partner Categories field by selecting it from the Search Partner Categories list,

	then save the partner by clicking the Save button.



Figure New Partner Form shows the result.


[image: ../../../_images/openerp_03_part.png]
New Partner Form




Note

Contact Types

If you have recorded several contacts for the same partner you can specify which contact is used for
various documents by specifying the Address Type.

For example the delivery address can differ from the invoice address for a partner. If the Address
Types are correctly assigned, then OpenERP can automatically select the appropriate address
during the creation of the document – an invoice is addressed to the contact that has been assigned
the Address Type of Invoice, otherwise to the Default address.



For the second partner, proceed just as you did for the first, with the following data:


	Name : Smith and Offspring,

	Customer checkbox : checked,

	Supplier checkbox : unchecked,

	Contact Name : Stephen Smith,

	Address Type : Default,

	add Customers  in the Categories field,

	Save the form.



To check
your work, you can go to the menu Sales ‣ Configuration ‣ Address Book ‣ Partner Categories
and click on each category in turn to see the companies in the category.


Note

Multiple Partner Categories

If this partner was also a supplier, then you would add Suppliers to the categories as well, but there is
no need to do so in this example. You can assign a partner to multiple categories at all levels of
the hierarchy.






新建商品信息及其分类

Unlike partner categories and their assigned partners, product categories do have an effect on the
products assigned to them – and a product may belong to only one category. Under the main menu link
Warehouse or Sale, select the menu
Configuration ‣ Products ‣ Products Categories and click New to get
an empty form for defining a product category.

Enter Radiators  in the Name field. You will see that other fields, specifically those
in the Accounting Properties section, have been automatically filled in with values of
accounts and journals. These are the values that will affect products – equivalent fields in a
product will take on these values if they, too, are blank when their form is saved.
Click Save.


Note

Property Fields

Properties have a rather unusual behavior. They are defined by parameters in the menus in
Administration ‣ Configuration ‣ Parameters ‣ Configuration Parameters,
and they update fields only when a form
is saved, and only when the fields are empty at the time the form is saved. You can manually
override any of these properties as you need.

Property fields are used all over the OpenERP system and particularly extensively in a multi-
company environment. There, property fields in a partner form can be populated with different
values depending on the user’s company.

For example, the payment conditions for a partner could differ depending on the company from which
it is addressed.




Note

UOM

UOM is an abbreviation for Unit of Measure. OpenERP manages multiple units of measure for each
product: you can buy in tons and sell in kgs, for example. The conversion between each category is
made automatically (so long as you have set up the conversion rate in the product form first).




Tip

Managing Double Units of Measure

The whole management of stock can be carried out with double units of measure (UOM and UOS – for
Unit of Sale). For example, an agro-food company can stock and sell ham by piece, but buy and value
it by weight. There is no direct relationship between these two units, so a weighing operation has to
be done.

This functionality is crucial in the agro-food industry, and can be equally important in
fabrication, chemicals and many other industries.



Now create a new product through the Warehouse or Sale menu:


	Go to Product ‣ Products and click New.

	Create a product – type Titanium Alloy Radiator in the Name field.

	Click the Search icon to the right of the Category field to select the
Radiators category.

	The Product Type field should be assigned as Stockable Product.
The fields Procurement Method, Supply method, Default Unit Of Measure,
and Purchase Unit Of Measure should
also stay at their default values.

	Enter 57.50 into the Cost Price
field and 132.50 into the Sale Price field.
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Product Form







	Click the Accounting tab, then click Save and observe that
Accounting Properties here remain empty. When product
transactions occur, the Income and Expense accounts that you have just defined in the Product
Category are used by the Product unless an account is specified here, directly in the product, to
override that.

	Once the product is saved, it changes to a non-editable state. If you had entered data
incorrectly or left a required field blank, an error message would pop-up, the form would have
stayed editable and you would need to
click from tab to tab to find a field colored red that would have
to be correctly filled in.






配置库位信息

Click Warehouse ‣ Inventory Control ‣ Location Structure to see the hierarchy of stock
locations. These locations have been defined by the minimal default data loaded when the database
was created. You will use this default structure in this example.

OpenERP has three predefined top-level location types , Physical Locations and Partner Locations
that act as their names suggest, and Virtual Locations that are used by OpenERP for its own purposes.


	From the Main Menu click on Warehouse ‣ Configuration ‣
Warehouse Management ‣ Locations to reach a list view of the locations (not the tree view).

	Click on the name of a location, such as Physical Locations/OpenERP S.A. to open a
descriptive form view. Each
location has a Location Type and a Parent Location that defines the hierarchical structure.
While you are here you should change
the location’s name to Ambitious Plumbing Enterprises , since it was named before you changed the
company name.

	From the Main Menu click Warehouse ‣ Configuration
Warehouse Management ‣ Warehouses to view a list of warehouses. There is only the one at the moment, which
should also be renamed from OpenERP S.A. to Ambitious Plumbing Enterprises .



A Warehouse contains an input location, a stock location and an output location for sold products.
You can associate a warehouse with a partner to give the warehouse an address. That does not have to
be your own company (although it can be); you can easily specify another partner who may be holding
stock on your behalf.


Note

Location Structure

Each warehouse is composed of three locations Location Input, Location Output, and
Location Stock. Your available stock is given by the contents of the Location Stock
and its child locations.

So the Location Input can be placed as a child of the Location Stock, which means
that when Location Stock is interrogated for product quantities, it also takes account of the
contents of the Location Input. Location Input could be used as a goods-in QC location.
The Location Output must never be placed as a child of Location Stock,
since items in Location Output, which can be considered to be
packed ready for customer shipment, should not be thought of as available for sale elsewhere.






设置会计科目表

You can set up a chart of accounts during the creation of a database, but for this exercise you will
start with the minimal chart that you created (just a handful of required
accounts without hierarchy, tax or subtotals).

A number of account charts have been predefined for OpenERP, some of which meet the needs of
national authorities (the number of those created for OpenERP is growing as various contributors
create and freely publish them). You can take one of those without changing it if it is suitable, or
you can take anything as your starting point and design a complete chart of accounts to meet your
exact needs, including accounts for inventory, asset depreciation, equity and taxation.

You can also run multiple charts of accounts in parallel – so you can put all of your transaction
accounts into several charts, with different arrangements for taxation and depreciation, aggregated
differently for various needs.

Before you can use any chart of accounts for anything, you need to specify a Fiscal Year. This
defines the different time periods available for accounting transactions. An initial Fiscal Year
was created during the database setup, so you do not need to do any more on this.
You can also create a Fiscal Year manually from Accounting ‣ Configuration ‣ Financial Accounting ‣ Periods ‣ Fiscal Years.

Click Accounting ‣ Charts ‣ Charts of Accounts to open a Chart of Accounts
form where you define exactly what you want to see.
Click Open Charts to accept the defaults and see a
hierarchical structure of the accounts.




备份数据库帐套

If you know the super-administrator password, make a backup of your database using the procedure
described in 管理数据库. Then restore it to a new database: testing .

This operation enables you to test the new configuration on testing  so that you can be sure
everything works as designed. Then if the tests are successful, you can make a new database from openerp_ch03 , perhaps called liveor  production, for your real work.

From here on, connect to this new testing  database logged in as admin  if you can.
If you have to make corrections, do that on openerp_ch03  and copy it to a new testing  database to continue checking it.

Or you can just continue working with the openerp_ch03  database to get through this
chapter. You can recreate openerp_ch03  quite quickly if something goes wrong and you cannot
recover from it but, again, you would need to know your super-administrator password for that.
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优化 采购/销售 业务流程

为了熟悉业务流程,下面我们以采购与销售两个业务做样例.

首先是采购业务,我们要达成下面的目的:



	从 元件供应商 那里以单价 56.00 采购 10 个 钛合金散热器 .

	做采购收货入库操作.

	做供应商采购发票.

	支付该发票.






然后,我们再做销售业务,以下面的数据为样例:



	向 客户 Smith and Sons 以单价 130.00/个 销售 6 个 钛合金散热器 .

	安排发货送货.

	开据客户发票.

	并做客户收款.







采购

要给供应商下达采购任务,菜单入口在 Purchases ‣ Purchase Management ‣ Purchase Orders 中文菜单项为 采购 ‣ 采购管理 ‣ 采购订单
点击 新建 按钮即可。

并填写采购订单中下面的字段:


	Supplier : Plumbing Component Suppliers .



当你选择了 供应商 后, 采购订单会自动完成该供应商的 地址 及 价格表 字段。

录入下面的数据:


	产品 : 钛合金散热器  - 在这里你可以按输入进行产品的模糊查询,当你输入一些产品名称关键词后按 Tab 键或者点击右侧的 放大镜 图标, 就会按给定的关键词弹出相关的产品查询结果窗口,供选择产品(前提是你已录入过相关产品的基础物料数据), 另外,如果你提供的查询只有一个结果时,系统会自动替你选择( Tab 键录入方式)。



当你在采购明细行选择一个产品后，OpenERP会自动将该产品的其他下面的信息带出来:


	单位 : 产品的默认采购单位,

	名称 : 产品的描述性名称,

	交货日期 : 采购预计交付时间,

	单价 : 产品的价格规则产生的默认采购价格,

	辅助核算项 : 当你设置了辅助核算默认项值，会自动带出来。(本例没有设置相关辅助核算),

	税 : applicable taxes defined in the partner, if specified, otherwise in the
product, if specified (there are not any in this example).



按上面的需求,修改采购订单中的数量及价格字段:


	数量 : 10.00.

	价格 : 56.00.



保存采购订单明细,点击 关闭 按钮关闭 明细 窗口. 点 保存 按钮, 可以保存数据并查看明细数据而不关闭窗口.

目前为止采购还仅是询价状态,现在你可以使用 采购经理或者 公司财务的角色 进到本采购单 点击 转换为采购单 的按钮, 批准该笔采购.

现在你点击 收货与发票 页签时，你可以看到收货地址是你所在公司 仓库 的 收货地址 。
并且系统已经自动为本次采购生成了草稿状态(还可以根据需要进行修改)的供应商发票。
因为目前为止还没有涉及财务部分，所以这个留到后面财务人员进行确认核准操作。




收货

在确认采购后,就需要等供应商送货,并按下面的操作进行收货操作:



	点开各个菜单项前的展开图标 仓库 ‣ 仓库管理 ‣ 收货 .









Note

From the Purchase Order

You could have clicked the Receptions link to the right of the Purchase Order
to reach the same screen, but this would confuse the purchasing role with the
stores role. That link is very useful during testing and training, however.







	When the Incoming Shipments window appears, select the name of the entry in the list
(IN/00002)   to display the Packing List itself – you would usually do a search for the supplier name
or order number in a list that was larger than this – then click Process to load the
Process Document form.

	Click Validate to indicate that you are receiving the whole quantity of 10 units.






当你收货确认这一刻,你应该可以在对应库存查询到公司该产品的相应库存量了. 恭喜恭喜...

使用菜单 采购 ‣ 产品 ‣ 产品 你可以找到产品 钛合金散热器 实物库存和虚拟库存数量为10.0了。 单击该产品进入到产品 表单 页后,在右面最右侧的 按库位查看库存 链接可以直接查看该产品在各个物理库位与虚拟库位的数量分布情况。点击 库位库存概要 报表就可以查看到各库位各产品的详细库存情况。
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List of products and their stock levels




Tip

复式记帐的物流管理

OpenERP operates a double-entry stock transfer scheme similar to double-entry accounting.
Because of this you can carry out various analyses of stock levels in your warehouse,
along with the corresponding levels in Partner Location at your Supplier.
The double-entry system, analogous to that of accounting, enables you to keep track
of stock movements quite easily, and to resolve any errors that occur.






开票管理

When you have received an invoice from your supplier (which would usually be sent to your Accounts department),
go to the menu Accounting ‣ Suppliers ‣ Supplier Invoices
to open a list of supplier invoices waiting for receipt.
These invoices enable your Accounts Department to match the price and quantities
ordered against the price and quantities on the supplier’s invoice (and since it is not uncommon to receive
an invoice showing details more favourable to the supplier than those agreed at the time of
purchase, this is a useful function).

In this example, you created an invoice automatically when you confirmed the supplier’s Purchase
Order. That is because the Invoicing Control  field on the order was set to From
Order(the default option). Other options enable you to create invoices at the time of
receiving goods or manually. The initial state of an invoice is Draft .

Now click the invoice for your order PO00001 to display its contents. You can compare the
goods that you have recorded there with the invoice received from your supplier. If there is a
difference, it is possible to change the order lines to, for example, add a delivery charge. Click
Validate to confirm the invoice and put it into the Open   state.

当发票核准时,系统会自动生成对应的会计凭证.这时打开 公司的会计科目一览表( 会计 ‣ 表 ‣ 科目一览表 ,
在 科目一览表 窗体中 点击 打开一览表 按钮,
你就可以看到对应的 材料采购 科目借方余额与 应付帐款 科目贷方余额 为 560.00 元.




支付货款

选择菜单 Accounting ‣ Suppliers ‣ Supplier Invoices and click on the Unpaid button
for a list of supplier invoices that have not yet been paid. 写PO00001在源文档文本本身发现发票。在实践中,你将会寻找发票通过订单号,或更普遍而言,他们的付款日期为发票接近。

在打开的供应商发票页面点击 支付发票 按钮, 打开 发票支付 窗体进行发票支付操作.

供应商 与 日期 会自动从发票获取. 你只需要选择 支付方式 并点击 核准 按钮即可.


Note

支付发票

这里描述的方法是为企业,不使用他们的会计系统付账单——
只是来记录他们

If you are using the account module with all its features, other, more efficient, methods let you manage payments,
such as entering account statements, reconciling paperwork, using tools for preparing payments,
interfacing with banks.



You can monitor the accounting impact of paying the invoice through the chart of accounts available
from the menu Accounting ‣ Charts ‣ Chart of Accounts. OpenERP
automatically creates accounting entries from the payment, and can reconcile the payment to the
invoice. You now have a new transaction that has debited the Payable account with 560.00 and
credited the Cash account.

If you look in Accounting ‣ Journal Entries ‣ Journal Entries you will see both
accounting transactions, one in each of the Purchase Journal and Bank Journal in
Draft state.




商机产生销售

In OpenERP, sales proposals and sales orders are managed using documents that are based on the
same common functionality as purchase orders, so you will recognize the following documents in general
but see changes to their detail and to their workflows. To create a new sales proposal, use the
menu Sales ‣ Sales ‣ Sales Orders and click on New button which creates a new order in a state of Quotation , then:



	Select the Customer Axelor . This has the effect of automatically
completing several other fields: Ordering Contact, Invoice Address,
Shipping Address, and the Pricelist Public Pricelist (EUR).  They are
all only defaults, so these fields can be modified as you need.

	Click the New button in Sales Order Lines section to open a Sales Order Lines window.

	Select the product Titanium Alloy Radiator . Although the Product field is not
itself required, it is used by OpenERP to select the specific product so that several other fields
can be automatically completed on the order line of the proposal, such as Description,
Unit of Measure, Unit Price, Procurement Method,
Delivery Lead Time, and Taxes.

	Change the Quantity (UoM) to 6 and the Unit Price to 130.00.
Then click Save & Close and the line appears on the quotation form.

	On the Other Information tab of this Sales Order, select a
Picking Policy of Complete Delivery and
Shipping Policy of Invoice on Order After Delivery from their dropdown menu lists.

	Return to the first tab Sales Order and validate the document by clicking
Confirm Order which calculates prices and the changes the order’s state from Quotation to In Progress as shown in screenshot Sales Order Form.
If you were in negotiation with the prospective customer,
you would keep clicking Compute and Save, keeping the document in Quotation state for as long as necessary.
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Sales Order Form







	In the last tab of the order History, you can see the Picking List
that has been created and you will be able to see any invoices that relate to this order when they are
generated.






Go to Sales ‣ Products ‣ Products to display a list of
products: just the one, Titanium Alloy Radiator , currently exists in this example. Its
Real Stock still shows 10.00  but its Virtual Stock now shows 4.00 to reflect the new future requirement of 6 units for dispatch.




发货备货

仓库管理员通过菜单项 仓库 ‣ 仓库管理 ‣ 送货单 可以列出当前待处理的送货单, 本例中, 你可以找到由前面的销售单而产生的送货单.


Tip

Running Schedulers

At the moment, your Sales Order is waiting for products to be reserved to fulfil it.
A stock reservation activity takes place periodically to calculate the needs,
which also takes customer priorities into account.
The calculation can be started from the menu
Warehouse ‣ Schedulers ‣ Compute Schedulers.
Running this automatically reserves products.

If you do not want to have to work out your stock needs but have a lean workflow you can install the
mrp_jit (Just In Time) module.



Although OpenERP has automatically been made aware that items on this order will need to be
dispatched, it has not yet assigned any specific items from any location to fulfil it. It is ready to
move 6.00 Titanium Alloy Radiators  from the Stock location to the Customers
location, so start this process by clicking
Check Availability. The Move line has now changed from the Confirmed  state to
the Available  state.

Then click the Process button to reach the Process Document window, where
you click the Validate button to transfer the 6 radiators to the customer.

To analyze stock movements that you have made during these operations, use
Warehouse ‣ Product ‣ Product and find this product, then click on the action
Stock by Location which is at the right most side to see that your stocks have reduced to
4 radiators and the generic Customers location has a level of 6 radiators.




进销存

Use the menu Accounting ‣ Customers ‣ Customer Invoices
to open a list of Sales invoices generated by OpenERP. If they are in the Draft state, it means that they do not yet have any presence in the accounting system. You will find a
draft invoice has been created for the order SO00008  once you have dispatched the goods
because you had selected Invoice on Order After Delivery .

Once you confirm an invoice, OpenERP assigns it a unique number, and all of the corresponding
accounting entries are generated. So open the invoice and click Validate to do that and
move the invoice into an Open  state with a number of SAJ/2011/001.

You can send your customer the invoice for payment at this stage. Click Print Invoice
to get a PDF document that can be printed or emailed to the customer.

You can also attach the PDF document to the OpenERP invoice record. Save the PDF somewhere
convenient on your PC (such as on your desktop). Then click the Add button to the top right of
the invoice form (it looks like a clipboard). Browse to the
file you just saved (record.pdf  if you did not change its name).
This gives you a permanent non-editable record of your invoice on the OpenERP system.

Review your chart of accounts to check the impact of these activities on your accounting. You will see
the new revenue line from the invoice.




客户收款

Registering an invoice payment by a customer is essentially the same as the process of paying a
supplier. 在菜单中 账户 ‣ 客户 ‣ 客户发票,
点击你想要设置为已付的发票名字:



	使用 Payment 按键打开一个`Pay Invoice`新窗口.

	选择 Payment Method, 在这个例子中使用 现金 then validate the entry.







[image: ../../../_images/familiarization_invoice.png]
发票表单



Check your Chart of Accounts as before to see that you now have a healthy bank balance in the Cash  account.
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开发新客户的管理
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管理地址簿

在OPENERP中，合作伙伴和联系人之间有什么区别呢？ 合作伙伴 代表一个与你有业务来往的个体 - 客户, 潜在客户, 甚至你公司的
员工.在其他CRM软件中, 合作伙伴也称为一个账户.
联系人 则代表合作伙伴中的个人.

每个合作伙伴可以有无数个联系人. Openerp同样允许一个合作伙伴有多个相同地址类型的联系人.比如，你可以轻松地链接多个开票地址
给一个客户.


Note

地址类型

如果你已经为相同的合作伙伴登记了多个联系人, 你能够通过指定 地址类型 告诉 OpenERP 用于哪种文档用哪个联系人（例如报价单）。

例如：, 合作伙伴(公司) 可以有一个发运地址以区别于公司的开票地址.
如果地址类型被正确指定, OpenERP 在创建单据的时候，能自动选择合适的地址 —- 发票地址被指派为 地址类型为 发票 ，
否则是默认地址。



OpenERP中合作伙伴的概念要比许多其他管理应用程序灵活得多. 为什么呢？? 因为合作伙伴可以同时是你的供应商和客户。
因此，你更新的任何数据将同时应用于客户和供应商! 多亏了这个,你不再需要为同样的合作伙伴更新您的地址簿几次(甚至在几个地方)。

合作伙伴表单包括了关于公司的信息, 比如公司名称，主要语言，公司是 客户 和/或 供应商 .
合作伙伴的表单由几个标签组成.


	一般 标签包括了合作伙伴不同联系人的信息, 邮政，通信和合作伙伴属于的分类,

	销售和采购 标签包括了诸如默认销售员、销售团队等信息，以及网站,

	日志 标签提供了该合作伙伴相关的完整 通信日志 (会议, 营销活动,
线索和商机, 电话访问, emails) . The events the partner has been involved in are created automatically by
different documents like phone calls, leads, meetings,

	the Notes tab is an area for free text notes.




[image: ../../../_images/crm_partner_hist.jpeg]
The History Tab of a Customer




创建和更新合作伙伴

在讲解如何创建合作伙伴之前，仅说两句OPENERP中合作伙伴不同的显示方式。
列表 视图显示客户列表(你点击客户菜单时的默认显示)。这种视图下，你可以同一时间查看到多个客户信息。
当你选择特定客户开始编辑，或者创建一个新客户时，则显示为 表单 视图。

创建一个新的合作伙伴(公司，客户，供应商 ...) 或者打开已存在的客户列表, 使用菜单 销售 ‣地址簿‣ 客户 Sales ‣ Address Book ‣ Customers .
这个菜单不仅可以创建新的合作伙伴，也可以用来查找合作伙伴.


[image: ../../../_images/crm_partner_default.jpeg]
客户表单




Note

必填项

蓝色区域是必填项, 意思就是必须在这里输入一个值。只要蓝色区域没有填写完成，就不能保存这次修改。



在合作伙伴表单上你至少要输入这个公司的 名字 。有些字段是文本字段，其他字段可能链接到别的地方已经填写过的数据, 比如 国家。

根据以下资料创建一个新的客户：


	名称 : Smith and Offspring,

	客户 选择框 : 勾选,

	供应商 选择框 : 不勾选,

	联系人名称 : Stephen Smith,

	类型 : 默认, 在邮政地址部分，

	保存 这个表单。




Tip

电子邮件

如果你要使用Email网关，OUTLOOK或者迅雷插件, 请不要忘记给每一个联系人登记Email地址， 那么这个网关就会把自动地接收到的邮件附给对应的合作伙伴.



更新合作伙伴信息， 打开对应的表单，选择 编辑 然后修改需要更新的字段。正如之前解释过的，当一个公司既是供应商又是客户时，你
只需要编辑一次这个合作伙伴表单，就会自动应用到供应商和客户上。


Note

选择框

为什么说在合作伙伴表单中正确地设置客户和供应商的选择框是很重要的呢? 这些选择框的设计是为了能让Openerp快速的选择那些
下拉框显示的合作伙伴。比如：当在一张销售报价单中你要选择一个合作伙伴时， Openerp只允许你在客户列表中选择.这正是客户
选择框的用处。






管理你的联系人和地址

一个合作伙伴可以有多个联系人。 联系人代表对方公司跟你联系的员工，
还有他们的详细地址。 你可以定义每个地址的类型 (默认, 开票, 送货, 联系  或者 其他)。

联系人信息记录在 客户 表单的 一般 选项中 ，或者地址列表中 销售 ‣ 地址簿 ‣ 地址 Sales ‣ Address Book ‣ Addresses 菜单。


Tip

Same Contact, Different Partners

你是否有联系人属于多个公司的， 并且需要链接到多个合作伙伴？ 查阅 一个管理联系人的替代方案 章节。






定制合作伙伴字段

OpenERP同样允许根据你的需要定义合作伙伴视图。如果你要添加字段，删除字段或者修改视图中的字段顺序，点击 管理视图 选项。

在 地址 表单视图中给联系人添加一个 生日 字段。要这样做, 转到 销售(Sales) ‣
地址簿(Address Book) ‣ 地址(Addresses) 菜单并打开任意一张表单视图。 在右侧菜单栏，点击 管理视图, 然后 编辑,因为相应的视图已经被选定。

Go to the last line of the view and click the blue plus (+) sign to add a field to the Communication group. Proceed as in the figure below, then click the Update button.


[image: ../../../_images/manage_views_addfield_small.jpeg]
联系人生日



In the Properties screen that appears, you can change the label to Birthday in the String field. To indicate that a new field can be used in the corresponding search view, make sure to select Always Searchable. Click the Update button to confirm your changes. Click Preview to see your result. The Birthday field will now appear in your Address form view, ready to be used.




根据客户执行动作

At the right side of the Customers list or form view, you will find a list of all of the reports, actions and links available for the selected partner(s). You can perform actions and print reports both from List and from Form view, List view allowing you to do actions for several partners at the same time.


Tip

Actions

To display the list of possible actions, just select one or more customers or click the arrow at the top of the right side bar.



You can create a new opportunity for a customer, or start a mass mailing. Mass mailings will usually be started from list view, because you will select several partners at a time.


Note

Campaigns

For mass mailings, you might prefer to use the Direct Marketing application, which offers great functionalities (please refer to chapter 开展营销活动).



Another action enables you to quickly send an SMS message.


Tip

发送手机短消息

你可以在 Clickatell™ http://clickatell.com 网站上注册后, 就可以在OpenERP 中使用发送手机短消息的功能了.

要给合作伙伴发送短消息, 需要先在合作伙们的列表页选择窿们,然后点击 短消息发送(SMS Send) 向导按钮
即可.






用过滤器查找合作伙伴

Open the Customers list view to discover the search options allowing you to easily filter your partners. You can group by Salesman to see which customers have already been assigned a salesman or not. Click the button at the right (the icon of the person) to see the customers you are responsible for.


Tip

Limit

If you want to display more than the 20 partners displayed by default, click the 1 to 20 of - XX option at the bottom of the screen to be able to change the limit.



Filters also allow you to quickly set lists of customers for which you want to do specific actions. Through the New Filter option, you can also add your own filters for any field related to the Customer form.


Note

Filters

You can easily create your own frequently used filters by prefiltering the data the way you want and then using the Save Filter option.






为合作伙伴分组

OpenERP uses categories to organize all of its partners according to their relationship with your company (customer, prospect, supplier, and so on). Each partner may be attached to several categories. To open the list of available partner categories, use the menu Sales ‣ Configuration ‣ Address Book ‣ Partner Categories.


[image: ../../../_images/crm_partner_category_big.png]
合作伙伴分类列表



点击合作伙伴分类结构中的一个分类时,会列出属于该分类下面的所有合作伙伴.如果你点的分类还有下级子分类时,属于下级子分类的
合作伙伴也会同样被列出来.


Note

Categories

To create a new category, go to the menu Sales ‣ Configuration ‣ Address Book ‣ Partner Categories and click the New button.



Because categories can be organized according to a tree structure, you can apply an action at any level of
the structure: a marketing promotion activity, for example, can be applied either to all customers,
or selectively only to customers in one category and its subcategories.

You can create your own categories and assign them to your partner from the Customer form. Another way of assigning the corresponding partner to a category is to open the category from the Partner Categories.

In the 客户分析挖掘 chapter, you will see how to assign partners to categories automatically using segmentation rules.




一个管理联系人的替代方案

According to your kind of business, the standard way of linking several contacts to one partner may not be flexible enough for you. You could perfectly well have the same employees working for several of your companies. Or maybe you work with representatives ensuring follow up of several of your customers. So you would want to have the same contact linked to different partners.

Of course, OpenERP provides an alternative, the base_contact module, which gives you even more flexibility in managing your contacts.

Easily share the same contact (an employee, for instance), who may perfectly have different jobs, with several partners. You only need to enter (or create) the contact once and link it to the partners concerned, while specifying the position the contact holds for each company in particular. Any changes to contact information only need to be made once for them to be applied to all partners the contact is related to!

We illustrate the concept of multiple relationships between contacts and partners (companies) through an example. The figure Advanced Contact Management shows two companies having several addresses (places of business) and several contacts attached to these addresses.

In this example you will find the following elements:


	The ABC bank has two places of business, represented by the addresses of ABC Belgium and ABC
Luxembourg,

	The addresses of Dexey France and Dexey Belgium belong to the Dexey company,

	At the office of ABC Luxembourg, you have the contacts of the director (D. Smith) and the
accountant (A. Doe),

	Mr Doe holds the post of accountant for ABC Luxembourg and Dexey France,

	Mr D. Smith is director of Dexey France and Dexey Belgium and we also have his private address
which is not attached to a partner.



An extra menu option will be added, allowing you to display the list of contacts, through Sales ‣ Address Book ‣ Contacts.

The screenshot below illustrates how contacts are handled with the advanced Contacts configuration.


[image: ../../../_images/crm_contact_with_latest.png]
Advanced Contact Management



This is a clear way to illustrate the complexities that may be accomplished in OpenERP.

If you correct or change a contact name in the contact form, the changes will be applied to all the posts occupied in the different companies.

The screen below represents a partner form. You can add several addresses, such as Invoice & Delivery, and a list of
contacts per address. Each contact has its own data, such as name, function, phone number and email.


[image: ../../../_images/crm_base_contacts.png]
Partner Form with the Advanced Contacts Management



Go to Sales ‣ Address Book ‣ Contacts to open a contact form.
You enter data in the contact form, containing information such as mobile phone, different functions occupied, and personal blog. You can also add a photo of your contact.
If you click the Functions and Addresses line, you will get more details about the job (such as start date, end date and fax).


[image: ../../../_images/crm_partner_poste.png]
Detail of a Position occupied by a Contact at a Partner
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管理线索

To define leads, imagine a bucket full of potential sales contacts expressing an interest in your company’s products.

A lead represents a potential customer with whom you have not established a relationship yet. Usually a lead contains valuable information to realise future sales opportunities. However, the most common mistake is that such key information too often gets lost, because it is registered nowhere. And even when registered, it might still be difficult to track any activity for that lead, because the information is not at hand when you need it.

Storing leads information in a central place such as OpenERP will release you of these worries.

So when would you create a lead in OpenERP, either manually or automatically? The following events could be a trigger:


	An inquiry email sent to one of your company’s generic email addresses, such as sales@mycompany.com, from the mailgateway,

	A business card from a prospective customer met briefly at an exhibition: you have to contact him
again to qualify the lead and to know if there is any possibility of a sales opportunity; registered manually,

	A database of potential customers in a given sector and region imported through a CSV file. The potential customers have to be
contacted again individually or through a mass mailing to determine which contacts require further follow-up,

	An interesting contact that you met during a business networking event. You have to qualify it before assigning a salesperson to the contact,

	A form completed on your website directly integrated into OpenERP using our webservice. Before converting the form
into a sales proposition or opportunity, you should read and handle the person’s request.



Employees in the marketing or presales department will usually work on leads. Once these leads will be converted into customers and/or sales opportunities, the sales department pays individual attention to each opportunity. Of course, before converting a lead into an opportunity, some qualification work has to be done.

OpenERP allows you to easily configure the way your company qualifies leads. You can create your own stages through Sales ‣ Configuration ‣ Leads & Opportunities ‣ Stages. Use the sequence number to determine the order of the stages, i.e. 10 for First Call, 20 for Renewing Contact and so on. Of course, you can also drag & drop a stage to another place to automatically change the order of all the stages. A salesman can change the status of the lead according to the response from the prospect and enter the result of this contact in the lead form (e.g. in the Notes field).

From the Sales ‣ Sales ‣ Leads menu, you can qualify each individual lead through the Stage field that is found up to the right of the lead definition. To move your lead automatically to the next step from the list of leads, you can use the button that looks like a green, right arrow.

Leads can be assigned to a Sales Team for easy follow-up (see  调整 OpenERP 适应你的销售组织). Each user can be added to a default sales team which can be specified in the User Preferences. When you define a tree structure for your sales teams, you can also escalate a lead to another sales team for further actions.


Note

线索与商机

Companies may decide to not use leads, but instead to keep all information directly in an opportunity. For some companies, leads are
merely an extra step in the sales process. You could call this extended (start from lead) versus simplified (start from
opportunity) customer relationship management.
OpenERP perfectly allows for either one of these approaches to be chosen. If your company handles its sales from
opportunities directly, feel free to move on to chapter 通过的商机优化你的销售周期, although most of the features explained below
also apply to opportunities.



In the next sections we will explain in more detail some examples of what Leads in OpenERP can be used for.


Tip

未找到 线索 菜单?

In  Simplified view, Leads will not be displayed. To see not also opportunities, but also leads, you should switch
to the Extended view. You can easily switch from Simplified to Extended view by changing your User Preferences through
the Edit Preferences button.




有效管理业务名片

Potential customers are usually entered as a lead in the system. This means that you do not create a
partner or a sales opportunity until you have qualified whether the lead is interesting or not.


Tip

Qualification

When a qualified lead requires further actions, you can turn the lead into a partner and, eventually, a sales opportunity.



To make a new lead, go to the Sales ‣ Sales ‣ Leads menu and click the New button. In the Lead form that opens, you can enter the contact data of this new potential customer and add notes.


[image: ../../../_images/crm_lead_new.png]
Creating a New Lead



You can also set the status of a lead according to the qualification work that has been carried out:


	Draft : the lead data have been entered, no work has been done yet and a salesperson has not
yet been assigned to the request,

	Open: the lead is being handled,

	Closed: the lead has been converted into a partner and/or a sales opportunity,

	Pending: the lead is waiting for a response from the potential customer,

	Escalate: the lead is escalated to the upper sales team in the tree structure for further actions,

	Cancelled: the lead has been cancelled because the salesperson has decided that it is not worth
following up.



A lead status can easily be changed, even from list view (the standard view when you start the Leads program). Simply click the green arrows to change the status of a lead.

On the Extra tab in the Leads form, you find statistics about days to open and close and more information about the campaign, the channel, and so on.


[image: ../../../_images/crm_lead_extra.jpeg]
Extra Tab



On the Communication & History tab in the Leads form, you can see a complete history of all actions regarding this lead. You can also add internal notes and change the status of a lead  while adding such a note.
Send an email directly from the lead simply by clicking the Send New Email button (to configure your email settings, please refer to chapter ch-crm-fetchmail-install.
You can add attachments to internal notes and emails you send to the prospect. You can customize your message and have the status changed after an email has been sent; you could automatically have the lead set to Pending, because you require a response from the customer before further actions can be taken.


[image: ../../../_images/crm_lead_comm.jpeg]
Communication & History Tab






导入线索数据库

You can also import a huge list of leads. That may be useful if you have bought a database of
potential prospects that you want to load into OpenERP to handle them all at the same time.

Start with a list of leads in CSV format, for instance. If your prospects database is provided in
another format, you can easily convert it to the CSV format using Microsoft Excel or OpenOffice Calc.


Tip

Import

The best thing to do to make sure your import will go smoothly, first export all the required Lead fields using the Export function,
and then edit the resulting csv file for import.



Open the Leads form using the menu Sales ‣ Sales ‣ Leads. In Other Options, click the Import link. (You can also import from List view, just open the action window on the right (by clicking the arrow) and in Other Options, click the Import link.)

Select your file containing the leads information and click Import File. OpenERP will automatically map the column headers from your CSV file to the corresponding fields in OpenERP. If necessary, you can click CSV Options to change the settings so that they match your local settings.


[image: ../../../_images/crm_lead_import1.jpeg]
Importing Leads into the System



Check the online chapter about system administration for more information on import and export on http://doc.openerp.com/v6.0/book/.


Tip

Various Imports

Importing and Exporting data in OpenERP is a generic function available to all resources.
So you can import and export such lists as partners, opportunities, accounting entries,
products and price lists.



Clearly there are other methods of generating leads automatically or semi-automatically:


	Through a Contact Form on your Website;

	Using the Outlook or Thunderbird plugin to insert new leads directly from the salesman’s mailbox when he sees promising emails,

	Using the email gateway for each incoming email from a certain address (such as
sales@mycompany.com) which may create a lead automatically from the contents of the email.



These different methods are described later in this book (see chapter 自动获取线索).




组织线索

To help the users organize and handle leads efficiently, OpenERP provides several features in the CRM to be used according to the needs of each:

Use the Sales ‣ Sales ‣ Leads view to organize your leads:


	Display a list of all the leads (qualified, open, not open, ...) according to the sales team you are linked to,

	Create a new lead by clicking New,

	Display Unassigned Leads, click the button next to the Salesman field,

	Display a list of all your leads you still need to handle (your open and draft leads),

	Display a list of all your leads that are waiting for a customer response (usually in Pending status). This enables you to check periodically on your work to do,

	Display a list of all the leads assigned to different salespeople,

	Use Extended Filters to display all the leads created today or during the last week, in a specific time period, and so on,

	Quickly find leads not yet assigned to a Campaign, by clicking the Group by button and then Campaign.



The sales manager can use this Leads view to easily keep track of what each salesperson is working on.


[image: ../../../_images/crm_leads_list.png]
List of Leads to be Handled



Leads can also be prioritized. Salespeople can assign a priority to their lead, and then start working on their leads from the top of the list, which is sorted by priority.




分析线索

OpenERP also offers statistical reports to keep track of your Lead Management. The Sales ‣ Reporting ‣ Leads Analysis report allows you to check various leads-related elements. You can look at processing delays, number of responses given and emails sent (if you use the email gateway feature). Sort your leads analysis by different groups to get accurate, grained analysis.

These are some analysis possibilities of the Leads Analysis report.


	Leads by State and per Month



To analyse the leads by status, group the leads by qualification level (Stage) and status (State), this can also be done for individual months (first group by Month).


	Leads by Origin



Analyse leads according to their state (open, lost, won) and their stage (e.g. cold / hot or new / qualification / ... ) and find out how many leads belong to each state / stage.


	How effective are your Campaigns?



Group by Campaign to easily find the number of leads by campaign and the total number of leads. You can also select a specific campaign in your filter.


	Leads by Priority.



Group by Priority to see which leads are hot, warm or cold.


[image: ../../../_images/crm_lead_analys.jpeg]
Leads Analysis
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通过的商机优化你的销售周期

While a lead represents the first contact with a prospect yet to be qualified, a sales opportunity represents a potential contract. Each opportunity has to be followed up by a salesperson (or sales team) spending time to qualify the opportunity, and this either by making a quotation or cancelling the opportunity.

Leads are generally handled by the dozen, with the automation of certain responses or emails.
Opportunities, on the contrary, are usually tracked one by one by the salespeople, because an opportunity involves a negotiation process with the customer to be.

Just like for leads, OpenERP provides specific features to handle sales opportunities efficiently. All opportunities can be found in the menu Sales ‣ Sales ‣ Opportunities.

With opportunities, you can manage and keep track of your sales pipeline by creating specific customer- or prospect-related sales documents to follow up potential sales. Information such as expected revenue, opportunity stage, expected closing date, communication history, next action date, next action, and much more can be stored.

Opportunities can be connected to the email gateway: new emails may create opportunities, each of them automatically gets the history of the conversation with the customer. You and your sales team(s) will be able to plan meetings and phone calls from opportunities, convert them into quotations, manage related documents, track all customer-related activities, and much more.


Tip

Attachments

By default, you can keep attachments in OpenERP to make sure all linked documents are directly accessible. At the right side
of the screen, under Attachments, click the Add button to start linking documents to your opportunity. With the Browse
button, you can search for the file to be attached in your directories. You can add attachments in the same way for leads,
for instance.
If you also want those documents to be indexed (not for pictures), you should install the Knowledge Application.




转换线索为客户或者商机

If the salesperson thinks that the lead has been well qualified and that there is a real opportunity, following the contact he had with the prospect, he can easily convert the lead into a partner / opportunity using the button Convert to Opportunity.

Clicking the Convert to Opportunity button offers several possibilities, allowing you also to avoid duplicate partners:


	You can decide to just create the opportunity and keep the contact data from the lead without creating a partner,

	You can convert to an opportunity, and create a new partner if it does not exist yet, or merge the contact with an existing partner,

	You first create a partner, and later you convert the lead to an opportunity.



To create only a partner, click the button Create next to the Customer field. You can also decide to add the contact data of the lead as a new contact to an existing partner.

OpenERP shows a window allowing you to select:


	whether you want to create a new partner,

	whether you want to link this contact to an existing partner (merge).



OpenERP opens a partner form containing the information from the lead. At this stage you can complete the contact details or add any other information for the partner.

The partner created is automatically attached to the lead, which enables you to keep complete traceability from the lead. To find this information, you should take a look at the Communication & History tab in the lead.

Instead, you can also combine the step of creating a partner and directly the lead converting into an opportunity through the Convert to Opportunity feature.


Tip

Convert to Opportunity

When you click the Convert to Opportunity button and the email address of the new contact is filled out, OpenERP will check whether
this email address corresponds to an email address of an existing partner. If so, OpenERP will directly propose to merge the new
contact with the partner found.



When you click the Convert to Opportunity button and the partner already exists, OpenERP opens a window allowing you to select:


	whether you want to create a new opportunity,

	whether you want to add this lead to an existing opportunity (merge).



OpenERP shows the title of the opportunity (taken from the lead description) and the partner.
Make sure to enter the estimated revenue and the success rate (probability) of converting to a sales.


[image: ../../../_images/crm_lead_convert.png]
Converting a Lead into a Sales Opportunity




[image: ../../../_images/crm_opport_data.jpeg]
From Lead to Opportunity: Details






调整 OpenERP 适应你的销售组织

Your sales organization may be composed of several groups which for instance address different customer segments or geographies, sell different products and services and often manage different sales cycles.  As a manager you will want to track the performance not only for each individual but also for each group.

OpenERP allows you to do that by defining Sales Teams. A sales team is a group of sales people who are performing a similar position. Implementing sales teams is a powerful tool. It allows you to:


	Assign leads or opportunities according to their nature to a sales team first. Then according to the company’s policy, the opportunities can be assigned to a given individual. For example opportunities can be assigned to a Western Region sales team or Eastern Region sales team in the first place according to their location. Each sales person may pick unassigned opportunities in his sales team according to his availability,

	You can group your sales teams according to a tree structure (hierarchy). This allows you to have a view of your sales activity at different granular levels (local, regional, national for instance),

	Some sales teams may manage their opportunities through different sales cycles. For instance a car dealership which addresses both the residential and corporate customers, will have different sales cycles.

	For each sales team, you can assign a responsible user and an email address that will be used when creating or replying to emails from OpenERP. This will be proposed by default in OpenERP when you create an event for this customer.




Note

Sales Teams

To define your Sales Teams, go to Sales ‣ Configuration ‣ Sales ‣ Sales Teams.



Let us take the example of a bank to explain how you can define your sales teams. A bank has several departments, such as Insurance, Accounts, Assets, Credit Management. Each department may be divided into several subdepartments. For Insurance, this could be Group Insurance and Home Insurance. The hierarchical structure of your Sales Teams could then be as follows:


	
	Insurance Sales Team

	
	Group Insurance

	Home Insurance









	Accounts Sales Team



	Assets Sales Team



	Credit Management Sales Team








定义销售周期的关键步骤

Each company will have similar, yet customized stages to qualify opportunities.

To see & define stages for Opportunity qualification, go to Sales ‣ Configuration ‣ Opportunities ‣ Stages.

The key steps of your Sales Cycle are what OpenERP calls Stages. You can use the stages to improve your sales capacity, because they allow you to find out the reasons why deals succeed or fail.

Stages will allow salesmen to easily track where a specific opportunity is positioned in the sales cycle. One of the frequent difficulties in using stages is that different sales people may assess differently in which stage their sales opportunity should be. You can avoid this by clearly stating what you expect as a result for each stage. This way, your sales teams will use the same stages throughout the qualification process, allowing the sales manager to get accurate and consistent information. We also recommend to limit the number of stages in your sales cycle to make them easy to follow up.

As you progress in your sales cycle, and move from one stage to another, you can expect to have more precise information about a given opportunity. For example, when setting an opportunity as ‘Qualified’, you may decide that the salesman has to enter the “Expected Revenue” and the “Expected Closing Date.” You can also have the probability changed automatically when changing stages, by selecting the “Change Probability Automatically” checkbox. If checked, OpenERP will set the probability of the opportunity to the probability defined in the stage. If you set a probability of 0% (Lost) or 100% (Won), OpenERP will assign the corresponding stage when the opportunity is marked as Lost or Won.

As an example, to track your opportunities, you can assign the following stages to the sales team. For each stage, you assume you will define criteria that have to be met prior to moving to the next stage.


	Territory - Segment your opportunities into territories.

	Qualified – Attract the prospect’s interest, determine whether the prospect has a need.





	What is the expected result?

	
	The need to buy the product/service has been confirmed,

	Confirm that there is a budget.











	Qualified Sponsors – Ask the right questions and listen carefully to identify and thoroughly understand the prospect’s needs.





	What is the expected result?

	
	Current pain points identified,

	Identify what the prospect wants to achieve,

	Identify the decision-maker.











	Proposition – Discuss some solutions to determine the customer’s preferences, recommend specific solutions to answer the customer’s needs.





	What is the expected result?

	
	Demo and/or Proposal given,

	Decision maker confirmed his interest to purchase,

	Preliminary pricing confirmed/agreed upon.











	Negotiation – Submit the final proposal to the customer and begin the negotiation process.





	What is the expected result?

	
	Negotiation concluded,

	Contract terms/conditions agreed upon,

	Contract submitted for signature.











	Won/Lost – Register the final step of the opportunity.





	What is the expected result?

	
	Contract signed / not signed,

	Next steps.










You can apply your own stages throughout the qualification process by means of the Stage field that is found up to the right of the opportunity definition. To move an opportunity automatically to the next step, you can use the button that looks like a green, right arrow.
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Example of Opportunity Stages



OpenERP also has other sales configuration options; you can define your Campaigns, allowing you to keep track of the event your leads and opportunities refer to. Examples of campaigns are Google Adwords, an event you are hosting, a newsletter.
With Categories you identify your prospect’s needs (e.g. Needs Training, Needs OpenERP Online), while Channels help you to keep visibility on how the lead or opportunity entered the system (email, website, referred by an existing customer).




计划你下个动作

When a lead has been converted into an opportunity, the latter can be assigned to any salesperson. You might designate an opportunity manager in the company who is responsible for assigning the new opportunities to different salespeople according to the job they do, their location or availability.

Of course, OpenERP allows you to automate such steps in your sales cycle. With Automated Rules you can tell the system for instance to automatically assign opportunities to a sales person or to change the status of an opportunity according to specific criteria.


Note

Automated Actions

To access the CRM rules, use the Sales ‣ Configuration ‣ Automated Actions ‣ Automated Actions menu.



Let’s give an example of what you can use Automated Actions for. Suppose you want to have OpenERP assign opportunities for customers in the IT Sector category directly to Thomas, your IT salesman. Thomas should be assigned automatically when a lead is converted to an opportunity by clicking the Convert to Opportunity button in the Leads screen. This can be set through the Object field in the Automated Actions form; just select Convert/Merge Opportunity.

The screenshots below illustrate how you can tell OpenERP to do this automatically for you.

Step 1


[image: ../../../_images/crm_autom_act1.jpeg]
Conditions Tab of Automated Actions



Step 2
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Actions Tab of Automated Actions



When you answer to an opportunity from the Communication & History tab, you can directly have the status of the opportunity changed. You can also add a Global CC, even with multiple email addresses separated by ‘;’. This ensures that when any email regarding this opportunity is sent, all the persons defined in Global CC will be notified.

Planning your next actions also refers to filling fields or performing actions manually, without interference of automated rules. It is important that you fill all the opportunity fields accurately. To ensure good follow-up and prioritise your opportunities, make sure to register the Next Action Date and the Next Action in the Opportunity. In the Opportunities screen, you can group your search results by these fields, so that you know exactly how to plan your work.

You can use the filters to group by Priority and then click the Next Action Date column to sort by next action date to easily follow up your opportunities and know exactly what you have to do.




有效计划你的会议和电话呼叫

Planning your meetings & calls does not only allow you to structure your work, but also to improve your sales skills by learning from your call & meeting history. For both Meetings & Calls, you can enter a complete report of what you discuss!

As explained in chapter crm-flow, you can schedule a meeting directly from an opportunity. When you create a meeting from an opportunity, related fields will be prefilled from the opportunity.
For the ease of reading, Thomas will schedule a new meeting from an opportunity here and set Luc, the Sales Manager, as the person responsible for the meeting. He wants to send Luc a reminder 1 day before the meeting starts.


Note

Schedule a Meeting from an Opportunity

To plan the meeting, Thomas clicks the Schedule Meeting button in the Opportunity and clicks the Week button in the Calendar view. He uses the drag and drop function to schedule the meeting for Luc. He plans the meeting next Wednesday from 2 pm to 3 pm. He sets Luc as the person responsible and sets a reminder to be send 1 day before the start of the meeting. He also changes the Next Action Date in the opportunity to the meeting date.



You can also schedule a meeting directly from a Customer form. Go to the customer for whom you want to schedule a meeting and open the form view. In the list of actions at the right side of the screen, click Schedule a Meeting. If you stay in the Month view of the Calendar, you just have to click the day you want the meeting to be planned, let’s say Thursday in two weeks. A meeting form will be displayed, with the name of the customer and the date prefilled.

Another way to enter a meeting request, is to directly use the meeting calendar from the menu Sales ‣ Meetings ‣ Meetings. You can use the monthly, weekly or daily views to plan a meeting by selecting the corresponding buttons. You can also click a day in the Navigator window to schedule a meeting.

In the Meeting window, enter the meeting data such as meeting summary, type, duration. In the weekly and daily views, you can also press the left mouse button in the calendar and slide the mouse along to create an event of several hours. OpenERP then opens an entry screen for a new meeting.
You can add reminders (or Alarms) to your meetings and send invitations, either to persons from your own company, partner contacts or external people (just specify the email address directly in the invitation). You can send invitations before or after confirmation of a meeting. Either from the meeting itself or from the separate Event Invitations view in the menu Sales ‣ Configuration ‣ Calendar ‣ Event Invitations, you can track and change the attendee status. If you cannot attend a meeting, you can delegate it to one of your colleagues.


Tip

Alarms or Meeting Reminders

Add your own alarms through Sales ‣ Configuration ‣ Calendar ‣ Alarms. You might want to be warned one week in advance of the meeting, so all you have to do is create your own alarm. The screenshot below will show you how to do this.
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Defining your Own Alarms
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Entering a New Meeting



You may notice different colours and styles in the calendar. That is because OpenERP distinguishes between recurring events, multiple days events and events that only happen once.
Multi-day events have a coloured background, whereas single events have a coloured font. Each event
has a colour that represents the user who created the meeting. You can filter the different users by
selecting them from the list at the right of the screen.
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Monthly Meeting Calendar
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Weekly Meeting Calendar



You can change the Calendar view for meetings and return to the list, form or gantt view by using the buttons at the top right. OpenERP’s usual search tools and filters enable you to filter the events displayed in the calendar or, for example, to display the calendar for only some employees at a time.


Tip

Related Partner

When you hover your mouse cursor over a meeting in Calendar view, the related partner and the sales team will be displayed.



Of course, you can access this OpenERP calendar from your smartphone. For more information about this feature, please refer to chapter 用移动设备同步你的CRM.

OpenERP also allows you to manage incoming (inbound) and outgoing (outbound) calls. Even from the Phone Calls list view, you can directly edit a call (change the status, convert it to an opportunity or schedule a meeting). For every call, you can enter notes about the outcome. While on the phone with your prospect or customer, you can directly schedule a meeting, schedule another call or convert your call to an opportunity. There is no need for you to scroll to several menus to do what you have to: plan an action as a result of your call.

Call management may be used for other needs than planning, such as:


	Entering customer calls so that you keep a record of the communication attached to a partner or a
sales opportunity,

	Calling out to large lists of prospects,

	Scheduling recurring calls or next actions.




Note

Schedule a Phone Call directly

Go to Sales ‣ Phone Calls ‣ Inbound to register incoming calls or Outbound to register outgoing calls.



The phone call will then be visible in the History tab of the Partner form to give you complete visibility of the
events for a customer or supplier.

Of course, OpenERP also allows you to schedule a phone call directly from an Opportunity form through the related Schedule/Log Call button.


Note

Phone Calls in Meeting Calendar

To have one calendar with both your meetings and your phone calls, you may choose to enter phone calls as a meeting, with a specific meeting type, Phone Call.






定期截止

To keep track of the coming sales pipeline, you should enter the expected closing date for each opportunity. By doing this, from the Opportunities screen you can easily filter your pipeline by Expected Closing (button in Group by). This is a clear way to forecast the expected revenues. You can also use this filter to check whether the expected closing date has been set.

Simply by adding an expected closing date, the sales team can manage the sales process more efficiently and effectively.
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Closing Dates
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用email联系以及从移动设备访问


OpenERP provides all the information you need to pursue your company’s business opportunities
effectively. But to stay productive with all the information you have to handle, it is essential
that you can keep using your normal communication tools by interfacing them with OpenERP,
and that you are not limited just to OpenERP’s interface.


Often your sales persons are already used to working with standard email clients to manage their business. OpenERP allows you to perfectly integrate their knowledge with the use of OpenERP.

OpenERP offers this flexibility to those who need to continue using their traditional email programs to maintain their
efficiency: OpenERP can be connected to Outlook and Thunderbird. Your users can participate in many OpenERP-maintained processes without ever leaving their familiar environment, and can avoid double data entry, yet easily link information to OpenERP’s database automatically.

With the Outlook and Thunderbird plug-ins, you can create and/or open contacts directly from your email client in OpenERP without effort.
You can also link emails (with attachments) to OpenERP, to avoid information getting lost.
Both plug-ins enable you for instance to create leads based on exchanges you have with the customer.

The email gateway functionality enables you to use OpenERP’s CRM without necessarily using the OpenERP interface. Up-to-date leads can automatically be stored in OpenERP just by sending and receiving emails through a specific email address. You can even answer such mails from your own mailbox.

And of course, you can link the OpenERP meeting calendar to your mobile device.


通讯工具

The Fetchmail / Mailgateway functionality lets you interface the CRM with incoming and outgoing emails. So you can receive mails in OpenERP and answer them directly from OpenERP.
You can install it when you configure the CRM, through the Reconfigure wizard, Fetch Emails, or by installing the fetchmail module from the list of modules.
Thanks to this feature, each email you receive on the specified email address may automatically create a lead, a contact or an other object in OpenERP, while keeping track of email attachments. This is an easy way to ensure that no crucial sales information gets lost.

You set the generic email address you want to use, such as sales@mycompany.com, and then you tell OpenERP that every incoming email for this address should automatically be created as a lead.


Tip

Objects

You can use this feature for any object in OpenERP, so for instance also to keep track of your helpdesk or job applications.



To use the email gateway, you should install the Fetchmail module. You might need a system administrator to carry out this work.

If you followed the steps in the previous chapters, you should have the Fetchmail module installed. If not, you can install the Fetchmail module from the Configuration Wizard (CRM Configuration Wizard, Synchronization, Fetch Emails), or from the modules list.


Note

Scheduled Action

Click the Fetch email button to get the emails directly. OpenERP also automatically creates a Scheduled Action to fetch the mails every 5 minutes.



Step 1

You can configure your incoming mail account(s) from the Sales ‣ Configuration ‣ Emails ‣ Email Servers.
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How to Configure your Email Server for Incoming Mails?



Go to Tools ‣ Configuration ‣ Email Template ‣ Email Accounts to define the email smtp settings.

In the Description field, type the visible name you would like to use for the account.

In Server, type the mail server, i.e. smtp.googlemail.com.

Type the SMTP port (e.g. 587), configure the other settings according to the specifications of your server.

Add the User Information, such as email address for which the mails will enter OpenERP, i.e. support@mycompany.com, the user name and the password. Configure the other settings to your needs.

Save and click the Test Outgoing Connection button to check whether the settings are correct.

When everything is correctly configured, Approve the account. OpenERP will automatically create a Scheduler for the mails. You can also send/receive mails manually by clicking the Send/Receive button.

Step 2

You can configure your outgoing mail account(s) from the Tools ‣ Configuration ‣ Email Template ‣ Email Accounts.
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How to Configure your Email Server for Outgoing Mails?



Go to Sales > Configuration > Emails > Email Servers to define the email server settings.

Assign a Name and select the Server Type, i.e. IMAP Server.

Click Add Attachments if you want to include attachments for the mails received / sent.

Enter the Server Information, check SSL if necessary, i.e. imap.googlemail.com and the Login Information.

You can also choose to send an automatic reply on receipt of the mail. You can configure the mail here from the Email Server Action field.

Assign the Model to use when a new email arrives, i.e. choose Lead (crm.leads) if you want every new email that arrives to be created as a lead.

Click Confirm to confirm the account settings.


Note

Server Configuration

You will also need your administrator to configure your server settings to allow for an email gateway. This will not be explained
in this book.






Microsoft Outlook 关联你的CRM

The Microsoft Outlook plug-in enables you to carry out a series of OpenERP operations quickly and directly
from the Outlook email client:


	create a contact or partner from an email,

	open a partner from an email,

	save an email and its attachments in OpenERP from your mailbox,

	send any attachment to an OpenERP document (such as opportunities, customers).



Thanks to the plug-in, you can effortlessly link emails and attachments to the corresponding opportunity in OpenERP, or link an attached product folder to a customer, for instance.


Tip

Outlook Versions

The Microsoft Outlook plug-in works with Microsoft Outlook 2003 and 2007, but not with Outlook Express.



In this chapter, only the actual possibilities of the plug-in will be discussed. For more information about how to install and configure the Outlook plug-in, please refer to the chapter outlook

From the Outlook toolbar, have a look at the Tools menu.

The Push option allows you to archive emails to OpenERP, either to new document types or to existing ones (such as Leads). It also allows you to create a new contact.

The Partner option allows you to open the Partner in OpenERP according to the email (i.e. contact email address) selected.

With Document, you can open the document (i.e. a customer, an opportunity) concerned in OpenERP. Make sure your web server is running to use this functionality.
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How to Access OpenERP from Outlook?




	Link an email to an existing document in OpenERP



To archive an email in OpenERP from Outlook, select the email and click the Push button. Alternatively you can open the menu Tools ‣ Push: the Push to OpenERP screen will open.

In the Link to an Existing Document section, check Partner. Then select the customer you want to attach the selected mail to.
The plug-in also allows you to select several customers at once, simply by selecting a customer and pressing the ctrl button while selecting the next one.

Suppose you decide to no longer link the selected email to a customer, but instead to an opportunity. Then you have to click the Search button to refresh the Documents list to display your opportunities.

From the list of available documents, you can select any document type you defined in the Document Settings section.


	Create a New Document



This feature can be used to create any of the configured document types in the Document Settings tab.
Suppose you would like to create a new lead from an email. In the Create a New Document section, select CRM Lead, then click the Create button. A new lead will be created in OpenERP from the selected email.


	Create a New Contact / Partner



If the partner or contact from your email does not exist in OpenERP yet, the Outlook plug-in allows you to
create one on the fly simply by using the information contained in the email.

Select the email from which you want to create a new contact, then click the Push button.
In the Create a New Contact section, click the New Contact button. This option offers two possibilities:
either you just create a contact (address), or you create a partner with the contact linked to it.



	When you just want to create a new contact, complete the address data in the dialog box and click the Save button.
The contact will then be created in OpenERP.

	When you also want to create a new partner, complete the contact data.
Then click the Create Partner button, add the partner’s name and click the Save button.

	You can also add a new contact to an existing partner. Click the Search button next to the Partner field
and select the corresponding partner from the list. Then complete the contact data and click the Save button.
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Creating a Contact on the Fly from Outlook




	Open the Document created in OpenERP



From your mailbox, simply by clicking an email, you can directly access the corresponding data in OpenERP. Go to the menu Tools ‣ Document which will open the corresponding document (e.g. a lead) in OpenERP, directly from the email you selected.


Tip

Knowledge Management

The Outlook plug-in is compatible with OpenERP’s Knowledge (i.e. Document) Management. If you install the
Knowledge application you will be able to:


	search through the content of your company’s documents (those that have the type .doc, .pdf, .sxw
and .odt) and also in archived emails,

	have a shared file system that is connected to various OpenERP documents to share information and
access it with your favorite browser,

	organize and structure your documents (such as projects, partners and users) in OpenERP’s
system.






	Step 1: Install the Outlook plugin in OpenERP



Use the OpenERP Configuration Wizard and install the Customer Relationship Management application. In the CRM Application Configuration dialog under Plug-In, select MS-Outlook.
Then the Outlook Plug-In wizard appears. Next to the Outlook Plug-in field, click the Save As button to save the plugin to your desktop (or any other location on your computer).

You can also download the installation manual by clicking the green arrow next to Installation Manual.

Another way to use the Outlook plugin, is by installing the OpenERP module outlook. When you install this module, the same Configuration Wizard as explained before will be displayed. Follow the same instructions.


	Step 2: Prerequisites (for more details, please refer to the online documentation)
	Install Python 2.6+

	Python for Windows extensions - PyWin32, this module for python must be installed for the appropriate version of Python.

	Specify the python folder in the system path (typically with this installer C:Python26)








How to set the path in Windows XP
For Windows XP: http://www.computerhope.com/issues/ch000549.htm

How to set the path in Windows 7
To change the system environment variables, follow the steps below.







	From the Windows button, select Control Panel, then click System.

	Click Remote Settings to open the System Properties window.

	In the System Properties window, click the Advanced tab.

	In the Advanced section, click the Environment Variables button.

	Finally, in the Environment Variables window (as shown below) under System Variables, highlight the Path directory,
click Edit and add ;C:Python26.






4. If you are using MS Outlook 2007 then you are required to install “Microsoft Exchange Server MAPI Client and Collaboration
Data Objects 1.2.1 (CDO 1.21)”
Double-click Exchange CDO to install it.


	If you are using MS Outlook 2003, be sure to install the built-in CDO component.







	Step 3: Install the OpenERP extension in Outlook.



	Double-click the file ``OpenERP-Outlook-addin.exe``that you saved on your desktop. Confirm the default settings.

	Double-click the file ``Register plugin``in the OpenERP Outlook Addin folder (typically in C:Program Files).

	Start Outlook.










When you have executed Installation Step 1, Step 2 and Step 3, the first thing to do is connect Outlook to OpenERP.
A little configuration needs to be done.


Tip

Toolbars

If you want the OpenERP connection to be shown as a separate toolbar, go to the menu View ‣ Toolbars. Select OpenERP.




	Go to the menu Tools and select Configuration. If this raises an error, make sure to check the access rights to that particular folder.



A configuration window appears enabling you to enter configuration data about your OpenERP server.
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How to Connect to the Server




	On the Configuration Settings tab, under Connection Parameters click the Change button
and type your server settings and XML-RPC port, e.g. http://127.0.0.1:8069,

	Select the database you want to connect to, and type the user and the password required to log in to the database,

	Click the Connect button,

	On the Configuration Settings tab, under Webserver Parameters click the Change button
and type your web server settings, e.g. http://localhost:8080,

	Click the Open button to test the connection.










When your connection has succeeded, you would typically want to configure Outlook to fit your needs.

To define extra document types, go to the Document Settings tab. This is the place where you can add objects from OpenERP that you wish to link mails to. The default installation comes with a number of predefined documents, such as Partners, Leads and Sales Orders.

Here is an example of how to configure extra document types. Suppose you would like to link mails to a meeting:



	In the Title, type Meeting,

	In the Document, type the object from OpenERP, in this example crm.meeting,

	In the Image, select an icon you would like to use,

	Click the Add button to actually create the document type.







Note

A Word about Objects

To find the object you need in OpenERP, go to the menu Administration ‣ Customization ‣ Database Structure ‣
Objects. OpenERP will only show objects for which the corresponding Business Applications / Modules have been installed.
You can only add objects to Outlook that are available in the selected database.






从Mozilla Thunderbird管理你的CRM

With the Mozilla Thunderbird plug-in you can carry out a series of OpenERP operations directly from Thunderbird, such as:


	create a contact or partner from an email,

	open a partner from an email,

	save an email and its attachments in OpenERP,

	send any attachment to an OpenERP document (such as opportunities, customers).



Thanks to the plug-in, you can effortlessly link emails and attachments to the corresponding opportunity in OpenERP, or link an attached product folder to a customer, for instance.

In this chapter, only the actual possibilities of the plug-in will be discussed. For more information about how to install and configure the Thunderbird plug-in, please refer to the chapter thunderbird.

From the Thunderbird toolbar, have a look at the OpenERP menu.

The Push option allows you to archive emails to OpenERP, either to new document types or to existing ones. It also allows you to create a new contact.

The Partner allows you to open the Partner in OpenERP according to the email (i.e. contact email address) selected.

With Document, you can open the document (i.e. a customer, an opportunity) concerned in OpenERP. Make sure your web server is running to use this functionality. You have to open the mail to use this feature.


	Link an email to an existing document in OpenERP
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How to Access OpenERP from Thunderbird?



To archive an email in OpenERP from Thunderbird, select the email and click the Push button. Alternatively you can open the menu OpenERP ‣ Push: the Push to OpenERP screen will open.

In the Link to an Existing Document section, check Partner. Then select the customer you want to attach the selected mail to.
The plug-in also allows you to select several customers at once, simply by selecting a customer and pressing the ctrl button while selecting the next one.

Suppose you decide to no longer link the selected email to a customer, but instead to an opportunity. Then you have to click the Search button to refresh the Documents list to display your opportunities.

From the list of available documents, you can select any document type you defined in the Document Settings section.


	Create a New Document



This feature can be used to create any of the configured document types in the Document Settings tab.
Suppose you would like to create a new lead from an email. In the Create a New Document section, select CRM Lead, then click the Create button. A new lead will be created in OpenERP from the selected email.


	Create a New Contact / Partner



If the partner or contact from your email does not exist in OpenERP yet, the Thunderbird plug-in allows you to
create one on the fly simply by using the information contained in the email.

Select the email from which you want to create a new contact, then click the Push button.
In the Create a New Contact section, click the New Contact button. This option offers two possibilities:
either you just create a contact (address), or you create a partner with the contact linked to it.



	When you just want to create a new contact, complete the address data in the dialog box and click the Save button.
The contact will then be created in OpenERP.

	When you also want to create a new partner, complete the contact data.
Then click the Create Partner button, add the partner’s name and click the Save button.

	You can also add a new contact to an existing partner. Click the Search button next to the Partner field
and select the corresponding partner from the list. Then complete the contact data and click the Save button.
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Creating a Contact on the Fly from Thunderbird




	Open the Document created in OpenERP



From your mailbox, simply by clicking an email, you can directly access the corresponding data in OpenERP. Go to the menu Tools ‣ Document which will open the corresponding document (e.g. a lead) in OpenERP, directly from the email you selected.


Tip

Knowledge Management

The Thunderbird plug-in is compatible with OpenERP’s Knowledge (i.e. Document) Management. If you install the
Knowledge application you will be able to:


	search through the content of your company’s documents (those that have the type .doc, .pdf, .sxw
and .odt) and also in archived emails,

	have a shared file system that is connected to various OpenERP documents to share information and
access it with your favorite browser,






	Step 1: Install the Thunderbird plugin in OpenERP



Use the OpenERP Configuration Wizard and install the Customer Relationship Management application. In the CRM Application Configuration dialog under Plug-In, select Thunderbird.
Then the Thunderbird Plug-In wizard appears. Next to the Thunderbird Plug-in field, click the Save As button to save the plugin to your desktop (or any other location on your computer).

You can also download the installation manual by clicking the orange arrow next to Installation Manual.

Another way to use the Thunderbird plugin, is by installing the OpenERP module thunderbird. When you install this module, the same Configuration Wizard as explained before will be displayed. Follow the same instructions.


	Step 2: Install the OpenERP extension in Thunderbird.



To do that, use the file ``openerp_plugin.xpi``that you saved on your desktop.

Then proceed as follows:



	From Thunderbird, open the menu Tools ‣ Add-ons.

	Click Extensions, then click the Install button.

	Go to your desktop and select the file openerp_plugin.xpi. Click Open.

	Click Install Now then restart Thunderbird.






Once the extension has been installed, a new OpenERP menu item is added to your Thunderbird menubar.


Tip

Thunderbird Version

The OpenERP plugin for Thunderbird works as from Thunderbird version 2.0.

So check your Thunderbird version before installing, and download the latest version that you need
from the following address: http://www.mozilla.org/products/thunderbird/



When you have executed Installation Step 1 and Step 2, the first thing to do is connect Thunderbird to OpenERP.
A little configuration needs to be done.


Note

Before starting the configuration, make sure your GTK server and web server are running (XML-RPC should be allowed).



Go to the OpenERP menubar and select ` Configuration`.

A configuration window appears enabling you to enter configuration data about your OpenERP server.
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How to Connect to the Server




	On the Configuration Settings tab, under Connection Parameters click the Change button
and type your server settings and XML-RPC port, e.g. http://127.0.0.1:8069,

	Select the database you want to connect to, and type the user and the password required to log in to the database,

	Click the Connect button,

	On the Configuration Settings tab, under Webserver Parameters click the Change button
and type your web server settings, e.g. http://localhost:8080,

	Click the Open button to test the connection.










When your connection has succeeded, you would typically want to configure Thunderbird to fit your needs.

To define extra document types, go to the Document Settings tab. This is the place where you can add objects from OpenERP that you wish to link mails to. The default installation comes with a number of predefined documents, such as Partners, Leads and Sales Orders.

Here is an example of how to configure extra document types. Suppose you would like to link mails to a purchase order.



	In the Title, type Purchase Order,

	In the Document, type the object from OpenERP, in this example purchase.order,

	In the Image, select an icon you would like to use,

	Click the Add button to actually create the document type.







Note

A Word about Objects

To find the object you need in OpenERP, go to the menu Administration ‣ Customization ‣ Database Structure ‣
Objects. OpenERP will only show objects for which the corresponding Business Applications / Modules have been installed.
You can only add objects to Thunderbird that are available in the selected database.




[image: ../../../_images/thunderbird_document.png]
How to Add Extra OpenERP Document Types to Thunderbird?
* organize and structure your documents (such as projects, partners and users) in OpenERP’s system.






用移动设备同步你的CRM

Synchronize your OpenERP calendars with your mobile device and know which meeting to go to from wherever you are!

Make your OpenERP even more efficient and let your sales synchronize their meetings with their mobile devices.
Anywhere your sales people are, they can easily check their planning and confirm new meetings with customers on the spot.

You can synchronize your calendars with iPhone and Android phones, and also with tools such as Evolution and Sunbird/Lightning.


Note

Installation and Configuration

Please note that setting this up requires some technical knowledge, and probably the assistance of IT staff.




OpenERP 服务器和 SSL 设置

Some modules need to be installed on the OpenERP server (or may already be installed). These are:



	
	caldav: Required, has the reference setup and the necessary

	underlying code. Will also cause document & document_webdav
to be installed.







	crm_caldav: Optional, will export the CRM Meetings as a calendar.



	project_caldav: Optional, will export project tasks as a calendar.



	
	http_well_known: Optional, experimental. Will ease bootstrapping,

	but only when a DNS srv record is also used.












When you install the above module(s), a ready-to-go reference setup of the folders is provided.
The OpenERP administrator can add more calendars and (re)structure if needed.

It is highly advisable that you also set up SSL to work for the OpenERP server. HTTPS is a server-wide feature in OpenERP, which means a
certificate will be set at the openerp-server.conf which will be the same for XML-RPC, HTTP, WebDAV and CalDAV.
The iPhone also supports secure connections with SSL, although it does not expect a self-signed certificate (or one that is not verified by
one of the “big” certificate authorities).




在iPhone上的日历

To set up the calendars, proceed as follows:


	Click Settings and go to the Mail, Contacts, Calendars page.

	Go to Add account...

	Click Other.

	From the Calendars group, select Add CalDAV Account.

	Enter the host name.
(e.g. if the URL is http://openerp.com:8069/webdav/db_1/calendars/ , openerp.com is the host)




Tip

Synchronize this Calendar

Go to Sales ‣ Meetings ‣ Synchronize this Calendar and select Iphone. Then the Caldav server will be shown.




	In Username and Password, type your OpenERP login and password.

	As a description, you can either leave the server’s name or
something like “OpenERP calendars”.

	If you are not using a SSL server, you will get an error, do not worry and push “Continue”

	Then click “Advanced Settings” to specify the correct ports and paths.

	Specify the port for the OpenERP server: 8071 for SSL, 8069 without SSL.

	Set the Account URL to the right path of the OpenERP webdav:
the URL given by the wizard (e.g. http://my.server.ip:8069/webdav/dbname/calendars/ )

	Click Done. The phone will connect to the OpenERP server
and verify whether the account can be used.

	Go to the main menu of the iPhone and open the Calendar application.
Your OpenERP calendars will be visible inside the selection of the
“Calendars” button.
Note that when creating a new calendar entry, you will have to specify
which calendar it should be saved to.



If you need SSL (and your certificate is not a verified one),
you will first need to let the iPhone trust the certificate. Follow these steps:


	Open Safari and enter the HTTPS location of the OpenERP server:
https://my.server.ip:8071/
(assuming you have the server at “my.server.ip” and the HTTPS port is the default 8071)

	Safari will try to connect and issue a warning about the certificate used. Inspect the certificate
and click “Accept” so that iPhone now trusts it.






在 Android 上的日历


先决条件

There is no built-in way to synchronize calendars with CalDAV.
So you need to install a third party software: Calendar (CalDav) Sync BETA
from Hypermatix Software (for now, it is the only one).




如何配置?


	Open the Calendar Sync application.
You get an interface with 2 tabs.

	On the Connection tab, in CalDAV Calendar URL, type a URL such as http://my.server.ip:8069/webdav/dbname/calendars/users/demo/c/Meetings.




Tip

Synchronize this Calendar

Go to Sales ‣ Meetings ‣ Synchronize this Calendar and select Android. Then the Caldav server link will be shown. Make sure to use the correct XML-RPC port, it may differ from 8069.




	Type your OpenERP username and password.

	If your server does not use SSL, you will get a warning. Answer Yes.

	Then you can synchronize manually or customize the settings (Sync tab) to synchronize every X minutes.








在Evolution上的日历


	Go to Calendar View.



	File ‣ New ‣ Calendar.



	Enter the data in the form:



	Type : CalDav

	Name : Whatever you want (e.g. Meeting)

	URL : http://HOST:PORT/webdav/DB_NAME/calendars/users/USER/c/Meetings (e.g.
http://localhost:8069/webdav/db_1/calendars/users/demo/c/Meetings)
the one given on top of this window

	Uncheck “User SSL”

	Username : Your username (e.g. Demo)

	Refresh : every time you want Evolution to synchronize the data with the server











Tip

Synchronize this Calendar

Go to Sales ‣ Meetings ‣ Synchronize this Calendar and select Evolution. Then the Caldav server will be shown.




	Click OK and enter your OpenERP password.

	A new calendar with the name you entered should appear on the left side.






在Sunbird/Lightning上的日历


先决条件

If you are using Thunderbird, first install the Lightning module
http://www.mozilla.org/projects/calendar/lightning/




配置


	Go to Calendar View.

	File ‣ New Calendar.

	Choose On the Network.

	As a format, select CalDav
and as a location type the URL (e.g. http://host.com:8069/webdav/db/calendars/users/demo/c/Meetings).




Tip

Synchronize this Calendar

Go to Sales ‣ Meetings ‣ Synchronize this Calendar and select Sunbird/Lightning. Then the Caldav server will be shown.




	Choose a name and a colour for the Calendar, and we advice you to uncheck “alarm”.




	Enter your OpenERP login and password (to give the password only once, check the box Use Password Manager to remember this password).

	Then click Finish; your meetings should now appear in your Calendar view.
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管理你的间接的销售

OpenERP 将帮助你管理你的渠道业务伙伴. 可以将商机进行区域化，只需要在 管理 ‣ 模块 ‣ 模块 在Modules的 Name 字段中输入: crm_partner_assign . 进行检索再点击最后一行的按钮 (在 State 字段后) 进行模块的安装. 注意 State 会转变为’将要安装的模块’. 点击执行左侧的动作`执行已安排的升级`. 模块将被安装，并且增加以下 销售 ‣ 设置 ‣ 线索 & 商机 ‣ 业务伙伴级别 与 销售 –> 报告 –> 商机指定分析.


Note

CRM 配置向导

当你点击`执行已安排的升级`, 配置向导将会显示. 如果不需要安装其他CRM模块，可以点击取消配置向导.




转发商机给渠道业务伙伴

可以使用地域化功能，把商机指派和转交给渠道业务伙伴.

通过 销售 ‣ 设置 ‣ 线索 & 商机 ‣ 业务伙伴级别, 可以创建业务伙伴级别对业务伙伴进行分类, 例如金牌业务伙伴, 银牌业务伙伴, 准业务伙伴. 这些级别将会被用来确定谁可以得到哪些商机.

在客户视图中的 Geo Localization 定位 分页中指定业务伙伴的级别. 同时可指定 重要性 用于指定商机分配给业务伙伴的概率(0表示不分配). 这个`重要性`,举例来说,可以是业务伙伴所能支付的业务合同的最大金额.

如何使用OpenERP来地域化一个商机?

可以将一个线索转化为商机, 或者直接将商机分配给具体的渠道业务伙伴.
Go to the Assignation tab of the Opportunities form, and click the Geo Assign button. The location of the partner in the opportunity will be matched with the geolatitude and the weight of the channel partners. The most appropriate channel partner will be assigned.


Note

GPS

You can also use the geolocalisation without GPS coordinates.



Now you can decide whether this is the correct channel partner for this opportunity. If you feel that another channel partner would be better to follow up this opportunity because he , you can change the assigned channel partner.

To automatically inform the channel partner of the new opportunity, proceed as follows.

Click the Forward button to automatically send an email to the assigned partner with all the details of the opportunity and the prospect.
When forwarding an opportunity to a partner, you can select which information you want to send: Latest email, Whole Story or Case Information. You can add a cc and add attachments to the mail.
You can send the mail to the partner (any contact person you want), to an OpenERP user or to an email address you specify.

To allow your salespeople to keep a view on forwarded opportunities, the assigned opportunity will be displayed for the selected channel partner on the Geo Localization tab of the Customer form.

Use the Opportunity Assignment Analysis for your reporting.


Tip

Google Maps

Use the geolocalization together with the google_map module. This adds a Map button to your Partner form. Click this button to open a browser with the partner’s location displayed in Google Maps.






Partner的地理定位

To determine the geographic location of your partners, you do not have to enter the GPS coordinates yourself. OpenERP can do this for you. All you have to do is click the Geo Localize button in the Customer form. The GPS coordinates will now be filled according to the address of the partner.

In the partner form, the Geo Localization tab gives you the information you need.


[image: ../../../_images/crm_partner_geolocalize.png]
Geolocalizing a Partner
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跟踪你的通讯


跟踪客户日志

Information related to leads & opportunities, meetings, phone calls,  marketing campaigns and emails will be tracked in OpenERP.
The activities are automatically reported in the partner form of the associated customer. To have a complete overview of the activities for a customer, all you have to do is open the Customer form and click the History tab. As you will notice in the screenshot below, this is not merely a report. From this tab, you can also plan new activities for the customer or change existing activities!


[image: ../../../_images/crm_partner_event.png]
History of Activities in a Customer Form






跟踪销售订单

After intensive opportunity qualification, your customer asks you to make a quotation. You can easily do this from the corresponding opportunity! Just click the Convert to Quote button and OpenERP will create a sales quotation ready for you to be edited. A sales quotation is an unconfirmed sales order. On the quotation, the Source document it was created from (in this case the opportunity) is displayed, to allow you to keep track of which opportunity is linked to which sales quotation / order.

To review the quotation later, you can access it from the Sales ‣ Sales ‣ Sales Orders menu. On the Extra Info tab of the sales quotation, you can find the reference to the related sales quotation / order that has been created from the opportunity concerned.

For more information about sales orders, please refer to the chapter part4-crm-sales.




存储附加单据

For any object in OpenERP, for instance a lead, opportunity, customer, you can attach external documents. Suppose you send a product folder to one of your customers, and to make sure you know exactly which version of the document he received, you can keep it as an attachment in OpenERP.

To attach whatever type of document to the customer, you just have to go to the Sales ‣ Address Book ‣ Customers menu.

Open the Customer form of the selected partner, and click the Add button in the Action bar, just below Attachments. Then click the Browse... button and navigate to the location where the product folder is stored, just like you would do in your file explorer. Click the product folder, and then confirm.

The product folder is now stored in OpenERP as an attachment for the customer. You can open it by clicking the document in Attachments.

OpenERP allows you to add as many attachments as needed. Combined with the Knowledge application, OpenERP will index documents of the type .doc, .pdf, .sxw and .odt, so that you can effortlessly search through their content.


Note

File Storage

If you do not install the Document Management system (Knowledge application) then the attachments in OpenERP are stored
directly in the database.
Once the document management system has been installed,
the contents of the files are no longer stored in the database, but on the OpenERP
server file system.

You can then read and add attachments to OpenERP quite independently of the OpenERP
interface or the FTP server using simple drag and drop.



For more information about the Knowledge and Document Management System, please refer to the online documentation.
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分析销售绩效


组织销售漏斗的复核

Through the Opportunities Analysis, Sales ‣ Reporting, you can keep track of your sales funnel. The analysis report gives you instant access to your opportunities displaying information such as expected revenue, planned cost, missed deadlines or the number of interactions per opportunity. This report is perfect for the Sales Manager to periodically review the sales pipeline with the salesteams concerned.


[image: ../../../_images/opport_analysis.jpeg]
Sales Funnel Review



The powerful Advanced Search View allows you to customize your analysis reports by using Extended Filters and Group by features.

With Extended filters, you can select specific options to filter your opportunities. For example, when you select a partner here, only opportunities related to that specific partner will be displayed.

You can also filter the information of an opportunity according to the Group by features.
Suppose you want to analyse your opportunities by campaign and by salesman. When you open the Opportunities Analysis screen, you will notice that the opportunities are by default grouped by salesman (see Salesman button in the Group by area).

Since you want to group by Campaign first, click the Salesman button to unselect it. Just click the Campaign button, then click Salesman to get the report you want.


[image: ../../../_images/filter_opport_analysis.png]
Opportunities Analysis



Some examples of how you could use the Opportunities Analysis report to analyse your opportunities in various ways.


	
	Customers with Open Opportunities:








Group by Partner, click the Active button to provide a list with the customer names and the number of draft / open opportunities.



	
	Closed Opportunities:








Click the Closed button, then group by State, then by Stage to display a list of closed opportunities divided by stage (lost and won).



	
	Opportunity Sources:








The number of opportunities can be displayed by closing date and sales stage, including expected revenue. Select only the Closed opportunities, group by Date button, then by Stage to obtain this view.



	
	Opportunity Pipeline:








To get an idea of what your salesman’s pipeline is like (or sales team), including the expected sales volume, click the Active button and group by Salesman (or Sales Team).



	
	Opportunities by Category:








Click the Graph button in the Opportunities screen to display the report as a Graph.



Tip

Graph

You can also display the Opportunities Analysis screen as a graph.






销售预测和销售仪表板

OpenERP dashboards are dynamic and allow you to edit or drill-down. Dashboards may be composed of several view types, such as List, Form, Graph view.

When you click the Sales button in the web version (to open the business application, so in the top bar), automatically the Sales Dashboard will appear. You can also access this dashboard from the Sales ‣ Reporting ‣ Dashboard. This dashboard gives you more information about your own sales activities, such as your Open Opportunities and your Quotations. This dashboard is prefiltered according to the OpenERP user who opens it.
Each user can also choose a dashboard that will be opened when he starts OpenERP.


[image: ../../../_images/sales_board.jpeg]
Sales Dashboard



The Sales Manager Dashboard is a powerful tool to have an overview of quotations, sales by month, sales per customer, per salesman or per product in the last 90 days.


[image: ../../../_images/sales_mgr_board.jpeg]
Sales Manager Dashboard



The Statistics Dashboard shows the Opportunities by Category and by Stage, as well as the planned revenue per stage and user. Clicking one of the stages in the graph will allow you to drill down to the details of such an opportunity. So no need to go through several screens to find what you need.


[image: ../../../_images/sales_stat_board.jpeg]
Statistics Dashboard
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开展营销活动


利用营销活动实现线索自动化

OpenERP 提供了一些模块让你轻松创建和跟踪营销活动。
使用 Marketing 模块, 可以定义直销活动,实现与线索的自动化交互。可以通过使用重新配置向导,选择 Marketing 来安装此模块。

营销活动可以以列表或图表试图的方式展现。图表试图使得你可以一目了然的看到营销动作（通过节点表现）和适用条件（通过箭头表现）。


[image: ../../../_images/market_diagram.jpeg]
一个营销活动的图表视图



市场营销活动是通过个性化的消息帮助管理和接触你的目标客户的一次事件或一个活动。一个营销活动在具体的营销环境下可以有很多行为被触发，例如一次实时的响应通过你发送邮件的接触。这种响应（或触发行为）的结果可以是一次邮件的发送，发送的内容在这之前已经在OPENERP里预先编辑好。

为了能够使用邮件功能，你必须配置你的邮件帐户。这一点在 ch-crm-fetchmail-install 章节有讲解。


一个完整的市场营销活动例子

假设我们是一家保险公司，我们正准备启动一项市场营销活动以便获取新的销售线索。公司在其网站上发起一个活动并提供给潜在客户获得汽车保险的免费报价机会。

每次一个潜在客户通过练习表单进行注册，一个销售线索就会在OpenERP里自动产生。关于网页联系表单的更多信息，请参考 自动获取线索 章节。

销售人员负责汽车保险触发活动，通过发送一封关于我们所有保险业务的介绍性邮件的方式，并感谢他们订阅免费汽车保险报价。

基于营销响应，保险公司划分标注销售线索的兴趣点：


	购买汽车保险，

	其他保险政策信息，

	购买保护儿童安全的书籍。



通过我们接收到的来自销售线索的回复，我们汽车保险公司的销售人员发送不同的电邮来满足他们各自的不同需求。


	如果他们对这样的邮件作出回应，那么销售线索就可以转化为销售机会。当这个销售线索买了一份汽车保险，这个销售线索就转化为我们的合作伙伴，并且作为一个客户在OpenERp系统中被自动创建。

	假如我们没有收到邮件回复，那么一周后他们会继续收到关于免费汽车保险报价的问候提醒。如果他们仍旧没有做出回应，我们的销售人员会主动打电话询问他的具体需求。



把上面这个过程看成一个完整的工作流程，使得我们能够对每一个营销机会做出各种合适的响应行为。无人接待客户的可能性将大大降低，对于每一个销售线索，我们都有预设的应对方案来维护他。

此外，通过对达成目标的比照我们可以衡量每种方法的效果。基于目标我们可以评估营销活动的效果，并且分析营销活动是否有改进的空间。


Tip

营销活动实例

为了在OpenERP系统中获取一个完整的营销活动实例，你可以安装 marketing_campaign_crm_demo 模块。






定义营销活动

Designing a marketing campaign is mostly a long term process and the success of any campaign depends on the research and the effectiveness in selecting your target audience for the campaign. There are certain questions that every marketeer always asks while designing a campaign.


	What would be our marketing campaign?

	Who would be the target audience?

	How would we measure the effectiveness of our campaign?



The OpenERP campaign is based on the principle of lead automation. A lead is created according to a specific response by a customer towards a stimulus. An example: filling the car insurance calculator on your website may create a lead in OpenERP.

The first step is to define the campaign, i.e. the sequence of steps to be performed. By defining the campaign, we trigger a set of activities in the Marketing Campaign application of OpenERP.

From the lead automation, we define the sequence of steps we ought to follow, the modes of creating and processing these activities and the cost involved in this campaign. After each activity and based on its respective stimuli, we can trigger the next event of the campaign concerned.




划分营销活动

The two most important points for any successful campaign are the adoption of a concrete methodology of execution and choosing the right segment: a target loop of customers to whom our campaign would be directed (i.e. your target audience). Inappropriate focus on the wrong segment would result in the campaign being misfired and our efforts would reach deaf ears.

Through the Segment tab in the Campaign module, we can define our segment for each Campaign activity. Indeed, it is perfectly well possible that with every step downwards, the segment gets narrowed in terms of number. You can also synchronize the entire campaign steps according to the defined segments.

Our insurance company wants to attack the Spanish market, and will define a segment called Spanish Leads. Of course you would want your segment to be valid for leads coming from Spain only. To achieve this, go to the Leads list view. Filter all the leads for Spain (type Spain in the Country field), make sure to clear the salesteam, so that all leads coming from Spain will be selected. Then click Save Filter and call it for instance Spanish Leads. Now return to the Campaigns menu and open the Segment, then click the Filter field to select Spanish Leads. The segment will now only apply to Spanish leads.

As you can see, the Marketing Campaign module is closely synchronized with the Customer Relationship Management Business Application. Let us consider the segment we cater in the campaign as Leads in OpenERP. Goals are set for each campaign, which would be considered as a desired state. Once a lead meets our objective criteria of goals, we change the lead status by converting it into an Opportunity, meaning that we should give focused attention.

Once the lead satisfies our final objective, we would consider it as a partner/customer and close that lead.




电子邮件模板

OpenERP allows you to create your own email templates. You can use the Expression Builder to have the variables created for you. Suppose you would like to add the Contact Name in the email, but of course, this will be a different name for each email.

In the Expression Builder, in Field, select Contact Name. Automatically, the Expression will be filled. Copy the value from the expression and paste it in your email, e.g. Dear ${object.contact_name}. So your email will start with Dear followed by the name of the contact. This way you automatically create personalized emails.

For each email template, you can have OpenERP generate a Wizard Action / Button that will be related to the object. So if you choose to do marketing campaigns for leads, the action will be added to the right side panel of the Lead form.


Tip

Configuring Marketing Campaigns

Please notice that it requires some technical knowledge to configure Marketing Campaigns.
To be able to see, create, edit campaign, users need to be in the Marketing / User group.






设置营销活动


[image: ../../../_images/crm_market_campaign.png]
Marketing Campaign




	简介



A campaign defines a workflow of activities that items/objects entering the campaign will go through. Items are selected by segments. Segments are automatically processed every few hours and inject new items into the campaign, according to a given set of criteria.
It is possible to watch the campaign as it is running, by following the campaign “workitems”. A workitem represents a given object/item passing through a given campaign activity. See it as a step that still can go either way. Workitems are left behind when the item proceeds to the next activities. This allows an easy analysis and reporting on the running campaign.
Each activity may execute an action upon activation depending on a dynamic condition. When the condition is not met, the workitem is cancelled/deleted; if the condition is met, the action is executed, the workitem is marked as Done, and propagated to the next activities.


	营销活动 (Marketing ‣ Campaigns ‣ Campaigns)




	营销活动

	Each campaign is made of activities and transitions, and must be defined on any specific object the system knows about
(e.g. Leads, Opportunities, Employees, Partners).




	模式

	A campaign can be in one of 4 modes:





	Test Directly: processes the whole campaign in one go, ignoring any delay put on transitions, and does not actually execute the actions, so the result is simply the set of corresponding campaign workitems (see below). Any time a segment adds new items in the campaign they will be processed in the same manner.

	Test in Real time: processes the campaign but does not actually execute the actions, so the result is simply the set of corresponding campaign workitems. Any time a segment adds new items in the campaign they will be processed in the same manner.

	Manual confirmation: No action will be executed automatically, a human intervention is needed to let workitems proceed into the flow. It is like a step-by-step manual process using the Campaign Followup menu. You can ignore the time delays and force any step of the campaign, implementing the campaign at your pace i.e. (you have a test email and want to see if the steps and templates do exactly what you want them to do). You will see that the actions set are defined as To Do and Done and the page has to be refreshed to see the next activities defined by the campaign node: the campaign sends real messages to the actual targets, be warned.

	Normal: the campaign is processed normally, all actions are executed automatically at the scheduled date. Pay attention that in this status, the campaign sends real messages to the actual target audience.






Regardless of the current mode of the campaign, any workitem can be manually executed or cancelled at any time (even if it is scheduled in the future) through Campaign Followup.


	Resource

	Specifies where the campaign will get the information from, i.e. the OpenERP object linked (e.g. Leads, Opportunities,
Employees, Partners).




	Activities

	Activities are steps in the campaign. Each activity is optionally linked to previous and next activities through transitions.



Each activity has:



	one optional condition that stops the campaign,

	one action to be executed when the activity is activated and the condition is True (could be a ‘do nothing’ action),

	one optional signal (ignore it),

	a start flag.






Start Activity

Activities that have the Start checkbox set, will receive a new workitem corresponding to each new resource/object entering the campaign. It is possible to have more than one Start Activity, but not less than one.

Activity Conditions

[a Boolean expression, made of clauses combined using boolean operators: AND, OR, NOT]
Each condition is the criterion that decides whether the activity is going to be activated for a given workitem, or just cancelled.
It is an arbitrary expression composed of simple tests on attributes of the object, possibly combined using or, and & not operators.

See section 6.1 for more information on Comparators.

The individual tests can use the “object” name to refer to the object/resource it originates from (e.g the lead), using a “dot notation” to refer to its attributes. Some examples on a CRM Lead resource:



	object.name == ‘Insurance Offer Lead’ would select only leads whose title is exactly “Insurance Offer Lead”,

	object.state == ‘pending’ would select Pending leads only,

	object.country_id.code == ‘be’ would select leads whose country field is set to Belgium,

	object.country_id.name == ‘Belgium’ would select leads whose country field is set to Belgium.






Tests can also use a ‘workitem’ name to refer to the actual item denoting the position of the object in the campaign. This can be useful to access some specific attributes, such as the segment that selected this item. Some examples:



	workitem.segment_id.name == ‘Insurance Offer EU Zone1 - Industry Consulting/Technology’  would select leads that entered this campaign through the “Insurance Offer Lead EU Zone1 - Industry Consulting/Technology” segment,

	‘EU Zone1’ in workitem.segment_id.name would select only leads that entered the campaign through a segment that has “EU Zone1” in its name.







Tip

Help

In the GTK client you can use “Help > Enable Debug mode tooltips” to see the attribute name of every field in a form. These are the same that you can use during import/export with CSV files.



You can also use the special formula re.search(PATTERN_TO_SEARCH, ATTRIBUTE_TO_SEARCH) where PATTERN_TO_SEARCH is a character string delimited with quotes, and ATTRIBUTE_TO_SEARCH uses the dot notation above to refer to a field of the object.
An example for CRM leads:



	re.search(‘Plan to buy: True’, object.description) would be true if the Notes on a Lead contain this text: “Plan to buy: True”. Be careful that all spaces etc. do matter, so you may use the special pattern characters as detailed at the bottom to account for small variations,

	re.search(‘Plan to.*True’, object.description) would be true if the Notes on a Lead contain this text: “Plan to” followed later on by “True”.






You can combine individual tests using boolean operators and parentheses.
Some examples on a CRM Lead resource:



	object.state != ‘pending’ and ( re.search(‘Plan to by:.*True’,object.description)  and not re.search(‘Plan to use:.*True’,object.description)   )  would be true if the lead is NOT in Pending state and it contains “Plan to buy”, but not “Plan to use”.







创建营销活动的指导方针



	It is a good idea to have an initial activity that will change some fields on the objects entering the campaign to mark them as such, to avoid mixing them in other processes (e.g. set a specific state and Sales Team on a CRM lead being processed by a campaign). You can also define a time delay so that the campaign seems more human (note if the answer comes in a matter of seconds or minutes it is computer generated).

	Put a stop condition on each subsequent activity in the campaign to get items out of the campaign as soon as the goal is achieved (e.g. every activity has a partial condition on the state of the item, if CRM Leads stops being Pending, the campaign ends for that case).







	Email Templates (Marketing ‣ Configuration ‣ Email Template ‣ Templates)



Email templates are composed of the following information:



	The Email headers: to, from, cc, bcc, subject

	The raw HTML body, with the low-level markup and formatting

	The plaintext body






Headers and bodies can contain placeholders for dynamic contents that will be replaced in the final email with the actual content.


	Campaign Segments



Segments are processed automatically according to a predefined schedule set in the menu Administration ‣ Configuration ‣ Scheduled Actions. It could be set to process every 4 hours or every minute for example.
This is the only entry point in a campaign at the moment.

Segment filters

Segments select resources via filters, exactly the same kind of filter that can be used in advanced search views on any list in OpenERP. You can actually create them easily from any OpenERP screen allowing you to save filters. Save your advanced search criteria as a new filters and add them to the segment in the Filter field.
Filters mainly consist in a domain expressing the criteria of selection on a model (the resource).
See section 10.3 for more information on the syntax for these filters.


	For Leads, the following filter would select draft Leads from any European country with “Plan for use: True” or “Plan for buy: False” specified in the body:

	
	[  (‘type’,’=’,’lead’),

	(‘state’, ‘=’, ‘draft’),
(‘country_id.name’, ‘in’, [‘Belgium’,
‘Netherlands’,
‘Luxembourg’,
‘United Kingdom’,
‘France’,
‘Germany’,
‘Finland’,
‘Denmark’,
‘Norway’,
‘Austria’,
‘Switzerland’,
‘Italy’,
‘Spain’,
‘Portugal’,
‘Ireland’,
]),
‘|’,
(‘description’, ‘ilike’, ‘Plan for use: True’),
(‘description’, ‘ilike’, ‘Plan for buy: False’)
]








	Miscellaneous References, Examples



6.1 Reference of Comparison Operators:



	==: Equal

	!=: Not Equal

	<: Bigger than

	>: Smaller Than

	<=: Bigger than or equal to

	>=: Smaller than or equal to

	in: to check that a given text is included somewhere in another text. e.g “a” in “dabc” is True






6.2 Reference of Pattern/Wildcard characters



	. (dot) represents any character (but just one)

	* means that the previous pattern can be repeated 0 or more times

	+ means that the previous pattern can be repeated 1 or more times

	? means that the previous pattern is optional (0 or 1 times)

	.* would represent any character, repeated 0 or more times

	.+ would represent at least 1 character (but any)

	5? would represent an optional 5 character






6.3 Reference of filter domains

Generic format is:  [ (criterion_1), (criterion_2) ] to filter for resources matching both criterions.
It is possible to combine criterions differently with the following operators:



	‘&’ is the boolean AND operator and will make a new criterion by combining the next 2 criterions (always 2). This is also the implicit operator when no operator is specified.
	for example:  [ (criterion_1), ‘&’, (criterion_2), (criterion_3) ] means criterion_1 AND (criterion_2 AND criterion_3)





	‘|’ is the boolean OR operator and will make a new criterion by combining the next 2 criterions (always 2)
	for example:  [ (criterion_1), ‘|’, (criterion_2), (criterion_3) ] means criterion_1 AND (criterion_2 OR criterion_3)





	‘!’ is the boolean NOT operator and will make a new criterion by reversing the value of the next criterion (always only 1)
	for example:  [ (criterion_1), ‘!’, (criterion_2), (criterion_3) ] means criterion_1 AND (NOT criterion_2) AND criterion_3










Criterion format is:  ( ‘field_path_operand’, ‘operator’, value )

Where:



	field_path_operand specifies the name of an attribute or a path starting with an attribute to reach the value we want to compare

	operator is one of the possible operator:
	‘=’ , ‘!=’ : equal and different

	‘<’, ‘>’, ‘>=’, ‘<=’ :  greater or lower than or equal

	‘in’, ‘not in’ : present or absent in a list of value. Values must be specified as [ value1, value2 ], e.g. [ ‘Belgium’, ‘Croatia’ ]

	‘ilike’ : search for string value in the operand





	value is the text or number or list value to compare with field_path_operand using comparator











进一步推动营销活动的成果

Of course, Marketing Campaigns can only be effective when you also do something with the results. OpenERP offers analysis features to help you better manage future campaigns based on the outcome of past campaigns. Learning from your results, that is.

The Marketing ‣ Reporting ‣ Campaign Analysis report allows you to analyse your campaigns in detail, both ongoing and completed campaigns.

Segments allow you to keep good track of the results of a marketing campaign. You can see from which segment you have most demands, for instance.

Thanks to good insights in the way your respondents answer to your campaign, you can continuously improve your marketing results!


[image: ../../../_images/camp_analysis.png]
Campaign Analysis








自动获取线索

Through your website, your company wants to get as much information as possible about the people who visit the website. But how can you make sure that every person who wants to know more about your company is actually registered somewhere?

Well, you could use a Contact form for this. And precisely such a form allows you to register contacts automatically in OpenERP.
By creating a link from your website’s Contact form to OpenERP, your contact data will automatically be created in the CRM (or any other application of your choice, such as HR).

Let us show you an example of how this can be achieved. The figure below shows a Contact form on a website.


[image: ../../../_images/crm_contact_form.png]
来自网站的咨询



All data entered in this form are linked to the Lead form in the CRM. Each time someone enters this contact form, a new lead is automatically created in OpenERP.

Such a system is a very easy yet flexible way of keeping track of your leads and automatically launch your marketing campaigns.


如何将网站联系页面转化为OpenERP线索?

OpenERP is accessible through XML-RPC interfaces, for which libraries exist in many languages.

Python 代码示例

import xmlrpclib
# ... define HOST, PORT, DB, USER, PASS
url = 'http://%s:%d/xmlrpc/common' % (HOST,PORT)
sock = xmlrpclib.ServerProxy(url)
uid = sock.login(DB,USER,PASS)
print "Logged in as %s (uid:%d)" % (USER,uid)
# Create a new lead
url = 'http://%s:%d/xmlrpc/object' % (HOST,PORT)
sock = xmlrpclib.ServerProxy(url)
args = {
'name' : 'A New Lead',
'description' : 'This is a new lead from the web contact form',
'inventor_id': uid,
}
lead_id = sock.execute(DB,uid,PASS,'crm.lead','create',args)





PHP 代码示例

<?
include('xmlrpc.inc'); // Use phpxmlrpc library, available on sourceforge
// ... define $HOST, $PORT, $DB, $USER, $PASS
$client = new xmlrpc_client("http://$HOST:$PORT/xmlrpc/common");
$msg = new xmlrpcmsg("login");
$msg->addParam(new xmlrpcval($DB, "string"));
$msg->addParam(new xmlrpcval($USER, "string"));
$msg->addParam(new xmlrpcval($PASS, "string"));
resp = $client->send($msg);
uid = $resp->value()->scalarval()
echo "Logged in as $USER (uid:$uid)"

// Create a new lead
$arrayVal = array(
'name'=>new xmlrpcval("A New Lead", "string") ,
'description'=>new xmlrpcval("This is a new lead from the web contact form" , "string"),
'inventor_id'=>new xmlrpcval($uid, "int"),
);

$msg = new xmlrpcmsg('execute');
$msg->addParam(new xmlrpcval($DB, "string"));
$msg->addParam(new xmlrpcval($uid, "int"));
$msg->addParam(new xmlrpcval($PASS, "string"));
$msg->addParam(new xmlrpcval("crm.lead", "string"));
$msg->addParam(new xmlrpcval("create", "string"));
$msg->addParam(new xmlrpcval($arrayVal, "struct"));
$resp = $client->send($msg);
?>






Tip

How to Link a Web Contact Form to OpenERP?

For technical information about how to link a web contact form to OpenERP, please also refer to the Technical Memento that you can download from http://www.openerp.com/community, the chapter about WebServices – XML-RPC.








客户分析挖掘

The segmentation tools let you create partner groups (or categories) and act on each segment differently according to questionnaires.
For example, you could create pricelists for each of the segments, or start phone marketing campaigns
by segment. To allow you to work with segments in OpenERP, you should install the crm_profiling module, which can also be achieved from the Configuration Wizard (Marketing - Profiling).

Profiling can be used to qualify your customers according to a questionnaire you define. When you establish a good customer profile, this will surely help you to close your deals. Customer profiles might even help you beat your competitors!


创建售前模板配置

During presales activities it is useful to qualify your prospects quickly. You can ask a series of
questions to find out what product / service to offer to the customer, or how quickly you should handle the
request.


Tip

Profiling

This method of rapidly qualifying prospects is often used by companies who carry out presales by
phone.
A prospect list is imported into the OpenERP system as a set of partners and the operators then
ask a series of questions to each prospect by phone.

Responses to these questions enable each prospect to be qualified automatically which leads to
a specific service being offered based on their responses.



As an illustration, take the case of a software company which offers a service based on the OpenERP
software. The company goes to several exhibitions and encounters dozens of prospects over a few
days. It is important to handle each request quickly and efficiently.

The products offered at these exhibitions are:


	training on OpenERP – for independent people or small companies,

	partner contract – for IT companies that intend to offer an OpenERP service,

	OpenERP as SaaS – for small companies,

	a meeting in conjunction with a partner to provide a demonstration aimed at providing a software
integration – for companies that are slightly larger.



The IT company has therefore put a decision tree in place based on the answers to several
questions to prospects. These are given in the following figure Example of Profiling Customer Prospects by the OpenERP Company:


[image: ../../../_images/crm_profile_tree_eng.png]
Example of Profiling Customer Prospects by the OpenERP Company



The sales person starts by asking the questions mentioned above and then after only a couple of minutes of
work, he can decide what to propose to the prospective customer simply by analysing the prospect’s answers.

At the end of the exhibition, prospects’ details and their responses to the questionnaire are entered
into OpenERP. The profiling system automatically classifies the prospects into appropriate partner
categories.

This enables your sales people to efficiently follow up prospects and adapt their approach according to
each prospect’s profile. For example, they can send a letter based on a template developed for a
specific partner category. They would use OpenERP’s report editor and generator for their sales
proposition, such as an invitation to a training session a week after the show.




高效使用配置模板

To use the profiling system, you have to install OpenERP’s crm_profiling module. You can also use the Reconfigure Wizard and add Marketing / Profiling.

Once the module is installed, you can create several questionnaires through the menu Sales ‣ Configuration ‣ Leads & Opportunities ‣ Questionnaires.  For each questionnaire, OpenERP allows you to create a list of questions and the possible responses through the menu Sales ‣ Configuration ‣ Leads & Opportunities ‣ Questions.

To obtain the scheme presented earlier you can create the following questions and responses:


Questionnaire for Defining Profiles





	Questions
	Possible Responses




	Journalist ?
	Yes / No


	Industry Sector ?
	IT / ERP Consultant / Services / Industry / Others


	Number of Staff ?
	1 / 2-20 / 21-50 / 51-100 / 101-500 / 500+


	Contact’s job function ?
	Decision-maker / Not decision-maker


	Already created a specification for the work ?
	Yes / Soon / No


	Implementation budget ?
	Unknown  / <100k / 101-300k / >300k





For instance, a sales person specializing in large accounts for the service sector could have a
profile defined like this:


	Budget for integration: Unknown , 100k-300k  or >300k ,

	Already created a specification for the work? Yes , No

	Industry Sector? Services .



When entering the details of a specific prospect, the prospect’s answers to various questions can be
entered in the Profiling tab of the Partner form. All you have to do is click the Use a Questionnaire button on the Profiling tab of the Partner form.

OpenERP will automatically assign prospects to the appropriate partner category based on these answers.

Customers corresponding to a specific search profile can be treated as a priority. The sales person
can access the profile of the large active accounts easily.
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管理你的账簿


如果管理系统很好的集成了会计系统，将会受惠于来自财务管理方面的显著支持。本部分涉及到会计实务处理和整个公司的会计
角色规划。



OpenERP的会计模块不仅仅帮助您更明确的遵循出票到付款的会计业务操作，还能通过使用多种财务工具基于实时数据和历史数据
进行分析。



您的会计账户结构可以完全按照A到Z配置好，从而最大可能的贴近您的公司业务情况。




	客户的开票和支付流程

	从开票到支付

	财务分析

	一步一步配置会计
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客户的开票和支付流程

OpenERP提供了多种方式来跟踪你的开票和付款记录。简单的开票流程以及高效的客户付款过程自动编目，使得OpenERP更易于被采用。
在本节中，我们讨论两个流程：一个是面向仅需跟踪付款记录的非会计人员的“简单流程”；另一个是完整会计流程。注：这里仅以客户流程
为例进行描述，当然对于供应商来说，OpenERP提供相同的开票和付款方法。



	简单的客户收据

	开票给你的客户

	跟踪客户的支付进程

	获取你的资金
	合作伙伴的财务分析

	多级提醒





	分析营业额
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  OpenERP 的开票流程也很简单,参见下面的工作流程图:


[image: ../../../_images/account_invoice_workflow.png]
开票流程



发票可根据其他各种文件生成，如销售订单，采购订单，或在确认发货时间时生成。 当您的OpenERP是一真正的集成系统时将提供这些方法.

当然，企业通常与记录这些信息的会计师一起工作。在这种情况下，您想知道哪些发票已经开出，并已支付。

Openerp中简明并易用的 开票 系统使你能跟踪您的账务，即使您不是一个专职财务人员。
它提供了一个简单的方法来跟踪你的供应商和客户。您可以使用这个简化的会计系统，即使您和专职财务人员一起工作的情况下，您仍然希望了解付款情况。
开票 系统包括了收款和付款 (一种跟踪销售和采购的简单方法). 它也提供一个简单的方法来登记付款，不需要您填写完整的会计信息


简单的客户收据

当您卖产品给客户时，您可以给他一个真正的发票或销售收据，这也被称为客户收据。销售收据仅仅是一种销售小票，而不是一个真正的发票。

当销售收据确认后，OpenERP的自动创建销售记录，并记录客户有关这张收据的付款情况。 简单的发票系统并不需要做大量的会计配置，因此您能很快上线并快速使用!

您可以通过以下菜单创建和修改销售收据 Accounting ‣ Customers ‣ Sales Receipt.


[image: ../../../_images/account_customer_receipt2.png]
创建客户收据



当您创建一张新的“销售收据”时，您必须录入“客户”——您想创建该凭证的对象。您可以在“销售信息”页签里面定义”销售明细行“，在这儿您必须定义“会计科目”，“金额”，“摘要”.
在表单底部， 您有两个“支付”选项：一个是“直接支付”， 另一个是“稍后付款或集中付款“.
当您选择”立即付款“选项，您必须录入银行“帐户”. 当您点击”计算税“按钮后，”总金额“会自动包含计算的税款（如果您添加了增值税信息）.

当您向供应商采购商品后，您会收到”采购收据“（一张票据），它在会计术语里叫”付款单据“。 When a purchase receipt is confirmed, it creates journal items automatically and you can record
the supplier payment related to this purchase receipt, just like for the sales receipts.

您可通过菜单 :menuselection:`Accounting –> Suppliers –> Purchase Receipt`创建或修改采购收据。


[image: ../../../_images/account_supplier_voucher2.png]
Purchase Receipt




Purchase Receipt 表单和 Sales Receipt 表单看起来很象。在这个表单中，请仔细选择分类帐。





开票给你的客户

很惊讶地看到在21世纪今天，大多数公司仍然采用手工处理报价单及发票，几乎都是通过邮寄或电子邮件的方式。但目前的明显趋势是这类传统媒体将会被即时通讯、社交网络等取代。电子数据交换（简称：EDI）平台在OpenERP中尝试与更多现代通讯系统相连接，在这个平台上，实现与合伙伙伴实时交换和同步电子文件。

最初的OpenERP支持某些特定的OpenERP的文件，如销售订单，采购订单和发票进行简单的电子数据交换（EDI)机制。

事实上，在OpenERP的集成电子邮件和发票系统允许您创建发票，并自动发送一封此发票的电子邮件链接给客户。

然后客户有几个选项。如果你的客户也有一个OpenERP的系统，只需通过点击你发送的链接，他可以很容易地导入此发票。

下面为你介绍一个EDI流程的例子：:


	贵公司发出销售订单，采购订单或发票给一个特定的合作伙伴，我们称呼为Camptocamp。

	合作伙伴Camptocamp收到一封可链接到在线预览文件的电子邮件。

	点击在线预览的文件，Camptocamp可以读取，下载或打印的PDF版本，然后选择几个选项：





	导入此文件在他自己的OpenERP的系统，只需通过提供系统地址;








	如需导入该文件，要求建立一个新的OpenERP的在线系统;








	合作伙伴可以通过相应的EDI导入系统，将原EDI文件导入到他自己的第三方软件.







	合作伙伴Camptocamp可以选择直接通过Paypal在线支付或任何其他贵公司提供的方式来付款.



自由定制的电子邮件模板 菜单 设置(Settings) ‣ 配置(Configuration) ‣ 电子邮件(Email) ‣ 模板(Templates).

要获得EDI和自动发送订单和发票电子邮件，你需要EDI模块，这里是默认安装的。你需要添加一个合作伙伴的电子邮件地址，并确保“选择退出”复选框未选中。请询问您的系统管理员配置发送邮件服务器。注意电子邮件通知将被添加到一个邮件队列中，在一段时间内处理，但你可以强制邮件直接发送：菜单选择：设置 - >电子邮件 - >信息.

您客户将收到的电子邮件，如图所示。.


[image: ../../../_images/account_edi_mail.png]
发邮件给您的客户






跟踪客户的支付进程

有效跟踪客户和供应商的付款是很重要的事，通过设定用户(User)表单中发票和付款（Invoicing & Payments）的访问权限，无论这个人员是否具备会计知识，都可以留意这些付款。

:guilabel:`客户付款(Customer Payment)允许您登记客户支付的款项。为了记录客户付款，你必须输入客户，付款方式（=日记账）及付款金额。OpenERP的会自动匹配核销未清的发票、销售单据、信用票据和（预付）款项。

你可以登记客户支付款项，从OpenERP菜单menuselection：会计(Accounting) ->客户(Customers)->客户付款(Customer Payment），点击新建登记付款。


[image: ../../../_images/account_cust_payment.png]
客户付款



假设您有张3000 EUR的发票，然而您从客户那里收到的是2995 EUR。 您可以认为该发票已经结清，您将如何处理呢？

创建一张新的 Customer Payment, 选择客户，输入 Paid Amount, 比如 2995 并选择 Payment Method, 也就是您的银行分类账。所有的未结清发票，Any open invoices, credit notes or advances for this partner will be displayed on the Payment Information tab.
In this example, the 3000 EUR invoice will be proposed.

Now you have to tell OpenERP that you want to consider the invoice as fully paid. Simply click the invoice line on the Payment Information tab to make it editable. Now select the Full Reconcile checkbox, and notice that the amount changes to the full amount of the invoice.


[image: ../../../_images/account_cust_reconcile.png]
Fully Pay



Select the proper option in the Payment Difference field, i.e. Reconcile Payment (you would use the Keep Open option if you want to claim the 5 EUR from the customer). The write-off amount is already proposed automatically, but you have to enter the Counterpart Account so that write-off entries can be generated by OpenERP. You can also enter a comment about the reconciliation (by default, Write-Off will be proposed). Then post your payment.


Note

Analytic Accounts

When you do analytic bookkeeping as well, you can enter an analytic account for the write-off too.



This easy payment system also allows you to post a payment that you cannot directly attribute to a customer as an advance.

Let us take the following example. A customer has two open invoices, one of 2000, one of 1500. He pays 1000, but you cannot assign this to any of the two invoices directly. You can just enter this payment as an advance. How do you proceed?

When you key in an Amount paid of 1000 in your Customer Payment, the amount will be attributed to the oldest invoice. You do not want this, because you have no idea yet of what invoice the amount should be linked to. Click the amount in the first line and set it to 0.
Validate the payment. The system will now create an advance payment of 1000 for the customer concerned.


Tip

Supplier Payment

The Supplier Payment form allows you to track the payment to your suppliers in the same way as a customer payment.



From the menu Accounting ‣ Suppliers ‣ Supplier Payment, click the New button to create a new Supplier Payment.


[image: ../../../_images/account_supplier_payment2.png]
Supplier Payment Form



Another way of keeping track of your payments is the way accountants will do it, by encoding Bank Statements. For more information about this, please refer to the chapter on invoicemanagement.

You can also push your accounting further by importing your payments electronically through a CODA file you receive from the bank. To do this install the account_coda module.

How should you proceed?

You have to enter your company’s bank account(s) for which you want to accept CODA files. Go to the menu Accounting ‣ Configuration ‣ Financial Accounting ‣ Accounts ‣ Setup your Bank Accounts. Choose the bank account type you want to use (IBAN or normal bank account). For electronic payments, you should use IBAN; do not forget to also enter your bank’s BIC code.


Tip

Bank Journal

When you save the bank account through the Setup your Bank Accounts wizard, a bank journal will be automatically created for that account.



Then add the bank account details for each partner that will pay you through a bank. You can do this in the Partner form, on the Accounting tab.

Download the CODA file from your bank to any directory. Import the electronic bank statement through the menu Accounting ‣ Periodical Processing ‣ Statements ‣ Import Coda Statements.

Enter the data required in the wizard (receivable and payable account, bank journal and a default account to post to when no corresponding partner is found). Then select the CODA file in your directory and click the Import button to start processing the CODA file.

OpenERP will then import a draft bank statement in the selected journal and will match all corresponding customer / supplier payments when possible. You can change the draft statement if necessary from the menu Accounting ‣ Bank and Cash ‣ Bank Statements. You can check any issues during file loading from the menu Accounting ‣ Bank and Cash ‣ Coda Import Logs.
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获取你的资金

OpenERP提供多种工具用来分析客户和供应商帐户。本章我们将解释：


	financial analysis of partners, to understand the reports that enable you to carry out an analysis
of all of your partners,

	multi-level reminders, which is an automatic system for preparing reminder letters or emails when
invoices remain unpaid,

	detailed analysis of individual partners.




合作伙伴的财务分析

When members of your accounting department sign in to OpenERP, they can immediately be presented with the Accounting Dashboard. By default, it contains the customer invoices to approve, a company analysis according to account type, a Treasury graph and a useful graph for analyzing aged receivables. Click the Accounting button in the top toolbar to open the dashboard. You can also call the dashboard from the menu Accounting ‣ Reporting ‣ Dashboard ‣ Accounting Dashboard.

In the dashboard, the graph at the right entitled Aged Receivables represents your receivables week by week. At a glance, you can see the cumulative amount of what your customers owe you by week.

All of OpenERP’s graphs are dynamic. So you can, for example, filter the data by clicking the graph itself and then Filter in the Search form. When you click the graph, data will be displayed in list view. Now you enter extra search criteria and then click the graph button to display the data as a graph again.

To obtain a more detailed report of the aged balance (or order by past date), use the menu Accounting ‣ Reporting ‣ Generic Reporting ‣ Partners ‣ Aged Partner Balance.

When you click that report, OpenERP shows a wizard asking you for the chart of accounts, the start date of the analysis period and the size of the interval to be analysed (in days). The start date will determine which documents will be included in the report (document date until the selected start date) and it will serve as a reference date to calculate the amounts due for the selected interval.
You can print an aged partner balance for Receivable Accounts or Payable Accounts of for both at the same time. The analysis direction may be Past (for entries that are due) or Future to keep track of your cash flow in the next days or weeks (according to your selection). OpenERP then calculates a table of credit balance by period. So, if you request an interval of 30 days, OpenERP generates an analysis of creditors for the past month, past two months, and so on.
An ageing balance will indicate how much of the accounts receivable is overdue. It also reports how far overdue the accounts are (number of days).


Tip

Aged Partner Balance

This report works best of you use payment terms or if you set a due date yourself.




[image: ../../../_images/account_aged_balance.png]
Aged Balance in the Past using a 30-days Period




[image: ../../../_images/account_aged_balance_fut.png]
Aged Balance in the Future using a 30-days Period



For an analysis by partner, you can use the partner balance that you get through the menu Accounting ‣ Reporting ‣ Generic Reporting ‣ Partners ‣ Partner Balance. The system then supplies you with a PDF report containing one line per partner representing debit, credit and balance. The total is displayed per account receivable.


[image: ../../../_images/account_partner_balance_61.png]
Partner Balance



If you want detailed information about all invoices, credit notes and payments related to partner, print the partner ledger from the menu Accounting ‣ Reporting ‣ Generic Reporting ‣ Partners ‣ Partner Ledger. You can choose to print one partner per page.


[image: ../../../_images/account_partner_ledger_61.png]
Partner Ledger



Furthermore, OpenERP also provides statistics about individual account entries, invoices and treasury, for instance. To look up statistic information about your accounting, explore the menu Accounting ‣ Reporting ‣ Statistic Reports. There you will find Invoices Analysis, Entries Analysis and Treasury Analysis to name some. By default these statistics are displayed as a list which you can filter to fit your needs. Standard filter buttons, extended filters and grouping features allow you to make an in-depth analysis of your accounting. But the list is not all OpenERP has to offer. These statistic reports can be displayed as a graph simply by clicking the Graph button at the top right side of the screen. Notice that graphs allow for only one Group by function at a time.


[image: ../../../_images/account_entries_anal.png]
Entries Analysis List View




[image: ../../../_images/account_entries_anal_graph.png]
Entries Analysis Graph View




Tip

Exporting Entries

Remember that you can export all types of resources in OpenERP.
From the web client, you need to navigate to a search list for the resource, then click the Export link at the bottom left of the list. From the GTK client, you would use the menu Form ‣ Export data. The Export feature enables you to easily create your own analysis in tools such as Microsoft Excel or Calc (LibreOffice or OpenOffice), simply by exporting accounting entries.






多级提醒

To automate the management of follow-ups (reminders) you should install the module account_followup (or check the Followups Management option in the Add More Features wizard).

This module is integrated with the email features of OpenERP. Ask your system administrator to define the smtp server through the menu Settings ‣ Configuration ‣ Email ‣ Outgoing Mail Servers.

Once the module is installed, configure your levels of follow-up using the menu Accounting ‣ Configuration ‣ Miscellaneous ‣ Follow-Ups.


Note

Follow-ups

You can define only one follow-up cycle per company, because you cannot link the follow-up cycle to a partner.



The levels of follow-up are relative to the due date; when no payment term is specified, the invoice date will be considered as the due date.

For each level, you should define the number of days and create a note which will automatically be added into the reminder letter. The order in which you define the various follow-up levels determines the order in which letters will be sent.


Example of Configuring Follow-up Levels







	Sequence
	Level
	Days
	Description




	1
	Level1
	15days net
	First payment reminder


	2
	Level2
	30days net
	Second reminder


	3
	Level3
	45days from end of month
	Put on notice





You can send your reminders by mail and/or email with the menu Accounting ‣ Periodical Processing ‣ Billing ‣ Send followups.


[image: ../../../_images/account_followup_wizard.png]
Prepare Reminders



OpenERP allows you to plan your reminders in the future; you could start a cycle today for invoices due at the end of the week, for instance.
OpenERP presents you with a list of partners who are due to be reminded, which you can modify before starting the procedure. On the Email Settings tab of the form, you can supply the information you will send in the email reminder.

You can either print the reminders or send them by email. From the Email Settings tab, you can select the Test Print checkbox to print the reminders as a preview only, without adding follow-up data to the reminded invoices. This way you can easily preview reminders to be sent.

The system then gives you a PDF report with all of the reminder letters for each partner. Each letter is produced in the language of the partner (if that is specified), so it is possible to have letters in different languages in the same PDF on several pages.

From the Journal Items view, you can check the due date of customers before starting the reminder procedure. You will get a list of unreconciled entries only by clicking the Unreconciled button. The best thing to do is open the unreconciled line in Form view; select the line and click the Form button at the top of the page. You can then easily modify the duedate, the last follow-up and the reminder level for each entry.

To obtain a detailed statistical report of sent follow-ups go to the menu Accounting ‣ Reporting ‣ Generic Reporting ‣ Partners ‣ Follow-ups Sent. This screen will let you analyse your reminder data in various ways, e.g. by follow-up level, by partner or for a combination of these data. You can also group by Latest Followup Date or Partner, for instance.

The different reports are standard OpenERP screens, so you can filter them and explore the elements in detail.


[image: ../../../_images/account_followup.png]
Reminder Statistics








分析营业额

Analyse your invoicing in OpenERP through the Invoices Analysis screen from the menu Accounting ‣ Reporting ‣ Statistic Reports ‣ Invoices Analysis.

In this statistic report, the columns displayed will vary according to the selections and grouping made, thus making it a very flexible report to analyse your invoices.

This report provides an overview of what has been invoiced to your customer as well as the average payment delays. To see the average due delay, make sure to group by Due Date.
You can easily group by partner, product category, ... or select only invoices that have not been confirmed yet.

This is also an easy way to check your sales people’s impact on turnover. You can see your turnover per product category, per salesman, per partner and many more options.


[image: ../../../_images/account_invoice_analysis.png]
Analysing your Invoices



To quickly see the total turnover per customer in a graph view, group by Partner and click the Graph button to change to graph mode.


[image: ../../../_images/account_turnover_analysis.png]
Analysing your Customer’s Turnover
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从开票到支付

本章分析OpenERP的会计的基本工作流，从填写发票到确认付款。介绍了具体各种操作，不仅包括填写会计凭证的分录，还有对账过程的账务处理（包括付款单等）。

总帐是公司管理的核心: 公司所有的业务都会影响它。它是一个信息员（有多少现金？什么样的债务需要偿还呢？库存价值多少？），并且，因为它提供的信息，可靠和详细的会计系统可以并且应该有一个重大决策的地位。

In most companies, accounting is limited to producing statutory reports and satisfying the
directors’ curiosity about certain strategic decisions, and to printing the balance sheet and the
income statement several times a year. Even then, there is often several weeks of delay between
reality and the report.


Note

Valueing your Accounting Function

In many small companies, the accounting function is poorly treated.

Not only do you see the data for documents being entered into the system twice,
but also the results are often just used to produce legal documents and regular printouts
of the balance sheet and income statements some weeks after the closing dates.

By contrast, integrating your accounts with your management system means that you can:


	reduce data entry effort – you only need to do it once,

	run your processes with the benefit of financial vision: for example, in managing projects,
negotiating contracts, and forecasting cash flow,

	easily get hold of useful information when you need it, such as a customer’s credit position.





So accounting is too often underused. The information it brings makes it a very effective tool
for running the company if it is integrated into the management system. Accounting information really
is necessary in all of your company’s processes for you to be effective, for example:


	for preparing quotations it is important to know the precise financial position of the client, and
to see a history of any delays in payment,

	if a given customer has exceeded his credit limit, accounting can automatically stop further
deliveries to the customer,

	if a project budget is 80% consumed, but the project is only 20% complete, you could renegotiate
with the client, or review and rein in the objectives of the project,

	if you need to improve your company’s cash flow then you could plan your service projects on the
basis of billing rates and payment terms of the various projects, and not just delivery dates –
you could work on short-term client projects in preference to R&D projects, for example.



OpenERP’s general accounting and analytic accounting handle these needs well because of the close
integration between all of the application modules. Furthermore, the transactions, the actions and
the financial analyses happen in real time, so that you cannot only monitor the situation but also
manage it effectively.

The account module in OpenERP covers general accounting, analytic accounting, and auxiliary
and budgetary accounting. It is double-entry, multi-currency and multi-company.


Note

Accounting


	General accounting (or financial accounting) is for identifying the assets and liabilities of the
business. It is managed using double-entry accounting which ensures that each transaction is
credited to one account and debited from another.

	Analytical accounting (or management accounting, or cost accounting) is an independent accounting
system, which reflects the general accounts but is structured along axes that represent the
company’s management needs.

	Auxiliary accounting reflects the accounts of customers and/or suppliers.

	Budgetary accounts predefine the expected allocation of resources, usually at the start of a
financial year.






Tip

多公司操作

在使用OpenERP多公司操作前, 请参考下面的情形进行配置选择:


	如果你的多个公司间只共用少部分数据(如产品, 合作伙伴以及其他),推荐你为每个公司独立创建一个帐套,

	如果你的多个公司间共用比较多的数据,那你就需要在同一个帐套中进行细致的权限规划配置了,




	you can synchronize specified document types in several databases using the base_synchro
module, which is a shared-funding module rather than a module in the standard open repositories.





One of the great advantages of integrating accounts with all of the other modules is in avoiding the
double entry of data into accounting documents. So in OpenERP, an Order automatically generates an
Invoice, and the Invoice automatically generates the accounting entries. These in turn generate tax
submissions, customer reminders, and so on. Such strong integration enables you to:


	reduce data entry work,

	greatly reduce the number of data entry errors,

	get information in real time and enable very fast reaction times (for bill reminders, for
example),

	exert timely control over all areas of company management.




Tip

For Accountants

You can configure the Accounting application using the information given in the configuration wizard.


[image: ../../../_images/config_wiz_account.png]


With appropriate rights management, this allows trustees to
provide customers with real-time access to their data. It also gives them the opportunity to work
on certain documents that have no direct accounting impact, such as budgets.

This can provide a value-added service that greatly improves the interaction between trustees and
their clients.



All the accounts are held in the default currency (which is specified in the company definition),
but each account and/or transaction can also have a secondary currency (which is defined in the
account). The value of multi-currency transactions is then tracked in both currencies.

For this chapter you should start with a fresh database that includes demo data,
with Sales Management installed and a generic chart of accounts.
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会计工作流和自动创建发票

The chart Accounting workflow for invoicing and payment shows the financial workflow followed by each invoice.


[image: ../../../_images/account_flow.png]
Accounting workflow for invoicing and payment



In general, when you use all of OpenERP’s functionality, invoices do not need to be entered
manually. Draft invoices are generated automatically from other documents such as Purchase Orders.


发票草稿

The system generates invoice proposals which are initially set to the Draft  state. While
these invoices remain unconfirmed, they have no accounting impact within the system. There is nothing
to stop users creating their own draft invoices if they want to.

You can create draft customer invoice manually using the menu Accounting ‣ Customers ‣ Customer Invoices.

The information that is needed for invoicing is automatically taken from the Partner form (such as
payment conditions and the invoice address) or from the Product (such as the account to be used) or
from a combination of the two (such as applicable Taxes and the Price of the product).


Tip

Draft Invoices

There are several advantages in working with draft invoices:


	You have got an intermediate validation state before the invoice is approved.
This is useful when your accountants are not the people creating the initial invoice,
but are still required to approve it before the invoice is entered into the accounts.

	It enables you to create invoices in advance, without approving them at the same time.
You are also able to list all of the invoices awaiting approval.








商业或形式发票

You can approve (or validate) an invoice in the Open  or Pro-forma  state.
A pro forma invoice does not have an invoice number yet, nor accounting entries.
It is commonly used as a preliminary invoice or for customs purposes.
It is more formal than a draft invoice and a pro forma invoice can later be converted to an open invoice.

An open invoice has a unique invoice number. The invoice is sent to the customer and is marked on
the system as awaiting payment.




核销和支付

In OpenERP, an invoice is considered to be paid when its accounting entries have been reconciled
with the payment entries. If there has not been a reconciliation, an invoice can remain in the Open
state until you have entered the payment.


Tip

Payment and Reconciliation

To avoid surprises, it is important to understand the idea of reconciliation and its link with
invoice payment.

You will find the Paid/Reconciled checkbox on an invoice.
It is checked if the Journal Entry of the invoice has been totally reconciled
with one or several Journal Entries of payment.




Note

Reconciliation

Reconciliation links entries in an account that cancel each other out – they are reconciled
to each other (sum of credits = sum of debits).

This is generally applied to payments against corresponding invoices.



Without the reconciliation process, OpenERP would be incapable of marking invoices that have been
paid. Suppose that you have got the following situation for the Smith and Offspring customer:


	Invoice 145: 50,

	Invoice 167: 120,

	Invoice 184: 70.



If you receive a payment of 120, OpenERP will delay reconciliation because there is a choice of
invoices to pay. It could either reconcile the payment against invoices 145 and 184 or against
invoice 167.


Tip

Treatment in Lots

Usually, different transactions are grouped together and handled at the same time rather than
invoice by invoice. This is called batch work or lot handling.

You can select several documents in the list of invoices: check the checkboxes of
the interesting lines using the web client and click the appropriate shortcut button at the right;
or shift-click the lines using the mouse in the GTK client and use the action or print button at
the top –
these give you the option of a number of possible actions on the selected objects.



At regular intervals, and independent of the invoices, an automatic import procedure or a manual
accounts procedure can be used to bring in bank statements. These comprise all of the payments of
suppliers and customers and general transactions, such as between accounts.

When an account is validated, the corresponding accounting entries are automatically generated by
OpenERP.

Invoices are marked as Paid when accounting entries on the invoice have been reconciled with
accounting entries about their payment.

This reconciliation transaction can be carried out at various places in the process, depending on
your preference:


	at data entry for the accounting statement,

	manually from the account records,

	automatically using OpenERP’s intelligent reconciliation.



You can create the accounting records directly, without using the invoice and account statements. To
do this, use the rapid data entry form in a journal. Some accountants prefer this approach because
they are used to thinking in terms of accounting records rather than in terms of invoices and
payments.

You should really use the forms designed for invoices and bank statements rather than manual data
entry records, however. These are simpler and are managed within an error-controlling system.




基于记录的会计系统

All the accounting transactions in OpenERP are based on records, whether they are created by an
invoice or created directly.

So, customer reminders are generated quickly from the list of unreconciled entries in the trade
receivables account for that partner. In a single reminder, you will find the whole set of unpaid
invoices as well as unreconciled payments, such as advance payments.

Similarly, financial statements such as the general ledger, account balance, aged balance (or
chronological balance) and the various journals are all based on accounting entries. It does not
matter if you generated the entry from an invoice form or directly in the invoice journal. It is the
same for the tax declaration and other statutory financial statements.

When using integrated accounting, you should still go through the standard billing process because
some modules are directly dependent on invoice documents. For example, a sales order can be
configured to wait for payment of the invoice before triggering a delivery. In such a case,
OpenERP automatically generates a draft invoice to send to the client.
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发票

OpenERP中, 发票管理包含以下部分:


	客户发票

	供应商发票

	客户红字发票

	供应商红字发票



这四类发票在系统是中同一对象, 仅仅只是发票类型与界面展现方式不一样.

OpenERP 为这四种类型的发票对应设置了四个菜单项,不同的菜单项会打开对应的发票表单, 从表单名就可以区分开.


Note

发票类型

多类型发票使用同一对象有很多方便之处,典型的优势如以下两点:


	多公司环境时公司间的发票,一个公司的客户发票则转为另一个公司的供应商发票.

	在同一个界面下, 你可以检索和处理各种类型的发票.在处理合作伙伴的应收/付帐时,你可以很清楚在这个列表中列出.






Note

Credit Note

A credit note is a document that enables you to cancel an invoice or part of an invoice.



点击菜单 会计(Accounting) ‣ 客户(Customers) ‣ 客户发票(Customer Invoices) 进入客户发票列表.
点击菜单 会计(Accounting) ‣ 供应商(Suppliers) ‣ 供应商发票(Supplier Invoices) 进入供应商发票列表.

通常情况,OpenERP中的发票都是由业务系统自动生成出来的.所以,一般不需要手工创建发票,只需要轻轻一点确认或审核即可.
OpenERP中一般有下面的几种途径去生成发票:


	来自供应商与客户的订单,

	from receipt or dispatch of goods,

	来自员工工单(timesheets, 参阅 人力资源管理的关键特性),

	来自完成的项目工作 (参阅 很棒的项目管理),

	from fee charges or other rechargeable expenses (see 提供高质量服务).



The different processes generate Draft  invoices. These must then be approved by a suitable
system user and sent to the customer. The different invoicing methods are detailed in the following
sections and chapters.

It is also possible to enter invoices manually. This is usually done for invoices that are not
associated with an order (usually purchase orders) or Credit Notes. Also, if the system has not been
configured correctly you might need to edit the invoice before sending it to the customer.

For example, if you have not realized that the customer is tax-exempt, the invoice you generate from an
order will contain tax at the normal rates. It is then possible to edit this out of the invoice
before validating it.


录入客户发票

OpenERP 的发票录入相当方便,而且支持非财务人员录入相应的发票信息.这意味着发票在生成到收款期间,随时可以保证
发票数据及相应税额计算的更新.

同时,具有会计权限的员工可以完成后续的凭证分录的处理.并且分录中的数据还可以继续修改确认.

点击菜单 会计(Accounting) ‣ 客户(Customers) ‣ 客户发票(Customer Invoices) 进入客户发票列表, 再点击 新建(New) 按钮
即可创建一张新的客户发票.

在新打开的发票窗体中,输入下面的信息.
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输入新发票



发票包含以下三部分:


	发票的抬头,是客户相关信息,

	发票主体部分,则是发票的明细行,

	发票的下面部分,则是关于所缴税行明细以及发票的汇总.



在填写发票信息的时候,你最好按OpenERP表单上的顺序填定数据.这样的目的是为了让你在录入一些数据后,能自动带出
其他字段的值.如,你选择一个客户后,下面的这些字段会被自动带出来:


	发票地址 默认使用了该客户联系人的发票地址,如果没有发票地址,则使用该客户联系人的默认地址,

	客户应收账款科目 默认使用了该客户窗体中 会计 页签中的 应收账款 科目,

	付款条件 也默认使用了该客户窗体中 会计 页签中的 付款条件, 如: “21天内付50%并在60天内付清余款”.




Note

Properties 字段

合作伙伴 或者 产品 上的 Property 字段是多公司类型的. 该字段的值取决于当前用户所属公司.

在一个账套上使用多公司配置,你可能需要为每个公司配置财务报表. 而且合作伙伴的 资产 与 负债 科目是也按公司分开的.




Tip

Seeing Partner Relationships

在OpenERP中, 你很多数据是相互关联的. 从某一个字段,可以引出相关的很多其他数据信息.


	In the web client in read-only mode, a relation is commonly a hyperlink
- it takes you to the main form for that entity, with all of the actions and links.

	使用浏览器访问时,在编辑模式下,你可以在字段上使用鼠标右键得到相关的功能菜单.

	在GTK客户端里,右键点击字段,可以得到一样的结果.



So one way or another you can rapidly reach the partner’s:


	current sales and purchases,

	CRM requests,

	草稿状态发票,

	accounts records,

	应收/应付科目.





录入发票其他相关内容并选择适当的发票币种.

发票表头输入完成后, 输入表体部分时, 你可以用下面两种方式来输入:


	表体各字段手工输入,

	选择一个产品, 让产品相关数据自动完成相关字段的输入.




Tip

发票明细备注

发票明细备注是对于明细摘要的补充.如果你对于发票明细添加更多的说明时,你只需要在明细窗体中的 备注(notes)
字段中输入即可.



接下去, 发票行选择 电脑兼容主机 产品, 下面的字段会自动带出:


	摘要(Description) : 默认由合作伙伴的产品名称带出,

	Account : determined by the purchase or sales account defined in the
product properties. If no account is specified in the product form, OpenERP uses the properties of
the category that the product is associated with.

	计量单位(Unit of Measure) : 默认由选择的产品的计量单位带出,

	单位价格(Unit Price) : 默认使用所选产品上的销售价格(不含税),

	税(Taxes) : 默认使用产品及合作伙伴窗体上定义的各种税.




Tip

使用含税价

通常情况下, OpenERP 发票等价格是使用的不含税价 – 你可以在OpenERP的税项配置中.勾选 含税价 勾选项而使用含
税价.




Note

产品相关信息

When you are entering invoice data, it can sometimes be useful to get hold of more information about
the product you are invoicing.
在 Web 客户端或者 Gtk 客户端 的 产品(Product) 字段编辑模式下点右键,可以看到关于产品的如下的一些信息:


	库存预测,

	产品成本结构,

	仓库产品库位.





输入完发票明细后, 你还可以继续修改自动带出的相关的信息.

输入完发票明细后,你可能点击 计算税额(Compute Taxes) 按钮, 发票会自动产生下面的相关税项:


	details of tax calculated,

	tax rate,

	total taxes,

	total price.



In the Taxes area at the bottom left of the invoice you will find the details of the totals
calculated for different tax rates used in the invoice.


Tip

计算税额

在发票税项区里双击明细行就可以查看相关税的详细信息.

OpenERP then shows you the detail of the tax charges which will form your tax
declaration at the end of the period.

It shows you the total that will be computed in the different parts of the legal declaration. This
enables you to manage the declaration in OpenERP automatically.
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Detail of tax charges on an invoice



Before approving the invoice you can modify the date and the accounting period, which are entered by
default as today’s date. These fields are found on the second tab Other Info.


Note

Invoice Layout

If you want to make your invoice layout more elaborate you can install the module
account_invoice_layout. This enables you to add various elements between the lines such as
subtotals, sections, separators and notes.



Click Validate when you want to approve the invoice. It moves from the Draft state to the Open  state.

When you have validated an invoice, OpenERP gives it a unique number from a defined sequence. By
default it takes the form Journal Code/Year/Sequence Number for example, SAJ/2010/005 . You cannot modify an
invoice number, but instead, you should modify the sequence numbers through the menu Administration ‣ Configuration ‣ Sequences ‣ Sequences.

Accounting entries corresponding to this invoice are automatically generated when you approve the
invoice. You see the details by clicking the entry in the Journal Entry field and searching
there for the account moves generated by that invoice number.




税的管理

Details on the product form determine the selection of applicable taxes for an
invoice line. By default, OpenERP takes account of all the taxes defined in the product form.

Take the case of the following product


	Applicable taxes:



	TVA: 19.6% type TVA

	DEEE: 5.5, type DEEE











Note

DEEE Tax

The DEEE tax (disposal of electronic and electrical equipment) is an ecological tax that was
imposed in France from 2009. It is applied to batteries to finance their recycling and is a fixed
sum that is applied to the before-tax amount on the invoice.



If you trade with a company in your own country, and your country has a DEEE-type tax, the
applicable taxes for this invoice could be:


	DEEE: 5.5,

	TVA: 19.6%.



If you sell to a customer in another company in the community (intracommunity), instead, then tax is
not charged. In the partner form, in the tab Accounting, the field Fiscal Position
maintains information whether the customer is within the region or not. When you create an invoice for this customer, OpenERP will calculate the following taxes on the product:


	DEEE: 5.5,

	TVA intracommunity: 0%.



If you have not entered the parameters in the customer form correctly, OpenERP will suggest incorrect
taxes in the invoice. That is not a real issue, because you can always modify the
information directly in the invoice before approving it.


Tip

Occasional Invoices

When you create an invoice for a product that will only be bought or sold once, you do not have to
encode a new product.
Instead, you will have to provide quite a bit of information manually on the invoice line:


	sales price,

	applicable taxes,

	account,

	product description.








取消发票

By default, OpenERP will not allow you to cancel an invoice once it has been approved. Since
accounting entries have been created, you theoretically cannot go back and delete them. However, in
some cases, it is more convenient to cancel an invoice when there is an error than to produce a credit
note and reconcile the two entries. Your attitude to this will be influenced by current legislation
in your accounting jurisdiction and your adherence to accounting purity.

OpenERP accommodates either approach. Install the account_cancel module. Then allow cancelling an invoice by checking the box
Allow Cancelling Entries in the Journal corresponding to this invoice. You will then be allowed to
cancel the invoice if the following two conditions are met:



	The accounting entries have not been reconciled or paid: if they have, then you will have to cancel
the reconciliation first.

	The accounting period or the fiscal year has not already been closed: if it is closed then no
modification is possible.






Cancelling an invoice has the effect of automatically modifying the corresponding accounting
entries.

要能取消发票, 你需要安装 account_cancel 模块, 并在你可以取消发票的账簿里配置 允许取消发票(Allow Cancelling Entries) 勾选项.
这时,只要未核销的发票均可以取消该发票, 并重置该发票到 草稿(Draft) 状态.


Tip

Numbering Invoices

Some countries require you to have contiguously numbered invoices (that is, with no break in the sequence).
If, after cancelling an invoice that you are not regenerating,
you find yourself with a break in the numbering you would have to go and modify the sequence,
redo the invoice and replace the sequence number with its original value.

You can control the sequences using the menu Administration ‣ Configuration ‣
Sequences ‣ Sequences.



Cancelling an invoice will cause a break in the number sequence of your invoices. You are
strongly advised to recreate this invoice and re-approve it to fill the hole in the numbering if you can.


Tip

Duplicating a Document

The duplication function can be applied to all the system documents: you can duplicate anything –
a product, an order, or a delivery.




Note

Duplicating Invoices

Instead of entering a new invoice each time, you can base an invoice on a similar preceding one
and duplicate it. To do this, first search for a suitable existing invoice. In the web client, show
the invoice in read-only (non-editable) form view, then click Duplicate. In the GTK client,
select Form ‣ Duplicate from the top menu.

The duplication creates a new invoice in the Draft state. That enables you to modify it before
approving it. Duplicating documents in OpenERP is an intelligent function, which enables the
duplicated invoice to be given its own sequence number, today’s date, and the draft state, even if
the preceding invoice has been paid.




Note

Saving Partner Preferences

OpenERP has many functions to help you enter data quickly. If you invoice the same products
frequently for the same partner you can save the last invoice preferences using conditional
default values.

To test this functionality, create an invoice for a partner and add some lines
(from the GTK client). Then right-click on the Invoice Line field and select
Set Default. Check the box that indicates this default should apply only to you.

Then the next time you create an invoice, these invoice lines will be
automatically created and you will only have to modify the quantities before confirming the invoice.

For taxes, you could put the default amount in the invoice lines (in France it would be
19.6%, in Belgium 21%, in the UK 17.5% or 15%). Doing this, you will not forget to add tax when you are
manually entering invoices.

(The capabilities of the GTK client are more extensive than those of the web client.
You can set defaults for multiple lines in the GTK client but only a single line in the web client,
so you need to be quite sure what is possible before you use this functionality routinely.)




Note

Getting Information by Navigating to it

As you are creating an invoice you will often find you need extra information about the partner to
help you complete the invoice. As described earlier, you can navigate to other
information linked to this partner by right-clicking, such as:


	Monthly Turnover

	Benefit Details,

	Most Recent Invoices,

	Latest Orders - Sales Order, Purchase Order.



Do the same to get information about the products you are invoicing. For example: is there enough
stock? When will you be getting more stocks in? What are the costs and normal list prices for this
product?

By making this information easily accessible while you are invoicing, OpenERP greatly simplifies
your work in creating the invoice.






创建供应商发票

The form that manages supplier invoices is very similar to the one for customer invoices. However,
it has been adapted to simplify rapid data entry and monitoring of the amounts recorded.


Tip

Entering Data

Many companies do not enter data on supplier invoices, but simply enter accounting data corresponding to
the purchase journal.

This particularly applies to users that have focused on the accounting system rather than all the
capabilities provided by an ERP system.
The two approaches reach the same accounting result: some prefer one and others prefer the other
depending on their skills.

However, when you use the Purchase Management functions in OpenERP you should work directly on
invoices because they are provided from Purchase Orders or Goods Receipt documents.



To enter a new supplier invoice, use the menu Accounting ‣ Suppliers ‣ Supplier Invoices.

Everything is similar to the customer invoice, starting with the Journal
unless the default is acceptable, and then the Supplier, which will automatically complete the following fields


	Invoice Address,

	Partner Account.



Unlike the customer invoice, you do not have to enter payment conditions – simply a Due
Date if you want one.
If you do not give a due date, OpenERP assumes that this invoice will be paid in cash.
If you want to enter more complete payment conditions than just the due date, you can use the Payment
Term field which you can find on the second tab Other Info.

You must also enter the invoice Total with taxes included. OpenERP uses this amount
to check whether all invoice lines have been entered correctly before it will let you validate the
invoice.

Indicate the Currency if the invoice is not going to use the default currency, then you can enter
the Invoice lines.

Just like the customer invoice, you have the choice of entering all the information manually or use
a product to complete many of the fields automatically. When you enter a product, all of the following
values are completed automatically:


	the product Account is completed from the properties of the product form or the
Category of the product if nothing is defined on the product itself,

	the Taxes come from the product form and/or the partner form, based on the same
principles as the customer invoice,

	the Quantity is set at 1 by default but can be changed manually,

	set the Unit Price from the total price you are quoted after deducting all
the different applicable taxes,



Click Compute Taxes to ensure that the totals correspond to those indicated on
the paper invoice from the supplier. When you approve the invoice, OpenERP verifies that the total
amount indicated in the header corresponds to the sum of the amounts without tax on the invoice lines
and the different applicable taxes.

OpenERP automatically completes the Date Invoiced and the accounting period.


Note

Dates and Accounting Periods

Accounting periods are treated as legal period declarations. For example, a tax declaration for an
invoice depends on the accounting period and not on the date of invoicing.

Depending on whether your declarations are made monthly or quarterly, the fiscal year contains
either twelve or four accounting periods.

The dates are shown in the document you created in the accounting system. They are used for
calculating due dates.



The two pieces of information do not have to have the same date. If, for example, you receive an
invoice dated 5th January which relates to goods or services supplied before 31st December, the
invoice may be coded into the December accounting period and thus be recognized in that period for
the tax declaration, while the invoice can remain 5th January which remains the basis of the due
date for payment.

You can find that the amounts do not correspond with what your supplier has given you on paper for
reasons that can include:


	the supplier made a calculation error,

	the amounts have been rounded differently.




Tip

Rounding Tax

It often happens that a supplier adds 1 to the total because the tax calculation has been rounded
upwards. Some tax amounts are not valid because of this rounding.

For example, it is impossible to arrive at the amount of 145.50 if you are working to a precision of 2
decimal places and a rate of 19.6%:


	121.65 x 1.196 = 145.49

	121.66 x 1.196 = 145.51





In this case you can modify a value in the lines that the total is based on, or the total amount of
taxes at the bottom left of the form: both are editable so that you can modify them to adjust the
total.

When the totals tally, you can validate the invoice. OpenERP then generates the corresponding
accounting entries. You can manage those entries using the Account fields on the
invoice and on each of the invoice lines.




欠款单据/ 偿还

Entering a customer credit note is almost identical to entering a customer invoice. You just start
from the menu Accounting ‣ Customers ‣ Customer Refunds.

Similarly, entering a supplier credit note is the same as that of the supplier invoice, and so you
use the menu Accounting ‣ Suppliers ‣ Supplier Refunds.

It is easy to generate a credit note quickly from an existing invoice. To do this, select a customer
or supplier invoice which is in Open or Paid state and click the Refund button. OpenERP
opens a new payment invoice form for you in the Draft  state so that you can modify it before
approval.


Tip

Crediting Several Invoices

You can credit more than one customer invoice using the menu Accounting ‣ Customers ‣
Customer Payment. You can find the Invoices and outstanding transactions and Credits for the particular customers.
Enter the amount in the field Paid Amount and validate it.






支付

An invoice is automatically marked as Paid by OpenERP once invoice entries have been reconciled
with payment entries. You yourself do not have to mark the invoices as paid: OpenERP manages that
when you reconcile your payments.


Tip

Reconciling a Credit Note

Generally, you reconcile the invoice’s accounting entries with their payment(s).
But you can also reconcile an invoice with the entries from the corresponding credit note instead,
to mutually cancel them.



You have seen the Payment button in the invoice form which is in Open state.
This lets you enter payments and get entries reconciled very quickly.

You can also manage the payment of invoices when you are entering bank statements and cash
transactions. These allow better control of financial transactions and permit greater flexibility in
areas such as:


	advance and partial payments of invoices,

	payment of several invoices by several payments,

	fine-grained management of different due dates on the same invoices,

	management of adjustments if there are different amounts to those on the invoice.
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会计分录

创建会计分录有多种方法。 比如，你已经清楚地了解了发票是怎么来创建它的分录。

本节讨论


	银行对账单的管理，

	现金管理，

	账簿分录管理。



这里我们给你展示如何进入财务交易。在OPENERP中，你可以处理银行对账单和现金记录。 对这两种交易使用不同的账簿。根据选择的账簿类型，you will have a different screen.


管理银行对账单

OpenERP提供了一个可视化的工具来管理银行对账单，简化了账户数据的录入。
当对账单被确认时，OPENERP就会自动生成相应的会计分录。 所以，非会计人员无需担心贷方，借方和counterparts这些事，也可以记录财务事项。

记录一张银行对账单， 转到菜单 会计(Accounting) ‣ 银行和现金(Bank and Cash) ‣ 银行对账单(Bank Statements) 。
输入数据到银行对账单的表单然后打开如图所示 银行对账单录入界面.
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银行对账单录入界面



单据引用的 名称 和 日期 是由OPENERP自动推荐的。这个 名称 在银行对账单确认的时候将被单据编号补充。 你可以通过管理序列号来配置你自己的引用，在 Administration ‣ Configuration ‣ Sequences 系统管理员 ‣ 设置 ‣ 序列 菜单。

接着选择 账簿(Journal). 一般来讲,在期初建立账套的时候,最好为公司的每一个银行账户及现金户各建立一个对应的
账簿(Journal). 然后在这里,你选择与本次银行对账相应的账簿即可.

银行对账单明细行上的币种会沿用对账单所属账簿的币种设置. 如你的银行对帐单明细是 美元(USD), 则你对应应该输入
美元(USD) 的金额. 在确认单据时,非公司本币位的币种会自动按当时有效汇率转换为公司本币位币种. (所以,您必须
首先在 会计(Accounting) ‣ 配置(Configuration) ‣ 其它(Miscellaneous) ‣ 货币(Currencies) 处建立相关币种的汇率)

OpenERP 会自动将上一次对账的余额处理到本次对账单的期初余额中.
You can modify this value and force another value. This lets you enter
statements in the order of your choice. Also if you have lost a page of your statement, you can enter
the following ones immediately and you are not forced to wait for a duplicate from the bank.

So, complete the closing balance which corresponds to the new value in the account displayed on your
bank statement. This amount will be used to control the operations before approving the statement.

接着就是按银行的回单逐行输入进银行对帐单明细中.

输入本次对账的所有交易明细行.
你可以手工录入这些交易明细,你也可以点击 导入发票(Import Invoices) 按钮来自动生成交易明细.




手工分录

当你输入一个合作者的名字, OpenERP 自动调用相应的中央集权的帐户. The total amount due for the customer or supplier is pre-completed (Amount). This gives you a simple indication of the effective payment. You
must then enter the amount that appears on your statement line: a negative sign for a withdrawal and
a positive sign for a cash payment or deposit.

在 收/付款(Payment) 界面按下键 F1 会自动将需要核销的凭证行与本次付款对应起来.




导入发票

点击 导入发票(Import Invoices) 按钮, 选择你要与付款相核销的发票行,并点击 添加(Add) 按钮. 点击OK确认选择; the statement line will automatically be added with the corresponding reconciliation.
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与银行对帐单的核销




Note

核销

OpenERP 有很多种核销方式: 你可以在支付发票时, 直接选择与之对应的发票相关的凭证行进行核销.也可以
使用 自动核销 工具进行自动核销.

你可以将相关金额全额核销,也可以仅核销一部分.



如果在你的收付款与发票的核销金额不一致时,OpenERP 会进入 销账(Write-off) 向导, 允许你将核销不平衡
余额调账到一个指定的会计科目中去. 通常使用下面的方式去调整余额:


	记入利润或者亏损,

	记入汇兑损益,

	记入销售折扣/回扣/佣金/返利等相关科目.



当付款金额与待付款项和调整科目项之和的金额相符时,就可以完成本次核销.

你还可以选择后面再处理本次核销余额.核销操作会处理两件事:


	标记发票已核销,

	防止已清账的支付信息与发票信息的客户提醒支付邮件重复发送, 客户收到的仅是未核销的支付与发票信息. 如果与
客户相互达成一致对某些欠款或者不明款项进行销账,也可以在核销中处理.



然后,你再确认一下. 只要余额平衡OpenERP 会自动生成对应的凭证分录. 对应的相关发票也会自动标记为已支付.

You can also enter general accounting entries, for example, banking costs. In such cases, you can enter the amounts directly in the corresponding general accounts.

A user with advanced accounting skills can enter accounting entries directly into the bank journal from Accounting ‣ Journal Entries -> Journal Items. The result is the same, but the operation is more complex because you must know the
accounts to use and must have mastered the ideas of credit and debit.




现金管理

要进入现金管理, 请点击菜单 会计 ‣
银行和现金 ‣ 现金记录. 然后每天在 初始余额(Opening Balance) 处输入当前的现金期初盘点.Then open the cashbox to start making entries from the Cash Transactions tab.


[image: ../../../_images/account_cash_registers.png]
定义现金记录(Cash Registers)



All the transactions throughout the day are then entered in this statement. When you close the cashbox, generally at the end of the day, enter the amounts on the CashBox tab, in the
销账(Closing Balance) section. Then confirm the statement to close the day’s cash statement and automatically
generate the corresponding accounting entries. Note that the Calculated Balance and the CashBox Balance need to be equal before you can close the cashbox.


Tip

确认对账单

Accounting entries are only generated when the cash statement is confirmed.
So if the total statement has not been approved (that is to say during the day, in the case of petty
cash), partner payments will not have been deducted from their corresponding account.






管理账簿中的分录

Invoices and statements produce accounting entries in different journals. But you could also
create entries directly in a journal (line by line) without using the dedicated journal views. This functionality is
often used for miscellaneous entries.

手工录入凭证时,进菜单 会计(Accounting) ‣ 会计凭证(Journal Entries) ‣ 会计凭证明细(Journal Items). 在 凭证明细列表页 选择适当的 账簿(Journal) 再点击 搜索(Find) 进行过滤. 这时如果你新建凭证行时, 新的凭证行则默认会记账到你过滤选择的账簿.

下面看一下采购发票的例子,在OpenERP中自动生成会计凭证分录.

点击 新建(New) 按钮, 并按下面的内容填写:


	参考(Reference): 发票及凭证相关的参考信息,

	发生日期(Effective date): 记账的日期,通常使用操作当天的日期,

	会计期间(Period): 业务发生时的会计期间, 通常情况下应该是当前的会计期间,

	合作伙伴(Partner): 与本次业务相关的合作伙伴,

	科目(Account): 记账科目 (如采购科目 材料采购(Products Purchase) ),

	摘要(Name): 发票行的摘要(如: PC2 ),

	借方(Debit): 借方的金额.

	账簿(Journal): 选择要记入的账簿.

	贷方(Credit): 贷方的金额.



按 回车(Enter) 键保存. 凭证会有一个简单的自动编号.因为凭证借贷方并不平衡,所以录入的数据行都是红色的状态.并且
默认情况下录入的发票行都处于草稿状态,还不会直接影响财务报表数据.因此,你需要将该凭证记账.注意凭证中的凭证行的借贷方的金额
必须平衡.

OpenERP now proposes the balancing accounting line to be filled in. If the account used (in this
case account 600000 ) includes taxes by default OpenERP automatically
proposes taxes associated with the amount entered. At this stage you can modify and validate this
second line of the account, or replace it with other information such as a second purchase line.

When you have entered all of the data from your lines, OpenERP automatically proposes counterpart
entries to you, based on the credit entries.


Tip

关于借贷平衡

When an accounting entry is matched, OpenERP moves it to the Valid state automatically and
prepares to enter the next data. Do not forget to definitely post the valid entries by clicking the Action
button and selecting Post Journal Entries.

If you want to add some other balancing lines you can enter the number of the entry on the new line
that you are entering.
In such a case the whole line stays Draft until the whole set balances to zero.






核销过程

The reconciliation operation consists of matching entries in different accounts to indicate that
they are related. Generally reconciliation is used for:


	matching invoice entries to payments, so that invoices are marked as paid and customers do not get
payment reminder letters for those entries (reconciliation in a customer account),

	matching deposits and cheque withdrawals with their respective payments,

	matching invoices and credit notes to cancel them out.



A reconciliation must be carried out on a list of accounting entries by an accountant, so that the
sum of credits equals the sum of the debits for the matched entries.

Reconciliation in OpenERP can only be carried out in accounts that have been configured as
reconcilable (the Reconcile field).


Tip

Do not confuse account reconciliation and bank statement reconciliation

It is important not to confuse the reconciliation of accounting entries with bank statement
reconciliation.
Account reconciliation consists of linking account entries with each other, while statement reconciliation consists of
verifying that your bank statement corresponds to the entries of that account in your accounting system.
You can perform statement reconciliation using the menu Accounting ‣ Periodical Processing ‣ Statements ‣ Statements Reconciliation.



There are different methods of reconciling entries. You have already seen the reconciliation of
entries while doing data entry in an account. Automatic and manual reconciliations are described
here.


自动核销

自动核销是让OpenERP自动从凭证行中按每个合作伙伴检索出金额相符的对应的双向凭证并标记为已核销.

Depending on the level of complexity that you choose (= power) when you start running the tool, the software
could reconcile from two to nine entries at the same time. For example, if you select level 5,
OpenERP will reconcile, for instance, three invoices and two payments if the total amounts correspond.
Note that you can also choose a maximum write-off amount, if you allow payment differences to be posted.


[image: ../../../_images/account_reconcile_auto.png]
自动核销界面



To start the reconciliation tool, click Accounting ‣ Periodical Processing ‣ Reconciliation ‣ Automatic Reconciliation.

自动核销弹出窗口后, 填写如下数据:


	核销科目(Accounts to Reconcile) : 选你将要核销的一个,几个甚至全部可以允许核销的科目,

	需要核销的数据时间范围 (起始日期(Starting Date) / 结束日期(Ending Date)),

	the Reconciliation Power  (from 2  to 9 ),

	允许销账(Allow write off) 是否将核销借贷方的差异进行销账处理.

	information needed for the adjustment (details for the Write-Off Move).




Note

Reconciling

You can reconcile any account, but the most common accounts are:


	all the Accounts Receivable – your customer accounts of type Debtor,

	all the Accounts Payable – your supplier accounts of type Creditor.





The write-off option enables you to reconcile entries even if their amounts are not exactly
equivalent. For example, OpenERP permits foreign customers whose accounts are in different
currencies to have a difference of up to, say, 0.50 units of currency and put the difference in a write-
off account.


Tip

Limit Write-off Adjustments

You should not make the adjustment limits too large. Companies that introduced substantial automatic
write-off adjustments have found that all employee expense reimbursements below the limit were
written off automatically!




Note

默认值

If you run the automatic reconciliation tool regularly, you should set default values for each
field by using the right-click mouse button in the web client (in edit mode) or the GTK client.
The resulting context menu enables you to set default values.
This means that you will not have to retype all the fields each time.






手工核销

For manual reconciliation, open the entries for reconciling an account through the menu Accounting ‣ Periodical Processing ‣ Reconciliation ‣ Manual Reconciliation.

You can also call up manual reconciliation from any screen that shows accounting entries.

Select entries that you want to reconcile. OpenERP indicates the sum of debits
and credits for the selected entries. When these are equal you can click the Reconcile Entries
button to reconcile the entries.



Note

Example Real Case of Using Reconciliation


Suppose that you are entering customer order details. You wonder what is outstanding on the
customer account (that is the list of unpaid invoices and unreconciled payments). To review
it from the order form, navigate to the Partner record and select
the view Receivables and Payables. OpenERP opens a history of unreconciled accounting entries
on screen.



[image: ../../../_images/account_sample2_entries.png]
Unreconciled Accounting Entries



After running the Reconcile Entries wizard, these lines can no longer be selected and will not appear when the                                entries are listed again. If there is a difference between the two entries, OpenERP suggests you to make
an adjustment. This “write-off” is a compensating entry that enables a complete reconciliation. You must
therefore specify the journal and the account to be used for the write-off.











For example, if you want to reconcile the following entries:


Entries for reconciliation









	Date
	Ref.
	Description
	Account
	Debit
	Credit




	12 May 11
	INV23
	Car hire
	4010
	544.50
	


	25 May 11
	INV44
	Car insurance
	4010
	100.00
	


	31 May 11
	PAY01
	Invoices n°23, 44
	4010
	
	644.00





On reconciliation, OpenERP shows a difference of 0.50. At this stage you have two possibilities:


	do not reconcile, and the customer receives a request for 0.50,

	reconcile and accept an adjustment of 0.50 that you will take from the P&L account.



OpenERP generates the following entry automatically:


Write-off account









	Date
	Ref.
	Description
	Account
	Debit
	Credit




	Date
	Ref.
	Description
	Account
	Debit
	Credit


	03 Jun 11
	AJ001
	Adjustment: profits and losses
	4010
	
	0.50


	03 Jun 11
	AJ001
	Adjustment: profits and losses
	XXX
	0.50
	





The two invoices and the payment will be reconciled in the first adjustment line. The two invoices
will then be automatically marked as paid.








支付管理

OpenERP gives you forms to prepare, validate and execute payment orders. This enables you
to manage issues such as:



	Payment provided on several due dates.

	Automatic payment dates.

	Separating payment preparation and payment approval in your company.

	Preparing an order during the week containing several payments, then creating a payment file at
the end of the week.

	Creating a file for electronic payment which can be sent to a bank for execution.

	Splitting payments depending on the balances available in your various bank accounts.







如何管理你的付款单

To use the tool for managing payments you must first install the module account_payment, or install Supplier Payments from the Configuration Wizard.
It is part of the core OpenERP system.

The system lets you enter a series of payments to be carried out from your various bank
accounts. Once the different payments have been registered, you can validate the payment orders.
During validation you can modify and approve the payment orders, sending the order to the bank
for electronic funds transfer.

For example, if you have to pay a supplier’s invoice for a large amount you can split the payments
amongst several bank accounts according to their available balance. To do this, you can prepare
several draft orders and validate them once you are satisfied that the split is correct.

This process can also be regularly scheduled. In some companies, a payment order is kept in Draft
state and payments are added to the draft list each day. At the end of the week, the accountant
reviews and confirms all the waiting payment orders.

Once the payment order is confirmed, there is still a validation step for an accountant to carry out.
You could imagine that these orders would be prepared by an accounts clerk, and then approved by a
manager to go ahead with payment.


Tip

Payment Workflow

An OpenERP workflow is associated with each payment order. Select a payment order, and
if you are in the GTK client
click Plugins ‣ Print workflow from the top menu.

You can integrate more complex workflow rules to manage payment orders by adapting the workflow.
For example, in some companies payments must be approved by a manager under certain cash flow or
value limit conditions.




[image: ../../../_images/account_payment_workflow.png]
Payments Workflow



In small businesses it is usually the same person who enters the payment orders and who validates
them. In this case you should just click the two buttons, one after the other, to confirm the
payment.




准备和传输付款单

To enter a payment order, use the menu Accounting ‣ Payment ‣ Payment Orders.


[image: ../../../_images/account_payment_order.png]
Entering a Payment Order



OpenERP then proposes a reference number for your payment order.

You then have to choose a payment mode from the various methods available to your company. These
have to be configured when you set up the accounting system using the menu Accounting ‣
Configuration ‣ Miscellaneous ‣ Payment Mode. Some examples are:


	Cheques

	Bank transfer,

	Visa card on a bank account,

	Petty cash.



Then, you set the Preferred date for payment:


	Due date : each operation will be effected at the invoice deadline date,

	Directly : the operations will be effected when the orders are validated,

	Fixed date : you must specify an effective payment date in the Scheduled date
if fixed field that follows.



The date is particularly important for the preparation of electronic transfers, because banking
interfaces enable you to select a future execution date for each operation. So to configure your
OpenERP, most simply you can choose to pay all invoices automatically by their deadline.

You must then select the invoices to pay. They can be entered manually in the field
Payment Line, but it is easier to add them automatically. For that, click Select Invoices to Pay
and OpenERP will then propose lines with payment deadlines. For each deadline you
can see:


	the invoice Payment Date,

	the reference Invoice Ref.,

	the deadline for the invoice,

	the amount to be paid in the partner’s default currency.



You can then accept the payment proposed by OpenERP, or select the entries that you will pay or not
pay on that order. OpenERP gives you all the necessary information to make a payment decision for
each line item:


	account,

	supplier’s bank account,

	amount that will be paid,

	amount to pay,

	the supplier,

	total amount owed to the supplier,

	due date,

	date of creation.



You can modify the first three fields on each line: the account, the supplier’s bank account and the
amount that will be paid. This arrangement is very practical because it gives you complete
visibility of all the company’s trade payables. You can pay only a part of an invoice, for example,
and in preparing your next payment order OpenERP automatically suggests payment of the remainder
owed.

When the payment has been prepared correctly, click Confirm Payments. The payment then changes to
the Confirmed  state and a new button appears that can be used to start the payment process.

In future versions of OpenERP, it is expected that the system will be able to prepare and print
cheques.

As usual, you can change the
start point for the payment workflow from the
Administration ‣ Customization ‣ Workflow menus.
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财务分析


This chapter is dedicated to statutory taxation and financial reporting from OpenERP.
Whether you need reports about customers and suppliers, or statements for various statutory purposes,
OpenERP enables you to carry out a whole range of parametric analyses regarding the financial health of
your company.


Whether you want to analyze the general health of your company or review the status of an Account
Receivable in detail, your company’s accounts are the place to define your various business
indicators.

To show you the most accurate picture of your business, OpenERP’s accounting reports
are flexible, and the results are calculated in real time. This enables you to automate recurring
actions and to change your operations quickly when a company-wide problem (such as cash reserves
dropping too low or receivables climbing too high) or a local problem (a customer that has not paid,
or a project budget overspend) occurs.

This chapter describes the various reports and financial statements supplied by OpenERP’s
accounting modules. It also describes how OpenERP handles purchase and sales taxation, and the
related tax reporting.

For this chapter you should start with a fresh database that includes demo data,
with sale and its dependencies installed and no particular chart of accounts configured.



	总账和试算平衡表

	资产负债表和损益表

	账户分类账
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总账和试算平衡表

A general ledger includes accounts with their debits and credits, and shows all transactions in an account, for one period, for several periods or for a financial year.

To print the General Ledger, you can use the menu Accounting ‣ Reporting ‣ Legal Reports ‣ Accounting Reports ‣ General Ledger.
You will find the following wizard which is used to filter the resulting report.


[image: ../../../_images/account_wizard_report.png]
Preparing a General Ledger



Select the proper options and journal(s) from the above wizard to print the General Ledger. The report can also be filtered by date or by period. When you choose to print the general ledger from one date to another, or for one or more periods, you can also have the initial balances printed for the periods preceding the periods you selected.
You can sort the report by date or by journal / partner.


[image: ../../../_images/account_general_ledger.png]
General Ledger




Tip

General Ledger for one or more accounts

When you want to print the general ledger for one or more accounts, go to the menu Accounting ‣ Configuration -> Financial Accounting ‣ Accounts ‣ Accounts. Select the account(s) for which you want to print the general ledger and click the General Ledger report at the right side of the screen.



While the general ledger displays transactions for an account, a trial balance will show one amount (either debit or credit) for each account. The aim of the trial balance is to prove that the total of all debit balances is equal to the total of all credit balances.

To print the Trial Balance, go to the menu Accounting ‣ Reporting ‣ Legal Reports ‣ Accounting Reports ‣ Trial Balance.
This report allows you to print or generate a PDF of your trial balance, allowing you to quickly check the balance of each of your accounts in a single report. A trial balance may include all accounts (even the ones without balance), only accounts with transactions or accounts of which the balance is not equal to zero. You can print a trial balance for all posted entries (meaning entries with a Valid state) or all entries, in which case the report will also print entries in a draft state. This option is useful, for instance, when your new financial year has just been opened, and you are preparing miscellaneous entries in the previous financial year.


[image: ../../../_images/account_trial_balance.png]
Trial Balance




Tip

Reporting for One or More Accounts

You can print the Trial Balance report directly from the Account form too.






资产负债表和损益表

OpenERP also offers a Balance Sheet and a Profit & Loss Report.

A Balance Sheet is a financial statement that summarises the assets, liabilities and shareholders’ equity of a company at a specific point in time. These three balance sheet segments give investors an idea as to what the company owns and owes, as well as the amount invested by the shareholders.

The balance sheet complies with the formula below:

Assets = Liabilities + Shareholders’ Equity.

A balance sheet is often described as a snapshot of a company’s financial condition.

The accounts displayed in the Balance Sheet are linked to an account type for which the P&L / Balance Sheet parameter is set to Balance Sheet (either Assets or Liabilities account). To configure Account Types, go to Accounting ‣ Configuration ‣ Financial Accounting ‣ Accounts ‣ Account Types.

The Balance Sheet can be printed from the menu Accounting ‣ Reporting ‣ Legal Reports ‣ Accounting Reports ‣ Balance Sheet. You can print this report in Landscape mode too.


Tip

Reserve & Profit and Loss Account

A Balance Sheet needs a reserve & profit and loss account, but instead of entering it each time you start the report, you can add a default Reserve & Profit and Loss account through the menu:menuselection:Settings –> Companies –> Companies on the Configuration tab. This account will be used as a counterpart to balance your accounts.



The Profit & Loss Report is a financial statement which gives a summary of the revenues, costs and expenses during a specific period of time. Such a report provides information that shows the ability of a company to generate profit by increasing revenue and reducing costs. The P&L statement is also known as an “Income Statement”.

The purpose of the Profit & Loss Report is to show managers and accountants whether the company earned or lost money during the report period.

In general, the Profit and Loss report will be used to determine profit ratios, to examine sales prices and costs, and to set marketing budgets, for instance.

The accounts displayed in the Profit and Loss Report are linked to an account type for which the "P&L / Balance Sheet parameter is set to Profit & Loss (either Expense or Income account). To configure Account types, go to Accounting ‣ Configuration ‣ Financial Accounting ‣ Account Types.

The Profit and Loss report can be printed from the menu Accounting ‣ Reporting ‣ Legal Reports ‣ Accounting Reports ‣ Profit And Loss.


[image: ../../../_images/account_profit_loss.png]
Profit and Loss Wizard
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Profit and Loss Report






账户分类账

A journal allows you to list entries in chronological order (by default according to date). Each entry posted in OpenERP is recorded in such a journal. To configure the different accounting journals, go to the menu Accounting ‣ Configuration ‣ Financial Accounting ‣ Journals ‣ Journals.


[image: ../../../_images/account_journal_form.png]
Defining a Journal



OpenERP provides three main reports regarding the journals:


	To print a Journal, use the menu Accounting ‣ Reporting ‣ Legal Reports ‣ Journals ‣ Journals. This report will show all entries per journal, e.g. sales entries, purchase entries, etc. Each transaction is mentioned, with date, reference, document number, account, partner, description and debit and credit amount. The Journal report can be printed per period and per journal.




[image: ../../../_images/account_journal_print.png]
Printing a Journal




	To print a General Journal, use the menu Accounting ‣ Reporting ‣ Legal Reports ‣ Journals ‣ General Journals. A General Journal will print a page per period for any journal entries posted in that period, and totalised per journal. The report will show the period, the journal, debit, credit and balance, but no details of the related entries.




[image: ../../../_images/account_gen_journal_print.png]
Printing a General Journal




	To print a Centralizing Journal, use the menu Accounting ‣ Reporting ‣ Legal Reports ‣ Journals ‣ Centralizing Journal. A centralizing journal gives a summary per account for each journal and period of debit, credit and balance.




[image: ../../../_images/account_cent_journal_print.png]
Printing a Centralizing Journal






纳税申报

Information required for a tax declaration is automatically generated by OpenERP from invoices. In the section on invoicing, you will have seen that you can get details of tax information from the area at the bottom left of an invoice.

You can also get the tax information when you open a journal entry by looking at the columns to the right of each line.


[image: ../../../_images/account_journal_vat.png]
Journal Entry with VAT Information



OpenERP keeps a tax chart that you can reach from the menu Accounting ‣ Charts ‣ Chart of Taxes. The wizard will propose to display entries for the current period only, but you can also leave the period empty to see a complete financial year. The structure of the chart is for calculating the VAT declaration, but all the other taxes can be calculated as well (such as the French DEEE).


[image: ../../../_images/account_tax_chart.png]
Example of a Belgian VAT Structure



The tax chart represents the amount of each area of the VAT declaration for your country. It is presented in a hierarchical structure which lets you see the detail only of what interests you and hides the less interesting subtotals. This structure can be altered as you wish to fit your needs.

You can create several tax charts if your company is subject to different types of tax or tax-like accounts, such as:


	authors’ rights,

	ecotaxes, such as the French DEEE for recycling electrical equipment.



By creating several charts of taxes, you can print different declarations from the menu Accounting ‣ Reporting ‣ Generic Reporting ‣ Taxes ‣ Taxes Report. Simply select the chart of taxes you want to print in the wizard.

Each accounting entry can then be linked to one of the tax accounts. This association is done automatically from the taxes which had previously been configured in the invoice lines.


Tip

Tax Declaration

Some accounting software manages the tax declaration in a dedicated general account.
The declaration is then limited to the balance in the specified period.
In OpenERP, you can create an independent chart of taxes, which has several advantages:


	it is possible to allocate only a part of the tax transaction,

	it is not necessary to manage several general accounts depending on the type of sales and the type of tax,

	you can restructure your chart of taxes as required.





At any time, you can check your chart of taxes for a given period using the report Accounting ‣ Reporting ‣ Generic Reporting ‣ Taxes ‣ Taxes Report.

Data is updated in real time. This is very useful because it enables you to preview at any time the tax that you owe at the start and end of the month or quarter.

Furthermore, for your tax declaration, you can click one of the tax accounts to investigate the detailed entries that make up the full amount. This helps you search for errors, such as when you have entered an invoice at full tax rate when it should have been zero-rated for an intracommunity trade or for charity.




管理指标

With OpenERP you can also create your own financial reports. This feature is now included in standard OpenERP. Go to Accounting -_> Configuration ‣ Financial Accounting ‣ Financial  Reports ‣ Account Reports and click Create.

Suppose we would like to create our company Balance Sheet. The first report to be created, should be a View report which will contain the final details. Keep the default Sequence 0.

Now create the Assets report, and set Balance Sheet as the parent for this report. Set the Sequence to 1.

Now create the Liabilities report, and set Balance Sheet as the parent for this report too. Set the Sequence to 2.

Both these reports are of the View type.

Apart from the View type, you can select three other types: Accounts, Account Type and Report Value.


	Accounts: here you can select view accounts or individual accounts that should be included in the report. View accounts offer the advantage that when new accounts are added as a child of such view account, they will automatically be printed on the report. When selecting individual accounts, you need to specifically add each newly created account to get the correct report.

	Account Type: selecting an account type means that all accounts related to the selected account type(s) will be printed on the report.

	Report Value: thanks to this value you can include the balance of existing reports in another report. Example: create a profit & loss report (view) including costs (account class 6) and income (account class 7). In the Balance Sheet, define a report Profit&Loss Balance, with Balance Sheet as the Parent. Set the type to Report Value and link it to the P&L view report you defined. This way, the balance sheet will print the Profit&Loss result.




[image: ../../../_images/financial_reports.png]
Financial Reports



Create a report to print the Asset accounts (class 2 from the Belgian ledger) on the Assets side of the report. As a Parent, define the Assets report; sequence 3, type Accounts. If you want to use all accounts of class 2, just select the class (view account). You can also select various asset accounts. You could also have set this report to Account Type, with type Immo.

If you just want the sum of the selected accounts to appear, you leave the settings as they are. Should you wish to print the account details as well, you can select the Display details checkbox. The report will then also print the selected account numbers.

To print the results, go to Accounting ‣ Reporting ‣ Legal Reports ‣ Accounting Reports ‣ Financial Report. Select the report you want to print (only reports of the View type will be displayed in the list). You can also print a report for specific periods or dates. If you select the Enable Comparison checkbox, an extra Comparison tab will appear in which you can, for instance, select periods from a previous financial year. You have to give the comparison column a name through the Column Label field.


[image: ../../../_images/account_fin_report.png]
Example of a Financial Report
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良好的预算管理

对于公司来说，预算是非常重要的，使你能很好地控制并预计费用和收入。他们使你能衡量财务状况相对于计划的实际表现。

OpenERP 使用总账和辅助核算来管理预算
进入菜单 设置Settings ‣ 模块Modules ‣ 模块Modules 并安装模块 account_budget 就可以做这些工作了.

The first step in defining budgets is to determine the general accounts for which you want to keep budgets (typically expense or income accounts).
That is what you will use Budgetary Positions for, from the menu Accounting ‣ Configuration ‣ Budgets ‣ Budgetary Positions. Here you can select the general accounts for which you want to keep budgets. The aim is to group general accounts logically, according to sales or purchases, for instance. OpenERP has no limitations as to the account types that can be used for budgeting.


[image: ../../../_images/account_budget_pos.png]
Budgetary Position for Sales



要开始预算, 点击菜单 会计(Accounting) ‣ 预算(Budgets) ‣ 预算(Budgets), 点击 新建(New) 按钮可以创建一张预算单据.


[image: ../../../_images/account_budget_form.png]
乐观预算




Tip

预算的版本管理

虽然你 可以 在任何时间进行预算的修改,但我们还是推荐只是做创建一个新的预算,这样才可以很明了地看到预算的整个修改历史.

Rather than edit an existing budget, make a new version so that you can keep your original estimates safe for comparison. This lets you analyse your changing perspectives of the company from revision to revision.



创建一张预算单后,输入 摘要(Name), 编码(Code), 起始日期(Start Date), 终止日期(End Date) . 然后将你要纳入预算管理的某个会计期间的辅助核算科目及预算金额全部一条条地填写进去(注意: 采购类的需要输入一个负数金额):


	an Analytic Account

	a Budgetary Position, for example Sales or Purchases,

	a Start Date and an End Date for the budget,

	a Planned Amount in the default currency of the chart of accounts.



上述信息完成后, 保存该预算单.

预算各阶段的流程:


	确认(Confirmed): 表示预算已审核通过,但还是可以随时进行预算修改.

	Approved: the budget is approved by the budget holder; the name of the user approving the budget will be displayed in the Validate User field.



如果觉得不合适,你随时可以在前面两种状态下, 取消(Cancel) 该预算单后再将其 置为草稿.


	完成(Done): 完成状态的预算单就不允许再做任何修改了. 而且也不能再取消后置为草稿了.



The Theoretical Amount indicates the actual amount that might have been realised for the budget concerned according to the current date. When your budget is 1200 for 12 months, and today is the 30 October, the theoretical amount will be 1000, since this is the actual amount that could have been realised to date.

To print a budget and make calculations of expenditure through budget, use the menu Accounting ‣ Budgets ‣ Budgets. OpenERP then gives you a list of available budgets. Select one or more budgets and then click Print Budgets to create the report for each, in a date range of your choice.

The Print Budget report gives an overview of each analytic account included in your budget, according to the individual budgetary positions for that account. From the percentage and the comparison of planned (budgeted) and practical (actual) amounts, you have a good view on your situation.

From the same list of actions, you can also print the Print Summary report, which will give you a total per analytic account (without splitting by budgetary position).

Each of these reports can be printed from a specific date to a specific date. The End Date selected in the wizard determines how the theoretical amount will be calculated; if you select the last day of your financial year, the theoretical amount will be calculated as a function of that date (thus considering a complete financial year). Note that the theoretical amount will be zero when the Paid Date entered is equal to or greater than the End Date for the budget.

The percentage for a budget is calculated as follows: (practical amount / theoretical amount) x 100.
This way you get a view on how much of the forecasted amount has been actually realised in your accounting.

The figure Printing a Budget gives an example of a budget produced by OpenERP.


[image: ../../../_images/account_budget.png]
Printing a Budget




[image: ../../../_images/account_budget_summ.png]
Summarised Budget



You could also use the menu Accounting ‣ Reporting ‣ Generic Reporting ‣ Budgets ‣ Budget Lines.
This gives an analysis of each budget line.

From the menu Accounting ‣ Configuration ‣ Budgets ‣ Budgetary Positions, you can print the budgets for an individual budgetary position. Open a budgetary position, and click the Budget Lines tab for a graphical representation of your budgetary position.


[image: ../../../_images/account_budget_graph.png]
Graphical Representation of Budgetary Position




Note

Print Reports

You can also print budgets from the menu Accounting ‣ Configuration ‣ Analytic Accounting ‣ Analytic Accounts.






会计仪表板

You can open the Accounting Dashboard in more than one way: either by clicking the Accounting button at the top of the web screen, or from the menu Accounting ‣ Reporting ‣ Dashboard ‣ Accounting Dashboard.


[image: ../../../_images/account_board.png]
Accounting Dashboard



OpenERP gives you an accounting dashboard that will be presented to your accounting staff as they sign in to the Accounting system (you can also set the dashboard as their Home Page by setting the Home Action to Accounting Dashboard in the User form). This dashboard provides an analysis of the company’s financial health at a glance.

The description of the different parts of the dashboard, from top to bottom, then from left to right, is as follows:


	Customer Invoices to Approve : gives the list of invoices waiting to be approved by an accountant.

	Company Analysis : lists the debit, credit and balance of all account types.

	Treasury : shows the balance per Bank account in graphical view.

	Aged Receivables : gives a weekly graph of the receivables that have not yet been reconciled.



For most of the panels of the Accounting Dashboard, you can click a line or a graph to investigate the detail of your financial indicators.

The Accounting Dashboard is dynamically integrated, which means that you can navigate easily through the data if you want more detail about certain factors, and edit the entries if necessary.

The Change Layout button at the top right allows you to change the way the dashboard is displayed; you can choose among several options, such as one column, two columns, etc.
You can also add other features to the dashboard and customise it to your needs with the Add Widget button. You can easily Undo changes or Reset the original dashboard.
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成本分析

There are various reports designed for financial analysis based on the analytic accounts. Most of these reports are available directly from the tree of analytic accounts or from the form view of the analytic account.

From the Accounting ‣ Configuration ‣ Analytic Accounting ‣ Analytic Accounts menu, select one or more analytic accounts and then click one of the reports in the Reports section at the right side of the screen.
OpenERP provides the following financial analyses from the analytic accounts (and maybe more, depending on the additional installed modules):


	Cost Ledger,

	Inverted Analytic Balance,

	Cost Ledger (only quantities).

	Analytic Balance,




Note

Menu

At the time of writing, there is no separate menu to print analytic reporting.




成本账

The cost ledger provides the entries in general accounts for the selected analytic account(s). It enables you to make a detailed analysis of each operation carried out on one or several projects.


[image: ../../../_images/analytic_cost_ledger.png]
Cost Ledger






反向辅助核算余额

The inverted analytic balance provides a summary report relating general accounts and analytic accounts. This report shows the balances of the general accounts broken down by the selected analytic accounts from date / to date.


[image: ../../../_images/analytic_balance_inverse.png]
Inverted Analytic Balance



This enables you to analyse your costs by general account. For example, if you examine your general account for staff salaries, you can obtain all your salary costs broken down by the different analytic (or project) accounts.




成本费用总账 (仅数量)

This report gives the details of entries for an analytic account and a list of selected journals.
Only quantities are reported for this analysis, not costs and revenues. In the wizard you can select from period and to period and one or more journals.


[image: ../../../_images/analytic_cost_ledger_quantity.png]
Cost Ledger with Quantities Only



The report is often used to print the number of hours worked on a project, without exposing the costs and revenues. So you can show it to a customer as a record of the hours worked on a particular project.

To restrict the report to hours worked, without including sales and purchases, select only the services journal in the printing options.


Tip

Multiple Printing

To print several analytic accounts at once, you can make a multiple selection on the different accounts in the tree of accounts. Then
click the appropriate Report in the toolbar (in the web client), or select one of the Print reports (in the
GTK client), to export the whole selection into a single PDF document.






辅助核算余额

The analytic balance is a summary report that relates the analytic accounts to the general accounts. It shows the balances of the analytic accounts broken down by general account for a selected period. The analytic balance allows you to display a breakdown of each project by operation in the general accounts. Quantities are printed too. You can choose to include accounts without a balance as well.

When you select the analytic chart itself (the main analytic account), you can print the analytic balance for the entire analytic chart of accounts.


[image: ../../../_images/analytic_balance.png]
Analytic Balance



This report gives you the profitability of a project for the different operations that you used to carry out the project.


Tip

Multi-company

In a multi-company environment, each company can have its own general chart of accounts on the same database.
The two general charts of accounts are independent, but can be linked in a third chart using a view account to do the consolidation.

If the different companies collaborate on joint projects, they may all share the same analytic chart of accounts.
In this environment, the cross-related reports like the balance and inverted balance are extremely useful, because they enable you to make an analysis per company by linking up to the general accounts.






辅助核算账簿

From the Accounting ‣ Configuration ‣ Analytic Accounting ‣ Analytic Journals, select one or more analytic journals and click the Analytic Journal report at the right side of the screen. This prints a report per analytic journal from debit and credit (general account versus analytic account).


[image: ../../../_images/analytic_journal.png]
Analytic Sales Journal






辅助核算分录分析

You can have the statistical analysis on all analytic entries from the menu Accounting ‣ Reporting ‣ Statistic Reports ‣ Analytic Entries Analysis. By default, analytic entries are grouped by analytic account and month, but you have many options to sort and regroup analytic entries. You can, for instance, first group the information by general account, then by analytic account.


[image: ../../../_images/analytic_entries_analysis.png]
Statistical Report for Analytic Entries




Tip

Graph

You can easily turn this analysis screen into a graph by clicking the Graph button at the top of the screen.









          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	OpenERP 用户手册 

          	管理你的账簿 
 
      

    


    
      
          
            
  
一步一步配置会计


会计科目可按公司要求配置
本章介绍如何修改会计科目表, 分类账, 权限, 初始余额和会计初始设置的默认值。


良好的会计软件需要很大的实用性和简单的数据录入，以及灵活配置不同的组件。
您应该能够很容易的修改会计模块来满足自己的需求，这样就可以按您想要的方式使用它。

OpenERP让您适应和重新配置很多功能以方便您录入数据:


	为数据项增加控制,

	自定义屏幕,

	系统通过已知数据的查询自动填充字段.





	会计期间和会计年度
	定义一个会计期间或者会计年度

	期末结账





	管理税务结构

	会计科目表
	使用预配置的会计科目表

	建立会计科目表

	虚拟会计科目表





	账簿
	配置账簿

	数据录入的控制和提示





	支付条款

	会计年度的启用和结账
	在一个已有的 OpenERP 配置中，逐步启用一个新的会计年度

	生成期初分录

	会计年度结账





	逐步启动会计年度

	使辅助核算项到位
	设置科目表

	创建辅助核算账簿

	默认辅助核算项(方案)
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会计期间和会计年度


Note

会计期间和会计年度

会计年度 (或财务年度) 对公司而言相当于12个月。
在许多国家，会计年度对应于一个日历年度。而另外一些国家不是这样。

财政年度可分为每月或每3月的会计期间（当你需要一个季度报表时）。



OpenERP的会计年度管理具有足够的灵活性，使您能够在一次创建几个会计年度。这给您一些优势，如可以建立为期三年的预算。


定义一个会计期间或者会计年度

定义会计年度，使用菜单 会计(Accounting) ‣ 配置(Configuration) ‣ 财务(Financial Accounting) ‣ 会计期间(Periods) ‣ 会计年(Fiscal Year) .
您可以提前创建多年的会计年度以便定义长期的预算。


[image: ../../../_images/account_period.png]
定义会计年度和会计期间



先输入会计年度的第一天和最后一天。然后，要创建会计期间, 单击两个底部的按钮中的一个，取决于您需要创建12个1个月还是4个3个月的会计期间:


	按月创建期间(Create Monthly Periods),

	按季创建期间(Create 3 Months Periods) .



OpenERP的自动创建一个初始会计期间，让您录入您的上一财年的余额。请注意这个会计期间 年初/年末 会计期间(Opening/Closing Period) 复选框。




期末结账

要关闭会计期间,，比方税收申报已经做好，到菜单 会计(Accounting) ‣ 配置(Configuration) ‣ 财务(Financial Accounting) ‣ 会计期间(Periods) ‣ 会计期间(Periods).
点击绿色的箭头就可关闭已没有业务需要处理的会计期间。


Tip

打开关已关闭的会计期间

系统管理员可以重新打开一个因错误操作关闭掉的会计期间。



当一个会计期间处于关闭状态，在该期间您不能增加或修改任何业务。并不是必须要关闭会计期间，您可以简单地让会计期间一直保持打开状态。

要关闭会计期间您可以使用菜单 会计(Accounting) ‣ 定期处理(Periodical Processing) ‣ 期间扎账(End of Period) ‣ 关闭期间(Close a Period).
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管理税务结构

本章节处理法定税收和公司通用会计科目的有关问题:


	OpenERP中提供的税制结构，



您可以在交易中增加税款，那样您就能:


	在付款或收款金额中包含税款,

	生成您应向税务机关缴纳的各种税收报告,

	在总帐中跟踪税收情况,

	用OpenERP处理其他货币交易一样的机制来管理付款和退税.



由于税收机制的细节是执行政府政策、为国家积聚税款的一种机制，因此税收规定和税务报表可能很复杂。OpenERP有灵活的机制来满足不同地区的税务要求。

税收机制也可以用于处理类似税收的交易，比如通过一个科目基于交易额的作者的版税。

通过菜单  Accounting ‣ Configuration ‣ Financial Accounting ‣ Taxes  您可以定义您的税收结构。 注意如果您使用预定义（本地化）科目表，多数情况下都已经定义好了税收。

OpenERP的税收机制围绕三大概念运行:


	Tax Code (或 Tax Case), 用于纳税申报， 可以设置成具有树状结构，这样多个税务代码可以像 Chart of Accounts  （会计科目表）一样显示。 税务代码用来定义您的VAT统计表，可以为数字或字母，您可以通过菜单  :menuselection: Accounting –> Configuration –> Financial Accounting –> Taxes –> Tax Codes   定义税务代码。

	Taxes, 在业务中包含计税规则的基本税务概念，它和总帐科目和税务登记号有关。税种下面包含多个税目，不同的税目使用不同的计税规则，因而具有很好的灵活性。

	General Accounts, 用于记录缴纳的税款。由于总帐科目并非是税收特有的，在本书中其他章节也有说明，所以本节不再详细阐述。



您可以为商品设置0至多个 Purchase Taxes 和 Sale Taxes ，这样您可以分别统计采购税和销售税（增值税进项税和销项税，增值税是商品流通环节价值增加而产生的税收）。由于可以设置多个税种，所以您可以对同一商品分别同时处理增值税和消费税。

创建新 Tax Code，使用菜单 Accounting ‣ Configuration ‣ Financial Accounting ‣ Taxes ‣ Tax Codes 。 您应当定义如下字段：


[image: ../../../_images/account_def_tax_code_form.png]
Tax Code




	Tax Case Name: 用于区分税目的唯一名称，通常来自于增值税申报表，

	Case Code: 用于该税目的一个可选的短的编码,

	Parent Code: 关联到上级税目的代码，用于树状结构，可通过菜单  Accounting ‣ Charts ‣ Chart of Taxes  显示

	Not Printable in Invoice: 一个复选框，允许您以表明链接到有关税务代码的任何税项不应该被打印在发票上，

	Coefficient for parent: 选择 1.00 用于增加到上级科目或选择 -1.00 以从上级科目减少，

	Description: 用于说明的一段文本。



您还会看到两个只读字段：


	Period Sum: 显示本会计期间本税目税款合计数。

	Year Sum： 显示本会计年度本税目税款合计数。



您可能需要为已经定义的每种税率定义两个税务代码，一个用于税收本身，另一个作为发票的计税依据 (所谓的计税基础)， 而且您也可以创建不关联到任何税的税务代码 (类似于总帐科目中的 View  类型) 仅用于组织树形（或层次）结构。

要查看您创建的结构，您可以使用菜单 Accounting ‣ Charts ‣ Chart of Taxes.
此树状视图反映了 Tax Codes 的结构，并显示所选择的会计期间或一个完整的会计年度里目前的纳税情况。


Taxes 被用来定义计算和他们关联的业务的税额，以及他们关联到的总帐科目（通常是增值税科目）和税务代码，既为计税基数又包含税额。


要创建一个新的税，使用菜单 Accounting ‣ Configuration ‣ Financial Accounting ‣ Taxes ‣ Taxes.


[image: ../../../_images/account_define_tax_form.png]
定义税种



您定义如下字段:


	Tax Name: 本税需要的唯一名称（比如 21% Purchase VAT ），

	Tax Code: 这个税的可选的代码（比如 VAT IN IC ），

	Tax Application: 定义税种是否适用于 Sale, Purchase or All 业务，

	Tax Included in Price: 当选中，显示在商品或发票上的价格将包含这个税，

	Tax Type: 一个必需字段，表明如何计算此税的税额: Percentage,
Fixed Amount, None, Balance or Python Code, (您可从 Special Computation 页签中找到 Compute Code ），

	Amount: 一个必需字段，意思是根据税收计算类型，若 Tax
Type 是 Percentage则税款额为纳税基数乘上税率，当 Tax Type 是 Fixed Amount则以固定金额增加到纳税基数上。

	Invoice Tax Account: 一个用于记录发票上税额的总帐科目， 这可能是多个税使用同一个科目，或按比例分割以便每一税种分配一个科目，

	Refund Tax Account: 一个用于记录发票上退回税额的总帐科目， 其可以是同一个发票税科目，或按不同的税务管辖区分拆成不同的科目，

	Tax on Children: 当选择时税额计算是根据 Child Tax Accounts 的计算结果决定的 （因此您可以有税上税），否则是根据业务金额计算的，

	Include in base amount: 当选上时，税收是加在计税基数上而非单独显示，比方Eco税，

	Child Tax Accounts: 可用于计算税额的其他税项。




Tip

使用子税

当您有一个复杂的税收情况有多个税收代码时您可以使用子税。



以上您提供的税务字段可在总帐中反映，但并不能提供税务机关可能需要的信息。使用 Tax Definition 页, 部分税务申报: Invoices and Credit Notes to define to which tax codes the tax should be assigned:


	Account Base Code: 记录计税基数（不含税）的税收代码，

	Account Tax Code: 记录计算出来的税收金额的税收代码，

	Refund Base Code: 记录计税基数（不含税）退回数的税收代码，

	Refund Tax Code: 记录退回税额的税收代码



当您创建了一个由税务代码和税组成的税务体系后，您可以在各种与税关联或类似税务业务中使用税， 比如生态税（比如回收处理和Bebat）。


Tip

零售客户

当您零售给最终用户而非销售给公司时，您也许希望（或必须）在您的发票上显示含税价格而非不含税价格再加税。



您可以为一种商品制定多个税，假定您已经创建了适当的税，您可以使用菜单 Sales ‣ Products ‣ Products 打开并编辑 Product 定义，然后:


	为您将销售的商品选择一个或多个 Sale Taxes ,它可能包含 Sales Tax  or Output VAT and a Sales Eco Tax ,

	为您将采购的商品选择一个或多个 Purchase Taxes ，它可能包含 Purchase Tax  or Input VAT and a Purchase Eco Tax .



通常您采购或销售时，会自动计算该分配给该商品的税种的应缴税额或抵扣金额（如进项税）。

您也可以指派多个税种到一个会计科目，这样这个会计科目发生业务时您可以自动计算指派的税收金额。 这个概念可以很容易的应用于邮寄没有商品的采购发票时。

与产品和科目关联的税收通常是国内税。 OpenERP is capable of automatically converting national taxes to intracommunal or export taxes through the concept of Fiscal Positions.

Go to the menu Accounting ‣ Configuration -_> Financial Accounting ‣ Taxes ‣ Fiscal Positions. You can use the fiscal positions to automatically convert national taxes to the required intracommunal or export taxes, according to the fiscal position specified for the customer or supplier.

Fiscal positions allow you to make a mapping from national taxes to intracommunal or export taxes, or to map your accounts according to these criteria. You can link fiscal positions to your customers and suppliers to ensure automatic and easy VAT conversion when posting entries.
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会计科目表

配置软件时，OpenERP允许您选择预定义的会计科目表，其中包括所有的基本配置，如税收法规和财政状况。当然，你也可以定义自己的会计科目表。


使用预配置的会计科目表

在安装时，软件可以让您从许多的预定义好的科目表中选择一个默认的会计科目表。 要安装（大多数情况下）贵国的会计科目表以及税种定义，需从 Installation Wizard 中选择符合贵国的列表。 Generic Chart of Accounts 提供一个默认（但有限）的科目表，可作为任何国家科目表的基础。 Chart of Accounts 列表中还包括了很多本地化的会计科目表。


[image: ../../../_images/account_chart.png]
采用通用会计科目表



该向导将根据您所选择的科目表而有所不同。 您如果使用 Generic Chart  将可以添加一个税率，但不适合您安装以下以下案例时，举例说，名字为 Belgium - Plan Comptable Minimum Normalise. 这里的OpenERP也会自动安装比利时税务定义。您也许希望，当增加一个新的产品时可以选择默认的销售和采购税种。


[image: ../../../_images/account_chart_be.png]
采用比利时科目表



请记住，即使您使用默认的会计科目表，您仍然可以修改它以满足您的需求。


Note

模块

您也可以从模块列表中安装一个科目表，要这样在此只需要简单地跳过安装向导。 模块名会类似 l10n_XX ，这里 XX 是表示国家代码的两个字母。 例如,要得到比利时科目表, 通过 Settings ‣ Modules ‣ Modules 安装模块 l10n_be。 结果和通过向导 (Belgium - Plan Comptable Minimum Normalise) 可取得同样的科目表。



许多预定义的科目表是完整且准确的，但也有一些处于试验状态和仅仅显示其可能性如此定义。 您可以修改它们，或在默认科目表上定义自己的科目， 或根据自定义的科目表修改其中项目。




建立会计科目表

通过菜单 Account Types, 创建科目类型来确定年底结帐时科目余额的处理方式。

要增加，修改或删除已存在的科目类型得通过菜单 Accounting ‣ Configuration ‣ Financial Accounting ‣ Accounts ‣ Account Types.


[image: ../../../_images/account_type.png]
定义科目类型



用于定义科目类型的字段如下：


	Account Type: 科目类型名称。



	Code: 科目类型编码。



	PL/BS Category: 这个类型确定科目将打印在在何种报表中 (比如资产负债表和利润表)。 共有五种类型可选: 无类型 (/), 平衡表 (资产科目 = active), 平衡表 (负债科目 = passive), 损益类 (收入) 和 损益类 (成本)。



	Deferral Method: 这个字段表明在年度结转时如何及是否结转科目余额。



	None 意味本科目余额不会被结转. 通常用于损益类科目.

	Balance 表明年底科目余额会被结转。通常用于资产负债表科目。

	Detail 表明每一条分录都会被结转到下年。

	Unreconciled 表明只有未核销净的（仍有余额）的分录会结转到下年。 通常用于往来类科目。








	Sign on Reports: 这个字段允许您保留科目的符号，比方收入科目会被显示为正数而非默认的负数，使用 Reverse balance sign 来完成这个。（译注：收入类科目默认发生方向为贷方，国外软件常常在余额表中显示成借正贷负，这个选项类似与国产财务软件中的借贷方向选项）





使用 View 类型来创建科目层次结构，不能用于数据录入。

要增加，修改或删除已存在的会计科目得通过菜单 Accounting ‣ Configuration ‣ Financial Accounting ‣ Accounts ‣ Accounts.


[image: ../../../_images/account_form.png]
定义会计科目



科目涉及的主要的字段:


	Name: 科目名称。



	Code: 科目编码数字的位数不受限制. 0为顶级科目的编码。



	Parent: 确定哪个科目是本科目的上级科目， 这样可创建树型科目表。



	Internal Type: OpenERP中有特殊作用的内部类型。正常情况下，有如下类型可选：

View 可用于创建科目（组）的层次结构（译注：非末级科目）,
Regular 不适合别的类型的科目; 大部分科目用于此类型（译注：一般是末级科目）,
Receivable - Payable: 这些类型用于标明汇总科目（用于客户和供应商）会被设置成明细到每一业务伙伴,
Liquidity 用于标明资金类科目(银行存款和现金科目),
Consolidation 用于创建虚拟 (或合并) 科目表,
Closed 标明不再使用的科目。



	Account Type: 选择如上所述相应的科目类型是很关键的。 这会对年底结转和生成报表时产生影响。



	Secondary Currency: 这个科目上的发生数强制使用这种外币。 注意您也可通过菜单 Accounting ‣ Configuration ‣ Miscellaneous ‣ Currencies 定义汇率。



	Outgoing Currencies Rate: 仅当您增加了一个外币时选择。您卖出外汇时有两个选项： At Date 或 Average Rate。买入外汇总是按业务日期 At Date 计算。



	Allow Reconciliation: 决定可否核销这个科目的分录。 为应收应付科目以及其他需要核销（不包括银行对账单）的科目激活这个字段。



	Default Taxes: 使用这个科目用于采购和销售的默认税,它使得在手工录入会计分录时系统可以自动给出税金分录。





科目的树形结构可以随时按需更改，而无需重新计算其中的任何分录。因此，为更好的反映公司财务状况，您可以在一个会计年度中轻松更改科目结构。

您可以通过菜单 Accounting ‣ Charts ‣ Chart of Accounts ，选择会计年度，会计凭证，会计期间，并点击 Open Charts 查看科目一览表， 点击一个科目可下钻到该科目的明细帐。


Note

分层图表

大多数财务软件都是以列表的形式显示会计科目表，在OpenERP中当然也可这样做，但它的树形图具有如下优点：


	它能让您只显示您感兴趣的科目的细节，

	它能够让您获得一个全局的科目视图（当您只显示各科目的汇总时），

	它更加直观，因您能够基于分类进行查询，

	它更加灵活，因您能更容易对他们重新构建。





会计科目的结构是分层的，还有被称为 View 的拥有小计功能科目（译注：有子科目的非末级科目），您可以配置一套只包含您感兴趣的会计科目表。

要获得科目的明细数据对您是非常重要的，您要做的就是点击科目代码或是名称。

显示会计科目表可能需要好几分钟，因为OpenERP是实时计算每个科目的借方、贷方和余额的。




虚拟会计科目表

会计科目的结构是受国家相关的法律制度制约的。不幸的是，这种结构不总是符合公司的需要。

在OpenERP中，您可以在使用相同的会计科目的同时使用虚拟会计科目的概念来管理一些不同的数据展示形式。这些展示可以实时的反映而不需要额外的数据录入。

因此普通会计科目表能够遵守您的国家的制度章程，同时您公司的CEO可以根据需要使用基于一般会计科目的其他虚拟科目。例如，CEO能够为每一个部门创建1个视图，1个现金流和流动资产视图，或者合并不同公司的科目。

虚拟会计科目最有趣的情况是，它能够被用来为整个组织与默认的会计科目拥有相同的方式。例如，您可以从您的合并科目或从您的某个公司的科目来创建预算。


Tip

虚拟科目

虚拟科目能够让您提供一个或多个已存在的会计科目的不同展示格式。创建或重组虚拟科目不影响会计凭证。您可以无风险的使用虚拟科目在修改普通会计科目或未来的会计凭证。

因为他们是被用作相同记录的不同表达方式，他们将非常有用:


	实时合并多个公司数据,

	根据企业投资者的科目表生成报表,

	折旧计算,

	现金流视图,

	获得比那些基于法定的报告更有用的视图,

	为其他用户根据他们权限展示汇总图表.



因此这是一个重要的原因，即通过虚拟的科目展示财务交易的执行，诸如预算和基于公司的特殊视图的财务指标。



创建一个新的会计科目表，您需要通过菜单 Accounting ‣ Configuration ‣ Financial Accounting ‣ Accounts ‣ Accounts 创建一个根科目。您的顶级帐户应该有一个名字，一个代码（不同于当前科目表中任何其他科目代码，一个 Internal Type 和 Account Type  View。 然后您可以根据自己的需要创建其他科目， Account Type View是必须的。如果您想从其他科目映射过来，则 Internal Type 应设为 Consolidation  。检查您的虚拟结构通过裁断 Financial Management ‣ Charts ‣ Charts of Accounts 并从屏幕顶部的下拉框中选择相应的科目表

要映射您的虚拟科目表到您的总帐科目，您必须将 Internal Type 设置成 Consolidation 。 通过 Consolidated Children 您可映射科目或创建合成类科目。 在 Consolidated Children, 您可以增加 View 类科目或末级科目，如果您增加了一个 View 科目成合成类科目的子科目， OpenERP 会自动包括该总帐科目中已经存在的和未来增加的子科目。


[image: ../../../_images/account_virtual.png]
Virtual Accounts Mapped to View Account



您既可以在通用会计科目上又可以在虚拟科目上运行 Trial Balance 和  General Ledger 报表从不同的视角审视公司。普通科目的所有动作和状态同样对虚拟科目有效。

最后，您还可以基于另外一个虚拟科目创建一个虚拟会计科目。这样能够提供一个附加的财务分析维度。
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账簿

所有的会计分录需要由会计帐簿来显示。因此您应该为销售发票创建销售分类帐， 为客户退货创建销售红字分类账, 为供应商发票创建采购分类帐， 为供应商欠条创建采购红字分类账以及为银行业务创建一个银行分类账。


配置账簿

要查看，编辑或创建新分类帐，使用菜单 Accounting ‣ Configuration ‣ Financial Accounting ‣ Journals ‣ Journals.


[image: ../../../_images/account_journal_form1.png]
定义会计分类帐



蓝色字段均为必填字段。当您选择了分类帐类型，将被预置一些配置参数。 分类帐类型告诉系统有关分类帐可用于何处。

每一分类帐都有显示数据的特殊方式。 分类帐类型决定分类帐视图，也就是表明哪些字段需要显示出来和输入会计数据。视图确定字段的顺序和每个字段的属性。 比如, 字段  Statement  在银行分类帐录入数据时会出现，但不会出现在别的分类帐中。

您还可以创建自己的分类帐视图。 然而，在创建新的视图前，最好检查一下有没有已经定义的类似的视图。您应该仅为新分类帐类型创建新的视图。

您可为每一分类帐创建序号。 这个序号为会计分录自动设定号码。 如果您想将多个分类帐定义成使用同一个序号（如果您允许这么做），它们可以使用同一套序号。


Tip

序号编码

序号可通过 Settings ‣ Configuration ‣ Sequences & Identifiers ‣ Sequences 创建。
默认情况下， OpenERP 的分类帐定义中仅有一个序号。 如果您需要在分类帐中保存两个不同的序号，您可安装 account_sequence 模块。



当您通过 Journal Items 录入数据时，默认贷方或借方科目可自动生成对方分录。 在一些分类帐中，借方科目或贷方科目是强制性的，比如在银行日记账中您必须写入相关的银行科目，这样你就不必手动创建每个业务的对应科目。

一个分类账可以标记为集中式的。当您这样做时，相匹配的分录不仅被每张凭证拥有，而且针对给定的分类账和会计期间是全局性的。当您在其中一个分类账中将贷方行和借方行做了集中式标记后，这意味着贷方和借方会在同一行上显示。这个选项常用于开账分录。


Note

银行日记帐，容易配置

在您定义您公司的银行帐户事可自动创建银行日记帐。到 Accounting ‣ Configuration ‣ Financial Accounting ‣ Accounts ‣ Setup your Bank Accounts， 这里您可创建您公司银行帐户的银行帐号或IBAN号。 录入银行名称，那么当您保存时，您的银行日记帐会连同银行名称和科目代码一起自动创建，  这家银行的总帐帐户也会创建。






数据录入的控制和提示

在OpenERP中您有两种方式可以控制分类帐————科目控制和组用户权限控制。除了这些控制之外，您也可启用所有的标准用户权限管理。

为避免在错误的科目中录入会计数据，您可以在总帐科目中设置哪些分类帐可以使用给定的会计科目的条件。 要做到这一点，你必须在第二个页签  Entry Controls 中列出所有有效的科目或科目类型。 如果您没有在此添加任何科目， OpenERP 在分类帐中的会计科目是没有任何约束的。 如果您列出在分类帐中可以使用的科目以及/或科目类型， OpenERP 阻止您使用任何不在该列表中的科目或科目类型。 这一校验步骤从您录入数据时开始， 您仅可选择允许的科目或科目类型。

这一功能通过分类帐中可以使用的科目可限制数据录入中发生错误的可能性。


Tip

数据录入控制

在帐务处理过程中，允许直接从银行A到银行B的会计分录不是一个好主意。如果您录入了银行A直接到银行B的会计分录，则这个分录会被记账两次。

要避免这个问题，通过中间科目C，在数据录入时，系统检查银行分类帐中可接受的科目类型: 只有非 Bank 类型的科目才会被接受。

如果您的财务人员定义了这种特性，则非会计人员不可从一个银行帐户划款到另一银行帐户，这可降低风险。
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支付条款

您可以在OpenERP中根据您的需要定义付款条款。 付款条款确定发票的到期支付日期。

要定义付款条款，使用菜单 会计(Accounting) ‣ 配置(Configuration) ‣ 其它(Miscellaneous) ‣ 付款条件(Payment Terms) 再点击 新建(New).

下图中付款条款后的数字代表天数: 5天内5000, 在本月内支付50%，剩下的在下月15日支付。


[image: ../../../_images/account_payment_term.png]
配置付款条款



要配置新的条款，首先在 Payment Term 中给付款条款一个名称。 在 Description on invoices 中输入该付款条款的简单说明，该说明将被发票所使用。

在 Payment Term 部分新增单独的一行以创建新付款条款。您必须给每行提供一个名称 Line Name . 这些信息并不会对付款条款的实际计算产生影响。  Sequence 字段允许您定义计算规则的顺序。

每行中 Valuation 字段能让您计算付款金额:


	Percent : 本行表明此次付款占总金额的百分比，百分比在 Value Amount 字段中提供， Value Amount 中的取值必须在0到1之间.

	Fixed Amount : 这是一个给定在 Value Amount 中的固定金额.

	Balance : 表明本次付款金额是除去以前付款金额的余款.



仔细思考为何设置最后一行为Balance ， 可以避免舍入误差。顺序号最大的最后计算。

最后两个字段, Number of Days 和 Day of the Month, 能为每一行提供计算延期处理方法。 延期的 Day of the Month 可设置成 -1 , 0 或其他正数。比如，如果今天是2010年12月20日，并且您希望像以下所示设置付款条款：


	5天内5000: 设置 Valuation 为 Fixed Amount, Number of Days 设置为 5 并且 Day of the Month 设置成 0。 则将在2010年12月25日创建一条会计分录。

	50% payment at the last day of current month: 设置 Valuation 为 Percent, Number of Days 为 0 并且设置  Day of the Month 为 -1。 则将在2010年12月31日创建一条会计分录。

	Remaining on 15th of next month: 设置 Valuation 为 Balance, Number of Days 设置成 0 并且  Day of the Month 设置成 15。  则将在2011年1月15日创建一条会计分录。



您可以在合作伙伴的 Accounting 页签将付款条款指定给合作伙伴.
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会计年度的启用和结账

在会计年度结束时，您必须将该年度的期末余额结转成新的会计年度的期初余额。 OpenERP允许您自动生成该分录。您可以多次结转期初余额，因为一次就关闭一个会计年度是不可能的。由于余额会变化因此需要相应修改开账分录。新的余额可很容易地通过一个向导结转，因此您不必记住在以前会计年度中的每一次修改。


Note

OpenERP会计

以下步骤对您已经在OpenERP中具有一个有会计凭证的会计年度有效。




在一个已有的 OpenERP 配置中，逐步启用一个新的会计年度

在为您的每个科目生成期初余额之前，您需要经过多个步骤。


	创建新的会计年度



创建新的会计年度在 定义一个会计期间或者会计年度 中有详细解释。


	定义一个打开的会计期间



通过菜单 Accounting ‣ Configuration ‣ Financial Accounting ‣ Periods ‣ Periods 为一个您想打开的会计年度创建新的会计期间 (假设会计期间没有自动生成)。确保会计期间联系上了新定义的会计年度。 选择 Opening/Closing Period 选项框标明 该会计期间用于期初分录。两个日期通常和您的会计年度的第一天相同(比如 01/01/YYYY).


	检查科目类型



生成期初分录之前，确认检查过定义的科目类型，具体说是科目的结转方式， Deferral Method.
结转方式决定了是否和如何将余额结转到新的会计年度。有四种可能的结转方法：不结转, 余额结转, 明细结转, 未核销部分结转。







	结转方式
	动作




	None
	不结转 (常用于损益类科目)


	Balance
	仅结转科目余额(通常是有余额的科目)


	Detail
	所以分录都结转，包括已核销分录


	Unreconciled
	仅结转在新会计年度第一天核销后余额(典型的如应收应付科目)






	检查科目与科目类型之间的联系



检查是否每个科目都设置成了正确的科目类型以避免生成错误的期初分录。


	创建一个 Opening/Closing Journal



通过菜单 Accounting ‣ Configuration ‣ Financial Accounting ‣ Journals ‣ Journals。
创建一个新的分类账来存放期初分录。 请务必遵守以下规则:



	Type 应为 Opening/Closing Situation。

	Standard debit/credit account 应为类似“140000 Benefits”。

	Centralised counterpart 当你选择分类账类型时会自动选上，以避免在每一行上有副本，并代替相应的开账科目的一个解放和贷方分录。

	在保存时会自动创建 Entry Sequence 。









生成期初分录

OpenERP提供了一个向导以根据您实际的帐簿自动生成期初分录。在菜单 Accounting ‣ Periodical Processing ‣ End of Period ‣ Generate Opening Entries。

在向导中，输入您想结转余额的会计年度 (Fiscal Year to close)。 然后选择 New Fiscal Year (您要生成期初分录的会计年度)。 您还必须选择提交期初分录的帐簿和会计期间。会生成默认的期初分录摘要，当然您也可以输入您自己的摘要，比如 “YYYY年期初分录” 。 最后您点击 Create 按钮即可根据您的设置生成期初分录。

要检查自动生成的草稿状态的期初分录，通过菜单 Accounting ‣ Journal Entries ‣ Journal Entries . 点击 Unposted 按钮可过滤出仅草稿状态的分录。打开相应的分录并校验数据。点击 Post 按钮确认分录。


Note

上一年度有变化

只要审计工作还在进行，就有可能在已关闭的会计年度中增加额外的分录。要自动获得正确的余额，OpenERP允许您使用 Cancel Opening Entries 向导，这个向导会自动取消已经存在的期初分录。

要更新余额显示正确的结果，需要您再次运行 Generate Opening Entries:guilabel: 向导，新的期初分录将包含正确的余额。这样，您可根据需要多次生成期初分录。






会计年度结账

要关闭一个会计年度，使用菜单 Accounting‣ Periodical Processing ‣ End of Period ‣ Close a Fiscal Year.
一个向导会询问您将关闭的会计年度的信息。

一旦关闭了一个会计年度，您将不能在该年度中新增或修改任何业务。因此切记务必在关闭会计年度前备份数据库。关闭会计年度并非强制性需要，并且当您的会计报表已经交给法定当局，而且不再做任何修改后，您可以在下一年度中任何时候做这件事情。


[image: ../../../_images/account_fy_close.png]
关闭会计年度








逐步启动会计年度

一旦您决定使用OpenERP中的会计模块，您就拥有了一个会计系统，您应该输入您的期初余额和未结分录到OpenERP中。请确保您按配置一章所言初始化好您的会计模块。下面我们简单讲解有关起初余额和未结分录的配置。


	创建新的会计年度



创建新的会计年度在 定义一个会计期间或者会计年度 中有详细解释。


	定义一个打开的会计期间



通过菜单 Accounting ‣ Configuration ‣ Financial Accounting ‣ Periods ‣ Periods 为一个您想打开的会计年度创建新的会计期间 (假设会计期间没有自动生成)。确保会计期间联系上了新定义的会计年度。 选择 Opening/Closing Period 选项框标明 该会计期间用于期初分录。两个日期通常和您的会计年度的第一天相同(比如 01/01/YYYY).


	检查科目类型



生成期初分录之前，确认检查过定义的科目类型，具体说是科目的结转方式， Deferral Method。
结转方式决定了是否和如何将余额结转到新的会计年度。有四种可能的结转方法：不结转, 余额结转, 明细结转, 未核销部分结转。







	结转方式
	动作




	None
	不结转 (常用于损益类科目)


	Balance
	仅结转科目余额(通常是有余额的科目)


	Detail
	所以分录都结转，包括已核销分录


	Unreconciled
	仅结转在新会计年度第一天核销后余额(典型的如应收应付科目)






	定义科目表



检查科目表中的每一个有余额的科目是否设置成正确的科目类型。我们建议您定义一个或多个临时科目来结转上以会计年度的未清分录。为每一临时科目勾选 Reconcile ，因为他们的余额将为0。


	创建一个 Opening/Closing Journal



通过菜单 Accounting ‣ Configuration ‣ Financial Accounting ‣ Journals ‣ Journals。
创建一个新的分类账来存放期初分录。 请务必遵守以下规则:



	Type 应为 Opening/Closing Situation。

	Standard debit/credit account 应为类似“140000 Benefits”。

	Centralised counterpart 当你选择分类账类型时会自动选上，以避免在每一行上有副本，并代替相应的开账科目的一个解放和贷方分录。

	在保存时会自动创建 Entry Sequence 。







	为未结分录创建一个采购和/或销售帐薄



我们建议您分别创建采购和销售分类帐以便存入您以前的会计系统中未清分录，这将有助于您轻松跟踪您的期初分录。

通过菜单 Accounting ‣ Configuration ‣ Financial Accounting ‣ Journals ‣ Journals.
创建一个新的采购和销售分类帐类记录未清分录，请务必遵守以下设定：



	Type 应为 Purchase or Sales.

	Entry Sequence 会在保存时自动生成。






现在您可以根据自己在年末的未清分录录入客户和供应商往来。

通过菜单 Accounting ‣ Customers ‣ Customer Invoices 录入您的未清销售分录。要录入您的未清的采购分录，通过菜单 Accounting ‣ Suppliers ‣ Supplier Invoices.

我们建议您使用临时科目来代替费用或收入科目。实际上，您的费用和收入科目在上以年度末已经被结转过了，没有必要结转它们的余额到下一年。上一年度的未清分录应该不会包含VAT（增值税）分录；仅包含客户应付给您的余额，或是您应该支付给供应商的余额。


	录入期初余额 (其他分录)



对每一个需要重新打开的科目在分类帐中录入科目数字（借方或贷方），要这样做，得通过菜单 Accounting ‣ Journal Entries ‣ Journal Entries 并选择其他分类帐。


Tip

导入

如果您从其他会计软件中转出科目余额表的话，您还可以使用的OpenERP的通用导入工具。
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使辅助核算项到位

为能更好的初始化辅助核算您应该做到:


	设置会计科目表,

	创建不同的分类帐,

	将辅助核算关联到分类帐上.




设置科目表

开始进入OpenERP之前请选择最时候贵公司的辅助核算方案。要创建不同的辅助核算项，使用菜单 Accounting‣ Configuration ‣ Analytic Accounting ‣ Analytic Accounts 并点击 Create 按钮。
注意您创建辅助核算项时看到数据依赖于您已经安装的模块。


[image: ../../../_images/account_analytic_form.png]
配置辅助核算项



要创建一个辅助核算项，您必须完成如下字段：


	（辅助核算项）名称,

	Code/Reference: 用于选择辅助核算项的快捷方式,

	Parent Analytic Account: 使用这个字段来定义不同辅助核算项的层次结构。

	Account Type: 就像通用科目表一样,  View类型仅用于创建用于层次结构和数据汇总的虚拟项目，不能用来录入数据。  Normal类型用于包含数据的辅助核算项。



如果一个辅助核算项（特别是一个项目）有时间限制，您可以在此定义一个开始时间和结束时间。


Maximum Time 可用于一个有固定持续时间的合同。



Tip

发票

在OpenERP中你有几种方法可用于自动发票：


	服务型公司通常因采购订单，辅助核算项或项目管理任务而开具发票。

	制造业或贸易企业经常因发货或客户采购订单而开具发票。
orders.



如需要项目发票的更多信息，请参阅有关项目和服务管理的书（即将发布）。



一旦您定义了不同的辅助核算，您就可以通过菜单 Accounting ‣ Charts ‣ Chart of Analytic Accounts 查看清单。 您可以一个会计年度中一个或多个会计期间的辅助核算项目。


[image: ../../../_images/account_analytic_chart.png]
辅助核算表




Tip

设置辅助核算项

辅助核算项设置画面可因安装在帐套中的模块而有很大不同。例如仅当您安装了 hr_timesheet_invoice 模块后才能看到有关收取服务成本费用的信息。

这些模块增加了一些对管理有用的针对辅助核算项的统计表。最有用的可能是模块 account_analytic_analysis ，它增加了利润率、发票金额和最新的服务日期和发票日期等信息。






创建辅助核算账簿

一旦为您的公司创建了辅助核算一览表那么您必须建立不同的帐簿。这谢帐簿可使您按不同类型的会计分录进行分录，比如：


	服务，

	费用报销，

	材料采购，

	其他指出，

	销售。




Note

最小分类帐

至少，您必须分别创建一个销售和采购辅助核算帐簿。如果您没有创建这两个帐簿，OpenERP不会验证关联到辅助核算的发票，因为它不能自动创建一个辅助核算分录。




[image: ../../../_images/account_analytic_journal.png]
创建辅助核算账簿



要定义辅助核算分类账，使用菜单 Accounting ‣ Configuration ‣ Analytic Accounting ‣ Analytic Journals 然后点击 Create 按钮。

很容易创建辅助核算分类账，进需给一个 Journal Name, 一个 Journal Code 和一个 Type. 可用类型有：


	Sale, 适用于销售给客户和欠款，

	Purchase, 适用于采购和费用,

	Cash, 适用于凭证分录,

	Situation, 开始运作时的调整科目, 或在本会计年度结束时,

	General, 其他分录。



辅助核算现在已链接到您的通用分类帐以便OpenERP放置辅助核算分录。比如，如果您在为客户录入发票，OpenERP 会自动搜索类型为 Sales的辅助核算关联到销售分类帐上。
通过菜单 Accounting‣ Configuration ‣ Financial Accounting ‣ Journals ‣ Journals 并选择比方销售分类帐。 在 Analytic Journal 中也选择销售辅助分类帐。


[image: ../../../_images/account_general_journal.png]
关联辅助核算分类账到分类账






默认辅助核算项(方案)

安装 account_analytic_default 模块后您可以在OpenERP中使用默认辅助核算项。 注意这个模块和 sale, stock 以及 procurement 模块有关联。

系统会根据以下条件选择辅助核算项:


	按 所选产品 产生默认

	按 所选业务伙伴 产生默认

	按 登陆用户 产生默认

	按 所选公司 产生默认

	按 日期 产生默认



您可以通过菜单 Accounting ‣ Configuration ‣ Analytic Accounting ‣ Analytic Defaults 并点击 Create 按钮创建这些标准。
根据您在此定义的条件，当创建订单或发票时系统将推荐正确的辅助核算项。


[image: ../../../_images/account_analytic_default.png]
提供条件以自动选择辅助核算项
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有效的运营管理


公司的管理是一个关于人力资源和工作流程的协调的过程，如果你希望公司能更高效，就必须有一个卓有成效的管理。
你必须组织它，使它系统化，并优化这些主要的流程。一些因管理不善造成的信息孤岛会影响整个公司的价值链。



这部分内容介绍了一些可以提高公司效率的途径，也提供了一些使用OpenERP解决具体的问题的方案。对于每一个企业，
OpenERP都可以自动归集任务，系统的解决复杂的工作流程，并且简化了信息的传输和控制成本。




	辅助核算

	人力资源管理的关键特性

	提供高质量服务

	很棒的项目管理
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辅助核算


作为公司流程的核心,分析会计（或成本会计）是您的操作管理的不可缺少的工具。与你的财务会计不同，他们为更多的会计
师服务,同时也适用于老板和项目经理们。


你需要一个通用的方法,将用户,服务和文档同公司的业务流程有效地整合到一起。在OpenERP里面,分析会计(也叫做管理会计或者
成本会计)提供这样一个通用的方法。

分析会计通常作为企业战略决策的基础。但因为这需要把所有信息集合到一起，在大多数系统的核心业务处理中，OpenERP的分析会计是一个有用的
管理工具。

这里有几点原因：


	反映整个管理活动,

	不同于财务会计，分析会计的结构不依据会计准则的规范制定，所以每个公司都可以调整适应自己的需要。




Note

独立于财务会计

在某些软件中，分析会计是财务会计的扩展 - 例如，通过使用帐户代码的最后两个数字来表示分析会计帐户。

在OpenERP的中，分析会计被关联到财务会计，但是被完全独立的对待。
所以，你可以使用各种不同的分析会计功能，不必在财务会计中有相应的分析会计科目。



虽然法律规定了财务会计科目表的结构，但分析会计科目可以更好更紧密地适应一个公司的需求。

正如在财务会计帐户，你会发现不同的分析会计科目产生各自的会计分录。每个会计分录可以关联到一个财务会计科目，正如你
所希望的。
相反，财务会计中的一个科目可以关联到一个，多个或没有相应的分析会计科目。

通过下面分析会计独立性的说明，你会发现它的许多优点。耐心点儿，这里是更多优势说明：


	你可以管理很多不同的分析操作，

	因为它的独立性，在经营活动中，你可以在任何时候修改分析计划，

	你能避免财务会计科目的爆炸行增长，

	即使是那些不使用OpenERP的财务会计功能的公司也可以使用分析会计管理业务。




Tip

谁受益于分析会计？

不同于财务会计，OpenERP的分析会计不只是记账工具，可以作为公司里面任何一个人的管理工具。 （这就是为什么他们
也被称为管理会计）。

分析帐户的主要用户应该是公司董事，总经理和项目经理。



分析会计提供了一个能在很多情况下使用的强大工具。关键是要建立你自己的分析会计科目表，和自身的需求密切配合。

在本章中，你应该使用一个包括了演示数据的全新数据库，安装`销售`及其依赖模块，并没有什么特别的会计科目配置



	公司辅助核算科目表
	案例 1: 制造行业企业

	案例 2:  律师事务所

	案例3: IT服务行业





	辅助核算凭证
	跟总账集成

	手工录入凭证

	自动生成凭证

	辅助核算模型
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公司辅助核算科目表

为了清楚地说明分析会计，将使用三个案例，分别应用在三个不同类型的公司：



	制造行业企业,

	律师事务所,

	IT服务公司.







案例 1: 制造行业企业

在工业中，你会经常发现分析科目表建立在部门和产品上，这也是公司建立的基础。

因此，目标是研究部门和产品的成本，销售和利润。结构的第一级由不同的部门构成，下级代表公司制造和销售的产品系列。


Note

工业制造公司的分析科目表


	市场部



	商务部



	行政部



	生产部



	产品系列1

	子产品系列

	产品系列2












在日常使用中，将每次采购发票标注到相应的分析账户是非常有用的。分析账户是采购成本的分配。当发票被核准时，它会自动生成财务和相应的分析账户的分录。因此，在每个总账分录上至少有一个分析账户分录以分配发生成本的部门。

这里有上面的例子中的一些的会计分录，归集到多个分析账户：


财务和分析会计分录明细（案例1）










	一般会计账户
	
	
	
	
	分析账户
	




	标题
	账户
	借
	贷
	
	账户
	金额


	购买原材料
	600
	1500
	
	
	产品 / 系列1
	-1500


	分包商
	602
	450
	
	
	产品 / 系列2
	-450


	有缺陷的材料
	600
	
	200
	
	产品 / 系列1
	200


	运输费用
	613
	450
	
	
	产品 / 系列1
	-450


	员工成本
	6201
	10000
	
	
	市场部
	-2000


	
	
	
	
	
	商务部
	-3000


	
	
	
	
	
	行政部
	-1000


	
	
	
	
	
	产品 / 系列1
	-2000


	
	
	
	
	
	产品 / 系列2
	-2000


	公关
	614
	450
	
	
	市场部
	-450





按部门分析可以让您审查分配到公司各部门的成本。

因此，分析科目表显示上面的例子中的公司的成本分布：


账目分析图表（案例1）





	账户
	合计




	市场部
	-2450


	商务部
	-3000


	行政部
	-1000


	产品
	-6200


	产品 系列1
	-3750


	产品 系列2
	-2450





在这个OpenERP分层结构的例子中，你不仅可以分析每个产品系列的成本，也可以分析整个产品的成本。汇总账户（产品）的余额是子账户余额的合计。

一份联系总账和分析账户的报告是你了解成本构成在一个被指定的部门。对产品/系列1的分析如下表中所示：


部门一般账户和分析账户的合并报告（案例1）





	产品 / 系列1
	




	一般账户
	金额


	600 – 原材料
	-1300


	613 – 运输费
	-450


	6201 – 员工成本
	-2000


	合计
	-3750





上面的例子是基于一个公司的成本构成明细。成本分配的分析对销售一样有效。这提供了不同部门的盈利能力（销售-成本）。


Note

独特的产品系列的代表性

这种按部门和产品系列的分析表示通常用于贸易公司和生产企业。

这方面的一个变种是不区分销售和营销部门，而是将每项成本分配给其相应的产品系列。这样就能得到每个产品系列的盈利能力分析。

选择其他方式，取决于你如何看待你的营销效能。它是总成本集中分配的一般方式还是每个产品系列都应分摊该产品自身营销成本？






案例 2:  律师事务所

律师事务所普遍采取按案件管理，每个案件代表了相对应的一个当前客户的档案。所有的费用和产品，都归属到一个给定的档案。

一个律师事务所主要关注的是每小时的收费以及每个案件和雇员的盈利能力。

工时编制机制将在下一章《领导并激励你的员工》中详细地介绍。像大多数系统进程，工时都纳入分析账户。每次当一个雇员在时间表里填写小时数，这些小时数将自动生成分析账户将这些时间的成本对应到相关案件上。每小时收费是以员工的工资进行换算。

因此，律师事务将会选择一个能够反映每个员工在服务于不同客户案件的时间管理分析。


Note

针对一家律师事务所的账户分析表作案例演示


	缺勤



	带薪缺勤

	无薪缺勤








	内部项目



	行政管理

	其他








	客户案例



	客户1



	案例1.1

	案例1.2








	客户2



	案例2.1



















所有费用和销售所得都关联到一个案例，这就能得到在每一个客户每个案例在综合水平下的盈利能力。

不同案例帐单是有点不同。案例与普通帐的任何会计分录都不相符并且也不是来自采购发票或销售发票。它们由各种分析操作表示，在普通帐户中没有对应。它们都基于雇员工作的小时成本基础上计算。这些分录在计费工作表上自动创建。

在月底支付工资和福利时，你将它们记入普通账户中，但不在分析账户中，因为他们已被占为每个账户的计费。你可以出一份报告，比较辅助核算项和普通账户数据的汇总，以便你可以调整员工实际工作的每小时成本。

下表给出了不同的辅助核算分录的例子：


会计科目表的辅助核算分录（案例2）










	标题
	账户
	金额
	
	总账
	借
	贷




	研究案例（1小时）
	案例1.1
	-15
	
	
	
	


	搜索信息（3小时）
	案例1.1
	-45
	
	
	
	


	咨询服务（4小时）
	案例2.1
	-60
	
	
	
	


	服务费
	案例1.1
	280
	
	705 – 结算服务
	
	280


	购买文具
	行政
	-42
	
	601 – 购买家具
	42
	


	燃料成本-拜访客户
	案例1.1
	-35
	
	613 – 运输
	35
	


	工作人员薪金
	
	
	
	6201 – 薪金
	
	3000





你会看到，它使您可以详细分析了解来自不同会计事项的盈利。在本例中的1.1案例的成本是95.00（分析费用的总和，包括研究分析案例文档、搜索信息和服务费），但开票是280.00，带来的利润总额是185.00。

但在辅助核算项的重点不是仅限于简单的分析不同案例的盈利情况。

这些产生自客户服务的相同数据可在月末自动收取服务成本。给客户的发票只需要在本月的分析成本基础上再加上一个销售价格系数即可。开票机制对此能为提供优质的服务做出最详细的解释。假如客户要求列出在此案例中提供的具体服务，那么你可以把这个辅助核算项中的关于这个案例的服务分录打印出来。


Tip

结算分析成本

大多数管理软件允许你收回花费的工时，在OpenERP里这些服务是通过成本的有效性分析来自动体现的，但是在很多其它的OpenERP 文档中也能生成分析成本，如信用票据和货物采购。

所以，当你在月底开发票给你的客户时，它包括所有的分析成本，而不仅仅是投入的工时。例如，你可以轻易的收回你为你的客户在整个流程中垫付的整体成本。






案例3: IT服务行业

大部分IT服务公司需要面对以下问题：


	项目规划,

	开票结算，盈利能力和项目的后续资金问题,

	合同管理支持.



为了解决这些问题，你应该在项目和合同中使用辅助核算科目表的结构分析图表。以下的示例中对此作一个演示:


Note

示例演示分析一家IT服务公司的会计科目表


	内部项目



	行政管理与商务

	研发








	客户项目



	客户 1



	项目 1.1

	项目 1.2








	客户 2



	项目 2.1

	项目 2.2















	技术支持合同 – 20小时



	顾客 X

	顾客 Y












服务管理，支出和销售管理要和上面给律师事务所演示的类似。进销存和盈利能力分析也很相似。

但现在看技术支持合同。这些合同通常只限于预付的工作时数。每个服务在分析账户中过账后会显示剩余的技术支持时间。对于技术支持服务合同的管理你应该使用工程量，而不是在辅助核算分录上的金额。

在Open ERP里每个分析行列出已出售的或者使用掉的数量单位，跟你通常在此发现的计量单位 - 金额的货币单位（美元或英镑，或任何其他你所选择的货币单位）。所以，你可以在每一个辅助核算项里累加统计已出售的和使用掉的数量，以确定是否还有剩余服务时间供技术支持合同继续使用。

为区分服务和来自分析帐户中其它费用，你应该使用辅助核算项的方案。
辅助核算分录分配到不同的日记账中去：


	服务日记账,

	费用日记账,

	销售日记账,

	采购日记账.



因此为了获取支持服务合同的分解明细，你只需要在相应合同的辅助核算项中查找服务日志。

最后，辅助核算项可以用来预测未来的需求。例如，每月的工作人员在不同的项目计划安排，可以看作是服务日志的分析预算上限。会计分录上表示为数量（如小时数，产品数量）和金额的货币单位（也许是美元或英镑）。

所以，你可以以数量为基础设置计划。分析预算可以让你比较把你的预算案（也就是说，你的预算计划）和你时间执行了的服务在月底进行比较。


Tip

现金预算案

关于可用现金预测问题是新创企业或者快速成长型企业所遇到的常见主要困难。

如果该公司采用了专案管理，那么正如你所看到的，人员雇佣规划可以由辅助核算项的报告来表示。

只要你知道每个的项目的出售价格，你可以轻松的使用辅助核算项中的计划案来更准确地预测在未来数月你要开出发票的金额。
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辅助核算凭证


跟总账集成

正如在总账，辅助核算分录必须属于一个会计帐户和一个辅助核算账簿。

通过以下几个特点辅助核算记录可以区别于普通会计记录：


	它们不一定是必要的会计凭证,

	它们不一定属于现有会计期间,

	它们根据它们自己的日期管理，而不是一个会计期间管理,

	它们不产生借方和贷方分录，而是一个正数金额（收入）或负数金额（成本）.




[image: ../../../_images/account_analytic_move.png]
为客户项目的分析账户记录



图 为客户项目的分析账户记录 的辅助核算会计记录了客户项目并为客户项目展示辅助核算会计中的分录条目。

你可以看到有:


	该项目工作人员的服务费用成本,

	报销去见客户往返程的费用成本,

	客户的购买的已交付货物,

	销售收回这些成本.






手工录入凭证

尽管大多数辅助核算分录目由其他Open ERP文件自动生成，有时使用手动记录分录还是必要的。它通常需要一定的分析操作，而它在总账
里没有对应的操作。

使用手动记录分录，请使用 会计 ‣ 账簿的分录 ‣ 辅助核算明细 Accounting ‣ Journal Entries ‣ Analytic Journal Items ，然后点击 新建 按钮。


Note

辅助核算记录

建立一条辅助核算记录，Open ERP要求你指定一个总账账户。这只是给不同的交叉报告一个信息。它不会在总账中产生任何新记录。



选择一个辅助核算并完成不同的栏目。把支出费用记为负数，收入记为正数。


Tip

输入日期

在编辑列表中选择输入一个日期，你可以在web客户端或者在GTK客户端中使用日历小工具，如果你只输入一个月中的某一天，
当您按下Tab键时Open ERP系统会自动填充年份和月份。




Note

成本的分摊示例

辅助核算操作中的手工录入数据分录的用途之一是成本分摊。例如，一个已交付的项目的研发，可再次使用在另一个项目上，你
可以分摊部分成本到这个项目上。

在这种情况下，在第一个帐户上做一个正数的分录，第二个项目的帐户上做一个相同数额的负数分录。






自动生成凭证

辅助核算会计与其他Open ERP模块完全集成，所以你永远不必重新输入记录。他们会自动生成以下操作：


	确认发票销售或采购生成辅助核算分录关联到帐户显示在发票行,

	关于服务的分录为这项特定项目的服务成本生成一个辅助核算分录,

	生产产品生成一个关于该产品范围内的每一项操作的生产成本分录。



其他文件关联到这三个操作中的任何一个产生间接的辅助核算记录。例如，当你进入客户的销售订单，你可以把它链接到客户的辅助核算
项。当您管理案子或项目时，把项目同订单做上标记。这个订单将生成客户发票，这将关联到辅助核算项。当发票得到确认时，它会自动
为相应的项目创建辅助核算会计记录。

来自雇员的费用收据可以关联到辅助核算项报销。当收据得到公司批准时，购买发票将会被创建。这发票作为员工福利登在公司的借方。
每一行购买发票自动链接到一个辅助核算项，分摊成本到相应的项目。

可视化以下各种动作的普通分录，您可以通过使用以下菜单之一来实现：



	查看的所有分录, 会计 ‣ 账簿的分录 ‣ 辅助核算明细 Accounting ‣ Journal Entries ‣ Analytic Journal Items

	查看每个帐户的分录，每个用户，每个产品或每个业务伙伴，你可以使用菜单 会计 ‣ 报告 ‣ 统计报表 ‣ 辅助核算分析 Accounting ‣ Reporting ‣ Statistic Reports ‣ Analytic Entries Analysis.







[image: ../../../_images/account_analytic_analysis2.png]
Analytic Entries Analysis






辅助核算模型

Standard OpenERP allows you to post analytic entries to one chart at a time. Using the Analytic Model concept (install the option Multiple Analytic Plans from the Add New Features wizard), you can distribute your income or expenses to one or several analytic charts of account at the same time.
You can define the combination of analytic plans through the menu Accounting ‣ Configuration ‣ Analytic Accounting ‣ Multi Plans ‣ Analytic Plan.


[image: ../../../_images/account_analytic_plan_61.png]
Definition of Analytic Plan



Using the link Distribution Models at the right side of the Analytic Plan form, you can define the distribution of either your expenses while creating a supplier invoice, or revenue when defining customer invoices.
Thanks to these models, you can have one amount distributed amongst several analytic accounts. Models can be reused, and they can be applied to one analytic chart of accounts, but also to a combination of various charts of account, such as projects and cost centers.


[image: ../../../_images/account_distribution_model_61.png]
Definition of Distribution Models



For example, when you create the invoice (suppose 1000 EUR) for the product Client Project with the analytic distribution defined above.

When the invoice has been validated, you can find the Analytic Journal Entries with the amount distributed amongst the analytic accounts through the menu Accounting ‣ Journal Entries ‣ Analytic Journal Items.


[image: ../../../_images/analytic_journal_entry_analytic_distribution_61.png]
Journal Entries with Distributed Amount



You can also specify a default Analytic Distribution for a particular product, partner, user and company for a specific time interval using the menu Accounting ‣ Configuration ‣ Analytic Accounting ‣ Analytic Defaults.
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人力资源管理的关键特性


本章描述OpenERP的主要人力资源及员工服务功能. 在财务分析的基础上, 有很多关于业务或项目方面的管理方案.


一个公司的有效性取决于其员工的优异的工作。OpenERP的人力资源模块，使您能够管理员工的工作效率的重要方面，
如他们的技能，合同，工作时间。

本章，您应开始一个新的数据库（包含演示数据）。在配置向导中配置人力资源模块时您需要勾选”Human Resources”项（译注：6.0版本的内容，6.1以后变化了）。


[image: ../../../_images/config_wiz_HR.png]
配置向导中的人力资源模块





	管理人力资源
	关联员工和OpenERP用户，促进权限的管理

	定义员工的账单价格和成本

	定义员工分类，给不同的员工组别指定不同的休假权限

	用合同起止日期、试用期来定义合同类型和工资类型

	管理考勤(上班/下班)





	招聘
	根据进来的邮件自动创建申请人并跟踪附件，如简历和求职信

	在招聘进程中定义阶段来跟踪进程

	定义下个动作以及日期

	跟踪申请人的邮件通信记录

	计划电话呼叫或者访问

	应聘者填写调查问卷（例如初步调查问卷）





	假期管理
	定义不同的休假类型

	管理假期申请和批准

	跟踪前面的请假

	允许员工输入他们自己的分配请求





	通过考评激励你的员工
	制定各种考核等级

	计划考评日期

	连接调查和工作考评





	考勤和计工单管理
	工作“上班”/“下班”管理考勤

	跟踪计工单和考勤的差异





	管理各种费用开支
	允许员工输入费用

	完善审批审核流程

	通过辅助核算在付给客户
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管理人力资源

为了建立一个和整个公司管理系统集成在一起的系统，您需要建立当前员工的清单。


Note

不要混淆员工和用户

就OpenERP而言，所谓 员工 是指与公司签署劳动合同的自然人。包括所有类型的合同：长期的和临时的，也
包括全职的和兼职的。

所谓 用户 是指有权访问公司系统的自然人。绝大部分的员工是用户，但是一些用户却不是员工，例如外部
合作伙伴可以访问系统的部分模块。



一些取决于员工名单准确性的功能如下所示:


	服务成本，取决于员工的劳动合同,

	项目计划，取决于项目贡献者的工作模式,

	客户端计费率，可能取决于员工的工作职能,

	连锁的命令或者责任，与公司的分层结构相关.




关联员工和OpenERP用户，促进权限的管理

在OpenERP中使用菜单 人力资源(Human Resources) ‣ 员工(Employees) 中定义一个新员工.


[image: ../../../_images/service_employee_form.png]
员工详细信息表单



在 名称 框输入员工姓名和在 公司 框输入员工所在公司的名称。然后在 用户 中填写一个新用户从而建立一个新的ERP系统 用户 。

即使这个员工不是用户，最好也为该员工创建一个系统账号以便于您可以从一开始就掌控他们的访问权限（如果您需要您可以
通过这个字段这么做）。


Tip

员工和用户的关联

如果员工在系统中有用户名，你可以通过他（她）的用户名连接到员工表。

创建这个链接后员工模块中的相关界面中的 员工 字段能够自动完成，例如服务和费用记录。



输入员工地址.

这个出现在ERP中的合作伙伴联系表中，自员工与公司签订合同开始，他们就可以像数据库中其他合作伙伴一样有记录。因此在
合作伙伴联系一栏输入员工的名字和地址。然后所有的功能既适用于一个合作伙伴也适用于一个员工。这个对于跟踪账户中借贷
方特别有用-例如您可以跟踪薪酬支付。

你可以通过在 配置导向 中选择工时表安装 hr_timesheet_sheet ，帮助 员工们 编制和确认 工时表 和考勤。然后你可以在工时表中
为这个员工设立一个成本凭证薄和一个产品。如果你这么做了，这些信息将用于跟踪服务。现在，完成下列表单信息:


	Analytic Journal : 通常是一个 工时表日志,

	Product : 一个描述了这个员工被解除的服务产品，例如 工时服务表 。






定义员工的账单价格和成本

你首先必须要确认员工是系统用户，才能够使用工时表。员工基本信息包括必要的信息，例如职务和小时成本。

成本凭证薄 和 产品 这两模块有利于管理工时表.

所有关于服务次数成本的分析将保存在成本凭证薄中。它们能帮助你将服务成本与公司的其他成本分开，例如原材料的购买，
费用和分包。你可以通过部门或者功能给每个员工指定不同的成本凭证薄来区分成本。

员工也与ERP数据库中的一个产品相关联。一个员工与一个产品相关联，所以他们可以是 ‘购买’（分包）也可以是 ‘开票’（
项目管理）。你必须为每一个工作类型建立一个产品。

在产品界面中下列信息至关重要:


	名称 : 秘书 ， 销售人员 或者 项目经理 ,

	产品类型 : 服务

	计量单位 : 小时 或者 天

	成本价格

	销售价格

	成本计算方法 : 标准价格 或者  平均价格




Tip

价格指数

当在 产品 页面中 成本计算方法 是 平均价格法 时，你可以使用 成本价格 字段旁边的 更新 按钮打开更换成本价格的向导。



总之，每一个公司员工应该对应下列主要事项:


	合作伙伴

	员工 表,

	系统用户.



一个公司工作职位对应一个 产品 。


Note

工时价格

默认地，员工小时成本来自于员工对应产品的标准成本。
但如果你安装了 人力资源合同 hr_contract 模块，将可以管理不同的合同。当员工输入他们的工时数据时，员工的小时成本
将根据员工的雇用合同自动计算。

为此，软件中用一个因素定义合同类型（例如总月工资，每天计算）。理想地，这个因素应该考虑到工资
成本，税，保险和其他费用支付。






定义员工分类，给不同的员工组别指定不同的休假权限

（你必须为员工建立和分派类型）以便于（能够根据类型）分配和管理（离开和分配要求）。你可以在 人力资源 ‣ 结构 ‣ 人力资源 ‣ 员工 ‣ 员工分类 Human Resources ‣ Configuration ‣ Human Resources ‣ Employees ‣ Categories of Employee
中将 员工分类 。在分类框填入一个新的分类名称从而建立一个新的分类。一个分类也可以被分配一个 父类 。


[image: ../../../_images/employee_categories.png]
Example of categories defined for employees



从 人力资源 ‣ 人力资源 ‣ 员工 Human Resources ‣ Human Resources ‣ Employees 中找到员工将其归到一个 分类 中。在 分类 栏中，你可以通过选择 添加 和选定一个分类将一个员工归到
不止一个类别中。


[image: ../../../_images/employee_assign_category.png]
Assign categories to an employee in the Employee form



现在，当你在 人力资源 ‣ 假期 Human Resources ‣ Holidays 下面的菜单中建立一个新的 离开 或者 分配请求 ，如果你的 离开类别 或者分配类别是 员工类别 ，那么
你必须选者一个预先定义的 类别 。这个请求将适用于所有属于这个类别的员工。例如你可以为 学员 类别的员工建立一个分配要求，
使他们的离开少于其他员工。




用合同起止日期、试用期来定义合同类型和工资类型

如果你安装了 人力资源合同 hr_contract 模块，你就可以打开合同明细员工记录。这个模块的安装如下图所示:


[image: ../../../_images/config_wiz_contract.png]
Configuration wizard to install hr_contract



在 人力资源 ‣ 设置 ‣ 人力资源 ‣ 合同 ‣ 合同类型 Human Resources ‣ Configuration ‣ Human Resources ‣ Contract ‣ Contract Types 中建立一个新的合同类型。


[image: ../../../_images/hr_contract_type_list.png]
Contract Types list



你可以用同样方法在 人力资源 ‣ 设置 ‣ 人力资源 ‣ 合同 ‣ 工资类型 Human Resources ‣ Configuration ‣ Human Resources ‣ Contract ‣ Wage Type 中建立一个新的工资类型。在表格中输入下列信息:


	工资类型名称 : 一个工资类型名称.

	工资期间 : 选择一个预先定义的工资期间。工资期间在 人力资源 ‣ 配置 ‣ 人力资源 ‣ 合同 ‣ 工资期间 Human Resources ‣ Configuration ‣ Human Resources ‣ Contract ‣ Wage period 中设定。

	类型 : 毛工资 或者 净工资 。

	小时成本因素 : 根据每个员工的合同通过工时系统计算每小时工作价格。




[image: ../../../_images/hr_wage_type.png]
Wage Type form



你可以在 人力资源 ‣ 人力资源 ‣ 合同 Human Resources ‣ Human Resources ‣ Contracts 中建立和编辑合同。


[image: ../../../_images/service_hr_contract.png]
Definition of a working contract for a given employee



你可以输入员工雇用合同的信息，如下:


	合同编码

	职务名称

	工作安排

	开始日期

	结束日期

	薪酬结构 : 在预先定义的工资期间选择一个。

	合同类型 : 在预先定义的合同期间选择一个。

	试用期开始日期 : 开始日期为合同的试用期。

	试用期结束日期 : 结束日期为合同的试用期。






管理考勤(上班/下班)

在一些公司中，员工必须上班时签入，下班时签出。如果员工是系统用户，他们可以在ERP中使用 人力资源 ‣ 考勤 ‣ 签入/签出 Human Resources ‣ Attendances ‣ Sign in / Sign out
进行签字（签入/签出）。

如果一个员工下班时忘记签出，系统将在第二天他们准备下班签出时，建议他们手工签出。这是一个管理忘记签出的简单方法。

在 人力资源 ‣ 员工 Human Resources ‣ Employees 中的员工表格中找到员工考勤详情。

你可以使用下列有效记录，在ERP的员工表格中看到员工考勤详情:


	每月考勤

	每周考勤

	考勤异常记录



最后一份报告显示在考勤数据中输入的错误。显示员工是否手工输入进入或者离开时间以及事实和期望签出签入时间的区别。

第二份报告显示选定月份的考勤数据。
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招聘

使用ERP可以高效的管理招聘新员工的流程。可以很好的管理从最初接触到雇用应聘者的全部招聘过程。

你需要安装 人力资源招聘 模块 hr_recruitment 来高效地管理招聘流程。安装此模块的配置向导如下图所示:


[image: ../../../_images/config_wiz_recruitment.png]
安装人力资源招聘模块的配置向导



在 人力资源 ‣ 招聘 ‣ 申请人 Human Resources ‣ Recruitment ‣ Applicants 中显示申请人 申请表 Applicants 。


[image: ../../../_images/recruitment_applicant_form.png]
申请人申请表



你可以使用申请人申请表管理下列信息:


	申请人姓名

	申请的职位

	部门

	阶段: 初期工作要求, 工资协议, ...

	负责人: 面试人

	联系人 联系方式

	合同信息: 包括有效（天数），期望的薪酬，提议薪酬

	资格

	状态: 实际招聘状态: 新建 , 进行中 , 待定 , 拒绝 或者 录用



最初，申请状态是 新建 ，然后转变为 进行中 。如果申请人处于 等待人力资源部审批 或者 等待接受录用 的任何一种
状态下，申请状态是 待定 。当状态处于 录用 时，你就可以在员工列表中看到该申请人的详细材料。

职位信息 保存在 人力资源 ‣ 招聘 ‣ 职位 Human Resources ‣ Recruitment ‣ Job Positions 。


[image: ../../../_images/recruitment_job_position.png]
系统中的职位



在ERP中，使用 招聘模块 hr_recruitment 招聘新员工的主要功能有:


	管理职务职位和招聘过程.

	利用 调查模块 survey 为不同工作设定面试.

	利用邮件网关自动跟踪邮件发送到jobs@yourcompany.com.

	利用文件管理系统在简历库中保存和查找简历.



你可以通过 人力资源 ‣ 报告 ‣ 招聘分析 Human Resources ‣ Reporting ‣ Recruitment Analysis 分析招聘过程数据.


根据进来的邮件自动创建申请人并跟踪附件，如简历和求职信

你可以在 申请人申请表 中看到如何建立一个新的申请人。你也可以在ERP中安装电子邮件服务器从而在接收到邮件的同时建立新的
申请人。例如，如果你有一个邮件地址，你可以安装它，这样所有通过这个地址接收到的电子邮件将自动生成新的申请人。

因此，你可以通过 使用重新设置向导 和 在客户管理设置部分安装读取电子邮件设备 来配置安装 读取电子邮件模块 fetchmail 。

浏览 销售 ‣ 安装 ‣ 邮件 ‣ 邮件服务器 Sales ‣ Configuration ‣ Emails ‣ Email Servers 并且点击 新建 。 邮件服务器 表提供下列信息:


	名称 : 服务器配置名称.

	服务器类型 : POP服务器 或者 IMAP服务器 .

	添加附件 : 设置 真 可以检索到简历，求职信等附件.

	服务器 : 服务器地址.

	端口 : 服务器端口.

	用户名 : 电子邮件服务器用户名.

	密码 : 访问电子邮件账户的密码.

	模型 : 你希望生成的记录。这种情况下选择 申请人 （人力资源-申请人）.




[image: ../../../_images/recruitment_config_server.png]
配置一个电子邮件服务器



配置服务器之后，点击 确认 按钮启用此配置并且开始接收电子邮件

如果在安装好的电子邮件地址中接收一封新邮件，那么与此同时（一个与该新邮件主题相同的）新申请人主题名称被建立。申请人
电子邮件详细内容被保存（用于今后核对）。你可以添加更多的详情到这个工作申请中。你可以在 人力资源—招聘—申请人 Human Resources ‣ Recruitment ‣ Applicants 中查看
这些新建立的申请人并且通过点击 清除 键清除所有过滤器。电子邮件中的申请人在求职者数据中自动建立，电子邮件中的前三个
申请人被自动创建, 参见图: Job applicants automatically created from e-mails.


[image: ../../../_images/recruitment_from_email.png]
Job applicants automatically created from e-mails



由于您的服务器已安装添加附件，如果一个收到的电子邮件中包含 附件 ，它将会链接到相应的申请人记录。你可以在申请表
右侧附件部分找到。你可以点击附件打开。


[image: ../../../_images/recruitment_email_attach.png]
Applicant form with its corresponding attachments






在招聘进程中定义阶段来跟踪进程

很少会只是一个单独的见面或者一个电话之后就结束招聘。为了有个良好的结果通常一个招聘过程是一系列的筹划。你可以设定招聘
过程中会经历的阶段。使用 人力资源 ‣ 设置 ‣ 招聘 ‣ 阶段 Human Resources ‣ Configuration ‣ Recruitment ‣ Stages 来设定不同阶段。


[image: ../../../_images/recruitment_stages.png]
Defining recruitment stages



你必须给出 阶段名称 。当显示阶段明细时，使用 序列 领域给出序列指令。你也可以将 部门 与 阶段 联系在一起。你设定的阶段在申请表
的阶段领域可用。使用这个，你可以使持续的招聘过程有效地从一个阶段到另一个阶段。




定义下个动作以及日期

申请表 上的 下一个操作 和 下一个操作日期 字段允许你设定未来某个时间想要实施的行动。这可以提醒招聘主管接下来要做的事情和时间。




跟踪申请人的邮件通信记录

使用 应聘申请表 上的 联系与历史 栏，你可以添加上仅供内部参考的注释或者发送电子邮件给应聘者。你也可以在 历史 部分查看交流历史
和注解招聘申请。如果你在 全局抄送 字段中指定电子邮件地址，那么该电子邮件地址将（在所有入站和出站的电子邮件发送前）添加
到邮件的 抄送 字段中。你可以用逗号分隔多个电子邮件地址。

点击 添加内部说明 按钮建立一个内部说明。在弹出框中 添加 一个描述说明。你也可以在这里改变应聘状态。点击添加保存注解使其
可以在 历史 部分看到。

点击 发送新电子邮件 按钮给应聘者发送邮件。在弹出框中，你必须填入下列信息:


	From : E-mail address used to send an e-mail.

	Reply To : E-mail address for receiving a reply.

	To : The applicants e-mail address

	Subject : Subject of the e-mail. By default, it takes the subject of the recruitment application.

	Message : The message to send in the e-mail.




[image: ../../../_images/recruitment_send_mail.png]
发送电子邮件给应聘者



这里你也可以改变应聘状态。你也可以在弹出的 附件框 中添加附件。点击 发送 发送电子邮件。如图所示你可以看到一个对应列表:


[image: ../../../_images/recruitment_comm_history.png]
History of communication for the recruitment application






计划电话呼叫或者访问

使用 人力资源模块 hr_recruitment 的一个优点是你可以计划安排给未来的员工打电话和预约。这是由于其与 客户关系管理 crm 模块中的电话和会议功能
相结合的原因。

你可以通过点击  打电话 键从 应聘申请表 中安排一个电话。弹出框如下所示:


[image: ../../../_images/recruitment_sched_phone.png]
安排一个呼出电话给应聘者



你需要在弹出框中输入下列信息:


	分配 : 电话负责人.

	计划时间 : 打电话的日期和时间.

	目标 : 电话议程.

	类别 : 呼入 或者 呼出 (默认).



然后你可以点击 安排打电话 键创建一个打电话计划。如果你的打 电话类别 是 呼出 ，那么在 呼出 表中你可以添加更多的信息。一旦
确定打电话，你可以输入 持续时间 并且点击 确定 按钮。你可以通过 销售 ‣ 打电话 ‣ 呼出 Sales ‣ Phone Calls ‣ Outbound 来跟踪和进行你的打电话计划.


[image: ../../../_images/recruitment_outbound_phone.png]
Details of an outbound phone call to an applicant



就像你安排打电话一样，你也可以为应聘者 安排面谈 。在 应聘申请表 中点击 会见 键。 会见 表格中有一个会议日程。在这里，你可以
点击时间的空白处，确定你希望安排会议的时间。如图所示:


[image: ../../../_images/recruitment_sched_meeting.png]
为应聘者安排会谈



你可以从这张表格中管理以下信息:


	摘要 : 默认地招聘申请主题，当然你可以更改它.

	开始日期 : 面谈开始的日期和时间.

	结束日期 : 面谈结束的日期和时间.

	持续时间 : 面谈持续多少小时.

	地点 : 面谈地点.

	提醒 : 如果你想提醒面谈，你可以在面谈开始前设定会议提醒.

	描述 : 在这里你可以指定会谈内容.



在 邀请信息 栏，你也可以邀请参加会议的人。当你输入必要的信息后点击 保存 。然后你可以在日程中看到这个会议，如图所示:


[image: ../../../_images/recruitment_calendar_meeting.png]
日程中可以看到申请人的预约会议



你可以通过 销售 ‣ 会议 ‣ 会议 Sales ‣ Meetings ‣ Meetings 来跟踪和编辑你的会议。默认地，你将会看到会议的“月份形式的日历”。




应聘者填写调查问卷（例如初步调查问卷）

你可以将调查问卷作为面试应聘者的工具。为了能够让应聘者使用调查问卷，你必须首先通过 工具 ‣ 调查 ‣ 设定调查 ‣ 调查 Tools ‣ Surveys ‣ Define Surveys ‣ Survey 设定问卷。
点击  新建 打开一个新的调查表。你可以输入 调查标题 和 负责人 。


[image: ../../../_images/recruitment_job_survey.png]
调查表



一个调查可以有多页。每一页可以包含多个问题并且每一个问题可以有多个答案。不同的使用者可以给出不同的答案。你可以在 表格
的调查框中进行设定这些。当你在表格中输入必要信息后点击 保存 。面试时使用这个调查问卷，点击 打开 键更改调查问卷（从 草稿
到 打开 ）的状态。

然后，在 人力资源 ‣ 招聘 ‣ 职位 Human Resources ‣ Recruitment ‣ Job Positions 中选择应聘者应聘的岗位或者创建一个新的岗位。在 工作岗位 表格的 调查 字段中，输入你建立的调查
问卷名称，从而链接到这一工作的调查问卷并且在面试中使用该问卷。

现在你可以打开你希望进行初步面试的应聘者的表格。如果申请的  职位 与某个调查相连接， 答案 按钮将可用。点击它进行初步调查，
并且在应聘者回复中填写。调查问卷完成后，你可以点击申请者 申请表 上的 面试 按钮在PDF中查看应聘者回复。


[image: ../../../_images/recruitment_survey_answers.png]
The applicant’s response in a PDF file
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假期管理

你可以使用 hr_holidays 模块来管理员工假期，这个模块的安装配置向导如下图所示:


[image: ../../../_images/config_wiz_holidays.png]
hr_holidays模块安装配置向导



员工请假可以使用菜单 人力资源 ‣ 假期 ‣ 准假申请 Human Resources ‣ Holidays ‣ Leave Requests 来实现。

请假申请由员工建立，并由他们的主管来审核。一旦申请被审核通过，它就会自动出现在员工的日程表上。
你可以定义多种准假方式（如有薪假期，病假等）然后分别进行管理。

OpenERP 为高效的假期管理流程提供了如下的功能:


	帮助你管理假期及假期申请。

	与内部议程同步（使用 客户关系管理 crm 模块）是可能的: 你必须将准假状态与事实部分相连接，这样才可以当一个准假
申请被接受时它将自动生成事实。

	你可以根据你的假期类型设置不同的颜色，如“病假”可以在报表中显示为红色。

	员工可以通过 人力资源 ‣ 假期 ‣ 分配准假 Human Resources ‣ Holidays ‣ Allocation Requests 申请新的分配准假，从而申请更多的假期。



使用菜单 人力资源 ‣ 报表 ‣ 假期 ‣ 假期分析 Human Resources ‣ Reporting ‣ Holidays ‣ Leaves Analysis 可以查看假期统计报表。


定义不同的休假类型

你可以定义不同的请假类型，便于员工区分其请假申请。定义一个新的请假类型，点击菜单 人力资源 ‣ 设置 ‣ 假期 ‣ 请假类型,
然后点击 新建 按钮。


[image: ../../../_images/holidays_leave_type.png]
请假类型表单



你可以设置如下的信息：


	请假类型 : 请假类型的名称。

	报表中的颜色 : 请假摘要报表中显示的颜色。

	会议: 如果你选择了一个会议，一旦此申请被审核通过，日历中就会创建一个事件。

	二次审核 : 如果勾选此项，则此类型的申请均需要做二次审核。

	允许不顾限制 : 如果勾选此项，则此类型的申请中，员工享受的假期可以超过最大的限制值。



完成信息输入后，请点击 保存 按钮。




管理假期申请和批准

员工可以在 人力资源 ‣ 假期 ‣ 准假申请 Human Resources ‣ Holidays ‣ Leave Requests 中请假。你要在一个新的准假申请表中填入以下信息.


	说明 : 请假原因.

	模式 : 按员工 或者 按员工分类 .

	员工 : 如果准假分类是 员工 ，你必须选择一个 员工 .

	分类 : 如果请假分类是 员工分类 ，你必须选择 员工分类 .

	准假类型: 选择提前设置好的准假类型.

	开始日期 : 请假开始时间.

	结束日期 : 请假结束时间.

	天数 : 共请假天数(据 开始日期 与 结束日期 计算所得) .




[image: ../../../_images/employee_leave_request_form.png]
Leave Requests form



员工点击 确认 后将准假申请提交给他的领导等待审批。经理可以在 人力资源 ‣ 假期 ‣ 准假申请 Human Resources ‣ Holidays ‣ Leave Requests （还是“要审批的请假申请”）”中
找到等待审批的员工准假申请，可以点击 清除 或者 过滤器 。经理可以打开一个待审批的申请然后点击 拒绝 按钮拒绝申请或者点击
审批 按钮批准申请。如果是 双重验证 类型的准假申请，最后审批的经理将决定申请的最终结果，申请将从最后的 待审批 变为 已审批 或者 拒绝 。




跟踪前面的请假

在OpenERP的一系列方式中可以找到以前的假期申请。你可以在 人力资源 ‣ 假期 ‣ 准假申请 Human Resources ‣ Holidays ‣ Leave Requests 中看到所有用户的准假申请记录.
点击 清除 然后 生效 从而看到所有已批准的准假申请。看拒绝的申请，点击 清除 并且看到红色标记的记录。

在 人力资源 ‣ 假期 ‣ 分配准假 Human Resources ‣ Holidays ‣ Allocation Requests 中看到以前的分配准假，之后的操作流程同上。

在 人力资源 ‣ 假期 ‣ 准假摘要 Human Resources ‣ Holidays ‣ Leaves Summary 中，用同样的方法你可以找到以前的
准假摘要，但是仅限于当前登录的用户。默认地，你可以根据准假类型看到不同的申请分类。

在 人力资源 ‣ 报告 ‣ 准假 ‣ 准假分析 Human Resources ‣ Reporting ‣ Holidays ‣ Leaves Analysis 中可以看到请假统计纪录，并且根据员工和准假类型分类。点击 清除 看到
所有未分类的准假申请。

通过各种过滤和分类上述所有统计报告有助于你搜索到你需要的信息。你可以通过他们的 状态 （ 生效, 确认, 审批）， 员工 ， 部门
和 准假类型 来过滤申请。你也可以查看 当月 的申请。你可以通过 员工 ， 经理 ， 部门 ， 类型 和 状态 分类。


[image: ../../../_images/holidays_leaves_analysis.png]
Leaves Analysis statistical report



在 人力资源 ‣ 报告 ‣ 假期 ‣ 部门准假 Human Resource ‣ Reporting ‣ Holidays ‣ Leaves by Department 中可以看到完整的部门准假。你也可以选择一个 开始时间 ， 准假类型
（ 生效， 确认 或者 生效确认 ）并且至少喜欢则一个部门。点击 打印 将根据你的设置生成一个PDF文件。


[image: ../../../_images/holidays_dept_leaves.png]
Leaves by Department PDF report






允许员工输入他们自己的分配请求

为了能够休假，员工必须被分配一些可以利用的假期。通常管理会为员工安排一些休假。但是当一个员工由于特殊原因要在周末
上班，那么他将被允许在其他时间休假。这种情况下，员工被允许自己安排休假，但准假申请是否被批准由他的经理决定。如果
获得批准，那么员工根据该休假类型及限制进行休假。

在 人力资源 ‣ 假期 ‣ 分配准假 Human Resources ‣ Holidays ‣ Allocation Requests 中进行分配准假。需要完成下列信息:


	说明 : 请假类型名称.

	分配模式 : 按员工 或者 按员工分类 .

	员工 : 如果分配分类是 员工 ，必须选择一个 员工 .

	分类 : 如果分配分类是 员工分类 ，必须选择 员工分类 .

	准假类型 : 选择之前设置好的准假类型.

	天数 : 分配准假的天数.

	原因 : 说明原因.




	一旦申请被批准或者被拒绝那么其余部分是只读并且将获得细节。员工点击 确认 将分配准假发送给他的经理。此时申请将处于

	待审批 状态。




[image: ../../../_images/holidays_allocation_request.png]
Allocation Requests form



经理将在他的分配准假明细中找到申请。他可以点击 拒绝 拒绝该申请或者点击 审批 批准该申请.







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	OpenERP 用户手册 

          	有效的运营管理 

          	人力资源管理的关键特性 
 
      

    


    
      
          
            
  
通过考评激励你的员工

员工的工作积极性可以提高工作效率，带来更好的收益。OpenERP可以通过定期考评员工绩效来激励员工的工作积极性。

定期的人力资源评价对员工和公司都有益。为了高效的定期评价员工绩效，你需要安装“人力资源-评价”模型。安装此模型的
配置向导如下图所示:


[image: ../../../_images/config_wiz_evaluation.png]
Configuration wizard to install hr_evaluation module



你可以在 人力资源 ‣ 评价 ‣ 评价 Human Resources ‣ Evaluations ‣ Evaluations 中建立和管理新的评价。


[image: ../../../_images/employee_evaluation.png]
Employee Evaluation form



为每个员工设定一个评估计划。这些评估计划都设定好频率和方式。你可以设定好评价步骤并且在每一步骤上都附带评价表格。
OpenERP可以管理所有类型的评价: 自下而上,自上而下,自评和经理终评。

OpenERP涵盖以下主要评价功能:


	建立员工评价表。

	员工可以建立发送给下级的或者经理的评价表。

	评价遵循评估计划，评估计划包含各种各样的问卷。每一特定级别的员工对应特定的问卷。最终由经理终评并确认评价完成。

	每个员工填写的评价表都可以用pdf格式查看。

	OpenERP根据评价计划自动生成评价申请。每个员工定期收到邮件，要求对他们的同事进行评价。



你可以通过 人力资源 ‣ 报告 ‣ 评估分析 Human Resources ‣ Reporting ‣ Evaluations Analysis 分析评估数据。


制定各种考核等级

在 人力资源 ‣ 设置 ‣ 定义复核 ‣ 评估计划 Human Resources ‣ Configuration ‣ Periodic Evaluations ‣ Evaluation Plans 中建立新的评估计划。点击 新建 并且完成下列信息


	评估计划 : 评估计划名称,

	初次评估月份 : 设定好评估计划后的首次员工评估时间,

	评估周期 : 上一次评估与下一次评估的间隔时间.




[image: ../../../_images/eval_evaluation_plans.png]
Evaluation Plans form



你还必须建立 评估计划阶段 ，让计划可以从一个阶段到下一个阶段，并且能很好的完成每个阶段的指令，例如发送电子邮件。你必须在
评估计划阶段安装下列设置:


	阶段 : 评估计划阶段名称.

	等待前面的阶段 : 你可以设定当前面的所有阶段完成后开始此阶段.

	序列 : 此阶段的序列号.

	操作 : 选择一个操作，可以是 自上而下的评估申请 ， 自下而上的评估申请 ， 自我评估申请 也可以是 最终评估 .

	评价表 : 链接到这个阶段的问卷.



如果你使用GTK-client,将可以打开评估计划阶段窗体视图.这里你可以自定义更多的设置,例如你是否想在这个阶段发送电子邮件。你也
可以选择发送这个阶段的结果给经理和员工。




计划考评日期


	一旦一个评价计划被建立，你可以使用它评价 员工 。在 人力资源 ‣ 评价 ‣ 评价 Human Resources ‣ Evaluations ‣ Evaluations 中建立一个新的评价。选择一个 员工 同时选择一个 计划 。在

	评估截止时间 选择一个评估截止时间。



虽然，评价提醒是根据 评价计划表 中的 第一个评价月 和 评价周期 进行提醒的。你可以用这些规范评价日期。




连接调查和工作考评


	一个评价计划是一系列的阶段，每一阶段对应一个评价表。这个评价表只不过是一个调查，一个通过问卷调查评估的工具。在

	工具 ‣ 调查 ‣ 定义调查 ‣ 调查 Tools ‣ Surveys ‣ Define Surveys ‣ Surveys 中设定调查。一个评价开始后，采访要求在评价计划的基础上自动创建。如果你要建立额外的采访要求，你必须将采访与 调查 相连接。这个调查可以处于任何状态（甚至是 草稿 ），但是要启用采访时，调查必须处于 打开 状态。
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考勤和计工单管理

在大多数使用OpenERP的服务公司中，服务表或者工时表改变了管理的一贯做法。这些服务表是由每个员工为正在运行的不同的项目建立
的。这些是通过系统中的一个分析账户来反映的。

一天中，员工需要将他们花在每个项目上的时间明细都添加在工时表中。一天结束后，员工必须记录他们当天所有的工作时间从而构成
一天的工作时间。如果（项目）账户不在系统中，那么工作时间不被计入任何指定的一天，而是另外记为小时。


[image: ../../../_images/service_timesheet_list.png]
Timesheet for a working day



此工时表 Timesheet for a working day 为一个员工工时表的例子。


Note

不要混淆工时表与考勤情况

工时表并不是一个考勤表。工时表无法控制超出的服务时间，如果员工愿意他们可以每天工作八小时，九小时甚至
更长时间。

如果你决定实行这个系统，那么一定要跟员工讲清楚这一点（工时表并不是考勤表），我们的目的不是控制时间，
因为时间是由员工自己输入的，但是任务运行和成本分配是由管理层负责的。



确保系统中的所有功能与 工时表 相关联，配置向导如下所示:


[image: ../../../_images/config_wiz_timesheets.png]
Configuration wizard for Timesheet



工时表系统的功能有很多，这里列举一些重要的功能:


	通过计算花在项目上的时间来跟踪项目的真实成本,

	追踪不同员工提供的服务,

	将项目真实的耗时时间与最初计划的时间进行比较,

	在服务时间的基础上自动提供进销存率

	获得指定客户端的服务时间明细

	获知运行公司所需的成本，例如市场成本，新员工培训成本以及客户进销存率.



工时表分类

你需要安装 制造应用（制造资源计划） mrp 从而访问工时分类。在 制造 ‣ 设置 ‣ 资源 ‣ 工作期间 Manufacturing ‣ Configuration ‣ Resources ‣ Working Period 中设定不同的工时表分类（工作会议时间）
并且可以选择一组（例如： 每周38小时 ）。


[image: ../../../_images/service_timesheet_def.png]
Timesheet category for full time 38 hours per week



输入工时表数据

为了充分使用工时表，可以通过在 重新配置向导 中选择 工时表 同时点击 设置 来安装 人力资源工时表 hr_timesheet_sheet 模块。一旦此模块被安装并且
设置好员工，那么不同系统的用户可以在 人力资源 ‣ 时间跟踪 ‣ 工作小时 Human Resources ‣ Time Tracking ‣ Working Hours 中输入他们的工时表数据，然后点击 新建 。


Tip

工时表快捷方式

使用工时表的所有员工可以将这个菜单放在他们的快捷方式中。因为他们每天要使用很多次。



一个新的条目:



	The 用户 : 本身是默认的，但是如果你编码的是公司其他员工的第一个工时表的话，你可以更改。

	The 日期 : 自动默认为当天日期，但是如果你要编码前一天的工时表，你也可以更改。

	帐户分析 : 运行中的项目，需要提前设定。

	描述 : 一个空白的文本文档用来描述工作时间。

	数量 : 时间单位数量（单位作为产品的一部分）。






其他字段将自动完成，但是可以修改： 服务产品 例如咨询，计量单位 （预定义的，也可能是分钟，小时或者天）， 服务成本
（默认计算地）以及相关的 普通账户。

每位员工可以编码一天的工作时间。它有助于在一天结束时再访明细从而确认工作时间的正确性。总输入的时间显示在服务小时明细的
右下角。


Tip

隐藏的服务成本

默认地，当员工编码每个项目的小时总数时，OpenERP会显示每个服务的成本。你可以通过在时间表视图中添加
invisible=True 来修改此字段。

其方法是要么修改文件系统上视图，要么使用网络客户端当前数据库中的修改视图。对于后者，在每个你可以访
问 管理视图 的表格的左下方有一个淡灰色 【自定义】 标识。如果你有足够的权限，你可以编辑设定当前视图的文
档。

成本中的价值显示的是员工为公司花费的时间成本，因此不应当总是隐藏此项。



服务输入的准确性对于计算不同工作的收益率和服务补给至关重要。不同的报告对于核对员工输入数据的准确性都很有用。员工可以使用
以下报告核对他们工时表:


	通过 人力资源 ‣ 报告 ‣ 工时表 ‣ 员工工时表 Human Resources ‣ Reporting ‣ Timesheet ‣ Employee Timesheet 打印指定员工工时表。

	通过 人力资源 ‣ 报告 ‣ 工时表 ‣ 员工工时表 Human Resources ‣ Reporting ‣ Timesheet ‣ Employees Timesheet 打印多个员工的工时表。你可以在每个用户每一天的表格中打印总表。




[image: ../../../_images/service_timesheet_all.png]
Employees’ monthly summary timesheet




	通过 人力资源 ‣ 报告 ‣ 工时表 ‣ 工时表利润 Human Resources ‣ Reporting ‣ Timesheets ‣ Timesheet Profit 审查工时表利润。

	你可以通过在 人力资源 ‣ 报告 ‣ 工时表 ‣ 工时表分析 Human Resources ‣ Reporting ‣ Timesheets ‣ Timesheet Analysis 与 人力资源 ‣ 报告 ‣ 工时表 ‣ 工时表分析 Human Resources ‣ Reporting ‣ Timesheets ‣ Timesheet Sheet Analysis 中使用统计报告分析你的每
时期的，每产品的，每账户的服务。




[image: ../../../_images/service_timesheet_graph.png]
Chart of timesheet by account



使用屏幕上方的过滤器可以使组成这个例表视图的数据不同。如果你想了解更多的细节，可以切换至图形视图。

计算服务成本

我们知道，工时表与成本科目（分析账户）密切相连。工时表中的各个项目与成本科目（分析账户）相一致。工时记录本身也是分析
（成本）记录。

这些记录包括各种不同于一般账户的分析操作。因此修改和创建工时表线的所有操作将自动影响相应的分析线，反过来，分析线上的
更改也将自动影响工时表线。


Note

工时表和分析数据

OpenERP中，有关于分析记录的工时表实施是由一个继承机制管理的:
工时表对象继承分析记录对象。

这样相同的信息不需要输入两次，避免了不一致的错误。
不过他们被存储在两个不同的表里，因为计工单一定是个成本凭证行，但成本凭证行不一定是计工单。



这不是传统的实现方式，但符合逻辑并且实用。员工的计工单是服务型企业在成本会计管理过程中分析服务成本在各个项目中分布的
重要指标。

成本科目应该在会计科目上反映，但成本科目与会计科目并非一一对应。取而代之的是，如果员工的每小时成本有了很好的预算，全月
的计工单条目余额应与月底支付给员工的工资加提成相匹配。

尽管如此，要精确计算出一个员工每小时的平均成本是很难的，因为它依赖于:


	额外的工作时间,

	假期或病休,

	工资变量及其他相关成本，如社保基数.



一系列的报表可以用于比对会计科目和成本科目的发生额，并且有利于你评估不同员工的工时成本。在成本科目上的产品余额与会计
科目上的产品余额的差异可以计入产品的成本。有些公司在月底用一个特殊的会计科目和另一个成本科目来处理这些差异。这个成本
科目的余额应该趋向于零。

因为你拥有了一个完整的计工单系统，所以你可以:


	追踪成本科目中项目的盈利,

	按项目或员工查找计工单的历史记录,

	定期通过与实际成本的比较来调整每小时成本,




Important

项目成本控制

严格控制项目的成本和利润是非常重要的。

有利于很好地估算以及为不同的服务产品和项目分配预算，如销售、研发。你还能通过清晰的证据来论证你的
理由而不是通过猜测来决定是不是应该在项目后期重新与客户讨论修正合同。



在成本会计模块中按项目或员工来分析盈利能力。分析的依据是所有的发票以及每个项目上花费的时间。


工作“上班”/“下班”管理考勤

在一些公司中，员工必须上班时签入，下班时签出。如果员工是系统用户，他们可以在ERP中使用 人力资源 ‣ 考勤 ‣ 签入/签出 Human Resources ‣ Attendances ‣ Sign in / Sign out 进行签字
（签入/签出）。

如果一个员工下班时忘记签出，系统将在第二天他们准备下班签出时，建议他们手工签出。这是一个管理忘记签出的简单方法。

在 人力资源 ‣ 员工 Human Resources ‣ Employees 中的员工表格中找到员工考勤详情。

你可以使用下列有效记录，在ERP的员工表格中看到员工考勤详情:


	每月考勤

	每周考勤

	考勤错误记录



最后一份报告显示在考勤数据中输入的错误。显示员工是否手工输入进入或者离开时间以及事实和期望签出签入时间的区别。
第二份报告显示选定月份的考勤数据。




跟踪计工单和考勤的差异

当工时表能够被正确使用时，它对于项目经理将是一个很好的控制工具，可以为其提供成本和次数意识。

员工团队很重要，因此必须执行一个控制体系。所有的员工都应该正确的完成他们的工时表，因为这是项目计划控制，财务管理以及
开发票的基础。

在 实现服务质量 提供高质量服务 中，月底你可以根据工时表自动开票。但同时，一些合同的预付时间是有限的。这些时间以及它们的扣减（从原始限制中的扣减）也是由这些工时表管理的。

这种情况下，没有编码到工时表中的时间反映了公司的亏损。所以建立后续的服务工时表及其编码是很重要的。你需要安装
人力资源-工时表-表 模块 hr_timesheet_sheet 从而建立一个使用工时表的控制体系（ 配置向导 中的 工时表 ）。


[image: ../../../_images/timesheet_flow.png]
Process of approving a timesheet



这个模型提供了一个新的过滤器使你能够通过周期管理工时表。工时表的记录由员工每天完成的。一个星期结束后，员工核实一周的
工时表然后发给服务经理批准。周期由公司设定，可以是一个月也可以是一个星期。

员工通过 人力资源 ‣ 时间追踪 ‣ 我的工时表 Human Resources ‣ Time Tracking ‣ My Timesheet 输入工时表数据。


[image: ../../../_images/service_timesheet_sheet_form.png]
Form for entering timesheet data



在屏幕的上面部分，用户可以进行签入和签出。系统掌控着每一天的考勤。屏幕左边的 签入 和 签出 按钮能够使时间自动完成。这些
时间可以由员工修改，所以它不是一个真实的管理控制系统。

屏幕底部是选定日期的员工时间记录表。总体来说，这个包含了在公司工作的时间数。为一整天的考勤时间提供了一个简单的核查。

工时表的第二栏 天数 给出了在不同项目上工作的时间数。如果考勤表和时间表记录有差距，你可以用第二栏检测（天数）或者
（输入错误的记录）。


[image: ../../../_images/timesheet_sheet_hours.png]
Detail of hours worked by day for an employee



工时表 账户显示了所有项目的工作时间。这样你可以看到员工在不同项目的工作时间。

一周或者一个月结束时，员工确认其工时表。如果公司的考勤时间与工时表相一致，那么就将工时表确认好发送给部门经理，由部门
经理核查批准。

每一位经理都可以在 人力资源 ‣ 报告 ‣ 工时表 ‣ 工时表表分析 Human Resource ‣ Reporting  ‣ Timesheet ‣ Timesheet Sheet Analysis 中看到其部门等待审批的工时表。经理可以批准“等待审批的工时表”
也可以将其退回。

通过 人力资源 ‣ 配置 ‣ 人力资源 ‣ 部门 Human Resources ‣ Configuration ‣ Human Resources ‣ Departments 设定部门结构。


Tip

工时表审批

工时表的审批对于部门经理来说是一个很烦琐的事情。然而，这一步骤对于有效管理是至关重要的。在公司，
我们经常会发现这种情况：经理超负荷的工作，但是他们却不知道自己的员工在做什么。

因此至少每周一次由经理审批每一个员工的工时表（即工作大纲）。每个不同的项目所花费的时间都有所记录，
都要审批。



一旦工时表被通过，你可以利用工时表控制成本以及管理开发票给客户的时间。

合同及其费用，计划和进销存方法将在下个章节讲述， 提高服务质量 提供高质量服务 。
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管理各种费用开支

员工费用是员工为公司垫付的。公司应将这些费用报销给员工。最常见的收据有以下几种:


	汽车费用，每（英里或公里）费用报销,

	生活费用，根据账单报销,

	其他商品，例如员工使用的文具和书籍.




[image: ../../../_images/service_expense_workflow.png]
处理费用报销的过程



员工费用可以一个星期一报也可以一个月一报。在一个星期或者一个月结束时，员工可以将复核好的所有费用及费用清单发
给部门经理。经理负责批准本部门所有的费用报销申请。费用清单上必须有员工的签字，同时也必须将收据附在费用清单上。

一旦部门经理批准费用清单后，费用清单将被送到财务部门（记录了公司对员工的负债）。财务可以用支票支付报销费用
也可以以员工最初提供的支付方式支付报销费用。

一些收据是项目费用，因此需要一个分析账户。当这些收据被批准后，这些费用被添加到分析账户的成本中。

经常会有一些在客户中产生的费用，具体的费用要根据合同情况而定。差旅费和生活费就是这样产生的。如果合同价包括
这些费用，那么可以在月底的时候向客户索取。

如果你要通过很多步骤收回费用，那么会很繁琐，特别是员工那些大量的不同的费用。如果你有一个好的管理系统，那么
你可以避免很多麻烦并且提高员工的工作效率。

如果用系统处理费用，那么你可以通过有效的设置销售条款从而避免重大损失。在固定价格的合同中，费用报销通常是根
据实际发生的费用报销。这将有利于系统化处理，自动程序最大化。


允许员工输入费用

安装人力资源-费用模块 hr_expense 自动管理费用处理。安装该模块的配置向导如下所示。


[image: ../../../_images/config_wiz_expenses.png]
Configuration wizard to install hr_expense module



用户可以通过 人力资源 ‣ 费用 ‣ 费用 Human Resources ‣ Expenses ‣ Expenses 输入和查看他们的费用。


[image: ../../../_images/employee_expenses.png]
Expenses form to enter and review expenses



公司认可通过OpenERP产品类型创建的各种费用的模板。例如，你可以创建一个 每公里0.25元的汽车费用 报销产品:


	名称 : 汽车费用 ,

	默认计量单位 : 公里 ,

	成本价 : 0.25 ,

	销售价 : 0.30 ,

	产品类型 : 服务 .



员工在规定的每个周期之前应该保持它的费用清单处于 草稿状态。到达规定时期（星期或者月）时，员工通过点击 确认 按钮
来确认他的报销清单。确认后报销清单处于 等待批准状态。




完善审批审核流程

在一段时期后，部门经理通过 人力资源 ‣ 费用 ‣ 费用 Human Resources ‣ Expenses ‣ Expenses 访问等待批准的费用清单。

费用报销由部门经理批准。点击 发票按钮 创建供应商发票以便于员工报销。分析账户编码到每一行发票中。当发票确认后，一般的分析会计条目将自动生成。




通过辅助核算在付给客户

如果你基于服务时间或者分析成本开票，当客户发票根据相关服务项目生成时，费用将自动计入客户。

根据时间表开票你可以准备好所有的发票，包括费用以及项目客户的时间表。

你可以通过 人力资源 ‣ 报告 ‣ 费用分析 Human Resources ‣ Reporting ‣ Expenses Analysis 查看到费用统计分析。
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提供高质量服务


This chapter focuses on the management of contracts, and the services associated with that.
The complete process of managing services is studied here: from defining prices and contracts to
automatically invoicing the services through planning, and the treatment of
additional costs such as expense receipts.


For this chapter you should start with a fresh database that includes demo data,
with sale, project and all of their dependencies installed, and
no particular chart of accounts configured.



	管理服务合同
	固定造价合同

	成本补偿合同

	Fixed-price Contracts Invoiced as Services are Worked

	Contracts Limited to a Quantity
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管理服务合同

Contracts can take different forms within OpenERP, depending on their nature. So you can have
several distinct types of service contracts, such as:


	fixed-price contracts,

	cost-reimbursement contracts, invoiced when services are completed,

	fixed-price contracts, invoiced monthly as services are carried out.




Tip

Contract Quotations

Some companies commit to contracts on the basis of a requested volume at a certain price for a
defined period.
In such a case, the contract is represented by a pricelist for that specific customer.

The pricelist is linked in the Sales and Purchases tab of the Customers form,
so that it is brought up whenever anything is bought from or sold to this partner
(depending on whether it is a purchase or sales agreement).
OpenERP automatically selects the price based on this agreed pricelist.




固定造价合同

Fixed price contracts for the sale of services are represented in OpenERP by a Sales Order. In
this case, the supply of services is managed just like all other stockable or consumable products.

You can add new orders using the menu Sales ‣ Sales ‣ Sales Orders.

The new Sales Order document starts in the Quotation state, so the estimate has no
accounting impact on the system until it is confirmed. When you confirm the order, your estimate
moves into the state Manual In Progress .


[image: ../../../_images/service_sale_workflow.png]
Process for handling a Sales Order



Once the order has been approved, OpenERP will automatically generate an invoice and/or a delivery
document proposal based on the parameters you set in the order.

The invoice will be managed by the system depending on the setting of the field Shipping
Policy on the order’s second tab Other Information:


	Payment Before Delivery : OpenERP creates an invoice in the Draft state.
Once this is confirmed and paid, the delivery is activated.

	Invoice on Order After Delivery : the delivery order is produced when the order is
validated. A draft invoice is then created when the delivery has been completed.

	Shipping & Manual Invoice : OpenERP starts the delivery from the confirmation of
the order, and adds a button which you manually click when you are ready to create an invoice.

	Invoice From The Picking : invoices are created from the picking stage.




Note

Delivery of an Order

The term ‘delivery’ should be taken in the broadest sense in OpenERP.
The effect of a delivery depends on the configuration of the sold product.

If its type is either Stockable Product or Consumable, OpenERP will make a request for it to be
sent for picking.
If the product’s type is Service, OpenERP’s scheduler will create a task in the project management
system,
or create a subcontract purchase order if the product’s Procurement Method is Make to Order.

Invoicing after delivery does as it says: invoicing for the services when the tasks have been
closed.



When you sign a new contract, you can just enter the order into the system and OpenERP will track
the order.

This works well for small orders. But for large valued service orders, you might want to invoice
several times through the contract, for example:


	30% on order,

	40% on completion,

	30% one month after the system has gone into production.



In this case you should create several invoices for the one Sales Order. You have two options for this:


	Do not handle invoicing automatically from the Sales Order but carry out manual invoicing instead,

	Create draft invoices and then link to them in the third tab History of the
Sales Order, in the Related
Invoices section. When you create an invoice from the order, OpenERP deducts the amounts of the
invoices already linked to the order to calculate the proposed invoice value.






成本补偿合同

Some contracts are not invoiced from a price fixed on the order but from the cost of the services
carried out. That is usually what happens in the building sector or in large projects.

The approach you use for this is totally different because instead of using the sales order as the
basis of the invoice you use the analytic accounts. For this you have to install the module
hr_timesheet_invoice.

An analytic account is created for each new contract. The following fields must be completed in this
analytic account:


	Partner : partner associated with the contract,

	Sale Pricelist,

	Invoicing.



The selection of an invoicing rate is an indirect way of specifying that the project will be
invoiced on the basis of analytic costs. This can take different forms, such as delivery of
services, purchase of raw materials, and expense reimbursements.


Note

Pricelists and Billing Rates

You can select a pricelist on the analytic account without having to use it to specify billing
rates.

An example of this is a client project that is to be invoiced only indirectly from the analytic
costs.
Putting the pricelist on the analytic account makes it possible to compare the actual sales with
a best case situation where all the services would be invoiced.
To get this comparison you have to print the analytic balance from the analytic account.



Services are then entered onto timesheets by the various people who work on the project.
Periodically the project manager or account manager uses the following menu to prepare an invoice
Accounting ‣ Periodical Processing ‣ Billing ‣
Bill Tasks Works.

OpenERP then displays all of the costs that have not yet been invoiced. You can filter the proposed
list and click the appropriate action button to generate the corresponding invoices. You can select
the level of detail which is reported on the invoice, such as the date and details of the services.


[image: ../../../_images/service_timesheet_invoice.png]
Screen for invoicing services




Note

Project Management and Analytic Accounts

Analytic Accounts is only available once you have
installed the module account_analytic_analysis.
It provides various global financial and operational views of a project manager’s projects.



Select an entry and click Invoice analytic lines link on the right of the form.
You can then invoice the selected entry by clicking Create Invoices.




Fixed-price Contracts Invoiced as Services are Worked

For large-valued projects, fixed-price invoicing based on the sales order is not always appropriate.
In the case of a services project planned to run for about six months, invoicing could be based on
the following:


	30% on order,

	30% at the project mid-point,

	40% at delivery.



Such an approach is often used in a company but there are other options. This method of invoicing
can pose many problems for the organization and invoicing of the project:


	It is extremely difficult to determine if the project is on track or not. The endpoint is fuzzy,
which can result in a tricky discussion with the client at the moment of final invoicing.

	If the project takes more or less time than forecast, it will effectively result in under- or
over-invoicing during the project.

	Whether you get a proper return can depend on the client. For example, if the client takes a long
time to sign off on project acceptance, you cannot invoice the remaining 40% even though you might
have supplied the agreed service properly.

	The account manager and the project manager are often different people.
The project manager has to
alert the account manager about the moment that the client can be invoiced, but that moment can easily be
forgotten or mistaken.

	The project can be fixed for service costs but have agreed extras, such as reimbursement for
travel expenses. Invoicing from the order does not adapt well to such an approach.



OpenERP provides a third method for invoicing services that can be useful on long projects. This
consists of invoicing the project periodically on the basis of time worked up to a fixed amount that
cannot be exceeded. At the end of the project, a final invoice or a credit note is generated to meet
the total amount of value fixed for the project.

To configure such a project you must set an invoicing rate, a pricelist and a maximum amount on the
analytic account for the project. The services are then invoiced throughout the project by the
different project or account managers, just like projects that are invoiced by time used. The
managers can apply a refund on the final invoice if the project takes more time to complete than
permitted under the contract.

When the project is finished you can generate the closing invoice using the  Final Invoice  button
on the analytic account. This automatically calculates the final balance of the bill, taking the
amounts already charged into account. If the amount already invoiced is greater than the maximum
agreed amount, then OpenERP generates a draft credit note.

This approach offers many advantages compared with the traditional methods of invoicing in phases
for fixed-price contracts:


	Fixed-price contracts and cost-reimbursable contracts are invoiced in the same way, which makes
the company’s invoicing process quite simple and systematic even when the projects are mixed.

	Everything is invoiced on the basis of worked time, making it easy to forecast invoicing from
plans linked to the different analytical accounts.

	This method of proceeding educates project managers just as much as the client because refunds
have to be given for work done if the project slips.

	Invoicing follows the course of the project and avoids a supplier’s dependence on the goodwill of
the client in approving certain phases.

	Invoicing of expenses follows the same workflow and is therefore very simple.




Note

Negotiating contracts

In contract negotiation, invoicing conditions are often neglected by the client.
So it can often be straightforward to apply this method of invoicing.






Contracts Limited to a Quantity

Finally, certain contracts are expressed in terms of a quantity rather than a fixed amount. Support
contracts comprising a number of prepaid hours are a case in point. To generate such contracts in
OpenERP you should start by installing the module account_analytic_analysis.

Then you can set a maximum number of hours for each analytic account. When employees enter their
time worked on the support contract in the timesheets, the hours are automatically deducted from the
maximum set on each analytic account.

You must also name someone in the company responsible for renewing expired contracts. They become
responsible for searching through the list of accounts showing negative remaining hours.

The client contract can be limited to a certain quantity of hours, and it can also be limited in
time. For that, you set an end date for the corresponding analytic account.
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很棒的项目管理


如果您有一个好的系统来管理任务，您的整个公司都将受益。OpenERP的项目管理模块能让你有效地管理和跟踪任务，有效地开展工作,
迅速委派任务并同时保持密切跟踪您委派的任务。OpenERP还有助于贵公司的人组织他们的个人时间，本章提出了一种旨在提高管理者的
生产力的方法。


新建一个包含演示数据的帐套，安装“销售管理”和“项目管理”并选择通用会计科目表



	项目管理
	创建项目和相关项目任务

	任务管理

	开票任务

	项目优先级管理

	任务委派





	长期项目规划
	项目阶段

	排程
	计算阶段计划

	计算任务计划









	提高领导能力的规划
	按时间还是按任务作计划？

	计划你的时间

	在层次每个级别都进行计划





	没有压力的生产力的艺术
	并非所有急事必然是重要的

	有条不紊地组织你的生活
	相关环境因素

	时间盒

	方法和迭代过程

	令人信服的结果
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项目管理

在前面的章节中，您基于OpenERP的辅助核算、实例结构了解了项目的财务管理。这种工作方式使您能够分析时间计划和预算，
和管理不同合同的发票。

在这里，我们将解释使用项目管理模块来组织任务和计划您需要完成的工作。所有必要的操作均出自于 Project
菜单中。


Tip

记得您在简化界面中比在扩展界面中选项更少.




Note

项目

在OpenERP中，项目代表了一系列需完成的任务。项目有一个树状结构，可以划分阶段和子阶段。这种结构非常有益于组织您
的工作。

相对于辅助核算是审视公司过去的活动，项目管理的作用是规划未来。虽然在两者之间存在密切的联系（如项目已通过OpenERP
计划和完成），他们仍然是两个不同的概念，各自形成自己的工作流程。



大多数自定义项目由以下构成:


	总账系统中一个或多个辅助核算以跟踪合同及其不同阶段,

	项目管理系统中一个或多个项目以跟踪需完成的不同任务.



这里项目和辅助核算可以直接关联，这是因为每创建一新的项目，OpenERP会在 项目 辅助核算表中自动创建对应的辅助核算项。
注意您不能从项目中直接存取辅助核算。


创建项目和相关项目任务

定义一个新项目，到菜单 Project ‣ Project ‣ Projects ，点击 New 并给项目一个 Project Name .

您可以将这个项目作为一个 Parent Project 的子项放入一个层次结构中，并指派一个 Project Manager 。
通过输入 Start Date 和 End Date 确定总持续时间。

Administration 选项卡显示关于计划时间的信息，并根据已完成任务计算项目花费的时间。如果选中了 Warn Manager 选择框，
您可设置系统在每一任务完成时向项目经理发一条 Request 。

万一项目运行时间过长，它可升级成另一项目 project_issue 。在 提升 处选择需提升成项目的已进行任务。
which can be done by selecting  in the Reconfigure wizard. In Project Escalation, enter the project that will be used for escalated tasks.
为自动电子邮件定义一个一般的 Reply-To Email Address ；这允许您直接从OpenERP中接收回复。您可定义一个 Working Time 类型，这可用于计算项目时间，特别是通过甘特图。

项目有如下状态:


	打开: 项目开出来了,

	中止: 项目暂停,

	取消: 项目因为取消而中断,

	关闭: 项目成功结束,

	模板: 该项目作为模板以据此创建新项目。



在 Members 选项卡，将 Members 添加到该项目，这与访问权限有关。

在 Billing 选项卡，您能看到客户的发票信息。选择 Customer ，客户表单的“客户地址”会自动填入。您必须完成其他信息，
比如 销售价格表 和在任务完成后直接 按任务进展开票 。OpenERP允许您设置项目（或子项目）的 最大开票价 。
已开票金额 显示的是相关项目的已开发票的总金额。

如果您想自动使您的客户了解项目的进展情况，选中 通知业务伙伴。


Note

通知业务伙伴

如果您选中 通知业务伙伴 ，在 发票 页签中需要您定义一个常用的 邮件头 和 邮件页脚 用于
自动生成的电子邮件（仅扩展用户界面）。OpenERP会准备好电子邮件，用户可以在每个任务结束后发给客户。这封电子邮件的
内容是基于项目任务的详细信息，并且在发送电子邮件之前，可以由用户修改。在这个页签下面，OpenERP显示了多个可用于电
子邮件的变量。




Note

客户满意度的研究

一些企业运行的电子邮件系统在任务完成时自动发送邮件，请求客户完成网上调查。这项调查通过公司询问有关工作开展的
一些问题，来衡量顾客对项目进程中的满意程度。

此功能也可用于通过ISO 9001认证的公司，来衡量顾客的满意度。 OpenERP还允许您创建自己的调查。



Task Stages 选项卡允许您定义阶段帮助你分割您的任务。您可以添加一个序列号来设置各阶段顺序，使您考虑优先的工作任务，
即：首先，您将先有 详细说明书 阶段然后才是 开发 。




任务管理

一旦一个项目已被定义，你可以输入要执行的任务。这有两种方法：


	点在项目表单右边的 ACTION Tasks ，然后点 New 按钮,

	从菜单 Project ‣ Project ‣ Tasks ，创建一个新任务并将其分配到现有项目.



每个任务包含以下状态:


	草稿: 任务已经录入但尚未得到有权限的人的审核,

	打开: 您可以开始工作或该任务已在运作,

	关闭: 任务已经结束,

	中止: 已不需要该任务,

	待决: 任务在等待其他人的响应（如客户信息）.



一个任务可以被分配给一个用户，他将负责关闭该任务。但你也可以不分配特定人员：取而代之的是各团队成员共同负责他们的
各自擅长的任务。


[image: ../../../_images/service_task.png]
项目管理中的任务



每个用户利用现有的各种菜单管理自己的任务。要打开已专门指派给您未关闭的任务列表，到菜单 Project ‣ Project ‣ Tasks 。
或是打开未指派的任务，到 Project ‣ Project ‣ Tasks 然后点 Clear按钮再点  Unassigned按钮。.


Tip

快捷方式

每个用户最好在自己的快捷方式里建立到 Tasks 菜单的链接，因为他们将不得不每日多次访问该菜单。



委派 标签允许你定义你的任务之间的联系。从 Parent Tasks 设置和本任务相关联的任务。通过这个方式可以定义需完成任务
的顺序，举例说，任务2不能先于任务1运行。




开票任务

开票的几种方法:


	根据销售订单开票,

	基于成本（服务时间、费用）开票,

	基于发货单开票,

	手工开票.



虽然开票任务可能看起来很有用，但在特定情况下，最好从服务商开票或用采购订单代替。这种开票方式更灵活，可根据价目表开出
不同价位的发票，不同产品也可以进行发票开具。扩大你已有的开票方式对限制你公司的开票方式数量也有帮助。

如果你想连接你的销售订单与项目任务，你应该创建类似 咨询和 深度开发这样的产品。这些产品应如下配置：产品类型 是 服务，
生产方法 是 据订单生产， 供应方法 是 生产。一旦你按此设置，当订单被批准时OpenERP会自动在项目管理中创建一个任务。你甚至
可以在产品中添加一个默认项目。在“产品”表单中，在 需求与库位 页签中，输入可以（从销售订单）自动创建任务的默认项目。

您还可以改变某些参数的顺序，从而影响发票:


	出运政策 : 发票交付后（任务关闭时）

	发票当时情况 : 实际发货量 (任务的实际工时).



利用上述配置创建产品为 咨询 的 销售订单 ，并确认它。您使用 Project ‣ Project ‣ Tasks 菜单
会发现根据销售订单创建的 任务 。一旦找到该任务，点击 开始任务 按钮以启用它。您必须手动指派这项任务所属的项目，
除非你在产品表单提供默认的项目。当你完成任务后，在 工作任务 字段中输入完成信息。单击 完成 按钮，以
通知OpenERP已完成这个任务。作为一个例子，新任务 SO008：Create SRS 如下图所示，据销售订单 SO008 生成的 SO008：Create SRS 。


[image: ../../../_images/project_task_from_sale_order.png]
创建自销售订单的任务




Tip

你需要仔细配置有关这个项目的辅助核算，如果您使用项目的 结算 标签来做到这一点，与项目有关的成本帐户将自动获得相关的设置。



任务结束后，到菜单 项目 ‣ 开发票 ‣ 根据任务开票 去找未开票任务。 当您想根据任务开发票时点击 辅助核算记录 行。


[image: ../../../_images/project_invoice_from_task_work.png]
Form to Create Invoice from Tasks Work






项目优先级管理

有多种方法可以按各自重点确定任务的顺序。OpenERP按照以下方面的功能为任务排序： 序列 ， 优先次序 ， 最后期限 。

使用第二张表单中的 序列 功能，附加信息 来为由多项任务组成的项目作规划。以软件项目举一个例子，所开发的
任务已给出序列，第一项任务为序号一号，以此类推2,3,4等。当你第一次打开项目任务的列表，任务已按序号排列好。你可简单地拖放
任务来改变顺序。

你可从这三种排序的方式中选一种，或者综合运用，这由项目决定。


Note

灵活的方式

OpenERP为软件开发项目项目组合模块补充了灵活的方法论 project_scrum ,

Srum 为系统补充了以下概念：长期计划，冲刺，重复开发，进度报告会议，燃尽图，产品订单。

查看以下网址: http://controlchaos.com 获取更多有关 Srum 的信息。




[image: ../../../_images/service_project_gantt.png]
甘特图，计算最早发运日期



你可在项目文件中设定工作时间。如果不设定，OpenERP会默认为周一到周日每天工作八小时。时间确定后，你可从任务中得到甘特图。
系统之后根据任务顺序和工作时间制定最快完成任务的项目计划。


Tip

日历视图

OpenERP在web客户端和Gtk客户端下都提供不同任务的日历视图。您可以通过拖放删除、创建、修改任务（仅限于web客户端）。


[image: ../../../_images/service_task_calendar.png]


Calendar View of the System Tasks






任务委派

通过委派任务给另外一个用户，您可以变更任务负责人。但是，通过这种方法系统无法帮助您跟踪您委派出去的任务，比方监控工作是否完成。


[image: ../../../_images/service_task_delegate.png]
委派任务给其他人表单



作为替代，您可以在任务上使用 委派 按钮。

您可用该系统调整任务链中不同级别的任务，添加补充信息。任务由一项整体的目标开始，按照等级委托下来变得具体化。

任务表单第二页签，给您一委派任务的完整的历史。您可以找到一个父任务的链接，以及已委派的不同任务。
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长期项目规划

您可以用“长期计划”规划您的项目。要做到这一点，使用的 重新配置 向导，并在项目应用配置一节中，选择 长期规划 ，
并单击 配置 。这会安装 project_long_term 模块。通过使用此功能，您可以将任务和在特定的时间由谁做完的计划链接起来。

传统的分阶段的方法，确定了必须完成的步骤的顺序。Faces [http://faces.homeip.net/] 用于调度阶段和基于日历的任务。因此，可使用此工具跟踪资源的可用
性或资源叶子。甘特图，让您通过拖放即可轻松管理您的资源和计划。日历视图还帮助您审视截止日期和需要注意的任务。


项目阶段

您可以将大项目分拆成多个阶段。定义一个新阶段，在 Project ‣ Project ‣ Project Phases 点击 New .
您必需通过 Project 字段将“项目阶段”和项目关联起来。对于每一个阶段，你可以定义你的需分配的资源（人或设备），描述不同
的任务和之前以及之后阶段。您还可以添加日期和调度相挂钩的约束。项目的甘特视图也来自本菜单，
此菜单为 Project ‣ Long Term Planning ‣ Project Phases .


[image: ../../../_images/project_phase.png]
Form View of Project Phase






排程

你需要确定一个工作进度表以及分支，因为项目调度者会以此来计算定项目周期。请确定您在项目表单中的 Administration
选项卡中 Working Time 字段填入了工作安排。这有助于为您的项目生成精确的甘特图。

如果您有一个任务与项目阶段相关，您可以在“项目阶段”表单中的 Tasks Details 选项卡中看到他们。为其分配日程点 Schedule Tasks 按钮。处于草稿、待决和打开状态的所有任务的日程和他们的工期的计算都基于阶段中的开始日期。


[image: ../../../_images/schedule_tasks.png]
安排相关的结束的任务



您同样可以用以下方式分配项目阶段和分配项目资源:


计算阶段计划

要获得项目阶段的甘特图需通过菜单项 Project ‣ Scheduling ‣ Compute Phase Scheduling ，
会出现一个对话框让您选择的所有项目或单个项目。它将计算给定项目处于草稿、打开和待决状态的各阶段的开始日期和结束日期。
点 Compute 按钮打开甘特图视图。


[image: ../../../_images/gc_project_phases.png]
Gantt Chart for Project Phases






计算任务计划

这一功能和前一功能目的一样，此功能仅用于不分阶段，但包含一系列任务的项目。要访问它，到 Project ‣ Scheduling ‣ Compute Task Scheduling 。
你必须且能选择单个项目来算。它可示资源分配的甘特图。


[image: ../../../_images/gc_resources_allocation.png]
资源分配甘特图
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提高领导能力的规划

在公司中的计划，往往通过团队之间的例会来确定。每个团队都有一定数量的项目和目标，他们必须确定优先事项。

理想的情况下，这些例会应是短暂的，但例行和系统的。取决于业务的要求他们可以每周或每月召开。一次计划会议，通常包括三个阶段:



	先用几分钟对前段时间的工作和计划作对比分析.

	介绍新的项目.

	计划下阶段工作.






规划功能包括将在本节中所述的几个目标:


	根据对客户作出的承诺规划现场项目,

	决定在未来一个月的工作人员（人力资源）的要求,

	安排每个员工或团队下阶段的工作,

	分析在前一阶段的工作完成情况,

	公司高层商议相对较低级别任务接受高级别任务.




Tip

制定计划的作用

很多项目经理认为他们可以独自制定计划。他们往往工作量过大，认为开会浪费时间。

即使员工真的可以安排自己的工作，你还是应该把例会当作一种缓解。否则你将陷入过度压抑的状态:


	有工作负荷的感觉是因为他们对于自身优先权没有把握,

	工作的反馈及跟踪可实现,

	若工作计划不明确,会给人造成组织管理差的印象.



So the social role of planning should not be neglected. We have often experienced a background of
stress in a company stemming from a lack of communication and planning.




按时间还是按任务作计划？

制定计划的方法有两种：按任务或者按时间。你可使用 Open ERP 。

若按任务方式，项目经理可在规定时间内将不同项目分配给员工。雇员认真完成项目经理分配的任务。

若按时间分配方式，每个员工将有一定时间内每个不同项目中分配的时间任务。每个项目的任务由上级分配，可直接分配给接受者，或者
不进行分配。每个员工按计划和任务的先后顺序，选择接下来的任务。


[image: ../../../_images/service_planning_time.png]
员工月度工作时间分配



从员工月度工作时间分配图 员工月度工作时间分配 看出，月度计划制订了每个员工在不同项目上的工作时间。

按照这种按时间分配的方式，客户的优先权不再在计划中体现，而是在任务列表中体现。所以该方法可将项目人力资源规划从任务优先
化处理中区分开来。


Note

两种计划方式比较

为说明按时间规划和按任务规划的不同，以一为期6个月的IT项目为例。该项目循环开发周期约一个月，每周期末
为客户作演示，来作项目跟踪。在会议上，你为下个月作计划。月末，项目的客户经理为客户为已完成的部分开票。

假设该项目由于比预期复杂而延期，若没有其他资源，有两种解决延期的方法:


	完成预期功能但延迟

	准时完成但完成的功能比预期要少.



若按阶段或任务作计划，你要在会议上告知客户现阶段要完成所有任务还需几周时间。相反，若按时间作计划，你要
告知客户停止现行的开发计划，作新计划，但只能提出部分规划的功能。

若客户对延期很在意，那么第一种方法会导致不开心的情况发生。你就必须考虑到延期重新对项目以及项目未来的
进程作计划。后期开票方面也可能出现问题，因为对于延迟完成且未展示给客户的工作部分，开票有难度。




Note

Comparing the Two Planning Methods

第二种方法要求你汇报未完成的功能以及其对未来计划阶段产生的影响。这种方法不会对分配到项目的工作时间产生中断，
但你必须提供两种清单：不同项目人员配置清单和客户项目的任务优化清单。这种方法相对于第一种方法有这些优势:


	客户也可通过制定新阶段计划来延长项目完成时间，或者放弃其中次要的功能来快速完成系统开发,

	客户可能因为考虑到延期, 而重新策划功能.

	你就要让客户意识到, 项目进度背负压力, 工作任务比期初预想的要复杂得多.

	几项功能的延迟发布, 不会对月度开票和项目计划造成影响.



将人力资源规划从任务优化中分离出来，简化了复杂事务的管理，如对员工假期的调整及处理项目中不断变化的岗位级别。






计划你的时间

安装项目计划模块 project_planning ，以获得其它功能，辅助项目规划和报告。使用菜单 Project ‣ Long Term Planning ‣ Plannings
项目—长期规划—计划实施 来开始计划。

在每项规划线内，你应登陆用户，可看到账户分析以及时间分配。分配量以小时或天的形式表示，取决于衡量的单位。每项规划线中，
可对要完成的工作加入简要说明。

保存好计划后，使用其它计划形式选项卡，确认分配给员工或项目的时间是否正确。分配的时间必须与员工的工作合同相一致，例如每周
37.5小时。同时项目预设的时间也应与你和客户的承诺相一致。

你应理想地完成现阶段的所有计划。也可完成未来几个月内的几项计划——如响应客户的承诺，储备不同项目的资源。这使你提前管理
几个月可用的人力资源。

计划可打印或通过邮件发送给员工。每位员工可通过图表清楚地看到他/她在项目上要花费的时间以及目前为止
已工作的时间。所以每位员工可对项目进行优化选择。

然后员工可在最紧急项目中选择任务。她可自己选择分配给她的任务，或者在最紧急任务列表中选择能够完成的任务，且该任务还未直接
分配给别人。

最后，你可对不同项目中所开展的有效工作时间与最初的预计作比较。将计划打印出来，来作计划工作时间和实际工作时间的比较。


[image: ../../../_images/planning_stat.png]
计划工作时间，实际工作时间，项目员工生产力比较



你还可根据 项目 ‣ 上报 Project ‣ Reporting 菜单对项目数据作分析.




在层次每个级别都进行计划

要将规划在整个公司落实到位，你需要运用规划代表团系统。

规划表格能够反应公司的层次结构。要使数据成为规划线的一部分，你可以:


	将项目上要花的时间分配给员工,

	将项目上要花的时间分配给负责其团队的部门经理.



现你可按部门整体来分配项目工作时间，无需细化每个员工的工作任务。当部门经理制定计划时，便可在表格底部看到其管理团队的需求。
而在表格顶部留有空白处，用于将工作具体分配至部门每个成员。

若你不需要在最终稿中作工作时间计划，你可在依附于子帐户的分析帐户作计划.也就是说你可以制定计划来满足高级管理层的最高级
目标,然后分配到不同部门,为每个员工作时间预算.每个经理之后用其计划管理其所在的等级。
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没有压力的生产力的艺术

现你可通过查看ERP提供的一些工具,稍放下单纯的企业管理,来加强你的个人时间管理.这不算绕行,因为良好的组织是你每日工作中
提高生产力的关键.

OpenERP的项目 project_gtd 模块 灵感来自两本有效时间管理为主题的书:


	《Getting Things Done》—无压力环境下提高生产力,戴维艾论著(2001).大部分参考了他本人在2005年草拟的
GTD, 这本书围绕人应该列出未完成任务,然后在一可靠的系统中储存这些任务的细节.




然后他们无须将这些任务记在脑中,他们可以很确定,这些事情已安全记录,他们可让自己放松,并将时间和经历系统
集中在处理任务上.



	《The 7 Habits of Highly Effective People》— 高效能人士的七个习惯(1989): 作者(Stephen R. Covey)建议
组织使用这些实践条例,并在组织中报告生产力提高的结果。





Note

有效安排时间

《Getting Things Done》 — 尽管去做 (David Allen)，企鹅书籍，纽约，2001,267页。(ISBN : 978-0142000281)
见网址：http://davidco.com

《The 7Habits of Highly Effective People》 — 高效能人士的七个习惯(Stephen R. Covey), Free出版社, 1989,
第15期周年改版：2004,384页(ISBN : 978-0743269513)




Tip

自我解压!

将混乱思维的任务理清，将其记录在一个有序的系统中。这能使你快速自我解压，并以最好的方式组织工作开展。

若你因工作负荷倍感压力，按以下方法来告诉自己它的好处。
拿出几页空白纸，将在你脑中要做的事情写下来。
每项工作的下一步用邻近线连接，并在上面标注你要承诺自己完成的时间。


在这个练习的最后，你会觉得做事更有条理，压力和忧虑大大减小。







在这绕行中的目标不是为了具体补充丰富方法论，而是为了介绍 OpenERP项目模块 project_gtd 的辅助工具。


并非所有急事必然是重要的

相对于基础OpenERP系统，模块的第一个调整就是将紧急性和重要性的概念区分开来。工作任务不再按单一的标准分类而是
由两个标准分类，使你在一张列表中看出同具紧急性和重要性的任务。

很多工作任务重的管理者只用紧急性来作为区分工作优先性的方法。其中的问题在于怎样为大多数的工作作计划（如中期目标）。这些工作不紧急但却非常重要。


Note

紧急性和重要性区别举例

如果你组织能力强，紧急的任务通常可以(通常应该)被安排在重要任务之后。从平时的生活中取一例子:
安排时间和你的孩子一起的例子

对于大多数人来说，此项任务是重要的。但是如果你的职业生活很忙碌。每日每周都被没完没了的紧急任务所填满。
即使你将时间安排的很好，几个月过去你仍然没有安排和你的孩子在一起的时间，因为见他们尽管很重要，但是却不像你的
工作那么紧急.



在Open ERP程序中，紧急性由任务的截止期限 Deadline 决定，重要性由优先顺序 Priority 决定。任务的分类由两个因素决定。
最重要和最紧急的任务显示在表格顶端。




有条不紊地组织你的生活

在此部分展示了运用环境联系和时间盒概念来安排自己的方法学


相关环境因素

环境联系是指你要处理某项任务的工作环境。例如你可以为下列环境联系作定义:


	办公室 : 在你工作场所要完成的任务（如打给客户电话或起草一份文件）,

	车 : 要四处奔波的任务（如购物或去邮局）,

	旅行 : 你在出差时在飞机或火车上完成的任务（如写一部作品，或分析一样新产品）,

	家 : 在私人住处完成的任务（如找一家清洁商户或割草）



员工/系统用户可通过菜单 项目 ‣ 配置 ‣ 任务 ‣ 环境因素 Project ‣ Configuration ‣ Tasks ‣ Contexts 来创建自己的相关环境困素.




时间盒

而后你需要为时间盒作定义。你必须完成在时间盒规定的时间间隔中完成任务。你经常通过以下时间段来为时间盒作定义。


	今天 : 今天必须完成的任务,

	本周 : 本周必须完成的任务,

	本月 : 本月必须完成的任务,

	长期 : 一个月之后要完成的任务.



一项任务一次只能放在一个时间盒里。

你必须将时间盒和完成任务的最后期限区分开来，因为任务最后期限是由项目管理者制定的，而时间盒是关于个人的任务。

为你公司的时间盒下定义，要用菜单 项目 ‣ 配置 ‣ 任务 ‣ 时间盒 Project ‣ Configuration ‣ Tasks ‣ Timeboxes.




方法和迭代过程

为有效开展你的任务，OpenERP软件在以下系统及迭代过程基础上使用方法:


#. 确定你要完成的所有任务，包括让你晚上失眠的所有事情，将其输入 任务 中，在菜单 项目 ‣ 项目 ‣ 任务
Project ‣ Project ‣ Tasks 里。


	定期将任务进行分类，为任务指定环境联系和时间盒。同时也指定了任务执行的时间和地点。若一项任务要花少于十分钟的时间，那么这项任务可以很快处理好。



	每天开展以下工作步骤:



	早上的第一件事，从最近一周的时间盒里选择你今天想完成的任务。这些任务按照重要性和紧急性排列，所以
你要从表格的最上方选择任务,

	执行每项任务，也就是说，你自己完成任务或者将任务委托给另一位用户,

	在一天结束的时候要做的就是清空当日的时间盒，并将未完成的任务放至周时间盒.








	每周每月按照各自的时间盒重复相同的步骤









Tip

不要将 议程 和 时间盒 混淆

时间盒和议程是不同的。某些任务，例如会议，必须在指定的时间完成。
所以这样的任务不能由时间盒系统管理，而要由议程管理。

最理想的就是将最小的事放在议程上，并将有明确日期的任务放在议程上。
时间盒系统对于处理多项任务来说更加灵活有效。



所以由输入项目所需的所有任务开始。
这些任务可能已由其他用户输入，并分配给你。
将那些在恼人的任务进行编码很重要，就将他们从你脑中除去。任务可能是:


	待完成的工作,

	短期, 中期或长期目标,

	一个还未分配任务的项目.



几天的项目或目标可在一单项任务中概括。如果你很清楚操作步骤，就不必细化每项操作.

你必须定期清空你的任务。使用菜单 项目 ‣ 项目 ‣ 任务 Project‣ Project ‣ Tasks 为每项任务安排时间盒和环境联系。这个步骤用不了一分钟的时间，
你只是将他们分配，并不是完成任务本身


[image: ../../../_images/service_timebox_day.png]
今天所要完成任务的时间盒



点击顶端右方的 Plannify Timebox .你从包含每周任务的时间盒中选择当天要完成的任务。通过这项操作你可对中期要完成的
任务和目标有整体了解，并让你每天至少回顾一次。然后你根据你任务的先后顺序来分配时间。

任务是按先后顺序分类的，可直接从列表最上方选择任务，一天忙上几个小时。这个步骤只需要一分钟，因为选择无关你未来的
任务，而只是最近一周任务的选择。

时间盒已设定好，你就可以开始你一天的工作。每项任务，你可对其设定开始，删除，结束，取消.

下班后你可点击顶端右边按钮 清空时间盒 。所有未完成的任务将放回周时间盒，并归类到第二天早上计划要完成的任务列表中。

使用相同的原则对每周每月的任务作计划，但要为每个时间段设置合适的时间盒。




令人信服的结果

经过一段时间这种方法的运用，用户报告了以下进展:


	被遗漏的任务和目标减少,

	压力减小，人们对其所在处境控制更强,

	日常开展的工作类型的先后顺序的改变,

	以更长远的时间管理角度来看任务和目标的重要性和紧急性,

	更好地管理所有任务，对任务进行筛选,



最后，注意这个系统完全和OpenERP的项目管理功能完全集成在一起。工作人员可以根据自己的需要决定是否使用该系统。
该系统是对OpenERP的项目管理功能的补充，用于对团队的组织以及对公司的规划.
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管理仓库和搞定制造


本书此部分主要描述实际物流-库存处理及通过组装和制造对物料进行转化.



存货是指产品規格的实体表现形式,而不仅是产品数据清单.存货需要储存,在各库位之间移动,会被以套或个的方式进行追踪.
它们有尺寸,重量以及成本属性.Open ERP 使用了一种有效且独特的方式进行存货管理.



制造是指将物料以及组件，可能还有一些可计量的资源转换成其它产品或服务,为公司增加价值.




	仓库

	定义主数据
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仓库


OpenERP的库存管理看似非常简易, 实则很灵活且功能全面.
它基于带给会计领域革命性变化的复式记帐原理.
系统特点正如 拉瓦锡的名言 “什么也没有失去，一切都改变了” 或者说,
“一切皆为移动”. 在OpenERP中你不会说物料不见了, 消耗了或丢失了:
而是说物料从一个库位移动到了另一个库位.


正如会计复式记帐一样, OpenERP系统管理的每一个主要业务活动
（如采购收货、销售发货、盘盈盘亏、原料损耗等）都有一个对应的库位,
存货移动始终是指物料从一个库位移动到另一个库位. 为了确保每次库存移动都有一个对应库位
软件支持以下不同类别的库位:


	实际库位,

	伙伴库位,

	虚拟库位（作为计划、生产、盘点的对方库位）.



实际库位代表仓库及其层次结构.
实际上就是指通常由传统库存管理系统管理的库位.

伙伴库位代表你的客户和供应商的库存. 在与你的这些伙伴们进行
对帐时, 这些库位就扮演了往来科目的角色. 从供应商收货在系统内就被表示
为物料由伙伴库位移动到了你自己公司的实际库位.
所以你会看到供应商库位通常都会显示负库存而客户库位通常显示为正库存.

与生产对应的虚拟库位通常使用在制造流程中. 制造的特性是消耗原材料,
产出成品.虚拟库位就用作上述操作的对应库位.

盘点库位是贵公司对库存进行盘盈和盘亏操作的对应库位.

下图 系统初始安装后的库位层次结构图 是系统初始安装后的库位层次结构图 (Warehouse ‣ Warehouse Management ‣ Locations).


[image: ../../../_images/stock_location_tree.png]
系统初始安装后的库位层次结构图




Note

结构化库位

在OpenERP中, 库位是结构化的.
你可以将库位设置成基于父子关系的树状结构, 这样的组织方式可以使你更精细的对库存操作和仓库结构进行分析.




Tip

库位与仓库

在 OpenERP 中 Warehouse 仓库代表实际存货的实际存放位置.
可以将仓库设置成多层级库位结构.
库位通常用来对货品进行分门别类的管理, 比如说客户库位和生产
库位.



本章中你可以使用上一章用过的带示例数据的数据库,
已经安装仓库管理及相关模块.

本章中我们要用到以下模块:


List of modules





	Name
	Description




	stock
	to handle the stock functions


	stock_planning
	to define planning on products


	stock_location
	to define pull and push flows


	delivery
	to define delivery methods and costs


	account_anglo_saxon
	to illustrate the valuation according to the anglo-saxon principles


	sale_journal
	to handle stock by journal


	mrp_jit
	to illustrate the just-in-time functionality


	sale_supplier_direct_delivery
	to directly deliver the product from the supplier to the customer







	理解复式库存管理

	管理实际库存结构
	仓库
	自动产生需求

	最小库存规则





	库位
	库位地址

	链式库位

	结构化库位





	商店

	库存
	提前期和库位

	期初库存









	跟踪库存运动
	货物接收
	按采购单接收供应商货物

	按产品接收供应商货物





	内部库存调拨

	货物运输
	部分运输

	客户退货

	准时生产方式（JIT）





	通过高级路线（Advanced Routes）配置物流
	推式物流

	拉式物流





	获得方式 – 按库存生产(MTS)和按订单生产(MTO)

	供应方法的选择

	各种计量单位的物流包装
	计量单位

	包装









	定期采购
	处理意外

	人工采购

	销售预测

	生产计划





	管理批次和可追溯性
	库存调拨

	批次

	可追溯性





	报废产品

	使用条码和RFID设备标识产品和库位

	财务的库存管理
	手动和实时库存核算

	管理运输成本





	组织你的交付
	不同的日记账

	使用日记账





	估算交付日期
	标准交付时间

	依据MRP1规则的定期物流





	收入和发出产品计划

	管理库存盘点

	物料追溯报表

	进口 / 出口
	库存

	租赁库位

	委外加工产品





	库位例子
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理解复式库存管理

本章节用于解释库存管理（或存货管理，stock management）的概念，看一下以下操作是怎样产生库存异动的：


	从供应商处接收产品，

	发货至客户

	丢失物料(or 损耗物料？lost materials)的库存操作

	生产



库位结构基于系统初始安装后的库位层次结构图 系统初始安装后的库位层次结构图. 假定还没有任何存货
也没有尚在进行中或已经计划的存货相关操作.

如果你从供应商处订购 ‘30台单车’，OpenERP会在接收时候执行以下操作：


Stock Move Operation from Suppliers to Stock





	库位
	产品




	伙伴库位 > 供应商
	-30 辆自行车


	实际库位 > OpenERP S.A. > 存货
	+30 辆自行车





如果你向一个欧洲用户发货‘2台自行车’，会产生以下事务(transactions)


出货给欧洲客户后库位中的存货移动





	库位
	产品




	实际库位 > OpenERP S.A. > 存货
	-2 辆自行车


	伙伴库位 > 客户 > 欧洲客户
	+2 辆自行车





当两个操作都完成以后，你会在各个地点看到以下库存


库位中的库存状态





	库位
	产品




	伙伴库位 > 供应商
	-30 辆自行车


	实际库位 > OpenERP S.A. > 存货
	+28 辆自行车


	伙伴库位 > 客户 > 欧洲客户
	+2 辆自行车





所以你能看到，在OpenERP中，一个物料在所有库位的库存总和为0
类似的，在会计中，你会有借方总和等于贷方总和
（注：感觉是说OpenERP中的事务记录设计是参考会计里面的借贷设计）

Partner locations (customers and suppliers) are not located under your company in the hierarchical
structure, so their contents are not considered as part of your own stock. So if you just look at
the physical locations inside your own company, those two bicycles are no longer in your company.
Although they are no longer in your own physical stock, it is still very useful to see them in your customer’s
stock, because that will help when you carry out detailed stock management analysis.
注：直翻有点拗口，上面的意思是：
OpenERP中，伙伴库位（partner locations）的库存并不属于你的公司，所以他们的库存量不属于你。
物理库位(physical locations)才是属于你的公司的，你只需要查看physical locations来了解自己的现有量状况。
参考上面的例子，已经发走的2台自行车不在属于你的公司
虽然他们不属于你公司的物理库存了，但是这笔数据放置在你的客户库存里面还是很有用的，这样可以帮助你进行更为详细的库存分析。


Tip

委托库存，或托管库存(Consignment Stock)

（注：即你的公司负责库存管理，但是所有权（物权）仍然属于供应商或者销售客户的库存。）
为管理托管库存，你需要为供应商或者客户定义专门的库位（托管类型的库位），而不是将其定义为一个合作方库位（partner location）




Note

账目(Accounts)

在管理库存时候，软件数据和实际库存有差异是难以避免的。
复式库存管理提供了2倍的机会来发现一个错误（即提供了双重数据进行复查）
If you forget two items of stock, this error will automatically be reflected in the
counterpart’s location.



You can make a comparison with accounting, where you will easily find an error because you can look
for an anomaly in an account or in the counterparts: if there is not enough in a bank account then that is
probably because someone has forgotten to enter a customer’s invoice payment. You always know that the
sum of debits must equal the sum of the credits in both accounting and OpenERP’s stock management.

In accounting, all documents lead to accounting entries that form the basis of management
accounting. If you create invoices or enter statements of account, for example, the results of the
operations are accounting entries on accounts. And it is the same for stock management in OpenERP.
All stock operations are carried out as simple stock moves. Whether you pack items, or manufacture
them, or carry out a stock inventory operation, stock moves are carried out every time.

你已经看过了一个简单的产品接收和发货的例子，但是有些操作是不明显的 - 如库存的物理盘点操作。
例如，当你对软件中的库存数量和实际的库存数量进行一次比对时，会进行物理盘点

In OpenERP, with its double-entry stock management, you would use stock moves for this inventory
operation. That helps you manage your stock traceability.
例如实际库存有26辆自行车，但是OpenERP显示系统中有28个自行车。
你需要从OpenERP中讲数量减少至26.
这个减少的2辆自行车会视为一个产品的丢失(loss)或者损耗(destruction)。
数量的更正由下面两个操作完成：
（注：相当于用一次库存转移做了盘亏）


Inventory Operation to Adjust Stock





	Location
	Products




	Physical Locations > OpenERP S.A. > Stock
	-2 bicycles


	Virtual Locations > Inventory Loss
	+2 bicycles





综合以上，产品库存变为：


Real and Counterpart Stocks when Operations are Completed





	Location
	Products




	Partner Locations > Suppliers
	-30 bicycles


	Physical Locations > OpenERP S.A. > Stock
	+26 bicycles


	Partner Locations > Customers > European Customers
	+2 bicycles


	Virtual Locations > Inventory Loss
	+2 bicycles





This example shows one of the great advantages of this approach in terms of performance analysis.
几个月以后，你能简单做一个库存评估(stock valuation)，路径为 Inventory Control ‣ Location Structure
‣ Virtual Locations ‣ Inventory Loss 来获得一个在此期间公司库存损耗的数据。

现在看一下，以下的生产操作在OpenERP中是如何记录(structured)的。
生产一辆自行车你需要2个轮子以及1个车架。
这意味着物理库存需要减少2个轮子以及1个车架，同时增加1辆自行车。
这个 物料消耗/生产完工 的过程是通过从物理库存中对物料进行（原材料）发料和（成品）入库来实现的。
以下是这个例子的库存操作数据：


制造后库存状态






	Location
	Products
	Step




	Physical Locations > OpenERP S.A. > Stock
	-2 Wheels
	Consumption of raw materials


	Virtual Locations > Production
	+2 Wheels
	Consumption of raw materials


	Physical Locations > OpenERP S.A. > Stock
	-1 Frame
	Consumption of raw materials


	Virtual Locations > Production
	+1 Frame
	Consumption of raw materials


	Virtual Locations > Production
	-1 Bicycle
	Manufacture of finished products


	Physical Locations > OpenERP S.A. > Stock
	+1 Bicycle
	Manufacture of finished products





至此你已得到从消耗材料到产出成品的预期结果.


Note

计算增值金额

你应该已经注意到这个方法的一个很有用的功能:
如果你查看 Virtual Locations > Production 这个虚拟库位的库存金额合计，就是贵公司的增值部分 (以负数表示).
库位的库存金额合计是由库存产品数量乘以成本价计算得来的.
这里是原材料的金额减去产成品的金额.
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管理实际库存结构


仓库

仓库是设计用于向客户进行交付活动或是接收原材料的实际场所。
当你从供应商处购买产品时，你应该考虑这次采购所要使用的仓库。这也使得最终用户不必从库位列表中进行选择，而是一个真实的仓库

使用菜单 仓库 ‣ 设置 ‣ 仓库管理 ‣ 仓库, 然后点击新建配置一个新的仓库.

A warehouse is defined by a link between three locations:


	库位库存 字段显示了可以直接从这个仓库交付给客户的可用的产品.
可用数 给出在这个库位以及子库位的所有产品。

	The Location Input field shows where ordered products are received from a supplier in that warehouse. It
can be the same as the stock location if, for example, you want to do a quality control operation on
your incoming raw materials.

	The Location Output field (called Output in the demonstration database) is designed as a buffer zone
in which you store all the items that have been picked, but not yet delivered to a customer. You are
strongly advised not to put this location within the stock hierarchy but instead at a higher level or at the same level.




[image: ../../../_images/stock_warehouse.png]
仓库参数



你也能为仓库设置一个地址。这个地址应该是你的公司的一个地址。一旦仓库被定义，你能用在：


	最小库存规则,

	供应商订单,

	客户订单 (用在 POS的定义，关联到一个仓库).




自动产生需求

OpenERP 有多种自动供应(procurement)产品的方法：


	the workflow used by products that have the procurement method Make to Order,

	对于*Make to Stock*产品(存货制造)，可以使用最小库存规则

	对于*Make to Stock*产品(存货制造)，使用主生产计划(Master Production Schedule)



The last two methods are described below.




最小库存规则

当希望自动产生补货请求是，你可以使用最小库存规则. 菜单路径：
Warehouse ‣ Automatic Procurements ‣ Minimum Stock Rules.

规则如下：如果指定地点(location)的虚拟库存(virtual stock)比规则中指定的最小库存量少，
系统会自动建议采购，增加虚拟库存(virtual stock)的数量至规则中规定的最大值


[image: ../../../_images/stock_min_rule.png]
List of Minimum Stock Rules




Tip

Conflict Resolution

You may find draft production or procurement orders to be created although they should not exist.
That can happen if the system is badly configured (for example, if you have forgotten to set the
supplier on a product).

To check this, look at the list of procurements in the exception state in the menu
Warehouse ‣ Schedulers ‣ Procurement Exceptions. More
details about processing these exceptions is given in ch-mnf.



We underline that the rule is based on virtual quantities and not just on real
quantities. It takes into account the calculation of orders and receipts to come.

如下面的例子：


	库存中的产品数量：15

	已下单(Sales Order?)但是未发货的数量：5

	在制数量：2



定义的规则为：


	最小库存: 13

	最大库存: 25.



一旦规则被正确设置，采购经理只需要查看订单(采购订单)列表与供应商进行确认，菜单路径为 Purchases ‣ Purchase Management ‣
Requests for Quotation.


Note

Procurement

注意，供应请求不一定要求你从供应商处购买，如果产品有一个属性
Supply Method Produce,(注：即供应方式为生产)
主生产计划(scheduler)会产生一个生产工单，而不是一个采购订单



你也可以在规则中设置最小包装量(multiple quantities). 如果你设置的最小包装量为3，系统会建议一个15pieces的供应，
而不是真正需要的13。在这种情况下，系统会自动根据最小包装量取上整数。（注：即根据最小包装取整，多买一个最小包装的量）


Note

Maximum Quantity

注意一个事实，最大数量不是你库存的最大量。
比如：一个公司有10 pieces的产品，最小库存规则设置为，最小数量 = 10, 最大数量 = 30 及 最小包装 = 12
如果有一个预计的2 piece订单（销售订单），系统执行计算后会产生一个24 pieces的采购需求。
第一个12 pieces会用于达到最小数量，第二个12 pieces用于达到最大数量。



In a minimum stock rule, when you indicate a warehouse, it suggests a stock location by default in
that warehouse. You can change that default location when the scheduler completes.






库位

一个库位（或 货位）是仓库中的一个组成部分，用来管理所有类型的库存位置。 such as at the
customer’s and production counterparts.

根据你的需求，在你（在系统中）构建你的仓库时候，可以设置不同类型的库位。
Locations are structured hierarchically to account for the subdivision of a warehouse into sections, aisles, and/or
cupboards.
(译：库位是多层级结构的，用于将仓库分为更小的子层级，如 区域、通道 或者 cupboards(货架？))
The hierarchical view also enables you to structure virtual locations such as production counterparts.
That gives you a finer level of analysis.
Go to the menu Warehouse ‣ Configuration ‣ Warehouse Management ‣ Locations, then click New
to define new locations.


[image: ../../../_images/stock_location_form.png]
定义新库位



下面是几种常见的库位:


	供应商库位: 虚拟货位，代表产品是从供应商处接收的(如收货时候，源货位就是供应商货位，代表供应商库存减少)




	视图库位: shows that the location is only an organizational node for the hierarchical structure, and
cannot be involved in stock moves itself. The view type is not made into a leaf node in a
structure – it usually has children.

	内部库位:  您仓库中的物理货位

	客户库位: 虚拟货位，表示货物发送给了客户，(如销售订单发货后，客户货位增加，表示已经发给了客户)

	盘点/损耗库位: virtual location serving as the counterpart for inventory operations used to correct stock levels (physical inventories),

	Procurement: virtual location serving as temporary counterpart for procurement operations when you do not yet know the source (supplier or production). Products in this location should be zero after the scheduler run
completes,

	生产库位: 生产过程的虚拟货位，用来记录原材料消耗(发放至此货位)以及成品完工来源

	多公司间中转库位: 用于多组织环境中的中间过程货位。(如两个组织间调拨时候，货物仍在途的情况)



You can have several locations of the same type. In that case, your product, supplier and warehouse configurations
determine the location that is to be used for any given operation.


库位地址

每个库位可以指定一个地址，使你能够给客户或者供应商建立一个库位。
如：你能够设置库位地址为供应商或者客户的地址。
去 业务合作伙伴 界面，告诉OpenERP，他应该使用这个库位，而不是默认库位
(Go to the partner form to tell OpenERP it should use this location rather than the default location given to partner deliveries.)


Tip

Subcontracting Production

You will see in the on line chapter Manufacturing that it is possible to assign a location to a manufacturing workcenter.
If this location is at a suppliers, you must give it an address so that OpenERP can prepare a delivery order for
the supplier and a receive operation for the manufactured goods.
Creating a location specifically for a partner is also a simple solution for handling consigned stocks in OpenERP.




Note

托管库存(Consigned Stock)

Consigned stock is stock that is owned by you (valued in your accounts), but is physically stocked by your supplier.
Or, conversely, it could be stock owned by your customer (not valued by you), but stocked in your company. Make sure
that you create consignment locations as part of your internal stock.



To enable you to easily consolidate at a higher level, the location definition is hierarchical. This structure is
given by the field Parent Location. That also enables you to manage complex cases of product localization.

例如，你可以想象一下以下场景：一个公司有两个仓库

一个公司有两个仓库，一个在巴黎，一个在波尔多。对于某些销售订单，你需要从巴黎发货，另外一些订单需要由波尔多进行发货。
但你仍需要指定一个虚拟的仓库给OpenERP,让系统计算他应该由巴黎还是波尔多进行发货。
在OpenERP里面，你可以设置一个(虚拟)仓库“法国”，组合(consolidates)了巴黎仓库和波尔多仓库。
(注：也就是设定了 法国.巴黎，以及 法国.波尔多 ？)
你建立了以下物理库位：


	Company
	Output
	Warehouses France
	Warehouse Paris

	Warehouse Bordeaux















OpenERP会从有产品库存的仓库发货。
当产品在几个仓库均有货时，OpenERP会选择最近的仓库(进行发货)。
为了让系统知道仓库之间的距离，你需要为每个仓库设置地理坐标(X,Y,Z)，以便OpenERP搜索最近的货物。
同样，坐标可以用于构建仓库的货架、货道和内部房间。(注：即仓库内部坐标)




链式库位

OpenERP中的库位是可以相互链接在一起，以定义产品的路径的。
因此你能够定义如下规则：所有进入仓库的产品会自动的发送至质量监控(即检验货位)。
仓储和质检由两个不同的货位表示(即类似于收货时，在一个货位做质检，另外一个货位做储存)

这样，当一个货物到达库位时候，OpenERP会自动建议你将货物发送到一个链接的库位。
有3种链接的模式：


	手工操作(Manual Operation),

	自动移动(Automatic Move),

	自动无步骤添加(Automatic No Step Added).



手工操作 模式，一旦货物到达源库位，(系统)会创建一张内部物料搬运单(从当前库位)至链接库位
物料搬运单会等待用户的确认(confirmation of the move)。
This enables you to have a list of moves to do,
物料搬运单由系统建议，由仓管员(storesperson)确认。

自动移动(Automatic Move) 模式会做相同的事情,但不会等待一个用户的确认(即移动步骤系统自动完成了)。
不需要人工的接入，产品会自动发送到链接库位。
这适合于，为了简化操作，你删除了系统上的一个操作步骤，用户自己完成这个(物理的)操作流程。
(即系统上少操作一步，但是现实中库存人员还是做了两步，如检验-入库)

自动无步骤添加(Automatic No Step Added) 模式不会包含额外的库存移动，但会透明的将目标库位进行更改至链接库位。(即直接更改目标库位，不会产生上面两个模式中的物料搬运单)
You could then assign a destination location to which you
send all the products that arrive in your warehouse. The storesperson will modify the goods receipt note.


Tip

Product Logistics

The module stock_location lets you generate paths to follow, not just at the level of locations, but also at the
level of products. It then enables you to manage default locations for a given product or to refer to the products
as a function of operations such as quality control, supplier receipt, and after-sales service.

A more detailed explanation of this module, with examples, is given at the end of this chapter.



If there is linking to do, the Chained Location Type field allows you to determine the destination location. If the field
is set to ‘Customer’, the location is given by the properties of the partner form. If the field is set to fixed, the
destination location is given by the field Chained Location If Fixed.

Some operations take a certain time between order and execution. To account for this lead time, you can set a
value in days in the field Chaining Lead Time. Then the extra move (automatic or not) will be carried out several
days after the original move. If you use the mode Automatic No Step Added, the lead time is inserted directly into
the initial order. In this way, you can add security lead times at certain control points in the warehouse.




结构化库位

In the next part, you will see that by linking locations you can manage a whole series of complex cases for efficient production management:


	Handling multiple operations for a customer order,

	Tracking import and export by sea transport,

	Managing a production chain in detail,

	Managing rented products,

	Managing consigned products.



To show these concepts, different cases of structuring and configuring these locations are given below. Many other
configurations are possible according to company needs.

Examples:


	Handling customer orders



Customer orders are usually handled in one of two ways:



	item note (or preparation order), confirmed when the item is ready to send,

	delivery order (or freight note), confirmed when the transporter has delivered the item to a customer.






You use the following stock move in OpenERP to simulate these operations:



	Packing Note: Stock > Output,

	Delivery Order: Output > Customer.






The first operation is automatically generated by the customer order. The second one is generated by the stock management,
showing that the Output location is linked to the Customer location. The two operations will be displayed in Waiting status. If the
Output location is not situated beneath the stock location, you then have to move the item from stock to the place where
the item is prepared.

Some companies do not want to work in two steps, because it just seems like extra work to have to confirm a
delivery note in the system. You can then set the link mode to ‘Automatic’ to make OpenERP automatically
confirm the second step. It is then assumed all the items have automatically been delivered to the customer.


	Linked production



The stock_location module enables you to manage the linkages by product in addition to doing that by
location. You can then create a location structure that represents your production chain by product.

The location structure may look like this:


	Stock


	Level 1



	Level 2



	Link 1
	Operation 1

	Operation 2

	Operation 3

	Operation 4


















You can then set the locations a product or a routing must go through in the relevant form. All products that enter
the production chain will automatically follow the predetermined path.
You can see the location structure using Warehouse ‣ Inventory Control ‣ Location Structure.






商店

The counterparts for procurement, inventory and production operations are given by the locations shown in the
product form. The counterparts of reception and delivery operations are given by the locations shown in the
partner form. The choice of stock location is determined by the configuration of the warehouse, linked to a Shop,
which can be defined using Sales ‣ Configuration ‣ Sales ‣ Shop.

Once a shop is defined, you will be able to make sales orders from this shop. You need at least one shop in order to be able to make sales orders.




库存

In the Product form, the Stock by Location action will give you the stock levels of the various products in any selected location. If you have not selected any location, OpenERP calculates stocks for all of the physical locations. When you are in the Stock by Location view, click the Print button to print the Location Content or the Location Inventory Overview reports.


Note

Availability of Stock

Depending on whether you look at the product from a customer order, or from the menu of a product form, you
can get different values for stock availability. If you use the Product menu, you get the stock in all of the
physical stock locations. Looking at the product from the order you will only see the report of the warehouse
selected in the order.



In this respect, two important fields in the product form are:


	Real Stock: Quantity physically present in your warehouse,

	Virtual Stock: Calculated as follows: real stock – outgoing + incoming.




Note

Virtual Stock

Virtual stock is very useful because it shows what the salespeople can sell. If the virtual stock is higher than
the real stock, this means products will be coming in. If virtual stock is smaller than real stock, certain
products are reserved for other sales orders or work orders.




Tip

Detail of Future Stock

To get more details about future stock, you can click Stock Level Forecast to the right of the product form to
get the report Forecast Stock Levels as illustrated below. OpenERP shows a graph of the changes in stock
in the days to come, varying as a function of purchase orders, confirmed production and sales orders.




[image: ../../../_images/stock_forecast_report.png]
Printout of forecast stock levels




Tip

Filter Stock by Location

By default, in Product list view, the columns Real Stock and Virtual Stock show the stock figures for all stock
locations where a product is stored. Use the Extended Filters to enter a specific stock location, if you want to
only see the stock in a specific location.




提前期和库位

The tab Procurement & Locations in the Product form contains information about different lead times and
locations. Three lead time figures are available:


	Customer Lead Time: lead time promised to the customer, expressed in number of days between the order
and the delivery to the customer,

	Manufacturing Lead Time: lead time, in days, between a production order and the end of production of
the finished product,

	Warranty (months): length of time in months for the warranty of the delivered products.




Note

Warranty

The warranty period is used in the Repairs management and after-sales service. You can find more information
on this subject in the on line chapter about Manufacturing.



Fields in the section Storage Localisation are for information only; they do not have any impact on the management
of stock.

Counter-Part Locations Properties are automatically proposed by the system, but the different values can be
modified. You will find counterpart locations for:


	Procurement,

	Production,

	Inventory.



A procurement location is a temporary location for stock moves that have not yet been finalized by the scheduler.
When the system does not yet know if procurement is to be done by a purchase or production, OpenERP uses the
counterpart location Procurement. In this location, you will find everything that has not yet been planned by the
system. The quantities of product in this location cancel each other out.




期初库存

Once a product has been defined, use an initial inventory operation to put current quantities into the system by
location for the products in stock. Go to the menu Warehouse ‣ Inventory Control ‣ Physical
Inventories to do your initial inventory.


[image: ../../../_images/stock_inventory_new.png]
Defining a New Inventory Operation



Give a name (for example Initial Inventory or Lost Product XYZ) and a date (proposed by default)
for each inventory operation.

You have three ways of doing an inventory.


	Click the Import Inventory action and select the location concerned. You can choose to include child locations
and set the inventory to zero (especially useful to ensure the count is done correctly).

	You can update the inventory from the Product form. Go to the Information tab, Stocks section, and click
the Update button. On confirmation, OpenERP will create a Physical Inventory.

	You can manually add inventory lines. You can then enter data about the quantities available for each product
by location. Start by entering the location, for example Stock, and then select the product.
OpenERP automatically completes the quantity available for that product in the location shown. You can
then change that value to correct the value in stock.



Enter data for a single line in your inventory:


	Location : Stock,

	Product : PC1 Basic PC,

	Quantity : 23 Units.



When your inventory operation is finished, you can confirm it using the Confirm Inventory button to the bottom
right of the form. OpenERP will then automatically create the stock moves to close the gaps, as mentioned at the
start of this chapter. You can verify the moves generated using the Posted Inventory tab of the inventory operation
form.

The correct levels of your product are now in your stock locations. A simple way of verifying this is to reopen the
product form to see the quantities available in stock.


Tip

Periodical Inventory

You are usually legally required to do a stock check of all your products at least once a year. As well as doing a
complete annual stock check, OpenERP also supports the method of periodical inventory.

That means you can check the stock levels of a proportion of your products every so often. This system is accepted
in France as long as you can guarantee that all of your products have been counted at least once per year. To see
the last inventory count per product, use the report Warehouse ‣ Reporting ‣ Last Product
Inventories.

You can do this the same way for all products and all locations, so you only carry out small inventory operations
through the year, rather than a single large stock check at one point in the year (which usually turns out to be at
an inconvenient time).
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跟踪库存运动


货物接收

在OpenERP中, 你可以有3种方法来接收供应商提供的货物。

The first method is to manually enter the information in the incoming shipment. To receive the products
through this method, you have to go to Incoming Shipments section in the Warehouse
Management submenu, click New and then you enter the information about the receipt.


[image: ../../../_images/stock_getting.png]
Manual Data Entry for Product Receipt



The second method is to receive products from a generated incoming shipment. To achieve the reception
using this method, you have to go to Incoming Shipments section in the Warehouse
Management submenu. You will find the list of waiting incoming shipments.

The third method is to receive products by waiting products without looking at the shipment document.
You can validate the reception by products in Receive Products section in the :guilabel:`
Product Moves` submenu. With this method, you will be able to receive one product, regardless of the
document which is attached to this product.


按采购单接收供应商货物

If you use Purchase Orders in OpenERP, product receipts are automatically generated by the system when the
purchase order is confirmed. You do not have to enter any date, just confirm that the quantities ordered match the
quantities received.

Incoming Shipments forms are automatically prepared by OpenERP from the purchase management
process. You will find a list of all the awaited receipts in the menu Warehouse
‣ Warehouse Management ‣ Incoming Shipments. Use the order number or the supplier name to find the
right goods receipt form for confirmation of a goods-in. This approach enables you to control
quantities received by referring to the quantities ordered.


[image: ../../../_images/stock_picking_in_tree.png]
List of Items Waiting



You can also do goods-in data entry manually if there is no order, using the same menu by clicking the New button.

A new goods-in data entry form opens. Enter the supplier data in the Address field
and type the reference number from your supplier in the field Origin. You should then enter data about the products received in the lines.

The source location is already completed by default because of your supplier selection. You should
then give the destination location where you will place the products. For example, enter Stock.
At this stage, you can set a lot number for traceability (this function will be described later in
this chapter, so leave this field empty for the moment).

Once the form has been completed, you can confirm the receipt of all the products at the same time
using the Process Now button. If you want to enter data for a goods receipt that you are still
waiting for, click the button Process Later.


Note

Partial or Complete Reception

When you process the incoming shipment, you can choose between partial or complete.

If you have to validate a partial incoming shipment, click Process now and change the number of items
according to the quantity received.


[image: ../../../_images/product_to_process.png]
Confirm partial reception



Another object will be generated with a back order reference equal to the
Reference number of the incoming shipment already confirmed.


[image: ../../../_images/partial_shipment.png]
Process a Partial Incoming Shipment



Once the rest of the order has arrived and has been processed, both orders will be merged.




[image: ../../../_images/stock_picking_in_form.png]
Form for Entering Goods received from a Supplier Order



The products then arrive in stock and should reflect the quantities shown on the product form.

In the Incoming Shipments form, the field Invoice Control lets you influence the way you
send invoices to suppliers. If this is set to To be invoiced, a supplier invoice will now be
generated automatically in the draft state, based on the goods received. Your accountant then has to
confirm this pre-invoicing once the supplier’s invoice is received. This enables you to verify that
the invoiced quantities correspond to the quantities received.


Tip

Print the Packing List

In order to print the packing list of an incoming shipment, select the incoming shipment of which you need
the details and click Packing List in the panel at the right side of the screen.

This link is available in the Internal Moves and Delivery Orders sections.



In case you received damaged or wrong products, you can return them to the supplier. In the Incoming shipment
form, click the Return Products button. A window will open that lets you choose the invoicing
process to follow. Once you click Process, a stock move is generated with the same reference number
and return to specify that this is a return move.


[image: ../../../_images/return_product_stock_move.png]
Stock Move for Returned Products






按产品接收供应商货物

The approach shown above is very useful if goods receipts correspond to the original orders. If your suppliers
deliver items that do not necessarily coincide with the orders, however, it is easier to work by products received
rather than by orders.

From this version on, you can also handle receptions by product, even from List view. Go to Warehouse ‣ Products Moves ‣ Receive Products.

Filters allow you to easily select receipts to be done, and so on. One way to quickly receive products is to Group by Supplier and select To Do.

This is very useful functionality when your supplier sends the goods for several purchase orders at a time. You can now just receive the products, regardless of the purchase order they come from, simply by clicking the green arrow at the right side of the screen.

The List view offers great flexibility and allows you to rapidly receive products by keeping full functionality! Of course, you can handle both partial and complete receptions, and you can add information about the production lots and packs.


[image: ../../../_images/receive_products.png]
Receipt of a Supplier Order using Group By



This can be also accomplished from Form view.






内部库存调拨

You should install the stock_location module (from the list of modules, or through Reconfigure wizard, Advanced Routes) if routing products to customers, from suppliers or in your warehouse is determined by the identity of the product itself.


[image: ../../../_images/product_location.png]
Managing the Paths from one Location to Another in a Product Form



This will let you configure logistics rules individually for each product. For example, when a specific product
arrives in stores, it can automatically be sent to quality control. In this case, it has to be configured as a Push Flow
with rules in the Product form. The fields that make up those rules are:


	Source Location: the rule only applies if a product comes from this location,

	Destination Location: the rule only applies if a product ends up in this location,

	Automatic Move: Automatic Move, Manual Operation, Automatic No Step Added,

	Delay (days),

	Operation: a free text field which will be included in the automatic stock move proposed by OpenERP.



There are two main logistic flows:


	Pushed Flows

	Pulled Flows



Push flows are useful when the arrival of certain products in a given location should always be followed by a
corresponding move to another location, optionally after a certain delay. The original Warehouse application already
supports such Push flow specifications on the Locations themselves, but these cannot be refined per product.
Pull flows are a bit different from Push flows, in the sense that they are not related to the processing of product
moves, but rather to the processing of procurement orders. What is being pulled is a need, not directly products.
You will now see some examples of using these locations and logistics by product through Pushed Flows for:


	A rentable product,

	A product bought in China, following its freight by ship from port to port,

	A product that you want to send to quality control before putting it in stocks.



We will develop the third scenario: the quality control.

You can configure the system to put a given product in the Quality Control bay automatically when it arrives in
your company. To do that, you just configure a rule for the product to be placed in the Quality Control location
rather than the Input location when the product is received from the supplier.


Rule to Move Products manually from Input to Quality Control





	Field
	Value




	Source location
	Stock


	Destination location
	Quality Control


	Automatic Move
	Manual Operation


	Shipping Type
	Getting Goods


	Delay (days)
	0


	Operation
	Quality Control





Once this product has been received, OpenERP will automatically manage the request for an internal movement
to send it to the Quality Control location. If you want to do this automatically without having to
confirm it, in the Automatic Move field, select Automatic Move or Automatic No Step Added.

With the configuration described in the table above, you will have to confirm the stock move manually once you
have received the goods.


[image: ../../../_images/manual_move.png]
Manual Stock Move to Quality Control



If you do not want to confirm the stock move manually, but you want to see the move Suppliers –> Stock then
Stock –> Quality Control, change the Automatic Move field and select Automatic Move. With this
configuration, you will see the two stock moves.


[image: ../../../_images/stock_move.png]
Automatic Stock Move to Quality Control



If you select Automatic Move No Step Added, you will only see one stock move: Suppliers –> Quality Control


[image: ../../../_images/automatic_move_nsta.png]
Automatic Stock Move to Quality Control (No Step Added)






货物运输

In the same way as delivering goods, you can ship goods in three different ways:


	manually enter data,

	deliver goods according to a sales order,

	deliver goods by product.



Everything about goods receipt can also be done manually in the same way for a customer delivery. This time, use
the automated product delivery processes based on customer orders. Install the sale module
(Reconfigure wizard, Sales Management), so that you can proceed further in this section of the chapter.

Now create a new sales order from the menu Sales ‣ Sales ‣ Sales Orders.
Enter the following data in this order:


	Shop : OpenERP S.A.

	Customer : Agrolait

	Sales order lines :
	Product : [PC2] Basic+ PC (assembly on order),

	Quantity (UoM) : 3,

	Product UoM : PCE,

	Procurement Method : from stock.







You have already seen that OpenERP shows the available product stock in list view. The real stock is equal to the virtual stock because you have nothing to deliver to customers and you are not waiting for any of these products to be received into stock. The salesperson then has
all the information needed to take orders efficiently.


[image: ../../../_images/stock_sale_form.png]
Entering an Order for Three Computers



Then confirm the quotation to convert it to an order. If you return to the product form, you will see
the virtual stock is now smaller than the real stock.

Start the scheduler through the menu Warehouse ‣ Schedulers ‣ Compute Schedulers. Its
functionality will be detailed in ch-mnf. This manages the reservation of products and places orders
based on the dates promised to customers, and the various internal lead times and priorities.
Three products will be reserved in the order that you created, so they cannot be sold to another customer.


Tip

Just in Time

Install the module mrp_jit to schedule each order in real time after it has been confirmed.
This means that you do not have to start the scheduler or wait for its periodical start time.



Now have a look at the list of deliveries waiting to be carried out using the menu
Warehouse ‣ Warehouse Management ‣ Delivery Orders. You find a line
there for your order representing the items to be sent. Double-click the line to see the detail of
the items proposed by OpenERP.


[image: ../../../_images/stock_picking_out_form.png]
Items on a Customer Order




Tip

States

OpenERP distinguishes between the states Confirmed and Assigned.

An item is Confirmed when it is needed, but the available stock may be insufficient.
An item is Assigned when it is available in stock and the storesperson reserves it:
the necessary products have been reserved for this specific operation.



You can also confirm a customer delivery from a confirmed Sales Order.
When you click the Process button of Outgoing Deliveries, a window opens where you can
enter the quantities actually delivered. If you enter a value less than the forecasted one, OpenERP
automatically generates a partial delivery note and a new order for the remaining items. For this
exercise, just confirm all the products.

However, if you want to look at a partial shipping, an example will be developed at the end of this section.

If you return to the list of current orders, you will see that your order has now been marked as
delivered (Done). A progress indicator from 0% to 100% is shown by each order so that the
salesperson can follow the progress of his orders at a glance.


[image: ../../../_images/stock_sale_tree.png]
List of Orders with their Delivery State




Note

Negative Stock

Stock Management is very flexible to be more effective.
For example, if you forget to enter products at goods-in, this will not prevent you from sending
them to customers.
In OpenERP, you can force all operations manually using the button Force Availability.
In this case, your stocks risk to become negative. You should monitor all stocks for negative
levels and carry out an inventory correction when that happens.




部分运输

Should you have to process a partial delivery, you can go to Warehouse ‣
Warehouse Management ‣ Delivery Orders, then select the order to process it. In the new window, change
the quantity to ship and then confirm it.

If you go back to the list view, you will now see a new delivery order with a back order number
equal to the just confirmed order. This is illustrated in the following figure.


[image: ../../../_images/partial_shipping.png]
Partial Shipping



In the stock moves, you will see that there are two moves. The first move is for the remaining quantities to
ship and the second one is for the shipped goods. There will be more stock moves if you process partial
shipping in more than two times.


[image: ../../../_images/stock_move_partial.png]
Stock Moves in Partial Shipping






客户退货

If a customer returns damaged or wrongly delivered products, you can enter this information in OpenERP
via Warehouse ‣ Warehouse Management ‣ Delivery Orders.

You have to select the order related to the returned products and click the Return Products.
A new window will open and will let you choose the invoicing method.


[image: ../../../_images/return_picking.png]
Return Products from Customers



When the product is returned, it will go back to your stock and you will see a stock move from Customers
–> Shelf 1.


[image: ../../../_images/return_product.png]
Stock Move for a Returned Product






准时生产方式（JIT）

By default, scheduling starts automatically once a day. You should make this
scheduling execute overnight to ensure that the system does not slow down under a heavy load of scheduling when
you are also trying to use it interactively.

To set the start time for the scheduler, go to the menu
Administration ‣ Configuration ‣ Scheduler ‣ Scheduled Actions. Select the rule
called ‘Run mrp scheduler’ and modify the date and time of the next execution.

Some companies want to plan orders progressively as they are entered, so they do not wait until
procurement orders are planned the next day. Install the module mrp_jit (Reconfigure wizard, Just In Time Scheduling) to handle this. Once the module is installed, each requirement (that could result in a Production or Purchase Order)
will be planned in real time as soon as it has been confirmed.

Then if you make a sales order with a product that is Make To Order, the quotation request to a
supplier will immediately be generated.


Tip

Delivery from the Supplier or to the Customer

The sale_supplier_direct_delivery module enables you to deliver the product directly from
the supplier to the customer. At the time of writing, this module is in extra-addons.
The logic that the product follows is configured individually for each product and affects only
products marked Make to Order.



This mode does not always makes sense. Each order is processed immediately when confirmed. So if an order
is to be delivered in three months, the scheduler will reserve goods in stock for each order once
it has been confirmed. It would have been more sensible to leave these products available for other
orders.

If a Purchase Order’s Invoicing Control is configured From Order,
the scheduler will immediately create the corresponding supplier quotation request. It might have been better to delay it for several weeks, if
you could have used the lead time to group the purchase with other future orders.

The negative effects of the Just in Time module are:


	Poor priority management between orders,

	Additionally stocked products.








通过高级路线（Advanced Routes）配置物流

To configure your logistics for advanced push and pull, you need to install stock_location module
(Reconfigure wizard, Advanced Routes) as explained before. A complete scenario will be developed at the end of this chapter.

This module supplements the Warehouse application by adding support for location paths per product, effectively implementing Push and Pull inventory flows.

Typically this could be used to:


	Manage product manufacturing chains,

	Manage default locations per product,

	Define routes within your warehouse according to business needs, such as:
	Quality Control

	After Sales Services

	Supplier Returns





	Help rental management, by generating automated return moves for rented products.



Once this module is installed, an additional Logistics Flows tab appears in the Product form, allowing you to add Push and Pull flow specifications.


推式物流

Push flows are useful when the arrival of certain products in a given location should always be followed by a corresponding move to another location, optionally after a certain delay.


Note

Product

The core Warehouse Management application already supports such Push Flow specifications on the Locations, but these cannot be refined per product.



A push flow specification indicates which location is chained with another location, as well as the parameters used. As soon as a given quantity of products is moved to the source location, a chained move is automatically foreseen according to the parameters set on the flow specification (destination location, delay, type of move, journal, etc.) The new move may be processed automatically, or may require a manual confirmation, according to what you have defined.

Suppose whenever the demo data product CPU3 enters the Stock location, it first has to be moved to the Quality Control location in order to check the quality.

Look up the product CPU3 using the menu Warehouse ‣ Product ‣ Products.

To have OpenERP accomplish this move automatically, you have to configure the Push flow as follows:


	Operation: Receptions to Quality Control

	Source Location: Stock

	Destination Location: Quality Control

	Automatic Move: Automatic No Step Added

	Delay (days): 1

	Shipping Type: Getting Goods

	Invoice Status: Not Applicable




[image: ../../../_images/stock_pushed_flow.png]
Push Flow Specification for Product CPU3



A push flow is related to how stock moves should be generated in order to increase or decrease inventory.




拉式物流

Pull flows are a bit different from Push flows, in the sense that they are not related to the processing of product moves, but rather to the processing of procurement orders. What is being pulled is a need, not directly products.

A classical example of a Pull flow is when you have an Outlet company, with a parent Company that is responsible for the supplies of the Outlet.


[ Customer ] <- A - [ Outlet ]  <- B -  [ Holding ] <- C - [ Supplier ]



Tip

Demo Data

In our demo data example, the Outlet Company is Shop 1, while OpenERP SA is the parent company.



When a new procurement order A (resulting from the confirmation of a Sales Order, for example) is created in the Outlet (Shop 1), it is converted into another procurement B (through a Pull flow of the ‘move’ type) requested from the Holding. When procurement order B is processed by the Holding company (OpenERP SA), and if the product is out of stock, it may be converted into a Purchase Order (C) from the Supplier (Push flow of the ‘Buy’ type). The result is that the procurement order, the need, is pushed all the way between the Customer and Supplier.

Technically, Pull flows allow to process procurement orders differently, not only depending on the product being considered, but also depending on which location holds the “need” for that product (i.e. the destination location of that procurement order).

To explain a pull flow for the product CPU1, we first have to configure the minimum stock rules of CPU1 for the company OpenERP S.A. and Shop 1 using the menu Warehouse ‣ Automatic Procurements ‣ Minimum Stock Rules or by selecting the product concerned and then clicking the Minimum Stock Rules action.


Note

Minimum Stock Rules

If you work with the demo data, these minimum stock rules have already been defined.



For the company OpenERP S.A.:


	Min Quantity : 10

	Max Quantity : 50



For the company Shop 1;


	Min Quantity : 10

	Max Quantity : 20



Look up the product CPU1 using menu Warehouse ‣ Product ‣ Products in order to define the configuration of the pulled flow.


[image: ../../../_images/stock_pulled_flow.png]
Pull Flow Specification for Product CPU1



There are two specifications of a pull flow for product CPU1.

Specification 1:


	Name : Receive from Warehouse

	Destination Location : Shop 1

	Type of Procurement : Move

	Source Location : Internal Shippings

	Partner Address : OpenERP S.A., Belgium Gerompont Chaussee de Namur 40

	Shipping Type : Getting Goods

	Procure Method : Make to Order

	Invoice Status: Not Applicable



Specification 2:


	Name : Deliver Shop

	Destination Location : Internal Shippings

	Type of Procurement : Move

	Source Location : Stock

	Partner Address : Fabien

	Shipping Type : Sending Goods

	Procure Method : Make to Stock

	Invoice Status: Not Applicable



Now sell 1 unit of product CPU1 from the Shop1 (do not forget to confirm your sales order) and run the scheduler using the menu Warehouse ‣ Schedulers ‣ Compute Schedulers. Then check the stock moves for product CPU1 from the menu  Warehouse ‣ Traceability ‣ Stock Moves.


[image: ../../../_images/stock_move_pull_flow.png]
Stock Move of CPU1 related to Pull Flow Specification



These moves can be explained like this:

[ Customer ] <– [ Shop 1 ]  <– Internal Shippings <– Stock <–  [ OpenERP S.A. ]

When the company Shop 1 sells one unit of CPU1 to a customer, its stock decreases to 10 units.
According to the minimum stock rule of the product CPU1, OpenERP generates a procurement order of 21 units of CPU1 for the company Shop 1 (OP/00007, or another number if you have added extra data). So 21 units of CPU1 move from OpenERP S.A. Stock to Shop 1 according to their internal configuration of Source and Destination Locations.

A pull flow is related to how the procurement process runs in order to find products to increase or decrease inventory.






获得方式 – 按库存生产(MTS)和按订单生产(MTO)

The procurement method determines how the product will be replenished:


	Make to Stock: your customers are supplied from available stock. If the quantities in stock are
too low to fulfil the order, a Purchase Order (according the minimum stock rules) will be generated in order
to get the products required. Example: a classic distributor.

	Make to Order: when a customer order is confirmed, you procure or manufacture
the products for this order. A customer order ‘Make to Order’ will not modify stock in the medium term
because you restock with the exact amount that was ordered. Example: computers from a large supplier
assembled on demand.



You find a mix of these two modes used for the different final and intermediate products in most
industries. The procurement method shown on the product form is a default value for the order,
enabling the salesperson to choose the best mode for fulfilling a particular order by varying the
sales order parameters as needed.

The figures Change in Stock for a Make to Stock Product and Change in Stock for a Make to Order Product show the change of stock levels for one product
managed as Make to Order and another managed as Make to Stock. The two figures are taken from OpenERP’s
Stock Level Forecast report, available from the product form.


[image: ../../../_images/stock_from_stock.png]
Change in Stock for a Make to Stock Product




[image: ../../../_images/stock_from_order.png]
Change in Stock for a Make to Order Product




Note

Logistical Methods

The Make to Stock logistical approach is usually used for high volumes and when the
demand is seasonal or otherwise easy to forecast.
The Make to Order approach is used for products that are measured, or very expensive to
stock or have a short restocking time.






供应方法的选择

OpenERP supports two supply methods:


	Produce: when the product is manufactured or the service is supplied from internal resources.

	Buy: when the product is bought from a supplier.



These are just the default settings used by the system during automated replenishment. The same
product can be either manufactured internally or bought from a supplier.

These three fields (Supply Method, Procurement Method, Product
Type) determine the system’s behaviour when a product is required. The system will generate
different documents depending on the configuration of these three fields when satisfying an order, a
price quotation to a supplier or a manufacturing order.

OpenERP manages both stockable products and services. A service bought from a supplier in
Make to Order mode, will generate a subcontract order from the supplier in question.

Figure Workflow for Automatic Procurement, depending on the Product Configuration illustrates different cases for automatic procurement.


[image: ../../../_images/stock_flow.png]
Workflow for Automatic Procurement, depending on the Product Configuration



The table below shows all possible cases for the figure Workflow for Automatic Procurement, depending on the Product Configuration.


Consequences of Procurement Methods Make to Stock (MTS) and Make To Order (MTO)






	Procurement Method
	Produce
	Buy




	MTS
	Wait for availability
	Wait for availability


	MTO
	Production Order
	Purchase Order






Consequences of Procurement Methods when using Services






	Procurement Method
	Produce
	Buy




	MTS
	/
	/


	MTO
	Create task
	Subcontract








各种计量单位的物流包装


计量单位

OpenERP supports several units of measure. Quantities of the same product can be expressed in
several units of measure at once. For example, you can buy grain by the tonne and resell it by kg.
You just have to make sure that all the units of measure used for a product are in the same units of
measure category.


Note

Categories of Units of Measure

All units of measure in the same category are convertible from one unit to another.



The table below shows some examples of units of measure and their category. The factor is used to
convert from one unit of measure to another as long as they are in the same category.


Example Units of Measure







	UoM
	Category
	Ratio
	UoM Type




	Kg
	Weight
	1
	Reference


	Gram
	Weight
	1000
	Smaller


	Tonne
	Weight
	1000
	Bigger


	Hour
	Working time
	8
	Smaller


	Day
	Working time
	1
	Reference


	Half-day
	Working time
	4
	Smaller


	Item
	Unit
	1
	


	100 Items
	Unit
	0.01
	





Depending on the table above, you have 1Kg = 1000g = 0.001 Tonnes. A product in the Weight
category could be expressed in Kg, Tonnes or Grammes. You cannot express it in hours or pieces, for example.

Use the menu Warehouse ‣ Configuration ‣ Products ‣  Units of Measure ‣ Units of Measure
to define a new unit of measure.

In the definition of a Unit of Measure, you have a Rounding precision factor which shows how
amounts are rounded after the conversion. A value of 1 gives rounding to the level of one unit. 0.01
gives rounding to one hundredth.


Note

Secondary Units

OpenERP supports double units of measure.
Notice however that the default unit of measure and the purchase unit of measure have to be in the same category.
Only the sales unit of measure may be in a different category.

This is very useful in the agro-food industry, for example: you sell ham by the piece, but invoice
by the Kg.
A weighing operation is needed before invoicing the customer.



To activate the management options for double units of measure, assign the group Useability /
Product UoS View to your user.

In this case, the same product can be expressed in two units of measure belonging to different
categories for sales and stock/purchase. You can then distinguish between the unit of stock management (the piece) and the unit
of invoicing or sales (kg).


[image: ../../../_images/UOM_UOS.png]
Secondary Unit of Measure



In the product form you can set one unit of measure for sales and stock management, and one
unit of measure for purchases.

For each operation on a product, you can use another unit of
measure, as long as it can be found in the same category as the two units already defined. If you
use another unit of measure, OpenERP automatically handles the conversion of prices and quantities.

So if you have 430 Kg of carrots at 5.30 EUR/Kg, OpenERP will automatically make the conversion if
you want to sell in tonnes – 0.43 tonnes at 5300 EUR / tonne. If you had set a rounding factor of
0.1 for the tonne unit of measure, OpenERP will tell you that you have only 0.4 tonnes
available.




包装

The packaging allows you to ship products in several ways. For example, you can ship goods by boxes or by
pallets.

At first, you have to define possible packaging. To define the packaging, go to :menuselection:
Warehouse –> Configuration –> Product –> Packaging and click New.


[image: ../../../_images/packaging.png]
Packaging definition



To complete the creation of a new packaging, you have to give it a name and a type. Different types are
available in OpenERP: Box, Pack, Pallet and Unit.

Once all packaging is defined, you can attach the packaging to your products through the following menu:
Warehouse ‣ Configuration ‣ Product ‣ Packaging.


[image: ../../../_images/product_packaging.png]
Defining the Packaging for the Product
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定期采购

The master production plan, sometimes called the MPS (Master Production Schedule), enables you to
generate forecasts for incoming and outgoing material. It is based on forecasts of inputs and outputs
by the logistics manager.

To be able to use the production plan, you must install the stock_planning module.


Note

MPS, Procurement and Production

OpenERP distinguishes between Production, Purchase and Procurement.

Production is manufacturing, Purchase is the acquisition of goods from another party,
and Procurement is either one or both of those. So it would be better to call the
MPS the Master Procurement Schedule. Which OpenERP does!




Tip

Product Trading

Also called the Production Plan, this tool is also very useful for traded products which are not
manufactured.
You can use it for stock management with purchased and manufactured products.




处理意外

The set of stock requirements is generated by procurement orders.

In normal system use, you do not need to worry about procurement orders because they are automatically
generated by OpenERP and the user will usually work on the results of a procurement: a production
order, a purchase order, a sales order and a task.

If there should be configuration problems, the system can remain blocked by a procurement without
generating a corresponding document. For example, suppose that you configure a product Procurement Method
as Make to Order, and Supply Method as Produce, but you have not defined the bill of materials. In that case, procurement of the product will stay blocked in an exception state No Bill of Materials defined for this product. You then have to create a bill of materials to solve the problem.

Troubleshooting:


	No bill of materials defined for production: you need to create a BoM or indicate
that the product can be purchased instead.

	No supplier available for a purchase: you have to define a supplier in the Supplier tab
of the product form.

	No address defined on the supplier partner: you have to complete an address for the default supplier
for the product concerned.

	No quantity available in stock: you have to create a rule for automatic procurement (for example, a
minimum stock rule) and put it in the order, or manually procure it.



Some problems are just those of timing and can be automatically corrected by the system.

Use the menu Warehouse ‣ Schedulers ‣ Procurement Exceptions to see all the exceptions.

If a product has to be ‘in stock’, but is not available in your stores, OpenERP will make the
exception as ‘temporary’ or ‘to be corrected’. The exception is temporary if the system can procure
it automatically, for example, if a procurement rule is defined for minimum stock.


[image: ../../../_images/mrp_exception.png]
Example of a Procurement in Exception



If no procurement rule is defined, the exception has to be corrected manually by the user. Once the
exception is corrected, you can restart by clicking Retry. If you do not do that,
OpenERP will automatically recalculate on the next automated requirements calculation.




人工采购

To procure internally, you can create a procurement order manually. Use the menu
Warehouse ‣ Schedulers ‣ Procurement Exceptions and click the New button to do this.


[image: ../../../_images/mrp_procurement.png]
Encoding a New Procurement Order



The procurement order will then be responsible for calculating a proposal for automatic procurement
for the product concerned. This procurement will start a task, a purchase order for the supplier or
a production depending on the product configuration.


[image: ../../../_images/mrp_procurement_flow.png]
Workflow for Handling a Procurement according to Product Configuration



It is better to encode a procurement order rather than direct purchasing or production. This method
has the following advantages:


	The form is simpler because OpenERP calculates the different values from other values and defined rules: purchase date calculated from order date, default supplier, raw materials needs, selection of the most suitable bill of materials, etc.

	The calculation of requirements prioritises the procurements. If you encode a purchase directly, you short-circuit the planning of different procurements.




Tip

Shortcuts

On the product form you have an ACTIONS shortcut button Create Procurements
that lets you quickly create a new procurement order.






销售预测

The first thing you have to do to work with a production plan is define the periods for stock management.
Some companies plan daily, others weekly or monthly.


Tip

Stock Management Interval

The interval chosen for managing stock in the production plan will depend on the length of your
production cycle. You generally work daily, weekly or monthly.

If it takes several days to assemble your products, you most likely will define a weekly plan. If your
manufacturing cycles take several months, you can work with a monthly plan.

To predefine these periods you can use the Stock and Sales Planning Periods that will automatically generate
daily, weekly or monthly periods.


[image: ../../../_images/stock_sales_periods.png]
Stock and Sales Planning Periods





Go to the menu Sales ‣ Configuration ‣ Stock and Sales Periods ‣
Create Stock and Sales Periods. A window appears enabling you to automatically define the next periods that will be
provided for stock management. For this example, create weekly periods.


[image: ../../../_images/sale_period.png]
Defining Periods for Stock Management



Salespeople can then enter their sales forecasts by product and by period using the menu
Sales ‣ Sales Forecasts ‣ Sales Forecasts. The forecasts can be
made by quantity or by value. For a forecast by amount, OpenERP automatically calculates the
quantity equivalent to the estimated amount. This can be modified manually as needed before
completion. A salesperson can create sales forecasts manually, or he can use the Create Sales Forecasts wizard in the above menu.


[image: ../../../_images/stock_sale_forecast.png]
Sales Forecast to Help Create a Master Production Plan






生产计划

The manager responsible for logistics then plans receipts (manufacturing or purchases) and outgoings
(consumption or customer deliveries) by period. From the menu Warehouse ‣ Stock Planning ‣ Create Stock Planning Lines, you can create a stock planning per week for a specific product category. Through  Warehouse ‣ Stock Planning ‣ Master Procurement Schedule you can adjust the planning.

For each period and product, OpenERP gives you the following information:


	Stock estimated at the end of the period, calculated as stock in the following period less the total
estimated outgoings plus total estimated inputs,

	Closed entries, coming from production or confirmed purchases,

	Forecast inputs for the period, calculated using the incoming entries less the closing amounts,

	Planned inputs entered manually by the logistics manager,

	Closed outgoings which are the consumption of manufacturing waiting and deliveries to be made to
customers,

	Forecast outgoings, calculated from the planned outgoings, less the closing amounts,

	Planned outgoings, manually entered by the logistics manager,

	Sales forecasts, which represent the sum of forecasts made by the salespeople.




[image: ../../../_images/stock_forecast.png]
The Master Production Schedule (MPS)



The production plan enables the logistics manager to play with the forecast receipts and
outgoings and test the impact on the future stock for the product concerned. It enables
you, for example, to check that the stock does not fall below a certain level for that product.

You can also open the production plan for past periods. In this case, OpenERP shows you the real
stock moves, by period for forecast reports.

If you do not have automated procurement rules for a product, you can start procurement at any time
based on the estimates of the production plan.
To do this, press the button Procure Incoming Left (i.e. remaining) on
the Master Procurement Schedule.
OpenERP plans procurement for an amount equal to the entries forecast.
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管理批次和可追溯性

OpenERP 的物流借鉴财务的复式记帐, 使得物流的跟踪变得相当灵活. 所有的操作都依托于 stock.move , so it is very easy to search for the cause of any
gaps in stock moves.


Note

Upstream Traceability

It runs from the raw materials received from the supplier and follows the
chain to the finished products delivered to customers.
(Note that the name is confusing - this would often be considered a downstream direction.
Think of it as Where Used.)




Note

Downstream Traceability

It follows the product in the other direction, from customer to the
different suppliers of raw material.
(Note that the name is confusing - this would often be considered an upstream direction.
Think of it as Where Supplied.)




库存调拨

Use the menu Warehouse ‣ Traceability ‣ Stock Moves
to track past stock transactions for a product or a given location. All the operations
are available. You can filter on the various fields to retrieve the operations about an order,
or a production activity, or a source location, or any given destination.


[image: ../../../_images/stock_move_tree.png]
History of Stock Movements



Each stock move is in a given state. The various states are:


	Draft : the move so far has no effect in the system. The transaction has not yet been confirmed,

	Not available: the move will be done, so it will be counted in the calculations of virtual stock. But
you do not know whether it will be done without problem because the products have not been reserved for
the move,

	Available : the move will be done and the necessary raw materials have been reserved for the
transaction,

	Done : the stock move (picking) has been done, and entered into the calculations of real stock,

	Waiting : in the case of transactions From Order, this state shows that the stock move is blocked
waiting for the end of another move,

	Cancelled : the stock move was not carried out, so it is not taken into account in either real stock or
virtual stock.



Delivery orders, goods receipts and internal picking lists are just documents that group a set of
stock moves. You can also consult the history of these documents using the menu
Warehouse ‣ Traceability ‣ Packs.




批次

OpenERP can also manage product lots. Two lot types are defined:


	Production lots (batch numbers) are represented by a unique product or an assembly of identical
products leaving the same production area. They are usually identified by bar codes stuck on the
products. The batch can be marked with a supplier number or your own company numbers.

	Tracking numbers are logistical lots to identify the container for a set of
products. This corresponds, for example, to the pallet numbers on which several different products
are stocked.



These lots can be encoded onto all stock moves and, specifically, on incoming shipments lines, internal moves
and outgoing deliveries.


[image: ../../../_images/picking_form_line.png]
Entering a Line for Production Receipt



To enter the lot number in an operation, you can use an existing lot number or create a new pack. A
production lot (batch number) is used for a single product. A tracking number can be
used several times for different products, so you can mix different products on a pallet or in a box.


Note

Simplified View

In the Simplified view, the tracking numbers cannot be seen: the field is hidden.
To get to Extended view mode, assign the group
Useability / Extended View to the current user, or change the User Preferences.



You can also specify on the product form the operations in which a lot number is
required. You can then compel the user to set a lot number for manufacturing operations, goods
receipt, or customer packing.

You do not have to encode the lot numbers one by one to assign a unique lot number to a set of several items.
You only need to take a stock move for several products line and click the button
Split in Production Lots. You can then give a lot number prefix (if you want) and OpenERP will
complete the prefix in the wizard with a continuing sequence number. This sequence number
might correspond to a set of pre-printed barcodes that you stick on each product.


[image: ../../../_images/picking_split_lot.png]
Splitting a Lot into uniquely Identified Parts






可追溯性

如果你在收/发货时 为移库单录入了批次号, 那你以后就可以用这个批次号进行移库追踪.
相应菜单项:
英文 Warehouse ‣ Traceability ‣
Production Lots 或者 Warehouse ‣ Traceability ‣ Packs
中文 仓库 ‣ 可追溯的 ‣ 生产批次 或者 仓库 ‣ 可追溯的 ‣ 包装.


Tip

Product Shortcuts

From the product form, the toolbar to the right offers useful information:


	Minimum Stock Rules,

	Stock by Location,

	Product Sales,

	Bills of Material.





Search for a particular lot using the filters for the lot number, the date or the product. Once you
can see the form about this lot, several actions can be performed:


	Upstream Traceability: from supplier through to customers,

	Downstream Traceability: from customer back to suppliers,

	Stock in all the physical and virtual locations.




[image: ../../../_images/stock_traceability_upstream.png]
Tracing Upstream in Make to Order




[image: ../../../_images/stock_traceability_downstream.png]
Tracing Downstream in Make to Stock



Finally, on a lot, you can enter data on all the operations that have been done for the product. That
keeps a useful history of the pre-sales operations.






报废产品

In OpenERP, there are many ways to handle scrap products.


	Warehouse ‣ Product Moves ‣ Receive Products

	Warehouse ‣ Product Moves ‣ Deliver Products

	Warehouse ‣ Warehouse Management ‣ Incoming Shipments





[image: ../../../_images/incoming_scrap.png]
Scrapping from an Incoming Shipment







	Warehouse ‣ Warehouse Management ‣ Internal Moves





[image: ../../../_images/internal_scrap.png]
Scrapping from an Internal Move







	Warehouse ‣ Warehouse Management ‣ Delivery Orders




[image: ../../../_images/delivery_scrap.png]
Scrapping from a Delivery Order



When you decide to scrap some products, they are transferred to the Scrap location.
To display the content of this Virtual Location, go to :menuselection:
Warehouse –> Inventory Control –> Location Structure, then select the virtual locations and display the
Scrap location.

If you want to transfer the products to another location, you can create a new one and check the
Scrap Location in the additional information.




使用条码和RFID设备标识产品和库位

You can the barcode in the product form in the field EAN13.
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财务的库存管理


手动和实时库存核算

If you have experience of managing with traditional software, you will know the problem of getting useful
indicators. If you ask your accountant for a stock valuation or the value added by production, he will give you
a figure.

If you ask for the same figure from your stores manager, you will get an entirely different amount. You have no
idea who is right!

In OpenERP, stock management is completely integrated with the accounts, to give strong coherence between
the two systems. The double-entry structure of locations enables a very precise correspondence between
stocks and accounts.

Each stock movement also generates a corresponding accounting entry in an accounting journal to ensure that the
two systems can stay in permanent synchronization.

To do that, set up a general account for each location that should be valued in your accounts. If a product goes
to one location or another and the accounts are different in the two locations, OpenERP automatically generates
the corresponding accounting entries in the accounts, in the stock journal.

If a stock move will go from a location without an account to a location where an account has been assigned (for
example goods receipt from a supplier order), OpenERP generates an accounting entry using the properties defined
in the product form for the counterpart. You can use different accounts per location or link several locations
to the same account, depending on the level of analysis needed.

You use this system for managing consigned stocks:


	a supplier location that is valued in your own accounts or,

	a location in your own company that is not valued in your accounts.



How to Configure Accounting Valuation?

In the Product form, go to the Accounting tab and select the Real Time (automated) option for Inventory Valuation,

To define your accounts, you have two options. Set them on the product category, or on the product.


	From the Accounting Stock Properties section, for the Product Category, set the Stock Input Account, the Stock Output Account and the Stock Variation Account,

	From the Accounting tab, for the Product, set the Stock Input Account and the Stock Output Account.



You can also overwrite the accounts from the Product or the Product Category by defining Stock Input Account
and Stock Output Account for a Location.


Note

account_anglo_saxon

You can also install the account_anglo_saxon module (Reconfigure wizard, Anglo-Saxon Accounting) to value
your stock according to Anglo-saxon principles.



The figure below shows the various accounts that can be used, with and without the account_anglo_saxon
module installed.


[image: ../../../_images/account_anglo_saxon.png]
Setting up Stock Valuation Accounts






管理运输成本

In OpenERP, you can handle the delivery methods when installing the delivery module.

This module will allow you:


	To select the delivery company




[image: ../../../_images/delivery_method_form.png]
Define the Delivery Method




	To define the delivery pricelist according to the price, the weight or the volume.




[image: ../../../_images/grid_lines.png]
Define the Delivery Costs



Now, in each Delivery Order, two new fields are available to enter the right
value to deliver the products to the customer. You can also find a new field in the Sales Order
form that enables you to select a delivery method.


[image: ../../../_images/delivery_order_delivcost.png]
Delivery Cost in the Delivery Orders




[image: ../../../_images/sale_order_delivcost.png]
Delivery Method in the Sales Orders
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组织你的交付

You can manage stock through journals in the same way as you can manage your accounts
through journals. This approach has the great advantage
that you can define journals in various ways to meet your company’s needs.

For example, a large company may want to organize deliveries by department or warehouse. You can
then create a journal and a manager for each department. The different users can work in a
journal as a function of their position in the company. That enables you to better structure your
information.

A company doing a lot of transport could organize its journals by delivery vehicle. The different
delivery orders will then be assigned to a journal representing a particular vehicle. When the
vehicle has left the company, you can confirm all the orders that are found in the journal all at the
same time.


不同的日记账

Install the Reconfigure option Invoicing Journals for Sales Management or the sale_journal module to work with different journals. This adds two new concepts to OpenERP:


	Invoicing journals,

	Stock journals or Delivery journals.



Invoicing journals (Sales ‣ Configuration ‣ Sales ‣ Invoice Types) are used to assign purchase orders and/or delivery orders to a given invoicing journal. Everything in the journal can be invoiced in one go, and you can control the amounts by
journal. For example, you can create the following journals: daily invoicing, end-of-week invoicing
and monthly invoicing. It is also possible to show the invoicing journal by default in the partner form.
Set the Invoicing Method to Grouped (one invoice per customer) or Non Grouped (individual invoices) according to your needs.

Stock journals (Warehouse ‣ Configuration ‣ Warehouse Management ‣ Stock Journals) allow you to classify the delivery orders in various ways, such as by department, by salesperson or by type. If a salesperson looks for a delivery order in his own journal, he can
easily see the work on current items compared with his own orders.


Tip

Default Values

To enter all the orders in his own stock journal, a salesperson can use the default values that
are entered in the fields when creating orders.



Finally, the stock journals can also be used as delivery journals to post each item into a delivery journal. For example, you
can create journals dated according to customer delivery dates (such as Monday’s deliveries, or
afternoon deliveries) or these journals could represent the day’s work for delivery vehicles (such
as truck1, truck2).




使用日记账

You will now see how to use the journals to organize your stock management in practice. After
installing the module sale_journal look at the list of partners. In the tab Sales and
Purchases on any of them you will now see the field Invoicing Method.


[image: ../../../_images/partner_property_view.png]
Partner Form in Invoicing Mode



You can create a new Invoicing Journal for a partner through the menu Sales ‣ Configuration ‣ Sales ‣ Invoice Types. You can decide if the invoices should be grouped or not when generating them in the journal. Create a second invoicing journal
End-of-Month Invoicing which you can assign to another partner.


[image: ../../../_images/invoice_mode.png]
Defining an Invoicing Journal



Then enter the data for some sales orders for these two partners. After entering sales order data, the
field Invoicing Mode in the second tab Other Information is completed automatically from the partner settings.

Look at the History tab of the Sales order, and observe the Picking List that has been created. The field Invoicing Mode is
automatically shown there.


[image: ../../../_images/sales_order_picking.png]
Generated Picking Lists



At the end of the day, the invoicing supervisor can display the list by journal. Go to the
menu Sales ‣ Invoicing ‣ Lines to Invoice. Add a New Filter by selecting Invoice Type contains Daily, or any other part of the invoice journal you are using. Select the different orders in the list. You can automatically carry out invoicing by clicking the action Make Invoices (the gears symbol).


Tip

Confirming Invoices

By default, invoices are generated in the draft state, which enables you to modify them before
sending them to the customer.
But you can confirm all the invoices in one go by selecting them all from the list and selecting the
action Confirm Draft Invoices.



At the end of the month the invoicing management does the same work, but in the journal ‘month-end invoicing’.

You can also enter a journal to confirm / cancel all the orders in one go. Then you can do several
quotations, assign them to a journal and confirm or cancel them at once.


[image: ../../../_images/stock_journal_form.png]
View of an Order Journal
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估算交付日期


标准交付时间

在订单中的标准交付时间,有下面三种含义:


	客户交付时间 :




即你向客户承诺的交货时间. It corresponds to the average delay
between the confirmation of the customer order and the delivery of the finished goods. It can be
defined in the product form, in the Procurement and Locations tab.

This time will be influenced by the Manufacturing Lead Time and the Delivery Lead Time.





	生产交付时间 :




指你生产一个生产单位的产品所需的时间. 如果产品由多个半成品组成,则需要加上各个半成品的生产时间.
这个时间需要在产品页面的 guilabel:生产与库位(Procurement and Locations) 页签中去设置.



	运送间隔时间 :




指你的供应商需要的送货时间. 在产品页的 供应商(Suppliers) 页签中去设置.


For example, if we have to deliver some products to a customer in a month (in 30 days). You promise to deliver
the goods to the customer within 10 days, the manufacturing time is equal to 4 days and our suppliers deliver
the raw materials within 3 days.

According to those numbers, we will have to start the process in 23 days if we have to order raw materials.




依据MRP1规则的定期物流

MRP is a software-based production, planning and inventory control system used to manage the manufacturing process.

It is a computer-based system in which the given Master Schedule is exploded with Bills Of
Material, into the required amount of raw material, parts and subassemblies needed to produce
the final products in each period.






收入和发出产品计划

要控制管理好收/发货时间计划, 你要安装模块: stock_planning.


[image: ../../../_images/stock_forecast.png]
预计送货日期



使用本模块,你可以大致估算出产品的预计送货日期.

Picking单的交付日期会传递到单据明细上面去. 由于一次收/发货可能会有多个产品,所以,根据每个产品可以出的送货日期可以得到该
收/发货的最早及最迟日期.

在日历视图上, 直接拖动单据, 可以直接修改相应数据的计划日期.




管理库存盘点

盘点要控制两个点: 实物与账务.

实物盘点则是通过对实际的物理库位上的产品进行纸质盘点,并且数量含过期与损坏的产品.

Reconciliation steps on the accounting side include verification that all inventory purchases are
posted, entering adjustments from the physical count and analysing the dollar differences between months.
Inventory reconciliation frequency depends on the size, location, and type of inventory in a company’s
operations.




物料追溯报表

OpenERP可以创建灵活的物料追溯报表. 创建报表请先安装 base_report_creator 模块,并在菜单
设置(Administration) ‣ 自定义(Customization) ‣ 报表(Reporting) 中去新建.


[image: ../../../_images/report_creation.png]
创建自定义报表



您可以打开最近使用过的报表:


	常规配置:




The aim of this tab is to choose the models your report will rely on.



	视图参数

视图页签用于定义报表需要显示的元素. You can choose between the traditional available views
(Tree/List, Form, Graph and Calendar) and you can define three different ways to display your report.



	显示字段






在 常规配置(General Configuration) 页签中,可以找到可用于显示对象的字段.

如果你需要在报表中使用新的字段,你需要遵循以下要求:


	顺序(Sequence) - 定义各个字段在报表中的显示顺序.

	字段(Field) - 定义需要在报表中显示的信息.

	分组统计方法(Grouping method) - 这里可以配置字段的分组统计方式, 可选有 分组(Grouped), 合计(Sum), 最小值(Minimum), 计数(Count),
最大值(Maximum) 与 平均值(Average) .

	图表模式(Graph mode) - 配置字段图表展示的参数.

	Calendar mode - defines the meaning of the field for the calendar (Starting or Ending date,
Delay, End Date, Unique Colours)







	过滤项




This tab will let you choose which data to display according to the value of a field. It is possible to
manually modify or add new filters according to your needs.



	安全项

安全页签用于控制哪些用户组可以显示报表.






Tip

用 OpenOffice 创建报表

安装模块 base_report_designer 后,你就可以利用 OpenOffice 方便地创建与修改报表.

In order to add the extension to OpenOffice, load this module and start the configuration. A new
window will ask you to Save As a file that contains the extension.

Once you have saved the file, start OpenOffice and go to Tools ‣ Extension Manager,
then click Add and select the previously saved file. Restart OpenOffice.org and now you have the
extension installed.


[image: ../../../_images/report_creator_openoffice.png]
Extension to Create a Report in OpenOffice
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进口 / 出口

Managing import / export with foreign companies can sometimes be very complex. Between a departure
port and the destination company, products can get stopped for several weeks at sea or somewhere in the
numerous transportation stages and customs. To manage such deliveries efficiently it is important to:


	know where your products are,

	know when they are likely to arrive at their destination,

	know your value in transit,

	follow the development of the different steps.



Linked locations in OpenERP enable you to manage all this rather elegantly. You can use a structure
like this:


	Suppliers
	European Suppliers

	Chinese Suppliers





	In transit
	Shanghai Port

	Pacific Ocean

	San Francisco Port

	San Francisco Customs








库存

The transit locations are linked between themselves with a manual confirmation step. The internal
stock move is validated at each port and customs arrival. OpenERP prepares all the linked moves
automatically.


Note

Intrastat

Companies that do import / export should install the module report_intrastat.
This enables them to prepare the reports needed to declare product exports.



You can use the lead times between different locations to account for real delays.
Your lead times and stock forecasts are calculated by OpenERP to estimate the arrival of
incoming products, so that you can respond to a customer’s needs as precisely as possible.

You can also value the products in transit in your account depending on the chosen stock location
configuration.




租赁库位

You can manage rental locations in OpenERP very simply using the same system of linked locations.
Using the stock_location module you can set a return date for rental items sent to a customer
location after a certain rental period.

Then the set of real and virtual stocks is maintained daily in real time. The different operations
such as delivery and receipt after a few days are automatically suggested by OpenERP which
simplifies the work of data entry.

You then have the product list found in the customer locations and your own stock in your stock
location. The list of waiting goods receipts is automatically generated by OpenERP using the
location links.

Suppose you want to rent a product (PC3) to your customer (Axelor) for 30 days.
Two stock movement entries are needed to manage this scenario:


	Product goes from Stock (your company’s location) to Axelor - Rental Location (your customer location).

	Product will be returned into Stock (your company’s location) from Axelor - Rental Location (your customer location) after 30 days.



To manage rental products by linking locations, configure a rental location (Axelor - Rental Location) as
shown in the following figure using the menu Warehouse ‣ Configuration ‣
Warehouse Management ‣ Locations.


[image: ../../../_images/stock_rental_location.png]
Configuration of a Rental Location `Axelor - Rental Location`



Through the menu Warehouse ‣ Traceability ‣ Stock Moves, you can create a
stock movement entry from Stock to Customer Location (Axelor - Rental Location) in OpenERP
for a rental product (PC3).


[image: ../../../_images/stock_move_rental_location.png]
Stock Movement Entry to Send the Product `PC3` to the Customer Location



The stock movement entry from Customer Location (Axelor - Rental Location) to Stock is generated
automatically on the proper Scheduled Date by OpenERP when you have confirmed the previous stock movement entry by
clicking the Process Now button.

The same principle is used for internal stock to generate quality control for certain products.




委外加工产品

The principle of linked locations is used to manage consigned products. You can specify that
certain products should be returned to you a certain number of days after they have been
delivered to customers.

When the products have been delivered, OpenERP automatically creates goods receipts for the
consigned product. The specified date is obviously approximate but enables you to forecast returns.
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库位例子

在本节中，我们将用一个更详细的例子，你将看到其中包含在前面的章节中的不同的概念.

下面的例子将使用库位类型 Stock Location types, Logistic Flows 和 Bill Of Materials.

我们有两个公司: OpenERP SA 和 OpenERP US.

我们有三个产品: Product A, Product B 和 Product C. 每个产品, 我们将定义库位，以确定从那个地方来取这些产品.

一个 Product A, 我们需要 Product B 和 Product C. 因此我们需要定义一个产品A的 物料清单.


Bill of Materials





	Field
	Value




	Product
	Product A


	Product Qty
	1


	Name
	Product A


	BoM Type
	Normal


	Company
	OpenERP US





生产一个 Product A 不同成分是一个 Product B 和一个 Product C .


Companies and Products





	Company
	What




	OpenERP SA
	Sell the Product A


	OpenERP SA
	Store the Product C


	OpenERP US
	Produce the Product A


	OpenERP US
	Store the Product B






Logistics Flows







	Name
	Type
	Product
	Goal of the flow




	Ask for Production
	Pull
	Product A
	OpenERP SA asks OpenERP US to produce the Product A


	Launch Production
	Pull
	Product A
	OpenERP US launches the production of the Product A


	Send Product to Transit
	Pull
	Product C
	OpenERP US asks for the Product C to OpenERP SA


	Get Product from Transit
	Pull
	Product C
	OpenERP US receives the Product C





这里是各种详细的工作流:


[image: ../../../_images/ask_production.png]
Ask for Production




[image: ../../../_images/launch_production.png]
Launch Production




[image: ../../../_images/send_transit.png]
Send Product to Transit




[image: ../../../_images/get_transit.png]
Get Product from Transit



通过这样的配置, 当销售订单确定销售 3 个 Product A 并且计划被执行, 你将得到下面的需求:


[image: ../../../_images/procurement.png]
Procurements View



并且生成下面的库存移动:


[image: ../../../_images/stock_moves_ex.png]
Stock Moves



因为我们用了两个不同公司做案例, 生成了不同的库存移动. 产品从 OpenERP SA 移动到了 OpenERP US 做为 Products C. 通过制造
过程后, Products A 从 OpenERP US 移动到 OpenERP SA 出售给客户.

一旦你对 Products B 和 Products C 配置了不同的移动, 生产订单在 待生产 状态. 你就可以开始 3个 Product A 的制造.


[image: ../../../_images/start_production.png]
Launch the Production



由于两家公司应用, 你需要确认不同的交付. 一产品交付 从 OpenERP US 到 OpenERP SA ，另一产品交付从 OpenERP SA 到客户.
现在你可以确认交付3个产品从 OpenERP US 到 OpenERP SA, 然后 OpenERP SA 确认接收完成, 交付产品给最终客户.
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定义主数据


不要忘记在第二个选项卡其他信息中设置正确的参数选择一个好的物流和包装策略。在这里，
我们选择的Invoiche的生产管理本章中介绍的涵盖计划，订货，库存和产品从原材料和零部件的制造
或组装的。
此外，还讨论消费和生产的产品，以及必要的操作机器，工具或人力资源.


OpenERP的生产管理其存货管理的基础上，同样非常
灵活，其业务及财务控制。它特别受益于使用
双项库存管理生产订单.

生产管理通过 mrp 模块实现. 他用来计算所有种类的产品:


	Assemblies of parts: composite products, soldered or welded products, assemblies, packs,

	Machined parts: machining, cutting, planing,

	Foundries: clamping, heating,

	Mixtures: mixing, chemical processes, distillation.



You will work in two areas: with products in the first part of this chapter, and with operations in the
second part. The management of products depends on the concept of classifications while operations management is related to routing and workcenters.


Note

Bills of Materials

Bills of Materials, or manufacturing specifications, go by different names depending on their
application area, for example:


	Food: Recipes,

	Chemicals: Equations,

	Building: Plans.





For this chapter you should start with a fresh database that includes demo data,
with mrp (Manufacturing) and its dependencies installed and a generic chart of accounts configured.
As you will notice, when you select Manufacturing to be installed, OpenERP will install the linked applications automatically.



	物料清单(BOM)和部件
	使用 BOM

	多层次BOM

	虚拟件BOM

	用于套件/套装的BOM





	工作中心

	工艺路线

	生产计划单

	完成生产流程
	销售单

	在制品管理

	生产完工流程

	半成品(部件)生产

	生产废品管理

	生产订单





	物流和生产制造
	生产库位

	可追溯性





	管理维修：从维修到开票和库位移动
	为新的维修输入数据

	维修工作流

	维修开票

	库存调拨和维修





	预测和供应
	排程

	计划
	排程和和精益生产（JIT）

	提前期

	安全天数





	需求
	自动采购和补充

	管理排程的异常

	人工生成需求









	使用分包商(外协件)

	匹配销售订单和物料清单BOM

	生产和服务
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物料清单(BOM)和部件


使用 BOM

物料清单(Bill of Materials)是用来列举制造一个成品所需要的原材料列表。
为了解释本章节的内容，你会生产一个生产计划指定的书架(或橱柜)。 Plan of Construction of a Shelf.


[image: ../../../_images/mrp_armoire.png]
Plan of Construction of a Shelf



书架由原材料和中间件(intermediate assemblies)组成。图片编码是指图片，产品参考号OpenERP的是相应的代码。

用 m 代替木门楣4m(LIN40)的单位PCE


定义BOM(Bills of Materials)前需要定义的产品






	图片编号
	产品参考号
	描述




	ARM100
	SHE100
	书架 100 cm


	PANLAT
	SIDEPAN
	侧面面板


	PANA100
	RPAN100
	后面板 SHE100


	PROFIL
	PROFIL
	组装


	ETA100
	RCK100
	架 100cm


	BOIS002
	WOOD002
	木材 2mm


	TAQ000
	METC000
	金属防滑钉


	LIN40
	LIN40
	木门楣 4m






New Products to be created before defining Bill of Materials






	Image Code
	Product Reference
	Description




	PLET100
	SPAN100
	Shelf Panel


	BOIS010
	WOOD010
	Wood 10mm






Tip

复制

如上面的两种产品我们可以找一个类似的产品复制,以便快速地创建.



为了揭示书架是如何组装的(assembled)，你需要定义每个中间件(intermediate product)的BOM以及最终书架的BOM。
BOM内容在下表中显示。你可以由DEMO数据开始，根据指令完成这些BOM。
新建或者更改BOM(bill of materials)，菜单路径为 Manufacturing ‣ Master Data ‣ Bill of Materials.


Bill of Materials for 1 SHE100 Unit (already defined)






	物料编码
	数量
	计量单位




	PROFIL
	4
	PCE


	SIDEPAN
	2
	PCE


	METC000
	12
	PCE


	RPAN100
	1
	PCE


	RCK100
	3
	PCE






Bill of Materials for 1 RCK100 PCE






	物料编码
	数量
	计量单位




	SPAN100
	1
	PCE


	METC000
	4
	PCE






Bill of Materials for 1 SPAN100 PCE






	物料编码
	数量
	计量单位




	WOOD010
	0.083
	m






Bill of Materials for 1 PROFIL PCE






	物料编码
	数量
	计量单位




	LIN40
	0.25
	m






Bill of Materials for 1 RPAN100 PCE






	物料编码
	数量
	计量单位




	WOOD002
	0.25
	m






Bill of Materials for 1 SIDEPAN PCE






	物料编码
	数量
	计量单位




	WOOD002
	0.083
	m





物料清单被系统用来，根据成品的需求，计算原材料的物料需求。
如果你想制作10个书架，系统会计算出实际会消耗的原材料数量：


Total Quantities per Shelf






	物料编码
	数量
	计量单位




	WOOD002
	0.416 (2 * 0.083 + 0.25)
	m


	LIN40
	1 (4 * 0.25)
	m


	WOOD010
	0.249 (0.083 * 3)
	m


	METC000
	132 ((3 * 4) + (10 * 12))
	PCE






Tip

原材料清单(BOM Bill Of Materials)

要查看产品的原材料清单列表, 点击菜单: 生产(Manufacturing) ‣ 主数据(Master Data) ‣ 原材料清单(Bill of Materials) 选择产品后点击 BOM 结构(BOM Structure).




[image: ../../../_images/mrp_bom_tree_new.png]
Bill of Materials structure



Use the menu Manufacturing ‣ Master Data ‣ Bill of Materials
and click the New button to define a new bill of materials.


Tip

The Different Views

To change the view in the bill of materials you can:


	From the list, select a bill of materials name and then click Form View,

	From a product form, use the menu Product BoM Structure to the right.






[image: ../../../_images/mrp_bom_new.png]
定义BOM清单(Bill of Materials)



在物料清单页面的 产品 字段，你需要填写成品料号，即最终生产完工的产成品。
一旦料号呗选择，OpenERP自动填入物料清单的名字，以及产品的主单位(UOM)。

BOM的类型 (BoM Type : Sets/Phantom or Normal BoM) 及 routing field ，会在后续章节解释。

现在你可以选择最终用来生产成品的原材料 (Components) 。
The quantities are set out based on the quantities of finished product and the quantities needed to produce them from the bill of materials.

第二个标签页, Revisions, 用来记录该BOM的所有更改信息。 在每次更改BOM的时候，你需要指定一个新的版本号，同时填写本次BOM更改的内容描述。


Note

简洁界面

The Revisions tab is only visible if the user works in the Extended view mode
(which means that the user should belong to the group Useability / Extended View .




[image: ../../../_images/mrp_bom_revision_new.png]
Revisions of a Bill of Materials (Extended view)



In the third tab, Properties, you can put a free text reference to a plan,
a sequence number that is used to determine the priorities between bills of materials, dates between which a bill of materials
is valid, and values for rounding and production efficiency.


[image: ../../../_images/mrp_bom_properties.png]
Properties of a Bill of Materials



Rounding is used to set the smallest Unit of Measure
in which the quantities of the selected product can be expressed. So if you set the rounding to 1.00, you will not be able to manufacture half a piece. The Efficiency of the product lets you indicate the percentage you lose during manufacturing. This loss
can be defined for the finished product or for each raw materials (components) line. The impact of this efficiency figure is that OpenERP will reserve more raw materials for manufacturing than you would otherwise use just from the Bill of Materials calculations.

The final part of the third tab lets you set some properties for the product’s manufacturing processes. These will be detailed further on in the chapter in the section about configurable products.




多层次BOM

在OpenERP中，物料清单(Bill of materials)的每一行(物料)可能自己就是一个BOM。
这就允许你将BOM定义为多层的(several levels)
Instead of defining several BoMs for the shelf in the figure Plan of Construction of a Shelf, you could define the single bill of materials below:


Single Bill of Materials for 1 SHE100 Unit






	Product Ref.
	Quantity
	Unit of Measure




	SHE100
	1
	PCE


	SIDEPAN
	2
	PCE


	WOOD002
	0.166
	m


	RPAN100
	1
	PCE


	WOOD002
	0.25
	m


	PROFIL
	4
	PCE


	LIN40
	1
	m


	RCK100
	3
	PCE


	SPAN100
	3
	PCE


	WOOD010
	0.249
	m


	METC000
	132
	PCE





OpenERP behaves differently depending on whether the bill of materials is defined in several small
BoMs each on a single level or in one BoM tree-structured on several levels.

If you select a BoM using intermediate products that automatically generates production orders
based on calculated requirements, OpenERP will propose to manufacture an intermediate product. To
manufacture a shelf according to the different bills of materials defined, you would create 6 production orders:


Production Order






	Product Ref.
	Quantity
	Unit of Measure




	SPAN100
	3
	PCE


	WOOD010
	0.249
	m






Production Order






	Product Ref.
	Quantity
	Unit of Measure




	RCK100
	3
	PCE


	SPAN100
	3
	PCE


	METC000
	12
	PCE






Production Order






	Product Ref.
	Quantity
	Unit of Measure




	PROFIL
	4
	PCE


	LIN40
	1
	m






Production Order






	Product Ref.
	Quantity
	Unit of Measure




	RPAN100
	1
	PCE


	WOOD002
	0.25
	m






Production Order






	Product Ref.
	Quantity
	Unit of Measure




	SIDEPAN
	2
	PCE


	WOOD002
	0.17
	m






Production Order






	Product Ref.
	Quantity
	Unit of Measure




	SHE100
	1
	PCE


	SIDEPAN
	2
	PCE


	RPAN100
	1
	PCE


	PROFIL
	4
	PCE


	RCK100
	3
	PCE


	METC000
	12
	PCE





In the case where a single bill of materials is defined in multiple levels, a single manufacturing
order will be generated for each shelf, including all of the sub BoMs. You would then get the
following production order:


Single Production from a tree-structured BoM






	Product Ref.
	Quantity
	Unit of Measure




	SHE100
	1
	PCE


	WOOD002
	0.17
	m


	WOOD002
	0.25
	m


	LIN40
	1
	m


	WOOD010
	0.249
	m


	METC000
	132
	PCE








虚拟件BOM

If a finished product is defined using intermediate products that are themselves defined using other
BoMs, OpenERP will propose to manufacture each intermediate product. This will result in several production orders. If you only want a single production order, you can define a single BoM with several levels.

Sometimes, however, it may be useful to define the intermediate product separately and not as part of a multi-level assembly, even if you do not want separate production orders for intermediate products.

In the example, the intermediate product RCK100 is used in the manufacturing of different shelves (SHE100, SHE200, ...). So you would prefer to define a unique BoM for it, even though you do not want any instances of this product to be built, nor would you want to rewrite these elements in a series of different multi-level BoMs.

If you only want a single production order for the complete shelf, and not one for the BoM itself, you
can define the BoM line corresponding to product RCK100 in the shelf’s BoM as type Sets/Phantom. Then OpenERP will automatically put RCK100‘s BoM contents into the shelf’s production order, even though it has been defined as multi-level.

This way of representing the assembly is very useful, because it allows you to define reusable assembly elements and keep them isolated.

If you define the BoM for the SHE100 shelf in the way shown by the table below, you will get two production orders on confirmation of a sales order, as also shown in the tables.


Defining and Using Phantom BoMs







	Product Ref.
	Quantity
	Unit of Measure
	Type of BoM




	SHE100
	1
	PCE
	normal


	SIDEPAN
	2
	PCE
	normal


	RPAN100
	1
	PCE
	phantom


	PROFIL
	4
	PCE
	phantom


	RCK100
	3
	PCE
	phantom






Production Order from Phantom BoMs






	Product Ref.
	Quantity
	Unit of Measure




	SHE100
	1
	PCE


	SIDEPAN
	2
	PCE


	WOOD002
	0.25
	m


	LIN40
	1
	m


	WOOD010
	0.249
	m


	METC000
	12
	PCE






Production Order from Normal BoM






	Product Ref.
	Quantity
	Unit of Measure




	SIDEPAN
	2
	PCE


	WOOD002
	0.17
	m








用于套件/套装的BOM


Note

Sales Bills of Materials

In other software, this is sometimes called a Sales Bill of Materials.
In OpenERP, the term Kits/Sets is used, because the effect of the bill of materials is visible not
only in sales, but also elsewhere, for example, in the intermediate manufactured products.



Kits/Sets bills of materials enable you to define assemblies that will be sold directly. These could also be used in deliveries and stock management rather than just sold separately. For example, if you deliver the shelf in pieces for self-assembly, set the SHE100 BoM to type
Sets / Phantom.

When a salesperson creates an order for a SHE100 product, OpenERP automatically changes the SHE100
from a set of components into an identifiable package for sending to a customer.
Then it asks the storesperson to pack 2 SIDEPAN, 1 RPAN100, 4 PROFIL, 3 RCK100.
This is described as a SHE100, not just the individual products delivered.






工作中心

Work centers represent units of production, capable of doing material transformation operations. You can distinguish two types of work centers: machines and human resources.


Note

工作中心

Work centers are units of production consisting of one or several people and/or machines
that can be considered as a unit for the purpose of forecasting capacity and planning.



Use the menu Manufacturing ‣ Configuration ‣ Resources ‣ Work Centers to define a new work center. You get a form as shown in the figure Defining a Work Center.


[image: ../../../_images/mrp_workcenter.png]
Defining a Work Center




Tip

Missing fields

If some fields such as Analytic Journal, General Account in the view are missing, you have
to add the user group Useability / Analytic Accounting.



A work center should have a name. You then assign a type: Machine or Human, a code and
the operating hours, i.e. Working Period. The Working Time(s) can be defined through the menu Manufacturing ‣ Configuration ‣ Resources ‣ Working Time. The figure Defining a Work Center represents the hours from Monday
to Friday, from 08:00 to 18:00 with a break of an hour from 12:00.

You can also add a description of the work center and its operations.

Once the work center is defined, you should enter data about its production capacity.
Depending on whether you have a machine or a person, a work center will be defined in cycles or hours. If it represents a set of machines and people you can use cycles and hours at the same time.


Note

A Cycle

A cycle corresponds to the time required to carry out an assembly operation.
The user is free to determine which is the reference operation for a given work center.
It should be represented by the cost and elapsed manufacturing time.

For example, for a printing work center, a cycle might be the printing of 1 page or of 1000 pages
depending on the printer.



To define the capacity properly, it is necessary to know, for each work center, what will be the
reference operation which determines the cycle. You can then define the data relative to the capacity.

Capacity per Cycle (CA): the number of operations that can be done in parallel during a
cycle. Generally, the number defines the number of identical machines or people defined by the
work center.

Time for 1 cycle (hour) (TC): the duration in hours for one cycle or the operations defined by a cycle.

Time before production (TS): the time in hours required to initialize production operations. Generally,
this represents the machine setup time.

Time after production (TN): the delay in hours after the end of a production operation. Generally, this represents the cleaning time necessary after an operation.

Efficiency factor (ET): the factor that is applied to the TC, TS and TN times to determine the real production time. This factor enables you to readjust the different times progressively and as a measure of machine utilization. You cannot re-adjust the other times, because generally they are taken from the machine’s data sheet. By default, the efficiency is set to 1, representing a load of 100%. When you set the efficiency to 2 (i.e. 200%), the load will be 50%.

The total time for carrying out X operations is then given by the following formula:

((X / CA) * TC + TS + TN ) * ET

In this formula the result of the division is rounded upwards. Then, if the
capacity per cycle is 6, it takes 3 cycles to realize 15 operations (15/6 = 2.5, rounded upwards = 3).

With the Hour Account and Cycle Account you define the links to analytical accounting, to report the costs of the work center operations. If you leave the different fields empty, it will not have any effect on the analytic accounts.




工艺路线

Routings define the manufacturing operations to be done in work centers to produce a certain product. A routing is usually attached to bills of materials, which will define the assembly of products required for manufacturing or to produce finished products.

A routing can be defined directly in a bill of materials or through the menu Manufacturing ‣ Configuration ‣ Master Bill of Materials ‣ Routings. A routing has a name, and a code. You can also add a description. Later in this chapter you will see that a routing can also be associated with a stock location. This enables you to indicate where an assembly takes place.


[image: ../../../_images/mrp_routing.png]
Defining a routing with Three Operations




Note

Subcontracting Assembly

You will see further on in this chapter that you can also link a routing to a stock location for the customer or the supplier.
You can use this functionality when you have subcontracted the assembly of a product to a supplier, for instance.



In the routing, you have to enter the list of operations that has to be executed. Each operation has to be done at a specific work center and includes a number of hours and/or cycles.


Tip

Multi-level Routing

It is possible to define routing on several levels to support multi-level bills of materials.
You can select the routing on each level of a bill of materials ( BoM in a BoM can have a different routing).
The levels are then linked to hierarchies of bills of materials.
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生产计划单

一旦物料清单定义好，OpenERP能够根据该公司的需求自动决定制造路线.

生产订单可以由系统根据前面的章节中描述的一些标准自动产生:


	使用 Make to Order 规则,

	使用 Order Point (最小库存) 规则,

	使用生产计划.



当然, 你也可以在菜单 生产(Manufacturing) ‣ 生产(Manufacturing) ‣ 生产计划(Manufacturing Orders) , 点击 新建(New) 按钮手动建立生产订单 .


[image: ../../../_images/mrp_manual.png]
生成订单



如果你没有安装 Just-in-Time 计划模块 mrp_jit, 你要Openerp通过各种不同系统规则安排生产订单. 需要这样做,执行菜单:menuselection:Warehouse –> Schedulers –> Compute Schedulers.


Tip

采购例外

注意，如果产品设置为 Make to Stock ，你需要对每个产品定义 最小库存规则 .






完成生产流程

要了解的系统功能和系统如何运作的，你需要安装带演示数据的数据库，我们将向您展示，测试一个完整的工作流程:


	如何创建销售订单,

	中间产品的制造工作流程,

	订购的产品的制造,

	交付产品给客户,

	月末开据发票,

	可追溯性的售后服务.




Tip

示范数据

要严格遵循工作流程如下图所示，你应该从一个新的数据库开始，
使用和本例中相同的数量，那么，你将不会碰到因库存不足造成的例外状况.



更高级的采购问题的处理将在本章的后面来解决.

可以做以下步骤，通过重新配置向导添加销售管理 Sales Management .


销售单

通过菜单 销售(Sales) ‣ 销售订单(Sales Orders) -> 销售报价(New Quotation) 来开始创建一个销售(或客户)订单. 键入下面的信息:



	客户(Customer) : 选择客户 Agrolait,

	开票方式(Shipping Policy) : 在 其他信息 页签中 选择 基于送货单开票,

	销售明细(Sales Order Lines), 点击 新建(New):

	产品(Product) : 选择产品 PC2 – Basic PC (assembly on order),

	数量(Quantity (UoM)) : 输入数量 1,

	单位(Product UoM) : 选择单位 个(PCE),

	供货方式(Procurement Method) : 按单生产.






报价单建好后, 你可以通过按钮 Confirm Order 来立即确认订单. 单据右下方,有一个备注栏可以在订单处理的全程中用
于录入相关销售的参考信息, 通常情况下,最初的备注信息是 SO007. 可以点击 Question Mark 按钮
you can look at the process linked to your order using the Question Mark button next to the Sales Orders title.


[image: ../../../_images/mrp_sales_process_new.png]
处理销售订单 SO007 的过程



通过菜单 Manufacturing ‣ Compute All Schedulers 来做需求计算.




在制品管理

要了解需求计算所带来的影响，你需要知道对销售的产品配置. 要做到这一点, 在产品 PC2 的form点击链接 Product BoM Structure . 所示的计划 PC2 的组成 这里就是所选产品的组成.


[image: ../../../_images/mrp_product_bom_tree_new.png]
PC2 的组成



PC2 电脑分两步来制造:

1: 中间产品: CPU_GEN

2: 使用中间产品组成的成品: PC2

生产主管可以使用菜单 Manufacturing ‣ Manufacturing ‣ Manufacturing Orders 看到生产订单. 然后，您可以得到一个
准备生产的订单列表 (Ready to Produce) 和预计开始日期 (Scheduled Date) 满足客户的交付日期.


[image: ../../../_images/mrp_production_list_new.png]
生产订单列表



您将看到 CPU_GEN 的生产订单, 不是 PC2 的，因为PC2的生产依赖于中间产品 CPU_GEN ,中间产品要首先生产. 返回到 CPU_GEN 的生产订单
点击它. 如果有一些其他订单的列表, 选择一个和你产品关联的订单号 (如本例中的 SO007 ).


[image: ../../../_images/mrp_production_form_new.png]
生产订单详细资料



系统会告诉你，你制造产品 CPU_GEN 必须使用的组件: MB1, CPU1, FAN, RAM. 您可以再次确认生产订单:

开始生产: 原料消耗,

生产: 生产成品.

单击 Start Production 按钮, 然后单击 Edit 按钮, 然后编辑该行的产品 MB1. 把光标定位在域 Production Lot
输入批号，快捷键 <F1> 创建一个新批号. 输入一个内部的参考，例如: MB1345678. 系统可能给你一个警告，因为这一个批号
没有库存, 你可以忽略此消息.

单击 Produce 按钮，制造成品.

生产订单的关闭状态，如下图中所示 生产订单后的不同阶段.


[image: ../../../_images/mrp_production_form_end_new.png]
生产订单后的不同阶段






生产完工流程

经过中间产品 CPU_GEN 的制造, OpenERP 自动建议使用先前创建的 PC2 的订单制造. 返回到“生产订单”菜单 ，可以通过菜单 Manufacturing ‣ Manufacturing ‣ Manufacturing Orders
看到订单准备生产.

你能找到电脑 PC2 已经销售给客户 (源文件 SO007), 如图所示.


[image: ../../../_images/mrp_production_list_end_new.png]
完成 PC2 的生产



现在的生产已经完成, 销售给客户的产品已生产完成和原材料已出库被消耗.


Tip

Automatic Actions

使用按库存生产的材料, 生产完成后将自动影响到下面几处， 更详细的介绍在后面章节介绍:


	增加库存,

	为装配人员自动生成操作,

	自动创建财务辅助核算项.








半成品(部件)生产

如果您需要管理的子产品, 你应该安装的模块 mrp_subproduct (Reconfigure wizard, MRP Sub-products). 生产的业务过程，
在OpenERP您可以从原材料制造几个单位的成品 (A + B > C). 在子产品管理, 制造的结果可以是有两个成品和子产品 (A + B > C + D).


Note

子产品材料

在 OpenERP, 子产品材料对应在产品制造主产品过程中的第二个产品
例如, 切割木板的木材会产生其他的木板，但这些木板太小，不能做主要的产品。
(如果他们能用在其他地方，或许切下部分具有价值).



如果模块 mrp_subproduct 已经安装, 你将在 BOM上看到一个新的标签页，在这里你可以设置子产品的制造成品.


[image: ../../../_images/mrp_bom_subproduct.png]
定义子产品



当 OpenERP 基于物料清单生成生产订单使用辅助产品时, 你可以在产品订单的 Finished Products 标签页中看到所有完成产品的列表.


[image: ../../../_images/mrp_production.png]
Production Order producing Several Finished Products



第二产品可以让你生成一些类型的产品用同样的原材料和制造方法 - 只有在不使用这些要求的计算. 然后, 如果你需要第二产品, OpenERP 不会问你制造其他产品使用废弃产品和第二产品.
在这种情况下, 你应该进入为第二产品的另一个生产订单.


Note

服务类的生产

不同于大多数软件的生产管理, OpenERP 管理服务作为库存商品. 所以
它可以把服务类型的产品放在BOM中. 这些不出现在生产订单，但他们的要求将被考虑到.

如果它们被定义为 Make to Order 按订单生产, OpenERP 将生成一个任务或转包生产的操作.
这个行为将取决于产品的配置供给方法: 购买还是生产。






生产废品管理

如果在产品没有完成之前想废弃它，你将不得不废弃制造这件产品的所有原材料


[image: ../../../_images/mo_scrap.png]
成品废弃




如果你废弃一件成品， 你可以在当前的图片中得到提示。一件成品将被创建并放在废弃的虚拟仓库中。已完成的新产品将被添加到制造订单中。



Tip

报废产品

废弃一件产品, 你必须编辑制造订单,然后选择产品，通过点击来取消左边有小铅笔在的项。



新产品由于以下的原因添加：当你要废弃一件你生产了的产品，你必须要生产另一件产品来代替这个被废弃的产品。这就是你为什么
The reason why you have to scrap each component manually is that the production problem can come from one component.

If the production process is finished and you see that you have to scrap the finished product, you will
not have to scrap the different components. They are already consumed. They are not available anymore
for further manufacturing orders; they have been moved to the production Stock Location.




生产订单

菜单 生产(Manufacturing) ‣ 生产(Manufacturing) ‣ 生产订单(Manufacturing Orders) 列表页面点击 新建(New) 按钮
得到如图 新建生产订单 所示的空白的生产订单表单.


[image: ../../../_images/mrp_production_new.png]
新建生产订单



生产订单接下去走图 生产订单处理流程图 的流程.


[image: ../../../_images/mrp_production_processus.png]
生产订单处理流程图



计划生产日期， 产品数量 和 摘要 这些数据都在生产订单窗体打开时, 自动完成了. 输入你想要生产的产品以及
需求的数量. 在选择产品后,  产品相关的计量单位也能自动完成输入.

你需要设置以下两个库位:



	原材料的库位

	产成品库位






For simplicity, put the Stock location in both places. The field Bill of Materials will
automatically be completed by OpenERP when you select the product. You can then overwrite it with another BoM to specify something else to use for this specific manufacturing, then click the button Compute Data.

The tabs Scheduled Products and Work Orders are also completed automatically when you click
Compute Data (in the Work Orders or Scheduled Products tabs).
You will find the raw materials there that are required for the production and the operations needed by the assembly staff.

如果你要开始生产, 点击按钮 确认生产(Confirm Production), OpenERP 则会自动在 耗用(Consumed Product) 页签 中产生相应的 物料耗用(Products to Consume)
以及 在 产成品(Finished Products) 页签中产生 完工产品(Products to Finish).

在下面这些情形时, 你需要修改 耗用(Consumed Products):


	耗用的原材料需要序列(批次)号管理,

	耗用的材料异常耗用(如生产中有异常损失).



为了跟踪,你需要在原材料投料以及产成品完工时,录入相应的批次号. 相应为 生产批次(Production Lot) 和 托盘(Pack).

Once the order is confirmed, you should force the reservation of materials
using the Force Reservation button. This means that you do not have
to wait for the scheduler to assign and reserve the raw materials from your stock for this
production run. This shortens the procurement process.

If you do not want to change the priorities, just leave the production order in this state and the scheduler will create a plan based on the priority and your planned date.

要制造一个产品, 点击 开始生产. 原料自动地从仓库中消耗, 即原材料的领料单由 待料 状态转变为 已领料 状态.

当产品制造完成时, 点击 生产. 将已完工产成品入库.
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物流和生产制造


生产库位

OpenERP 中为了跟踪生产过程中的物料,你可以定义一种特殊的生产库位.

要查看所有的移库明细可以进菜单 仓库(Warehouse) ‣ 可追溯的(Traceability) ‣ 库存调拨(Stock Moves). 在右上角的搜索框内输入 库位 名称可以按源库位
以及目标库位进行过滤及分组.




可追溯性

在OpenERP中可以很方便地追溯产品. 你只需要在追溯系统中为每一个产品批次指定一个批次号,便可以很容易地在仓库中追溯到某批次的产品.

要在生产中启用物料追踪, 点击菜单 仓库(Warehouse) ‣ 产品(Product) ‣ 产品(Product) 在 产品 界面的 信息(Information)
页签的 跟踪生产批次(Track Manufacturing Lots) 选项中选择 批次(Lots) 选项.

In the manufacturing order, you have to mention a production lot number in order to continue the process.
You can select the production lot in the Manufacturing Order form on the second tab, called Finished Products. You have to click the Products to Finish you want to trace, a new window will open. In the Production Lot field, click to link the manufacturing order to a production lot.


[image: ../../../_images/prod_lot.png]
制程中的物料跟踪



When you have linked some manufacturing orders to production lots, you can trace them from the menu Warehouse ‣ Traceability ‣ Production Lots. In this view, you see the different production lots linked to a product. If you select one lot, you will have the possibility to choose between Upstream Traceability or Downstream Traceability.


[image: ../../../_images/production_lots.png]
选择 推式/拉式物流追溯




Tip

物料追溯

推式物流追溯: 推式物流从供应商获得原材料然后经过各种库位链形成最终产品到达客户. Note that the name is confusing - this
would often be considered a downstream direction. Think of it as Where Used.

拉式物流追溯: 拉式物流则刚好相反,它是由客户的产品订单进行驱动,然后最终形成对供应商的原材料采购. Note that the name is confusing - this would often be considered an upstream
direction. Think of it as Where Supplied.




[image: ../../../_images/upstream_trace.png]
推式物料跟踪



The different lines show the stock moves attached to the production of the product. There are several
stock moves that are traced due to the Bill of Materials attached to the product [PC1] Basic PC.


[image: ../../../_images/downstream_trace.png]
拉式物流跟踪



在这个窗口中, 你能看到产品完工的调拨记录.
This is related to the definition of the  concept of Downstream Traceability, which only shows the flow from the customer to the supplier of raw materials.






管理维修：从维修到开票和库位移动

The management of repairs is carried out through the module mrp_repair. Once installed, this module adds a new Manufacturing ‣ Manufacturing ‣ Repair Orders menu under the Manufacturing menu to create repair jobs and review repairs in progress.


Tip

维修

安装维修模块,你也可以在 重新配置(Reconfigure) 向导. 在 MRP 应用配置 屏, 勾选 维修(Repairs) 选项.



在OpenERP中,维修会有如下的影响:


	使用原材料: 维修更换的部件,

	待产产品: items replaced from reserved stock,

	质量管理: 跟踪物料故障原因,

	会计分录: following stock moves,

	Receipt and delivery of product from and to the end user,

	Adding operations that can be seen in the product’s traceability,

	Invoicing items used and/or free for repairs.




为新的维修输入数据

要创建维修单,进入菜单 生产(Manufacturing) ‣ 生产(Manufacturing) ‣ 维修单(Repair Order). 点击 创建(Create) 可以看到一张空的维修单,
如下图: 创建报修单


[image: ../../../_images/mrp_repair_new.png]
创建报修单



First enter the product to repair, then identify the product that will be repaired using the product lot number. OpenERP then automatically completes fields from the selected lot – the partner fields, address, delivery location and stock move.

If a warranty period has been defined in the product description, in months, OpenERP completes the field Guarantee limit with the correct warranty date.

Now you have to specify the components that you will be adding, replacing or removing in the Operations part. On each line, you should specify the following:

Add or remove a component of the finished product:


	产品,

	数量,

	单位,

	单价,

	开票 或者 不开票.



Once the component has been selected, OpenERP automatically completes most of the fields:


	数量(Qty): 1,

	单位(UoM): unit for managing stock defined in the product form,

	单价(Unit Price): calculated from the customer list price,

	源库位(Source Location): given by the stock management,

	开票方式(To Invoice): depends on the actual date and the guarantee period.



这些数据都是系统自动产生的, 你还可以再修改它们.

维修单 的第二个标签页的 开票方式 ,你可以选择此次维修是否需要开票, 以及是维修前开票还是维修后开票等.
You can also select the applicable list price, a specific address and encode additional charges that need to be added to the repair invoice.


[image: ../../../_images/mrp_repair_tab2.png]
维修单及开票信息



在第三个页签, 额外信息 显示了相关的 调拨单以及发票. 还有当前库位的相关信息, 更新 送/收货地址(Delivery Location) 可以更改库位.
备注(Notes) 里则可以添加一些与之相关的其他的参考用的信息.




维修工作流

A defined process handles a repair order – both the repair itself and the customer invoicing. The figure 典型的维修处理流程 shows this repair process.


[image: ../../../_images/mrp_repair_workflow.png]
典型的维修处理流程



最初的维修单状态是 询价(Quotation) 状态. 这种状态的维修单不会影响系统中的其他数据. 而且你可以通用 询价(Quotation)/订单(Order) 来打印这个询价的维修单.

在第二个页签,你可以选择不同的 开票方式:


	不开票,

	维修前开票,

	维修后开票.



You can then confirm the repair operation or create an invoice for the customer depending on the Invoice Method.

The repair quotation can now be sent to the customer. Once the customer approves the repair, click the Confirm Repair button. From the menu Manufacturing ‣ Manufacturing ‣ Repair Orders you can easily find the confirmed repair orders by selecting the Confirmed button. Click Start Repair to indicate that you can start working on the repair. The Repair order will now be in the Under Repair state. When you finish the repair, click the End Repair button.




维修开票

当维修单开票后, 点击 生成发票(Make Invoice) 系统中会生成一张草稿状态的发票. 同时在维修单上会以红字显示该发票.
You can easily go to that invoice simply by clicking the corresponding red text. This invoice contains the raw materials used (replaced components) and any other costs such as the time used for the repair. These other costs are entered on the second tab of the Repair form. Any information you entered for the quotation on the Notes tab will also be displayed on the invoice.

If the product to be repaired is still under guarantee, OpenERP automatically suggests that the components themselves are not invoiced, but will still use any other defined costs. You can override any of these default values while entering the data.


Note

扩展信息

The link to the generated invoice is shown on the Extra Info``tab of the repair document. To open the invoice, simply click the ``Invoice field.






库存调拨和维修

When the repair has been carried out, OpenERP automatically carries out stock movements for components that have been removed, added or replaced on the finished product. From the menu Warehouse ‣ Traceability ‣ Stock Moves, you can for instance enter the production lot to see all moves for the repaired product.

The move operations are carried out using the locations shown in the first tab of the Repair form. If a destination location has been specified, OpenERP automatically handles the final customer delivery order when the repair has been completed. This also lets you manage the delivery of the repaired products.

For example, take the case of the shelf that was produced at the start of this chapter. If you have to replace the shelf SIDEPAN, you should enter data for the repair as shown in figure Repair for a Side Panel.


[image: ../../../_images/mrp_repair_panlat.png]
Repair for a Side Panel



In this example, you would carry out the following operations:


	Remove a SIDEPAN shelf in the cabinet and put the faulty shelf in the Scrapped location,

	Place a new SIDEPAN shelf that has been taken from stock.



When the repair is ready to be confirmed, OpenERP will generate the following stock moves:


	Put faulty SIDEPAN into suitable stock location Default Production > Scrapped,

	Consume SIDEPAN: 库存库位(Stock) > 生产库位(Production).



If you analyze the traceability of this lot number, you will see all the repair operations in the
upstream and downstream traceability lists of the products concerned.
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预测和供应


排程

需求计划是根据定义在产品部分的规则，自动计划/优化生产和采购的计算引擎。该计划默认设定为每天运行一次（OpenERP为此自动完成一个既定动作）。你也可以使用菜单 仓库(Warehouse) ‣ 生产计划(Schedulers) ‣ 运行计划(Compute Schedulers). 来运行计划。
该需求计划依据定义在产品、供应商及公司上的所有相关参数来决定不同生产订单、发货以及供应商采购的优先次序。


Note

起始时间

你可以同过修改菜单 Administration ‣ Configuration ‣ Scheduler ‣ Scheduled Actions 来设置计划的起始时间。修改“运行MRP计划”配置文件。（此处原文是两句单独的话，有点看不懂，只能直译）




[image: ../../../_images/stock_cron.png]
配置计算需求的起始时间




Tip

计算需求/排程

排程计划只考虑那些已经被确认但却还没有开始的获取需求，这些预定需求将根据所需求产品的配置自行开始生产/任务或者采购。



在开始进行保留和获取的时候，你需要考虑到操作的优先顺序。那些需求日期已经超期的紧急需求，或者比其他产品的需求日期更早的产品，将最先启动。如果库存里有足够的产品能满足所有需求的话，你可以肯定的是，那些最紧急的需求产品将最先被生产。




计划

使用OpenERP，你可以以简单的方法来计划生产。只需进入菜单 Manufacturing ‣ Planning，就可以计划制造订单，工单，以及/或者工作中心。

点击 计划 菜单里的 制造订单 ，将会打开一个日历视图。在这里，你可以选择一个你需要的日期来创建订单。你也可以看到那些已经计划好的订单。在日历视图里拖动一个制单订单，你可以更改这个订单的起始日期。


[image: ../../../_images/mo_plan.png]
计划制造订单



你在日历视图里点击一个日期，将会打开一个空白的生产订单窗口，允许你选择你想要生产的产品。


[image: ../../../_images/newmo_plan.png]
新的生产订单




排程和和精益生产（JIT）

如果你想采用 精益生产（JIT） 的方式，你需要安装模块 mrp_jit.

如果你安装了这个模块，你将不再需要运行常规的采购计划排程（但仍然需要运行最小库存采购点计划，或者比如说，每天运行一次。）

所有的需求订单都将立即运行，这在某些情况下可能会引起轻微的性能影响。

这也可能会增加你的库存量，因为产品会尽快地被保存占用而且计划的时间范围却不再被考虑进去。在这种情况下，你没有办法再对不同的分拣订单使用优先顺序。




提前期

所有的资源获取操作（也就是包括生产订单的需求和采购订单的需求）都会被计划排程所计算。但是OpenERP不只是生成每一个订单，还能够计划每一个步骤的时间安排。在每个订单文件上你都能找到一个由系统计算出来的计划时间。

OpenERP基于承诺给客户的交货日期来组织整个生产和采购链。这些数据是由订单里确认的日期和订单行里所列的产品的提前期决定的。这个提前期是自动从字段 Customer Lead Time 获取的，你可以在产品表单里看到。客户的提前期则和产品的提前期以及交货期是有区别的。

要知道提前期的计算方法，我们以下面要生产一款柜子为例。假设这个柜子的组装过程分为2个工序，使用下面的两个物料清单（Bill of Materials）。


1 SHE100 Unit的物料清单






	产品编码
	数量
	单位




	SIDEPAN
	2
	PCE


	WOOD002
	0.25
	m


	LIN040
	1
	m


	WOOD010
	0.249
	m


	METC000
	12
	PCE






2 SIDEPAN Units的物料清单






	产品编码
	数量
	单位




	WOOD002
	0.17
	m





这里，SIDEPAN是由所示的流程按订单生产， WOOD002则是按订单采购，而其他的产品都有库存。这样一个SHE100的产品，会生成2张生产订单（SHE100和SIDEPAN），并且生成2张采购WOOD002的采购订单。产品WOOD002会用在SHE100和SIDEPAN的生产过程中。我们在产品表单里设置提前期如下：


提前期







	产品编码
	客户提前期
	生产提前期
	供应商提前期




	SHE100
	30 days
	5 days
	


	SIDEPAN
	
	10 days
	


	WOOD002
	
	
	5 days





一个下单日期在1月1日的客户订单，将会安排下列操作和提前期：


	SHE100发货: 1月31日 （=1月1日 + 30天），

	生产SHE100: 1月26日（=1月31日 - 5天），

	生产SIDEPAN: 1月16日（=1月26日 - 10天），

	采购WOOD002 （生产SHE100用）： 1月21日（=1月26日 - 5天），

	采购WOOD002 （生产SIDEPAN用）：1月11日（=1月16日 - 5天）。



在这个例子里，OpenERP将拟向产品WOOD002的供应商下2个订单，这两个订单可以有不同的需求日期。 在确认订单前，采购经理可以把这两个订单合并成一个单独的订单。




安全天数

排程会计划所有设置了时间参数的产品。但是直接在公司范围设置这些参数也是可能的。这样这些参数就在整个公司范围内发挥作用，而不去考虑具体产品。在公司说明的标签页 Configuration ，你会发现下面的参数：


	排程期间(Scheduler Range Days): 程对需求的计算是有时间限制的。如果需求时间的范围是在过去或者是从今天算起晚于你所设置的天数之后的话，排程是不做计划的。

	生产提前期(Manufacturing Lead Time): 生产所需要耗用的时间(天数),

	采购提前期(Purchase Lead Time): 所需原材料半成品采购备齐所需耗用的时间(天数),

	预留提前期(Security Days): 为其他异常情况提供的预留的耗用时间(天数),




Note

采购提前期

即采购部门根据供应商的情况,由采购订单确认到供应商真实采购之间的平均时间来确定.
This delay takes into account the order process in your company, including order negotiation time.



下面用一个实例来说明:


	生产提前期(Manufacturing Lead Time) : 1,

	采购提前期(Purchase Lead Time) : 3,

	预留提前(Security Days) : 2.



这样,由上面的数据就可以计算出下面的这些时间:


	送货时间 SHE100: 29 January (= 1st January + 30 days – 2 days),

	生产时间 SHE100: 23 January (= 29 January – 5 days – 1 day),

	生产时间 SIDEPAN: 12 January (= 26 January – 10 days – 1 day),

	采购时间 WOOD002 (for SHE100): 15 January (= 26 January – 5 days – 3 days),

	采购时间 WOOD002 (for SIDEPAN): 4 January (= 12 January – 5 days – 3 days).








需求

在系统正常运作时, 并不需要担心生产需求计划, 用户只需要按系统自动生成的采购,销售,任务及生产计划完成相应的操作即可.

但是如果有任何的配置问题.系统都会在出现相应的异常,并保持在异常状态下. 只有在这些异常都解决后, 才能计算出相关的采购或者生产任务.


自动采购和补充

在 产品 视图页,需要设置下面两个有关生产的参数:



	按备货计划生产(MTS)

	按订单生产(MTO)






这两个参数直接影响自动采购与自动补货的方式.
使用MTS方式时, 你需要在对应产品上设置最小库存规则来触发补货或者采购动作. 并且你还应该给产品设置合适的供应商.
使用MTO方式时, 你必须要给相应产品设置对应的供应商,以便在生产单及销售单确认时能自动产生相应的采购.




管理排程的异常

你可能会在生产过程中遇到各种各样的异常情况. An exception appears in the Procurement Exception view when the system does not know what to do with an object, such as a Manufacturing Order or a Purchase Order.

通常会有如下几种异常情况:



	产成品未定义BOM单(Bill Of Materials): in this case you have got to create a BoM or indicate that the product can be purchased instead (change the Supply Method).

	相关采购未定义供应商: you have to define a supplier in the Supplier tab of the product form.

	供应商未定义地址联系人: you have to complete an address for the supplier for the product in consideration.

	原材料库存不足: you have to create a rule for automatic procurement (for example, a minimum stock rule), or manually procure it.







[image: ../../../_images/procurement_exception.png]
需求异常



有时候的一些异常只是系统的临时异常. 系统会自动修复.

如果产品的需求方式是 来自库存(in stock) 而产品的库存数量又不足的情况下, OpenERP will make the exception as ‘temporary’ or ‘to be corrected’. The exception is temporary if the system can procure it automatically, for example, when a procurement rule has been defined for minimum stock.

当需求异常时, 你要去确认一下产品的各项配置是否正确. 然后去重新运行一下MRP计算也可以在明细行上点击 重试(Retry) 按钮并
点击 计算需求(Run procurement).


[image: ../../../_images/procurement_fix.png]
需求异常处理



异常中相关产品的生产方法定义为 生产(Produce) 又未为其定义相应的 原材料清单(Bill of Materials), 所以计算机系统并不知道如何生产
该产品, 因此处于异常状态.




人工生成需求

对于内部采购,则可以手工创建一张需求单. 打开菜单 仓库(Warehouse) ‣ 排程(Schedulers) ‣
需求异常(Procurement Exceptions) 并点击 新建 按钮即可.


[image: ../../../_images/mrp_procurement1.png]
手工需求



需求单可以自动计算出相关原材料的需求单. 这些需求单根据相应产品的配置情况又可以生成相应的生产计划以及相应的采购订单.


[image: ../../../_images/mrp_procurement_flow1.png]
需求流程



在产品库存不足时,直接产生采购或者生产是不太好的.最好是先生成一张需求单, 主要有以下的一些优点:


	界面更简单，因为OpenERP根据预定义的规则和相关数据得到需求计算结果，例如：采购日期的计算依据是，需求日期、默认供应商、需要的原材料及所选BOM等。

	需求单会考虑需求的优先次序。如果直接输入采购订单，就打破了这种优先次序。




Tip

快捷方式

在产品窗体中可以使用 需求申请(Procurement Request) action 按钮的快捷方式 去创建新的需求申请单.










使用分包商(外协件)

在OpenERP中,还可以处理供应商生产外包(外协)(如 标识喷印, 外加工件等), 在仓库中定相关的供应商外加工库位路径即可.

按以下数据配置一个供应商库位:


	库位类型(Location Type): 供应商库位,

	地址(Location Address): 选择供应商的发货地址,

	库位链类型(Chained Location Type): 固定,

	固定库位(Chained Location if Fixed): 库存库位,

	Chaining Lead Time: number of days before receipt of the finished product.



一但相关的产品的生产计划被确认, OpenERP 会生成下面的这些:


	原材料由库存库位向供应商库位的送货,

	相应产成品向库存库位的产成品入库.



一旦生产计划单被确认, OpenERP 会自动生成向供应商发货的单据.仓库保管员可以在 仓库(Warehouse) ‣ 仓库管理(Warehouse Management) ‣ 内部调拨(Internal Moves)
菜单去处理这些单据以完成向供应商的发货.

如果原材料确认到货，OpenERP就会激活生产订单，供应商使用原材料来生产成成品后，将会自动被放入您的仓库。从供应商处收到产品的时候，生产就会确认。这时你需要标明供应商消耗的物料的数量。


Tip

Subcontract without Routing

If you do not use routing, you can always subcontract work orders by creating an empty routing in the subcontracting bill of materials.



进入菜单 生产(Manufacturing) ‣ 生产(Manufacturing) ‣ 生产计划(Manufacturing Orders) 可以查看到相应的生产计划单.
生产计划通常需要按下面两个阶段生产:


	耗用原材料,

	完工产成品.



视公司管理需求,可以认为第一步即是在制供应商的确认.第二步则是仓库操作者的确认.




匹配销售订单和物料清单BOM

OpenERP 中,可以为产品定义多个原材料清单(BOM单). 而且还可以为各种原材料定义各种生产方式.
You will see in the following section that the manufacturing procedure (the routing) is attached to the Bill of Materials, so the choice of bill of materials implicitly includes the operations to make it.

Once several bills of materials have been defined for a particular product, you need to have a system to enable OpenERP to select one of them for use. By default, the bill of materials with the lowest sequence number is selected by the system.

使用 属性 还可以更灵活地控制采购与销售. 进入菜单: 生产(Manufacturing) ‣ 配置(Configuration) ‣ 主数据(Master Bill of Materials) ‣ 属性(Properties) 以定义BOM单属性, which can be set up arbitrarily to help you select a bill of materials when you have a choice of BoMs.


Note

属性

Properties is a concept that enables the selection of a method to manufacture a product.
Properties define a common language between salespeople and technical people,
letting the salespeople have an influence on the manufacturing of the products using
non-technical language and the choices decided on by the technicians who define Bills
of Materials.



例如你可以按下面的表格数据定义属性组以及属性:


属性





	属性分组
	属性




	质保
	3 年


	质保
	1 年


	Method of Manufacture
	Serial


	Method of Manufacture
	Batch





Once the bills of materials have been defined, you could associate the corresponding properties with them. Then when the salesperson enters a sales order line, he can attach the properties required (Extra Info tab). If the product has to be manufactured, OpenERP will automatically choose the bill of materials that matches the defined properties in the order most closely.


Note

扩展视图

Note that the properties are only visible in the Bills of Materials and Sales Management if you are working in the Extended view mode. If you cannot see it on your screen, add the group Useability /Extended View to your user.




[image: ../../../_images/sale_line_property.png]
销售单明细上定义属性



例如: 生产单明细上的制造批次号

As an example, take the manufacturing of the shelf presented above. You can imagine that the company has two methods of manufacturing for this cabinet:


	Manually: the staff assembles the shelves one by one and cuts the wood plank by plank. This approach is
usually used to assemble prototypes. It gets you very rapid production, but at a high cost and
only in small quantities.

	On a production line: the staff uses machines that are capable of cutting wood by bandsaw. This method
is used for production runs of at least 50 items because the lead times using this method are quite
lengthy. The delay to start the production is much longer, yet the cost per unit is considerably lower
in this volume.



You define two bills of materials for the same cabinet. To distinguish between them, you will define two properties in the same group: manual assembly and production line assembly. In the quotation, the salesperson can set the method of manufacture he wants on each order line,
depending on the quantities and the lead time requested by the customer.


Note

原材料清单及代用品

在一些ERP软件里, 也将原材料清单叫做 替代品.



By putting a bill of materials on its own line, you can also implement substitute products. You set the bill of materials to type Sets/Phantom to make the substitution transparent and to prevent OpenERP from proposing an intermediate production order.




生产和服务

In OpenERP, you can handle three types of goods: two types of products (Stockable or Consumable products) and one type of services.

For this last category, OpenERP can react in two different ways. Once a manufacturing order is generated for a product and this product contains a Service, a task can be automatically generated or not.


Note

任务

要自动产生相关任务, 你需要安装 project_mrp 以及 project 模块.



通常, 任务不会与项目关联. 你可以创建一个项目, 并在对应的服务 产品 页的 需求与库们(Procurement & Locations)
页签 Miscellaneous 项目(Project) 字段选择该项目进行关联.


[image: ../../../_images/service_prj.png]
为服务类产品关联一个项目



To illustrate this process, follow the next example:

首先, 您需要创建一个项目用于关联本次服务. 我们将项目叫做 咨询服务项目(Consulting), 然后我们还需要按下面的信息创建一个相应的服务产品:


服务配置





	字段
	值




	Name
	Consulting


	Reference
	CSLT


	Product Type
	Service


	Procurement Method
	Make to Order


	Supply Method
	Produce


	Default UoM
	Hour


	Project
	Consulting





Once you have configured your project and your product, you can create a Sales Order to order hours of consultancy. When you confirm the Sales Order, a task will be created.


[image: ../../../_images/soprj_tip.png]


进入菜单 项目(Project) ‣ 项目(Project) ‣ 任务(Tasks), 会有一个 SO011:[CSLT] Consulting 新的任务.
任务会有不同的销售单号.


[image: ../../../_images/prj_so.png]
产品与任务,项目关联
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多公司环境

书的这部分的主要介绍OpenERP的多公司环境下的应用。OpenERP从6.0版本起，应用多公司的环境你不必安装任何额外的模块。所有的组件都包括在基本模块。您的多公司的环境所要做的工作，是添加 易用性/multi-companies 组给您的用户。

多公司的环境让您从不同公司的不同仓库、客户和供应商、产品来管理运营...

在下面的章节中，我们将执行一个完整的订单流程，一个法国客户没有库存，但将其委托给另一家在比利时的公司，提供产品给客户。

为完成这一订单，我们制定以下计划。


[image: ../../_images/schema.png]
Flow Schema




	为了能够管理这个过程，请安装以下模块：

	
	sale

	purchase

	stock

	stock_location, Reconfigure wizard –> Advanced route (为了能定义推拉式物流)









	多公司的物流管理
	基本配置

	销售与采购流程
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多公司的物流管理



	基本配置




	销售与采购流程
	销售单据
	物流单据
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基本配置

那么我们从配置所需的不同组件开始。在下一个章节，我们就会去定义组件内容：



	
	公司结构

	
	多公司定义

	Charts of Accounts

	Storage









	用户,供应商与客户



	
	产品

	
	产品数据

	Push & pull flows















Note

User Group

Go to Administration ‣ Users ‣ Users and add the Useability / Multi Companies group to your user, to be able to use OpenERP in a multi-company environment.
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销售与采购流程

At this point, we have defined everything that we need, we can now execute the process.

The following example will be structured as follows:

First, we will make a sales order for one unit of our product (Basic PC) in the company
OpenERP France for the customer NotSoTiny. Then this will be sent to the company OpenERP
Belgium that stocks the Basic PCs. An order of one unit will be sent to OpenERP Belgium
from OpenERP France. OpenERP will purchase the product from its supplier (in this case,
Dell Belgium). Second, OpenERP France will have to invoice the delivered quantities sent
by OpenERP Belgium to NotSoTiny.



	销售单据
	物流单据
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销售单据

At this point, you have to login as a user of OpenERP France to make a Sales Order coming from a customer
of this company.


[image: ../../../../_images/sales_order_1tab.png]
创建销售单据



You should not forget to set the correct parameters in the second tab Other Information to select the good shipping
and picking policies. Here we select the Invoice From the Picking as Shipping Policy.

Confirm the Sales Order, then run the Scheduler (Warehouses ‣ Schedulers ‣ Compute
Schedulers) and run the Procurement from each company (OpenERP France, OpenERP and OpenERP Belgium).

At this time, a Purchase Order and a Delivery Order have been generated. The Purchase Order is in the Request For
Quotation state and you have to convert it into a Purchase Order to confirm the purchase. The Delivery Order is in Not Available state because you have to buy the products before delivery.


[image: ../../../../_images/request_quotation.png]
采购单据



Once the purchase order has been confirmed and the reception is completed, we can process the delivery order.


物流单据

Once the delivery order is processed, the products are sent to the customer and we can invoice the order from OpenERP
France on the delivered quantities.

The delivery order will be processed from OpenERP Belgium. OpenERP Belgium is the company that manages the stock of products.
This company is responsible for the delivery of the products to the final customers. However, the invoicing process will be
handled by OpenERP France, because it is the company that received the order from the customer.


[image: ../../../../_images/delivery_order.png]
产品交付



From the user of OpenERP France, we can create the invoice for the order (Sales ‣ Invoicing ‣ Lines
to Invoice), then pass the invoice from the Draft state to the Open state. To finalize the invoicing process, you have to
go to Accounting ‣ Customers ‣ Customers Invoices to execute the payment process.


[image: ../../../../_images/delivery_order_fr.png]
创建发票




[image: ../../../../_images/customer_invoice.png]
审核发票
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基本的业务流程


这两章的内容则讲解了产品与服务的基本的采购与销售操作.




	为你的销售提供助力

	驱动采购
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为你的销售提供助力


这一章主要讲述Openerp的销售管理，包括从报价到客户订单的销售订单处理过程，以及发货管理及发票。
这一章并不包含客户关系及售前管理，这两个功能主要由CRM（客户关系管理）模块处理，在本书的早期章节中已经有所描述。

这一章还讲述了运输管理，利润管理，报表，价格管理，及处理各种类型的销售优惠活动。




这一章的学习应该从一个全新的包含示例数据的数据库开始，并安装’销售‘模块，不需要特别的会计科目表设置。



	管理销售报价单

	包装

	消息提醒

	发货和开票设置
	订单相关参数设置

	装箱方式





	运输管理
	送货价格表

	交货方式

	基于订单数量交付

	基于发货数量交付





	明明白白利润点
	每笔销售单据的利润

	每种产品的利润

	每个项目的利润





	灵活的价格体系
	创建价格表
	价格表版本

	定价规则

	小数精度





	价格表应用示例
	默认价格表

	商贸类公司

	建立客户合同条件





	价格表和币种管理





	活动结束后的回佣

	无限期的订单的跟踪

	自定义销售单格式
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管理销售报价单

In OpenERP, a quotation and an order are handled in the same form (a Sales Order), but in different states. You
can consider an order to be a quotation that has evolved, because it has been confirmed by the
customer. Or, conversely, that a quotation is an order that has not been validated or cancelled yet.
Both your quotations and sales orders can be opened using the menu Sales
‣ Sales ‣ Sales Orders.

To enter details of a new quotation, you can use the menu Sales ‣
Sales ‣ Sales Orders and then select New. OpenERP opens a new window
allowing you to enter data into a new blank quotation form. You can also create a quotation directly from an opportunity, as explained in a previous chapter.


[image: ../../../_images/sale_quotation_new.png]
New Quotation



Some information is automatically specified by the system:


	an internal reference for the quotation or order,

	the sales point that the order will be delivered from,

	the order date,

	the pricelist for the current sales order.



You can modify any of that information before validating the quotation. The customer
reference is shown in the header of the order. This optional field is for the customer’s own reference –
if the customer does not supply one, just leave it empty.

You then enter all the data about the order in the Sales Order tab. Start by entering
the customer name, by selecting the correct customer from the list of customers in the system. From the quotation, you can
create a new customer on the fly if necessary – press <F1> in the empty Customer field to do that, or type the name, press the Tab key and then click Create. Indeed, when you type a name or part of a name in the Customer field, and OpenERP does not find a corresponding customer, you will see the Create button appear to allow you to directly create the customer with the name you entered.

Once the customer name has been selected, different fields of the order are completed
automatically, based on the configuration of the partner form for that customer:


	Ordering Contact : person handling the order at the customer end. By default, OpenERP
proposes the Ordering Contact at the selected partner.

	Delivery Address : address used on the delivery order. By default, OpenERP proposes
the delivery address from the partner form. If no specific delivery address is defined, the default
address will be used instead.

	Invoice Address : address used to send the invoice to the customer. By default, OpenERP
proposes the address labelled Invoice from the partner form. If no specific invoice address is defined, the default
address will be used instead.

	Pricelist : will determine both the currency of the quotation and the price that will
be used for each product.

	Payment Term : available in the Other Information tab, it shows the payment
method that the customer will follow, for example 30 Days End of Month.



You can modify any of these fields on the order as you go.

You can also set an analytic account for your order. This account will be used during invoicing
to generate accounting entries corresponding to the invoice automatically. This is extremely useful
for assigning revenues to the project or case specified by this order.


Tip

Analytic Accounts

If you are managing by task, the analytic account to be selected is the one that corresponds to
the project for the order.
The sales carried out by the order can be allocated to the project so that profitability
calculations can be made.



Once the information has been entered, you can enter data for the order lines. To do that, create a
new order line as shown in the figure Entering a New Sales Order Line.


[image: ../../../_images/sale_line_form.png]
Entering a New Sales Order Line



First of all, select the product that is to be sold to the customer. OpenERP shows some
useful information in the list of products to help you making a sales quotation:


	Real Stock : physically present in your warehouses. This value depends on the Shop (sales
point) selected in the order header. Different shops can be linked to different warehouses,
giving different stock levels, or can use the same warehouse.

	Virtual Stock : shows a salesperson the quantity that can be sold, taking into account
both stock reserved for other orders and the number of products planned to arrive in the short term.

	Public Price : the basic sales price for the given product. It provides a basis for the
salesperson to be able to judge whether to offer a discount to the customer, and how much the
discount should be.

	Pricelist : (may not be shown, depending on the installed modules) depends on the pricing conditions attached to the customer, calculated on the list price. This is the price that is proposed by default in the customer quotation, unless it has been modified by the salesperson.

	Cost Price : shows the cost price of the product. If the salesperson sells at less
than this amount, the company incurs a loss.




[image: ../../../_images/sale_product_list.png]
Selecting a Product in a Sales Order Line



Once the product to be sold to the customer has been selected, OpenERP automatically
completes all the other required fields: quantity, unit of measure, description, unit price,
discount, procurement method, lead times and applicable taxes. All of this information comes from
the product form.


Tip

Visible Discount

If a discounted price is taken from a price list, by default that figure is shown as the
sales price to the customer. He will see a discount of 0% along with the unit price that is different
from the list price.
If you install the module product_visible_discount from extra-addons,
you can configure whether you want to make the discount
explicitly visible in an order form as a percentage difference from the list price,
or just show a reduced unit price as in the default configuration.



When you enter a quotation, the selected product is presented in the language of the user so that he can see
what he is selling. The description of the product sold can also be expressed in the customer’s language.
The translation to the customer’s language is used on the quotation or order when it is printed.


[image: ../../../_images/sale_line_translation.png]
Selling a Product in a Partner Language that differs from the User Language




Note

One-off Sales

If a product is sold to a customer only once, you do not have to create a completely new
product form just for that sale.
You can manually complete all the information in the order without actually creating a product:
description, price, quantity, lead time, taxes.
In this case, OpenERP will not generate a delivery note because the a pure description is not a product, and so it is not in stock.



When all of the products are entered, you can print the quotation and send it to the customer. To do
this, click the Quotation / Order link in the Reports section to the right.
OpenERP opens the quotation in PDF to enable to you to check it before printing.


[image: ../../../_images/sale_print.png]
Printing a Sales Quotation



When the order is confirmed by the customer, you can confirm the quotation to turn in into a sales order. You can also just cancel the window without confirming the order to leave it in quotation state. To see all the current quotations, you can use the menu Sales ‣ Sales ‣ Sales Orders and click the Quotations filter button.

To follow the process for your order, you can click on the process view (indicated by a question mark) from the order form. OpenERP
shows you an interactive process view of that order. For more information about its use,
look at 流程.


[image: ../../../_images/sale_process.png]
Process View for a Sales order
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包装

Products can be managed in several packaged forms. For example, if you sell
batteries you can define the following packages for a given battery product:


	Piece: a battery,

	Blister Pack: a pack of 4 batteries,

	Pack of 100 blisters: 400 batteries,

	Palette: 40 packs for a total of 16,000 batteries.



OpenERP’s package management enables you to sell the same product in several different forms. The
salesperson could sell separately, one battery or a palette of batteries. In the order, you can
select the default packaging type as a function of the quantities ordered.

For example, if the customer wants to buy 30,000 batteries, the salesperson can select the palette package. OpenERP will then propose to sell 32,000 batteries, which corresponds to two palettes. Or the salesperson can select 75 packs.

The available packages are defined in the product form, in the Packaging tab. The first item on the
list is the one that will be used by default.

Once a package has been defined on the order, OpenERP will throw up an alert if the ordered
quantities do not correspond to the proposed packages. The quantity must be a multiple of the field
Quantity by Package defined on the packaging form.


[image: ../../../_images/sale_warning_packaging.png]
Alert on the Quantities sold compared to the Packaging



Do not confuse the management of packaging with the management of multiple units of measure. The
Unit of Measure is used to manage the stock differently according to the various units.
With packages, the stock is always managed by individual items, but information about the package to use is supplied
to the storesperson along with that item.

Even if the effects are the same, the printed documents will be different. The two following
operations have the same effect on stock movement levels, but will be printed differently
on the sales order and the packing order as where quantities are concerned:


	32,000 batteries, delivered on two palettes,

	2 palettes of batteries, with no information about packaging.



If the customer wants to order a palette and 10 packs, the salesperson can put two order
lines on the sales order using the same product with different units of measure.

It is sometimes more useful to define different products than to define several possible packages for
the same product. A case of beer in a supermarket is a good example. A case holds 24 bottles, plus
the empty case itself. The customer can buy bottles by the piece or a case of 24 bottles at one go.

You could define two packages for the Bottle of beer : PCE and case . But this
representation does not let you manage the stock and price of empty cases. So you might instead
prefer a Bill of Materials, defining and using three different products:


	the empty case for the beer,

	the bottle of beer,

	the case of 24 bottles of beer.



You also define the bill of materials below which determines the make-up of the case of 24 beers:


	Case of 24 bottles of beer: 1 unit,

	Bottle of beer: 24 units,

	Empty case of beer: 1 unit.



Each of these three products has a different price. The products Bottle of beer and Empty case of beer have a stock level that needs to be managed. The Case of 24 bottles of beer has no stock because, if you sell the product, OpenERP automatically moves the stock in two lines, one for the empty case and the other for the 24 individual bottles of beer. For more information on bills of materials,
see chapter ch-mnf.
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消息提醒

通过安装警告消息与预警管理  warning  模块，您可以为业务伙伴和产品设置警告消息。安装之后，可以在业务伙伴或产品的页面上
的 警告(Warnings) 选项卡上设置参数。

在采购和销售流程里，可以设置以下警告消息类型：


	无消息(No Message) : 不显示任何信息。

	警告(Warning) : 显示您输入的信息。

	阻止(Blocking Message) : 将抛出一个异常，并停止工作流。



可以为一系列的事件配置警告消息。相应事件激活后，就会显示您输入的警告信息。


[image: ../../../_images/warning_partner.png]
合作伙伴的警告管理



合作伙伴可设置的警告消息有:


	销售订单创建警告,

	采购订单创建警告,

	合作伙伴发货创建警告（或接收物料）,

	为合作伙伴开票创建警告.



例如：如果您为某客户开票配置一条警告消息之后，当财务人员为该客户录入发票时，就会看到一条警告消息，如图 为客户开票的警告消息 。


[image: ../../../_images/warning_sample.png]
为客户开票的警告消息




[image: ../../../_images/warning_product.png]
产品警告消息配置



产品可设置的警告消息有:


	销售产品,

	采购产品.



一个实际的例子:

Now when could you use such an alert? Suppose that your customer asks you to never make any deliveries on Tuesday morning, because the street is blocked due to a weekly market. You surely would like your transporter to be aware of this, so it could be useful to have a kind of message printed by default on each delivery order for this customer.
To do this, you could create a Warning on the Picking in the Customer form of the partner concerned, saying that no deliveries are allowed on Tuesday morning.
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发货和开票设置


订单相关参数设置

以下字段决定订单的下一步流程:


	装箱方式(Picking Policy)  : 分批交货(Partial Delivery)  或 一次性交货(Complete Delivery) ,

	Shipping Policy : Shipping & Manual Invoice, Payment Before Delivery,
Invoice on Order After Delivery, and Invoice from Delivery,



译者注：OpenERP 6.1 6.1该字段改为：Invoice Policy: Deliver & invoice on demand, Pay before delivery, Invoice on order after delivery, Invoice based on deliveries

结算方式:

先款后货——订单确认后自动生成发票，付款后自动生成发货单

手工结算——订单确认后自动生成发货单。在【销售-发票管理-基于销售订单行】菜单，可以看到待开发票的订单行列表

发货完成后开票收款——订单确认后自动生成发货单，发货完成后手工创建发票 （这个逻辑很奇怪，需要读一下代码看看。如果发货数量和订单不一致，发票上单价会变）

按发货单开发票 ——订单确认后自动生成发货单。在【销售-发票管理-待开票的发货单】菜单，可以看到待开发票的发货单


	开票基于(Invoice on)  : 已订数量(Ordered Quantities)  或 已发数量(Shipped Quantities) .





Tip

配置界面

如果您在 简化界面 下工作，只能看到销售订单的装箱方式 Shipping Policy 字段。
可以通过配置向导配置界面为 扩展 ，或把当前用户添加到组 可用性－扩展视图 ，就可以切换到“扩展”视图模式。
您也可以点击 首选项 选择并切换试图。









装箱方式

The picking mode determines the way the storesperson will do the picking. If the order is put
into Partial Delivery mode, the picking order will appear in the list of things for the
storesperson to do as soon as any of the products on the order is available. To get the list of
items to be done, you can use the menu Warehouse ‣ Outgoing Deliveries.
By default, the Available filter button is selected, so you immediately see the list of available pickings.

仓库管理员可以根据送货的实际数量进行部分发货.然后后续可以在备货完成的情况下继续发货操作.

If the picking mode is Complete Delivery, the picking order will not appear in the list of
pickings to do until all of the products are available in stock. This way, there will only be a
single delivery for any such order.

只要仓库管理员愿意, 每个发货单的发货方式都可以修改. 甚至在订单被确认后都还可以继续修改.

本例开票方式是 来自订单 , 产品的成本可以根据多次交付而多次调整.但是这样带来的结果是,处理多次收货较单次
收货的风险成本增加.If invoicing is done from the order, the customer will only be invoiced
once for the whole delivery, even if the delivery of several items has already been made.
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运输管理

为了在OpenERP中管理送货，需要安装 delivery 模块。
使用  Reconfigure  重新配置向导然后选择  Sales Application Configuration 销售配置下的  Delivery Costs 发货安装。

本模块功能：


	管理物流公司

	管理运输方式

	发货成本计算及开票

	运输方式及相关税率（译注：通过产品设置）



安装 delivery 模块后，首先要设置送货方式。菜单“仓库->设置->送货 ->送货方式“

对于每种送货方式，您需要定义以下内容：


	送货方式的名称

	物流公司（可以是您的公司）

	送货产品（服务型产品）



举例如下：


送货模式举例






	运送方式
	物流公司
	送货产品（服务型产品）




	Express Track
	Mail Office
	Express Track Delivery


	Priority Courier
	Mail Office
	Courier Express Delivery


	EFG Standard
	EFG Inc
	Delivery EFG


	EFG Express
	EFG Inc
	Delivery EFG Express





在送货方式链接的产品上输入运输开票的信息（例如帐户、适用税）。理论上，这个 Product Type 产品类型设置为服务型，Procurement Method 供应方式设置为“按库存生产”。

您可以在几种送货方式中使用相同的产品。这将简化配置，但其缺点是您不能按发货模式区分销售数据。


送货价格表

与普通产品不同，运费不是通过价格表（pricelists）计算，而是通过专为此设计的运费表计算。 对于每种送货方式，您可以输入一个或几个资费表。每一个资费表用于一个给定区域或目的地。

例如，对于邮费，您通常可以定义三种资费：


	国内邮费,

	欧洲邮费,

	其他地区邮费.



使用菜单“仓库-> 设置->送货货->送货价格表”定义一个新的送货价格表。为您的运费表取一个名字，在第选项卡“目标库位”定义价格表格适用的范围。在这里您可以设置：


	国家列表（例如，英国或欧洲）

	地区列表

	邮政编码范围（对于巴黎，邮政编码范围是75000-75900）



您必须在选项卡“网络定义”中设置运费计算规则。首先，规则必须有一个名称。然后，为这个规则设置条件，例如，重量<0.5kg。


Note

重量

重量用千克表示。您可以为数字定义小数位，这样，您在重量规则中录入0.5来设置500g



接着，您可以设置销售价格和成本价格。价格可以用不同方式表示：


	固定价格,

	可变价格 按照重量、体积 或者 重量×体积计算.



例如，在法国用当前的资费邮递，可以使用以下表格


资费规则







	名称
	条件
	价格
	价格类型




	S
	重量 < 3 kg
	6.90
	固定价格


	M
	重量 < 5 kg
	7.82
	固定价格


	L
	重量 < 6 kg
	8.53
	固定价格


	XL
	重量 < 7 kg
	9.87
	固定价格





您也可以按照订单金额上定义规则。例如，对于订单总金额大于150美元使用固定运费的情况，增加以下规则：


特殊资费规则







	名称
	条件
	价格
	价格类型




	Franked > 150 USD
	Price > 150 USD
	10
	固定价格








交货方式

一旦定义好送货方式及其相关税，您就可以在销售订单中使用它们。在OpenERP的销售订单中，送货有两种方法：


	基于订单数量交付

	基于发货数量交付






基于订单数量交付

为了在报价单上增加运费，请点击销售订单页上的  Delivery Costs “送货成本”按钮。打开一个对话框，要求您选择一个预先设定的可用送货模式。


[image: ../../../_images/sale_delivery.png]
在销售订单上增加运费



选择了送货方式之后，OpenERP 会在订单（草稿状态）上增加一行运费。这个方法使您能够基于订单计算运费，以及产品的物流运输方法。

如果您想根据实际的发生的运费开票，就必须使用“基于发货数量交付”的开票方法。




基于发货数量交付

为已发货的产品开具运费发票，在销售订单中的“其他信息”-> “送货方式”设置。不需要在销售订单中增加运费，这样可以把运费添加到发票中。

为了这个功能正常工作，您的订单必须设置结算方式为“按发货单开发票”。然后确认订单，并确认交货。

当销售管理者按照已执行的发货方式生成销售发票是，OpenERP自动在每张销售发票上增加相应的运费，运费的计算基于实际发生的费用。
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明明白白利润点

对于每一个公司, 保持一个清晰的景象和 a good control of margins is crucial. 即使你有一个很好的销售层次, it will not guarantee company profitability if margins are not high enough. OpenERP provides a number of methods allowing you to monitor your sales margins. The main ones are:


	每笔销售利润,

	每产品利润,

	每项目利润,

	价格表的亮点.




每笔销售单据的利润

If you want to check your margins on sales orders, you can install the sale_margin module
by selecting Margins in Sales Orders for installation in the Reconfigure wizard.
This will add margins calculated on each order line and on the order total.


[image: ../../../_images/sale_margin.png]
An order with the module sale_margin



The margin on each line is defined as the quantity sold multiplied by the sales price for the
customer less the cost price of the products. By default, products are managed using standard price
in OpenERP (cost price fixed manually and reviewed once per year). You can change that to
Average Price, meaning that the product cost fluctuates with purchases from
suppliers. After product receipt you can include fixed costs, such as delivery costs, in the cost of
each product.

OpenERP supports a third method of updating the cost price of products.
This is through the button Update on the product form which lets you
automatically recalculate the cost price for the selected product.
The cost price is calculated from the raw materials and the operations carried out
(if the products have been manufactured internally, so that you have set their costs).




每种产品的利润

To track margins by product, install the module product_margin. Once the module
is installed you can see the margins by product by using the menu Sales ‣ Products
‣ Product Margins.

When you have clicked the menu option concerned, OpenERP asks for an analysis period and the state of invoices (draft, open, paid). If
no period is given, OpenERP will calculate margins on all of the operations without restriction. By
default, however, OpenERP proposes a period of the last 12 months for analysis.

你还能按指定类型的发票来进行过滤分析:


	所有发票(含草稿状态的发票),

	所有生效或者已支付发票,

	仅统计已支付发票.




[image: ../../../_images/product_margin_tree.png]
产品利润



您可以得到一个详细的利润分析数据, 下面列出了显示每种产品销售的可分析统计的字段:


	Avg. Unit Price: 销售平均价,

	Catalog Price: 产品标准售价,

	# Invoiced: 已开发票的销售产品数量汇总,

	Sales Gap: the difference between the revenue calculated from list price and volume, and the actual sales,

	Turnover: 销售收入,

	Expected Sale: 销售额,




[image: ../../../_images/product_margin_form.png]
指定产品的利润明细



The following fields are given by product for purchases:


	Avg. Unit price : 采购平均价,

	Standard price : 产品成本价,

	# Invoiced : 采购汇总数量,

	Purchase Gap: the difference between the total actual cost and the standard cost
multiplied by the number of units purchased,

	Total Cost: 采购成本汇总,

	Normal Cost: 销售成本汇总.



The following fields are given by product for margins:


	Total Margin,

	Expected Margin,

	Total Margin in percent,

	Expected Margin in percent.






每个项目的利润

To manage margins by project, you should install the analytical accounts with management by task. The use
of these accounts is described in 辅助核算.

Install the module account_analytic_analysis and all of its dependencies.
This module adds a tab on the analytic account form to handle the different margins in an analytic account
representing a project or a case, and several new reports on those accounts.


[image: ../../../_images/account_analytic_analysis_form.png]
Detail of margins for a case



Start by opening a project’s analytic account through
Project ‣ Billing ‣ Overpassed Accounts
and selecting one of them.
In the form’s Analysis summary tab you will find the following information:


	The total costs for the analytic account,

	The total amount of invoiced sales,

	The number of hours worked,

	The number of hours remaining to be worked,

	The remaining income,

	The theoretical income (hours worked multiplied by their sale price),

	The number of hours invoiced,

	The real income per hour,

	The real margin,

	The theoretical margin taking into account everything yet to be invoiced,

	The real margin rate in percent,

	The last invoicing date,

	The last worked hours,

	The number of hours remaining to be invoiced,

	The amount remaining to be invoiced.



For detailed information on the analytic account you can use any of the several reports available in
the toolbar to the right.
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灵活的价格体系

Some companies are notorious for their complicated pricelists. Many forms of price variation are
used, such as end-of-year refunds, discounts, change of terms and conditions with time, various
prepayments, cascaded rebates, seasonal promotions, and progressive price reductions.


Note

Rebate, Refund, Reduction

In some accounting jurisdictions you have to differentiate between the three following terms:


	Rebate: reimbursement to the client, usually at the end of the year, that depends on the
quantity of goods purchased over a period.

	Refund: reduction on the order line or invoice line if a certain quantity of goods is purchased
at one time or is sold in a framework of a promotional activity.

	Reduction: a one-off reduction resulting from a quality defect or a variation in a product’s
conformance to a specification.





Intelligent price management is difficult, because it requires you to integrate several conditions
from clients and suppliers to create estimates quickly or to invoice automatically. But if you have
an efficient price management mechanism you can often keep margins raised and respond quickly to
changes in market conditions. A good price management system gives you scope for varying any and all
of the relevant factors when you are negotiating a contract.

To help you work most effectively, OpenERP’s pricelist principles are extremely powerful yet are
based on simple and generic rules. You can develop both sales pricelists and purchase pricelists for
products capable of accommodating conditions such as the date period, the quantity requested and the
type of product.


Tip

Do not confuse the Different Price Specifications

Do not confuse the sales price with the basic price of the product.
In OpenERP’s basic configuration, the sales price is the list price specified in the product form,
but a customer can have a different sales price depending on the conditions.

The same applies to the purchase price and standard cost. Purchase price is your suppliers’ selling price,
which changes in response to different criteria such as quantities, dates, and supplier. This is
automatically set by the accounting system.
You will find that the two prices have been set by default to the same for all products with the demonstration data,
which can be a source of confusion.
You are free to set the standard cost to something different.



Each pricelist is calculated from defined policies, so you will have as many sales pricelists as
active sales policies in the company. For example, a company that sells products through three sales
channels could create the following price lists:



	Main distribution:



	pricelist for Walbury,

	pricelist for TesMart,








	Postal Sales.



	Walk-in customers.








A single pricelist can exist in several versions, only one of which is permitted to be active at a
given time. These versions let you set different prices at different points in time. So the
pricelist for walk-in customers could have five different versions, for example: Autumn,
Summer, Summer Sales, Winter, Spring. Direct customers will see prices
that change with the seasons.

Each pricelist is expressed in a single currency. If your company sells products in several
currencies, you will have to create as many pricelists as you have currencies.

The prices on a pricelist can depend on another list, which means that you do not have to repeat the
definition of all conditions for each product. So a pricelist in USD can be based on a pricelist in
EUR. If the currency conversion rates between EUR and USD change, or the EUR prices change, the USD
rates can be automatically adjusted.


创建价格表

You can define a pricelist from the menu Sales ‣ Configuration ‣ Pricelists ‣ Pricelists.

For each list you should define:


	a Name for the list,

	a Type of list: Sale for customers or Purchase for suppliers,

	the Currency in which the prices are expressed.




价格表版本

Once the pricelist is defined you have to link at least one version. You can create a new version directly from the pricelist or from the
Sales ‣ Configuration ‣ Pricelists ‣ Pricelist Versions menu. The version contains all of the
rules that enable you to calculate a price for a product and a given quantity.

Start by setting the Name of this associated version. If the list only has a single version, you
can use the same name for the pricelist and the version. In the Price List field, select
the pricelist you created (this is not necessary if you create the version directly from the pricelist).

Then set the Start Date and End Date of this version. The fields are both
optional: if you do not set any dates the version will be permanently active. Only one version
may be active at any one point, so bear this in mind when creating them.
Use the Active field in the versions to activate or disable a pricelist version.


Note

Automatically Updating the Sales Pricelist

Any sales pricelist can be set to depend on one of the other pricelists.
So you could create your sales pricelist based on the supplier’s purchase pricelist, to
which you add a margin.
The prices are automatically calculated as a function of the purchase price and need no further
manual adjustment.






定价规则

A pricelist version is made up of a set of rules that apply to the basic product prices.


[image: ../../../_images/service_pricelist_line.png]
Rule in a Pricelist Version



You define the conditions for a rule in the first part of the screen labelled Rules Test
Match. The rule applies to the Product or Product Template and/or the named Product
Category. If a rule is applied to a category, then it is automatically applied to all of its
subcategories too (using the tree structure for product categories).

If you set a minimum quantity in Min. Quantity, the rule will only apply to a quantity equal to or larger than the quantity set. This way, you can define reduced rates in steps according to the quantities ordered.

Several rules can be applied to an order. OpenERP evaluates these rules by sequence number, to determine
which rule(s) to apply to the specified price calculation. If several rules are valid, only the first in
sequence is used for the calculation. The Sequence field determines the order, starting with the
lowest number and working up.

Once a rule has been selected, the system has to determine how to calculate the price from the rule.
This operation is based on the criteria set out in the lower part of the form, labelled Price
Computation.

The first field to complete is Based on. Set the way in which the partner price will be calculated, choosing between:


	the Public Price set in the product file,

	the Cost Price set in the product file,

	an Other Pricelist given in the field If Other Pricelist,

	the price that varies as a function of a supplier defined in the Partner section of the
product form.



Several other criteria can be considered and added to the list, as you will see in the following
section.

Next, various operations can be applied to the basic price to calculate the sales or purchase price
for the partner, according to the specified quantities. To calculate it, you apply the formula shown on the
form: Price = Base Price x (1 + Field1) + Field2 .

The first field, Field1, defines a discount or a supplement. Set it to -0.20 for a discount of 20% from
the basic price. If your price is based on standard cost, you can set 0.15 to get a 15% price uplift
compared to the standard costs.

Field2 sets a fixed supplement to the price, expressed in the currency of the pricelist.
This amount is just added (or subtracted, if negative) to the amount calculated with the
Field1 discount.

Then you can specify a rounding method. The rounding calculation is carried out to the nearest
number. For example if you set 0.05 in this example, a price of 45.66 will be rounded to 45.65, and
14,567 rounded to 100 will give a price of 14,600.


Note

Swiss Special Situation

In Switzerland, the smallest monetary unit is 5 cents.
There are not any 1 or 2 cent coins.
So you set OpenERP’s rounding to 0.05 to round everything in a Swiss franc pricelist.



The supplement from Field2 is applied before the rounding calculation, which enables
some interesting effects. For example, if you want all your prices to end in 9.99, set your rounding
to 10 and your supplement to -0.01 in Field2.

Minimum and Maximum margins enable you to guarantee a given margin over the base price. A margin of
10 USD enables you to stop the discount from returning less than that margin. If you put 0 into this
field, no effect is taken into account.

Once the pricelist is defined, you can assign it to a partner. Go to the Partner form and select
its Sales & Purchases tab. You can then change the Purchase Pricelist and the
Sale Pricelist that is loaded by default for the partner.




小数精度

There are several configuration settings related to the decimal accuracy of
prices, or the number of decimal places to hold with each price field. To change
the accuracy of a field, follow these steps:


	Make sure you have the Extended user interface. The setting is in your user
preferences.

	Go to Administration ‣ Customization ‣ Database Structure ‣
Decimal Accuracy. This list contains a number of predefined elements.

	Open the entry you want to change. Purchase Price and Sale Price are the
most common ones related to prices, but some fields are controlled by the
Account entry.

	Type a new value in the digits field, and save the entry. Do not change the description in the
Usage field, or it will stop working.

	Close the screen where you were editing prices and reopen it. The price field
should now have the number of digits you asked for.








价格表应用示例

Take the case of an IT systems trading company, for which the following product categories have
been configured:

所有产品



	配件



	打印机

	扫描仪

	键鼠与耳麦








	电脑



	笔记本





	一体机







	台式电脑





	办公用台式机

	专业台式机
















In addition, the products presented in the table below are defined in the currency of the installed
chart of accounts.

表格


Examples of products with their different prices








	产品
	销售价
	成本价
	采购价
	


	Acclo 笔记本
	1,200
	887
	893
	


	Toshibishi 笔记本
	1,340
	920
	920
	


	Berrel 键盘
	100
	50
	50
	


	办公台式机
	1,400
	1,000
	1,000
	






默认价格表


[image: ../../../_images/product_pricelist_default.png]
OpenERP 默认的价格表



When you install the software, two pricelists are created by default: one for sales and one for
purchases. Each of them contains only one pricelist version and only one line in that version.

The price for sales defined in the Default Public Pricelist is set by default to
the Public Price of the product, which is the Sales Price in the Product form.

The price for purchases defined in the Default Purchase Pricelist is set by default in the same way to
the Cost Price of the product.




商贸类公司

Take the case of a trading company, where the sales price for resellers can be defined like this:


	For portable computers, the sale price is calculated from the list price of the supplier Acclo,
with a supplement of 23% on the cost of purchase.



	For all other products the sales price is given by the standard cost in the product file, to which
31% is added. The price should end in .99 .



	The sales price of Berrel keyboards is fixed at 60 for a minimum quantity of 5 keyboards purchased.
Otherwise it uses the rule above.



	Assume that the Acclo pricelist is defined in OpenERP. The pricelist for resellers and the
pricelist version then contains three lines:



	Acclo line:



	Product Category : Portables ,

	Based on : Other pricelist ,

	Pricelist if other : Acclo pricelist ,

	Field1 : 0.23 ,

	Priority : 1 .








	Berrel Keyboard line:



	Product Template : Berrel Keyboard ,

	Min. Quantity : 5 ,

	Field1 : 1.0 ,

	Field2 : 60 ,

	Priority : 2 .








	Other products line:



	Based on: Standard Price ,

	Field1 : 0.31 ,

	Field2 : -0.01 ,

	Rounding : 1.0 .

	Priority :  3.

















It is important that the priority of the second rule is set below the priority of the third in this
example. If it were the other way around, the third rule would always be applied, because a quantity of
5 is always greater than a quantity of 1 for all products.

Also note that to fix a price of 60 for the 5 Berrel Keyboards, the formula Price = Base Price x
(1 + 1.0) + 60  has been used.




建立客户合同条件

The trading company can now set specific conditions to a customer, such as the company TinAtwo, who
might have signed a valid contract with the following conditions:


	For Toshibishi portables, TinAtwo benefits from a discount of 5% of resale price.

	For all other products, the resale conditions are unchanged.



The sales price for TinAtwo, called TinAtwo contract, contains two rules:



	Toshibishi portable :



	Product : Toshibishi Portable ,

	Based on : Other pricelist ,

	Pricelist if other : Reseller pricelist ,

	Field1 : 0.05 ,

	Priority : 1 .








	Other Products:



	Product :

	Based on : Other pricelist ,

	Pricelist if other : Reseller pricelist ,

	Priority : 2 .













Once this list has been entered, you should look up the partner form of TinAtwo again. Click the
Sales & Purchases tab to set the Sale Pricelist field to TinAtwo Contract. If
the contract is only valid for one year, do not forget to set the Start Date and
End Date fields in the Pricelist Version.

Then when salespeople prepare an estimate for TinAtwo, the prices proposed will automatically be
calculated from the contract conditions.






价格表和币种管理

If your trading company wants to start a product catalog in a new currency you can handle this
several ways:


	Enter the prices in a new independent pricelist and maintain the lists in the two currencies
separately,

	Create a field in the product form for this new currency and make the new pricelist depend on this
field: prices are then maintained separately, but in the product file,

	Create a new pricelist for the second currency and make it depend on another pricelist or on the
product price: the conversion between the currencies will then be done automatically at the
prevailing currency conversion rate.
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活动结束后的回佣

If you want to provide discounts on an order, you can use the pricelist system in OpenERP. But we would not be writing about end-of-campaign rebates if no other solution was available. You can also work with end-of-campaign rebates or year-end rebates. The customer pays a certain price during the whole of the campaign or the year, and he will receive a rebate at the end of the campaign according to the sales made throughout the year.

Take the case of contract negotiations with a wholesaler. To get the best selling price, the
wholesaler will ask you for a good deal and will sign up to a certain volume of orders over
the year.

You can then propose a price based on the volume that the wholesaler agrees to sell. But then you
do not have any control over his orders. If at the end of the year the wholesaler has not taken the
agreed volumes, you can do nothing. At most you can review his terms for the following year.

Rebates at the end of a campaign can help you avoid this sort of problem. You can propose a contract
where the price depends on the usual wholesaler’s terms. You can propose a rebate grid which
will be assigned at the end of the year as a function of the actual sales made.

Install the discount_campaign module (in extra-addons at the time of writing)
to generate rebates at the end of the campaign. Once the modules have been installed, you can configure your campaign using the menu Sales ‣ Configuration ‣ Sales ‣ Discount Campaigns.


Note

Year-end Rebate

Most companies use the term year-end rebate, where rebates are applied at the end of the year.
But of course you can also define rebates for a campaign that lasts less than or more than one year.




[image: ../../../_images/discount_campaign_RFA.png]
Configuring a Campaign Rebate



A campaign should have a name, a refund journal (to create the credit notes at the end of the campaign), a start date, and an end date. After entering this information, you should describe the lines of the campaign. Each line can be applied to a product or a category of
products. Then set the quantity of products sold from which the discount is applied, and the amount
of the rebate as a percentage of the actual sales volume.

When you have defined the campaign, you can activate it by clicking the Open button. The
figure Configuring a Discount Campaign for Computers shows a campaign with a rebate on computers which is between 10% and 20% depending on
the sales volume.


[image: ../../../_images/discount_campaign.png]
Configuring a Discount Campaign for Computers



Once the campaign has been defined and activated, you can assign it to various partners. To do that
set a Discount Campaign in the second tab Sales & Purchases of the partner form.

Finally, at the end of the campaign, you should close it and OpenERP will automatically generate
invoices or credit notes for your partner associated with this campaign. OpenERP opens credit
notes in the Draft state so you can modify them before validation. To calculate the amount on the
credit note, OpenERP uses all of the invoices sent out during the period of the campaign as a
basis.

You can also get an overview of all draft credit notes using the menu Accounting
‣ Customers ‣ Customer Refunds.
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无限期的订单的跟踪

In some industries, customers commonly place orders for a certain volume of products and ask for regular
deliveries from an order up to the total amount on it. This principle, called open orders, is managed
by the sale_delivery module in OpenERP.

OpenERP handles open orders easily. An open order is an order for a
certain quantity of products but whose deliveries are planned for various dates over a period of
time.

To do that, you should install the sale_delivery module (in extra-addons at the time of writing).
A Sales Order is entered as a normal order, but you also set the total quantity that will be delivered on each order line.

Then you can use the new tab Deliveries on the order to plan the quantities sold and enter your
delivery planning there.


[image: ../../../_images/sale_delivery_form.png]
Managing Open Orders, Planning Forecasts



In the order lines, OpenERP shows you the quantity planned in addition to the quantity sold. This way, you
can verify whether the quantities sold equal the quantities to be delivered. On confirmation of the sales order, OpenERP no longer generates a single delivery order, but plans scheduled dispatches.


Tip

Invoicing Mode

If you work with Open Orders, you should set Invoice Control to the mode Shipped Quantities.
Then the storesperson will be able to re-plan and change the quantities of the forecast deliveries
in the system.
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自定义销售单格式

安装模块 sale_layout 后, 选择 自定义销售单格式(Sale Order Layout Improvement) 并点击 重配置(Reconfigure) 向导.
本模块可以提供比标准订单更灵活的功能.

例如, 你可以使用下面这些展现订单行:


	水平分隔线,

	标题与子标题,

	行小结,

	批注,

	分页符.



本模块可以让你设计出复杂,强大,专业的报价单. 模块 account_invoice_layout (安装 sale_layout 时会自动安装) 则类似
是设计调整发票样式的, 功能与本模块类似.

下面两张图 自定义的发票打印模板 与 最终打印输出效果 展示了发票模板与该模板最终打印结果.


[image: ../../../_images/invoice_layout_form.png]
自定义的发票打印模板




[image: ../../../_images/invoice_layout_print.png]
最终打印输出效果
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驱动采购


在前面的章节中，你已经了解了在OpenERP如何使用客户发票和送货单。这章是关于采购管理，之前的处理两个操作。你可以学习到OpenERP如何处理和简化它，以及如何管控从供应商采购。


这章你可以继续使用已经创建好的数据库，当然你也可以创建一个全新的包含演示数据的数据库，安装 purchase 以及它的依赖模块，不需要配置特别的会计科目表。



	完备的采购工作流程
	设置数据库

	从供应商询价

	收货

	开发票管理

	基于订单

	基于收/发货

	招标

	价格版本
	标准价格

	平均价格









	通过辅助核算项进行采购分析
	强大的统计

	每个企业自己的辅助核算科目表
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完备的采购工作流程

供应商或者采购订单，让你管理价格谈判，管理采购发票，处理货物收据并同步这些内容。

让我们一起看看下面的订单流程：


	向供应商询价，

	确认采购，

	收货和产品管理，

	发票管理。




设置数据库

要配置一个新的系统使用这些例子，先创建一个有示例数据的数据库，用 admin 登录系统，选择 Extended 。
输入您公司的信息，或者您愿意的化也可以用默认的内容。

然后使用配置向导，在 Install Applications 中，选择 Purchase Management 安装 purchase 采购模块，
同时会安装几个依赖模块。在这章的其他部分都用*admin*登录




从供应商询价

选择菜单 采购(Purchases) ‣ 采购管理(Purchase Management) ‣ 采购询价(Request for Quotation) ，
输入一个新的询价（例如,request for quotation）。点击 新建(New) ，OpenERP打开一个空的询价表单，
用来输入从供应商询到的价格。如图所示 采购订单的数据入口 。如果询价是OpenERP自动处理，
您可以看到一个引用文档，在询价的 Origin 字段。


[image: ../../../_images/purchase_form.png]
采购订单的数据入口




Note

警告管理



如果您安装了 warning 模块，你可以定义警告，当采购员输入一个价格请求的时候，警告将显现出来。
您可以为产品或者供应商设置警告。

默认情况下, 采购日期,仓库以及产品的交货期会自动生成,当然,如果需要的话这些值你也可以更改. 接着选定供应商后,
供应商默认的收货人(或者默认的联系人)以及同该供应商达成的采购价格表(采购协议)也会自动带出,


Tip

供应商

如果你发现在系统找不到你录入的供应合作伙伴,那你就需要确认在录入合作伙伴的时候,是否已经将 供应商 的勾选项勾上了. 如果忘记了,请到合作伙伴列表中找到它,并勾选上.



采购订单主体部分输入完成后,就可以录入采购订单明细行了.


[image: ../../../_images/purchase_line_form.png]
采购订单明细行



当你选择了产品后, OpenERP 会自动填充其它字段:


	单位, 默认与对应产品的对应的 采购单位,

	描述, 按供应商语言翻译的产品描述,

	采购日期, 按对应产品定义的供应商的提前供货周期计算出的计划采购执行日期,

	单价, 来自系统定义的供应商价格表,

	税, 从产品与供应商定义中得出的应缴纳的各种税, 还取决于 Financial Analysis 中定义的各种规则.




Tip

产品命名及多形式编码

当你选择了供应商后, 系统还能将你录入的产品及产品编码替换为你单独为这个供应商指定的 供应商的产品名称以及供应商的产品代码.



如果你想按项目来管理采购成本, 你可以使用辅助核算科目来完成, 所有项目的采购成本是基于该项目的供应商发票而核算出来的成本.


Tip

按项目核算成本

辅助核算在多公司的各种维度的成本核算上面发挥了相当重要的作用.
为了让辅助核算能处理多维度, 你需要安装模块 purchase_analytic_plans, 并点击 配置(Configure) 中的 重新配置(Reconfigure)
向导, 选中 采购辅助核算方案(Purchase Analytic Plans).



安装了模块 account_analytic_default (你安装模块 purchase_analytic_plans 的同时会自动安装这个模块) 后, 你就可以根据 合作伙伴
日期 产品`以及`登陆用户 创建多种辅助科目默认值的规则,而自动选择匹配的默认核算科目.

在采购订单明细里添加产品时你可以添加一个 备注(Notes) , 这个备注会在订单确认及询价函中附加传递给供应商.
而且这个备注也可以放在产品定义窗体中, 以便每次选择该产品时自动带出. 如: 你可以输入类似”Do not forget to send
by express delivery as specified in our contract reference 1234.”

订单制单完成后, 你可以将其打印做为询价函发送给供应商. 你还可以在单据第三页签添加一些供应商的备注信息.
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打印采购询价函



当询价函得到供应商的反馈后, 要将询价 转为订单 或者 取消 该询价,只需要点击菜单 采购(Purchase) ‣ 采购管理(Purchase Management) ‣ 询价单(Request for Quotation) 后,
进入相关单据点击相应的操作按钮即可.

当确认该询价订单时,只需要点 转换为采购订单, 这里询价单的价格就被确认,后续采购流程再也不能更改.


[image: ../../../_images/purchase_process.png]
采购订单处理流程






收货

当采购订单确认后, OpenERP 会自动生成准备状态的收货单, 要看有哪些产品是准备收货状态,进菜单 仓库(Warehouse) ‣ 仓库管理(Warehouse Management) ‣ 收货(Incoming Shipments) .


Tip

服务类型产品的采购

如果你向供应商采购服务类型的产品, OpenERP 不会生成相应的收货单, 在OpenERP中,服务类型的产品是没有收货操作的.



收货时通常根据订单编号或者供应商名称进行筛选,然后选择适合的收货条目进行收货产生相应的供应商收货凭据.

正如 仓库 所讲, 在OpenERP中, 采购订单部分收货流程也相当棒.收一次货后会自动创建余下的收货明细,当你觉得可
以不用收余下的货品时,你可以随时取消.

收货操作后, 会跳转到采购订单列表页中, 在这个列表里,你可以清楚地了解到每个订单的收货情况及发票开具情况.
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采购订单列表及收货,发票进度






开发票管理

采购发票的开票控制在OpenERP中可以有三种情形,而且可以每次采购使用不同的开票方式:


	基于订单 : 当订单确认时,就开据采购发票(挂应付款项),

	基于收货 : 只在收货的时候开具采购发票,

	手工开票 : 由人工控制什么时候开采购发票挂应收账.



发票开票方式在采购单的第二个页签的 开票方式(Invoicing Control) 字段来选择.
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采购订单 与 发票开票




Tip

默认值

因为大多数公司的发票开票控制(什么时候开具采购收据)基本上是不会变动的. 所以,你可以在模块安装完成时就在 开票方式(Invoicing Control)
里选择适当的值做为默认值.然后采购开票时,就会自动使用该默认值.






基于订单

如果你的开票方式选择了 基于订单(Base on Order) , 确认采购订单时, OpenERP 会自动产生相应的供应商发票. 点击菜单
会计(Accounting) ‣ 供应商(Suppliers) ‣ 供应商发票(Supplier Invoices) 打开列表后, 点击 草稿(Draft)
过滤,可以看到所有的 草稿(Draft) 状态的供应商发票.

当你从供应商处收到真实供应商发票时,你就可以同系统中生成的发票进行核对数量与价格, 然后在系统中确认这些发票,这时
OpenERP会自动处理发票相关的采购成本会计凭证分录.

同时, 相应的采购订单的发票状态也会显示为 已支付(Paid).

基于订单的开票方式一般用于服务类供应商,因为服务行业的开据的发票金额与订单的金额通常是一致的. 而大多数情况下
一般企业都通常采用基于收/发货单的开票方式.




基于收/发货

要在收货时才给供应商开据供应商发票的话, 需要在采购订单的第二个页签 开票方式(Invoicing Control) 字段处选择 来自收/发货.

在基于收/发货的开票方式时, 采购订单确认后,是不会生成任何的发票, 仅在收/发货单的 开票方式(Invoice Control) 处显示为 发票待开(To Be Invoiced) .

仓库管理员此时可以收/发货订单处理. 并且点单据 创建发票(Create Invoice) 按钮即可创建收货对应的草稿状态的供应商/客户发票.
此时,你可以再次核对该草稿发票数据, 并选择一个适当的 帐簿(Journal) 并确认该笔或多笔收/发货产生的发票.

这种方式特别适合大部分供应商的货物与发票并不是同时送达的情况. 通常情况下, 发票总是迟于货物好几天送达. 在本范例中, 仓库管理员
并不在收到货物时生成发票. 而是由会计每天或者每周统一将近期的收/发货生成草稿发票. 点击菜单 采购(Purchase) ‣ 发票控制(Invoice Control) ‣ 待开发票明细(Purchase Lines Not Invoiced)
并点击 创建发票(Create invoices) 可以将列表中未开发票的收/发货生成草稿发票.

在这个时候, 会计可以决定是按收/发货明细产生多张发票或者按合作伙伴汇到一张发票上.

基于收/发货 的发票处理与 基于订单 的发票处理流程类似. 一但相应财务人员收到发票,只需要将发票与系统内生成的该供应
商发票进行比对.比对正确无误后在系统中确认该发票即可.


Tip

相关物流费用

要管理物流运输费用, 你需要安装 delivery 模块, 并在 配置(Reconfigure) 向导中 销售配置(Sale Application Configuration) 选择 运输成本(Delivery Costs.
安装完毕后, 在产品收/发货或者订单确认时产生的发票中, 会自动添加上相关的运输物流费用.






招标

招标管理,你要安装 purchase_requisition 模块, 并在安装模块后的 配置(Reconfigure) 向导里选择
采购申请(Purchase Requistion).
这样你就可以向多个供应商发出询价,从其中选择一个. 模块安装后, 请求菜单项为: 采购(Purchase) ‣ 采购管理(Purchase management) ‣ 采购询价(Purchase Requisitions).
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定义一个投标方



点击菜单 采购(Purchase) ‣ 采购管理(Purchase Management) ‣ 采购询价(Purchase Requisitions) 并 新建(New) 一个询价单.
在新的询价单里, 你可以填写各个投标供应商的相关信息.

当你的询价函有供应商回复时, 你可以将该供应商的回复在 询价(Quotation) 页签中新建采购单. 同时,
你在同供应商的价格谈判期间, 都可以随时调出对应的草稿状态的采购订单进行价格调整.

当你的询价单类型选择的是 单独 竞标模式时, 你确认任何一家竞标方的定单后, 其他供应商的报价会自动取消. 当然, 如果你选择的是
多家竞标模式, 你确认时,其他供应商的报价是不会被自动取消的.




价格版本

OpenERP有多种方法计算更新产品成本:


	标准价格(Standard Price): 手工更新产品标准价,

	标准价格(Standard Price): 定期自动更新产品标准价,

	平均价(Average Price): 每次收货时更新产品标准价.



产品成本价表示你库存产品的价值. 影响库存产品成本有很多因素, 大致包含有下面的几部分:


	采购价格,

	运送费用,

	制造成本,

	仓储费用.




标准价格

产品的标准价格可以在产品窗体的 其他信息(Information) 中看到, 每个产品的标准价可以单独设置.并且你可以在 标准价格
与 平均价格 间做出适当的选择.


Tip

简化界面

在简化界面时,你可能在产品页找不到更改产品成本计算方法的字段. 在本例中, 默认值是 标准成本价.



标准价格 的成本计算方式需要为每个产品单独设置 成本价. 通常都是每年根据采购平均成本或者制造平均成本来更新一次.

如果产品的价格在一年中的变化幅度不大时, 通常使用标准价的成本计价法. 如书籍,面包这类的产品, 通常就使用标准计价法.

你可以每个财年进行一次产品成本调整, 这样做的好处如下:


	你可以按产品的成本价来指导制定销售价, 这样每个产品就基本上可以保证一个比较固定的利润率.

	accounting is simplified because there is a direct relationship between the value of stock and the
number of items received.



To get an automated periodic revaluation of the standard price you can use the action Update
on the product form, enabling you to update prices of all the selected products.
OpenERP then recalculates the price of the products as a function of the cost of raw materials and the
manufacturing operations given in the routing.




平均价格

Working with standard prices does not lend itself well to the management of the cost price of products
when the prices change a lot with the state of the market. This is the case for many commodities and
energy.

在本例中, OpenERP 会自动将求出仓库中该产品的所有的收货单的平均价格做为该产品的成本价. 发货单(出库类)则不会参与计算,
不影响产品成本.


Tip

成本价计算

每次收货, 都会引发产品成本价的重新计算 计算公式如下:
NP = (OP * QS + PP * QR) / (QS + QR), 各缩写意义为:


	NP: 更新后的最新成本,

	OP: 原成本价,

	QS: 现库存数量,

	PP: 本次收货的产品的支付价,

	QR: 本次收货数量.





如果你的产品使用的是加权平均成本计算法,OpenERP 则会在产品收货时弹出窗体让你指定该批次产品的成本价. 默认为该次采购的
采购单价. 你还可以在收货时对个别货物的采购价进行单独的调整. 如下图所示:
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基于收货的加权平均价



每次收货确认后, 产品会重新计算成本价,并更新到相应的产品上.
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通过辅助核算项进行采购分析


强大的统计

OpenERP允许你通过多个维度进行分析，通过周期（本年，本月，上月）、通过状态（报价，订单），供应商，用户，
产品，分类，仓库等维度。可以通过菜单 Purchases ‣ Reporting ‣ Purchase Analysis 进入
搜索界面，执行操作。
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一个月的产品采购分析



这个分析在基于供应商订单，而不是发票或者实际到货数量。要得到产品分析，使用模块 product_margin . 这个功能
模块在 为你的销售提供助力 .章有更详细说明

为了分析到货数量，你可以使用库存统计报表，

为了管理项目采购，你应该分析帐目。你可以在供应商订单的每一行上设置一个分析帐目。
OpenERP通过管理供应商发票确认和货物收据管理这次采购关联的成本。


hr_timesheet_invoice 模块可让您重新开具发票,使用分析的帐目中的参数（如销售价格表，相关的合作伙伴，最高金额）分析成本。


So you can put an invoice order with a defined invoice workflow in place based on the analytic accounts. If you are
working Make to Order, the workflow will be:


	客户订单,

	向供应商采购订单,

	从供应商收货，进货发票,

	发货和销售发票到客户.



When re-invoicing based on costs you would get the following workflow:


	Enter the customer contract conditions from the analytic accounts,

	采购原材料，并写提供的服务和时间,

	收取供应商发票和产品,

	将这些成本写进发票给客户




Tip

辅助核算方案


如果你有几种辅助核算方案, 你就需要安装模块 purchase_analytic_plans. 这个模块可以实现将采购单的明细再
按你设定的核算方案进行拆分.


Sitting at the heart of your company’s processes, analytic accounts (or cost accounts) are
indispensable tools for managing your operations well. Unlike your financial accounts, they are for
more than accountants - they are for general managers and project managers, too.



你需要一种基本的方法涉及到每一个用户，每一项服务，或是有效整合公司流程的手册. Openerp中的分析会计（也会称作管理会计，成本会计）
就能够提供这样一种基本的方法.

分析会计通常作为公司的战略决策基础. 因为它整合了所有信息, OpenERP的分析会计是一个非常实用的管理工具，
是大多数系统流程的核心。
.. i18n: There are several reasons for this:
..

原因如下:


	它反映了整个管理活动,

	不同于总账会计.分析会计的结构是不受法律约束的，所以每个公司可以按需配置。




Note

独立于总账之外

In some software packages, analytic accounts are managed as an extension of general accounts –
for example, by using the two last digits of the account code to represent analytic accounts.

In OpenERP, analytic accounts are linked to general accounts but are treated totally
independently.
So you can enter various different analytic operations that have no counterpart in the general
financial accounts.



While the structure of the general chart of accounts is imposed by law, the analytic chart of
accounts is built to fit a company’s needs closely.

Just as in the general accounts, you will find accounting entries in the different analytic accounts.
Each analytic entry can be linked to a general account, or not, as you wish. Conversely, an entry in
a general account can be linked to one, several, or no corresponding analytic accounts.

You will discover many advantages of this independent representation below. For the more impatient,
here are some of those advantages:


	you can manage many different analytic operations,

	you can modify an analytic plan on the fly, during the course of an activity, because of its
independence,

	you can avoid an explosion in the number of general accounts,

	even those companies that do not use OpenERP’s general accounts can use the analytic accounts for
management.




Tip

Who Benefits from Analytic Accounts?

Unlike general accounts, analytic accounts in OpenERP are not so much an accounting tool for Accounts as a
management tool for everyone in the company. (That is why they are also called management accounts.)

The main users of analytic accounts should be the directors, general managers and project managers.



Analytic accounts make up a powerful tool that can be used in different ways. The trick is to create
your own analytic structure for a chart of accounts that closely matches your company’s needs.

For this chapter, you should start with a fresh database that includes demo data,
with sale and its dependencies installed, and no particular chart of accounts configured.




每个企业自己的辅助核算科目表

To illustrate analytic accounts clearly, you will follow three use cases, each in one of three
different types of company:



	工业制造企业.

	律师事务所.

	IT服务公司.






案例1: 工业制造企业

In industry, you will often find analytic charts of accounts structured into the departments and
products that the company itself is built on.

So the objective is to examine the costs, sales and margins by department and by product. The first
level of the structure comprises the different departments, and the lower levels represent the
product ranges that the company makes and sells.


Note

Analytic Chart of Accounts for an Industrial Manufacturing Company


	Marketing Department



	Commercial Department



	Administration Department



	Production



	Product Range1

	Sub-groups

	Product Range2












In daily use, it is useful to mark the analytic account on each purchase invoice. The analytic account
is the one to which the costs of that purchase should be allocated. When the invoice is approved, it
will automatically generate the entries for both the general and the corresponding analytic
accounts. So, for each entry on the general accounts, there is at least one analytic entry that
allocates costs to the department that incurred them.

Here is a possible breakdown of some general accounting entries for the example above, allocated to
various analytic accounts:


Breakdown of general and analytic accounting entries (Case1)










	General accounts
	
	
	
	
	Analytic accounts
	




	Title
	Account
	Debit
	Credit
	
	Account
	Value


	Purchase of Raw Material
	600
	1500
	
	
	Production / Range1
	-1500


	Subcontractors
	602
	450
	
	
	Production / Range2
	-450


	Credit Note for defective materials
	600
	
	200
	
	Production / Range1
	200


	Transport charges
	613
	450
	
	
	Production / Range1
	-450


	Staff costs
	6201
	10000
	
	
	Marketing
	-2000


	
	
	
	
	
	Commercial
	-3000


	
	
	
	
	
	Administrative
	-1000


	
	
	
	
	
	Production / Range1
	-2000


	
	
	
	
	
	Production / Range2
	-2000


	PR
	614
	450
	
	
	Marketing
	-450





The analytic representation by department enables you to investigate the costs allocated to each
department in the company.

So, the analytic chart of accounts shows the distribution of the company’s costs using the example
above:


Analytic chart of accounts (Case1)





	Account
	Total




	Marketing Department
	-2450


	Commercial Department
	-3000


	Administration Department
	-1000


	Production
	-6200


	Product Range1
	-3750


	Product Range2
	-2450





In this example of a hierarchical structure in OpenERP, you can analyze not only the costs of each
product range but also the costs of the whole of production. The balance of a summary account (
Production ) is the sum of the balances of the child accounts.

A report that relates both general accounts and analytic accounts enables you to get a breakdown of
costs within a given department. An analysis of the Production / Product Range 1 department is shown
in this table:


Report merging both general and analytic accounts for a department (Case1)





	Production / Product Range1
	




	General Account
	Amount


	600 – Raw Materials
	-1300


	613 – Transport charges
	-450


	6201 – Staff costs
	-2000


	Total
	-3750





The examples above are based on a breakdown of the costs of the company. Analytic allocations can be
just as effective for sales. That gives you the profitability (sales - costs) of different
departments.


Note

Representation by Unique Product Range

This analytic representation by department and by product range is usually used by trading
companies and industries.

A variant of this is not to break it down by sales and marketing departments but to assign each
cost to its corresponding product range.
This will give you an analysis of the profitability of each product range.

Choosing one over the other depends on how you look at your marketing effort.
Is it a global cost allocated in some general way, or does each product range have responsibility
for its own marketing costs?



Case 2:  Law Firm

Law firms generally adopt management by case, where each case represents a current client file. All
of the expenses and products are then attached to a given file.

A principal preoccupation of law firms is the invoicing of hours worked, and the profitability by
case and by employee.

Mechanisms used for encoding the hours worked will be covered in detail in the following chapter, 人力资源管理的关键特性.
Like most system processes, hours worked are integrated into the analytic accounting. Every time an
employee enters a timesheet for a number of hours, that automatically generates analytic accounts
corresponding to the cost of those hours in the case concerned. The hourly charge is a function of
the employee’s salary.

So a law firm will opt for an analytic representation which reflects the management of the time that
employees work on the different client cases.


Note

Example Representation of an Analytic Chart of Accounts for a Law Firm


	Absences



	Paid Absences

	Unpaid Absences








	Internal Projects



	Administrative

	Others








	Client Cases



	Client1

	Case1.1

	Case1.2

	Client2

	Case2.1












All expenses and sales are then attached to a case. This gives the profitability of each case and,
at a consolidated level, of each client.

Billing for the different cases is a bit unusual. The cases do not match any entry on the general
account and nor do they come from purchase or sale invoices. They are represented by the various
analytic operations and do not have exact counterparts in the general accounts. They are calculated on
the basis of the hourly cost per employee. These entries are automatically created on billing
worksheets.

At the end of the month when you pay salaries and benefits, you integrate them into the general
accounts but not in the analytic accounts, because they have already been accounted for in billing
each account. A report that relates data from the analytic and general accounts then lets you
compare the totals, so you can readjust your estimates of hourly cost per employee depending on the
time actually worked.

The following table gives an example of different analytic entries that you can find for your
analytic account:


Analytic entries for the account chart (Case2)










	Title
	Account
	Amount
	
	General Account
	Debit
	Credit




	Study the file (1h)
	Case1.1
	-15
	
	
	
	


	Search for information (3h)
	Case1.1
	-45
	
	
	
	


	Consultation (4h)
	Case2.1
	-60
	
	
	
	


	Service charges
	Case1.1
	280
	
	705 – Billing services
	
	280


	Stationery purchase
	Administrative
	-42
	
	601 – Furniture purchase
	42
	


	Fuel Cost -Client trip
	Case1.1
	-35
	
	613 – Transports
	35
	


	Staff salaries
	
	
	
	6201 – Salaries
	
	3000





You will see that it allows you to make a detailed study of the profitability of different
transactions. In this example, the cost of Case 1.1 is 95.00 (the sum of the analytic costs of
studying the files, searching for information and service charges), but has been invoiced for
280.00, which gives you a gross profit of 185.00.

But an interest in analytical accounts is not limited to a simple analysis of the profitability of
different cases.

This same data can be used for automatic recharging of the services to the client at the end of the
month. To invoice clients, just take the analytic costs in that month and apply a selling price
factor to generate the invoice. Invoicing mechanisms for this are explained in greater detail in
提供高质量服务. If the client requires details of the services used on the case, you can then print the
service entries in the analytic account for this case.


Tip

Invoicing Analytic Costs

Most software that manages billing enables you to recharge for hours worked.
In OpenERP, these services are automatically represented by analytic costs.
But many other OpenERP documents can also generate analytic costs, such as credit notes and
purchases of goods.

So when you invoice the client at the end of the month, it is possible for you to include all the
analytic costs,
not just the hours worked. So, for example, you can easily recharge the whole cost of your journeys
to the client.



Case3: IT Services Company

Most IT service companies face the following problems:


	project planning,

	invoicing, profitability and financial follow-up of projects,

	managing support contracts.



To deal with these problems, you would use an analytic chart of accounts structured by project and by
contract. A representation of that is given in the following example:


Note

Example Analytic Representation of a Chart of Accounts for an IT Services Company


	Internal Projects



	Administrative and Commercial

	Research and Development








	Client Projects



	Client 1

	Project 1.1

	Project 1.2

	Client 2

	Project 2.1

	Project 2.2








	Support Contracts – 20h



	Customer X

	Customer Y












The management of services, expenditures and sales is similar to that presented above for lawyers.
Invoicing and the study of profitability are also similar.

But now look at support contracts. These contracts are usually limited to a prepaid number of hours.
Each service posted in the analytic accounts shows the remaining available hours of support. For the
management of support contracts, you would use the quantities and not the amounts in the analytic
entries.

In OpenERP, each analytic line lists the number of units sold or used, as well as what you would
usually find there – the amount in currency units (USD or GBP, or whatever other choice you make).
So you can sum the quantities sold and used on each analytic account to determine whether any hours
of the support contract remain.

To differentiate services from other costs in the analytic account, you use the concept of the
analytic journal. Analytic entries are then allocated into the different journals:


	service journal,

	expense journal,

	sales journal,

	purchase journal.



So to obtain the detailed breakdown of a support contract, you only have to look at the service
journal for the analytic account corresponding to the contract in question.

Finally, the analytic account can be used to forecast future needs. For example, monthly planning of
staff on different projects can be seen as an analytic budget limited to the service journal.
Accounting entries are expressed in quantities (such as number of hours, and numbers of products),
and in amounts in units of currency (USD or GBP perhaps).

So you can set up planning on just the basis of quantities. Analyzing the analytic budget enables
you to compare the budget (that is, your plan) to the services actually carried out by month end.


Tip

Cash Budgets

Problems of cash management are amongst the main difficulties encountered by small growing
businesses.
It is really difficult to predict the amount of cash that will be available when a company is young
and rapidly growing.

If the company adopts management by case, then staff planning can be represented on the analytic
accounts report, as you have seen.

But since you know your selling price for each of the different projects,
you can see that it is easy to use the plan in the analytic accounts
to more precisely forecast the amounts that you will invoice in the coming months.
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流程与文档管理



	流程

	集成化文档管理

	管理体系

	同步日历(CalDAV)
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流程


在学习流程之前,你可能不是很清楚哪些带编号的业务对象,更没有头绪如何去实现模型和业务之间的流程.

在安装有流程功能的模块时,OpenERP的流程模块会被自动安装，流程里的各节点之间的跨职能的流程和工作流技术细节会被很好地展示。这种可视化对流程规范来说是非常重要- 甚至还可以更深一步。你可以修改已有的流程和工作流，甚至可以根据不同的单据类型重新产生新的流程和工作流.

如果你从发票或订单这类特定的单据进入,那你可以看到这个单据在工作流程图上的确切位置




在本章，你有一个包含销售模块(sale)且带演示数据的新数据库就可以开始，跟销售关联的模块都会被自动安装，流程模块(:mod:’process’)是其中之一，也不必去配置好科目表.
对于本章的第二个例子，你还需要安装一些诸如(hr_attendance)，(hr_contract)和(hr_holidays)一些相关的人事模块(hr).



	管理系统的流程集成
	过程举例
	跟踪客户销售订单

	新员工入职









	工作流和用户处理
	有效使用流程

	定义自己的用户流程










一个公司组织结构的优劣通常要看这个公司的是否成熟。一个成熟的公司需要有一个完善的流程，员工能够根据流程快速找到所需文档,知道如何去完成各种任务.

有很多现成的工具可以满足建立有效的组织结构或提高组织结构品质的需求:


	ISO9001 质量标准,

	业务流程管理工具(BPM),

	类似统一建模语言(UML)的用例工作流或正式标准规范,

	公司质量手册.



问题是这些工具通常跟管理系统是分开的，只是被公司里的个别人所使用。它们往往不是放在在管理系统之中处理而是分开处理。当你向公司员工问及ISO9001时,你会发现它只是被看作一个规约，而不是一个非常有用的日常管理工具。

为了帮助公司满足其管理质量的追求并且把这些管理流程融入到日常工作，OpenERP提供了一个能让你把公司的流程置入管理系统的企业级智能工具® .

这个系统能做到:


	通过软件直观动态给新员工显示各种单据内容和其作业操作,

	很容易访问到每个单据的所有关联内容,

	让大家既能看到公司的整体流程图,又能知道公司流程的所有细节,

	通过图形化模块和集成的质量手册能够快速访问到作业所需内容,

	将知识库包括公司所有对运营有价值资料应用到交互形式的流程之中,

	让员工可以更了解自己在整个公司里的职责.
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管理系统的流程集成

信息管理已成为公司 发展战略的一个主要因素。如何安全地将正确的信息尽可能有效的传给适合的人更是其中的重点。建立文档管理系统就是提供给公司将各种形式的资料统一存放的一种方法。

From a mapping process, integrating management and the changing needs of each
employee becomes very useful for the fulfilment of each. Based on that, each
employee becomes aware of his own personal contribution to the company’s value
chain. This representation also helps an employee’s own personal management
because it shows his place and his role in the overall process, very often over
several departments.

The system of ‘Corporate Intelligence’ will also be highly useful to system
implementers who, after studying the requirements, have to formalize a
company’s processes to put them into operation in OpenERP.


过程举例

To understand the aims of the system of Corporate Intelligence (process)
better, you will now see an overview of the functions available to you in a the study of
two processes:


	A customer order quotation,

	The engagement of a new employee.




跟踪客户销售订单

The example Example of a process handling a customer order quotation shows the process for handling a customer sales order. Use
the menu Sales ‣ Sales ‣ Sales Orders to list all orders, then choose
Order SO001 – you can either check the checkbox to its left, or you can open
the order itself by clicking the row containing the order.

To view the process for that specific order, click the Corporate Intelligence
button (displayed as a question mark) at the
top right of the title of the list or form. The process for this order is shown in the
window, and the current state of this document can be seen by looking for the
node whose left edge is colored maroon rather than grey.


[image: ../../../_images/process_quotation_flow.png]
Example of a process handling a customer order quotation



This order is in the Quotation state. The whole of some nodes is greyed out
because the selected document will never enter into that state, such as
invoicing based on deliveries (the order is in an invoicing mode that is based
on orders, not deliveries).

The process is completely dynamic and based on that specific sale order
document. You can click each of the process nodes (Quotation, Sale Order,
Procurement, Draft Invoice, Outgoing Products) using one of the
links or icons on it:


	Obtaining the documentation and the corresponding process in the quality manual, using the
Help (or Information) icon,

	Obtaining the documents that an employee needs to carry out the process by clicking the green
arrow icon,

	Seeing the menu that OpenERP uses to get the document by hovering over the green arrow icon.






新员工入职

Open the employee form for Fabien Pinckaers from the menu
Human Resources ‣ Human Resources ‣ Employees.
Click the Corporate Intelligence button to open the detailed
process of engagement.


[image: ../../../_images/process_employee_flow.png]
Example of a process engaging a new employee



You can immediately see things that might interest the HR manager. On a single
screen she has all of the documents about the selected employee. She can then
zoom into each document to look at associated documents or
the user account in the system.
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工作流和用户处理

工作流通常用于定义给定单据的行为。它们是被开发人员使用且由系统实施者来确定哪个对象在哪个时刻应执行哪些操作。
这些主要是整个对象（比如一个单据）生命周期的垂直方式 中定义的技术流程。工作流的改变会对用户操作所对应的软件
行为产生直接的影响。在哪里你要处理所有可能的异常，让软件很健全.


[image: ../../../_images/process_sale_workflow.png]
一个客户订单的工作流范例



Unlike workflows, user processes represent workflows across all of a company
and its documents. They are used by end-users to locate an action for more
complete handling. A change of user process will not have any effect on the
software but will show the user another way of working on a given problem.


[image: ../../../_images/process_sale_process.png]
Example of a process handling a customer order



Processes are used by end-users to help them understand the problems which
have not been handled in OpenERP. You can find actions that have no influence
on the software, such as “Telephone customer to thank him”, and “Send a fax to
reassure them”. As well as providing user help, processes provide functions such
as:


	integration with OpenERP Help and the company’s quality manual,

	showing the user the menu for finding a specific document.




[image: ../../../_images/process_cross_worfklow_process.png]
Relationship between workflow and user process



User processes are thus connected to technical workflows. If you modify the
software’s behaviour with a workflow, the changes will be directly visible in
the user processes that are based on the modified document. So if you modify certain
transitions on a workflow they will automatically be
shown in the process corresponding to the modified document.

To get maximum benefit from the power of user processes and the workflow
engine, OpenERP provides an integrated workflow editor and user process
editor. These enable you to modify them through the client interface.

You will only work with the process editor in this chapter. If you want to view and edit the
workflow of a document, click on the link Edit Workflow to the right of the document.
OpenERP opens a graphical view of the workflow for the selected document type.

If you want to edit a workflow in a text-based editor, you can use the menus under
Administration ‣ Customization ‣ Workflows.


有效使用流程

Regardless of which OpenERP screen you are in you can call up a process on the
current document by clicking the Corporate Intelligence (question mark) icon.
Depending on the document, you can have several processes defined using it.
OpenERP then asks you to choose which one of them you want.

For example, if you are in a meeting form, OpenERP will ask you to choose from
the processes it knows about that involve such forms:


	processes for selecting and inducting new employees,

	tracing customer orders in pre-sales,

	processes for visiting customers and handling expenses.




[image: ../../../_images/process_screen.png]
Button for entering a user process from a form



The element colored red shows the active process for the selected document.
Elements in grey are the states that the selected document will not go through
because of its configuration. You can use the different icons to open the
document, print it, or get its documentation.

Some states have an image inside of arrows formed into a circle. These show
that the state refers to another process. To go to this other process, you can
click on the title of the state. For example, you can click on the invoice in
the customer order management workflow to see in detail how that invoice is
handled.


[image: ../../../_images/process_subflow_icon.png]
A state that refers to another workflow






定义自己的用户流程

Use the menus under Administration ‣ Customization ‣ Enterprise Process to
define new processes or modify existing processes. When entering a process,
OpenERP shows you the list of states available for that process.


[image: ../../../_images/process_form.png]
Form for defining a process



You can add a new state or modify an existing state. A state can be associated
with an object (whose instances are represented by documents). If that is the
case, choose it in the case object. You can set an expression that shows if the
object can be found in that state or not. Expressions are in Python format. For
example, for the quotation state choose the object sale.order and set the
following expression object.state == 'draft' .

You can also link to a menu so that users can learn which menu to use to access
objects in a state. You can set the conditions in which this object is in a
greyed-out state in the section Conditions. These expressions, too, are
encoded in Python format.

Once the node has been defined, you should set the transitions leaving this
object. For each transition you can:


	Give the leaving and destination states,

	Set up a list of buttons that start various transitions in the process,

	Map between workflow transitions and the document that is selected,

	Put an explanatory notice in different languages.




[image: ../../../_images/process_transition_form.png]
Screen for defining a process transition
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集成化文档管理


信息管理已成为公司 发展战略的一个主要因素。如何安全地将正确的信息尽可能有效地传递给适合的人更是其中的重点。建立文档管理系统就是提供了公司把各种形式的资料统一存放的一种方法。


文档管理的目标包括更便捷归档，访问和引用，智能分类和分发文件以及他们所包含的内容。它就像公司的文件集合，涉及各种工作程序，会议报告，从客户和供应商收到的文件，发送给客户的文件、传真、销售演示和产品资料等

在本章，我们应该从一个新的包含demo数据的数据库开始，安装 sale, document 模块以及他们的依赖模块而没有单独的账户配置图。



	良好的文档管理系统的重要性

	传统的文档管理方案

	OpenERP 文档解决方案
	如何开始
	安装









	完备的FTP内/外部访问权限控制

	Mapping between OpenERP Resources and Directories

	附件管理

	Virtual Files

	标准结构

	优化文档管理
	文档搜索

	Email集成
	使用 Outlook 和 Thunderbird





	Working with Users’ Changes

	版本管理
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良好的文档管理系统的重要性

全球化意味着工作地点更分散。这意味着文件的使用在国家与大洲之间的沟通和协作中更加频繁。

你会看到即使在同一个办公室的雇员之间沟通都是有问题的，因为他们不容易获得他们所需要的文件。
你发现有些文件是存放在在财务办公室。有些是作为每个人都可以访问的共享目录，有些文件是纸质，有些是电子文档。

通过增加文件数量是解决不了这些问题的。如果文件的存档和索引组织得不好，这些文件就会变得毫无作用，因为他们是如此难以检索。

文件管理不善的结果可能导致耗费大量的时间。问问自己，用了多久你才找到以下你所需要的文件：


	一份已经发送给采购经理的供应商目录，

	一位客户几个月前签订的合同，

	提供给某个客户的条款和细则最终本，

	对于雇佣新员工的要求细则的文档，

	由客户发送到销售人员的已确认的订单，甚至更为常见的：你收到订单确认但是相关的销售人员去度假了，

	一本你的有某个工序出错了的质量手册，

	一封已经发送你同事的电子邮件，

	一个你需要的特定类型的合同样本，

	一份关于合同上的供应商的完整通信历史。



比浪费时间更糟的是缺乏良好的文档管理，这可能影响您公司的组织以及提供服务的质量。在这样的公司通常是：


	文件归类没有遵循一套标准,

	每个销售人员都用自己的格式来组织报价单并且所有更改的都只对个人而不是以组为单位,

	某部分人在纠正合同的内容，但没有传达到公司的其他人使他们受益,

	版本管理混乱，甚至没有。



良好的综合文档管理系统是有助于公司日常管理的强大的工具，有了它，你可能就很容易做到：


	如果同事去了度假，你也可以继续她的工作，有需要还可以回复她的客户,

	只需点击几下获取所有文件类型的样板。因此当你制作询价单,
会议纪要，客户交付单，合同，传真和信件的样板可以按照公司的标准，

	在招聘新员工、组织会议或者整理会议纪要时，如果你不知道相关的文档结构，
你可以通过系统检索相关文件，

	在面对类似的需求的时候复用同事的记录，并在公司建立你的个人工作档案,

	几秒钟内就可以找到客户或者供应商在公司的所有订单并回答他们的问题，如果是没有初次记录
也可以通过继续沟通在系统里建立初次接触的记录,

	通过建立你的工作方法让你的同事从文件和流程的改良中获益。



从这些例子你看可以看出一个良好的文档管理系统的重要性，它有助于提高每个员工的工作效率和质量。
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传统的文档管理方案

面对需要整理的文件，企业一直在寻找文档管理的解决方案，从简单的邮件归档发展成完整的电子文档管理系统。

不幸的是大多数解决方案并不是非常实用，因为他们与公司的管理系统集成度太低。我遇到的大多数解决方案的结果是
只有少部分人使用系统，而不是全部人。

这其中最主要的原因是一个文档管理系统没有把雇员额外的工作也集成了。
例如：销售人员最好可以将客户每次的确认都存档到系统里面，这意味着仅仅为这些确认就多了
相当沉重的额外工作量：


	查收/查阅来自客户的邮件，

	桌面操作发送邮件及邮件附件，

	直接连接ERP系统进行单据流程管理，

	连接文档管理系统，

	优化文档存储位置，

	如果订单不存在就为客户创建一个目录，

	从桌面复制文件到文档管理系统。



为了处理一个简单的订单确认操作竟要如此繁复的步骤。你就可以理解为什么企业在文档管理系统上付出那么多的努力
和成本但是系统还是难以用起来的原因。


Tip

免费文档管理系统

有很多的免费的文件管理系统，其中比较最有名的有：:


	Alfresco: http://www.alfresco.com

	Quotero: http://www.quotero.com





将公司的文档和文档管理系统保持同步是非常困难的。例如，当客户改变了他的住址，
用户需要在管理软件里修改相关的资料，但是通常情况并没有在文档管理系统更改。

此外如果这两个系统是相互独立的，那么用户必须在两个储存结构相同的系统添加相同数据，
在几个月以后你很快就发现文档管理系统脱离了公司的管理系统了。例如你将很难知道最近经常使用的文件，例如员工汽车
租赁文档存放在哪里。

Also, document management systems are typically very complex because they must manage user access
rights in just the same way as those that are available in the company management system. This means
that you have to enter the same sort of data about access rights twice for the system
administrators.

You will see that the total integration of OpenERP’s document management system with the main company
management system, and plugins to Outlook and Thunderbird email clients, offers an elegant solution
that addresses these problems.
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OpenERP 文档解决方案

OpenERP’s management of documents is unique and totally innovative in its integrated approach. Its
complete integration with the company’s management system solves most of the problems that are
encountered when you use independent document management systems:


	Login and the management of access rights is integrated with that of OpenERP for controlling
access to different document types,

	Ultra-rapid access to documents, which are directly accessible through your email client or
through the company management software,

	Automatic assignment of meta-information comes directly from information contained in your
OpenERP login registration,

	Document workflow, which automatically follows OpenERP’s documentation process, provides complete
synchronization between the systems,

	Document classification is determined by OpenERP itself so that the structure that is created is
always synchronized between the systems,

	Automatic indexation and classification of all documents produced by OpenERP for maximum
efficiency.




如何开始

This section is about how to get started with the document management system from its installation
to advanced use with FTP access.


安装

To install OpenERP’s document management system, you just need to install the document
and document_ftp modules through the Reconfigure wizard by selecting
Knowledge Management, and further on, Shared Repositories (FTP) for installation.
As the module installation proceeds, the system automatically proposes that you
configure the FTP server.


[image: ../../../_images/document_config.png]
Screen for configuring document management



Once the module has been installed, you will see a new entry in the main menu called Knowledge.


[image: ../../../_images/document_menu.png]
The Knowledge menu
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完备的FTP内/外部访问权限控制

为了更好地分类各类文档, 咱们配置第一步就是要建立一个合理的FTP目录结构. 进入菜单 知识管理 ‣ 配置 ‣ 文档管理 ‣ 目录结构
Knowledge ‣ Configuration ‣ Document Management ‣ Directories’ Structure.


[image: ../../../_images/document_structure.png]
Structure of directories when the document module has been installed



我们除了能在 OpenERP 中直接管理各种文档外,甚至还可以使用FTP 客户端工具直接连接 OpenERP 的FTP服务器对文档进行各种管理.
常见的 OpenERP FTP服务器地址为:







	参数
	默认值




	Server
	服务器监听地址 例如: 127.0.0.1


	Port
	服务器监听端口 例如: 8021


	Path
	服务器路径 默认’/’ 代表根目录


	User
	OpenERP 用户名


	Password
	OpenERP 密码






Note

FTP 服务器

These comments about an FTP server may appear a bit technical, but
it is just a general standard for getting hold of files without worrying too much about the platform
(Windows, Mac, Linux, or other Unix-like system).
So FTP is just a way of getting access to files without needing to use an OpenERP client.
There could have been other ways, but FTP proved itself to the developers to be the one that performed best
at lowest cost.



Once you are connected using FTP, you get to the root of a directory for the document
management system. Once you enter that directory you find a structure that matches the structure
defined in OpenERP.


[image: ../../../_images/document_ftp_structure_root.png]
Root of the database directory seen through FTP




[image: ../../../_images/document_ftp_structure_tree.png]
Structure of the directories in the document management system
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Mapping between OpenERP Resources and Directories

Each directory can either have the type Static or Folders per resource. A static directory, as
with operating systems, is the classic directory that can contain a set of files. On the other hand, the directories
linked to systems resources automatically possess sub-directories for each of the resource types defined in
the parent directory.


Tip

Directories in English

To keep them synchronized to the working language, directory names are not translatable.
But OpenERP’s demonstration data automatically creates directories in English.
You can rename them through the menu Knowledge ‣ Configuration ‣ Document Management ‣
Directories.



For example, you can look at the directory shown in Documents ‣ Sales Order
‣ All Sales Order. You will see the directory for all the orders present in OpenERP that was
created automatically by the system.


[image: ../../../_images/document_sale.png]
Orders in OpenERP




[image: ../../../_images/document_ftp_sale.png]
Directories representing all the orders in the document management system



Directories can follow a tree structure, like the tree of resources in OpenERP. For example, if you go to the
directory Documents ‣ Projects you will see the structure of the analytic
accounts.

To define a directory containing a specific type of resource, you have to define parameters when you
define the directory itself:


	Type : Folders per resource

	Resource model : Choose one of the system objects

	Domain :  an event filtered so that it sees only a subset of the resources

	Tree Structure : to show the resources hierarchically




[image: ../../../_images/document_dir_form.png]
Configuration of the directory containing All Sales Orders



This is a very flexible approach because any modification of the resource in OpenERP is
automatically reflected in the document management system. So when the quotation gets confirmed in
OpenERP the directory no longer appears as a quotation through FTP access.

Here are some examples of directories linked to OpenERP resources that could be helpful when
configured in the document management system:


	Quotations and Order: storing documents that relate to orders,

	Products: for storing products’ technical datasheets,

	Users: to automatically define a directory owned by each user of the system,

	Employees: to store documents about employees, such as their CVs, your interview notes, contract
details, and their annual assessments,

	Support Requests: storing items about requests or about technical support responses,

	Analytic Accounts or Project: to store project management and tracking documents.







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	OpenERP 用户手册 

          	流程与文档管理 

          	集成化文档管理 
 
      

    


    
      
          
            
  
附件管理

As you see, you can connect any directory in the document management system to an OpenERP
resource. The system then manages its creation and keeps the directory synchronized with the
reports generated by OpenERP from its own data. You do not have to create or rename these
directories because OpenERP does all this automatically as it resynchronizes with its own database.

You can then copy the files in the directories that correspond to any of the resources. The files
are automatically attached to OpenERP’s documents through attachment management. Conversely, if you
attach a document to one of OpenERP’s resources then that document will automatically become visible
over FTP in the document management system.


Note

文件存储

If you do not install the document management system then the files that are attached to an OpenERP
resource are stored directly in the database.
Once the document management system has been installed,
the contents of the files are no longer stored in the database but are stored instead on the OpenERP
server filesystem in a directory named ‘filestore’.

You can then read and add attachments to OpenERP resources quite independent of the OpenERP
interface or the FTP server using simple drag and drop.
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Virtual Files

The most well-organized companies keep track of all the documents they have sent to customers in their
document management system. It is very useful to be able to retrieve every document about a customer
or a project. But the work of storing these documents can itself often take up quite a bit of time
for staff. Each report must be saved in the document management system as well as be sent
by email to the customer.

That is not the case in OpenERP. To automatically make OpenERP reports available in the FTP server,
OpenERP automatically uses virtual files. You can put virtual files into directories
that have the special type of linked resource and link the virtual files to OpenERP’s reports.


Note

Virtual Files

Virtual files do not actually exist in OpenERP but are made visible with a size of 0 in the FTP
server.
Once these files have been read by the client software, OpenERP prints the document related to
this file and
returns a PDF document linked to the resource.

When you copy or open a virtual file you print the selected resource.
You do not then have to go and print a document through OpenERP –
you just open the file containing that document in the document management system.
The PDF file is then created in real time by OpenERP by reading the relevant data.



The screen Virtual files for Sales Orders in OpenERP shows the parameters of the virtual files in All Sales Order. You define the virtual files
using the name ORDERNUM_print.pdf, where ORDERNUM represents the reference to the order. To do
this, you must check the option Include Record Name of the file for a directory.
You can then find a virtual file for each report associated with an order.


[image: ../../../_images/document_virtual_form.png]
Virtual files for Sales Orders in OpenERP



To see the effect of this configuration, connect to the FTP server and go into a directory for an
order such as Documents ‣ Sales Order ‣ All Sales Order ‣ SO003. You
can then just click the file SO003_print.pdf to get a printout of Order SO003.
You can attach it to an email or put it on your desktop.


[image: ../../../_images/document_virtual_ftp.png]
Virtual files for Sales Orders through FTP



This system of virtual files is very useful in a lot of situations. For example, if you must quickly
re-send a quotation to a customer, you do not have to open OpenERP, you can just attach the relevant
virtual file to your email.

Importantly, once files have been read or copied, they become real files, taking up real space, rather than
just virtual. This means that you can keep a legal record of all documents that have been created and sent
to customers and suppliers.
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标准结构

You now have a configuration that enables you to automatically get a directory structure linked to
OpenERP for each resource, such as for projects and orders. The ideal situation would now be to
automatically structure the documents about projects, say for example, you could classify them
depending on their type:


	Quotations,

	Meeting Minutes,

	Delivery Documents,

	Documentation.



OpenERP provides you with a system that lets you create a structure type for each type of a given
document. It then provides that classification for all documents in the directories structured in
that type.

So create the structure above for your project management system. To do that, create the four
directories above and give them the following data:


	Type : Static Directory,

	Parent Model : Analytic Account.



Then in each project (represented by analytic accounts) you will get this substructure for
organizing your documents efficiently.


[image: ../../../_images/document_shared_structure.png]
Substructure common to all projects




Tip

Mapping

In practice, OpenERP does not create directories or files for every resource.
It actually manages this by mapping between OpenERP resources and the FTP interface.

This approach gives a lot of flexibility because there is no synchronizing to do, nor any redundancy.
Changes in either the document management system or in OpenERP will automatically be reflected
over in the other side.

And system resources are obviously not used up by storing things twice.



Once a new project has been defined in OpenERP, the system automatically creates a directory
corresponding to the project in the right place in the document management system, and creates a
structure type there for classifying documents.
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优化文档管理

All documents produced by OpenERP are automatically indexed and classified for
maximum efficiency. There is an ultra-rapid access to documents, which are
directly available from your email client or the company management software.
The user access rights are managed just the same way as those that are available
in the company management system. All these features help you to get the best
out of OpenERP’s document management system.


文档搜索

You have seen several methods of accessing documents quickly:


	From attachments to an OpenERP resource,

	Through FTP access to OpenERP,

	Using the menu Knowledge ‣ Document Management ‣ Directories’ Structure.



But if you do not know where a specific document can be found, OpenERP also has a search tool
integrated into its document management to simplify your search. To search for a file, use the menu Knowledge
‣ Documents ‣ Documents. You get to a document search view that lets you search amongst
all the attachments and all the documents in the FTP server.

You can search for a file using various different criteria:


	The attachment name,

	The attachment type,

	The filename,

	The owner of a file,

	The directory that it is found in,

	The indexed content.



Notice here an important advantage for an integrated document management system. Information such as
which partner is associated with a document is automatically detected by OpenERP when the document
has been stored in a directory. This information is never input by the user – it is detected
automatically using the information about the resource when it is being saved as a file.

But your search is not limited to these few fields. You can also search on the content in the files.
Each file is automatically indexed by the system to give you a search engine rather like Google’s on
the whole set of company documents.


Note

Supported File Formats

The OpenERP document management system can index the following file formats:


	TXT : text files,

	PDF : PDF files,

	SXW : OpenOffice V1 files,

	ODT : OpenOffice V2 files,

	DOC : Microsoft Word files.



The other file formats are properly handled in the document management system, but their content
is not indexed automatically.



This functionality is very significant. All you need to do is search for a partner name or an order
number to automatically get all the documents that are referenced there. And you can use a fragment
of text to find the document you need from within that subset.




Email集成


使用 Outlook 和 Thunderbird

OpenERP’s document management system is well-integrated with popular email clients like Microsoft Outlook and Mozilla Thunderbird. For this, you can install the required plugins available in OpenERP, usually made available when you install and configure crm. Or you may install outlook or thunderbird module according to your requirement, and take advantage of its compatibility with OpenERP’s documents. For more on this, refer ch-commtools.


[image: ../../../_images/create_contact_outlook.png]
Creating a new contact through the Document Management System from Outlook




[image: ../../../_images/document_attachment_thunderbird.png]
Pushing an attachment in the Document Management System from Thunderbird








Working with Users’ Changes

To make the document management system’s use as unobtrusive as possible, the system’s users should
easily be able to store all the documents that they produce or receive from their customers and
suppliers. So OpenERP supplies dashboards to help system users approve their acceptance of such
documents.

So you will find two dashboards in the menu Knowledge ‣ Reporting ‣ Dashboard. One
dashboard is for the document management system manager and one dashboard is for tracking use by different
users.

The first lets you track the changes to documents by month, by customer and by type of resource. You
could also quickly assess the use that is made of the system by the various users.


[image: ../../../_images/document_board1.png]
Dashboard for the document management system manager



The second dashboard shows you how different employees use the system.
You can see the number of files sent by each user and who uses the document
management system the least. That tells you something about your user training
and whether you need to do something about changing work methods.


[image: ../../../_images/document_board2.png]
Dashboard for the document management system analyzed by user






版本管理

There is usually a need to keep track of all the important documents that you have printed. For
example, when you send an invoice to a customer it is a good idea to store a copy of that invoice
internally in paper or electronic form. Then you can reprint it exactly in the same format as when
you sent it, even if the company’s details have changed in the meantime.

To do this, OpenERP can automatically store as attachments the different reports printed by users.
By default, only invoices are saved as attachments, and they are saved when they are printed.
That is because they are commonly legally required.

But you can configure the system so that it does not matter which type of report is printed -
they can all be stored automatically. To
activate that functionality on another type of report, modify this in the menu
Administration ‣ Low Level Objects ‣ Actions ‣ Reports.
To be able to access this menu, the user should be added to the group Useability / No One.


[image: ../../../_images/document_report_modif.png]
Modifying the definition of a report



Select the report that you want to change and complete the field Save As Attachment Prefix.
Once you have done that, each document print action will automatically be saved as an
attachment to the document.







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	OpenERP 用户手册 

          	流程与文档管理 
 
      

    


    
      
          
            
  
管理体系


管理体系是过程和程序的框架，用来保证组织机构可以有效地完成所有需要的工作，从而达到目标


The objective of management system is to provide all the required applications to manage your
manuals, procedures, environmental aspects, work instructions, audits, nonconformities,
improvement opportunities, immediate, corrective and preventive actions.

For this chapter you should start with a fresh database that includes demo data,
with mgmtsystem_quality, or mgmtsystem_environment and their dependencies installed.



	手册

	程序和环境因素

	审核

	不符合要求的事项

	动作
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手册

每一个管理系统会有相应的手册，手册一般按相应的ISO标准所要求的结构来编制。
你可以从菜单:menuselection:`知识库 –> 协作内容 –> Wiki页面`进入Wiki页面，开始撰写用户手册。


[image: ../../../_images/mgmtsystem_manual.png]
质量手册






程序和环境因素

当系统手册编制完成后，你必须编制一系列适用的程序文件来支撑手册，并考虑环境因素的影响。
这些文件都可以通过Wiki页面来进行管理，访问菜单同上所述。


[image: ../../../_images/mgmtsystem_procedure.png]


你可以进一步的编制工作指导书，即创建新的Wiki页面，来更详细补充说明程序文件。
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审核

You can then plan your audit calendar by creating audits from the menu Management System ‣ Management System ‣ Audits.
You give it a name, and a date and time. You can then assign the auditors and the auditees.


[image: ../../../_images/mgmtsystem_audit.png]
Management system audit



The auditor can then fill in the verification list with questions based on the manual, the procedure (or the environmental aspects) and the work instructions. He will be able to print the verification list (report) and carry out his audit.


[image: ../../../_images/mgmtsystem_verification.png]
Verification line



At the end of the audit, he will add the answers to his questions in the verification list stating if it has conformed or not. He will provide feedback to the auditees with the strong points and points to improve. The auditor will be suggesting improvement opportunities and explaining the nonconformities he discovered.

Once completed, the auditor can close the audit and generate his audit report.





          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	OpenERP 用户手册 

          	流程与文档管理 

          	管理体系 
 
      

    


    
      
          
            
  
不符合要求的事项

Prior to create a non conformity, you need to create the list of origins (how you
discovered your nonconformities) and causes (the root causes) of your nonconformities
from the menu Management System ‣ Configuration ‣ Nonconformities.

Then you can create nonconformities directly from the audit or from the menu :menuselection:
Management System –> Management System –> Nonconformities. You set the partner
involved by the nonconformity, an identifier to what it is related to and the employee
responsible for the nonconformity, with his manager.


[image: ../../../_images/mgmtsystem_nonconformity.png]
Nonconformity



You then choose the origins of the nonconformity and the procedure involved. In the
description, you explain and detail the nonconformity with facts and evidences.
You choose the cause and then analyze why the nonconformity happened in order to
suggest immediate, corrective and preventive actions.

Once all the actions have proven to be completed and efficient, you can close the
nonconformity.
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动作

You can create actions directly from the nonconformity 或者从菜单
Management System ‣ 管理系统 ‣ 动作.


[image: ../../../_images/mgmtsystem_action.png]
Immediate, corrective or preventive action



For each action, you give it a subject, a deadline, a user responsible for carrying
out the action and a type:



	immediate action: an action that can be quickly closed (in less than a day).

	corrective action: an action to solve the nonconformity.

	preventive action: an action which makes sure you will not face the same
nonconformity once again in the future.

	improvement opportunity: an action that might be relevant for you to implement.
You have to evaluate if it makes sense for your business.






The person in charge of the action can then detail his different steps as internal
note or email. Once the action has proven to be completed and efficient, the action
is closed.
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同步日历(CalDAV)

自从OpenERP 6.0版本后, document_webdav v2.2, OpenERP CalDAV模块就开始iphone的日历客户端.当然android也同样的支持。

However, keep in mind that OpenERP is not a straightforward calendaring
server, but an ERP application (with more data + structure) which exposes
those data to calendar clients. That said, the full features that would be
accessible through the GTK or Web OpenERP clients cannot be included into Calendar clients (such as iPhone).


OpenERP Server 配置

Some modules need to be installed on the OpenERP server. These are:



	
	caldav: Required, has the reference setup and the necessary

	underlying code. Will also cause document & document_webdav
to be installed.







	crm_caldav: Optional, will export the CRM Meetings as a calendar.



	project_caldav: Optional, will export project tasks as a calendar.



	
	http_well_known: Optional, experimental. Will ease bootstrapping,

	but only when a DNS srv record is also used.












When you install the above module(s), a ready-to-go reference setup of the folders is provided.
The OpenERP administrator can add more calendars and (re)structure if needed.




SSL 配置

It is highly advisable that you also set up SSL to work for the OpenERP
server. HTTPS is a server-wide feature in OpenERP, which means a
certificate will be set at the openerp-server.conf which will be the same
for XML-RPC, HTTP, WebDAV and CalDAV.
The iPhone also supports secure connections with SSL, although it does
not expect a self-signed certificate (or one that is not verified by
one of the “big” certificate authorities).




iPhone 设备日历

To set up the calendars, proceed as follows:


	Click Settings and go to the Mail, Contacts, Calendars page.

	Go to Add account...

	Click Other.

	From the Calendars group, select Add CalDAV Account.

	Enter the host name.
(e.g. if the URL is http://openerp.com:8069/webdav/db_1/calendars/ , openerp.com is the host)





Tip

Go to Sales ‣ Meetings ‣ Synchronize this Calendar and select Iphone. Then the Caldav server will be shown.







	In Username and Password, type your OpenERP login and password.

	As a description, you can either leave the server’s name or
something like “OpenERP calendars”.

	If you are not using a SSL server, you will get an error, do not worry and push “Continue”

	Then click “Advanced Settings” to specify the correct ports and paths.

	Specify the port for the OpenERP server: 8071 for SSL, 8069 without SSL.

	Set the Account URL to the right path of the OpenERP webdav:
the URL given by the wizard (e.g. http://my.server.ip:8069/webdav/dbname/calendars/ )

	Click Done. The phone will connect to the OpenERP server
and verify whether the account can be used.

	Go to the main menu of the iPhone and open the Calendar application.
Your OpenERP calendars will be visible inside the selection of the
“Calendars” button.
Note that when creating a new calendar entry, you will have to specify
which calendar it should be saved to.



If you need SSL (and your certificate is not a verified one),
you will first need to let the iPhone trust the certificate. Follow these steps:


	Open Safari and enter the HTTPS location of the OpenERP server:
https://my.server.ip:8071/
(assuming you have the server at “my.server.ip” and the HTTPS port is the default 8071)

	Safari will try to connect and issue a warning about the certificate used. Inspect the certificate
and click “Accept” so that iPhone now trusts it.






Android 设备日历


使用条件

There is no built-in way to synchronize calendars with CalDAV.
So you need to install a third party software: Calendar (CalDav) Sync BETA
from Hypermatix Software (for now, it is the only one).




配置步骤


	打开 Calendar Sync 应用.
打开后，界面上应该会有两个页面.

	在 Connection 页面中, 找到 CalDAV 日历链接, 输入你的OpenERP 日历地址 “http://my.server.ip:8069/webdav/dbname/calendars/users/demo/c/Meetings” 。





Tip

Go to Sales ‣ Meetings ‣ Synchronize this Calendar and select Android. Then the Caldav server link will be shown. Make sure to use the correct XML-RPC port, it may differ from 8069.







	输入你的OpenERP帐户及密码.

	如果你的OpenERP没有配置SSL，会接受一个关于SSL的警告，请选择 Yes.

	Then you can synchronize manually or customize the settings (Sync tab) to synchronize every X minutes.








Evolution 日历


	Go to Calendar View.



	File ‣ New ‣ Calendar.



	Enter the data in the form:



	Type : CalDav

	Name : Whatever you want (e.g. Meeting)

	URL : http://HOST:PORT/webdav/DB_NAME/calendars/users/USER/c/Meetings (e.g.
http://localhost:8069/webdav/db_1/calendars/users/demo/c/Meetings)
the one given on top of this window

	Uncheck “User SSL”

	Username : Your username (e.g. Demo)

	Refresh : every time you want Evolution to synchronize the data with the server












Tip

Go to Sales ‣ Meetings ‣ Synchronize this Calendar and select Evolution. Then the Caldav server will be shown.







	Click OK and enter your OpenERP password.

	A new calendar with the name you entered should appear on the left side.






Sunbird/Lightning 日历


使用条件

If you are using Thunderbird, first install the Lightning module
http://www.mozilla.org/projects/calendar/lightning/




配置


	Go to Calendar View.

	File ‣ New Calendar.

	Choose On the Network.

	As a format, select CalDav
and as a location type the URL (e.g. http://host.com:8069/webdav/db/calendars/users/demo/c/Meetings).





Tip

Go to Sales ‣ Meetings ‣ Synchronize this Calendar and select Sunbird/Lightning. Then the Caldav server will be shown.)







	Choose a name and a colour for the Calendar, and we advice you to uncheck “alarm”.




	Enter your OpenERP login and password (to give the password only once, check the box Use Password Manager to remember this password).

	Then click Finish; your meetings should now appear in your Calendar view.
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系统管理与实施


在你测试完评估版的OpenERP后, 你需要配置它以适应贵公司的软件需求.
你可以灵活地配置各种不同的模块，以适应贵企业及各部门的业务.



这部份专为ERP项目经理而设立,讲述系统的管理和配置,为你提供把软件整合到公司的强大工具,以管控和跟踪整个项目,
考虑到各种不同的问题, 还有各种对你有用的选项，如一系列的供应商类型, 风险模型.




	配置与系统管理

	实施方法
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配置与系统管理


This chapter is for the administrators of an OpenERP system.
You will learn to configure OpenERP to match it to your company’s needs and
those of each individual user of the system.


OpenERP gives you great flexibility in configuring and using it, letting you modify
its appearance, the general way it functions and the different analysis tools chosen to match your
company’s needs most closely. These configuration changes are carried out through the user
interface.

Users can each arrange their own welcome page and their own menu, and you can also personalize
OpenERP by assigning each user their own dashboard on their welcome page to provide them with the
most up to date information. Then, they can immediately see the information most relevant to them
each time they sign in.

And OpenERP’s main menu can be entirely reorganized. The management of access rights lets you
assign certain functions to specific system users. You can also assign groups to the user,
which lets him move system documents from state to state (such as
the ability to approve employee expense requests).


Note

Configuration, Parametrization, Personalization, Customization

The word personalization is sometimes used in this book where you might expect to find
configuration or customization.

Customization generally refers to something that requires a bit of technical effort
(such as creating specialized code modules) and creates a non-standard system.

Configuration is less radical – it is the general process of setting all
the parameters of the software to fit the needs of your system (often called parametrization or setup).
Configuration is also, by convention, the name of the sub-menu below each of OpenERP’s top-level menus that
is accessible only to the administrative user for that section.

Personalization is just that subset of configuration options that shapes the system to the
particular operational and/or stylistic wishes of a person or company.



Using the OpenOffice Report Designer module (base_report_designer), you can change any part of any of the reports
produced by the system. The system administrator can configure each report to modify its layout and
style, or even the data that is provided there.


Note

The OpenOffice Report Designer

The OpenOffice Report Designer plug-in enables you not only to configure the reports of the basic products in
OpenERP, but also to create entirely new report templates.
When the user uses OpenERP’s client interface, OpenOffice can create a report template
that has access to all the data available to any OpenERP document type.

You can easily create fax documents, quotations, or any other commercial document.
This functionality enables you to considerably extend the productivity of your salespeople who have
to send many proposals to customers.



Finally, you will see how to import your data into OpenERP automatically, to migrate all of your
data in one single go.

For this chapter, you should start with a fresh database that includes demo data,
with sale and its dependencies installed and no particular chart of accounts configured.
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创建一个设置模块

备份你刚刚做的Openerp模块设置，对你来说非常有用的,它使您能够:


	可通过其它数据库的设置信息自动安装模块

	假如你自己的设置有问题，可用初始设置重新安装一个干净的数据库。

	简化升级, 如果你修改了一些基本设置元素,这会对你还原初始状态造成风险, 但是如果你备份了修改信息将会有效避免风险.



用通常的方式开始安装模块 base_module_record ，从菜单 设置(Administration) ‣ 模块(Modules) ‣ 模块(Modules).
通过用户界面像往常一样手工使您的所有设置变化（例如：菜单管理，仪表台控制，屏幕设置，新报表和访问权限管理 – 一些细节将在本章后面说明）。

开始记录你的数据使用菜单 设置(Administration) ‣ 自定义(Customization) ‣ 模块创建(Module Creation) ‣导出自定义模块(Export Customizations As a Module) 。
打开向导,选择要记录的数据，你可以选择录制日期,记录类型可以选择创建 , 修改 或者创建和修改 .
你必须选择记录对象,然后点击 记录 开始录制。录制操作完成后,你需要在弹出对话框中选择保存位置.

OpenERP会记录所有的设置工作并保存成为ZIP文件,你可以在其它数据库中重新安装.这对你安装测试
服务器,并保留所有用户的设置信息到生成服务器中,非常有用.

要安装一个保存在zip文件格式的模块，使用菜单  设置(Administration) ‣ 模块(Modules) ‣ 导入模块(Import Module).
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设置菜单

OpenERP的菜单组织不受任何限制，所以你可以修改整体结构、术语和所有访问权限，它尽最大可能满足您的特定需求。
然而，你做这一切之前，就像任何其他的可自定义的软件，你应该平衡考虑这种变化的好处和成本，比如需要培训用户，
要维护新的文件，以及继续修改这个软件的后续版本。

本节介绍如何更改菜单结构和欢迎页面，设置在用户界面中菜单和表单的术语，管理用户的菜单访问权限的以及各项
基础业务对象。


修改菜单

你可以改变菜单项出现的方式和他们触发的动作，使用菜单
设置 ‣ 自定义 ‣ 用户界面 ‣ 菜单项 ,来变更菜单的显
示方式及触发动作。
在搜索视图中, 在:guilabel:菜单 字段输入整个名称找到你要编辑的菜单项目（如菜单层次结构中
指定），或在 上级菜单 指定上级菜单名称.

例如: 找到菜单项  设置/翻译/导入/导出 翻译 点击该项打开响应的表单,你能编辑这个表单 (请先不要这样操作,请先阅读下
一段), 改变它的 上级菜单 ，并移动至菜单系统任何一个位置; 编辑 菜单  可以改变
菜单树显示的内容，或者给一个新的 图标 。或者你能给一个全新的 动作 (但会导致错误的操作)

在编辑原始表单内容前,请先复制。在WEB客户端,你点击:guilabel:取消 按钮使得表单只读,然后点击”复制”按钮
（在GTK客户端，单击从顶部的菜单 表单
‣ 复制 ）.你看到是复制后的,而不是原来的菜单内容.

为了移动复制项, 通过删除或者用其它每人能看到的菜单（比如 工具 或者   人力资源）
替换的方式改变 上级菜单 字段 。
并确保该项目移动到菜单的尾部,用 99  替换 序列  字段。你
可尝试修改你喜欢的图标并保存,并刷新页面查看结果.


Tip

复制菜单

如果你打算修改菜单,请先复制. 这可以保证你找回原始的菜单信息.






为每个用户个性化欢迎页面

管理员能为每个用户设置欢迎页面和主菜单,以满足不同角色的需求.

使用 设置 ‣ 用户 ‣ 用户  为特定用户修改设置.打开特定用户的表单,
为 主页动作 和 菜单动作 字段选择不同的菜单项目。


[image: ../../../_images/new_home.png]
选择一个新的欢迎页



主页动作  是当你第一次登陆是自动打开的菜单项目。当你在在WEB客户端的右上角工具条的 Home 链接上面点击时，
也能到达。你这里能选择能通过菜单到达的任意页面 – 一个控制台是最有用的。
在GTK 客户端，通过菜单 表单 ‣ 菜单 ， 菜单动作 可以是你能通过菜单到达的任意一个。


Tip

管理员菜单的动作

非常容易改变不同用户的欢迎页面和菜单。然而，你不能改变管理员的菜单，因为你可以错误地使某些菜单完全无法访问






为字段指定默认值

你能很容易地设置系统在打开新表单时的各个字段的默认值。用默认数据预先完成这些字段，可简
化用户在输入新单据的工作。

让我们用“客户”表单来演示这个特性。创建一个新客户时 将:guilabel:国家 字段设置为  新西兰


	如果你使用web 客户端。单击 国家 字段右边的小按钮。

	如果你使用 GTK 客户端，鼠标右击字段。



从弹出菜单选择 设置默认值 。
管理能选择默认值是对指定用户有效还是对数据库中的所有用户有效.


[image: ../../../_images/set_default.png]
插入一个新的默认值



要测试这个新的配置，打开一个合作伙伴表单，在字段 国家 现在有了新西兰

这是一个非常强大的特性，管理员能用这个功能重新定义整个系统的行为。你能在数据库  openerp_ch13 测试这个，通过打开一
个新的:guilabel:采购订单 ，点击第二个选项卡  交付和开发票 ， 在  开票方式 字段选择  从收货 为默认值。

从这一刻起，只有当货物被收到时，你将自动创建采购发票草稿，所以你可以很容易地限制你的会计师支付任何发票，
直到你确信你已经收到货物。他不会阻止选择其它的发票控制方法，但他们将从定义的默认值开始


（译注：测试中发现开票方式字段 并不能设置默认值，该字段右边没有小按钮）





更改术语

你可以使用OpenERP的语言翻译功能，用更好适合你的公司的术语来取代标准术语。这是很简单的，软件以适应不同的条款
针对具体的行业。此外，这可以增强新的OpenERP系统的接受程度，因为每个人都将能够保持其一贯的词汇。

你有两条途径做这些：:


	在CSV文件里翻译他们，他给你一个全局的概况，这样你能搜索和替换各处的特定术语。

	直接在客户端翻译短语，意味你能在上下文里修改他们，当你翻译的时候给你很好的帮助。



同样的方法用来翻译那些尚未创建的术语。这是有用的，例如，那些模块还没有被翻译为英语或者其它任何你要的语言


通过CSV文件翻译

要翻译或者修改所有系统短语，你首先要导出一个翻译文件到CSV表单。要做这些，你需要安装
一个语言进入OpenERP。要装入一个OpenERP已存在的翻译，
使用 设置 ‣ 翻译 ‣ 装入一个官方翻译 ，选择语言，然后点击  装入。

然后导出它，使用 设置 ‣ 翻译 ‣ 导入/导出‣ 导出 翻译 ，选择语言，CSV 文件格式，
然后选择 一个或多个（或全部）模块。点击:guilabel:导出 开始导出过程，
然后点击 小的 保存为 ，保存文件到某个地方。


Note

UTF-8 格式

这个CSV文件用UTF-8格式编码。要确保你在电子表格程序中打开这个文件是保留这个格式，因为你如果**不保留**，
你可能会看到奇怪的乱码（重音符）




[image: ../../../_images/csv_transl.png]
在CSV文件的翻译视图



这个文件包含了6列：: module ,
type , name, res_id,
src, and value. 你必须确保第一行包含了这些列名，保持不变。

src  字段包含了英语的基础文本，value  字段包含了翻译成另一个传统的语言或专业技术短语。
如果 value  字段没有内容,英语基础文本将会做为默认显示。


Tip

你应该在哪里修改文本？?

大部分时间，你会发现要修改的文字在CSV文件中的好几行。
你应该修改哪一行？
参考这两列：type`（B列）
和:guilabel:`name （C列）。有些行在 name 列有名称 ir.ui.menu，表明这是
一个菜单项的名。
另外在:guilabel:type`列有:guilabel:`selection ，这表明，你会在一个下拉菜单项看到这个项目。



然后你要装入这个新文件到你的OpenERP系统中，使用菜单 设置 ‣ 翻译 ‣ 导入/导出 ‣ 导入翻译
。之后你有两种方法：


	你能使用相同的名称覆盖以前的翻译（所以，重新使用名称 Name Français 和代码 Code fr_FR ，你能有一个特殊的‘standard French’翻译）

	你能创建一个新的翻译文件，用户可以在“用户喜好”中选择。



如果您没有连接到翻译的语言，单击  编辑首选项 “”，从 Preferences 标签的 语言 字段选择语言，最后点击:guilabel:保存 ，装入新的语言，用新的术语。


Tip

部分翻译

你可以选择翻译部分行，删去文件中的大部分行，然后只装入改变后的行。OpenERP只修改上传的行，其它的保留原样。






通过客户端界面修改

你还能通过客户端界面在WEB客户端改变标签和其它屏幕上的项目。要做到这一点，打开你要翻译的表单，然后点击其右下角的
翻译  图标。
然后，你有的翻译选择：


	系统中的数据(包含在 字段 里)

	字段标题 ( 标签),

	表单右侧所有的 动作 按钮（ 关联 的选项）

	在表单 视图 中的术语。



你能修改这些中任意一项。

使用GTK的客户端的过程略有不同。在此，你只是一个选项卡或按钮，用鼠标右键单击。你可以选择翻译项目本身或整个视图。

当你只有几个项目要修改，这个方法是简单和快速的。但是如果要修改贯穿于整个系统中的术语，这将变得厌烦，要花费很多时间。

这种情况下，更好的方法就是采用CSV文件的翻译方法。


Tip

译文的考虑

在 GTK 客户端，修改的属于并不会立即生效,
要看到修改的效果，必须关掉当前的窗口，并且再次打开表单。
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用户登陆


Tip

Managing Passwords

如果你让用户有权更改自己的密码，你将无法直接控制他们的密码。
你应该有一个书面的关于密码强度的政策，以保证系统的安全。




Tip

通过LDAP管理用户

使用 users_ldap 模块，用户帐户可通过LDAP目录，共同管理各种不同的公司资源。
LDAP目录中的连接参数，根据公司定义进行注册。你可以提供一个用户设置文件的模板，
新用户在第一次连接到OpenERP自动创建。




Note

LDAP

LDAP协议（Lightweight Directory Access Protocol），使您通过标准的TCP/IP网络
为各种不同的资源管理公共目录这使得该公司的用户有相同的用户名和密码来访问所有
的应用程序（如Email和Intranet）。






管理访问权限

如何管理访问信息的权限，是设置OpenERP的最重要领域之一

你打算把你具有重要意义的业务全部投入系统，但你的员工只需要看到的只是它的一部分，并可能需要改变， 甚至很少。
谁应该有什么样的权利，你如何管理？

OpenERP 管理权限的方法非常灵活，每个用户可以属于一个或多个组，你属于哪个组决定了:


	每个菜单项的可见性

	数据库中的每个表的可访问性



例如，组仓库/用户 只能访问 仓库(Warehouse) 中一些菜单，可能没有任何权限访问财务信息。
在商店工作的仓库的每个系统用户被指派为仓库/用户 组的成员。如果有些用户有其它的工作
内容,他们也会被指派为其它组的成员。




组和用户

要设置权限，你将从组的定义开始。
它是重要的，组应该是贵公司工作岗位职能的代表，而不是个别员工。

因此，如果您的财务总监，也是您的销售总监，你应该创建既是一个财务总监组和销售总监组，即使它们都是同一个人，实际都应包含该
用户.这给你在未来很大的灵活性。

你还应该创建组内有不同级别访问权限的部门区域。例如，如果你创建一个销售总监(Sales Director) 组和销售(Sales) 组，避免不同组别被赋予相同的权限.第一个可以看到所有的报表，第二个被限制看到报价单。你可以使销售总监是两个组的成员，并且
销售总监(Sales Director) 组有限制的额外权力，或者给销售总监(Sales Director) 组需要的全部权力，如果销售总监
只属于这一个组。你应该选择为你提供了最大的灵活性的方案，然后坚持下去，以保持一致性。


Tip

管理访问的灵活性

为了给你自己灵活性，你可以确保一个可信任的工作人员（可能是董事，或者财务部
门工作的某人，甚至是设置员）广泛权利以使用该系统，并因管理需求授权予指定人。




菜单的访问权限

为了感受OpenERP的权限管理, 你可以创建一个新的 Stock1  用户组,此用户组拥有 仓库 菜单下的项目. 然后你再
创建一个仓库用户,并设置为 Stock1  组的成员.

要创建新组，使用菜单 设置(Administration) ‣ 用户(Users) ‣ 用户组(Groups) 。点击新建，输入组名
Stock1，然后保存。

然后创建一个新用户关联到这里，使用 设置(Administration) ‣ 用户(Users) ‣ 用户(Users) ，输入如下：


	用户姓名 : Stores Person ,

	登录名 : stores ,

	密码 : stores ,

	菜单动作 : Menu .



在用户表单中 访问权限  的部分，增加你刚刚创建的  Stock1  组。


[image: ../../../_images/menu_access.png]
可以访问仓库菜单的组



保存这个用户，然后进入 菜单  设置(Administration) ‣ 自定义(Customization) ‣ 用户界面(User Interface) ‣ 菜单项目(Menu Items) ，
取得菜单的列表，使用搜索 菜单 字段过滤列表获得 仓库 菜单项目。在这个表单的菜单明细里，增加  Stock1 进入 组 字段。从现在开始，只有 仓库管理/主管 , 仓库管理/用户 `` \ and \ ``Stock1  组的成员能
够在他们的主菜单列表中看到这个菜单项。


Tip

菜单结构

由于菜单是分层的，这样就不需要隐藏下级菜单：一旦你用这样的方式设置隐藏 仓库(Warehouse)，所有下级菜单对其它的组变得不可见。




Tip

安全

这种管理菜单访问的方法并不能保证阻止用户用其它的方式到达系统中隐藏的业务对象。
例如，隐藏发票菜单不会阻止用户通过采购和销售订单的发票到达，或者通过猜测URL。

为了有效的安全管理，您必须使用在下一节介绍的对象的访问权限管理的方法。




Note

初始的访问设置

在初始设置中,作为 系统管理 / 设置  组一员，OpenERP的 管理 级别用户拥有主菜单下
所有部分的设置菜单权限。这是惯例。
例如, 销售 ‣ 设置 ，出现在管理员的菜单中。对
其他用户，只有:menuselection:销售 –> 设置 以外的菜单可见。
同样，主菜单中的 设置 ，按照惯例，只有  设置 / 设置 组的成员的用户可见。






对象的访问权限

菜单访问权限决定了谁能访问哪个菜单，但是没有定义你能够在菜单里能做什么.

对象的权限管理,让你能够定义用户对数据的操作类别.对象的权限管理方式跟菜单权限管理有相同的结构。


Note

对象

一个对象类似系统中的一个文档. 对象被关联到数据库的表,或者是其它概念,比如字段函数,其它对象的继承,
或者赋予他们行为的类方法



如果对象没有被指派给任何组,所有用户是有无限制的权限访问.相反地,一个对象被设定了访问控制,用户必须成为组成员
才可以拥有适当的权限.

你必须始终确保你没有锁定  系统管理/访问权限组  对任何对象的”管理和设置”的权限,例如 ir.model.access 模型

你能独立管理4种访问模式：


	读访问 : 组成员能读取对象数据,

	创建 : 组成员能在对象里创建一个新纪录,

	写入 : 组成员能修改对象中记录的内容,

	删除 : 组成员能删除对象中的记录.




[image: ../../../_images/access_control.png]
会计/管理员 组的发票访问控制



To configure access rights on an OpenERP object, use the menu Administration ‣
Security ‣ Access Controls List and click New or choose an existing one
and click Edit.
You give a Name to the access control, select a Group, and
the Object, then check the checkbox corresponding to each of the four Access modes.

要设置OpenERP 对象的访问权限，使用菜单 设置(Administration) ‣ 安全设定(Security) ‣ 访问控制列表(Access Controls List) ，然后点击  新建
或者选择已经存在的一个再点击 编辑 按钮（ 在每一行的前面）。你要给出一个访问控制的 名称 ，选择一个 Group` 组
和:guilabel:对象 ，然后为四种 访问 模式逐一点击相应的复选框。编辑完成后，点击尾部的 保存 图标按钮 。

If you do not specify any group in the access rules, the rule is applied to all groups. So to remove
access to an object for all users you could create a rule:

如果你在访问规则不指定任何组，该规则将应用到所有的组。因此要去掉所有用户对一个对象的访问权限，你要建立这样的一条规则：


	定义指定对象,

	没有关联至任何组,

	然后，你能对同样的对象创建附加的规则给某些特定组特别的权限



You can then create additional rules on the same object to give specific rights to certain groups.




对象的记录规则

记录规则决定了谁能访问这个对象，依赖于针对特定对象的规则集合。你能管理四种独立的对象访问模式：

You can manage four access modes on objects independently, depending on the test:



	读访问 : 组成员能读取对象数据,

	创建 : 组成员能在对象里创建一个新纪录,

	写入 : 组成员能修改对象中记录的内容,

	删除 : 组成员能删除对象中的记录.






To configure a rule on an object, use the menu Administration ‣
Security ‣ Record Rules. The fields in the ir.rule object describe:

要设置对象上的规则，使用菜单 Administration ‣
安全设定 ‣ 记录规则 。 ir.rule 对象中的字段领域描述：



	对象 : 规则在哪个对象上



	名称 : 规则的名称



	全局 : 如果全局 被选中，这条规则将应用到所有的组，如果未选中，这条规则只应用到为此选择的组。



	过滤条件 : 对象上所有验证条件的列表。通过一组 元组列表作为python表达式进行设定。



	如果有多个测试在相同对象上面，他们将用 AND 操作符组合，根据规则得到满意结果。

	如果对象上有多个验证条件,可能根据需要设置关联方式为and的操作符组合如果有多个
规则在在相同对象上面，将使用 OR  操作符组合








	访问模式 : 读，写，创建，删除如前所述



	如果只有一个访问模式被选中，只有这个模式被应用

	如果他们都被选中，所有的访问模式都将被应用














它们都可以不选中，但至少有一个访问模式被选中。如果所有这些都未选中，将抛出一个异常。


For example : We can have a rule defined on res.partner object, which tests if the user is the dedicated salesman of the partner [('user_id', '=', user.id)]. We check only the create and write access modes and keep other access modes unchecked.

例如：如果 res.partner 对象上有个规则，测验用户是不是业务伙伴的专职销售员， [('user_id', '=', user.id)]。我们只检测创建和写访问模式，保持另外的访问模式为不选中。

This would mean that a user in the group for which the rule is applied can only create/write records where he himself serves as the dedicated salesman, and cannot create/write records where he is not the dedicated salesman. As other access modes are unchecked, the user can read/delete the records of partners where he is not the dedicated salesman.

这就意味着 ，在他自己的服务器里，作为专职销售员，被应用这条规则的组里的用户 只能创建和写他自己的记录。
那些不是专门的销售人员就不能创建/写入记录。
这意味着这个规则只允许组中为专职销售员的用户进行创建与写入,组中非专职销售员则不能创建/写入记录。至于其它模式的用户(不是一个专职销售员)能进行读和删除的操作.
记录规则也可以在用户-组表单中的 访问权限进行定义（只能为指定的组定义）。




修改历史记录


[image: ../../../_images/view_log.png]
供应商历史记录



Each record in an OpenERP database carries a note of its history. You can find out who it was
created by and when that occurred, and who last modified it and when that occurred. Click the
View Log link at the right of any form in the web client
to display a dialog box showing this information, as shown in the
figure 供应商历史记录. It can help you identify who to contact if there are any problems with the
data in the records.

OpenERP数据库的每一条记录带有其历史的说明。能找出什么时候由谁创建的，以及谁什么时候最后修改了。
查看历史记录，首先要进入开发者模式（点击右上角的感叹号按钮“关于”，再点击 激活开发者模式），在任意表单窗口标题右侧的调试视图选择框中点击“查看日志”项目，出现一个对话框显示这些信息。如图 供应商历史记录.


译注 上面这段根据实际情况重写了 by ccdos


“供应商历史记录”所示。如果记录的数据有任何问题，它能帮你识别跟谁有联系 。


Tip

审计跟踪

OpenERP有一个审计跟踪模块（模块名称是：audittrail）跟踪线索，可以用来跟踪一
个或多个对象的任何或所有的变化。这是很有用的工具,但应谨慎使用,因为它会在数据库中产
生巨量的数据.
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设置工作流和流程

工作流代表了公司不同的文档流程。它们是完全可设置的，并且定义任何单个OpenERP对象（比如一个订单）依
据条件必须遵循的路径（例如一个订单在交付前，超过一定的金额必须由销售总监批准，其它情况任何销售人员就可以）。

下图  订单 SO005 的工作流 展示了一个订单的标准工作流。你能从GTK客户端 用 销售 ‣ 销售 ‣ 销售订单  显示它，
选择一个 订单，然后进入顶部菜单    插件 ‣ 执行一个插件 ‣ 打印工作流

In the web client, you can reach a workflow from the associated cross-company process
(the process itself is reached by going to the sales document and then clicking the
Corporate Intelligence button above it).
The chapter 流程 provides all of the information
needed to create and modify technical workflows and cross-company processes.

译注：英文文档描述在6.1 已经不对应，下面根据实际情况重写

在web客户端，首先要进入开发者模式（右上角 关于，然后 点击 激活开发者模式），在表单标
题（例如销售订单）右侧表单调试视图选择框中，点击“编辑工作流”。
然后在右侧的视图切换中点击 最右的按钮“图形”，即可进入工作流的可视化编辑状态。


[image: ../../../_images/sales_workflow.png]
订单 SO005 的工作流
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设置报表

OpenERP有两种不一样的报表类型:


	统计报表：这些计算数据，往往在列表或图表的表单中显示。这些报告是动态的，可以通过客户端界面浏览包括这些数字的数据。

	报表文件：它们被用来打印系统文档。结果通常是屏幕上生成一个PDF。此外，OpenERP使您在OpenOffice.org中打开这些报表进行编辑，
在你发送他们给你客户之前，可以做任何你需要的变动。  因为 OpenERP 引擎的强大，这两种类型的报表无须任何开发就能建立和修
改，并能在OpenERP客户端界面或者OpenOffice中 直接完成。



因为 OpenERP 引擎的强大，这两种类型的报表无须任何开发就能建立和修改，并能在OpenERP客户端界面或者OpenOffice中 直接完成。


管理统计报表

许多报表已经在OpenERP中预先设置好了。你能在每个主菜单项目下面的报表子菜单找到他们。


新报表建模

OpenERP gives you the possibility of developing your own analyses to meet your specific needs. To
define a new analysis of the system’s data, you should install the module base_report_creator.
You can do so by using the Reconfigure wizard and installing Advanced Reporting.
Then as you configure the reporting tools, select Query Builder for installation.
This enables you to create complex queries on the database, in a simple and visual way.

OpenERP提供自行开发报表的功能，以满足你自己的特殊需要。要定义一个新的系统数据的分析，你
需要安装一个模块 base_report_creator 。你能使用 设置→设置→设置向导→设置向导，
选择 “OpenERP 报表设计器安装程序”，点击“作为待办事项”→ 启动，然后把表设计器另存为 到一个目录中，待用。


译注：下面的内容在6.1没了


启动向导并安装 Advanced Reporting来做。然后你设置报表工具，选择安装Query Builder。这使得你能在一个简易和可视
化的方案中建立复杂的数据库查询。

一旦模块安装完成，要创建一个新的报表，使用菜单 设置(Administration) ‣ 自定义(Customization) ‣ 报表(Reporting) ‣ 自定义报表(Custom Reports)。

Give a Report Name to your new report and select the objects that you are going to
analyse. For example, select the project.vs.hours object (you have to install Project Management for this).

给出一个新报表一个 报表名称，然后选择一个你要分析的对象。例如 选择下面三个对象：“Partner”、“Sale Order”、“Sale Order line”。
然后再打开第二个选项卡[视图参数],选择你报表所需的视图。在第一个视图选择 树，在第二个视图选择图。你能选择图显示的类型 使用 图形视图字
段。您也可以选择日历作为视图，如果你要添加日期字段在您的报告中。

Then turn to the second tab View parameters to select the views that you want in your
report. Select Tree  in the First View and Graph  in the Second
View. You can choose the type of graph displayed using the Graph View fields. You could
also select Calendar  as a view if you were going to add a date field to your
report.


[image: ../../../_images/report_analysis_config.png]
Fields selected for the project analysis



In the third tab Fields to Display you must indicate which of the fields in the list you want to be shown in your report. Complete the screen along the lines of the figure above.



	The Sequence field gives the order of the fields displayed.



	Field, the second column, enables you to select a field from any of the objects
you selected in the first tab.



	Grouping Method, the third column lets you to determine the grouping operation that
is to be applied to this field:



	Grouped : Enables you to group document entries with the same value in this field.

	Sum : Gives the sum of values in this field.

	Minimum : Gives the minimum of all the values that appear in this field.

	Maximum : Gives the maximum of all the values that appear in this field.

	Average : Gives the arithmetic average of all the values in this field.

	Count : Gives the count of all the values in this field.








	Graph Mode, the fourth column, determines if the field will appear in the graph view
and, if so, on which axis (X or Y).



	Calendar Mode, the fifth column, enables you to specify if the field can be the
basis of a calendar view.








In the fourth tab Filters on Fields, you can add filters on all the fields of the selected
objects. To do that, use the button Add filter at the
top of this tab. For the moment, do not add a filter.

You can now Save the report you defined. Click on the Open Report button to
the right of the form on the General Configuration tab to get the requested analysis.


[image: ../../../_images/report_project_tree.png]
按项目分组的任务列表统计




[image: ../../../_images/report_project_graph.png]
按项目分组的任务图形统计






设置控制台

控制台可以选择之前定义的报表,并且可指定任何一个报表在控制台的位置.

就像在报表中的字段，序列字段决定了在控制台上出现的顺序


[image: ../../../_images/dashboard_config.png]
定义一个新的仪表板



一旦控制台被定义，通过菜单 设置(Administration) ‣ 自定义(Customization) ‣ 报表(Reporting) ‣ 控制台(Dashboard Definition)，你能用 创建菜单 按键在菜单系统的任何位
置为你的控制板建立一个菜单项。






用 OpenOffice.org管理文档模版

要在openERP里设置可以打印的文档，将使用前面一节中 另存为的 插件。设置


Tip

OpenOffice.org  Writer 插件

你能使用 OpenOffice.org Writer插件 只需花费几分钟就能 建立你自己的报表。这个工具可以让你的
团队工作效率得到巨大的提升。使用它，你能为你公司的所有文档建立模版，减少创建和填入数据和客
户文档的工作。



这系统是简单和强大的，因为它给你所有OpenOffice.org Writer中提供的排版能力以及OpenERP提供的数据和计算的好处。
你可以直接从OpenOffice.org创建和修改报表，然后在OpenERP中使用


Note

OpenOffice.org的独立性

OpenOffice.org只是用来产生新的文档模版。设置员是安装它的唯一的人。

一旦文档模版被定义，用户就不需要再带入到平常的工作中。他们能够选
择Microsoft Office或者OpenOffice.org。



OpenOffice.org插件使你能搜索OpenERP的字段，集成他们到你的文档模版。你可以使用表或章节循
环数据,你可也可以在一张订单中添加多行明细，例如：

一旦新报表被定义，他就直接展示在系统用户的OpenERP客户端

There are two modes of using reports:


	用选择的记录数据生成报表产生一个PDF文档（比如开票）

	用选择的记录数据生成报表，在OpenOffice.org中打开进行修改。这让你在发送给客户前能够修改这个文档（比如报价单）



个性化的报表存储在OpenERP数据库，每个有权使用数据库的人无须安装OpenOffice.org在他们自己的计算机上就能访问。文档
的修改被保存在单个数据库


安装OpenOffice.org模块

使用报表设计器之前，你要安装两个部件:


	模块:mod:base_report_designer

	OpenERP的OpenOffice扩展，使用前面一节中 另存为的 插件：设置 openerp_report_designer.zip文件
（译注：base_report_designer模块的安装目录的plugin子目录存有此文件）。



安装模块 base_report_designer 就像其它所有OpenERP模块一样。

要安装OpenERP的OpenOffice扩展，使用前面一节中 另存为的 插件：设置 openerp_report_designer.zip文件
（译注：base_report_designer模块的安装目录的plugin子目录存有此文件）。检测OpenOffice.org 已经正确安
装在你的计算机上面，并且你有管理员权限用于安装。


[image: ../../../_images/tinyreport.png]
OpenOffice.org Writer 中的 “OpenERP Report”菜单



启动 OpenOffice.org Writer，选择菜单 工具(Tools) ‣ 扩展管理器(Extension Manager...) 打开扩展管理 对话框， 搜索openerp_report_designer.zip文件安装，然后关闭
程序，重启Writer，一个新的菜单出现在菜单条上




连接 OpenOffice.org 到 OpenERP

在 OpenOffice.org Writer 顶部菜单 选择 OpenERP Report Designer → Server parameters 。 你能输入到OpenERP server 的连接参数。你
必须选择一个 你已经安装了“采购”模块 的数据库。如果成功连接，一条信息会出现。




修改报表

报表编辑器能够做到:


	修改一个已经存在的报表，然后替换数据库之前的老版本,

	重新选择对象并创建新报表.



要修改一个已经存在的报表，选择 “OpenERP Report Designer → Modify Existing Report”。
Choose the report Purchase Order - Request for Quotation in the Modify Existing Report
dialog box, and then click Open Report.


[image: ../../../_images/openoffice_quotation.png]
修改文档模板



OpenOffice.org 然后为你打开报表进入编辑模式，你能使用OpenOffice.org Writer的标准字处理功能修改它。

在你已经设置相应的言语模块的情况,一量英文版本被修改后,当你通过客户端界面使用它的时候，它将被OpenERP的翻译系统翻
译。这样你只需要修改模版一次，即使你的系统使用了其它语言，如本章前面所述，如果你添加了字段，你将需要增加翻译，
或者更改已经存在的。


Tip

旧的报表

旧报表可能还没有全部转换为新的由OpenERP支持的形式。旧格式的数据表达式显示在双括号内，
并且不在OpenOffice.org字段内

You can transform an old report format to the new format from the OpenOffice.org menu
OpenERP Report Designer ‣ Convert Brackets -> Fields.



从 OpenOffice.org 中的 OpenERP 工具栏，可能是：:


	connect to the OpenERP server: 提供链接参数.



	
	add a loop: 选择相关字段，其中包括了建议对象可用的字段，例如 订单行。当它被打印时，对订单的每一行循环执行。

	循环能被放进表格（行将被重复）或者放进OpenOffice.org部分。







	add a field: 从整个OpenERP数据库选择对象及特定的字段。.



	add an expression:输入一个python语言表达式 从选择对象的任意字段计算数值。






Tip

Python 表达式

使用 表达式按纽，你能输入Python语言的表达式，这些表达式能使用所有对象的字段用于计算。

例如,如果你要在一个订单做做个报表，你能使用下列表达式：

‘%.2f’ % (amount_total * 0.9,)

这个列子中amount_total是order对象的一个字段。结果将是订单汇总的90%，格式化为2位小数。



你能在Openerp里面测试结果，使用菜单“采购→采购管理→询价单”




建立新报表

通常模版由循环（比如选中的订单列表）和来自对象的可循环字段组成。按你的要求格式化，然后保存为模版

已有的报表模版构成了丰富的示例。 你能开始通过增加循环和几个字段来创建一个最小的模版。

当报表已经被建立，发送到服务器，点击OpenERP Report Designer → Send to the server，带来Send To Server对话框。
一个报表的技术名称被指定为默认，使其出现在其它销售订单报表的旁边。在Report Name字段将模版改名为Sale Order New，
选中 Corporate Header 复选框，然后 点击 Send Report to Server完成。

发布到服务器，你能指定打印方式,当用户打印文档时，是否要openerp 产生一个PDF,或者在打印前，打开文档到
OpenOffice.org Writer中进行编辑。要做到这点，在字段Select Rpt. Type中选择PDF , OpenOffice (SXW) 或者 HTML。






创建报表的公用页眉

当保存新报表和修改完报表，将会有一个选项,让你选择一个页眉。这个页眉是个模版，每个数据库都会一个包含指定
内容的标准页眉及页脚。

这个模块通过改变公司信息进行自定义 ，通过菜单 设置→公司→公司。你能从列表选择你的合作伙伴公司 ，然后在一般信息
选项卡里面编辑报表页眉、报表页脚1、报表页脚2字段。如果你的公司有标记，你能让他显示在所有的报表，你能用 logo 字
段加上它。你能通过编辑 页眉/页脚，和内部页眉/页脚 选项卡的XML代码改变页眉/页脚的外观。
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数据导入/导出

通过客户端界面，OpenERP的每个表单， 都有一个标准机制 从csv文件导入数据。跟使用语言翻译相同格式。


Note

Forms and Lists



在web客户端，只读模式下的单个表单视图, 你有机会使用导入和导出功能。在其它任意视图或者表单可编辑，你不能进行
导入导出。如果你使用了GTK客户端，你能从顶部菜单的 表单→导入数据  和 表单→导出数据 找到这个功能

CSV文件格式是文本格式，兼容于多数电子表格程序（如OpenOffice Calc和Microsoft Excel）并且很容易在工作表中编辑。表
单的的第一行包含了字段的名称。后面所有的行是数据，对齐在各自列。


导出数据为CSV文件

通过在演示数据中导出一个适度复杂的合作伙伴和他们的地址数据，来开始探索 OpenERP  CSV文件的使用。

去 销售→地址簿→客户，取得 合作伙伴的列表，然后点击每条记录左边的复选框选择记录导出。然后看右侧列表中 其它选项
部分，点击 导出 的链接。弹出 导出数据对话框


	Name,

	Contact Name under the Contacts menu,

	City under the Contacts menu.



你可以点击选择一次加入一个，也可以Ctrl+点击加入多个选择 –你加入他们的顺序就是他们显示的顺序。

如果你还不想导出数据，或者希望将来使用相同的字段，你有
选项保存这些设置。要做到这点，点击 “保存字段列表”并且输入一个名称。

然后点击 “导出”并保存结果数据为  csv 文件在可访问的任何地方 – 比如你的桌面。你能在电子表格程序或者文本编辑器中打开。

你将看到你有了一个合作伙伴列表，包括 名称和每个伙伴的联系人旁边的城市。在有多个地址的情况下，合作伙伴的名称被留
空。所以，要注意条目的顺序是很关键的，这很重要 – 不要对列表排序！


Tip

列表限制

你在客户端导出的条目的数量有个限制 – 它是你可以看到的，默认情况下，web客户端是20项，但是在GTK客户端是任意的

在你显示的条目个数上面点击，您可以改变浏览的条目数量。然后你可以选择一次固定显示的条目数量，例如，50或100，或您可以选择一次查看条目的数量不受限制。






将CSV文件导入OpenERP

通过删除所有数据并输入新的数据，使用导出的文件作为一个导入文件的模版（这里你仅仅导入新数据在演示数
据旁边，但是这原理跟空白数据库是相同的）

例如：要导入几个你指定了名字和城市联系人的合作伙伴 ，能将从导出文件创建下面的CSV文件：


示例导入业务伙伴地址






	Name
	Contacts/Contact Name
	Contacts/City




	Whole Globe Technologies
	Graham Global
	Athens


	
	Wanda World
	Rome


	
	Emerson Earth
	New York


	Miles A Minute
	
	





从合作伙伴列表，点击 导入 按纽，然后在 导入数据窗口 点击 浏览 搜素并打入新的data.csv文件。
Web客户端自动匹配列名，但是gtk客户端要求你点击“自动检测”按钮。你能使用默认的选项或者根据自己的喜好修改他们

你将得到对话框 显示你的已经导入2个对象，并且当你刷新屏幕列表是，你能看到新的合作伙伴和地址。




用CSV格式文件导入OpenERP复杂数据(含关联数据)

当你导入数据时，你必须克服一个问题，就是如何在 csv 平面文件表示数据库结构。
要做这一点，有两个解决方案可以用在OpenERP里：


	导入特殊方法结构化的CSV文件，是你能从单个文件装入几个不同的数据库表（比如，合作伙伴和合作伙伴的联系人
在一个csv文件，就像上面刚刚做的一样）

	导入几个CSV文件，每个对应到一个特定的数据库表，表之间有明确的连接。




Note

服务器端导入

你也能导入csv数据通过 服务器接口。文件格式是一样的，但是但列标题略有不同。当通过用户界面导入时，
它会检查列标题名称与用户
界面表单看到的名称相匹配。相反，当通过服务器导入的列标题的名称必须和字段的内部名称相匹配。



从建立csv文件头部开始。，在你感兴趣的对象上打开导入工具，选择你要导入进OpenERP数据库的字段。你必须包括那些
标记蓝色的字段，因为这些字段是必须的（除非你知道他们默认情况下会被适当的值填充），还有其它的对你重要的字段。


[image: ../../../_images/csv_column_select.png]
选择需要从CSV文件导入的字段



在你的CSV文件的第一行，使用字段名作为列名，每列增加一个字段。当导入CSV文件时，如果你的CSV文件第一行有这些
名字，OpenERP将自动匹配列名到表的字段名。当你
创建你的CSV文件，你将这么做，点击 “全部移除”按钮清除要导入的字段，然后选择浏览你要导入的文件，再点击“自动检测”按钮。

要使导入CSV数据匹配的你数据库结构，你应该在OpenERP接口区分一下几种类型的字段：many-to-many字段（在多个源和目
标之间），many-to-one fields（多个源到单一目标），和one-to-many（单一起源到多个目标）


Note

前台表

这些类型在相关联的前台表中描述 - 表的报名表格，您正在查看的项目将由一个简单的CSV文件更新。

只是因为这些关系字段出现在前台表，并不意味着相关的表上有一个反向字段 - 但也有可能。

所以在“用户”表单里没有one-to-many字段，来反应映“客户”表单many-to-one  USER_ID销售员字段，
但有在“地址”表单有一个many-to-one
partner_id 合作伙伴名称字段 反映到 “客户”表单的 one-to-many child_ids 合作伙伴联系人。



看看下面的截屏，找出差异


[image: ../../../_images/csv_many2one.png]
many2one字段: 业务伙伴的销售员




[image: ../../../_images/csv_many2many.png]
many2many字段: 业务伙伴分类




[image: ../../../_images/csv_one2many.png]
one2many字段: 业务伙伴联系人



CSV文件中所有其他字段 被编码为每一列中只有一个文本字符串。


many2one 字段

Many-to-one字段描述了一个关系，在数据库中前台表和其它表有个单一条目到其它表。OpenERP试图通过匹配字段值用其它
表的这个字段连接前景表中的新纪录。


Tip

字段标识

如果工作在服务器端，你能使用标识符，而不是资源的名称来连接表。要做这些，你导入第
一个文件（例如：产品），在CSV文件中具有命名为ID的列，它是包含了每个产品的唯一标识
符。这可能是一个递增的数字。

当您导入其他文件链接到第一个表，你可以使用偏好的名称作为标识符（因此，例如，当您节
省库存，您可以使用的产品ID，而不是产品名称D）。然后，你不需要任何复杂的转换，以创建
两个表之间的联系。

这大大简化了从另一个数据库导入到OpenERP。你为每个要导入的表创建连接ID列，包含第一个表的标识符






many2many 字段

Many-to-many字段负责 就像many-to-one 字段试图在表之间重建关系：通过姓名搜索或者使用标识符

单个many-to-many 字段有多个可能的值。因此，一个合作伙伴能够被授予几个关联的类别。你必须用逗号分隔不同的值。




one2many 字段

One-to-many 字段 有点不同。例如: 客户表单的联系人字段，包含了所有关联的联系人

要导入这样一个字段，你不必非要链接到另一个表中的现有条目，但是可以使用相同的文件创建和链接到几个合作伙伴。
然后，您可以通过one-to-many字段方式，指定多个值给链接到那个对象的不同字段上。每个字段必须在表的一列，该列标
题必须这种形式表达：字段 field_one-to-/field_linked-object . 刚才你导入合作伙伴的数据采取这种形式。


Note

关系字段的对称性


依赖于你数据的结构，能够更容易地 使用 one-to-many 表单或者 many-to-one表
单在关联的两个表，只要相关字段存在于关系的两端


例如,你能够：


	导入 一个合作伙伴用不同的联系人在单个文件(one-to-many)

	首先导入合作伙伴，然后联系人，用这个字段连接到合作伙伴many-to-one表单










CSV文件导入的另一示例

为了说明数据导入，你可以看到下面的另一个例子。首先导入合作伙伴类别，然后导入一些合作伙伴和他们的联系人，链
接到刚刚创建的类别。虽然您可以在建立合作伙伴的同时创建新的联系人（因为你能做one-to-many关系），但这种方式
你不能建立新的类别（因为它们使用了many-to-many关系）。你必须在单独的步骤创建新的类别。


业务伙伴分类

开始在一个CSV文件中创建合作伙伴类别:


	在你的电子表格程序建立下表:





Partner categories file






	
	Column A
	Column B




	Line 1
	Category Name
	Parent Category


	Line 2
	Quality
	


	Line 3
	Gold
	Quality


	Line 4
	Silver
	Quality


	Line 5
	Bronze
	Quality








在第一行，“My Name”和“Parent Category”是列标题  相当于“合作伙伴分类”表单的字段名。

Column A是不同的合作伙伴分类，Column B 表示了类别有个上级分类。如果:guilabel:Column B 是空白的，
表明这分类是顶层.


	保存电子表格文件为CSV格式 – 逗号分割 – 命名这个文件为categories.csv。

	在OpenERP，选择 销售→设置→地址簿→本地化→合作伙伴分类。

	点击 “导入”（列表的右下方），弹出导入数据对话框，这里你将找到能被导入的字段列表。

	在文件上点击“浏览”以导入字段，然后选择 你刚刚创建的，名为categories.csv的CSV文件。

	如果你使用GTK客户端，点击 自动检测 匹配在CSV文件中的列名与合作伙伴分类的字段名匹配。

	在对话框坐上点击“导入”装入你的数据。你将在新个对话框得到信息 导入4个对象。关闭这个和导入数据对话框返回原来的页面

	刷新合作伙伴类别列表浏览分类树，包括了新的Quality分支，它的子分支就是你加载的新的合作伙伴






新建业务伙伴

这里是如何建立有多于一个联系人的新的合作伙伴，所以你做之前，如何将它们联系到这些新的类别。


	输入下表进入你的电子表格程序





Partner data file - partners.csv








	
	Column A
	Column B
	Column C
	Column D




	Line 1
	Name
	Categories
	Contacts/Contact Name
	Salesman


	Line 2
	Black Advertising
	Silver,Gold
	George Black
	Administrator


	Line 3
	
	
	Jean Green
	


	Line 4
	Tiny sprl
	
	Fabien Pinckaers
	Administrator









	第二行相当于建立一个新的合作伙伴，有两个已有的类别，两个联系人，并关联了一个销售员

	保存这个文件，用文件名partners.csv。

	在OpenERP，选择 销售→地址簿→客户，然后导入这个你刚刚保存的文件。你将得到一个信息确认你
要导入的数据，并 保存这些数据

	校验你的导入的数据。应当出现一个新的合作伙伴（Black Advertising），具有有一个销售员
(Administrator),两个联系人(George Black and Jean Green)以及两个类别(Silver and Gold)。








在其它表单导出数据

OpenERP的一般导出机制， 让你更方便导出你系统内的任意数据到任何位置。
你能不受限制地导出数据，虽然你可以使用上面讨论过的 权限管理措施来限制能导出数据的人。

你能使用这个来导出你的数据到电子表格 或者进入其它系统，比如专门的财务软件包。
导出格式通常使用CSV格式，但你使用Microsoft 的COM机制，也能直接连接到Microsoft Excel。


Tip

访问数据库

开发人员还可以使用其他技术来自动访问OpenERP数据库。两个最有用的是：


	使用XML-RPC web service，

	直接访问PostgreSQL数据库。






Tip

Module Recorder

如果你要人工输入数据到OpenERP中，你将使用在本章的第一部分描述过的模块记录器。.

通过这样做，你会生成一个可以很容易地在不同的数据库重用的模块。然后，如果有一个
数据库的问题，你就能重新安装你生成的数据模块，包括你为这个系统所做的所有项目和修改。
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实施方法


You may have mastered the technical aspects of administering and using your enterprise management
system,
but you still have a great deal of work to do integrating OpenERP into your company.
This work is more business-related and social in nature than technical.

The OpenERP implementation process encompasses several different phases:
evaluation, planning, configuration, data migration, deployment, and user training, and affects
both support and maintenance.




The management of ERP projects, and IT project management in general, are the subject of very many
other books that you might want to investigate for yourself. The elements of the methodology
presented here are not intended to be an exhaustive review, just a brief overview of the different
phases necessary to implement OpenERP in your company.


Tip

Implementation

Implementation encompasses the whole process of integrating and deploying OpenERP,
including evaluating it, establishing specifications, planning the deployment, the configuration of
the software, loading data, installation and training the users.
It does not generally extend to software customization, nor support and maintenance.





	需求分析和规划
	规划方法





	系统部署
	部署环境
	以SaaS(Software as a Service)方式部署

	服务器托管

	内部安装





	部署过程





	用户培训

	支持和维护
	更新与升级

	版本升级
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需求分析和规划

需求分析和规划是成功实施的关键. At this stage,
you should set up a management team to define the costs and benefits of the project, select a
project team, and set out the detailed stages that will have to be carried out.

OpenERP is so easy to start using that it is not always obvious, particularly to IT staff, that a
clear requirements plan is necessary for implementing the system successfully. The difficulty is not
particularly in installing the software nor in configuring it, but rather more about:


	knowing what to configure,

	deciding if you should adapt the software, or perhaps change your method of working, for some of
your specialized processes,

	forming teams that can specify and work on some of the changes,

	ensuring that your users are committed to the change.



ERP system implementation is a project carried out using information technology, but it is a business
project rather than an IT project in itself. The challenge of this type of project is in changing
the behaviour of those involved at all levels of the enterprise.

People in the IT department will certainly be an integral part of the project, but they should be
managed by someone in a senior position, who both understands the business impact across the
organization and has experience of technical projects. Ideally, the project manager should know the
company well, both its specific quirks and its different standard cross-company processes.

If the enterprise does not have its own IT group, you are probably better off opting for a SaaS
offer. This means that you subcontract all the difficult technology, from the installation of the
server to its maintenance, all the while being assured of the installation of a robust architecture
with its redundancy, backed-up servers, and separation of authentication and data.


规划方法

Planning methods vary in their degree of complexity, formality and level of automation. It is not the
intention of this chapter to steer you towards one method or the other.

OpenERP’s menus are organized to lead you through an implementation in a sensible order, so that
information that has to be entered first is encountered first in the menu system. Forms are also
organized so that if you enter data in the natural order, you will get later fields completed
automatically by the earlier ones where possible. And demonstration data illustrates how OpenERP’s
functional areas are linked from one to the other

The menus themselves hint at several helpful implementation suggestions, for example, the sub-menus of
Administration ‣ Configuration are useful for the configuration of the software.
New functions such as the Module Recorder enable you to significantly accelerate the configuration
of data.
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系统部署

As you have seen, the complete architecture of OpenERP includes the following elements:


	a database server,

	an OpenERP application server,

	an OpenERP client-web server,

	several clients that access the OpenERP server: they can either be web clients if the client-web
server is installed, or GTK clients.




Note

Deployment

Deployment is the process of putting an OpenERP database into a production-ready state,
where it can be used by everyone in your business for their daily work.
You would usually configure OpenERP and load data into it on one development system,
train staff on that or another training system and
deploy it onto a production system that has better protection against failure, better security and
more performance.




部署环境

To deploy OpenERP in your company, several options are available to you:


	a SaaS (Software as a Service) or On-Demand offer, which includes the equipment, the hosting, the
maintenance and the support on a system configured to your needs in advance,

	an internal installation, that you manage yourselves or have managed by an IT services company
such as an OpenERP partner,

	hosting by a server supplier on which OpenERP is installed, which enables you to proceed to add
adaptations on your server.



The first two approaches are the most commonly used.


以SaaS(Software as a Service)方式部署

SaaS is a complete package hosted at a supplier, that includes the following services: server
hardware, hosting of the generic solution, installation and initial configuration, redundancy of the
architecture, backups, system maintenance and support. It is also known as On-Demand.

It is provided in the form of a monthly subscription with a fixed price per user. You can find the
detail of Tiny’s SaaS packages at http://ondemand.openerp.com/.

SaaS packages do not permit you to develop specific modules to your needs. On the contrary, they
offer a service at a set price based on standard software modules that contain few migration risks.
SaaS suppliers are limited generally to the modules certified and validated by the original author
and project manager, Tiny.

Here are the main advantages of an OpenERP SaaS solution:


	an unbeatable return on investment (cost of implementation: 0, cost of licenses: 0),

	costs that are controlled and without surprises (the offer includes maintenance, frequent
migrations and support),

	a turnkey solution, installed in less than twenty-four hours,

	packages adapted and preconfigured for different sectors of activity,

	a very robust architecture guaranteed to have constant and permanent access, reachable from
anywhere.



So this server is recommended for small companies with fewer than about fifteen employees.




服务器托管

At first sight, a hosted OpenERP system appears similar to SaaS: it provides OpenERP from a
remote installation through a web browser. But in general, the similarities stop there.

To compare it with an SaaS package, you should check if the hosting offer properly includes the
following elements:


	server hardware,

	hosting,

	maintenance,

	future migrations,

	backups,

	server redundancy,

	telephone and email support,

	frequent updates to the modules.



Also get yourself up to speed on the following points:


	the version of OpenERP proposed,

	the costs of implementation (configuration, data loading, training),

	the cost of configuration (if it is proposed),

	the technology and the procedure used for securing your database,

	the technology and the procedure for preventing system faults,

	the technology and the procedure for restoring a faulty system,

	limitations on the number of users, the number of simultaneous users, and the size of the
database,

	the level of support and its costs,

	the procedure used to update OpenERP (to fault-fixed versions)

	the procedure adopted for OpenERP upgrades (to versions that have both fault fixes and new
functionality).



Calling such suppliers can be a good solution if you are willing to entrust all the technical
specifications for the functioning of OpenERP to them, especially if you need to use customized or
extension modules that are not in the stable version released by Tiny.




内部安装

Large and medium-large companies typically install OpenERP using their own internal company
resources. They usually prefer to have their own IT service in charge of maintenance.

Such companies can do the implementation work themselves internally, or turn to an OpenERP partner
who will do the ERP implementation work or assist them with it. Generally, companies prefer to adopt
an intermediate solution which consists of:



	Turning the initial implementation over to a partner to limit the risks and delays of integration.
That enables them to be managed by experts and obtain a high quality configuration.

	Taking charge of the simple needs for themselves once the software has been implemented. It is
quite a lot more convenient for them to be able to modify the database tables, forms, templates and
workflows internally than routinely depend on a supplier.






An internal installation will probably prove more costly than a SaaS package or hosted service.
Even if you put yourself in charge of it all, you will take quite a bit of time learning how to manage
the implementation unless the team already has an experience of OpenERP. This represents a
significant risk.

However, an internal implementation can be particularly interesting when:


	you want to keep your data within your company,

	you think you want to modify your software,

	you want a specific package of modules,

	you would like a very fast response time,

	you want the software to be available even if your Internet connection goes down.



These factors, and access to the resources needed to handle an implementation and the subsequent
maintenance, are the reasons that large and medium-large companies usually do it for themselves, at
least partly.






部署过程

The deployment of a version of OpenERP is quite simple when your server has been configured in
your production environment. The security of data will then be a key element.

When you have installed the server, you should create at least two databases:


	a test or development database, in which the users can test the system and familiarize themselves
with it,

	a production database, which will be the one used by the company in daily use.




Note

Version Numbering

OpenERP uses a version numbering model that comprises 3 numbers A.B.C (for example 4.2.2 or
5.0.0) where changes in the number A signify a major functional change, changes to number B signify
an update that includes a batch of fault fixes and some new functionality, and the number C
generally refers to some limited updates or fixes to the existing functionality.

The number B is special: if it is an odd number, (for example 4.3.2 or 5.1.0) it is for a development
version which is not designed for a production environment. The even numbers are for stable
versions.



If you have prepared a data module for OpenERP (that is a module that consists just of data, not
altered functionality), you should test it in your development version and check that it does not
require any more manual adjustments. If the import runs correctly, it shows that you are ready to
load your data in the production database.

You can use the OpenERP database backup procedure at different stages of configuration (see
安装与初始配置). Then, if you have made a false step that you cannot recover from, you can always return to a
prior state.

Since your data describes much of your company’s value, take particular care both when you need to
transfer it (in backups and across your network) and when you are managing the super-administrator
password. Make sure that the connection between a PC client and the two servers is correctly
secured. You can configure OpenERP to use the HTTPS protocol, which provides security for data
transfer


Note

HTTPS

The HTTPS protocol (Secured Hyper Text Transfer Protocol) is the standard HTTP protocol secured by
using the SSL (Secure Socket Layer) or TLS (Transport Layer Security) security protocols.
It allows a user to verify her identify to the site to which she wants access, using a certificate
of authentication.
It also guarantees the integrity and confidentiality of the data sent between the user and the
server.
It can, optionally, provide highly secure client authentication by using a numbered certificate.

The default HTTPS port is 443.



You could also use the PostgreSQL database directly to backup and restore data on the server,
depending on access rights and the availability of passwords for the server.
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用户培训

Two types of training are provided by the Tiny company and its partners:


	Technical training in OpenERP: the objective of this intensive training is to enable you to
develop your own modules by modifying and adapting the existing ones. It covers the creation of new
objects, menus, reports and workflows, and also of interfaces with external software. It lasts for
five days and is designed for IT people.

	User training: this enables you to be productive as rapidly as possible in the use of OpenERP.
All of the modules there are detailed with concrete examples and different exercises. For the sake
of realism, the training uses data for a fictitious company. This training also lasts for five days.
It is designed for those responsible for an ERP project, who will then be capable of training
employees internally.



Tiny’s training calendar is available on the official OpenERP site at
http://www.openerp.com/services/training-schedule. The training is delivered in either French or English,
depending on the course.

Both Tiny, the creators of OpenERP, and the OpenERP partners can also provide customized
training. This, although more expensive, is focused on your own needs.

Your training needs depend on the type of deployment you have chosen. If you have opted for a SaaS
development, technical training is not very useful.

In summary, you should arrange both user training and self-paced training (perhaps based on this
book series) if you can. Technical training is strongly advised if you see yourselves developing your own
modules. Although it is not obligatory, it gives you quite a time advantage in any serious OpenERP
engagement.
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支持和维护

It is when you actually use your ERP that you will obtain value from your investment. For that reason,
maintenance and support are critical for your long term success.


	Support aims to ensure that end users get the maximum productivity from their use of OpenERP, by
responding to their questions on the use of the system. Support can be technical or functional.

	Maintenance aims to ensure that the system itself continues to function as required. It includes
system upgrades, which give you access to the latest functionality available.



Some partners offer preventative maintenance. This makes sure that all the specific developments for
your system are revised and tested for each new version so that they remain compatible with the base
OpenERP.

Tiny themselves have changed their support strategy from time to time. At the time of writing,
they propose a maintenance contract supplied either direct to the end user or through partners
that guarantees a quick fix to any faults discovered in the covered code. Although you can
expect these fixes to become available to all users of the code in time, maintenance
guarantees quick attention. And you are likely to get quicker migration support to new upgrades.

If you have not anticipated your needs with a preventive maintenance contract, the costs of migration
after a few years can become significant. If special modules that you developed have been allowed to
become too old, you may eventually need a new development according to your specifications.


更新与升级

There are four sources of code change for OpenERP:


	patches supplied by Tiny to correct faults: after validation these patches should not cause any
secondary effects,

	minor updates, which gather the fault corrections together in one package, and are generally
announced with a modification of the version number, such as from 6.0.0 to 6.0.1,

	upgrades, which bundle both the fault corrections and the improvements to the functionality in a
major release, such as from 6.0.3 to 6.2.0,

	new functions, generally released in the form of new modules.



You should establish a procedure with your supplier to define how to respond to changes in the
OpenERP code.

For simple updates, your maintenance team will evaluate the patches to determine if they are
beneficial to the use of your OpenERP. These patches should be tested on an offline instance of
OpenERP before being installed in your live production version.

The maintenance team would also take charge of regular updates to the software.

Patches and updates can only be installed if you have the necessary access to the OpenERP server.
You must first install the patch or update and then restart the server using the command line: --update=all .

Once Tiny has released a new upgraded version, your response should be a cautious one. If you are
perfectly satisfied with the existing system, it would be best to not touch the new version. If you
want to have access to the new functionality supplied by an upgraded version, you have a delicate
operation to carry out. Most upgrades require your data to be migrated, because the databases before
and after the upgrade can be a little different.




版本升级

OpenERP has a system to manage migrations semi-automatically. To update specific modules, or the whole
database, you only need to start the server with the argument: --update=NAME_OF_MODULE or
--update=all (that is minor module changes).

New stable versions of OpenERP sometimes require operations that are not provided in the automated
migration. Tiny, the creator and maintainer of OpenERP, has a policy of supporting migration from
all official stable releases to the latest. Scripts are provided for each new release of a stable
version. These carry out the upgrade from the previous major version to the new major version.

Managers responsible for the migration between two versions of OpenERP will find the
documentation and the necessary scripts in the directory doc/migrate of the OpenERP
server.

The changes between version 4 and 5 made the migration process more difficult than in the past,
so there was a greater delay in the provision of migration assistance and more manual work
than usual.

The procedure for migrating runs like this:



	Make a backup of the database from the old version of OpenERP.

	Stop the server running the old version.

	Start the script called pre.py for the versions you are moving between.

	Start the new version of the server using the option --update=all .

	Stop the server running the new version.

	Start the script called post.py for the versions you are moving between.

	Start the new version of the server and test it.






A migration is never an easy process. It may be possible that your system does not function as it did before,
or that something requires new developments in the functionality of the modules that have already
been installed. So you should only move to a new version if you have a real need, and should engage a
competent partner to help if the version that you use differs greatly from the basic version of
OpenERP.

Similarly, you should take care that this migration does not incorrectly change any setting
that has already been made. The main menu structure might have been modified in place
without proper recording of the changes.
So you could find that you are making the wrong assumptions about that structure
when later loading data that was recorded with the Module Recorder.
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Google 模块

OpenERP集成了谷歌应用, 可以在Google上访问OpenERP数据, 请参考模块描述.

请移步到: lp:~openerp-commiter/openobject-addons/trunk-extra-addons 下载模块.



	Google 翻译

	Google 日历

	Google 博客

	Google Earth
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Google 翻译

模块名:
google_translate

本模块可以将OpenERP 中terms/fields/objects等数据通过 Google 翻译服务翻译成Google翻译服务支持的其它语言。

可以在菜单 Administration/Translation/Application terms/下找到 Translation Terms 和 Need review terms 翻译入口。

下面的图例演示了模块如何将 “how are you” 翻译为简体中文:


Note

如果你设置了 Need Review 项 就能按给定的语言翻译。



翻译前


[image: ../../../_images/translate.png]


翻译后


[image: ../../../_images/translate_dest.png]
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Google 日历

模块名:
google_calendar

本模块可以同步 Google日期中的事件同 OpenERP 事件. 用户可以在任何地点从Google日历上更新 OpenERP事件 或者 从OpenERP 事件中 更新 Google日历项.

菜单项: Event Organization/ Google Import Export/ Synchronize Events

Google 日历项


[image: ../../../_images/google_event.jpg]


OpenERP 事件


[image: ../../../_images/tiny_event.jpg]
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Google 博客

模块名:
google_blogger

本模块将 Google博客与 OpenERP 任务管理做了集成, 以便可以将任务更新到博客中,更好地将OpenERP任务在博客中进行互动.

一个非常有用的功能是, 将任务公示到博客会激发完成任务的动力.

还可以用于简化多任务,多用户并行管理.有利于在任务进行中共同兴趣点的用户进行分享交流.

下面的图例中演示了如何将 OpenERP 的任务 发送到 Google 博客平台.

Google 博客


[image: ../../../_images/google_blog.jpg]


Openerp 任务


[image: ../../../_images/tiny_blog.jpg]
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Google Earth

模块名:
google_earth

模块功能:


	可以在 Google 地图上标注业务伙伴的名称,地址,编码,icon等

	可以按国家显示营业额, 如按不同的颜色深度来表示各个国家的营业额大小.

	可以用近10种颜色来区分城市与城市间的送货物流送货路线图.

	可以创建可用于 Google Earth 动态更新的 KML 文件.

	还可以直接在浏览器中打开 Google 地图 来显示信息.

	可以生成 KML 文件保存并用于 Google 地图与 Google Earth.



菜单


[image: ../../../_images/menu_earth.jpg]


在 Partners/ Google Map/Earth 菜单下面, 你可以找到5个菜单或者向导:

KML 文件:

在用 google_earth 模块前, 你最好先了解一下 什么是 KML 文件, 以及如何在 Google 地图与 Google Earth 中使用它.


Tip

KML 标记

KML 是一种用于在 地理浏览器(如 Google Earth, Google 地图或者 Google 手机地图)上显示 地理数据的文件格式.KML 通常使用 基本于XML标准的带内嵌套元素与属性结构化文本描述语言. 所有标签都大小写敏感并且符合 KML参考所提出的规范. Reference indicates 是可选的. 在一个元素内, 所有的标签都需要按序出现.



请参阅:

http://code.google.com/apis/kml/documentation/kml_tut.html

http://code.google.com/apis/kml/documentation/topicsinkml.html

http://code.google.com/apis/kml/documentation/kmlreference.html

现在来看看怎么样将一个 KML 文件上传到 Google 地图:

第一步: 先创建一个地图链接

第二步: 导入

第三步: 上传 KML 文件

看看 Google 地图与 Google Earth 的异同:

Google 地图只能通过浏览器访问. 而 Google Earth 则是一个下载后安装在你电脑上, 通过桌面应用访问卫星地图的软件. 虽然这样, Google 还是会定期同步更新两款产品的功能.尽量操持两款产品的一致性.

上传完 KML 文件后, 可以在 Google 地图片看到:


	业务伙伴同国家的KML文件 Partner-Country




[image: ../../../_images/google_map.jpg]


下面的截图展示了 业务伙伴的国家, 以及业务伙伴在这个国家的营业额. 在地图上通过点击选中的国家,能获取该国的业务伙伴数, 业务往来以及整个国家的营业额.


Note

深色与浅色的颜色差异代表了营业额的差异。




	用于发货路线的KML文件 Delivery Route




[image: ../../../_images/earth_delivery.jpg]


下面的截图展示了 从仓库到客户的送货线路图, 图中用不同的颜色区别了配送不同区间. 当点击各个配送路线段时, 还可以查看详细的客户收货,公司送货, 送货信息.


	用于业务伙伴 的 KML 文件 Partners




[image: ../../../_images/partner_map.jpg]


下面的截图展示了 全球的所有业务伙伴, 可以在地图中标出业务伙伴的特定地址, 点击这些点可以获取业务伙伴的如 名称, 代码, 业务伙伴类型(客户? 供应商?), 地址, 营业额, 销售额, 采购额, 应收汇总等等信息.


	网络分享向导 Network link




[image: ../../../_images/earth_wizard.jpg]



Tip

分享KML链接:

一种可以在网络上存储的可访问的 KML 文件URL地址.



本向导可以完成 上传生成的KML文件到 Google Earth 或者 Google 地图, 并生成网络分享链接. 你还可以设置定时完成 KML文件数据更新参数(更新时间, 频次等等). 下面的例子中演示了如果 在添加一个新的业务伙伴,并让 Google Earth 能获取该业务伙伴的一些信息.


Note

如果你勾选了 按业务伙伴和按国家 方式. 向导会按要求分别创建两个 KML 文件, 并生成两种方式的查看的网络链接. 这时, 你可以上传这些 KML 文件, 并能在 Google Earth 上查找到相应的 业务伙伴及 国家信息. 并可以按 给定的更新频次更新这些信息.



向导生成的网络链接会需要配置:

First, path 你的WEB服务器提供的 信息 service 的 接口网络地址(URL).

RefreshMode 指定数据更新模式, 有下面几个选项:


onChange - 当链接参数发生变化时(这是默认的选项).

onInterval - 按 refreshInterval 秒数进行周期更新.(参见 <refreshInterval>).

onExpire - 按文件的到期时间进行更新.




RefreshInterval 指定更新的周期秒数

ViewRefreshMode 查看模式时的更新设定 指定 “Camera” 更改时, 链接更新.


never(default) - 查看时，忽略 <viewFormat> 参数，不更新。(默认选项)

onStop - 查看时, 停留 viewRefreshTime 指定秒后, 再更新。 参阅 <viewRefreshTime>.

onRequest - 用户手动更新(如在 Google Earth 中, 用户右键菜单中的”更新”)

onRegion - 仅更新查看的区域的文件.




View Refresh Time 指定当停止移动地图后查看时停滞时间(秒)


	打开Google 地图向导*




[image: ../../../_images/open_map.jpg]


本向导可以直接在浏览器中打开 Google 地图.

如: 你想在地图上查看 合作伙伴-国家 数据, 你可以直接打开向导.

在上图中的 Path 字段里 “http://maps.google.com/maps?q=” 后面提供了一个 web-client 的URL. 另一个字段则指定了地图上显示 “合作伙伴”, “合作伙伴/国家”,还是”送货路线”. 然后 就可以按你指定的参数打开Google 地图。

你打开后的浏览器的URL 看起来类似 http://maps.google.com/maps?q=http://yourserver.com:port/kml?model=res.partner 。
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结语

横览企业管理系统这个千变万化生态圈，不管是在诸如SAP、甲骨文（Oracle）、微软（Microsoft）等软件巨头的统治领域，
还是在小型软件开发者的一亩三分地，OpenERP俨然已经树立起自己免费接替者的角色。

迄今为止，企业如何管理自己的信息系统，只有两种方法可选：购买并安装一套专有的、完整的，但常常又是用力过头的、
难以适应改变的，并且是昂贵的ERP系统；或者是内部自行开发一套系统，仅仅适用于现有需求，但进一步开发又非常昂贵、
整合性不高，并且不是很完整。

OpenERP凭借其自由的商业模型，整合了ERP系统应有的完整性和环境可适应性（灵活性）。开发的源代码、项目的通用灵活性，
及其成百上千个模块，可以让你通过适当选择组合，即可构建一套自有的解决方案，并根据发展的需求，自由更新。

The results will be at the top end of what you might expect from any ERP system,
let alone an Open Source system.
The considerable gains in productivity, efficiency and visibility become apparent only a few months
after implementation.
And you can gain from increased operational quality even if you reduce your human resourcing
intensity.
Because there are fewer repetitive tasks for your staff to do,
they can concentrate on higher value-added work.
We frequently receive the gratitude of senior management who get better results from their
business because they have adopted OpenERP.


你不是一个人在战斗

Many resources are at hand to accompany you on your OpenERP adventure.


使用SaaS让烦人的技术问题见鬼去吧

For a quick low-cost start, you can make use of a month’s comprehensive free trial of Tiny’s
OpenERP SaaS package found at http://ondemand.openerp.com/.
Using this, you sidestep any technical difficulties and get a
comprehensive set of system administration services, server hosting, configuration to your
environment, maintenance, support and initial training.

A SaaS package is suited to the needs of small enterprises that do not have very specific needs, and
where the initial cost and the delay of implementation are critical factors.

To meet its objectives of minimal cost, the SaaS package aims for highly automated standardized data
migrations, minimal support load by training customers well, and a strict limit to the number of
modules offered. So you cannot use your own modules, and are limited to the standard modules that are
included in various package levels.




购买咨询,少走弯路

Larger companies often prefer a more classic implementation path. Even though OpenERP’s simplicity
makes this task easier than with other systems, you cannot hide the fact that a project
implementation is complex and introduces big changes to a company.

So you can turn towards some of the different actors in this free software ecosystem to help you
out:


	the community of users and developers,

	Tiny’s OpenERP partner companies,

	the main project developers, Tiny, themselves.




社区用户与开发者

The community, supported by Tiny, hosts a set of communication tools which can help you in your
OpenERP investigation.


	The forum http://openerp.com/forum



The forum enables you to discuss issues with other OpenERP users. It is very active and you have a
good chance of receiving some form of response to your questions within twenty-four hours or so.


	The wiki http://openobject.com/wiki



The OpenObject wiki is used to manage activities around OpenERP.

You will find information about:



	Shared Funding Projects

	IRC Meetings

	Real Life Meetings (e.g. Community Days)

	Business Intelligence

	Open Report (e.g. OpenReport, OpenOffice Plugin)







	Database of OpenERP modules http://doc.openerp.com/v6.0/py-modindex.html



所有可用模块的数据库应用让你自由接入到已知的OpenERP的扩展当中


	Launchpad https://code.launchpad.net/~openerp/



最近的传输通讯工具是那个主控所有系列OpenERP源码（使用*bzr*源码控制系统）
和用作报告错误的launchpad系统。它已占据OpenERP技术的核心位置。




OpenERP 官方合作伙伴

If you need contract-backed guarantees for implementing and maintaining OpenERP, you can contact an
official OpenERP partner. OpenERP partners offer various services such as user training,
prototype installations, and change management services. The complete list of partners by country
and by type can be found on the official OpenERP site: http://openerp.com/partners




主导开发者: Tiny

Finally you can call the main project developers, Tiny, who can help you in your OpenERP project.
Tiny offers various services, such as free demonstration days for the software, user training and
technical training, support contracts, maintenance contracts and developments as required. Depending
on the demand, they can also put you in contact with partners most aligned to your requirements.


	The mailing list To keep up to date with all OpenERP’s news you can subscribe to the mailing list using http://tiny.be/mailman/listinfo/tinyerp-announce.



To conclude, do not forget that OpenERP has more than two hundred modules available and that many
of them have not been covered in this book. So if you have not found a solution to your problems here,
look amongst those modules, talk to other OpenERP users on the forum, and do not hesitate to
contact a partner.

Wishing you the greatest of success in your ERP project,

— Geoff Gardiner and Fabien Pinckaers.
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简介

OpenERP是一个强大的开发环境。由于它结合运用了Python和PostgreSQL，尤其是它采用对象关系映射（ORM），
您可以以此为平台，开发出任意复杂的模块。




本书的目标读者




目录

Book Contents




可爱的作者们


Note

2011年4月，北京邮电大学的一位老师联系上了当时OpenERP云实施团队的Jeff，希望能购买一次开发技术培训。
他们有个实验室，由导师带着一些研究生做一些国家级项目。他们希望用OpenERP定制一个实验室管理系统，自
己来用。培训时间是三天，培训后一个月，这位老师把一些中文文档发给了我。说是他们的学生翻译的OpenERP
技术开发手册，希望能贡献给社区。这就是这本developer book的第一个版本。今天有机会把这些文字合并到官
方文档里，算是给学生们的辛勤劳动找到了最好的归宿。
从目录名上猜测参与翻译的有：combo,wk,wsx,yhs,zzz。
文档基于5.0版本的OpenERP，翻译中还有些疏漏和问题，只要有人愿意付出时间，完善指日可待。
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OpenERP 开发入门








安装


Windows下安装


	Windows 下安装:

	
	执行位置

	步骤










Debian/Ubuntu安装


.deb 安装包下载





获取源代码

为了获取源代码,您需要使用版本控制工具从Launchpad网站检出源码。根据你的开发环境检查如何安装Bazaar。安装和配置好bazaar后,输入如下命令准备开发环境:

mkdir source;cd source





输入下面的命令获取OpenERP设置脚本:

bzr cat -d lp:~openerp-dev/openerp-tools/trunk setup.sh | sh





下面命令获取OpenERP当前开发分支源代码:

make init-trunk





（译注：这里要执行很长很长很长的时间，别傻等，去睡吧）

通过如下命令可以查看其它关于make命令的选项:

make





为使用 OpenERP 需要安装一些依赖包。根据您的环境，可能需要安装以下包:

sudo apt-get install graphviz ghostscript postgresql python-imaging python-matplotlib





然后你需要初始化数据库。这里将创建一个新的openerp角色:

make db-setup





最后运行 OpenERP 服务:

make server





可以通过 http://localhost:8069/ 测试你安装好的OpenERP




开发版

预留章节，用于明确开发版本和其他细节






配置

有2个配置文件：



	客户端配置文件: ~/.openerprc

	服务端配置文件: ~/.openerp_serverrc






这些文件遵循python的ConfigParser模块规范。

以”#”或者”;”开头的行是注释。

客户端第一次启动会自动生成配置文件。服务端配置文件可以使用下面命令生成:

openerp-server.py -s





如果上面的配置文件不存在，服务端和客户端将按照默认配置启动。

服务端配置文件

服务端配置文件  .openerp_serverrc  用于保存服务启动参数。
以下是可用的参数:





	interface:	服务器绑定的IP地址









	port:	监听端口









	database:	数据库名称









	user:	数据库连接帐号用户名









	translate_in:	导入翻译文件









	translate_out:	导出翻译文件









	language:	默认载入语言. 必须是符合 W3C 标准的 ISO 国家代码，









	verbose:	开启调试输出









	init:	初始化模块(“all”为所有模块)









	update:	更新模块(“all”为所有模块)









	upgrade:	升级/安装/卸载 模块









	db_name:	指定数据库名称









	db_user:	指定数据库用户名









	db_password:	指定数据库用户密码









	pg_path:	指定PostgreSQL数据库可执行文件路径









	db_host:	PostgreSQL数据库主机名









	db_port:	PostgreSQL数据库端口









	translate_modules:

		指定导出翻译模块，与 –i18n-export 参数一起使用





通过指定  -s 或 –save 参数从命令行启动服务，可以创建你自己的配置文件。
你也可以使用 -c <配置文件路径> 或 –config=<配置文件路径> 参数，加载配置文件启动服务。
以下是基本的服务端配置:

[options]
verbose = False
xmlrpc = True
database = terp
update = {}
port = 8069
init = {}
interface = 127.0.0.1
reportgz = False





OpenERP GTK 客户端V5.0的配置文件示例

[printer]
path = none
softpath_html = none
preview = True
softpath = none

[logging]
output = stdout
logger =
verbose = True
level = error

[help]
index = http://www.openerp.com/documentation/user-manual/
context = http://www.openerp.com/scripts/context_index.php

[form]
autosave = False
toolbar = True

[support]
recipient = support@openerp.com
support_id =

[tip]
position = 0
autostart = False

[client]
lang = en_US
default_path = /home/user
filetype = {}
theme = none
toolbar = icons
form_tab_orientation = 0
form_tab = top

[survey]
position = 3

[path]
pixmaps = /usr/share/pixmaps/openerp-client/
share = /usr/share/openerp-client/

[login]
db = eo2
login = admin
protocol = http://
port = 8069
server = localhost








指定运行时命令行参数


常规参数






	
--version
	显示版本信息，然后结束

	
-h, --help
	显示帮助信息，然后结束

	
-c CONFIG, --config=CONFIG


		指定配置文件

	
-s, --save
	保存配置文件到 ~/.openerp_serverrc

	
-v, --verbose
	开启调试模式

	
--pidfile=PIDFILE


		存储服务启动的 PID 文件

	
--logfile=LOGFILE


		存储LOG的文件

	
-n INTERFACE, --interface=INTERFACE


		监听IP地址

	
-p PORT, --port=PORT


		监听 TCP 端口

	
--net_interface=NETINTERFACE


		netrpc 监听IP地址

	
--net_port=NETPORT


		netrpc 监听端口

	
--no-netrpc
	禁止 netrpc 协议

	
--no-xmlrpc
	禁止 xmlrpc 协议

	
-i INIT, --init=INIT


		初始化模块 (“all” 参数为初始化所有模块)

	
--without-demo=WITHOUT_DEMO


		加载 demo 数据 ( “all” 参数为加载所有模块的demo 数据)

	
-u UPDATE, --update=UPDATE


		升级模块 ( “all” 参数为升级所有模块)

	
--stop-after-init


		初始化后停止运行

	
--debug
	开启调试模式

	
-S, --secure
	https 协议

	
--smtp=SMTP_SERVER


		SMTP 服务器










数据库相关参数:






	
-d DB_NAME, --database=DB_NAME


		指定数据库名

	
-r DB_USER, --db_user=DB_USER


		数据库用户名

	
-w DB_PASSWORD, --db_password=DB_PASSWORD


		数据库密码

	
--pg_path=PG_PATH


		PostgreSQL可执行文件所在路径

	
--db_host=DB_HOST


		数据库主机名或IP地址

	
--db_port=DB_PORT


		数据库端口










多语言相关参数:



用这些选项把OpenERP翻译成其他语言。详见OpenERP用户手册的
多语言章节。 ‘-l’ 选项是必输的。






	
-l LANGUAGE, --language=LANGUAGE


		指定翻译语言。与 –i18n-export 或 –i18n-import一起使用。

	
--i18n-export=TRANSLATE_OUT


		导出翻译语言为CSV文件，然后结束

	
--i18n-import=TRANSLATE_IN


		导入CSV翻译文件，然后结束

	
--modules=TRANSLATE_MODULES


		指定要导出翻译的模块。与 –i18n-export 一起使用










之前版本的配置选项:

某些参数在OpenERP6中被移除了。如 price_accuracy 现在是通过  小数精度  配置。
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架构


MVC 架构

在 Wikipedia [http://zh.wikipedia.org/zh/MVC], “MVC模式（三层架构模式）（Model-View-Controller）是软件工程中的一种软件架构模式”. 一个复杂的电脑应用程序会展示大量的数据给用户, 人们希望将数据(model)和界面(view)分离。 改变用户界面并不会影响数据管理，在不改变用户界面的基础上，数据可以得以重新整理。 MVC模式（三层架构模式）通过引入控制器来解耦数据读取和商业逻辑，同时解决数据呈现和用户交互的问题。


[image: ../_images/MVCDiagram.png]
MVC 图解



例如上图中, 带有箭头的实线从控制模同时指向试图和模型，其中的含义是说控制模块对试图和模型具有完全访问权限。 The dashed line for the arrow going from the view to the controller means that the view has a limited access to the controller. The reasons of this design are :



	From View to Model : the model sends notification to the view when its data has been modified in order the view to redraw its content. The model doesn’t need to know the inner workings of the view to perform this operation. However, the view needs to access the internal parts of the model.

	From View to Controller : the reason why the view has limited access to the controller is because the dependencies from the view to the controller need to be minimal: the controller can be replaced at any moment.







OpenERP MVC 模型

在OpenERP中，我们可以这样应用model-view-controller语义：



	Model : PostGreSQL数据表

	View : 在OpenERP中定义XML文件

	Controller : OpenERP的对象









MVCSQL


Example 1




例子1

假设销售在sale.order对象中相关的sale_order表中是一个可变记录，你可以用使用下面的代码得到这个变量:


sale = self.browse(cr, uid, ID)


(数据库游标中，cr是当前行，uid是当前用户的ID,为了安全起见，ID是销售订单的ID，如果要得到多个结果的时候，ID就为多个销售订单ID的列表)

假设你想要根据第一个合作伙伴相关的销售订单ID取得相应的国家名，那么你可以在OpenERP中如下实现:


country_name = sale.partner_id.address[0].country_id.name


如果你要用传统的SQL开发写相同情况的代码，用 python 是这样的：（cr 是系统中数据库的游标(cursor)）

cr.execute('select partner_id from sale_order where id=%d', (ID,))
partner_id = cr.fetchone()[0]
cr.execute('select country_id from res_partner_address where partner_id=%d', (partner_id,))
country_id = cr.fetchone()[0]
cr.execute('select name from res_country where id=%d', (country_id,))
del partner_id
del country_id
country_name = cr.fetchone()[0]





Of course you can do better if you develop smartly in SQL, using joins or subqueries. But you have to be smart and most of the time you will not be able to make such improvements:



	Maybe some parts are in others functions

	There may be a loop in different elements

	You have to use intermediate variables like country_id






The first operation as an object call is much better for several reasons:



	It uses objects facilities and works with modules inheritances, overload, ...

	It’s simpler, more explicit and uses less code

	It’s much more efficient as you will see in the following examples

	Some fields do not directly correspond to a SQL field (e.g.: function fields in Python)









Prefetching

Suppose that later in the code, in another function, you want to access the name of the partner associated to your sale order. You can use this:

partner_name = sale.partner_id.name





And this will not generate any SQL query as it has been prefetched by the object relational mapping engine of OpenERP.




Loops and special fields

假如现在你想计算一个区域10个销售订单总数. 在OpenERP中通过一个对象如下操作:

def get_totals(self, cr, uid, ids):
   countries = {}
   for sale in self.browse(cr, uid, ids):
      country = sale.partner_invoice_id.country
      countries.setdefault(country, 0.0)
      countries[country] += sale.amount_untaxed
   return countries





并且, 你能加打印他们的好的方法到你的对象中:

def print_totals(self, cr, uid, ids):
   result = self.get_totals(cr, uid, ids)
   for country in result.keys():
      print '[%s] %s: %.2f' (country.code, country.name, result[country])





The 2 functions will generate 4 SQL queries in total ! This is due to the SQL engine of OpenERP that does prefetching, works on lists and uses caching methods. The 3 queries are:



	Reading the sale.order to get ID’s of the partner’s address

	Reading the partner’s address for the countries

	Calling the amount_untaxed function that will compute a total of the sale order lines

	Reading the countries info (code and name)






That’s great because if you run this code on 1000 sales orders, you have the guarantee to only have 4 SQL queries.

Notes:



	IDS is the list of the 10 ID’s: [12,15,18,34, ...,99]



	The arguments of a function are always the same:



	cr: the cursor database (from psycopg)

	uid: the user id (for security checks)








	If you run this code on 5000 sales orders, you may have 8 SQL queries because as SQL queries are not allowed to take too much memory, it may have to do two separate readings.











Complex example

Here is a complete example, from the OpenERP official distribution, of the function that does bill of material explosion and computation of associated routings:

class mrp_bom(osv.osv):
    ...
    def _bom_find(self, cr, uid, product_id, product_uom, properties=[]):
        bom_result = False
        # Why searching on BoM without parent ?
        cr.execute('select id from mrp_bom where product_id=%d and bom_id is null
                      order by sequence', (product_id,))
        ids = map(lambda x: x[0], cr.fetchall())
        max_prop = 0
        result = False
        for bom in self.pool.get('mrp.bom').browse(cr, uid, ids):
            prop = 0
            for prop_id in bom.property_ids:
                if prop_id.id in properties:
                    prop+=1
            if (prop>max_prop) or ((max_prop==0) and not result):
                result = bom.id
                max_prop = prop
        return result

        def _bom_explode(self, cr, uid, bom, factor, properties, addthis=False, level=10):
            factor = factor / (bom.product_efficiency or 1.0)
            factor = rounding(factor, bom.product_rounding)
            if factor<bom.product_rounding:
                factor = bom.product_rounding
            result = []
            result2 = []
            phantom = False
            if bom.type=='phantom' and not bom.bom_lines:
                newbom = self._bom_find(cr, uid, bom.product_id.id,
                                        bom.product_uom.id, properties)
                if newbom:
                    res = self._bom_explode(cr, uid, self.browse(cr, uid, [newbom])[0],
                          factor*bom.product_qty, properties, addthis=True, level=level+10)
                    result = result + res[0]
                    result2 = result2 + res[1]
                    phantom = True
                else:
                    phantom = False
            if not phantom:
                if addthis and not bom.bom_lines:
                    result.append(
                    {
                        'name': bom.product_id.name,
                        'product_id': bom.product_id.id,
                        'product_qty': bom.product_qty * factor,
                        'product_uom': bom.product_uom.id,
                        'product_uos_qty': bom.product_uos and
                                           bom.product_uos_qty * factor or False,
                        'product_uos': bom.product_uos and bom.product_uos.id or False,
                    })
                if bom.routing_id:
                    for wc_use in bom.routing_id.workcenter_lines:
                        wc = wc_use.workcenter_id
                        d, m = divmod(factor, wc_use.workcenter_id.capacity_per_cycle)
                        mult = (d + (m and 1.0 or 0.0))
                        cycle = mult * wc_use.cycle_nbr
                        result2.append({
                            'name': bom.routing_id.name,
                            'workcenter_id': wc.id,
                            'sequence': level+(wc_use.sequence or 0),
                            'cycle': cycle,
                            'hour': float(wc_use.hour_nbr*mult +
                                          (wc.time_start+wc.time_stop+cycle*wc.time_cycle) *
                                           (wc.time_efficiency or 1.0)),
                        })
                for bom2 in bom.bom_lines:
                     res = self._bom_explode(cr, uid, bom2, factor, properties,
                                                 addthis=True, level=level+10)
                     result = result + res[0]
                     result2 = result2 + res[1]
            return result, result2












技术架构

OpenERP is a multitenant [http://en.wikipedia.org/wiki/Multitenancy],
three-tier architecture [http://en.wikipedia.org/wiki/Multitier_architecture#Three-tier_architecture].
The application tier itself is written as a core, multiple additional
modules can be installed to create a particular configuration of
OpenERP.

The core of OpenERP and its modules are written in Python [http://python.org/]. The functionality of a module is exposed through
XML-RPC (and/or NET-RPC depending on the server’s configuration)[#]. Modules
typically make use of OpenERP’s ORM to persist their data in a relational
database (PostgreSQL). Modules can insert data in the database during
installation by providing XML, CSV, or YML files.


[image: ../_images/client_server.png]





	[1]	JSON-RPC is planned for OpenERP v6.1.





The OpenERP server

OpenERP provides an application server on which specific business applications
can be built. It is also a complete development framework, offering a range of
features to write those applications. The salient features are a flexible ORM,
a MVC architecture, extensible data models and views, different report engines,
all tied together in a coherent, network-accessible framework.

From a developer perspective, the server acts both as a library which brings
the above benefits while hiding the low-level, nitty-gritty details, and as a
simple way to install, configure and run the written applications.




Modules

By itself, the OpenERP server is not very useful. For any enterprise, the value
of OpenERP lies in its different modules. It is the role of the modules to
implement any business needs. The server is only the necessary machinery to run
the modules. A lot of modules already exist. Any official OpenERP release
includes about 170 of them, and hundreds of modules are available through the
community. Examples of modules are Account, CRM, HR, Marketing, MRP, Sale, etc.

A module is usually composed of data models, together with some initial data,
views definitions (i.e. how data from specific data models should be displayed
to the user), wizards (specialized screens to help the user for specific
interactions), workflows definitions, and reports.




Clients

Clients can communicate with an OpenERP server using XML-RPC. A custom, faster
protocol called NET-RPC is also provided but will shortly disappear, replaced
by JSON-RPC. XML-RPC, as JSON-RPC in the future, makes it possible to write
clients for OpenERP in a variety of programming languages. OpenERP S.A.
develops two different clients: a desktop client, written with the widely used
GTK+ [http://www.gtk.org/] graphical toolkit, and a web client that should
run in any modern web browser.

As the logic of OpenERP should entirely reside on the server, the client is
conceptually very simple; it issues a request to the server and display the result
(e.g. a list of customers) in different manners (as forms, lists, calendars,
...). Upon user actions, it will send modified data to the server.




Relational database server and ORM

The data tier of OpenERP is provided by a PostgreSQL relational database. While
direct SQL queries can be executed from OpenERP modules, most database access
to the relational database is done through the Object-Relational Mapping [http://en.wikipedia.org/wiki/Object-relational_mapping].

The ORM is one of the salient features mentioned above. The data models are
described in Python and OpenERP creates the underlying database tables. All the
benefits of RDBMS (unique constraints, relational integrity, efficient
querying, ...) are used when possible and completed by Python flexibility. For
instance, arbitrary constraints written in Python can be added to any model.
Different modular extensibility mechanisms are also afforded by OpenERP[#].




	[2]	It is important to understand the ORM responsibility before attempting to by-pass it and access directly the underlying database via raw SQL queries.  When using the ORM, OpenERP can make sure the data remains free of any corruption.  For instance, a module can react to data creation in a particular table. This reaction can only happen if the ORM is used to create that data.







Models

To define data models and otherwise pursue any work with the associated data,
OpenERP as many ORMs uses the concept of ‘model’. A model is the authoritative
specification of how some data are structured, constrained, and manipulated. In
practice, a model is written as a Python class. The class encapsulates anything
there is to know about the model: the different fields composing the model,
default values to be used when creating new records, constraints, and so on. It
also holds the dynamic aspect of the data it controls: methods on the class can
be written to implement any business needs (for instance, what to do upon user
action, or upon workflow transitions).

有两个不同的模型. 一个简单地叫’model’, 另一个叫 ‘transient model’. 这两个模型提供的功能基本一致，除了一点:
transient models 会自动在数据库中清除数据 (当数值到达某个值，或是超过某个时间点的时候，数据会自动清除).

To describe the data model per se, OpenERP offers a range of different kind of
fields. There are basic fields such as integer, or text fields. There are
relational fields to implement one-to-many, many-to-one, and many-to-many
relationships. There are so-called function fields, which are dynamically
computed and are not necessarily available in database, and more.

Access to data is controlled by OpenERP and configured by different mechanisms.
This ensures that different users can have read and/or write access to only the
relevant data. Access can be controlled with respect to user groups and rules
based on the value of the data themselves.




Modules

OpenERP supports a modular approach both from a development perspective and a
deployment point of view. In essence, a module groups everything related to a
single concern in one meaningful entity. It is comprised of models, views,
workflows, and wizards.




Services and WSGI

Everything in OpenERP, and models methods in particular, are exposed via the
network and a security layer. Access to the data model is in fact a ‘service’
and it is possible to expose new services. For instance, a WebDAV service and a
FTP service are available.

While not mandatory, the services can make use of the WSGI [http://en.wikipedia.org/wiki/Web_Server_Gateway_Interface] stack.
WSGI is a standard solution in the Python ecosystem to write HTTP servers,
applications, and middleware which can be used in a mix-and-match fashion.
By using WSGI, it is possible to run OpenERP in any WSGI-compliant server, but
also to use OpenERP to host a WSGI application.

A striking example of this possibility is the OpenERP Web project. OpenERP Web
is the server-side counter part to the web clients. It is OpenERP Web which
provides the web pages to the browser and manages web sessions. OpenERP Web is
a WSGI-compliant application. As such, it can be run as a stand-alone HTTP
server or embedded inside OpenERP.




XML-RPC, JSON-RPC

The access to the models makes also use of the WSGI stack. This can be done
using the XML-RPC protocol, and JSON-RPC will be added soon.

Explanation of modules:

Server - Base distribution

We use a distributed communication mechanism inside the OpenERP server. Our engine supports most commonly distributed patterns: request/reply, publish/subscribe, monitoring, triggers/callback, ...

Different business objects can be in different computers or the same objects can be on multiple computers to perform load-balancing.

Server - Object Relational Mapping (ORM)

This layer provides additional object functionality on top of PostgreSQL:



	Consistency: powerful validity checks,

	Work with objects (methods, references, ...)

	Row-level security (per user/group/role)

	Complex actions on a group of resources

	Inheritance






Server - Web-Services

The web-service module offer a common interface for all web-services



	SOAP

	XML-RPC

	NET-RPC






Business objects can also be accessed via the distributed object mechanism. They can all be modified via the client interface with contextual views.

Server - Workflow Engine

Workflows are graphs represented by business objects that describe the dynamics of the company. Workflows are also used to track processes that evolve over time.

An example of workflow used in OpenERP:

A sales order generates an invoice and a shipping order

Server - Report Engine

Reports in OpenERP can be rendered in different ways:



	Custom reports: those reports can be directly created via the client interface, no programming required. Those reports are represented by business objects (ir.report.custom)



	High quality personalized reports using openreport: no programming required but you have to write 2 small XML files:



	a template which indicates the data you plan to report

	an XSL:RML stylesheet








	Hard coded reports



	OpenOffice Writer templates








Nearly all reports are produced in PDF.

Server - Business Objects

Almost everything is a business object in OpenERP, they describe all data of the program (workflows, invoices, users, customized reports, ...). Business objects are described using the ORM module. They are persistent and can have multiple views (described by the user or automatically calculated).

Business objects are structured in the /module directory.

Client - Wizards

Wizards are graphs of actions/windows that the user can perform during a session.

Client - Widgets

Widgets are probably, although the origin of the term seems to be very difficult to trace, “WIndow gaDGETS” in the IT world, which mean they are gadgets before anything, which implement elementary features through a portable visual tool.

All common widgets are supported:



	entries

	textboxes

	floating point numbers

	dates (with calendar)

	checkboxes

	...






And also all special widgets:



	buttons that call actions



	references widgets



	one2one

	many2one

	many2many

	one2many in list

	...













Widget have different appearances in different views. For example, the date widget in the search dialog represents two normal dates for a range of date (from...to...).

Some widgets may have different representations depending on the context. For example, the one2many widget can be represented as a form with multiple pages or a multi-columns list.

Events on the widgets module are processed with a callback mechanism. A callback mechanism is a process whereby an element defines the type of events he can handle and which methods should be called when this event is triggered. Once the event is triggered, the system knows that the event is bound to a specific method, and calls that method back. Hence callback.






模块集成

The are many different modules available for OpenERP and suited for different business models. Nearly all of these are optional (except ModulesAdminBase), making it easy to customize OpenERP to serve specific business needs. All the modules are in a directory named addons/ on the server. You simply need to copy or delete a module directory in order to either install or delete the module on the OpenERP platform.

Some modules depend on other modules. See the file addons/module/__openerp__.py for more information on the dependencies.

Here is an example of __openerp__.py:

{
    "name" : "Open TERP Accounting",
    "version" : "1.0",
    "author" : "Bob Gates - Not So Tiny",
    "website" : "http://www.openerp.com/",
    "category" : "Generic Modules/Others",
    "depends" : ["base"],
    "description" : """A
    Multiline
    Description
    """,
    "init_xml" : ["account_workflow.xml", "account_data.xml", "account_demo.xml"],
    "demo_xml" : ["account_demo.xml"],
    "update_xml" : ["account_view.xml", "account_report.xml", "account_wizard.xml"],
    "active": False,
    "installable": True
}





When initializing a module, the files in the init_xml list are evaluated in turn and then the files in the update_xml list are evaluated. When updating a module, only the files from the update_xml list are evaluated.




继承


传统的继承


介绍

对象可能被继承自一些自定义或特殊模块，这可以添加/修改一些文件去继承一个对象。

这样就可以了:

_inherit='object.name'








对象的扩展

There are two possible ways to do this kind of inheritance. Both ways result in a new class of data, which holds parent fields and behaviour as well as additional fields and behaviour, but they differ in heavy programatical consequences.

While Example 1 creates a new subclass “custom_material” that may be “seen” or “used” by any view or tree which handles “network.material”, this will not be the case for Example 2.

This is due to the table (other.material) the new subclass is operating on, which will never be recognized by previous “network.material” views or trees.

Example 1:

class custom_material(osv.osv):
        _name = 'network.material'
        _inherit = 'network.material'
        _columns = {
                'manuf_warranty': fields.boolean('Manufacturer warranty?'),
        }
        _defaults = {
                'manuf_warranty': lambda *a: False,
       }
custom_material()






Tip

Notice

_name == _inherit



在这个例子中，”custom_material”对象会对”network_material”对象添加一个新的字段”manuf_warranty”， New instances of this class will be visible by views or trees operating on the superclasses table ‘network.material’.

This inheritancy is usually called “class inheritance” in Object oriented design. The child inherits data (fields) and behavior (functions) of his parent.

Example 2:

class other_material(osv.osv):
        _name = 'other.material'
        _inherit = 'network.material'
        _columns = {
                'manuf_warranty': fields.boolean('Manufacturer warranty?'),
        }
        _defaults = {
                'manuf_warranty': lambda *a: False,
       }
other_material()






Tip

Notice

_name != _inherit



In this example, the ‘other_material’ will hold all fields specified by ‘network.material’ and it will additionally hold a new field ‘manuf_warranty’. All those fields will be part of the table ‘other.material’. New instances of this class will therefore never been seen by views or trees operating on the superclasses table ‘network.material’.

This type of inheritancy is known as “inheritance by prototyping” (e.g. Javascript), because the newly created subclass “copies” all fields from the specified superclass (prototype). The child inherits data (fields) and behavior (functions) of his parent.






Inheritance by Delegation


Syntax ::

class tiny_object(osv.osv)
    _name = 'tiny.object'
    _table = 'tiny_object'
    _inherits = { 'tiny.object_a' : 'name_col_a', 'tiny.object_b' : 'name_col_b',
               ..., 'tiny.object_n' : 'name_col_n' }
    (...)








The object ‘tiny.object’ inherits from all the columns and all the methods from the n objects ‘tiny.object_a’, ..., ‘tiny.object_n’.

To inherit from multiple tables, the technique consists in adding one column to the table tiny_object per inherited object. This column will store a foreign key (an id from another table). The values ‘name_col_a’ ‘name_col_b’ ... ‘name_col_n’ are of type string and determine the title of the columns in which the foreign keys from ‘tiny.object_a’, ..., ‘tiny.object_n’ are stored.

This inheritance mechanism is usually called ” instance inheritance ”  or  ” value inheritance ”. A resource (instance) has the VALUES of its parents.
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模块开发


简介

OpenERP 采用 三层架构 [http://en.wikipedia.org/wiki/Multitier_architecture#Three-tier_architecture]。
应用层本身被设计成核心和多个附加的模块，这些模块可以安装，不用OpenERP创建一个特殊的配置。

OpenERP的核心和其他不同的模块都是用 Python [http://python.org/]  写的。 模块的功能通过XML-RPC（或是NET-RPC，这取决于服务器端的配置）显示出来。模块也采用OpenERP ORM在关系型数据库（PostgreSQL）中来持久化数据。当模块安装好后通过提供XML文件就可以在数据库中插入数据。

尽管使用模块是构建一个复杂应用的简单方式，在OpenERP中模块同样可以扩展系统。事实上，模块也被称为addons（它们有时也被称为plugins）。

在OpenERP的典型配置中，以下模块是必须的：



	base: 最基本的模块。它无论何种情况下都必须安装，被认为是OpenERP核心的一部分。定义了 ir.property,
res.company, res.request, res.currency, res.users,
res.partner, 等等。

	crm: 客户关系管理和供应商关系管理。

	sale: 销售管理。

	mrp: 制造资源管理。






通过使用Python, XML files，依赖OpenERP的ORM和它的延伸机制，新的模块可以很容易快速的写出。OpenERP的开源特性和它众多的模块也为新模块的开发提供很多的例子。




模块结构


模块



	介绍



	
	文件和文件夹结构

	
	__openerp__.py



	__init__.py



	
	XML 文件

	
	操作

	菜单

	报表

	向导

















	配置文件











模块 - 文件和文件夹结构

所有模块都应放到 server/addons 文件夹下。

按下面步骤创建新模块：



	在 server/addons 文件夹下面创建模块子文件夹

	创建模块定义文件: __openerp__.py

	创建定义 objects 的 Python 文件

	创建包括(初始数据, 视图, 菜单, 演示数据)的 .xml 文件

	创建包含 reports, wizards 及  workflows 的 xml文件(可选)







模块 - 文件和目录 - XML 文件

模块目录里的XML文件用于修改数据库结构，他们有很多的用途，我们可以列出来：



	初始化，实例化（demonstration）数据声明（declaration）

	视图声明

	报表声明

	向导声明

	工作流声明






OpenERP XML文件主要结构的更多细节在
XML 数据序列化 部分，如果你想学习更多关于*初始化* 和 示例数据 XML文件，可以查看这里。 下面的部分只是关于特定的XML文件，如
following section are only related to XML specific to actions, menu entries,
*操作、菜单、报表、向导 和 工作流 定义。




Python 模块描述文件 __init__.py

** __init__.py 文件**

这个文件就像任何的Python模块中一样，在程序的开始运行。它负责导入程序所需的Python文件。


	所以，如果你想创建一个“module.py”文件，它包括你的对象的描述，在这种情况下，你需要在__init__.py文件中写一行：

	import module






OpenERP 模块描述文件 __openerp__.py

在已经创建的模块目录中，我们需要添加这样一个文件__openerp__.py。这个文件必须是Python的格式书写，用于：


1.确定所需的XML文件，server在进行初始化时将从语法上分析这些文件。
2.确定该创建模块的依赖模块。


这个文件包括下面的值：

name


(英文) 模块名称。


version


模块版本号， 2 位 (1.2 或 2.0).


description


模块的描述，包含模块的使用文档。


author


模块编者


website


模块的网址


license


模块的许可证（默认是GPL）


depends

init


List of .xml files to load when the server is launched with the “–init=module” argument. Filepaths must be relative to the directory where the module is. OpenERP XML File Format is detailed in this section.


data


List of .xml files to load when the server is launched with the “–update=module” launched. Filepaths must be relative to the directory where the module is. OpenERP XML File Format is detailed in this section.


demo


List of .xml files to provide demo data. Filepaths must be relative to the directory where the module is. OpenERP XML File Format is detailed in this section.


installable


True或是False，决定这个模块是否可安装。


images


List of .png files to provide screenshots, used on http://apps.openerp.com.


active


True或是False（默认是False），决定这个模块在数据库创建时是否安装。


test


List of .yml files to provide YAML tests.


Example

以product模块中的__openerp__.py为例：

{
    "name" : "Products & Pricelists",
    "version" : "1.1",
    "author" : "Open",
    "category" : "Generic Modules/Inventory Control",
    "depends" : ["base", "account"],
    "init_xml" : [],
    "demo_xml" : ["product_demo.xml"],
    "update_xml" : ["product_data.xml", "product_report.xml", "product_wizard.xml",
                    "product_view.xml", "pricelist_view.xml"],
    "installable": True,
    "active": True
}





放置在init_xml中的文件必须要么是和工作流定义相关，要么是安装软件时装载数据相关，或是和示例数据相关。

update_xml中的文件涉及到视图，报表和向导。




对象

所有OpenERP的资源都是对象，如menus，actions，reports，invoices，partners... OpenERP通过数据库的对象关系映射(ORM,object relational mapping of a database)来控制信息存储。OpenERP的对象名是层次结构的，例如：



	account.transfer : a money transfer

	account.invoice : an invoice

	account.invoice.line : an invoice line






总之，第一个单词是模块的名字：account，stock，sale

ORM的其他优点有：



	simpler relations : invoice.partner.address[0].city

	objects have properties and methods: invoice.pay(3400 EUR),

	inheritance, high level constraints, ...






操作一个对象比很多表要容易些。


[image: ../_images/pom_3_0_3.png]
The Physical Objects Model of [OpenERP version 3.0.3]




PostgreSQL

OpenERP的ORM是在PostgreSQL上构造的。在OpenERP上通过对象接口或是直接使用SQL语句查询一个对象是可行的。

在PostgreSQL数据库中直接进行读写是非常危险的，因为可能会漏掉重要的步骤如约束检查或是工作流的修改。


Note

The Physical Database Model of OpenERP








Pre-Installed Data

PostgreSQL表中的数据可以使用XML文件来进行插入或更新，使得于OpenERP对象数据一致。OpenERP XML文件的主要结构是：

<?xml version="1.0"?>
<openerp>
  <data>
    <record model="model.name_1" id="id_name_1">
      <field name="field1">
        "field1 content"
      </field>
      <field name="field2">
        "field2 content"
      </field>
      (...)
    </record>
    <record model="model.name_2" id="id_name_2">
        (...)
    </record>
    (...)
  </data>
</openerp>





Fields content are strings that must be encoded as UTF-8 in XML files.

让我们回顾一下另一个例子（base模块中的base_demo.xml）：

<record model="res.company" id="main_company">
    <field name="name">Tiny sprl</field>
    <field name="partner_id" ref="main_partner"/>
    <field name="currency_id" ref="EUR"/>
</record>





<record model="res.users" id="user_admin">
    <field name="login">admin</field>
    <field name="password">admin</field>
    <field name="name">Administrator</field>
    <field name="signature">Administrator</field>
    <field name="action_id" ref="action_menu_admin"/>
    <field name="menu_id" ref="action_menu_admin"/>
    <field name="address_id" ref="main_address"/>
    <field name="groups_id" eval="[(6,0,[group_admin])]"/>
    <field name="company_id" ref="main_company"/>
</record>





上面的这个record定义了admin user：



	明确定义了login，password等
*   ref属性用于在records之间建立关系






<field name="company_id" ref="main_company"/>





字段company_id是一个从user object到company object的many-to-one的关系，main_company是相关联的id。



	eval字段使得XML中有很多python代码：这里的groups_id字段是many2many的。“[(6,0,[group_admin])]”的意思是：移除与当前用户相关的所有groups，使用list[group_admin]作为新的相关groups（并且group_admin is the id of another record）。

	Search字段是当你不知道它的XML id时，用来查找相关记录（record）。当你查找所需记录时可以特别指定一个查找标准。这个标准相对于预定义的查找方法最好是一个相同形式元祖的列表（The criteria is a list of tuples of the same form than for the predefined search method.）。如果有很多查找记录，程序自动选择任意一个（第一个）：






<field name="partner_id" search="[]" model="res.partner"/>





这是个在demo数据中使用search的典型例子。在这里我们并不是真正想知道是哪个partner，所以我们给出了一个空的list。注意model属性是在一般情况下必须要写的。


Record Tag

Description

T新数据的添加是通过record标签实现的。它利用一个必备的属性：model。Model是一个对象名称，可以用来实现插入数据。record标签内还有一个可选择的属性：id。如果使用了这个属性，那么在相同文件中，这个名字可以代替新创建的资源ID。

record标签中包含field标签。他们指出record的字段值（record’s fields value）。如果这个field没有详细说明，那么它会使用默认值。

Example

<record model="ir.actions.report.xml" id="l0">
     <field name="model">account.invoice</field>
     <field name="name">Invoices List</field>
     <field name="report_name">account.invoice.list</field>
     <field name="report_xsl">account/report/invoice.xsl</field>
     <field name="report_xml">account/report/invoice.xml</field>
</record>








Field tag

field标签包含的属性如下所示：

name : （必须有的）field name

eval : （可选）将指定值进行添加的python表达式

ref  :  这个文件中涉及到已定义的id

model ：用于查找的model

search ：查询




Function tag

一个功能标签包含其他的功能标签。

model ：（必须有的）要调用的model

name ：（必需）function的名称


	eval

	eval ：估值（evaluate）要调用的方法的参数列表，不计cr和uid



Example

<function model="ir.ui.menu" name="search" eval="[[('name','=','Operations')]]"/>








Getitem tag

得到该标签最近子节点估值的子集

type ：（必需）int 或 list

index ：（必需）int or string

Example

Evaluates to the first element of the list of ids returned by the function node

<getitem index="0" type="list">
    <function model="ir.ui.menu" name="search" eval="[[('name','=','Operations')]]"/>
</getitem>










i18n


改进翻译


	
Translating in launchpad

	



翻译由“Launchpad Web interface”管理。在这里你会找到可译项目的清单。

请在问问题前阅读 FAQ [https://answers.launchpad.net/rosetta/+faqs]


	
Translating your own module

	




Changed in version 5.0.



和之前4.2.x的版本不同，现在翻译都是通过模块来做。所以和之前整个系统中有一个特殊i18n文件夹不同的是，现在每一个模块都有自己的i18n文件夹。此外，OpenERP可以处理.po文件作为导入导出格式。当我们安装或是更新一个模块时，安装语言的翻译文件可以自动装入系统中。OpenERP也可以产生一个.tgz文件归档，里面包括为每个选中模块组织很好的.po文件。




	[1]	http://www.gnu.org/software/autoconf/manual/gettext/PO-Files.html#PO-Files









Process


Defining the process

通过界面（interface）或是模块recorder来定义进程。然后放置生成的XML文件在自己的模块中。






Views


Technical Specifications - Architecture - Views

视图是一种在客户端显示对象的方式。他们指示客户端如何在屏幕上显示对象数据。

视图有两种表现形式：



	表单视图

	列表视图






Lists是tree views中的特殊情形。

同一个对象有几种视图：首先定义的视图样式（tree，form，…）将会做为它默认的样式。那样的话，当你双击一个菜单项时，就有一个默认的tree view和一个特定的view显示差不多的信息。例如，products针对product变量有几种视图。

视图都是在XML文件中进行描述的。

如果一个对象没有定义视图，那么这个对象可以自己产生一个视图来显示它自己。这会限制开发者的工作，但是会导致较少的人们自己的视图设计（ergonomic views）。




Usage example

当我们打开一张发票时，接下来是在客户端上的操作：



	一个动作请求打开发票（它给出了一个对象的数据（account.invoice）,视图，域（例如仅仅是还未付款的发票））

	客户端请求server，什么样的视图由发票对象定义，哪些数据要显示。

	客户端通过视图显示表单







[image: ../_images/arch_view_use.png]





To develop new objects

对新对象的设计限制到最低限度：创建对象并且有选择的创建视图来显示他们。PostgreSQL的table数据不用手写，因为对象会自动创建它们（除非它们已经存在）。






Reports

OpenERP使用一个非常灵活和强大的报表系统。报表以PDF或是HTML的形式生成。报表是以数据层和表现层分开的原理进行设计的。

关于报表更多的细节在 Reporting [http://openobject.com/wiki/index.php/Developers:Developper%27s_Book/Reports] 章节。




Wizards

这里有个描述向导的.xml文件的例子：

<?xml version="1.0"?>
<openerp>
    <data>
     <wizard string="Employee Info"
             model="hr.employee"
             name="employee.info.wizard"
             id="wizard_employee_info"/>
    </data>
</openerp>





向导的声明是通过使用wizard标签。想要知道更多关于向导XML文件的信息可以查看“Add A New Wizard”部分。

或者你可以在菜单中通过使用下面的XML entry添加向导。

<?xml version="1.0"?>
</openerp>
     <data>
     <wizard string="Employee Info"
             model="hr.employee"
             name="employee.info.wizard"
             id="wizard_employee_info"/>
     <menuitem
             name="Human Resource/Employee Info"
             action="wizard_employee_info"
             type="wizard"
             id="menu_wizard_employee_info"/>
     </data>
</openerp>








Workflow

通过对象和视图，我们可以很简单的定义新的表单，lists/trees和它们间的交互。但是这还不够：你还得定义这些对象间的动态关系。
.. i18n: A few examples:
..

举个例子：



	在一般的情况下，一个已确定的销售订单必须生成一张发货单。

	只是在确认发货单已付款的前提下，才会开出运送清单。






工作流使用图表描述这些交互，一个或几个工作流相关到对象。工作流是非必须的；一些对象就没有工作流。

下面的工作流用于销售订单的例子。在一定的条件下，它必须产生发货单和出货。


[image: ../_images/arch_workflow_sale.png]


在这张图表中节点代表着要做的动作。



	创建发票

	取消销售订单

	生成装货单, ...






上面的箭头代表条件：


1.等待订单获得批准
2.发票支付
3.点击取消按钮，。。。


方格样式的节点代表其他的工作流：



	发票

	发货













OpenERP 模块描述文件 : __openerp__.py


一般模块

在已创建模块的目录下，你必须添加一个__openerp__.py文件。这个文件必须在Python的格式下，负责：



	确定所需的XML文件，server在进行初始化时将从语法上分析这些文件。

	1.确定已创建模块的依赖。






这个文件包括下面的值：

name


(英文)名称.


version


版本


description


描述


author


模块的作者


website


模块的网站


license


模块的授权协议(默认AGPL).


depends


列出该模块所依赖的其他模块，因为base模块包括模块必须的视图，报表等数据，所以base模块应该在其他所有模块的依赖中。


init_xml


List of .xml files to load when the server is launched with the “–init=module” argument. Filepaths must be relative to the directory where the module is. OpenERP XML File Format is detailed in this section.


update_xml


List of .xml files to load when the server is launched with the “–update=module” launched. Filepaths must be relative to the directory where the module is. OpenERP XML File Format is detailed in this section.


installable


True或是False，决定这个模块是否可安装。


active


True或是False（默认是False），决定这个模块在数据库创建时是否安装。



示例

以product模块中的__openerp__.py为例：

{
    "name" : "Products & Pricelists",
    "version" : "1.1",
    "author" : "Open",
    "category" : "Generic Modules/Inventory Control",
    "depends" : ["base", "account"],
    "init_xml" : [],
    "demo_xml" : ["product_demo.xml"],
    "update_xml" : ["product_data.xml","product_report.xml", "product_wizard.xml","product_view.xml", "pricelist_view.xml"],
    "installable": True,
    "active": True
}





放置在init_xml中的文件必须要么是和工作流相关，要么是安装软件时装载数据相关，或是和示例数据相关。

update_xml中的文件涉及到视图，报表和向导。






Profile 模块

一个profile的目的是在数据库创建后直接使用一组模块来初始化OpenERP。这个profile是一种特殊的模块，它不包含代码，只是 依赖于其他的模块 。

为了创建一个新的profile，你需要在server/addons里建一个新目录（可以给它取名为profile_modulename）。在新目录里放一个空的__init__.py文件和__openerp__.py。这个文件的结构是：

{
     "name":"''Name of the Profile'',
     "version":"''Version String''",
     "author":"''Author Name''",
     "category":"Profile",
     "depends":[''List of the modules to install with the profile''],
     "demo_xml":[],
     "update_xml":[],
     "active":False,
     "installable":True,
}






示例

我们以文件server/bin/addons/profile_manufacturing/__openerp__.py中的代码为例，它对应着OpenERP中的manufacturing industry profile。

{
     "name":"Manufacturing industry profile",
     "version":"1.1",
     "author":"Open",
     "category":"Profile",
     "depends":["mrp", "crm", "sale", "delivery"],
     "demo_xml":[],
     "update_xml":[],
     "active":False,
     "installable":True,
}












创建模块


Getting the skeleton directory

你可以从其他任意模块中复制文件__openerp__.py和__init__.py到一个新目录来创建一个新模块。

Ubuntu中一个例子：

$ cd ~/workspace/stable/stable_addons_5.0/
$ mkdir travel
$ sudo cp ~/workspace/stable/stable_addons_5.0/hr/__openerp__.py ~/workspace/stable/stable_addons_5.0/travel
sudo cp ~/workspace/stable/stable_addons_5.0/hr/__init__.py ~/workspace/stable/stable_addons_5.0/travel





你如果想修改这个目录，你需要设置自己的权限在这个目录上:

$ sudo chown -R `whoami` travel





进入新模块的目录，里面有个框架结构，你仍需要去更改模块定义里面的东西。




Changing the default definition

为了更改模块“travel”里面的默认设置，我们需要进入“travel”目录，编辑__openerp__.py文件。

$ cd travel
$ gedit __openerp__.py





文件里面类似下面：

{
  "name" : "Human Resources",
  "version" : "1.1",
  "author" : "Tiny",
  "category" : "Generic Modules/Human Resources",
  "website" : "http://www.openerp.com",
  "description": """
  Module for human resource management. You can manage:
  * Employees and hierarchies
  * Work hours sheets
  * Attendances and sign in/out system

  Different reports are also provided, mainly for attendance statistics.
  """,
  'author': 'Tiny',
  'website': 'http://www.openerp.com',
  'depends': ['base', 'process'],
  'init_xml': [],
  'update_xml': [
      'security/hr_security.xml',
      'security/ir.model.access.csv',
      'hr_view.xml',
      'hr_department_view.xml',
      'process/hr_process.xml'
  ],
  'demo_xml': ['hr_demo.xml', 'hr_department_demo.xml'],
  'installable': True,
  'active': False,
  'certificate': '0086710558965',
}





你可能会更改任意你觉得正确的东西，像下面这样：

{
    "name" : "Travel agency module",
    "version" : "1.1",
    "author" : "Tiny",
    "category" : "Generic Modules/Others",
    "website" : "http://www.openerp.com",
    "description": "A module to manage hotel bookings and a few other useful features.",
    "depends" : ["base"],
    "init_xml" : [],
    "update_xml" : ["travel_view.xml"],
    "active": True,
    "installable": True
}





注意“active”字段变成了true。




Changing the main module file

现在你需要更新travel.py脚本以满足你自己的模块的需要。我们建议你遵循Flash教程，或是从20minutes教程页面来下载travel agent模块。

The documentation below is overlapping the two next step in this wiki tutorial,
so just consider them as a help and head towards the next two pages first...





travel.py文件应该看起来是这样：

from osv import osv, fields

class travel_hostel(osv.osv):
       _name = 'travel.hostel'
       _inherit = 'res.partner'
       _columns = {
       'rooms_id': fields.one2many('travel.room', 'hostel_id', 'Rooms'),
       'quality': fields.char('Quality', size=16),
       }
       _defaults = {
       }
travel_hostel()





理想情况下，你会拷贝那些代码几次来创建你所需要的实体（travel_airport, travel_room, travel_flight）。这就是你的对象的数据库结构，但是你真的不需要担心数据库端。当你安装模块时，这个文件会为你创建系统架构。




Customizing the view

接下来你可以编辑视图。编辑custom_view.xml文件，像这样：

<openerp>
<data>
    <record model="res.groups" id="group_compta_user">
            <field name="name">grcompta</field>
    </record>
    <record model="res.groups" id="group_compta_admin">
            <field name="name">grcomptaadmin</field>
    </record>
    <menuitem name="Administration" groups="admin,grcomptaadmin"
                    icon="terp-stock" id="menu_admin_compta"/>
</data>
</openerp>





就像你看到的，这是个accounting系统的例子。

定义视图就是定义访问你的模块时的用户界面。这里定义的这些字段已经是一个完整的界面。然而，由于做这个的复杂性，我们建议，再一次，从链接http://www.openerp.com/download/modules/5.0/下载travel agent模块。

下次你可以使用其他的文件来定义不同的视图，并且在你的basic/admin视图中分开它们。






Action creation


Linking events to action

可用类型的事件是：



	client_print_multi (print from a list or form)

	client_action_multi (action from a list or form)

	tree_but_open (double click on the item of a tree, like the menu)

	tree_but_action (action on the items of a tree)






从事件到动作的映射是：

<record model="ir.values" id="ir_open_journal_period">
    <field name="key2">tree_but_open</field>
    <field name="model">account.journal.period</field>
    <field name="name">Open Journal</field>
    <field name="value" eval="'ir.actions.wizard,%d'%action_move_journal_line_form_select"/>
    <field name="object" eval="True"/>
</record>





如果你双击journal/period (object: account.journal.period),将会打开一个选中的向导(id=”action_move_journal_line_form_select”).

只是当用户点击特定的对象时，你可以使用res_id字段来允许这个动作。

<record model="ir.values" id="ir_open_journal_period">
    <field name="key2">tree_but_open</field>
    <field name="model">account.journal.period</field>
    <field name="name">Open Journal</field>
    <field name="value" eval="'ir.actions.wizard,%d'%action_move_journal_line_form_select"/>
    <field name="res_id" eval="3"/>
    <field name="object" eval="True"/>
</record>





当用户点击account.journal.period n°3时，这个动作将会触发。

当你声明向导，报表或是菜单时，ir.values的创建会自动由下面的标签完成：



	<wizard... />

	<menuitem... />

	<report... />






所以一般不需要自己加映射。
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Objects, Fields and Methods


OpenERP 对象

我们可以通过 对象 访问所有ERP的数据。举个例子，可以通过 res.partner 对象访问 合作伙伴 相关的数据，通过 account.invoice 对象访问 发票 相关的数据。

请注意的是，每种类型的资源是一个对象，而不是每个资源是一个对象。我们可以使用res.partner对象来管理所有的partners，而不是每个partner用一个res.partner对象来表示。当我们说“object oriented”术语时，其实说的是每级有个对象（an object per level）。

直接的后果是，对象的所有方法都有一个共同的参数：参数“ids”。这个资源特别指定的方法必须被使用。准确的是，必须使用的这个方法的参数包括着资源ids的列表。

例如，我们有两个标识为1和5的合作伙伴，当我们想要调用res_partner的方法“send_email”时，我们应该这样写：:

res_partner.send_email(... , [1, 5], ...)





我们在这份文档中将会看到更多具体的对象方法调用的语法。

在下面的章节中，我们将会看到如何定义一个新对象。然后，我们会检验定义新对象所使用的不同方法。

对于开发者来说：


	OpenERP “object”在面向对象编程中经常被成为类（class）。

	一个OpenERP “resource”在面向对象编程中经常被称为一个对象，一个类的实例。



当你试图在OpenERP中编程时会有些困惑，因为使用的是Python语言，而Python语言是一种完全的面向对象语言。它有对象和实例…

我们感到幸运的是，OpenERP“resource”当使用“browse”类方法（OpenERP object method）时，可以神奇的转变成一个Python对象。




The ORM - Object-relational mapping - Models

ORM是Object-Relational Mapping（对象关系映射）的简称，是OpenERP的中心部分。

在OpenERP中，数据模型的描述和操纵都是通过Python的类和对象。ORM的作用是为python文件和底层的关系型数据库（PostgreSQL）消除隔阂（bridge the gap）（尽可能的透明的为开发人员），为对象提供持久性。




OpenERP Object Attributes


Objects Introduction

想要定义一个新对象，你就要先定义一个新的Python类，然后实例化它。这个类必须继承自osv模块的osv类。




Object definition

对象定义的前几行如下：:

class name_of_the_object(osv.osv):
        _name = 'name.of.the.object'
        _columns = { ... }
        ...
name_of_the_object()





一个对象可以通过一些字段来定义，而这些字段在类中已经预定义了名称。其中有两个是必须的（_name和_columns），其他都是可选的。预定义的字段是：




Predefined fields


	_auto

	是否自动创建对象对应的Table，如果OpenERP的对象从PostgreSQL views中产生时，将_auto设为False比较好。想要知道更多的细节可以查看“Reporting From PostgreSQL Views”。




	_columns (required)

	对象字段，可在field章节了解更多。




	_constraints

	定义对象上的约束，可在“constraints”章节了解更多。




	_sql_constraints

	定义对象中SQL约束，可在“SQL constraints”章节了解更多。




	_defaults

	定义一些字段的缺省值，可在“default value”章节了解更多。




	_inherit

	当前对象继承自哪里，可在 object inheritance section
(first form) 了解更多。



_inherits


当前对象继承的对象列表，这个列表必须是下面的形式：{‘name_of_the_parent_object’: ‘name_of_the_field’, ...}。可在“object inheritance section”了解更多。缺省值是：{}



	_log_access

	定义对资源的写访问是否应写入日志，如果是true，那将自动在对应的数据表中增加create_uid, create_date, write_uid, write_date四个字段，缺省值为True，即字段增加。这四个字段分布记录record的创建人，创建日期，修改人，修改日期。这四个字段值可以用对象的方法（perm_read）读取。




	_name (required)

	定义对象的名称，缺省值为None。




	_order

	定义search和read方法的结果记录排序规则。




缺省值：“id”



例如:

_order = "name"
_order = "date_order desc"









	_rec_name

	标识每个已被存储的资源的名称字段。缺省值是：“name”，缺省情况（name_get没被重载的话）方法name_get()返回本字段值。




	_sequence

	数据库表的id字段的序列采集器，缺省值为: None。




	_sql

	SQL代码执行在对象的创建之上，意思就是说在表格创建后代码执行。




	_table

	数据库表名，缺省值是和_name一样，只是将”.”替换成”_”。








Object Inheritance - _inherit


Introduction

对象可能继承于很多定制的或是特定的模块。这比继承一个对象增加或修改某方面更好。

It is done with:

_inherit='object.name'








Extension of an object

这里继承有两种方式：他们都产生一个新的数据类，它将父类的字段和行为做为自己额外的字段和行为，但是他们在heavy programatical consequences上不同。

例子1中产生一个新的子类叫“custom_material”，当操作network.material的视图或是列表时可以看到或是使用它。这和例子2不同。

这是由于这个新类操作的表格（other.material）是不能被之前的对象“network.material”的视图或列表所识别的。

例子1:

class custom_material(osv.osv):
    _name = 'network.material'
    _inherit = 'network.material'
    _columns = {
        'manuf_warranty': fields.boolean('Manufacturer warranty?'),
    }
    _defaults = {
        'manuf_warranty': lambda *a: False,
    }
    custom_material()






Tip

Notice

_name == _inherit



这个例子，“custom_material”增加了一个新的字段“manuf_warranty”到对象“network.material”中。这个类的新的实例对运行在父类“network.material”上的视图或列表是可见的。

在面向对象的设计中，这种继承通常称为“类继承（class inheritance）”。子类继承父类的字段和函数。

例子2:

class other_material(osv.osv):
    _name = 'other.material'
    _inherit = 'network.material'
    _columns = {
        'manuf_warranty': fields.boolean('Manufacturer warranty?'),
    }
    _defaults = {
        'manuf_warranty': lambda *a: False,
    }
    other_material()






Tip

Notice

_name != _inherit



在这个例子中，“other_material”会继承“network.material”的所有字段，它另外会加入一个新的字段“manuf_warranty”。所有这些字段都在表格“other.material”中。这个类的新的实例对运行在父类“network.material”上的视图或列表是不可见的。

这种类型的继承被称为“原型继承（inheritance by prototyping）”。因为新创建的子类拷贝了父类的所有字段。子类继承父类的字段和方法。






Inheritance by Delegation - _inherits


Syntax ::

class tiny_object(osv.osv)
    _name = 'tiny.object'
    _table = 'tiny_object'
    _inherits = {
        'tiny.object_a': 'object_a_id',
        'tiny.object_b': 'object_b_id',
        ... ,
        'tiny.object_n': 'object_n_id'
    }
    (...)








对象“tiny.object”继承n个对象“tiny.object_a, ...,tiny.object_n”的所有的字段和方法。

为了继承多种表格，每继承一个对象就加一列到表格中。这个列存储继承表格的外键。值‘object_a_id’ ‘object_b_id’ ... ‘object_n_id’ 是字符串类型，定义列头，它里面放着存储对象‘tiny.object_a’, ..., ‘tiny.object_n’的外键。

这种继承称为“对象继承（instance inheritance）”或是“值继承（value inheritance）”。对象有它父类的值（values）。




字段(Fields) 简介

对象包括不同类型的字段，分为三类：simple types，relation types，functional fields。simple types是integers, floats, booleans, strings, etc ...；relation types是表示对象间的关系（one2one, one2many, many2one）。Functional fields是特殊的字段，因为它们不是存储在数据库中，而是实时计算视图给定的其他字段。

这是OpenERP继承类方法初始化的头文件。（Here’s the header of the initialization method of the class any field defined in OpenERP inherits）。:

def __init__(self, string='unknown', required=False, readonly=False,
             domain=None, context="", states=None, priority=0, change_default=False, size=None,
             ondelete="set null", translate=False, select=False, **args) :





这里有一套通用的可选参数，它对大多数的字段类型是可用的：

change_default：别的字段的缺省值是否可依赖于本字段。这些缺省值定义在ir.values表格中。
help：用于描述这个字段如何使用：更长的描述文字。当鼠标滑过该字段时将会显示在一个提示框中。
ondelete：如何处理相关记录的删除。允许的值有：‘restrict’, ‘no action’, ‘cascade’, ‘set null’, and ‘set default’。
priority：Not used？
readonly：当值为True时，该字段只读不可修改，缺省值：False
required：当值为True时，在对象存储前，该字段必须有个值，缺省值：False
size：数据库中该字段的size：number characters or digits.
states：让我们为这个对象特定的states重写其他参数，Accepts a dictionary with the state names as keys and a list of name/value tuples as the values. For example: states={‘posted’:[(‘readonly’,True)]}
string：The field name as it should appear in a label or column header. Strings containing non-ASCII characters must use python unicode objects. For example: ‘tested’: fields.boolean(u’Testé’)
translate：值为True的话应该翻译这个字段的content，为False的话就不翻。

对于一些字段类型，下面也是可选的参数：

context: Define a variable’s value visible in the view’s context or an on-change function. Used when searching child table of one2many relationship?
domain: 相关字段的Domain restriction


缺省值: [].


示例: domain=[(‘field’,’=’,value)])
:invisible: 在表单中隐藏该字段的值，例如输入密码区
:on_change: Default value for the on_change attribute in the view. This will launch a function on the server when the field changes in the client. For example, on_change=”onchange_shop_id(shop_id)”.
:relation: 当某个字段是另张表的id reference时就使用它。This is the name of the table to look in. Most commonly used with related and function field types.
:select: 视图中select 属性的默认值，1指basic search，2指advanced search.




字段类型


基础类型





	boolean:	






布尔型(boolean) (true, false).



语法:

fields.boolean('字段名称' [, 可选参数]),












	integer:	






整型(integer).



语法:

fields.integer('字段名称' [, 可选参数]),












	float:	






浮点型(float).



语法:

fields.float('字段名称' [, 可选参数]),






Note

digits定义整数部分和小数部分的位数。 The scale being the number of digits after the decimal point
whereas the precision is the total number of significant digits in the
number (before and after the decimal point). If the parameter digits is
not present, the number will be a double precision floating point number.
Warning: these floating-point numbers are inexact (not any value can be
converted to its binary representation) and this can lead to rounding
errors. You should always use the digits parameter for monetary amounts.



例子:

'rate': fields.float(
    'Relative Change rate',
    digits=(12,6) [,
    Optional Parameters]),












	char:	






字符串(char):
限定长度的字符串，size属性定义字符串长度。



语法:

fields.char(
        '字段名称',
        size=n [,
        可选参数]), # 参数 ''n'' 指明了字符串字段的长度.





Example:

'city' : fields.char('City Name', size=30, required=True),












	text:	






没有长度限制的text field



Syntax:

fields.text('Field Name' [, Optional Parameters]),












	date:	






A date.



Syntax:

fields.date('Field Name' [, Optional Parameters]),












	datetime:	






Allows to store a date and the time of day in the same field.



Syntax:

fields.datetime('Field Name' [, Optional Parameters]),












	binary:	






A binary chain






	selection:	






这个字段让用户对之前定义的值进行选择



Syntax:

fields.selection((('n','Unconfirmed'), ('c','Confirmed')),
                   'Field Name' [, Optional Parameters]),






Note

Format of the selection parameter: tuple of tuples of strings of the form:

(('key_or_value', 'string_to_display'), ... )








Note

You can specify a function that will return the tuple. Example

def _get_selection(self, cursor, user_id, context=None):
    return (
       ('choice1', 'This is the choice 1'),
       ('choice2', 'This is the choice 2'))

_columns = {
   'sel' : fields.selection(
       _get_selection,
       'What do you want ?')
}







Example

Using relation fields many2one with selection. In fields definitions add:

...,
'my_field': fields.many2one(
        'mymodule.relation.model',
        'Title',
        selection=_sel_func),
...,





And then define the _sel_func like this (but before the fields definitions):

def _sel_func(self, cr, uid, context=None):
    obj = self.pool.get('mymodule.relation.model')
    ids = obj.search(cr, uid, [])
    res = obj.read(cr, uid, ids, ['name', 'id'], context)
    res = [(r['id'], r['name']) for r in res]
    return res











Relational Types





	one2one:	






表示有两个对象是一对一的关系。现在用many2one来代替。



Syntax:

fields.one2one('other.object.name', 'Field Name')












	many2one:	






通过这个字段一个对象与它的父对象关联。例如，员工和部门的关系就是多对一的关系。



Syntax:

fields.many2one(
        'other.object.name',
        'Field Name',
        optional parameters)





可选的参数:



	
	ondelete: 当该字段指示的资源被删除时会发生些什么

	
	预先定义的值: “cascade”, “set null”, “restrict”, “no action”, “set default”

	缺省值: “set null”









	required: True



	readonly: True



	select: True - (creates an index on the Foreign Key field)








Example

'commercial': fields.many2one(
        'res.users',
        'Commercial',
        ondelete='cascade'),












	one2many:	






TODO



Syntax:

fields.one2many(
        'other.object.name',
        'Field relation id',
        'Fieldname',
        optional parameter)






	可选的参数：

	
	invisible: True/False

	states: ?

	readonly: True/False







Example

'address': fields.one2many(
        'res.partner.address',
        'partner_id',
        'Contacts'),












	many2many:	






TODO



Syntax:

fields.many2many('other.object.name',
                 'relation object',
                 'actual.object.id',
                 'other.object.id',
                 'Field Name')






	Where:

	
	other.object.name是属于这个关系的其他对象。

	relation object做该关系链接的表格

	actual.object.id和other.object.id是用于关系表格的字段名称。







Example:

'category_ids':
   fields.many2many(
    'res.partner.category',
    'res_partner_category_rel',
    'partner_id',
    'category_id',
    'Categories'),





To make it bidirectional (= create a field in the other object):

class other_object_name2(osv.osv):
    _inherit = 'other.object.name'
    _columns = {
        'other_fields': fields.many2many(
            'actual.object.name',
            'relation object',
            'actual.object.id',
            'other.object.id',
            'Other Field Name'),
    }
other_object_name2()





Example:

class res_partner_category2(osv.osv):
    _inherit = 'res.partner.category'
    _columns = {
        'partner_ids': fields.many2many(
            'res.partner',
            'res_partner_category_rel',
            'category_id',
            'partner_id',
            'Partners'),
    }
res_partner_category2()












	related:	






有时候你需要考虑关联中的关联。例如，假设你有这样的对象：City -> State -> Country，你需要从一个城市名得到一个国家名，你可以在City对象中定义:

'country_id': fields.related(
    'state_id',
    'country_id',
    type="many2one",
    relation="res.country",
    string="Country",
    store=False)






	Where:

	
	The first set of parameters are the chain of reference fields to
follow, with the desired field at the end.

	:guilabel:type是期望字段的类型。

	Use relation if the desired field is still some kind of
reference. relation is the table to look up that
reference in.













Functional Fields

函数字段是通过函数计算了值的字段。 (而不是存储在数据库中).

参数:

fnct, arg=None, fnct_inv=None, fnct_inv_arg=None, type="float",
    fnct_search=None, obj=None, method=False, store=False, multi=False





where



	fnct 是计算字段值的函数或者方法。它必须在声明该函数字段前定义。

	fnct_inv 用来为改制段写入值的函数或者方法.

	type 由函数返回的字段类型名称. 可以是函数以外的任何字段类型名称.

	fnct_search 允许你在该字段上面定义搜索行为.

	method 指明了该字段是由一个方法（属于对象）或者一个全局函数计算的。

	store 是否要储存该字段在数据库中。默认是 False.

	multi 是一个组名. 所有具有相同 multi 参数的字段将被在单次函数调用中计算。







fnct 参数

如果 method 是 True, 那么方法的声明必须是这样的:

def fnct(self, cr, uid, ids, field_name, arg, context):





否则(如果是个全局函数), 它的声明必须是这样:

def fnct(cr, table, ids, field_name, arg, context):





不管哪种形式，它的返回值形式是：
{id’_1_’: value’_1_’, id’_2_’: value’_2_’,...}.

返回值必须是之前定义的类型。

如果multi是set，则field_name将会被field_names代替：a list of the field names会被计算。Each value in the returned dictionary is also a dictionary from field name to value.例如，如果字段’name’和’age’都基于函数vital_statistics，那么该函数的返回值应该是这样（当ids是[1,2,5]）：:

{
    1: {'name': 'Bob', 'age': 23},
    2: {'name': 'Sally', 'age', 19},
    5: {'name': 'Ed', 'age': 62}
}








fnct_inv parameter

如果method是True，那么method声明是：:

def fnct(self, cr, uid, ids, field_name, field_value, arg, context):





不然（如果是全局函数），声明是:

def fnct(cr, table, ids, field_name, field_value, arg, context):








fnct_search parameter

If method is true, the signature of the method must be:

def fnct(self, cr, uid, obj, name, args, context):





otherwise (if it is a global function), it should be:

def fnct(cr, uid, obj, name, args, context):





在查找函数中，返回值是三元祖的列表。


return [(‘id’,’in’,[1,3,5])]


obj和self相同，name接受字段名。args是三元祖的列表，包含这个字段的查询规范，即使每个元祖分别调用该查询函数。




例子

我们创建这样一个contract对象：

class hr_contract(osv.osv):
    _name = 'hr.contract'
    _description = 'Contract'
    _columns = {
        'name' : fields.char('Contract Name', size=30, required=True),
        'employee_id' : fields.many2one('hr.employee', 'Employee', required=True),
        'function' : fields.many2one('res.partner.function', 'Function'),
    }
hr_contract()





如果添加一个字段要通过看它的current contract来检索员工，我们使用functional field。对象hr_employee这样继承：

class hr_employee(osv.osv):
    _name = "hr.employee"
    _description = "Employee"
    _inherit = "hr.employee"
    _columns = {
        'contract_ids' : fields.one2many('hr.contract', 'employee_id', 'Contracts'),
        'function' : fields.function(
            _get_cur_function_id,
            type='many2one',
            obj="res.partner.function",
            method=True,
            string='Contract Function'),
    }
hr_employee()





def _get_cur_function_id(self, cr, uid, ids, field_name, arg, context):
    for i in ids:
        #get the id of the current function of the employee of identifier "i"
        sql_req= """
        SELECT f.id AS func_id
        FROM hr_contract c
          LEFT JOIN res_partner_function f ON (f.id = c.function)
        WHERE
          (c.employee_id = %d)
        """ % (i,)

        cr.execute(sql_req)
        sql_res = cr.dictfetchone()

        if sql_res: #The employee has one associated contract
            res[i] = sql_res['func_id']
        else:
            #res[i] must be set to False and not to None because of XML:RPC
            # "cannot marshal None unless allow_none is enabled"
            res[i] = False
    return res





在SQL query中使用函数的id来检索。如果这个查询没有结果返回，那么sql_res[‘func_id’]的值为None。我们必须将值设为False，因为XML:RPC不允许传送该值。




store Parameter

它会计算该字段的值，并且将结果存储在表中。当其他对象中相应该字段的值发生变化时会重新计算它。它使用一下句法：

store = {
    'object_name': (
            function_name,
            ['field_name1', 'field_name2'],
            priority)
}





当对象object_name中列表[‘field1’,’field2’]中的字段发生变化时，会调用函数function_name。函数声明如下：


def function_name(self, cr, uid, ids, context=None):


ids是其他对象表中记录的ids，这些对象有些字段值已被更改。这个函数在自己表中返回a list of ids of records 并且有些值已被更改。这个list作为main函数的参数字段。

下面是一个membership模块的例子：

'membership_state':
    fields.function(
        _membership_state,
        method=True,
        string='Current membership state',
        type='selection',
        selection=STATE,
        store={
            'account.invoice': (_get_invoice_partner, ['state'], 10),
            'membership.membership_line': (_get_partner_id,['state'], 10),
            'res.partner': (
                lambda self, cr, uid, ids, c={}: ids,
                ['free_member'],
                10)
        }),










Property Fields


	
Declaring a property

	



property是一个特定的字段：fields.property

class res_partner(osv.osv):
    _name = "res.partner"
    _inherit = "res.partner"
    _columns = {
                'property_product_pricelist':
                                            fields.property(
                                'product.pricelist',
                        type='many2one',
                        relation='product.pricelist',
                        string="Sale Pricelist",
                                method=True,
                                view_load=True,
                                group_name="Pricelists Properties"),
    }





你要在.xml文件中为这个property创建一个默认值：

<record model="ir.property" id="property_product_pricelist">
    <field name="name">property_product_pricelist</field>
    <field name="fields_id" search="[('model','=','res.partner'),
      ('name','=','property_product_pricelist')]"/>
    <field name="value" eval="'product.pricelist,'+str(list0)"/>
</record>






Tip

if the default value points to a resource from another module, you can use the ref function like this:

<field name=”value” eval=“‘product.pricelist,’+str(ref(‘module.data_id’))”/>



Putting properties in forms

想要在表单中添加属性，就要放<properties/>标签在表单中。这会自动添加与该对象相关的所有属性字段。你有权添加想要的属性。

属性值以部分的形式显示，依赖于group_name属性（这个在客户端像分隔符标签的样子渲染）。

How does this work ?

fields.property类继承自fields.function，重写了读写方法。这个字段的type是many2one，所以在表单中，property像many2one方法那样显示。

但是property的值作为一个完全的记录存储在ir.property class/table中。已存储的值是一个字段类型参考（不是many2one），因为每个property指向一个不同的对象。如果你要编辑properties values（从administration menu），这些代表着字段类型参考。

当你读取一个property时，程序会给你链接该property附属的对象实例。如果该对象没有值，系统会给你缺省值。

property的定义像其他字段一样存储在ir.model.fields类中。在property的定义中，你可以添加groups来更改property。

Using properties or normal fields

当你想要添加一个新feature，你会选择是作为property还是normal field来实现它。当你继承自对象并想要扩展它时，应该选择作为normal field。当新feature和对象不相关，只是一个外部概念时，应该选择作为property。

下面有些技巧来帮助你在normal field和property之间做选择：

Normal field扩展对象，增加很多features或是数据。

A property是附属于对象的概念，有着特定的属性：


	由公司决定相同的property有不同的值。

	每个字段权限管理

	资源之间的链接 (many2one)



Example 1: Account Receivable

对于一个特定partner的默认“Account Receivable”作为property执行是因为：



	这是个关系到account chart而不是partner的概念，所以account property在合作伙伴表单上是可见。会计人员有权管理这个字段。这不是相同的权限应用于partner对象。所以你对于partner表单的这个字段有特定的权限：只有会计人员可以更改the account receivable of a partner。

	1．这是个多公司字段：相同的partner有不同的account receivable values取决于这个用户属于哪个公司。在多公司系统中，每个公司有一个account chart。一个合作伙伴的account receivable取决于该公司的销售订单。

	1．对于所有合作伙伴的默认account receivable是相同的，由（administration中）主要property menu来配置。







Note

One interesting thing is that properties avoid “spaghetti” code. The account module depends on the partner (base) module. But you can install the partner (base) module without the accounting module. If you add a field that points to an account in the partner object, both objects will depend on each other. It’s much more difficult to maintain and code (for instance, try to remove a table when both tables are pointing to each others.)



Example 2: Product Times

生产到期模块实现所有相关产品的逾期：搬运日期，生产所用时间…这个模块对于食品生产非常有用。

这个模块继承自product.product，并且添加新字段到其中：

class product_product(osv.osv):

    _inherit = 'product.product'
    _name = 'product.product'
    _columns = {

        'life_time': fields.integer('Product lifetime'),
        'use_time': fields.integer('Product usetime'),
        'removal_time': fields.integer('Product removal time'),
        'alert_time': fields.integer('Product alert time'),
        }

product_product()





这个模块添加简单的字段到product.product对象中。我们不使用properties的原因是：



	我们扩展一个product，life_time字段是相关到product而不是另一个对象的概念

	我们不需要一个字段有个权限管理，不同的延迟被管理所有产品的人管理着。











ORM methods


Keeping the context in ORM methods

在OpenObject中，上下文保留重要数据类似文档必须被写入的语言等，无论function field是否需要更新等。

当调用ORM方法时，你已经拥有一个上下文，例如，框架提供给你一个几乎每个方法的参数。如果你有一个上下文，那么你一直带它通过你调用的每个单独的方法是很重要的。

这个规则适用于写ORM方法。你应该希望接受一个上下文作为参数，让它一直通过你调用的其他方法。




ORM methods
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视图和事件


介绍视图

因为程序中所有数据存储在对象中，这个在对象的部分已经解释过了，这些对象如何显示给用户的呢？我们将在这个部分解释这个问题。

首先注意每个资源类型有自己的界面。例如，修改一个合作伙伴数据的显示不同于修改invoice。

然后，你应该知道Openerp用户界面是动态变化的，这意味着它不是有“静态”代码来描述，而是由XML动态描述用户界面。

从现在起，我们称这些为screen descriptions views。

这些视图的显著特征是可以在任何时刻被修改（即使是在程序执行时刻）。如果对一个已经显示的视图进行修改后，你只需要关闭这个视图的标签，并且再打开，修改后的视图就会显示。


视图原理

视图描述了每个对象是如何显示的。更准确的说，对每个对象，我们可以定义一个或几个视图来描述哪个字段要显示和如何显示。

视图有两种:



	form views

	tree views







Note

Since OpenERP 4.1, form views can also contain graphs.








Form 视图

在表单视图中，字段配置一致遵守相同的准则。显示的字段遵守以下的准则：



	默认情况下，每个字段由label开始，以字段名称代表该字段。

	字段在屏幕上按照从左到右，从上到下的顺序显示，是依照他们在视图中的显示顺序。

	每个屏幕分成4列，每一列要么是一个label，要么是“edition”字段。每个edition字段由label开始（默认情况下），以字段名称代表该字段，在屏幕的每一行将有两个字段。下面的截图中，绿色和红色的区域正好举例说明了这4列，他们分别代表着labels和他们相关的字段。







[image: ../_images/sale_order.png]


视图支持更多的高级选项：



	一个视图字段可以有多列。例如，下面的截图中，蓝框的区域事实上是一个“one to many”的字段。我们注意到该字段是整个屏幕的宽度，而不是一列。









[image: ../_images/sale_order_sale_order_lines.png]






	我们同样可以做相反的操作：将一列分成任意的多列。上图中的绿框区域正好就说明这个情况。更准确的说，绿框看着是两列，其实包括着4列。






下面截图中蓝色的区域，是将对象的字段分成不同的标签。


[image: ../_images/sale_order_notebook.png]





Tree 视图

当我们工作在一个list样式下（想要同时看到很多资源）和查询界面时，这些视图就会用到。这些视图比form views简单，有较少的选项。


[image: ../_images/tree_view.png]





Graph 视图

graph对所有的表单视图来说是一种新形式的视图。例如，如果一个销售订单线作为list或graph必须是可见的，将它定义为打开这个销售订单线的动作。不要将视图形式设置为“tree，form，graph”或“form，graph”，必须设置为“graph，tree”来首先显示graph或者设置为“tree，graph”来首先显示list。（这个视图形式是你的“form，tree”视图的额外形式并且应该有个分开的菜单选项）。

<field name="view_type">form</field>
<field name="view_mode">tree,graph</field>





view_type:

tree = (tree with shortcuts at the left), form = (switchable view form/list)





view_mode:

tree,graph : sequences of the views when switching





接下来，用户可以从一个视图转换到另一个视图。不像表单和列表视图一样，OpenERP不能自动按需创建graph视图，所以你必须自己定义graph视图：

<record model="ir.ui.view" id="view_order_line_graph">
   <field name="name">sale.order.line.graph</field>
   <field name="model">sale.order.line</field>
   <field name="type">graph</field>
   <field name="arch" type="xml">
         <graph string="Sales Order Lines">
              <field name="product_id" group="True"/>
              <field name="price_unit" operator="*"/>
        </graph>
    </field>
</record>





graph 视图

graph类型的视图只是graph的字段列表。


Graph tag

graph的默认类型是圆形分格统计图表（pie chart），要将它转换成条形图（barchart），就需要将<graph string=”Sales Order Lines”> 转换成 <graph string=”Sales Order Lines” type=”bar”>，你也可以改变方向。

:例如 :

<graph string="Sales Order Lines" orientation="horizontal" type="bar">








Field tag

第一个字段是x轴，第二个是y轴，第三个是z轴，这个是可选择的三维图字段。你可以运用一些属性到每个field/axis。



	group: 如果设置为true，客户端会组合这个字段相同值的所有项。对于相互的字段，它会应用operator。

	operator: operator的应用是由另一个字段决定的，默认是“+”，允许的值是：








	+: addition

	*: multiply

	**: exponent

	min: minimum of the list

	max: maximum of the list










	Defining real statistics on objects:

		





定义真正的对象数据统计：



	定义一个统计对象，它是PostgreSQL视图

	在这个对象上创建一个tree view和graph view






You can get an example in all modules of the form: report_.... Example: report_crm.






Search views

search views是Openerp 6.0版本支持的一个新特性。它创建一个自定义的查找面板，它的显示和表单视图非常相似，除了将视图的类型和根元素由form改为search。

[image: ../_images/search.png]
下面是search视图中要用到的新的元素和特性列表。


Group tag

不像表单元素组，search view groups支持一行中不限数量的widget（fields或filters），并且只是使用下面的属性：



	expand: turns on the expander icon on the group (1 for expanded by default, 0 for collapsed)

	string: label for the group






<group expand="1" string="Group By...">
   <filter string="Users" icon="terp-project" domain="[]" context="{'group_by':'user_id'}"/>
   <filter string="Project" icon="terp-project" domain="[]" context="{'group_by':'project_id'}"/>
   <separator orientation="vertical"/>
   <filter string="Deadline" icon="terp-project" domain="[]" context="{'group_by':'date_deadline'}"/>
</group>





以上的截图是个扩展group。




Filter tag

Filters在查找面板作为一个触发按钮方式显示，可以添加新的过滤元素在当前域或是查询视图的上下文。Filters可以作为一个字段子元素添加进去，来表示他们专门用于该字段（这种情况下button按钮会变小些）。

在图中表单上部红色区域包含着filters，而蓝色区域是一个字段，并且是child filter。

<filter string="Current" domain="[('state','in',('open','draft'))]" help="Draft, Open and Pending Tasks" icon="terp-project"/>
<field name="project_id" select="1" widget="selection">
    <filter domain="[('project_id.user_id','=',uid)]" help="My Projects" icon="terp-project"/>
</field>








Group By

<filter string="Project" icon="terp-project" domain="[]" context="{'group_by':'project_id'}"/>





以上的filters groups records都用相同的project_id值。groups懒加载，所以，inner records只在group扩展时加载。group header lines包含这个group中所有记录的共同值，并且所有数字型的字段一般先是在视图中，来代替值的和。

将指定的a list of fields的很多值分组来代替a single string是可能的。这种情况下，嵌套分组就会显示出来:

<filter string="Project" icon="terp-project" domain="[]" context="{'group_by': ['project_id', 'user_id'] }"/>








Fields

search view里面的字段元素用来为搜索得到user-provided值。其结果是，对于组元素（group elements），它们和表单视图的字段大不相同：


	一个搜索字段可以包含过滤（filters），通常表明字段和过滤管理相同的字段并且二者相关。




那些内部的过滤器渲染为小buttons，紧挨着字段，肯定没有string属性。




	一个search字段确实构造了一个由[(field_name, operator, field_value)]构成的domain。这个domain在两种情况下无效：

	@operator replaces the default operator for the field (which
depends on its type)

	@filter_domain lets you provide a fully custom domain, which
will replace the default domain creation







	一个search字段不能默认创建上下文，但是你可以提供一个context，来评估和合并进wider context。



为了在你的context或filter_domain中获得字段值，你可以使用可变的self：

<field name="location_id" string="Location"
       filter_domain="['|',('location_id','ilike',self),('location_dest_id','ilike',self)]"/>





or

<field name="journal_id" widget="selection"
       context="{'journal_id':self, 'visible_id':self, 'normal_view':False}"/>






Range fields (date, datetime, time)

range字段由两个input widgets组成，而不是之前的一个。

这导致了它的特殊性（相比于non-range search fields来说）：


	由于domain由两个section构成，每个section使用不同的operator，但通过@operator重写range field是不可能的。

	Instead of being a simple value (integer, string, float) self
for use in @filter_domain and @context is a dict.




因为range field的每个input widget可以为空（并且字段本身始终有效），必须谨慎使用self：它有两个string keys“from”和“to”，这些keys任意一个可以不使用或设置其值为False。







Actions for Search view

在声明一个search view后，它会被自动用在相同model的所有tree view中。如果一个model有几个search view，那它会使用拥有最高优先级的那个。另一个选择就是通过设置action中的search_view_id字段来明确选择想要使用的search view。

除了能够传递在action上下文中的默认表单值外，OpenERP 6.0现在支持通过上下文来传递search views的初始值。这个上下文keys需要匹配search_default_XXX格式。在search view中XXX是指<field>或<filter>的名字（其实对于filters，name属性并不是必须的，当它必须要有个明确的name值时才起作用）。这个值要么是search fields的初始值，要么是filter的布尔值，现在来切换它们：

<record id="action_view_task" model="ir.actions.act_window">
    <field name="name">Tasks</field>
    <field name="res_model">project.task</field>
    <field name="view_type">form</field>
    <field name="view_mode">tree,form,calendar,gantt,graph</field>
    <field eval="False" name="filter"/>
    <field name="view_id" ref="view_task_tree2"/>
    <field name="context">{"search_default_current":1,"search_default_user_id":uid}</field>
    <field name="search_view_id" ref="view_task_search_form"/>
</record>








Custom Filters

对于V6.0，search view都可以进行自定义search filters，向下面显示的那样。用户可以使用当前模块的任意字段来定义自己的filters，并且用AND/OR operator来合并他们。将任何的search context作为个人过滤器都是可以的，还可以在任何时候重新调用。过滤器可以在用户主页直接转换成快捷键。

[image: ../_images/filter.png]
在以上的截图中，我们过滤Partner用Salesman = Demo user 和Country = Belgium，我们将这个搜索标准作为快捷键或是保存为过滤器。

过滤器是用户特定的，可以通过在filters 下拉菜单中管理过滤器选项来进行修改。






Calendar Views

Calendar 视图为数据提供时间线（timeline）/日程表（schedule）视图。


View Specification

这有一个视图例子：

<calendar color="user_id" date_delay="planned_hours" date_start="date_start" string="Tasks">
    <field name="name"/>
    <field name="project_id"/>
</calendar>





下面是该视图标签的属性:



	string

	该视图的标题






date_start  ：表示开始时间的属性，该字段是必须的。
date_stop  ：表示结束时间的属性，如果指定了date_delay属性就可以忽视该属性。
date_delay  ：A numeric field to specify time in hours for a record. This attribute will get preference over date_stop and date_stop will be ignored.
day_length  ：显示工作时间长度的数字值，默认为8小时
color  ：A field, generally many2one, to colorize calendar/gantt items.
mode  ：A string value to set default view/zoom mode. For calendar view, this can be one of following (default is month):



	day

	week

	month









Screenshots

Month Calendar:


[image: ../_images/calendar_month.png]


Week Calendar:


[image: ../_images/calendar_week.png]







Gantt Views

Gantt view为数据提供时间线视图，总体来说，它用于显示项目任务和资源分配。

甘特图是这个项目所有任务的图形显示。图的每一条显示该任务花费时间的长度。

资源分配总条在图中所有任务的上面显示，代表着任务中资源的有效利用情况。

颜色使用情况是：



	Gray 显示是指这个时候资源没有分配给任何任务。

	Blue 显示是指这个时候资源完全分配了。

	Red 显示是指这个时候资源overallocated。







View Specification

Here is an example view:

<gantt color="user_id" date_delay="planned_hours" date_start="date_start" string="Tasks">
    <level object="project.project" link="project_id" domain="[]">
        <field name="name"/>
    </level>
</gantt>





甘特图标签的属性和calendar图标签的属性类似。level标签用于将一些many2one字段的记录分组。目前仅支持one level。

下面是gantt标签的属性：



	string

	The title string for the view.








	date_start

	A datetime field to specify the starting date for the gantt item. This
attribute is required.

	date_stop

	A datetime field to specify the end date. Ignored if date_delay
attribute is specified.

	date_delay

	A numeric field to specify time in hours for a record. This attribute
will get preference over date_stop and date_stop will be ignored.

	day_length

	An integer value to specify working day length. Default is 8 hours.

	color

	A field, generally many2one, to colorize calendar/gantt items.

	mode

	A string value to set default view/zoom mode. For gantt view, this can be
one of following (default is month):


	day

	3days

	week

	3weeks

	month

	3months

	year

	3years

	5years










The level tag supports following attributes:



	object

	一个openerp对象和视图object有many2one的关系。








	link

	链接到给定对象的当前对象的字段名








	domain

	这个domain用于过滤给定的对象记录。









Drag and Drop

左边的窗格显示由level分组的任务列表。你可以重新排序或是通过拖动他们来更改记录的分组。

主要内容窗格显示在时间格中绘制的水平条。一组水平条概要汇总了所有任务资源分配条。

你可以通过水平拖动任务来更改任务开始时间，当然也可以通过拖动右侧条来更改结束时间。


Note

The time is calculated considering day_length so a bar will span more
then one day if total time for a task is greater then day_length value.






Screenshots


[image: ../_images/gantt.png]







Design Elements

文件中的视图描述形式如下：





	Example:	





<?xml version="1.0"?>
<openerp>
   <data>
       [view definitions]
   </data>
</openerp>





视图定义包含了以下三种类型的标签：



	<record> 标签有属性model=“ir.ui.view”，它包含本身的视图定义

	<record> 标签有属性model=“ir.actions.act_window”，它将动作和这些视图链接起来。

	<menuitem> 标签，在菜单中创建记录，将他们和动作链接起来。






New：你可以指定组，菜单在menuitem标签中用组属性来访问这些组。

New：你可以使用shortcut标签来加快捷键。





	Example:	





<shortcut
    name="Draft Purchase Order (Proposals)"
    model="purchase.order"
    logins="demo"
    menu="m"/>





你应该加一个id属性在menuitem上

<record model="ir.ui.view" id="v">
    <field name="name">sale.order.form</field>
    <field name="model">sale.order</field>
    <field name="priority" eval="2"/>
    <field name="arch" type="xml">
            <form string="Sale Order">
                .........
            </form>
    </field>
</record>





priority字段的默认值为16，在没有特别规定的前提下，系统的视图都是最低优先级。


View Types


Tree View

你可以指定列表中包含的列元素和一些细节在列的显示中。search字段不能在这指定，他们显示在form视图中。

<record id="view_location_tree2" model="ir.ui.view">
    <field name="name">stock.location.tree</field>
    <field name="model">stock.location</field>
    <field name="type">tree</field>
    <field name="priority" eval="2"/>
    <field name="arch" type="xml">
        <tree
                colors="blue:usage=='view';darkred:usage=='internal'">

            <field name="complete_name"/>
            <field name="usage"/>
            <field
                name="stock_real"
                invisible="'product_id' not in context"/>
            <field
                name="stock_virtual"
                invisible="'product_id' not in context"/>
        </tree>
    </field>
</record>





这个例子是一个二维列表，但是你可以通过指点field_parent来显示树结构。这个名字尽管有些误导人，但是该字段必须包含一列所有的child记录。

<record id="view_location_tree" model="ir.ui.view">
    <field name="name">stock.location.tree</field>
    <field name="model">stock.location</field>
    <field name="type">tree</field>
    <field name="field_parent">child_ids</field>
    <field name="arch" type="xml">
        <tree toolbar="1">
            <field icon="icon" name="name"/>
        </tree>
    </field>
</record>





在tree元素中包含下面的属性：

colors：在列表中根据不同情况不同的颜色来记录，默认为黑。
toolbar：如果你想要一个树结构在单独工具栏区域列出上层的记录，那就把给属性值设为1。当你点击工具栏上的一个记录时，它的所有的后代都会显示在main tree中。二维列表中该值可以忽略






Grouping Elements


Separator

加个分隔线





	Example:	





<separator string="Links" colspan="4"/>





string属性定义了它的标签，colspan属性定义了他的水平大小（列的个数）。




Notebook

<notebook>: 用notebooks你可以分配视图字段在不同的标签上（每个由page tag定义）。你可以使用tabpos属性来设置tab：up，down，left，right。





	Example:	





<notebook colspan="4">....</notebook>








Group

<group>: 对几个列进行分组。



	colspan: 被使用的列数

	rowspan: 被使用的行数

	expand: 是否扩展该分组

	col:被提供的列数 (给他的下级)

	string: (可选) 如果设置了，将在字段组周围绘制一个框架, 包括这个string作为标签. 否则，这个框架是不可见的.










	Example:	





<group col="3" colspan="2">
    <field name="invoiced" select="2"/>
    <button colspan="1" name="make_invoice" states="confirmed" string="Make Invoice"
        type="object"/>
</group>








Page

为视图定义新的notebook





	Example:	





<page string="Order Line"> ... </page>:






	string: 定义page的名称








数据元素


Field

“field” tag的属性



	
	select="1": 标记这个是search 视图的搜索条件之一 。

	数值1 意思是这个字段被被包括在基本搜索里
数值2 意思是这个字段在高级搜索中.







	colspan="4": 字段被扩展开的列数.



	readonly="1": 设置位置 只读



	required="1": 该字段被标记为 必须. 如果字段被标记为必须,用户必须填写它，如果字段不填，系统不会保存资源。这个属性将取代 对象中的定义的required 字段值.



	nolabel="1": 隐藏字段的便签(但是这个字段在 search 视图不会被隐藏).



	invisible="True": 隐藏标签和字段.



	password="True": 用 星号替换字段值, “*”.



	string="": 改变字段的标签. 注意，这个标签也会用在search视图: 看上面的 select 属性).



	
	domain: 约束条件.

	
	Example: domain=”[(‘partner_id’,’=’,partner_id)]”









	
	widget: 可改变 widget.

	
	
	Example: widget=”one2many_list”

	
	one2one_list

	one2many_list

	many2one_list

	many2many

	url

	email

	image

	float_time

	reference

















	
	mode: 视图切换时的顺序.

	
	Example: mode=”tree,graph”









	
	on_change: 定义一个 函数，当字段内容被改变时调用.

	
	Example: on_change=”onchange_partner(type,partner_id)”

	要更详细的内容，查看 on change event .









	
	attrs: 允许定义一个字段的取决于同一窗口其它字段 的属性 . (也可用在 page, group, button and notebook 标签中o)

	
	格式: “{‘attribute’:[(‘field_name’,’operator’,’value’),(‘field_name’,’operator’,’value’)],’attribute2’:[(‘field_name’,’operator’,’value’),]}”

	这里的 attribute 是 readonly, invisible, required

	默认值: {}.

	例子在: (in product.product)
















<field digits="(14, 3)" name="volume" attrs="{'readonly':[('type','=','service')]}"/>









	eval: evaluate the attribute content as if it was Python code (see below for example)



	default_focus: set to 1 to put the focus (cursor position) on this field when the form is first opened.
There can only be one field within a view having this attribute set to 1 (new as of 5.2)


<field name="name" default_focus=”1”/>















Example

这有销售订单对象视图的源代码。这是相同对象作为对象在截图中的显示。





	Example:	





<?xml version="1.0"?>
<openerp>
    <data>
    <record id="view_partner_form" model="ir.ui.view">
            <field name="name">res.partner.form</field>
            <field name="model">res.partner</field>
            <field name="type">form</field>
            <field name="arch" type="xml">
            <form string="Partners">
                <group colspan="4" col="6">
                    <field name="name" select="1"/>
                    <field name="ref" select="1"/>
                    <field name="customer" select="1"/>
                    <field domain="[('domain', '=', 'partner')]" name="title"/>
                    <field name="lang" select="2"/>
                    <field name="supplier" select="2"/>
                </group>
                <notebook colspan="4">
                    <page string="General">
                        <field colspan="4" mode="form,tree" name="address"
                         nolabel="1" select="1">
                            <form string="Partner Contacts">
                                <field name="name" select="2"/>
                                <field domain="[('domain', '=', 'contact')]" name="title"/>
                                <field name="function"/>
                                <field name="type" select="2"/>
                                <field name="street" select="2"/>
                                <field name="street2"/>
                                <newline/>
                                <field name="zip" select="2"/>
                                <field name="city" select="2"/>
                                <newline/>
                                <field completion="1" name="country_id" select="2"/>
                                <field name="state_id" select="2"/>
                                <newline/>
                                <field name="phone"/>
                                <field name="fax"/>
                                <newline/>
                                <field name="mobile"/>
                                <field name="email" select="2" widget="email"/>
                            </form>
                            <tree string="Partner Contacts">
                                <field name="name"/>
                                <field name="zip"/>
                                <field name="city"/>
                                <field name="country_id"/>
                                <field name="phone"/>
                                <field name="email"/>
                            </tree>
                        </field>
                        <separator colspan="4" string="Categories"/>
                        <field colspan="4" name="category_id" nolabel="1" select="2"/>
                    </page>
                    <page string="Sales &amp; Purchases">
                        <separator string="General Information" colspan="4"/>
                        <field name="user_id" select="2"/>
                        <field name="active" select="2"/>
                        <field name="website" widget="url"/>
                        <field name="date" select="2"/>
                        <field name="parent_id"/>
                        <newline/>
                    </page>
                    <page string="History">
                        <field colspan="4" name="events" nolabel="1" widget="one2many_list"/>
                    </page>
                    <page string="Notes">
                        <field colspan="4" name="comment" nolabel="1"/>
                    </page>
                </notebook>
            </form>
            </field>
        </record>
    <menuitem
            action="action_partner_form"
            id="menu_partner_form"
            parent="base.menu_base_partner"
            sequence="2"/>
    </data>
 </openerp>






The eval attribute

eval属性评估它的内容像Python代码似地。这就允许你定义不是字符串的值。

一般情况下，内容中<field>标签一直作为字符串来计算。


	
Example 1:

	



<field name="value">2.3</field>





2.3不是float 2.3而是字符串2.3


	
Example 2:

	



<field name="value">False</field>





False不是布尔值False，而是字符串’False’。 This is especially tricky because Python’s conversion rules
consider any non-empty string to be True, so the above code will
end up storing the opposite of what is desired.

如果你想要计算float，boolean或是其他类型，除了string，可以使用eval属性：

<field name="value" eval="2.3" />
<field name="value" eval="False" />










Button

加button到当前视图中。允许用户在当前记录上执行各种动作。

点击button按钮后，记录会重新装载。

Buttons有以下的属性：


	@type

	定义button按钮激活后action执行类型。





	workflow (default)

	button会在当前model上发送workflow signal，使用button的name作为workflow signal name并且提供记录id作为参数（in a list）。







workflow signal会返回一个动作描述符，已执行的。否则会返回False。




	object

	button会在当前model上执行@name的方法，提供一个记录id作为参数（in a list）。该调用会返回一个动作描述符来执行。








	action

	button会触发action（ir.actions.actions）来执行。这个动作的id是button的@name。







From there, follows the normal action-execution workflow. One extra action
type is to just close the window.



return {'type': 'ir.actions.act_window_close'}









	@special

	当前仅有一个可能值：cancel，popup在没有RPC调用或是action执行时就会关闭。





Note

Only meaningful within a popup-type window (e.g. a
wizard). Otherwise, is a noop.




Warning

@special and @type are incompatible.







	@name

	button的标识符，用于指出调用哪个方法，发送哪个signal，执行哪个动作。




	@confirm

	当执行button的任务前，确认对话框会显示。当确认取消后，button的任务不会执行。




	@string

	button上会显示的标签。 [1].




	@icon

	显示button图表，如果没有这个button就是text-only
[2].




	@states, @attrs, @invisible

	OpenERP这些视图属性的标准含义。




	@default_focus

	如果设置为确认值（1）时，当点击RETURN时就会自动搜索按钮。




client端会忽视这个属性。




New in version 6.0.










	Example:	





<button name="order_confirm" states="draft" string="Confirm Order" icon="gtk-execute"/>
<button name="_action_open_window" string="Open Margins" type="object" default_focus=”1”/>








Label

用label来加个标题。





	Example:	





<label string="Test"/>








New Line

如果视图的所有列不能全部放进一行是强制换行。





	Example:	





<newline/>








	[1]	via exec_workflow on the object rpc endpoint







	[2]	in form view, in list view buttons have no label







	[3]	behavior in list view is undefined, as list view buttons don’t
have labels.











Inheritance in Views

当你要在一些自定义或是特定的模块上创建和继承对象时，在已经存在的视图上通过继承来添加/修改/删除一些字段相比于替换更好些。





	Example:	





<record model="ir.ui.view" id="view_partner_form">
    <field name="name">res.partner.form.inherit</field>
    <field name="model">res.partner</field>
    <field name="inherit_id" ref="base.view_partner_form"/>
    <field name="arch" type="xml">
        <notebook position="inside">
            <page string="Relations">
                <field name="relation_ids" colspan="4" nolabel="1"/>
            </page>
        </notebook>
    </field>
</record>





这是要在base模块上给res.partner.form的notebook里面加一个page。

继承engine会分析已存在的视图并且搜索的根节点。

<field name="arch" type="xml">





它会添加或是修改这个标签的内容。如果这个标签有很多属性，它会查找父类视图来匹配这些属性。

在位置属性上你可以使用以下的值：



	inside (default): your values will be appended inside the tag

	after: add the content after the tag

	before: add the content before the tag

	replace: replace the content of the tag.







Replacing Content

<record model="ir.ui.view" id="view_partner_form1">
    <field name="name">res.partner.form.inherit1</field>
    <field name="model">res.partner</field>
    <field name="inherit_id" ref="base.view_partner_form"/>
    <field name="arch" type="xml">
        <page string="Extra Info" position="replace">
            <field name="relation_ids" colspan="4" nolabel="1"/>
        </page>
    </field>
</record>





可用relation_ids字段来替换notebook的额外信息标签的内容。

父类和子类的视图可像其他视图一样通过—update=all来进行更新。




Deleting Content

想要删除表单视图中的一个字段，可使用position=”replace”属性。

<record model="ir.ui.view" id="view_partner_form2">
    <field name="name">res.partner.form.inherit2</field>
    <field name="model">res.partner</field>
    <field name="inherit_id" ref="base.view_partner_form"/>
    <field name="arch" type="xml">
        <field name="lang" position="replace"/>
    </field>
</record>








Inserting Content

想要加一个字段到form中在特定标签前的话，使用position=’before’属性。

<record model="ir.ui.view" id="view_partner_form3">
    <field name="name">res.partner.form.inherit3</field>
    <field name="model">res.partner</field>
    <field name="inherit_id" ref="base.view_partner_form"/>
    <field name="arch" type="xml">
        <field name="lang" position="before">
            <field name="relation_ids"/>
        </field>
    </field>
</record>





在lang字段前加relation_ids字段。

想要加一个字段到form中在指定标签后的话，使用position=’before’属性。

<record model="ir.ui.view" id="view_partner_form4">
    <field name="name">res.partner.form.inherit4</field>
    <field name="model">res.partner</field>
    <field name="inherit_id" ref="base.view_partner_form"/>
    <field name="arch" type="xml">
        <field name="lang" position="after">
            <field name="relation_ids"/>
        </field>
    </field>
</record>





在lang字段后加relation_ids字段。




Multiple Changes

想要在多个位置进行更改，在数据元素中包裹多个字段。

<record model="ir.ui.view" id="view_partner_form5">
    <field name="name">res.partner.form.inherit5</field>
    <field name="model">res.partner</field>
    <field name="inherit_id" ref="base.view_partner_form"/>
    <field name="arch" type="xml">
        <data>
            <field name="lang" position="replace"/>
            <field name="website" position="after">
                <field name="lang"/>
            </field>
        </data>
    </field>
</record>





在平常位置删除lang字段，在website后显示它。




XPath Element

有时视图因为太复杂了而不能让你简单的通过name找到字段。例如，字段显示在两个地方。在这种情况下，你可以使用xpath元素来描述想要进行更改的位置。

<record model="ir.ui.view" id="view_partner_form6">
    <field name="name">res.partner.form.inherit6</field>
    <field name="model">res.partner</field>
    <field name="inherit_id" ref="base.view_partner_form"/>
    <field name="arch" type="xml">
        <data>
            <xpath
                expr="//field[@name='address']/form/field[@name='email']"
                position="after">
                <field name="age"/>
            </xpath>
            <xpath
                expr="//field[@name='address']/tree/field[@name='email']"
                position="after">
                <field name="age"/>
            </xpath>
        </data>
    </field>
</record>





在表单视图和列表视图中添加age字段在email字段后。




Replacing Attributes

The attributes position lets you change an element’s attributes without
completely replacing it and its children. A common example is changing the
colours in a tree view.

<record id="mrp_production_tree_view" model="ir.ui.view">
  <field name="name">mrp.production.mycompany.tree.view</field>
  <field name="model">mrp.production</field>
  <field name="type">tree</field>
  <field name="inherit_id" ref="mrp.mrp_production_tree_view"/>
  <field name="arch" type="xml">
    <xpath expr="//tree" position="attributes">
      <attribute name="colors">blue:state=='draft'</attribute>
    </xpath>
  </field>
</record>










指定你要使用的视图

在几种情况下你相比于默认的视图更想用指定的视图：


	如果一个对象有好几种表单或是列表视图。

	如果你想要通过使用关系字段（如one2many）来更改表单或是列表视图。




使用优先级字段（priority field）

这个字段在视图定义中是可用的，默认为16。在默认情况下，OpenERP用最高优先级（更小的值）的视图来显示model。比如，想象我们的一个model有两个视图。model client有两个字段：firstname和lastname。我们将会定义两个视图，一个用于首先显示firstname，另一个用于首先显示lastname。

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32

	<!--
    Here is the first view for the model 'client'.
    We don't specify a priority field, which means
    by default 16.
    这是模型‘client'的第一个视图。
    我们不指定priority字段，意味着是默认值16
-->
<record model="ir.ui.view" id="client_form_view_1">
    <field name="name">client.form.view1</field>
    <field name="model">client</field>
    <field name="type">form</fiel>
    <field name="arch" type="xml">
        <field name="firstname"/>
        <field name="lastname"/>
    </field>
</record>

<!--
    A second view, which show fields in an other order.
    We specify a priority of 15.
    在 用另外的顺序显示字段的第二个视图，我们指定了priority为15.
-->
<record model="ir.ui.view" id="client_form_view_2">
    <field name="name">client.form.view2</field>
    <field name="model">client</field>
    <field name="priority" eval="15"/>
    <field name="type">form</fiel>
    <field name="arch" type="xml">
        <field name="lastname"/>
        <field name="firstname"/>
    </field>
</record>







现在，OpenERP每次为对象client显示表单视图，它都有两个视图选择。它一直选择的是第二个，因为这个有高优先级。除非你告诉它选择第一个。




Specify per-action view

为了说明这一点，我们将会创建2个菜单来为client对象显示表单视图。

	 1
 2
 3
 4
 5
 6
 7
 8
 9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37

	<!--
    This action open the default view (in our case,
    the view with the highest priority, the second one)
    此actionb打开了默认视图（在我们的例子中，这个视
            图有最优先级 ，第二个方法  -->
<record
    model="ir.actions.act_window"
    id="client_form_action">
    <field name="name">client.form.action</field>
    <field name="res_model">client</field>
    <field name="view_type">form</field>
    <field name="view_mode">form</field>
</record>

<!--
    This action open the view we specify.
    这个 action 打开我们指定的视图
-->
<record
    model="ir.actions.act_window"
    id="client_form_action1">
    <field name="name">client.form.action1</field>
    <field name="res_model">client</field>
    <field name="view_type">form</field>
    <field name="view_mode">form</field>
    <field name="view_id" ref="client_form_view_1"/>
</record>

<menuitem id="menu_id" name="Client main menu"/>
<menuitem
    id="menu_id_1"
    name="Here we don't specify the view"
    action="client_form_action" parent="menu_id"/>
<menuitem
    id="menu_id_1"
    name="Here we specify the view"
    action="client_form_action1" parent="menu_id"/>







你可以看到第19行，我们特定了一个视图。这意味着当我们打开第二个菜单时，OpenERP将会使用视图client_form_view_1，而不管它的优先级。


Note

记住，如果在 ref 属性中涉及在另外模块定义的一个视图，要使用模块名 (module.view_id) .






为关联字段related fields指定视图


使用上下文 context

view_id方法对于menus/actions效果很好，但是你如何为one2many字段特定视图呢？当你有一个one2many字段时，将会使用两个视图，一个列表视图（蓝色的），和一个表单视图（红色的，当你点击添加按钮时就会显示出）。


[image: ../_images/one2many_views.png]


当你添加一个one2many字段在表单视图中时，你会这么做：

<field name="order_line" colspan="4" nolabel="1"/>





当你想要使用指定的视图时，你可以添加一个context属性，并且为每个支持的视图类型指定一个view id，就像action的view_id属性：

<field name="order_line" colspan="4" nolabel="1"
       context="{'form_view_ref' : 'module.view_id', 'tree_view_ref' : 'module.view_id'}"/>





如果你不想指定视图，OpenERP将会用以下的顺序选择一个：

1．它会使用定义了inside字段的<form>和<tree>视图。

2．不然，它会使用这个对象最高优先级的视图。

3．最后，它会产生拥有所有字段的默认空视图。


Note

上下文关键字（context keys）被命名为 <view_type>_view_ref.




Note

默认情况下，OpenERP不会使用不是为自己对象定义的视图。如果你有两个model，有相同的字段，但是不同的model名称，OpenERP不会混乱使用，即使一个model继承自另一个。你可以更改这个通过手动指定视图，在动作中或是上下文中。






使用子视图

对于关联字段（related fields），你可以直接在一个字段中创建一个视图：

<record model="ir.ui.view" id="some_view">
    <field name="name">some.view</field>
    <field name="type">form</field>
    <field name="model">some.model.with.one2many</field>
    <field name="arch" type="xml">
        <field name="..."/>

        <!-- <=== order_line is a one2many field -->
        <field name="order_line" colspan="4" nolabel="1">
            <form>
                <field name="qty"/>
                ...
            </form>
            <tree>
                <field name="qty"/>
                ...
            </tree>
        </field>
</field>





如果你或是其他的开发人员想要在其他的module中继承这个视图，你需要继承父类视图并且修改子类字段。对于子类视图，你需要使用XPath Element来直接描述想要在哪里存放你的新字段。

<record model="ir.ui.view" id="some_inherited_view">
    <field name="name">some.inherited.view</field>
    <field name="type">form</field>
    <field name="model">some.model.with.one2many</field>
    <field name="inherit_id" ref="core_module.some_view"/>
    <field name="arch" type="xml">
        <data>
            <xpath
               expr="//field[@name='order_line']/form/field[@name='qty']"
               position="after">
               <field name="size"/>
            </xpath>
            <xpath
               expr="//field[@name='order_line']/tree/field[@name='qty']"
               position="after">
               <field name="size"/>
            </xpath>
        </data>
</field>





像这样定义一个subview的副作用是，它不能继承自它自己，它只能继承自父类视图。如果你单独定义了子类视图并且指定哪个子类视图来作为one2many字段的一部分使用，这样你的视图将会非常灵活。








事件


On Change  事件

当一个字段的内容发生改变时，on_change属性定义个方法就会被调用。

这个方法至少有几个参数：cr，uid，ids，这是三个传统的参数并且也在上下文字典中。你需要给方法添加参数。他们必须符合在视图中定义的其他字段，并且必须在XML中以以下的方式定义：:

<field
    name="name_of_field"
    on_change="name_of_method(other_field_1, ..., other_field_n)"/>





下面的是来自销售订单视图中的例子。

你可以使用‘context’关键字来访问上下文中的数据，这个上下文可以被用作函数中的参数：:

<field name="shop_id" on_change="onchange_shop_id(shop_id)"/>





def onchange_shop_id(self, cr, uid, ids, shop_id):

    v={}
    if shop_id:

        shop=self.pool.get('sale.shop').browse(cr,uid,shop_id)
        v['project_id']=shop.project_id.id
        if shop.pricelist_id.id:

            v['pricelist_id']=shop.pricelist_id.id

        v['payment_default_id']=shop.payment_default_id.id

    return {'value':v}





当编辑shop_id表单字段时，sale_order对象的onchange_shop_id方法会被调用，并且返回一个字典，其中‘value’关键字包含在’project_id’, ‘pricelist_id’, ‘payment_default_id’字段中新值来使用的字典。

我们注意到除了字段值，更改更多的东西是可能的。例如，可以更改字段值和其他字段的domain，这个更改通过表单的返回值：return {‘domain’: d, ‘value’: value}





	returns:	一个字典有以下关键字任意的混合：






domain
{field: domain} 的一个映射



这个返回的domains将被设置在该字段上，以替换默认的一个。



value
{field: value}} 的映射，这个值将会在相对应的字段上设置，可能触发新的onchanges或是attrs changes。



warning 有关键字``title`` 和 ``message``（两个是必须的）的字典。指出显示给用户的错误信息。
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菜单和操作


菜单

这有一个菜单项的模板：

<menuitem id="menuitem_id"
          name="Position/Of/The/Menu/Item/In/The/Tree"
          action="action_id"
          icon="NAME_FROM_LIST"
          groups="groupname"
          sequence="<integer>"/>





其中



	id用来在菜单项表中区别不同的菜单，这个标识符是唯一的，必须的字段。



	name定义了该菜单在menu层次中的位置。元素间通过斜杠“/”来划分。菜单名称中没有斜杠的是顶级菜单项。这个字段是必须的。



	action指定了动作的标识符，这个动作必须在action表（ir.actions.act_window）中定义过了。我们注意到这个字段不是必须的：你可以定义没有相应动作的菜单项。当我们为菜单项定义自制的按钮，就像文件夹的功能时，这个没有动作的菜单是有用的。



	
	icon指定了菜单项将会使用哪个按钮。默认的是ＳＴＯＣＫ＿ＯＰＥＮ．

	
	可用的按钮有: STOCK_ABOUT, STOCK_ADD, STOCK_APPLY, STOCK_BOLD, STOCK_CANCEL, STOCK_CDROM, STOCK_CLEAR, STOCK_CLOSE, STOCK_COLOR_PICKER, STOCK_CONNECT, STOCK_CONVERT, STOCK_COPY, STOCK_CUT, STOCK_DELETE, STOCK_DIALOG_AUTHENTICATION, STOCK_DIALOG_ERROR, STOCK_DIALOG_INFO, STOCK_DIALOG_QUESTION, STOCK_DIALOG_WARNING, STOCK_DIRECTORY, STOCK_DISCONNECT, STOCK_DND, STOCK_DND_MULTIPLE, STOCK_EDIT, STOCK_EXECUTE, STOCK_FILE, STOCK_FIND, STOCK_FIND_AND_REPLACE, STOCK_FLOPPY, STOCK_GOTO_BOTTOM, STOCK_GOTO_FIRST, STOCK_GOTO_LAST, STOCK_GOTO_TOP, STOCK_GO_BACK, STOCK_GO_DOWN, STOCK_GO_FORWARD, STOCK_GO_UP, STOCK_HARDDISK, STOCK_HELP, STOCK_HOME, STOCK_INDENT, STOCK_INDEX, STOCK_ITALIC, STOCK_JUMP_TO, STOCK_JUSTIFY_CENTER, STOCK_JUSTIFY_FILL, STOCK_JUSTIFY_LEFT, STOCK_JUSTIFY_RIGHT, STOCK_MEDIA_FORWARD, STOCK_MEDIA_NEXT, STOCK_MEDIA_PAUSE, STOCK_MEDIA_PLAY, STOCK_MEDIA_PREVIOUS, STOCK_MEDIA_RECORD, STOCK_MEDIA_REWIND, STOCK_MEDIA_STOP, STOCK_MISSING_IMAGE, STOCK_NETWORK, STOCK_NEW, STOCK_NO, STOCK_OK, STOCK_OPEN, STOCK_PASTE, STOCK_PREFERENCES, STOCK_PRINT, STOCK_PRINT_PREVIEW, STOCK_PROPERTIES, STOCK_QUIT,STOCK_REDO, STOCK_REFRESH, STOCK_REMOVE, STOCK_REVERT_TO_SAVED, STOCK_SAVE, STOCK_SAVE_AS, STOCK_SELECT_COLOR, STOCK_SELECT_FONT, STOCK_SORT_ASCENDING, STOCK_SORT_DESCENDING, STOCK_SPELL_CHECK, STOCK_STOP, STOCK_STRIKETHROUGH, STOCK_UNDELETE, STOCK_UNDERLINE, STOCK_UNDO, STOCK_UNINDENT, STOCK_YES, STOCK_ZOOM_100, STOCK_ZOOM_FIT, STOCK_ZOOM_IN, STOCK_ZOOM_OUT, terp-account, terp-crm, terp-mrp, terp-product, terp-purchase, terp-sale, terp-tools, terp-administration, terp-hr, terp-partner, terp-project, terp-report, terp-stock









	groups 指定哪个组的用户可以看到这个菜单（例如：groups=”admin”）。想要得到更多信息可以看“Management of Access Rights”。多个组的话可以用逗号分开（如：groups=”admin,user”）。



	sequence 是个整数类型，用于为菜单项中的菜单排序。更高的sequence number在菜单项的更下面。这个字段不是必须的：如果sequence没有指定值，菜单项将会得到一个默认的数值10。有相同数值的菜单项按照创建顺序来排序（_order = “sequence,id“）。









例如：

在server/bin/addons/sale/sale_view.xml中，我们有:

<menuitem name="Sales Management/Sales Order/Sales Order in Progress" id="menu_action_order_tree4" action="action_order_tree4"/>





想要更改菜单项的图标：

* Highlight the menu with the icon you want to change.
* Select the "Switch to list/form" option from the "Form" menu. This will take you to the Menu editor.
* From here you can change the icon of the selected menu.










动作


介绍

actions定义系统的行为来响应用户的动作；登录的新用户，双击invoice，点击动作按钮，...

简单的动作也有很多类型：



	Window: 打开一个新窗口



	
	Report: 打印报表

	o Custom Report: 自定义报表
o RML Report: XSL:RML 报表







	Wizard: 开始向导



	Execute: server端方法的执行。



	Group: 在一个组中集合多个动作








发生动作的以下事件：



	用户连接,

	用户双击菜单项,

	用户点击图标’print’和’action’.









事件样例

在OpenERP中，所有的动作都被描述了而没有配置。两个例子：



	双击菜单项时打开窗口

	用户连接







打开菜单

当用户打开菜单选择 “Operations > Partners > Partners Contact”，下一步是给用户该动作承诺的信息。



	在IR中查询动作



	
	执行动作

	1.如果这个动作类型是打开新窗口，它显示给用户：必须对选定的对象打开这个新窗口，并且它显示视图（form or list）和使用的文件。
2. 用户要求这个对象返回必要的信息来显示在表单视图中，字段的描述和XML视图















用户登陆

当一个新用户连接到服务器端时，客户端会搜索用于显示给该用户的首页动作。一般情况下，这个动作是：在‘Operations’部分打开菜单。

步骤是：



	阅读用户文件来获取ACTION_ID

	读取这个动作并且执行它









The fields


	Action Name

	The action name

	Action Type

	一直是’ir.action.act_window’

	View Ref

	用于显示对象的视图

	Model

	对象公布的model

	Type of View

	视图类型（Tree/Form）

	Domain Value

	在视图中减少可视数据的domain








The view

view描述表单视图或是数据列表如何显示在屏幕上。视图可以是Form类型或是Tree类型，这个取决于他们显示一个表单来编辑还是列表来看所有数据。

有动作打开‘Tree’模式时，一个表单就会被调用。表单视图可以从列表形式中打开。




The domain

这个参数让你可以控制在搜索视图中，哪些资源可以显示。

例如，在invoice这个实例中，你可以定义一个动作，这个动作用于打开发票没有付费的视图。

domain用Python写的，是元组的列表。这个元组有三个元素：



	测试必须完成的字段

	用于测试的运算符（<, >, =, like）

	已测试的值






如果你想要获得‘Draft’发票，使用以下的domain：[(‘state’,’=’,’draft’)]。

在简单的视图中，domain定义了资源，这个资源是树根（the roots of the tree）。而对于其他的资源，如果用户开发树的分支，那么即使他们不在domain中，也会被显示出来。




Window Action

动作在 Client Action
章节已经解释的很多了。这有一个动作XML记录的模板。

<record model="ir.actions.act_window" id="action_id_1">
    <field name="name">action.name</field>
    <field name="view_id" ref="view_id_1"/>
    <field name="domain">["list of 3-tuples (max 250 characters)"]</field>
    <field name="context">{"context dictionary (max 250 characters)"}</field>
    <field name="res_model">Open.object</field>
    <field name="view_type">form|tree</field>
    <field name="view_mode">form,tree|tree,form|form|tree</field>
    <field name="usage">menu</field>
    <field name="target">new</field>
</record>





其中



	id是动作在表格“ir.actions.act_window”中的标识符。它必须是唯一的。



	name是动作的名称（这个字段是必须的）



	view_id是当动作被激活时要显示的视图的名称。如果这个字段没有定义，拥有最高优先级的（如果两个视图有相同的优先级，那么先定义的一类视图就会被使用。），并且与对象res_model相关的一类视图就会被使用。



	domain是约束条件的列表，用于筛选搜索结果使更少的记录显示在视图上。约束条件列表用AND连接在一起：当所有的约束条件都满足时，表格记录就会显示在视图上。



	context是显示在视图中的上下文字典，当动作被激活时它就会打开。在XML文件中上下文字典的声明和Python字典一样有相同的语法。想要知道更多关于上下文字典的信息可以看” The context Dictionary”这个章节。



	res_model是这个动作发生的对象的名称。



	view_type当某个动作必须打开一个新的表单视图时，这个字段的值是form，当某个动作必须打开一个新的列表视图时，这个字段的值是tree。



	
	view_mode仅在view_type值是form时起作用，忽略其他的情况。四种可能的值是：

	
	form，tree: 这个视图开始时显示为表单视图，当点击“alternate view button”时，列表视图就会显示。

	tree，form: 这个视图开始时显示为列表视图，当点击“alternate view button”时，表单视图就会显示。

	form: 这个视图显示为表单视图，不可能显示为列表视图。

	tree: 这个视图显示为列表视图，不可能显示为表单视图。














(version 5 introduced graph and calendar views)



	usage is used [+ TODO +]

	target：视图会在新窗口打开，就像wizard似的。

	context会传递给动作本身，并加入到全局上下文中。







<record model="ir.actions.act_window" id="a">
    <field name="name">account.account.tree1</field>
    <field name="res_model">account.account</field>
    <field name="view_type">tree</field>
    <field name="view_mode">form,tree</field>
    <field name="view_id" ref="v"/>
    <field name="domain">[('code','=','0')]</field>
    <field name="context">{'project_id': active_id}</field>
</record>








他们想要告知用户的是，用户可以在新‘tab’打开一个新窗口.

Administration > Custom > Low Level > Base > Action > Window Actions


[image: ../_images/module_base_action_window.png]



Examples of actions

This action is declared in server/bin/addons/project/project_view.xml.

<record model="ir.actions.act_window" id="open_view_my_project">
    <field name="name">project.project</field>
    <field name="res_model">project.project</field>
    <field name="view_type">tree</field>
    <field name="domain">[('parent_id','=',False), ('manager', '=', uid)]</field>
    <field name="view_id" ref="view_my_project" />
</record>





This action is declared in server/bin/addons/stock/stock_view.xml.

<record model="ir.actions.act_window" id="action_picking_form">
    <field name="name">stock.picking</field>
    <field name="res_model">stock.picking</field>
    <field name="type">ir.actions.act_window</field>
    <field name="view_type">form</field>
    <field name="view_id" ref="view_picking_form"/>
    <field name="context">{'contact_display': 'partner'}</field>
</record>










Url Action




Wizard Action

下面是个显示wizard的.XML文件。

<?xml version="1.0"?>
<openerp>
    <data>
         <wizard string="Employee Info"
                 model="hr.employee"
                 name="employee.info.wizard"
                 id="wizard_employee_info"/>
    </data>
</openerp>





wizard用wizard标签来声明。想要知道更多关于wizard XML的信息可以查看“Add A New Wizard”这个章节。

你也可以使用一下的xml entry在menu中加wizard。

<?xml version="1.0"?>
<openerp>
     <data>
     <wizard string="Employee Info"
             model="hr.employee"
             name="employee.info.wizard"
             id="wizard_employee_info"/>
     <menuitem
             name="Human Resource/Employee Info"
             action="wizard_employee_info"
             type="wizard"
             id="menu_wizard_employee_info"/>
     </data>
</openerp>








Report Action


Report declaration

报表的解释在“Reports Reporting”章节。这有一个RML报表声明的XML文件。

<?xml version="1.0"?>
<openerp>
    <data>
    <report id="sale_category_print"
            string="Sales Orders By Categories"
            model="sale.order"
            name="sale_category.print"
            rml="sale_category/report/sale_category_report.rml"
            menu="True"
            auto="False"/>
     </data>
</openerp>





报表使用report标签在“data”块中声明。报表标签中的不同参数有：



	id : 一个标识符，必须是唯一的

	string : 菜单文字用来调用报表

	model : 报表会渲染的OpenERP对象

	rml : the .RML report model. Important Note : Path is relative to addons/ directory.

	menu : 不管报表是否通过客户端直接调用。如果报表通过wizard来调用，设置menu为False。

	auto : 确定.RML文件是否必须使用默认的解析器解析。使用客户解析器可以为你的报表定义额外的功能。













Security

在OpenERP中三个概念要区分一下：


1．The users：通过login/password来鉴定的person
2．The groups：定义资源的访问权限
3．The roles：确定用户的roles/duties



[image: ../_images/module_base_user.png]


The users

他们代表物理人类。他们通过登录和密码来鉴别。一个用户可以属于多个groups，可以有多个roles。

一个用户有开始action。当用户登录和输入密码时，action执行。比如一个动作是打开菜单‘Operations’。

用户可用选择图标选择不同的参数选择。例如，你可以使用这些参数选择来决定工作语言。默认为英语。

当你使用OpenERP时，可以修改自己的参数选择。你可以点击菜单：User > Preferences。OpenERP管理员可以修改很多参数选择和每个用户的参数选择。

The groups

groups决定对不同资源的访问权限。这有三种权限：



	写权限：写入和创建

	读权限：读取一个文件

	执行权限：工作流或向导的按钮






一个用户可以属于多个groups。如果他属于多个groups，我们将总是用有最高权限的组来对选定的资源。

The roles

roles在tree上定义了一个层次结构。他在公司内部代表着不同的jobs/roles。最大的role对所有的下级roles有自动的权限。

Example:

CEO



	Technical manager








	Chief of projects
	Developers

	Testers












	Commercial manager








	Salesmen

	...






如果我们想要验证一段程序（=role Testers）的测试，一个用户会有以下roles中的一个：Testers，Chief of the project，Technical manager，CEO。

roles用于将工作流动作转换为确认，选择或是验证动作。他们的含义在Workflow章节有详细的介绍。


Menu Access

允许对用户组菜单的grained访问是容易的，但是也是有风险的。

首先，你应该知道如果一个菜单不能被任何组访问，那么它可以让每个用户访问。如果你想要访问一些组，只需要点击Menu > Administration > Security > Define access to Menu-items和搜索可以用在这个菜单项中组。


[image: ../_images/grant_access.png]


注意：如果管理员不属于这个组，他将不能再使用这个菜单。
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创建向导 - (The Process)


简介

向导是描述客户端和服务器之间的相互动作的序列.

以下是一个典型的向导进程:



	向客户端发送一个窗口(待完成的表格)

	客户端发送在此表格中所填的数据

	服务器收到结果，执行一个函数并发送一个新的窗口到客户端






[image: ../_images/Wizard.png]
以下是一个向导的截图，该向导是用于处理业务的 (when you click on the gear icon in an account chart):

[image: ../_images/Wizard_screenshot.png]



向导 - 原则

向导具有一连串的步骤，每一个步骤由多个动作组成;


	发送表单给客户端或按钮

	客户端的按钮按下后，服务端获取表单的数据

	执行动作

	发送一个新动作给客户端（form，print, ...）



为了定义一个向导，需要创建一个继承于wizard.interface的类，并将其实例化。每个向导都有一个唯一的名字，该名字可以随意取，但它必须以组件名开头（如：account.move.line.reconcile）.向导必须定义一个名为states的字典，该字典定义了它所有的步骤。一个简单的向导例子在  http://www.openobject.com/forum/post43900.html#43900

以下为一个向导类的例子:

class wiz_reconcile(wizard.interface):
      states = {
           'init': {
                'actions': [_trans_rec_get],
                'result': {'type': 'form',
                           'arch': _transaction_form,
                           'fields': _transaction_fields,
                           'state':[('reconcile','Reconcile'),('end','Cancel')]}
          },
           'reconcile': {
                'actions': [_trans_rec_reconcile],
                'result': {'type': 'state', 'state':'end'}
          }
     }
wiz_reconcile('account.move.line.reconcile');





‘states’ 字典定义了向导的所有状态。在这个例子里; init 和 reconcile. 还有一个隐藏的状态叫 end .

向导一般从从 init 状态开始，到 end 状态结束.

状态定义了以下两个东西:



	动作列表

	结果







动作列表(The list of actions)

向导的每一步骤/状态都定义了动作列表，到向导进入该状态后便执行这些动作。动作列表可以是空的.

函数（actions）的语法规范如下 :

def _trans_rec_get(self, uid, data, res_get=False):





其中:



	self 是指向向导当前对象的指针



	uid 是执行此向导的用户ID



	
	data 是包含以下数据的字典:

	
	ids: 用户执行向导时，所关联的资源的id列表

	id: 当用户执行向导时高亮的id

	form: 一个字典，该字典包含了之前发送的表单里用户填写的数据，若你改变了字典里的值，则表单里的数据就会被提前填写.














每个动作函数必须返回一个字典。字典中的每一项将会与发送来的表单中所填写的数据合并.




结果(The result)

以下为一些result的例子:

Result: 下一步

'result': {'type': 'state',
           'state':'end'}





表示向导得继续下一步的状态: ‘end’. 如果这一步是 ‘end’ 状态，则向导停止.

Result: 发给客户端的新对话

'result': {'type': 'form',
           'arch': _form,
           'fields': _fields,
           'state':[('reconcile','Reconcile'),('end','Cancel')]}





type=form 表示这步骤是发送对话给客户端，对话由以下部分组成:


	a form : 带有字段的描述和表单的描述

	some buttons : 用户填写完数据后，按此按钮提交



表单的描述（arch）和视图一样，如下:

_form = """<?xml version="1.0"?>
        <form title="Reconciliation">
          <separator string="Reconciliation transactions" colspan="4"/>
          <field name="trans_nbr"/>
          <newline/>
          <field name="credit"/>
          <field name="debit"/>
          <field name="state"/>
          <separator string="Write-Off" colspan="4"/>
          <field name="writeoff"/>
          <newline/>
          <field name="writeoff_acc_id" colspan="3"/>
        </form>
        """





字段的描述和python对象里字段的描述类似。如:

_transaction_fields = {
      'trans_nbr': {'string':'# of Transaction', 'type':'integer', 'readonly':True},
      'credit': {'string':'Credit amount', 'type':'float', 'readonly':True},
      'debit': {'string':'Debit amount', 'type':'float', 'readonly':True},
      'state': {
                'string':"Date/Period Filter",
                'type':'selection',
                'selection':[('bydate','By Date'),
                             ('byperiod','By Period'),
                             ('all','By Date and Period'),
                             ('none','No Filter')],
                'default': lambda *a:'none'
                },
      'writeoff': {'string':'Write-Off amount', 'type':'float', 'readonly':True},
      'writeoff_acc_id': {'string':'Write-Off account',
                           'type':'many2one',
                           'relation':'account.account'
                         },
}





向导中每一步/状态都有多个按钮，这些按钮都分布在对话框的右下方。向导的每一步所涉及的按钮列表在结果字典的状态键中声明.

例如:

'state':[('end', 'Cancel', 'gtk-cancel'), ('reconcile', 'Reconcile', '', True)]






	下一步的名称（决定下一个状态）

	按钮的名字 (用于在客户端上的展示)

	the gtk stock item without the stock prefix (自 4.2)

	a boolean, 如果为true，按钮被设置为默认的动作 (自 4.2)



以下为这种表单的截图:

[image: ../_images/Wizard_screenshot1.png]
Result: 调用方法决定下一个状态

def _check_refund(self, cr, uid, data, context):
    ...
    return datas['form']['refund_id'] and 'wait_invoice' or 'end'

    ...

    'result': {'type':'choice', 'next_state':_check_refund}





Result: 打印一个报表

def _get_invoice_id(self, uid, datas):
      ...
      return {'ids': [...]}

      ...

      'actions': [_get_invoice_id],
      'result': {'type':'print',
                 'report':'account.invoice',
                 'get_id_from_action': True,
                 'state':'check_refund'}





Result: 客户端执行一个动作

def _makeInvoices(self, cr, uid, data, context):
    ...
    return {
                'domain': "[('id','in', ["+','.join(map(str,newinv))+"])]",
                'name': 'Invoices',
                'view_type': 'form',
                'view_mode': 'tree,form',
                'res_model': 'account.invoice',
                'view_id': False,
                'context': "{'type':'out_refund'}",
                'type': 'ir.actions.act_window'
        }

        ...

        'result': {'type': 'action',
        'action': _makeInvoices,
        'state': 'end'}





函数的返回的结果必须为 ir.actions.* 的所有字段. 这里为ir.action.act_window，所以客户端会打开一个新的标签页，新的标签页包含了account.invoicd的信息.

建议用一下方式读取 ir.actions 对象:

def _account_chart_open_window(self, cr, uid, data, context):
        mod_obj = pooler.get_pool(cr.dbname).get('ir.model.data')
        act_obj = pooler.get_pool(cr.dbname).get('ir.actions.act_window')

        result = mod_obj._get_id(cr, uid, 'account', 'action_account_tree')
        id = mod_obj.read(cr, uid, [result], ['res_id'])[0]['res_id']
        result = act_obj.read(cr, uid, [id])[0]
        result['context'] = str({'fiscalyear': data['form']['fiscalyear']})
        return result

        ...

        'result': {'type': 'action',
                   'action': _account_chart_open_window,
                   'state':'end'}










规范


表单(Form)

_form = '''<?xml version="1.0"?>
<form string="Your String">
    <field name="Field 1"/>
    <newline/>
    <field name="Field 2"/>
</form>'''








字段(Fields)


标准(Standard)

Field type: char, integer, boolean, float, date, datetime

_fields = {
      'str_field': {'string':'product name', 'type':'char', 'readonly':True},
}






	string: 字段的标签(必填)

	type: (必填)

	readonly: (可选)






关系(Relational)

Field type: one2one,many2one,one2many,many2many

_fields = {
    'field_id': {'string':'Write-Off account', 'type':'many2one', 'relation':'account.account'}
}






	string: 字段标签 (必填)

	type: (必填)

	relation: 所关系的对象名称






选择(Selection)

Field type: selection

_fields = {
    'field_id':  {
                 'string':"Date/Period Filter",
                 'type':'selection',
                 'selection':[('bydate','By Date'),
                              ('byperiod','By Period'),
                              ('all','By Date and Period'),
                              ('none','No Filter')],
                 'default': lambda *a:'none'
                 },






	string: 字段标签 (必填)

	type: (必填)

	selection: 选择字段中的键和值










添加一个新向导

创建一个新向导，你应该:



	
	在一个 .py 文件中创建向导定义

	
	向导一般都是定义在组件中的向导子文件夹中 server/bin/addons/module_name/wizard/your_wizard_name.py









	把向导添加到导入的声明列表，该列表位于组件向导子目录的 __init__.py 文件.



	在数据库中声明向导








声明需要映射向导和客户端键之间的关系，从而才能启动相应的客户端。声明一个新向导，需要把它加到 module_name_wizard.xml 文件里，该文件包含了此组件所有的向导声明。若该文件不存在，则需先创建.

这里以 account_wizard.xml 文件做一个例子;

<?xml version="1.0"?>
<openerp>
    <data>
        <delete model="ir.actions.wizard" search="[('wiz_name','like','account.')]" />
        <wizard string="Reconcile Transactions" model="account.move.line"
                name="account.move.line.reconcile" />
        <wizard string="Verify Transac steptions" model="account.move.line"
                name="account.move.line.check" keyword="tree_but_action" />
        <wizard string="Verify Transactions" model="account.move.line"
                name="account.move.line.check" />
        <wizard string="Print Journal" model="account.account"
                name="account.journal" />
        <wizard string="Split Invoice" model="account.invoice"
                name="account.invoice.split" />
        <wizard string="Refund Invoice" model="account.invoice"
                name="account.invoice.refund" />
    </data>
</openerp>





向导的标签属性:



	id: 此向导的唯一标识.



	string: 如果一个资源关联多个向导，此字符串会显示）.



	model: 对象从该模型中获取所需数据.



	name: 向导的名称，只可内部使用并且唯一.



	replace (可选): 此向导是否要重写 all 所有已经存在的向导。缺省值: False.



	menu (可选): 是否 (True|False) 把向导和 ‘gears’ 按钮 (i.e. show the button or not) 关联到一起。缺省值: True.



	
	keyword (可选): 向导绑定另一动作 (print icon, gear icon, ...). 关键字属性的可能值为:

	
	client_print_multi: 表单中的打印图标

	client_action_multi: 表单中的 ‘gears’ 图标

	tree_but_action: 列表中的 ‘gears’ 图标 (在左侧的快捷方式)

	tree_but_open: 在树的一个分支，双击 (在左侧的快捷方式). 例如，有这样的应用，在菜单中来绑定向导.














__openerp__.py

若创建的向导是模块中的第一个，还需要创建 modulename_wizard.xml 文件. 在这样的情况下，需要在 __openerp__.py 模块文件中增加 update_xml 文件.

例如 ，下面的 account 模块 account_wizard.xml 需要添加到 __openerp__.py 文件.

{
    "name": OpenERP Accounting",
    "version": "0.1",
    "depends": ["base"],
    "init_xml": ["account_workflow.xml", "account_data.xml"],
    "update_xml": ["account_view.xml","account_report.xml", "account_wizard.xml"],
}








osv_memory 向导系统

开发一个 osv_memory 向导, 只需创建一普通的对象，不是继承至 osv.osv, 而是继承至 osv.osv_memory. 向导 “wizard” 的方法是在对象中的，如果向导很复杂，可以在对象中定义工作流. osv_memory 对象是存储在内存中的，而不是存储在 postgresql.

就这些，仅仅是改变了继承。这些向导可以被定义在任意位置，而不仅仅是 addons/modulename/modulename_wizard.py.
从历史上看，_wizard前缀的是（旧式）向导，所以有可能是一个osv_memory为基础的“新风格”“向导”是完全正常的对象（只是用来模拟旧的向导，并没有完全脱离旧式的向导.
此外，osv_memory的“向导”，往往需要多个对象 (例如. 一个osv_memory对象为每个状态的原始向导) 所以对应的是不完全的 1:1.

所以，为何他们看着想旧式的向导呢?



	在打开对象的动作中，你可以写入以下






<field name="target">new</field>





这表示对象会在一个新的窗口中打开，而非当前这个.



	可以使用 <button special=”cancel” .../> 来关闭窗口.






例如 : 在 project.py 文件中.

class config_compute_remaining(osv.osv_memory):
    _name='config.compute.remaining'
    def _get_remaining(self,cr, uid, ctx):
        if 'active_id' in ctx:
            return self.pool.get('project.task').browse(cr,uid,ctx['active_id']).remaining_hours
        return False
    _columns = {
        'remaining_hours' : fields.float('Remaining Hours', digits=(16,2),),
            }
    _defaults = {
        'remaining_hours': _get_remaining
        }
    def compute_hours(self, cr, uid, ids, context=None):
        if 'active_id' in context:
            remaining_hrs=self.browse(cr,uid,ids)[0].remaining_hours
            self.pool.get('project.task').write(cr,uid,context['active_id'],
                                                 {'remaining_hours' : remaining_hrs})
        return {
                'type': 'ir.actions.act_window_close',
         }
config_compute_remaining()






	视图也和普通的视图一样 (注意按钮).



例如 :

<record id="view_config_compute_remaining" model="ir.ui.view">
            <field name="name">Compute Remaining Hours </field>
            <field name="model">config.compute.remaining</field>
            <field name="type">form</field>
            <field name="arch" type="xml">
                <form string="Remaining Hours">
                    <separator colspan="4" string="Change Remaining Hours"/>
                    <newline/>
                    <field name="remaining_hours" widget="float_time"/>
                    <group col="4" colspan="4">
                        <button icon="gtk-cancel" special="cancel" string="Cancel"/>
                        <button icon="gtk-ok" name="compute_hours" string="Update" type="object"/>
                    </group>
                </form>
            </field>
        </record>






	动作也和普通的动作一样 (不要忘了添加一个target 属性)



例如 :

<record id="action_config_compute_remaining" model="ir.actions.act_window">
    <field name="name">Compute Remaining Hours</field>
    <field name="type">ir.actions.act_window</field>
    <field name="res_model">config.compute.remaining</field>
    <field name="view_type">form</field>
    <field name="view_mode">form</field>
    <field name="target">new</field>
</record>








osv_memory 配置项

有时，你的插件不希望用默认的配置，而需要进一步的配置从而工作的更好。在这种情况下，
你希望在安装之后能有一个配置向导，并在今后需要重新配置时能再次调用该向导.

5.0以上的openerp有这样的功能，但却无相应的文档，而且需要手工操作。为了这样的需求，
一个简单明了的新的解决方案已经出现.


基础概念

新的解决方案提供一个具有基本的行为 osv_memory 对象，你必须继承该对象。这行为
是用来控制配置项和扩展之间的流的，而且必须继承自此对象.

同时，还有一个可继承的视图，该视图提供一个基本的框架，通过这种机制从而达到很强的可定制性。所以强烈建议你继承该视图.




创建基本的配置项


你的配置模型

首先是创建配置项本身，这是以个普通的 osv_memory 对象，该对象有一些限制:


	必须继承至 res.config, 提供一个基本的配置行为和基本的事件控制器和扩展点

	必须提供一个 execute 方法.[#]_ 当验证配置表单和包含验证逻辑时，就会调用这个方法。方法没有返回值.



class my_item_config(osv.osv_memory):
    _name = 'my.model.config'
    _inherit = 'res.config' # mandatory

    _columns = {
        'my_field': fields.char('Field', size=64, required=True),
    }

    def execute(self, cr, uid, ids, context=None):
        'do whatever configuration work you need here'
my_item_config()








配置视图

接下来是配置表单。Openerp提供一个基础视图，你可以继承这个基础视图，所以你
不需要自己创建按钮和控制进度条。强烈推荐使用这个基本视图.

在 ir.ui.view 中加入一个 inherit_id 字段，把它的值设为 res_config_view_base:

<record id="my_config_view_form" model="ir.ui.view">
    <field name="name">my.item.config.view</field>
    <!-- this is the model defined above -->
    <field name="model">my.model.config</field>
    <field name="type">form</field>
    <field name="inherit_id" ref="base.res_config_view_base"/>
    ...
</record>





当不做任何改变时，会展示出一个对话框，该对话框中包含一个进度条和两个按钮，
毫无生趣. res_config_view_base 有一个特别的group hook，你可以用你自己
的代码代替它，如下:

<field name="arch" type="xml">
    <group string="res_config_contents" position="replace">
        <!-- your content should be inserted within this, the string
             attribute of the previous group is used to easily find
             it for replacement -->
        <label colspan="4" align="0.0" string="
            Configure this item by defining its field"/>
        <field colspan="2" name="my_field"/>
    </group>
</field>








打开你的窗口

下一步是创建 act_window ，用于连接模型和视图的配置:

<record id="my_config_window" model="ir.actions.act_window">
    <field name="name">My config window</field>
    <field name="type">ir.actions.act_window</field>
    <field name="res_model">my.model.config</field>
    <field name="view_type">form</field>
    <field name="view_id" ref="my_config_view_form"/>
    <field name="view_mode">form</field>
    <field name="target">new</field>
</record>






	当在配置向导步骤的子菜单中列出多种配置选项时，注意到 act_window 的 name 字段会被显示出来

	(在 Administration > Configuration > Configuration > Wizards).






注册你的动作

最后是在openerp中注册配置项。这是在 ir.actions.todo 对象中完成的，
需要一个 action_id 字段关联到之前创建的 act_window:

<record id="my_config_step" model="ir.actions.todo">
    <field name="action_id" ref="my_config_window"/>
</record>





ir.actions.todo 有3个可选字段:


	sequence (default: 10)

	执行次序，数值小的先执行.




	active (default: True)

	不活跃的步骤在下一轮配置时将不会被执行.




	state (default: 'open')

	配置步骤的当前状态，用于记录执行过程中所发生的时间，值包含有 'open', 'done', 'skip' and
'cancel'.



结果如下图:

[image: ../_images/config_wizard_base.png]





定制你的配置项

目前所具备的知识已经足够配置你的插件了，但做一些好的定制能得到更好的用户体验.


更进一步的视图的定制

也许你已经注意到之前的截图，在默认的情况下，窗口是没有标题的，虽然并无大碍但却影响美观.

在设置一个标题之前，需要在视图里做一些微小的改动:  group 标签中需要填入 data ，这样就能修改父窗口中的多项配置:

<record id="my_config_view_form" model="ir.ui.view">
    <field name="name">my.item.config.view</field>
    <!-- this is the model defined above -->
    <field name="model">my.model.config</field>
    <field name="type">form</field>
    <field name="inherit_id">res_config_view_base</field>
    <field name="arch" type="xml">
        <data>
            <group string="res_config_contents" position="replace">
                <!-- your content should be inserted within this, the
                     string attribute of the previous group is used to
                     easily find it for replacement
                 -->
                 <label colspan="4" align="0.0" string="
                        Configure this item by defining its field
                 ">
                 <field colspan="2" name="my_field"/>
             </group>
         </data>
     </field>
</record>





然后，就能通过增加以下代码 data 元件，从而转换原始 form 的 string 属性 (这个例子,或许在 group 前):

<!-- position=attributes is new and is used to alter the
     element's attributes, instead of its content -->
<form position="attributes">
    <!-- set the value of the 'string' attribute -->
    <attribute name="string">Set item field</attribute>
</form>






Warning

Comments in view overload

At this point (December 2009) OpenERP cannot handle comments at the
toplevel of the view element overload. When testing or reusing
these examples, remember to strip out the comments or you will get
runtime errors when testing the addon.



完成这步后，配置的表单有用了一个标题:

[image: ../_images/config_wizard_title.png]
更有趣的配置比如改变按钮，按钮是由对话框底部的 res_config_view_base 提供的：
删除一个按钮（若配置无法被跳过），改变按钮标签, ...

由于这些改变无具体的与之关联的属性，需要使用xpath选择器（使用 xpath 元素).

删除Skip按钮，把Recond按钮的标签改成Set。例如，可以在
group 元素后加入以下代码，如下:

<!-- select the button 'action_skip' of the original template
     and replace it by nothing, removing it -->
<xpath expr="//button[@name='action_skip']"
    position="replace"/>





<!-- select the button 'action_next' -->
<xpath expr="//button[@name='action_next']"
       position="attributes">
    <!-- and change the attribute 'string' to 'Set' -->
    <attribute name="string">Set</attribute>
</xpath>





and yield:

[image: ../_images/config_wizard_buttons.png]
还可以用这种方法改变按钮的名称, 这样方法在对象中被唤醒 (不推荐).




定制模型

使用 execute method hook, 可以很轻易的实现许多要求，但addon-specific要求会
更复杂点. res.config 必须提供所有的hooks用于复杂的行为.


忽略下一步

最后，通过调用 res.config 中的 self.next 方法，进入下一步的配置项。 action_next 和 action_skip 最后
做的事。但是在某些情况下，循环当前的视图或实现一个和工作流一样的行为是必要的。在这样的情况下，
你可以通过 execute 返回一个字典， res.config 会跳转到那个视图，而不是 self.next 返回的那个 .

这是创建项目所必须做的，例如，让用户在一行中创建多个新用户.




在 skipping 执行一个动作

和 action_next 对比（ action_next 要求 execute 被子类实现）， action_skip 是实现 res.config 的。
但是在子模型需要完成sipping discovery的动作的情况下，它需要提供一个方法，该方法名为 cancel ，
你可以用和 execute 一样的方法重载此函数。这是和 execute 一致的：不仅在 cancel 结束时可以自动调用 next 方法，
而且能 忽略下一步




选取动作

既可以选择action重载 action_next 和
action_skip 方法，也可以实现更多的函数，如果此实例中的按钮多余两.

在这样的情况下，请记住，你需要提供一个方法，让用户能调用self.next函数，这样他才能配置他剩下的插件.








res.config 的公开接口

接口和标准的Openerp的变量一致: self, cr, uid, ids and context.


execute

Hook 方法会被 action_next 按钮（默认标签：Record）唤醒. 除非你想展示一个
新的视图而非下一步的配置项，否则不要返回任何内容 anything 。返回字典以为的东西将会导致未定义的行为.

重写它是必须的。如果不这么做，将会导致 NotImplementedError 错误.

默认的 res.config 在重载时不能被调用 (don’t use super).




cancel

action_skip 按钮 (default label: Skip) 会调用相关的方法，他和 execute‘ 是一样的，除了它不是必须被重载.




next

下一步配置项调用绑定的方法.若配置项需要定制，则它可以被重载.

如果被重载，默认的 res.config 的实现将会被调用，返回值是为了下一步的配置项.




action_next and action_skip

基础视图中的时间控制按钮，重载他们是不需要的，但是在默认的
res.config 实现被调用 (via super) 且有返回值的情况下是必须的.




	[1]	This isn’t completely true, as you will see when 定制你的配置项







	[2]	this method is part of the official API and you’re free to
overload it if needed, but you should always call
res.config‘s through super when your work is
done. Overloading next is also probably overkill in most
situations.











Guidelines on how to convert old-style wizard to new osv_memory style


OSV Memory Wizard

provide important advantages over the pre-5.0 wizard system, with support features that were difficult to implement in wizards previously, such as:


	inheritance

	workflows

	complex relation fields

	computed fields

	all kind of views (lists, graphs, ...)



The new wizards are also easier and more intuitive to write as they make use of the same syntax as other osv objects and views.

This section will highlight the main steps usually required when porting a classical wizard to the new osv_memory wizard system.
For more details about the osv_memory wizard see also section XXX.

Basically the idea is to create a regular osv object to hold the data structures and the logic of the wizard, but instead of inheriting from osv.osv, you inherit from osv.osv_memory. The methods of the old-style wizard will be moved as methods of the osv_memory object, and the various views changed into real views defined on the model of the wizard.

If the wizard is complex, you could even define a workflow on the wizard object (see section XXX for details about workflows)

Using a very simple wizard as an example, here is a step-by-step conversion to the new osv_memory system:




Steps


	Create a new object that extends osv_memory, including the required fields and methods:



[image: ../_images/wizard_window.png]
def _action_open_window(self, cr, uid, data, context):
.
.

class product_margins(wizard.interface):
    form1 = '''<?xml version="1.0"?>
    <form string="View Stock of Products">
        <separator string="Select " colspan="4"/>
        <field name="from_date"/>
        <field name="to_date"/>
        <field name="invoice_state"/>
    </form>'''

    form1_fields = {
        'from_date': {
                'string': 'From',
                'type': 'date',
                'default': lambda *a:time.strftime('%Y-01-01'),

        },
        'to_date': {
                'string': 'To',
                'type': 'date',
                'default': lambda *a:time.strftime('%Y-12-31'),

        },
        'invoice_state': {
                'string': 'Invoice State',
                'type': 'selection',
                'selection': [('paid','Paid'),('open_paid','Open and Paid'),('draft_open_paid','Draft, Open and Paid'),],
                'required': True,
                'default': lambda *a:"open_paid",
        },
    }

    states = {
      'init': {
            'actions': [],
            'result': {'type': 'form', 'arch':form1, 'fields':form1_fields, 'state': [('end', 'Cancel','gtk-cancel'),('open', 'Open Margins','gtk-ok')]}
        },
    'open': {
            'actions': [],
            'result': {'type': 'action', 'action': _action_open_window, 'state':'end'}
        }
    }
product_margins('product.margins')








New Wizard File : <<module_name>>_<<filename>>.py

class product_margin(osv.osv_memory):
    '''
    Product Margin
    '''
    _name = 'product.margin'
    _description = 'Product Margin'

    def _action_open_window(self, cr, uid, ids, context):
        .
        .
        .

    _columns = {
        #TODO : import time required to get correct date
        'from_date': fields.date('From'),
        #TODO : import time required to get correct date
        'to_date': fields.date('To'),
        'invoice_state':fields.selection([
           ('paid','Paid'),
           ('open_paid','Open and Paid'),
           ('draft_open_paid','Draft, Open and Paid'),
        ],'Invoice State', select=True, required=True),
    }
    _defaults = {
        'from_date':  lambda *a:time.strftime('%Y-01-01'),
        'to_date': lambda *a:time.strftime('%Y-01-01'),
        'invoice_state': lambda *a:"open_paid",
    }
product_margin()





转换视图到实际视图(real view)显示你的向导模块定义：




旧的向导文件 : wizard_product_margin.py

form1 = '''<?xml version="1.0"?>
<form string="View Stock of Products">
    <separator string="Select " colspan="4"/>
    <field name="date"/>
    <field name="invoice_state"/>
</form>'''








新的向导文件 : wizard/<<module_name>>_<<filename>>_view.xml

<record id="product_margin_form_view" model="ir.ui.view">
    <field name="name">product.margin.form</field>
    <field name="model">product.margin</field>
    <field name="type">form</field>
    <field name="arch" type="xml">
        <form string="Properties categories">
                <separator colspan="4" string="General Information"/>
                <field name="from_date" />
                <field name="to_date" />
                <field name="invoice_state" />
                <group col="4" colspan="2">
                            <button special="cancel" string="Cancel" type="object"/>
                            <button name="_action_open_window" string="Open Margins" type="object" default_focus=”1”/>
                </group>
        </form>
    </field>
</record>








Default_focus attribute

<button name="_action_open_window" string="Open Margins" type="object" default_focus=”1”/>





default_focus=”1” is a new attribute added in 5.2. While opening wizard default control will be on the widget having this attribute. There must be only one widget on a view having this attribute = 1 otherwise it will raise exception.

Note: 在旧向导全部状态下，我们应该用新途径建立按钮。


	To open the new wizard, you need to register an action that opens the first view on your wizard object. You will need to do the same for each view if your wizard contains several views. To make the view open in a pop-up window you can add a special target=’new’ field in the action:



<act_window name="Open Margin"
        res_model="product.margin"
        src_model="product.product"
        view_mode="form"
        target="new"
        key2="client_action_multi"
        id="product_margin_act_window"/>





key2=”client_action_multi” : While using it in the act_window, wizard will be added in the


	Action
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	Sidebar



[image: ../_images/wizard_panel.png]
If key2 is omitted then it will be displayed only in sidebar.

Note: The “src_model” attribute is only required if you want to put the
wizard in the side bar of an object, you can leave it out, for example
if you define an action to open the second view of a wizard.


	You can register this new action as a menuitem or in the context bar of any object by using a <menuitem> or <act_window> record instead of the old <wizard> tag that can be removed:






菜单选项

你可以使用下面的菜单语法打开一个向导视图(wizard view),  使用相应的act_window的XML id.

<menuitem id="main" name="OSV Memory Wizard Test"/>
<menuitem
    action="product_margin_act_window"
    id="menu_product_act"
    parent="main" />





4.打开向导视图(wizard view)经由“其他”按钮你可以使用下面的语法，应用相应的act_window里的XML id，构建按钮。这个常被应用到制作多步骤向导中。

<button name="%(product_margin.product_margin_act_window)d"
        string="Test Wizard" type="action" states="draft"/>





5.最后，你必须清理模块，如果你修改该了向导python文件名，那么必须更新__init__.py的python文件，同时对你新的XML文件加入到__openerp__.py文件的update_xml字段中。
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报表

OpenERP 主要有三种类型的报表:



	OpenOffice.org 报表

	XML 报表

	自定义报表 (基于 PostgreSQL 视图，显示在界面上)






这一部分主要描述 OpenOffice.org 报表, 和 XSL:XML 报表. 自定义报表在高级建模部分描述 -  PostgreSQL 基于数据库视图的报表.


OpenOffice.org 报表

文件流

OpenOffice.org是OpenERP中最常用的报表格式。OpenOffice.org Writer被用来生成RML模板，而RML模板用来生成pdf报表。


[image: ../_images/ooo_report_overview.png]


内部过程


[image: ../_images/process_ooo.png]


.SXW 模板文件



	我们用OpenOffice1.0的.sxw文件作为模板。模板中包含用中括号括起来的表达式或OpenOffice字段(field)，用来提供给OpenERP server填充数据。但这只是作为帮助开发者更直观地生成.RML文件的一种方法。OpenERP并不需要SXW文件产生报表。






.RML 模板



	可以使用Open SXW2RML从SXW文件生成RML文件。RML文件是一种表现PDF文档的XML格式，可以转换为PDF文件。RML是一种更容易的方法，至少XML语法比PDF语法更加通俗易懂。






报表引擎



	报表引擎(report engine)从数据库中读出数据，插入在RML文件的表达式中。






在.RML文件中，将以发票上客户的城市名称替换掉相应表达式。报表引擎以真实数据替换所有表达式之后，生成相同的.RML文件。

生成最终文档



	最后RML文件会根据OpenReport代码的需要，转换成PDF或者HTML文件。







生成 SXW 文件

你可以使用 OpenOffice 设计报表。举个例子，如： server/bin/addons/sale/report/order.sxw.


[image: ../_images/writer_report.png]





OpenOffice 报表中的动态内容

动态内容

SXW/RML报表中，你可以在中括号中加入Python代码，以获得OpenERP中的对象(object)。代码可以使用如下变量

可用的变量

可以用的 Python 对象/变量:



	objects : 将要打印的object记录(例如发票（invoice)对象）.

	data : 向导(wizard)中获得的数据

	time : Python的time模块(详见Python文档).

	user : 运行这个报表的用户.







可用的函数


可以用的 Python 函数:



	setLang(‘fr’) : 设置语言，用于自动取得对应翻译.

	repeatIn(list, varname[, tagname]) : 遍历模板当前部分list中的对象 (整个文档, 当前段落, 表格中的当前行)，可以在模板中使用varname作为变量名。 从 4.1.X版开始, 你可以使用第三个(可选的)参数指定循环结果放在哪个.RML标记中.

	setTag(‘para’,’xpre’) : 在由sxw转换rml文档过程中，替换指定标记。这里是用xpre替换para (xpre 是一个预定义格式的段落)。(?)

	removeParentNode(‘tr’) : 移除类型’tr’的父结点, 这个参数经常在条件语句中使用 (如下例)






标签示例:



	[[ repeatIn(objects,’o’) ]] : 循环objects，指定变量名为o.

	[[ repeatIn(o.invoice_line,’l’) ]] : 对o的invoice_line循环，指定变量名为’l’.

	[[ repeatIn(o.invoice_line,’l’, ‘td’) ]] : 循环每行，并为每行数据创建一个单元格

	[[ (o.prop==’draft’)and ‘YES’ or ‘NO’ ]] : 根据变量‘prop’输出YES或 NO

	[[ round(o.quantity * o.price * 0.9, 2) ]] : 可以进行变量计算.

	[[ ‘%07d’ % int(o.number) ]] : 数字的格式化输出

	[[ reduce(lambda x, obj: x+obj.qty , list , 0 ) ]] : 列表中所有对象 qty 字段值的和 (可以试一下用 “object” 作为列表变量)

	[[ user.name ]] : 打印报表的当前用户名

	[[ setLang(o.partner_id.lang) ]] : 从变量中取得语言

	[[ time.strftime(‘%d/%m/%Y’) ]] : 以dd/MM/YYYY格式输出时间, 查阅python文档获得关于“%d”的帮助, ...

	[[ time.strftime(time.ctime()[0:10]) ]] 或 [[ time.strftime(time.ctime()[-4:]) ]] : 只输出日期.

	[[ time.ctime() ]] : 输出当前日期 & 时间

	[[ time.ctime().split()[3] ]] : 只输出时间

	[[ o.type in [‘in_invoice’, ‘out_invoice’] and ‘Invoice’ or removeParentNode(‘tr’) ]] : 如果type是 ‘in_invoice’ 或‘out_invoice’ 那么输出 ‘Invoice’；如果 不是，‘tr’类型的父节点会被删除.






一个有趣的标记(tag)：如果想输出当前记录的创建者(create_uid)或者最后一位修改者你需要在报表要输出的类中加入如下字段:

'create_uid': fields.many2one('res.users', 'User', readonly=1)





然后在报表中用这个变量输出相应的名字:

o.create_uid.name





有时你希望根据条件打印。 你可以用python的逻辑操作符＂not＂,＂and＂,＂or＂构造自己的判断语句。
Python中的每个对象都有自己的逻辑值(TRUE或FALSE):

(o.prop=='draft') and 'YES' or 'NO' #prints YES or NO





注意and要比or的优先级高，表达式等价为:

((o.prop=='draft') and 'YES') or 'NO'






	如果 o.prop是 ‘draft’, 那么计算结果为:

	
	o.prop == ‘draft’ 为 True.

	True and ‘YES’ 为 ‘YES’. 左项为 真时, 返回右项, 否则返回左项.这里返回字符串’YES’.

	‘YES’ or ‘NO’ is ‘YES’. 左项为真， or操作会忽略右项。只计算左项值.返回字符串’YES’.








	如果 o.prop 是‘confirm’之类其他的操作, 那么计算如下:

	
	o.prop == ‘draft’ 为 False.

	False and ‘YES’ is False. 因为左项为 “false” 值, and 操作截断并忽略右项. 只计算左项.

	False or ‘NO’ is ‘NO’. 因为左项为 “false” 值, or 计算右项.







可以使用更复杂的的结构。可以参照python 手册章节 `Python’s boolean operators`_ 。

可以用python的“filter”函数。示例:

repeatIn(filter( lambda l: l.product_id.type=='service' ,o.invoice_line), 'line')





只输出每段中product 含有 type=’service’的行.

报表中显示二进制字段图像

[[ setTag('para','image',{'width':'100.0','height':'80.0'}) ]] o.image or setTag('image','para')








SXW2RML


Open Report 手册


关于

The OpenERP 的报表引擎.

Open Report 是一个模块，可让您从OpenOffice的模板文件（sxw）和任何关系数据库中渲染出高质量报表。
它可以用来作为OpenERP模块或作为独立的程序.




SXW 转 RML 代码的安装，适用于Windows用户

为了使用python代码‘tiny_sxw2rml.py’，你需要安装如下包:



	Python (http://www.python.org)

	ReportLab (http://www.reportlab.org)/(Installation)

	Libxml for Python (http://users.skynet.be/sbi/libxml-python)









SXW 转 RML 代码的安装，适用于linux用户

tiny_sxw2rml.py 可以在OpenERP 模块 base_report_designer 中找到:

server/bin/addons/base_report_designer/wizard/tiny_sxw2rml/tiny_sxw2rml.py





确认 normalized_oo2rml.xsl 和 tiny_sxw2rml 在一起，否则你会遇到如下错误:



	failed to load external entity normalized_oo2rml.xsl









使用 tiny_sxw2rml

当你做好必要的准备，打算编辑您自己的报表模板(template)时，使用如下命令:

tiny_sxw2rml.py template.sxw > template.rml





注释: tiny_sxw2rml.py 帮助 建议你使用”-o OUTPUT”指定输出文件，但貌似0.9.3版本不支持








OpenERP Server PDF 输出


Server PDF 输出


关于

要根据rml文件生成pdf，OpenERP需要一个rml解释器.




解释器

语法解释器可以在模块中添加。例如如下代码:

import time
from report import report_sxw

class order(report_sxw.rml_parse):
    def __init__(self, cr, uid, name, context):
        super(order, self).__init__(cr, uid, name, context)
        self.localcontext.update({
            'time': time,
        })

report_sxw.report_sxw('report.sale.order', 'sale.order',
      'addons/sale/report/order.rml', parser=order, header=True)





解释器继承自 report_sxw.rml_parse 对象 并且增加了localcontext变量和函数 time， 因此在报表中可以调用.


report_sxw.report_sxw 实例生成之后，需要如下参数:




	报表的名字



	report关联的object名字



	rml文件的路径



	默认的rml解释器(默认为rml_parse)



	
	在公司配置报表头部(默认为true)

	
	'external' (默认)

	'internal'

	'internal landscape'

	False - 使用报表自己定义的报表头

















xml 定义

如果要在 client端可见, 报表应该声明在一个 xml 文件中 (一般格式为: “module_name”_report.xml) ，这个文件应该列进 __openerp__.py 文件

下面是销售订单报表的例子:

<?xml version="1.0"?>
<openerp>
        <data>
                <report
                        id="report_sale_order"
                        string="Print Order"
                        model="sale.order"
                        name="sale.order"
                        rml="sale/report/order.rml"
                        auto="False"/>
                        header="False"/>
        </data>
</openerp>





参数如下:



	id: OpenERP中的报表id，类似openerp中的其他xml标记

	string: 客户端按钮显示的文字

	model: 报表中用到的object

	name: parse中注册的报表名字去掉”report.” 之后的部分

	rml: rml 文件路径

	auto: 指定server是否生成默认的解释器

	header: 是否允许页眉(report header)。 如果需要编辑, 进入如下菜单: Administration -> Users -> Company’s structure -> Companies. 选择并编辑您的公司: 其中 “Header/Footer” 标签 允许你编辑相应的 header/footer.















XSL:RML 报表

XML 报表不需要编程，但是需要两种简单的 XML 文件:



	一种文件描述输出的数据 (*.xml)

	一种文件描述输出的格式 (*.xsl)







[image: ../_images/automatic-reports.png]


XML模板主要描述记录的哪些字段需要输出.
XSL:RML 样式表单(style sheet)处理输出数据，以及报表中的静态文本.
静态文本是指在报表中不怎么变化的部分，比如表格头部的标题.

示例

下面给出一个例子，列出用于生成ERP报表的不同文件.


[image: ../_images/ids-report.png]


XML 模板

<?xml version="1.0"?>

    <ids>
    <id type="fields" name="id">

        <name type="field" name="name"/>
        <ref type="field" name="ref"/>

    </id>
    </ids>





XML 数据文件 (生成的)

<?xml version="1.0"?>

    <ids>
    <id>

        <name>Tiny sprl</name>
        <ref>pnk00</ref>

    </id><id>

        <name>ASUS</name>
        <ref></ref>

    </id><id>

        <name>Agrolait</name>
        <ref></ref>

    </id><id>

        <name>Banque Plein-Aux-As</name>
        <ref></ref>

    </id><id>

        <name>China Export</name>
        <ref></ref>

    </id><id>

        <name>Ditrib PC</name>
        <ref></ref>

    </id><id>

        <name>Ecole de Commerce de Liege</name>
        <ref></ref>

    </id><id>

        <name>Elec Import</name>
        <ref></ref>

    </id><id>

        <name>Maxtor</name>
        <ref></ref>

    </id><id>

        <name>Mediapole SPRL</name>
        <ref></ref>

    </id><id>

        <name>Opensides sprl</name>
        <ref>os</ref>

    </id><id>

        <name>Tecsas sarl</name>
        <ref></ref>

    </id>
    </ids>





XSL 样式表

<?xml version="1.0" encoding="utf-8"?> <xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform" xmlns:fo="http://www.w3.org/1999/XSL/Format">

    <xsl:template match="/">

        <xsl:apply-templates select="ids"/>

    </xsl:template>

    <xsl:template match="ids">

        <document>

            <template pageSize="21cm,29.7cm">

                <pageTemplate>

                    <frame id="col1" x1="2cm" y1="2.4cm" width="8cm" height="26cm"/>
                    <frame id="col2" x1="11cm" y1="2.4cm" width="8cm" height="26cm"/>

                </pageTemplate>

            </template>

        <stylesheet>

            <blockTableStyle id="ids">

                <blockFont name="Helvetica-BoldOblique" size="12" start="0,0" stop="-1,0"/>
                <lineStyle kind="BOX" colorName="black" start="0,0" stop="-1,0"/>

                <lineStyle kind="BOX" colorName="black" start="0,0" stop="-1,-1"/>

            </blockTableStyle>

        </stylesheet>

        <story>

            <blockTable colWidths="2cm, 6cm" repeatRows="1" style="ids">

                <tr>

                    <td t="1">Ref.</td>
                    <td t="1">Name</td>

                </tr>
                <xsl:apply-templates select="id"/>

            </blockTable>

        </story>
        </document>

    </xsl:template>

    <xsl:template match="id">

        <tr>

            <td><xsl:value-of select="ref"/></td>
            <td><para><xsl:value-of select="name"/></para></td>

        </tr>

    </xsl:template>
    </xsl:stylesheet>





生成的RML文件

<?xml version="1.0"?>

    <document>
    ...

        <story>

            <blockTable colWidths="2cm, 6cm" repeatRows="1" style="ids">

                <tr>

                    <td t="1">Ref.</td>
                    <td t="1">Name</td>

                </tr>
                <tr>

                    <td>pnk00</td>
                    <td><para>Tiny sprl</para></td>

                </tr>
                <tr>

                    <td></td>
                    <td><para>ASUS</para></td>

                </tr>
                <tr>

                    <td></td>
                    <td><para>Agrolait</para></td>

                </tr>
                <tr>

                    <td></td>
                    <td><para>Banque Plein-Aux-As</para></td>

                </tr>
                <tr>

                    <td></td>
                    <td><para>China Export</para></td>

                </tr>
                <tr>

                    <td></td>
                    <td><para>Ditrib PC</para></td>

                </tr>
                <tr>

                    <td></td>
                    <td><para>Ecole de Commerce de Liege</para></td>

                </tr>
                <tr>

                    <td></td>
                    <td><para>Elec Import</para></td>

                </tr>
                <tr>

                    <td></td>
                    <td><para>Maxtor</para></td>

                </tr>
                <tr>

                    <td></td>
                    <td><para>Mediapole SPRL</para></td>

                </tr>
                <tr>

                    <td>os</td>
                    <td><para>Opensides sprl</para></td>

                </tr>
                <tr>
                <td></td>

                    <td><para>Tecsas sarl</para></td>

                </tr>

            </blockTable>

        </story>

    </document>





详见以下文档:



	RML user guide [http://www.reportlab.com/docs/rml2pdf-userguide.pdf]

	XSL specification [http://www.w3.org/TR/xslt]

	XSL tutorial [http://www.zvon.org/xxl/XSLTutorial/Books/Output/contents.html]






这些格式都是作为 XML specification [http://www.w3.org/XML/].  的拓展。


XML 模板

XML 模板是简单的XML文件，用来描述object字段中哪些要在报表上显示.


文件格式

标签(tag)名称可以任意(但必须是有效XML标签)。在XSL文件中，你要用这些名称来定义。大多数情况下，标签名和对象字段保持一致.

没有**type** 属性的节点会直接复制到目标XML文件(数据文件)。有**type**属性的结点及其内容被server解析并由object中的实际数据替换。除了type属性，节点还可以有其他属性。这些属性基于type属性，type不同的节点属性也不同。大部分结点类型都有 name 属性，指向相应object的字段名称 .

类似object中的 “browse” 方法，报表中的字段名称可以使用一种类似面向对象语言中的符号来表示。这意味可以用关系字段来作为桥梁来获取相关对象的数据。

以 “account.transfer” 对象为例。Account.transfer对象包含一个partner_id字段，这个字段是一 个指向”res.partner” 对象的多对一关系字段。我们假设要创建一个转账的报表,，而报表中需要用到业务伙伴的名称。我们可以这样写:


partner_id.name





其它类型

这里是可用的字段类型的列表:



	field: 最简单的类型。针对这种类型的结点，服务器会用同名字段值来替换节点内容。

	fields: 这种结点类型，服务器会在XML数据文件中生成一个和name属性相同的唯一结点.







注释:





** 这种结点通常使用 “id” 作为名称。其行为是为用户在界面上选择的每个记录创建一个节点。
** 结点语法 <node type=”fields” name=”field_name”> 类似SQL语句 “SELECT FROM object_table WHERE id in identifier_list GROUP BY field_name” 相似，其中identifier_list 是::user 在界面上选择的对象记录。



	eval: 这个结点(node)类型计算 expr 属性中表达式(expression)的值。表达式(expression)可以是python表达式，也可以是object的字段名字.

	zoom: 这个结点(node)类型允许通过name属性指定的关系字段进入另一个对象。也就是说子节点的name属性不需要用关系字段名作为前缀了。如上例，我们可以通过以下方式获得parter的name字段:






<partner type="zoom" name="partner_id">

        <name type="field" name="name"/>

</partner>

在这个例子中, 不用zoom注解，标准格式也同样可以有效果:

<name type="field" name="partner_id.name"/>









zoom 类型往往用于显示同一个object的多个字段.




	function: 返回name属性中所调用函数的结果。这个函数必须是提前定义的。暂时可用的函数是today，用来返回当前日期.

	call: 调用name属性指定的对象方法，args属性是参数名称。函数的结果放进一个字典(dictionary)，形如：{‘name_of_variable’: value, ... } 这个结果可以被子结点使用。这些子结点必须有相应的value属性，以和调用方法所返回字典的一个键值(key)匹配.






示例:

<cost type="call" name="compute_seller_costs" args="">

    <name value="name"/>
    <amount value="amount"/>

</cost>





TODO: 要调用的方法 def compute_buyer_costs(self, cr, uid, ids, *args):



	attachment: 提取属性name中对应id的记录的第一个附件，可以在报表中显示图片。







	示例:

	<image type=”attachment” name=”id”/>



示例

XML 文件的例子:

<?xml version="1.0" encoding="ISO-8859-1"?>
<transfer-list>

    <transfer type="fields" name="id">

        <name type="field" name="name"/>
        <partner_id type="field" name="partner_id.name"/>
        <date type="field" name="date"/>
        <type type="field" name="type"/>
        <reference type="field" name="reference"/>
        <amount type="field" name="amount"/>
        <change type="field" name="change"/>

    </transfer>

</transfer-list>










RML 介绍

有关RML格式的更多信息, 请参照官方文档.



	http://www.reportlab.com/docs/rml2pdf-userguide.pdf









XSL:RML 样式表

为报表定义XSL样式表有两个选项. 或者完全自定义, 或者使用模版

可以是自由格式，也可以用公司表头 + RML模版


导入 rml_template.xsl



必须的模板:




	frames?

	stylesheet

	story







可选的模板:



Translations

OpenERP可以使用多种语言，因此报表必须可以翻译成多种语言。但是一个报表中，并不是所有项目都被翻译，比如动态的文本需要翻译转换，而格式代码(format code)则不需要。一个字段如果包含在有t=”1”这个属性的XML标签内，翻译系统就会处理它。服务器会在报表生成过程中处理所有这样的字段.




一些有用的链接



	url=http://www.reportlab.com/docs/rml2pdf-userguide.pdf RML 用户指南 (pdf) (reportlab.com)

	http://www.zvon.org/xxl/XSLTutorial/Output/index.html XSL 教程 (zvon.org)

	http://www.zvon.org/xxl/XSLTreference/Output/index.html XSL 参考 (zvon.org)

	http://www.w3schools.com/xsl/ XSL 教程和参考 (W3Schools)

	http://www.w3.org/TR/xslt/ XSL 规范 (W3C)









示例 (使用公司表头)

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform" :xmlns:fo="http://www.w3.org/1999/XSL/Format">

    <xsl:import href="../../custom/corporate_defaults.xsl"/>
    <xsl:import href="../../base/report/rml_template.xsl"/>
    <xsl:variable name="page_format">a4_normal</xsl:variable>
    <xsl:template match="/">

        <xsl:call-template name="rml"/>

    </xsl:template>
    <xsl:template name="stylesheet">

        </xsl:template>

    <xsl:template name="story">

        <xsl:apply-templates select="transfer-list"/>

    </xsl:template>
    <xsl:template match="transfer-list">

        <xsl:apply-templates select="transfer"/>

    </xsl:template>
    <xsl:template match="transfer">

        <setNextTemplate name="other_pages"/>
        <para>

            Document: <xsl:value-of select="name"/>

        </para><para>

            Type: <xsl:value-of select="type"/>

        </para><para>

            Reference: <xsl:value-of select="reference"/>

        </para><para>

            Partner ID: <xsl:value-of select="partner_id"/>

        </para><para>

            Date: <xsl:value-of select="date"/>

        </para><para>

            Amount: <xsl:value-of select="amount"/>

        </para>
        <xsl:if test="number(change)>0">

            <para>

                Change: <xsl:value-of select="change"/>

            </para>

        </xsl:if>
        <setNextTemplate name="first_page"/>
        <pageBreak/>

    </xsl:template>

</xsl:stylesheet>












没有公司表头的示例

示例 (使用公司表头):

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform" :xmlns:fo="http://www.w3.org/1999/XSL/Format">
     <xsl:import href="../../base/report/rml_template.xsl"/>
     <xsl:variable name="page_format">a4_normal</xsl:variable>

     <xsl:template match="/">
          <xsl:call-template name="rml"/>
     </xsl:template>

     <xsl:template name="stylesheet">
      </xsl:template>

      <xsl:template name="story">
           <xsl:apply-templates select="transfer-list"/>
      </xsl:template>

      <xsl:template match="transfer-list">
           <xsl:apply-templates select="transfer"/>
      </xsl:template>

      <xsl:template match="transfer">
           <setNextTemplate name="other_pages"/>

           <para>
                 Document: <xsl:value-of select="name"/>
           </para><para>
                 Type: <xsl:value-of select="type"/>
           </para><para>
                 Reference: <xsl:value-of select="reference"/>
           </para><para>
                 Partner ID: <xsl:value-of select="partner_id"/>
           </para><para>
                 Date: <xsl:value-of select="date"/>
           </para><para>
                 Amount: <xsl:value-of select="amount"/>
           </para>

           <xsl:if test="number(change)>0">
                <para>
                      Change: <xsl:value-of select="change"/>
                </para>
           </xsl:if>

           <setNextTemplate name="first_page"/>
          <pageBreak/>
     </xsl:template>
</xsl:stylesheet>








每个报表都有自己的公司表头

示例 (使用默认的公司表头):

<xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform" :xmlns:fo="http://www.w3.org/1999/XSL/Format">

    <xsl:import href="../../custom/corporate_defaults.xsl"/>
    <xsl:import href="../../base/report/rml_template.xsl"/>
    <xsl:variable name="page_format">a4_normal</xsl:variable>
    .....................
    </xsl:template>

</xsl:stylesheet>








条形码


RML 文件中的条形码

可以在RML 文件中使用<barCode>标签生成条形码。 支持以下格式:



	codabar

	code11

	code128 (如果没有指定 ‘code’ ,则默认code128码)

	standard39

	standard93

	i2of5

	extended39

	extended93

	msi

	fim

	postnet

	ean13

	ean8

	usps_4state






你可以更改以下属性来生成自己的条形码(barcode):



	‘code’: ‘char’

	‘ratio’:’float’

	‘xdim’:’unit’

	‘height’:’unit’

	‘checksum’:’bool’

	‘quiet’:’bool’






示例:


<barcode code=”code128” xdim=”28cm” ratio=”2.2”>`SN12345678</barcode>







如何生成一个新的报表


Administration -> Custom -> Low Level -> Base->Actions -> ir.actions.report.xml





常用标签


包含在 [[ ]] 标签中的代码是 python 代码

代码中的内容(你可以使用的变量值)和链接 OpenOffice 报表中的动态内容 描述中的相同.






Unicode 报表

OpenERP 5.0-rc3 中还是不能使用Unicode 报表的。症结在于OpenERP使用的PDF标准字体(14号字体，不嵌入文档，而是由pdf reader提供)Type1只含有Latin1字符.


解决办法有三步



	提供 TrueType 字体，让ReportLab可以使用他们.

	在报表中使用Unicode之前，在ReportLab中注册TrueType 字体.

	在xsl和rml模板中替换旧字体名称为TrueType.









论坛中有更详细的信息

免费的字体 TrueType fonts

来自DejaVu 一族，可用于解决此问题. 可访问 http://dejavu-fonts.org/wiki/index.php?title=Main_Page 安装



	在 ReportLab 字体目录,

	系统路径和 rl_config.py 中包含这个目录,

	在 OpenERP 安装子目录提供一个路径给ReportLab作为注册字体用.






在文件 server/bin/report/render/rml2pdf/__init__.py 中

import reportlab.rl_config
reportlab.rl_config.warnOnMissingFontGlyphs = 0

from reportlab.pdfbase import pdfmetrics
from reportlab.pdfbase.ttfonts import TTFont
import reportlab

enc = 'UTF-8'

#需要的字体做如下类似的重复
pdfmetrics.registerFont(TTFont('DejaVuSans', 'DejaVuSans.ttf',enc))
pdfmetrics.registerFont(TTFont('DejaVuSans-Bold', 'DejaVuSans-Bold.ttf',enc))

from reportlab.lib.fonts import addMapping

#需要的字体做如下类似的重复
addMapping('DejaVuSans', 0, 0, 'DejaVuSans') #normal
addMapping('DejaVuSans-Bold', 1, 0, 'DejaVuSans') #normal





如果是命令行引用 trml2pdf.py ，则需要做如上修改.

所有需要修改的 xsl 和 rml 文件

需要修改调整的清单:

'Times-Roman',       'DejaVuSerif.ttf'
'Times-BoldItalic',  'DejaVuSerif-BoldItalic.ttf'
'Times-Bold',        'DejaVuSerif-Bold.ttf'
'Times-Italic',      'DejaVuSerif-Italic.ttf'

'Helvetica',     'DejaVuSans.ttf'
'Helvetica-BoldItalic',  'DejaVuSans-BoldOblique.ttf'
'Helvetica-Bold',    'DejaVuSans-Bold.ttf'
'Helvetica-Italic',  'DejaVuSans-Oblique.ttf'

'Courier',           'DejaVuSansMono.ttf'
'Courier-Bold',      'DejaVuSansMono-Bold.ttf'
'Courier-BoldItalic','DejaVuSansMono-BoldOblique.ttf'
'Courier-Italic',    'DejaVuSansMono-Oblique.ttf'

'Helvetica-ExtraLight',  'DejaVuSans-ExtraLight.ttf'

'TimesCondensed-Roman',      'DejaVuSerifCondensed.ttf'
'TimesCondensed-BoldItalic', 'DejaVuSerifCondensed-BoldItalic.ttf'
'TimesCondensed-Bold',       'DejaVuSerifCondensed-Bold.ttf'
'TimesCondensed-Italic',     'DejaVuSerifCondensed-Italic.ttf'

'HelveticaCondensed',        'DejaVuSansCondensed.ttf'
'HelveticaCondensed-BoldItalic', 'DejaVuSansCondensed-BoldOblique.ttf'
'HelveticaCondensed-Bold',   'DejaVuSansCondensed-Bold.ttf'
'HelveticaCondensed-Italic', 'DejaVuSansCondensed-Oblique.ttf










使用Mako模板的HTML报表


Note

只在trunk实现的

Mako的是用Python编写一个模板库。它提供了一个熟悉的，非XML的语法，编译成Python模块以获得最佳性能.




Mako 模板


语法


Mako模板可以解析 XML, HTML, email text, 等文字流(parsed from a text stream) .

Mako模板含有Mako特有的指令(Mako-specific directives), 包括变量、表达式替换(expression substitution)，控制结构(比如条件和循环,conditionals and loops)，服务器端命令，完整的Python代码块，这些就像不同功能的标签(tag)一样易用。所有这些指令都解析为Python代码.

这意味着在Mako模板中，你可以最大化发挥Python的优势.







表达式替换


最简单的表达式是变量替换。 Mako模板中使用 ${} 结构，而不是rml中的 [[ ]] .


eg:

这是x: ${x}

    上面表达式中“这是x”字符串直接输出，而${}里的x值来自报表解析器的localcontext中.

    标签 ${} 中的代码直接被Python解析.









	控制结构:	






在Mako中，控制结构 (i.e. if/else, 循环 (像 while 和 for), 包括 try/except) 都使用 % 标记，之后接上普通的Python控制表达式即可。在控制结构结束时，使用 “end<name>” 标记，”<name>” 是控制结构的关键字:


eg:

% if x==5:
  this is some output
% endif










Python 块


在 <% %> 标记中, 你可以加入普通的Python代码块。虽然之中的代码可以加入任意的空格，但是还是注意下格式比较好。Mako的编译器会根据周围生成的 Python代码结构，调整Python代码块中的格式.



	有用的链接:

	http://www.makotemplates.org/docs/




销售订单中的例子


销售完整的例子请从下面的地址参照 sale_report_html 模块 :



https://code.launchpad.net/~openerp-community/openobject-addons/trunk-addons-community


## -*- coding: utf-8 -*-
<html>
<head>
        <%include file="mako_header.html"/>
</head>
% for o in objects:
<body>
    <table width="100" border="0" cellspacing="0" cellpadding="0">
            <tr>
                    <td>
                                <p><small><b>Shipping address :</b></small>
                        </td>
                </tr>
                <tr>
                        <td>
                                <small>${ o.partner_id.title or '' } ${ o.partner_id.name }</small>
                        </td>
                </tr>
                <tr>
                    <td>
                                <small>${ o.partner_shipping_id.state_id and o.partner_shipping_id.state_id.name or '' } ${ o.partner_shipping_id.country_id and o.partner_shipping_id.country_id.name or '' }</small>
                        </td>
                </tr>
        </table>
        <table>
                   <tr align="left">
                          <th>Description</th>
                          <th>VAT</th>
                          <th>Quantity</th>
                          <th>Unit Price</th>
                          <th>Disc.(%)</th>
                          <th>Price</th>
                        </tr>
                % for line in o.order_line:
                          <tr>
                          <td>${line.name}</p>
                          <td>${', '.join(map(lambda x: x.name, line.tax_id))}</td>
                          <td>${line.product_uos and line.product_uos_qty or line.product_uom_qty}
                          ${line.product_uos and line.product_uos.name or line.product_uom.name}</td>
                          <td>${line.price_unit}</td>
                          <td>${line.discount or 0.00 }</td>
                          <td>${line.price_subtotal or 0.00 }</td>
                          </tr>
                  % if line['notes']:
                            <tr>
                            <td>${line.notes}</td>
                            </tr>

                  % endif
                  % endfor
        </table>
</body>
% endfor
<%include file="mako_footer.html"/>
</html>





可以根据需要用 HTML格式化报表.




有报表头和报表尾(header and footer)的报表


如果希望在报表中加入公司专有的页眉，需要包含 <%include file=”mako_header.html”/>
加入页脚需要包含 <%include file=”mako_footer.html”/>
这些文件会从数据库中读出你预先为公司定义好的页眉页脚.
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服务器动作


简介

服务器动作(Server Action)是OpenErp 5.0以来推出的一项新的功能。这个功能对于满足客户需求非常有用。
它可以为客户常见的一些业务要求提供简单而又快速的配置界面。
比如确认销售订单或发票时发送电子邮件、记录发票的开具和作废、或者在确认订单和发票的时候运行向导。




第一步：服务器动作的定义

下面列举了服务器动作的动作类型:



	客户端动作 Client Action

	无动作 Dummy

	迭代器 Iteration

	Python 代码

	触发器 Trigger

	邮件 Email

	短信 SMS

	创建对象 Create Object

	修改对象 Write Object

	多个动作 Multi Action






每种类型的动作具有不同的功能和不同的配置参数。我们接下来将看到每种类型的动作，
如何配置，以及影响系统的参数。


客户端动作（Client Action）

这一动作在客户端执行，可以用来执行一个向导或报表。例如，一个客户端动作可以先打印一张发票随后运行付款向导。
从技术上来讲我们能够运行所有客户端执行的动作。包括ir.actions.report.custom,
ir.actions.report.xml, ir.actions.act_window, ir.actions.wizard, 和
ir.actions.url. 下面这个例子向我们配置一个客户端动作来确认发票后立即打印.

[image: ../_images/client_action.png]
要关注的字段:





	Object:	动作相关工作流对应的对象


	Client Action:	选择要执行的动作，这些动作必须是如下种类中的一个:






	ir.actions.report.custom

	ir.actions.report.xml

	ir.actions.act_window

	ir.actions.wizard

	ir.actions.url






循环

输入一个python变量作为循环表达式，然后选择要在这个表达式的结果集上遍历执行的服务端动作。
例如，确认一张入库单以后，每个移库行都要记录一下状态的变更。可以把 object.move_lines
作为表达式，然后创建另一个服务器动作来实现记录状态变更的功能。




Python 代码

这个动作类型是执行一个多行的Python代码. 返回的值是 action``变量的值, 缺省值是
``{}. 仅在你需要弹出特定内容的特定窗体的时候需要返回值，一般来说返回空即可.

记住: 这些代码用Python的 exec 函数来执行. 这个函数有一些内置的变量可用，
如: object, time, cr, uid, ids.




触发器Trigger

任何工作流的迁移都可以用这个来触发。你需要设定的参数是:





	Object:	动作相关工作流对应的对象.


	Workflow on:	要触发的工作流对应的对象.


	Trigger on:	源对象中指向目标对象的字段名.


	Trigger Name:	是用来触发迁移的信号signal。下拉列表框列出了数据库中所有信号.
注意：这里可选的是所有信号，但实际上你应该选择目标对象对应的才有意义。下拉选项括号内给出的是对象名.





下图演示了如何配置实现自动触发确认发票的动作:

[image: ../_images/trigger_action.png]



邮件动作 Email Action

发邮件是所有业务处理的通用需求，比如通过邮件确认销售订单、采购订单、发票、付款、发货等.

不需要自己搭建邮件服务器，你可以使用现有的免费邮件服务账号，比如Gmail、Yahoo等等。

邮件服务配置

启用OpenErp服务时，我们提供下列参数:

--email-from=<sender_email@address>
--smtp=<smtp server name or IP address>
--smtp-port=<smtp server port>
--smtp-user=<smtp user name, if required>
--smtp-password=<smtp user password, if required>
--smtp-ssl=<true if the server requires SSL for sending email, else false>





下面以为发票确认后自动发送一封邮件为例, 来配置一个服务器动作:

[image: ../_images/email_action.png]
关注以下字段:





	Object:	动作相关的工作流相关的对象


	Contact:	告诉系统我们要使用的收件人地址从对象的哪个字段来


	Message:	这个邮件模版里可以使用对象的字段作为占位符，在发送邮件时它会被字段值替换。用的格式与我们用来设计rml报表一样，
用[[ object.partner_id.name ]]来表示变量，还可以使用HTML标记来格式化。object就是我们上面指定的对象，可以使用其中的任意字段。





完成上面的服务器动作配置后, 随便你啥时候确认发票的时候,都会自动发送类似下面的Email:

[image: ../_images/email_confirm.png]



创建对象

This type of action can be used to emulate the Event history feature currently
available on Partners, which logs sales orders issued by a partner, on
other objects which do not natively support this feature, such as
invoices:

[image: ../_images/create_object.png]
Create Object action configuration can be tricky, since it is
currently necessary to remember the field names (or to check them out
from the source code itself). There are plans to provide an
expression builder inside OpenERP in the future, which will be useful
to build complex expressions.

重点字段:





	Object:	the object affected by the workflow on for which we want to
run the action


	Model:	the target model for the object to be created. If empty, it
refers to the current object and allows to select the fields
from it. It is recommended to provide a model in all cases.


	Fields Mapping:	Need to provide 3 values:






	Destination: any of the fields from the target model

	Type: the type of the mapping. Allowed values are value or formula

	Value: provide the value or expression the expression. The
object refers to the current object.



你必须选择该 对象 的所有必填字段





	Record Id:	the field in which the  id of the new record is
stored. This is used to refer to the same object in future
operations (see below)








编辑对象

The configuration is very similar to the Create Object actions. The
following example writes ‘Additional Information’ on the same object

[image: ../_images/write_object.png]
重点字段:


same as the Create Object





多重组合动作

这个动作允许在同一个商务活动中执行多个服务端动作. 例如, 可以打印 并 发送一封邮件确认发票. 这需要创建三个服务端动作:



	打印发票

	发票确认邮件

	多重动作






这个动作有一点限制的地方: 可以在服务端执行多个动作, 但是只有一个客户端动作. 这也是为什么不能在执行打印报表的同时无法打开
珍上向导的原因.

[image: ../_images/multi_action.png]
重点字段:





	Object:	这个对象受到我们想要执行动作的影响


	Other Actions:	服务动作清单.任意数量的动作都可以被选择,但是小心上面提到的限制:
如果你选择的客户端动作数量超过一个，那么只有第一个动作会被执行.










第二步：给工作流定义服务端动作

服务端的动作除非在工作流中触发，否则是无用的

工作流可以在: 设置(Administration) ‣ 自定义(Customization) ‣ 工作流(Workflow Definitions) ‣ 工作流(Workflows) 中访问. 打开相应的
工作流,编辑要被触发的服务端动作. 选择要执行的动作.

The following example shows how to associate the Print invoice action
to the Open state of the Invoice workflow:

[image: ../_images/link_workflow.png]






          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	开发手册 
 
      

    


    
      
          
            
  
工作流程-商业处理流程


简介

工作流程系统在OpenERP里是非常有用的机制，可以用于及时描述文件(模型)的演进过程。

工作流程是完全可以定制的，这些流程可以调整适用于几乎所有公司的作业流程和交易逻辑。 这个工作流程系统使OpenERP非常有弹性，
而且可以不用编程增加新功能,就可以支持不断变化的需要。

目标



	及时描述文件的演进

	符合某些条件时自动触发动作

	管理公司里人员的角色和验证步骤

	管理不同物件/模块间的互动

	为文件流程可视化提供图形化的工具






以下三个例子说明了工作流程系统的用途:


例子1 : 订单折扣

第一个流程图代表了一种非常基本的订单流程:

[image: ../_images/Workflow_bc1.png]
订单一开始在输入但是还没有被核准前，是在’草稿’状态。当使用者按下’确认’，系统会生成请款单，而且订单会变成’已确认’状态。

然后, 可能有2个动作:


	订单完成(已出货)

	订单被取消



假设公司有一个需求还没有在 OpenERP 里实现，例如，销售人员只能同意到最多 15% 的折扣，所有折扣大于 15% 的订单必须由销售经理核准。

这种业务流程的修改需求不需要更改任何 Python 编码! 只需要一个简单的工作流程修改就可以让我们把这个新的需求列入考虑，并且多增加一个验证步骤。

[image: ../_images/Workflow_bc2.png]
工作流程依上面的图里修改以后，订单就会依所要求的方式反应。然后我们只需要修改订单的表单显示方式，在想要的位置加上验证的按键。

然后我们可以再深入强化这个工作流程-当订单进入 ‘待验证’ 状态，主动通知销售经理审核订单。工作流程的节点可以执行物件的程序；只要增加2行 Python 编码，就可以通知销售经理审核或是取消订单。




例子2: 业务订单产生请款单及出货通知

[image: ../_images/Workflow_sale.png]



例子3: 客户请款单基本工作流程

[image: ../_images/Acount_inv_wkf.jpg]





定义工作流程

工作流程是在以下档案里定义的 server/addons/base/ir/workflow/workflow.py。 在这个档案里定义的前3个级别(class)是 workflow，wkf_activity 和 wkf_transition。他们分别对应了工作流程里3种需要的资源:



	workflow [http://openobject.com/wiki/index.php/WkfDefXML] : 工作流程，

	wkf_activity [http://openobject.com/wiki/index.php/WorkflowActivity] : 工作流程的活动(节点)，

	wkf_transition [http://openobject.com/wiki/index.php/WorkflowTransition] : 在不同活动间的转变。









工作流程 XML 档案的一般结构

工作流程 XML 档案的一般结构如下:

<?xml version="1.0"?>
<openerp>
<data>
<record model="workflow" id=workflow_id>

    <field name="name">workflow.name</field>
    <field name="osv">resource.model</field>
    <field name="on_create" eval='True|False' />

</record>

</data>
</openerp>





这里的



	id (就是 “workflow_id”) 是工作流程的识别码。每个工作流程必须有一个唯一的识别码。

	name (就是 “workflow.name”) 是工作流程的名称。工作流程的名称必须符合 OpenERP 文法的 “带点名称” 要求。

	osv (就是 “resource.model”) 是我们当做模型使用的物件名称 [-(请记得 OpenERP 物件是从 osv.osv 继承属性，所以 ‘<字段名称=”osv”>’)-]。

	on_create 如果为 True，在创建 resource.model 时会自动将 workflow.name 实体化，如果是 False 则相反。






范例

定义在 addons/sale/sale_workflow.xml 里的工作流程 sale.order.basic 完全依照这个模式，工作流程标签的编码如下:

<record model="workflow" id="wkf_sale">

    <field name="name">sale.order.basic</field>
    <field name="osv">sale.order</field>
    <field name="on_create" eval='True' />

</record>








Activity(活动)


简介

wkf_activity 这个级别(class)代表工作流程的节点。这些节点就是要被执行的行动。




字段

split_mode(拆分模式)





[image: ../_images/Wkf_split.png]
可能的值:


	XOR: 一个必须的转变, 取找到的第一个转变(预设值)。

	OR: 只依顺序取有效的转变(可能是0个或是多个)。

	AND: 所有有效的转变都会同时出现(分叉)。



在 OR 和 AND 分离模式，可能会产生一些工作时间。

在 AND 模式，活动会等到所有转变都生效才会开始进行；即使是有小部分转变还没有生效，活动也不会开始进行。所有活动是同时被触发的。

join_mode(结合模式)





[image: ../_images/Wkf_join.png]
可能的值:


	XOR: 进行目标的活动前，还必须继续一个转变(预设值)。

	AND: 等待所有转变都生效，才能执行活动。



kind(种类)





可能的值:



	dummy: 不作任何事(预设值)。

	function: 执行一个行为选择的功能。

	subflow: 执行一个子工作流程 SUBFLOW_ID(子工作流程代码)。这个行为程序必须回复子工作流程所需要的资源代码。如果这个行为程序回复 False，这个工作项目就会消失。

	stopall: 全部停止






当某一个活动是 SUBFLOW 形态时，就会执行子工作流程。当子工作流程结束时活动也会结束。当子工作流程在作用中，这个活动的工作项目会被冻结。

action(行动)





行动是指当某一个工作项目来到这个活动时，所要执行的程序方法。这些程序方法必须在这个工作流程里的物件里有定义，而且具有以下特征:

def object_method(self, cr, uid, ids):





在实际行动里，这些程序方法会被以下的叙述方式呼叫:

object_method()





signal_send(送出信号)





这个字段是用于指定一个信号，当活动在作用中，这个信号就会被送往上一层的工作流程。如果要送出信号，将字段值设定为信号的名字 (去掉开头的 signal. )。

flow_start(流程开始)





标记这个节点是否为开始节点。当创建一个工作流程的实例(instance)时，每一个活动都会启动一个标记为 n``flow_start``n (流程开始)的工作项目。


Warning


	对所有的布尔型字段来说，当在你的XML资料里写入 <field> 标记时，务必使用 eval 属性，

	不可以使用文字节点属性。详细说明请参考:ref:eval attribute <eval-attribute-link>。





flow_stop(流程停止)





标记这个节点是否为结束的节点。当一个实例(instance)里所有作用中的工作项目来到标记为``flow_stop``(流程停止)的节点，工作流程将会结束。


Warning

参考上面关于 flow_start (流程开始)的字段说明




	::

	wkf_id(工作流程识别码)



表示这个活动所属的工作流程。




使用XML档案定义活动

活动记录的一般结构如下

<record model="workflow.activity" id="''activity_id''">
      <field name="wkf_id" ref="''workflow_id''"/>
      <field name="name">''activity.name''</field>::

      <field name="split_mode">XOR | OR | AND</field>
      <field name="join_mode">XOR | AND</field>
      <field name="kind">dummy | function | subflow | stopall</field>

      <field name="action">''(...)''</field>
      <field name="signal_send">''(...)''</field>
      <field name="flow_start" eval='True | False' />
      <field name="flow_stop" eval='True | False' />
  </record>





开始的**wkf_id**和**name**是强制要求要有的两个参数。




范例

有太多时候可以从这个定义档案里选择其中一项作为活动的定义，所以我们建议大家看看以下档案里的几个活动定义范例。server/addons/sale/sale_workflow.xml






Transition(转变)


简介

工作流程的转变是指，一个活动要进行到下一个活动前，必须满足的条件。转变是用单向的箭头代表，通常会连接前后两个活动。

条件有以下几种:



	使用者必须符合某种角色要求

	在使用界面里按下某个按钮

	经由某个指定的活动达到这个子流程的结束点






系统是在表达式之前先判断任务或信号是否成立，所以如果任务或信号为伪(false)，系统不会进行表达式的判断。

转变的判断可能不会在物件里写入任何值。




字段

act_from(来源活动)





转变的来源活动。当这个(来源)活动结束后，系统会检查这个字段的状态，来确认是不是可以开始进行 ACT_TO 活动。

act_to(目标活动)





转变要进行到的目标活动

condition(状态)





要满足**表达式(Expression)** 才能完成转变。

signal(信号)





当转变的运作是来自于在使用者界面里按下一个按钮，信号会检查被按下的按钮的名称。

如果信号为空值(NULL)，表示不需要任何按钮来启动这个转变。

role_id(角色识别码)





使用者必须符合某个**角色**才能启动这个转变




用 XML 档案定义转变

转变记录的一般结构如下

<record model="workflow.transition" id="transition_id">

    <field name="act_from" ref="activity_id'_1_'"/>
    <field name="act_to" ref="activity_id'_2_'"/>

    <field name="signal">(...)</field>
    <field name="role_id" ref="role_id'_1_'"/>
    <field name="condition">(...)</field>

    <field name="trigger_model">(...)</field>
    <field name="trigger_expr_id">(...)</field>

</record>





只有**act_from**和**act_to**这两个字段是强制要求要有的。






Expressions(表达式)

表达式是以 Python 写成的:



	True

	1==1

	‘hello’ in [‘hello’,’bye’]






工作流程指向的资源里，任何字段都可以用在表达式里。例如，如果想要为伙伴地址建立一个工作流程，可以用类似以下的表达式:



	zip==1400

	phone==mobile









使用者角色

转变可以附加角色要求。如果转变指定角色要求，只有符合角色要求的使用者启动转变，转变才会进行。

每个使用者可以有一个或多个角色。角色会被定义在一个角色树状图里，上层(父层)的角色拥有所有下层(子层)的权力。

范例:

执行长



	技术经理


	
	研发组长

	
	研发员

	测试员




















	销售经理
	广告人员

	...










假设我们要查找数据库里的错误，需要测试员的角色才能在找到的错误上做标示，在上述范例的角色树里，有以下角色的人都可以在找到的错误上做标示：测试员，研发组长，技术经理，执行长。




错误处理

在以下的叙述中，工作流程里没有包含错误处理。

如果工作流程是批量执行的动作组成的，就不会触发例外状况。为了提升执行效率和尽量不被锁住，工作流程在每一个活动结束时才提交一个结果。这个策略是合理的，因为在每一个动作要求的条件被满足后，活动才会被执行。

唯一可能出现例外状况的问题是编程上的错误；这种状况下，只有属于整个已经执行完成的活动的动作才会被执行，其他的活动会被回退到上个检查点。




创建一个工作流程

以下步骤是用于创建一个名为**mymod**的定制模块，是一个简单的改变状态的工作流程


定义你的物件的状态

第一步是定义你的物件可以有那些状态。我们在物件的栏目(_columns)集合里加上一个 ‘state’ 字段，用于定义物件的状态。

_columns = {
 ...
    'state': fields.selection([
    ('new','New'),
    ('assigned','Assigned'),
    ('negotiation','Negotiation'),
    ('won','Won'),
    ('lost','Lost')], 'Stage', readonly=True),
}








定义状态改变的处理方式

在你的物件里增加以下额外的处理方法，我们的工作流程里的按钮会呼叫这些方法。

def mymod_new(self, cr, uid, ids):
     self.write(cr, uid, ids, {'state': 'new'})
     return True

def mymod_assigned(self, cr, uid, ids):
     self.write(cr, uid, ids, {'state': 'assigned'})
     return True

def mymod_negotiation(self, cr, uid, ids):
     self.write(cr, uid, ids, {'state': 'negotiation'})
     return True

def mymod_won(self, cr, uid, ids):
     self.write(cr, uid, ids, {'state': 'won'})
     return True

def mymod_lost(self, cr, uid, ids):
     self.write(cr, uid, ids, {'state': 'lost'})
     return True





显然你以后会想把这些方法扩充改成执行更有用的事项!




创建你的工作流程XML档案

我们在 mymod_workflow.xml 这个档案里需要定义3个种类的记录。


	工作流程标题记录




<record model="workflow" id="wkf_mymod">
    <field name="name">mymod.wkf</field>
    <field name="osv">mymod.mymod</field>
    <field name="on_create" eval='True' />
</record>









	工作流程活动记录




这种记录是在定义工作流程到达某个特定状态时，必须执行的动作



<record model="workflow.activity" id="act_new">
    <field name="wkf_id" ref="wkf_mymod" />
    <field name="flow_start" eval='True' />
    <field name="name">new</field>
    <field name="kind">function</field>
    <field name="action">mymod_new()</field>
</record>

<record model="workflow.activity" id="act_assigned">
    <field name="wkf_id" ref="wkf_mymod" />
    <field name="name">assigned</field>
    <field name="kind">function</field>
    <field name="action">mymod_assigned()</field>
</record>

<record model="workflow.activity" id="act_negotiation">
    <field name="wkf_id" ref="wkf_mymod" />
    <field name="name">negotiation</field>
    <field name="kind">function</field>
    <field name="action">mymod_negotiation()</field>
</record>

<record model="workflow.activity" id="act_won">
    <field name="wkf_id" ref="wkf_mymod" />
    <field name="name">won</field>
    <field name="kind">function</field>
    <field name="action">mymod_won()</field>
    <field name="flow_stop" eval='True' />
</record>

<record model="workflow.activity" id="act_lost">
    <field name="wkf_id" ref="wkf_mymod" />
    <field name="name">lost</field>
    <field name="kind">function</field>
    <field name="action">mymod_lost()</field>
    <field name="flow_stop" eval='True' />
</record>









	工作流程转变记录




这种记录是在定义工作流程的状态间，可能的转变



<record model="workflow.transition" id="t1">
    <field name="act_from" ref="act_new" />
    <field name="act_to" ref="act_assigned" />
    <field name="signal">mymod_assigned</field>
</record>

<record model="workflow.transition" id="t2">
    <field name="act_from" ref="act_assigned" />
    <field name="act_to" ref="act_negotiation" />
    <field name="signal">mymod_negotiation</field>
</record>

<record model="workflow.transition" id="t3">
    <field name="act_from" ref="act_negotiation" />
    <field name="act_to" ref="act_won" />
    <field name="signal">mymod_won</field>
</record>

<record model="workflow.transition" id="t4">
    <field name="act_from" ref="act_negotiation" />
    <field name="act_to" ref="act_lost" />
    <field name="signal">mymod_lost</field>
</record>











把 mymod_workflow.xml 加到 __openerp__.py 里

修改你的模块里的 __openerp__.py ；把 "mymod_workflow.xml" 加到 update_xml 阵列，这样下一次 OpenERP 载入你的模块时，就会抓取这些修改。




在你的视图里加上工作流程按钮

最后一个步骤是把需要的按钮加到 mymod_views.xml 档案里。

在你的物件的视图定义里， <form> 部分的最后一段，加上以下程序:


<separator string="Workflow Actions" colspan="4"/>
<group colspan="4" col="3">
    <button name="mymod_assigned" string="Assigned" states="new" />
    <button name="mymod_negotiation" string="In Negotiation" states="assigned" />
    <button name="mymod_won" string="Won" states="negotiating" />
    <button name="mymod_lost" string="Lost" states="negotiating" />
</group>











测试

现在可以用模块管理员(Module Manager)来安装或更新你的模块。如果你有正确地完成所有事项，应该不会出现任何错误。你可以检查你的工作流程是不是有被安装在菜单里:选择菜单(menuselection):管理(Administration) –> 定制(Customization) –> 工作流程定义(Workflow Definitions).

当你进行测试时，记得新加入的工作流程只会被应用在新创建的记录上。




故障排除

如果你的按钮看起来没有任何作用，或许是因为以下两个问题的其中一个:



	你正在处理的记录没有连接到工作流程实例(Instance)记录(也许是这笔记录是在你定义你的工作流程以前创建的)

	你在你的工作流程 XML 档案里没有正确设定 osv 这个字段
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控制界面

OpenERP 物件可以从 PostgreSQL 的窗体创建产生。方式如下:



	宣告你的栏位 _columns 定义。所有字段必须有 readonly=True. 的旗标。

	对 OpenERP 物件指定参数 _auto=False ，所以不会自动产生对应到 _columns 定义的资料表。

	增加一个方法 init(self, cr) 用来创建一个符合 _columns 栏位定义的 PostgreSQL 窗体 .






范例 report_crm_case_user 这个物件是依照以下模式创建的

class report_crm_case_user(osv.osv):
    _name = "report.crm.case.user"
    _description = "Cases by user and section"
    _auto = False
    _columns = {
        'name': fields.date('Month', readonly=True),
        'user_id':fields.many2one('res.users', 'User',
                                  readonly=True, relate=True),
        'section_id':fields.many2one('crm.case.section', 'Section',
                                     readonly=True, relate=True),
        'amount_revenue': fields.float('Est.Revenue',
                                       readonly=True),
        'amount_costs': fields.float('Est.Cost', readonly=True),
        'amount_revenue_prob': fields.float('Est. Rev*Prob.',
                                            readonly=True),
        'nbr': fields.integer('# of Cases', readonly=True),
        'probability': fields.float('Avg. Probability',
                                    readonly=True),
        'state': fields.selection(AVAILABLE_STATES, 'State',
                                  size=16, readonly=True),
        'delay_close': fields.integer('Delay to close',
                                      readonly=True),
        }
    _order = 'name desc, user_id, section_id'

    def init(self, cr):
        cr.execute("""
     CREATE OR REPLACE VIEW report_crm_case_user AS (
     SELECT
         min(c.id) as id,
         SUBSTRING(c.create_date for 7)||'-01' as name,
         c.state,
         c.user_id,
         c.section_id,
         COUNT(*) AS nbr,
         SUM(planned_revenue) AS amount_revenue,
         SUM(planned_cost) AS amount_costs,
         SUM(planned_revenue*probability)::decimal(16,2)
              AS amount_revenue_prob,
         avg(probability)::decimal(16,2) AS probability,
         TO_CHAR(avg(date_closed-c.create_date),
                 'DD"d" `HH24:MI:SS') AS delay_close
     FROM
         crm_case c
     GROUP BY SUBSTRING(c.create_date for 7), c.state,
              c.user_id, c.section_id
     )""")
report_crm_case_user()
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I18n - 国际化

关于多种语言应用程序的说明


简介

I18n 包含了各模块对不同语言的翻译。这个文件夹包含2种类型的文件， .po 和 .pot。
.po 文件是真正的翻译文件， .pot 是翻译文件的模板。

.po 文件应该是依照对应语言的代码命名的， .pot 应该是依照对应模块的名称命名的。

以下以 account.pot 为例子

"Project-Id-Version: OpenERP Server 5.0.0\n"
"Report-Msgid-Bugs-To: support@openerp.com\n"
"POT-Creation-Date: 2009-05-19 14:36+0000\n"
"PO-Revision-Date: 2009-05-20 10:36+0000\n"
"Last-Translator: <>\n"
"Language-Team: \n"
"MIME-Version: 1.0\n"
"Content-Type: text/plain; charset=UTF-8\n"
"Content-Transfer-Encoding: 8bit\n"
"X-Launchpad-Export-Date: 2009-12-07 15:06+0000\n"
"X-Generator: Launchpad (build Unknown)\n"

#. module: account
#: code:addons/account/account.py:0
#, python-format
msgid "Integrity Error !"
msgstr ""





上述的文件是会计(account)模块翻译文件的模板，里面的程序是在判别所有模块里的值，在对应的语言里应该被翻译成什么。

以下例子是会计模块里的 fr_FR.po 把会计模块翻译成法文。

# Translation of OpenERP Server.
# This file contains the translation of the following modules:
#     * account
#
msgid ""
msgstr ""
"Project-Id-Version: OpenERP Server 5.0.0\n"
"Report-Msgid-Bugs-To: support@openerp.com\n"
"POT-Creation-Date: 2009-05-19 14:36+0000\n"
"PO-Revision-Date: 2010-01-04 11:19+0530\n"
"Last-Translator: Anup <ach@tinyerp.co.in>\n"
"Language-Team: \n"
"MIME-Version: 1.0\n"
"Content-Type: text/plain; charset=UTF-8\n"
"Content-Transfer-Encoding: 8bit\n"
"X-Launchpad-Export-Date: 2009-12-07 15:07+0000\n"
"X-Generator: Launchpad (build Unknown)\n"

#. module: account
#: code:addons/account/account.py:0
#, python-format
msgid "Integrity Error !"
msgstr "Erreur d'Intégrité !"





上面的文件把 msgid 的值，依据 msgid 在 .pot 文件里代表的值，翻译成 msgstr 里的法文。
fr_FR 是法文的语言代码，其中 fr 表示法文， FR 表示使用这个语言的国家。
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测试


单元测试

自OpenERP 4.2版以来, 新增了利用XML文件进行模块测试的功能. 可以完成:



	测试记录属性，类常量等。

	测试您的方法

	操作对象，以检查流程和特殊方法






可以利用这些来模拟一个用户与系统的交互来测试你的模块.


概述

单元测试主要通过 OpenERP XML 文件的三个标签 : <assert>, <workflow> 和 <function> 来完成。其共有属性如下：





	uid:	






可指定 User ID 来完成交互 (你必须指定该用户的 XML id, 如 “base.user_demo”)






	context:	






可指定上下文字典（Python 表达式）内容（对于 <function> 标签需注意不是所有对象方法都会读取 context ，因此上下文不一定会传递。但对 <value> 标签可用）


这2个属性可设置在任意标签（对于 <functions> 标签，只有根 root <functions> 标签可用）中，或 <data> 标签本身。如果你同时设置，context 会自动合并。

注意：单元测试标签在<data> 里设置为 noupdate 时，将不会被解析。




使用单元测试

你可以在XML文件中声名单元测试,我们建议你如下面的样子命名：



	module_name_test.xml






如果你的测试在 __openerp__.py 作为演示数据申明，那么将会在系统安装演示数据时检查。例如，在生成发票过程中，测试销售订单是否产生了正确的金额。

如果你的测试申明为初始数据（init），那么将在模块安装时检查。可以在模块安装后检查数据的一致性。

如果你的测试数据在升级部分申明，那么将在模块安装和升级时检查。用于检查数据一致性和常量。例如，会计模块中，所有非草稿状态分录总和贷方必须等于借方。将测试放在升级章节中，在模块迁移和升级中是非常有用的。




断言标签

断言标签允许你定义某些断言，这些断言将会启动的时候检查。如：

<assert model="res.company" id="main_company" string="The main company name is Open sprl">
    <test expr="name">Open sprl</test>
</assert>





该断言将会检查 id 为 main_company 的 company 对象名字是否匹配 “Open sprl” 。expr 字段指定一个 python 表达式计算。该表达式可以读取指定对象的任意字段或是 python 内置函数（如sum, reduce等）。ref 函数指定数据库ID 对应的 XML id，同样也是可用（在某些例子中，ref 同时也是指定对象的属性名，这时应该使用 _ref 来代替）。经过计算后的结果值将会与 test 标签文本值比较。假如断言失败，相关属性值和测试标签信息将会作为一条消息记录下来。

在更复杂的测试中，也可以使用计算结果为 True 的 python 表达式。

<assert model="res.company"
        id="main_company"
        string="The main company's currency is €" severity="warning">
    <test expr="currency_id.code == 'eur'.upper()"/>
</assert>





severity 标签定义了断言的级别：debug, info, warning, error 或 critical，默认值为 error 。如果断言严重失败，那么将抛出一个异常，然后停止解析。如果是发生在服务初始化阶段，你们程序将中止。除此之外，其它的所有异常将会发送到客户端。默认情况下，系统将会在 warning 级别抛出失败异常，但可以通过 –assert-exit-leve 启动参数设置。

As sometimes you do not know the id when you’re writing the test, you can use a search instead. So we can define another example, which will be always true:

<assert model="res.partner"
        search="[('name','=','Agrolait')]"
        string="The name of Agrolait is :Agrolait">
    <test expr="name">Agrolait</test>
</assert>





When you use the search, each resulting record is tested but the assertion is counted only once. Thus if an assertion fails, the remaining records won’t be tested. In addition, if the search finds no record, nothing will be tested so the assertion will be considered successful. If you want to make sure that there are a certain number of results, you might use the count parameter:

<assert model="res.partner"
        search="[('name','=','Agrolait')]"
        string="The name of Agrolait is :Agrolait"
        count="1">
    <test expr="name">Agrolait</test>
</assert>









	Example:	





Require the version of a module.

<!-- modules requirement -->
<assert model="ir.module.module"
        search="[('name','=','common')]"
        severity="critical" count="1">
    <test expr="state == 'installed'" />
    <!-- only check module version -->
    <test expr="'.'.join(installed_version.split('.')[3:]) >= '2.4'" />
</assert>








工作流标签

The workflow tag allows you to call for a transition in a workflow by sending a signal to it. It is generally used to simulate an interaction with a user (clicking on a button…) for test purposes:

<workflow model="sale.order" ref="test_order_1" action="order_confirm" />





This is the syntax to send the signal order_confirm to the sale order with id test_order_1.

Notice that workflow tags (as all other tags) are interpreted as root which might be a problem if the signals handling needs to use some particular property of the user (typically the user’s company, while root does not belong to one). In that case you might specify a user to switch to before handling the signal, through the uid property:

<workflow model="sale.order" ref="test_order_1" action="manual_invoice" uid="base.user_admin" />





(here we had to specify the module base - from which user_admin comes - because this tag is supposed to be placed in an xml file of the sale module)

In some particular cases, when you write the test, you don’t know the id of the object to manipulate through the workflow. It is thus allowed to replace the ref attribute with a value child tag:

<workflow model="account.invoice" action="invoice_open">
    <value model="sale.order" eval="obj(ref('test_order_1')).invoice_ids[0].id" />
</workflow>





(notice that the eval part must evaluate to a valid database id)




函数标签

The function tag allows to call some method of an object. The called method must have the following signature:

def mymethod(self, cr, uid [, …])

Where



	cr is the database cursor

	uid is the user id






Most of the methods defined in Tiny respect that signature as cr and uid are required for a lot of operations, including database access.

The function tag can then be used to call that method:

<function model="mypackage.myclass" name="mymethod" />





Most of the time you will want to call your method with additional arguments. Suppose the method has the following signature:

def mymethod(self, cr, uid, mynumber)

There are two ways to call that method:



	either by using the eval attribute, which must be a python expression evaluating to the list of additional arguments:






<function model="mypackage.myclass" name="mymethod" eval="[42]" />





In that case you have access to all native python functions, to a function ref() that takes as its argument an XML id and returns the corresponding database id, and to a function obj() that takes a database id and returns an object with all fields loaded as well as related records.



	or by putting a child node inside the function tag:






<function model="mypackage.myclass" name="mymethod">
     <value eval="42" />
</function>





Only value and function tags have meaning as function child nodes (using other tags will give unspecified results). This means that you can use the returned result of a method call as an argument of another call. You can put as many child nodes as you want, each one being an argument of the method call (keeping them in order). You can also mix child nodes and the eval attribute. In that case the attribute will be evaluated first and child nodes will be appended to the resulting list.






验收测试

这个文档描述的是所有人在计算机上安装OpenERP的测试。你可以假设所有测试都已通过致使我们必须更新整合到发行版的新模块中或者一个新OpenERP候选版本中。


迁移完整性测试



	Sum credit = Sum debit

	Balanced account chart






... Describe all integrity tests here




工作流测试

... Describe all processes tested here.




记录生成

More than 300 records are created, describe them here.
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持久化，迁移和升级


数据序列化

在 OpenERP 安装的时候, 创建和填充数据库是必须的两个步骤:



	创建 SQL 表

	插入不同的数据到表中






由于服务器中的对象描述，SQL表的创建和修改时自动的.

使用 OpenERP, 除了对象的业务逻辑以外，其它都存在数据库中.
例如(不存入数据库):



	reports的定义,

	fields的默认值,

	每个文档(views)的用户接口的定义 ,

	菜单，按钮和动作的关系

	等等其他.






必须有一个机制去描述, 修改和装载这些不同的数据.
OpenERP 的数据可以以模块提供的 CSV, XML or YAML 的序列化文件的形式指定模块
modules, 并在模块安装和升级时装载以便填充和升级数据库表.


XML 数据序列化

4.2版本之后, OpenERP 提供基于XML的数据序列化格式.

基本的 OpenERP XML 文件格式如下:

<?xml version="1.0"?>
<openerp>
    <data>
    <record model="model.name_1" id="id_name_1">
        <field name="field1">
            field1 content
        </field>
        <field name="field2">
            field2 content
        </field>
        (...)
    </record>
    <record model="model.name_2" id="id_name_2">
        (...)
    </record>
    (...)
    </data>
</openerp>





Fields 内容是 strings 类型,保存在以 UTF-8 编码的 XML 格式的文件中.

下面是一个来自 OpenERP 的源码的例子 (base_demo.xml 在 base 模块中):

<record model="res.company" id="main_company">
    <field name="name">OpenERP SA</field>
    <field name="partner_id" ref="main_partner"/>
    <field name="currency_id" ref="EUR"/>
</record>

<record model="res.users" id="user_admin">
    <field name="login">admin</field>
    <field name="password">admin</field>
    <field name="name">Administrator</field>
    <field name="signature">Administrator</field>
    <field name="action_id" ref="action_menu_admin"/>
    <field name="menu_id" ref="action_menu_admin"/>
    <field name="address_id" ref="main_address"/>
    <field name="groups_id" eval="[(6,0,[group_admin])]"/>
    <field name="company_id" ref="main_company"/>
</record>





最后的字段定义的 admin user :



	登录，密码等字段比较直接.

	ref 属性用于填充两个记录之间的关系 :






<field name="company_id" ref="main_company"/>





company_id 字段是一个多对一(many2one) 从USER对象到 COMPANY 对象, main_company 是关系的 id.



	eval 属性允许将一些 python 代码放进 xml 中: 这里 groups_id 字段是一个多对多(many2many)的关系. 对于这样一个字段, “[(6,0,[group_admin])]” 的意思为 : 删除所有与当前用户相关的组，并使用 [group_admin] 作为新的关联组 (and group_admin 是另一个记录的 id ).

	search 属性允许你在不指定 xml id 的情况下. 查找相关的记录. 你可以指定一个搜索条目来寻找想要查询的字段. 条目是一个 tuple 的 lists 用于预定义的搜索方法, 如果有多个结果， 通常选中(第一个):







<field name=”partner_id” search=”[]” model=”res.partner”/>


只是 search 在演示数据的一个经典的例子：这里我们并不关心用哪一个 partner 来进行测试，所以我们给出一个空的 list . 注意 model 属性是必须的.

一些典型的 XML 元素描述如下.


记录标签

通过 record 标签来实现新数据的添加. 这里 : model 属性是必须的. Model 是插入数据的对象名. 它还有一个可选的属性: id. 如果给出该属性, 在同一个文件中, 这个名字对应的变量将在以后使用, 以便生成新产生资源 ID 的引用.

一个 record 标签可以包含多个 field 标签. 他们指定了记录的 fields 值. 如果不指定一个 field 默认值将会被使用.


例子

<record model="ir.actions.report.xml" id="l0">
     <field name="model">account.invoice</field>
     <field name="name">Invoices List</field>
     <field name="report_name">account.invoice.list</field>
     <field name="report_xsl">account/report/invoice.xsl</field>
     <field name="report_xml">account/report/invoice.xml</field>
</record>










field tag

对应的属性如下:



	
	name

	o 必须的属性，用于指定字段名称







	
	eval

	o 用于指定添加值的 python 语句







	
	ref

	o 定义在此文件中的 id 的引用















function tag



	model:



	name:



	
	eval

	o 用于评价将被调用的方法的属性列表，包括 cr 和 uid













例子

<function
    model="ir.ui.menu"
    name="search"
    eval="[[('name','=','Operations')]]"/>










getitem tag

采用标签最后一个子节点的子集.



	
	type

	
	int or list









	index



	int or string (a key of a dictionary)









例子

节点返回的一个 ids 的列表的第一个元素:

<getitem index="0" type="list">
    <function
            model="ir.ui.menu"
            name="search"
            eval="[[('name','=','Operations')]]"/>
</getitem>












YAML 数据序列化

YAML 是 human-readable 可读的数据序列化格式 概念源于 C, Perl, Python, 主意来自 XML
和电子邮件的数据格式.
YAML stands for YAML Ain’t Markup Language (yes, that’s a recursive acronym).
YAML 用于 OpenERP 数据格式 as of OpenERP 6.0, 有以下优点:



	作为当前的 XML 格式的一个用户友善的备选格式.

	在相同的系统模块中进行数据的装载，测试集成.

	内建与 OpenERP 以便开发复杂的 Python 测试.

	方便非开发人员写功能测试.






下面是一个 XML 记录和 YAML 记录的比较.

首先，XML 记录使用当前的 XML 序列化格式：
(参阅 previous section )

<!--
    Resource: sale.order
-->

<record id="order" model="sale.order">
  <field name="shop_id" ref="shop"/>
  <field model="product.pricelist" name="pricelist_id" search="[]"/>
  <field name="user_id" ref="base.user_root"/>
  <field model="res.partner" name="partner_id" search="[]"/>
  <field model="res.partner.address" name="partner_invoice_id search="[]"/>
  <field model="res.partner.address" name="partner_shipping_id" search="[]"/>
  <field model="res.partner.address" name="partner_order_id" search="[]"/>
</record>

<!--
      Resource: sale.order.line
-->

<record id="line" model="sale.order.line">
  <field name="order_id" ref="order"/>
  <field name="name">New server config + material</field>
  <field name="price_unit">123</field>
</record>

<record id="line1" model="sale.order.line">
  <field name="order_id" ref="order"/>
  <field name="name">[PC1] Basic PC</field>
  <field name="price_unit">450</field>
</record>






YAML 记录

#<!--
#       Resource: sale.order
#   -->

-
 !record {model: sale.order, id: sale_order_so4}:
   amount_total: 3263.0
   amount_untaxed: 3263.0
   create_date: '2010-04-06 10:45:14'
   date_order: '2010-04-06'
   invoice_quantity: order
   name: SO001
   order_line:
     - company_id: base.main_company
       name: New server config + material
       order_id: sale_order_so4
       price_unit: 123.0
     - company_id: base.main_company
       name: '[PC1] Basic PC'
       order_id: sale_order_so4
       price_unit: 450.0
   order_policy: manual
   partner_id: base.res_partner_agrolait
   partner_invoice_id: base.main_address
   partner_order_id: base.main_address
   partner_shipping_id: base.main_address
   picking_policy: direct
   pricelist_id: product.list0
   shop_id: sale.shop








YAML Tags


data


	Tag: data




	必选属性: None



	可选属性: noupdate : 0 | 1



	子节点:


	menuitem

	record

	workflow

	delete

	act_window

	assert

	report

	function

	ir_set





	样例:

-
  !context
   noupdate: 0












record


	标签: record




	
	必选属性:

	
	model









	可选属性: noupdate : 0 | 1



	
	子节点标签:

	
	field









	
	可选属性:

	
	id

	forcreate

	context









	样例:

-
  !record {model: sale.order, id: order}:
     name: "[PC1] Basic PC"
     amount_total: 3263.0
     type_ids:
       - project_tt_specification
       - project_tt_development
       - project_tt_testing
     order_line:
         - name: New server config
            order_id: sale_order_so4
         - name: '[PC1] Basic PC'
            order_id: sale_order_so4












field


	标签: field



	
	必选属性:

	
	name









	
	可选属性:

	
	type

	ref

	eval

	domain

	search

	model

	use









	
	子节点标签:

	
	text node









	样例:

-price_unit: 450
-product_id: product.product_product_pc1












workflow


	标签: workflow




	
	必填属性:

	
	model

	action









	
	可选属性:

	
	uid

	ref









	
	子节点标签:

	
	value









	样例:

-
 !workflow {action: invoice_open, model: account.invoice}:
  - eval: "obj(ref('test_order_1')).invoice_ids[0].id"
    model: sale.order
  - model: account.account
    search: [('type', '=', 'cash')]












function


	标签: function




	
	必选属性:

	
	model

	name









	
	可选属性:

	
	id

	eval









	
	子节点标签:

	
	value

	function









	样例:

-
 !function {model: account.invoice, name: pay_and_reconcile}:
  -eval: "[obj(ref('test_order_1')).id]"
   model: sale.order












value


	标签: value




	必选属性: None



	
	可选属性:

	
	model

	search

	eval









	子节点属性: None



	样例:

-eval: "[obj(ref('test_order_1')).id]"
 model: sale.order












menuitem


	标签: menuitem




	必选属性: None



	
	可选属性:

	
	id

	name

	parent

	icon

	action

	string

	sequence

	groups

	type

	menu









	子节点标签: None



	样例:

-
 !menuitem {sequence: 20, id: menu_administration,
  name: Administration,
  icon: terp-administration}












act_window


	标签: act_window




	
	必选属性:

	
	id

	name

	res_model









	可选属性:



	domain

	src_model

	context

	view

	view_id

	view_type

	view_mode

	multi

	target

	key2

	groups








	子节点标签: None



	样例:

-
  !act_window {target: new,
  res_model: wizard.ir.model.menu.create,
  id:act_menu_create, name: Create Menu}












report


	标签: report




	
	必选属性:

	
	string

	model

	name









	可选属性:



	id

	report

	multi

	menu

	keyword

	rml

	sxw

	xml

	xsl

	auto

	header

	attachment

	attachment_use

	groups








	子节点标签: None



	样例:

-
  !report {string: Technical guide,
   auto: False, model: ir.module.module,
   id: ir_module_reference_print,
   rml: base/module/report/ir_module_reference.rml,
   name: ir.module.reference}












ir_set


	标签: ir_set




	必选属性: None



	可选属性: None



	
	子节点属性:

	
	field









	样例:

-
 !ir_set:
 args: "[]"
 name: account.seller.costs
 value: tax_seller












python


	标签: Python




	
	必选属性:

	
	model









	可选属性: None



	子节点标签: None



	样例:

Python code












delete


	标签: delete




	
	必选属性:

	
	model









	
	可选属性:

	
	id

	search









	子节点标签: None



	样例:

-
  !delete {model: ir.actions, search: "[(model,like,auction.)]"}












assert


	标签: assert




	
	必选属性:

	
	model









	
	可选属性:

	
	id

	search

	string









	
	子节点标签:

	
	test









	样例:

-
  !assert {model: sale.order,
   id: test_order, string: order in progress}:
     - state == "progress"












test


	标签: test




	
	必选属性:

	
	expr









	可选属性: None



	
	子节点标签:

	
	text node









	样例:

- picking_ids[0].state == "done"












url


	标签: url




	必选属性: -

	可选属性: -

	子节点标签: -

	样例: -










写一个 YAML 测试


Note

参考第三部分 3YAML 自动测试指南 自动化YAML测试指南




	手工写

	
	记录的 CRUD

	工作流过渡

	段言 (像在 XML 中的语句)

	纯 Python 代码







使用 base_module_record(er)



	生成带有 record 和 workflow 的 YAML 文件








[image: ../_images/record_object.png]



	用 assertions / Python 代码更新这个 YAML







Warning

重要

yaml 的结构采用(像 Python)缩进, 每一个 child 标签(sub-tag) 相对于父标签进行缩进.




Field Tag


	
	text

	
	
	用双引号在前面或后面包含输入的文字.

	Ex: name: “[PC1] Basic PC”















	
	integer and float

	Ex: price_unit: 450
Ex: amount_total: 3263.0







	
	boolean

	active: 1







	
	datetime

	date_start: str(time.localtime()[0] - 1) + -08-07







	
	selection

	
	
	给出一个缩写

	Ex: title: M.















	
	many2one

	
	
	如果它是 res_id 的引用, 指向 res_id

	Ex: user_id: base.user_root



















	
	如果它的值是基于搜索条目，那么指定 model 到搜索条目

	Ex: object_id: !ref {model: ir.model, search: “[(‘model’,’=’,’crm.claim’)]”}













	
	one2many

	
	
	start each record in one2many field on a new line with a space and a hyphen

	Ex: order_line:
name: New server config
order_id: sale_order_so4
......


















name: ‘[PC1] Basic PC’
order_id: sale_order_so4
......



	
	many2many

	
	
	用每一个 many2many 字段，以空格和连字符开始

	Ex: type_ids:
- project_tt_specification **
**- project_tt_development
- project_tt_testing




















Value tag


	
	如果Tag能被评估(like res_id is available), 像下面一样写 value tag :

	-
!function {model: account.invoice, name: pay_and_reconcile}:
- eval: “obj(ref(‘test_order_1’)).amount_total”
model: sale.order










这会捕获一个 ‘sale.order’ 记录的 ‘amount_total’ 值伴随 res_id ‘test_order_1’



	
	如果值是在一些基于条目的模块上被搜索, 那么就像下面一样写 value tag :

	-
!function {model: account.invoice, name: pay_and_reconcile}:
- model: account.account
search: “[(‘type’, ‘=’, ‘cash’)]”
这将抓取所有 account.account 记录类型等于 ‘cash’












Test Tag


	
	直接指定测试

	Ex:  - picking_ids[0].state == “done”
- state == “manual”












comment

#<!– Resource: sale.order –>




Asserts and Python code

为了创建一个发票，python 代码应该这样写:


	-

	
	!python {model: account.invoice}: |

	self.action_move_create(cr, uid, [ref(“invoice1”)])







发票必须在 draft 状态:


	-

	
	!assert {model: account.invoice , id: invoice1, string: “the invoice is now in Draft state”}:

	- state == “draft”







测试所有在树形数据结构的账户, 我们写下面的 python 代码:


	-

	
	!python {model: account.account}:

	ids = self.search(cr, uid, [])








accounts_list = self.read(cr, uid, ids[‘parent_id’,’parent_left’,’parent_right’])



accounts = dict((x[‘id’], x) for x in accounts_list)



log(“Testing parent structure for %d accounts”, len(accounts_list))




	for a in accounts_list:

	
	if a[‘parent_id’]:

	assert a[‘parent_left’]>accounts[a[‘parent_id’][0]][‘parent_left’]











assert a[‘parent_right’]<accounts[a[‘parent_id’][0]][‘parent_right’]



assert a[‘parent_left’]<a[‘parent_right’]



for a2 in accounts_list:




	assert not ((a2[‘parent_right’]>a[‘parent_left’])and

	(a2[‘parent_left’]<a[‘parent_left’])and







(a2[‘parent_right’]<a[‘parent_right’]))




	if a2[‘parent_id’]==a[‘id’]:

	assert(a2[‘parent_left’]>a[‘parent_left’])and(a2[‘parent_right’]<a[‘parent_right’])









运行测试



	以扩展名 ‘.yml’ 保存文件

	添加 yaml 文件到 ‘demo_xml’ 下

	以参数 ‘–log-level=test’ 运行服务器











CSV Data Serialization

Since version 4.2, OpenERP provides a Comma-Separated-Values (CSV),
spreadsheet-compatible data serialization format.

The basic format of an OpenERP CSV file is as follows:

"id","name","model_id:id","group_id:id","perm_read","perm_write","perm_create","perm_unlink"
"access_product_uom_categ_manager","product.uom.categ manager","model_product_uom_categ","product.group_product_manager",1,1,1,1
"access_product_uom_manager","product.uom manager","model_product_uom","product.group_product_manager",1,1,1,1
"access_product_ul_manager","product.ul manager","model_product_ul","product.group_product_manager",1,1,1,1
"access_product_category_manager","product.category manager","model_product_category","product.group_product_manager",1,1,1,1
"access_product_template_manager","product.template manager","model_product_template","product.group_product_manager",1,1,1,1
"access_product_product_manager","product.product manager","model_product_product","product.group_product_manager",1,1,1,1
"access_product_packaging_manager","product.packaging manager","model_product_packaging","product.group_product_manager",1,1,1,1
"access_product_uom_categ_user","product.uom.categ.user","model_product_uom_categ","base.group_user",1,0,0,0
"access_product_uom_user","product.uom.user","model_product_uom","base.group_user",1,0,0,0
"access_product_ul_user","product.ul.user","model_product_ul","base.group_user",1,0,0,0
"access_product_category_user","product.category.user","model_product_category","base.group_user",1,0,0,0
"access_product_template_user","product.template.user","model_product_template","base.group_user",1,0,0,0
"access_product_product_user","product.product.user","model_product_product","base.group_user",1,0,0,0
"access_product_packaging_user","product.packaging.user","model_product_packaging","base.group_user",1,0,0,0






Importing from a CSV

Instead of using .XML file, you can import .CSV files. It is simpler but the migration system does not migrate the data imported from the .CSV files. It’s like the noupdate attribute in .XML files.
It’s also more difficult to keep track of relations between resources and it is slower at the installation of the server.

Use this only for [demo] data that will never been upgraded from one version of OpenERP to another.

The name of the object is the name of the CSV file before the first ‘-‘.
You must use one file per object to import. For example, to import a file with partners (including their
multiple contacts and events), the file must be named like one of the following example:



	res.partner.csv

	res.partner-tiny_demo.csv

	res.partner-tiny.demo.csv









Structure of the CSV file



	Separator to use: ,

	Quote character for strings: " (optional if no separator is found in field values)

	Encoding to use: UTF-8

	No whitespace allowed around separators if not using quote characters

	Be sure to configure your CSV export software (e.g. spreadsheet editor) with the above parameters









Exporting demo data and import it from a module

You can import .CSV file that have been exported from the OpenERP client.
This is interesting to create your own demo module. But both formats are not exactly the same,
mainly due to the conversion: Structured Data -> Flat Data -> Structured Data.



	
The name of the column (first line of the .CSV file) use the end user term in his own language when
you export from the client. If you want to import from a module, you must convert the first column
using the fields names.
Example, from the partner form:

Name,Code,Contacts/Contact Name,Contacts/Street,Contacts/Zip





becomes:

name,ref,address/name,address/street,address/zip









	When you export from the OpenERP client, you can select any many2one fields and their child’s relation.
When you import from a module, OpenERP tries to recreate the relations between the two resources.
For example, do not export something like this from a sale order form - otherwise OpenERP will not be
able to import your file:

Order Description,Partner/Name,Partner/Payable,Partner/Address/Name







	To find the link for a many2one or many2many field, the server uses the name_search function when importing.
So, for a many2one field, it is better to export the field ‘name’ or ‘code’ of the related resource only.
Use the more unique one. Be sure that the field you export is searchable by the name_search function.
(the ‘name’ column is always searchable):

Order Description,Partner/Code







	Change the title of the column for all many2many or many2one fields. It’s because you export the related
resource and you import a link on the resource.
Example from a sale order: Partner/Code should become partner_id and not partner_id/code.
If you kept the /code, OpenERP will try to create those entries in the database instead of finding
references to existing ones.



	
Many2many fields. If all the exported data contains 0 or 1 relation on each many2many fields, there will
be no problem. Otherwise, the export will result in one line per many2many. The import function expects
to get all many2many relations in one column, separated by a comma.

So, you have to make the transformation. For example, if the categories “Customer” and “Supplier”
already exists:

name,category_id
Smith, "Customer, Supplier"





If you want to create these two categories you can try

name,category_id/name
Smith, "Customer, Supplier"





But this does not work as expected: a category “Customer, Supplier” is created.
The solution is to create an empty line with only the second category:

name,category_id/name
Smith, Customer
,Supplier





Note the comma before “Supplier”!





	Read only fields. Do not try to import read only fields like the amount receivable or payable for a partner.
Otherwise, OpenERP will not accept to import your file.



	Exporting trees. You can export and import tree structures using the parent field.
You just have to take care of the import order. The parent have to be created before his child’s.











Use record id like in xml file

It’s possible to define an id for each line of the csv file. This allow to define references between records:


id, name, parent_id:id
record_one, Father,
record_two, Child, record_one


If you do this, the line with the parent data must be before the child lines in the file.






Multiple CSV Files


Importing from multiple CSV a full group of linked data

It’s possible to import a lot of data, with multiple CSV files imported as a single operation. Assume we have a database with books and authors with a relation many2many between book and author.

And that you already have a file with a lot of books (like a library) and an other file with a lot of authors and a third file with the links between them.

How to import that easily in openERP ?




Definition of an import module

You can do this in the module you have defined to manage yours books and authors. but Sometimes, the tables to import can also be in several modules.

For this example, let’s say that ‘book’ object is defined in a module called ‘library_management’ and that ‘Author’ object in a module called ‘contact_name’.

In this case, you can create a ‘fake’ module, just to import the data for all these multiples modules. Call this importation module : ‘import_my_books’.

You create this module as others modules of OpenObject :



	create a folder ‘import_my_books’

	inside, create a ‘__init__.py’ file with only one line : import import_my_books

	again, in the same folder, create a ‘__openerp__.py’ file and in this file, write the following code :






# -*- encoding: utf-8 -*-
{
  'name': 'My Book Import',
  'category': 'Data Module 1',
  'init_xml':[],
  'author': 'mySelf & I',
  'depends': ['base','library_management','contact_name'],
  'version': '1.0',
  'active': False,
  'demo_xml': [],
  'update_xml':['contact_name.author.csv','library.book.csv'],
  'installable': True
}








Creation of CSV files

For the CSV files, you’ll import one after the other.

So you have to choose in which way you’ll treat the many2many relation.
For our example, we’ve choose to import all the authors, then all the books with the links to the authors.



	authors CSV file






You have to put your data in a CSV file without any link to books (because the book ids will be known only AFTERWARDS...) For example : (“contact_name.author.csv”)

  id,last_name,first_name,type
  author_1,Bradley,Marion Zimmer,Book writer
  author_2,"Szu T'su",,Chinese philosopher
  author_3,Zelazny,Roger,Book writer
  author_4,Arleston,Scotch,Screen Writer
  author_5,Magnin,Florence,Comics Drawer
  ...

1. Books CSV file





Here, you can put the data about your books, but also, the links to the authors, using the same id as the column ‘id’ of the author CSV file. For example : (“library.book.csv” )

id,title,isbn,pages,date,author_ids:id
book_a,Les Cours du Chaos,1234567890123,268,1975-12-25,"author_3"
book_b,"L'art de la Guerre, en 219 volumes",1234567890124,1978-01-01,"author_2"
book_c,"new marvellous comics",1587459248579,2009-01-01,"author_5,author_4"
...





Five remarks :



	the field content must be enclosed in double quotes (”) if there is a double quote or a comma in the field.

	the dates are in the format YYYY-MM-DD

	if you have many ids in the same column, you must separate them with a comma, and, by the way, you must enclosed the content of the column between double quotes...

	the name of the field is the same as the name of the field in the class definition AND must be followed by ‘:id’ if the content is an ID that must be interpreted by the import module. In fact, “author_4” will be transformed by the import module in an integer id for the database module and this numerical id will be put also in the table between author and book, not the literal ID (author_4).

	the encoding to be used by the CSV file is the ‘UTF-8’ encoding













Data Migration - Import / Export


Data Importation


Introduction

There are different methods to import your data into OpenERP:



	Through the web-service interface

	Using CSV files through the client interface

	Building a module with .XML or .CSV files with the content

	Directly into the SQL database, using an ETL









Importing data through a module

The best way to import data in OpenERP is to build a module that
integrates all the data you want to import. So, when you want to
import all the data, you just have to install the module and OpenERP
manages the different creation operations. When you have lots of different
data to import, we sometimes create different modules.

So, let’s create a new module where we will store all our data. To do
this, from the addons directory, create a new module called data_yourcompany.


	mkdir data_yourcompany

	cd data_yourcompany

	touch __init__.py



You must also create a file called __openerp__.py in this new module.
Write the following content in this module file description.

{
  'name': 'Module for Data Importation',
  'version': '1.0',
  'category': 'Generic Modules/Others',
  'description': "Sample module for data importation.",
  'author': 'Tiny',
  'website': 'http://www.openerp.com',
  'depends': ['base'],
  'init_xml': [
      'res.partner.csv',
      'res.partner.address.csv'
  ],
  'update_xml': [],
  'installable': True,
  'active': False,
}





The following module will import two different files:


	res.partner.csv : a CSV file containing records of the res.partner object

	res.partner.address.csv : a CSV file containing records of the res.partner.address object



Once this module is created, you must load data from your old application to
.CSV file that will be loaded in OpenERP. OpenERP has a builtin system to
manage identifications columns of the original software.

For this exercise, we will load data from another OpenERP database called old.
As this database is in SQL, it’s quite easy to export the data using the command
line postgresql client: psql. As to get a result that looks like a .CSV file,
we will use the following arguments of psql:


	-A : display records without space for the row separators

	-F , : set the separator character as ‘,’

	–pset footer : don’t write the latest line that looks like “(21 rows)”



When you import a .CSV file in OpenERP, you can provide a ‘id’ column that
contains a uniq identification number or string for the record. We will use
this ‘id’ column to refer to the ID of the record in the original application.
As to refer to this record from a many2one field, you can use ‘FIELD_NAME:id’.
OpenERP will re-create the relationship between the record using this uniq
ID.

So let’s start to export the partners from our database using psql: ::

psql trunk -c "select 'partner_'||id as id,name from res_partner"
           -A -F , --pset footer > res.partner.csv





This creates a res.partner.csv file containing a structure that looks like this:

id,name
partner_2,ASUStek
partner_3,Agrolait
partner_4,Camptocamp
partner_5,Syleam





By doing this, we generated data from the res.partner object, by creating a uniq
identification string for each record, which is related to the old application’s
ID.

Now, we will export the table with addresses (or contacts) that are linked to
partners through the relation field: partner_id. We will proceed in the same
way to export the data and put them into our module:

psql trunk -c "select 'partner_address'||id as id,name,'partner_'||
              partner_id as \"partner_id:id\" from res_partner_address"
              -A -F , --pset footer > res.partner.address.csv





This should create a file called res.partner.address with the following data:

id,name,partner_id:id
partner_address2,Benoit Mortier,partner_2
partner_address3,Laurent Jacot,partner_3
partner_address4,Laith Jubair,partner_4
partner_address5,Fabien Pinckaers,partner_4





When you will install this module, OpenERP will automatically import the partners
and then the address and recreate efficiently the link between the two records.
When installing a module, OpenERP will test and apply the constraints for consistency
of the data. So, when you install this module, it may crash, for example, because
you may have different partners with the same name in the system. (due to the uniq
constraint on the name of a partner). So, you have to clean your data before importing
them.

If you plan to upload thousands of records through this technique, you should consider
using the argument ‘-P’ when running the server.

openerp_server.py -P status.pickle --init=data_yourcompany





This method provides a faster importation of the data and, if it crashes in the middle
of the import, it will continue at the same line after rerunning the server. This may
preserves hours of testing when importing big files.




Using OpenERP’s ETL

The next version of OpenERP will include an ETL module to allow you
to easily manages complex import jobs. If you are interested in this
system, you can check the complete specifications and the available
prototype at this location:


bzr branch lp:~openerp-commiter/openobject-addons/trunk-extra-addons/etl


... to be continued ...






Data Loading

During OpenERP installation, two steps are necessary to create and feed the database:



	Create the SQL tables

	Insert the different data into the tables






The creation (or modification in the case of an upgrade) of SQL tables is automated thanks to the description of objects in the server.

Into OpenERP, all the logic of the application is stored in the database. We find for example:



	the definitions of the reports,

	the object default values,

	the form description of the interface client,

	the relations between the menu and the client buttons, ...






There must be a mechanism to describe, modify and reload the different data. These data are represented into a set of XML files that can possibly be loaded during start of the program in order to fill in the tables.






Upgrading


Warning

This section needs to be rewritten or improved. If you think you
can contribute to this effort, and are already familiar with Launchpad
and OpenERP’s source control system, Bazaar, please have a look at:



	the section explaining how you can download and build the
current documentation on your system: 建立文档

	an RST primer such as this one [http://sphinx.pocoo.org/rest.html] to learn
how you can start modifying the documentation content









Upgrading Server, Modules

The upgrade from version to version is automatic and doesn’t need any special
scripting on the user’s part. In fact, the server is able to automatically
rebuild the database and the data from a previously installed version.

The tables are rebuilt from the current module definitions. To rebuild the
tables, the server uses the definition of the objects and adds / modifies
database fields as necessary.

To invoke a database upgrade after installing a new version, you need to start
the server with the –update=all argument :

openerp-server.py --update=all





You can also only upgrade specific modules, for example:

openerp-server.py --update=account,base





The database is rebuilt according to information provided in XML files and
Python Classes.
You can also execute the server with –init=all. The server will then
rebuild the database according to the existing XML files on the system, delete
all existing data and return OpenERP to its basic configuration.


Detailed update operations

OpenERP has a built-in migration and upgrade system which allows updates to be nearly (or often) automatic.
This system also allows to easily include custom modules.


Table/Object structure

When you run openerp-server with option --init or --update, the table
structure is updated to match the new description that is in Python code. Fields
that are removed from Python code are not removed from the postgresql database
to avoid losing data.

So, simply running with --update or --init, will upgrade your table structure.

It’s important to run --init=module the first time you install the module.
Next time, you must use the --update=module argument instead of the init
one. This is because --init loads resources that are loaded only once and
never upgraded (i.e., resources with no id="" attribute or within a
<data noupdate="1"> tag). Resources with the noupdate attribute will still
be created if they do not exist at upgrade time. This can be overridden by marking
a record with forcecreate="False".




数据

Some data is automatically loaded at the installation of OpenERP:



	views, actions, menus,

	workflows,

	demo data






This data is also migrated to a new version if you run –update or –init.




工作流

Workflows are also upgraded automatically. If some activities are removed, the documents states evolves automatically to the preceding activities. That ensure that all documents are always in valid states.

You can freely remove activities in your XML files. If workitems are in this activity, they will evolve to the preceding unlinked activity. And after the activity will be removed.




开发过程中需要注意的事项

Since version 3.0.2 of OpenERP, you can not use twice the same ‘id=”...”’ during resource creation in your XML files, unless they are in two different modules.

Resources which don’t contain an id are created (and updated) only once; at the installation of the module or when you use the –init argument.

If a resource has an id and this resource is not present anymore in the next version of the XML file, OpenERP will automatically remove it from the database. If this resource is still present, OpenERP will update the modifications to this resource.

If you use a new id, the resource will be automatically created at the next update of this module.

Use explicit id declaration !, Example:



	view_invoice_form,

	view_move_line_tree,

	action_invoice_form_open, ...






It is important to put id=”....” to all record that are important for the next version migrations. For example, do not forget to put some id=”...” on all workflows transitions. This will allows OpenERP to know which transition has been removed and which transition is new or updated.




自定义模块

For example, if you want to override the view of an object named ‘invoice_form’ in your xml file (id=”invoice_form”). All you have to do is redefine this view in your custom module with the same id. You can prefix ids with the name of the module to reference an id defined in another module.

例子:


<record model=”ir.ui.view” id=”account.invoice_form”>
...
<record>


This will override the invoice form view. You do not have to delete the old view, like in 3.0 versions of OpenERP.

Note that it is often better to use view inheritance instead of overwriting views.

In this migration system, you do not have to delete any resource. The migration system will detect if it is an update or a delete using id=”...” attributes. This is important to preserve references during migrations.




演示数据

Demo data does not have to be upgraded; because it was probably modified or
deleted by users. To avoid demo data being upgraded you can put a
noupdate="1" attribute in the <data> tag of your .xml data files.






Summary of update and init process

init:


修改/添加/删除演示数据和内置数据


更新:


modify/add/delete non demo data


内置（非演示）数据例子:



	菜单结构,

	视图定义,

	工作流描述, ...

	Everything that has an id attribute in the XML data declaration (if no attr noupdate=”1” in the header)






What’s going on during the update process:



	
	If you manually added data within the client:

	
	the update process will not change them









	
	If you dropped data:

	
	if it was demo data, the update process will do nothing

	if it was built-in data (like a view), the update process will recreate it









	
	If you modified data (either in the .XML or the client):

	
	if it’s demo data: nothing

	if it’s built-in data, data are updated









	
	If built-in data have been deleted in the .XML file:

	
	this data will be deleted in the database.
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API 接口


使用Web服务（Working with Web Services）

鉴于OpenERP的架构,它不适合直接通过PostgreSQL客户端或者 ODBC 这样的连接方法访问数据库，
幸运的是,OpenERP提供了一个非常全面的web服务集，允许你通过标准协议做任何事情。


Note

虽然直接访问数据库，在技术上是可行的,你必须意识到这可能对您的数据造成灾难性的后果,除非你知道你是在做
什么。当你直接访问数据库的时候，建议您关闭OpenERP服务器，以避免缓存和并发问题。




支持的网络服务协议（Supported Web Services Protocols）

目前支持的协议是XML-RPC和Net-RPC。XML-RPC是用于Web服务的第一批标准之一，
几乎可以再任何语言中使用。这是一个非常详细的协议，而且在需要的时候可以引入潜在位。
另一方面，Net-RPC是一个优化的协议，特别用在Python编写的应用程序之间。.

对于REST风格的web服务的支持在将来的OpenErp发布包中支持。

对于SOAP协议，目前的OPenErp已经不再支持，但是如果在社区有足够的爱好者的话将来可能恢复。




可用的Web服务（Available Web Services）

OpenERP 为你提供了以下的Web服务.


Note

你能在服务的源码（/bin/service/web_services.py）的对应类里面找到每种服务的细节 .







	db:	提供函数创建、删除、备份、恢复数据库.
请谨慎使用!









	common:	让你登录和退出 OpenERP, 并且提供各种实用功能。你只有登录后才能使用其他的网络服务.









	object:	这是最有用的网络服务，因为通过它可以访问 OpenERP 对象.
值得注意的是, 函数 “execute” 让你调用对象的方法，
比如可以搜索的大部分的ORM方法，读写记录。它也可以用来调用价格计算等对象的其他方法.






Note

主要的 ORM 方法一览:


	create({‘field’:’value’})

	
	创建一个具有指定值的新纪录

	Returns: 新纪录的ID





	search([(‘arg1’,’=’,’value1’)...], offset=0, limit=1000)

	
	arg1, arg2, .. ,argN: 指定列表的搜索条件

	offset: 跳过的可选的记录

	limit: 返回的最大数量的记录

	Returns: 匹配给定条件的记录





	read([IDS], [‘field1’,’field2’,...])

	
	fields: 返回的字段名字（默认全部返回） (default: all fields)

	Returns: 每条记录的ID和请求字段的值





	write([IDS], {‘field1’:’value1’,’field2’:3})

	
	values: 更新的字段的值

	Updates 对给定的记录按照给定的值进行更新

	Returns: True





	unlink([IDS])

	
	按照给定的IDS删除记录

	Returns: True







通过 Web 服务不能使用 Browse() 函数.



另一个有用的功能是 “exec_workflow”, 它可以让你通过工作流制定记录的进展.





	向导:	





提供对旧式的向导。新风格的向导是基于ORM的，因此他们可以通过 “object” web 服务来进行访问.





	报告:	





让你生成和检索报告.




例子：通过Web服务写入数据（Example:writing data through the Web Service）

下面是一个写数据的例子程序。在下一章你会发现关于多种编程语言 XML-RPC的更详尽的例子.


	login: 在Web服务 “common” 中调用 “login” 函数，使用下面的参数:



	database

	user name

	password








	创建一个新的合作者: 在Web服务 “object” 中调用 “execute” 函数，使用下面的参数:



	database

	user id provided by “login” in step 1.

	the object name : ‘res.partner’

	the name of the ORM method : “create”

	some data to be recorded










上面提到的数据都是键值对, 比如:



	name: Fabien Pinckaers

	lang: fr_FR






但是更复杂的数据结构也可以发送。比如你可以在一个单一的Web服务调用中创建一个合作者
和他的地址。在那种情况下，所有的数据在服务的相同的数据库事务中来处理。这意味.
着你一定要保存好你的数据一致性的状态。这是对所有ERP应用的关键要求.






XML-RPC Web服务(XML-RPC Web Services)

XML-RPC 是一个著名的Web服务. Web 服务是一个工具，它可以再现有的网络基础设施上面设置分布式的应用程序。这些应用程序使用一种传输层的网络但是并不提供直接通过浏览器的人机界面。可扩展标记语言(XML)提供了描述远程过程调用(RPC)的词汇表，RPC是使用超文本传输协议（HTTP）      在计算机之间传输。实际上，RPC让各开发者自行定义网络调用中的接口。这些接口可以是很简单的一个函数调用也可以像大型API那样复杂.

XML-RPC 允许在两台或者更多运行不同操作系统和不同语言程序的计算机之间协同处理。比如，一个JAVA应用可以和一个Perl应用会谈，一个Perl应用可以同一个同ASP会谈的PYTHON应用会谈，等等。系统集成商往往在不同系统之间建立自己的连接，创建它们自己定义的格式的协议来进行通信，但是这造成了大量的不常使用的协议。RPC方法的程序员无需了解底层的协议、网络以及各种实施细则.

XML-RPC 可以同 Python, Java, Perl, PHP, C, C++, Ruby, Microsoft’s .NET 以及许多其他的编程语言来一起使用。它的实现被广泛用于 Unix, Linux, Windows 和 Macintosh 的平台.

一个 XML-RPC 调用实在双方之间进行的，客户端(调用程序)和服务器(被调用过程)。服务时提供在一个特定的URL上的，比如 (such as http://example.org:8080/rpcserv/).

上面我们只是接触了 XML-RPC 的表面. 我推荐 O’Reilly’s “Programming Web Service with XML-RPC” 进行进一步的学习。还可以阅读以下几个环节:


接口（InterFaces）


XML-RPC


XML-RPC 架构

OpenERP 基于C/S体系结构。服务器和客户端之间的通信使用XML-RPC协议。XML-RPC是一个非常简单的协议，它允许客户端进行远程过程调用。被调用的函数，它的参数，调用结果通过XML编码并且使用HTTP进行传输。欲了解更多的关于XML-RPC的详尽信息，请参阅: http://www.xml-rpc.com.




架构(Architecture)

下面的图标综合了OpenERP的客户端和服务器结构。OpenERP的服务器和客户端通信使用 XML-RPC.


[image: ../_images/tech_arch.png]


客户端

OpenERP 的逻辑是在服务器端配置的。客户端是很简单的，它是仅用于POST的数据(forms, lists, trees)并且把结果发回服务器。新功能的更新和加入并不需要客户端的升级，这使得OpenERP更容易维护.

客户端并不明白POST的内容。即使像点击打印图标的行动时发送到服务器并且询问如何作出反应.

客户端的操作时很简单的，当客户发出一个动作（保存一个表格、打开一个目录、打印…）它发送动作到服务器。然后服务器执行客户端的请求并将结果发送回来.

下面是三种行为;



	Open a window (form or tree)

	Print a document

	Execute a wizard











Python


通过 xml-rpc 获取数据


代码示例



	创建一个合作伙伴和他的地址







import xmlrpclib

username = 'admin' # OpenERP 登陆用户
pwd = 'admin'      # 登陆密码
dbname = 'terp'    # OpenERP 帐套

# Get the uid
sock_common = xmlrpclib.ServerProxy ('http://localhost:8069/xmlrpc/common')
uid = sock_common.login(dbname, username, pwd)

#replace localhost with the address of the server
sock = xmlrpclib.ServerProxy('http://localhost:8069/xmlrpc/object')

partner = {
   'name': 'Fabien Pinckaers',
   'lang': 'fr_FR',
}

partner_id = sock.execute(dbname, uid, pwd, 'res.partner', 'create', partner)

address = {
   'partner_id': partner_id,
   'type' : 'default',
   'street': 'Chaussée de Namur 40',
   'zip': '1367',
   'city': 'Grand-Rosière',
   'phone': '+3281813700',
   'fax': '+3281733501',
}

address_id = sock.execute(dbname, uid, pwd, 'res.partner.address', 'create', address)









	查询业务伙伴

args = [('vat', '=', 'ZZZZZZ')] # 查询过滤条件
ids = sock.execute(dbname, uid, pwd, 'res.partner', 'search', args)







	读取业务伙伴数据

fields = ['name', 'active', 'vat', 'ref'] # 需要读取的数据字段
data = sock.execute(dbname, uid, pwd, 'res.partner', 'read', ids, fields) #ids is a list of id







	更新业务伙伴数据

values = {'vat': 'ZZ1ZZZ'} # 待更新数据Dictionary
result = sock.execute(dbname, uid, pwd, 'res.partner', 'write', ids, values)







	删除业务伙伴

# ids : 待删除业务伙伴id列表
result = sock.execute(dbname, uid, pwd, 'res.partner', 'unlink', ids)
















PHP


通过 xml-rpc 获取数据

下载 XML-RPC PHP Library

windows / linux: 从 http://phpxmlrpc.sourceforge.net/ 上下载xmlrpc框架，目前最新的正式版本是2007年2月25日发行的2.2版本

配置 PHP XML-RPC Library

从xmlrpc-2.2.tar.gz 解压出xmlrpc.inc 文件，把这个文件放到php函数库文件夹中,重启apache/iis 服务器

代码示例


	登陆OpenERP



function connect() {
   var $user = 'admin';
   var $password = 'admin';
   var $dbname = 'db_name';
   var $server_url = 'http://localhost:8069/xmlrpc/';

   if(isset($_COOKIE["user_id"]) == true)  {
       if($_COOKIE["user_id"]>0) {
       return $_COOKIE["user_id"];
       }
   }

   $sock = new xmlrpc_client($server_url.'common');
   $msg = new xmlrpcmsg('login');
   $msg->addParam(new xmlrpcval($dbname, "string"));
   $msg->addParam(new xmlrpcval($user, "string"));
   $msg->addParam(new xmlrpcval($password, "string"));
   $resp =  $sock->send($msg);
   $val = $resp->value();
   $id = $val->scalarval();
   setcookie("user_id",$id,time()+3600);
   if($id > 0) {
       return $id;
   }else{
       return -1;
   }
 }






	查询业务伙伴



/**
 * $client = xml-rpc handler
 * $relation = name of the relation ex: res.partner
 * $attribute = name of the attribute ex:code
 * $operator = search term operator ex: ilike, =, !=
 * $key=search for
 */

function search($client,$relation,$attribute,$operator,$keys) {
     var $user = 'admin';
     var $password = 'admin';
     var $userId = -1;
     var $dbname = 'db_name';
     var $server_url = 'http://localhost:8069/xmlrpc/';

     $key = array(new xmlrpcval(array(new xmlrpcval($attribute , "string"),
              new xmlrpcval($operator,"string"),
              new xmlrpcval($keys,"string")),"array"),
        );

     if($userId<=0) {
     connect();
     }

     $msg = new xmlrpcmsg('execute');
     $msg->addParam(new xmlrpcval($dbname, "string"));
     $msg->addParam(new xmlrpcval($userId, "int"));
     $msg->addParam(new xmlrpcval($password, "string"));
     $msg->addParam(new xmlrpcval($relation, "string"));
     $msg->addParam(new xmlrpcval("search", "string"));
     $msg->addParam(new xmlrpcval($key, "array"));

     $resp = $client->send($msg);
     $val = $resp->value();
     $ids = $val->scalarval();

     return $ids;
}






	创建业务伙伴



<?

include('xmlrpc.inc');

$arrayVal = array(
'name'=>new xmlrpcval('Fabien Pinckaers', "string") ,
'vat'=>new xmlrpcval('BE477472701' , "string")
);

$client = new xmlrpc_client("http://localhost:8069/xmlrpc/object");

$msg = new xmlrpcmsg('execute');
$msg->addParam(new xmlrpcval("dbname", "string"));
$msg->addParam(new xmlrpcval("3", "int"));
$msg->addParam(new xmlrpcval("demo", "string"));
$msg->addParam(new xmlrpcval("res.partner", "string"));
$msg->addParam(new xmlrpcval("create", "string"));
$msg->addParam(new xmlrpcval($arrayVal, "struct"));

$resp = $client->send($msg);

if ($resp->faultCode())

    echo 'Error: '.$resp->faultString();

else

    echo 'Partner '.$resp->value()->scalarval().' created !';

?>






	更新业务伙伴数据



/**
 * $client = xml-rpc handler
 * $relation = name of the relation ex: res.partner
 * $attribute = name of the attribute ex:code
 * $operator = search term operator ex: ilike, =, !=
 * $id = id of the record to be updated
 * $data = data to be updated
 */

function write($client,$relation,$attribute,$operator,$data,$id) {
     var $user = 'admin';
     var $password = 'admin';
     var $userId = -1;
     var $dbname = 'db_name';
     var $server_url = 'http://localhost:8069/xmlrpc/';

     $id_val = array();
     $id_val[0] = new xmlrpcval($id, "int");

     if($userId<=0) {
     connect();
     }

     $msg = new xmlrpcmsg('execute');
     $msg->addParam(new xmlrpcval($dbname, "string"));
     $msg->addParam(new xmlrpcval($userId, "int"));
     $msg->addParam(new xmlrpcval($password, "string"));
     $msg->addParam(new xmlrpcval($relation, "string"));
     $msg->addParam(new xmlrpcval("write", "string"));
     $msg->addParam(new xmlrpcval($id, "array"));
     $msg->addParam(new xmlrpcval($data, "struct"));

     $resp = $client->send($msg);
     $val = $resp->value();
     $record = $val->scalarval();

     return $record;

}










JAVA


通过 xml-rpc 获取数据

下载 JAVA XML-RPC Library

从 http://ws.apache.org/xmlrpc/ 上下载java xmlrpc框架，目前最新版本是2007年8月发布的3.1版本.
All OpenERP errors throw exceptions because the framework allows only an int as the error code where OpenERP returns a string.

代码示例


	获取OpenERP帐套列表



import java.net.URL;
import java.util.Vector;

import org.apache.commons.lang.StringUtils;
import org.apache.xmlrpc.XmlRpcException;
import org.apache.xmlrpc.client.XmlRpcClient;
import org.apache.xmlrpc.client.XmlRpcClientConfigImpl;

public Vector<String> getDatabaseList(String host, int port)
{
  XmlRpcClient xmlrpcDb = new XmlRpcClient();

  XmlRpcClientConfigImpl xmlrpcConfigDb = new XmlRpcClientConfigImpl();
  xmlrpcConfigDb.setEnabledForExtensions(true);
  xmlrpcConfigDb.setServerURL(new URL("http",host,port,"/xmlrpc/db"));

  xmlrpcDb.setConfig(xmlrpcConfigDb);

  try {
    //Retrieve databases
    Vector<Object> params = new Vector<Object>();
    Object result = xmlrpcDb.execute("list", params);
    Object[] a = (Object[]) result;

    Vector<String> res = new Vector<String>();
    for (int i = 0; i < a.length; i++) {
    if (a[i] instanceof String)
    {
      res.addElement((String)a[i]);
    }
  }
  catch (XmlRpcException e) {
    logger.warn("XmlException Error while retrieving OpenERP Databases: ",e);
    return -2;
  }
  catch (Exception e)
  {
    logger.warn("Error while retrieving OpenERP Databases: ",e);
    return -3;
  }
}






	登陆



import java.net.URL;

import org.apache.commons.lang.StringUtils;
import org.apache.xmlrpc.XmlRpcException;
import org.apache.xmlrpc.client.XmlRpcClient;
import org.apache.xmlrpc.client.XmlRpcClientConfigImpl;

public int Connect(String host, int port, String tinydb, String login, String password)
{
  XmlRpcClient xmlrpcLogin = new XmlRpcClient();

  XmlRpcClientConfigImpl xmlrpcConfigLogin = new XmlRpcClientConfigImpl();
  xmlrpcConfigLogin.setEnabledForExtensions(true);
  xmlrpcConfigLogin.setServerURL(new URL("http",host,port,"/xmlrpc/common"));

  xmlrpcLogin.setConfig(xmlrpcConfigLogin);

  try {
    //Connect
    params = new Object[] {tinydb,login,password};
    Object id = xmlrpcLogin.execute("login", params);
    if (id instanceof Integer)
      return (Integer)id;
    return -1;
  }
  catch (XmlRpcException e) {
    logger.warn("XmlException Error while logging to OpenERP: ",e);
    return -2;
  }
  catch (Exception e)
  {
    logger.warn("Error while logging to OpenERP: ",e);
    return -3;
  }
}






	查询业务伙伴

TODO







	创建业务伙伴

TODO







	更新业务伙伴

TODO
















Python 代码示例

创建合作伙伴和他们的地址的例子.

import xmlrpclib

sock = xmlrpclib.ServerProxy('http://localhost:8069/xmlrpc/object')
uid = 1
pwd = 'demo'

partner = {
    'title': 'Monsieur',
    'name': 'Fabien Pinckaers',
    'lang': 'fr',
    'active': True,
}

partner_id = sock.execute(dbname, uid, pwd, 'res.partner', 'create', partner)

address = {
    'partner_id': partner_id,
    'type': 'default',
    'street': 'Rue du vieux chateau, 21',
    'zip': '1457',
    'city': 'Walhain',
    'phone': '(+32)10.68.94.39',
    'fax': '(+32)10.68.94.39',
}

sock.execute(dbname, uid, pwd, 'res.partner.address', 'create', address)





用下面的脚本来获得用户的 UID :

sock = xmlrpclib.ServerProxy('http://localhost:8069/xmlrpc/common')
 UID = sock.login('terp3', 'admin', 'admin')





CRUD(创建/读取/更新/删除)代码示例:

"""
:The login function is under
::    http://localhost:8069/xmlrpc/common
:For object retrieval use:
::    http://localhost:8069/xmlrpc/object
"""
import xmlrpclib

user = 'admin'
pwd = 'admin'
dbname = 'terp3'
model = 'res.partner'

sock = xmlrpclib.ServerProxy('http://localhost:8069/xmlrpc/common')
uid = sock.login(dbname ,user ,pwd)

sock = xmlrpclib.ServerProxy('http://localhost:8069/xmlrpc/object')

# CREATE A PARTNER
partner_data = {'name'.. code-block:: php:'Tiny', 'active':True, 'vat':'ZZZZZ'}
partner_id = sock.execute(dbname, uid, pwd, model, 'create', partner_data)

# The relation between res.partner and res.partner.category is of type many2many
# To add  categories to a partner use the following format:
partner_data = {'name':'Provider2', 'category_id': [(6,0,[3, 2, 1])]}
# Where [3, 2, 1] are id fields of lines in res.partner.category

# SEARCH PARTNERS
args = [('vat', '=', 'ZZZZZ'),]
ids = sock.execute(dbname, uid, pwd, model, 'search', args)

# READ PARTNER DATA
fields = ['name', 'active', 'vat', 'ref']
results = sock.execute(dbname, uid, pwd, model, 'read', ids, fields)
print results

# EDIT PARTNER DATA
values = {'vat':'ZZ1ZZ'}
results = sock.execute(dbname, uid, pwd, model, 'write', ids, values)

# DELETE PARTNER DATA
results = sock.execute(dbname, uid, pwd, model, 'unlink', ids)





PRINT(打印) 示例代码:



	打印发票

	IDS is the invoice ID, as returned by:

	ids = sock.execute(dbname, uid, pwd, ‘account.invoice’, ‘search’, [(‘number’, ‘ilike’, invoicenumber), (‘type’, ‘=’, ‘out_invoice’)])






import time
import base64
printsock = xmlrpclib.ServerProxy('http://server:8069/xmlrpc/report')
model = 'account.invoice'
id_report = printsock.report(dbname, uid, pwd, model, ids, {'model': model, 'id': ids[0], 'report_type':'pdf'})
time.sleep(5)
state = False
attempt = 0
while not state:
    report = printsock.report_get(dbname, uid, pwd, id_report)
    state = report['state']
    if not state:
    time.sleep(1)
    attempt += 1
    if attempt>200:
    print 'Printing aborted, too long delay !'

    string_pdf = base64.decodestring(report['result'])
    file_pdf = open('/tmp/file.pdf','w')
    file_pdf.write(string_pdf)
    file_pdf.close()








PHP 代码示例

下面的例子是如何使用 PHP 创建一个合作伙伴. 这里使用 phpxmlrpc 库, 在 sourceforge 上有效.

<?

    include('xmlrpc.inc');

    $arrayVal = array(
    'name'=>new xmlrpcval('Fabien Pinckaers', "string") ,
    'vat'=>new xmlrpcval('BE477472701' , "string")
    );

    $client = new xmlrpc_client("http://localhost:8069/xmlrpc/object");

    $msg = new xmlrpcmsg('execute');
    $msg->addParam(new xmlrpcval("dbname", "string"));
    $msg->addParam(new xmlrpcval("3", "int"));
    $msg->addParam(new xmlrpcval("demo", "string"));
    $msg->addParam(new xmlrpcval("res.partner", "string"));
    $msg->addParam(new xmlrpcval("create", "string"));
    $msg->addParam(new xmlrpcval($arrayVal, "struct"));

    $resp = $client->send($msg);

    if ($resp->faultCode())

        echo 'Error: '.$resp->faultString();

    else

        echo 'Partner '.$resp->value()->scalarval().' created !';

    ?>








Perl 代码示例

下面的例子是使用 Perl 创建、查找、删除一个合作伙伴.

#!c:/perl/bin/perl
# 17-02-2010
# OpenERP XML RPC communication example
# Todor Todorov <todorov@hp.com> <tttodorov@yahoo.com>

use strict;
use Frontier::Client;
use Data::Dumper;

my($user) = 'admin';
my($pw) = 'admin';
my($db) = 'put_your_dbname_here';
my($model) = 'res.partner';

#登录
my $server_url = 'http://localhost:8069/xmlrpc/common';
my $server = Frontier::Client->new('url' => $server_url);
my $uid = $server->call('login',$db,$user,$pw);

print Dumper($uid);

my $server_url = 'http://localhost:8069/xmlrpc/object';
my $server = Frontier::Client->new('url' => $server_url);

print Dumper($server);

#
# 创建合作伙伴
#
my $partner_data = {'name'=>'MyNewPartnerName',
                  'active'=> 'True',
          'vat'=>'ZZZZZ'};
my $partner_id = $server->call('execute',$db, $uid, $pw, $model, 'create', $partner_data);

print Dumper($partner_id);

#
# 搜索合作伙伴
#
my $query = [['vat', '=', 'ZZZZZ']];

print Dumper($query);

my $ids = $server->call('execute',$db, $uid, $pw, $model, 'search', $query);

print Dumper($ids);

#这里等待用户输入
#OpenERP interface my be checked if partner is shown there

print $/."Check OpenERP if partner is inserted. Press ENTER".$/;
<STDIN>;

#
# 删除合作伙伴
#
my $results = $server->call('execute',$db, $uid, $pw, $model, 'unlink', $ids);

print Dumper($results);





在 OpenERP 的 GTK 或 web 客户端的一切活动都是通过 XML/RPC webservices. 启动 openERP GTK 客户端
使用 ./openerp-client.py -l debug_rpc (or debug_rpc_answer) 然后你可以在 GTK 客户端操作，查看客户端操作日志，
你将看到webservice的标签。通过在日志中创建缩进将帮助您
找出它的web服务.
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构建安装程序包和安装

这个页面描述了如果在windows平台下搭建指定版本的OpenERP


构建


关联性

第一步是建立关联性。要建立关联性，要抓取 Windows 安装分支:

bzr branch lp:~openerp-groupes/openerp/win-installer-trunk





然后安装以下程序包:



	7z465.msi

	python-2.5.2.msi

	setuptools-0.6c9.win32-py2.5.exe

	Beaker-1.4.1.tar.gz

	Mako-0.2.4.tar.gz

	pytz-2010l.win32.exe







服务器

安装以下程序包:



	lxml-2.1.2.win32-py2.5.exe

	PIL-1.1.6.win32-py2.5.exe

	psycopg2-2.2.2.win32-py2.5-pg9.0.1-release.exe

	PyChart-1.39.win32.exe

	pydot-1.0.2.win32.exe

	python-dateutil-1.5.tar.gz

	pywin32-212.win32-py2.5.exe

	PyYAML-3.09.win32-py2.5.exe

	ReportLab-2.2.win32-py2.5.exe









网页

安装以下程序包:



	Babel-0.9.4-py2.5.egg

	CherryPy-3.1.2.win32.exe

	FormEncode-1.2.2.tar.gz

	simplejson-2.0.9-py2.5-win32.egg

	xlwt-0.7.2.win32.exe











来源配置

第二步是在 Linux 上建构一个来源配置


服务器

假设你是要用你自己的服务器建构，版本名称 6.0 ，而且想用以下的模块建构服务器:



	base_setup

	base_tools

	board






这表示这些模块已经用类似以下的指令连结到 bin/addons

ln -s ~/openerp/addons/6.0/{base_setup,base_tools,board} .





要建构服务器，到根目录输入:

python setup.py sdist --format=zip






	现在在 dist 目录里新增了一个文件，名为 openerp-server-M.m.P.zip ，这里的:

	
	M 是主版次编号，例如 6

	m 是次要版次编号，例如 0

	p 是补丁版次编号，例如 1










网页

要建构网页客户端，到根目录输入:

python setup.py sdist --format=zip






	现在在 dist 目录里新增了一个文件，名为 openerp-web-M.m.P.zip ，这里的:

	
	M 是主版次编号，例如 6

	m 是次要版次编号，例如 0

	p 是补丁版次编号，例如 1












Binary distribution

第三步是建构一个 Windows 规格的安装程序包


服务器

开启一个指令提示行， 解压缩以下文件

7z x openerp-server-M.m.P.zip -oC:\openerp





移到 win32 文件夹

cd C:\openerp\openerp-server-M.m.P\win32





用以下指令建立一个服务程序

python setup.py py2exe





移到上一层文件夹

cd ..





用以下指令建立一个服务程序

python setup.py py2exe





用以下指令建立一个 Windows 安装包

makensis setup.nsi





现在在根文件夹有一个新文件，名为 openerp-server-setup-M.m.P.exe。 这个文件就是安装定制版本 OpenERP 的安装程序包。




网页

开启一个指令提示行， 解压缩以下文件

7z x openerp-web-M.m.P.zip -oC:\openerp





移到 win32 文件夹

cd C:\openerp\openerp-web-M.m.P\win32





用以下指令建立一个服务程序

python setup.py py2exe





移到上一层文件夹

cd ..





用以下指令建立一个网页程序

python setup.py py2exe





用以下指令建立一个 Windows 安装包

makensis setup.nsi





现在在根文件夹有一个新文件，名为 openerp-web-setup-M.m.P.exe。 这个文件就是安装定制版本 OpenERP 的安装程序包。








安装

这一页在说明如何是在 Windows 里安装定制版本的 OpenERP 。


安装包脚本

第一步是要抓取安装包脚本分支

bzr branch lp:~openerp-groupes/openerp/package-script








批次执行档

移到这个分支的 packaging 文件夹，把 build.bat 复制到 Widnows 电脑的 C:\openerp 文件夹里。




SSH 服务器

你需要在 Windows 电脑上安装 SSH 服务器，例如 freeSSHd [http://www.freesshd.com/]。




Fabric

你需要安装 Fabric [http://docs.fabfile.org/0.9.3/] 这个工具，才能让 Linux 透过 SSH 连上这台电脑， 并且执行命令。参照你的 Linux 套装管理员进行安装。


设定

到分支里的 packaging 文件夹，依照需要修改 fabfile.py 文件。

运行
+++

输入以下指令

fab -H host -u user server






	这里的 :

	
	host 是 Windows 主机名称

	user 是 Windows 使用者名称
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附录


约定事项


指南

关于 OpenERP 模块的开发指南和一般建议，
请参阅 贡献 文件里的
指南




模块结构和文件名称

模块的结构应该如下:

/module/

    /__init__.py
    /__openerp__.py
    /module.py
    /module_other.py
    /module_view.xml
    /module_data.xml
    /module_demo.xml

    /wizard/
    /wizard/__init__.py
    /wizard/wizard_name.py

    /report/
    /report/
    /report/__init__.py
    /report/report_name.sxw
    /report/report_name.rml
    /report/report_name.py








命名方式约定



	
	模块: 模块名称应该使用下划线(_)，加上小写字母。模块的名称就是服务器上插件所在的路径名称。如果某个模块依赖其他的模块，你可以用最重要的模块作为名称的开始，把其他几个模块的名称用下划线分别串起来。例如:

	
	sale

	sale_commission









	
	物件: 物件的名称必须依照以下的形式 模块名称.物件名称1.物件名称2.物件名称3.... 物件名称i 的排列顺序必须是由最重要的到最不重要的，由左到右，而且要是小写字母。尽量不要在物件名称里使用复数形式，同时要避免在名称里使用捷径。例如:

	
	sale.order

	sale.order.line

	sale.shop

	sale_commission.commission.rate









	
	字段: 字段必须是小写，加上分隔的下划线。尽量使用一般常用的字段名称，例如：name, state, active, partner_id, 等等。字段名称是依据字段的属性来约定的:

	
	多对一: 必须在结尾加上 ‘_id’ (例如: partner_id, order_line_id)

	多对多: 必须在结尾加上’_ids’ (例如: category_ids)

	一对多: 必须在结尾加上’_ids’ (例如: line_ids)



















翻译

OpenERP 是多语言的。你想要加进多少种语言都没问题。每个用户都可以用他自己的语言作为工作界面，而且某些资源 (报表的内容，产品名称等等) 也可以翻译成想要的语言。

这一段说明了如何改变每个用户看到的语言，以及如何在 OpenERP 里新增语言。

几乎所有在使用界面里用到的标签都有储存在服务器上，同样的，标签的翻译也都有储存在服务器上。服务器的预设值是把英文的字典储存在服务器上，所以如果用户想要尝试除了英文以外的语言，这些语言的定义(字典)必须要储存在服务器上。

然而，要把 “所有的东西” 存在服务器上是不可能的。实际上，在连上服务器 之前 ，一定会有一些文字显示在某些菜单，按键等等使用者界面上，这些为数不多的文字和句子是使用 GETTEXT 来翻译的；系统预设会依照用户(连上服务器的)电脑的语言来翻译以上的文字和句子。

OpenERP 的翻译系统不限于使用界面的文字；它对报表及某些数据库里的字段 “内容” 同样有效。显然并非所有的数据库字段都需要翻译，所以如果字段内容需要是多语言的，这个字段会有一个旗标图标作为标示。


如何变更用户使用界面的语言？

用户可以设定偏好的语言。当前用户要改变语言设定，在菜单上按：用户 > 偏好选项。

系统管理员也可以在菜单里修改用户的偏好语言(包含用户的使用界面语言)：系统管理 > 用户群 > 用户群。系统管理员只需要选择一个用户，然后切换 “偏好选项” ，就可以完成偏好语言的修改。




在服务器上储存翻译文件

用以下的指令上传包含翻译内容的文件 :


./openerp_server.py –i18n-import=file.csv -l LANG


这里的 LANG 是以 CVS 格式保存的文件，存有这个语言的翻译资料。

注意，翻译的文件内容必须使用 UTF8 编码!




翻译成新的语言

请时刻记得，对于相同的资源要使用相同的翻译词句     。在 Launchpad 线上翻译里，可以找到一些有用的提示。

在以下这个网站上可以找到更多关于翻译加速器的资讯:
http://translate.sourceforge.net/wiki/guide/translation/accelerators

想要翻译成某种语言，或是想要修改某个语言的翻译内容，必须依照以下步奏:


1. 把要翻译的所有词句输出到 CSV 文件

使用以下指令输出这个文件:


./openerp_server.py –i18n-export=file.csv -l**LANG**


这里的 LANG 是你想翻译的标的语言。




2. 翻译文件的最后一列

你可以制作某个语言的翻译文件，不论这个语言是已经被翻译过的还是一个新的语言。如果你处理的是一个已经翻译过的语言，以前翻译好的词句应该要写在最后一列。

例如，以下是某个翻译文件(荷兰语)的前几行:










	type
	name
	res_id
	src
	value


	field
	“account.account,code”
	0
	Code
	Code


	field
	“account.account,name”
	0
	Name
	Name


	model
	“account.account,name”
	2
	Assets
	Aktiva


	model
	“account.account,name”
	25
	Results
	Salden


	model
	“account.account,name”
	61
	Liabilities
	Verbindlichkeiten








3. 把这个文件导入 OpenERP (如同前一节所说明的)

注释



	你应该要在一个空的数据库里进行这些工作，以免覆盖到其他资料。






用以下的指令创建一个新的数据库 (名为 ‘terp_test’):


createdb terp_test –encoding=unicode
terp_server.py –database=terp_test –init=all


或者，你也可以用以下的指令删除你当前的数据库 :


dropdb terp
createdb terp –encoding=unicode
terp_server.py –init=all





4. 采用 Launchpad / Rosetta 来翻译模块和应用程序

以下的链接是一个很好的开始 https://launchpad.net/openobject

线上翻译

选择模块翻译的段落，输入你的翻译。

离线翻译

如果你想一次性翻译100个名词，就采用离线翻译的方式。

要成功的完成翻译的一个周期，必须严格遵守以下的步奏。 (在 Linux 上测试的结果)



	从 Launchpad 下载 <po 文件> 。



	
	从 bzr 分支找到模板文件 <pot 文件>

	
	记得 <pot 文件> 不一定会包含所有字串，因为 <pot 文件> 是不定期更新的。

	msgmerge <pot 文件> <po 文件> -o <新 po 文件>









	
	采用 poedit, kbabel (KDE) 翻译 <新 po 文件>

	
	有些程序 (例如 kbabel) 可以用字典进行大略的翻译。



	
	有一个特别有用的做法，就是从现有的翻译中创建一个完整的字典，以便能重复使用与应用程序相关的现有词汇。

	
	在 OpenERP 里载入全部或是大部分的模块

	载入你的语言

	将你的语言的全部模块输出成 po 文件，然后把这个文件当成是字典。依据模块内容的不同，这个做法可以产生准确度 30-80% 的翻译。

















	
	<新 po 文件> 一定不可以有 kbabel 大略翻译产生的 <模糊> 叙述

	
	grep -v fuzzy <新 po 文件> > <po 文件>









	
	检查拼字是否正确

	
	msgfmt <po 文件> -o <mo 文件>









	
	检查翻译的连贯性

	
	导入 (模块的) <po 文件>

	安装 <mo 文件> ，然后重启应用程序









	
	调整 OpenERP 里的线上翻译

	
	检查连贯性

	检查字串的长度

	输出 <po 文件>









	
	把 <po 文件> 上传到 Launchpad

	
	记住 Launchpad / Rosetta 会抓取某些 (不确定是哪些) 藏在输出文件 <po 文件> 标头段落的标签，来判别导入的 <po 文件> 是否有效。

	一段时间 (几小时) 后， 你会收到一封 E-Mail ， 确认结果是成功还是有错误。



















采用上下文词典进行翻译

上下文词典在以下段落有详细说明 “物件 - 方法 - 上下文词典”. 如果使用管理菜单安装新增加语言，上下文词典里会新增加一个主要 : 语言 。例如，如果安装了法语，而且设置为当前使用者的语言，使用者的上下文词典里会新增加一个主要语言，而且这个主要语言会被连结到 fr_FR 这个值上。






技术备忘录

技术备忘录，通常被昵称为 “欺骗表(cheat sheet)”，是 OpenERP 开发人员的快速参考指南。


	[image: t] [http://doc.openerp.com/memento] 技术备忘录 [http://doc.openerp.com/memento]



技术备忘录一般是每个 OpenERP 的 主要版次 更新，而且包含了 OpenERP 的程序编程界面(API)的全体概览；
其中有模块的宣告， ORM，XML 语法，动态视窗和工作流程。备忘录并不是一个广泛的参考，而是一个快速找到存取或使用某些 OpenERP 功能的指南。
所以每个主题都只有一小段叙述，通常还附带一个小范例。

在技术备忘录里的范例全部是来自范例模块 idea ；这个模块可以让一个组织管理成员提交的一般 ideas(想法) 。

备忘录有2种版本，第一种是适合A4横向打印，每一页有3个栏位的文字，整个备忘录只有不到 20 迷你页 (栏位)。
这种设计是为了把这些页打印出来装订在一起，变成参考手册。
第二种版本包含了许多细节资讯，依照A4纵向排版，这样比较容易阅读内容，但是尺寸大些。

所有版次的技术备忘录 (包含以前的版次) ，都可以在这里找到 : [image: t] [http://doc.openerp.com/memento] 技术备忘录 [http://doc.openerp.com/memento]




信息库

信息库是一种树状结构的语义描述方式，用于描述所储存的资料，而不是资源。 信息库的结构如下:



	预设的值



	
	有条件的值；

	
	州（省）取决于邮编，

	付款方法取决于伙伴，









	
	事件客户端的反应动作；

	
	滑鼠在请款单菜单上单击，

	打印一份请款单，

	对一个伙伴的动作， ...














信息库(IR)有 3 个物件方法；



	在语义树里增加值

	在语义树里删除值

	在一个选定表单里取得所有值







设定数值

ir_set（信息库_设置） 标签让你能在 “信息库” 里新增数值。 这个标签必须包含数个 字段（field） 标签，这些字段标签要具备 name 及 eval
属性。

这些属性是依据存取信息库的方法定义的；我们必须在提供标签时设置以下属性：keys, args, name, value, isobject, replace, meta, 和其他一些可选的属性。

范例:

<ir_set>
    <field name="keys" eval="[('action','client_print_multi'),('res_model','account.invoice')]"/>
    <field name="args" eval="[]"/>
    <field name="name">Print Invoices</field>
    <field name="value" eval="'ir.actions.report.xml,'+str(l0)"/>
    <field name="isobject" eval="True"/>
    <field name="replace" eval="False"/>
</ir_set>








信息库物件方法

def ir_set(cr, uid, key, key2, name, models, value, replace=True, isobject=False, meta=None)





def ir_get(cr, uid, key, key2, models, meta=False, context={}, res_id_req=False)





def ir_del(cr, uid, id):









	字段描述:	







	key:

	key2:

	name:

	models):

	value:

	isobject:

	replace: 所描述的动作是否应该覆盖现有的动作， 或是应该被加到现在的动作清单里。

	meta:










	使用 ir_set 和 ir_get:

		





...

    res = ir.ir_set(cr, uid, key, key2, name, models, value, replace, isobject, meta)

...

...

    if not report.menu_id:

        ir.ir_set(cr, uid, 'action', 'client_print_multi', name, [(model, False)], action, False, True)

    else:

        ir.ir_set(cr, uid, 'action', 'tree_but_open', 'Menuitem', [('ir.ui.menu', int(m_id))], action, False, True)

...

...

    res = ir.ir_get(cr, uid, [('default', self._name), ('field', False)], [('user_id',str(uid))])

...

    account_payable = ir.ir_get(cr, uid, [('meta','res.partner'), ('name','account.payable')], opt)[0][2]

...
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开发平台


Launchpad站点及 bazaar工具

在你给launchpad提交贡献之前，你需要先去launchpad注册并登陆，同时也是你提交代码及你自己的开发分支。URL: https://launchpad.net

输入你的Email地址，并在收到一封确认邮件并完成相关注册步骤。

在 https://help.launchpad.net/YourAccount/NewAccount 完成:

每个希望成为提交者的贡献者必须先证明他对OpenERP项目的热情和能力。可以通过以下
活动来证明：在我们的 :ref:`bug tracker <bug-tracker-link>`系统上提交bug或新功
能，甚至新的模块。

你可以在 https://help.launchpad.net/Teams/Joining 加入一些开发团队。

Contributors are people who want to help the project improve, add
functionality and improve stability. Anyone can contribute to the project
by reporting bugs, proposing improvements and
posting patches.

OpenERP 社区团队地址: https://launchpad.net/~openerp-community

社区 组的用户也自动成为 质量 与 提交 组的成员.

第一次配置时，还需要使用 Bazaar 版本控制从 Launchpad 获取源代码。

NoteThib: viré les explications sur comment installer bazaar, je propos de mettre le lien vers le site qui expliquera comment l’installer si besoin est

当你遇到关于 Bazaar 的使用问题前, 请参阅 Bazaar 版本控制的常见问题(F.A.Q) .




工作分支

The combination of Bazaar branch hosting and Launchpad’s teams infrastructure gives you a very powerful capability to collaborate on code. Essentially, you can push a branch into a shared space and anyone on that team can then commit to the branch.

This means that you can use Bazaar in the same way that you would use something like SVN, i.e. centrally hosting a branch that many people commit to. You have the added benefit, though, that anyone outside the team can always create their own personal branch of your team branch and, if they choose, upload it back to Launchpad.

This is the official and proposed way to contribute on OpenERP and OpenObject.


快捷参考

获取最新源码及创建你自己的OpenERP分支，可以按下面的命令操作:

mkdir openerp
cd openerp
bzr branch lp:~openerp/openobject-server/trunk server
bzr branch lp:~openerp/openobject-addons/trunk addons
bzr branch lp:~openerp-commiter/openobject-addons/trunk-extra-addons addons-extra
bzr branch lp:~openerp-community/openobject-addons/trunk-addons-community addons-community
bzr branch lp:~openerp/openerp-web/trunk web
bzr branch lp:~openerp/openobject-client/trunk client
bzr branch lp:~openerp-community/openobject-doc/6.1 doc





这些命令将下载运行 OpenERP 的所有的源码包含(server, client, addons), 接下来,将 addons 文件夹软链到 server addons 文件夹下,就可以直接使用 addons 中的所有业务模块了. 现在你可以修改 bzr_set.py 中代码源为你本地地址, 并可以开始编辑代码, 提交代码到你自己的本地代码分支.

EDIT addons/account/account.py
cd addons
bzr ci -m "Testing Modifications"





Once your code is good enough and follow the 编程指引, you
can push your branch to launchpad. You may have to create an account on
launchpad first, register your public key, and subscribe to the openerp-community [https://launchpad.net/~openerp-community] team. Then, you
can push your branch. Suppose you want to push your addons:

cd addons
bzr push lp:~openerp-community/openobject-addons/YOURLOGIN_YOURBRANCHNAME
bzr bind lp:~openerp-community/openobject-addons/YOURLOGIN_YOURBRANCHNAME





After having done that, your branch is public on Launchpad, in the OpenObject
project [https://code.launchpad.net/openobject], and committers can work on
it, review it and propose for integration in the official branch. The last line
allows you to rebind your branch to the one on launchpad, after having
done this, your commit will be applied on launchpad directly (unless you use --local):

bzr pull    # Get modifications on your branch from others
EDIT STUFF
bzr ci    # commit your changes on your public branch





如果你是针对某个公开BUG的修正提交，你可以在提交给你自己分支的时候提交一个bug的ID标记:

bzr ci --fixes=lp:453123   # Where 453123 is a bug ID





Once your branch is mature, mark it as mature in the web interface of launchpad
and request for merging in the official release. Your branch will be reviewed
by a committer and then the quality team to be merged into the official release.

[更多请参见:ref:OpenERP 团队 <openerp-team>]




发布一个新分支

If you want to contribute on OpenERP or OpenObject, here is the proposed method:



	You create a branch on launchpad on the project that interests you. It’s
important that you create your branch on launchpad and not on your local
system so that we can easily merge, share code between projects and
centralize future developments.

	You develop your own features or bugfixes
in your own branch on launchpad. Don’t forget to set the status of your
branch (new, experimental, development, mature, ...) so that contributors
know what they can and cannot use.

	Once your code is good enough, propose your branch for merging

	Your work will be evaluated by a member of the committers team.
	If they accept your branch for integration in the official version, they
will submit to the quality team that will review and merge in the official
branch.

	If the committer team refuses your branch, they will explain why
so that you can review the code to better fit the guidelines (problem for
future migrations, ...)










The extra-addons branch, that stores all extra modules, is directly accessible
to all committers. If you are a committer, you can work directly on this branch
and commit your own work. This branch does not require a validation of the
quality team. You should put there your special modules for your own customers.

If you want to propose or develop new modules, we suggest creating your
own branch in the openobject-addons project [https://launchpad.net/openobject-addons]
and develop within your branch. You can fill in a bug to request that
your modules are integrated in one of the two branches:



	extra-addons : if your module touches a few companies

	addons : if your module will be useful for most of the companies






We invite all our partners and contributors to work in that way so that we can
easily integrate and share the work done between the different projects.

After having done that, your branch is public on Launchpad, in the OpenObject
project [https://code.launchpad.net/openobject], and committers can work on
it, review it and propose for integration in the official branch. The last line
allows you to rebind your branch to the one which is on launchpad, after having
done this, your commit will be applied on launchpad directly (unless you use --local):

bzr pull    # Get modifications on your branch from others
EDIT STUFF
bzr ci    # commit your changes on your public branch





If your changes fix a public bug on launchpad, you can use this to mark the bug as fixed by your branch:

bzr ci --fixes=lp:453123   # Where 453123 is a bug ID





Once your branch is mature, mark it as mature in the web interface of launchpad
and request for merging in the official release. Your branch will be reviewed
by a committer and then the quality team to be merged in the official release.




How to commit Your Work

If you want to contribute on OpenERP or OpenObject, here is the proposed method:



	You create a branch on launchpad on the project that interests you. It’s
important that you create your branch on launchpad and not on your local
system so that we can easily merge, share code between projects and
centralize future developments.

	You develop your own features or bugfixes
in your own branch on launchpad. Don’t forget to set the status of your
branch (new, experimental, development, mature, ...) so that contributors
know what they can and cannot use.

	Once your code is good enough, propose your branch for merging

	Your work will be evaluated by a member of the committers team.
	If they accept your branch for integration in the official version, they
will submit to the quality team that will review and merge in the official
branch.

	If the committer team refuses your branch, they will explain why
so that you can review the code to better fit the guidelines (problem for
future migrations, ...)










The extra-addons branch [https://code.launchpad.net/~openerp-commiter/openobject-addons/trunk-extra-addons],
that stores all extra modules, is directly accessible to all committers. If you
are a committer, you can work directly on this branch and commit your own work.
This branch does not require validation by the quality team. You should put
there your special modules for your own customers.

If you want to propose or develop new modules, we suggest creating your
own branch in the openobject-addons project [https://launchpad.net/openobject-addons]
and develop within your branch. You can fill in a bug to request that
your modules are integrated in one of the two branches:



	extra-addons branch [https://code.launchpad.net/~openerp-commiter/openobject-addons/trunk-extra-addons] : if your module touches a few companies

	addons [https://code.launchpad.net/~openerp/openobject-addons/trunk] : if your module will be useful for most of the companies






We invite all our partners and contributors to work in that way so that we can
easily integrate and share the work done between the different projects.






Registration and Configuration

Before you can commit on launchpad, you need to create a login.

Go to: https://launchpad.net –> log in / register on top right.

You enter your e-mail address and you wait for an e-mail which will guide you trough the process needed to create your login.

This login is only needed if you intend to commit on bazaar on openerp-commiter or on your own branch.

You can refer to this link :
https://help.launchpad.net/YourAccount/NewAccount

Any contributor who is interested to become a committer must show his interest
on working for openerp project and ability to do it properly as
selection is based on merit. It can be by proposing bug
fixes, features requested on our bug tracker system.
You can even suggest additional modules and/or functionality on our bug
tracker system.

You can contribute or join OpenERP team, : https://help.launchpad.net/Teams/Joining

Contributors are people who want to help the project improve, add
functionality and improve stability. Anyone can contribute on the project
by reporting bugs, proposing some improvement and
posting patch.

The community team is available on launchpad: https://launchpad.net/~openerp-community

Member of the quality and committer team are automatically members of the community.


安装 Bazaar

Get Bazaar version control to pull the source from Launchpad.

To install bazaar on any ubuntu distribution, you can edit /etc/apt/sources.list by

sudo gedit /etc/apt/sources.list





and put these lines in it:

(for ubuntu intrepid 8.10)
deb http://ppa.launchpad.net/bzr/ubuntu intrepid main
deb-src http://ppa.launchpad.net/bzr/ubuntu intrepid main

or (for ubuntu jaunty 9.04)
deb http://ppa.launchpad.net/bzr/ubuntu jaunty main
deb-src http://ppa.launchpad.net/bzr/ubuntu jaunty main

or (for ubuntu karmic 9.10)
deb http://ppa.launchpad.net/bzr/ubuntu karmic main
deb-src http://ppa.launchpad.net/bzr/ubuntu karmic main





Here, intrepid, jaunty and karmic are version names of ubuntu, replace it with your ubuntu version.

Then, do the following

sudo apt-get install bzr





To work correctly, bzr version must be at least 1.3. Check it with the command:

bzr --version





If you have an older version check this url: http://bazaar-vcs.org/Download
On debian, in any distribution, the 1.5 version is working, you can get it on this url: http://backports.org/debian/pool/main/b/bzr/bzr_1.5-1~bpo40+1_i386.deb

If you experience problems with Bazaar, please read the Bazaar 版本控制的常见问题(F.A.Q) before asking any questions.






Branch

The combination of Bazaar branch hosting and Launchpad’s teams infrastructure gives you a very powerful capability to collaborate on code. Essentially, you can push a branch into a shared space and anyone on that team can then commit to the branch.

This means that you can use Bazaar in the same way that you would use something like SVN, i.e. centrally hosting a branch that many people commit to. You have the added benefit, though, that anyone outside the team can always create their own personal branch of your team branch and, if they choose, upload it back to Launchpad.

This is the official and proposed way to contribute on OpenERP and OpenObject.




如何提交

If you want to contribute on OpenERP or OpenObject, here is the proposed method:



	You create a branch on launchpad on the project that interests you. It’s
important that you create your branch on launchpad and not on your local
system so that we can easily merge, share code between projects and
centralize future developments.

	You develop your own features or bugfixes
in your own branch on launchpad. Don’t forget to set the status of your
branch (new, experimental, development, mature, ...) so that contributors
know what they can and cannot use.

	Once your code is good enough, propose your branch for merging

	Your work will be evaluated by a member of the committers team.
	If they accept your branch for integration in the official version, they
will submit to the quality team that will review and merge in the official
branch.

	If the committer team refuses your branch, they will explain why
so that you can review the code to better fit the guidelines (problem for
future migrations, ...)










The extra-addons branch, that stores all extra modules, is directly accessible
to all committers. If you are a committer, you can work directly on this branch
and commit your own work. This branch does not require a validation of the
quality team. You should put there your special modules for your own customers.

If you want to propose or develop new modules, we suggest creating your
own branch in the openobject-addons project [https://launchpad.net/openobject-addons]
and develop within your branch. You can fill in a bug to request that
your modules are integrated in one of the two branches:



	extra-addons : if your module touches a few companies

	addons : if your module will be useful for most of the companies






We invite all our partners and contributors to work in that way so that we can
easily integrate and share the work done between the different projects.

After having done that, your branch is public on Launchpad, in the OpenObject
project [https://code.launchpad.net/openobject], and committers can work on
it, review it and propose for integration in the official branch. The last line
allows you to rebind your branch to the one which is on launchpad, after having
done this, your commit will be applied on launchpad directly (unless you use --local):

bzr pull    # Get modifications on your branch from others
EDIT STUFF
bzr ci    # commit your changes on your public branch





If your changes fix a public bug on launchpad, you can use this to mark the bug as fixed by your branch:

bzr ci --fixes=lp:453123   # Where 453123 is a bug ID





Once your branch is mature, mark it as mature in the web interface of launchpad
and request for merging in the official release. Your branch will be reviewed
by a committer and then the quality team to be merged in the official release.




Answer and bug tracking and management

We use launchpad on the openobject project to track all bugs and features
request related to openerp and openobject. the bug tracker is available here:



	Bug Tracker : https://bugs.launchpad.net/openobject

	Ideas Tracker : https://blueprints.launchpad.net/openobject

	FAQ Manager : https://answers.launchpad.net/openobject






Every contributor can report bug and propose bugfixes for the bugs.
The status of the bug is set according to the correction.

When a particular branch fixes the bug, a committer (member of the Commiter
Team [https://launchpad.net/~openerp-commiter]) can set the status to “Fix
Committed”. Only committers have the right to change the status to “Fix
Committed.”, after they validated the proposed patch or branch that fixes the
bug.

The Quality Team [https://launchpad.net/~openerp] have a look every day to
bugs in the status “Fix Committed”. They check the quality of the code and merge
in the official branch if it’s OK. To limit the work of the quality team, it’s
important that only committers can set the bug in the status “Fix Committed”.
Once quality team finish merging, they change the status to “Fix Released”.




翻译

Translations are managed by
the Launchpad Web interface [https://translations.launchpad.net/openobject]. Here, you’ll
find the list of translatable projects.

Please read the FAQ [https://answers.launchpad.net/rosetta/+faqs] before asking questions.




Blueprints

Blueprint is a lightweight way to manage releases of your software and to track the progress of features and ideas, from initial concept to implementation. Using Blueprint, you can encourage contributions from right across your project’s community, while targeting the best ideas to future releases.

Launchpad Blueprint helps you to plan future release with two tools:



	milestones: points in time, such as a future release or development sprint

	series goals: a statement of intention to work on the blueprint for a particular series.






Although only drivers can target blueprints to milestones and set them as series goals, anyone can propose a blueprint as a series goal. As a driver or owner, you can review proposed goals by following the Set goals link on your project’s Blueprint overview page.

By following the Subscribe yourself link on a blueprint page, you can ask Launchpad to send you email notification of any changes to the blueprint. In most cases, you’ll receive notification only of changes made to the blueprint itself in Launchpad and not to any further information, such as in an external wiki.

However, if the wiki software supports email change notifications, Launchpad can even notify you of changes to the wiki page.

If you’re a blueprint owner and want Launchpad to know about updates to the related wiki page, ask the wiki admin how to send email notifications. Notifications should go to notifications@specs.launchpad.net.


Blueprints for OpenERP are listed here:



	https://blueprints.launchpad.net/openerp

	https://blueprints.launchpad.net/~openerp-commiter
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OpenERP Web v6.0


介绍

Web Client – 一个软件应用程序通过一个web浏览器中启动.

推出OpenERP v6,一个新的web客户端进行设计和开发,
它提供了一个更专业的形象 than OpenERP v5.

我们迁移web客户端来CherryPy3滴TurboGears完全和迁移的孩子模板来更快的尖吻鲭鲨模板,
一个重大步骤使web客户端更快和更容易部署。

All the Kid templates were converted to faster Mako templates, i18n/l18n features
have been partially reimplemented using Python Babel, CherryPy2 (TG is built on
top of CP2) was replaced with CherryPy3, the latest, much better version of
CherryPy Server.

这大大减少了使用和部署OpenERP Web client的难度.

Now the number of third party dependencies are reduced to 3-4 pure Python libraries which
you can install within the local lib dir with the help of populate.sh script, found under
the same lib directory.


	仅需要从 Launchpad 获取源码后, 运行 populate.sh 就可以完成 web client 的启动...




整个测试效果会让你惊叹!.


一般3-5次后的提速效果就很明显了.




弥补 OpenERP Web 5.0 不足

下面是 6.0 版与 5.0 版就web性能方面做的测试报告:

使用 Apache ap.exe 工具对处理大量的 客户发票表单为例做性能测试.







	OpenERP Web 5.0 (TurboGears + Kid)
	OpenERP Web 6.0 (CherryPy3 + Mako)




	ApacheBench工具, 版本 2.3 <内部版本: 655654>
	ApacheBench工具, 版本 2.3 <内部版本: 655654>


	Copyright 1996 Adam Twiss, Zeus Technology Ltd, http://www.zeustech.net/
	Copyright 1996 Adam Twiss, Zeus Technology Ltd, http://www.zeustech.net/


	Licensed to The Apache Software Foundation, http://www.apache.org/
	Licensed to The Apache Software Foundation, http://www.apache.org/


	Benchmarking localhost (be patient).....done
	Benchmarking localhost (be patient).....done


	Server Software: CherryPy/2.3.0
	Server Software: CherryPy/3.1.2


	Server Hostname: localhost
	Server Hostname: localhost


	Server Port: 8081
	Server Port: 8080


	Document Path: /form/edit?model=account.invoice&id=1
	Document Path: /form/edit?model=account.invoice&id=1


	Document Length: 79965 bytes
	Document Length: 90394 bytes


	Concurrency Level: 1
	Concurrency Level: 1


	Time taken for tests: 166.323 seconds
	Time taken for tests: 42.054 seconds


	Complete requests: 100
	Complete requests: 100


	Failed requests: 0
	Failed requests: 0


	Write errors: 0
	Write errors: 0


	Total transferred: 8022000 bytes
	Total transferred: 9063400 bytes


	HTML transferred: 7996500 bytes
	HTML transferred: 9039400 bytes


	Requests per second: 0.60 [#/sec] (mean)
	Requests per second: 2.38 [#/sec] (mean)


	Time per request: 1663.228 [ms] (mean, across all concurrent requests)
	Time per request: 420.543 [ms] (mean, across all concurrent requests)


	Transfer rate: 47.10 [Kbytes/sec] received
	Transfer rate: 210.47 [Kbytes/sec] received


	Connection Times (ms)
	Connection Times (ms)


	min mean[+/-sd] median max
	min mean[+/-sd] median max


	Connect: 0 0 0.0 0 0
	Connect: 0 0 0.0 0 0


	Processing: 1556 1663 71.3 1663 1856
	Processing: 1556 1663 71.3 1663 1856


	Waiting: 1555 1662 71.3 1662 1855
	Waiting: 381 420 27.7 415 522


	Total: 1556 1663 71.3 1663 1856
	Total: 382 420 27.7 416 523


	Percentage of the requests served within a certain time (ms)
	Percentage of the requests served within a certain time (ms)


	50% 1663
	50% 416


	66% 1681
	66% 418


	75% 1695
	75% 420


	80% 1715
	80% 424


	90% 1775
	90% 436


	95% 1801
	95% 512


	98% 1829
	98% 520


	99% 1856
	99% 523


	100% 1856 (longest request)
	100% 523 (longest request)








测试结果


	报告显示, 第二列的测试结果明显好于第一列.

	3-5次缓存加速明显.

	还有进一步提升性能的空间.

	如还可以再减少一些RPC调用, 有一些获取结果后仍有一定量的冗余计算.
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Cherrypy 是嘛东西?

CherryPy 是个典型的面向对象的 HTTP 开发框架.

CherryPy 可以让开发者可以象开发类似其他Python面向对象的程序那样简单并快速地去开发一个Web应用. 下面就是一个简单的例子:

import cherrypy
class HelloWorld:
    def index(self):
        return "Hello World!"
    index.exposed = True
cherrypy.quickstart(HelloWorld())





要运行这段代码, 只需要在命令行进入该代码文件夹, 运行下面的命令:

python hello.py





然后 使用浏览器访问地址: http://localhost:8080

浏览器上就显示出结果:

Hello World!





这时, 在命令行窗口上按下 Ctrl+C 键便可以终止程序的运行.

代码 import cherrypy 将引入 CherryPy 模块扩展.

HelloWorld 类的定义则会将完成类的方法的发布.

有一个必须定义的 index() 方法则默认为URL(如: http://localhost:8080)中的网站root, 该方法返回的字符串将做为网页中的 内容 (如本例中的 ‘Hello World!’).

代码 index.exposed = True 则表明 index() 方法是要开放出去的.


	只有开放出去的方法,才可以处理各种HTTP请求.

	让开发人员自主控制对象的方法是否开放为Web请求更简单快捷.

	在方法前使用代码 @cherrypy.expose 同样也能立即发布该方法:



@cherrypy.expose
def index(self):
    return "Hello World!"





代码 cherrypy.quickstart(HelloWorld()) 是将对象做为 CherryPy 的HTTP Handle 启动 CherryPy 的 Web 服务.


发布 HelloWorld 类的实例


	启动内嵌 webserver

	直到按(Ctrol+C)键结束运行






当应用运行时, CherryPy 是以默认配置运行的.


	监听地址 localhost  监听端口 8080

	这些默认值都可以使用配置文件进行覆盖修改
	cherrypy.config.update({‘server.socket_port’:8010})

	这样就将监听端口修改为8010了.







服务器的访问地址为: http://localhost:8080


	从 HelloWorld 类中找最匹配的方法来处理Web请求.

	调用 HelloWorld().index() 方法.

	方法返回给请求用户的浏览器内显示.




Cherrypy 应用实例

CherryPy 可以让你开发出内嵌Python标准应用多线程Web服务的强大的Web应用. 你可以在任何可以运行Python程序的环境下布曙它.
并不需要Apache, 但你可以在Apache(或者 lightpd 甚至 IIS)中调用 CherryPy 应用.
可以运行于 Windows, Linux, Max OS X 以及其他的支持 Python 语言的操作系统.

除此之外, CherryPy 还会原汁原味地保留你的应用. 你可以自由地使用各种各样的模板,数据存取等技术方案.
CherryPy 也能处理诸如 Session, 静态文件, Cookie, 文件上传等几乎所有 Web 应用中涉及到的东西.




功能


	高效的, 兼容HTTP/1.1, 支持 WSGI 线程池的webserver. 通常 CherryPy 处理页面本身耗时仅 1-2ms!

	支持其他任何支持 WSGI 的webserver, 诸如 Apache, IIS, lighttpd, mod_python, FastCGI, SCGI, 和 mod_wsgi 等等.

	多HTTP实例服务.

	强大的开发与布曙配置系统.

	灵活的扩展性能.

	内建 缓存, 编码, SESSION, 身份认证, 静态化 等支持.

	内置支持 mod_python .

	完整的测试套件.

	任意交互与定制.

	Built-in profiling, coverage, and testing support.




	看看下面的例子 (root 是指向网站根目录的一个参考),

	root = HelloWorld()

root.onepage = OnePage()

root.otherpage = OtherPage()





URL http://localhost:8080/onepage 指向了 OnePage() 的对象实例,

URL http://localhost:8080/otherpage 指向了 OtherPage() 的对象实例.


	又如,

	root.some = Page()

root.some.page = Page()





URL http://localhost:8080/some/page  请求映射转给了 root.some.page 对象开放出来的方法(诸如 index 方法).

在本例中, 为本例添加 http://.../onepage 访问到 OnePage() 可以象下面这样搞定:

class OnePage():
    def index(self):
        return "one page!"
    index.exposed = True
class HelloWorld(object):
    onepage = OnePage()
    def index(self):
        return "hello world"
    index.exposed = True
cherrypy.quickstart(HelloWorld())





打开浏览器地址栏输入 http://localhost:8080/onepage




Index 方法


	index() 方法就如同 index.html 文件一样, 是系统默认访问文档.

	附带参数与页面表单的GET POST参数对应.

	仅在URL与方法路径完全一致的情况下才被调用.






其他方法

对象所发布出去的方法均被CherryPy映射为可访问的 URL.

class HelloWorld():
    def index(self):
        return "Hello World!"
    index.exposed = True

    @cherrypy.expose
    def test(self):
        return "Test Controller"
cherrypy.quickstart(HelloWorld())





按上面的代码,只需要请求 http://localhost:8080/test 就可以访问 HelloWorld 对象的 test 方法了.

当 CherryPy 处理URL为 /test 的请求时, 会自动调用 test() 来处理.


	可以是平常的 function, 也可以是任何可以调用的任意对象的方法.



CherryPy 会去查找所有满足条件的对象的可调用方法,并调用最后一个匹配的方法.


	方法,函数甚至那些支持 __call__ 属性的对象,以及那些连 index() 方法都没有的对象都可以做 CherryPy 的事件处理.



然后对象会被调用.

在生产环境中, Python 的类能调用是很必须的.

而且 CherryPy 的表单还支持 POST 及 GET 方法处理.
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Mako 模板

Mako 是Python语言的一个模板处理库.

它能提供编译为常见的非XML语法的高性能的Python模块.

Mako 的语法及API融合了很多模块系统的亮点, 如常用的 Django, Cheetah, Myghty, Genshi等等.

从概念上讲, Mako 属于一种内嵌Python语言(如Python的服务端页面). 这样模板开发者精确的想法布局实现及简单而直接地继承.
模式灵活同时还保证了与应用与Python的调用及语义的紧密联系.

<%inherit file="base.html"/>
<%
    rows = [[v for v in range(0,10)] for row in range(0,10)]
%>

<table>
    % for row in rows:
        ${makerow(row)}
    % endfor
</table>

<%def name="makerow(row)">
    <tr>
    % for name in row:
        <td>${name}</td>
    % endfor
    </tr>
</%def>






功能

API简洁, 最简单的例子, 只需要引用一个 Template class 即可.

from mako.template import Template
print Template("hello ${data}!").render(data="world")





另一个例子,使用文件模板以及模板缓存,模板文件优先查询的处理.

Insanely Fast. An included bench suite, adapted from a suite included with Genshi, has
these results for a simple three-sectioned layout:

Mako: 1.10 ms                                             Kid: 14.54 ms






	标准模板功能
	模板结构,逻辑控制使用标准Python语法(如 循环语句, 条件语句等)

	straight Python blocks, inline or at the module-level





	可重复使用模板块
	can access variables from their enclosing scope as well as the template’s request context

	模块任意嵌套

	can specify regular Python argument signatures

	outer-level callable blocks can be called by other templates or controller code (i.e. “method call”)

	calls to functions can define any number of sub-blocks of content which are accessible to the called
function (i.e. “component-call-with-content”). This is the basis for nestable custom tags.





	模板继承
	supports “multi-zoned” inheritance - define any number of areas in the base template to be overridden.

	supports “chaining” style inheritance - call next.body() to call the “inner” content.

	the full inheritance hierarchy is navigable in both directions (i.e. parent and child) from anywhere in the chain.

	inheritance is dynamic ! Specify a function instead of a filename to calculate inheritance on the fly for every request.










例子


	基本用法



from mako.template import Template

mytemplate = Template("hello world!")
print mytemplate.render()





传给 Template 的模板文本被处理成一种类似 Python 模块的对象.

这个模块对象有一个 render_body() 方法, 用于将模板处理为最终的输出结果.

当 mytemplate.render() 时，Mako 会处理当前的运行环境并调用 render_body() 方法渲染模板后返回处理结果为一个
字符串.

The code inside the render_body() function has access to a namespace of variables. You can specify
these variables by sending them as additional keyword arguments to the render() method:

from mako.template import Template

mytemplate = Template("hello, ${name}!")
print mytemplate.render(name="openerp")






	基于文件的模板



使用文件做为模板代码源, 只需要使用 filename 参数指定文件路径即可:

from mako.template import Template

mytemplate = Template(filename='/test.html')
print mytemplate.render()






	使用 TemplateLookup 匹配最佳模板



到目前, 所有的例子还都是只使用单一的 Template 模板.

如果模板代码中引用一个本地的另一个模板资源, Mako 则可以使用简单的 URI 串来指定查找位置.

因此, TemplateLookup 类就解决了在一个模板中引用其它模板的问题.

该类将按给定的目录列表查找模板，
This class is constructed given a list of directories in which to search for templates, as well as keyword arguments
that will be passed to the Template objects it creates:

from mako.template import Template
from mako.lookup import TemplateLookup

mylookup = TemplateLookup(directories=[''])
mytemplate = Tempalte('<% include file="header.txt"/> Hello!',lookup=mylookup)





上面的代码, 则创建了一个引用了 “header.txt” 文件的模板.

为了让系统能找到 “header.txt” 模板, 我们传了一个 TemplateLookup 对象过去,告诉系统从当前文件夹中查找 “header.txt”.




语法


	表达式



模板最简单的表达式就是模板变量的替换了.

${} 的语法类似于 Perl, Genshi, JSP EL等模板系统的语法:


${x}



${5%5}



${7*2}



${pow(x,2) + pow(y,2)}



	流程控制
	条件语句(如: if/else)

	循环语句(如: for 与 while)

	异常控制(如: try/except)







模板的流程控制完全使用 Python 语言的流程控制语法, 只不过, 在模板流程控制结束, 需要使用 “%end<name>”来做为控制结束符.
其中 “<name>” 为控制语句的 Python 保留字. 例如:

% if user_name == 'openerp':
    valid user
% endif

% if a > 1:
    a is positive number
% elif a == 0:
    a is 0
% else:
    a is negative number
% endif

<table>
% for a in [1,2,3,4,5]:
    <tr>
        <td>
            ${a}
        </td>
    </tr>
% endfor
</table>






	Python 代码块



你可以在模板的 <% %> 标符内随意使用 Python 代码:

<%
    a = {'a': 1, 'b': 2, 'c': 3, 'd': 4, 'e': 5}
    b = a.values()
%>
% for x in b:
    ${x}
% endfor






	Module-level Blocks



<% %> Python 代码块的另一种方式是可以使用 <%! %> 做为定界符.

模板里这个标签内的代码可以执行, 但是函数定义里的代码并不立即执行.

<%!
    import cherrypy
    def get_user_from_session():
        return cherrypy.session['current_user']
%>





Therefore, this code does not have access to the template’s context and is only executed when the template is loaded into
memory (which can be only once per application, or more, depending on the runtime environment).


	Mako Tags



<%page>

<%page> 标签是在模板中常用的标签, 在标签内可以配置页面的缓存参数,以及模板引用时需要的一些可选择的列表.

Also defines caching characteristics.

<%page args="x, y, z='default'"/>
<%page cached="True" cache_type="memory"/>





<%include>

只需要传递一个参数就可以调用该参数对应的模板.

Also accepts arguments which are available as <%page> arguments in the receiving template:

<%include file="header.mako"/>
    Welcome to OpenERP
<%include file="footer.mako"/>

<%include file="toolbar.html" args="current_section='members', username='ed'"/>





<%inherit>

Inherit allows templates to arrange themselves in inheritance chains.

When using the %inherit tag, control is passed to the topmost inherited template first, which
then decides how to handle calling areas of content from its inheriting templates.

<%inherit file="index.mako"/>





<%def>

The %def tag defines a Python function which contains a set of content, that can be called at some other point in the template.

The %def tag is a lot more powerful than a plain Python def, as the Mako compiler provides many extra services
with %def that you wouldn’t normally have, such as the ability to export defs as template “methods”,
automatic propagation of the current Context, buffering/filtering/caching flags, and def calls with content,
which enable packages of defs to be sent as arguments to other def calls (not as hard as it sounds).

<%def name="my_function(x)">
    this is function ${x}
<%def>





<%namespace>

%namespace is Mako’s equivalent of Python’s import statement.

这允许访问所有的渲染函数及其它模板文件的元数据, plain Python modules,
甚至本地定义的函数包.

<%namespace file="test.mako" import="*"/>





<%doc>

处理多行内容:

<%doc>
    多行内容
    使用文档标签
</%doc>





更多的资料，请访问访官方文档: http://www.makotemplates.org/docs/index.html
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RAD Tools


DIA

uml_dia 模块可以帮助开发者使用 DIA 工具 (http://www.gnome.org/projects/dia) 设计UML后自动生成开发新模块.

这并不是一个需要安装到服务器上的非标准模块, 整个模块仅仅是一个 Dia 的Python脚本(codegen_openerp.py), 以及一个用于生成模块的测试用的 dia 文档.

模块在 extra_addons 项目的分支中: https://code.launchpad.net/openobject-addons

要在Dia中使用 codegen_openerp 模块, 通常在 /usr/share/dia/python 路径下载入一次即可, 只需要打开 Dia 并且从 Dialog Menu
菜单下打开 Python Console, 在Python 交互窗口中输入 “import codegen_openerp”. 如果不出意外的话,你就可以在 “PyDia Code Generation (OpenERP)”
对话框中 选择 “Export...” 来导出并创建一个由UML设计自动生成的 zip 格式的OpenERP 模块了.

要安装 Dia for windows, 你需要先安装 Python-2.3.5, 再安装 Dia, 就可以选择是否安装 Dia 的plug-in.  然后再将 codegen_openerp.py
文件复制到 C:\Program Files\Dia , 然后你的Dia 就可以实现导出 OpenERP 模块的功能了.

Dia for Windows 的安装请参阅 (http://openerpdev.blogspot.com/2009/11/rad-with-openerp.html)

如果你得到最终的ZIP文件不能正常打开, 只需要使用 DiskInternals ZipRepais utility 工具来修复一下zip 文件,即可在OpenERP
中正常导入了. 当然,你不能修改zip文件的文件名. 因为文件名必须与你的模块名保持一致.




Open Office 报表设计工具


安装

Openoffice.org 报表设计器插件方便安装与使用. 整个插件只有两个文件: openofficereport.zip 与 Makefile. 下面来看看具体的安装步骤.


	在 Openoffice Writer 中插件管理中心安装.



要安装设计器插件,需要在菜单 Tools ‣ Extension Manager 去激活安装.

[image: ../../_images/1_1.png]
在插件管理器窗口中, 点击 Add 按钮弹出文件选择框, 这时你选择下载的插件 openofficereport.zip 文件进行安装.

[image: ../../_images/1_2.png]
插件安装完毕后,你可以在 Openoffice.org Writer 中发现多出来一个 OpenERP Report 菜单项.

[image: ../../_images/21.png]



配置连接参数

你可以在菜单: OpenERP Report ‣ Server Parameters 或者点击工具栏上的 OpenERP 按钮,就可以以不同的用户
身份连接到 OpenERP Server.

点开后弹出窗体:

[image: ../../_images/31.png]
指定正确的 Server URL 后, 你就可以用相应的用户登陆进该 OpenERP Server了.

你还可以通过点击 ‘Change’ 按钮来修改这些配置参数.

[image: ../../_images/3_1.png]



创建一个新报表

点击 OpenERP Report ‣ Open a new report 打开创建新报表的对话框.

[image: ../../_images/41.png]
在上面的窗口中,选择相应模块来创建与该模块相关的报表.




循环

为了在 OpenERP Report 中循环输出数据. 只需要打开菜单 OpenERP Report ‣ Add a loop 或者 点击工具栏的
按钮 激活下面的窗口.
* 循环部分也可以放到表格或者OpenOffice.org的部件中.

[image: ../../_images/51.png]
点击 ‘OK’ 按钮,就可以得到一个可循环的对象,参见下图:

[image: ../../_images/5_1.png]
上面完成了在 OpenOffice.org 报表中使用一个 Input 字段的功能. 并且这个字段会在文档上表现为一个深色背景以及
你在变量名那里输入的英文: | .partner.|




添加字段打印

如果需要在 OpenERP Report 中使用对象的其他字段, 你需要点开工具栏按钮或者 OpenERP Report ‣ Add a Field 菜单
打开下图的对话框,选择一个或者多个字段.

[image: ../../_images/61.png]



使用表达式

还可以为 OpenERP Report 针对字段创建一些表达式. 点击 OpenERP Report ‣ Add an expression 象下图这样.


	点 Expression 按钮,你可以直接输入 Python表达式. 表达式可以用于报表涉及对象的所有字段计算. 例如, 你可以在订单报表中使用如下的表达式:



'%.2f' % (amount_total * 0.9,)





在上面的例子中, amount_total 是订单对象的一个字段. 上面的表达式则将字段的金额9折后按两位小数的格式输出.

[image: ../../_images/71.png]
点击 ‘ok’ 按钮后, 就会得到一个 表达式 对象, 如下图所示

[image: ../../_images/7_1.png]



使用翻译标签

因为 OpenERP 是多语言的, 所以报表也必须要支持多语言翻译. 但是报表中并非所有项都需要翻译:  类似那些用于格式
化输入的部分,就不应该做翻译处理. 如果XML标签含有属性 t=”1” 的话, 则这个字段会被处理成多语言字段. 在报表生
成的时候, 服务器会自动处理该字段为含有<lang>标签的字段.

[image: ../../_images/81.png]



修改

修改 OpenERP Report 中的 repeatIn, 字段及表达式.
* This functionality will work with cursor you have to place your current cursor before the report statement and it will open dialog box after detecting that statement is either Expression, RepeatIn or Fields.


	点击 OpenERP Report ‣ Modify 菜单弹出下面的对话框.



[image: ../../_images/91.png]
将光标置于你要修改的部分的最前面, 点击菜单 OpenERP Report ‣ Modify 或者点击工具栏的修改按钮.
系统会自动根据所修改的部分的类型(字段,表达式,循环)自动调出类似下面的对应的修改窗口.

[image: ../../_images/101.png]



Conversion Fields > Brackets

The purpose of this functionality is mapping old (use bracket for writing report
statement) and new (use input filed for writing report statement). So whenever you want
to convert your new report statement to old fashion then you can use this method. if you
want to access this functionality you can click on OpenReport > Conversion Fields >
Bracket from menubar.

[image: ../../_images/11.png]



Conversion Brackets > Fields

This is reverse functionality in which you can change your old-format report into new
format. If you want to access this functionality you can click on Open Report > Conversion
Bracket > Fields from menubar.

[image: ../../_images/121.png]



添加附件

You can attach the report with record using attachment and the model which add in
base_model are displayed in list.
Note: Server side Add the base_model module this module available in trunk-extra-addons and add the model name which display in Add Attachment.

[image: ../../_images/13.png]
[image: ../../_images/141.png]



导出RML文件


	可以将 sxw 文件转化生成相应的 rml 文件.

	点击 OpenERP Report ‣ Export to RML 菜单.

	The basic feature of this functionality is now you can create your rml file in just few mouse clicks. The  main requirements of this utility is you must have to save your report in Open Server using Send to the Server functionality.

	When you click on Export to RML It will open save file dialog box in which you can specify file name and destination of rml file to save






保存报表到OpenERP

This is the most important functionality available in Open Report Design tools
* The basic feature of this functionality is to add new report or update existing report to Open Servein RML as well as SXW format.
* You can access this feature by using clicking on Open Report > Send to the Server in menubar *

[image: ../../_images/151.png]



修改报表

Openoffice.org Report Design tool provide functionality of modify existing report which
is already available in Open server and also delete the report from database. You can
access this feature by using clicking on OpenReport > Modify Existing Report in
menubar. By clicking on Modify Existing Report I will display dialog box displayed
below.

[image: ../../_images/16.png]
现在你可以选择打开现有的报表, 或者删除掉现有的报表. 打开报表则会将服务器的报表保存到一个临时文件夹里,再调用可用
的编辑器打开. 如图所示

[image: ../../_images/17.png]



关于

这个关于窗口显示着版权和版本信息.你可以在菜单栏上的报表>关于中打开窗口.

[image: ../../_images/18.png]
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安装

本章讲述在主要支持平台上部署OpenERP时通常的安装过程。

对于 OpenERP Online (SaaS mode) 而言，安装过程简单到只需在 https://www.openerp.com/online 中创建一个新帐号。
本章的第一节，提供了SaaS使用的常见问题的答案。

对于 OpenERP on-site 而言, 作为一个AllinOne的安装包，安装过程主要是 安装PostgreSQL (openerp使用的数据库引擎)、
Python (多数平台内置)以及之后的 OpenERP 自身的安装。


Note

对于熟悉OpenERP早期版本的用户而言，6.1 系列有了一个不一样的框架，和只需要安装单个OpenERP安装包的安装过程。





	使用OpenERP做SaaS(Software as a Service)服务
	No Lock-in

	常见问题(FAQ)
	常见问题
	本地化OpenERP和在线式OpenErp究竟有什么不同呢？

	签约的在线式OpenERP包含哪些服务呢？





	报价及支付
	什么是OpenERP的价格模式？

	What is the Payment Process?

	How can I check my Monthly Usage and Invoice?





	Infrastructure and Security
	What is the Infrastructure Provided?

	Where are the Data Centers Located?

	Can I get my Data back?

	Can I get a Shell Access to my Servers?





	数据导入
	I already use OpenERP, can I Migrate to the OpenERP Online Offer?

	Can I Import Data from other Software applications in my OpenERP Online System?





	服务内容
	Can I request some Services for Support and Training?

	What can I do if I find a bug in OpenERP Online?





	解决方案
	What should I do if I have Specific Needs?

	What Languages are Available?













	在 Linux 上安装 OpenERP
	PostgreSQL 数据库安装和配置
	Ubuntu 上的例子

	为OpenERP设置一个 PostgreSQL 用户
	第一个方法

	第二个方法









	OpenERP 服务器安装
	安装所需要的包

	下载 OpenERP 服务器

	测试 OpenERP 服务器

	安装 OpenERP 服务器

	创建 OpenERP 服务器配置文件
	默认的配置文件









	OpenERP GTK 客户端安装
	安装需要的包

	下载 OpenERP 客户端

	测试 OpenERP 客户端

	安装OpenERP 客户端

	配置 PDF 浏览器





	安装 OpenERP Web 客户端
	运行 OpenERP Web 客户端

	支持的浏览器





	更新你的 OpenERP 安装
	更新次版本/补丁发行版

	更新到一个新的主发行版









	在Windows上安装OpenERP
	OpenERP完整（All-In-One）安装
	下载OpenERP完整安装包

	安装OpenERP完整包（All-In-One）

	连接到 OpenERP





	PostgreSQL 数据库安装与配置
	PostgreSQL 数据库安装

	配置PostgreSQL角色用户
	新增用户

	大小写不敏感搜索问题









	OpenERP服务器安装
	下载 OpenERP 服务器

	安装 OpenERP 服务器

	定制配置
	决定数据库目的
	指定安装模块及示例数据

	不带示例数据

	更新数据库









	监控 OpenERP 服务器

	恭喜，您的OpenERP Server已经安装成功啦！





	OpenERP GTK 客户端安装
	下载 OpenERP GTK 客户端

	安装 OpenERP GTK 客户端

	启动 OpenERP GTK 客户端





	OpenERP Web 安装
	运行 OpenERP Web 客户端

	支持的浏览器





	问题解决和Windows补充安装信息
	PostgreSQL 管理
	OpenERP Server 链接 PostgreSQL 错误









	更新你的 OpenERP 安装
	Going to a Newer Minor/Patch Release

	Going to a Newer Major Release









	OpenERP Publisher Warranty 迁移
	如何进行数据库迁移?
	迁移步骤

	如何恢复数据库备份?

	如何保证数据库数据安全?
	Anonymization History

	Anonymize database

	Anonymized Fields





















          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	安装 
 
      

    


    
      
          
            
  
使用OpenERP做SaaS(Software as a Service)服务



	No Lock-in

	常见问题(FAQ)
	常见问题
	本地化OpenERP和在线式OpenErp究竟有什么不同呢？

	签约的在线式OpenERP包含哪些服务呢？





	报价及支付
	什么是OpenERP的价格模式？

	What is the Payment Process?

	How can I check my Monthly Usage and Invoice?





	Infrastructure and Security
	What is the Infrastructure Provided?

	Where are the Data Centers Located?

	Can I get my Data back?

	Can I get a Shell Access to my Servers?





	数据导入
	I already use OpenERP, can I Migrate to the OpenERP Online Offer?

	Can I Import Data from other Software applications in my OpenERP Online System?





	服务内容
	Can I request some Services for Support and Training?

	What can I do if I find a bug in OpenERP Online?





	解决方案
	What should I do if I have Specific Needs?

	What Languages are Available?
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No Lock-in

With traditional SaaS solutions, restrictions like the use of proprietary formats tie you to a supplier from
the minute you decide to use their services. Such lock-in strategy makes it nearly impossible to
choose another supplier without substantial switching costs. Also, nothing prevents the supplier from increasing
their prices after 1 or 2 years. With OpenERP Online, you will not fall into such an inflexible situation.

We guarantee that the software running on OpenERP Online is exactly the same as the Open Source official
version of OpenERP. Any improvement made on OpenERP will be ported online and vice-versa. Therefore, you can
switch from the SaaS version to the local version anytime. This allows you to adapt your infrastructure to the
solution that suits your needs the best - whenever you want. Moreover, you are able to change your service provider
anytime and continue using the exact same system. Hence, you are not dependent on your hosting or even maintenance
partner. In addition, OpenERP works with standard, open formats and programming languages which allow
you to export your data and use it in any other software. These advantages give you total control over your
data, your software, your platform.


OpenERP Online versus Traditional SaaS






	Feature
	OpenERP Online
	Traditional SaaS




	Cloud-independent
	Yes
	No


	Vendor-independent
	Yes
	No


	Platform-independent
	Yes
	No


	Software-independent
	Yes
	No


	Format-independent
	Yes
	No






	Cloud-independent:    Switch to the local application (OpenERP) anytime

	Vendor-independent:   Multiple providers exist to guarantee competition and low prices

	Platform-independent: Work on any operating system and with any browser

	Software-independent: Interface OpenERP Online with 3rd party web-services

	Format-independent:   Export your data in standard reusable format







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	安装 

          	使用OpenERP做SaaS(Software as a Service)服务 
 
      

    


    
      
          
            
  
常见问题(FAQ)


常见问题


本地化OpenERP和在线式OpenErp究竟有什么不同呢？

本地化OpenERP和在线式OpenErp没有什么不同. 在线式OpenERP总是使用最新的官方稳定版.然而, 在线式OpenERP通常包含多种增值服务: 主机, 数据库管理, 稳定安全更新, 备份, 维护, 漏洞修复和迁移等.




签约的在线式OpenERP包含哪些服务呢？

对于每份签约, 我们提供以下硬件资源:



	一个用于WEB和GTK数据的OpenERP应用服务器，

	两个增量备份服务器，

	一个用于备份和监控系统的控制中心。






也包括以下服务:



	
	保养服务

	
	3个工作日内漏洞分析修复

	迁移至每个最新的版本

	安全升级









	位于欧洲或美国的高速宽带数据中心



	7*24小时的监控和维护您的服务器













报价及支付


什么是OpenERP的价格模式？

Our pricing model is simple. We charge $49 or €39 per user, per month. We bill each month according to the number of users registered at that time. If you add new users during the next 30 days they will only be charged with the next invoice.

The storage volume allowed is 1GB. If you use more we will charge $6.5 or €5 per extra GB.




What is the Payment Process?

You will receive an invoice at the beginning of each billing period, according to the number
of active users in the system. Once the invoice is paid, you will get a confirmation that payment
has been successful through the secured payment platform. If you do not pay the invoice within the
payment term, your account will be deactivated. It will however be reactivated automatically on payment.
We will keep your data for 2 months after an account is closed, unless explicitly requested otherwise by the customer.




How can I check my Monthly Usage and Invoice?

Daily statistics on your OpenERP Online usage page are available from the control center.
Statistics include hours of use by instance, hours of use by day or user, monthly invoice amount, space used by
server, etc.






Infrastructure and Security


What is the Infrastructure Provided?

For every OpenERP Online subscription, we provide access to the following infrastructure to
guarantee you maximum reliability and security:



	OpenERP Server and Web Interface

	PostgreSQL database

	Backup servers

	Access to the control center, so that you can control your OpenERP Online instances and perform actions: create new instances, migrations, duplicate instances, access to backups, etc.









Where are the Data Centers Located?

We have two data centers, one in Europe (France) and one in the U.S. (East Coast).




Can I get my Data back?

With OpenERP Online, we want to provide you with the maximum flexibility and avoid the traditional
Lock-In model of SaaS offers. Therefore, the version of OpenERP used in OpenERP Online is the same as
the Open Source version of OpenERP you can install on your premises.

From the control center, you have access to all your backup servers. You can download a
dump of your PostgreSQL database and all your files from our FTP access and switch to an on-site
installation of OpenERP.




Can I get a Shell Access to my Servers?

For security and confidentiality reasons, we do not provide servers’ shell access to our customers.
We only allow 3 OpenERP employees to have a root access to our customers’ servers.






数据导入


I already use OpenERP, can I Migrate to the OpenERP Online Offer?

Yes, this is possible if your instance uses only modules from the latest official (certified) addons. Contact our
sales team to get a quotation: online@openerp.com.




Can I Import Data from other Software applications in my OpenERP Online System?

OpenERP supports data importation from .CSV text files (Comma Separated Values) for any object in the
system. If you can export all your data to .CSV files, you should be able to import it in OpenERP.
For experts, you can also connect your own scripts through web-services. Read our documentation for more
information. We also provide data migration services. Contact us to get a quotation depending on your current
software: online@openerp.com.






服务内容


Can I request some Services for Support and Training?

Yes. We provide services at an extra fee on OpenERP Online: support,
training, help to customize or configure, data importation, etc. You can
also contact an OpenERP partner; most of them provide services on OpenERP
Online as well.




What can I do if I find a bug in OpenERP Online?

All OpenERP Online customers benefit from the OpenERP Publisher Warranty (OPW). If you find a bug, please contact our support team at online@openerp.com.






解决方案


What should I do if I have Specific Needs?

OpenERP gives you much more flexibility than other traditional ERPs. You can design new features
directly in the OpenERP user interface. We provide you with the report designer, the screen and object
editor, a workflow designer, etc. Should you want to develop new modules, we advise you to use the on-site
edition and have your modules certified by OpenERP to guarantee that they will be supported by
OpenERP in the long term.




What Languages are Available?

Over 10 languages are available in OpenERP Online (English, Catalan, Chinese (Simplified), Dutch,
Estonian, French, German, Italian, Polish, Portuguese, Spanish). The OpenERP Online control center is
only available in English.
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在 Linux 上安装 OpenERP

本章介绍在 Linux 上安装OpenERP 6.1 的过程。此过程已在 Ubuntu version 10.04 LTS 严格测试过。 对于熟悉 OpenERP 早期版本的用户而言， 6.1 系列有一个不一样的架构:


	web 客户端已经内置在 OpenERP 服务器中，再不需要单独安装。

	原生的 GTK 客户端作为历史遗留组件仍将保留，但是就像对所有现代应用一样，更推荐以 web 界面来使用 OpenERP 。通常情况下，完全没必要安装GTK 客户端。



对于**基于 Debian 发行版**，OpenERP已经有了All-In-One应用程序包(.deb)，能够简单地一键安装。该包可在 OpenERP 站点的 下载页 [http://www.openerp.com/downloads] 中找到。

对于**基于 RedHat 的平台**，在 nightly builds 上有个试验性的 RPM 发布包。 查看 下载页 [http://www.openerp.com/downloads] 以获取更多信息。

对于**其它的 Linux 发行版** ，以及那些更喜欢**手工安装**的人们，在linux上面部署Openerp 也只需两个步骤：安装 OpenERP 使用的数据库引擎PostgreSQL， 然后安装 OpenERP 自身。 接下来的章节中将介绍这些步骤:



	PostgreSQL 数据库安装和配置
	Ubuntu 上的例子

	为OpenERP设置一个 PostgreSQL 用户
	第一个方法

	第二个方法









	OpenERP 服务器安装
	安装所需要的包

	下载 OpenERP 服务器

	测试 OpenERP 服务器

	安装 OpenERP 服务器

	创建 OpenERP 服务器配置文件
	默认的配置文件









	OpenERP GTK 客户端安装
	安装需要的包

	下载 OpenERP 客户端

	测试 OpenERP 客户端

	安装OpenERP 客户端

	配置 PDF 浏览器





	安装 OpenERP Web 客户端
	运行 OpenERP Web 客户端

	支持的浏览器





	更新你的 OpenERP 安装
	更新次版本/补丁发行版

	更新到一个新的主发行版
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PostgreSQL 数据库安装和配置


Ubuntu 上的例子

在系统命令行提示符下使用下面的命令安装 postgresql 包:

sudo apt-get install postgresql





示例:

openerp@openerp-desktop:/$ sudo apt-get install postgresql





对于 postgresql GUI用户界面 , 使用下面的命令:

sudo apt-get install pgadmin3





示例:

openerp@openerp-desktop:/$ sudo apt-get install pgadmin3





你能在Ubuntu系统菜单找到新的菜单项 pgAdmin III
Applications ‣ Programming ‣ pgAdmin III.




为OpenERP设置一个 PostgreSQL 用户

当所需的软件完成安装后，你必须创建一个PostgreSQL用户。这个用户必须和你的系统用户同名。 OpenERP 将使用这个用户来连接PostgreSQL.


[image: ../../../_images/openerp_postgresql.png]
图示 演示了OpenERP用户如何使用PostgreSQL 用户与其交互




Tip

Database

如果没有按如下所述方式为 OpenERP 创建和配置一个 PostgreSQL 用户, 你就不能用 OpenERP 客户端来创建数据库。




第一个方法

PostgreSQL的默认超级用户叫做 postgres. 你首先要用这个用户登录:

openerp@openerp-desktop:/$ sudo su postgres
password: XXXXXXXXXX





现在用下列命令创建PostgreSQL 用户 openerp :

postgres@openerp-desktop:/$ createuser openerp
Shall the new role be a superuser? (y/n) y





确保新用户成为超级用户。这样你才能用OpenERP客户端创建数据库。
总之, openerp 是一个在PostgreSQL中为OpenERP创建的新用户。这个用户将是OpenERP客户端创建的全部表的所有者。

现在用下列命令列出在PostgreSQL中已经创建的数据库列表:

postgres@openerp-desktop:/$ psql -l





能找到数据库 template1, 运行下列命令使用这个数据库 :

postgres@openerp-desktop:/$ psql template1





要在OpenERP客户端创建的数据库中应用访问权限给角色 openerp ，使用下列命令:

template1=# alter role openerp with password 'postgres';
ALTER ROLE








第二个方法

为OpenERP创建和配置一个PostgreSQL用户的其它方法显示如下:

postgres@openerp-desktop:/$ createuser --createdb --username postgres --no-createrole
--pwprompt openerp
Enter password for new role: XXXXXXXXXX
Enter it again: XXXXXXXXXX
Shall the new role be a superuser? (y/n) y
CREATE ROLE






Note

密码

注意密码是*postgres*.



选项说明:



	--createdb : 新用户能创建新数据库

	--username postgres : createuser 将使用 postgres 用户 (超级用户)

	--no-createrole :  此用户不允许创建新用户

	--pwprompt : createuser 将询问你新用户的密码

	openerp : 新用户的名称






要使用 pgAdmin III 访问你的数据库，你必须如下图所示配置你的数据库连接:


[image: ../../../_images/new_server_registration.png]


现在，你可以启动 OpenERP 服务器了。根据你的需求，你可能还要修改OpenERP的配置文件，该文件通常在 ~/.openerprc。


Tip

开发手册

你能在开发手册找到配置文件有关的信息, 章节 Configuration
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OpenERP 服务器安装


安装所需要的包

OpenERP 6.1要求Python 2.6 或更新. 这已经内建在 Ubuntu 10.04 及之上.
还需有几个Python库，已经列表于下.

在基于Debian 的 Linux 发行版，你能用下面一条指令安装所有依赖:

apt-get install python-dateutil python-feedparser python-gdata python-ldap \
    python-libxslt1 python-lxml python-mako python-openid python-psycopg2 \
    python-pybabel python-pychart python-pydot python-pyparsing python-reportlab \
    python-simplejson python-tz python-vatnumber python-vobject python-webdav \
    python-werkzeug python-xlwt python-yaml python-zsi






	dateutil : 此模块提供了强大的扩展以处理标准日期时间，用于 Python 2.3+.

sudo apt-get install python-dateutil







	feedparser : 用于Python 的通用聚合解析器

sudo apt-get install python-feedparser







	gdata : Google Data Python 客户端库

sudo apt-get install python-gdata







	ldap : LDAP 接口 module

sudo apt-get install python-ldap







	libxslt1 : Python bindings for XSLT transformation library

sudo apt-get install python-libxslt1







	lxml : lxml 是个具有丰富特性且易用的库， 用于 Python 语言处理 XML 和 HTML.

sudo apt-get install python-lxml







	mako : 用于 python平台的快速、轻量的模版.

sudo apt-get install python-mako







	openid : OpenID 身份认证，支持服务器和消费者

sudo apt-get install python-openid







	psycopg2 : 最大众化的python PostgreSQL 接口.

sudo apt-get install python-psycopg2







	babel : Python 应用的国际化工具

sudo apt-get install python-pybabel







	pychart :  封装了 Postscript, PDF, PNG, or SVG charts 的高质量的库.

sudo apt-get install python-pychart







	pydot :  提供了 Graphviz’s dot language的完整的特性，包括创建，保存，修改，处理图像.

sudo apt-get install python-pydot







	pyparsing : 解析 Python 代码的库

sudo apt-get install python-pyparsing







	reportlab : ReportLab 工具是个经时间证明，超强，开源的引擎，以 RML 为基础，用于 编程创建 PDF 文档和 and 表格L. 也包括了一个创建平台无关的向量图像的库.是用 python 写成的一个快速、灵活、可伸缩、交叉平台解决方案。

sudo apt-get install python-reportlab







	simplejson : 简单，快速，可扩展的 JSON 编码和解码器

sudo apt-get install python-simplejson







	vatnumber :  用于欧洲国家的检查 VAT（增值税号）的模块

sudo apt-get install python-vatnumber







	vobject : VObject simplifies the process of parsing and creating iCalendar and vCard objects.

sudo apt-get install python-vobject







	pytz : 用于的 世界时区定义

sudo apt-get install python-tz







	webdav : 用python 实现的 WebDAV 服务器

sudo apt-get install python-webdav







	werkzeug : WSGI应用程序 工具集合

sudo apt-get install python-werkzeug







	yaml : 用于 Python 的 YAML 解析器和发射器。

sudo apt-get install python-yaml







	xlwt : 读写 Microsoft Excel 电子表格文件的模块

sudo apt-get install python-xlwt







	zsi :  Zolera Soap 客户端基础

sudo apt-get install python-zsi












下载 OpenERP 服务器

OpenERP 服务器可从这里下
载 OpenERP 网站的下载页面 [http://www.openerp.com/downloads]




测试 OpenERP 服务器

如果你只想测试服务器, 你不需要安装它.仅仅解包并
启动  openerp-server 执行文件即可:

tar -xzf openerp-6.1-latest.tar.gz
cd openerp-6.1-*
./openerp-server





可用的下面的命令行参数列表能通过 命令行开关 -h 获得:

openerp-server -h








安装 OpenERP 服务器

OpenERP 服务器能非常容易地使用 setup.py 文件安装:

tar -xzf openerp-6.1-latest.tar.gz
cd openerp-6.1-*
sudo python setup.py install





如果 PostgreSQL 服务器已经启动并正在运行，你能用下列命令运行OpenERP 服务器:

openerp-server





如果你还没有启动 PostgreSQL 服务器并运行，请参阅 PostgreSQL 数据库安装和配置.




创建 OpenERP 服务器配置文件

你能用 -s 选项启动OpenERP服务器 用默认的选项 创建一个配置文件，然后进行修改。
配置文件参数类似服务器的启动参数。如果你不能确定一个参数是干啥的，可以用命
令 openerp -h 看看该参数是干啥的

./openerp-server -s -c <config_file_path>
# 现在编辑 <config_file_path> 中的配置文件
# 用 -h 选项输出更多的明细说明...
./openerp-server -h
(...)
# 最后，用所需的配置文件启动服务器
./openerp-server -c <config_file_path>






默认的配置文件

默认的OpenERP文件存放于 $HOME/.openerp_serverrc,
是运行OpenERP的系统用户的Home 目录中，其名称为 .openerp_serverrc 。
这是 -c 启动参数的默认值。
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OpenERP GTK 客户端安装

原生的GTK客户端是历史遗留物，会继续为仍有需要的用户服务，但推荐用内置的web界面来访问OpenERP 6.1。


安装需要的包

OpenERP 6.1要求Python 2.6 或以上版本。 在Ubuntu 10.04 及以上版本系统已自带。 还有几个Python库是需要的，下面会列举出来。

在基于 Debian 的 Linux 发行版中，可能用这样的单个命令来安装所有要求的依赖包:

apt-get install python-gtk2 python-glade2 python-matplotlib python-dateutil \
    python-lxml python-tz python-hippocanvas python-pydot






	gtk : GTK+ is a highly usable, feature-rich toolkit for creating graphical user interfaces which boosts cross-platform compatibility and an easy-to-use API.

sudo apt-get install python-gtk2







	glade : Glade is a RAD tool to enable quick & easy development of user interfaces for the GTK+ toolkit and the GNOME desktop environment.

sudo apt-get install python-glade2







	matplotlib : matplotlib is a Python 2D plotting library which produces publication quality figures in a variety of hard-copy formats and interactive environments across platforms.

sudo apt-get install python-matplotlib







	dateutil : Provides date/time values in Python

sudo apt-get install python-dateutil







	lxml : XML support for Python platform.

sudo apt-get install python-lxml







	tz : World Timezone definitions for Python.

sudo apt-get install python-tz







	hippocanvas : The Hippo Canvas is a Cairo/GObject/GTK+ based canvas, written in C with support for flexible layout, CSS styling, and initial work on animations.

sudo apt-get install python-hippocanvas







	pydot : Python interface to Graphviz’s Dot language.

sudo apt-get install python-pydot







	任意的 PDF 浏览器，在系统中适度注册，以便能自动打开 PDF 文件 (例如 xpdf, kpdf, acroread, evince, 等等)。
请看 配置 PDF 浏览器 一节.






Note

基于RedHat的发行版

替代上面用在 基于Debian发行版的命令,
下面的命令将安装基于RedHat 的系统所需要的依赖

yum install pygtk2 glade3 pydot python-dateutil python-matplotlib \
    python-lxml python-hippo-canvas python-tz








Note

Mandriva

替代上面用在 基于Debian发行版的命令,
下面的命令将安装Mandriva系统所需要的依赖

yum install pygtk2 glade3 pydot python-dateutil python-matplotlib \
    python-lxml python-hippo-canvas python-tz










下载 OpenERP 客户端

OpenERP 客户端能从 OpenERP 网站的下载页面 [http://www.openerp.com/downloads]  下载。




测试 OpenERP 客户端

如果你只是要测试客户端, 你不必安装，只要解包并启动 openerp客户端的执行文件:

tar -xzf openerp-client-6.1-latest.tar.gz
cd openerp-client-6.1-*/bin
./openerp-client.py





使用 -h 命令行开关能获得一个可用的命令行参数的列表:

./openerp-client.py -h








安装OpenERP 客户端

客户端可以非常容易地用 setup.py 文件安装:

tar -xzf openerp-client-6.1-latest.tar.gz
cd openerp-client-6.1-*
sudo python setup.py install





你能用下列命令运行客户端:

openerp-client








配置 PDF 浏览器

默认时， OpenERP 客户端将使用默认的 PDF 应用程序来显
示 PDF 文件。你可以在系统中配置一个不一样的默认PDF应用来定制此行为。

作为选择，你也能在配置文件明确指定一个 PDF 指令用来显示PDF 文件，
通常此文件保存在HOME目录，命名为 '.openerprc' 。
找到 [printer] 节并编辑 softpath 参数。例如:

[printer]
softpath = kpdf
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安装 OpenERP Web 客户端

截至OpenERP 6.1，web 客户端已成为标准
all-in-one 安装过程的一部分，因此不需要额外的步骤来安装它。

all-in-one 版本可以从 OpenERP 网站的下载页面 [http://www.openerp.com/downloads]  下载。


运行 OpenERP Web 客户端

一旦Openerp 服务器启动运行，OpenERP 6.1 的web客户端就自动可用了。用你喜爱的浏览器链接OpenERP服务器的地址和端口来访问，
默认是 http://localhost:8069.




支持的浏览器

已知OpenERP WEB 客户端在Google Chrome 和 Mozilla Firefox的最新版本中可以更好地工作。
下列浏览器被支持:



	Google Chrome 9.0 以及更新的

	Firefox 4.0 以及更新的

	Safari 4.1 以及更新的

	Opera 10.0 以及更新的

	Internet Explorer 8.0 以及更新的 (强烈建议更新的版本)







Note

从OpenERP 6.1开始, 访问web接口不再需要flash 插件。
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更新你的 OpenERP 安装


更新次版本/补丁发行版

OpenERP的发布策略是 通常每个月发布稳定版本的次版本/补丁。 这些建议部署在生产环
境,因为它们包括最新的安全更新和错误修正,并且需要任何迁移过程。

当然，当然,你总是应该在应用到实际生产环境之前，在一个模拟环境（生成环境的
拷贝）中测试这些更新。

OpenERP的小版本/补丁发行版用增加第3个发行号来标识，例如 v6.0.5是  OpenERP v6.0 的第15个补丁发行.

关于发行周期的更多信息，参阅 OpenERP 版本发布常见问题 。


Note

Minor

你能跳过 minor 版本, 例如,如果你要升级一个已经过时的版本，只要你还停留在同一个版本线中，你不必安装从 6.0.6 到 6.0.15 的所有发行版（例如：例子中的6.0），



升级一个已有的 OpenERP 安装到较新的补丁发行版，归结为两个操作:



	安装新的代码覆盖已有的一个

	用新的代码同步每个已有的数据库






为了实现这些，下面的步骤将给你一个最好的结果 :



	为所有数据库制作一个新的备份, 而且要备份你的Openerp安装的全部文件（服务器和addons），以防万一。



	找到启动服务器的执行文件,通常是``openerp-server.py``。 你可能要看一下运行过程，找出传递给服务器的命
令行参数(下面需要).



	停止 OpenERP 服务器.



	升级最新发布的源文件e,或者简单地按一个新的发布覆盖以前的一个。



	用下来附加参数手动启动服务器 (直接调用上面找到的执行文件), 基于新的源文件，升级数据库中所有
模块数据和视图 (包括你常用的启动参数,并且用你要升级的数据库名称替换 DB_NAME):

openerp-server.py -d DB_NAME -u all







	让服务器完成他的启动 (查看日志的最后一条消息： OpenERP server is running, waiting for connections 或者
等到你能用GTK客户端连接到数据库 ), 然后用 Ctrl+C 停止服务器 ，并且为OpenERP安装的每个数据库重复上述
步骤 (任何数据库没有更新，将使用最新的业务逻辑，但是可能有错误或者在视图中丢失改进的东西，直到你用这个步骤更新).



	再次用 Ctrl+C 停止服务器 并且正常重启(不需要额外参数).



	现在可以更新 GTK 客户端，简单地重新安装一个最新版覆盖前面版本即可。









Note

服务器

作为一个选中，在更新模式为每个数据重启服务器，如上面所述，你可以横穿启动服务器，然后作为*Administrator* 用户连接到每个数据库, 打开模块列表，手工触发 base 模块的升级.因为所有的模块依赖于 base，他们也将被升级。然而这要求每个数据库的 Administrator 密码，特别是当这些更新阻止你的系统.




Tip

开发指南

为了更多在真实的譬如完成服务器升级的技术信息, 你参考开发指南的相关章节: Upgrading Server, Modules.






更新到一个新的主发行版

在过去，主要的稳定发行版的频率是波动的, 但是当前策略是平均每6个月发布一个新的稳定版本, 三个稳定版之间有个一个是长期支持版（LTS）.一个LTS版本通常是正常稳定的版, 是在 OpenERP Publisher’s Warranty (OPW)下面支持长时间。稳定版用两个部件标记为一个小数(例如 6.1),在最左边的部分显示相应的长期支持(LTS)版本,第二个数字指示了在两个LTS版之间的连续稳定版本。

过渡到下个主发行版意味着比小发行版多得多的变化。从主发行版到下一个，因为基础的Openerp数据结构的演进非常大,对已有的数据，需要一个完整的迁移。
每个主发行版，将发布具体建议和过程，以升级一个已有的Openerp系统到下一个主版本。
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在Windows上安装OpenERP

在本章，你将看到OpenERP v6.1在Windows系统上的安装。这个流程在Windows 7上很好地测过。

在Windows系统上安装OpenERP有两个选择：


	
	All-In-One 安装

	这是安装OpenERP最快捷的方式。在计算机上安装并配置所有的组件（OpenERP服务器，客户端，WEB以及PostgreSQL数据库）。如果没有很大的系统定制，推荐这种安装方式。







	
	独立安装

	如果选择这种安装模式，运行OpenERP所需的组件需要分别下载和安装。如果计划在不同机器上安装这些组件，须选择独立安装方式。如果已经在用或者计划使用不同于完整安装版本的PostgreSQL，这个模式也比较可行。











	OpenERP完整（All-In-One）安装
	下载OpenERP完整安装包

	安装OpenERP完整包（All-In-One）

	连接到 OpenERP





	PostgreSQL 数据库安装与配置
	PostgreSQL 数据库安装

	配置PostgreSQL角色用户
	新增用户

	大小写不敏感搜索问题









	OpenERP服务器安装
	下载 OpenERP 服务器

	安装 OpenERP 服务器

	定制配置
	决定数据库目的
	指定安装模块及示例数据

	不带示例数据

	更新数据库









	监控 OpenERP 服务器

	恭喜，您的OpenERP Server已经安装成功啦！





	OpenERP GTK 客户端安装
	下载 OpenERP GTK 客户端

	安装 OpenERP GTK 客户端

	启动 OpenERP GTK 客户端





	OpenERP Web 安装
	运行 OpenERP Web 客户端

	支持的浏览器





	问题解决和Windows补充安装信息
	PostgreSQL 管理
	OpenERP Server 链接 PostgreSQL 错误









	更新你的 OpenERP 安装
	Going to a Newer Minor/Patch Release

	Going to a Newer Major Release
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OpenERP完整（All-In-One）安装

每当有新的版本的时候，OpenERP都会提供一个完整的Windows自动安装包。安装包包含你需要的所有组件 – PostgreSQL数据库服务器，OpenERP应用服务器，GTK应用客户端以及WEB客户端。

这个自动安装包能够让你仅仅点击几次鼠标就可以安装整个系统。在安装过程中完成初步配置，系统可以很快好用，无需改变底层代码。虽然安装包倾向于在单机上安装所有的东西，你还可以从其它的PC机、Mac机、Linux盒子连接GTK客户端。


下载OpenERP完整安装包

第一步是下载OpenERP完整安装包。在这个阶段，必须选择哪个版本 – 稳定版或开发版。如果你想直接用于生产，那么我们强烈推荐你选择稳定版。


Note

稳定版和开发版

OpenERP开发双轨平行进行有稳定版和开发版。

新功能整合到开发分支。这个分支比稳定版分支先进，但是可能还有未发现和未解决的问题。开发版约每月发布一次，你可以从OpenERP代码库下载最新的版本。

稳定版是为生产环境设计的。新功能版本要经过长期测试和验证后（大概）一年发布一次；  这个当中仅仅发布BUG补丁。



按照以下步骤下载用于Windows的OpenERP：


	访问站点：http://www.openerp.com

	点击右边 Downloads 按钮，然后在 Windows Auto-Installer 下面选择 All-In-One

	在可以下载之前，你将被要求填写一个在线表格：你的联系方式和公司详情以及有关你对OpenERP兴趣的信息。

	提交在线表格之后，Windows完整安装包就可自动下载了。

	在你的PC上保存文件 – 因为要下载包含PostSQL数据库系统（撰写此文的时候版本是8.3）的所有东西，尺寸确实有些大，下载要费点时间。






安装OpenERP完整包（All-In-One）

要安装OpenERP及其数据库，你必须以管理员身份登录你的PC。

如果你之前曾经安装过OpenERP完整版，你先需要卸载掉它，因为之前安装的各种元素可能会与新的安装冲突。确保所有Tiny ERP，OpenERP以及PostgreSQL应用已经移除：你极可能需要重启你的PC完成所有残余的移除。

双击安装文件安装OpenERP并接受接下来每个对话框的默认参数。完整安装包是最简单的安装模式，有如下步骤：


	
	
	选择安装语言

	默认语言是英文；其他选项有法语。











	
	
	欢迎信息

	小心仔细遵循这步给出的推荐。















[image: ../../../_images/a2_welcome.png]
欢迎安装OpenERP







	
	
	许可证协议

	你要接受GNU公共许可才能继续安装，这很重要。











	
	
	选择安装组件

	你可以以默认安装方式，完整安装OpenERP服务器，GTK桌面客户端，WEB客户端以及PostgreSQL数据库（撰写此书的时候版本是8.3）或者你可以定制安装你需要的组件。










[image: ../../../_images/a4_components.png]
组件定制安装





	
	
	配置PostgreSQL链接

	安装包将建议默认参数，完成你的PostgreSQL链接配置。你可以接受默认配置或者按照你的需要变更。










[image: ../../../_images/a6_config_postgres.png]
PostgreSQL 配置





	
	
	选择安装目录

	默认情况下，OpenERP安装在 ‘’C:ProgramFilesOpenERP 6.0’‘。要安装到不同的目录，在这步浏览不同的位置。











	
	
	安装

	OpenERP自动安装开始，你能看到安装进度。











	
	
	完成

	成功安装OpenERP，你会得到一个适当的确认。你可以点击完成结束安装向导。










[image: ../../../_images/a9_finish.png]
结束安装向导










连接到 OpenERP

你不需要手工启动OpenERP服务器，OpenERP服务器安装为Windows服务，会自动启动。不过，你还可以开始菜单的OpenERP快捷方式进入，或者用你喜欢的浏览器连接web接口，默认情况下接口在``http://localhost:8069``。

用右上角的数据库列表选择要连接的数据库。如果你是安装后第一次使用的话，你的数据库列表是空的。你可以通过登录界面的 ‘’管理数据库’’ 链接创建新的数据库。
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PostgreSQL 数据库安装与配置

在本章节，你将看到如何配置PostgreSQL用于OpenERP。以下流程在PostgreSQLv9.0上很好地测试过。


PostgreSQL 数据库安装

你可以从这里下载Windows 安装包 PostgreSQL download page [http://www.postgresql.org/download/windows]

依照你的需要，选择One Click安装包，或选择pgInstaller，然后运行你刚下载的可执行文件。




配置PostgreSQL角色用户

当所需的软件安装完成，你必须设置一个PostgreSQL用户。OpenERP将使用这个用户连接到PostgreSQL。


新增用户

启动Windows控制台（在开始菜单的搜索程序和文件文本框运行 ‘’cmd’’ 命令）。

变更目录到 PostgreSQL bin 目录
(例如 C:\Program Files\PostgreSQL\9.0\bin) 或者将这个目录添加到你的 PATH 环境变量。

PostgreSQL的默认超级用户叫 postgres。密码是你在安装过程中设置的。

在你的 Windows 控制台，输入:

  C:\Program Files\PostgreSQL\9.0\bin>createuser.exe --createdb --username postgres --no-createrole --pwprompt openpg
  Enter password for new role: openpgpwd
  Enter it again: openpgpwd
  Shall the new role be a superuser? (y/n) y
  Password: XXXXXXXXXX

* line 1 is the command itself
* line 2 asks you the new user's password
* line 3 asks you to confirm the new user's password
* line 4 new role is superuser or not?
* line 5 asks you the *postgres* user's password





选项解释:



	--createdb : the new user will be able to create new databases

	--username postgres : createuser will use the postgres user (superuser)

	--no-createrole : the new user will not be able to create new users

	--pwprompt : createuser will ask you the new user’s password

	openpg : the new user’s name. Alternatively, you may specify a different username.

	openpgpwd : the new user’s password. Alternatively, you may specify a different password.







Note

密码

在OpenERPv6，openpg和openpwd是OpenERP服务器安装过程使用的默认用户名和密码。如果你计划变更这些默认设置，或者已经用不同的值安装了服务器，你需要用那些用户配置值创建用于OpenERP的PostgreSQL用户。



现在使用 pgAdmin III 创建数据库 “openerpdemo” ，数据库所有者是 “openpg”:

CREATE DATABASE openerpdemo WITH OWNER = openpg ENCODING = 'UTF8';
COMMENT ON DATABASE openerpdemo IS 'OpenERP Demo DB';





如果你已经安装了OpenERP服务器，那么现在你可以启动它了。如果需要，你可以在Windows控制窗，通过指定命令行选项，覆盖服务器配置。有关于此更多信息，参见这部分 定制配置.

在任何Windows版本，执行如下命令，改变用户密码:

net user <accountname> <newpassword>
e.g. net user postgres postgres





如果它是个域帐号，那么只要在后面添加 “/DOMAIN” 。

如果你想删除它, 只需要执行:

net user <accountname> /delete








大小写不敏感搜索问题

因为安装需要完全UTF8字符支持，考虑用postgres >= 8.2.x。使用这个之前的版本，OpenERP搜索合作伙伴、产品等将不会返回想要的大小写不敏感搜索结果。

例如:

SELECT 'x' FROM my_table WHERE 'bét' ilike 'BÉT'
--matches only in 8.2.x
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OpenERP服务器安装

OpenERP 服务器6.1安装运行于NTFS格式硬盘（而非FAT或FAT32分区）。以下安装流程在Windows 7上很好地测试过。


Note

Windows 版本

OpenERP服务器不行运行于Windows 98或者ME；原因很显然，这些版本不能用NTFS格式化。



你需要一个运行的PostgreSQL服务器。如果没有，你可以阅读PostgreSQL服务器安装和配置部分 PostgreSQL 数据库安装与配置 。


下载 OpenERP 服务器

OpenERP服务器可以从OpenERP网站下载页面下载 <http://www.openerp.com/downloads>`_.

在 Windows Auto-Installer 下面, 选择 All-In-One 来下载 OpenERP。




安装 OpenERP 服务器

Execute the installer you have just downloaded. It has the following stages:


	
	
	选择安装语言

	The default is English. The other option is French.











	
	
	欢迎信息

	Carefully follow the recommendations given in this step.











	
	
	许可协议

	It is important that you accept the GNU General Public License to proceed with installation.











	
	
	选择安装目录

	By default, OpenERP Server is installed in C:\Program Files\OpenERP 6.1\Server. To install in a different folder, browse for a different location(folder) in this step.











	
	
	配置 PostgreSQL 连接

	The installer will suggest default parameters to complete your PostgreSQL connection configuration. You may accept the defaults, or change it according to your requirement.















[image: ../../../_images/s5_config_postgres.png]


PostgreSQL 配置





	
	
	生成快捷

	Select a folder in the Start menu where you would like to create the program’s shortcuts.















[image: ../../../_images/s6_shortcuts.png]


生成开始菜单快捷





	
	
	安装

	The automatic installation of OpenERP Server begins and you can view its progress.











	
	
	完成

	On successful installation of OpenERP Server, you will get an appropriate confirmation. You can click Finish to close the setup wizard.















[image: ../../../_images/Openerp_server_finish_install.png]


End of setup wizard




The OpenERP Server installs as a Windows service. This means you do not have to start the
server each time you start the computer and it runs without the need of an open user
session.




定制配置

To initialize the server with configurations of your choice, you have to invoke it at the Windows Command prompt with the options you wish to override.

Navigate to the
installation directory in C:\Program Files\OpenERP 6.1\Server\
and type this command but do not execute it yet:

openerp-server.exe -d <db_name> -r <db_user> -w <db_password>
--db_host=<postgresql_server_address>
--db_port=<port_no> --logfile="<logfile>"





The initialization of OpenERP Server provides necessary information for connection
to the PostgreSQL database and the choice of data to load. Here is the
explanation of used options:



	-d <db_name> : Name of the database created for OpenERP Server.

	-r <db_user> : Name of the PostgreSQL user (role).

	-w <db_password> : Password of the PostgreSQL user.

	--db_host=<postgresql_server_address> : Address of the server where PostgreSQL is. If
you have installed PostgreSQL on the same computer as OpenERP Server, you can enter
localhost, else, the IP address or the name of the distant server.

	--db_port=<port_no> : Port number where PostgreSQL listens. The default is 5432.

	--stop-after-init : This option stops the server after initialization.

	--logfile="<logfile>" : specify an alternate logfile where all the output of server will be
saved. The default is C:\Program Files\OpenERP 6.1\Server\openerp-server.log.






Before the execution of this command you have to decide the purpose of the database created in OpenERP.

Sample command:

openerp-server.exe -d openerpdemo -r openpg -w openpgpwd
--db_host=localhost --logfile="C:\Users\tiny\Desktop\demo_db.log"
--db_port=5430 --stop-after-init





Here you have to enter the username and password specified in the PostgreSQL connection configuration during server installation.

When you execute the initialization command, if you specify a logfile, the server runtime output is written to that file, and you will not see any server output in the prompt window. You have only to wait until the prompt comes back.


决定数据库目的

You can initialize the database with OpenERP Server to:



	Take a look at the system with modules installed and demo data loaded

	Install a new clean database system (without demo data)

	Upgrade an existing version







指定安装模块及示例数据

If you execute the sample command above, you will get a database with only base modules installed and loaded with demo data.
To initialize OpenERP Server with additional modules and its demo data, you need to add this option to the above
command:

-i <module name>





Sample command:

openerp-server.exe -d openerpdemo --stop-after-init -i sale





This command will initialize the OpenERP Server with the module sale and its dependencies, and fill its PostgreSQL database with their related demo data. As can be seen, you must specify the target database for the module installation.

To install more than one module, specify a comma-separated module list at the command-line.




不带示例数据

Execute the command with an option excluding the demo data:

--without-demo=all





This will load base modules (and other modules if -i option is used), but will not load its demo data.

Sample command usage:

openerp-server.exe -d openerpdemo --stop-after-init --without-demo=all





If you have already initialized the database with demo data loaded, you can create
a new database and execute the above command on it.




更新数据库

Execute the command with an option that updates the data structures:

--update=all





Sample command usage:

openerp-server.exe -d openerpdemo --stop-after-init --update=all












监控 OpenERP 服务器

The service and some runtime information is accessible through the Computer Management console in
Administrative Tools.


[image: ../../../_images/Openerp_service_mmc_terp_service.png]


OpenERP 6.1 in the Services list

Here, you can define how the service should act in case of server failure. Access the service’s properties by double-clicking OpenERP 6.1 in the list.


[image: ../../../_images/Openerp_service_mmc_control_actions.png]


Recovery tab to set service failure response

The Computer Management logging service offers additional information about the execution of the OpenERP Server, for example, the startup or shutdown information of the service.


[image: ../../../_images/Openerp_service_mmc_logs.png]


Server information in Windows Logs list

OpenERP Server runtime output can be found in the default logfile.
Given that the server is now running as a Windows service, it does not output any runtime
messages. For this, the logfile is the only option. Access it from the Start menu, through the View log link in the group of shortcuts for OpenERP 6.1. Alternatively, use the path C:\Program Files\OpenERP 6.1\Server\openerp-server.log.


[image: ../../../_images/log_file.png]


OpenERP Server log file

You can find out whether OpenERP is running by invoking Windows Task Manager.
When you look at the Processes tab, you will see OpenERPServerService.exe and openerp-server.exe, both having SYSTEM as their user (to see these, Show processes from all users must be enabled in the Task Manager).


[image: ../../../_images/Openerp_service_running.png]


The services in Windows Task Manager




恭喜，您的OpenERP Server已经安装成功啦！

For more information, please take a look at
Additional Installation Information and
Troubleshooting,
where you can find some troubleshooting examples.
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OpenERP GTK 客户端安装

原生GTK客户端可作为传统接口，给那些还需要它的用户，但推荐使用内置web接口访问OpenERP6.1。

在使用OpenERP客户端之前必须安装，配置和运行OpenERP服务器。客户端需要服务器运行。你可以在你的电脑上安装服务器应用，或者在安装在网络内的独立服务器上。


下载 OpenERP GTK 客户端

您可以从  OpenERP 官网下载 [http://www.openerp.com/downloads]  OpenERP GTK 客户端安装文件.

在`Windows Auto-Installer`下面, 选择 Client 来下载独立的 OpenERP 客户端。




安装 OpenERP GTK 客户端

点击你刚下载的可执行安装文件，进行如下步骤：


	
	
	选择安装语言

	默认是 English。其它选项有 French。











	
	
	欢迎页面

	仔细遵循这步给出的的建议。











	
	
	版权协议

	你要接受GNU公共许可证才能进行安装，这很重要。











	
	
	选择安装路径

	默认情况下，OpenERP 客户端安装在 C:\Program Files\OpenERP 6.0\Client。要安装到不同目录，可在这步可以浏览不同的位置（目录）。











	
	
	创建快捷方式

	在’开始’ 菜单选择你要创建的程序快捷链接的目录















[image: ../../../_images/c5_shortcuts.png]


生成开始菜单快捷链接





	
	
	开始安装

	OpenERP 客户端自动安装开始，你能看到安装进度。











	
	
	安装完成

	成功安装OpenERP客户端，你会得到一个适当的确认。点击’完成’关闭安装向导界面。















[image: ../../../_images/c7_finish.png]


结束配置向导







启动 OpenERP GTK 客户端

安装程序在开始菜单和桌面生成快捷链接，你可以用来启动客户端。要能使用客户端软件，须确保OpenERP正在运行（在你的电脑上或者远程电脑上）。

用默认用户名和密码登录到 openerpdemo 数据库:



	Username = admin

	Password = admin






祝贺！



[image: ../../../_images/client_startup.png]


链接到演示数据库
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OpenERP Web 安装

从6.1开始，web 客户端已经作为标准的安装包一部分包含在all-in-one 内，不需要另外安装了。

all-in-one 版本可从`OpenERP 网站的下载页面 <http://www.openerp.com/downloads>`_下载。


运行 OpenERP Web 客户端

当OpenERP服务器启动以后，OpenERP 6.1网页客户端已经自动准备就绪.你可以用你喜欢的浏览器访问OpenERP服务器地址和端口，默认值为：
“http://localhost:8069”.




支持的浏览器

最新版本的Google Chrome 和 Mozilla Firefox浏览器和OpenERP网页客户端兼容性最好.
支持的浏览器如下：



	Google Chrome 9.0 or later

	Firefox 4.0 or later

	Safari 4.1 or later

	Opera 10.0 or later

	Internet Explorer 8.0 or later (later is strongly recommended)







Note

From OpenERP 6.1, no flash plugin is required to access the web interface
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问题解决和Windows补充安装信息


PostgreSQL 管理


OpenERP Server 链接 PostgreSQL 错误

如果你从命令行用指定的用户名/角色（-r）和密码（-w）初始化一个数据库，请确保你已经创建了一个一致的 POstgreSQL 用户。
否则你会遇到如下显示的错误信息：


[image: ../../../_images/user_fail.png]


User authentication failure 用户认证失败

你也会遇到其它的类似下述情形的问题：


[image: ../../../_images/101_erp2pgsql_conn_fail.png]


Database connection failure

In this case, check if the service postgresql-9.0 - PostgreSQL Server 9.0 is running in the Services Manager (Control Panel ‣ System and Security ‣ Administrative Tools ‣ Services).


[image: ../../../_images/Pgsql_51_service_status.png]


PostgreSQL 9.0 in the Services list

You can edit the service configuration to start PostgreSQL as a service on system boot. This is usually the default.


[image: ../../../_images/Pgsql_53_service_start_mode.png]


Configure PostgreSQL 9.0 service

If your PostgreSQL service is running, but you get connection errors, you can restart the service.


[image: ../../../_images/Pgsql_52_service_restart.png]


Restarting the service
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更新你的 OpenERP 安装


Going to a Newer Minor/Patch Release

OpenERP’s release policy states that minor/patch releases of the stable
versions are usually published every month. These are recommended for
production deployment, as they include the latest security updates and bugfixes,
and do not require any migration process.

Of course you should always test these updates on a staging environment
(copy of your production environment) before actually applying them on the real
production systems.

For more details regarding the release cycle, have a look at the section
OpenERP 版本发布常见问题.

Minor/patch releases of OpenERP are identified by an increasing 3rd release
number, for example, v6.0.15 would be the 15th patch release of OpenERP v6.0.


Note

Minor Versions

You can skip minor versions, for example, you do not need to install all the intermediary versions between 6.0.6 and 6.0.15 if you need to upgrade an outdated installation, as long as you stay in the same version line (6.0 in this example).



Updating an existing OpenERP installation to a newer patch release boils down to 2 operations:



	Install the new code over the existing one

	Synchronize each existing database with the new code






In order to accomplish this, the following step-by-step procedure should give you
the best results:



	Make a fresh backup of all existing databases, as well as a backup of the files
of your OpenERP installation (server and addons), just in case.



	Stop the OpenERP server.



	Update the source files to the latest release, or simply install the new releases
over the previous ones. If need be, you can uninstall the previous version, but
be sure to avoid uninstalling PostgreSQL, as this could delete
your current databases!



	Locate the separate server executable openerp-server.exe (this is not the
executable used by the Windows Service!). It should be in the location where
you installed OpenERP Server, for example in C:\Programs\OpenERP 6.0\Server.



	From a Command-Line Prompt, start the server executable manually (directly call
the executable you located above), with the following parameters, to trigger an
update of all module data and views in the database, based on the new source files
(include your usual startup parameters, if any, and replace DB_NAME with the name
of the OpenERP database you wish to update):

openerp-server.exe -d DB_NAME -u all







	Let the server complete its startup (watch the log file for the final message that
says OpenERP server is running, waiting for connections or wait until you can
connect to that database with a GTK client), then stop the server using the Ctrl+C
key combination and repeat previous step for each database on this OpenERP installation
(any database not updated will use the latest business logic but might have errors
or missing improvements in the views until you update it using this procedure).



	Stop the server again with Ctrl+C and restart it normally as a service.



	You can now proceed with the update of the GTK clients, which can be done
separately by simply reinstalling the latest version over the previous one.









Note

Server

As an alternative to restarting the server in update mode for each database, as described above, you may try to start the server normally after installing the new version, and then connect to each database as the Administrator user, open the list of modules and manually trigger an update of the base module.

Because all modules depend on base they will be updated too. However this requires the Administrator password of each database and may not work for some updates, specifically when the update prevents you from logging into the system.




Tip

Developer Book

For more technical details on the actual operations accomplished by the server during such an update, you may refer to the corresponding section in the Developer Book: Upgrading Server, Modules.






Going to a Newer Major Release

OpenERP’s release policy states that one or two major releases are published from the
development version every year. Transitioning to the next major release implies a lot
more changes than jumping to another minor release.
As the underlying OpenERP data structures usually evolve quite a bit from one major release
to the next, a full migration of the existing data is needed.
Each major release will be published with specific recommendations and procedures for
upgrading an existing OpenERP system to the next major version.


Note

Major Release

For major releases, it is usually not possible to skip one release, for example upgrading directly from OpenERP 4.2 to OpenERP 6.0. If you need to do such an upgrade, you will simply have to do each intermediary upgrade one after the other.
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OpenERP Publisher Warranty 迁移



	如何进行数据库迁移?
	迁移步骤

	如何恢复数据库备份?

	如何保证数据库数据安全?
	Anonymization History

	Anonymize database

	Anonymized Fields
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如何进行数据库迁移?


[image: ../../_images/migration.png]
迁移步骤



你必须遵循下面的3～4个步骤以进行数据库迁移。我们建议您至少实践这个步骤两次（如果你愿意的话，你也可以多做几次）：首先，在将你的数据库发给我们之后，你需要知道你选择迁移的版本，而且必须进行测试，检查并确认数据正确以及过程正常；在测试验证通过后，你就可以准备实际的迁移。将你的最新版本的数据库发给我们，我们将再次应用该迁移步骤，然后你就可以获得迁移后的数据库以用于生产环境的安装和使用。

We remind you, that you are in charge of your database cleaning, and that the migration warranty concerns all certified modules only. If you made some specific developments and want to keep them, be sure that they are grouped in a certified module. (For further information, have a look at our OpenERP Publisher’s Warranty or contact our technical team at support@openerp.com or +32 81 81 37 00 if you want to certify your modules.)


迁移步骤


	第1步: 上传你的数据库




Create a backup of your database and upload it. You can anonymize your data before uploading the database. For further information, see 如何恢复数据库备份? and 如何保证数据库数据安全?.



	第2步: 我们迁移数据库操作，并做严格测试




Once we receive your database, we run our migration process and test your database.




	If the migration process ended without any problem, you will receive an email within a few hours, with a link where you can download your migrated database. You may then go directly to step 4.

	If the migration process does not end automatically, you will receive an email within a few hours, explaining that the migration process encountered some difficulties and that a manual intervention is necessary. More details are available in step 3.







	第3步: 我们特别针对你的数据库定制迁移处理




Our migration process is automated as much as possible, but some manual work may be necessary, depending on your data’s complexity. It is possible, during step 2, that the migration process did not complete correctly and that we need to customize our scripts for your database. This operation may take 2-4 weeks, depending on the complexity of your database. After the migration script adaptation, you will receive an email with a link where you can download your migrated database.



	第4步: 你重新部署迁移过的数据库




You can download your migrated database and reinstall it on your new OpenERP version. If you executed the anonymisation process at step 1, you will have to reverse it to recover your real data.





如何恢复数据库备份?

做为超级管理员的角色，你能够创建一个帐套，当然也能做下面的操作:


	备份数据库(帐套),

	删除数据库(帐套),

	恢复数据库(帐套).



All of these operations can be carried out from the menu File ‣ Databases...
in the GTK client, or from the Databases button in the web client’s
Login screen.


Tip

备份(复制)数据库(帐套)

To make a copy of a database, go to the web Login screen and click the Databases button.
Then click the Backup button, select the database you want to copy and enter the super-administrator
password. Click the Backup button to confirm that you want to copy the database.




Tip

删除数据库(帐套)

To delete a database, go to the web Login screen and click the Databases button.
Then click the Drop button, select the database you want to delete and enter the super-administrator
password. Click the Drop button to confirm that you want to delete the database.




Tip

恢复数据库(帐套)

To restore a database, go to the web Login screen and click the Databases button.
Then click the Restore button, click the Choose File button to select the database
you want to restore. Give the database a name and enter the super-administrator password.
Click the Restore button to confirm that you want to install a new copy of the selected database.
To restore a database, you need to have an existing copy, of course.




Tip

复制数据库(帐套)

To duplicate a database, you can:


	make a backup file on your PC from this database.

	restore this database from the backup file on your PC, and give it a new name.



This can be a useful way of making a test database from a production database. You can try out the
operation of a new configuration, new modules, or just the import of new data.



A system administrator can configure OpenERP to restrict access to some of these database functions
so that your security is enhanced in normal production use.




如何保证数据库数据安全?

我们提供了一个的选项，让您的数据通过我们的 anonymization 模块来隐匿起来.这个模块可以让你保持一个指定数据库的数据机密性。
这是非常有用的功能，在你要迁移数据的过程中保护您自己或您的客户的机密数据。其原理是，你运行一个隐匿数据的工具，它会隐藏你的
机密数据（它们被替换为’XXX’字符）。然后，您就可以发送已经经过隐匿的数据给你的数据库迁移团队。一旦你数据库迁移完成，可以还
原和恢复回以前的隐匿数据。

We suggest you to work on a copy of your database, so be sure to make a backup before starting the anonymisation process.

The first step is to install and configure the anonymization module. The menus are located in Administration ‣ Database anonymization.


Anonymization History

This is the history of all the anonymisation (and the reverse process) that occurred on a particular database.




Anonymize database

This is the wizard that will actually anonymise the database. This wizard is also responsible to reverse the anonymization process.




Anonymized Fields

Pre-defined fields

On module installation, OpenERP will create some fields considered as important to anonymise, these are:



	Partner: Name








	Partner: Reference

	Partner Addresses: Contact Name

	Partner Addresses: City

	Partner Addresses: Street

	Partner Addresses: Street2

	Partner Addresses: Zip

	Partner Addresses: Phone

	Partner Addresses: Fax

	Partner Addresses: Mobile

	Partner Addresses: E-Mail

	Invoice: Untaxed (amount_untaxed)

	Invoice: Tax

	Invoice: Total (amount_total)

	Invoice: Total (check_total)

	Invoice: Residual

	Invoice line: Unit Price

	Invoice line: Subtotal

	Invoice move line: Debit

	Invoice move line: Credit

	Invoice move line: Tax/Base Amount

	Invoice move line: Amount Currency

	Invoice move line: Taxed Amount

	Sale order: amount_tax

	Sale order: amount_untaxed

	Sale order: amount_total

	Sale order line: price unit

	Sale order line: discount

	Purchase order: amount_tax

	Purchase order: amount_untaxed

	Purchase order: amount_total

	Purchase order line: price_unit






The anonymised values are:



	char field: xxx + record id

	text field: xxx + record id

	selection field: xxx + record id

	integer field: 1

	float field: 0.0

	date field: 2011-11-11

	datetime field: 2011-11-11 11:11:11






All attachment object contents are replaced by an empty string in the database.

Create new fields to anonymize

You also have the possibility to add other fields that you want to keep confidential. You have to create them manually.

First choose an object by using the popup (Object field). You can also enter the object model name directly into the Object Name field, if you know it. These two fields are linked to each other; fill out one of both and the other one will be filled automatically.

You then choose the field by using the popup (Field field). You can also enter the field name directly if you know it (Field Name field). These two fields are linked to each other in the same way as described above.

The State field values are:


	Clear: the field values have their original status in the database

	Anonymized: the field values are anonymised in the database

	Not Existing: the field does not exist in the database.
This is probably a field which comes from the module’s data file. For example, the data file creates some predefined anonymized fields, but the module might not be installed. These fields are ignored by the anonymisation process.
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介绍

本社区指南让你对于OpenERP社区的组织以及其生态系统有一个概览。
它不仅是一个给新的OpenERP社区成员的快速帮助手册，而且对于有经验的社区成员也是大有裨益的，因为它会根据社区的最新消息同步更新。

你能在社区手册里找以下几个要点的例子：



	社区工具的使用说明 ;

	社区角色和团队的说明 ;

	目前社区推进的流程 ;

	一组关于各个主要贡献区的增量说明。






当然此文档并不是已经停止更新，相反更新此文档应该是大家作出贡献的第一步！

为了打造有史以来创造最好的企业管理软件，我们需要社区成员的通力合作。
随着各个领域的市场专家以及质量流程控制的高手加入到贡献者的行列并不断作出反馈，
我们将一起为客户创造最有价值的产品。这就是OpenERP发展方向和业务模式。




Launchpad 社区协作平台

我们使用 Launchpad.net [https://launchpad.net], 一个开源项目管理和协作平台,
作为我们代码托管和社区合作的平台。
其中 OpenObject [https://launchpad.net/openobject] 项目组汇集了所有关于OpenERP的项目。

OpenERP 使用下列 Launchpad 的工具, 本指南将进一步介绍相关详情:



	Bug Tracker : https://bugs.launchpad.net/openobject

	Translations: https://translations.launchpad.net/openobject

	Source version control and code Hosting: https://code.launchpad.net/openobject

	Specifications/BluePrints : https://blueprints.launchpad.net/openobject

	FAQ : https://answers.launchpad.net/openobject






OpenERP 的每一位社区成员只需要 在 Launchpad 上注册 [https://login.launchpad.net/+new_account]
并加入 OpenERP 社区 [https://launchpad.net/~openerp-community/+join] 团队
这样轻松点击几下都可以免费使用这些工具，

还有后一些特定任务需要别的特殊的组来完成，你可以在贡献指南的相应部分看到相应解释。
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如何在团队中工作

在OpenERP社区中有多少种角色呢？


贡献者

贡献者帮助项目提高，添加新功能以及提高稳定性。任何人都可以通过提交bug报告，提出改进建议和发布补丁来为项目做贡献

社区贡献团队在launchpad: https://launchpad.net/~openerp-community




社区贡献团队

Official committers are people allowed to commit in the shared community repositories.
Those people are approved as committers by the community once they’ve provided
enough good-quality patches and/or contributions in the project.

They are allowed to :



	Propose and post their own patches against bug reports.

	Review patches from contributors, comments and / or improve them.

	Commit good-quality patch or contribution in the community repository.

	Write a news on the Planet OpenERP RSS






The community contributors team list include the following teams, most
specific to a given category of OpenERP features:

After contributing on a specific team’s project, you can apply to be part of the related team and the members of that team will vote on your approval.

As part of all of all other ” * Core Editors” teams, we have the “OpenERP Community Reviewer” team : https://launchpad.net/~openerp-community-reviewer

The goal is to have a basis of strong community members in all specific teams. This is a team of well experienced OpenERP developers that can have a word on any community developments. Their role is to help having good quality, well maintained modules. They have a mailing list here: openerp-community-reviewer@lists.launchpad.net

Historically there was the generic OpenERP committers [https://launchpad.net/~openerp-commiter]
team, but it has become deprecated along with the phase out of the obsolete
extra-addons shared repository.




OpenERP 核心团队

The OpenERP core team are the employees from OpenERP SA responsible for the
quality of the Official repository. They assure the stability and coherence
of the official version by reviewing all patches and commits.

The OpenERP Core Team is available on Launchpad: https://launchpad.net/~openerp




专家团队

To help developers and contributors make the right decisions when
improving OpenERP, we set up expert teams for different management domains.
Only people that have a strong experience in OpenERP and the related domain can
apply as an expert. We have teams of accountants, manufacturing experts,
technical experts, services management experts, ...

Developers can contact our experts mailing list when they need feedback on
particular features to be developed. Please contact our experts only for new
development related questions. They don’t provide help on current features of
OpenERP. Most of our experts have very senior positions in the company they work
for, so they don’t have time to spend providing help or support.

The expert teams are:



	Accounting: https://launchpad.net/~openerp-expert-accounting

	Services Management: https://launchpad.net/~openerp-expert-service

	Manufacturing Industries: https://launchpad.net/~openerp-expert-production

	Framework: https://launchpad.net/~openerp-expert-framework

	Usability: https://launchpad.net/~openerp-expert-ergonomy

	Localization/Translations: https://launchpad.net/~openerp-expert-localization







Requesting Advice from a Team

When you create a specification [https://blueprints.launchpad.net/openobject/+addspec]
for a new feature on launchpad (called a blueprint), you can
assign an expert team as a drafter of the specification. Then, you can click
on request feedback on your blueprint and assign this to an expert team.

They will receive a notification email and will discuss the requested
feature. The team will improve your specifications directly in your blueprint.






翻译团队

The translation teams are in charge of the translation of OpenERP in a specific language.
The list of current translation teams can be found here: https://translations.launchpad.net/+groups/openobject-translators

For more information regarding OpenERP translations and the corresponding process,
please see the OpenERP 翻译 section.




合并提案

Making a merge proposal of your own code is the way to integrate your work in the OpenERP project. You can request a merge proposal either on OpenERP’s branch or OpenERP community’s branch. In every project the process is the same and you can get the basic documentation here: https://help.launchpad.net/Code/Review
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博客集聚和公告


Contents


	博客集聚和公告
	什么是博客集聚 ?

	撰写指南










什么是博客集聚 ?

The planets are places where partners, developers and contributors express
their thoughts about the Open Object project. It’s an aggregate of the personal blogs
of partners and contributors. We use them to announce new developments,
features and events on OpenERP and Open Object.

We have two planets:


	Open Object, the community planet : http://openobject.com/planet

	OpenERP, the editor planet : http://openerp.com/planet



Every OpenERP contributor can post blogs on the Open Object planet, if they
follow the writing guidelines. See the section below to subscribe.

Our marketing and editorial team will review the Open Object planet frequently.
When they notice good announcements, they will write an announcement and publish
on the OpenERP planet. If the new feature is very good, we may also write
a press release based on our article.




撰写指南

To post on the Open Object planet, you must:


	Create a personal blog

	Subscribe your blog on the planet by sending an email to fp AT openerp.com

	Write blogs and attach the label “openobject” to your posts



Some rules to follow:


	All blog entries to be published in the planet must be in English

	Announce only new events, new features or new developments

	Promote the work you did primarily, not the company you represent

	Only write positive messages, not negatives ones

	Avoid commercial messages in the planet. The only acceptable commercial messages
are from partners to announce training, exhibitions or
conferences.



If you don’t follow these rules, we may remove you from the planet.
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Bazaar 版本控制工具

The new development process uses Bazaar via launchpad.net instead of Subversion.
Bazaar offers flexibility with this distributed model. You can see our
branches on https://code.launchpad.net/~openerp.


	
Explanation of directories:

	



Two teams have been created on launchpad:



	OpenERP quality teams –> they can commit on:
	lp:~openerp/openobject-addons/4.2

	lp:~openerp/openobject-addons/trunk

	lp:~openerp/openobject-addons/4.2-extra-addons

	lp:~openerp/openobject-addons/trunk-extra-addons

	lp:~openerp/openobject-bi/trunk-addons

	lp:~openerp/openobject-bi/trunk-cli

	lp:~openerp/openobject-bi/trunk-client-web

	lp:~openerp/openobject-client/4.2

	lp:~openerp/openobject-client/trunk

	lp:~openerp/openobject-client-web/4.2

	lp:~openerp/openobject-client-web/trunk

	lp:~openerp/openobject-server/4.2

	lp:~openerp/openobject-server/trunk





	OpenERP-commiter –> They can commit on:
	lp:~openerp/openobject-addons/4.2-extra-addons

	lp:~openerp/openobject-addons/trunk-extra-addons










In this group, we include some of our partners who will be selected on merit by the quality team.



	Contributors –> They can commit on:
	lp:~openerp-community











	
How can I be included in OpenERP-commiter team ?

	



To become a committer a contributor must show interest
on working for openerp project and ability to do it properly as
selection is based on merit. It can be by proposing bug
fixes, features requested on our bug tracker system.
You can even suggest additional modules and/or functionality on our bug
tracker system.


	
How can I suggest some additional modules or functionality ?

	



To create additional modules and/or functionality and include them in
the project:



	open a branch in launchpad

	report and suggest your work via your new branch to our bug tracker system (there are two ways: bugs report for bug and
blueprint for idea / functionality)

	wait for approval by our quality team






Or the quality team approved your work and merge it into the official branch
(like explained in the bug tracker section), or they
refuse it and ask you to improve your work before merging it in our official
branch.


安装 Bazaar

Get Bazaar version control to pull the source from Launchpad.

To install bazaar on any ubuntu distribution, you can edit /etc/apt/sources.list by

sudo gedit /etc/apt/sources.list





and put these lines in it:

deb http://ppa.launchpad.net/bzr/ubuntu intrepid main
deb-src http://ppa.launchpad.net/bzr/ubuntu intrepid main





接下来要做的

sudo apt-get install bzr





To work correctly, bzr version must be at least 1.3. Check it with the command:

bzr --version





If you have an older version check this url: http://bazaar-vcs.org/Download
On debian, in any distribution, the 1.5 version is working, you can get it on this url: http://backports.org/debian/pool/main/b/bzr/bzr_1.5-1~bpo40+1_i386.deb

If you experience problems with Bazaar, please read the Bazaar 版本控制的常见问题(F.A.Q) before asking any questions.




快速摘要

This is the official and proposed way to contribute on OpenERP and OpenObject.

To download the latest sources and create your own local branches of OpenERP, do this:

mkdir openerp
cd openerp
bzr branch lp:~openerp/openobject-server/trunk server
bzr branch lp:~openerp/openobject-addons/trunk addons
bzr branch lp:~openerp-commiter/openobject-addons/trunk-extra-addons addons-extra
bzr branch lp:~openerp-community/openobject-addons/trunk-addons-community addons-community
bzr branch lp:~openerp/openerp-web/trunk web
bzr branch lp:~openerp/openobject-client/trunk client
bzr branch lp:~openerp-community/openobject-doc/6.1 doc





This will download all components of openerp (server, client, addons) and create links of modules in addons on your server so that you can use it directly. You can change the bzr_set.py file to select what you want to download exactly. Now, you can edit the code and commit in your local branch.:

EDIT addons/account/account.py
cd addons
bzr ci -m "Testing Modifications"





Once your code is good enough and follow the 编程指引, you
can push your branch in launchpad. You may have to create an account on
launchpad first, register your public key, and subscribe to the openerp-community [https://launchpad.net/~openerp-community] team. Then, you
can push your branch. Suppose you want to push your addons:

cd addons
bzr push lp:~openerp-community/openobject-addons/YOURLOGIN_YOURBRANCHNAME
bzr bind lp:~openerp-community/openobject-addons/YOURLOGIN_YOURBRANCHNAME





After having done that, your branch is public on Launchpad, in the OpenObject
project [https://code.launchpad.net/openobject], and committers can work on
it, review it and propose for integration in the official branch. The last line
allows you to rebind your branch to the one which is on launchpad, after having
done this, your commit will be applied on launchpad directly (unless you use --local):

bzr pull    # Get modifications on your branch from others
EDIT STUFF
bzr ci    # commit your changes on your public branch





If your changes fix a public bug on launchpad, you can use this to mark the bug as fixed by your branch:

bzr ci --fixes=lp:453123   # Where 453123 is a bug ID





Once your branch is mature, mark it as mature in the web interface of launchpad
and request for merging in the official release. Your branch will be reviewed
by a committer and then the quality team to be merged in the official release.




怎么获取最新的代码

Get a clone of each repository:

bzr clone lp:~openerp/openobject-server/trunk server
bzr clone lp:~openerp/openobject-client/trunk client
bzr clone lp:~openerp/openobject-client-web/trunk client-web
bzr clone lp:~openerp/openobject-addons/trunk addons





If you want to get a clone of the extra-addons repository, you can execute this command:

bzr clone lp:~openerp-commiter/openobject-addons/trunk-extra-addons extra-addons





run the setup scripts in the respective directories:

python2.5 setup.py build
sudo python2.5 setup.py install





Currently the initialisation procedure of the server parameter –init=all to
populate the database seems to be broken in trunk.

It is recommended to create a new database via the gtk-client. Until then the web-client will not work.

Start OpenERP server like this:

./openerp-server.py --addons-path=~/home/workspace/stable/addons





The bin/addons will be considered as default addons directory which can be
overridden by the ~/home/workspace/stable/addons. That is if an addon exists in
bin/addons as well as ~/home/workspace/stable/addons (custom path) the later one will
be given preference over the bin/addons (default path).




怎样提交你的成果

If you want to contribute on OpenERP or OpenObject, here is the proposed method:



	You create a branch on launchpad on the project that interests you. It’s
important that you create your branch on launchpad and not on your local
system so that we can easily merge, share code between projects and
centralize future developments.

	You develop your own features or bugfixes
in your own branch on launchpad. Don’t forget to set the status of your
branch (new, experimental, development, mature, ...) so that contributors
know what they can and cannot use.

	Once your code is good enough, propose your branch for merging

	Your work will be evaluated by a member of the committers team.
	If they accept your branch for integration in the official version, they
will submit to the quality team that will review and merge in the official
branch.

	If the commiter team refuses your branch, they will explain why
so that you can review the code to better fit the guidelines (problem for
future migrations, ...)










The extra-addons branch [https://code.launchpad.net/~openerp-commiter/openobject-addons/trunk-extra-addons],
that stores all extra modules, is directly accessible to all committers. If you
are a committer, you can work directly on this branch and commit your own work.
This branch does not require validation by the quality team. You should put
there your special modules for your own customers.

If you want to propose or develop new modules, we suggest creating your
own branch in the openobject-addons project [https://launchpad.net/openobject-addons]
and develop within your branch. You can fill in a bug to request that
your modules are integrated in one of the two branches:



	extra-addons branch [https://code.launchpad.net/~openerp-commiter/openobject-addons/trunk-extra-addons] : if your module touches a few companies

	addons [https://code.launchpad.net/~openerp/openobject-addons/trunk] : if your module will be useful for most of the companies






We invite all our partners and contributors to work in that way so that we can
easily integrate and share the work done between the different projects.




案例

This page presents the approach you should follow on how to contribute in
OpenObject. Suppose you want to develop new features in the addons or simply
correct some bugfixes.

If you have the right to modify the branch you plan to change, you can
do it directly. For example, a quality team member doing a bugfix can do it
directly on the main branch. Or committers can work directly on the
extra-addons. If you don’t have the right to modify the branch you plan to
change or if you want to branch because you are starting big developments
that may break the code, the first thing to do is to branch the repository
you plan to modify:

bzr branch lp:openobject-addons lp:~openerp-commiter/openobject-addons/trunk-new-reporting





In that case, the branch created will be for the openerp-commiter team. If you
are not a committer, you can create the branch for the community team
openerp-community or just for yourself, depending if you allow others to
directly commit on your branch or not. For all Tiny employees, we propose to
create all branches for the team openerp-commiter. An OpenERP service company
may create a team for their company and create branches at the name of their
team. This prevents others changing their
customer branch.

Once the branch is created, you must checkout a local copy to work on:

bzr co lp:~openerp-commiter/openobject-addons/trunk-new-reporting





This will download the branch on your local computer. You can then start
developing on it. From time to time, you should commit the work done:

bzr ci





This will send your modification to the branch:
lp:~openerp-commiter/openobject-addons/trunk-new-reporting. Don’t forget to
change the status of the branch to show other contributors the status of your
current work on
https://code.launchpad.net/~openerp-commiter/openobject-addons/trunk-new-reporting

For instance, you can switch the status to “In Development” to show you are
working on it and put the status to “Mature” when you’d like to have your code
integrated in the official release.

During your development, if you want to receive the latest modifications from
the parent branches, you can merge it:

bzr merge





Once your development on this branch are OK, you can ask a committer to review
and merge it or fill in a bug in the bugtracker. A committer will then review
your work and merge it to the official branch if it’s good enough.




提交指南

When committing your work to Launchpad, please respect these policies:


The stable branch is for bugfixes

The stable branch must be used for bugfixes. Only bugfixes.

The new features (+the bugfixes on these new functionality) have to be done
in the trunk branch.


Note

We will periodically backport all the fixes from stable to trunk.






Set the author’s name, if it’s different from the committer

Always set the author’s name, if it’s different from the committer. It is not
acceptable at all to commit a contributor’s work without at least his/her name in
the commit message. We have to respect them and their work, so
please use --author="<author_name>" when merging work or patching features
from community.

e.g: bzr commit --author="<author_name>"








写上有用的提交信息

Use a commit tag in each message. This tag should be one of:


	[IMP]

	[FIX]

	[REF]

	[ADD]

	[REM]







	[IMP]:	For improvements









	[FIX]:	For bug fixes









	[REF]:	For refactoring (improvements of the source code, without changing the
functionality or behavior. See http://en.wikipedia.org/wiki/Refactoring for
further details)









	[ADD]:	For adding new resources









	[REM]:	For removing of resources






	Always put a meaningful commit message. Commit message should be self
explanatory including the name of the module that has been changed. No more
“bugfix” or “improvements” anymore! (the only single word commit message
accepted is “merge”)

	If you are fixing the bugs use --fixes=lp:<bug_number> instead of putting the
number of the bug in the commit message.

	Use the revision id instead of the revision number when you make reference to
a revision in your commit message. You can get this revision id, by using the
command bzr version-info.



e.g:

  Not Correct : bzr commit -m “[FIX]: reverted bad revision (cannot install new db)
    with revision number:525425”

  Correct : bzr commit -m “[FIX]: reverted bad revision (cannot install new db)
  with revision number id: qdp@tinyerp.com-20090602143202-ehmntlift166mrnn”

  Not Correct : bzr commit -m "Bug 568889 : typo corrected"

  Correct : bzr commit --fixes=lp:568889 -m "[FIX] account module: typo corrected"






Note

How to handle translations ?

use [IMP] if you translated a message in a po file

use [ADD] if you added an new po file






避免大提交

Don’t make a commit that will impact lots of modules. Try to split it into
different commits where impacted modules are different (It will be
helpful when we are going to revert that module separately).
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开发模块


介绍

Here you will find information about the organisation of the community in
OpenERP project. It includes a description of the different tools used, the role
of the different actors, and the different process for improvement management.

The whole organisation is managed through our launchpad projects: http://launchpad.net
Our projects on launchpad are currently organised like this:








	Project name
	URL
	Description




	openobject
	https://launchpad.net/openobject
	the main super-project (group) where all
bugs, features and faq are managed


	openobject-addons
	https://launchpad.net/openobject-addons
	the project for core OpenERP modules


	openobject-server
	https://launchpad.net/openobject-server
	the OpenERP server


	openerp-web
	https://launchpad.net/openerp-web
	the web client for OpenERP 6.1 and newer
versions


	openobject-client
	https://launchpad.net/openobject-client
	the native client (gtk) for OpenERP 6.1
and earlier


	openobject-client-web
	https://launchpad.net/openobject-client-web
	the web client for OpenERP 6.0 and earlier
versions








获取源码

Please refer to 怎么获取最新的代码 in the Bazaar section

If you don’t know the Bazaar version control system, please read the documentation on Bazaar




社区模块

OpenERP modules developed by the community were historically published in a shared source
code branch on Launchpad, nicknamed extra-addons: https://code.launchpad.net/~openerp-commiter/openobject-addons/trunk-extra-addons

As of 2012 and the release of OpenERP 6.1, this shared branch is being phased out, due to several downsides to this
organization, such as:



	difficult to enforce access control on the modules (commit right is all or nothing)

	difficult to enforce quality (therefore impossible to rely on it for customer projects)

	commit history mixes all modules

	download/checkout of the branch requires to fetch all modules at once






A better organization was discussed on the OpenERP mailing-lists [https://lists.launchpad.net/openerp-expert-framework/msg00948.html],
with the following goals [https://lists.launchpad.net/openerp-expert-framework/msg00997.html]:



	To get rid of the big extra-addons branch

	To join efforts on the same topic in order to avoid too many modules for a same feature

	To become more aware of the developments that have been done by others

	To start working with merge proposal between us

	To improve the quality of our code






The community modules have therefore been split into separate Launchpad project and
their respective branches. When possible, existing ones were reused. All listed projects
provide a short description of the kind of modules you can find/merge into.

The community welcomes everyone on board to join efforts! In order to add your own modules in the appropriate project,
you should use merge proposals. Depending on the volume, some time might be needed at the beginning to review everything.
So thank you all in advance for your patience during this transition period.

For all of these projects, the rules we expect you to adhere to and respect are:



	No company-related prefix or suffix in the module names (like c2c-account-something);

	Always make merge proposal for any bugfix or improvement so that everyone can take note of it and eventually ask for a different approach;

	Nobody merge his/her own work into the branch. Another member of the team must do it. Exceptions may be accepted if the merge proposal has been strongly approved by the rest of the team;

	If your module doesn’t fit into any of the available projects, or you found no related team, please post a request on the framework expert mailing list [https://launchpad.net/~openerp-expert-framework] so that we can create a specific one for you;

	When at least one of your modules has been approved in the branch, you may ask to be part of the team. If you are not part of the team, you can still contribute to the project through merge proposals;

	Use the available teams (see 社区贡献团队 section) according to their topics (it means that you always need to attribute a new project to these teams, so as to avoid having hundreds of them).






Should you have any suggestions related to the above rules, please feel free to post them on the framework expert mailing list.


Community Projects

The list of the official community projects/topics can be found under this project group: https://launchpad.net/openobject,
and is summarized below.



	Stock and Logistic Barcode: https://launchpad.net/stock-logistic-barcode

	Stock and Logistic Warehouse: https://launchpad.net/stock-logistic-warehouse

	Stock and Logistic Tracking: https://launchpad.net/stock-logistic-tracking

	Stock and Logistic Flows: https://launchpad.net/stock-logistic-flows

	Stock and Logistic - Reports: https://launchpad.net/stock-logistic-report

	Carriers And Deliveries Management: https://launchpad.net/carriers-deliveries

	Banking Addons: https://launchpad.net/banking-addons

	Contact and Partner Management: https://launchpad.net/partner-contact-management

	Purchase - Workflow and Organization: https://launchpad.net/purchase-wkfl

	Purchase - Financial Controlling: https://launchpad.net/purchase-financial

	Purchase - Reports: https://launchpad.net/purchase-report

	Sales - Financial Controlling: https://launchpad.net/sale-financial

	Sales - Workflow and Organization: https://launchpad.net/sale-wkfl

	Sales - Reports: https://launchpad.net/sale-reports

	Product - Kitting Management: https://launchpad.net/product-kitting

	OpenERP Product Attributes : https://launchpad.net/openerp-product-attributes

	Account - Financial Report: https://launchpad.net/account-financial-report

	Account - Analytic Accounting: https://launchpad.net/account-analytic

	Account - Budgeting: https://launchpad.net/account-budgeting

	Account - Invoicing Reports: https://launchpad.net/account-invoice-report

	Account Payment Addons: https://launchpad.net/account-payment

	Account - Closing: https://launchpad.net/account-closing

	Account - Consolidation: https://launchpad.net/account-consolidation

	Account - Financial Tools: https://launchpad.net/account-financial-tools

	Account - Invoicing: https://launchpad.net/account-invoicing

	Contract management: https://launchpad.net/contract-management

	OpenERP Fiscal Rule: https://launchpad.net/openerp-fiscal-rules

	Margin Analysis: https://launchpad.net/margin-analysis

	Medical in OpenERP : https://launchpad.net/oemedical

	Construction : https://launchpad.net/openerp-construction

	Project Management - Invoicing and Reporting: https://launchpad.net/project-reporting

	Project Management - Services: https://launchpad.net/project-service

	HR - Timesheet Management: https://launchpad.net/hr-timesheet

	Hotel Management System on OpenERP : https://launchpad.net/hotel-management-system

	Department Management: https://launchpad.net/department-mgmt

	Server Environment And Tools: https://launchpad.net/server-env-tools

	Webkit Utils: https://launchpad.net/webkit-utils

	E-Commerce addons: https://launchpad.net/e-commerce-addons

	Report - Printing and Sending: https://launchpad.net/report-print-send

	Management Systems : https://launchpad.net/openerp-mgmtsystem

	Web-Addons for OpenERP : https://launchpad.net/web-addons

	Geospatial Addons for OpenERP : https://launchpad.net/geospatial-addons

	Knowledge Management Addons https://launchpad.net/knowledge-addons






Some of them are waiting on their owner to bring some modifications so they can fit into other projects (changing team, series,...).
Should you be one of these owners, please inform the others on the mailing-list when ready.
If some refuse to open the projects to the community, it is always possibel to create another project.






其他规则


模块


模块中的文件组织

The structure of a module should be:

/module_name/
/module_name/__init__.py
/module_name/__openerp__.py
/module_name/i18n
/module_name/i18n/module_name.pot
/module_name/images/
/module_name/images/screenshot.png
/module_name/migrations
/module_name/module.py
/module_name/module_view.xml
/module_name/module_wizard.xml
/module_name/module_report.xml
/module_name/module_data.xml
/module_name/module_demo.xml
/module_name/module_security.xml
/module_name/wizard/
/module_name/wizard/__init__.py
/module_name/wizard/wizard_name.py
/module_name/wizard/wizard_name_view.xml
/module_name/wizard/wizard_name_workflow.xml
/module_name/report/
/module_name/report/__init__.py
/module_name/report/report_name.sxw
/module_name/report/report_name.rml
/module_name/report/report_name.py
/module_name/security
/module_name/security/ir.model.access.csv
/module_name/static/src/img/icon.png
/module_name/tests








权限

模块中定义的每个模块必须有至少一条安全规则，使得它可被访问




编码指南

Follow Python PEP 8: http://www.python.org/dev/peps/pep-0008/






Reporting


总体风格



	每个地方使用 Helvetica 字体

	边缘 (用毫米表示):
	top: 14

	bottom: 16

	left: between 12 and 13 to allow punching holes without punching in the text area

	right: between 12 and 13













Note

the line separator between the header and the body can overlap slightly in the left and right margins: up to 9 millimeters on the left and up to 12 millimeters on the right







	for Titles use font Helvetica-Bold with size 14.5

	put the context on each report: example, for the report account_balance: the context is the fiscal year and periods

	for the name of cells: use Capital Letter if the name contains more than one word (ex: Date Ordered)

	content and name of cells should have the same indentation

	for report, we can define two kinds of arrays:
	array with general information, like reference, date..., use:
	Bold-Helvetica and size=8 for cells name

	Helvetica size=”8” for content





	array with detailed information, use:
	Helvetica-Bold size 9 for cells names

	Helvetica size 8 for content















	
Headers and footers for internal reports:

	
	Internal report = all accounting reports and other that have only internal use (not sent to customers)

	height of headers should be shorter

	take off corporate header and footer for internal report (Use a simplified header for internal reports: Company’s name, report title, printing date and page number)

	header:
	company’s name: in the middle of each page

	report’s name: is printed centered after the header

	printing date: not in the middle of the report, but on the left in the header

	page number: on each page, is printed on the right. This page number should contain the current page number and the total of pages. Ex: page 3/15





	footer:
	to avoid wasting paper, we have taken off the footer












	
table line separator:

	




	it’s prettier if each line in a table has a light grey line as separator

	use a grey column separator only for array containing general information




	
table breaking

	
	a table header should at least have two data rows (no table header alone at the bottom of the page)

	when a big table is broken, the table header is repeated on every page








	
how to differentiate parents and children ?

	
	When you have more than one level, use these styles:




	for the levels 1 and 2:fontSize=”8.0” fontName=”Helvetica-Bold”

	from the third level, use:fontName=”Helvetica” fontSize=”8.0” and increase the indentation with  13 (pixels) for each level

	underline sums when the element is a parent








模块








命名惯例

模块的名称全部小写，每个单词用下划线分割。
总是用最重要、最相关的单词开头，区别其它模块的最好的名称

例如：



	account_invoice_layout









必要信息

每个模块至少包括：



	name 模块名称

	description  模块说明









模块描述




描述

每个模块必须包含：



	一个与其它模块的依赖关系的列表： [‘account’,’sale’]

	只需提供最高的需求级别，不需要设置 [‘account’,’base’,’product’,’sale’]









模块内容

每个模块必须为 模块中定义的对象包含演示数据

如果你要在模块中实现工作流，创建 传递你工作流的多数分支的演示数据 。
你能使用模块记录器（ module recorder）来帮助你建立这样的演示数据




菜单


菜单命名



	使用复数形式: Customer Invoice, 命名为 Customer Invoices

	如果可能，在菜单中避免缩略语. 例如: BoMs -> Bills of Materials









菜单的顺序

The Reporting menu is at the bottom of the list, use a sequence=50.




常见错误



	Edit Categories -> Categories

	List of Categories -> Categories









搜索条件

搜索条件: 搜索可用在列表视图的所有列






默认语言

每个开发的默认语言必须是 U.S. English.

对菜单和字段，第一个字母使用大写, 除非是 连词:



	Chart of Accounts









字段命名惯例



	many2one fields should respect this regex: ‘.*_id’

	one2many fields should respect this regex: ‘.*_ids’

	one2many relation table should respect this regex: ‘.*_rel’

	many2many fields should respect this regex: ‘.*_ids’

	使用下划线 分割单词

	避免使用大写

	如果一个字段有几个单词组成，用最重要的单词开头









模块命名惯例


	所有对象必须用定义他们的模块的名称开头.

	如果一个对象名称由几个单词组成，用 小数点 分割单词






术语



	记录的树形列表应该被称为“XXX的结构”，除非有个特定的称谓已经存在
	推荐: 库位结构，科目表，类型结构

	不推荐: 分类树，物料清单树
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文档处理


书籍

The main documentation of OpenERP is composed of a set of books according to
the business need. These books are reviewed once a year. We are working with
authors/contributors/employees/translators to build chapters on the different
aspects of the ERP.

This section describes how we collaborate with authors and translators to
provide very good documentation on OpenERP. To motivate people to write
quality documentation/chapters we set up author rights to pay each contributor
and translator according to their effort.


创建数据

We have contracts with several editors to publish books in different countries.

Once we have enough chapters written, we can compose a book and publish it.

Books are first published in a paper version. Three months after, we release it online.




著作权

The typical author rights are between 8% and 10% on the public price, according
to the authors, the country and the editor in which the book will be published.
This commission is on the public price, no matter of the final selling price
per item.

These author rights have to be divided according to people working on the book:



	Reviewers: 10% to be divided by number of reviewers

	Translators: 30% to be divided by the number of translators

	Authors: the rest (60%-90%) to be divided by number of authors






As an example, Geoff and Fabien worked on the French and English book on
OpenERP. This book is sold at a public price of 35 EUR with 10% author rights.
We had one reviewer for this book from Eyrolles. So author rights are split
in that way:



	Geoff: 1.575 EUR/book (= 35 * 0.1 * (0.9 / 2))

	Fabien: 1.575 EUR/book

	Reviewer: 0.35 EUR/book (= 35 * 0.1 * 0.1)






Once this book will be translated to Hungarian, with a public price of 30 EUR
and author rights of 10% (0.1) we will have:



	Geoff: 1.05 EUR/book (=30 * 0.1 * 0.7 / 2)

	Fabien: 1.05 EUR/book

	Hungarian translator: 0.90 EUR/book (=30 * 0.1 * 0.30)






Author rights are paid every 3 months, after one month. (to be verified
according to what we can do with editors)






个人


作者

Anyone can be an author and write a complete book or just one or several
chapters on particular aspects of OpenERP. Chapters are then review




来自 Tiny 的作者

At Tiny (the editor of OpenERP), each employee can write a few chapters based
on new module he wrote for specific customers, at the end of the project. As
employees get a salary to write these chapters during their working hours,
author rights are computed slightly differently:



	Computed rights are divided by two for the employee: 50%

	Valid while the employee works for Tiny











建立文档

文档能从下面的源里下载到:

bzr branch lp:openobject-doc





我们使用 Sphinx [http://sphinx.pocoo.org], 一个用来建立文档的生成器, 因此，将被安装在你的系统里。
你后面将了解如何使用它.

You can install it with easy_install [http://peak.telecommunity.com/DevCenter/EasyInstall]. For example, on Ubuntu:

sudo easy_install sphinx





Sphinx is built on top of the reStructuredText [http://docutils.sourceforge.net/rst.html] project that lets you write
documents in plain text files and then generate HTML, PDF or other formats from
them. A good introduction to reStructuredText is the Quick reStructuredText [http://docutils.sourceforge.net/docs/user/rst/quickref.html]
reference page. reStructuredText defines the layout and formatting of a single
page. Sphinx lets you organise several pages into a large document with a
table of contents and cross references.


Note

if you step into this error message (line number can vary):

! Undefined control sequence.
l.462 \capstart





This sometimes means that you have a buggy version of sphinx. Try
to install Sphinx version 1.0.2:

sudo easy_install sphinx==1.0.2 --upgrade







Building the documentation in HTML and in PDF requires a few dependencies,
namely for the LaTeX system (additional packages and fonts). On Ubuntu you can
install the required packages with the following command::

# Install Latex extras
sudo apt-get install texlive-latex-extra texlive-fonts-recommended
# Install ImageMagick for images conversion
sudo apt-get install imagemagick






	
building the documentation in html:

	



make clean
make html






	
building the documentation in pdf:

	



make clean
make latex
cd build/latex
make all-pdf






	
building a book:

	



For example, if you want to build the OpenERP for Retail and Industrial Management book:

cd books/book_mrp
make clean
make latex
cd build/latex
make all-pdf








链接到源码的文档

Some of the pages include links to classes in the project’s source code. One
example is developer/2_5_Objects_Fields_Methods/methods.rst. You can add more
links to source code documentation using the Sphinx autodoc extension [http://sphinx.pocoo.org/ext/autodoc.html]. This
will import classes and methods along with their docstring documentation. If you
don’t tell Sphinx how to find the project’s source code, then the import will
fail with a warning. If you want to make the import work, follow these steps:


	It seems like you need at least version 1.0 of Sphinx. If your version hasn’t
automatically upgraded that far, see the easy_install instructions above. To
see what version you have, run the following:

sphinx-build --help







	You need to have a copy of the OpenERP server code. The web site builds
against the trunk version.



	You need to tweak server/bin/tools/config.py by commenting out the call to
config.parse_config() on the last line. Hopefully that will get cleaned up
eventually, but for now you either need a second copy of the server just for
building the docs from or you need to add and remove this tweak every time you
work on the docs.



	You need to add server/bin to your PYTHONPATH environment variable. The
simplest way to do that is to launch make like this:

PYTHONPATH=/path/to/server/bin make html












FAQ


	
How many units can we expect to sell for a book ?

	



Our first French book sold 500 units per month. It’s good as it
was our the first book on OpenERP but we can expect better results with an
English version. So probably between 250 and 1500 units per month for an
English book.
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将OpenERP翻译为你的本地语言

要将OpenERP翻译为本地语言, 主要要处理下面两块的翻译:



	OpenERP 软件的翻译

	OpenERP 在线文档的翻译






These two areas are organised differently in terms of translations,
and as a consequence the contribution process differs too, and is
outlined in the following sections.



	OpenERP 翻译

	OpenERP 文档翻译
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OpenERP 翻译

Within the OpenERP source code, all translatable terms are written in international
English (language code en_US). The Administrator of an OpenERP instance can
install additional languages among the official translations. As a result the corresponding
translations of all installed modules will be loaded in the database, and used to
replace the default English terms in the application interface when a user changes her
preferred language.

Regardless of what follows, if you are considering working on the OpenERP translations,
please read the general Launchpad Translations Guidelines [https://help.launchpad.net/Translations/Guide]
before writing your first translation, as it includes very important advice for new translators.

There are 2 ways for contributors to add or modify translations in their languages:



	Work on Launchpad, OpenERP’s community platform, using the dedicate Translation
interface on Launchpad [http://translations.launchpad.net], formerly known as Rosetta.
This guarantees to work on the latest translation, and is automatically synchronized
with the .po files of the source code. See 在Launchpad上翻译 for more
details.

	Work directly on the PO files, considering them as regular source code files, and thus
sending a merge proposal of the .po patch to OpenERP, just like for a regular patch.
This is explained in more details in 源代码中的翻译 section.






The first solution is strongly recommended when you are working on official OpenERP translations,
but sometimes the second solution is more efficient when you are translating new community modules.
These two solutions also have different access rights requirements, as explained below.


Can I do batch translations locally and then upload the .po files in batch in Launchpad?

You can translate locally the .po files, then upload them using the Upload translation
button that appears on top of each module’s translations. For example to upload a French (fr)
translation for “account” in the trunk branch, you can use the following URL:

https://translations.launchpad.net/openobject-addons/trunk/+pots/account/fr/+translate





There is also one (beta, unsupported) technical tool available to perform mass upload of
translations on Launchpad. It may be helpful if you want to translate offline or to copy
translations from one branch to another. It’s a Python script called lp_upload.py,
used in command-line mode. It can be found
here [http://bazaar.launchpad.net/~odo-openerp/+junk/openerp-utils/files].

We still really recommend working directly with Launchpad’s translation interface whenever possible,
due to the numerous advantages, detailed in 在Launchpad上翻译.




在Launchpad上翻译

Launchpad provides a web-based translation interface, which can be
used to translate. Its main features are:



	Being web-based, it is accessible everywhere for anyone and does not require
any developer skill

	It provides all the contextual information that a translator needs, and mentions
the place where the term comes from inside the software, a critical information
for proper translations.

	Making use of the thousands of other open source project hosted on Launchpad,
it is able to suggest similar translations from all other projects, speeding
up the translator’s work.

	It provides reviewing features, and allows marking the terms that one thinks
should be reviewed by other translators, easing collaboration further.

	It comes with a specific access right system, and Launchpad Teams can be assigned
to specific languages, making them responsible for the quality of the translations.

	It is automatically synchronized with the source code files containing the
translations, effectively replacing completely the need for manually updating
them as explained in 源代码中的翻译.






After registering on Launchpad, you can access the translations for any OpenERP project
by clicking on the Translations or Help Translate links on the homepage of the project.
You may also find the list of all (official and community-driven) translatable OpenERP-related
Launchpad projects: https://translations.launchpad.net/openobject.

Some quick links to the main OpenERP projects’ translations:



	https://translations.launchpad.net/openobject-server

	https://translations.launchpad.net/openobject-addons

	https://translations.launchpad.net/openobject-client

	https://translations.launchpad.net/openobject-client-web

	https://translations.launchpad.net/openobject-client-kde






Please also have a look at the Launchpad Translations Documentation [https://help.launchpad.net/Translations/]
and FAQ [https://answers.launchpad.net/rosetta/+faqs].


Launchpad上的翻译权限

OpenERP uses structured permissions [https://help.launchpad.net/Translations/YourProject/PermissionPolicies]
for the Launchpad translations, which means three things:



	Anyone is always free to suggest translations for OpenERP modules, clients and server.

	If no translation team is assigned to a language, anyone can review or even accept a
given translation.

	If a translation team is assigned to a language, only members of that team are allowed
to review and accept the translations in this language, but anyone can still suggest
translations.






See also Launchpad’s Translations documentation for more details:



	https://help.launchpad.net/Translations

	https://help.launchpad.net/Translations/StartingToTranslate

	https://answers.launchpad.net/rosetta/+faqs









Requesting the creation of assignation of a translation team

If your language does not yet have an assigned translation you are free to create one
yourself, and request its assignation to that language. If the team already exists,
please contact its members to join their effort.

If you decide to create a new team [https://launchpad.net/people/+newteam] (anyone can do that),
please name it openerp-i18n-XXX where XXX is your language, for example openerp-i18n-dutch.
Please be sure to put a complete description for the team, explaining its purpose, how to join
(if you want to make it moderated or restricted, etc.) The description can be in your language,
and you could look at the description of existing translation teams if you need examples.
Please also have a look at the
Launchpad recommendations for running a Localization team [https://help.launchpad.net/Translations/Guide#Runningalocalizationteam].

When this is done, send a message through Launchpad to https://launchpad.net/~odo-openerp, requesting
the assignation of your new team.

After this point, anyone will still be free to propose and view translations for your language, but one will
need to be a member of your new team to be able to validate/accept them.




Reviewing translations on Launchpad

When a translation team is assigned, it is in charge of reviewing every
translation made by the contributors before they can be used in the official
packages and branches.

If you are a member of a translation team, please make sure that new
suggestions are reviewed as soon as possible.
There are few things more disappointing than contributing and having your work
ignored! Fortunately Launchpad makes it pretty easy for you to keep up.

You can see how many strings need review on the project’s translation page for
your language.
Just click on the number in the column “Need review” will directly open a page
with all the contributions waiting to be reviewed:

[image: ../_images/translation-lp-template-list.png]
One of the neat features of Launchpad is that it can keep several suggestions
for translating the same string. Launchpad will also suggest translations made in
completely different projects if it can.
As a reviewer, you are free to either choose the translation you find best, or
to make a new translation yourself.

When  none of the suggestions are good enough, you can also discard them by
checking “Dismiss all suggestions above.”. They will be removed from the review
process and fall into oblivion - use wisely.

[image: ../_images/translation-lp-review.png]

Requesting review for your own translations

While you are in charge of reviewing other’s translation, you may also
wish to new translations of your own, and have others review them.
To this end, launchpad will present you with an additional checkbox
labeled “Someone should review this translation”. If you check this box,
your contribution will be considered as a suggestion rather than a
reviewed translation.

If you are making lots of translations that to want others to review,
just leave the “Reviewer mode” to enter the “Translator mode”. Launchpad
will then check the box automatically for you.

[image: ../_images/translation-lp-translator-mode.png]



Why am I credited for translations when I only reviewed someone else’s contribution?

When reviewing translations, you must be careful to select the suggestion
and not copy/paste it into the “New translation” box, otherwise Launchpad
may consider the contribution is yours.

Also, if you change even a tiny bit from the translation (like correcting
a small type), it will be considered a new suggestion and credited to you.








源代码中的翻译

As an alternative to Launchpad, translations may also be done in directly in the
source code, considering the translation files as regular source code files.
The result of a translator’s work is essentially a regular patch, which may
only be published according to the specific permissions allowed on each project
code. To the contrary, when using Launchpad any validated translation is directly
committed by Launchpad in the official branches, without any further delay.

As no-one outside of OpenERP’s Quality Team is allowed to directly commit
patches on the official branches, this means that a translation patch for
the official OpenERP project would need to be submitted using a regular merge proposal,
as described in 合并申请 & 修补程序.
If you still want to use this technique, you will first need to understand the
翻译文件目录结构.

You can edit the .po files directly using a PO editor such
as POEdit [http://www.poedit.net], or instead update the translations directly
within OpenERP and replace the existing .po by exporting updated ones using
OpenERP’s translation export wizard.

We recommend you follow these steps to ensure the best result with this technique:



	read everything about the 翻译文件目录结构

	grab the latest source code and create a new OpenERP database to start with,
to make sure you have all the latest translation terms

	translate locally using OpenERP’s interface or any other way you like

	if translating in OpenERP, re-export all .po files of your language for all modules
over the current ones in the source using OpenERP’s export wizard

	at that point you basically have a version of the code where your language’s
.po files are patched. You then need to commit and push these changes into
a public branch on LP and make a merge proposal so OpenERP’s quality team can merge
the updated .po files into the official branches. Follow the regular procedure
as explained in 合并申请 & 修补程序.









翻译文件目录结构


Changed in version 5.0: and 6.0



As of version 5.0, OpenERP uses exclusively the GetText Portable Object (a.k.a. *.po [1])
standard format for storing translations. Numerous tools and libraries are available on most
platforms and programming languages to deal with this widespread format.

The translations are organized in several translations domains, where each domain is a
topic-specific area of OpenERP. Each domain has a separate list of translatable terms,
described in what is called a PO Template file, usually called domain.pot and found
in a i18n [4] subdirectory specific to that domain. Each OpenERP client (GTK/Native
and Web) represent a separate domain, and each OpenERP module is also a separate domain.

A domain template file does not contain any translation, but only lists the available terms
to be translated. Translations are regular .po files that should be located in the same
subdirectory as their domain template, and respect the following naming convention.


Warning

Domain templates files must be named domain.pot and located in a po or i18n
subdirectory.

For OpenERP 5.0, translation files must be named lc_CC.po after the corresponding
country and language code from ISO 3166 [2] and ISO 639-1 [3].
For example a translation in French from France would be fr_FR.po while one for
Brazilian Portuguese would be pt_BR.po.

For OpenERP 6.0 and later, translation files must be named lc_CC.po after the corresponding
country and language code from ISO 3166 [2] and ISO 639-1 [3], except for
the canonical combinations, such as French from France or Portuguese from Portugal, which
must only have the language code.
For example a translation in French from France would be fr.po and one for regular
Portuguese would be pt.po, but one for Brazilian Portuguese would be pt_BR.po.

If you were looking for the domain template and Belgian Dutch translation of the
account module, you would look for the following files in the addons project:

account
 i18n
   account.pot
   nl_BE.po










	[1]	http://www.gnu.org/software/autoconf/manual/gettext/PO-Files.html#PO-Files







	[2]	(1, 2) http://www.iso.org/iso/country_codes/iso_3166_code_lists.htm







	[3]	(1, 2) http://en.wikipedia.org/wiki/List_of_ISO_639-1_codes







	[4]	i18n is a common shortcut for Internationalization, as there are 18 letters
between the first i and last n in this word.
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OpenERP 文档翻译


先决条件

You should be able to build the untranslated documentation. So Sphinx [http://sphinx.pocoo.org] should be installed on your system and you should
know how to use it.

If this is not the case, please read about 建立文档 in the
Community Guide.

You can download the sources of the documentation from launchpad:


bzr branch lp:openobject-doc





理解目录结构

We are supposing that <openobject-doc> is the root of the Open Object
documentation bazaar branch.

The untranslated sources are located in <openobject-doc>/source.

The translated documentation will be located in <openobject-doc>>/i18n/<lang>/source.

For example, the documentation in French will be
located in <openobject-doc>/i18n/fr/source and it will be built
in <openobject-doc>/i18n/fr/build/html for example.


总览







	Directory
	Description




	<openobject-doc>/source
	untranslated sources


	<openobject-doc>/i18n/<lang>/source
	translated sources


	<openobject-doc>/i18n/<lang>/build/html
	translated documentation in html










创建翻译目录结构

Use the make command (with target i18n) to create the translation
templates. You’ll need to pass the language as an additional parameter to the make command.

For example, supposing you want to translate the documentation in French:

make i18n LANG=fr





This command will do several things:


	create these directories, if they does not exist yet:
	i18n

	i18n/fr

	i18n/fr/source

	i18n/fr/build





	copy files in i18n/fr/ required for the html build:
	MakeFile

	conf.py





	create the translation templates based on the untranslated restructured text files. They will be created in i18n/fr/source

	copy all the other necessary files (images for example)






翻译模版

The template structure for a given file is very simple. Each text section is
prepended by the original context. Here is a title, for example:

.. i18n: %%%%%%%%%%%%%%%%%%%%%%%%%
.. i18n: Open Object Documentation
.. i18n: %%%%%%%%%%%%%%%%%%%%%%%%%

%%%%%%%%%%%%%%%%%%%%%%%%%
Open Object Documentation
%%%%%%%%%%%%%%%%%%%%%%%%%





The context is a commented section starting with .. i18n:. It helps you
understand the section in context. It also helps you remember the original
section.

And here is the translated section:

.. i18n: %%%%%%%%%%%%%%%%%%%%%%%%%
.. i18n: Open Object Documentation
.. i18n: %%%%%%%%%%%%%%%%%%%%%%%%%

%%%%%%%%%%%%%%%%%%%%%%%%%%%%%
Documentation sur Open Object
%%%%%%%%%%%%%%%%%%%%%%%%%%%%%








源文件更改管理

If someone adds or changes something in the documentation, that section will
have to be retranslated but all the other sections should keep their
translation.

When you get the documentation changes with bzr pull (for example), the
new sections and some changed sections will be reset to the untranslated text
when you will rebuild the translation with make i18n LANG=fr.




以您的语言生成文档

That is very simple because the directory and file structure is exactly the
same as the original structure:

i18n
`-- fr
    |-- build
    `-- source





For example, in i18n/fr, you just have to do a simple make:

make html





And the html documentation will be built in i18n/fr/build/html.




上传到Launchpad

Once you have translated a few pages, you should commit back to launchpad.
To do this, your launchpad account must be subscribed in the
openobject-community group [http://https://launchpad.net/~openerp-community].

To upload your modifications, you should commit on launchpad:


bzr add YOUR_NEW_FILES_OR_DIR
bzr ci
bzr push





状态

At the moment, this script is in alpha status and has not been thoroughly
tested. It should work but expect some bugs to pop up at unexpected times.
Contact olt AT openerp.com if you notice some troubles.
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Bug 的提交和处理


Bug 跟踪

As described in the Launchpad 社区协作平台 section, OpenERP uses
Launchpad as the bug tracker platform.

Anyone is free to report new bugs or give feedback on existing ones
in OpenERP’s Launchpad bugtracker.
The only requirement is to sign up on Launchpad [https://login.launchpad.net/+new_account]
and join the OpenERP Community [https://launchpad.net/~openerp-community/+join] team,
which only requires a few clicks.


Note

Some additional team memberships are required in order to accomplish specific
tasks, as explained in the Bug 的处理 section below.



Any issue you notice in OpenERP should be reported on the appropriate
project on LaunchPad. A link to report a new bug can be found on the
top right side of the homepage of each Launchpad project.
Here is a quick overview of the direct links for reporting bugs on
each OpenERP project:







	项目
	Bug 报告页面


	OpenERP Addons
	http://bugs.launchpad.net/openobject-addons


	OpenERP Server
	http://bugs.launchpad.net/openobject-server


	OpenERP GTK Client
	http://bugs.launchpad.net/openobject-client


	OpenERP Web Client (6.0)
	http://bugs.launchpad.net/openobject-client-web


	OpenERP Web (6.1)
	http://bugs.launchpad.net/openerp-web






Important

The LaunchPad bug tracker automatically proposes bugs that look
similar to your bug title when you attempt to report a new one.
It is important to avoid reporting the same bug several times.
Be careful to double-check the proposed bugs to avoid
creating duplicates. However do not forget to proceed further
should none of the existing bugs match yours.






Bug 的定义

At the risk of stating the obvious, here are a few key points to keep in mind
concerning the definition of an OpenERP bug.

Is usually considered a bug:



	Any system failure with a complete stop or traceback

	Any abnormal behavior of the system resulting from an
issue with OpenERP code, without changing the original
functional scope or specification

	Any security breach in the code of the software

	Non compliance with the law for an existing feature
of a certified accounting module






Is usually not considered a bug:



	Non compliance with a customer specific need

	Abnormal system behavior due to defective
installation or configuration

	Security breach resulting from defective
installation or configuration

	Any usage of the software which would not
comply with some industry standard






Everything else is probably either a wishlist or should be made into
a blueprint for change/improvement.




Bug 的处理

The following figure depicts the generic Bug Handling Process currently applied
at OpenERP, and more specifically on the trunk branch,
also known as development version (see also the Bug 管理策略 section)


[image: Bug Management Process]


The processing of bugs is divided up into several successive main stages:



	Incoming bugs are reported on Launchpad by the whole OpenERP Community

	Qualification of new bugs is performed by a dedicated team within
OpenERP SA, assisted by the Drivers Team [https://launchpad.net/openerp-drivers],
a group of experienced Community Members.

	Actual bug Resolution is usually performed by the various OpenERP R&D teams,
unless the Qualification step was directly able to take care of the fix,
for example thanks to a patch contributed along with the bug report.

	The last step before a bugfix is fully released into the official trunk
branches is a final technical and functional review of the fix by the
Team Leader and/or the Quality Team.







Bug 的信息

In order to properly qualify each bug, the following attributes must be
properly set:



	the branch(es) it’s affecting must be correct

	the reproducibility of the bug must be verified, as well as the possible
duplication (if it’s a duplicate, mark it as such and stop processing it)

	the status must be correctly set, as explained in the next section

	the importance must be correctly set, as explained in the next section

	if the bug is valid and must be solved (now or in the future), it must
be assigned to the corresponding R&D Team

	if the bug is not solved yet, the milestone should not be set except
by the assigned R&D Team, to indicate when they plan to release the fix






Leaving a bug as New or Confirmed, but not assigning a proper Team is
not useful.

Qualified Bug Status

One of the following status values must be set on a bug when qualifying it:



	Confirmed: this means that the bug has been reproduced or is considered valid,
and has been accepted. Bugs in this state are considered open. Can be set also for
Wishlists that we plan to implement in a future release.

	Incomplete: the bug description does not contain enough information to properly
handle it, and prevents from reproducing it (such as missing version, no steps to
reproduce, or some other important information missing).
Keep in mind that bugs in this state might be updated with a response
(in Launchpad bug search you can filter on Incomplete with response or Incomplete without response).
As we have enabled auto-bug expiry on Launchpad these bugs will be put in status Expired
automatically by Launchpad after 60 days of inactivity, and no answer.
Bugs in this state are still considered open until they are Expired.

	Invalid: the bug cannot be reproduced at all or is incorrect, for example because
the poster has misunderstood OpenERP’s features or is misusing the system.
Bugs in this state are considered closed.
Note: If this looks like it could become a Frequently Asked Question, don’t hesitate to
Convert to a question before answering (link is on top-right of bug page).
This will mark the bug Invalid automatically, and then you can provide the answer on
the linked Question.

	Won’t Fix: bugs or wishlists that we can’t or don’t
want to fix/implement. Bugs in this state are considered closed.

	Triaged: this status means that the qualifier is not sure if the bug should be
confirmed or refused. Set this status and assign a Team to indicate that a Team Leader still
needs to confirm/refuse this bug before starting to work on it.
Bugs in this state are considered open.

	Fix Released: if you know the bug was valid and has been fixed since it was reported,
it may of course be marked directly as such (you may also set the appropriate milestone
if you know it)






Qualified Bug Importance

Assessing the importance of a bug is a difficult and often subjective task.
In order to have common criteria, we propose the following definition
for the severity levels on Launchpad bugs



	Critical: security issue (e.g. system compromised or arbitrary
code execution possible), or system completely unusable, for many users.
Any kind of data loss.

	High: major part of an application not working correctly and blocking
for many users: like the impossibility to display Sale Orders
for all users (not just for a peculiar setup, but in most cases)

	Medium: a minor part of an applications not working correctly (not
really blocking), or a major feature not working for few users only
or for a specific configuration only.

	Low: the rest, mostly usability issues (eg. presentation/layout issues)
that don’t prevent to use any of the features.

	Wishlist: nice to have features/patches, propositions to enhance/modify
the current logic.






Qualified Bug Assignation

In order to be actually solved, a bug should be assigned to the R&D Team in charge
of this area of OpenERP. Each team will assign milestones to indicate when they
plan to release the fix for each bug. The main R&D teams and their responsibilities
are currently:



	Addons Team 1 [http://launchpad.net/~openerp-dev-addons1] is responsible for CRM, Project, Plugins, Knowledge, Tools

	Addons Team 2 [http://launchpad.net/~openerp-dev-addons2] is responsible for MRP, Stock, Purchase, Procurement, Marketing

	Addons Team 3 [http://launchpad.net/~openerp-dev-addons3] is responsible for Account, Sales, Point of sale, Association, HR

	Framework Team [http://launchpad.net/~openerp-dev-framework] is responsible for the Server/Framework

	GTK Team [http://launchpad.net/~openerp-dev-gtk] is responsible for the GTK Native Client

	Web Team [http://launchpad.net/~openerp-dev-web] is responsible for the Web Interface






Milestone Assignation

Milestones should be set only for bugs that have been fixed, to track when it happened,
or by the R&D team to indicate when they plan to release the fix.






Bug 管理策略


OpenERP Bug Policy

The official OpenERP policy is different depending on the version/branch the bug affects.
Bugs reported against the trunk/development branch are all processed as described in the
Bug 的处理 section. Bugs reported on a stable branch follow a much stricter
qualification process, to limit the risk of regressions on these production-grade versions.


trunk

All bugs and wishlists should be reported on Launchpad, and
will be qualified by the OpenERP Launchpad Qualification
team. Valid bugs will be confirmed and scheduled for
resolution according to their importance. Wishlists will be
accepted depending on the R&D strategy, and scheduled in the
R&D backlog at the discretion of the R&D Teams.

stable

Bugs on stable releases may be reported:



	via Launchpad for High/Critical importance (no guaranteed response time)

	via the OpenERP Enterprise channel (former Publisher’s Warranty) for Customers
(guaranteed response time according to the
contract [http://www.openerp.com/services/subscribe-onsite])






Valid bugs that also affect trunk
will be fixed in trunk, but the fix will only be applied to
stable if their importance requires the release of an updated version (security issue,
major issue affecting important features, etc.) Anything that looks
like a change or improvement will not be accepted on stable.




You will find the complete rationale for this policy below. You may also want to have
a look at the Bug 管理 FAQ.



Rationale for the Bug Policy

As of November 2010, OpenERP has started to enforce a stricter policy, which
means that you may be surprised to see that more Launchpad bugs are
closed with status Invalid or Won’t Fix. The goal being pursued is to
really improve the stability of the stable versions.

OpenERP used to have developers working on all bugs reported via Launchpad,
regardless of the OpenERP release they were reported on, and without a strict
policy on what is accepted as a bug and what is not.
A few years of working in this manner has shown us that this is not efficient,
as it leads to long processing times for some bugs, and too often to the introduction
of regressions in the stable branches:



	The main trouble with past stable versions
was that developers did too many changes on
the stable branch and introduced regressions (because
the Support/Maintenance team was fixing a maximum of requests
on stable branch reported by the
community). This was too risky for a stable version.

	Only very few of these changes were impacting customers ;
changing a stable branch used by customers in production is always a
risk that should be minimized.

	Most of these requests (65% of bugs according to a
recent bug qualification sprint) were feature improvements, not bugs.

	The distinction was not clear between bugs fixed through the
OpenERP Enterprise contract with a guaranteed response time,
and those fixed for free on Launchpad. The Support team did its
best to fix both.






In order to improve the situation, OpenERP has split up the teams assigned to the resolution of bugs
and the corresponding processes, separating the management of general purpose
community bug reports (improving the product for the future) and the management
of day-to-day issues encountered on production systems
(ensuring stability in a conservative manner):



	The OpenERP Launchpad team is dedicated to processing all bugs reported via
Launchpad, qualifying them as quickly as possible, and getting them solved
by the R&D teams. They must not touch the stable branches directly, and any
important issue reported on a stable branch will be passed on to the
OpenERP Enterprise team.

	The OpenERP Enterprise team (formerly OpenERP Publisher’s Warranty) is in
charge of receiving issues reported directly by customers via the OpenERP
Publisher’s Warranty, providing high-level expertise within short response times,
including workarounds and patches when available.
They carefully select the fixes to apply to the stable branches, to be published
every month.






This way the responsibilities of the teams are clear, and we can appropriately
implement continuous improvement, with distinct goals!


Bug 管理 FAQ


1. What is the policy regarding bugs encountered by users of the OpenERP Online Offer?

Customers of OpenERP’s Online Offer [http://www.openerp.com/services] are automatically
subscribed to an OpenERP Enterprise contract so any bug they report via their
dedicated Support/Maintenance channel will be handled accordingly.




2. My Launchpad bug report was refused for the stable release I reported! How can I get it
        fixed for my important projects/customers?

It is the responsibility of OpenERP Enterprise team (former OpenERP Publisher’s Warranty) to
maintain the maximum stability of the stable branches, and this implies being very strict on
what can be considered important enough to qualify for a patch on a stable branch.

Note that if the bug affects the trunk as well, you can simply try to apply or backport the fix that was
or will be provided for trunk. Other community contributors may also provide patches for the stable
branch even if the bug was




3. My Launchpad bug report/feature request was closed as Invalid or Won’t Fix, but I can prove that
        it really is valid! How can I get it fixed/implemented for my important projects/customers?

This may happen and is not necessarily an error. OpenERP cannot cover all possible cases and does
not want to. The idea is to support the most important and common features, and try to avoid
becoming overcomplicated or bloated.
However OpenERP is also easily extensible and customizable, so you could instead handle your
special cases or features in customization modules (if done well and often requested,
they could later be included in the official addons)




4. What’s the matter with OpenERP Web Client bugs being all closed as Won’t Fix?

As you certainly noticed, bugs reported against the 6.0 web client series had not
been receiving a lot of attention lately on Launchpad.

The reason is that the OpenERP Web Client from the 6.0 series will not be developed further
in the future, as it was becoming too hard to maintain, due to its aging architecture.
For the 6.1 series, a
new web frontend [https://launchpad.net/openerp-web] is under development, rewritten from
scratch with a clean (HTML5/Javascript) state-of-the-art architecture. This will make future
improvements and maintenance much easier.

The OpenERP Bug Management Policy explains that R&D developers solve
bugs reported on Launchpad in the trunk development branch, in order to improve the
product for the future, for everyone. As this project will no longer be used in 6.1,
these R&D efforts would now be wasted.

Concerning the correction of bugs in the stable series, this is the responsibility of the
OpenERP Enterprise (OPW) maintenance team, for all the reasons explained
above, and they will of course continue to do it as long as the 6.0 LTS
series is supported.

The R&D Web Team can therefore dedicate all its efforts to finishing the new
OpenERP 6.1 client, and making it very robust, stable, easy to improve and maintain.
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新功能要求

If you want to suggest or request some additional modules or functionality, you use the
Launchpad Blueprints [https://blueprints.launchpad.net/openobject].
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交流


论坛


用户 - 论坛

URL: http://openerp.com/forum/general-discussion-f11.html

This forum is used to request help on general topics and is more useful for
users. It could be functional question, configuration problem and so on. Every
request posted on this forum will appear in the according mailing-list. It
functions both ways, so every post on the mailing list will also appear in the
forum.




开发者 - 论坛

URL: http://openerp.com/forum/general-questions-f37.html

This forum is used for committers to ask for more help about a bug resolution.
An automatic message is sent to the associated mailing list when you click on a
button featured in the bug tracker. It functions both
ways, so every post on the mailing list will also appear in the forum.






IRC




邮件列表


用户邮件列表

This mailing list serves the same purpose as the Users Forum

http://tiny.be/mailman/listinfo/tinyerp-users: the web interface to manage your subscription.




技术邮件列表

This mailing list serves the same purpose as the Developers Forum

http://tiny.be/mailman/listinfo/tinyerp-devel: the web interface to manage your subscription.




合作伙伴邮件列表

This is the partner communication canal. It is used to ask about skills or
contributions on project, share development, announcing IRC meeting, .... It is
also the communication channel between Tiny and their partners.

http://tiny.be/mailman/listinfo/partners: the web interface to manage your subscription.






Wiki

The OpenObject wiki is used to manage activities around OpenERP.



	http://openobject.com/wiki






You’ll find information about:



	Shared Funding Projects

	IRC Meetings

	Real Life Meetings (eg. Community Days)

	Business Intelligence

	Open Report (eg. OpenReport, OpenOffice Plugin)






To keep you aware about what is improved on this wiki, use this RSS feed:



	http://openobject.com/wiki/index.php?title=Special:Recentchanges&feed=rss









博客


	
Where is Planet OpenERP located ?

	



http://www.openerp.com/planet


	
How to contribute to Planet OpenERP RSS ?

	



Only committers can write in the planet, others can announce on the forum.

If you are a member of the commiter team:



	Create your personal blog

	Send an email to nva AT openerp.com with your name, photo and address of your blog.
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OpenERP 版本发布常见问题

OpenERP 主要有2个系列：Stable 系列（5.0, 6.0, 6.1, ...）这个系列适合生产部署，Trunk 系列 这是一个开发中的版本，准备演化到下一个稳定版。
stable 系列是属于维护状态，意味着不再接受新需求改进或新的功能，但仍会继续修正BUG。
相反, trunk 系列可能会有新的功能和改进，因而通常不适合生产部署。

以下是关于版本发布常见问题列表。


	什么时候发布新的 稳定版/主分支？ 还有版本号是如何命名？



The frequency of major stable releases has fluctuated in the past, but the current policy is to release a new stable version every 6 months on average, with one out of three stable versions being a Long Term Support (LTS) version. An LTS version is normal stable version, but one that is supported for an extended time under the OpenERP Publisher’s Warranty (OPW).
Stable versions are labelled as a decimal number with 2 components (e.g. 6.1), where the leftmost part indicates the corresponding Long Term Support (LTS) version, and the second digit indicates successive stable releases between two LTS versions.

As an illustration, here is a prospective list of future releases:



	09/2011: 6.1

	03/2012: 6.2

	09/2012: 7.0 LTS

	03/2013: 7.1







	什么时候实际支持LTS版本？并且如何理解您说的“支持”？



The OpenERP Publisher’s Warranty contract covers the 3 last LTS version in parallel. This means that when a new LTS version is released, an older version reaches its end-of-life, and is not supported anymore.
As an example, 6.0 LTS will be supported along with 7.0 LTS and 8.0 LTS, but will reach end-of-life when 9.0 LTS is released.
The OPW contract defines the kind of support you get for each covered version. This usually includes unlimited bug fixes.
You can also read in detail our bug correction policy here: http://doc.openerp.com/v6.0/contribute/11_bug_tracker.html#bug-management-policy


	一个LTS版本和另一个主要版本之间的区别是什么？升级过程有什么不同？



Apart from the extended support period, a LTS version is just a normal major version. Any major version introduces many new features and improvements, and some changes that may not be fully compatible with previous version. This is true for non-LTS major versions too. For each major version, you can upgrade via OPW’s migration services.


	轻微/修补程序版本和主要版本之间的区别是什么？升级过程有什么不同？



Major versions introduce new features and may not be directly compatible with previous stable series. As a result, a complete migration process has to be followed when going from one major version to the next. This is available via the OPW.
Minor versions only introduce bug corrections, but no new features, so the upgrade procedure is built-in in OpenERP Server. You simply need to restart the server once with the additional options “-d <DB> -u all”.


Hint

See also the 安装 section for more details
regarding the update process.




	When are minor/patch versions released? How are they numbered? Where can the release schedule be found?



Minor versions (a.k.a. patch versions) do not follow a fixed schedule, but are instead released as soon as our OPW team considers that important bugs have been corrected, or that a large number of smaller corrections are now available. If very important issues are discovered one after the other, it may be possible for several patch versions to be released quite close to each other.
Minor versions are labelled with 3 numbers (e.g. 6.1.2) where the 2 leftmost numbers correspond to the major release, and the last number indicates successive minor releases between two LTS versions. The most recent minor version (the one with the highest 3rd number) is the recommended one for all production environments.
As there is no fixed release schedule, it is not possible to publish it beforehand. The series of milestones on Launchpad are just prospective dates, and may change without notice.


	I really need a given stable bugfix, but there is no minor version that contains it yet. What can I do?



If the bug has already been corrected in the corresponding stable series, it means that you can already download it from the source repository on Launchpad, and apply it to your installation.
If you prefer to have a full installation package, you can contact the OPW team via your usual OPW channel and explain why this bug requires a faster release.
We also plan to provide very soon a nightly build system so that the latest code for each series can always be downloaded as a full installer, without waiting for a formally tagged release.





          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	如何回馈社区 
 
      

    


    
      
          
            
  
OpenERP 指引

下列指引主要是给新参与到OpenERP社区的人提供一个参考。为了让OpenERP能保持
高水平的质量改进，希望每一个新贡献者在开始贡献前都阅读本章节。

对于程序员浏览以下的最佳实践对于更新他们技巧和编程习惯也是相当重要的。

作为质量审查的一个重要步骤，希望大家在对贡献（代码、文档、任何东西）提交反馈的时候都按照以下指引。
如果你发现列表中缺少某个指引或者发现里面有好（或坏的）的例子，请随时贡献。

评论系统可以用来达到这个目的，不过直接更新本文档的源码就更好了。（请看贡献指引）



	编程指引
	1Python代码风格指南

	2OpenERP 特别指引

	3YAML 自动测试指南





	文档指南
	实用和简明文档





	贡献指南
	提交Bug

	合并申请 & 修补程序

	使用共享库以加快分支管理





	使用指南

	本地化指南
	本地化模块的内容

	通用指南

	科目类型指南 (account.account.type)

	科目表指南 (account.account.template)

	税码表指南 (account.tax.code.template)

	科目表指南 account.chart.template

	税项指南 (account.tax.template)

	财务结构指南 (account.fiscal.position.template)

	模块依赖指南

	特定报表指南
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编程指引

以下条目由OpenERP质量团队维护并且作为质量审查的一部分。
包含了OpenERP的推荐的/不推荐的实现方式，以及通用的Python编程建议。

这两部分是每一个OpenERP的开发、贡献者都必须阅读的。

请谨记以下几点普遍的规则：


你写的每一行代码将会被别人（包括你自己）读很多次


相信大家都知道以上的风险，意味着你在按照其他指引的时候，
必须依靠自己准确的判断以实现最好的代码可读性。
为写出可读性高的代码而努力是非常值得的。



	1Python代码风格指南
	1.1魔术方法

	1.2.clone()

	1.3“clone 和 update”

	1.4“手动 update”

	1.5Java 的字典创建方式

	1.6“临时的 kwargs”

	1.7（正式和非正式）过时的方法

	1.8没必要的中间变量

	1.9让冗余代码三振出局

	1.10简单的多个返回点是可以接受的

	1.11尽量避免类型测试

	1.12除非你知道要的是什么类型，否则不要使用 type

	1.13如果真的想用，那就用python提供的类型测试

	1.14不要只是为了调用函数而创造新函数

	1.15了解内建函数

	1.16学习列表推导式

	1.17学习你的标准库

	1.18Collections 也是布尔类型

	1.19你可以把一个对象添加到列表中

	1.20列表相加

	1.21学习你的标准库 (2)

	1.22遍历可迭代对象

	1.23链接调用是可以的，只要你不要滥用

	1.24使用 dict.setdefault

	1.25使用默认值，远离“神奇数字”





	2OpenERP 特别指引
	2.1Bazaar 是你的历史档案

	2.2命名要言之有物

	2.3不要绕过ORM

	2.4请不要SQL注入

	2.5合理抽象

	2.6警惕context

	2.7有时候这比 lambda 好

	2.8保持您的方法尽量简洁/简单

	2.9不要提交事务

	2.10正确使用 gettext 方法





	3YAML 自动测试指南
	3.1语法

	3.2运行在服务端的测试

	3.3精确的测试目标

	3.4尽量避免依赖那些会被用户修改的数据

	3.5把测试信息写得详细有助于Yaml测试系统进行测试

	3.6避免依赖现有的数据以防用户修改它们

	3.7不用深究测试的具体出错信息

	3.8说明用户要做什么比在哪里点击要好

	3.9你可以在测试里使用”onchange”以此来模拟客户端
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1Python代码风格指南

In additions to these guidelines, you may also find the following link
interesting:



	http://python.net/~goodger/projects/pycon/2007/idiomatic/handout.html (a little bit outdated, but quite relevant)







1.1魔术方法

magic methods (starting and ending with two underscores) should not have to be called directly unless you’re overriding a method of the same name.

magic methods are used to implement specific protocols and are called for you, either due to operator access or due to some special operation using them:

# bad
levels.__contains__(name)
# good
name in levels
# very bad
kw.__setitem__('nodes',nodes)
# much better
kw['nodes'] = nodes








1.2.clone()

rarely necessary (unless you really have no idea what the type of the variable you’re trying to clone is), never necessary for built-in collections: just call the constructor with your existing collection:

# bad
new_dict = my_dict.clone()
# good
new_dict = dict(my_dict)
# bad
new_list = old_list.clone()
# good
new_list = list(old_list)





And don’t clone manually, please:

# surely you jest!
values = []
for val in view_items:
        values += [val]
# sane
values = list(view_items)








1.3“clone 和 update”

the dict constructor takes both a single (optional) positional argument (either a dictionary-like object or an iterable of 2-tuples) and an unlimited number of keyword arguments. Thus, you can “merge” two different dictionaries into a third, new, dictionary:

# bad
dictionary3 = dictionary1.clone()
dictionary3.update(dictionary2)
# worse
dictionary3 = {}
dictionary3.update(d1)
dictionary3.update(d2)
# good
dictionary3 = dict(dictionary1, **dictionary2)





You can use those properties for simpler operations, such as cloning an existing dict and (re) setting a key:

# no
context = kw.clone()
context['foo'] = 'bar'
# yes
context = dict(kw, foo='bar')








1.4“手动 update”

the signature of dict.update is the same as dict(): a single, optional, positional argument and an unlimited number of keyword arguments.

Thus the following are possible:

merging a dict from another one:

# bad
for key, value in other_dict.iteritems():
        my_dict[key] = value
# good
my_dict.update(other_dict)





Setting a bunch of keys at the same time:

# bad
my_dict['foo'] = 3
my_dict['bar'] = 4
my_dict['baz'] = 5
# good
my_dict.update(
        foo=3,
        bar=4,
        baz=5)








1.5Java 的字典创建方式

Python isn’t java, it has literals:

# very very very bad
my_dict = {}
my_dict['foo'] = 3
my_dict['bar'] = 4
my_dict['baz'] = 5
# good
my_dict = {
        'foo': 3,
        'bar': 4,
        'baz': 5
}








1.6“临时的 kwargs”

keyword arguments are a good way to get a bunch of unspecified supplementary arguments if e.g. you just want to forward them:

def foo(**kwargs):
        logging.debug('Calling foo with arguments %s', kwargs)
        return bar(**kwargs)





or if you retrieved a ready-made dict (from another function) and want to pass its content to another function or method:

sessions = some_function_returning_a_dict_of_sessions()
some_other_function(**sessions)





but there is no point whatsoever in creating a dict for the sake of passing it as **kwargs, just provide the damn keyword arguments:

# waste of time and space
my_dict = {
        'foo': 3,
        'bar': 4,
        'baz': 5
}
some_func(**my_dict)
# good
some_func(foo=3, bar=4, baz=5)








1.7（正式和非正式）过时的方法

dict.has_key(key) is deprecated, please use the in operator:

# bad
kw.has_key('cross_on_pages')
# good
'cross_on_pages' in kw








1.8没必要的中间变量

Temporary variables can make the code clearer by giving names to objects, but that doesn’t mean you should create temporary variables all the time:

# pointless
schema = kw['schema']
params = {'schema': schema}
# simpler
params = {'schema': kw['schema']}








1.9让冗余代码三振出局

A bit of redundancy can be accepted: maybe you have to get the content of an axis:

col_axes = []
if kw.has_key('col_axis'):
    col_axes = self.axes(kw['col_axis'])





and a second one:

col_axes = []
if kw.has_key('col_axis'):
    col_axes = self.axes(kw['col_axis'])
page_axes= []
if kw.has_key('page_axis'):
    page_axes = self.axes(kw['page_axis'])





But at the third strike, chances are you’re going to need the thing again and again. Time to refactor:

def get_axis(self, name, kw):
        if name not in kw:
            return []
        return self.axes(kw[name])
#[…]
col_axes = self.get_axis('col_axis', kw)
page_axes = self.get_axis('page_axis', kw)





The refactoring could also be an improvement of a method already called (be sure to check where the method is called in order not to break other pieces of code. Or write tests):

# from
def axes(self, axis):
        axes = []
        if type(axis) == type([]):
                axes.extend(axis)
        else:
                axes.append(axis)
        return axes

def output(self, **kw):
        col_axes = []
        if kw.has_key('col_axis'):
                col_axes = self.axes(kw['col_axis'])
        page_axes = []
        if kw.has_key('page_axis'):
                page_axes = self.axes(kw['page_axis'])
        cross_on_rows = []
        if kw.has_key('cross_on_rows'):
                 cross_on_rows = self.axes(kw['cross_on_rows'])

# to:
def axes(self, axis):
        if axis is None: return []
        axes = []
        if type(axis) == type([]):
                axes.extend(axis)
        else:
                axes.append(axis)
        return axes

def output(self, **kw):
        col_axes = self.axes(kw.get('col_axis'))
        page_axes = self.axes(kw.get('page_axis'))
        cross_on_rows = self.axes(kw.get('cross_on_rows'))








1.10简单的多个返回点是可以接受的

# a bit complex and with a redundant temp variable
def axes(self, axis):
        axes = []
        if type(axis) == type([]):
                axes.extend(axis)
        else:
                axes.append(axis)
        return axes

 # clearer
def axes(self, axis):
        if type(axis) == type([]):
                return list(axis) # clone the axis
        else:
                return [axis] # single-element list








1.11尽量避免类型测试

Python is a dynamically typed languages, if you don’t absolutely need to
receive a list, then don’t test for a list, just do your stuff (e.g. iterating
on it, then caller can provide any kind of iterator or container)




1.12除非你知道要的是什么类型，否则不要使用 type

The type of a list is list, the type of a dict is dict:

# bad
def axes(self, axis):
        if type(axis) == type([]): # we already know what the type of [] is
                return list(axis)
        else:
                return [axis]
# good
def axes(self, axis):
        if type(axis) == list:
                return list(axis)
        else:
                return [axis]





plus Python types are singletons, so you can just test for identity, it reads better:

# better
def axes(self, axis):
        if type(axis) is list:
                return list(axis)
        else:
                return [axis]








1.13如果真的想用，那就用python提供的类型测试

The previous piece of code will fail if the caller provided a subclass of list (which is possible and allowed), because == and is don’t check for subtypes. isinstance does:

# shiny
def axes(self, axis):
        if isinstance(axis, list):
                return list(axis) # clone the axis
        else:
                return [axis] # single-element list








1.14不要只是为了调用函数而创造新函数

# dumb, ``str`` is already callable
parent_id = map(lambda x: str(x), parent_id.split(','))
# better
parent_id = map(str, parent_id.split(','))








1.15了解内建函数

You should at least have a basic understanding of all the Python builtins (http://docs.python.org/library/functions.html)

For example, isinstance can take more than one type as its second argument, so you could write:

def axes(self, axis):
        if isinstance(axis, (list, set, dict)):
                return list(axis)
        else:
                return [axis]





Another one is dict.get, whose second argument defaults to None:

# very very redundant
value = my_dict.get('key', None)
# good
value= my_dict.get('key')





Also, if 'key' in my_dict and if my_dict.get('key') have very different meaning, be sure that you’re using the right one.




1.16学习列表推导式

When used correctly, list comprehensions can greatly enhance the quality of a piece of code when mapping and/or filtering collections:

# not very good
cube = []
for i in res:
        cube.append((i['id'],i['name']))
# better
cube = [(i['id'], i['name']) for i in res]





But beware: with great power comes great responsibility, and list comprehensions can become overly complex. In that case, either revert back to “normal” for loops, extract functions or do your transformation in multiple steps




1.17学习你的标准库

Python is provided “with batteries included”, but these batteries are often
criminally underused. Some standard modules to know are itertools,
operator and collections, among others (though be careful to note the
python version at which functions and objects were introduced, don’t break
compatibility with the officially supported versions for your tool):

# no
cube = map(lambda i: (i['id'], i['name']), res)
# still no
cube = [(i['id'], i['name']) for i in res]
# yes, with operator.itemgetter
cube = map(itemgetter('id', 'name'), res)





Excellent resources for this are the official stdlib documentation (http://docs.python.org/library/index.html ) and Python Module of the Week (http://www.doughellmann.com/projects/PyMOTW/, do subscribe to its RSS feed)




1.18Collections 也是布尔类型

In python, many objects have “boolean-ish” value when evaluated in a boolean context (such as an if). Among these are collections (lists, dicts, sets, …) which are “falsy” when empty and “truthy” when containing items:

bool([]) is False
bool([1]) is True
bool([False]) is True





therefore, no need to call len:

# redundant
if len(some_collection):
        "do something..."
# simpler
if some_collection:
        "do something..."








1.19你可以把一个对象添加到列表中

# no
some_list += [some_item]
# yes
some_list.append(some_item)
# very no
view += [(code, values)]
# yes
view.append((code, values))








1.20列表相加

# obscure
my_list = []
my_list += list1
my_list += list2
# simpler
my_list = list1 + list2








1.21学习你的标准库 (2)

Itertools is your friend for all things iterable:

# ugly
my_list = []
my_list += list1
my_list += list2
for element in my_list:
        "do something..."
# unclear, creates a pointless temporary list
for element in list1 + list2:
        "do something..."
# says what I mean
for element in itertools.chain(list1, list2):
        "do something..."








1.22遍历可迭代对象

# creates a temporary list and looks bar
for key in my_dict.keys():
        "do something..."
# better
for key in my_dict:
        "do something..."
# creates a temporary list
for key, value in my_dict.items():
        "do something..."
# only iterates
for key, value in my_dict.iteritems():
        "do something..."








1.23链接调用是可以的，只要你不要滥用

# what's the point of the ``graph`` temporary variable?
# plus it shadows the ``graph`` module, bad move
graph = graph.Graph(kw)
mdx = ustr(graph.display())
# just as readable
mdx = ustr(grah.Graph(kw).display())





NOTE:

yes, here the temporary variable graph is redundant but sometimes using such
temporary variables simplify code debugging when you want to inspect the
variable and you put breakpoint on the single line expression it’s difficult to
know when to do step-in and step-out.




1.24使用 dict.setdefault

If you need to modify a nested container for example:

# longer.. harder to read
values = {}
for element in iterable:
    if element not in values:
        values[element] = []
    values[element].append(other_value)

# better.. use dict.setdefault method
values = {}
for element in iterable:
    values.setdefault(element, []).append(other_value)






	Documentation for dict.setdefault [http://docs.python.org/library/stdtypes.html?highlight=setdefault#dict.setdefault]






1.25使用默认值，远离“神奇数字”

# bad
limit = 20

# bad
search(cr, uid, ids, domain, limit=20, context=context)





You should use a constant, name it correctly, and perhaps add a comment on it
explaining where the value comes from. And of course it’s cleaner, easier
to read and there’s only one place to modify.
Oh and that is true not just for numbers, but for any literal value that is
semantically a constant!

# better
DEFAULT_SEARCH_LIMIT = 20  # limit to 20 results due to screen size

search(cr, uid, ids, domain, limit=DEFAULT_LIMIT, context=context)
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2OpenERP 特别指引


2.1Bazaar 是你的历史档案

不要通过注释来禁用代码。代码的各个版本会记录在Bazaar里面，把你的意见写到里面，它不会丢失这些文件的记录的。

留下注释只会让代码更加难以阅读。diff 的目的就是让你不用担心直接更改代码:

# 例如这里的代码是真的被删除了。 ;-)








2.2命名要言之有物

变量的名字需要有其含义。
你现在可能知道他的意思，但是2个月后或者别人就不知道了。
单个字母的变量只允许在lambda表达式、循环的索引又或者是数学表达式里出现
（而且给它一个真正的名字也不会有什么坏处）:

# 不清楚，具误导性
a = {}
ffields = {}

# 更好
results = {}
selected_fields = {}








2.3不要绕过ORM

如果ORM能实现的就不要通过直接写数据库语句！ 这样你会绕过ORM的权限控制等功能来进行操作。

代码不仅更难读，还有可能有安全的问题（请看下一个指引）:

# 非常、非常不推荐
cr.execute('select id from auction_lots where auction_id in (' +
           ','.join(map(str,ids))+') and state=%s and obj_price>0',
           ('draft',))
auction_lots_ids = [x[0] for x in cr.fetchall()]

# 没注入不过仍然不推荐
cr.execute('select id from auction_lots where auction_id in %s '\
           'and state=%s and obj_price>0',
           (tuple(ids),'draft',))
auction_lots_ids = [x[0] for x in cr.fetchall()]

# 更好
auction_lots_ids = self.search(cr,uid,
                               [('auction_id','in',ids),
                                ('state','=','draft'),
                                ('obj_price','>',0)])








2.4请不要SQL注入

Care must be taken not to introduce SQL injections vulnerabilities when using
manual SQL queries.  The vulnerability is present when user input is either
incorrectly filtered or badly quoted, allowing an attacker to introduce
undesirable clauses to a SQL query (such as circumventing filters or executing
UPDATE or DELETE commands).

The best way to be safe is to never, NEVER use Python string concatenation (+)
or string parameters interpolation (%) to pass variables to a SQL query string.

The second reason, which is almost as important, is that it is the job of the
database abstraction layer (psycopg2) to decide how to format query parameters,
not your job!
For example psycopg2 knows that when you pass a list of values it needs to
format them as a comma-separated list, enclosed in parentheses!

# the following is very bad:
#   - it's a SQL injection vulnerability
#   - it's unreadable
#   - it's not your job to format the list of ids
cr.execute('select distinct child_id from account_account_consol_rel ' +
           'where parent_id in ('+','.join(map(str, ids))+')')

# better
cr.execute('SELECT DISTINCT child_id '\
           'FROM account_account_consol_rel '\
           'WHERE parent_id IN %s',
           (tuple(ids),))





This is very important, so please be careful also when refactoring, and most
importantly do not copy these patterns!

Here is a memorable example [http://www.bobby-tables.com] to help
you remember what the issue is about (but do not copy the code there).

Before continuing, please be sure to read the online documentation of pyscopg2
to learn of to use it properly:



	The problem with query parameters [http://initd.org/psycopg/docs/usage.html#the-problem-with-the-query-parameters]

	How to pass parameters with psycopg2 [http://initd.org/psycopg/docs/usage.html#passing-parameters-to-sql-queries]

	Advanced parameter types [http://initd.org/psycopg/docs/usage.html#adaptation-of-python-values-to-sql-types]









2.5合理抽象

If you are writing the same code over and over and it is more than one line,
then you must factor it out into a reusable function or method:

# after writing this multiple times:
terp = get_module_resource(module, '__openerp__.py')
if not os.path.isfile(terp):
   terp = addons.get_module_resource(module, '__terp__.py')
   info = eval(tools.file_open(terp).read())

# make a function out of it
def _load_information_from_description_file(module):
    for filename in ['__openerp__.py', '__terp__.py']:
        description_file = addons.get_module_resource(module, filename)
        if os.path.isfile(description_file):
            return eval(tools.file_open(description_file).read())
    raise Exception('The module %s does not contain a description file!')








2.6警惕context

Do not use mutable objects as default values for functions, because they are
created as constants (evaluated only once), so you will have possible
side-effects if you modify them.
The usual example of this is the context argument to all ORM methods:

# bad, this could have side-effects
def spam(eggs, context={}):
   setting = context.get('foo')
   #...

# this is better if your need to use the context
def spam(eggs, context=None):
   if context is None:
      context = {}
   setting = context.get('foo')
   #...





Also be careful with boolean tests on lists and maps, because an empty
dict, list or tuple will evaluate as False:

# bad, you shadow the original context if it's empty
def spam(eggs, context=None):
   if not context:
      context = {}
   setting = context.get('foo')
   #...





And it’s okay if you only need to forward it, you can pass None and
let the downstream code handle it:

# fine
def spam(eggs, context=None):
    setting = get_setting(True, context=context)





See also launchpad bug 525808 [https://bugs.launchpad.net/openobject-server/+bug/525808].




2.7有时候这比 lambda 好

Instead of writing trivial lambda expression to extract items or attributes
from a list of data structures, learn to use list comprehension
or operator.itemgetter and operator.attrgetter instead, which are
often more readable and faster:

# not very readable
partner_tuples = map(lambda x: (x['id'], x['name']), partners)

# better with list comprehension for just one item/attribute
partner_ids = [partner['id'] for partner in partners]

# better with operator for many items/attributes
from operator import itemgetter
# ...
partner_tuples = map(itemgetter('id', 'name'), partners)





See also http://docs.python.org/library/operator.html#operator.attrgetter

As of version 6.0 you can also use literal values as defaults for
your ORM columns, which means that you can stop writing these:

# lots of trivial one-liners in 5.0
_defaults = {
    'active': lambda *x: True,
    'state': lambda *x: 'draft',
}

# much simpler as of 6.0
_defaults = {
    'active': True,
    'state': 'draft',
}






Warning

Be careful with this, because non-callable defaults are only evaluated
once! If you want to generate new default values for each
record you really need to keep the lambda or make it a callable.



The most frequent error is with timestamps, as in the following example:

# This will always give the server start time!
_defaults = {
    'timestamp': time.strftime('%Y-%m-%d %H:%M:%S'),
}

# You need to keep it callable, e.g:
_defaults = {
    'timestamp': lambda *x: time.strftime('%Y-%m-%d %H:%M:%S'),
}








2.8保持您的方法尽量简洁/简单

Functions and methods should not contain too much logic: having a lot of small and simple methods is more advisable than having few
large and complex methods. A good rule of thumb is to split a method as soon as:



	it has more than one responsibility (see http://en.wikipedia.org/wiki/Single_responsibility_principle)

	it is too big to fit on one screen.






Also, name your functions accordingly: small and properly named functions are the starting point of readable/maintainable code and tighter documentation.

This recommendation is also relevant for classes, files, modules and packages. (See also http://en.wikipedia.org/wiki/Cyclomatic_complexity )




2.9不要提交事务

The OpenERP/OpenObject framework is in charge of providing the transactional context for all RPC calls.
The principle is that a new database cursor is opened at the beginning of each RPC call, and committed
when the call has returned, just before transmitting the answer to the RPC client, approximately like this:

def execute(self, db_name, uid, obj, method, *args, **kw):
    db, pool = pooler.get_db_and_pool(db_name)
    # create transaction cursor
    cr = db.cursor()
    try:
        res = pool.execute_cr(cr, uid, obj, method, *args, **kw)
        cr.commit() # all good, we commit
    except Exception:
        cr.rollback() # error, rollback everything atomically
        raise
    finally:
        cr.close() # always close cursor opened manually
    return res





If any error occurs during the execution of the RPC call, the transaction is rolled back atomically,
preserving the state of the system.

Similarly, the system also provides a dedicated transaction during the execution of tests suites,
so it can be rolled back or not depending on the server startup options.

The consequence is that if you manually call cr.commit() anywhere there is a very high chance
that you will break the system in various ways, because you will cause partial commits, and thus
partial and unclean rollbacks, causing among others:



	inconsistent business data, usually data loss ;

	workflow desynchronization, documents stuck permanently ;

	tests that can’t be rolled back cleanly, and will start polluting the database,
and triggering error (this is true even if no error occurs during the transaction) ;






Here is the very simple rule:


Warning

You should NEVER call cr.commit() yourself, UNLESS you have created your own
database cursor explicitly! And the situations where you need to do that are exceptional!



And by the way if you did create your own cursor, then you need to handle error cases and proper
rollback, as well as properly close the cursor when you’re done with it.

And contrary to popular belief, you do not even need to call cr.commit() in the following
situations:



	in the _auto_init() method of an osv.osv object: this is taken care of by the addons
initialization method, or by the ORM transaction when creating custom models ;

	in reports: the commit() is handled by the framework too, so you can update the database
even from within a report ;

	within osv.osv_memory methods: these methods are called exactly like regular osv.osv
ones, within a transaction and with the corresponding cr.commit()/rollback() at the end ;

	etc. (see general rule above if you have in doubt!)






And another very simple rule:


Warning

All cr.commit() calls outside of the server framework from now on must have an explicit
comment explaining why they are absolutely necessary, why they are indeed correct, and why
they do not break the transactions. Otherwise they can and will be removed!






2.10正确使用 gettext 方法

OpenERP uses a GetText-like method named “underscore” _( ) to indicate that a static
string used in the code needs to be translated at runtime using the language of the context.
This pseudo-method is accessed within your code by importing as follows:

from tools.translate import _





A few very important rules must be followed when using it, in order for it to work and to
avoid filling the translations with useless junk.

Basically, this method should only be used for static strings written manually in the code,
it will not work to translate field values, such as Product names, etc. This must be
done instead using the translate flag on the corresponding field.

The rule is very simple: calls to the underscore method should always be in the form _('literal string')
and nothing else:

# Good: plain strings
error = _('This record is locked!')

# Good: strings with formatting patterns included
error = _('Record %s cannot be modified!') % record

# OK too: multi-line literal strings
error = _("""This is a bad multiline example
             about record %s!""") % record
error = _('Record %s cannot be modified' \
          'after being validated!') % record

# BAD: tries to translate after string formatting
#      (pay attention to brackets!)
# This does NOT work and messes up the translations!
error = _('Record %s cannot be modified!' % record)

# BAD: dynamic string, string concatenation, etc are forbidden!
# This does NOT work and messes up the translations!
error = _("'" + que_rec['question'] + "' \n")

# BAD: field values are automatically translated by the framework
# This is useless and will not work the way you think:
error = _("Product %s is out of stock!") % _(product.name)
# and the following will of course not work as already explained:
error = _("Product %s is out of stock!" % product.name)

# BAD: field values are automatically translated by the framework
# This is useless and will not work the way you think:
error = _("Product %s is not available!") % _(product.name)
# and the following will of course not work as already explained:
error = _("Product %s is not available!" % product.name)

# Instead you can do the following and everything will be translated,
# including the product name if its field definition has the
# translate flag properly set:
error = _("Product %s is not available!") % product.name





Also, keep in mind that translators will have to work with the literal values that are passed
to the underscore function, so please try to make them easy to understand and keep spurious
characters and formatting to a minimum. Translators must be aware that formatting patterns such
as %s or %d, newlines, etc. need to be preserved, but it’s important to use these
in a sensible and obvious manner:

# Bad: makes the translations hard to work with
error = "'" + question + _("' \nPlease enter an integer value ")

# Better (pay attention to position of the brackets too!)
error = _("Answer to question %s is not valid.\n" \
          "Please enter an integer value.") % question
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3YAML 自动测试指南


Note

Please see also section YAML 数据序列化



This is a guideline for project managers and developers on automated tests.


3.1语法


Write scenarios using the YAML syntax, not the “cucumber” syntax,  so
that we can directly integrate these tests in OpenERP modules (and implement
them later).





3.2运行在服务端的测试

As tests are performed server side, you don’t need to write things like


# wrong
* Given I am logged in as admin user with proper password
* module pos is installed





The user is admin by default, so no need to write this in each test
file. Instead of saying ‘I check that the module pos is installed’,
just write the name of the module where you will put this test. The first
line would then be “module: pos”.







3.3精确的测试目标

Try to use functional terms instead of object



	This is not good enough:

I will test the manufacturing order







	An example of a good introduction:

In order to test the CRM in OpenERP, I will do a customer qualification
process that begins with the first customer contact (a lead),
which will be converted to a business opportunity and a partner.









# wrong
*In caldav testing of creation of calendar as Admin

# better
*In order to test the calendar synchronisation with mobile phones and
outlook, I will test the caldav interface for meetings.

# wrong:
In order to test the manufacturing order process and modules as an
administrator I want to see if the features work correctly.

# better:
  In order to test the manufacturing of products, I will test the
  features of the manufacturing order document: consume raw materials,
  produce finished goods, scrap some products and split in production
  lots.

# wrong:
Testing of Document for ftp server is running and being connected or
not
# better:
  In order to test the document management system, I will try different
  operations on the FTP interface, and check their impacts on OpenERP's
  documents.











3.4尽量避免依赖那些会被用户修改的数据


# wrong (mrp):
Then my manufacturing order turned into 'Waiting for goods' state.
And one picking was also generated for my manufacturing order:
'INT/00001'.





This is not a good test, who knows if it will be ‘INT/0001’ or another
sequence ‘INT/0002’ ? Because the user may have created internal
pickings before they installed the mrp module.

# wrong (pos):
I press new record from toolbar.
Some default values are filled automatically like:
Company>Tinysprl,Journal>x Sales Journal





You can not test if the company is ‘Tiny SPRL’. The user may have
configured it to his own company name. It’s better to test:
“The company is set by default to the company of the admin user.”

Take care of these data dependencies, because it may crash the tests
simply because the user changed some demo data before launching the tests.

You can rely on demo data defined by the module where you put your test
file, but if the demo data are defined by another module, try to either
create your own data or find a way to work with ids instead of names.







3.5把测试信息写得详细有助于Yaml测试系统进行测试

For example,
the mail gateway. You can not write this:

First I have made one fetchmail rc script using the proper syntax
with specific email server and address information and used crm.lead
as model Then I run the fetchmail command like: fetchmail -f <created
rc file name> The script should exit successfully





Because you can not set-up an email pop account to test this.

I would rather do:

I have a list of different emails with different encoding and
different kind of attachments stored in the directory test/emails.
I test to pass all these documents through the mailgateway script:
  something like:
    for each email file:
      call the script with stdin<this email file





If possible call in python directly, not using os.system.

For the FTP, it can be tested by the YAML as you simply have to use the Python
FTP client in your yaml code:

import ftplib








3.6避免依赖现有的数据以防用户修改它们


Bad example:



When I pressed ‘Confirm Production’ button.
Then I could see the Finished Products into Products to Consume with
quantity 10.00.



Then my manufacturing order turned into ‘Waiting for goods’ state.
And one picking was also generated for my manufacturing order:
‘INT/00001’.




And the following values appeared in the Products to Consume









	product_id
	product_qty
	product_uom
	location_id
	||
	||




	[CPU_GEN] Regular processor config
	10.00
	PCE
	Stock
	||
	||


	[HDD1] HDD Seagate 7200.8 80GB
	10.00
	PCE
	Stock
	||
	||


	[TOW1] ATX Mid-size Tower
	10.00
	PCE
	Stock
	||
	||


	[MOU] Mouse
	10.00
	PCE
	Stock
	||
	||


	[KEYA] Keyboard -AZERTY
	10.00
	PCE
	Stock
	||
	||





For such an example, I would have created a few products and a bom in the test scenario. And test the manufacturing order on these test data.







3.7不用深究测试的具体出错信息


Then I got the following error message:



xmlrpclib.Fault: <Fault warning – Error:

    Couldn't find bill of material for product: 'Traceback (most recent call last):
    File in dispatch
    result = ExportService.getService(service_name).dispatch(method, auth, params)
     File "/home/uco/workspace/Trunk/openobject-server/bin/service/web_services.py", line 587, in dispatch
     res = fn(db, uid, *params)
     File "/home/uco/workspace/Trunk/openobject-server/bin/osv/osv.py", line 64, in wrapper
     self.abortResponse(1, inst.name, inst.exc_type, inst.value)
     File "/home/uco/workspace/Trunk/openobject-server/bin/netsvc.py", line 66, in abortResponse
     raise Exception("%s -- %s\\n\\n%s"%(origin, description, details))
    Exception: warning -- Error

    Couldn\'t find bill of material for product\n'>

Simply do::

  And it should generate an exception to say that it cannot find a BoM
  defined for this product.











3.8说明用户要做什么比在哪里点击要好

# wrong:
I press new record from toolbar of lead's view
Some default values are filled automatically like: priority>Normal,user_id>Administrator, state>Draft
Then I give some values for lead:
|name|section_id|partner_name|phone|mobile|
|Carrie Helle|Sales Department|Stonage IT|(855) 924-4364|(333) 715-1450|
Then I press the save button from toolbar
The lead is created successfully





No need to write the all the data of the form in the English text
(phone, mobile, ...). These data will be written in the final YAML, when
you implement the test. A better final YAML for the above example should
look like this:

-
 As I met a new customer in a fair, I create a new lead "Stonage IT"
 to record his data.
-
 !record {model:rcrm.lead, id:partner_carrie}
   name: Stonage IT
   contact_name: Carrie Helle
   phone: (855) 924-4364
   mobile: (333) 715-1450
-
  I check that the state field is set automatically by default.
-
  !assert {model:crm.lead, id:partner_carrie} state








3.9你可以在测试里使用”onchange”以此来模拟客户端



	I create a new sale order by filling the partner.
I want addresses to be filled up by the onchange call but I still need to
provide dummy addresses (required fields) to allow the record to be created.



	
	!record {model: sale.order, id: my_order}:

	partner_id: base.res_partner_asus
pricelist_id: product.list0
partner_order_id: base.main_address
partner_invoice_id: base.main_address
partner_shipping_id: base.main_address







	I then call the onchange method and update the record with the returned value.



	
	!python {model: sale.order}: |

	my_order = self.browse(cr, uid, ref(‘my_order’))
value = my_order.onchange_partner_id(my_order[‘partner_id’]).get(‘value’, {})
my_order.write(value)
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文档指南


实用和简明文档

Every ORM object method takes the same self, cr, uid parameters
and usually a list of ids and an optional context, so it would be
quite redundant to copy/paste the obvious description for these parameters
every time:

def action_send(self, cr, uid, ids, context=None):
    """ This sends an email to ALL the addresses of the selected partners.
    @param self: The object pointer
    @param cr: the current row, from the database cursor,
    @param uid: the current user ID for security checks
    @param ids: List of Phonecall to Opportunity's IDs
    @param context: A standard dictionary for contextual values
    """

def action_send(self, cr, uid, ids, context=None):
    """ This sends an email to ALL the addresses of the selected partners.
    @param context['mail']: 'new' to send a new mail or 'reply' if to reply to the last case_history
    """
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贡献指南


提交Bug

For all details regarding bug reports and bug processing, please
refer to the Bug 的提交和处理 section.




合并申请 & 修补程序

It is quite easy to make a patch and propose it for merging on any
OpenERP project, be it to fix a bug, improve an existing feature,
or add something new.

However, in order to tremendously increase the chances of getting
your patch noticed and merged, you should pay attention to the
Merge Proposal Acceptance Policy and then carefully follow the
Merge Proposal Guidelines.


Merge Proposal Acceptance Policy

OpenERP’s R&D expects to receive merge proposals from the Community in these areas:



	patches to correct a bug in an official addons

	patches to improve an existing official addon, such as extending a feature or adding one






OpenERP’s R&D does not expect to receive merge proposals from the Community in these areas:



	addition of an extra feature to an official addons, when the feature should really
provided by a separate (new) module

	addition of a new module to the official addons






For these last cases, it is better to put the feature into new modules entirely maintained
by their authors in their own Launchpad repository, and published on OpenERP Apps,
to be visible by the whole Community. This is totally unrelated to the quality of the
proposition: there are tons of great community modules on OpenERP Apps, some of them already
downloaded thousands of times!

However, including a module in the official release is a big commitment in terms of review
maintenance, support, etc. In addition, it would quickly bloat the OpenERP core if done too
often, compromising its agility and maintainability, and thus the future of the product.
On the other hand, by progressively integrating OpenERP Apps better in the product, we should
reach the same visibility for Community modules, without incurring these risks.

Therefore the process of including a community module into the official addons is entirely
driven by OpenERP R&D based on the product strategy. In addition to features selected by
OpenERP Product Managers, features that are considered REQUIRED to use OpenERP in a certain
market/domain will also be considered for inclusion.
Deciding whether a feature is REQUIRED is quite subjective, but the following hints are useful:



	if most established competitors on the given market/domain implement this feature, and
this domain is normally addressed by official OpenERP addons, then it’s likely REQUIRED.

	on the other hand, if no established software competitors on the given market/domain
implement this feature, then it’s probably NOT REQUIRED.






This certainly doesn’t mean we don’t want to innovate (that’s the part where Product Managers
choose new features!), this is only for deciding that a module is REQUIRED and thus it is
necessary to include it in the default installations.

Of course, on top of the above, a merge proposal needs to pass the functional and technical
review by OpenERP’s R&D, and even though we do our best to process them in a timely fashion,
there is no guarantee it will be accepted, nor when.




Merge Proposal Guidelines

The basic procedure is the following:



	Register on Launchpad if not done yet



	If you wish to be able to easily publish your changes, setup
an SSH private/public key pair and register your public key
on your LaunchPad profile page, then use the following command
to provide your LP login to Bazaar:

$ bzr launchpad-login <your-launchpad-login>







	Grab a local copy of the branch you want to patch, e.g. for the
development version of the OpenERP server, that would be:

$ bzr branch lp:openobject-server






	..note:: If you want to avoid downloading many times the large history

	of OpenERP’s source code, you may want to create a proper
shared repository.







	Work on the local branch, and commit your changes with relevant
commit messages. Do not forget to add the –fixes parameter
if your work fixes a specific LaunchPad bug:

$ ... patch the code ...
$ bzr ci --fixes lp:12345 -m '[FIX] fixed formatting of date field'







	Push your work as a new branch on LaunchPad, either into your personal
space, or in any of the relevant teams you may be member of
(e.g. openerp-community):

$ bzr push lp:~openerp-community/openobject-server/trunk-bugfix-12345







	Finally go to the LaunchPad page for your branch and click on the
Propose for merging link, choose the appropriate target project and
branch, and provide a useful description of your work.
The URL of the new branch is in the form:

https://code.launchpad.net/~openerp-community/openobject-server/trunk-bugfix-12345












The following guidelines will give you further advice in getting
your patch through:



	Carefully select the appropriate target branch for your patch.
For example if your patch introduces an improvement but does not
technically fix a bug, do not bother proposing it for merging on
a stable branch. Stable branches are only for bugfixes, so rather
propose it on a trunk branch. See also the definition of a bug above.

	Obviously, pay attention to the
Coding Guidelines.

	While following coding guidelines, avoid being over-zealous. If existing
code does not meet the guidelines, you should usually fix only the lines
that you are modifying, not the rest. Otherwise you will quickly find
yourself modifying everything, and your patch will be refused.

	Please review your own changes before committing them, to avoid
introducing useless noise in the merge proposal, like additional
whitespace, etc.
Use bzr status, then bzr diff or bzr cdiff to know
exactly what you changed, before committing.

	Don’t hesitate to revert a bad commit, it’s the right time to do it
before you push or propose your branch. bzr uncommit is a useful
tool when working locally.

	Work on a separate feature/bug/whatever at a time. Do not mix lots of
changes in one merge proposal, as it will be too complicated to review,
thus refused.

	Make separate branches and merge proposals for separate changes.

	The smaller and cleaner a merge proposal, the higher the
chance of seeing it merged.

	Avoid any kind of automatic formatting, like white-space
conversion or re-wrapping. Even if the original code is ugly, this
will make it possibly much harder to review.
If you really want to do it, make it a separate branch and
merge proposal for that, clearly stating why you did so.

	Be very accurate and honest in the description of your patch, and in
the commit messages. Do not propose a patch claiming that it contains
“just some layout improvements” and try to slip into it some
functional changes as well, or new fields that you added, etc.
In fact you should explicitly warn the reviewers about these parts,
if you could not split them in separate merge proposals.
Indeed the layout changes could be reviewed easily by testing the
updated views, but any Python change needs to be reviewed carefully,
and should never go unnoticed.

	If your patch is very long (say, more than 100 lines), consider
splitting it in separate atomic patches, that will be easier to review.
You can make several successive merge proposals that depend on each
other. This is also useful when you work on different projects
(e.g. a patch to addons that depends on another patch for server).

	If your patch still needs to change a lot of lines at once into a
core branch (it’s not likely you have a valid reason to do so), and
if it cannot be split into separate parts (like a proposal for one
refactoring, then one functional change, then one layout change, etc.),
then you must absolutely consider providing dedicated tests in it.
These tests should prove the correctness of the system after applying
your patch, and will help reviewers assess the impact of your changes,
and verify that your patch does not break existing functionality.

	One more time for good measure: keep your merge proposals as
small as possible. This is normally quite possible if you keep
the merge proposal in mind as soon as you start working on the code.











使用共享库以加快分支管理

Bazaar is a distributed version control system, and this means that every time
you copy, upload or download a bazaar branch, you are carrying around a complete
repository. OpenERP’s repositories now contain several hundred megabytes of
history, and this may represent a fair bit of bandwidth and time whenever
you transfer a branch over the network (for example when you want to
create a merge proposal).

There are ways to avoid this overhead if you learn to master the concepts of
shared repositories  and stacked branches of Bazaar and Launchpad.


Shared Repositories

A “shared repository” allows several branches to be stored under an umbrella
repository that centralizes the history of the branches, avoiding duplication
of the revisions. Importing a new branch in such a shared repo will only
require the download of the history delta: the revisions in the new branch
that are not yet known in the shared repository.
It works in your local copy of the branches as long as you make sure to
branch/pull inside a relevant shared repository.

A shared repository is created using the bzr init-repo command.
For mode details have a look at the shared repository tutorial:
http://wiki.bazaar.canonical.com/SharedRepositoryTutorial




Stacked branches

As described in the official Bazaar documentation,
a stacked branch is a branch that knows how to find revisions in another
branch (the stacked-on branch). Stacked branches store just the unique
revisions that are not in the stacked-on branch, making them faster to create
and more storage efficient.

Launchpad will automatically try to stack new branches you push onto the
trunk branch. This means that whenever you execute a bzr push lp:...
command, it will only need to upload the revisions that are not present
in the latest trunk.
You can also manually specify the branch to stack on using the --stacked-on
parameter. This may be useful if you are pushing branches that have
significant deltas with the trunk, such as older stable branches.

For more details on stacked branches, see also the official
Bazaar documentation [http://doc.bazaar.canonical.com/bzr.2.5/en/user-guide/stacked.html].




In a nutshell

Practically, here is how you can use shared repositories and stacked branches
to speed up day-to-day branch management.


下载

To initialize a proper shared repository you do the following:

# create an empty repo for addons
$ bzr init-repo addons
$ cd addons
# grab trunk addons -> full download!
$ bzr branch lp:openobject-addons trunk





The first download in the repository will be the only full one, because it
starts empty. If you have a local copy of some addons branch somewhere, you can
branch from the local path instead of the lp: URL, it will be much faster.

From then on, you can download any remote or local addons branch inside this
shared repo, bzr will automatically detect the shared repo and only download
the revisions that were not know yet in it (the delta).
For example:

# grab 6.1 addons -> delta only
$ bzr branch lp:openobject-addons/6.1
# grab 6.0 addons -> delta only
$ bzr branch lp:openobject-addons/6.0






Note

the OpenERP 6.1 Release Notes [http://bit.ly/openerp61RN] mention a
a script that is used by OpenERP developers to initialize a development
environment. It can automate the creation of the share repository structure.
You can use it as follows:

$ bzr cat -d lp:~openerp-dev/openerp-tools/trunk setup.sh | sh
$ make help          # << Read the available commands
$ make init-trunk    # << Fetch the trunk projects in a shared repo
$ make server        # << Start OpenERP Server with embedded Web










上传

It’s a little bit different when you push a branch: there is no shared
repository, but Launchpad will automatically use stacked branches.
Have a look at the metadata of the 6.1 addons branch on Launchpad here:
https://code.launchpad.net/~openerp/openobject-addons/6.1

You’ll see mentioned at the bottom: Stacked on: lp:openobject-addons.
It means that the 6.1 branch is stacked on the trunk branch.

This happens transparently whenever you push a branch in a LP project: bazaar
will automatically stack it on the trunk branch. But you can specify the
stacking branch yourself if you prefer, which is useful sometimes (see below).

Let’s say I write a bugfix following the merge_proposals_guidelines .
When I do the push this is what I will see:

$ bzr push lp:~openerp-community/openobject-addons/trunk-bug-123456
Using default stacking branch /+branch-id/243984 at chroot-71245584:///~openerp-community/openobject-addons/
(...)





This cryptic message means my branch was stacked on trunk, so only the
revisions that are not present in trunk will need to be uploaded. As a result,
pushing a bugfix branch on trunk usually only takes a few seconds.

Now if you’re working on a stable branch rather than trunk, there may still be a large
delta to upload because there are many revisions that were added to in stable after
it was forked off trunk (the largest ones being the translations!)
In that case you can manually tell bzr to stack on the 6.1 branch rather than trunk,
as follows:

$ bzr push lp:~openerp-community/openobject-addons/6.1-bug-123456 --stacked-on bzr+ssh://bazaar.launchpad.net/~openerp/openobject-addons/6.1





There are a couple of caveats with this stacking mechanism:



	the --stacked-on parameter must use the full bzr+ssh://bazaar.launchpad.net
protocol prefix, the usual lp: shortcut does not work
(yet? [https://bugs.launchpad.net/bzr/+bug/296592])

	the stacking cannot be modified on remote branches, so if you get it wrong the
first time (or it simply fails) you must go on the branch URL on Launchpad
(https://code.launchpad.net/full_name_of_branch) and delete it, then
push again.






This certainly takes a bit of getting used to, but once you understand the key
ideas you will almost never need full branch uploads/downloads anymore.
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使用指南

See the Usability Book
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本地化指南

OpenERP Localization is the process of writing the necessary configuration
or the customizations required to make OpenERP suitable for a general purpose
use in a particular country.

Usually the first step for creating a localization (a.k.a. l10n) is to
configure one (or more) Chart(s) of Accounts for the country, with the related
dependencies: Account types, Taxes, etc.

This section gives a few guidelines to assist in the creation of a correct
l10n_XXX module. Once the new l10n module meets the following requirements,
it can be considered for inclusion in the official OpenERP addons, via a
merge proposal process (as described in 合并申请 & 修补程序).


Tip

Reference and Examples

Have a look at the Belgian localization module (l10n_be) to get
started, and for references and examples of how a localization module
is structured




本地化模块的内容

In order to have a localization module fully complete, you should ensure
that the following features are present in your module:



	chart  of account and chart of taxes are mandatory, and must meet the
guidelines defined below. It’s quite possible to put multiple chart
templates in the same l10n module

	bank interfaces (import - export)

	legal reports (no business reports, these could be in a separate module)






Most of the time it’s preferable that localization modules do not contain
any Python code that would interfere with the normal behavior of OpenERP’s
core (such as inherited/overridden methods).
It’s also preferable that they do not reimplement existing
features (e.g. don’t add a wizard to generate the chart of account, use the
existing one).

If you think the OpenERP accounting report engine does not fit the legal
requirements for your country, you can make a merge proposal (see 合并申请 & 修补程序)
to improve the core accounting engine.

The next sections provide guidelines for writing the most critical parts of
you l10n modules, in the preferred order of writing.




通用指南



	The module must be named l10n_XX where XX is the lower case country code,
taken from http://en.wikipedia.org/wiki/ISO_3166-1_alpha-2



	The l10n_XX module must be hosted on Launchpad, like all OpenERP modules



	The l10n_XX module must be in a bzr branch which is:



	either a branch of lp:openobject-addons

	or a branch containing this module only (in that case it will need to be added
to a branch of lp:openobject-addons in order to make a merge proposal
to include it in official addons).








	The module must not define charts but charts templates



	the whole localization must be contained in one and only one module that contains
legal requirements:



	chart of accounts

	tax structure

	taxes

	legal statements (reports), if any

	tax declarations, if any

	bank import/export features, if any














	Extra features which are not legal requirements but best practices of the country
can be in separate modules (such as special kind of discounts, some special tax for
very specific situations, etc.)






科目类型指南 (account.account.type)


	Example

	Assets, Liabilities...




	Description

	The type contains more information about the account and its specifics.



It’s important to pay attention to the deferral method field (named
close_method) because it will define the way your accounts will create or not
new entries when opening a new fiscal year. You should choose:



	detail for accounts that you want to fully report (even reconciled entries)

	none for accounts that you don’t want to report at all






Make also sure to give a corresponding value for the new field report_type
(new as of v6) because it’s used in balance sheet and P&L report to know in
which column to display it.
You must have at least one account with report_type '/' (net profit).




科目表指南 (account.account.template)

When creating your chart of account, the principal information you should take
care of is the internal type field (named type), because that field will
be used by OpenERP in many places:



	receivable type is used for customer accounts

	payable is used for supplier accounts

	view is used for non-leaf accounts, used to organize the Chart of
Accounts in a suitable tree of accounts. OpenERP won’t accept any entries
in view accounts.

	liquidity is used for cash/bank accounts (new as of v6)






For any other accounts (regular ones), you should chose the internal type other.

Important: Create templates of charts of accounts, not real charts of accounts,
as the Chart Of Accounts is not global, it’s a template that needs to be applied
for each company.

This is also the place where you’ll have to make the categorization of your
accounts in the account types (as explained in previous section), via the
user_type field.

Be sure the chart of account has a hierarchical tree structure.




税码表指南 (account.tax.code.template)

This object is the same in v5 and v6. The hierarchical structure of the
Chart of Tax Codes should allow you to compute the sum/totals easily
as legally required in your country.

The code of each tax code must respect legal statements.

Here is an example of minimal chart of taxes structure:



	Tax Balance to Pay



	Tax Paid



	Tax Paid 21%

	Tax Paid 0%








	Tax Received



	Tax Received 21%

	Tax Received 0%








	Tax Bases



	Base of Taxable Sales

	Base Tax Sales 21%

	Base of Taxable Purchases

	Base Tax Purchases 21%




















The code of each tax code must be the code of the tax section/cell
for this amount in your monthly/yearly legal tax declaration.
Leave the tax code empty if you don’t want that code to appear
in the legal tax statement (i.e. for chart structure purposes)




科目表指南 account.chart.template

Once all above objects are created, you can focus on the Chart Template.
It specifies the required information for generating the proper chart
of account, taxes, etc. when you install this chart via the
Chart of Account installation wizard.

This information includes:



	chart of account: the account_root_id field provides the root account
(with parent_id = False) of your chart

	chart of tax: the tax_code_root_id field provides the root tax code
(with parent_id = False) of your chart

	parent of the bank/cash accounts: the bank_account_view_id field selects
the account (within your chart) under which the bank and cash accounts will be
created by OpenERP

	default receivable account: the property_account_receivable field
selects the account of your chart that will be used by default as customer
account for each new partner

	default payable account: the property_account_payable field selects
the account of your chart that will be used by default for the supplier account
of new partners

	default expense accounts: the property_account_expense_categ field selects
the account of your chart that will be used by default for the expense account
of each new product

	default income account: the property_account_income_categ selects the account
of your chart that will be used by default for the income account of each new
product

	As of v6, a new field has been introduced for Reserve and Profit/Loss Account,
named property_reserve_and_surplus_account. This fields select the account
used for transferring amounts from Profit & Loss Report.









税项指南 (account.tax.template)

The only change in that object for v6 is the removal of the tax_group
field which was unused. When testing the taxes, you should make sure that:



	the accounting entries created for it are correct: right accounts, debit
and credit

	the vat amounts that are put in the tax code are correct






This should be verified for both invoices and refunds.

Use the chart_template_id to link the taxes to the
account.chart.template object defined above.

Check that each tax is linked to an account, a tax code and a base tax code.




财务结构指南 (account.fiscal.position.template)

Fiscal position objects stay the same in v6. They’re used to
automatically map the default tax/account for a product
according to Partner-specific situations (for invoices, sale
and purchase orders).

In Europe we need at least 3 fiscal positions:



	national customers

	foreign customers, within Europe

	foreign customers, outside Europe






This tax and account mapping will allow you to keep a generic VAT,
let’s say 21% (Belgian VAT), and a corresponding income account
“sales in Belgium”  on your products. When invoicing a
customer that has the fiscal  position ‘in Europe’, those values
will be automatically changed into (for example) the corresponding
0% VAT and “sales in Europe” account.

Use the chart_template_id field to link the fiscal positions
to the account.chart.template object defined above.

Check that each l10n module has at least two fiscal positions
defined:



	one for the national customers

	one or more for foreign customers









模块依赖指南

If the module is from an European country, it should
depend on the base_vat module.

Avoid to put specific features in your l10n_XX module if it’s not related
to legal requirement. New accounting features (example: discount on payment, etc.)
must be in another and generic module, not in a l10n_XX  module.
Also, the l10n_XX module should not depend (require) on these other modules,
which may not be included into official addons.

For legal requirements that are specific to your country
(e.g.: mandatory electronic tax declaration system), you can add the features
in the l10n_XX  module directly.




特定报表指南

If there is any specific report legally required in your country
(such as the VAT report that generates XML files in l10n_be), the
localization module of that country is the right place to put it.

As a reminder: look at l10n_be for examples or for references.
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协议介绍


OpenERP Server, Addons, GTK Client

OpenERP server, 官方的 OpenERP 模块与OpenERP 桌面客户端基于以下协议发布:


	GPLv3 [http://www.gnu.org/licenses/gpl.html] OpenERP 5.0

	AGPLv3 [http://www.gnu.org/licenses/agpl.html] OpenERP 6.0



一些社区贡献代码和内嵌库基于特定的 GPL-兼容性协议 [http://www.dwheeler.com/essays/floss-license-slide.html], 这种情况下相关的协议会在源代码中说明（或在作者/项目网站中）






许可协议


GPL v3.0

                    GNU GENERAL PUBLIC LICENSE
                       Version 3, 29 June 2007

 Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>
 Everyone is permitted to copy and distribute verbatim copies
 of this license document, but changing it is not allowed.

                            Preamble

  The GNU General Public License is a free, copyleft license for
software and other kinds of works.

  The licenses for most software and other practical works are designed
to take away your freedom to share and change the works.  By contrast,
the GNU General Public License is intended to guarantee your freedom to
share and change all versions of a program--to make sure it remains free
software for all its users.  We, the Free Software Foundation, use the
GNU General Public License for most of our software; it applies also to
any other work released this way by its authors.  You can apply it to
your programs, too.

  When we speak of free software, we are referring to freedom, not
price.  Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for
them if you wish), that you receive source code or can get it if you
want it, that you can change the software or use pieces of it in new
free programs, and that you know you can do these things.

  To protect your rights, we need to prevent others from denying you
these rights or asking you to surrender the rights.  Therefore, you have
certain responsibilities if you distribute copies of the software, or if
you modify it: responsibilities to respect the freedom of others.

  For example, if you distribute copies of such a program, whether
gratis or for a fee, you must pass on to the recipients the same
freedoms that you received.  You must make sure that they, too, receive
or can get the source code.  And you must show them these terms so they
know their rights.

  Developers that use the GNU GPL protect your rights with two steps:
(1) assert copyright on the software, and (2) offer you this License
giving you legal permission to copy, distribute and/or modify it.

  For the developers' and authors' protection, the GPL clearly explains
that there is no warranty for this free software.  For both users' and
authors' sake, the GPL requires that modified versions be marked as
changed, so that their problems will not be attributed erroneously to
authors of previous versions.

  Some devices are designed to deny users access to install or run
modified versions of the software inside them, although the manufacturer
can do so.  This is fundamentally incompatible with the aim of
protecting users' freedom to change the software.  The systematic
pattern of such abuse occurs in the area of products for individuals to
use, which is precisely where it is most unacceptable.  Therefore, we
have designed this version of the GPL to prohibit the practice for those
products.  If such problems arise substantially in other domains, we
stand ready to extend this provision to those domains in future versions
of the GPL, as needed to protect the freedom of users.

  Finally, every program is threatened constantly by software patents.
States should not allow patents to restrict development and use of
software on general-purpose computers, but in those that do, we wish to
avoid the special danger that patents applied to a free program could
make it effectively proprietary.  To prevent this, the GPL assures that
patents cannot be used to render the program non-free.

  The precise terms and conditions for copying, distribution and
modification follow.

                       TERMS AND CONDITIONS

  0. Definitions.

  "This License" refers to version 3 of the GNU General Public License.

  "Copyright" also means copyright-like laws that apply to other kinds of
works, such as semiconductor masks.

  "The Program" refers to any copyrightable work licensed under this
License.  Each licensee is addressed as "you".  "Licensees" and
"recipients" may be individuals or organizations.

  To "modify" a work means to copy from or adapt all or part of the work
in a fashion requiring copyright permission, other than the making of an
exact copy.  The resulting work is called a "modified version" of the
earlier work or a work "based on" the earlier work.

  A "covered work" means either the unmodified Program or a work based
on the Program.

  To "propagate" a work means to do anything with it that, without
permission, would make you directly or secondarily liable for
infringement under applicable copyright law, except executing it on a
computer or modifying a private copy.  Propagation includes copying,
distribution (with or without modification), making available to the
public, and in some countries other activities as well.

  To "convey" a work means any kind of propagation that enables other
parties to make or receive copies.  Mere interaction with a user through
a computer network, with no transfer of a copy, is not conveying.

  An interactive user interface displays "Appropriate Legal Notices"
to the extent that it includes a convenient and prominently visible
feature that (1) displays an appropriate copyright notice, and (2)
tells the user that there is no warranty for the work (except to the
extent that warranties are provided), that licensees may convey the
work under this License, and how to view a copy of this License.  If
the interface presents a list of user commands or options, such as a
menu, a prominent item in the list meets this criterion.

  1. Source Code.

  The "source code" for a work means the preferred form of the work
for making modifications to it.  "Object code" means any non-source
form of a work.

  A "Standard Interface" means an interface that either is an official
standard defined by a recognized standards body, or, in the case of
interfaces specified for a particular programming language, one that
is widely used among developers working in that language.

  The "System Libraries" of an executable work include anything, other
than the work as a whole, that (a) is included in the normal form of
packaging a Major Component, but which is not part of that Major
Component, and (b) serves only to enable use of the work with that
Major Component, or to implement a Standard Interface for which an
implementation is available to the public in source code form.  A
"Major Component", in this context, means a major essential component
(kernel, window system, and so on) of the specific operating system
(if any) on which the executable work runs, or a compiler used to
produce the work, or an object code interpreter used to run it.

  The "Corresponding Source" for a work in object code form means all
the source code needed to generate, install, and (for an executable
work) run the object code and to modify the work, including scripts to
control those activities.  However, it does not include the work's
System Libraries, or general-purpose tools or generally available free
programs which are used unmodified in performing those activities but
which are not part of the work.  For example, Corresponding Source
includes interface definition files associated with source files for
the work, and the source code for shared libraries and dynamically
linked subprograms that the work is specifically designed to require,
such as by intimate data communication or control flow between those
subprograms and other parts of the work.

  The Corresponding Source need not include anything that users
can regenerate automatically from other parts of the Corresponding
Source.

  The Corresponding Source for a work in source code form is that
same work.

  2. Basic Permissions.

  All rights granted under this License are granted for the term of
copyright on the Program, and are irrevocable provided the stated
conditions are met.  This License explicitly affirms your unlimited
permission to run the unmodified Program.  The output from running a
covered work is covered by this License only if the output, given its
content, constitutes a covered work.  This License acknowledges your
rights of fair use or other equivalent, as provided by copyright law.

  You may make, run and propagate covered works that you do not
convey, without conditions so long as your license otherwise remains
in force.  You may convey covered works to others for the sole purpose
of having them make modifications exclusively for you, or provide you
with facilities for running those works, provided that you comply with
the terms of this License in conveying all material for which you do
not control copyright.  Those thus making or running the covered works
for you must do so exclusively on your behalf, under your direction
and control, on terms that prohibit them from making any copies of
your copyrighted material outside their relationship with you.

  Conveying under any other circumstances is permitted solely under
the conditions stated below.  Sublicensing is not allowed; section 10
makes it unnecessary.

  3. Protecting Users' Legal Rights From Anti-Circumvention Law.

  No covered work shall be deemed part of an effective technological
measure under any applicable law fulfilling obligations under article
11 of the WIPO copyright treaty adopted on 20 December 1996, or
similar laws prohibiting or restricting circumvention of such
measures.

  When you convey a covered work, you waive any legal power to forbid
circumvention of technological measures to the extent such circumvention
is effected by exercising rights under this License with respect to
the covered work, and you disclaim any intention to limit operation or
modification of the work as a means of enforcing, against the work's
users, your or third parties' legal rights to forbid circumvention of
technological measures.

  4. Conveying Verbatim Copies.

  You may convey verbatim copies of the Program's source code as you
receive it, in any medium, provided that you conspicuously and
appropriately publish on each copy an appropriate copyright notice;
keep intact all notices stating that this License and any
non-permissive terms added in accord with section 7 apply to the code;
keep intact all notices of the absence of any warranty; and give all
recipients a copy of this License along with the Program.

  You may charge any price or no price for each copy that you convey,
and you may offer support or warranty protection for a fee.

  5. Conveying Modified Source Versions.

  You may convey a work based on the Program, or the modifications to
produce it from the Program, in the form of source code under the
terms of section 4, provided that you also meet all of these conditions:

    a) The work must carry prominent notices stating that you modified
    it, and giving a relevant date.

    b) The work must carry prominent notices stating that it is
    released under this License and any conditions added under section
    7.  This requirement modifies the requirement in section 4 to
    "keep intact all notices".

    c) You must license the entire work, as a whole, under this
    License to anyone who comes into possession of a copy.  This
    License will therefore apply, along with any applicable section 7
    additional terms, to the whole of the work, and all its parts,
    regardless of how they are packaged.  This License gives no
    permission to license the work in any other way, but it does not
    invalidate such permission if you have separately received it.

    d) If the work has interactive user interfaces, each must display
    Appropriate Legal Notices; however, if the Program has interactive
    interfaces that do not display Appropriate Legal Notices, your
    work need not make them do so.

  A compilation of a covered work with other separate and independent
works, which are not by their nature extensions of the covered work,
and which are not combined with it such as to form a larger program,
in or on a volume of a storage or distribution medium, is called an
"aggregate" if the compilation and its resulting copyright are not
used to limit the access or legal rights of the compilation's users
beyond what the individual works permit.  Inclusion of a covered work
in an aggregate does not cause this License to apply to the other
parts of the aggregate.

  6. Conveying Non-Source Forms.

  You may convey a covered work in object code form under the terms
of sections 4 and 5, provided that you also convey the
machine-readable Corresponding Source under the terms of this License,
in one of these ways:

    a) Convey the object code in, or embodied in, a physical product
    (including a physical distribution medium), accompanied by the
    Corresponding Source fixed on a durable physical medium
    customarily used for software interchange.

    b) Convey the object code in, or embodied in, a physical product
    (including a physical distribution medium), accompanied by a
    written offer, valid for at least three years and valid for as
    long as you offer spare parts or customer support for that product
    model, to give anyone who possesses the object code either (1) a
    copy of the Corresponding Source for all the software in the
    product that is covered by this License, on a durable physical
    medium customarily used for software interchange, for a price no
    more than your reasonable cost of physically performing this
    conveying of source, or (2) access to copy the
    Corresponding Source from a network server at no charge.

    c) Convey individual copies of the object code with a copy of the
    written offer to provide the Corresponding Source.  This
    alternative is allowed only occasionally and noncommercially, and
    only if you received the object code with such an offer, in accord
    with subsection 6b.

    d) Convey the object code by offering access from a designated
    place (gratis or for a charge), and offer equivalent access to the
    Corresponding Source in the same way through the same place at no
    further charge.  You need not require recipients to copy the
    Corresponding Source along with the object code.  If the place to
    copy the object code is a network server, the Corresponding Source
    may be on a different server (operated by you or a third party)
    that supports equivalent copying facilities, provided you maintain
    clear directions next to the object code saying where to find the
    Corresponding Source.  Regardless of what server hosts the
    Corresponding Source, you remain obligated to ensure that it is
    available for as long as needed to satisfy these requirements.

    e) Convey the object code using peer-to-peer transmission, provided
    you inform other peers where the object code and Corresponding
    Source of the work are being offered to the general public at no
    charge under subsection 6d.

  A separable portion of the object code, whose source code is excluded
from the Corresponding Source as a System Library, need not be
included in conveying the object code work.

  A "User Product" is either (1) a "consumer product", which means any
tangible personal property which is normally used for personal, family,
or household purposes, or (2) anything designed or sold for incorporation
into a dwelling.  In determining whether a product is a consumer product,
doubtful cases shall be resolved in favor of coverage.  For a particular
product received by a particular user, "normally used" refers to a
typical or common use of that class of product, regardless of the status
of the particular user or of the way in which the particular user
actually uses, or expects or is expected to use, the product.  A product
is a consumer product regardless of whether the product has substantial
commercial, industrial or non-consumer uses, unless such uses represent
the only significant mode of use of the product.

  "Installation Information" for a User Product means any methods,
procedures, authorization keys, or other information required to install
and execute modified versions of a covered work in that User Product from
a modified version of its Corresponding Source.  The information must
suffice to ensure that the continued functioning of the modified object
code is in no case prevented or interfered with solely because
modification has been made.

  If you convey an object code work under this section in, or with, or
specifically for use in, a User Product, and the conveying occurs as
part of a transaction in which the right of possession and use of the
User Product is transferred to the recipient in perpetuity or for a
fixed term (regardless of how the transaction is characterized), the
Corresponding Source conveyed under this section must be accompanied
by the Installation Information.  But this requirement does not apply
if neither you nor any third party retains the ability to install
modified object code on the User Product (for example, the work has
been installed in ROM).

  The requirement to provide Installation Information does not include a
requirement to continue to provide support service, warranty, or updates
for a work that has been modified or installed by the recipient, or for
the User Product in which it has been modified or installed.  Access to a
network may be denied when the modification itself materially and
adversely affects the operation of the network or violates the rules and
protocols for communication across the network.

  Corresponding Source conveyed, and Installation Information provided,
in accord with this section must be in a format that is publicly
documented (and with an implementation available to the public in
source code form), and must require no special password or key for
unpacking, reading or copying.

  7. Additional Terms.

  "Additional permissions" are terms that supplement the terms of this
License by making exceptions from one or more of its conditions.
Additional permissions that are applicable to the entire Program shall
be treated as though they were included in this License, to the extent
that they are valid under applicable law.  If additional permissions
apply only to part of the Program, that part may be used separately
under those permissions, but the entire Program remains governed by
this License without regard to the additional permissions.

  When you convey a copy of a covered work, you may at your option
remove any additional permissions from that copy, or from any part of
it.  (Additional permissions may be written to require their own
removal in certain cases when you modify the work.)  You may place
additional permissions on material, added by you to a covered work,
for which you have or can give appropriate copyright permission.

  Notwithstanding any other provision of this License, for material you
add to a covered work, you may (if authorized by the copyright holders of
that material) supplement the terms of this License with terms:

    a) Disclaiming warranty or limiting liability differently from the
    terms of sections 15 and 16 of this License; or

    b) Requiring preservation of specified reasonable legal notices or
    author attributions in that material or in the Appropriate Legal
    Notices displayed by works containing it; or

    c) Prohibiting misrepresentation of the origin of that material, or
    requiring that modified versions of such material be marked in
    reasonable ways as different from the original version; or

    d) Limiting the use for publicity purposes of names of licensors or
    authors of the material; or

    e) Declining to grant rights under trademark law for use of some
    trade names, trademarks, or service marks; or

    f) Requiring indemnification of licensors and authors of that
    material by anyone who conveys the material (or modified versions of
    it) with contractual assumptions of liability to the recipient, for
    any liability that these contractual assumptions directly impose on
    those licensors and authors.

  All other non-permissive additional terms are considered "further
restrictions" within the meaning of section 10.  If the Program as you
received it, or any part of it, contains a notice stating that it is
governed by this License along with a term that is a further
restriction, you may remove that term.  If a license document contains
a further restriction but permits relicensing or conveying under this
License, you may add to a covered work material governed by the terms
of that license document, provided that the further restriction does
not survive such relicensing or conveying.

  If you add terms to a covered work in accord with this section, you
must place, in the relevant source files, a statement of the
additional terms that apply to those files, or a notice indicating
where to find the applicable terms.

  Additional terms, permissive or non-permissive, may be stated in the
form of a separately written license, or stated as exceptions;
the above requirements apply either way.

  8. Termination.

  You may not propagate or modify a covered work except as expressly
provided under this License.  Any attempt otherwise to propagate or
modify it is void, and will automatically terminate your rights under
this License (including any patent licenses granted under the third
paragraph of section 11).

  However, if you cease all violation of this License, then your
license from a particular copyright holder is reinstated (a)
provisionally, unless and until the copyright holder explicitly and
finally terminates your license, and (b) permanently, if the copyright
holder fails to notify you of the violation by some reasonable means
prior to 60 days after the cessation.

  Moreover, your license from a particular copyright holder is
reinstated permanently if the copyright holder notifies you of the
violation by some reasonable means, this is the first time you have
received notice of violation of this License (for any work) from that
copyright holder, and you cure the violation prior to 30 days after
your receipt of the notice.

  Termination of your rights under this section does not terminate the
licenses of parties who have received copies or rights from you under
this License.  If your rights have been terminated and not permanently
reinstated, you do not qualify to receive new licenses for the same
material under section 10.

  9. Acceptance Not Required for Having Copies.

  You are not required to accept this License in order to receive or
run a copy of the Program.  Ancillary propagation of a covered work
occurring solely as a consequence of using peer-to-peer transmission
to receive a copy likewise does not require acceptance.  However,
nothing other than this License grants you permission to propagate or
modify any covered work.  These actions infringe copyright if you do
not accept this License.  Therefore, by modifying or propagating a
covered work, you indicate your acceptance of this License to do so.

  10. Automatic Licensing of Downstream Recipients.

  Each time you convey a covered work, the recipient automatically
receives a license from the original licensors, to run, modify and
propagate that work, subject to this License.  You are not responsible
for enforcing compliance by third parties with this License.

  An "entity transaction" is a transaction transferring control of an
organization, or substantially all assets of one, or subdividing an
organization, or merging organizations.  If propagation of a covered
work results from an entity transaction, each party to that
transaction who receives a copy of the work also receives whatever
licenses to the work the party's predecessor in interest had or could
give under the previous paragraph, plus a right to possession of the
Corresponding Source of the work from the predecessor in interest, if
the predecessor has it or can get it with reasonable efforts.

  You may not impose any further restrictions on the exercise of the
rights granted or affirmed under this License.  For example, you may
not impose a license fee, royalty, or other charge for exercise of
rights granted under this License, and you may not initiate litigation
(including a cross-claim or counterclaim in a lawsuit) alleging that
any patent claim is infringed by making, using, selling, offering for
sale, or importing the Program or any portion of it.

  11. Patents.

  A "contributor" is a copyright holder who authorizes use under this
License of the Program or a work on which the Program is based.  The
work thus licensed is called the contributor's "contributor version".

  A contributor's "essential patent claims" are all patent claims
owned or controlled by the contributor, whether already acquired or
hereafter acquired, that would be infringed by some manner, permitted
by this License, of making, using, or selling its contributor version,
but do not include claims that would be infringed only as a
consequence of further modification of the contributor version.  For
purposes of this definition, "control" includes the right to grant
patent sublicenses in a manner consistent with the requirements of
this License.

  Each contributor grants you a non-exclusive, worldwide, royalty-free
patent license under the contributor's essential patent claims, to
make, use, sell, offer for sale, import and otherwise run, modify and
propagate the contents of its contributor version.

  In the following three paragraphs, a "patent license" is any express
agreement or commitment, however denominated, not to enforce a patent
(such as an express permission to practice a patent or covenant not to
sue for patent infringement).  To "grant" such a patent license to a
party means to make such an agreement or commitment not to enforce a
patent against the party.

  If you convey a covered work, knowingly relying on a patent license,
and the Corresponding Source of the work is not available for anyone
to copy, free of charge and under the terms of this License, through a
publicly available network server or other readily accessible means,
then you must either (1) cause the Corresponding Source to be so
available, or (2) arrange to deprive yourself of the benefit of the
patent license for this particular work, or (3) arrange, in a manner
consistent with the requirements of this License, to extend the patent
license to downstream recipients.  "Knowingly relying" means you have
actual knowledge that, but for the patent license, your conveying the
covered work in a country, or your recipient's use of the covered work
in a country, would infringe one or more identifiable patents in that
country that you have reason to believe are valid.

  If, pursuant to or in connection with a single transaction or
arrangement, you convey, or propagate by procuring conveyance of, a
covered work, and grant a patent license to some of the parties
receiving the covered work authorizing them to use, propagate, modify
or convey a specific copy of the covered work, then the patent license
you grant is automatically extended to all recipients of the covered
work and works based on it.

  A patent license is "discriminatory" if it does not include within
the scope of its coverage, prohibits the exercise of, or is
conditioned on the non-exercise of one or more of the rights that are
specifically granted under this License.  You may not convey a covered
work if you are a party to an arrangement with a third party that is
in the business of distributing software, under which you make payment
to the third party based on the extent of your activity of conveying
the work, and under which the third party grants, to any of the
parties who would receive the covered work from you, a discriminatory
patent license (a) in connection with copies of the covered work
conveyed by you (or copies made from those copies), or (b) primarily
for and in connection with specific products or compilations that
contain the covered work, unless you entered into that arrangement,
or that patent license was granted, prior to 28 March 2007.

  Nothing in this License shall be construed as excluding or limiting
any implied license or other defenses to infringement that may
otherwise be available to you under applicable patent law.

  12. No Surrender of Others' Freedom.

  If conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License.  If you cannot convey a
covered work so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you may
not convey it at all.  For example, if you agree to terms that obligate you
to collect a royalty for further conveying from those to whom you convey
the Program, the only way you could satisfy both those terms and this
License would be to refrain entirely from conveying the Program.

  13. Use with the GNU Affero General Public License.

  Notwithstanding any other provision of this License, you have
permission to link or combine any covered work with a work licensed
under version 3 of the GNU Affero General Public License into a single
combined work, and to convey the resulting work.  The terms of this
License will continue to apply to the part which is the covered work,
but the special requirements of the GNU Affero General Public License,
section 13, concerning interaction through a network will apply to the
combination as such.

  14. Revised Versions of this License.

  The Free Software Foundation may publish revised and/or new versions of
the GNU General Public License from time to time.  Such new versions will
be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.

  Each version is given a distinguishing version number.  If the
Program specifies that a certain numbered version of the GNU General
Public License "or any later version" applies to it, you have the
option of following the terms and conditions either of that numbered
version or of any later version published by the Free Software
Foundation.  If the Program does not specify a version number of the
GNU General Public License, you may choose any version ever published
by the Free Software Foundation.

  If the Program specifies that a proxy can decide which future
versions of the GNU General Public License can be used, that proxy's
public statement of acceptance of a version permanently authorizes you
to choose that version for the Program.

  Later license versions may give you additional or different
permissions.  However, no additional obligations are imposed on any
author or copyright holder as a result of your choosing to follow a
later version.

  15. Disclaimer of Warranty.

  THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY
APPLICABLE LAW.  EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY
OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM
IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF
ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

  16. Limitation of Liability.

  IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS
THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE
USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF
DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD
PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS),
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

  17. Interpretation of Sections 15 and 16.

  If the disclaimer of warranty and limitation of liability provided
above cannot be given local legal effect according to their terms,
reviewing courts shall apply local law that most closely approximates
an absolute waiver of all civil liability in connection with the
Program, unless a warranty or assumption of liability accompanies a
copy of the Program in return for a fee.

                     END OF TERMS AND CONDITIONS

            How to Apply These Terms to Your New Programs

  If you develop a new program, and you want it to be of the greatest
possible use to the public, the best way to achieve this is to make it
free software which everyone can redistribute and change under these terms.

  To do so, attach the following notices to the program.  It is safest
to attach them to the start of each source file to most effectively
state the exclusion of warranty; and each file should have at least
the "copyright" line and a pointer to where the full notice is found.

    <one line to give the program's name and a brief idea of what it does.>
    Copyright (C) <year>  <name of author>

    This program is free software: you can redistribute it and/or modify
    it under the terms of the GNU General Public License as published by
    the Free Software Foundation, either version 3 of the License, or
    (at your option) any later version.

    This program is distributed in the hope that it will be useful,
    but WITHOUT ANY WARRANTY; without even the implied warranty of
    MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the
    GNU General Public License for more details.

    You should have received a copy of the GNU General Public License
    along with this program.  If not, see <http://www.gnu.org/licenses/>.

Also add information on how to contact you by electronic and paper mail.

  If the program does terminal interaction, make it output a short
notice like this when it starts in an interactive mode:

    <program>  Copyright (C) <year>  <name of author>
    This program comes with ABSOLUTELY NO WARRANTY; for details type `show w'.
    This is free software, and you are welcome to redistribute it
    under certain conditions; type `show c' for details.

The hypothetical commands `show w' and `show c' should show the appropriate
parts of the General Public License.  Of course, your program's commands
might be different; for a GUI interface, you would use an "about box".

  You should also get your employer (if you work as a programmer) or school,
if any, to sign a "copyright disclaimer" for the program, if necessary.
For more information on this, and how to apply and follow the GNU GPL, see
<http://www.gnu.org/licenses/>.

  The GNU General Public License does not permit incorporating your program
into proprietary programs.  If your program is a subroutine library, you
may consider it more useful to permit linking proprietary applications with
the library.  If this is what you want to do, use the GNU Lesser General
Public License instead of this License.  But first, please read
<http://www.gnu.org/philosophy/why-not-lgpl.html>.
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                    GNU AFFERO GENERAL PUBLIC LICENSE
                       Version 3, 19 November 2007

 Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>
 Everyone is permitted to copy and distribute verbatim copies
 of this license document, but changing it is not allowed.

                            Preamble

  The GNU Affero General Public License is a free, copyleft license for
software and other kinds of works, specifically designed to ensure
cooperation with the community in the case of network server software.

  The licenses for most software and other practical works are designed
to take away your freedom to share and change the works.  By contrast,
our General Public Licenses are intended to guarantee your freedom to
share and change all versions of a program--to make sure it remains free
software for all its users.

  When we speak of free software, we are referring to freedom, not
price.  Our General Public Licenses are designed to make sure that you
have the freedom to distribute copies of free software (and charge for
them if you wish), that you receive source code or can get it if you
want it, that you can change the software or use pieces of it in new
free programs, and that you know you can do these things.

  Developers that use our General Public Licenses protect your rights
with two steps: (1) assert copyright on the software, and (2) offer
you this License which gives you legal permission to copy, distribute
and/or modify the software.

  A secondary benefit of defending all users' freedom is that
improvements made in alternate versions of the program, if they
receive widespread use, become available for other developers to
incorporate.  Many developers of free software are heartened and
encouraged by the resulting cooperation.  However, in the case of
software used on network servers, this result may fail to come about.
The GNU General Public License permits making a modified version and
letting the public access it on a server without ever releasing its
source code to the public.

  The GNU Affero General Public License is designed specifically to
ensure that, in such cases, the modified source code becomes available
to the community.  It requires the operator of a network server to
provide the source code of the modified version running there to the
users of that server.  Therefore, public use of a modified version, on
a publicly accessible server, gives the public access to the source
code of the modified version.

  An older license, called the Affero General Public License and
published by Affero, was designed to accomplish similar goals.  This is
a different license, not a version of the Affero GPL, but Affero has
released a new version of the Affero GPL which permits relicensing under
this license.

  The precise terms and conditions for copying, distribution and
modification follow.

                       TERMS AND CONDITIONS

  0. Definitions.

  "This License" refers to version 3 of the GNU Affero General Public License.

  "Copyright" also means copyright-like laws that apply to other kinds of
works, such as semiconductor masks.

  "The Program" refers to any copyrightable work licensed under this
License.  Each licensee is addressed as "you".  "Licensees" and
"recipients" may be individuals or organizations.

  To "modify" a work means to copy from or adapt all or part of the work
in a fashion requiring copyright permission, other than the making of an
exact copy.  The resulting work is called a "modified version" of the
earlier work or a work "based on" the earlier work.

  A "covered work" means either the unmodified Program or a work based
on the Program.

  To "propagate" a work means to do anything with it that, without
permission, would make you directly or secondarily liable for
infringement under applicable copyright law, except executing it on a
computer or modifying a private copy.  Propagation includes copying,
distribution (with or without modification), making available to the
public, and in some countries other activities as well.

  To "convey" a work means any kind of propagation that enables other
parties to make or receive copies.  Mere interaction with a user through
a computer network, with no transfer of a copy, is not conveying.

  An interactive user interface displays "Appropriate Legal Notices"
to the extent that it includes a convenient and prominently visible
feature that (1) displays an appropriate copyright notice, and (2)
tells the user that there is no warranty for the work (except to the
extent that warranties are provided), that licensees may convey the
work under this License, and how to view a copy of this License.  If
the interface presents a list of user commands or options, such as a
menu, a prominent item in the list meets this criterion.

  1. Source Code.

  The "source code" for a work means the preferred form of the work
for making modifications to it.  "Object code" means any non-source
form of a work.

  A "Standard Interface" means an interface that either is an official
standard defined by a recognized standards body, or, in the case of
interfaces specified for a particular programming language, one that
is widely used among developers working in that language.

  The "System Libraries" of an executable work include anything, other
than the work as a whole, that (a) is included in the normal form of
packaging a Major Component, but which is not part of that Major
Component, and (b) serves only to enable use of the work with that
Major Component, or to implement a Standard Interface for which an
implementation is available to the public in source code form.  A
"Major Component", in this context, means a major essential component
(kernel, window system, and so on) of the specific operating system
(if any) on which the executable work runs, or a compiler used to
produce the work, or an object code interpreter used to run it.

  The "Corresponding Source" for a work in object code form means all
the source code needed to generate, install, and (for an executable
work) run the object code and to modify the work, including scripts to
control those activities.  However, it does not include the work's
System Libraries, or general-purpose tools or generally available free
programs which are used unmodified in performing those activities but
which are not part of the work.  For example, Corresponding Source
includes interface definition files associated with source files for
the work, and the source code for shared libraries and dynamically
linked subprograms that the work is specifically designed to require,
such as by intimate data communication or control flow between those
subprograms and other parts of the work.

  The Corresponding Source need not include anything that users
can regenerate automatically from other parts of the Corresponding
Source.

  The Corresponding Source for a work in source code form is that
same work.

  2. Basic Permissions.

  All rights granted under this License are granted for the term of
copyright on the Program, and are irrevocable provided the stated
conditions are met.  This License explicitly affirms your unlimited
permission to run the unmodified Program.  The output from running a
covered work is covered by this License only if the output, given its
content, constitutes a covered work.  This License acknowledges your
rights of fair use or other equivalent, as provided by copyright law.

  You may make, run and propagate covered works that you do not
convey, without conditions so long as your license otherwise remains
in force.  You may convey covered works to others for the sole purpose
of having them make modifications exclusively for you, or provide you
with facilities for running those works, provided that you comply with
the terms of this License in conveying all material for which you do
not control copyright.  Those thus making or running the covered works
for you must do so exclusively on your behalf, under your direction
and control, on terms that prohibit them from making any copies of
your copyrighted material outside their relationship with you.

  Conveying under any other circumstances is permitted solely under
the conditions stated below.  Sublicensing is not allowed; section 10
makes it unnecessary.

  3. Protecting Users' Legal Rights From Anti-Circumvention Law.

  No covered work shall be deemed part of an effective technological
measure under any applicable law fulfilling obligations under article
11 of the WIPO copyright treaty adopted on 20 December 1996, or
similar laws prohibiting or restricting circumvention of such
measures.

  When you convey a covered work, you waive any legal power to forbid
circumvention of technological measures to the extent such circumvention
is effected by exercising rights under this License with respect to
the covered work, and you disclaim any intention to limit operation or
modification of the work as a means of enforcing, against the work's
users, your or third parties' legal rights to forbid circumvention of
technological measures.

  4. Conveying Verbatim Copies.

  You may convey verbatim copies of the Program's source code as you
receive it, in any medium, provided that you conspicuously and
appropriately publish on each copy an appropriate copyright notice;
keep intact all notices stating that this License and any
non-permissive terms added in accord with section 7 apply to the code;
keep intact all notices of the absence of any warranty; and give all
recipients a copy of this License along with the Program.

  You may charge any price or no price for each copy that you convey,
and you may offer support or warranty protection for a fee.

  5. Conveying Modified Source Versions.

  You may convey a work based on the Program, or the modifications to
produce it from the Program, in the form of source code under the
terms of section 4, provided that you also meet all of these conditions:

    a) The work must carry prominent notices stating that you modified
    it, and giving a relevant date.

    b) The work must carry prominent notices stating that it is
    released under this License and any conditions added under section
    7.  This requirement modifies the requirement in section 4 to
    "keep intact all notices".

    c) You must license the entire work, as a whole, under this
    License to anyone who comes into possession of a copy.  This
    License will therefore apply, along with any applicable section 7
    additional terms, to the whole of the work, and all its parts,
    regardless of how they are packaged.  This License gives no
    permission to license the work in any other way, but it does not
    invalidate such permission if you have separately received it.

    d) If the work has interactive user interfaces, each must display
    Appropriate Legal Notices; however, if the Program has interactive
    interfaces that do not display Appropriate Legal Notices, your
    work need not make them do so.

  A compilation of a covered work with other separate and independent
works, which are not by their nature extensions of the covered work,
and which are not combined with it such as to form a larger program,
in or on a volume of a storage or distribution medium, is called an
"aggregate" if the compilation and its resulting copyright are not
used to limit the access or legal rights of the compilation's users
beyond what the individual works permit.  Inclusion of a covered work
in an aggregate does not cause this License to apply to the other
parts of the aggregate.

  6. Conveying Non-Source Forms.

  You may convey a covered work in object code form under the terms
of sections 4 and 5, provided that you also convey the
machine-readable Corresponding Source under the terms of this License,
in one of these ways:

    a) Convey the object code in, or embodied in, a physical product
    (including a physical distribution medium), accompanied by the
    Corresponding Source fixed on a durable physical medium
    customarily used for software interchange.

    b) Convey the object code in, or embodied in, a physical product
    (including a physical distribution medium), accompanied by a
    written offer, valid for at least three years and valid for as
    long as you offer spare parts or customer support for that product
    model, to give anyone who possesses the object code either (1) a
    copy of the Corresponding Source for all the software in the
    product that is covered by this License, on a durable physical
    medium customarily used for software interchange, for a price no
    more than your reasonable cost of physically performing this
    conveying of source, or (2) access to copy the
    Corresponding Source from a network server at no charge.

    c) Convey individual copies of the object code with a copy of the
    written offer to provide the Corresponding Source.  This
    alternative is allowed only occasionally and noncommercially, and
    only if you received the object code with such an offer, in accord
    with subsection 6b.

    d) Convey the object code by offering access from a designated
    place (gratis or for a charge), and offer equivalent access to the
    Corresponding Source in the same way through the same place at no
    further charge.  You need not require recipients to copy the
    Corresponding Source along with the object code.  If the place to
    copy the object code is a network server, the Corresponding Source
    may be on a different server (operated by you or a third party)
    that supports equivalent copying facilities, provided you maintain
    clear directions next to the object code saying where to find the
    Corresponding Source.  Regardless of what server hosts the
    Corresponding Source, you remain obligated to ensure that it is
    available for as long as needed to satisfy these requirements.

    e) Convey the object code using peer-to-peer transmission, provided
    you inform other peers where the object code and Corresponding
    Source of the work are being offered to the general public at no
    charge under subsection 6d.

  A separable portion of the object code, whose source code is excluded
from the Corresponding Source as a System Library, need not be
included in conveying the object code work.

  A "User Product" is either (1) a "consumer product", which means any
tangible personal property which is normally used for personal, family,
or household purposes, or (2) anything designed or sold for incorporation
into a dwelling.  In determining whether a product is a consumer product,
doubtful cases shall be resolved in favor of coverage.  For a particular
product received by a particular user, "normally used" refers to a
typical or common use of that class of product, regardless of the status
of the particular user or of the way in which the particular user
actually uses, or expects or is expected to use, the product.  A product
is a consumer product regardless of whether the product has substantial
commercial, industrial or non-consumer uses, unless such uses represent
the only significant mode of use of the product.

  "Installation Information" for a User Product means any methods,
procedures, authorization keys, or other information required to install
and execute modified versions of a covered work in that User Product from
a modified version of its Corresponding Source.  The information must
suffice to ensure that the continued functioning of the modified object
code is in no case prevented or interfered with solely because
modification has been made.

  If you convey an object code work under this section in, or with, or
specifically for use in, a User Product, and the conveying occurs as
part of a transaction in which the right of possession and use of the
User Product is transferred to the recipient in perpetuity or for a
fixed term (regardless of how the transaction is characterized), the
Corresponding Source conveyed under this section must be accompanied
by the Installation Information.  But this requirement does not apply
if neither you nor any third party retains the ability to install
modified object code on the User Product (for example, the work has
been installed in ROM).

  The requirement to provide Installation Information does not include a
requirement to continue to provide support service, warranty, or updates
for a work that has been modified or installed by the recipient, or for
the User Product in which it has been modified or installed.  Access to a
network may be denied when the modification itself materially and
adversely affects the operation of the network or violates the rules and
protocols for communication across the network.

  Corresponding Source conveyed, and Installation Information provided,
in accord with this section must be in a format that is publicly
documented (and with an implementation available to the public in
source code form), and must require no special password or key for
unpacking, reading or copying.

  7. Additional Terms.

  "Additional permissions" are terms that supplement the terms of this
License by making exceptions from one or more of its conditions.
Additional permissions that are applicable to the entire Program shall
be treated as though they were included in this License, to the extent
that they are valid under applicable law.  If additional permissions
apply only to part of the Program, that part may be used separately
under those permissions, but the entire Program remains governed by
this License without regard to the additional permissions.

  When you convey a copy of a covered work, you may at your option
remove any additional permissions from that copy, or from any part of
it.  (Additional permissions may be written to require their own
removal in certain cases when you modify the work.)  You may place
additional permissions on material, added by you to a covered work,
for which you have or can give appropriate copyright permission.

  Notwithstanding any other provision of this License, for material you
add to a covered work, you may (if authorized by the copyright holders of
that material) supplement the terms of this License with terms:

    a) Disclaiming warranty or limiting liability differently from the
    terms of sections 15 and 16 of this License; or

    b) Requiring preservation of specified reasonable legal notices or
    author attributions in that material or in the Appropriate Legal
    Notices displayed by works containing it; or

    c) Prohibiting misrepresentation of the origin of that material, or
    requiring that modified versions of such material be marked in
    reasonable ways as different from the original version; or

    d) Limiting the use for publicity purposes of names of licensors or
    authors of the material; or

    e) Declining to grant rights under trademark law for use of some
    trade names, trademarks, or service marks; or

    f) Requiring indemnification of licensors and authors of that
    material by anyone who conveys the material (or modified versions of
    it) with contractual assumptions of liability to the recipient, for
    any liability that these contractual assumptions directly impose on
    those licensors and authors.

  All other non-permissive additional terms are considered "further
restrictions" within the meaning of section 10.  If the Program as you
received it, or any part of it, contains a notice stating that it is
governed by this License along with a term that is a further
restriction, you may remove that term.  If a license document contains
a further restriction but permits relicensing or conveying under this
License, you may add to a covered work material governed by the terms
of that license document, provided that the further restriction does
not survive such relicensing or conveying.

  If you add terms to a covered work in accord with this section, you
must place, in the relevant source files, a statement of the
additional terms that apply to those files, or a notice indicating
where to find the applicable terms.

  Additional terms, permissive or non-permissive, may be stated in the
form of a separately written license, or stated as exceptions;
the above requirements apply either way.

  8. Termination.

  You may not propagate or modify a covered work except as expressly
provided under this License.  Any attempt otherwise to propagate or
modify it is void, and will automatically terminate your rights under
this License (including any patent licenses granted under the third
paragraph of section 11).

  However, if you cease all violation of this License, then your
license from a particular copyright holder is reinstated (a)
provisionally, unless and until the copyright holder explicitly and
finally terminates your license, and (b) permanently, if the copyright
holder fails to notify you of the violation by some reasonable means
prior to 60 days after the cessation.

  Moreover, your license from a particular copyright holder is
reinstated permanently if the copyright holder notifies you of the
violation by some reasonable means, this is the first time you have
received notice of violation of this License (for any work) from that
copyright holder, and you cure the violation prior to 30 days after
your receipt of the notice.

  Termination of your rights under this section does not terminate the
licenses of parties who have received copies or rights from you under
this License.  If your rights have been terminated and not permanently
reinstated, you do not qualify to receive new licenses for the same
material under section 10.

  9. Acceptance Not Required for Having Copies.

  You are not required to accept this License in order to receive or
run a copy of the Program.  Ancillary propagation of a covered work
occurring solely as a consequence of using peer-to-peer transmission
to receive a copy likewise does not require acceptance.  However,
nothing other than this License grants you permission to propagate or
modify any covered work.  These actions infringe copyright if you do
not accept this License.  Therefore, by modifying or propagating a
covered work, you indicate your acceptance of this License to do so.

  10. Automatic Licensing of Downstream Recipients.

  Each time you convey a covered work, the recipient automatically
receives a license from the original licensors, to run, modify and
propagate that work, subject to this License.  You are not responsible
for enforcing compliance by third parties with this License.

  An "entity transaction" is a transaction transferring control of an
organization, or substantially all assets of one, or subdividing an
organization, or merging organizations.  If propagation of a covered
work results from an entity transaction, each party to that
transaction who receives a copy of the work also receives whatever
licenses to the work the party's predecessor in interest had or could
give under the previous paragraph, plus a right to possession of the
Corresponding Source of the work from the predecessor in interest, if
the predecessor has it or can get it with reasonable efforts.

  You may not impose any further restrictions on the exercise of the
rights granted or affirmed under this License.  For example, you may
not impose a license fee, royalty, or other charge for exercise of
rights granted under this License, and you may not initiate litigation
(including a cross-claim or counterclaim in a lawsuit) alleging that
any patent claim is infringed by making, using, selling, offering for
sale, or importing the Program or any portion of it.

  11. Patents.

  A "contributor" is a copyright holder who authorizes use under this
License of the Program or a work on which the Program is based.  The
work thus licensed is called the contributor's "contributor version".

  A contributor's "essential patent claims" are all patent claims
owned or controlled by the contributor, whether already acquired or
hereafter acquired, that would be infringed by some manner, permitted
by this License, of making, using, or selling its contributor version,
but do not include claims that would be infringed only as a
consequence of further modification of the contributor version.  For
purposes of this definition, "control" includes the right to grant
patent sublicenses in a manner consistent with the requirements of
this License.

  Each contributor grants you a non-exclusive, worldwide, royalty-free
patent license under the contributor's essential patent claims, to
make, use, sell, offer for sale, import and otherwise run, modify and
propagate the contents of its contributor version.

  In the following three paragraphs, a "patent license" is any express
agreement or commitment, however denominated, not to enforce a patent
(such as an express permission to practice a patent or covenant not to
sue for patent infringement).  To "grant" such a patent license to a
party means to make such an agreement or commitment not to enforce a
patent against the party.

  If you convey a covered work, knowingly relying on a patent license,
and the Corresponding Source of the work is not available for anyone
to copy, free of charge and under the terms of this License, through a
publicly available network server or other readily accessible means,
then you must either (1) cause the Corresponding Source to be so
available, or (2) arrange to deprive yourself of the benefit of the
patent license for this particular work, or (3) arrange, in a manner
consistent with the requirements of this License, to extend the patent
license to downstream recipients.  "Knowingly relying" means you have
actual knowledge that, but for the patent license, your conveying the
covered work in a country, or your recipient's use of the covered work
in a country, would infringe one or more identifiable patents in that
country that you have reason to believe are valid.

  If, pursuant to or in connection with a single transaction or
arrangement, you convey, or propagate by procuring conveyance of, a
covered work, and grant a patent license to some of the parties
receiving the covered work authorizing them to use, propagate, modify
or convey a specific copy of the covered work, then the patent license
you grant is automatically extended to all recipients of the covered
work and works based on it.

  A patent license is "discriminatory" if it does not include within
the scope of its coverage, prohibits the exercise of, or is
conditioned on the non-exercise of one or more of the rights that are
specifically granted under this License.  You may not convey a covered
work if you are a party to an arrangement with a third party that is
in the business of distributing software, under which you make payment
to the third party based on the extent of your activity of conveying
the work, and under which the third party grants, to any of the
parties who would receive the covered work from you, a discriminatory
patent license (a) in connection with copies of the covered work
conveyed by you (or copies made from those copies), or (b) primarily
for and in connection with specific products or compilations that
contain the covered work, unless you entered into that arrangement,
or that patent license was granted, prior to 28 March 2007.

  Nothing in this License shall be construed as excluding or limiting
any implied license or other defenses to infringement that may
otherwise be available to you under applicable patent law.

  12. No Surrender of Others' Freedom.

  If conditions are imposed on you (whether by court order, agreement or
otherwise) that contradict the conditions of this License, they do not
excuse you from the conditions of this License.  If you cannot convey a
covered work so as to satisfy simultaneously your obligations under this
License and any other pertinent obligations, then as a consequence you may
not convey it at all.  For example, if you agree to terms that obligate you
to collect a royalty for further conveying from those to whom you convey
the Program, the only way you could satisfy both those terms and this
License would be to refrain entirely from conveying the Program.

  13. Remote Network Interaction; Use with the GNU General Public License.

  Notwithstanding any other provision of this License, if you modify the
Program, your modified version must prominently offer all users
interacting with it remotely through a computer network (if your version
supports such interaction) an opportunity to receive the Corresponding
Source of your version by providing access to the Corresponding Source
from a network server at no charge, through some standard or customary
means of facilitating copying of software.  This Corresponding Source
shall include the Corresponding Source for any work covered by version 3
of the GNU General Public License that is incorporated pursuant to the
following paragraph.

  Notwithstanding any other provision of this License, you have
permission to link or combine any covered work with a work licensed
under version 3 of the GNU General Public License into a single
combined work, and to convey the resulting work.  The terms of this
License will continue to apply to the part which is the covered work,
but the work with which it is combined will remain governed by version
3 of the GNU General Public License.

  14. Revised Versions of this License.

  The Free Software Foundation may publish revised and/or new versions of
the GNU Affero General Public License from time to time.  Such new versions
will be similar in spirit to the present version, but may differ in detail to
address new problems or concerns.

  Each version is given a distinguishing version number.  If the
Program specifies that a certain numbered version of the GNU Affero General
Public License "or any later version" applies to it, you have the
option of following the terms and conditions either of that numbered
version or of any later version published by the Free Software
Foundation.  If the Program does not specify a version number of the
GNU Affero General Public License, you may choose any version ever published
by the Free Software Foundation.

  If the Program specifies that a proxy can decide which future
versions of the GNU Affero General Public License can be used, that proxy's
public statement of acceptance of a version permanently authorizes you
to choose that version for the Program.

  Later license versions may give you additional or different
permissions.  However, no additional obligations are imposed on any
author or copyright holder as a result of your choosing to follow a
later version.

  15. Disclaimer of Warranty.

  THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY
APPLICABLE LAW.  EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT
HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY
OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM
IS WITH YOU.  SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF
ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

  16. Limitation of Liability.

  IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MODIFIES AND/OR CONVEYS
THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY
GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE
USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED TO LOSS OF
DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD
PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS),
EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

  17. Interpretation of Sections 15 and 16.

  If the disclaimer of warranty and limitation of liability provided
above cannot be given local legal effect according to their terms,
reviewing courts shall apply local law that most closely approximates
an absolute waiver of all civil liability in connection with the
Program, unless a warranty or assumption of liability accompanies a
copy of the Program in return for a fee.

                     END OF TERMS AND CONDITIONS

            How to Apply These Terms to Your New Programs

  If you develop a new program, and you want it to be of the greatest
possible use to the public, the best way to achieve this is to make it
free software which everyone can redistribute and change under these terms.

  To do so, attach the following notices to the program.  It is safest
to attach them to the start of each source file to most effectively
state the exclusion of warranty; and each file should have at least
the "copyright" line and a pointer to where the full notice is found.

    <one line to give the program's name and a brief idea of what it does.>
    Copyright (C) <year>  <name of author>

    This program is free software: you can redistribute it and/or modify
    it under the terms of the GNU Affero General Public License as published by
    the Free Software Foundation, either version 3 of the License, or
    (at your option) any later version.

    This program is distributed in the hope that it will be useful,
    but WITHOUT ANY WARRANTY; without even the implied warranty of
    MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the
    GNU Affero General Public License for more details.

    You should have received a copy of the GNU Affero General Public License
    along with this program.  If not, see <http://www.gnu.org/licenses/>.

Also add information on how to contact you by electronic and paper mail.

  If your software can interact with users remotely through a computer
network, you should also make sure that it provides a way for users to
get its source.  For example, if your program is a web application, its
interface could display a "Source" link that leads users to an archive
of the code.  There are many ways you could offer source, and different
solutions will be better for different programs; see section 13 for the
specific requirements.

  You should also get your employer (if you work as a programmer) or school,
if any, to sign a "copyright disclaimer" for the program, if necessary.
For more information on this, and how to apply and follow the GNU AGPL, see
<http://www.gnu.org/licenses/>.
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版权申明

“OpenERP”, “OpenObject”及本文档属于:

Copyright © 2001-TODAY OpenERP S.A. All rights reserved.





“OpenERP”及”OpenObject”为”OpenERP S.A.”公司注册商标。

其他详情参阅 Documentation License.
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文档许可协议

Open Object Press 版权所有. 保留所有权利.

在不以任何方式改变内容的前提下，你可以获取一份电子拷贝用于发布和分发。在仅用于个人的前提下，你也可以打印阅读。

我们与各个国家的出版社签署了合同，用于在书店销售和分发本书的纸质或电子版本（包含翻译和其他内容）。
这有助于分发和保护 OpenERP 的产品。
借助以上销售方式，将帮助我们我们激励和支付贡献者和作者。

基于以上原因，翻译、修改或销售本书是严格禁止的，除非Tiny SPRL (也就是 Open Object Press)为您提供书面授权。

制造商和供应商为区分它们的产品，注册了许多标志为商标。
关于本书中出现的标志，Open Object Press 充分意识到商标所有者权利，因此相关标志将会以首字母大写的形式出现。

在本书的编写过程中，我们采取了一切可能的措施。
但对于出版商和作者的错误或遗漏，或使用过程中造成的损失，我们对此不承担任何责任。

Open Object Press, Grand Rosière, 比利时 声明。


文档许可协议常见问题


为什么不采取免费文档协议？

为了高质量完成这些文档，我们将这些工作作为标准出版过程来管理，我们有专门的编辑进行质量审核。
同时，我们也认为将这些文档非常值得在书店里销售纸质版。这可以让我们的产品更具有全球知名度。

与专业编辑一起工作时，有人要求获得这些内容（已翻译）版权，通过大批量印刷或在书店销售，从而使他们能够轻松获益。
但要承担以下风险：他们需要本书版本的保护，但这是和 GFPL 不兼容的。




你们是否接受大家修改此书的贡献？

我们的愿景是接受大部分的贡献和贡献者。如果你的贡献很牛B的话，我们会给您提供书面许可。

但我们必须保持对本书的控制以确保：
* 编辑的权利不受侵犯
* 相关的激励措施（如支付作者/译者）的权利不受侵犯

勘误部分公开在WIKI上，人人都可以为此做贡献。然后作者可以查看修改，以他/她自己的方式应用上去。




为什么这是个好方法？

OpenERP 的文档工作是我们最高优先级的工作之一。现在我们拥有所有开源的ERP系统中最好的文档，但这远远不够并且我相信能做得更好。

撰写一个良好的文档是非常复杂的过程

这些年来，我们试图在开发社区基础上，采取人人都可以贡献的WIKI形式编撰文档。
OpenERP 拥有一个强大的社区，但这些年来，我们发现社区文档并没有达到我们的期望：


	文档相对落后于新版软件,

	原作者没有维护他们所编写/贡献的内容,

	貌似不相关的文档组合在一起,

	某些贡献者并没有完全理解软件,

	不以最终用户为导向,

	有些仅仅拥有食品行业经验，有些只拥有服务行业经验，有些只有制造业经验，等等。



因此，我们决定以审核的方式来编写和维护以后的 OpenERP 和 Open Object 文档。

编写过程

大部分最好的开源文档都只有1、2个作者完成。
然后社区再参与一些小的改动。

因此我认为我们应该集中资源于少数人身上，而不是一个全球性的社区。
但编写一个完整的文档（或设置于一个完整的章节）需要花费相当长的时间（我们花了200小时编写OpenERP法语文档，一共280页）。
因此我们需要一些激励措施来鼓励和支持这些贡献者/作者。

因此我们决定如其他出版书籍一样管理OpenERP的文档。我们有以下角色参与：


	编辑: 与作者一起审核此书的质量，然后在一些国家的书店和网上商店分发。编辑还定义了与作者的合同和图形、图标和风格。编辑还将管理与此书相关的集合。

	作者: 每个人都可以写自己的章节，然后推荐给编辑。编辑将选好章节出版完整的书籍。

	审核: 在发布之前，将会重新阅读此书，与编辑一起完成高质量的工作。

	译者: 以英文版本为基础，翻译成自己的母语。



不同的国家和翻译会有不同的情况。
对于法语国家，我们已经和Eyrolles签约出版。
对于英文版本，我们将创建自己的公司版，使我们可以将其发布在网上免费。

现在我们为作者和译者建立以下激励措施：


	作者可以按照月销售获取一定的提成

	通过我们的全球分发渠道在书店出版



通过以上措施，应该在促进贡献者写出良好的文档上起到一定的效果。
当人们可以通过努力工作获取报酬和出版，这应该可以促进新的人员不断加入。

通过在不同国家和语言的书店中销售此书，这可以通过版权对作者支付酬劳。
这也有助于我们激励作者和译者写更多的章节和改善现有内容。

在销售本书以支付作者和在网络提供免费版本之间，我们必须找到平衡点。
因此，我们大多数书都是在官方出版（依赖于相关国家我们与编辑的合同）一个月之后，也会在网上提供。

我们的目标是为不同领域创建不同的书：技术指南，市场管理，多公司管理，财务管理, ...

书籍编写是我们的主要文档工作。
当OpenERP新版本发布是，我们也将发布更新新版书籍。
编辑会组织并因此获得报酬。

此外，我们使用社区 wiki 方式来编写其他文档，如其他与软件没有直接关系的文档或各个模块的文档等。
我们使用 Launchpad Answers 作为我们主要的知识管理系统，您可以在上面提问和回答问题。

社区的角色和定位

本文档的编写和维护比较倾向于专业的作者和译者。
但这并不意味社区在编写文档中不重要。
基于以下原因，社区仍然是非常重要：


	社区中的每个人都可以申请为作者和译者，可以为文档完成一个或多个章节，不需要完成整本书。

	在正式发布前，编辑们也需要读者来审核此书。

	读者是从社区的不同贡献者中选出来的。



为持续改善本书的质量，我们也在WIKI上建立了勘误表。
社区可以在WIKI勘误表上提出改进意见。

允许每个人在勘误表贡献，要比直接在内容上修改好，这样有助于我们对文档质量的控制。
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介绍








本章目标

OpenERP 是一个全功能全业务软件套装，超过700模块。无论技术有多复杂、还有众多的社区成员仍在不断开发如此巨大的项目，我们的目标是让软件容易使用、用户友好和保持完全开源。

我们最大的挑战是：在提供大量的功能同时又要保证易于使用。

OpenERP SA 为此专门成立了一个界面交互团队，持续改进易用性，让安装和配置变的更简单。同时该团队也为开发者维护界面开发指南文档。

本指南主要有2部分：一部分是阐述 OpenERP 的界面设计，另外一部分是本章最后部分的各种指南。

本指南的另外一个目标是，汇集社区成员的各种观点、意见和建议。实际上，每个人都可以自由贡献、编写本指南。 界面交互团队的备注可以在 web 上插入，或是添加到手册中。社区成员同样也可以提出意见或建议。




持续改进流程

在大约200个全职开发人员的努力下，OpenERP 每天都在改进。界面交互团队也在不断寻找让OpenERP的新用户更容易使用的方法。

OpenERP SA 、官方合作伙伴、社区成员一直在讨论这些方法，为此，我们还在 Launchpad 建立了 usability team on Launchpad [https://launchpad.net/~openerp-expert-ergonomy] .  来专门讨论。

您可以通过订阅邮件列表 usability mailing list [https://launchpad.net/~openerp-expert-ergonomy] 来参与讨论如何提高 OpenERP 的界面友好度。

一旦某项改善建议被界面交互团队经理确认，OpenERP SA 社区开发人员，会根据改善建议开始开发。您可以查阅 developer guide 与 documentation process  开发指南和相关文档来获知如何为OpenERP 贡献。

主要的界面交互方面的改进将会在本书形成一系列的指南。界面交互团队将会把 OpenERP 的最佳实践与本书同步。如果您想在此方面为 OpenERP 做出贡献，您可以在这里 Launchpad documentation branch [https://code.launchpad.net/~openerp-community/openobject-doc/trunk] 和我们一起工作。

所要更改和重大改进，都会发布在博客 OpenERP blog [http://usability-openerp.blogspot.com/] ，您可以在上面留下您的意见、建议和想法。

每个人都可以在这本书的任何页面上发表评论。每个月界面交互团队将查看所有评论，如果有需要还会更新本书。

本书用英文写作，然后由 translated by community members  翻译成几种语言。

为了检查模块是否符合界面交互指南，我们把这些检查作为 OpenERP SA 新模块质量检查的一部分。因此，我们会检查所有官方模块是否符合上述方针。

界面交互团队同时对开发人员进行培训。所以，当界面交互团队检查到不符合要求时，他们将会联系作者，并要求作者改善。在这个反馈过程中，界面交互团队将会具体指出违背了那些原则。

在这个改善过程中，将会有几位开发人员和专家组成的团队跟进，随着时间的推移，我们期待 OpenERP 的可用性将会很快提高。如果您想提出一项新的改进，最好的方法就是通过邮件列表 write to the usability mailing list ，来提出您的意见和建议。

如果的改进意见被确认，我们将安排相应的开发人员和界面交互团队按照界面可用性原则跟进。
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配置向导功能

配置向导会在创建新数据库后自动启动。你需要为每个应用套件开发配置向导：



	让用户选择安装哪些功能（模块）

	帮助用户配置系统






第一点中，让用户选择越少越容易理解系统。因此，大部分功能在配置向导中都是属于额外选项。

第二点中，对大多数企业，最好是提供一个默认的配置，而不是开发一个配置向导。

切记配置向导的作用是让用户按需定制系统，而不是问用户一些非常技术化、复杂的问题去配置系统。

OpenERP 允许用户按照业务需求配置安装。当用户创建完数据库之后，就可以选择一个或多个业务套件。
然后就可以看到相关的配置向导。比如，如果用户选择“项目管理” ，然后就会看到一个关于项目管理的配置向导。


[image: ../../_images/2.1.Project_management.png]






          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	界面交互指南 

          	配置 
 
      

    


    
      
          
            
  
配置默认值

要配置用户默认值, 使用菜单项: 配置(Settings) ‣ 技术(Technical) ‣ 动作(Actions) ‣ 用户定义默认值(User-defined Defaults).
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应用套件


定义新的应用或完成已存在的应用

一般来说我们是根据企业内部的职位来定义相关的业务套件。好的例子，如采购、销售、财务和项目管理等。
不好的例子就是按照功能来创建业务套件，如午餐订单管理，费用表，等等。

如果你的功能不属于已有的应用套件，你可以把它们放在“其他模块”应用中




业务应用的配置向导

每个应用都必须在主配置界面创建一个条目，上面显示了经过质量认证各种应用。


[image: ../../_images/1.2.Installation_of_modules.png]


你也可以为你的应用创建一个配置向导。例如，当你安装项目管理应用后，你可以看到以下的配置向导：


[image: ../../_images/1.3.Project_management.png]





应用模块功能完整

每个用户/角色都应该在一个应用下完成自身的大部分工作。例如，一个销售人员应该可以看到线索、商机、会议、销售订单、销售发票等菜单。他不应该强制要去财务应用模块中才能看到销售发票。




横向功能，能够被所有应用使用

有些功能应该可以被所有用户访问，无论他们是什么岗位。例如，大多数用户应该可以访问合作伙伴、会议日程、产品等。这种情况下，你可以把这些功能菜单放在各个应用下（如：联系人菜单在销售、采购、财务等模块都有）。而且在创建用户的时候，系统默认为这些用户创建菜单的快捷方式。




每个应用必须为用户组定义权限

每个应用组都必须按照相关的工作职责定义权限。因此，如果你有一个财务应用模块，这个应用的组应该是这样的：“财务/会计师”，“财务/财务经理”，等等。




每个应用定义一个面板

每个应用应该在相应的根菜单下定义一个面板。当用户进入应用时，该用户应该可以看到相应的应用面板。
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菜单组织规则


菜单组织


	应用套件的第一个菜单往往是最主要的功能。理由如下：
* 用户可以方便直接读取他们的文档，通常来说，是和日常工作对应的主要功能
* 在Web客户端，第一个菜单默认情况下是打开的





[image: ../../_images/webmenu.png]






	如果应用套件包含 “res.partner” 对象，往往是放在主菜单之后。无论是在销售中的“客户”或采购当中的“供应商”，都是非常重要的。

	“设置” 菜单往往放在主菜单的最后一项。只有“admin / configuration” 组的用户才有权限操作。

	“报表” 菜单往往是在 “设置” 菜单之前。对于经理来说是最后一项菜单。

	如果应用套件包含 “res.product” 对象，往往是放在 “报表” 项之前（对普通用来来说，这是最后一项菜单）。

	如果应用套件有“invoice（发票）” 对象，那必须放在 “产品” 菜单之前。

	其他菜单就按照一定的逻辑顺序排列。例如，在 “人力资源” 中，时间追踪要比费用更常用，因此时间追踪会放在费用之前。



总结下菜单的样子：


	应用的主菜单

	(地址薄)

	…

	(费用)

	(产品)

	报表

	设置






菜单用词

菜单名称必须言简意赅。首先，在 Web 客户端主菜单是位于页面上部的水平栏里，因此不能占用太多地方。所以，我们用 “采购” 而不是 “采购管理”，这样可以缩短单词长度。


[image: ../../_images/menubar.png]


其次，菜单名称必须符合应用的上下文。比如，res.partner 对象在 “销售” 中是 “客户”，而在 “采购” 中是 “供应商”。
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搜索视图（注：OE7搜索视图巨变，此节暂且不译）


如何设计一个搜索试图


[image: ../../_images/3.5.search_view.png]


Filtering buttons and main filter fields must be the first elements on top of the view, and on the same line. Below this main filter option,  you must place extended filters and group by one above the other. Each field group must be placed in a new line. Finally, the search bar must be below the view as displayed in the picture above.




使用业务相关的术语

As previously mentioned, the used terminology must be adapted to the application. An example of this would be, in sale order the search field “partner_id” is named “Customer” and in purchase application, the same search field is named “Supplier”. In the same way, the “user_id” field in sales is named “Salesman” and in project management, it is named “Project Manager”.




过滤器按钮详情


	These kinds of buttons are on the top left of the screen.

	Filtering buttons are grouped by context (more often States and Dates).

	Inside a single group, button behavior is exclusive.

	Each context is separated by a vertical separator.

	The first group is always related to states (Current, Pending or Open).



Then there are other buttons in one or more groups, it depends on the context. These are specific to the current view. For instance, in sale orders, we have “to invoice”. Finally, if there are buttons related to the date such as, “This Month” or “Today”, it has to be last group on the right.


Note

In statistic reports search views, filter buttons related to dates are first on the left. Because user date is important, statistics is often computed on a given time. A sales manager wants to see statistics of the month or of the year.




	If there is a current button, it is generally selected by default. This button filters all draft and open documents. This is  usually selected by default to avoid seeing cancelled and closed documents.






主过滤器选项影响的列表项


	Default search fields might reflect the available columns in the list view. In other words, each field must have a related column in the list view and is placed in the same position as the column.



	Near fields like “user_id” or “section_id”, following the current view context, we can find some buttons



	near “user_id” field we can find the following buttons :



	this filters all documents of the current user and is named “My..”

	this filters all unassigned documents. This button is used in views where documents are self generated such as leads.








	Near “section_id” we can find buttons generally used in views related to sale’s applications. This button shows documents linked with current user’s department(sales/marketing/HR,etc.).















分组 : 数据组织


	like buttons, “group by” are organized in context.

	The first group is related to human resources, the second group is related to the state of the document. The third group is related to a place, and finally the last group is related to dates.

	A separator is defined between each group. For example : Salesman Partner | Stage State | Shop Company | Day Month Year

	Use appropriate icons as defined in 图标.

	In all search views, except for report’s search view, groups by must be folded. The goal is to have simple view by default.






扩展过滤器的用法


	There are extended filters only in extended interface because it complicates the views. In the simplified interface, the user can use optional filters.

	By default, extended filters are folded.

	Generally, the user can find important fields in extended filters, but it is possible that no column is linked to the field.

	Extended filters also give you the possibility to add columns that users might need.




[image: ../../_images/3.7.extended_filter_button.png]
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配置向导


向导的通用布局


	标题要符合应用套件内容：正如之前介绍，选择安装应用之后就会有一个配置向导。该配置向导的标题必须与应用套件相关。

	图片和说明性信息放在左边：所有向导都需要相关的图片和说明性的文字，告诉用户如何配置。

	可配置对象（文件）放在右边：所有可配置对象应该可以选择和配置，放在配置向导的右边。

	允许用户跳过配置：所有配置向导都必须有2个按钮，“跳过” 和 “配置”，放在配置向导右下角。

	进度条：允许用户看到进行到哪一步了，所有应用都应该有一个百分比的进度条来显示完成进度。

	分隔符：每个配置部分都应该用分割栏分开布局。






配置向导应该是可选的

配置向导是可选的。系统应该可以使用默认配置，即使管理员在配置过程中跳过所有步骤。配置向导仅适用于：


	提供新功能安装（一系列模块）

	更改系统的默认配置（而不是配置系统！）






配置向导为应用的一部分

大多数的应用向导必须是应用套件的一部分。请务必做到：


	明确配置向导向导属于某个应用套件

	术语独立于应用套件的上下文。例如，在项目管理应用中，不要讨论辅助核算或凭证，要讨论项目或时间表。避免涉及到多个应用套件的配置向导。






配置向导与扩展/简单试图

扩展/简单试图也同样适用于配置向导。为简化配置过程，有些配置选项仅在扩展试图中显示。
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按钮图标



	图标
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图标

大多数图标都可在搜索视图中看到。所有的按钮中必须有一个相关的功能的图标。 OpenERP 使用一系列预定义的图标。以下是最常见的图标（所有的图标都在附件）







	
	人力资源




	
[image: ../../_images/personal.png]





	
	日期




	
[image: ../../_images/go-month.png]





	
	商品




	
[image: ../../_images/accessories-archiver.png]





	
	状态按钮:




	


	
	草稿

	确认

	处理中




	
[image: ../../_images/document-new.png]



[image: ../../_images/camera_test.png]



[image: ../../_images/gtk-media-pause.png]





	
	今天、会议、事件




	
[image: ../../_images/go-today.png]





	
	周




	
[image: ../../_images/go-week.png]





	
	日期




	
[image: ../../_images/go-month.png]





	
	年




	
[image: ../../_images/go-year.png]





	
	关闭、完成、正常关闭、卸载




	
[image: ../../_images/dialog-close.png]





	
	取消、拒绝、标记损失




	
[image: ../../_images/gtk-stop.png]





	
	迟到、超期、紧急、到期




	
[image: ../../_images/gnome-cpu-frequency-applet+.png]





	
	昨天




	
[image: ../../_images/gtk-go-back-ltr.png]





	
	确认、校验。。。等等下一步流程




	
[image: ../../_images/gtk-go-back-rtl.png]





	
	登录、去往等流程跳转




	
[image: ../../_images/gtk-jump-to-ltr.png]





	
	登出、来源等流程跳转




	
[image: ../../_images/gtk-jump-to-rtl.png]





	
	未激活




	
[image: ../../_images/gdu-smart-failing.png]





	
	计划、任务、类型、路由




	
[image: ../../_images/stock_align_left_24.png]





	
	例外、意外等




	
[image: ../../_images/emblem-important.png]
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常见问题(FAQ)



	Bazaar 版本控制的常见问题(F.A.Q)
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Bazaar 版本控制的常见问题(F.A.Q)


Contents


	Bazaar 版本控制的常见问题(F.A.Q)
	Bazaar安装

	Launchpad 帐号

	代码提交

	Bazaar使用指导

	常见问题










Bazaar安装

在Ubuntu系统上使用下面命令安装 Bazaar:

apt-get install bzr





最好安装Bazaar版本>=1.3。下面的命令可以查看当前Bazaar的版本:

bzr --version





如果Bazaar版本过低， 请到 http://bazaar-vcs.org/Download 下载最新版本

Debian分发的系统可以使用1.5版本的Bazaar，下载地址为: http://backports.org/debian/pool/main/b/bzr/bzr_1.5-1~bpo40+1_i386.deb




Launchpad 帐号

要在Launchpad上提交代码，你肯定是需要去注册一下的。

在 https://launchpad.net 首页的右上方的 Login/Register 就是咱注册的地儿了。

输入您的e-mail 地址，然后收取邮件，指导您创建登录。

使用bazaar 提交代码到 openerp-commiter 或 你自己的分支上的时候，才需要您登录




代码提交

当你创建完用户之后，你需要创建 ssh 密钥，然后将密钥添加到您的登录页中（页面左边有如何创建ssh 密钥）。
这个 ssh 密钥必须要提交。

建议您按照以下指引完成创建SSH密钥: https://help.launchpad.net/您的账户名/CreatingAnSSHKeyPair




Bazaar使用指导

有2种方式开始工作。检出代码或是创建一个本地分支。

检出方法:

bzr co lp:~openerp/openobject-addons/trunk -- to make a checkout
bzr up                                     -- to make an update
bzr ci                                     -- to commit





创建分支:

bzr branch lp:~<url> <local dir>             -- to create a branch locally
bzr pull                                     -- to update the branch
bzr push lp:~<url>                           -- to include your changes in the remote branch





当你遇到问题，无论是什么情况，都可以输入:

bzr help





或者 bzr help <command>. e.g.:

bzr help branch








常见问题

检出代码不成功，如下提示:

bzr lp:~<url>
bzr: ERROR: Repository KnitPackRepository is not compatible with repository RemoteRepository





有2种方法可以修正.

使用 bzr co bzr+ssh://<yourlaunchpad login>@bazaar.launchpad.net/~<url> , 代替使用  bzr co lp:~<url> 。

参考以下地址: https://bugs.launchpad.net/bzr/+bug/205579. 通常，你可以这么做:

bzr branch lp:~<url>
bzr reconfigure --checkout
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模块技术指南: Introspection report on objects



	report_account_analytic (account_analytic_analysis)

	Account Analytic Default (account_analytic_default)

	Account Analytic Package - To configure Analytic Account for product packages (account_analytic_package)

	Multiple-plans management in Analytic Accounting (account_analytic_plans)

	Account Analytic Progress - Define Progress bar for analytic accounts (account_analytic_progress)

	Stock Accounting for Anglo Saxon countries (account_anglo_saxon)

	Asset management (account_asset)

	Account balance reporting engine (account_balance_reporting)

	Accounting and financial management-Compare Accounts (account_balance)

	Account Bankimport (account_bankimport)

	Accounting Base Properties (account_base)

	Import accounting entries from Bob (account_bob_import)

	Account Budget Project (account_budget_project)

	Budget Management (account_budget)

	Payment Term with Cash Discount (account_cash_discount)

	Charts of Accounts (account_chart)

	Update account chart from template (account_chart_update)

	Account CODA Version 2.1 D - Helps to import bank statements from .csv file. (account_coda_2_1_d)

	Account CODA - To import bank statements from .csv file (account_coda)

	Account Date check (account_date_check)

	Common financial reports (account_financial_report)

	Accounting follow-ups management (account_followup)

	Make Account invoice analytic account required in sale.invoice.line. (account_invoice_analytic_required)

	Accounting Base Configuration and Properties (account_invoice_india)

	account_invoice_layout (account_invoice_layout)

	Allow to change definition of the name field of invoice (account_invoice_number)

	Invoice with payment term lines (account_invoice_payment_term)

	India Accounting (account_invoice)

	Salesman on invoices (account_invoice_salesman)

	Accounting journal visibility (account_journal_visibility)

	Account l10nbe Domiciliation (account_l10nbe_domiciliation)

	Account For Multicompany (account_multicompany)

	Import ePassporte Payments (account_payment_epassporte)

	Payment Order Export (account_payment_export)

	Account Payment Extension (account_payment_extension)

	Import Paypal Payments (account_payment_paypal)

	Payment Management (account_payment)

	Account Regularizations (account_regularization)

	Account renumber wizard (account_renumber)

	Indian Accounting and financial management (account_report_india)

	Reporting of Balancesheet for accounting (account_reporting)

	Reporting for accounting (account_report)

	Accounting Reports - Indian Accounting (account_reports_india)

	Module Help To Reverse Account Move (account_reverse)

	会计与财务管理 (会计)

	Accounting simulation journal (account_simulation)

	Account Stock (account_stock)

	Invoices and prices with taxes included (account_tax_include)

	Invoice Payment/Receipt by Vouchers. (account_voucher_payment)

	Accounting Voucher Reports (account_voucher_report)

	Accounting Voucher Entries (account_voucher)

	Business Process for Accounting Voucher (account_voucher_workflow)

	Actions Server: Mako Emails (actions_server_mako_email)

	Airport (airport)

	Generic alerts (alerts)

	Analytic Journal Billing Rate (analytic_journal_billing_rate)

	Analytic accounts with multiple partners (analytic_partners)

	Analytic User Function (analytic_user_function)

	Asterisk - Manage Asterisk servers and IP phones. (asterisk)

	Auction module (auction)

	Audit Trail (audittrail)

	Email Invoice - Send email to customers or suppliers (auto_email_account)

	邮寄销售订单 - 发送邮件给客户 (auto_email_sale)

	Auto Email Stock Picking - Send email to customer and supplier from picking (auto_email_stock)

	Base (base)

	City for Base Contact (base_contact_city)

	Base Contact (base_contact)

	Base Contact Team - To manage teams of contacts (base_contact_team)

	Menu Wizard  (base_create_menu)

	Base - Password Encryption (base_crypt)

	Base External Referentials (base_external_referentials)

	IBAN (base_iban)

	Base Language - To load all existing languages in the world (base_language)

	Module Technical Guide in Restructured Text  (base_module_doc_rst)

	Module Merger (base_module_merge)

	Module publisher (base_module_publish)

	Base module quality (base_module_quality)

	Module Recorder (base_module_recorder)

	Module Recorder (base_module_record)

	Base Partner Gender (base_partner_gender)

	Partners - relation extension (base_partner_relation)

	Restrict access to partners by categories (base_partner_security)

	Add a sequence on partners Code (base_partner_sequence)

	Base Partner Surname (base_partner_surname)

	Report Creator (base_report_creator)

	Report designer interface module (base_report_designer)

	Base Report Model (base_report_model)

	Unicode Reports with TrueType fonts (base_report_unicode)

	Base Sale MultiChannels (base_sale_multichannels)

	Base Setup (base_setup)

	Translation (base_translation)

	Url Menus (base_url_menu)

	VAT (base_vat)

	Base VAT Unique check VAT number is unique (base_vat_unique)

	Board for accountant (board_account)

	Dashboard for Associations (board_association)

	Board for Auction (board_auction)

	Dashboard for CRM Configuration (board_crm_configuration)

	Board for DM users (board_dm)

	Dashboard for Document Management (board_document)

	Board for Hotel FrontDesk (board_frontdesk)

	Board for manufacturing (board_manufacturing)

	Board for project users (board_project_portal)

	Board for project users (board_project)

	Board for Hotel Reservation (board_reservation)

	Board for Hotel Restaurant users (board_restaurant)

	Dashboard main module (board)

	Dashboard for sales (board_sale)

	Dashboard for Service Profile (board_service)

	Bookstore Verticalisation (bookstore)

	Module business (business)

	Account Payment (c2c_account_payment)

	Rapport sur le plan comptable analytique (c2c_analytic_chart)

	Fonctions standads C2C pour account analytic (c2c_analytic)

	Analytic wizard and tools for services companies (c2c_analytic_wizard)

	Fonctions standads C2C pour base et account (c2c_base_account)

	Advanced Budget (c2c_budget)

	Camptocamp Partner extension to synchronize OpenERP with LDAP (c2c_contact_to_ldap)

	Invoice Correcting (c2c_correct_invoice)

	CRM Reporting (c2c_crm_reporting)

	c2c_cumulated_finance_report (c2c_cumulated_finance_report)

	Currency Rate Update (c2c_currency_rate_update)

	Date in SO lines (c2c_date_in_so_line)

	Fonctions standads C2C pour expense (c2c_expense)

	Financial report improvements (c2c_finance_report_extended)

	Financial report improvements (c2c_finance_report)

	c2c close fiscal year (c2c_fiscal_year_close)

	Holidays import in timesheet (c2c_holidays_import)

	Holidays Report (c2c_holidays_report)

	C2C Hours Blocks (c2c_hours_blocks)

	Fonctions standads C2C pour timsheet (c2c_hr_timesheet_sheet)

	C2C Invoice Layer (c2c_invoice_layer)

	Invoice customisation (c2c_invoice_report)

	Multi-Costs Handling base (c2c_multicost_base)

	Multi-Costs Handling in expense (c2c_multicost_expense)

	Multi-Costs Handling in project timesheet (c2c_multicost_project_timesheet)

	Multi-Costs Handling in stock (c2c_multicost_stock)

	Multi-Costs Handling in hr_timesheet_invoice (c2c_multicost_timesheet_invoice)

	Multi-Costs Handling in hr_timesheet (c2c_multicost_timesheet)

	Multi-Costs Handling in analytic_user_function (c2c_multicost_user_function)

	c2c_multi_currency_consolidated_chart (c2c_multi_currency_consolidated_chart)

	Multi currency expenses (c2c_multi_currency_expense)

	Auto currency computation in journal (c2c_multicurrency_journal)

	c2c_multi_header (c2c_multi_header)

	c2c_one_time_password_login (c2c_one_time_password_login)

	Show orphans accounts (c2c_orphans_accounts_checker)

	C2C partner address (c2c_partner_address)

	Planning management (c2c_planning_management)

	Project activities (c2c_project_activities)

	Refresh Sale orders line prices (c2c_refresh_so_lines)

	c2c Reporting Tools. A library that provide a new way to create clean reports efficiently (c2c_reporting_tools)

	Order line of sale order (c2c_sale_sequence)

	Wizard to Scan BVR for Invoice (c2c_scan_bvr)

	Stock obsolete (c2c_stock_obsolete)

	Timesheet fullfill wizard (c2c_timesheet_fullfill)

	Timesheet Reports (c2c_timesheet_reports)

	Translation synchronisation (c2c_translation_synchro)

	Carrier picking adds carrier contact information (carrier_picking)

	Module Catalogue (catalog)

	CCI Account (cci_account)

	Audit Trail (cci_audittrail)

	CCI Base Contact (cci_base_contact)

	CCI Country (cci_country)

	CCI CRM Profile (cci_crm_profile)

	CCI CRM (cci_crm)

	cci Data 1 (cci_data_csv)

	CCI EVENT (cci_event)

	CCI Membership (cci_membership)

	CCI mission (cci_mission)

	CCI Partner (cci_partner)

	CCI Purchase (cci_purchase)

	CCI Sales (cci_sales)

	CCI Security (cci_security)

	CCI Timesheet (cci_timesheet)

	CCI Translation (cci_translation)

	Module for Chemical Industries (chemical)

	Account Period Sum (chricar_account_period_sum)

	Partner Parent Companies (chricar_partner_parent_companies)

	Product GTIN EAN8 EAN13 UPC JPC Support (chricar_product_gtin)

	Product Image (chricar_product_image)

	ChriCar unique View ID (chricar_view_id)

	City-Helps to keep homogeneous address data in the Database (city)

	Civil Engineering (civil_engineering)

	Sale agent Information (commission_pricelist)

	Sale Agent Information (commission_rate)

	Sale agent Information (commission)

	ERP Comparisons (comparison)

	Bayesian Filter (crm_bayes)

	Customer Relationship Management (crm_configuration)

	CRM Configuration Timesheet (crm_configuration_timesheet)

	CRM - Livechat Jabber Client (crm_livechat)

	crm_profiling management (crm_profiling)

	Customer & Supplier Relationship Management (crm)

	Telemarketing Management (crm_telemarketing)

	CRM Timesheet (crm_timesheet)

	CRM Verticalisation (crm_vertical)
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report_account_analytic (account_analytic_analysis)





	Module:	account_analytic_analysis


	Name:	report_account_analytic


	Version:	5.0.1.1


	Author:	Camptocamp


	Directory:	account_analytic_analysis


	Web:	http://www.camptocamp.com/


	Official module:

		yes


	Quality certified:

		yes






Description

Modify account analytic view to show
important data for project manager of services companies.
Add menu to show relevant information for each manager.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/account_analytic_analysis.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/account_analytic_analysis.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_analytic_analysis.zip]









Dependencies



	account

	hr_timesheet

	hr_timesheet_invoice

	project









Reports

None




Menus



	Project Management/Financial Project Management

	Project Management/Financial Project Management/Analytic Accounts

	Project Management/Financial Project Management/Invoicing

	Project Management/Financial Project Management/Analytic Accounts/My Accounts

	Project Management/Financial Project Management/Invoicing/All Uninvoiced Entries

	Project Management/Financial Project Management/Invoicing/My Uninvoiced Entries

	Project Management/Financial Project Management/Analytic Accounts/My Accounts/My Current Accounts

	Project Management/Financial Project Management/Analytic Accounts/My Accounts/My Pending Accounts

	Project Management/Financial Project Management/Analytic Accounts/New Analytic Account

	Project Management/Financial Project Management/Analytic Accounts/All Analytic Accounts

	Project Management/Financial Project Management/Invoicing/Overpassed Accounts

	Project Management/Financial Project Management/Analytic Accounts/All Analytic Accounts/Current Analytic Accounts

	Project Management/Financial Project Management/Analytic Accounts/All Analytic Accounts/Pending Analytic Accounts









Views



	* INHERIT account.analytic.account.tree (tree)

	* INHERIT account.analytic.account.tree (tree)

	account.analytic.account.simplified.tree (tree)









Objects


Object: Hours summary by user (account_analytic_analysis.summary.user)





	account_id:	Analytic Account, many2one, readonly









	unit_amount:	Total Time, float, readonly









	user:	User, many2one








Object: Hours summary by month (account_analytic_analysis.summary.month)





	account_id:	Analytic Account, many2one, readonly









	unit_amount:	Total Time, float, readonly









	month:	Month, char, readonly
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Account Analytic Default (account_analytic_default)





	Module:	account_analytic_default


	Name:	Account Analytic Default


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_analytic_default


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Allows to automatically select analytic accounts based on criterions:
* Product
* Partner
* User
* Company
* Date








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_analytic_default.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_analytic_default.zip]









Dependencies



	account

	sale









Reports

None




Menus



	Financial Management/Configuration/Analytic Accounting/Analytic Defaults









Views



	account.analytic.default.tree (tree)

	account.analytic.default.form (form)









Objects


Object: Analytic Distributions (account.analytic.default)





	date_stop:	End Date, date









	user_id:	User, many2one









	product_id:	Product, many2one









	sequence:	Sequence, integer









	date_start:	Start Date, date









	company_id:	Company, many2one









	analytic_id:	Analytic Account, many2one









	partner_id:	Partner, many2one
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Account Analytic Package - To configure Analytic Account for product packages (account_analytic_package)





	Module:	account_analytic_package


	Name:	Account Analytic Package - To configure Analytic Account for product packages


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_analytic_package


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

The Module allows to configure analytic account for product packages.
    Views for total and monthly product packages weight, Amount analysis.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_analytic_package.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_analytic_package.zip]









Dependencies



	account

	product

	crm









Reports

None




Menus



	Financial Management/Reporting/Packages

	Financial Management/Reporting/Packages/Service & Activity Units

	Financial Management/Reporting/Packages/Service & Activity Units/Service Units

	Financial Management/Reporting/Packages/Service & Activity Units/Activity Units

	Financial Management/Reporting/Packages/Monthly Services & Activity Units

	Financial Management/Reporting/Packages/Products Units









Views



	* INHERIT account.analytic.account.package.form (form)

	* INHERIT crm.case.section.package.form (form)

	* INHERIT product.normal.package.form (form)

	account.analytic.line.package.simplified.tree (tree)

	account.analytic.line.package.form (form)

	account.analytic.line.package.tree (tree)

	account.analytic.line.package.month.graph (graph)

	account.analytic.line.package.month.form (form)

	account.analytic.line.package.month.tree (tree)

	Products List (tree)









Objects


Object: account.analytic.line.package (account.analytic.line.package)





	account_id:	Account, many2one, readonly









	unit_weight:	Unit Weight, float, readonly









	name:	Name, char, readonly









	total_weight:	Total Weight, float, readonly









	unit_amount:	Quantity, float, readonly









	date:	Date, date, readonly









	partner_id:	Partner, many2one, readonly









	product_id:	Product, many2one, readonly








Object: account.analytic.line.package.month (account.analytic.line.package.month)





	product_id:	Product, many2one, readonly









	total_service:	Total Service, float, readonly









	total_activity:	Total Activity, float, readonly









	total_weight:	Total Weight, float, readonly









	partner_id:	Partner, many2one, readonly









	name:	Date, date, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multiple-plans management in Analytic Accounting (account_analytic_plans)





	Module:	account_analytic_plans


	Name:	Multiple-plans management in Analytic Accounting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_analytic_plans


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows to use several analytic plans, according to the general journal,
so that multiple analytic lines are created when the invoice or the entries
are confirmed.

For example, you can define the following analytic structure:
  Projects
      Project 1
          SubProj 1.1
          SubProj 1.2
      Project 2
  Salesman
      Eric
      Fabien

Here, we have two plans: Projects and Salesman. An invoice line must
be able to write analytic entries in the 2 plans: SubProj 1.1 and
Fabien. The amount can also be split. The following example is for
an invoice that touches the two subproject and assigned to one salesman:

Plan1:
    SubProject 1.1 : 50%
    SubProject 1.2 : 50%
Plan2:
    Eric: 100%

So when this line of invoice will be confirmed, it will generate 3 analytic lines,
for one account entry.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_analytic_plans.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_analytic_plans.zip]









Dependencies



	account

	account_analytic_default









Reports



	Crossovered Analytic









Menus



	Financial Management/Configuration/Analytic Accounting/Analytic Journal Definition/Analytic Distribution’s models

	Financial Management/Configuration/Analytic Accounting/Analytic Accounts/Analytic Plan









Views



	* INHERIT account.journal.form.inherit (form)

	* INHERIT account.move.form.inherit (form)

	* INHERIT account.move.line.form.inherit (form)

	* INHERIT account.invoice.line.form.inherit (form)

	* INHERIT account.invoice.supplier.form.inherit (form)

	account.analytic.plan.instance.form (form)

	account.analytic.plan.instance.tree (tree)

	account.analytic.plan.instance.line.form (form)

	account.analytic.plan.instance.line.tree (tree)

	account.analytic.plan.form (form)

	account.analytic.plan.tree (tree)

	account.analytic.plan.line.form (form)

	account.analytic.plan.line.tree (tree)

	* INHERIT account.analytic.default.form.plans (form)

	* INHERIT account.analytic.default.tree.plans (tree)









Objects


Object: Analytic Plans (account.analytic.plan)





	plan_ids:	Analytic Plans, one2many









	name:	Analytic Plan, char, required









	default_instance_id:

		Default Entries, many2one








Object: Analytic Plan Lines (account.analytic.plan.line)





	min_required:	Minimum Allowed (%), float









	plan_id:	Analytic Plan, many2one









	name:	Plan Name, char, required









	max_required:	Maximum Allowed (%), float









	sequence:	Sequence, integer









	root_analytic_id:

		Root Account, many2one, required






Root account of this plan.





Object: Analytic Plan Instance (account.analytic.plan.instance)





	account5_ids:	Account5 Id, one2many









	code:	Distribution Code, char









	plan_id:	Model’s Plan, many2one









	name:	Analytic Distribution, char









	account3_ids:	Account3 Id, one2many









	journal_id:	Analytic Journal, many2one, required









	account6_ids:	Account6 Id, one2many









	account_ids:	Account Id, one2many









	account4_ids:	Account4 Id, one2many









	account2_ids:	Account2 Id, one2many









	account1_ids:	Account1 Id, one2many








Object: Analytic Instance Line (account.analytic.plan.instance.line)





	analytic_account_id:

		Analytic Account, many2one, required









	rate:	Rate (%), float, required









	plan_id:	Plan Id, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account Analytic Progress - Define Progress bar for analytic accounts (account_analytic_progress)





	Module:	account_analytic_progress


	Name:	Account Analytic Progress - Define Progress bar for analytic accounts


	Version:	5.0.1.0


	Author:	tiny


	Directory:	account_analytic_progress


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Progress bar for analytic accounts.
This is the module used for displaying the shared funded
development projects on the Tiny ERP website.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_analytic_progress.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_analytic_progress.zip]









Dependencies



	account_analytic_analysis









Reports

None




Menus



	Financial Management/Reporting/Analytic/Remaining turnover by account









Views



	account.analytic.account.progress.view (graph)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Stock Accounting for Anglo Saxon countries (account_anglo_saxon)





	Module:	account_anglo_saxon


	Name:	Stock Accounting for Anglo Saxon countries


	Version:	5.0.1.2


	Author:	Tiny, Veritos


	Directory:	account_anglo_saxon


	Web:	http://tinyerp.com - http://veritos.nl


	Official module:

		no


	Quality certified:

		no






Description

This module will support the Anglo-Saxons accounting methodology by
    changing the accounting logic with stock transactions. The difference between the Anglo-Saxon accounting countries
    and the Rhine or also called Continental accounting countries is the moment of taking the Cost of Goods Sold versus Cost of Sales.
    Anglo-Saxons accounting does take the cost when sales invoice is created, Continental accounting will take the cost at he moment the goods are shipped.
    This module will add this functionality by using a interim account, to store the value of shipped goods and will contra book this interim account
    when the invoice is created to transfer this amount to the debtor or creditor account.
    Secondly, price differences between actual purchase price and fixed product standard price are booked on a separate account








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	product

	account

	sale

	purchase

	stock









Reports

None




Menus

None




Views



	* INHERIT product.normal.form.inherit.stock (form)

	* INHERIT product.template.product.form.inherit (form)

	* INHERIT product.category.property.form.inherit.stock (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Asset management (account_asset)





	Module:	account_asset


	Name:	Asset management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_asset


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Financial and accounting asset management.
    Allows to define
    * Asset category.
    * Assets.
    *Asset usage period and property.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_asset.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_asset.zip]









Dependencies



	account

	account_simulation









Reports

None




Menus



	Financial Management/Periodical Processing/Compute assets

	Financial Management/Configuration/Assets

	Financial Management/Configuration/Assets/Asset Category

	Financial Management/Configuration/Assets/Asset

	Financial Management/Assets

	Financial Management/Assets/Asset Hierarchy

	Financial Management/Assets/Assets

	Financial Management/Assets/Assets/Draft Assets

	Financial Management/Assets/Assets/Open Assets









Views



	account.asset.category.form (form)

	account.asset.category.tree (tree)

	account.asset.property.tree (tree)

	account.asset.asset.form (form)

	account.asset.property.history.form (form)

	account.asset.property.history.tree (tree)

	account.asset.board.form (form)

	account.asset.board.tree (tree)

	account.asset.asset.tree (tree)

	* INHERIT account.invoice.line.form (form)









Objects


Object: Asset category (account.asset.category)





	note:	Note, text









	code:	Asset code, char









	name:	Asset category, char, required








Object: Asset (account.asset.asset)





	property_ids:	Asset method name, one2many, readonly









	note:	Note, text









	code:	Asset code, char









	name:	Asset, char, required









	sequence:	Sequence, integer









	child_ids:	Childs asset, one2many









	entry_ids:	Entries, one2many, readonly









	localisation:	Localisation, char









	date:	Date, date, required









	state:	Global state, selection, required









	period_id:	Period, many2one, required, readonly









	parent_id:	Parent asset, many2one









	value_total:	Total value, float, readonly









	active:	Active, boolean









	category_id:	Asset category, many2one









	partner_id:	Partner, many2one








Object: Asset property (account.asset.property)





	asset_id:	Asset, many2one, required









	board_ids:	Asset board, one2many









	entry_asset_ids:

		Asset Entries, many2many









	history_ids:	History, one2many, readonly









	method_progress_factor:

		Progressif factor, float, readonly









	method_end:	Ending date, date









	account_asset_id:

		Asset account, many2one, required









	journal_id:	Journal, many2one, required









	method:	Computation method, selection, required, readonly









	journal_analytic_id:

		Analytic journal, many2one









	date:	Date created, date









	method_time:	Time method, selection, required, readonly









	state:	State, selection, required









	method_period:	Period per interval, integer, readonly









	value_residual:	Residual value, float, readonly









	value_total:	Gross value, float, readonly









	account_analytic_id:

		Analytic account, many2one









	account_actif_id:

		Depreciation account, many2one, required









	type:	Depr. method type, selection, required









	method_delay:	Number of interval, integer, readonly









	name:	Method name, char








Object: Asset history (account.asset.property.history)





	user_id:	User, many2one, required









	name:	History name, char









	method_end:	Ending date, date









	asset_property_id:

		Method, many2one, required









	note:	Note, text









	method_delay:	Number of interval, integer









	method_period:	Period per interval, integer









	date:	Date, date, required








Object: Asset board (account.asset.board)





	asset_id:	Asset, many2one, required









	value_gross:	Gross value, float, required









	value_asset_cumul:

		Cumul. value, float, required









	name:	Asset name, char, required









	value_asset:	Asset Value, float, required









	value_net:	Net value, float, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account balance reporting engine (account_balance_reporting)





	Module:	account_balance_reporting


	Name:	Account balance reporting engine


	Version:	5.0.0.1


	Author:	Pexego


	Directory:	account_balance_reporting


	Web:	http://www.pexego.es


	Official module:

		no


	Quality certified:

		no






Description

The module allows the user to create account balance reports and templates,
comparing the values of 'accounting concepts' between two fiscal years
or a set of fiscal periods.

Accounting concepts values can be calculated as the sum of some account balances,
the sum of its children, other account concepts or constant values.

Generated reports are stored as objects on the server,
so you can check them anytime later or edit them
(to add notes for example) before printing.

The module lets the user add new templates of the reports concepts,
and associate them a specific "XML reports" (OpenERP RML files for example)
with the design used when printing.
So it is very easy to add predefined country-specific official reports.

The user interface has been designed to be as much user-friendly as it can be.

Note: It has been designed to meet Spanish/Spain localization needs,
but it might be used as a generic accounting report engine.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	account









Reports



	Generic balance report

	Generic balance report (non zero lines)









Menus



	Financial Management/Legal Statements/Account balance reports

	Financial Management/Legal Statements/Account balance reports/Templates

	Financial Management/Legal Statements/Account balance reports/Reports









Views



	account.balance.report.template.form (form)

	account.balance.report.template.tree (tree)

	account.balance.report.template.line.form (form)

	account.balance.report.template.line.tree (tree)

	account.balance.report.form (form)

	account.balance.report.tree (tree)

	account.balance.report.line.form (form)

	account.balance.report.line.tree (tree)









Objects


Object: account.balance.report.template (account.balance.report.template)





	description:	Description, text









	balance_mode:	Balance mode, selection






Formula calculation mode: Depending on it, the balance is calculated as follows:
Mode 0: debit-credit (default);
Mode 1: debit-credit, credit-debit for accounts in brackets;
Mode 2: credit-debit;
Mode 3: credit-debit, debit-credit for accounts in brackets.






	report_xml_id:	Report design, many2one









	line_ids:	Lines, one2many









	type:	Type, selection









	name:	Name, char, required








Object: account.balance.report.template.line (account.balance.report.template.line)





	code:	Code, char, required






Concept code, may be used on formulas to reference this line






	name:	Name, char, required






Concept name/description






	sequence:	Sequence, char






Lines will be sorted/grouped by this field






	css_class:	CSS Class, selection






Style-sheet class






	child_ids:	Children, one2many









	negate:	Negate, boolean






Negate the value (change the sign of the balance)






	parent_id:	Parent, many2one









	current_value:	Fiscal year 1 formula, text






Value calculation formula: Depending on this formula the final value is calculated as follows:
Empy template value: sum of (this concept) children values.
Number with decimal point (“10.2”): that value (constant).
Account numbers separated by commas (“430,431,(437)”): Sum of the account balances
(the sign of the balance depends on the balance mode).
Concept codes separated by “+” (“11000+12000”): Sum of those concepts values.






	previous_value:	Fiscal year 2 formula, text






Value calculation formula: Depending on this formula the final value is calculated as follows:
Empy template value: sum of (this concept) children values.
Number with decimal point (“10.2”): that value (constant).
Account numbers separated by commas (“430,431,(437)”): Sum of the account balances
(the sign of the balance depends on the balance mode).
Concept codes separated by “+” (“11000+12000”): Sum of those concepts values.






	report_id:	Template, many2one








Object: account.balance.report (account.balance.report)





	name:	Name, char, required









	current_fiscalyear_id:

		Fiscal year 1, many2one, required









	company_id:	Company, many2one, required, readonly









	previous_fiscalyear_id:

		Fiscal year 2, many2one









	state:	State, selection









	current_period_ids:

		Fiscal year 1 periods, many2many









	previous_period_ids:

		Fiscal year 2 periods, many2many









	line_ids:	Lines, one2many









	calc_date:	Calculation date, datetime









	template_id:	Template, many2one, required








Object: account.balance.report.line (account.balance.report.line)





	code:	Code, char, required









	name:	Name, char, required









	sequence:	Sequence, char









	template_line_id:

		Line template, many2one









	notes:	Notes, text









	child_ids:	Children, one2many









	calc_date:	Calculation date, datetime









	parent_id:	Parent, many2one









	css_class:	CSS Class, selection









	current_value:	Fiscal year 1, float









	previous_value:	Fiscal year 2, float









	report_id:	Report, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Accounting and financial management-Compare Accounts (account_balance)





	Module:	account_balance


	Name:	Accounting and financial management-Compare Accounts


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	account_balance


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Account Balance Module is an added functionality to the Financial Management module.

    This module gives you the various options for printing balance sheet.

    1. You can compare the balance sheet for different years.

    2. You can set the cash or percentage comparison between two years.

    3. You can set the referential account for the percentage comparison for particular years.

    4. You can select periods as an actual date or periods as creation date.

    5. You have an option to print the desired report in Landscape format.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/account_balance.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/account_balance.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_balance.zip]









Dependencies



	account









Reports



	Account balance

	Account balance









Menus

None




Views

None




Objects

None
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Account Bankimport (account_bankimport)





	Module:	account_bankimport


	Name:	Account Bankimport


	Version:	0.0.1


	Author:	Tiny / Eddy Boer


	Directory:	account_bankimport


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_bankimport.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_bankimport.zip]









Dependencies



	base

	account

	account_report

	base_iban









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Accounting Base Properties (account_base)





	Module:	account_base


	Name:	Accounting Base Properties


	Version:	5.0.1.0


	Author:	Tiny & Axelor


	Directory:	account_base


	Web:	http://tinyerpindia.com


	Official module:

		no


	Quality certified:

		no






Description

Accounting Base Properties is providing the,
    Basic properties for the Customer / Suppliers for the Accounting
    i.e. PAN No, TIN No, Sales Tax No, and Exise related Information








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_base.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_base.zip]









Dependencies



	base

	account









Reports

None




Menus

None




Views



	* INHERIT account_base.partner.form (form)

	wizard.account.base.setup.form (form)









Objects


Object: wizard.account.base.setup (wizard.account.base.setup)





	pan_no:	PAN Number, char









	excise:	Exices Number, char









	vat_no:	VAT Number, char









	company_id:	Company, many2one, required









	range:	Range, char









	ser_tax:	Service Tax Number, char









	div:	Division, char









	partner_id:	Partner, many2one









	cst_no:	CST Number, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Import accounting entries from Bob (account_bob_import)





	Module:	account_bob_import


	Name:	Import accounting entries from Bob


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_bob_import


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module provide an easy way to migrate your financial data from Bob software to OpenERP. It includes the import of
            * chart of accounts,
            * financial journals,
            * customers, suppliers and prospects,
            * contacts,
            * accounting entries

        Once the module is installed, all you have to do is run the configuration wizard and provide OpenERP the location of the Bob directory where is your data.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_bob_import.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_bob_import.zip]









Dependencies



	base_contact

	account_l10nbe_domiciliation

	l10n_be









Reports

None




Menus

None




Views



	Configure BOB Import (form)

	Select Folder for BOB Import (form)









Objects


Object: config.bob.import (config.bob.import)





	path:	Path for BOB Folder, char






Supply a path that is a Bob Installation Folder.






	company_id:	Company, many2one, required









	zipped_file:	Upload a Zip File, binary






Upload a .zip file containing information of BOB Installation’






	location:	Location, selection, required






If this machine is the server, select ‘locally’ as the location. If this is the client machine, create a zip of the ‘Bob’ folder placed in Root(Drive Letter)://Program Files/Bob. Upload it and follow the further instructions.





Object: config.path.folder (config.path.folder)





	folder:	Folder, selection, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account Budget Project (account_budget_project)





	Module:	account_budget_project


	Name:	Account Budget Project


	Version:	5.0.0.0.1


	Author:	Tiny SPRL


	Directory:	account_budget_project


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module overrides the budget lines in the Analytic Account








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_budget_project.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_budget_project.zip]









Dependencies



	account_budget









Reports

None




Menus

None




Views



	* INHERIT account.analytic.account.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Budget Management (account_budget)





	Module:	account_budget


	Name:	Budget Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_budget


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows accountants to manage analytic and crossovered budgets.

Once the Master Budgets and the Budgets defined (in Financial
Management/Budgets/), the Project Managers can set the planned amount on each
Analytic Account.

The accountant has the possibility to see the total of amount planned for each
Budget and Master Budget in order to ensure the total planned is not
greater/lower than what he planned for this Budget/Master Budget. Each list of
record can also be switched to a graphical view of it.

Three reports are available:
    1. The first is available from a list of Budgets. It gives the spreading, for these Budgets, of the Analytic Accounts per Master Budgets.

    2. The second is a summary of the previous one, it only gives the spreading, for the selected Budgets, of the Analytic Accounts.

    3. The last one is available from the Analytic Chart of Accounts. It gives the spreading, for the selected Analytic Accounts, of the Master Budgets per Budgets.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_budget.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_budget.zip]









Dependencies



	account









Reports



	Print Budgets

	Print Budgets

	Print Budget









Menus



	Financial Management/Reporting/Budgets

	Financial Management/Budgets

	Financial Management/Budgets/Budgetary Positions

	Financial Management/Budgets/Budget

	Financial Management/Reporting/Budgets/Budget Lines









Views



	account.budget.post.tree (tree)

	account.budget.post.dotation.form (form)

	account.budget.post.dotation.tree (tree)

	account.budget.post.form.inherit (form)

	crossovered.budget.view.form (form)

	crossovered.budget.view.tree (tree)

	crossovered.budget.line.tree (tree)

	crossovered.budget.line.form (form)

	* INHERIT account.analytic.account.form.inherot.cci (form)









Objects


Object: Budgetary Position (account.budget.post)





	crossovered_budget_line:

		Budget Lines, one2many









	code:	Code, char, required









	dotation_ids:	Spreading, one2many









	name:	Name, char, required









	account_ids:	Accounts, many2many








Object: Budget Dotation (account.budget.post.dotation)





	post_id:	Item, many2one









	amount:	Amount, float









	period_id:	Period, many2one









	name:	Name, char









	tot_planned:	Total Planned Amount, float, readonly








Object: Budget (crossovered.budget)





	crossovered_budget_line:

		Budget Lines, one2many









	name:	Name, char, required









	date_from:	Start Date, date, required









	state:	Status, selection, required, readonly









	code:	Code, char, required









	validating_user_id:

		Validate User, many2one, readonly









	date_to:	End Date, date, required









	creating_user_id:

		Responsible User, many2one








Object: Budget Lines (crossovered.budget.lines)





	analytic_account_id:

		Analytic Account, many2one, required









	general_budget_id:

		Budgetary Position, many2one, required









	theoritical_amount:

		Theoritical Amount, float, readonly









	date_from:	Start Date, date, required









	planned_amount:	Planned Amount, float, required









	crossovered_budget_id:

		Budget, many2one, required









	paid_date:	Paid Date, date









	date_to:	End Date, date, required









	practical_amount:

		Practical Amount, float, readonly









	percentage:	Percentage, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Payment Term with Cash Discount (account_cash_discount)





	Module:	account_cash_discount


	Name:	Payment Term with Cash Discount


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_cash_discount


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds cash discounts on payment terms. Cash discounts
    for a payment term can be configured with:
        * A number of days,
        * A discount (%),
        * A debit and a credit account








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/account_cash_discount.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/account_cash_discount.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_cash_discount.zip]









Dependencies



	account









Reports

None




Menus

None




Views



	account.cash.discount.form (form)

	account.cash.discount.tree (tree)

	* INHERIT account.payment.term.form (form)









Objects


Object: Cash Discount (account.cash.discount)





	payment_id:	Associated Payment Term, many2one









	name:	Name, char









	credit_account_id:

		Credit Account, many2one









	delay:	Number of Days, integer, required









	discount:	Discount (%), float, required









	debit_account_id:

		Debit Account, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Charts of Accounts (account_chart)





	Module:	account_chart


	Name:	Charts of Accounts


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	account_chart


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Remove minimal account chart








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/account_chart.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/account_chart.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_chart.zip]









Dependencies



	account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Update account chart from template (account_chart_update)





	Module:	account_chart_update


	Name:	Update account chart from template


	Version:	5.0.1.0


	Author:	Zikzakmedia SL


	Directory:	account_chart_update


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Adds a wizard to update a company account chart from a template:
  * Generates the new accounts from the template and assigns them to the right company
  * Generates the new taxes and tax codes, changing account assignations
  * Generates the new fiscal positions, changing account and taxes assignations

Before creating the new accounts, taxes, tax codes and fiscal positions, the user can select
which ones must be created.

The user can also choose to update the existing accounts, taxes, tax codes and fiscal positions
from a template.

The problems occurred during the creation/updating of the account chart are shown in the last step.

It is useful when the account law has changed and you want to transfer the new accounts, taxes and
fiscal positions included in the account chart template to an existing company account chart.

Note: Due to the memory limitation of the osv_memory OpenERP objects, only a maximum number of
objects can be created each time. If a lot of new accounts, taxes, tax codes or fiscal positions
must be created, the wizard should be run several times.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	account









Reports

None




Menus



	Financial Management/Configuration/Financial Accounting/Templates/Update Chart of Accounts from a Chart Template









Views



	Update Chart of Accounts from a Chart Template (form)









Objects


Object: wizard.update.charts.accounts (wizard.update.charts.accounts)





	update_tax_code:

		Update tax codes, boolean






Existing tax codes are updated. Tax codes are searched by name.






	code_digits:	# of Digits, integer, required






No. of Digits to use for account code. Make sure it is the same number as existing accounts.






	fiscal_position_ids:

		Fiscal positions, one2many









	logs:	Logs, text, readonly









	new_fp:	Create - Fiscal positions, integer, readonly









	chart_template_id:

		Chart Template, many2one, required









	company_id:	Company, many2one, required









	tax_code_ids:	Tax codes, one2many









	update_account:	Update accounts, boolean






Existing accounts are updated. Accounts are searched by code.






	update_fiscal_position:

		Update fiscal positions, boolean






Existing fiscal positions are updated. Fiscal positions are searched by name.






	state:	Status, selection, readonly









	update_tax:	Update taxes, boolean






Existing taxes are updated. Taxes are searched by name.






	updated_tax:	Update - Taxes, integer, readonly









	account_ids:	Accounts, one2many









	new_account:	Create - Accounts, integer, readonly









	updated_fp:	Update - Fiscal positions, integer, readonly









	updated_tax_code:

		Update - Tax codes, integer, readonly









	updated_account:

		Update - Accounts, integer, readonly









	new_tax_code:	Create - Tax codes, integer, readonly









	new_tax:	Create - Taxes, integer, readonly









	tax_ids:	Taxes, one2many








Object: wizard.update.charts.accounts.tax.code (wizard.update.charts.accounts.tax.code)





	tax_code_id:	Tax codes, many2one, required









	update_chart_wizard_id:

		Update chart wizard, many2one, required








Object: wizard.update.charts.accounts.tax (wizard.update.charts.accounts.tax)





	update_chart_wizard_id:

		Update chart wizard, many2one, required









	tax_id:	Taxes, many2one, required








Object: wizard.update.charts.accounts.account (wizard.update.charts.accounts.account)





	update_chart_wizard_id:

		Update chart wizard, many2one, required









	account_id:	Accounts, many2one, required








Object: wizard.update.charts.accounts.fiscal.position (wizard.update.charts.accounts.fiscal.position)





	update_chart_wizard_id:

		Update chart wizard, many2one, required









	fiscal_position_id:

		Fiscal positions, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account CODA Version 2.1 D - Helps to import bank statements from .csv file. (account_coda_2_1_d)





	Module:	account_coda_2_1_d


	Name:	Account CODA Version 2.1 D - Helps to import bank statements from .csv file.


	Version:	5.0.1.0.1


	Author:	OpenERP


	Directory:	account_coda_2_1_d


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module provides functionality to import
    bank statements from .csv file.
    Import coda file wizard is used to import bank statements.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_coda_2_1_d.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_coda_2_1_d.zip]









Dependencies



	base

	account

	account_report

	base_iban









Reports

None




Menus



	Financial Management/Reporting/Coda Statements

	Financial Management/Periodical Processing/Import Coda Statements









Views



	account.coda.form (form)

	account.coda.tree (tree)









Objects


Object: CODA Format For Account (account.coda)





	user_id:	User, many2one, readonly









	name:	Coda File, binary, readonly









	journal_id:	Bank Journal, many2one, readonly









	note:	Import Log, text, readonly









	date:	Import Date, date, readonly









	statement_id:	Generated Bank Statement, many2one, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account CODA - To import bank statements from .csv file (account_coda)





	Module:	account_coda


	Name:	Account CODA - To import bank statements from .csv file


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_coda


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module provides functionality to import
    bank statements from .csv file.
    Import coda file wizard is used to import bank statements.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_coda.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_coda.zip]









Dependencies



	base

	account

	account_report

	base_iban









Reports

None




Menus



	Financial Management/Reporting/Coda Statements

	Financial Management/Periodical Processing/Import Coda Statements









Views



	account.coda.form (form)

	account.coda.tree (tree)









Objects


Object: coda for an Account (account.coda)





	user_id:	User, many2one, readonly









	name:	Coda file, binary, readonly









	journal_id:	Bank Journal, many2one, readonly









	note:	Import log, text, readonly









	date:	Import Date, date, readonly









	statement_id:	Generated Bank Statement, many2one, readonly













          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account Date check (account_date_check)





	Module:	account_date_check


	Name:	Account Date check


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_date_check


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

* Adds a field on journals: "Allows date not in the period"
    * By default, this field is checked.

If this field is not checked, the system control that the date is in the
period when you create an account entry. Otherwise, it generates an
error message: "The date of your account move is not in the defined
period !"








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_date_check.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_date_check.zip]









Dependencies



	account









Reports

None




Menus

None




Views



	* INHERIT account.journal.form.inherit2 (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Common financial reports (account_financial_report)





	Module:	account_financial_report


	Name:	Common financial reports


	Version:	5.0.1.0


	Author:	Zikzakmedia SL


	Directory:	account_financial_report


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Add some common financial/accounting reports and some wizards to quickly compute them:
  * Account chart list
  * Invoice list
  * Account move (journal ledger)
  * Account move line
  * Account balance compared period-fiscal year
  * Cumulative general ledger

They can be found in the "Financial Management/Legal Statements/Generic Reports" menu or in the tree/form views of accounts, journals, invoices, account entries and account move lines.

Some reports are based on previous work by Pexego and others on the c2c_finance_report module for TinyERP 4.2 by Camptocamp SA.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	account









Reports



	Full account balance

	Cumulative general ledger

	Cumulative general ledger landscape

	Chart of accounts

	Invoice list

	Entry lines

	Entry

	Entry landscape

	Print journal by entries

	Print journal by entries landscape









Menus



	Financial Management/Legal Statements/Generic Reports/Print journal by entries

	Financial Management/Legal Statements/Generic Reports/Full account balance

	Financial Management/Legal Statements/Generic Reports/Cumulative general ledger

	Financial Management/Legal Statements/Generic Reports/Chart of accounts

	Financial Management/Legal Statements/Generic Reports/Print invoice list









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Accounting follow-ups management (account_followup)





	Module:	account_followup


	Name:	Accounting follow-ups management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_followup


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Modules to automate letters for unpaid invoices, with multi-level recalls.

    You can define your multiple levels of recall through the menu:
        Financial Management/Configuration/Payment Terms/Follow-Ups

    Once it's defined, you can automatically prints recall every days
    through simply clicking on the menu:
        Financial_Management/Periodical_Processing/Print_Follow-Ups

    It will generate a PDF with all the letters according to the
    different levels of recall defined. You can define different policies
    for different companies.


    Note that if you want to change the followup level for a given partner/account entry, you can do it in the menu:
        Financial_Management/Reporting/Follow-Ups/All Receivable Entries








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/account_followup.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/account_followup.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_followup.zip]









Dependencies



	account









Reports



	Followup Report









Menus



	Financial Management/Periodical Processing/Send followups

	Financial Management/Reporting/Follow-Ups

	Financial Management/Configuration/Follow-Ups

	Financial Management/Reporting/Follow-Ups/All receivable entries

	Financial Management/Reporting/Follow-Ups/All payable entries









Views



	account_followup.stat.form (form)

	account_followup.stat.tree (tree)

	account_followup.followup.line.tree (tree)

	account_followup.followup.line.form (form)

	account_followup.followup.form (form)

	account_followup.followup.tree (tree)

	account.move.line.partner.tree (tree)

	* INHERIT account.move.line.form.followup (form)

	* INHERIT account.move.line.tree.followup (form)

	* INHERIT res.company.followup.form.inherit (form)









Objects


Object: Follow-Ups (account_followup.followup)





	followup_line:	Follow-Up, one2many









	description:	Description, text









	name:	Name, char, required









	company_id:	Company, many2one








Object: Follow-Ups Criteria (account_followup.followup.line)





	description:	Printed Message, text









	sequence:	Sequence, integer









	delay:	Days of delay, integer









	start:	Type of Term, selection, required









	followup_id:	Follow Ups, many2one, required









	name:	Name, char, required








Object: Followup statistics (account_followup.stat)





	balance:	Balance, float, readonly









	account_type:	Account Type, selection, readonly









	name:	Partner, many2one, readonly









	date_move:	First move, date, readonly









	credit:	Credit, float, readonly









	date_move_last:	Last move, date, readonly









	date_followup:	Latest followup, date, readonly









	debit:	Debit, float, readonly









	followup_id:	Follow Ups, many2one, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Make Account invoice analytic account required in sale.invoice.line. (account_invoice_analytic_required)





	Module:	account_invoice_analytic_required


	Name:	Make Account invoice analytic account required in sale.invoice.line.


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_invoice_analytic_required


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Module to make analytic account field required in sale.invoice.line.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_invoice_analytic_required.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_invoice_analytic_required.zip]









Dependencies



	account

	base









Reports

None




Menus

None




Views

None




Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Accounting Base Configuration and Properties (account_invoice_india)





	Module:	account_invoice_india


	Name:	Accounting Base Configuration and Properties


	Version:	5.0.1.0


	Author:	Tiny & Axelor


	Directory:	account_invoice_india


	Web:	http://tinyerpindia.com


	Official module:

		no


	Quality certified:

		no






Description

Accounting Base Properties Reports and Wizards,
    Basic properties for the Customer / Suppliers for the Accounting
    Wizards that allow creation of Party Accounts,
    Reports that provides Indian Accounting Reports for Invoice








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_invoice_india.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_invoice_india.zip]









Dependencies



	account_base

	account









Reports



	Invoice - Exice

	Partner ledger

	Custom Journal Print

	Custom General Ledger

	Partner balance









Menus



	Financial Management/Legal Statements/Miscellaneous Reports

	Financial Management/Legal Statements/Miscellaneous Reports/Aged Partner Balance

	Financial Management/Legal Statements/Miscellaneous Reports/Partner Balance

	Financial Management/Legal Statements/Miscellaneous Reports/Periodical Charts of Accounts

	Financial Management/Legal Statements/Miscellaneous Reports/Partner wise Ledger









Views



	* INHERIT voucher.account.invoice.form (form)

	* INHERIT voucher.account.invoice.form (form)

	* INHERIT voucher.account.invoice.form (form)

	* INHERIT voucher.account.invoice.form (form)

	* INHERIT voucher.account.invoice.form (form)

	* INHERIT voucher.account.invoice.line.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







account_invoice_layout (account_invoice_layout)





	Module:	account_invoice_layout


	Name:	account_invoice_layout


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_invoice_layout


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module provides some features to improve the layout of the invoices.

    It gives you the possibility to
        * order all the lines of an invoice
        * add titles, comment lines, sub total lines
        * draw horizontal lines and put page breaks

    Moreover, there is one option which allow you to print all the selected invoices with a given special message at the bottom of it. This feature can be very useful for printing your invoices with end-of-year wishes, special punctual conditions...








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_invoice_layout.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_invoice_layout.zip]









Dependencies



	base

	account









Reports



	Invoices with Layout









Menus



	Financial Management/Configuration/Notification Message

	Financial Management/Configuration/Notification Message/All Notification Messages









Views



	* INHERIT account.invoice.line.form.inherit_1 (form)

	* INHERIT account.invoice.line.tree.inherit_1 (tree)

	* INHERIT account.invoice.line.tree.inherit_2 (tree)

	* INHERIT account.invoice.form.inherit_1 (form)

	notify.message.tree (tree)

	notify.message.form (form)









Objects


Object: Notify By Messages (notify.message)





	msg:	Special Message, text, required






This notification will appear at the bottom of the Invoices when printed.






	name:	Title, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Allow to change definition of the name field of invoice (account_invoice_number)





	Module:	account_invoice_number


	Name:	Allow to change definition of the name field of invoice


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_invoice_number


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Module to change definition of the name field of invoice
    using this module you can change the invoice number when it is in draft state.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_invoice_number.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_invoice_number.zip]









Dependencies



	account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Invoice with payment term lines (account_invoice_payment_term)





	Module:	account_invoice_payment_term


	Name:	Invoice with payment term lines


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	account_invoice_payment_term


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module to Add payment term lines on invoice report.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_invoice_payment_term.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_invoice_payment_term.zip]









Dependencies



	account









Reports

None




Menus

None




Views

None




Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







India Accounting (account_invoice)





	Module:	account_invoice


	Name:	India Accounting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_invoice


	Web:	http://tinyerp.com


	Official module:

		no


	Quality certified:

		no






Description

India Accounting module includes all the basic requirements of
    Basic Accounting, plus new things which available are
    * Indian Account Chart
    * New Invoice - (Local, Retail)
    * Invoice Report
    * Tax structure
    * Journals
    * VAT Declaration report
    * Accounting Periods








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	account

	account_base









Reports

None




Menus

None




Views



	* INHERIT voucher.account.invoice.form (form)

	* INHERIT voucher.account.invoice.form (form)

	* INHERIT voucher.account.invoice.form (form)

	* INHERIT voucher.account.invoice.form (form)

	* INHERIT voucher.account.invoice.form (form)

	* INHERIT voucher.account.invoice.line.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Salesman on invoices (account_invoice_salesman)





	Module:	account_invoice_salesman


	Name:	Salesman on invoices


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_invoice_salesman


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds a salesman on each invoice.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_invoice_salesman.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_invoice_salesman.zip]









Dependencies



	account









Reports

None




Menus

None




Views



	* INHERIT account.invoice.supplier_salesman.form (form)

	* INHERIT account.invoice.salesman.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Accounting journal visibility (account_journal_visibility)





	Module:	account_journal_visibility


	Name:	Accounting journal visibility


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_journal_visibility


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Using this module :
    when we open the journals list, people will only see journal for which they are allowed
    (means their group is specified on the journal definition). and also
    Only people in the group defined on the journal will be able to see the invoices of this journal.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_journal_visibility.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_journal_visibility.zip]









Dependencies



	account









Reports

None




Menus

None




Views



	* INHERIT account.journal.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account l10nbe Domiciliation (account_l10nbe_domiciliation)





	Module:	account_l10nbe_domiciliation


	Name:	Account l10nbe Domiciliation


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_l10nbe_domiciliation


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Related with l10n_be module.
        Adds Domiciled and Domiciled send date fields on invoice.
        Domiciliation and Domiciliation Number fields on partner.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_l10nbe_domiciliation.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_l10nbe_domiciliation.zip]









Dependencies



	base

	account









Reports

None




Menus

None




Views



	* INHERIT account.invoice.domicile.form (form)

	* INHERIT supplier.invoice.domicile.form (form)

	* INHERIT res.partner.domicile.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account For Multicompany (account_multicompany)





	Module:	account_multicompany


	Name:	Account For Multicompany


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	account_multicompany


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Multicompany Report








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	account









Reports

None




Menus



	Financial Management/Reporting/Account Detail (Group By Company)









Views



	* INHERIT account.move.line.form.inherit (form)

	* INHERIT account.move.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Import ePassporte Payments (account_payment_epassporte)





	Module:	account_payment_epassporte


	Name:	Import ePassporte Payments


	Version:	5.0.1.0


	Author:	Zikzakmedia


	Directory:	account_payment_epassporte


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Import ePassporte Payments from a CSV file.

Adds a wizard in bank statements to select a CSV file with ePassporte payments lines like this:

"Transaction Date","Posted Date","Description","Amount in USD","Balance"
3/27/2009,3/27/2009,"b2p Fee",-2.00,17816.06
3/27/2009,3/27/2009,"b2p particularaccount",-11.17,17818.06
3/23/2009,3/24/2009,"b2b Fee",-2.00,17829.23
3/23/2009,3/24/2009,"b2b businessaccount",-111.51,17831.23

Checks if the bank statement currency and ePassporte file currency (USD in the example) are the same.
Tries to fill the partner information from the ePassporte account (businessaccount and particularaccount in the example). This ePassporte account is searched in the partner bank account field (the bank name of ePassporte accounts must be 'EPASSPORTE').
If the 'Search invoice to reconcile' option is checked, tries to reconcile with an open invoice with the same partner, same amount+-accuracy, same date+-accuracy and payment type 'EPASSPORTE'.

First we must define an ePassporte importation configuration:
    * The account for the ePassporte fees.
    * If you want to insert the ePassporte transactions in the bank statement or only show the warning or error messages.
    * If you want to reconcile with open invoices (giving an amount and date accuracy to search the invoices).








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	account

	account_payment_extension









Reports

None




Menus



	Financial Management/Configuration/Epassporte Payment Import Configuration









Views



	account.payment.epassporte.import.config (tree)

	account.payment.epassporte.import.config (form)









Objects


Object: Epassporte payments Configuration (account.payment.epassporte.import.config)





	name:	Name, char









	activate_insert:

		Active Insert, boolean






Check this box if you want to insert the ePassporte transactions in the bank statement. If not, it only shows the warning or error messages.






	account_expenditure_id:

		Payment fee account, many2one, required






Account for the ePassporte fees.






	invoice_date_accuracy:

		Invoice date accuracy, integer






Payment date accuracy (number of days) on searching an invoice to reconcile.






	active:	Active, boolean









	invoice_reconcile:

		Search invoice to reconcile, boolean






Check this box when you want to find an open invoice to reconcile with same partner, same amount+-accuracy, same date+-accuracy and payment type ‘EPASSPORTE’.






	invoice_amount_accuracy:

		Invoice amount accuracy (%), float






Payment amount accuracy (% ratio between 0-1) on searching an invoice to reconcile.
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Payment Order Export (account_payment_export)





	Module:	account_payment_export


	Name:	Payment Order Export


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_payment_export


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module allows to export payment orders.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_payment_export.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_payment_export.zip]









Dependencies



	base_vat

	base_iban

	account_payment









Reports

None




Menus



	Financial Management/Configuration/Payment Export

	Financial Management/Configuration/Payment Export/Payment Export Logs

	Financial Management/Configuration/Payment/Payment Method

	Financial Management/Configuration/Payment/Charges Code









Views



	* INHERIT res.partner.form.code.inherit (form)

	* INHERIT res.partner.bank.form.code.inherit (form)

	account.pay.tree (tree)

	account.pay.form (form)

	* INHERIT res.bank.form.inherit (form)

	payment.method.tree (tree)

	payment.method.form (form)

	charges.code.tree (tree)

	charges.code.form (form)









Objects


Object: Payment Export History (account.pay)





	create_uid:	Creation User, many2one, required, readonly









	create_date:	Creation Date, datetime, required, readonly









	note:	Creation Log, text, readonly









	payment_order_id:

		Payment Order Reference, many2one, readonly









	state:	Status, selection, readonly









	file:	Saved File, binary, readonly








Object: Payment Method For Export (payment.method)





	name:	Code, char, required









	description:	Description, text








Object: Charges Codes For Export (charges.code)





	name:	Code, char, required









	description:	Description, text
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account Payment Extension (account_payment_extension)





	Module:	account_payment_extension


	Name:	Account Payment Extension


	Version:	5.0.1.1


	Author:	Zikzakmedia SL


	Directory:	account_payment_extension


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Account payment extension.

This module extends the account_payment module with a lot of features:
    * Extension of payment types: The payment type has a translated name and note that can be shown in the invoices.
    * Two default payment types for partners (client and supplier).
    * Automatic selection of payment type in invoices. Now an invoice can have a payment term (30 days, 30/60 days, ...) and a payment type (cash, bank transfer, ...).
    * A default check field in partner bank accounts. The default partner bank accounts are selected in invoices and payments.
    * New menu/tree/forms to see payments to receive and payments to pay.
    * The payments show tree editable fields: Due date, bank account and a check field (for example to write down if a bank check in paper support has been received).
    * Two types of payment orders: Payable payment orders (from supplier invoices) and receivable payment orders (from client invoices). So we can make payment orders to receive the payments of our client invoices. Each payment order type has its own sequence.
    * The payment orders allow negative payment amounts. So we can have payment orders for supplier invoices (pay money) and refund supplier invoices (return or receive money). Or for client invoices (receive money) and refund client invoices (return or pay money).
    * Payment orders: Selected invoices are filtered by payment type, the second message communication can be set at the same time for several invoices.
Based on previous work of Pablo Rocandio & Zikzakmedia (version for 4.2).








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_payment_extension.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_payment_extension.zip]









Dependencies



	base

	account

	account_payment









Reports

None




Menus



	Financial Management/Configuration/Payment/Payment Type

	Financial Management/Payment/Payable payment orders

	Financial Management/Payment/Payable payment orders/Pay. payment order

	Financial Management/Payment/Payable payment orders/Pay. payment order/Draft pay. payment order

	Financial Management/Payment/Payable payment orders/Pay. payment order/Pay. payment orders to validate

	Financial Management/Payment/Payable payment orders/New Pay. payment Order

	Financial Management/Payment/Receivable payment orders

	Financial Management/Payment/Receivable payment orders/Rec. payment order

	Financial Management/Payment/Receivable payment orders/Rec. payment order/Draft rec. payment order

	Financial Management/Payment/Receivable payment orders/Rec. payment order/Rec. payment orders to validate

	Financial Management/Payment/Receivable payment orders/New rec. payment order

	Financial Management/Payment/Invoice payments

	Financial Management/Payment/Invoice payments/Invoice payments to receive

	Financial Management/Payment/Invoice payments/All received and to receive invoice payments

	Financial Management/Payment/Invoice payments/Invoice payments to pay

	Financial Management/Payment/Invoice payments/All paid and to pay invoice payments

	Financial Management/Payment/Done payments

	Financial Management/Payment/Done payments/Done receivable payments unreconciled

	Financial Management/Payment/Done payments/All done receivable payments

	Financial Management/Payment/Done payments/Done payable payments unreconciled

	Financial Management/Payment/Done payments/All done payable payments









Views



	* INHERIT  (form)

	* INHERIT  (form)

	* INHERIT view.partner.form3  (form)

	* INHERIT view.partner.bank.tree  (form)

	* INHERIT res.partner.form.payment_type1 (form)

	* INHERIT res.partner.form.payment_type2 (form)

	payment.type.tree (tree)

	* INHERIT payment.type.form_ext (form)

	* INHERIT account.invoice.form3.payment_type (form)

	* INHERIT account.invoice.form4.payment_type (form)

	* INHERIT account.invoice.supplier.form2 (form)

	* INHERIT account.payments.move.line.tree (tree)

	* INHERIT account.payments.move.line.form (form)

	* INHERIT account.bank.statement.form.ext (form)

	* INHERIT payment.order.form.ext1 (form)

	* INHERIT payment.order.form.ext2 (form)

	* INHERIT payment.line.ext1 (form)

	Payments (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Import Paypal Payments (account_payment_paypal)





	Module:	account_payment_paypal


	Name:	Import Paypal Payments


	Version:	5.0.1.0


	Author:	Zikzakmedia


	Directory:	account_payment_paypal


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Import Paypal Payments from a CSV file.

Adds a wizard in bank statements to select a CSV file with Paypal payments lines like this:

Date, Time, Time Zone, Name, Type, Status, Currency, Gross, Fee, Net, From Email Address, To Email Address, Transaction ID, Counterparty Status, Address Status, Item Title, Item ID, Shipping and Handling Amount, Insurance Amount, Sales Tax, Option 1 Name, Option 1 Value, Option 2 Name, Option 2 Value, Auction Site, Buyer ID, Item URL, Closing Date, Escrow Id, Invoice Id, Reference Txn ID, Invoice Number, Custom Number, Receipt ID, Balance, Address Line 1, Address Line 2/District, Town/City, State/Province/Region/County/Territory/Prefecture/Republic, Zip/Postal Code, Country, Contact Phone Number,
"25/03/2009", "23:45:35", "GMT+02:00", "Computer Company", "Web Accept Payment Received", "Completed", "EUR", "20,00", "-0,89","19,11", "from1@email.com", "to@email.com","0LN645674B531493M","Non-U.S. - Verified", "Non-U.S.","Item1 title", "1", "0,00","","0,00","usr", "45678","","","","","","","","","","","","","1.315,74", "address1","","city1","state1", "zip1","country1","",
"28/03/2009","21:58:54","GMT+02:00", "John Smith", "Web Accept Payment Received", "Completed", "USD","20,00","-0,94","19,06", "from2@email.com", "to@email.com", "6V823569E37342433", "Verified","Confirmed","Item 2 title","1", "0,00","","0,00","usr", "34567","","","", "","","","","","","","","", "20.979,99", "address2","", "city2","state2","zip2","country2","",

These fields are optional: Address Line 1, Address Line 2/District, Town/City, State/Province/Region/County/Territory/Prefecture/Republic, Zip/Postal Code, Country, Contact Phone Number.

Only the Paypal payment lines with the same currency as the bank statement are imported. And if 'Status completed' option is checked, only the Paypal payment lines with status field = 'Completed' are imported.

Paypal transactions are classified as:
    * customer: 'Type' in ['Web Accept Payment Received', 'Payment Received', 'Subscription Payment Received', 'Refund']
    * supplier: 'Type' in ['Credit']
    * general: Other cases, 'Type' in ['Transfer', 'Chargeback Settlement', ...]

Tries to fill the partner and invoice to conciliate from the Paypal transaction ID. If not, try to find the partner with the from (customer) or to (supplier) email addresses (from1@email.com or to@email.com in the example) and, if the 'Search invoice to reconcile' option is checked, try to conciliate it with an open invoice with the same partner, same amount+-accuracy, same date+-accuracy and payment type 'PAYPAL'.

The from/to Paypal email address (it can be considered as a Paypal account) is searched in the partner bank account field (the bank name of Paypal accounts must be 'PAYPAL').

First we must define a Paypal importation configuration:
    * The account for the Paypal fees.
    * If you want to insert the Paypal transactions in the bank statement or only show the warning or error messages.
    * If you want to reconcile with open invoices (giving an amount and date accuracy to search the invoices).








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	account

	account_payment_extension









Reports

None




Menus



	Financial Management/Configuration/Paypal Payment Import Configuration









Views



	account.payment.paypal.import.config (tree)

	account.payment.paypal.import.config (form)









Objects


Object: Paypal payments Configuration (account.payment.paypal.import.config)





	status_completed:

		Status completed, boolean






Check this box if you want to process only the Paypal transactions with the status field = ‘Completed’.






	name:	Name, char









	activate_insert:

		Active Insert, boolean






Check this box if you want to insert the Paypal transactions in the bank statement. If not, it only shows the warning or error messages.






	account_expenditure_id:

		Payment fee account, many2one, required






Account for the Paypal fees.






	invoice_date_accuracy:

		Invoice date accuracy, integer






Payment date accuracy (number of days) on searching an invoice to reconcile.






	active:	Active, boolean









	invoice_reconcile:

		Search invoice to reconcile, boolean






Check this box when, if an invoice to reconcile have not found by the Paypal transaction ID, you want to find an open invoice with same partner, same amount+-accuracy, same date+-accuracy and payment type ‘PAYPAL’.






	invoice_amount_accuracy:

		Invoice amount accuracy (%), float






Payment amount accuracy (% ratio between 0-1) on searching an invoice to reconcile.
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Payment Management (account_payment)





	Module:	account_payment


	Name:	Payment Management


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	account_payment


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module provide :
    * a more efficient way to manage invoice payment.
    * a basic mechanism to easily plug various automated payment.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/account_payment.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/account_payment.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_payment.zip]









Dependencies



	account









Reports



	Payment Order









Menus



	Financial Management/Payment

	Financial Management/Configuration/Payment

	Financial Management/Configuration/Payment/Payment Mode

	Financial Management/Payment/Payment Orders

	Financial Management/Payment/Payment Orders/Draft Payment Order

	Financial Management/Payment/Payment Orders/Payment Orders to Validate

	Financial Management/Payment/Payment Orders/New Payment Order









Views



	* INHERIT account.move.line.form.inherit (form)

	account.move.line.tree (tree)

	payment.type.form (form)

	payment.mode.tree (tree)

	payment.mode.form (form)

	payment.order.form (form)

	payment.order.tree (tree)

	Payment Line (form)

	Payment Lines (tree)

	* INHERIT account.bank.statement.form.inherit (form)

	* INHERIT account.invoice.supplier.form.inherit (form)









Objects


Object: Payment type (payment.type)





	suitable_bank_types:

		Suitable bank types, many2many









	code:	Code, char, required






Specify the Code for Payment Type






	name:	Name, char, required






Payment Type





Object: Payment mode (payment.mode)





	journal:	Journal, many2one, required






Cash Journal for the Payment Mode






	type:	Payment type, many2one, required






Select the Payment Type for the Payment Mode.






	name:	Name, char, required






Mode of Payment






	bank_id:	Bank account, many2one, required






Bank Account for the Payment Mode





Object: Payment Order (payment.order)





	date_prefered:	Preferred date, selection, required






Choose an option for the Payment Order:’Fixed’ stands for a date specified by you.’Directly’ stands for the direct execution.’Due date’ stands for the scheduled date of execution.






	user_id:	User, many2one, required









	date_done:	Execution date, date, readonly









	reference:	Reference, char, required









	date_planned:	Scheduled date if fixed, date






Select a date if you have chosen Preferred Date to be fixed.






	state:	State, selection









	mode:	Payment mode, many2one, required






Select the Payment Mode to be applied.






	date_created:	Creation date, date, readonly









	line_ids:	Payment lines, one2many









	total:	Total, float, readonly








Object: Payment Line (payment.line)





	company_currency:

		Company Currency, many2one, readonly









	ml_inv_ref:	Invoice Ref., many2one, readonly









	create_date:	Created, datetime, readonly









	name:	Your Reference, char, required









	state:	Communication Type, selection, required









	order_id:	Order, many2one, required









	communication:	Communication, char, required






Used as the message between ordering customer and current company. Depicts ‘What do you want to say to the recipient about this order ?’






	bank_id:	Destination Bank account, many2one









	communication2:	Communication 2, char






The successor message of Communication.






	currency:	Partner Currency, many2one, required









	amount:	Amount in Company Currency, float, readonly






Payment amount in the company currency






	info_partner:	Destination Account, text, readonly






Address of the Ordering Customer.






	date:	Payment Date, date






If no payment date is specified, the bank will treat this payment line directly






	ml_date_created:

		Effective Date, date, readonly






Invoice Effective Date






	move_line_id:	Entry line, many2one






This Entry Line will be referred for the information of the ordering customer.






	info_owner:	Owner Account, text, readonly






Address of the Main Partner






	amount_currency:

		Amount in Partner Currency, float, required






Payment amount in the partner currency






	partner_id:	Partner, many2one, required






The Ordering Customer






	ml_maturity_date:

		Maturity Date, date, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account Regularizations (account_regularization)





	Module:	account_regularization


	Name:	Account Regularizations


	Version:	5.0.1.0


	Author:	ACYSOS S.L.


	Directory:	account_regularization


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module creates a new object in accounting,
      very similar to the account models named account.regularization.
      Within this object you can define regularization moves,
      This is, accounting moves that will automatically calculate the balance of a set of accounts,
      Set it to 0 and transfer the difference to a new account. This is used, for example with tax declarations or in some countries to create the 'Profit and Loss' regularization








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/account_regularization.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/account_regularization.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_regularization.zip]









Dependencies



	account









Reports

None




Menus



	Financial Management/Periodical Processing/Regularizations









Views



	account.regularization.form (form)









Objects


Object: Account Regularization Model (account.regularization)





	balance_calc:	Regularization time calculation, selection, required









	name:	Name, char, required









	credit_account_id:

		Result account, credit, many2one, required









	move_ids:	Regularization Moves, one2many









	account_ids:	Accounts to balance, many2many, required









	debit_account_id:

		Result account, debit, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account renumber wizard (account_renumber)





	Module:	account_renumber


	Name:	Account renumber wizard


	Version:	5.0.0.1


	Author:	Pexego


	Directory:	account_renumber


	Web:	http://www.pexego.es


	Official module:

		no


	Quality certified:

		no






Description

This module adds a wizard to renumber account moves by date.

The wizard, that will be added to the "End of Year Treatments",
let's you select one or more journals and fiscal periods,
set a starting number; and then renumber all the posted moves
from those journals and periods sorted by date.

It will recreate the sequence number of each account move using their journal sequence so:
    - Sequences per journal are supported.
    - Sequences with prefixes and suffixes based on the move date are also supported.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	account









Reports

None




Menus



	Financial Management/Periodical Processing/End of Year Treatments/Renumber Account Moves









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Indian Accounting and financial management (account_report_india)





	Module:	account_report_india


	Name:	Indian Accounting and financial management


	Version:	False


	Author:	Tiny ERP


	Directory:	account_report_india


	Web:	http://tinyerp.com/module_account.html


	Official module:

		no


	Quality certified:

		no






Description

Financial and accounting module:
Supporting module to the Account base module
provides the functionality according to the Indian Accounting








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	account_voucher

	account_india









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Reporting of Balancesheet for accounting (account_reporting)





	Module:	account_reporting


	Name:	Reporting of Balancesheet for accounting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_reporting


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Financial and accounting reporting
    Balance Sheet Report








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_reporting.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_reporting.zip]









Dependencies



	account









Reports

None




Menus



	Financial Management/Configuration/Balance Sheet Report

	Financial Management/Configuration/Balance Sheet Report/Balance Sheet Report

	Financial Management/Configuration/Balance Sheet Report/Balance Sheet Report Form









Views



	account.report.bs.form (form)

	account.report.report.tree.bs (tree)









Objects


Object: Rml Colors (color.rml)





	code:	code, char, required









	name:	Name, char, required








Object: Account reporting for Balance Sheet (account.report.bs)





	font_style:	Font, selection









	account_id:	Accounts, many2many









	sequence:	Sequence, integer









	note:	Note, text









	parent_id:	Parent, many2one









	code:	Code, char, required









	report_type:	Report Type, selection









	child_id:	Children, one2many









	color_back:	Back Color, many2one









	color_font:	Font Color, many2one









	name:	Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Reporting for accounting (account_report)





	Module:	account_report


	Name:	Reporting for accounting


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	account_report


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Financial and accounting reporting
    Fiscal statements
    Indicators








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/account_report.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/account_report.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_report.zip]









Dependencies



	account









Reports



	Fiscal Statements

	Indicators

	Print Indicators in PDF









Menus



	Financial Management/Configuration/Custom reporting

	Financial Management/Configuration/Custom reporting/New Reporting Item Formula

	Financial Management/Reporting/Custom reporting

	Financial Management/Reporting/Custom reporting/Fiscal Statements reporting

	Financial Management/Reporting/Custom reporting/Indicators reporting

	Financial Management/Reporting/Custom reporting/Other reports

	Financial Management/Reporting/Custom reporting/Print Indicators









Views



	account.report.report.form (form)

	account.report.report.tree.simple (tree)

	account.report.report.tree (tree)

	account.report.history1 (tree)

	account.report.history2 (form)

	account.report.history3 (graph)









Objects


Object: Account reporting (account.report.report)





	status:	Status, selection, readonly









	note:	Note, text









	disp_tree:	Display Tree, boolean






When the indicators are printed, if one indicator is set with this field to True, then it will display one more graphs with all its children in tree






	code:	Code, char, required









	name:	Name, char, required









	sequence:	Sequence, integer









	type:	Type, selection, required









	child_ids:	Children, one2many









	badness_limit:	Badness Indicator Limit, float






This Value sets the limit of badness.






	goodness_limit:	Goodness Indicator Limit, float






This Value sets the limit of goodness.






	parent_id:	Parent, many2one









	amount:	Value, float, readonly









	disp_graph:	Display As Graph, boolean






If the field is set to True, information will be printed as a Graph, otherwise as an array.






	active:	Active, boolean









	expression:	Expression, char, required








Object: Indicator (account.report.history)





	tmp:	temp, integer, readonly









	fiscalyear_id:	Fiscal Year, many2one, readonly









	period_id:	Period, many2one, readonly









	name:	Indicator, many2one, readonly









	val:	Value, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Accounting Reports - Indian Accounting (account_reports_india)





	Module:	account_reports_india


	Name:	Accounting Reports - Indian Accounting


	Version:	5.0.1.0


	Author:	Tiny & Axelor


	Directory:	account_reports_india


	Web:	http://tinyerp.com/module_account.html


	Official module:

		no


	Quality certified:

		no






Description

Accounting Reports - Indian Accounting
Modules gives the 3 most Important Reports for the Indian Accounting
* Trial Balance
* Profit and Loss Account
* Balance Sheet








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_reports_india.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_reports_india.zip]









Dependencies



	account_voucher









Reports



	Trial Balancesheet

	Profit And Loss Account

	Profit And Loss Account

	Balance Sheet









Menus



	Financial Management/Legal Statements/Accounting Reports

	Financial Management/Legal Statements/Accounting Reports/Trial Balance Sheet

	Financial Management/Legal Statements/Accounting Reports/Profit And Loss Account

	Financial Management/Legal Statements/Accounting Reports/Balance Sheet









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Module Help To Reverse Account Move (account_reverse)





	Module:	account_reverse


	Name:	Module Help To Reverse Account Move


	Version:	5.0.1.0


	Author:	ACYSOS S.L.


	Directory:	account_reverse


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module adds a wizard to help reversing moves. This can be used to correct mistakes where it's not possible to cancel moves or even for creating close/open moves for periods or fiscalyears.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_reverse.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_reverse.zip]









Dependencies



	account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

本模块是业界领先的开源企业管理系统OpenERP的一部分。如果你想探索OpenERP，请查看我们的
截屏 [http://openerp.tv] 或直接下载
OpenERP [http://openerp.com] .







会计与财务管理 (会计)





	模块:	会计


	名称:	会计与财务管理


	版本:	5.0.1.1


	作者:	Tiny


	目录:	account


	网站:	http://www.openerp.com


	官方模块:	是


	质量认证:	是






概述

财务与会计模块涵盖:
    一般会计
    成本 / 会计分析
    第三方会计
    税收管理
    预算
    客户和供应商发票
    银行对账单








下载链接

你可以从以下版本中下载本模块(zip格式):



	4.2 [http://www.openerp.com/download/modules/4.2/account.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/account.zip]

	当前分支 [http://www.openerp.com/download/modules/trunk/account.zip]









依赖



	产品

	基础

	流程









报表



	General Ledger

	Partner Ledger

	Partner Other Ledger

	Account Balance

	Partner Balance

	Central Journal

	General Journal

	Journal

	Overdue Payments

	Invoices

	Transfers

	IntraCom

	All Entries

	Taxes Report

	Analytic Journal

	Analytic Balance

	Inverted Analytic Balance

	Cost Ledger

	Cost Ledger (Only quantities)

	Analytic Check









Menus



	Financial Management/Configuration

	Financial Management/Reporting

	Financial Management/Legal Statements

	Financial Management/Invoices

	Financial Management/Periodical Processing/Reconciliation/Automatic reconciliation

	Financial Management/Charts

	Financial Management

	Financial Management/Configuration/Financial Accounting
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Objects


Object: Payment Term (account.payment.term)





	active:	Active, boolean









	note:	Description, text









	name:	Payment Term, char, required









	line_ids:	Terms, one2many








Object: Payment Term Line (account.payment.term.line)





	payment_id:	Payment Term, many2one, required









	name:	Line Name, char, required









	sequence:	Sequence, integer, required






The sequence field is used to order the payment term lines from the lowest sequences to the higher ones






	days2:	Day of the Month, integer, required






Day of the month, set -1 for the last day of the current month. If it’s positive, it gives the day of the next month. Set 0 for net days (otherwise it’s based on the beginning of the month).






	days:	Number of Days, integer, required






Number of days to add before computation of the day of month. If Date=15/01, Number of Days=22, Day of Month=-1, then the due date is 28/02.






	value:	Value, selection, required






Example: 14 days 2%, 30 days net
1. Line 1: percent 0.02 14 days
2. Line 2: balance 30 days






	value_amount:	Value Amount, float






For Value percent enter % ratio between 0-1.





Object: Account Type (account.account.type)





	code:	Code, char, required









	name:	Acc. Type Name, char, required









	sequence:	Sequence, integer






Gives the sequence order when displaying a list of account types.






	sign:	Sign on Reports, selection, required






Allows you to change the sign of the balance amount displayed in the reports, so that you can see positive figures instead of negative ones in expenses accounts.






	close_method:	Deferral Method, selection, required









	partner_account:

		Partner account, boolean








Object: account.tax (account.tax)





	ref_base_code_id:

		Refund Base Code, many2one






Use this code for the VAT declaration.






	domain:	Domain, char






This field is only used if you develop your own module allowing developers to create specific taxes in a custom domain.






	ref_tax_code_id:

		Refund Tax Code, many2one






Use this code for the VAT declaration.






	sequence:	Sequence, integer, required






The sequence field is used to order the tax lines from the lowest sequences to the higher ones. The order is important if you have a tax with several tax children. In this case, the evaluation order is important.






	base_sign:	Base Code Sign, float






Usually 1 or -1.






	child_depend:	Tax on Children, boolean






Set if the tax computation is based on the computation of child taxes rather than on the total amount.






	include_base_amount:

		Include in base amount, boolean






Indicate if the amount of tax must be included in the base amount for the computation of the next taxes






	python_applicable:

		Python Code, text









	applicable_type:

		Applicable Type, selection, required






If not applicable (computed through a Python code), the tax won’t appear on the invoice.






	company_id:	Company, many2one, required









	tax_code_id:	Tax Code, many2one






Use this code for the VAT declaration.






	parent_id:	Parent Tax Account, many2one









	python_compute_inv:

		Python Code (reverse), text









	ref_tax_sign:	Tax Code Sign, float






Usually 1 or -1.






	type:	Tax Type, selection, required






The computation method for the tax amount.






	ref_base_sign:	Base Code Sign, float






Usually 1 or -1.






	description:	Tax Code, char









	tax_group:	Tax Group, selection






If a default tax is given in the partner it only overrides taxes from accounts (or products) in the same group.






	child_ids:	Child Tax Accounts, one2many









	type_tax_use:	Tax Application, selection, required









	base_code_id:	Base Code, many2one






Use this code for the VAT declaration.






	active:	Active, boolean









	name:	Tax Name, char, required






This name will be displayed on reports






	account_paid_id:

		Refund Tax Account, many2one









	account_collected_id:

		Invoice Tax Account, many2one









	amount:	Amount, float, required






For Tax Type percent enter % ratio between 0-1.






	python_compute:	Python Code, text









	tax_sign:	Tax Code Sign, float






Usually 1 or -1.






	price_include:	Tax Included in Price, boolean






Check this if the price you use on the product and invoices includes this tax.





Object: Account (account.account)





	code:	Code, char, required









	reconcile:	Reconcile, boolean






Check this if the user is allowed to reconcile entries in this account.






	user_type:	Account Type, many2one, required









	company_currency_id:

		Company Currency, many2one, readonly









	check_history:	Display History, boolean






Check this box if you want to print all entries when printing the General Ledger, otherwise it will only print its balance.






	child_id:	Child Accounts, many2many, readonly









	note:	Note, text









	company_id:	Company, many2one, required









	shortcut:	Shortcut, char









	child_consol_ids:

		Consolidated Children, many2many









	parent_id:	Parent, many2one









	debit:	Debit, float, readonly









	type:	Internal Type, selection, required









	tax_ids:	Default Taxes, many2many









	child_parent_ids:

		Children, one2many









	active:	Active, boolean









	currency_id:	Secondary Currency, many2one






Force all moves for this account to have this secondary currency.






	parent_right:	Parent Right, integer









	name:	Name, char, required









	credit:	Credit, float, readonly









	parent_left:	Parent Left, integer









	currency_mode:	Outgoing Currencies Rate, selection, required






This will select how the current currency rate for outgoing transactions is computed. In most countries the legal method is “average” but only a few software systems are able to manage this. So if you import from another software system you may have to use the rate at date. Incoming transactions always use the rate at date.






	balance:	Balance, float, readonly








Object: Journal View (account.journal.view)





	columns_id:	Columns, one2many









	name:	Journal View, char, required








Object: Journal Column (account.journal.column)





	name:	Column Name, char, required









	sequence:	Sequence, integer









	view_id:	Journal View, many2one









	required:	Required, boolean









	field:	Field Name, selection, required









	readonly:	Readonly, boolean








Object: Journal (account.journal)





	default_debit_account_id:

		Default Debit Account, many2one









	groups_id:	Groups, many2many









	update_posted:	Allow Cancelling Entries, boolean









	code:	Code, char









	user_id:	User, many2one






The user responsible for this journal






	name:	Journal Name, char, required









	centralisation:	Centralised counterpart, boolean






Check this box to determine that each entry of this journal won’t create a new counterpart but will share the same counterpart. This is used in fiscal year closing.






	view_id:	View, many2one, required






Gives the view used when writing or browsing entries in this journal. The view tell OpenERP which fields should be visible, required or readonly and in which order. You can create your own view for a faster encoding in each journal.






	type_control_ids:

		Type Controls, many2many









	company_id:	Company, many2one









	default_credit_account_id:

		Default Credit Account, many2one









	currency:	Currency, many2one






The currency used to enter statement






	sequence_id:	Entry Sequence, many2one, required






The sequence gives the display order for a list of journals






	account_control_ids:

		Account, many2many









	refund_journal:	Refund Journal, boolean









	invoice_sequence_id:

		Invoice Sequence, many2one






The sequence used for invoice numbers in this journal.






	active:	Active, boolean









	analytic_journal_id:

		Analytic Journal, many2one









	entry_posted:	Skip ‘Draft’ State for Created Entries, boolean






Check this box if you don’t want new account moves to pass through the ‘draft’ state and instead goes directly to the ‘posted state’ without any manual validation.






	type:	Type, selection, required









	group_invoice_lines:

		Group invoice lines, boolean






If this box is checked, the system will try to group the accounting lines when generating them from invoices.





Object: Fiscal Year (account.fiscalyear)





	date_stop:	End Date, date, required









	code:	Code, char, required









	name:	Fiscal Year, char, required









	end_journal_period_id:

		End of Year Entries Journal, many2one, readonly









	date_start:	Start Date, date, required









	company_id:	Company, many2one






Keep empty if the fiscal year belongs to several companies.






	period_ids:	Periods, one2many









	state:	Status, selection, readonly








Object: Account period (account.period)





	date_stop:	End of Period, date, required









	code:	Code, char









	name:	Period Name, char, required









	date_start:	Start of Period, date, required









	fiscalyear_id:	Fiscal Year, many2one, required









	state:	Status, selection, readonly









	special:	Opening/Closing Period, boolean






These periods can overlap.





Object: Journal - Period (account.journal.period)





	name:	Journal-Period Name, char, required









	state:	Status, selection, required, readonly









	journal_id:	Journal, many2one, required









	fiscalyear_id:	Fiscal Year, many2one









	period_id:	Period, many2one, required









	active:	Active, boolean, required









	icon:	Icon, char, readonly








Object: Account Entry (account.move)





	partner_id:	Partner, many2one









	name:	Number, char, required









	type:	Type, selection, readonly









	amount:	Amount, float, readonly









	journal_id:	Journal, many2one, required









	line_id:	Entries, one2many









	state:	Status, selection, required, readonly









	period_id:	Period, many2one, required









	date:	Date, date, required









	ref:	Ref, char









	to_check:	To Be Verified, boolean








Object: Account Reconciliation (account.move.reconcile)





	line_id:	Entry Lines, one2many









	type:	Type, char, required









	create_date:	Creation date, date, readonly









	name:	Name, char, required









	line_partial_ids:

		Partial Entry lines, one2many








Object: Tax Code (account.tax.code)





	info:	Description, text









	code:	Case Code, char









	name:	Tax Case Name, char, required









	sum:	Year Sum, float, readonly









	child_ids:	Child Codes, one2many









	company_id:	Company, many2one, required









	sign:	Sign for parent, float, required









	notprintable:	Not Printable in Invoice, boolean






Check this box if you don’t want any VAT related to this Tax Code to appear on invoices






	parent_id:	Parent Code, many2one









	line_ids:	Lines, one2many









	sum_period:	Period Sum, float, readonly








Object: Account Model (account.model)





	lines_id:	Model Entries, one2many









	ref:	Ref, char









	journal_id:	Journal, many2one, required









	name:	Model Name, char, required






This is a model for recurring accounting entries






	legend:	Legend, text, readonly








Object: Account Model Entries (account.model.line)





	model_id:	Model, many2one, required









	account_id:	Account, many2one, required









	sequence:	Sequence, integer, required






The sequence field is used to order the resources from lower sequences to higher ones






	partner_id:	Partner Ref., many2one









	name:	Name, char, required









	currency_id:	Currency, many2one









	credit:	Credit, float









	date_maturity:	Maturity date, selection






The maturity date of the generated entries for this model. You can choose between the date of the creation action or the date of the creation of the entries plus the partner payment terms.






	debit:	Debit, float









	date:	Current Date, selection, required






The date of the generated entries






	amount_currency:

		Amount Currency, float






The amount expressed in an optional other currency.






	ref:	Ref., char









	quantity:	Quantity, float






The optional quantity on entries





Object: Account Subscription (account.subscription)





	model_id:	Model, many2one, required









	period_nbr:	Period, integer, required









	lines_id:	Subscription Lines, one2many









	name:	Name, char, required









	date_start:	Start Date, date, required









	period_total:	Number of Periods, integer, required









	state:	Status, selection, required, readonly









	period_type:	Period Type, selection, required









	ref:	Ref, char








Object: Account Subscription Line (account.subscription.line)





	date:	Date, date, required









	subscription_id:

		Subscription, many2one, required









	move_id:	Entry, many2one








Object: account.config.wizard (account.config.wizard)





	date1:	Start Date, date, required









	date2:	End Date, date, required









	name:	Name, char, required






Name of the fiscal year as displayed on screens.






	period:	Periods, selection, required









	charts:	Charts of Account, selection, required









	code:	Code, char, required






Name of the fiscal year as displayed in reports.





Object: account.tax.template (account.tax.template)





	ref_base_code_id:

		Refund Base Code, many2one






Use this code for the VAT declaration.






	domain:	Domain, char






This field is only used if you develop your own module allowing developers to create specific taxes in a custom domain.






	ref_tax_code_id:

		Refund Tax Code, many2one






Use this code for the VAT declaration.






	sequence:	Sequence, integer, required






The sequence field is used to order the taxes lines from lower sequences to higher ones. The order is important if you have a tax that has several tax children. In this case, the evaluation order is important.






	base_sign:	Base Code Sign, float






Usually 1 or -1.






	child_depend:	Tax on Children, boolean






Indicate if the tax computation is based on the value computed for the computation of child taxes or based on the total amount.






	include_base_amount:

		Include in Base Amount, boolean






Set if the amount of tax must be included in the base amount before computing the next taxes.






	python_applicable:

		Python Code, text









	applicable_type:

		Applicable Type, selection, required









	tax_code_id:	Tax Code, many2one






Use this code for the VAT declaration.






	parent_id:	Parent Tax Account, many2one









	python_compute_inv:

		Python Code (reverse), text









	ref_tax_sign:	Tax Code Sign, float






Usually 1 or -1.






	type:	Tax Type, selection, required









	ref_base_sign:	Base Code Sign, float






Usually 1 or -1.






	description:	Internal Name, char









	tax_group:	Tax Group, selection






If a default tax if given in the partner it only override taxes from account (or product) of the same group.






	type_tax_use:	Tax Use In, selection, required









	base_code_id:	Base Code, many2one






Use this code for the VAT declaration.






	name:	Tax Name, char, required









	account_paid_id:

		Refund Tax Account, many2one









	account_collected_id:

		Invoice Tax Account, many2one









	chart_template_id:

		Chart Template, many2one, required









	amount:	Amount, float, required









	python_compute:	Python Code, text









	tax_sign:	Tax Code Sign, float






Usually 1 or -1.





Object: Templates for Accounts (account.account.template)





	currency_id:	Secondary Currency, many2one






Force all moves for this account to have this secondary currency.






	code:	Code, char









	reconcile:	Allow Reconciliation, boolean






Check this option if you want the user to reconcile entries in this account.






	child_parent_ids:

		Children, one2many









	user_type:	Account Type, many2one, required






These types are defined according to your country. The type contains further information about the account and its specifics.






	shortcut:	Shortcut, char









	name:	Name, char, required









	note:	Note, text









	parent_id:	Parent Account Template, many2one









	type:	Internal Type, selection, required






This type is used to differentiate types with special effects in OpenERP: view can not have entries, consolidation are accounts that can have children accounts for multi-company consolidations, payable/receivable are for partners accounts (for debit/credit computations), closed for deprecated accounts.






	tax_ids:	Default Taxes, many2many








Object: Tax Code Template (account.tax.code.template)





	info:	Description, text









	code:	Case Code, char









	name:	Tax Case Name, char, required









	child_ids:	Child Codes, one2many









	sign:	Sign for parent, float, required









	notprintable:	Not Printable in Invoice, boolean






Check this box if you don’t want any VAT related to this Tax Code to appear on invoices






	parent_id:	Parent Code, many2one








Object: Templates for Account Chart (account.chart.template)





	property_account_expense_categ:

		Expense Category Account, many2one









	name:	Name, char, required









	property_account_expense:

		Expense Account on Product Template, many2one









	property_account_receivable:

		Receivable Account, many2one









	property_account_payable:

		Payable Account, many2one









	tax_template_ids:

		Tax Template List, one2many






List of all the taxes that have to be installed by the wizard






	tax_code_root_id:

		Root Tax Code, many2one, required









	property_account_income_categ:

		Income Category Account, many2one









	property_account_income:

		Income Account on Product Template, many2one









	bank_account_view_id:

		Bank Account, many2one, required









	account_root_id:

		Root Account, many2one, required








Object: Template for Fiscal Position (account.fiscal.position.template)





	chart_template_id:

		Chart Template, many2one, required









	tax_ids:	Tax Mapping, one2many









	name:	Fiscal Position Template, char, required









	account_ids:	Account Mapping, one2many








Object: Fiscal Position Template Tax Mapping (account.fiscal.position.tax.template)





	position_id:	Fiscal Position, many2one, required









	tax_dest_id:	Replacement Tax, many2one









	tax_src_id:	Tax Source, many2one, required








Object: Fiscal Position Template Account Mapping (account.fiscal.position.account.template)





	position_id:	Fiscal Position, many2one, required









	account_dest_id:

		Account Destination, many2one, required









	account_src_id:	Account Source, many2one, required








Object: wizard.multi.charts.accounts (wizard.multi.charts.accounts)





	chart_template_id:

		Chart Template, many2one, required









	code_digits:	# of Digits, integer, required






No. of Digits to use for account code






	company_id:	Company, many2one, required









	seq_journal:	Separated Journal Sequences, boolean






Check this box if you want to use a different sequence for each created journal. Otherwise, all will use the same sequence.






	bank_accounts_id:

		Bank Accounts, one2many, required








Object: account.bank.accounts.wizard (account.bank.accounts.wizard)





	currency_id:	Currency, many2one









	acc_no:	Account No., many2one, required









	bank_account_id:

		Bank Account, many2one, required








Object: Analytic Accounts (account.analytic.account)





	code:	Account Code, char









	quantity_max:	Maximum Quantity, float









	contact_id:	Contact, many2one









	company_currency_id:

		Currency, many2one, readonly









	active:	Active, boolean









	partner_id:	Associated Partner, many2one









	user_id:	Account Manager, many2one









	date_start:	Date Start, date









	company_id:	Company, many2one, required









	parent_id:	Parent Analytic Account, many2one









	state:	State, selection, required









	complete_name:	Full Account Name, char, readonly









	debit:	Debit, float, readonly









	type:	Account Type, selection









	description:	Description, text









	child_ids:	Child Accounts, one2many









	date:	Date End, date









	name:	Account Name, char, required









	credit:	Credit, float, readonly









	line_ids:	Analytic Entries, one2many









	balance:	Balance, float, readonly









	quantity:	Quantity, float, readonly








Object: account.analytic.journal (account.analytic.journal)





	active:	Active, boolean









	line_ids:	Lines, one2many









	code:	Journal code, char









	type:	Type, selection, required






Gives the type of the analytic journal. When a document (eg: an invoice) needs to create analytic entries, OpenERP will look for a matching journal of the same type.






	name:	Journal name, char, required








Object: Fiscal Position (account.fiscal.position)





	note:	Notes, text









	tax_ids:	Tax Mapping, one2many









	company_id:	Company, many2one









	name:	Fiscal Position, char, required









	account_ids:	Account Mapping, one2many








Object: Fiscal Position Taxes Mapping (account.fiscal.position.tax)





	position_id:	Fiscal Position, many2one, required









	tax_dest_id:	Replacement Tax, many2one









	tax_src_id:	Tax Source, many2one, required








Object: Fiscal Position Accounts Mapping (account.fiscal.position.account)





	position_id:	Fiscal Position, many2one, required









	account_dest_id:

		Account Destination, many2one, required









	account_src_id:	Account Source, many2one, required








Object: Maintains Invoice sequences with Fiscal Year (fiscalyear.seq)





	fiscalyear_id:	Fiscal Year, many2one, required









	sequence_id:	Sequence, many2one, required









	journal_id:	Journal, many2one








Object: Invoice (account.invoice)





	origin:	Origin, char






Reference of the document that produced this invoice.






	comment:	Additional Information, text









	date_due:	Due Date, date






If you use payment terms, the due date will be computed automatically at the generation of accounting entries. If you keep the payment term and the due date empty, it means direct payment. The payment term may compute several due dates, for example 50% now, 50% in one month.






	check_total:	Total, float









	reference:	Invoice Reference, char






The partner reference of this invoice.






	payment_term:	Payment Term, many2one, readonly






If you use payment terms, the due date will be computed automatically at the generation of accounting entries. If you keep the payment term and the due date empty, it means direct payment. The payment term may compute several due dates, for example 50% now, 50% in one month.






	number:	Invoice Number, char, readonly






Unique number of the invoice, computed automatically when the invoice is created.






	journal_id:	Journal, many2one, required, readonly









	currency_id:	Currency, many2one, required, readonly









	address_invoice_id:

		Invoice Address, many2one, required, readonly









	tax_line:	Tax Lines, one2many, readonly









	account_id:	Account, many2one, required, readonly






The partner account used for this invoice.






	fiscal_position:

		Fiscal Position, many2one









	amount_untaxed:	Untaxed, float, readonly









	address_contact_id:

		Contact Address, many2one, readonly









	reference_type:	Reference Type, selection, required









	company_id:	Company, many2one, required









	amount_tax:	Tax, float, readonly









	state:	State, selection, readonly









	partner_bank:	Bank Account, many2one






The bank account to pay to or to be paid from






	type:	Type, selection, readonly









	invoice_line:	Invoice Lines, one2many, readonly









	move_lines:	Move Lines, many2many, readonly









	payment_ids:	Payments, many2many, readonly









	reconciled:	Paid/Reconciled, boolean, readonly






The account moves of the invoice have been reconciled with account moves of the payment(s).






	residual:	Residual, float, readonly






Remaining amount due.






	move_name:	Account Move, char









	date_invoice:	Date Invoiced, date






Keep empty to use the current date






	period_id:	Force Period, many2one, readonly






Keep empty to use the period of the validation(invoice) date.






	move_id:	Invoice Movement, many2one, readonly






Link to the automatically generated account moves.






	amount_total:	Total, float, readonly









	partner_id:	Partner, many2one, required, readonly









	name:	Description, char, readonly








Object: Invoice line (account.invoice.line)





	origin:	Origin, char






Reference of the document that produced this invoice.






	uos_id:	Unit of Measure, many2one









	account_id:	Account, many2one, required






The income or expense account related to the selected product.






	invoice_id:	Invoice Ref, many2one









	price_unit:	Unit Price, float, required









	price_subtotal:	Subtotal, float, readonly









	invoice_line_tax_id:

		Taxes, many2many









	note:	Notes, text









	discount:	Discount (%), float









	product_id:	Product, many2one









	account_analytic_id:

		Analytic Account, many2one









	quantity:	Quantity, float, required









	name:	Description, char, required








Object: Invoice Tax (account.invoice.tax)





	tax_amount:	Tax Code Amount, float









	account_id:	Tax Account, many2one, required









	sequence:	Sequence, integer









	invoice_id:	Invoice Line, many2one









	manual:	Manual, boolean









	base_amount:	Base Code Amount, float









	base_code_id:	Base Code, many2one






The account basis of the tax declaration.






	tax_code_id:	Tax Code, many2one






The tax basis of the tax declaration.






	amount:	Amount, float









	base:	Base, float









	name:	Tax Description, char, required








Object: Bank Statement (account.bank.statement)





	name:	Name, char, required









	balance_end:	Balance, float, readonly









	balance_start:	Starting Balance, float









	journal_id:	Journal, many2one, required









	currency:	Currency, many2one, readonly









	state:	State, selection, required, readonly









	move_line_ids:	Entry lines, one2many









	line_ids:	Statement lines, one2many









	date:	Date, date, required









	period_id:	Period, many2one, required









	balance_end_real:

		Ending Balance, float








Object: Statement reconcile (account.bank.statement.reconcile)





	total_currency:	Currency, many2one, readonly









	total_amount:	Payment amount, float, readonly









	total_entry:	Total entries, float, readonly









	statement_line:	Bank Statement Line, one2many









	total_new:	Total write-off, float, readonly









	line_new_ids:	Write-Off, one2many









	name:	Date, char, required









	total_balance:	Balance, float, readonly









	total_second_currency:

		Currency, many2one, readonly






The currency of the journal






	line_ids:	Entries, many2many









	partner_id:	Partner, many2one, readonly









	total_second_amount:

		Payment amount, float, readonly






The amount in the currency of the journal





Object: Statement reconcile line (account.bank.statement.reconcile.line)





	line_id:	Reconcile, many2one









	amount:	Amount, float, required









	name:	Description, char, required









	account_id:	Account, many2one, required








Object: Bank Statement Line (account.bank.statement.line)





	reconcile_id:	Reconcile, many2one









	note:	Notes, text









	partner_id:	Partner, many2one









	statement_id:	Statement, many2one, required









	ref:	Ref., char









	account_id:	Account, many2one, required









	reconcile_amount:

		Amount reconciled, float, readonly









	move_ids:	Moves, many2many









	amount:	Amount, float









	date:	Date, date, required









	type:	Type, selection, required









	name:	Name, char, required








Object: Entry lines (account.move.line)





	analytic_lines:	Analytic lines, one2many









	statement_id:	Statement, many2one






The bank statement used for bank reconciliation






	currency_id:	Currency, many2one






The optional other currency if it is a multi-currency entry.






	date_maturity:	Maturity date, date






This field is used for payable and receivable entries. You can put the limit date for the payment of this entry line.






	invoice:	Invoice, many2one, readonly









	partner_id:	Partner Ref., many2one









	reconcile_partial_id:

		Partial Reconcile, many2one, readonly









	blocked:	Litigation, boolean






You can check this box to mark the entry line as a litigation with the associated partner






	analytic_account_id:

		Analytic Account, many2one









	centralisation:	Centralisation, selection









	journal_id:	Journal, many2one, required









	tax_code_id:	Tax Account, many2one






The Account can either be a base tax code or tax code account.






	state:	Status, selection, readonly









	debit:	Debit, float









	ref:	Ref., char









	account_id:	Account, many2one, required









	amount_taxed:	Taxed Amount, float









	period_id:	Period, many2one, required









	date_created:	Creation date, date









	date:	Effective date, date, required









	move_id:	Move, many2one






The move of this entry line.






	product_id:	Product, many2one









	reconcile_id:	Reconcile, many2one, readonly









	tax_amount:	Tax/Base Amount, float






If the Tax account is tax code account, this field will contain the taxed amount. If the tax account is base tax code,                    this field will contain the basic amount(without tax).






	name:	Name, char, required









	account_tax_id:	Tax, many2one









	product_uom_id:	UoM, many2one









	credit:	Credit, float









	amount_currency:

		Amount Currency, float






The amount expressed in an optional other currency if it is a multi-currency entry.






	balance:	Balance, float, readonly









	quantity:	Quantity, float






The optional quantity expressed by this line, eg: number of product sold. The quantity is not a legal requirement but is very usefull for some reports.





Object: Analytic lines (account.analytic.line)





	code:	Code, char









	user_id:	User, many2one









	account_id:	Analytic Account, many2one, required









	general_account_id:

		General Account, many2one, required









	product_uom_id:	UoM, many2one









	journal_id:	Analytic Journal, many2one, required









	amount:	Amount, float, required









	product_id:	Product, many2one









	unit_amount:	Quantity, float









	date:	Date, date, required









	ref:	Ref., char









	move_id:	Move Line, many2one









	name:	Description, char, required








Object: Analytic account costs and revenues (report.hr.timesheet.invoice.journal)





	account_id:	Analytic Account, many2one, readonly









	revenue:	Debit, float, readonly









	journal_id:	Journal, many2one, readonly









	cost:	Credit, float, readonly









	quantity:	Quantities, float, readonly









	name:	Month, date, readonly








Object: account.sequence.fiscalyear (account.sequence.fiscalyear)





	sequence_id:	Sequence, many2one, required









	fiscalyear_id:	Fiscal Year, many2one, required









	sequence_main_id:

		Main Sequence, many2one, required








Object: wizard.company.setup (wizard.company.setup)





	partner_id:	Partner, many2one









	company_id:	Company, many2one, required









	overdue_msg:	Overdue Payment Message, text
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Accounting simulation journal (account_simulation)





	Module:	account_simulation


	Name:	Accounting simulation journal


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_simulation


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Accounting simulation plan.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_simulation.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_simulation.zip]









Dependencies



	account









Reports

None




Menus



	Financial Management/Configuration/Financial Accounting/Financial Journals/Journal Simulations

	Financial Management/Configuration/Financial Accounting/Financial Journals/Account Journal









Views



	account.journal.simulation.tree (tree)

	account.journal.simulation.form (form)

	* INHERIT account.journal.simulation.form.inherit (form)

	account.journal.tree (tree)









Objects


Object: Simulation level (account.journal.simulation)





	code:	Simulation code, char, required









	name:	Simulation name, char, required
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Account Stock (account_stock)





	Module:	account_stock


	Name:	Account Stock


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_stock


	Web:	http://tinyerp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	product

	account









Reports



	Stock Summary Product Vice









Menus



	Financial Management/Reporting/Stock Summary Product Vice









Views

None




Objects

None
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Invoices and prices with taxes included (account_tax_include)





	Module:	account_tax_include


	Name:	Invoices and prices with taxes included


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	account_tax_include


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Allow the user to work tax included prices.
Especially useful for b2c businesses.

This module implement the modification on the invoice form.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/account_tax_include.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/account_tax_include.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_tax_include.zip]









Dependencies



	account









Reports

None




Menus

None




Views



	* INHERIT account.tax.exlcuded.view.form (form)

	* INHERIT account.invoice.vat.exlcuded.view.form (form)

	* INHERIT account.invoice.supplier.tax_include (form)

	* INHERIT account.invoice.supplier.tax_include2 (form)

	* INHERIT account.invoice.supplier.tax_include3 (form)

	* INHERIT account.invoice.line.tree (tree)









Objects

None
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Invoice Payment/Receipt by Vouchers. (account_voucher_payment)





	Module:	account_voucher_payment


	Name:	Invoice Payment/Receipt by Vouchers.


	Version:	5.0.1.0


	Author:	Tiny & Axelor


	Directory:	account_voucher_payment


	Web:	http://tinyerpindia.com


	Official module:

		no


	Quality certified:

		no






Description

This module includes :
    * It reconcile the invoice (supplier, customer) while paying through Accounting Vouchers
    A Voucher, is defined like some document that involve a banking transaction.
    the Objective, is, one time the credit and collection people load some payment on the system, every voucher
    Loaded on system should be reconcilied with a bank statement by Accounting people.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_voucher_payment.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_voucher_payment.zip]









Dependencies



	base

	account

	account_voucher









Reports

None




Menus

None




Views



	* INHERIT account.voucher.form.inherit (form)

	* INHERIT account.voucher.form.inherit2 (form)

	* INHERIT account.move.line.form.inherit (form)

	* INHERIT account.move.line.form.inherit (tree)









Objects

None
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screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Accounting Voucher Reports (account_voucher_report)





	Module:	account_voucher_report


	Name:	Accounting Voucher Reports


	Version:	5.0.1.0


	Author:	Tiny & Axelor


	Directory:	account_voucher_report


	Web:	http://tinyerp.com


	Official module:

		no


	Quality certified:

		no






Description

India Accounting module includes all the basic requirements of
    Basic Accounting, like
    * Bank Payment, Receipt
    * Cash Payment, Receipt








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_voucher_report.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_voucher_report.zip]









Dependencies



	base

	account









Reports



	Voucher Report (Cr/Dr)









Menus

None




Views

None




Objects

None
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screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Accounting Voucher Entries (account_voucher)





	Module:	account_voucher


	Name:	Accounting Voucher Entries


	Version:	5.0.1.0


	Author:	Tiny & Axelor


	Directory:	account_voucher


	Web:	http://tinyerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

India Accounting module includes all the basic requirements of
    Basic Accounting, like
    * Bank Payment, Receipt
    * Cash Payment, Receipt








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/account_voucher.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/account_voucher.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_voucher.zip]









Dependencies



	base

	account









Reports



	Voucher Report (Cr/Dr)

	Voucher Report









Menus



	Financial Management/Voucher Entries/Open Vouchers

	Financial Management/Voucher Entries

	Financial Management/Voucher Entries/Receipt Vouchers

	Financial Management/Voucher Entries/Receipt Vouchers/Cash Receipts

	Financial Management/Voucher Entries/Receipt Vouchers/Cash Receipts/New Cash Receipt

	Financial Management/Voucher Entries/Receipt Vouchers/Bank Receipts

	Financial Management/Voucher Entries/Receipt Vouchers/Bank Receipts/New Bank Receipt

	Financial Management/Voucher Entries/Payment Vouchers

	Financial Management/Voucher Entries/Payment Vouchers/Cash Payments

	Financial Management/Voucher Entries/Payment Vouchers/Cash Payments/New Cash Payment

	Financial Management/Voucher Entries/Payment Vouchers/Bank Payments

	Financial Management/Voucher Entries/Payment Vouchers/Bank Payments/New Bank Payment

	Financial Management/Voucher Entries/Other Vouchers

	Financial Management/Voucher Entries/Other Vouchers/Contra Voucher

	Financial Management/Voucher Entries/Other Vouchers/Journal Sale Voucher

	Financial Management/Voucher Entries/Other Vouchers/Journal Purchase Voucher

	Financial Management/Voucher Entries/Other Vouchers/Journal Voucher









Views



	account.voucher.tree (tree)

	account.voucher.form (form)

	* INHERIT account.move.type.form.inherit2 (form)

	* INHERIT account.form1 (form)

	* INHERIT account.form2 (form)

	* INHERIT account.tree1 (tree)

	* INHERIT account.tree2 (tree)

	* INHERIT sub.currency.form (form)









Objects


Object: Accounting Voucher (account.voucher)





	move_ids:	Real Entry, many2many









	type:	Type, selection, readonly









	account_id:	Account, many2one, required, readonly









	reference:	Voucher Reference, char









	amount:	Amount, float, readonly









	reference_type:	Reference Type, selection, required









	company_id:	Company, many2one, required









	number:	Number, char, readonly









	currency_id:	Currency, many2one, required, readonly









	journal_id:	Journal, many2one, required, readonly









	state:	State, selection, readonly









	payment_ids:	Voucher Lines, one2many









	narration:	Narration, text, required, readonly









	date:	Date, date, readonly









	period_id:	Period, many2one, required









	partner_id:	Partner, many2one, readonly









	move_id:	Account Entry, many2one









	name:	Name, char, required, readonly








Object: Voucher Line (account.voucher.line)





	ref:	Ref., char









	name:	Description, char, required









	partner_id:	Partner, many2one









	account_analytic_id:

		Analytic Account, many2one









	amount:	Amount, float









	voucher_id:	Voucher, many2one









	type:	Type, selection









	account_id:	Account, many2one, required
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Business Process for Accounting Voucher (account_voucher_workflow)





	Module:	account_voucher_workflow


	Name:	Business Process for Accounting Voucher


	Version:	5.0.1.0


	Author:	Tiny & Axelor


	Directory:	account_voucher_workflow


	Web:	http://tinyerpindia.com


	Official module:

		no


	Quality certified:

		no






Description

Business process for the Accounting Voucher
    We can define the rules for voucher > 1000 need Special Authorization








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/account_voucher_workflow.zip]

	trunk [http://www.openerp.com/download/modules/trunk/account_voucher_workflow.zip]









Dependencies



	account_voucher









Reports

None




Menus

None




Views



	* INHERIT account.voucher.form (form)

	* INHERIT account.journal.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Actions Server: Mako Emails (actions_server_mako_email)





	Module:	actions_server_mako_email


	Name:	Actions Server: Mako Emails


	Version:	0.1


	Author:	Tiny


	Directory:	actions_server_mako_email


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Allow action server emails to be mako templates




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/actions_server_mako_email.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Airport (airport)





	Module:	airport


	Name:	Airport


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	airport


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Sample module to manage airport, flights and hostels








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/airport.zip]

	trunk [http://www.openerp.com/download/modules/trunk/airport.zip]









Dependencies



	base

	product









Reports

None




Menus



	Airports

	Airports/Configuration

	Airports/Configuration/Airport

	Airports/Air Lines

	Airports/Configuration/Flights









Views



	airport.airport (tree)

	airport.airport (form)

	airport.flight (form)









Objects


Object: airport.airport (airport.airport)





	city:	City, char









	country_id:	Country, many2one









	lines:	Flight lines, many2many









	name:	Airport name, char








Object: Product (airport.flight)





	warranty:	Warranty (months), float









	ean13:	EAN13, char









	supply_method:	Supply method, selection, required






Produce will generate production order or tasks, according to the product type. Purchase will trigger purchase orders when requested.






	uos_id:	Unit of Sale, many2one






Used by companies that manages two unit of measure: invoicing and stock management. For example, in food industries, you will manage a stock of ham but invoice in Kg. Keep empty to use the default UOM.






	list_price:	Sale Price, float






Base price for computing the customer price. Sometimes called the catalog price.






	weight:	Gross weight, float






The gross weight in Kg.






	incoming_qty:	Incoming, float, readonly









	standard_price:	Cost Price, float, required






The cost of the product for accounting stock valuation. It can serves as a base price for supplier price.






	price_extra:	Variant Price Extra, float









	mes_type:	Measure Type, selection, required









	uom_id:	Default UoM, many2one, required






Default Unit of Measure used for all stock operation.






	code:	Code, char, readonly









	description_purchase:

		Purchase Description, text









	default_code:	Code, char









	qty_available:	Real Stock, float, readonly









	partner_id:	Customer, many2one









	variants:	Variants, char









	uos_coeff:	UOM -> UOS Coeff, float






Coefficient to convert UOM to UOS
uos = uom * coeff






	product_tmpl_id:

		Product Template, many2one, required









	date:	Departure Date, datetime









	seller_delay:	Supplier Lead Time, integer, readonly






This is the average delay in days between the purchase order confirmation and the reception of goods for this product and for the default supplier. It is used by the scheduler to order requests based on reordering delays.






	purchase_ok:	Can be Purchased, boolean






Determine if the product is visible in the list of products within a selection from a purchase order line.






	product_manager:

		Product Manager, many2one









	company_id:	Company, many2one









	name:	Name, char, required









	active:	Active, boolean









	state:	Status, selection






Tells the user if he can use the product or not.






	loc_rack:	Rack, char









	uom_po_id:	Purchase UoM, many2one, required






Default Unit of Measure used for purchase orders. It must be in the same category as the default unit of measure.






	type:	Product Type, selection, required






Will change the way procurements are processed. Consumables are stockable products with infinite stock, or for use when you have no stock management in the system.






	price:	Customer Price, float, readonly









	description:	Description, text









	weight_net:	Net weight, float






The net weight in Kg.






	volume:	Volume, float






The volume in m3.






	airport_from:	Airport Departure, many2one









	outgoing_qty:	Outgoing, float, readonly









	procure_method:	Procure Method, selection, required






‘Make to Stock’: When needed, take from the stock or wait until re-supplying. ‘Make to Order’: When needed, purchase or produce for the procurement request.






	virtual_available:

		Virtual Stock, float, readonly









	cost_method:	Costing Method, selection, required






Standard Price: the cost price is fixed and recomputed periodically (usually at the end of the year), Average Price: the cost price is recomputed at each reception of products.






	partner_ref:	Customer ref, char, readonly









	loc_row:	Row, char









	sale_ok:	Can be sold, boolean






Determine if the product can be visible in the list of product within a selection from a sale order line.






	rental:	Rentable Product, boolean









	packaging:	Logistical Units, one2many






Gives the different ways to package the same product. This has no impact on the packing order and is mainly used if you use the EDI module.






	sale_delay:	Customer Lead Time, float






This is the average time between the confirmation of the customer order and the delivery of the finished products. It’s the time you promise to your customers.






	loc_case:	Case, char









	description_sale:

		Sale Description, text









	categ_id:	Category, many2one, required









	lst_price:	List Price, float, readonly









	produce_delay:	Manufacturing Lead Time, float






Average time to produce this product. This is only for the production order and, if it is a multi-level bill of material, it’s only for the level of this product. Different delays will be summed for all levels and purchase orders.






	seller_ids:	Partners, one2many









	airport_to:	Airport Arrival, many2one









	price_margin:	Variant Price Margin, float
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Generic alerts (alerts)





	Module:	alerts


	Name:	Generic alerts


	Version:	1.0


	Author:	Sednacom


	Directory:	alerts


	Web:	http://www.sednacom.fr


	Official module:

		no


	Quality certified:

		no






Description

Add an alert generator on every resources of the system








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/alerts.zip]

	trunk [http://www.openerp.com/download/modules/trunk/alerts.zip]









Dependencies



	base

	sednacom_extras









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Analytic Journal Billing Rate (analytic_journal_billing_rate)





	Module:	analytic_journal_billing_rate


	Name:	Analytic Journal Billing Rate


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	analytic_journal_billing_rate


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows you to define what is the default invoicing rate for a specific journal on a given account. This is mostly used when a user encode his timesheet: the values are retrieved and the fields are auto-filled... but the possibility to change these values is still available.

    Obviously if no data has been recorded for the current account, the default value is given as usual by the account data so that this module is perfectly compatible with older configurations.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/analytic_journal_billing_rate.zip]

	trunk [http://www.openerp.com/download/modules/trunk/analytic_journal_billing_rate.zip]









Dependencies



	analytic_user_function

	account

	hr_timesheet_invoice









Reports

None




Menus

None




Views



	analytic_journal_rate_grid.tree (tree)

	analytic_journal_rate_grid.form (form)

	* INHERIT account.analytic.account.form (form)

	* INHERIT hr.timesheet.sheet.form (form)

	* INHERIT hr.analytic.timesheet.form (form)

	* INHERIT hr.analytic.timesheet.form (form)









Objects


Object: Relation table between journals and billing rates (analytic_journal_rate_grid)





	rate_id:	Invoicing Rate, many2one









	journal_id:	Analytic Journal, many2one, required









	account_id:	Analytic Account, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Analytic accounts with multiple partners (analytic_partners)





	Module:	analytic_partners


	Name:	Analytic accounts with multiple partners


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	analytic_partners


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module adds the possibility to assign multiple partners on
    the same analytic account. It's usefull when you do a management
    by affairs, where you can attach all suppliers and customers to
    a project.

    A report for the project manager is added to print the analytic
    account and all associated partners with their contacts.

    It's usefull to give to all members of a project, so that they
    get the contacts of all suppliers in this project.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/analytic_partners.zip]

	trunk [http://www.openerp.com/download/modules/trunk/analytic_partners.zip]









Dependencies



	account









Reports



	Analytic Account with Partners









Menus

None




Views



	* INHERIT analytic_partners.analytic.account.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Analytic User Function (analytic_user_function)





	Module:	analytic_user_function


	Name:	Analytic User Function


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	analytic_user_function


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows you to define what is the default function of a specific user on a given account. This is mostly used when a user encode his timesheet: the values are retrieved and the fields are auto-filled... but the possibility to change these values is still available.

    Obviously if no data has been recorded for the current account, the default value is given as usual by the employee data so that this module is perfectly compatible with older configurations.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/analytic_user_function.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/analytic_user_function.zip]

	trunk [http://www.openerp.com/download/modules/trunk/analytic_user_function.zip]









Dependencies



	hr_timesheet_sheet









Reports

None




Menus

None




Views



	analytic_user_funct_grid.tree (tree)

	analytic_user_funct_grid.form (form)

	* INHERIT account.analytic.account.form (form)

	* INHERIT hr.timesheet.sheet.form.tree (form)

	* INHERIT hr.timesheet.sheet.form.form (form)

	* INHERIT hr.analytic.timesheet.form (form)

	* INHERIT hr.analytic.timesheet.form (form)

	* INHERIT hr.analytic.timesheet.tree (tree)

	* INHERIT hr.analytic.timesheet.tree (tree)









Objects


Object: Relation table between users and products on a analytic account (analytic_user_funct_grid)





	user_id:	User, many2one, required









	product_id:	Product, many2one, required









	account_id:	Analytic Account, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Asterisk - Manage Asterisk servers and IP phones. (asterisk)





	Module:	asterisk


	Name:	Asterisk - Manage Asterisk servers and IP phones.


	Version:	5.0.0.1proto2


	Author:	Tiny


	Directory:	asterisk


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Manages a list of asterisk servers and IP phones.
This module implements a system to popup the partner form based on phone calls.
This is still a proof of concept, that have been made during Tiny ERP's
technical training session.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/asterisk.zip]

	trunk [http://www.openerp.com/download/modules/trunk/asterisk.zip]









Dependencies



	base









Reports

None




Menus



	Sys Admin

	Sys Admin/Configuration

	Sys Admin/Configuration/Asterisk Server

	Sys Admin/Configuration/IP Phones

	Sys Admin/Get Partner From Call









Views



	Asterisk Server (tree)

	Asterisk Server (form)

	IP Phone (tree)

	IP Phone (form)









Objects


Object: asterisk.server (asterisk.server)





	host:	Server Host, char, required









	login:	Login, char









	password:	Password, char









	port:	Server Port, integer, required









	name:	Asterisk Server, char, required








Object: IP Phone (asterisk.phone)





	current_callerid:

		Current Caller, char









	user_id:	User, many2one, required









	name:	Phone Name, char, required









	ip:	Phone IP, char









	state:	State, selection









	phoneid:	Phone ID, char









	asterisk_id:	Asterisk Server, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Auction module (auction)





	Module:	auction


	Name:	Auction module


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	auction


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module provides functionality to
     manage artists, articles, sellers, buyers and auction.
     Manage bids, track of sold, paid and unpaid objects.
     Delivery Management.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/auction.zip]

	trunk [http://www.openerp.com/download/modules/trunk/auction.zip]









Dependencies



	base

	account

	hr_attendance









Reports



	Listing Huissiers

	Artists Biography

	Bids phones

	Bids

	Code barres du lot

	Lots List - Landscape

	Auction Totals with lists

	Buyer Form

	Deposits

	Seller Form

	Seller List

	Buyer List

	Bids per lot (phone)

	Results with buyer









Menus



	Auction Management

	Auction Management/Configuration

	Auction Management/Configuration/Define Artists

	Auction Management/Configuration/Object Categories

	Auction Management/Auction Dates

	Auction Management/Auction Dates/Next Auction Dates

	Auction Management/Auction Dates/Old Auction Dates

	Auction Management/Auction Dates/New Auction Dates

	Auction Management/Objects

	Auction Management/Objects/All objects

	Auction Management/Objects/All objects/Sold Objects

	Auction Management/Objects/All objects/Objects to sell

	Auction Management/Objects/All objects/Unplanned objects

	Auction Management/Objects/All objects/Unsold Objects

	Auction Management/Objects/All objects/Unclassified objects

	Auction Management/Sellers

	Auction Management/Sellers/Deposit border

	Auction Management/Buyers

	Auction Management/Buyers/Bids

	Auction Management/Buyers/Bids/Bids line

	Auction Management/Reporting

	Auction Management/Reporting/Auction

	Auction Management/Reporting/Auction/Auction’s Summary

	Auction Management/Reporting/Auction/Auction’s Revenues

	Auction Management/Reporting/Sellers

	Auction Management/Reporting/Sellers/Seller’s Summary

	Auction Management/Reporting/Sellers/Seller’s Revenues

	Auction Management/Reporting/Buyer

	Auction Management/Reporting/Buyer/Buyer’s Summary

	Auction Management/Reporting/Buyer/Buyer’s Revenues

	Auction Management/Reporting/Employees

	Auction Management/Reporting/Employees/Comparison of estimations

	Auction Management/Reporting/Manager

	Auction Management/Reporting/Manager/Comparison of estimations

	Auction Management/Reporting/Employees/Attendance

	Auction Management/Reporting/Manager/Attendance

	Auction Management/Reporting/Employees/My Latest Deposits

	Auction Management/Reporting/Manager/Latest Deposits

	Auction Management/Reporting/Manager/Encoded Objects Per Day

	Auction Management/Reporting/Employees/My Encoded Objects Per Day

	Auction Management/Objects/Objects by Auction

	Auction Management/Reporting/Manager/Adjudication by Auction

	Auction Management/Reporting/Manager/Depositer’s Statistics

	Auction Management/Reporting/Employees/Depositer’s Statistics

	Auction Management/Tools Bar Codes

	Auction Management/Tools Bar Codes/Deliveries Management









Views



	auction.artists.tree (tree)

	auction.artists.form (form)

	auction.lot.category.tree (tree)

	auction.lot.category.form (form)

	Auction dates (tree)

	Auction dates (form)

	Auction lots (tree)

	Auction lots (form)

	Auction lots (graph)

	Auction lots (tree)

	Auction lots (form)

	auction.lots.form3 (form)

	Auction.deposit.tree (tree)

	auction.deposit.form (form)

	Deposit border (tree)

	auction.bid_line.tree1 (tree)

	auction.bid_line.form1 (form)

	auction.bid.form (form)

	auction.bid.tree (tree)

	auction.reports.tree (tree)

	auction.reports.form (form)

	auction.reports.tree2 (tree)

	Auction report (form)

	Seller’s auction (form)

	Seller’s auction (tree)

	Seller’s auction (graph)

	Seller’s auction (form)

	Seller’s auction (tree)

	Seller’s auction (graph)

	Buyer’s auction (form)

	Buyer’s auction (tree)

	Buyer’s auction (form)

	Buyer’s auction (tree)

	Unplanned objects (tree)

	Unplanned objects (form)

	report.auction.estimation.adj.category.form (form)

	report.auction.estimation.adj.category.tree (tree)

	report.auction.estimation.adj.category.graph (graph)

	report attendance (tree)

	Graph attendance (graph)

	Objects by date (tree)

	Object date (form)

	report.auction.object.date.graph (graph)

	report.auction.adjudication.tree (tree)

	report.auction.adjudication.graph (graph)

	Depositer’s statistics (tree)

	report.object.encoded.form (form)

	report.object.encoded.tree (tree)

	report.object.encoded.graph (graph)

	report.object.encoded.tree (tree)

	report.object.encoded.graph (graph)

	report.unclassified.objects (tree)









Objects


Object: auction.artists (auction.artists)





	birth_death_dates:

		Birth / Death dates, char









	pseudo:	Pseudo, char









	name:	Artist/Author Name, char, required









	biography:	Biography, text








Object: auction.dates (auction.dates)





	journal_seller_id:

		Seller Journal, many2one, required









	expo1:	First Exposition Day, date, required









	acc_expense:	Expense Account, many2one, required









	expo2:	Last Exposition Day, date, required









	acc_income:	Income Account, many2one, required









	journal_id:	Buyer Journal, many2one, required









	adj_total:	Total Adjudication, float, readonly









	state:	Status, selection, readonly









	auction1:	First Auction Day, date, required









	buyer_costs:	Buyer Costs, many2many









	auction2:	Last Auction Day, date, required









	account_analytic_id:

		Analytic Account, many2one, required









	seller_costs:	Seller Costs, many2many









	name:	Auction date, char, required








Object: Deposit Border (auction.deposit)





	info:	Description, char









	create_uid:	Created by, many2one, readonly









	specific_cost_ids:

		Specific Costs, one2many









	name:	Depositer Inventory, char, required









	date_dep:	Deposit date, date, required









	transfer:	Transfer, boolean









	partner_id:	Seller, many2one, required









	lot_id:	Objects, one2many









	total_neg:	Allow Negative Amount, boolean









	method:	Withdrawned method, selection, required









	tax_id:	Expenses, many2one








Object: auction.deposit.cost (auction.deposit.cost)





	deposit_id:	Deposit, many2one









	account:	Destination Account, many2one, required









	amount:	Amount, float









	name:	Cost Name, char, required








Object: auction.lot.category (auction.lot.category)





	priority:	Priority, float









	active:	Active, boolean









	name:	Category Name, char, required









	aie_categ:	Aie Category, selection








Object: Object (auction.lots)





	is_ok:	Buyer’s payment, boolean









	vnd_lim:	Seller limit, float









	statement_id:	Payment, many2many









	net_margin:	Net Margin (%), float, readonly









	image:	Image, binary









	lot_num:	List Number, integer, required









	ach_uid:	Buyer, many2one









	sel_inv_id:	Seller Invoice, many2one, readonly









	vnd_lim_net:	Net limit ?, boolean, readonly









	bord_vnd_id:	Depositer Inventory, many2one, required









	ach_emp:	Taken Away, boolean









	ach_avance:	Buyer Advance, float









	lot_local:	Location, char









	net_revenue:	Net revenue, float, readonly









	artist2_id:	Artist/Author 2, many2one









	obj_comm:	Commission, boolean









	paid_ach:	Buyer invoice reconciled, boolean, readonly









	lot_type:	Object category, selection









	state:	Status, selection, required, readonly









	auction_id:	Auction Date, many2one









	history_ids:	Auction history, one2many









	artist_id:	Artist/Author, many2one









	ach_login:	Buyer Username, char









	gross_revenue:	Gross revenue, float, readonly









	author_right:	Author rights, many2one









	create_uid:	Created by, many2one, readonly









	gross_margin:	Gross Margin (%), float, readonly









	important:	To be Emphasised, boolean









	bid_lines:	Bids, one2many









	lot_est1:	Minimum Estimation, float









	lot_est2:	Maximum Estimation, float









	name:	Short Description, char, required









	obj_num:	Catalog Number, integer









	buyer_price:	Buyer price, float, readonly









	ach_inv_id:	Buyer Invoice, many2one, readonly









	obj_price:	Adjudication price, float









	obj_ret:	Price retired, float









	costs:	Indirect costs, float, readonly









	name2:	Short Description (2), char









	paid_vnd:	Seller Paid, boolean









	product_id:	Product, many2one, required









	obj_desc:	Object Description, text









	seller_price:	Seller price, float, readonly








Object: Bid auctions (auction.bid)





	bid_lines:	Bid, one2many









	contact_tel:	Contact, char









	auction_id:	Auction Date, many2one, required









	partner_id:	Buyer Name, many2one, required









	name:	Bid ID, char, required








Object: Lot history (auction.lot.history)





	lot_id:	Object, many2one, required









	price:	Withdrawn price, float









	auction_id:	Auction date, many2one, required









	name:	Date, date








Object: Bid (auction.bid_line)





	name:	Bid date, char









	auction:	Auction Name, char









	price:	Maximum Price, float









	bid_id:	Bid ID, many2one, required









	call:	To be Called, boolean









	lot_id:	Object, many2one, required








Object: Auction Reporting on buyer view (report.buyer.auction)





	total_price:	Total Adj., float, readonly









	auction:	Auction date, many2one, readonly









	object:	No of objects, integer, readonly









	buyer:	Buyer, many2one, readonly









	avg_price:	Avg Adj., float, readonly









	date:	Create Date, date









	buyer_login:	Buyer Login, char, readonly








Object: Auction Reporting on buyer view (report.buyer.auction2)





	gross_revenue:	Gross Revenue, float, readonly









	net_revenue:	Net Revenue, float, readonly









	auction:	Auction date, many2one, readonly









	net_margin:	Net Margin, float, readonly









	buyer:	Buyer, many2one, readonly









	sumadj:	Sum of adjustication, float, readonly









	date:	Create Date, date, required









	buyer_login:	Buyer Login, char, readonly








Object: Auction Reporting on seller view (report.seller.auction)





	total_price:	Total adjudication, float, readonly









	auction:	Auction date, many2one, readonly









	object_number:	No of Objects, integer, readonly









	seller:	Seller, many2one, readonly









	state:	Status, selection, readonly









	avg_estimation:	Avg estimation, float, readonly









	avg_price:	Avg adjudication, float, readonly









	date:	Create Date, date, required








Object: Auction Reporting on seller view2 (report.seller.auction2)





	gross_revenue:	Gross revenue, float, readonly









	sum_adj:	Sum Adjustication, float, readonly









	net_revenue:	Net revenue, float, readonly









	auction:	Auction date, many2one, readonly









	seller:	Seller, many2one, readonly









	date:	Auction date, date, required









	net_margin:	Net margin, float, readonly








Object: Auction Reporting on  view2 (report.auction.view2)





	gross_revenue:	Gross revenue, float, readonly









	obj_number:	# of Objects, integer, readonly









	sum_adj:	Sum of adjudication, float, readonly









	net_revenue:	Net revenue, float, readonly









	auction:	Auction date, many2one, readonly









	obj_margin_procent:

		Net margin (%), float, readonly









	obj_margin:	Avg margin, float, readonly









	date:	Auction date, date, required








Object: Auction Reporting on view1 (report.auction.view)





	max_est:	Maximum Estimation, float, readonly









	min_est:	Minimum Estimation, float, readonly









	nseller:	No of sellers, float, readonly









	nbuyer:	No of buyers, float, readonly









	nobjects:	No of objects, float, readonly









	obj_ret:	# obj ret, integer, readonly









	auction_id:	Auction date, many2one, readonly









	adj_price:	Adjudication price, float, readonly








Object: Objects per day (report.auction.object.date)





	month:	Month, date









	user_id:	User, many2one









	obj_num:	# of Objects, integer









	name:	Created date, date








Object: comparison estimate/adjudication  (report.auction.estimation.adj.category)





	user_id:	User, many2one









	lot_type:	Object Type, selection









	adj_total:	Total Adjudication, float









	date:	Date, date, readonly









	lot_est1:	Minimum Estimation, float









	lot_est2:	Maximum Estimation, float








Object: report_auction_adjudication (report.auction.adjudication)





	date:	Date, date, readonly









	adj_total:	Total Adjudication, float









	state:	Status, selection









	user_id:	User, many2one









	name:	Auction date, many2one, readonly








Object: Report Sign In/Out (report.attendance)





	total_attendance:

		Total, float, readonly









	employee_id:	Employee, many2one, readonly









	name:	Date, date, readonly








Object: Report deposit border (report.deposit.border)





	total_marge:	Total margin, float, readonly









	nb_obj:	# of objects, float, readonly









	bord:	Depositer Inventory, char, required









	moy_est:	Avg. Est, float, readonly









	seller:	Seller, many2one








Object: Object encoded (report.object.encoded)





	user_id:	User, many2one









	obj_num:	# of Encoded obj., integer, readonly









	obj_ret:	# obj ret, integer, readonly









	state:	Status, selection, required









	date:	Create Date, date, required









	estimation:	Estimation, float








Object: Object encoded (report.object.encoded.manager)





	gross_revenue:	Gross revenue, float, readonly









	user_id:	User, many2one









	obj_num:	# of Encoded obj., integer, readonly









	net_revenue:	Net revenue, float, readonly









	obj_ret:	# obj ret, integer, readonly









	obj_margin:	Net margin, float, readonly









	date:	Create Date, date, required









	estimation:	Estimation, float









	adj:	Adj., integer, readonly








Object: Unclassified objects  (report.unclassified.objects)





	obj_num:	Catalog Number, integer









	auction:	Auction date, many2one, readonly









	obj_comm:	Commission, boolean









	obj_price:	Adjudication price, float









	name:	Short Description, char, required









	lot_type:	Object category, selection









	state:	Status, selection, required, readonly









	lot_num:	List Number, integer, required









	lot_est1:	Minimum Estimation, float









	lot_est2:	Maximum Estimation, float









	bord_vnd_id:	Depositer Inventory, many2one, required









	ach_login:	Buyer Username, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Audit Trail (audittrail)





	Module:	audittrail


	Name:	Audit Trail


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	audittrail


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Allows the administrator to track every user operation on all objects of the system.
    Subscribe Rules for read, write, create and delete on objects and check logs








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/audittrail.zip]

	trunk [http://www.openerp.com/download/modules/trunk/audittrail.zip]









Dependencies



	base

	account

	purchase

	mrp









Reports

None




Menus



	Administration/Audittrails

	Administration/Audittrails/Rules

	Administration/Audittrails/Rules/Subscribed Rules

	Administration/Audittrails/Logs

	Administration/Audittrails/View Logs









Views



	audittrail.rule.form (form)

	audittrail.rule.tree (tree)

	audittrail.log.form (form)

	audittrail.log.tree (tree)









Objects


Object: audittrail.rule (audittrail.rule)





	log_read:	Log reads, boolean









	log_unlink:	Log deletes, boolean









	user_id:	Users, many2many









	name:	Rule Name, char, required









	log_write:	Log writes, boolean









	object_id:	Object, many2one, required









	log_create:	Log creates, boolean









	state:	State, selection, required









	action_id:	Action ID, many2one








Object: audittrail.log (audittrail.log)





	user_id:	User, many2one









	name:	Name, char









	timestamp:	Date, datetime









	object_id:	Object, many2one









	line_ids:	Log lines, one2many









	res_id:	Resource Id, integer









	method:	Method, selection








Object: audittrail.log.line (audittrail.log.line)





	log:	Log ID, integer









	log_id:	Log, many2one









	old_value:	Old Value, text









	field_id:	Fields, many2one, required









	old_value_text:	Old value Text, text









	field_description:

		Field Description, char









	new_value:	New Value, text









	new_value_text:	New value Text, text
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Email Invoice - Send email to customers or suppliers (auto_email_account)





	Module:	auto_email_account


	Name:	Email Invoice - Send email to customers or suppliers


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	auto_email_account


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Use Email client module to send to customers or suppliers
the selected invoices attached by Email








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/auto_email_account.zip]

	trunk [http://www.openerp.com/download/modules/trunk/auto_email_account.zip]









Dependencies



	smtpclient

	account









Reports

None




Menus

None




Views

None




Objects

None
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邮寄销售订单 - 发送邮件给客户 (auto_email_sale)





	Module:	auto_email_sale


	Name:	Email Sale order - Send Email to customers


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	auto_email_sale


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






描述

使用邮件客户端模块发送邮件给客户
选中的销售订单被附加为邮件附件








下载链接

你可以通过以下链接下载这个模块的ZIP文件:



	5.0 [http://www.openerp.com/download/modules/5.0/auto_email_sale.zip]

	trunk [http://www.openerp.com/download/modules/trunk/auto_email_sale.zip]









依赖



	smtpclient

	sale









报表

None




菜单

None




视图

None




对象

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Auto Email Stock Picking - Send email to customer and supplier from picking (auto_email_stock)





	Module:	auto_email_stock


	Name:	Auto Email Stock Picking - Send email to customer and supplier from picking


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	auto_email_stock


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Use Email Client module
    to Send the Automatic Sales Order to the
    Customer or supplier by Email
    when the Picking order confirm








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/auto_email_stock.zip]

	trunk [http://www.openerp.com/download/modules/trunk/auto_email_stock.zip]









Dependencies



	smtpclient

	stock









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base (base)





	Module:	base


	Name:	Base


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	base


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

The kernel of OpenERP, needed for all installation.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies

None




Reports



	Technical guide

	Labels









Menus



	Administration

	Administration/Low Level Objects

	Administration/Low Level Objects/Workflow Items

	Administration/Customization

	Administration/Customization/Actions

	Administration/Configuration

	Administration/Translations

	Administration/Translations/Application Terms

	Administration/Translations/Import / Export

	Administration/Users

	Administration/Security

	Administration/Modules Management

	Partners/Configuration/Localisation/Currencies

	Partners/Configuration

	Partners/Partners/New Partner

	Administration/Maintenance/Your Maintenance Contracts

	Administration/Customization/User Interface

	Administration/Customization/Actions/Connect Actions To Client Events

	Administration/Low Level Objects/Client Actions Connections

	Administration/Configuration/Sequences

	Administration/Configuration/Sequences/Sequences

	Administration/Configuration/Sequences/Sequence Types

	Administration/Low Level Objects/Actions

	Administration/Low Level Objects/Actions/Actions

	Administration/Low Level Objects/Actions/Report Custom

	Administration/Low Level Objects/Actions/Report Xml

	Administration/Low Level Objects/Actions/Window Actions

	Administration/Low Level Objects/Actions/Wizards

	Administration/Users/Company’s Structure

	Administration/Users/Company’s Structure/Companies

	Administration/Users/Users

	Administration/Users/Groups

	Administration/Users/Roles Structure

	Administration/Users/Roles Structure/Roles

	Administration/Customization/User Interface/Views

	Administration/Low Level Objects/Attachments

	Administration/Customization/Database Structure

	Administration/Customization/Database Structure/Objects

	Administration/Customization/Database Structure/Fields

	Administration/Translations/Application Terms/All terms

	Administration/Translations/Application Terms/All terms/Untranslated terms

	Administration/Security/Grant Access To Menus

	Administration/Configuration/Scheduler

	Administration/Configuration/Scheduler/Scheduled Actions

	Administration/Security/Access Controls

	Administration/Security/Access Controls/Access Controls List

	Administration/Security/Record Rules

	Administration/Customization/Actions/Server Actions

	Administration/Security/Access Controls/Access Controls Grid

	Administration/Configuration/Configuration Wizards

	Administration/Configuration/Configuration Wizards/Config Wizard Steps

	Administration/Configuration/Configuration Wizards/Configuration Wizard

	Administration/Customization/Workflow Definitions

	Administration/Customization/Workflow Definitions/Workflows

	Administration/Customization/Workflow Definitions/Activities

	Administration/Customization/Workflow Definitions/Transitions

	Administration/Low Level Objects/Workflow Items/Instances

	Administration/Low Level Objects/Workflow Items/Workitems

	Administration/Modules Management/Import module

	Administration/Modules Management/Update Modules List

	Administration/Modules Management/Apply Scheduled Upgrades

	Administration/Translations/Load an Official Translation

	Administration/Translations/Import / Export/Export a Translation File

	Administration/Translations/Import / Export/Import a Translation File

	Administration/Translations/Application Terms/Resynchronise Terms

	Administration/Modules Management/Categories of Modules

	Administration/Modules Management/Modules

	Administration/Modules Management/Modules/Installed modules

	Administration/Modules Management/Modules/Uninstalled modules

	Administration/Modules Management/Modules/Modules to be installed, upgraded or removed

	Administration/Modules Management/Repository list

	Administration/Low Level Objects/Requests

	Administration/Low Level Objects/Requests/Requests

	Administration/Low Level Objects/Requests/Accepted Links in Requests

	Administration/Translations/Application Terms/Languages

	Partners

	Partners/Configuration/Partner Functions

	Partners/Partner Addresses

	Partners/Configuration/Titles

	Partners/Configuration/Titles/Partner Titles

	Partners/Configuration/Titles/Contact Titles

	Partners/Partners

	Partners/Partners/Customers Partners

	Partners/Partners/Suppliers Partners

	Partners/Partners/Others Partners

	Partners/Partners/Partners by Categories

	Partners/Configuration/Partner Categories

	Partners/Configuration/Banks

	Partners/Configuration/Localisation

	Partners/Configuration/Localisation/Countries

	Partners/Configuration/Localisation/States

	Partners/Configuration/Partner Events

	Partners/Configuration/Partner Events/Channels

	Partners/Configuration/Partner Events/Active Partner Events

	Partners/Configuration/Partner Events/States of mind

	Administration/Configuration/Properties

	Administration/Configuration/Properties/Default Properties

	Administration/Configuration/Properties/All Properties

	Administration/Maintenance

	Administration/Maintenance/Add Maintenance Contract









Views



	ir.ui.menu.tree (tree)

	res.groups.form (form)

	res.users.form.modif (form)

	res.users.form (form)

	res.users.tree (tree)

	res.company.form (form)

	res.company.tree (tree)

	res.users.confirm.form (form)

	res.users.confirm.simple_view (form)

	Create Menu (form)

	ir.values.form.action (form)

	ir.values.form (form)

	ir.values.tree (tree)

	ir.sequence.form (form)

	ir.sequence.tree (tree)

	ir.sequence.type.form (form)

	ir.actions.actions (form)

	ir.actions.actions.tree (tree)

	ir.actions.report.custom (form)

	ir.actions.report.custom.tree (tree)

	ir.actions.report.xml (form)

	ir.actions.report.xml.tree (tree)

	ir.actions.windows.tree (tree)

	ir.actions.windows.form (form)

	ir.actions.wizard.tree (tree)

	ir.actions.wizard (form)

	res.roles.form (form)

	res.roles.tree (tree)

	ir.ui.view (form)

	ir.ui.view.tree (tree)

	ir.attachment.view (form)

	ir.attachment.view.tree (tree)

	ir.report.custom.fields.tree (tree)

	ir.report.custom.fields (form)

	ir.report.custom (form)

	ir.model.form (form)

	ir.model.tree (tree)

	ir.model.fields.form (form)

	ir.model.fields.tree (tree)

	Translations (form)

	Translations (tree)

	ir.ui.view_sc (form)

	ir.ui.view_sc (tree)

	ir.ui.menu.tree (tree)

	ir.ui.menu.form2 (form)

	ir.cron.tree (tree)

	ir.cron.form (form)

	ir.model.access.tree (tree)

	ir.model.access.form (form)

	Record rules (form)

	Record rules (tree)

	Rule Definition (form)

	Rules (tree)

	Server Action (form)

	Server Actions (tree)

	Config Wizard Steps (tree)

	Config Wizard Steps (form)

	Main Configuration Wizard (form)

	workflow.form (form)

	workflow.tree (tree)

	workflow.activity.form (form)

	workflow.activity.tree (tree)

	workflow.transition.form (form)

	workflow.transition.tree (tree)

	workflow.instance.form (form)

	workflow.instance.tree (tree)

	workflow.workitem.form (form)

	workflow.workitem.tree (tree)

	Export a Translation File (form)

	Update Translations (form)

	ir.module.category.form (form)

	ir.module.category.tree (tree)

	ir.module.module.form (form)

	ir.module.module.tree (tree)

	ir.module.repository.form (form)

	ir.module.repository.tree (tree)

	res.request.tree (tree)

	res.request.form (form)

	res.request.link.form (form)

	res.request.link.form (tree)

	res.request.history.tree (tree)

	res.request.history.form (form)

	res.lang.tree (tree)

	res.lang.form (form)

	res.partner.function.form (form)

	res.partner.function.tree (tree)

	res.partner.address.tree (tree)

	res.partner.address.form1 (form)

	res.partner.address.form2 (form)

	res.partner.title.form (form)

	res.partner.tree (tree)

	res.partner.form (form)

	res.payterm (form)

	res.partner.bank.type.form (form)

	res.partner.bank.type.tree (tree)

	res.partner.bank.form (form)

	res.partner.bank.tree (tree)

	res.partner.tree (tree)

	res.partner.category.form (form)

	res.partner.category.list (tree)

	res.partner.category.tree (tree)

	res.bank.form (form)

	res.bank.tree (tree)

	res.country.tree (tree)

	res.country.form (form)

	res.country.state.tree (tree)

	res.country.state.form (form)

	res.currency.tree (tree)

	res.currency.form (form)

	res.partner.canal.form (form)

	res.partner.event.type.form (form)

	res.partner.event.type.tree (tree)

	res.partner.som.tree (tree)

	res.partner.som.form (form)

	res.partner.event.form (form)

	res.partner.event.tree (tree)

	ir.property.form (form)

	ir.property.tree (tree)

	maintenance.contract.tree (tree)

	maintenance.contract.form (form)

	maintenance.contract.add.wizard (form)









Objects


Object: Objects (ir.model)





	info:	Information, text









	access_ids:	Access, one2many









	name:	Object Name, char, required









	field_id:	Fields, one2many, required









	state:	Manually Created, selection, readonly









	model:	Object, char, required








Object: Objects Security Grid (ir.model.grid)





	access_ids:	Access, one2many









	group_14:	Portal group, char









	group_44:	Point of Sale / Manager, char









	group_33:	Purchase / User, char









	group_25:	Human Resources / Attendances User, char









	group_17:	Document / Manager, char









	group_39:	Portal Account group, char









	group_38:	Portal Service group, char









	group_18:	Useability / Product UoS View, char









	group_16:	Human Resources / User, char









	group_35:	Manufacturing / Worker, char









	group_34:	Manufacturing / Manager, char









	group_37:	Sale / Salesman, char









	group_36:	Sale / Manager, char









	group_31:	Stock / Worker, char









	group_59:	Direct Marketing / Customer File Admin, char









	group_42:	Hotel / User, char









	group_32:	Purchase / Manager, char









	group_71:	Acces commandes client base, char









	group_70:	Acces commandes fournisseur, char









	state:	Manually Created, selection, readonly









	group_72:	Acces commande client admin, char









	group_13:	RadioTV / Podcast, char









	group_12:	RadioTV / Program, char









	group_11:	Comparison / Admin, char









	group_10:	CRM / User, char









	group_53:	Direct Marketing / Item Admin, char









	group_52:	Direct Marketing / Campaign Manager, char









	group_51:	Direct Marketing / Campaign Admin, char









	group_50:	Direct Marketing / Offer Manager, char









	group_57:	Direct Marketing / DTP Admin, char









	group_58:	Direct Marketing / DTP Manager, char









	group_55:	Direct Marketing / Manufacturing Admin, char









	group_54:	Direct Marketing / Item Manager, char









	group_3:	Employee, char









	group_2:	Administrator / Access Rights, char









	group_1:	Administrator / Configuration, char









	group_0:	All Users, char









	group_7:	Maintenance Manager, char









	group_6:	Partner Manager, char









	group_5:	Useability / No One, char









	group_4:	Useability / Extended View, char









	group_9:	CRM / Manager, char









	group_8:	No One Demo, char









	field_id:	Fields, one2many, required









	group_30:	Stock / Manager, char









	group_19:	Product / Manager, char









	group_40:	Portal Analytic group, char









	group_29:	Project / User, char









	group_43:	OSCommerce / User, char









	group_45:	Point of Sale / User, char









	group_64:	Acces compta admin, char









	group_41:	Portal Analytic Package group, char









	info:	Information, text









	group_28:	Project / Manager, char









	group_65:	Groupe vide, char









	name:	Object Name, char, required









	group_15:	Human Resources / Manager, char









	group_22:	Finance / Accountant, char









	group_23:	Finance / Manager, char









	group_20:	Maintenance Editor / Manager, char









	group_21:	Finance / Invoice, char









	group_26:	Finance / Payments, char









	group_27:	Project / Financial Manager, char









	group_24:	Human Resources / Contracts, char









	group_56:	Direct Marketing / Manufacturing Manager, char









	group_48:	Direct Marketing / Admin, char









	group_49:	Direct Marketing / Offer Admin, char









	group_46:	Portal Sale group, char









	group_68:	Acces stock base, char









	group_69:	Acces stock admin, char









	group_66:	Acces livre base, char









	group_67:	Acces livre admin, char









	model:	Object, char, required









	group_47:	Direct Marketing / User, char









	group_62:	Acces partenaire admin, char









	group_63:	Acces compta base, char









	group_60:	Direct Marketing / Customer File Manager, char









	group_61:	Acces partenaire base, char








Object: Fields (ir.model.fields)





	model_id:	Object ID, many2one, required









	domain:	Domain, char









	select_level:	Searchable, selection, required









	name:	Name, char, required









	on_delete:	On delete, selection






On delete property for many2one fields






	required:	Required, boolean









	state:	Manually Created, selection, required, readonly









	view_load:	View Auto-Load, boolean









	readonly:	Readonly, boolean









	selection:	Field Selection, char









	relation:	Object Relation, char









	groups:	Groups, many2many









	relation_field:	Relation Field, char









	complete_name:	Complete Name, char









	model:	Object Name, char, required









	translate:	Translate, boolean









	ttype:	Field Type, selection, required









	field_description:

		Field Label, char, required









	size:	Size, integer








Object: ir.model.access (ir.model.access)





	model_id:	Object, many2one, required









	perm_read:	Read Access, boolean









	name:	Name, char, required









	perm_unlink:	Delete Permission, boolean









	perm_write:	Write Access, boolean









	perm_create:	Create Access, boolean









	group_id:	Group, many2one








Object: ir.model.data (ir.model.data)





	noupdate:	Non Updatable, boolean









	name:	XML Identifier, char, required









	res_id:	Resource ID, integer









	date_update:	Update Date, datetime









	module:	Module, char, required









	model:	Object, char, required









	date_init:	Init Date, datetime








Object: ir.model.config (ir.model.config)





	password_check:	Confirmation, char









	password:	Password, char








Object: ir.sequence.type (ir.sequence.type)





	code:	Sequence Code, char, required









	name:	Sequence Name, char, required








Object: ir.sequence (ir.sequence)





	code:	Sequence Code, selection, required









	name:	Sequence Name, char, required









	number_next:	Next Number, integer, required









	padding:	Number padding, integer, required









	number_increment:

		Increment Number, integer, required









	prefix:	Prefix, char









	fiscal_ids:	Sequences, one2many









	active:	Active, boolean









	suffix:	Suffix, char








Object: ir.ui.menu (ir.ui.menu)





	groups_id:	Groups, many2many






If you have groups, the visibility of this menu will be based on these groups. If this field is empty, OpenERP will compute visibility based on the related object’s read access.






	name:	Menu, char, required









	sequence:	Sequence, integer









	parent_id:	Parent Menu, many2one









	complete_name:	Complete Name, char, readonly









	action:	Action, reference









	child_id:	Child IDs, one2many









	icon_pict:	unknown, picture, readonly









	icon:	Icon, selection








Object: ir.ui.view.custom (ir.ui.view.custom)





	arch:	View Architecture, text, required









	user_id:	User, many2one









	ref_id:	Original View, many2one








Object: ir.ui.view (ir.ui.view)





	inherit_id:	Inherited View, many2one









	name:	View Name, char, required









	type:	View Type, selection, required









	priority:	Priority, integer, required









	model:	Object, char, required









	arch:	View Architecture, text, required









	field_parent:	Child Field, char








Object: ir.ui.view_sc (ir.ui.view_sc)





	resource:	Resource Name, char, required









	res_id:	Resource Ref., many2one









	user_id:	User Ref., many2one, required









	name:	Shortcut Name, char, required









	sequence:	Sequence, integer








Object: ir.default (ir.default)





	uid:	Users, many2one









	ref_table:	Table Ref., char









	company_id:	Company, many2one









	value:	Default Value, char









	ref_id:	ID Ref., integer









	field_tbl:	Object, char









	field_name:	Object Field, char









	page:	View, char








Object: ir.actions.actions (ir.actions.actions)





	usage:	Action Usage, char









	type:	Action Type, char, required









	name:	Action Name, char, required








Object: ir.actions.report.custom (ir.actions.report.custom)





	multi:	On multiple doc., boolean






If set to true, the action will not be displayed on the right toolbar of a form view.






	name:	Report Name, char, required









	portal_visible:	Visible in Portal, boolean









	usage:	Action Usage, char









	model:	Object, char, required









	type:	Report Type, char, required









	report_id:	Report Ref., integer, required








Object: ir.actions.report.xml (ir.actions.report.xml)





	groups_id:	Groups, many2many









	report_rml_content:

		RML content, binary









	portal_visible:	Visible in Portal, boolean









	header:	Add RML header, boolean






Add or not the corporate RML header






	report_type:	Type, selection, required









	report_sxw_content:

		SXW content, binary









	attachment:	Save As Attachment Prefix, char






This is the filename of the attachment used to store the printing result. Keep empty to not save the printed reports. You can use a python expression with the object and time variables.






	usage:	Action Usage, char









	report_sxw_content_data:

		SXW content, binary









	type:	Report Type, char, required









	report_xml:	XML path, char









	model_id:	Model Id, float, readonly









	report_rml_content_data:

		RML content, binary









	auto:	Automatic XSL:RML, boolean, required









	report_sxw:	SXW path, char, readonly









	document_id:	Document, integer









	multi:	On multiple doc., boolean






If set to true, the action will not be displayed on the right toolbar of a form view.






	report_xsl:	XSL path, char









	name:	Name, char, required









	report_rml:	RML path, char






The .rml path of the file or NULL if the content is in report_rml_content






	report_name:	Internal Name, char, required









	attachment_use:	Reload from Attachment, boolean






If you check this, then the second time the user prints with same attachment name, it returns the previous report.






	model:	Object, char, required








Object: ir.actions.act_window (ir.actions.act_window)





	groups_id:	Groups, many2many









	domain:	Domain Value, char









	target:	Target Window, selection









	view_type:	View Type, selection









	res_model:	Object, char









	view_id:	View Ref., many2one









	portal_visible:	Visible in Portal, boolean









	auto_refresh:	Auto-Refresh, integer






Add an auto-refresh on the view






	src_model:	Source Object, char









	view_mode:	View Mode, char









	limit:	Limit, integer






Default limit for the list view






	context:	Context Value, char









	type:	Action Type, char, required









	usage:	Action Usage, char









	view_ids:	Views, one2many









	views:	Views, binary, readonly









	name:	Action Name, char








Object: ir.actions.act_window.view (ir.actions.act_window.view)





	act_window_id:	Action, many2one









	view_id:	View, many2one









	multi:	On Multiple Doc., boolean






If set to true, the action will not be displayed on the right toolbar of a form view.






	view_mode:	View Type, selection, required









	sequence:	Sequence, integer








Object: ir.actions.wizard (ir.actions.wizard)





	groups_id:	Groups, many2many









	multi:	Action on Multiple Doc., boolean






If set to true, the wizard will not be displayed on the right toolbar of a form view.






	name:	Wizard Info, char, required









	portal_visible:	Visible in Portal, boolean









	wiz_name:	Wizard Name, char, required









	usage:	Action Usage, char









	model:	Object, char









	type:	Action Type, char, required








Object: ir.actions.url (ir.actions.url)





	url:	Action URL, text, required









	type:	Action Type, char, required









	name:	Action Name, char









	target:	Action Target, selection, required








Object: ir.server.object.lines (ir.server.object.lines)





	server_id:	Object Mapping, many2one









	type:	Type, selection, required









	value:	Value, text, required









	col1:	Destination, many2one, required








Object: ir.actions.server (ir.actions.server)





	code:	Python Code, text






Python code to be executed






	sequence:	Sequence, integer






Important when you deal with multiple actions, the execution order will be decided based on this, low number is higher priority.






	write_id:	Write Id, char






Provide the field name that the record id refers to for the write operation. If it is empty it will refer to the active id of the object.






	message:	Message, text






Specify the message. You can use the fields from the object. e.g. `Dear [[ object.partner_id.name ]]`






	email_server:	Email Server, many2one









	subject:	Subject, char






Specify the subject. You can use fields from the object, e.g. `Hello [[ object.partner_id.name ]]`






	loop_action:	Loop Action, many2one






Select the action that will be executed. Loop action will not be available inside loop.






	trigger_obj_id:	Trigger On, many2one






Select the object from the model on which the workflow will executed.






	sms:	SMS, char









	wkf_model_id:	Workflow On, many2one






Workflow to be executed on this model.






	state:	Action Type, selection, required






Type of the Action that is to be executed






	sms_server:	SMS Server, many2one









	usage:	Action Usage, char









	type:	Action Type, char, required









	email:	Email Address, char






Provides the fields that will be used to fetch the email address, e.g. when you select the invoice, then `object.invoice_address_id.email` is the field which gives the correct address






	action_id:	Client Action, many2one






Select the Action Window, Report, Wizard to be executed.






	model_id:	Object, many2one, required






Select the object on which the action will work (read, write, create).






	child_ids:	Other Actions, many2many









	record_id:	Create Id, many2one






Provide the field name where the record id is stored after the create operations. If it is empty, you can not track the new record.






	srcmodel_id:	Model, many2one






Object in which you want to create / write the object. If it is empty then refer to the Object field.






	trigger_name:	Trigger Name, selection






Select the Signal name that is to be used as the trigger.






	dm_action:	Action, boolean









	condition:	Condition, char, required






Condition that is to be tested before action is executed, e.g. object.list_price > object.cost_price






	fields_lines:	Field Mappings., one2many









	name:	Action Name, char, required






Easy to Refer action by name e.g. One Sales Order -> Many Invoices






	mobile:	Mobile No, char






Provides fields that be used to fetch the mobile number, e.g. you select the invoice, then `object.invoice_address_id.mobile` is the field which gives the correct mobile number






	expression:	Loop Expression, char






Enter the field/expression that will return the list. E.g. select the sale order in Object, and you can have loop on the sales order line. Expression = `object.order_line`.





Object: ir.actions.act_window_close (ir.actions.act_window_close)





	usage:	Action Usage, char









	type:	Action Type, char, required









	name:	Action Name, char, required








Object: ir.actions.todo (ir.actions.todo)





	groups_id:	Groups, many2many









	name:	Name, char, required









	end_date:	End Date, datetime









	sequence:	Sequence, integer









	note:	Text, text









	state:	State, selection, required









	users_id:	Users, many2many









	start_on:	Start On, selection









	active:	Active, boolean









	type:	Type, selection, required









	start_date:	Start Date, datetime









	action_id:	Action, many2one, required








Object: ir.actions.configuration.wizard (ir.actions.configuration.wizard)





	item_id:	Next Configuration Wizard, many2one, readonly









	progress:	Configuration Progress, float, readonly









	name:	Next Wizard, text, readonly








Object: ir.report.custom (ir.report.custom)





	menu_id:	Menu, many2one









	model_id:	Object, many2one, required









	print_format:	Print format, selection, required









	limitt:	Limit, char









	fields_child0:	Fields, one2many, required









	repeat_header:	Repeat Header, boolean









	title:	Report Title, char, required









	state:	State, selection









	frequency:	Frequency, selection









	sortby:	Sorted By, char









	print_orientation:

		Print orientation, selection, required









	footer:	Report Footer, char, required









	field_parent:	Child Field, many2one









	type:	Report Type, selection, required









	name:	Report Name, char, required








Object: ir.report.custom.fields (ir.report.custom.fields)





	fc2_op:	Relation, selection









	groupby:	Group By, boolean









	fc1_op:	Relation, selection









	operation:	unknown, selection









	alignment:	Alignment, selection, required









	fc2_operande:	Constraint, many2one









	fc2_condition:	condition, char









	fc0_op:	Relation, selection









	sequence:	Sequence, integer, required









	fc3_operande:	Constraint, many2one









	fc0_condition:	Condition, char









	bgcolor:	Background Color, char









	fontcolor:	Font color, char









	fc1_operande:	Constraint, many2one









	field_child1:	Field child1, many2one









	field_child0:	Field child0, many2one, required









	field_child3:	Field child3, many2one









	field_child2:	Field child2, many2one









	fc1_condition:	condition, char









	cumulate:	Accumulate, boolean









	report_id:	Report Ref, many2one









	fc3_op:	Relation, selection









	name:	Name, char, required









	fc3_condition:	condition, char









	fc0_operande:	Constraint, many2one









	width:	Fixed Width, integer








Object: ir.attachment (ir.attachment)





	create_date:	Date Created, datetime, readonly









	file_type:	Content Type, char









	res_model:	Attached Model, char









	write_uid:	Last Modification User, many2one, readonly









	vt_url:	VirusTotal URL, char, readonly









	file_size:	File Size, integer, required









	partner_id:	Partner, many2one









	create_uid:	Creator, many2one, readonly









	user_id:	Owner, many2one









	title:	Resource Title, char









	parent_id:	Directory, many2one









	vt_status:	VirusTotal status, selection, readonly









	index_content:	Indexed Content, text









	preview:	Image Preview, binary, readonly









	res_id:	Attached ID, integer









	store_fname:	Stored Filename, char









	description:	Description, text









	store_method:	Storing Method, selection









	link:	Link, char









	write_date:	Date Modified, datetime, readonly









	vt_status_pict:	unknown, picture, readonly









	group_ids:	Groups, many2many









	name:	Attachment Name, char, required









	datas:	File Content, binary









	datas_fname:	Filename, char








Object: ir.cron (ir.cron)





	function:	Function, char









	args:	Arguments, text









	user_id:	User, many2one, required









	name:	Name, char, required









	interval_type:	Interval Unit, selection









	numbercall:	Number of Calls, integer






Number of time the function is called,
a negative number indicates that the function will always be called






	nextcall:	Next Call Date, datetime, required









	priority:	Priority, integer






0=Very Urgent
10=Not urgent






	doall:	Repeat Missed, boolean









	active:	Active, boolean









	interval_number:

		Interval Number, integer









	model:	Object, char








Object: ir.values (ir.values)





	model_id:	Object, many2one






This field is not used, it only helps you to select a good model.






	object:	Is Object, boolean









	user_id:	User, many2one









	name:	Name, char









	key2:	Event Type, char






The kind of action or button in the client side that will trigger the action.






	value_unpickle:	Value, text









	company_id:	Company, many2one









	value:	Value, text









	meta:	Metadata, text









	key:	Type, selection









	res_id:	Object ID, integer






Keep 0 if the action must appear on all resources.






	model:	Object Name, char









	meta_unpickle:	Metadata, text









	action_id:	Action, many2one






This field is not used, it only helps you to select the right action.





Object: ir.translation (ir.translation)





	lang:	Language, selection









	src:	Source, text









	name:	Field Name, char, required









	type:	Type, selection









	value:	Translation Value, text









	res_id:	Resource ID, integer








Object: ir.exports (ir.exports)





	export_fields:	Export ID, one2many









	resource:	Resource, char









	name:	Export Name, char








Object: ir.exports.line (ir.exports.line)





	export_id:	Export, many2one









	name:	Field Name, char








Object: workflow (workflow)





	activities:	Activities, one2many









	on_create:	On Create, boolean









	name:	Name, char, required









	osv:	Resource Object, char, required








Object: workflow.activity (workflow.activity)





	kind:	Kind, selection, required









	name:	Name, char, required









	join_mode:	Join Mode, selection, required









	wkf_id:	Workflow, many2one, required









	flow_stop:	Flow Stop, boolean









	subflow_id:	Subflow, many2one









	split_mode:	Split Mode, selection, required









	action:	Python Action, text









	signal_send:	Signal (subflow.*), char









	flow_start:	Flow Start, boolean









	out_transitions:

		Outgoing Transitions, one2many









	in_transitions:	Incoming Transitions, one2many









	action_id:	Server Action, many2one








Object: workflow.transition (workflow.transition)





	trigger_model:	Trigger Object, char









	signal:	Signal (button Name), char









	role_id:	Role Required, many2one









	act_from:	Source Activity, many2one, required









	condition:	Condition, char, required









	trigger_expr_id:

		Trigger Expression, char









	act_to:	Destination Activity, many2one, required








Object: workflow.instance (workflow.instance)





	res_type:	Resource Object, char









	wkf_id:	Workflow, many2one









	res_id:	Resource ID, integer









	uid:	User ID, integer









	state:	State, char








Object: workflow.workitem (workflow.workitem)





	subflow_id:	Subflow, many2one









	act_id:	Activity, many2one, required









	state:	State, char









	inst_id:	Instance, many2one, required








Object: workflow.triggers (workflow.triggers)





	instance_id:	Destination Instance, many2one









	workitem_id:	Workitem, many2one, required









	model:	Object, char









	res_id:	Resource ID, integer








Object: ir.rule.group (ir.rule.group)





	model_id:	Object, many2one, required









	name:	Name, char









	rules:	Tests, one2many






The rule is satisfied if at least one test is True






	global:	Global, boolean






Make the rule global, otherwise it needs to be put on a group or user






	groups:	Groups, many2many









	users:	Users, many2many








Object: ir.rule (ir.rule)





	domain:	Domain, char, readonly









	domain_force:	Force Domain, char









	field_id:	Field, many2one, required









	operand:	Operand, selection, required









	operator:	Operator, selection, required









	rule_group:	Group, many2one, required








Object: wizard.ir.model.menu.create (wizard.ir.model.menu.create)





	menu_id:	Parent Menu, many2one, required









	model_id:	Object, many2one, required









	view_ids:	Views, one2many









	name:	Menu Name, char, required








Object: wizard.ir.model.menu.create.line (wizard.ir.model.menu.create.line)





	view_id:	View, many2one









	sequence:	Sequence, integer









	wizard_id:	Wizard, many2one









	view_type:	View Type, selection, required








Object: wizard.module.lang.export (wizard.module.lang.export)





	lang:	Language, selection






To export a new language, do not select a language.






	name:	Filename, char, readonly









	format:	File Format, selection, required









	advice:	Advice, text, readonly









	modules:	Modules, many2many









	state:	unknown, selection









	data:	File, binary, readonly








Object: wizard.module.update_translations (wizard.module.update_translations)





	lang:	Language, selection, required








Object: Module Repository (ir.module.repository)





	url:	URL, char, required









	filter:	Filter, char, required






Regexp to search module on the repository webpage:
- The first parenthesis must match the name of the module.
- The second parenthesis must match the whole version number.
- The last parenthesis must match the extension of the module.






	active:	Active, boolean









	name:	Name, char









	sequence:	Sequence, integer, required








Object: Module Category (ir.module.category)





	parent_id:	Parent Category, many2one









	module_nr:	Number of Modules, integer, readonly









	child_ids:	Child Categories, one2many









	name:	Name, char, required








Object: Module (ir.module.module)





	website:	Website, char, readonly









	menus_by_module:

		Menus, text, readonly









	license:	License, selection, readonly









	reports_by_module:

		Reports, text, readonly









	description:	Description, text, readonly









	certificate:	Quality Certificate, char, readonly









	author:	Author, char, readonly









	url:	URL, char









	demo:	Demo data, boolean









	published_version:

		Published Version, char, readonly









	installed_version:

		Latest version, char, readonly









	latest_version:	Installed version, char, readonly









	dependencies_id:

		Dependencies, one2many, readonly









	views_by_module:

		Views, text, readonly









	state:	State, selection, readonly









	shortdesc:	Short Description, char, readonly









	category_id:	Category, many2one, readonly









	name:	Name, char, required, readonly








Object: Module dependency (ir.module.module.dependency)





	module_id:	Module, many2one









	state:	State, selection, readonly









	name:	Name, char








Object: Country (res.country)





	main_language:	Main Language, many2one









	code:	Country Code, char, required






The ISO country code in two chars.
You can use this field for quick search.






	name:	Country Name, char, required






The full name of the country.






	payment_method_ids:

		Payment Methods, many2many









	forwarding_charge:

		Forwarding Charge, float









	main_currency:	Main Currency, many2one









	intrastat:	Intrastat member, boolean








Object: Country state (res.country.state)





	code:	State Code, char, required






The state code in three chars.






	country_id:	Country, many2one, required









	name:	State Name, char, required








Object: Bank (res.bank)





	city:	City, char









	fax:	Fax, char









	code:	Code, char









	name:	Name, char, required









	zip:	Zip, char









	country:	Country, many2one









	street2:	Street2, char









	bic:	BIC/Swift code, char






Bank Identifier Code






	phone:	Phone, char









	state:	State, many2one









	street:	Street, char









	clearing:	Clearing number, char









	active:	Active, boolean









	email:	E-Mail, char









	bilateral:	Bilateral Relationship, char






This field may contain indications on the processing to be applied, e.g. an indication concerning the globalisation of these payments. The content of this field must be laid down on a bilateral basis between the bank and its client.





Object: Function of the contact (res.partner.function)





	code:	Code, char, required









	ref:	Notes, char









	name:	Function Name, char, required








Object: Payment term (res.payterm)





	name:	Payment Term (short name), char








Object: Partner Categories (res.partner.category)





	name:	Category Name, char, required









	child_ids:	Child Categories, one2many









	parent_id:	Parent Category, many2one









	complete_name:	Full Name, char, readonly









	active:	Active, boolean






The active field allows you to hide the category without removing it.






	export_enabled:	Export this category to financial software, boolean








Object: res.partner.title (res.partner.title)





	gender_id:	Gender, many2one









	domain:	Domain, selection, required









	name:	Title, char, required









	shortcut:	Shortcut, char, required








Object: Partner (res.partner)





	ean13:	EAN, char






Barcode number for EAN8 EAN13 UPC JPC GTIN






	property_account_position:

		Fiscal Position, many2one






The fiscal position will determine taxes and the accounts used for the partner.






	excise:	Exices Number, char









	ref_companies:	Companies that refers to partner, one2many









	fleets:	Fleets, one2many









	property_stock_customer:

		Customer Location, many2one






This stock location will be used, instead of the default one, as the destination location for goods you send to this partner






	property_product_pricelist:

		Sale Pricelist, many2one






This pricelist will be used, instead of the default one,                     for sales to the current partner






	title:	Title, selection









	vat_no:	VAT Number, char









	parent_id:	Main Company, many2one









	membership_cancel:

		Cancel membership date, date, readonly









	decoy_for_campaign:

		Used for Campaigns, boolean






Define if this decoy address can be used with campaigns






	client_media_ids:

		Client for Media, many2many









	child_ids:	Partner Ref., one2many









	number:	Number, char, readonly









	property_stock_supplier:

		Supplier Location, many2one






This stock location will be used, instead of the default one, as the source location for goods you receive from the current partner






	language_ids:	Other Languages, many2many









	partner_ref:	Partner Ref., char






The reference of my company for this partner






	name:	Name, char, required









	decoy_external_ref:

		External Reference, char






The reference of the decoy address for the owner






	debit_limit:	Payable Limit, float









	property_delivery_carrier:

		Delivery Method, many2one






This delivery method will be used when invoicing from packing.






	property_account_receivable:

		Account Receivable, many2one, required






This account will be used instead of the default one as the receivable account for the current partner






	domiciliation_bool:

		Domiciliation, boolean









	decoy_for_renting:

		Used for File Renting, boolean






Define if this decoy address can be used with used with customers files renting






	div:	Division, char









	sale_warn_msg:	Message for Sale Order, text









	logo:	Logo, binary









	debit:	Total Payable, float, readonly






Total amount you have to pay to this supplier.






	supplier:	Supplier, boolean






Check this box if the partner is a supplier. If unchecked, purchasing staff will not see it when encoding a purchase order.






	ref:	Acronym, char









	picking_warn:	Stock Picking, selection






Selecting the “Warning” option will notify user with the message, Selecting “Blocking Message” will throw an exception with the message and block the flow. The Message has to be written in the next field.






	free_member:	Free member, boolean









	membership_amount:

		Membership amount, float






The price negotiated by the partner






	address:	Contacts, one2many









	active:	Active, boolean









	cst_no:	CST Number, char









	property_product_pricelist_purchase:

		Purchase Pricelist, many2one






This pricelist will be used, instead of the default one, for purchases from the current partner






	state_ids:	Allowed States, many2many









	credit:	Total Receivable, float, readonly






Total amount this customer owes you.






	range:	Range, char









	ser_tax:	Service Tax Number, char









	magento_id:	Magento partner id, integer









	comment:	Notes, text









	sale_warn:	Sale Order, selection






Selecting the “Warning” option will notify user with the message, Selecting “Blocking Message” will throw an exception with the message and block the flow. The Message has to be written in the next field.






	decoy_owner:	Decoy Address Owner, many2one






The partner this decoy address belongs to






	purchase_warn:	Purchase Order, selection






Selecting the “Warning” option will notify user with the message, Selecting “Blocking Message” will throw an exception with the message and block the flow. The Message has to be written in the next field.






	to_export:	To export, boolean









	country_ids:	Allowed Countries, many2many









	dm_contact_id:	Address To Use, many2one









	header:	Header (.odt), binary









	member_lines:	Membership, one2many









	property_invoice_type:

		Invoicing Method, many2one






The type of journal used for sales and packing.






	city:	City, char









	user_id:	Dedicated Salesman, many2one






The internal user that is in charge of communicating with this partner if any.






	sub_fleets:	Sub Fleets, one2many









	partner_ids:	Parent Companies, one2many









	vat:	VAT, char






Value Added Tax number. Check the box if the partner is subjected to the VAT. Used by the VAT legal statement.






	website:	Website, char









	picking_warn_msg:

		Message for Stock Picking, text









	to_update:	To update, boolean









	answers_ids:	Answers, many2many









	participation_ids:

		Participations, one2many









	esale_oscom_id:	OScommerce Id, integer









	customer:	Customer, boolean






Check this box if the partner is a customer.






	purchase_warn_msg:

		Message for Purchase Order, text









	membership_start:

		Start membership date, date, readonly









	country:	Country, many2one









	membership_stop:

		Stop membership date, date, readonly









	discount_campaign:

		Discount Campaign, many2one









	invoice_warn_msg:

		Message for Invoice, text









	relation_ids:	Relations, one2many









	prospect_media_ids:

		Prospect for Media, many2many









	domiciliation:	Domiciliation Number, char









	decoy_address:	Decoy Address, boolean






A decoy address is an address used to identify illegal uses of a customers file






	pan_no:	PAN Number, char









	invoice_warn:	Invoice, selection






Selecting the “Warning” option will notify user with the message, Selecting “Blocking Message” will throw an exception with the message and block the flow. The Message has to be written in the next field.






	property_account_payable:

		Account Payable, many2one, required






This account will be used instead of the default one as the payable account for the current partner






	partner_location:

		Partner Location, selection









	turnover_id:	Turnover, one2many









	events:	Events, one2many









	associate_member:

		Associate member, many2one









	bank_ids:	Banks, one2many









	vat_subjected:	VAT Legal Statement, boolean






Check this box if the partner is subjected to the VAT. It will be used for the VAT legal statement.






	signature:	Signature, binary









	property_product_pricelist_customer:

		Customer Pricelist, many2one









	decoy_media_ids:

		decoy address for Media, many2many









	date:	Date, date









	lang:	Language, selection






If the selected language is loaded in the system, all documents related to this partner will be printed in that language. If not, it will be English.






	membership_state:

		Current membership state, selection, readonly









	credit_limit:	Credit Limit, float









	payment_type_customer:

		Payment type, many2one






Payment type of the customer






	property_payment_term:

		Payment Term, many2one






This payment term will be used instead of the default one for the current partner






	payment_type_supplier:

		Payment type, many2one






Payment type of the supplier






	category_id:	Categories, many2many








Object: Partner Addresses (res.partner.address)





	comment:	Notes, text









	dn:	Distinguished name, char









	last_name:	Last Name, char









	photo:	Photo, binary






Photograph of the contact






	zarafa_id:	Z-Id, char









	street:	Street, char









	partner_id:	Partner, many2one






Keep empty for a private address, not related to partner.






	city:	City, char









	first_name:	First Name, char









	name_complement:

		Name Complement, char









	zip:	Zip, char









	title:	Title, selection









	country_id:	Country, many2one









	type:	Address Type, selection






Used to select automatically the right address according to the context in sales and purchases documents.






	email:	E-Mail, char









	function:	Function, many2one









	fax:	Fax, char









	firstname:	First Name, char









	street2:	Street2, char









	street3:	Street3, char









	street4:	Street4, char









	phone:	Phone, char









	active:	Active, boolean






Uncheck the active field to hide the contact.






	job_ids:	Contacts, one2many









	esale_oscom_id:	OScommerce Id, integer









	name:	Name, char, readonly









	mobile:	Mobile, char









	birthdate:	Birthdate, char









	complete_address:

		Complete Name, char, readonly









	state_id:	Fed. State, many2one








Object: Bank Account Type (res.partner.bank.type)





	code:	Code, char, required









	name:	Name, char, required









	field_ids:	Type fields, one2many








Object: Bank type fields (res.partner.bank.type.field)





	size:	Max. Size, integer









	readonly:	Readonly, boolean









	required:	Required, boolean









	name:	Field Name, char, required









	bank_type_id:	Bank Type, many2one, required








Object: Bank Accounts (res.partner.bank)





	post_number:	Post number, char









	institution_code:

		Institution Code, char









	owner_name:	Account Owner, char









	name:	Description, char, required









	zip:	Zip, char









	sequence:	Sequence, integer









	country_id:	Country, many2one









	dta_code:	DTA code, char









	default_bank:	Default, boolean









	state:	Bank Type, selection, required









	street:	Street, char









	iban:	IBAN, char, readonly






International Bank Account Number






	state_id:	State, many2one









	bvr_number:	BVR account number, char









	acc_number:	Account Number, char









	partner_id:	Partner, many2one, required









	city:	City, char









	bank:	Bank, many2one









	bvr_adherent_num:

		BVR adherent number, char








Object: Channels (res.partner.canal)





	active:	Active, boolean









	name:	Channel Name, char, required








Object: res.partner.som (res.partner.som)





	name:	State of Mind, char, required









	factor:	Factor, float, required








Object: res.partner.event (res.partner.event)





	partner_id:	Partner, many2one









	user_id:	User, many2one









	name:	Events, char, required









	probability:	Probability (0.50), float









	canal_id:	Channel, many2one









	planned_revenue:

		Planned Revenue, float









	planned_cost:	Planned Cost, float









	som:	State of Mind, many2one









	partner_type:	Partner Relation, selection









	date:	Date, datetime









	document:	Document, reference









	type:	Type of Event, selection









	event_ical_id:	iCal id, char









	description:	Description, text








Object: Partner Events (res.partner.event.type)





	active:	Active, boolean









	name:	Event Type, char, required









	key:	Key, char, required








Object: Currency (res.currency)





	rate_ids:	Rates, one2many









	code:	Code, char









	name:	Currency, char, required









	rounding:	Rounding factor, float









	company_id:	Company, many2one









	rate:	Current Rate, float, readonly






The rate of the currency to the currency of rate 1






	active:	Active, boolean









	accuracy:	Computational Accuracy, integer








Object: Currency Rate (res.currency.rate)





	currency_id:	Currency, many2one, readonly









	rate:	Rate, float, required






The rate of the currency to the currency of rate 1






	name:	Date, date, required








Object: res.company (res.company)





	addresses:	Email Addresses, one2many









	security_lead:	Security Days, float, required






This is the days added to what you promise to customers for security purpose






	timesheet_max_difference:

		Timesheet allowed difference, float






Allowed difference between the sign in/out and the timesheet computation for one sheet. Set this to 0 if you do not want any control.






	currency_id:	Currency, many2one, required









	po_lead:	Purchase Lead Time, float, required






This is the leads/security time for each purchase order.






	user_provider:	Providers, many2one









	logo:	Logo, binary









	partner_id:	Partner, many2one, required









	rml_header:	RML Header, text









	manufacturing_lead:

		Manufacturing Lead Time, float, required






Security days for each manufacturing operation.






	user_customer:	Customers, many2one









	timesheet_range:

		Timesheet range, selection









	ldaps:	LDAP Parameters, one2many









	parent_id:	Parent Company, many2one









	bvr_delta_horz:	BVR Horz. Delta (mm), float






horiz. delta in mm 1.2 will print the bvz 1.2mm lefter






	child_ids:	Child Companies, one2many









	user_computer:	Computers, many2one









	bvr_delta_vert:	BVR Vert. Delta (mm), float






vert. delta in mm 1.2 will print the bvz 1.2mm lefter






	rml_header2:	RML Internal Header, text









	rml_header1:	Report Header, char









	project_time_mode:

		Project Time Unit, selection






This will set the unit of measure used in projects and tasks.
If you use the timesheet linked to projects (project_timesheet module), don’t forget to setup the right unit of measure in your employees.






	schedule_range:	Scheduler Range, float, required






This is the time frame analysed by the scheduler when computing procurements. All procurement that are not between today and today+range are skipped for future computation.






	rml_footer1:	Report Footer 1, char









	rml_footer2:	Report Footer 2, char









	name:	Company Name, char, required









	currency_ids:	Currency, one2many








Object: res.groups (res.groups)





	comment:	Comment, text









	users:	Users, many2many









	rule_groups:	Rules, many2many









	menu_access:	Access Menu, many2many









	model_access:	Access Controls, one2many









	name:	Group Name, char, required








Object: res.roles (res.roles)





	parent_id:	Parent, many2one









	child_id:	Children, one2many









	name:	Role Name, char, required









	users:	Users, many2many








Object: res.users (res.users)





	groups_id:	Groups, many2many









	address_id:	Address, many2one









	currency_id:	Default Currency, many2one, required









	blogger_email:	Blogger Email Id, char









	unit_test:	unit_test, boolean









	context_tz:	Timezone, selection









	google_email:	Google Email Id, char









	company_id:	Company, many2one









	zarafa_password:

		Zarafa password, char









	rules_id:	Rules, many2many









	parent_id:	Parent Users, many2many, readonly









	email:	E-Mail Address, char, required









	action_id:	Home Action, many2one









	menu_id:	Menu Action, many2one









	google_password:

		Password, char









	roles_id:	Roles, many2many









	blogger_password:

		Password, char









	active:	Active, boolean









	password:	Password, char






Keep empty if you don’t want the user to be able to connect on the system.






	zarafa_server:	Zarafa server, char









	zarafa_user:	Zarafa user, char









	context_lang:	Language, selection, required









	name:	Name, char, required









	created:	Created, datetime









	first_login:	First Login, boolean, required









	input_pw:	Password, char









	zarafa_email:	Zarafa email, char









	signature:	Signature, text









	login:	Login, char, required








Object: res.config.view (res.config.view)





	name:	Name, char









	view:	View Mode, selection, required








Object: Languages (res.lang)





	date_format:	Date Format, char, required









	direction:	Direction, selection, required









	code:	Code, char, required









	name:	Name, char, required









	thousands_sep:	Thousands Separator, char









	translatable:	Translatable, boolean









	time_format:	Time Format, char, required









	decimal_point:	Decimal Separator, char, required









	active:	Active, boolean









	grouping:	Separator Format, char, required






The Separator Format should be like [,n] where 0 < n :starting from Unit digit.-1 will end the separation. e.g. [3,2,-1] will represent 106500 to be 1,06,500;[1,2,-1] will represent it to be 106,50,0;[3] will represent it as 106,500. Provided ‘,’ as the thousand separator in each case.





Object: res.request (res.request)





	body:	Request, text









	create_date:	Created Date, datetime, readonly









	name:	Subject, char, required









	state:	State, selection, required, readonly









	priority:	Priority, selection, required









	ref_doc1:	Document Ref 1, reference









	ref_doc2:	Document Ref 2, reference









	act_from:	From, many2one, required, readonly









	ref_partner_id:	Partner Ref., many2one









	date_sent:	Date, datetime, readonly









	trigger_date:	Trigger Date, datetime









	active:	Active, boolean









	act_to:	To, many2one, required









	history:	History, one2many








Object: res.request.link (res.request.link)





	priority:	Priority, integer









	object:	Object, char, required









	name:	Name, char, required








Object: res.request.history (res.request.history)





	body:	Body, text









	name:	Summary, char, required









	act_from:	From, many2one, required, readonly









	req_id:	Request, many2one, required









	date_sent:	Date sent, datetime, required









	act_to:	To, many2one, required








Object: ir.property (ir.property)





	fields_id:	Fields, many2one, required









	res_id:	Resource, reference









	name:	Name, char









	value:	Value, reference









	company_id:	Company, many2one








Object: maintenance contract modules (maintenance.contract.module)





	version:	Version, char









	name:	Name, char, required








Object: Maintenance Contract (maintenance.contract)





	date_stop:	Ending Date, date, readonly









	name:	Contract ID, char, required, readonly









	module_ids:	Covered Modules, many2many, readonly









	date_start:	Starting Date, date, readonly









	kind:	Kind, selection, required, readonly









	state:	State, selection, readonly









	password:	Password, char, required, readonly








Object: maintenance.contract.wizard (maintenance.contract.wizard)





	state:	States, selection









	password:	Password, char, required









	name:	Contract ID, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







City for Base Contact (base_contact_city)





	Module:	base_contact_city


	Name:	City for Base Contact


	Version:	5.0.1.0


	Author:	Pablo Rocandio


	Directory:	base_contact_city


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Zip code, city, state and country fields are replaced with a location field in partner form when base_contact module is installed.
This module helps to keep homogeneous address data in our database.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_contact_city.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_contact_city.zip]









Dependencies



	base

	base_contact

	city









Reports

None




Menus

None




Views



	* INHERIT partners_form_inherit_add_location (form)

	* INHERIT partners_form_inherit_del_city (form)

	* INHERIT partners_form_inherit_del_zip (form)

	* INHERIT partners_form_inherit_del_state (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base Contact (base_contact)





	Module:	base_contact


	Name:	Base Contact


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_contact


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows you to manage entirely your contacts.

    It lets you define
        *contacts unrelated to a partner,
        *contacts working at several addresses (possibly for different partners),
        *contacts with possibly different functions for each of its job's addresses

    It also add new menu items located in
        Partners \ Contacts
        Partners \ Functions

    Pay attention that this module converts the existing addresses into "addresses + contacts". It means that some fields of the addresses will be missing (like the contact name), since these are supposed to be defined in an other object.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_contact.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_contact.zip]









Dependencies



	base

	process









Reports

None




Menus



	Partners/Contacts

	Partners/Contact’s Jobs









Views



	res.partner.contact.tree (tree)

	res.partner.contact.form (form)

	* INHERIT Partner form inherited (form)

	* INHERIT res.partner.form (form)

	* INHERIT res.partner.form (form)

	* INHERIT res.partner.form (form)

	* INHERIT Partner addresses inherited (tree)

	* INHERIT res.partner.address.form.inherited0 (form)

	* INHERIT res.partner.address.form.inherited1 (form)

	* INHERIT res.partner.address.form.inherited2 (form)

	* INHERIT res.partner.address.form.inherited3 (form)

	* INHERIT res.partner.address.form.inherited4 (form)

	* INHERIT res.partner.address.form.inherited6 (form)

	* INHERIT res.partner.address.form.inherited5 (form)

	res.partner.job.tree (tree)

	res.partner.job.form (form)









Objects


Object: res.partner.contact (res.partner.contact)





	website:	Website, char









	first_name:	First Name, char









	job_id:	Main Job, many2one, readonly









	title:	Title, selection









	mobile:	Mobile, char









	country_id:	Nationality, many2one









	birthdate:	Birth Date, date









	job_ids:	Functions and Addresses, one2many









	lang_id:	Language, many2one









	active:	Active, boolean









	function_id:	Main Function, many2one









	partner_id:	Main Employer, many2one









	email:	E-Mail, char









	name:	Last Name, char, required








Object: Contact Partner Function (res.partner.job)





	sequence_partner:

		Partner Seq., integer






Order of importance of this job title in the list of job title of the linked partner






	sequence_contact:

		Contact Seq., integer






Order of importance of this address in the list of addresses of the linked contact






	fax:	Fax, char









	name:	Partner, many2one









	extension:	Extension, char






Internal/External extension phone number






	date_start:	Date Start, date









	address_id:	Address, many2one









	contact_id:	Contact, many2one, required









	email:	E-Mail, char









	phone:	Phone, char









	state:	State, selection, required









	date_stop:	Date Stop, date









	function_id:	Partner Function, many2one









	other:	Other, char






Additional phone field
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base Contact Team - To manage teams of contacts (base_contact_team)





	Module:	base_contact_team


	Name:	Base Contact Team - To manage teams of contacts


	Version:	5.0.0.1


	Author:	Tiny SPRL


	Directory:	base_contact_team


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

With this module will help you to manages teams of contacts for different purposes.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_contact_team.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_contact_team.zip]









Dependencies



	base_contact









Reports

None




Menus



	Partners/Teams

	Partners/Teams/New Team









Views



	* INHERIT view.partner.job.inherited (form)

	res.partner.team.form (form)

	res.partner.team.tree (tree)









Objects


Object: res.partner.team (res.partner.team)





	name:	Name, char, required









	description:	Description, text
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Menu Wizard  (base_create_menu)





	Module:	base_create_menu


	Name:	Menu Wizard


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_create_menu


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_create_menu.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_create_menu.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Customization/User Interface/Create menus









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base - Password Encryption (base_crypt)





	Module:	base_crypt


	Name:	Base - Password Encryption


	Version:	5.0.1.3330


	Author:	FS3 , Review Tinywwwwwwwwwwwwww


	Directory:	base_crypt


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Module for password encryption.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_crypt.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_crypt.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	* INHERIT res.users.form.modif.inherit (form)

	* INHERIT res.users.form.inherit1 (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base External Referentials (base_external_referentials)





	Module:	base_external_referentials


	Name:	Base External Referentials


	Version:	5.0.1.0


	Author:	Raphaël Valyi (Akretion.com), Sharoon Thomas (Openlabs.co.in)


	Directory:	base_external_referentials


	Web:	http://www.akretion.com, http://openlabs.co.in/


	Official module:

		no


	Quality certified:

		no






Description

This module provide an abstract common minimal base to add any additional external id columns
to some OpenObject table, pointing to some external referential.
A referential is abstract and minimal at this stage, it only has:
* a name
* a location (possibly webservice URL, database connection URL...); the connection method will tell it...
* referential credentials (user name + password)
* placeholders for custom in and out mapping for OpenERP object fields.

OpenERP already has limited supported to external ids using the ir_model_data and the id
fields in the loaded data such as XML or CSV. We think that's OK to store all referential ids
into the same ir_model_data table: yes it makes it large, but synchronisation operations involve
a network bottleneck anyway, so it's largely OK and negligible to have a large table here.
The existing ir_model_data feature of OpenERP is mostly thought as an mono-external referential
(even if the module key of ir_model_data plays some referential scoping role). Here we just push
the concept further to assume multiple external ids for OpenERP entities and add the possibility
to customize their field mapping directly in OpenERP to accommodate the external systems.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base









Reports

None




Menus



	Administration/Customization/Database Structure/External Referentials









Views



	external_referential_form_view (form)

	external_referential_tree_view (tree)









Objects


Object: External Referential Type (Ex. Magento, Spree) (external.referential.type)





	name:	Name, char, required, readonly








Object: The source mapping records (external.mapping.template)





	model_id:	OpenERP Model, many2one, required









	external_update_method:

		Update Method, char









	type_id:	External Referential Type, many2one









	external_key_name:

		External field used as key, char









	external_delete_method:

		Delete Method, char









	external_get_method:

		Get Method, char









	external_create_method:

		Create Method, char









	model:	Model Name, char









	external_list_method:

		List Method, char








Object: The source mapping line records (external.mappinglines.template)





	model_id:	OpenERP Model, many2one









	external_field:	External Field, char









	in_function:	Import in OpenERP Mapping Python Function, text









	type_id:	External Referential Type, many2one









	out_function:	Export from OpenERP Mapping Python Function, text









	model:	Model Name, char









	type:	Type, selection









	external_type:	External Type, selection








Object: External Referential (external.referential)





	apipass:	Password, char









	name:	Name, char, required









	type_id:	Referential Type, many2one









	apiusername:	User Name, char









	location:	Location, char









	mapping_ids:	Mappings, one2many








Object: Field Mapping (external.mapping.line)





	external_field:	External Field, char









	in_function:	Import in OpenERP Mapping Python Function, text









	name_function:	Full Name, char, readonly









	out_function:	Export from OpenERP Mapping Python Function, text









	field_id:	OpenERP Field, many2one









	mapping_id:	External Mapping, many2one









	related_model_id:

		Related Model, many2one









	type:	Type, selection









	external_type:	External Type, selection








Object: External Mapping (external.mapping)





	model_id:	OpenERP Model, many2one, required









	external_update_method:

		Update Method, char









	external_key_name:

		External field used as key, char, required









	external_delete_method:

		Delete Method, char









	related_model_ids:

		Related Inherited Models, one2many, readonly






potentially inherited through ‘_inherits’ model, used for mapping field selection






	external_get_method:

		Get Method, char









	external_create_method:

		Create Method, char









	referential_id:	External Referential, many2one, required









	mapping_ids:	Mappings Lines, one2many









	model:	Model Name, char









	external_list_method:

		List Method, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







IBAN (base_iban)





	Module:	base_iban


	Name:	IBAN


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_iban


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module install the base for IBAN bank accounts.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/base_iban.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/base_iban.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_iban.zip]









Dependencies



	base

	account









Reports

None




Menus

None




Views



	* INHERIT res.partner.bank.form.iban.inherit (form)

	* INHERIT res.partner.bank.tree.iban.inherit (tree)

	* INHERIT res.partner.form.iban.inherit (form)

	* INHERIT res.partner.form.iban.inherit.list (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base Language - To load all existing languages in the world (base_language)





	Module:	base_language


	Name:	Base Language - To load all existing languages in the world


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_language


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows you to load all existing languages in the world.
You can install this module only if you still not installed any other
languages, otherwise you may have a conflict with languages codes that
must be unique.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_language.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_language.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Module Technical Guide in Restructured Text  (base_module_doc_rst)





	Module:	base_module_doc_rst


	Name:	Module Technical Guide in Restructured Text


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_module_doc_rst


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

* This module generate the Technical Guides of selected modules in Restructured Text format (RST)
    * It uses the Sphinx (http://sphinx.pocoo.org) implementation of RST
    * It creates a tarball (.tgz file suffix) containing an index file and one file per module








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_module_doc_rst.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_module_doc_rst.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Module Merger (base_module_merge)





	Module:	base_module_merge


	Name:	Module Merger


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_module_merge


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

* The wizard asks a many2many of modules
    * And then generate a module which is the merge of all selected modules
    * The new module is provided as a .zip file

    The merge will works in all situations:
    * Merging all .py files with the same name in the new module
    * merging all .xml files and take care of id's.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_module_merge.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_module_merge.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Modules Management/Merge module









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Module publisher (base_module_publish)





	Module:	base_module_publish


	Name:	Module publisher


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_module_publish


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module can be used by developers to automatically publish their modules
in a few click to the following websites:
* http://OpenERP.com, section module
* http://TinyForge.org
* PyPi, The python official repository
* http://Freshmeat.net

It adds a button "Publish module" on each module, so that you simply have
to call this button when you want to release a new version of your module.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/base_module_publish.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/base_module_publish.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_module_publish.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base module quality (base_module_quality)





	Module:	base_module_quality


	Name:	Base module quality


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_module_quality


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		yes






Description

This module's aim is to check the quality of other modules.

It defines a wizard on the list of modules in OpenERP, which allow you to
evaluate them on different criteria such as: the respect of OpenERP coding
standards, the speed efficiency...

This module also provides generic framework to define your own quality test.
For further info, coders may take a look into base_module_quality\README.txt

WARNING: This module can not work as a ZIP file, you must unzip it before
using it, otherwise it may crash.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_module_quality.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_module_quality.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	Results of Quality Checks (tree)

	Results of Quality Checks (form)

	Results of Quality Checks with detail (form)

	Results of Quality Checks with detail (tree)









Objects


Object: module.quality.check (module.quality.check)





	final_score:	Final Score (%), char









	name:	Rated Module, char









	check_detail_ids:

		Tests, one2many








Object: module.quality.detail (module.quality.detail)





	name:	Name, char









	detail:	Details, text









	summary:	Summary, text









	note:	Note, text









	state:	State, selection






The test will be completed only if the module is installed or if the test may be processed on uninstalled module.






	score:	Score (%), float









	quality_check_id:

		Quality, many2one









	ponderation:	Ponderation, float






Some tests are more critical than others, so they have a bigger weight in the computation of final rating






	message:	Message, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Module Recorder (base_module_recorder)





	Module:	base_module_recorder


	Name:	Module Recorder


	Version:	1.0


	Author:	Tiny


	Directory:	base_module_recorder


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


This module allows you to create a new module without any development. It records all operations on objects during the recording session and produce a .ZIP module. So you can create your own module directly from the OpenERP client.  This version works for creating and updating existing records. It recomputes dependencies and links for all types of widgets (many2one, many2many, ...). It also support workflows and demo/update data.  This should help you to easily create reusable and publishable modules for custom configurations and demo/testing data.  How to use it: 1. Start the recording 2. Do stuff in your OpenERP client 3. Stop the recording session 4. Export to a reusable module





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/base_module_recorder.zip]









Dependencies



	base

	base_module_record









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Module Recorder (base_module_record)





	Module:	base_module_record


	Name:	Module Recorder


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_module_record


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows you to create a new module without any development.
It records all operations on objects during the recording session and
produce a .ZIP module. So you can create your own module directly from
the OpenERP client.

This version works for creating and updating existing records. It recomputes
dependencies and links for all types of widgets (many2one, many2many, ...).
It also support workflows and demo/update data.

This should help you to easily create reusable and publishable modules
for custom configurations and demo/testing data.

How to use it:
1. Start the recording
2. Do stuff in your OpenERP client
3. Stop the recording session
4. Export to a reusable module








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/base_module_record.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/base_module_record.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_module_record.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Customization/Module Creation

	Administration/Customization/Module Creation/Module Recorder

	Administration/Customization/Module Creation/Module Recorder/Start Recording

	Administration/Customization/Module Creation/Module Recorder/Stop Recording

	Administration/Customization/Module Creation/Module Recorder/Save Recorded Module

	Administration/Customization/Module Creation/Export Customizations As a Module









Views

None




Objects


Object: ir.module.record (ir.module.record)
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base Partner Gender (base_partner_gender)





	Module:	base_partner_gender


	Name:	Base Partner Gender


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_partner_gender


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows you to load partner gender.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_partner_gender.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_partner_gender.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	partner.gender.form (form)

	partner.gender.tree (tree)

	* INHERIT res.partner.title.inherit (form)









Objects


Object: partner.gender (partner.gender)





	code:	Code, char, required









	name:	Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Partners - relation extension (base_partner_relation)





	Module:	base_partner_relation


	Name:	Partners - relation extension


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_partner_relation


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Add a tab in the partner form to encode relations between several partners.
    For eg, the partner 'Toubib and Co.' has different contacts.
    When 'Toubib and Co.' orders, you have to deliver to 'Toubib - Belgium'
    and invoice to 'Toubib - Geneva'.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/base_partner_relation.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/base_partner_relation.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_partner_relation.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	res.partner.relation.form (form)

	res.partner.relation.tree (tree)

	* INHERIT res.partner.form.inherit (form)









Objects


Object: Partner Relation (res.partner.relation)





	partner_id:	Main Partner, many2one, required









	name:	Relation Type, selection, required









	relation_id:	Relation Partner, many2one, required
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Restrict access to partners by categories (base_partner_security)





	Module:	base_partner_security


	Name:	Restrict access to partners by categories


	Version:	0.8


	Author:	Gábor Dukai


	Directory:	base_partner_security


	Web:	http://exploringopenerp.blogspot.com


	Official module:

		no


	Quality certified:

		no






Description

Adds a restricted field to partner categories. That field value is copied
    to the partners and partner addresses belonging to those categories. With this, it is easy
    to restrict access to some partner categories using record rules.
    Example domain to use with record rules or views: [('restricted','=',False)]








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_partner_security.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_partner_security.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Add a sequence on partners Code (base_partner_sequence)





	Module:	base_partner_sequence


	Name:	Add a sequence on partners Code


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_partner_sequence


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds the possibility to define a sequence for
        the partner code. This code is then set as default when you
        create a new partner, using the defined sequence.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/base_partner_sequence.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/base_partner_sequence.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_partner_sequence.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base Partner Surname (base_partner_surname)





	Module:	base_partner_surname


	Name:	Base Partner Surname


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_partner_surname


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module use for separate surname from contact name of partner. Now You can give first name & last name on contact Name.
This module is deprecated, it is strongly recommended to use base_contact instead.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/base_partner_surname.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/base_partner_surname.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_partner_surname.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	* INHERIT res.partner.address.form1.inherit (form)

	* INHERIT res.partner.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Report Creator (base_report_creator)





	Module:	base_report_creator


	Name:	Report Creator


	Version:	5.0.1.0


	Author:	Tiny & Axelor


	Directory:	base_report_creator


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This modules allows you to create any statistic
report on several object. It's a SQL query builder and browser
for and users.

After installing the module, it adds a menu to define custom report in
the "Dashboard" menu.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_report_creator.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_report_creator.zip]









Dependencies



	base

	board









Reports

None




Menus



	Dashboards/Configuration/Custom Reports

	Dashboards/Custom Reports









Views



	base_report_creator.report.tree (tree)

	base_report_creator.report.form (form)

	base_report_creator.report.simple.tree (tree)









Objects


Object: Report (base_report_creator.report)





	model_ids:	Reported Objects, many2many









	filter_ids:	Filters, one2many









	name:	Report Name, char, required









	sql_query:	SQL Query, text, readonly









	view_graph_type:

		Graph Type, selection, required









	view_type2:	Second View, selection









	view_type1:	First View, selection, required









	state:	Status, selection, required









	view_type3:	Third View, selection









	field_ids:	Fields to Display, one2many









	active:	Active, boolean









	group_ids:	Authorized Groups, many2many









	type:	Report Type, selection, required









	view_graph_orientation:

		Graph Orientation, selection, required








Object: Display Fields (base_report_creator.report.fields)





	calendar_mode:	Calendar Mode, selection









	group_method:	Grouping Method, selection, required









	sequence:	Sequence, integer









	field_id:	Field, many2one









	graph_mode:	Graph Mode, selection









	report_id:	Report, many2one








Object: Report Filters (base_report_creator.report.filter)





	expression:	Value, text, required






Provide an expression for the field based on which you want to filter the records.
e.g. res_partner.id=3






	name:	Filter Name, char, required









	condition:	Condition, selection









	report_id:	Report, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Report designer interface module (base_report_designer)





	Module:	base_report_designer


	Name:	Report designer interface module


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	base_report_designer


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module adds wizards to import/export documents to be edited in
OpenOffice.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/base_report_designer.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/base_report_designer.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_report_designer.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Customization/Report Designer









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base Report Model (base_report_model)





	Module:	base_report_model


	Name:	Base Report Model


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	base_report_model


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows you to specify the models which can have an attachment from OpenOffice Report








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_report_model.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_report_model.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Low Level Objects/Base

	Administration/Low Level Objects/Base/OpenOffice Attachment Available Models









Views



	base.report.model.view.form (form)

	base.report.model.view.tree (tree)









Objects


Object: Visible models for a tool (base.report.model)





	model_id:	Model, many2one, required









	name:	Visible Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Unicode Reports with TrueType fonts (base_report_unicode)





	Module:	base_report_unicode


	Name:	Unicode Reports with TrueType fonts


	Version:	5.0.1.1


	Author:	Gábor Dukai


	Directory:	base_report_unicode


	Web:	http://exploringopenerp.blogspot.com


	Official module:

		no


	Quality certified:

		no






Description

This module replaces the standard PDF Type1 fonts with TrueType fonts that have
    unicode characters.
    The module contains the DejaVu fonts v2.29 from http://dejavu-fonts.org/
    With this module you can continue to use the old font names in the templates,
    they will be replaced with the DejaVu font names every time before creating a pdf.

    Compatibility: tested with OpenERP v5.0

    NOTE: You have to copy this module to the addons folder. It doesn't work from a zip file!








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_report_unicode.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_report_unicode.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base Sale MultiChannels (base_sale_multichannels)





	Module:	base_sale_multichannels


	Name:	Base Sale MultiChannels


	Version:	5.0.1.0


	Author:	Raphaël Valyi (Akretion.com), Sharoon Thomas (Openlabs.co.in)


	Directory:	base_sale_multichannels


	Web:	http://www.akretion.com


	Official module:

		no


	Quality certified:

		no






Description

This module provide an abstract common minimal base to multi-channels sales.
Say you want to expose your product catalog to
* several instances of flashy-sluggish Magento web sites
* a cutting edge Spree web shop
* a Neteven online Marketplace
* EBay
* Amazon
* Google Base
* an external Point Of Sale system
* ...
Then this module allows you to:
* use several external references ids on every OpenERP object matching those all those external referentials
* per referential instance, use several sale sub platform entities (ex: several Magento websites per instance)
* per sub platform, use several shops (ex: several Magento web shops per website)

For each sale shop (matching OpenERP sale.shop object), this module abstract the interfaces to:
* export the catalog, shop warehouse stock level wise, shop pricelist wise
* import the catalog
* import orders
* export orders/picking status








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	sale

	base_external_referentials









Reports

None




Menus

None




Views



	* INHERIT base_sale_multichannels_view_shop_form (form)

	* INHERIT simple_pos_view_account_journal_form (form)









Objects


Object: External Referential Shop Group (external.shop.group)





	shop_ids:	Sale Shops, one2many









	referential_id:	Referential, many2one









	name:	Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base Setup (base_setup)





	Module:	base_setup


	Name:	Base Setup


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_setup


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module implements a configuration system that helps user
    to configure the system at the installation of a new database.

    It allows you to select between a list of profiles to install:
    * Minimal profile
    * Accounting only
    * Services companies
    * Manufacturing companies

    It also asks screens to help easily configure your company, the header and
    footer, the account chart to install and the language.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/base_setup.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/base_setup.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Translation (base_translation)





	Module:	base_translation


	Name:	Translation


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_translation


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

For better translation process








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_translation.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_translation.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Translations/Translations Management

	Administration/Translations/Translations Management/All Contribution

	Administration/Translations/Translations Management/Maintainer

	Administration/Translations/Translations Management/Maintainer/Review Proposed Contribution

	Administration/Translations/Translations Management/Contributors

	Administration/Translations/Translations Management/Contributors/Download New Version

	Administration/Translations/Translations Management/Maintainer/Download Contributor’s Proposition

	Administration/Translations/Translations Management/Contributors/Review Proposed Contributions

	Administration/Translations/Translations Management/Contributors/Upload Contributions

	Administration/Translations/Translations Management/Maintainer/Publish New Version









Views



	Translations Contrib (form)

	Translations Contrib (tree)









Objects


Object: Translation Contribution (ir.translation.contribution)





	lang:	Language, selection









	src:	Source, text









	name:	Field Name, char, required









	res_id:	Resource ID, integer









	upload:	upload, boolean









	value:	Translation Value, text









	state:	Translation State, selection, readonly









	contributor_email:

		Email Id of Contributor, char









	type:	Type, selection
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Url Menus (base_url_menu)





	Module:	base_url_menu


	Name:	Url Menus


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	base_url_menu


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Module for creating URL menus. Work only with eTiny








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_url_menu.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_url_menu.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Customization/Menu Management

	Administration/Customization/Menu Management/Create a menu that links to an URL









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







VAT (base_vat)





	Module:	base_vat


	Name:	VAT


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	base_vat


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Enable the VAT Number for the partner. Check the validity of that VAT Number.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/base_vat.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/base_vat.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_vat.zip]









Dependencies



	base

	account









Reports

None




Menus

None




Views



	* INHERIT res.partner.vat.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base VAT Unique check VAT number is unique (base_vat_unique)





	Module:	base_vat_unique


	Name:	Base VAT Unique check VAT number is unique


	Version:	5.0.0.1


	Author:	vitrum Network


	Directory:	base_vat_unique


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Check VAT Number is unique.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/base_vat_unique.zip]

	trunk [http://www.openerp.com/download/modules/trunk/base_vat_unique.zip]









Dependencies



	base

	account

	base_vat









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Board for accountant (board_account)





	Module:	board_account


	Name:	Board for accountant


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_account


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module creates a dashboards for accountants that includes:
    * List of analytic accounts to close
    * List of uninvoiced quotations
    * List of invoices to confirm
    * Graph of costs to invoice
    * Graph of aged receivables
    * Graph of aged incomes








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/board_account.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/board_account.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_account.zip]









Dependencies



	account

	hr_timesheet_invoice

	board

	report_account

	report_analytic

	report_analytic_line

	account_report









Reports

None




Menus



	Dashboards/Accounting

	Dashboards/Accounting/Accounting Dashboard









Views



	board.account.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Dashboard for Associations (board_association)





	Module:	board_association


	Name:	Dashboard for Associations


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_association


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module implements a dashboard for associations.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/board_association.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_association.zip]









Dependencies



	event

	membership

	board

	project









Reports

None




Menus



	Dashboards/Associations









Views



	board.associations.manager.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Board for Auction (board_auction)





	Module:	board_auction


	Name:	Board for Auction


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_auction


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module creates a dashboards for auction that includes:








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/board_auction.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_auction.zip]









Dependencies



	board

	auction









Reports

None




Menus



	Dashboards/Auction/Auction Member

	Dashboards/Auction/Auction Manager









Views



	board.auction.manager.form (form)

	board.auction.manager.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Dashboard for CRM Configuration (board_crm_configuration)





	Module:	board_crm_configuration


	Name:	Dashboard for CRM Configuration


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_crm_configuration


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module implements a dashboard for CRM that includes:
    * My Leads (list)
    * Leads by Stage (graph)
    * My Meetings (list)
    * Sales Pipeline by Stage (graph)
    * My Cases (list)
    * Jobs Tracking (graph)








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/board_crm_configuration.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_crm_configuration.zip]









Dependencies



	board

	crm_configuration









Reports

None




Menus



	Dashboards/CRM Configuration

	Dashboards/CRM Configuration/Statistics Dashboard

	Dashboards/CRM Configuration/Connecting Dashboard









Views



	Leads By Stage - Graph (graph)

	report.crm.case.categ.graph (graph)

	CRM - Statistical Dashboard Form (form)

	crm.case.user.graph1 (graph)

	CRM - Dashboard Form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Board for DM users (board_dm)





	Module:	board_dm


	Name:	Board for DM users


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_dm


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module implements a dashboard for campaign manager that includes:
    * List of campaigns that have started at max 2 month ago and those that will start in the 2 month to come
    * List of the tasks of the day
    * List of  the tasks with a deadline passed

This module implements a dashboard for offer manager that includes:
    * Offers
    * Offer Ideas








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/board_dm.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_dm.zip]









Dependencies



	board

	dm









Reports

None




Menus



	Dashboards/Direct Marketing

	Dashboards/Direct Marketing/Campaign Manager Dashboard

	Dashboards/Direct Marketing/Customers Files Manager Dashboard

	Dashboards/Direct Marketing/Mailing Manufacturing Manager Dashboard

	Dashboards/Direct Marketing/Desktop Publishing Manager Dashboard

	Dashboards/Direct Marketing/Items Procurement Manager Dashboard

	Dashboards/Direct Marketing/Offer Manager Dashboard









Views



	board.campaign.form (form)

	board.campaign.form (form)

	board.campaign.form (form)

	board.campaign.form (form)

	board.campaign.form (form)

	board.campaign.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Dashboard for Document Management (board_document)





	Module:	board_document


	Name:	Dashboard for Document Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_document


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module implements a dashboard for Document








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/board_document.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_document.zip]









Dependencies



	board

	document

	report_document









Reports

None




Menus



	Dashboards/Document

	Dashboards/Document/Document Dashboard

	Dashboards/Document/Statistics by User









Views



	board.document.manager.form (form)

	board.document.manager.form1 (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Board for Hotel FrontDesk (board_frontdesk)





	Module:	board_frontdesk


	Name:	Board for Hotel FrontDesk


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_frontdesk


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module implements a dashboard for hotel FrontDesk that includes:
    * Calendar view of Today's Check-In and Check-Out
    * Calendar view of Weekly Check-In and Check-Out
    * Calendar view of Monthly Check-In and Check-Out








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/board_frontdesk.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_frontdesk.zip]









Dependencies



	board

	report_hotel_reservation









Reports

None




Menus



	Dashboards/Hotel FrontDesk Board









Views



	board.frontdesk.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Board for manufacturing (board_manufacturing)





	Module:	board_manufacturing


	Name:	Board for manufacturing


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_manufacturing


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module creates a dashboards for Manufacturing that includes:
    * List of next production orders
    * List of deliveries (out packing)
    * Graph of workcenter load
    * List of procurement in exception








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/board_manufacturing.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/board_manufacturing.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_manufacturing.zip]









Dependencies



	board

	mrp

	stock

	report_mrp









Reports

None




Menus



	Dashboards/Production

	Dashboards/Production/Production Dashboard









Views



	board.mrp.manager.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Board for project users (board_project_portal)





	Module:	board_project_portal


	Name:	Board for project users


	Version:	1.0


	Author:	Tiny


	Directory:	board_project_portal


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


This module implements a dashboard for project member that includes:     * List of my open tasks     * List of my Bugs     * List of Features     * List of Supported Requests     * List of Supported Documents     * Shortcut Buttons     * Graph of my work analysis     * Graph of Bugs status





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/board_project_portal.zip]









Dependencies



	project

	report_timesheet

	board

	report_analytic_planning

	report_analytic_line

	report_task

	hr_timesheet_sheet

	portal_project

	base

	crm_configuration









Reports

None




Menus

None




Views



	BUG TRACKING (graph)

	board.portal.project.form (form)









Objects



	report.crm.case.state
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Board for project users (board_project)





	Module:	board_project


	Name:	Board for project users


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_project


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module implements a dashboard for project member that includes:
    * List of my open tasks
    * List of my next deadlines
    * List of public notes
    * Graph of my timesheet
    * Graph of my work analysis








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/board_project.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/board_project.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_project.zip]









Dependencies



	project

	report_timesheet

	board

	report_analytic_planning

	report_analytic_line

	report_task

	hr_timesheet_sheet









Reports

None




Menus



	Dashboards/Project

	Dashboards/Project/Project Dashboard

	Dashboards/Project/Project Manager Dashboard









Views



	project.task.tree (tree)

	board.project.form (form)

	hr.timesheet.sheet.tree.simplified.board (tree)

	board.project.manager.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Board for Hotel Reservation (board_reservation)





	Module:	board_reservation


	Name:	Board for Hotel Reservation


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_reservation


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module implements a dashboard for hotel Reservation that includes:
      * List of Today's checkin
      * List of Today's checkout
      * Graph of Reservation by states(pie)
      * Graph of reservation by states(bar)








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/board_reservation.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_reservation.zip]









Dependencies



	board

	report_hotel_reservation









Reports

None




Menus



	Dashboards/Hotel Reservation Board









Views



	board.reservation.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Board for Hotel Restaurant users (board_restaurant)





	Module:	board_restaurant


	Name:	Board for Hotel Restaurant users


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_restaurant


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module implements a dashboard for project member that includes:
      * list of current orders
      * List of Kitchen order tickets
      * List of current table reservation








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/board_restaurant.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_restaurant.zip]









Dependencies



	board

	report_hotel_restaurant









Reports

None




Menus



	Dashboards/Hotel Restaurant Board









Views



	board.restaurant.form (form)









Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Dashboard main module (board)





	Module:	board


	Name:	Dashboard main module


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Base module for all dashboards.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/board.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/board.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board.zip]









Dependencies



	base









Reports

None




Menus



	Dashboards

	Dashboards/Publish a note

	Dashboards/Configuration

	Dashboards/Configuration/Dashboard Definition









Views



	board.note.tree (tree)

	board.note.form (form)

	board.board.tree (tree)

	board.board.form (form)









Objects


Object: board.board (board.board)





	line_ids:	Action Views, one2many









	view_id:	Board View, many2one









	name:	Dashboard, char, required








Object: board.board.line (board.board.line)





	board_id:	Dashboard, many2one, required









	name:	Title, char, required









	sequence:	Sequence, integer









	height:	Height, integer









	width:	Width, integer









	position:	Position, selection, required









	action_id:	Action, many2one, required








Object: board.note.type (board.note.type)





	name:	Note Type, char, required








Object: board.note (board.note)





	note:	Note, text









	date:	Date, date, required









	user_id:	Author, many2one









	name:	Subject, char, required









	type:	Note type, selection
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Dashboard for sales (board_sale)





	Module:	board_sale


	Name:	Dashboard for sales


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_sale


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module implements a dashboard for salesman that includes:
    * You open quotations
    * Top 10 sales of the month
    * Cases statistics
    * Graph of sales by product
    * Graph of cases of the month








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/board_sale.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/board_sale.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_sale.zip]









Dependencies



	board

	sale

	report_crm

	report_sale









Reports

None




Menus



	Dashboards/Sales

	Dashboards/Sales/Sale Dashboard









Views



	board.sales.manager.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Dashboard for Service Profile (board_service)





	Module:	board_service


	Name:	Dashboard for Service Profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	board_service


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module displays three dashboards for the logged in user:

        A. Dashboard 1: Weekly Dashboard
                   - Draft Forecasts Lines
                   - Turnover by Product and Month
                   - Aged Receivables
                   - Timesheet to Validate
                   - Sales pipeline
                   - Planning Statistics

                This dashboard is reachable from Dashboards/Service Profile/Weekly Dashboard.

        B. Dashboard 2: Daily Dashboard
                   - Open Tasks
                   - Pending Tasks
                   - Inbox
                   - Meeting of the Day
                   - Department's Timesheet Lines of last 3 days.

                This dashboard is reachable from Dashboards/Service Profile/Daily Dashboard.

        C. Dashboard 3 : Random Activities
                   - Random Timesheet Lines from the past 15 days
                   - Random Tasks Closed within the past 15 days
                   - Random Cases Closed within the past 15 days
                   - Random Open Cases Created within the past 15 days
                   - Random Sales Orders Created within the past 15 days
                   - Random Invoices Created within the past 15 days

                This dashboard is reachable from Dashboards/Service Profile/Random Activities(Within Last 15 Days).








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/board_service.zip]

	trunk [http://www.openerp.com/download/modules/trunk/board_service.zip]









Dependencies



	base

	project_gtd

	board_project

	sale_forecast

	crm_configuration

	report_account

	report_analytic_planning

	report_sale

	report_crm

	report_task

	report_timesheet









Reports

None




Menus



	Dashboards/Service Profile

	Dashboards/Service Profile/Weekly Dashboard

	Dashboards/Service Profile/Daily Dashboard

	Dashboards/Service Profile/Random Activities(Within Last 15 Days)









Views



	sale.forecast.line.tree (tree)

	sale.forecast.line.form (form)

	board.service.weekly.form (form)

	CRM - Meetings Tree (tree)

	project.task.tree (tree)

	board.service.daily.form (form)

	board.service.random.activitiy.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Bookstore Verticalisation (bookstore)





	Module:	bookstore


	Name:	Bookstore Verticalisation


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	bookstore


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module to manage book store.
    Add book Information,
    Author Information,
    Books Category,
    Related books,
    Available Languages,








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/bookstore.zip]

	trunk [http://www.openerp.com/download/modules/trunk/bookstore.zip]









Dependencies



	library

	delivery

	sale









Reports

None




Menus

None




Views



	* INHERIT Company (form)

	* INHERIT Partner (form)

	* INHERIT Partner (form)

	* INHERIT Partner Address (form)

	Partners (tree)

	* INHERIT Sale lines replace uom by mode (form)

	* INHERIT  (form)









Objects

None
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Module business (business)





	Module:	business


	Name:	Module business


	Version:	1.0


	Author:	Sednacom


	Directory:	business


	Web:	http://www.sednacom.fr


	Official module:

		no


	Quality certified:

		no






Description

regroup object for a business








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/business.zip]

	trunk [http://www.openerp.com/download/modules/trunk/business.zip]









Dependencies



	base

	product

	sale

	account

	project









Reports

None




Menus

None




Views

None




Objects

None
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Account Payment (c2c_account_payment)





	Module:	c2c_account_payment


	Name:	Account Payment


	Version:	1.0


	Author:	Camptocamp SA


	Directory:	c2c_account_payment


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds a report on account payment








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_account_payment.zip]









Dependencies



	account_payment









Reports

None




Menus

None




Views

None




Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
  

Rapport sur le plan comptable analytique (c2c_analytic_chart)





	Module:	c2c_analytic_chart


	Name:	Rapport sur le plan comptable analytique


	Version:	0.1


	Author:	Camptocamp


	Directory:	c2c_analytic_chart


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Ce module permet d'imprimer le plan comptable analytique, il est li? ? un wizard
qui permet de d?finir le niveau de descente. c'est une premi?re version en effet l'id?e est de
l'am?lior? pour permettre








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_analytic_chart.zip]









Dependencies



	account









Reports

None




Menus

None




Views

None




Objects

None
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Fonctions standads C2C pour account analytic (c2c_analytic)





	Module:	c2c_analytic


	Name:	Fonctions standads C2C pour account analytic


	Version:	1.0


	Author:	Camptocamp


	Directory:	c2c_analytic


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_analytic.zip]









Dependencies



	base

	account

	c2c_base_account

	hr_timesheet_sheet

	hr_timesheet_invoice









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Analytic wizard and tools for services companies (c2c_analytic_wizard)





	Module:	c2c_analytic_wizard


	Name:	Analytic wizard and tools for services companies


	Version:	5.0.1.3


	Author:	Camptocamp


	Directory:	c2c_analytic_wizard


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Add wizard to manage analytic account and invoicing :
 - Associate Analytic Lines to invoice (from an invoice or from analytic line directly)
 - Dissociate Analytic Lines from an invoice
 - Create blank invoice from Analytic Account (with all information completed)
 - Create invoice from Analytic Lines
 - Get all invoice from Analytic Account (with recursion in child account)
 - Get Analytic Lines from Analytic Account (with recursion in child account)
 - Get Analytic Lines from an invoice for controlling
Add report for on analytic account showing the indicators et open invoice.

-----------------------------------------------------------------------------------------------

Ce module comprend un set de wizard pour faciliter la gestion des entreprises de service travaillant avec les comptes analytiques,
par exemple pour la gestion de projet. Il apporte une réelle plus-value en terme d'ergonomie. Ces wizards améliorent la facturation du travail
effectué depuis un projet (compte analytique), permettent d'associer / dissocier des lignes analytiques d'une facture ou encore d'obtenir
la liste des factures relatives à un projet.
Ajoute egalement un rapport affichant le détails d'un compte analytique et ses factures ouvertes








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_analytic_wizard.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/c2c_analytic_wizard.zip]

	trunk [http://www.openerp.com/download/modules/trunk/c2c_analytic_wizard.zip]









Dependencies



	base

	account

	product

	account_analytic_analysis

	c2c_reporting_tools

	hr_timesheet_invoice

	account_tax_include









Reports



	Indicator Report









Menus

None




Views



	* INHERIT indicator.account.detail.form (form)









Objects

None
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Fonctions standads C2C pour base et account (c2c_base_account)





	Module:	c2c_base_account


	Name:	Fonctions standads C2C pour base et account


	Version:	1.0


	Author:	Camptocamp


	Directory:	c2c_base_account


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_base_account.zip]









Dependencies



	base

	account

	hr_expense

	hr_timesheet_sheet

	hr_timesheet_invoice

	hr









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Advanced Budget (c2c_budget)





	Module:	c2c_budget


	Name:	Advanced Budget


	Version:	5.0.5.0


	Author:	Camptocamp SA (aw)


	Directory:	c2c_budget


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Budget Module:
    * Create budget, budget items and budget versions.
    * Base your budget on analytics accounts
    * Budget versions are multi currencies and multi companies.

    This module is for advanced budget use, if the additional functionality is not needed it is best to use the standard modules.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_budget.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/c2c_budget.zip]

	trunk [http://www.openerp.com/download/modules/trunk/c2c_budget.zip]









Dependencies



	base

	account

	c2c_reporting_tools









Reports

None




Menus



	Financial Management/Budgets

	Financial Management/Budgets/Budgets

	Financial Management/Budgets/Budgets Versions

	Financial Management/Budgets/Budgets Lines

	Financial Management/Budgets/Budgets Items

	Financial Management/Budgets/Budgets Structures

	Financial Management/Budgets/Budget Lines Search









Views



	c2c_budget.form (form)

	c2c_budget.version.form (form)

	c2c_budget.item.form (form)

	c2c_budget.list (tree)

	c2c_budget.version.list (tree)

	c2c_budget.version.list (tree)

	c2c_budget.item.list (tree)

	c2c_budget.item.tree (tree)

	c2c_budget.line.list.in.budget.version (tree)

	c2c_budget.line.list (tree)

	c2c_budget.line.list (form)

	c2c_budget.analytic_line.list (tree)









Objects


Object: Budget items (c2c_budget.item)





	children_ids:	Children Items, one2many









	code:	Code, char, required









	name:	Name, char, required









	sequence:	Sequence, integer









	calculation:	Calculation, text









	style:	Style, selection, required









	note:	Notes, text









	parent_id:	Parent Item, many2one









	active:	Active, boolean









	account:	Financial Account, many2many









	type:	Type, selection, required








Object: Budget (c2c_budget)





	code:	Code, char









	create_date:	Creation Date, datetime, readonly









	name:	Name, char, required









	end_date:	End Date, date, required









	note:	Notes, text









	budget_item_id:	Budget Structure, many2one, required









	budget_version_ids:

		Budget Versions, one2many, readonly









	active:	Active, boolean









	start_date:	Start Date, date, required








Object: Budget versions (c2c_budget.version)





	currency_id:	Currency, many2one, required









	code:	Code, char









	create_date:	Creation Date, datetime, readonly









	name:	Version Name, char, required









	budget_line_ids:

		Budget Lines, one2many









	company_id:	Company, many2one, required









	ref_date:	Reference Date, date, required









	note:	Notes, text









	budget_id:	Budget, many2one, required









	user_id:	User In Charge, many2one








Object: Budget Lines (c2c_budget.line)





	analytic_account_id:

		Analytic Account, many2one









	budget_version_id:

		Budget Version, many2one, required









	name:	Description, char









	amount_in_budget_currency:

		In Budget’s Currency, float, readonly









	currency_id:	Currency, many2one, required









	amount:	Amount, float, required









	budget_item_id:	Budget Item, many2one, required









	period_id:	Period, many2one, required








Object: Wizard Abstraction (c2c_budget.wizard_abstraction)




Object: Report Abstraction (c2c_budget.report_abstraction)
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Camptocamp Partner extension to synchronize OpenERP with LDAP (c2c_contact_to_ldap)





	Module:	c2c_contact_to_ldap


	Name:	Camptocamp Partner extension to synchronize OpenERP with LDAP


	Version:	5.0.1.2


	Author:	Camptocamp


	Directory:	c2c_contact_to_ldap


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Live partner address synchronization through a LDAP module (inetOrgPerson).
Tiny becomes the master of the LDAP. Each time an address is deleted, created or updated the same is done in the LDAP (a new record is pushed).
The LDAP configuration is done in the company view. There can be one different LDAP per company! Do not forget to activate
the LDAP link in the configuration.
The LDAP used depends on the current user company.

This module does not allow bulk batching synchronisation into the LDAP and is thus not suitable for instant use with an existing LDAP.
In order to use it with an existing LDAP you have to alter the uid of contact in your LDAP. The uid should be terp_ plus the OpenERP contact id (for example terp_10).

N.B: the module requires the python-ldap library

---------------------------------------------------------------------------------------------------------------------------------------
Ce module interface les partenaires OpenERP avec un repository LDAP existant. Ainsi, OpenERP devient le master, l'interface unique
de saisie des partenaires de l'entreprise. Tous ce qui est renseigné dans OpenERP est automatiquement reporté dans
LDAP (ajout, suppression, modification).

L'avantage d'utiliser un tel système est la constitution d'une base de données
client unique , qui pourra s'interfacer avec un client mail (Outlook, Thunderbird, etc..) pour avoir la complétion des adresses dans la
rédaction des mails. De plus, de nombreux systèmes de téléphonie utilisent maintenant une telle base pour la gestion des appels
(click to dial ou remontée de fiche).


--!!!!!!! V5 change log
added OU specification
Unicode support --> As python LDAP does not support unicode we try to decode string - if it fails we transliterate values
Active Directory Support








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_contact_to_ldap.zip]









Dependencies



	base

	c2c_partner_address









Reports

None




Menus

None




Views



	* INHERIT res.company.form (form)









Objects

None
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Invoice Correcting (c2c_correct_invoice)





	Module:	c2c_correct_invoice


	Name:	Invoice Correcting


	Version:	1.1


	Author:	Camptocamp


	Directory:	c2c_correct_invoice


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows correction of a paid invoice in one action.
-This will create a refund,
-Unreconcile the invoice and reconcile it with the refund
-If needed recreate an invoice
This wizard overrides the invoice Refund wizard
It adds two actions:
-The cancel invoice that will create a refund and unreconcile/reconcile it.
-The modify invoice that does the same as before but also creates a new invoice
which is a copy of the original.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_correct_invoice.zip]









Dependencies



	base

	c2c_partner_address

	account









Reports

None




Menus

None




Views

None




Objects

None
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CRM Reporting (c2c_crm_reporting)





	Module:	c2c_crm_reporting


	Name:	CRM Reporting


	Version:	1.0


	Author:	Camptocamp SA


	Directory:	c2c_crm_reporting


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Ce module permet d'afficher facilement les cas CRM , triés par date
------------------------------------------------------------------------------------------------------------
This module will add CRM Reporting tools








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_crm_reporting.zip]









Dependencies



	crm









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







c2c_cumulated_finance_report (c2c_cumulated_finance_report)





	Module:	c2c_cumulated_finance_report


	Name:	c2c_cumulated_finance_report


	Version:	5.0.1.0


	Author:	Camptocamp SA


	Directory:	c2c_cumulated_finance_report


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Modify the general ledger and the partner ledger in order to have the cumulated amount








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	account









Reports

None




Menus

None




Views

None




Objects

None
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Currency Rate Update (c2c_currency_rate_update)





	Module:	c2c_currency_rate_update


	Name:	Currency Rate Update


	Version:	0.5


	Author:	Camptocamp SA


	Directory:	c2c_currency_rate_update


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Import exchange rates from three different sources on the internet :

1. Admin.ch
   Updated daily, source in CHF. Source type is XML based.

2. Federal Reserve Bank of New York
   Daily 12 noon buying rates in New York are certified by the
   New York Federal Reserve Bank for customs purposes.
   Source in USD.
   http://www.newyorkfed.org/markets/pilotfx.html

3. European Central Bank
   The reference rates are based on the regular daily concertation procedure between
   central banks within and outside the European System of Central Banks,
   which normally takes place at 2.15 p.m. (14:15) ECB time. Source in EUR.
   http://www.ecb.europa.eu/stats/exchange/eurofxref/html/index.en.html

4. Google Finance
   Updated daily from Citibank N.A., source in EUR. Information may be delayed.
   This is parsed from an HTML page, so it may break in the future.

5. Bank of Canada
   Updated daily at 12:30 am, source in CAD, nominal rate. Source type is CSV based.

You can set time cycle for getting updates, 'first execute date' define when to start
the import and you can add a comment that describe why you use that particular service.

The module uses internal ir_cron feature from OpenERP, so the job is launched once
the server starts if the 'first execute date' is before the current day.

If in multi-company mode, the base currency will be the first company's currency
found in database.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_currency_rate_update.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/c2c_currency_rate_update.zip]

	trunk [http://www.openerp.com/download/modules/trunk/c2c_currency_rate_update.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Date in SO lines (c2c_date_in_so_line)





	Module:	c2c_date_in_so_line


	Name:	Date in SO lines


	Version:	5.0.1.0


	Author:	Camptocamp SA


	Directory:	c2c_date_in_so_line


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module allows to set planned execution date in Sale order
    When the SO is confirmed the delay is automatically computed, you do not have to use
    day for computing Delivery date of generated picking. If a date is set on the SO, it will automatically be taken in SO line, if not it will recompute a date based on the product customer lead time !!!Warning this module overwrites the SO line product_id_change function and add a parameters in signature. If another module does the same they will conflict








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	sale









Reports

None




Menus

None




Views



	* INHERIT sale.order.form (form)

	* INHERIT sale.order.form (form)

	* INHERIT sale.order.form (form)









Objects

None
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Fonctions standads C2C pour expense (c2c_expense)





	Module:	c2c_expense


	Name:	Fonctions standads C2C pour expense


	Version:	1.0


	Author:	Camptocamp


	Directory:	c2c_expense


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_expense.zip]









Dependencies



	base

	account

	c2c_base_account

	hr_expense









Reports

None




Menus

None




Views

None




Objects

None
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Financial report improvements (c2c_finance_report_extended)





	Module:	c2c_finance_report_extended


	Name:	Financial report improvements


	Version:	1.0


	Author:	Camptocamp SA


	Directory:	c2c_finance_report_extended


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Extended Report definition
------------------------------------------------------------------------------------------------------------
This module provide improvements on financial reports (general ledger, account balance, account balance compared








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_finance_report_extended.zip]









Dependencies



	c2c_finance_report

	c2c_reporting_tools

	c2c_fiscal_year_close









Reports

None




Menus

None




Views

None




Objects

None
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Financial report improvements (c2c_finance_report)





	Module:	c2c_finance_report


	Name:	Financial report improvements


	Version:	1.0


	Author:	Camptocamp SA


	Directory:	c2c_finance_report


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Ce modules propose des améliorations de certains rapports financier tel que le generel leder (
ajoute le report de colonnes dans les factures et les ordres de ventes.), le bilan et le bilan comparé
dispose d'une nouvelle mise en page
------------------------------------------------------------------------------------------------------------
This module provide improvements on financial reports (general ledger, account balance, account balance compared








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_finance_report.zip]









Dependencies



	account

	c2c_fiscal_year_close









Reports

None




Menus

None




Views

None




Objects

None
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c2c close fiscal year (c2c_fiscal_year_close)





	Module:	c2c_fiscal_year_close


	Name:	c2c close fiscal year


	Version:	0.6


	Author:	Camptocamp SA


	Directory:	c2c_fiscal_year_close


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module addresses the wizard "close fiscal year" of the 4.2 version
of OpenERP => it allows:

- Closing at any time
- Correctly report non-reconciled entries (positions open)
- Automatic transfer actual year result to the balance sheet
- Automatic closing of periods fiscal year
- News data checking
- Checking of the "closing type" of the accounts (compared to the
"closing type" of the "type of account")

The module work is :

1. tests (opening and closing journal, dates, previous fiscal years
status, etc. ..)
2. transfer the actual year result to the balance sheet
3. transfer the account balance of "balance" type to the new fiscal year
4. transfer of 31.12 non reconciles entries to the new fiscal year
(based on the dates of reconciled entries)
5. Reconciliation of the "new entries" entry to remove the conflict with
the initial invoice entry
6. closing periods and fiscal year

The module does not:
- Be able to re-open closed fiscal year (but we're available if you want
us to develop it :-) )
- Separate the step of transferring account balance and the step of
closing (=> we can develop that feature if necessary)

Here are the steps to allow the closing of fiscal year :

=> The following screencast will explain in detail how to do: http://www.screencast.com/t/lXLRJoQca

0. !!!!!!!!!!! MAKE A BACKUP OF THE DATABASE !!!!!!!!!!!
1. verify that the "types of closing" specified on the "type of
accounts" are correct
2. launch the "Finance -> Charts -> Charts of Account -> trouble accounts" list which give you the list of all the
accounts which the type of closing is different than that specified the
type of account
3. start the wizard closing "Finance -> End of Year Treatments -> close a fiscal year" specifying the asking fields
4. press OK

Camptocamp is open to support you in the process of closing on site or
remotely.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_fiscal_year_close.zip]









Dependencies



	base

	account









Reports

None




Menus

None




Views

None




Objects

None
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Holidays import in timesheet (c2c_holidays_import)





	Module:	c2c_holidays_import


	Name:	Holidays import in timesheet


	Version:	0.2


	Author:	Camptocamp


	Directory:	c2c_holidays_import


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_holidays_import.zip]









Dependencies



	hr

	account

	hr_holidays

	hr_timesheet_sheet









Reports

None




Menus

None




Views

None




Objects

None
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Holidays Report (c2c_holidays_report)





	Module:	c2c_holidays_report


	Name:	Holidays Report


	Version:	1.0


	Author:	Camptocamp


	Directory:	c2c_holidays_report


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_holidays_report.zip]









Dependencies



	hr_holidays

	c2c_reporting_tools









Reports

None




Menus

None




Views

None




Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
  

C2C Hours Blocks (c2c_hours_blocks)





	Module:	c2c_hours_blocks


	Name:	C2C Hours Blocks


	Version:	1.2


	Author:	Camptocamp


	Directory:	c2c_hours_blocks


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows you to follow product that you want to sell in one block (Support hours etc...)








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_hours_blocks.zip]









Dependencies



	base

	account

	product









Reports

None




Menus

None




Views

None




Objects

None
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Fonctions standads C2C pour timsheet (c2c_hr_timesheet_sheet)





	Module:	c2c_hr_timesheet_sheet


	Name:	Fonctions standads C2C pour timsheet


	Version:	1.0


	Author:	Camptocamp


	Directory:	c2c_hr_timesheet_sheet


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_hr_timesheet_sheet.zip]









Dependencies



	base

	account

	hr_timesheet_sheet









Reports

None




Menus

None




Views

None




Objects

None
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C2C Invoice Layer (c2c_invoice_layer)





	Module:	c2c_invoice_layer


	Name:	C2C Invoice Layer


	Version:	0.2


	Author:	Camptocamp


	Directory:	c2c_invoice_layer


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Improvement of supplier and customer invoice view: better management on due date, payment term, better ergonomics, ...








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_invoice_layer.zip]









Dependencies



	account

	account_tax_include









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Invoice customisation (c2c_invoice_report)





	Module:	c2c_invoice_report


	Name:	Invoice customisation


	Version:	5.0.1.0


	Author:	Camptocamp


	Directory:	c2c_invoice_report


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/c2c_invoice_report.zip]

	trunk [http://www.openerp.com/download/modules/trunk/c2c_invoice_report.zip]









Dependencies



	account









Reports

None




Menus



	Financial Management/Configuration/Invoice Condition/Conditions

	Financial Management/Configuration/Invoice Condition/Edit Conditions









Views



	account.condition_text.form (form)

	account.condition_text.list (tree)

	* INHERIT account.invoice.form.date_sent (form)

	* INHERIT account.invoice.form.date_sent (form)









Objects


Object: Invoice condition text (account.condition_text)





	text:	text, text, required









	type:	type, selection, required









	name:	Methode, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi-Costs Handling base (c2c_multicost_base)





	Module:	c2c_multicost_base


	Name:	Multi-Costs Handling base


	Version:	5.0.1.0


	Author:	Camptocamp


	Directory:	c2c_multicost_base


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This improves OpenERP multi-cost handling, overall for multi-company, regarding to product costs. It also improves
the multi-currency handling into analytic accounting.

This module (as all c2c_multicost*) is a backport to current stable from our work merged in the trunk branch of OpenERP.

What has been done here:

 * Add price type on company as a property (with default value based on standard price)

 * Analytic accounting
  * Use the price type currency and field for cost valuation (including timesheet)
  * Add multi-currency on analytic lines (similar to financial accounting)
  * Allow to share the same product between company employees, with different cost for each one
  * Correct all "costs" indicators into analytic account to base them on the correct currency (owner's company)

 * By default, nothing change for single company implementation (base the cost valuation on standard price)

 * Factorise part of function field into analytic accounting

As a result, we can now share the same product between companies that don't have the same currency and/or same cost price.
We can also manage one field per company on the product form to store the cost for a given price type (and so for a given company).


Warning !!

This module change some functions signatures in some object. In order to have it running properly,
you need to install every c2c_multicost_*, where * is the name of the already install module.

Example : If you're using hr_expense, then don't forget to install c2c_multicost_expense.

Please, also verify that one of your specific modules on concerned methodes.

How to setup:
-------------

This module won't change anything unless you assign a different price_type to your company. This price type has
to point on one of the product.product "float" field as the costing value for this company. The currency used is the one
define into the price type. It has to be the same than your company currency !

Example 1 :

Your company is in EUR. You can setup a different price type for your company. Let it point on a new product.product field,
lets say "my_new_product_cost_price" (this field needs to be defined in one of your specific module). Now this new field
will be used as the new cost price for all product.

Example 2 :

You have two companies, one in CHF and the other in EUR. Assuming each of your company has its own price type pointing on
their own float field, you can now have one product but a different cost for each company.

Company 1 (EUR) -> price type "Cost EUR", pointing on "standard_price"

Company 2 (CHF) -> price type "Cost CHF", pointing on "standard_price_chf"

With this configuration, you can also easily update your costs price with a simple .csv import using one of the
client (GTK or Web).








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	account

	account_analytic_analysis

	product









Reports

None




Menus

None




Views



	* INHERIT res.company.product.property.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi-Costs Handling in expense (c2c_multicost_expense)





	Module:	c2c_multicost_expense


	Name:	Multi-Costs Handling in expense


	Version:	5.0.1.0


	Author:	Camptocamp


	Directory:	c2c_multicost_expense


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This improves multi-company in OpenERP regarding product costs in company. Refer
to c2c_multicost_base description for more information...

This module needs to be installed if you install both hr_expense and c2c_multicost_base.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	hr_expense

	c2c_multicost_base









Reports

None




Menus

None




Views



	* INHERIT hr.expense.form (form)

	* INHERIT hr.expense.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi-Costs Handling in project timesheet (c2c_multicost_project_timesheet)





	Module:	c2c_multicost_project_timesheet


	Name:	Multi-Costs Handling in project timesheet


	Version:	5.0.1.0


	Author:	Camptocamp


	Directory:	c2c_multicost_project_timesheet


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This improves multi-company in OpenERP regarding product costs in company. Refer
to c2c_multicost_base description for more information...

This module needs to be installed if you install both project_timesheet and c2c_multicost_base.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	project_timesheet

	c2c_multicost_base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi-Costs Handling in stock (c2c_multicost_stock)





	Module:	c2c_multicost_stock


	Name:	Multi-Costs Handling in stock


	Version:	5.0.1.0


	Author:	Camptocamp


	Directory:	c2c_multicost_stock


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This improves multi-company in OpenERP regarding product costs in company. Refer
to c2c_multicost_base description for more information...

What has been done here:

 * Add price type on company as a property (with default value based on standard price)

 * Stock accounting
  * Use the price type currency and field for cost valuation
  * Into stock move for standard price
  * Into stock move for average price

This module needs to be installed if you install both stock and c2c_multicost_base.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	stock

	c2c_multicost_base









Reports

None




Menus

None




Views

None




Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi-Costs Handling in hr_timesheet_invoice (c2c_multicost_timesheet_invoice)





	Module:	c2c_multicost_timesheet_invoice


	Name:	Multi-Costs Handling in hr_timesheet_invoice


	Version:	5.0.1.0


	Author:	Camptocamp


	Directory:	c2c_multicost_timesheet_invoice


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This improves multi-company in OpenERP regarding product costs in company. Refer
to c2c_multicost_base description for more information...

This module needs to be installed if you install both hr_timesheet_invoice and c2c_multicost_base.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	hr_timesheet_invoice

	c2c_multicost_base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi-Costs Handling in hr_timesheet (c2c_multicost_timesheet)





	Module:	c2c_multicost_timesheet


	Name:	Multi-Costs Handling in hr_timesheet


	Version:	5.0.1.0


	Author:	Camptocamp


	Directory:	c2c_multicost_timesheet


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This improves multi-company in OpenERP regarding product costs in company. Refer
to c2c_multicost_base description for more information...

This module needs to be installed if you install both hr_timesheet and c2c_multicost_base.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	hr_timesheet

	c2c_multicost_base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi-Costs Handling in analytic_user_function (c2c_multicost_user_function)





	Module:	c2c_multicost_user_function


	Name:	Multi-Costs Handling in analytic_user_function


	Version:	5.0.1.0


	Author:	Camptocamp


	Directory:	c2c_multicost_user_function


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This improves multi-company in OpenERP regarding product costs in company. Refer
to c2c_multicost_base description for more information...

This module needs to be installed if you install both analytic_user_function and c2c_multicost_base.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	analytic_user_function

	c2c_multicost_base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







c2c_multi_currency_consolidated_chart (c2c_multi_currency_consolidated_chart)





	Module:	c2c_multi_currency_consolidated_chart


	Name:	c2c_multi_currency_consolidated_chart


	Version:	5.0.1.0


	Author:	Camptocamp SA


	Directory:	c2c_multi_currency_consolidated_chart


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Modify the account chart
        __compute function to have amount in the correct currency in multi-currencies consolidated chart.
        The module also adds a new date field in the account chart wizard








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	account









Reports

None




Menus

None




Views

None




Objects

None
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Multi currency expenses (c2c_multi_currency_expense)





	Module:	c2c_multi_currency_expense


	Name:	Multi currency expenses


	Version:	0.1


	Author:	Camptocamp


	Directory:	c2c_multi_currency_expense


	Web:	http://tinyerp.com/


	Official module:

		no


	Quality certified:

		no






Description

Add multi currency support for expenses








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_multi_currency_expense.zip]









Dependencies



	hr_expense









Reports

None




Menus

None




Views

None




Objects

None
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Auto currency computation in journal (c2c_multicurrency_journal)





	Module:	c2c_multicurrency_journal


	Name:	Auto currency computation in journal


	Version:	1.0


	Author:	Camptocamp


	Directory:	c2c_multicurrency_journal


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Modify the journal view in order to fill automatically the field currency_amount, or amount. It will add
amount_currency and currency columns in your journal view. You can remove this columns of the views without any         trouble by editing your journal view. But if there are no amount_currency and currency column the module will           be ineffective.
The journal will check if there is a currency, amount-currency or an amount data enter and complete the others.
The date taken for computation will be maturity date if there is one, else it will use today date.
If you enter currency amount it sign will decide if it is a debit or credit writing








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_multicurrency_journal.zip]









Dependencies



	base

	account

	product









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







c2c_multi_header (c2c_multi_header)





	Module:	c2c_multi_header


	Name:	c2c_multi_header


	Version:	5.0.1.0


	Author:	Camptocamp SA


	Directory:	c2c_multi_header


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

c2c_multi_header








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base









Reports

None




Menus



	Administration/Users/Company’s Structure/Header IMG

	Administration/Users/Company’s Structure/Header RML









Views



	* INHERIT res.company.form.inherit (form)

	res.company.header.img (form)

	res.company.header.rml (form)









Objects


Object: c2c.header_rml (c2c.header_rml)





	name:	Name, char, required









	rml:	RML, text








Object: c2c.header_img (c2c.header_img)





	name:	Name, char, required









	img:	Image, binary
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







c2c_one_time_password_login (c2c_one_time_password_login)





	Module:	c2c_one_time_password_login


	Name:	c2c_one_time_password_login


	Version:	5.0.1.0


	Author:	Camptocamp SA


	Directory:	c2c_one_time_password_login


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Generic OTP login module that provides basic
    session and mechanism for OTP.

    We do not intend to provide a generic authentication framework, just one for OTP.
    Actually it is not designed to support CAS, Kerberos etc.

    The c2c_one_time_password_login provides the base mechanism for OTP
    like authentication function overriding, user session, login management, timeout management, multi connection, etc.
    You have one function (check_otp) to override in a provider module.
    A provider module lets you write a provider for a specific OTP system
    You have a sample in the c2c_one_time_password_login_yubikey_provider module.
    The OTP configuration is done on the company view. Please see the help in the form.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base









Reports

None




Menus

None




Views



	* INHERIT res.company.form.inherit (form)

	* INHERIT res.company.form.otp_setting (form)









Objects

None
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Show orphans accounts (c2c_orphans_accounts_checker)





	Module:	c2c_orphans_accounts_checker


	Name:	Show orphans accounts


	Version:	1.0


	Author:	Camptocamp


	Directory:	c2c_orphans_accounts_checker


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This module will show all accounts with no parents








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_orphans_accounts_checker.zip]









Dependencies



	account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







C2C partner address (c2c_partner_address)





	Module:	c2c_partner_address


	Name:	C2C partner address


	Version:	5.0.1.2


	Author:	Camptocamp


	Directory:	c2c_partner_address


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Add fields on address and categories
    to be more compatible with
    LDAP and Active Directory.
    Add commodities for addresses input.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_partner_address.zip]









Dependencies



	base









Reports

None




Menus



	Partners/Configuration/Address categories/Address category’s Structure

	Partners/Contact by address category

	Partners/Configuration/Address categories/Edit adresses categories









Views



	* INHERIT res.partner.address.form1.c2c_partner_adress (form)

	* INHERIT res.partner.address.form1.c2c_partner_adress (form)

	* INHERIT res.partner.address.form2_c2c_partner_address (form)

	* INHERIT res.partner.address.form2_c2c_partner_address (form)

	res.partner.address.category.form (form)

	res.partner.address.category.list (tree)

	res.partner.address.category.tree (tree)









Objects


Object: Partner address Categories (res.partner.address.category)





	active:	Active, boolean









	parent_id:	Parent Category, many2one









	child_ids:	Childs Category, one2many









	complete_name:	Name, char, readonly









	name:	Category Name, char, required
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Planning management (c2c_planning_management)





	Module:	c2c_planning_management


	Name:	Planning management


	Version:	1.0


	Author:	Camptocamp


	Directory:	c2c_planning_management


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_planning_management.zip]









Dependencies



	c2c_reporting_tools

	c2c_project_activities

	analytic_user_function

	report_analytic_planning

	c2c_holidays_import

	hr









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Project activities (c2c_project_activities)





	Module:	c2c_project_activities


	Name:	Project activities


	Version:	5.0.1.0


	Author:	Camptocamp


	Directory:	c2c_project_activities


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_project_activities.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/c2c_project_activities.zip]

	trunk [http://www.openerp.com/download/modules/trunk/c2c_project_activities.zip]









Dependencies



	account

	hr_timesheet_sheet

	project









Reports

None




Menus



	Project Management/Configuration/Project activity/Project activity

	Project Management/Configuration/Project activity/Activity tree

	Project Management/Configuration/Project activity/Edit Project activity









Views



	project.activity_al.form (form)

	project.activity_al.list (tree)

	project.activity_al.tree (tree)

	* INHERIT account.analytic.account.form (form)

	* INHERIT hr.timesheet.sheet.form (form)

	* INHERIT account.analytic.line.form (form)

	* INHERIT account.analytic.line.tree (tree)









Objects


Object: Project activity (project.activity_al)





	parent_id:	Parent activity, many2one









	code:	Code, char, required









	child_ids:	Childs Activity, one2many









	project_ids:	Concerned project, many2many









	name:	Activity, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Refresh Sale orders line prices (c2c_refresh_so_lines)





	Module:	c2c_refresh_so_lines


	Name:	Refresh Sale orders line prices


	Version:	5.0.1.0


	Author:	Camptocamp SA


	Directory:	c2c_refresh_so_lines


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/c2c_refresh_so_lines.zip]

	trunk [http://www.openerp.com/download/modules/trunk/c2c_refresh_so_lines.zip]









Dependencies



	base

	sale









Reports

None




Menus

None




Views



	* INHERIT solstis_custom_sale (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







c2c Reporting Tools. A library that provide a new way to create clean reports efficiently (c2c_reporting_tools)





	Module:	c2c_reporting_tools


	Name:	c2c Reporting Tools. A library that provide a new way to create clean reports efficiently


	Version:	5.0.5.0


	Author:	Camptocamp


	Directory:	c2c_reporting_tools


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This module offers a growing collection of objects to create simple and advanced reports.
                     You can create powerful reports with a few lines of python code and nothing else. (no sxw, rml or xml)
                                 This module follow multiple goals:
                                   - To accelerate report creation by creating reusable pieces of code (one line of code to create standard header and footer)
                                   - To accelerate report generation (processing) by removing unnecessary parsing and transformations (direct python to pdf generation)
                                   - To improve reporting capabilities by getting rid of incomplete parsers and limited middle technologies
                                   - To make reports designs more uniform

                                 For examples please see c2c_planning_management (our first module based on this tool).








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_reporting_tools.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/c2c_reporting_tools.zip]

	trunk [http://www.openerp.com/download/modules/trunk/c2c_reporting_tools.zip]









Dependencies

None




Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Order line of sale order (c2c_sale_sequence)





	Module:	c2c_sale_sequence


	Name:	Order line of sale order


	Version:	5.0.1.1


	Author:	Camptocamp


	Directory:	c2c_sale_sequence


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Add sequence in sale order line, allowing you to order them.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	sale









Reports

None




Menus

None




Views



	* INHERIT sale.order.form (form)

	* INHERIT sale.order.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Wizard to Scan BVR for Invoice (c2c_scan_bvr)





	Module:	c2c_scan_bvr


	Name:	Wizard to Scan BVR for Invoice


	Version:	5.0.1.3


	Author:	Camptocamp


	Directory:	c2c_scan_bvr


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

This module Will work with C-channel or other OCR scanner,
        the module helps you create an invoice directly from the BVR Code
        , currently it works with BVR and BVR+








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_scan_bvr.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/c2c_scan_bvr.zip]

	trunk [http://www.openerp.com/download/modules/trunk/c2c_scan_bvr.zip]









Dependencies



	l10n_ch









Reports

None




Menus



	Financial Management/Scan BVR









Views

None




Objects

None
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Stock obsolete (c2c_stock_obsolete)





	Module:	c2c_stock_obsolete


	Name:	Stock obsolete


	Version:	1.0


	Author:	Camptocamp


	Directory:	c2c_stock_obsolete


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_stock_obsolete.zip]









Dependencies



	stock

	product









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Timesheet fullfill wizard (c2c_timesheet_fullfill)





	Module:	c2c_timesheet_fullfill


	Name:	Timesheet fullfill wizard


	Version:	5.0.1.0


	Author:	Camptocamp


	Directory:	c2c_timesheet_fullfill


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Add a wizard into timesheet allowing people to complete a long period of time with the given values.
                This is mainly useful to handle a long period of time like holidays.
                Known limitation:
                  - Will complete all day between dates
                  - Timesheet days must be empty before using this wizard








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	hr_timesheet_sheet

	hr_holidays









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Timesheet Reports (c2c_timesheet_reports)





	Module:	c2c_timesheet_reports


	Name:	Timesheet Reports


	Version:	5.0.1.1


	Author:	camptocamp.com (aw)


	Directory:	c2c_timesheet_reports


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Timesheet Reports Module:
            * Add a report "/HR/report/Timesheets/Timesheet Status" that displays the timesheet status for each user: "confirmed", "draft", "missing".
              It displays 5 periods' status previous to a given date
            * Add a field "ended" to the employee form to define when the employee stopped working for the company
            * Add a tool "/HR/Configuration/Timesheet Reminder" to send automatic emails to those who did not complete their timesheet and add a boolean field to employees to define if they should receive this message or not








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_timesheet_reports.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/c2c_timesheet_reports.zip]

	trunk [http://www.openerp.com/download/modules/trunk/c2c_timesheet_reports.zip]









Dependencies



	hr_timesheet_sheet

	hr

	c2c_reporting_tools









Reports



	Timesheet Status









Menus



	Human Resources/Reporting/Timesheet/Timesheets Status

	Human Resources/Configuration/Timesheet Reminder









Views



	* INHERIT hr.employee.end.date.form (form)









Objects


Object: Handle the scheduling of messages (c2c_timesheet_reports.reminder)





	reply_to:	Reply To, char









	message:	Message, text









	subject:	Subject, char
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Translation synchronisation (c2c_translation_synchro)





	Module:	c2c_translation_synchro


	Name:	Translation synchronisation


	Version:	0.8


	Author:	camptocamp.com (jba)


	Directory:	c2c_translation_synchro


	Web:	http://camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Synchronize translations with new terms, put a default translation to allow modification from "All terms" menu.
Safe mode available, existing translations won't be overridden if active.

This module replaces the default translation importation.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/c2c_translation_synchro.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Carrier picking adds carrier contact information (carrier_picking)





	Module:	carrier_picking


	Name:	Carrier picking adds carrier contact information


	Version:	5.0.0.1


	Author:	Zikzakmedia


	Directory:	carrier_picking


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Carrier picking module:

* Adds contact carrier in picking lists and a field to store additional information (like vehicle's plate) in partner addresses and picking lists








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/carrier_picking.zip]

	trunk [http://www.openerp.com/download/modules/trunk/carrier_picking.zip]









Dependencies



	base

	stock









Reports

None




Menus

None




Views



	* INHERIT stock.picking.form.v1 (form)

	* INHERIT stock.picking.delivery.form.v1 (form)

	* INHERIT stock.picking.in.form.v1 (form)

	* INHERIT stock.picking.out.form.v1 (form)

	* INHERIT stock.picking.tree.v1 (tree)

	* INHERIT stock.picking.delivery.tree.v1 (tree)

	* INHERIT stock.picking.in.tree.v1 (tree)

	* INHERIT stock.picking.out.tree.v1 (tree)

	* INHERIT res.partner.form.v1 (form)

	* INHERIT res.partner.address.form.v1 (form)









Objects

None
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Module Catalogue (catalog)





	Module:	catalog


	Name:	Module Catalogue


	Version:	1.0


	Author:	Sednacom


	Directory:	catalog


	Web:	http://www.sednacom.fr


	Official module:

		no


	Quality certified:

		no






Description

Report for catalog








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/catalog.zip]

	trunk [http://www.openerp.com/download/modules/trunk/catalog.zip]









Dependencies



	base

	product









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI Account (cci_account)





	Module:	cci_account


	Name:	CCI Account


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_account


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

specific module for cci project which will use account module (Reports).








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_account.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_account.zip]









Dependencies



	account_invoice_layout

	sale

	account_analytic_plans

	l10n_be

	base_vat

	cci_partner

	membership









Reports



	Draft Invoices

	Print VCS









Menus



	Financial Management/Periodical Processing/Use Models









Views



	* INHERIT account.invoice.supplier.form.inherit (form)

	* INHERIT account.invoice.form.inherit (form)

	* INHERIT account.bank.statement.form (form)

	* INHERIT account.invoice.supplier.form (form)

	* INHERIT account.invoice.form (form)

	* INHERIT account.invoice.supplier.form (form)

	* INHERIT account.invoice.form (form)

	* INHERIT sale.order.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Audit Trail (cci_audittrail)





	Module:	cci_audittrail


	Name:	Audit Trail


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_audittrail


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Allows the administrator to track every user operation on all objects of the system.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_audittrail.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_audittrail.zip]









Dependencies



	audittrail









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI Base Contact (cci_base_contact)





	Module:	cci_base_contact


	Name:	CCI Base Contact


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_base_contact


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

specific module for cci project which will inherit
        base_contact module..








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_base_contact.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_base_contact.zip]









Dependencies



	base

	base_contact

	project









Reports

None




Menus



	Partners/Configuration/Link Type

	Partners/Configuration/Link Type/Contact Link Type









Views



	res.partner.country.relation.tree (tree)

	res.partner.country.relation.form (form)

	* INHERIT res.partner.contact.tree2 (tree)

	* INHERIT res.partner.contact.form (form)

	* INHERIT res.partner.contact.form (form)

	* INHERIT res.partner.contact.form (form)

	* INHERIT res.partner.contact.form (form)

	res.partner.contact.link.type.tree (tree)

	res.partner.contact.link.type.form (form)

	* INHERIT project.project.form.inherit (form)

	* INHERIT res.partner.job.form.inherit (form)









Objects


Object: res.partner.contact.link.type (res.partner.contact.link.type)





	name:	Name, char, required








Object: res.partner.contact.link (res.partner.contact.link)





	current_contact_id:

		Current contact, many2one, required









	name:	Name, char, required









	contact_id:	Contact, many2one, required









	type_id:	Type, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI Country (cci_country)





	Module:	cci_country


	Name:	CCI Country


	Version:	5.0.1.0


	Author:	CCILV


	Directory:	cci_country


	Web:	http://www.ccilv.be


	Official module:

		no


	Quality certified:

		no






Description

For some applications in the OpenERP software used by some Belgian Chamber of Commerce,
        we need a table regrouping countries and areas (group of countries). The table used by
        default in OpenERP doesn't answer to this need, because it's used in other and we need to
        specify if this code can be used in some cases or others
        This table is by evidence very specific to the Chamber of Commerce dedicated modules.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_country.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_country.zip]









Dependencies



	base









Reports

None




Menus



	Partners/Configuration/Country and Area









Views



	cci_country.form (form)

	cci_country.tree (tree)









Objects


Object: Country or Area for CCI (cci.country)





	cci_country_ids:

		Linked Countries-Areas, many2many









	phoneprefix:	Phone Prefix, integer









	description:	Description, text









	valid4embassy:	Embassy, boolean






Indicates if this code can be used for Embassies






	valid4certificate:

		Certificates, boolean






Indicates if this code can be used for certificates






	iscountry:	Country, boolean






Indicates if this code designates a country; if False, designates an area






	postalabbrev:	Postal Abbreviation, char









	code:	Code, char, required









	official_name:	Official Name, char









	active:	Active, boolean






Indicates if we can still use this country-area code






	valid4ata:	ATA, boolean






Indicates if this code can be used for carnets ATA






	name:	Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI CRM Profile (cci_crm_profile)





	Module:	cci_crm_profile


	Name:	CCI CRM Profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_crm_profile


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

specific module for cci project which will use crm_profile module.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_crm_profile.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_crm_profile.zip]









Dependencies



	base

	crm_profiling

	base_contact









Reports

None




Menus

None




Views



	* INHERIT Answers (tree)

	* INHERIT Answers (form)

	* INHERIT Questions (tree)

	* INHERIT Questions (form)

	* INHERIT Questions (form)

	* INHERIT res.partner.contact.form (form)

	* INHERIT res.partner.address.form (form)

	* INHERIT res.partner.job.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI CRM (cci_crm)





	Module:	cci_crm


	Name:	CCI CRM


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_crm


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

- define some groups with access rules
        - so using above rules , new object which will be confidential (can only be accessed by some users of group)








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_crm.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_crm.zip]









Dependencies



	base

	crm_configuration

	event

	cci_partner









Reports

None




Menus



	CRM & SRM/Meeting Confidential Info









Views



	* INHERIT crm.case.form.confidential (form)

	* INHERIT crm.case.form.inherit (form)

	* INHERIT event.event.form.inherit (form)

	meeting.confidential.info.form (form)

	meeting.confidential.info.tree (tree)

	meeting.confidential.info.form (form)

	meeting.confidential.info.tree (tree)









Objects


Object: Meeting Confidential Info (meeting.confidential.info)





	group:	Group, selection, required









	name:	Table, char









	description:	Description, text, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







cci Data 1 (cci_data_csv)





	Module:	cci_data_csv


	Name:	cci Data 1


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_data_csv


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_data_csv.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_data_csv.zip]









Dependencies



	base

	account

	l10n_be









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI EVENT (cci_event)





	Module:	cci_event


	Name:	CCI EVENT


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_event


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

specific module for cci project which will use Event module.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_event.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_event.zip]









Dependencies



	event_project

	account_payment

	membership

	cci_account

	cci_partner









Reports

None




Menus



	Events Organisation/Configuration/Groups

	Events Organisation/Configuration/Groups/Event Group

	Events Organisation/Event Check

	Events Organisation/Configuration/Event Check

	Events Organisation/Configuration/Event Check/Check Type

	Events Organisation/Event Meeting

	Events Organisation/Reporting/Registrations with Missing Checks









Views



	* INHERIT event.event.form.cci (form)

	* INHERIT event.event.form (form)

	* INHERIT event.event.form (form)

	* INHERIT event.event.form (form)

	* INHERIT event.event.form (form)

	* INHERIT event.event.form (form)

	* INHERIT event.event.form (form)

	event.event.tree (tree)

	* INHERIT Event type (form)

	* INHERIT Event type (tree)

	event.group.form (form)

	event.group.tree (tree)

	event.check.form (form)

	event.check.tree (tree)

	event.check.type.form (form)

	event.check.type.tree (tree)

	* INHERIT event.registration.form (form)

	* INHERIT event.registration.form (form)

	* INHERIT event.registration.form (form)

	* INHERIT event.registration.form (form)

	* INHERIT event.registration.form.cci (form)

	* INHERIT event.registration.form (form)

	* INHERIT event.registration.form (form)

	* INHERIT event.registration.form (form)

	* INHERIT event.registration.form (form)

	event.meeting.table.form (form)

	event.meeting.table.tree (tree)

	* INHERIT account.move.line.form (form)









Objects


Object: event.meeting.table (event.meeting.table)





	service:	Service, integer, required









	event_id:	Related Event, many2one, required









	contact_id2:	Second Contact, many2one, required









	contact_id1:	First Contact, many2one, required









	partner_id1:	First Partner, many2one, required









	table:	Table, char, required









	partner_id2:	Second Partner, many2one, required








Object: event.check.type (event.check.type)





	name:	Name, char, required








Object: event.check (event.check)





	date_reception:	Reception Date, date









	code:	Code, char









	name:	Name, char, required









	type_id:	Type, many2one









	date_submission:

		Submission Date, date









	date_limit:	Limit Date, date









	reg_id:	Inscriptions, many2one, required









	state:	State, selection, readonly









	unit_nbr:	Value, float








Object: event.group (event.group)





	picture:	Picture, binary









	type:	Type, selection, required









	name:	Group Name, char, required









	bookmark_name:	Value, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI Membership (cci_membership)





	Module:	cci_membership


	Name:	CCI Membership


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_membership


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

cci membership
            - vcs functionality for cci








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_membership.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_membership.zip]









Dependencies



	base

	membership

	cci_event









Reports

None




Menus



	Membership/Reporting/Select Specific Members









Views



	* INHERIT res.partner.form.member (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI mission (cci_mission)





	Module:	cci_mission


	Name:	CCI mission


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_mission


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

specific module for cci project.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_mission.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_mission.zip]









Dependencies



	base

	crm

	cci_partner

	product

	membership

	sale

	cci_event

	cci_account

	cci_translation

	cci_country









Reports

None




Menus



	Missions

	Missions/Configuration/Dossier Types

	Missions/Configuration/Site

	Missions/Configuration/Search Entries/Dossier

	Missions/Embassy Folder

	Missions/Configuration/Search Entries/Embassy Folder Lines

	Missions/Configuration/Custom Codes

	Missions/Legalizations

	Missions/Certificates

	Missions/Configuration/ATA Usage

	Missions/Configuration/Search Entries/Letters Log

	Missions/ATA Carnet

	Missions/Incompleted Certificates

	Financial Management/Periodical Processing/Group Draft Invoices for Missions and Events









Views



	* INHERIT res.partner.form (form)

	cci_missions.dossier_type.form (form)

	cci_missions.dossier_type.tree (tree)

	cci_missions.site.form (form)

	cci_missions.site.tree (tree)

	cci_missions.dossier.form (form)

	cci_missions.dossier.tree (tree)

	cci_missions.embassy_folder.form (form)

	cci_missions.embassy_folder.tree (tree)

	cci_missions.embassy_folder_line.form (form)

	cci_missions.embassy_folder_line.tree (tree)

	cci_missions.custom_code.form (form)

	cci_missions.custom_code.tree (tree)

	cci_missions.legalization.form (form)

	cci_missions.legalization.tree (tree)

	cci_missions.certificate.form (form)

	cci_missions.certificate.tree (tree)

	cci_missions.ata_usage.form (form)

	cci_missions.ata_usage.tree (tree)

	cci_missions.letters_log.form (form)

	cci_missions.letters_log.tree (tree)

	cci_missions.ata_carnet.form (form)

	cci_missions.ata_carnet.tree (tree)

	product.lines.tree (tree)

	product.lines.form (form)









Objects


Object: cci_missions.site (cci_missions.site)





	name:	Name of the Site, char, required









	embassy_sequence_id:

		Sequence for Embassy Folder, many2one, required









	official_name_4:

		Official Name of the Site, char









	official_name_1:

		Official Name of the Site, char, required









	official_name_3:

		Official Name of the Site, char









	official_name_2:

		Official Name of the Site, char








Object: cci_missions.embassy_folder (cci_missions.embassy_folder)





	date_closed:	Closed, datetime, readonly









	history_line:	Communication, one2many, readonly









	ref2:	Reference 2, reference









	create_date:	Created, datetime, readonly









	description:	Your action, text









	probability:	Probability (%), float









	canal_id:	Channel, many2one









	date_action_last:

		Last Action, datetime, readonly









	planned_cost:	Planned Costs, float









	partner_address_id:

		Partner Contact, many2one









	som:	State of Mind, many2one









	section_id:	Section, many2one, required









	customer_reference:

		Folders Reference for the Customer, char









	active:	Active, boolean









	member_price:	Member Price Allowed, boolean









	destination_id:	Destination Country, many2one









	date:	Date, datetime









	invoice_note:	Note to Display on the Invoice, text






to display as the last embassy_folder_line of this embassy_folder.






	crm_case_id:	Case, many2one









	planned_revenue:

		Planned Revenue, float









	id:	ID, integer, readonly









	date_action_next:

		Next Action, datetime, readonly









	invoice_id:	Invoice, many2one









	link_ids:	Linked Documents, one2many









	user_id:	Responsible, many2one









	name:	Description, char, required









	date_deadline:	Deadline, datetime









	invoice_date:	Invoice Date, datetime, readonly









	partner_id:	Partner, many2one









	embassy_folder_line_ids:

		Details, one2many









	categ_id:	Category, many2one









	priority:	Priority, selection









	state:	Status, selection, readonly









	site_id:	Site, many2one, required









	email_last:	Latest E-Mail, text, readonly









	email_cc:	Watchers Emails, char









	internal_note:	Internal Note, text









	ref:	Reference, reference









	email_from:	Partner Email, char









	log_ids:	Logs History, one2many, readonly








Object: cci_missions.embassy_folder_line  (cci_missions.embassy_folder_line)





	awex_amount:	AWEX Amount, float, readonly









	credit_line_id:	Credit Line, many2one, readonly









	name:	Description, char, required









	type:	Type, selection, required









	awex_eligible:	AWEX Eligible, boolean









	tax_rate:	Tax Rate, many2one









	folder_id:	Related Embassy Folder, many2one, required









	courier_cost:	Couriers Costs, float









	customer_amount:

		Invoiced Amount, float









	account_id:	Account, many2one, required








Object: cci_missions.dossier_type (cci_missions.dossier_type)





	code:	Code, char, required









	name:	Description, char, required









	copy_product_id:

		Reference for Copies, many2one, required






for the association with a pricelist






	id_letter:	ID Letter, char






for identify the type of certificate by the federation






	section:	Type, selection, required









	site_id:	Site, many2one, required









	sequence_id:	Sequence, many2one, required






for association with a sequence






	warranty_product_2:

		Warranty product for ATA carnet if not own Risk, many2one









	warranty_product_1:

		Warranty product for ATA carnet if Own Risk, many2one









	original_product_id:

		Reference for Original Copies, many2one, required






for the association with a pricelist





Object: cci_missions.dossier (cci_missions.dossier)





	goods:	Goods Description, char









	embassy_folder_id:

		Related Embassy Folder, many2one









	name:	Reference, char, required









	quantity_original:

		Quantity of Originals, integer, required









	type_id:	Dossier Type, many2one, required









	sender_name:	Sender Name, char









	invoiced_amount:

		Total, float









	sub_total:	Sub Total for Extra Products, float, readonly









	order_partner_id:

		Billed Customer, many2one, required









	to_bill:	To Be Billed, boolean









	state:	State, selection









	product_ids:	Products, one2many









	destination_id:	Destination Country, many2one









	invoice_id:	Invoice, many2one









	date:	Creation Date, date, required









	quantity_copies:

		Number of Copies, integer









	text_on_invoice:

		Text to Display on the Invoice, text









	id:	ID, integer, readonly









	asker_name:	Asker Name, char









	goods_value:	Value of the Sold Goods, float








Object: cci_missions.custom_code (cci_missions.custom_code)





	meaning:	Meaning, text, required









	official:	Official Code, boolean









	name:	Name, char, required








Object: cci_missions.certificate (cci_missions.certificate)





	embassy_folder_id:

		Related Embassy Folder, many2one









	legalization_ids:

		Related Legalizations, one2many









	type_id:	Dossier Type, many2one, required









	sender_name:	Sender Name, char









	invoiced_amount:

		Total, float









	asker_name:	Asker Name, char









	sub_total:	Sub Total for Extra Products, float, readonly









	asker_zip_id:	Asker Zip Code, many2one









	asker_address:	Asker Address, char









	origin_ids:	Origin Countries, many2many









	destination_id:	Destination Country, many2one









	date:	Creation Date, date, required









	total:	Total, float, readonly









	text_on_invoice:

		Text to Display on the Invoice, text









	id:	ID, integer, readonly









	special_reason:	For special cases, selection









	goods:	Goods Description, char









	name:	Reference, char, required









	quantity_original:

		Quantity of Originals, integer, required









	invoice_id:	Invoice, many2one









	customs_ids:	Custom Codes, many2many









	state:	State, selection









	dossier_id:	Dossier, many2one









	order_partner_id:

		Billed Customer, many2one, required









	sending_spf:	SPF Sending Date, date






Date of the sending of this record to the external database






	quantity_copies:

		Number of Copies, integer









	goods_value:	Value of the Sold Goods, float









	to_bill:	To Be Billed, boolean









	product_ids:	Products, one2many








Object: cci_missions.legalization (cci_missions.legalization)





	embassy_folder_id:

		Related Embassy Folder, many2one









	type_id:	Dossier Type, many2one, required









	sender_name:	Sender Name, char









	invoiced_amount:

		Total, float









	asker_name:	Asker Name, char









	sub_total:	Sub Total for Extra Products, float, readonly









	partner_member_state:

		Member State of the Partner, selection, readonly









	member_price:	Apply the Member Price, boolean









	destination_id:	Destination Country, many2one









	date:	Creation Date, date, required









	total:	Total, float, readonly









	text_on_invoice:

		Text to Display on the Invoice, text









	id:	ID, integer, readonly









	goods:	Goods Description, char









	name:	Reference, char, required









	quantity_original:

		Quantity of Originals, integer, required









	invoice_id:	Invoice, many2one









	state:	State, selection









	dossier_id:	Dossier, many2one









	order_partner_id:

		Billed Customer, many2one, required









	certificate_id:	Related Certificate, many2one









	quantity_copies:

		Number of Copies, integer









	goods_value:	Value of the Sold Goods, float









	to_bill:	To Be Billed, boolean









	product_ids:	Products, one2many








Object: cci_missions.courier_log (cci_missions.courier_log)





	documents_certificate:

		List of Certificates, text









	embassy_folder_id:

		Related Embassy Folder, many2one, required









	qtty_to_print:	Number of Sheets, integer









	copy_cba:	Photocopy Before CBA, boolean









	cba:	CBA, boolean









	message:	Message to the Courier, text









	address_street:	Street, char









	documents:	Number of Documents to Legalize, integer









	address_name_1:	Company Name, char









	address_name_2:	Contact Name, char









	consulate_name:	Consulate Name, char









	documents_invoice:

		List of Invoices, text









	partner_address_id:

		Courier, many2one









	copy_ministry:	Photocopy Before Ministry, boolean









	others:	Others, char









	translation:	Translation, boolean









	address_city:	City, char









	ministry:	Ministry, boolean









	return_address:	Address of Return, selection, required









	embassy_name:	Embassy Name, char









	documents_others:

		Others, text









	copy_embassy_consulate:

		Photocopy Before Embassy or Consulate, boolean








Object: cci_missions.ata_usage (cci_missions.ata_usage)





	name:	Usage, char, required








Object: cci_missions.ata_carnet (cci_missions.ata_carnet)





	warranty:	Warranty, float, readonly









	area_id:	Area, many2one, required









	type_id:	Related Type of Carnet, many2one, required









	member_price:	Apply the Member Price, boolean









	partner_member_state:

		Member State of the Partner, selection, readonly









	creation_date:	Emission Date, date, required









	ok_state_date:	Date of Closure, date









	partner_id:	Partner, many2one, required









	id:	ID, integer, readonly









	usage_id:	Usage, many2one, required









	federation_sending_date:

		Date of Sending to the Federation, date, readonly









	representer_name:

		Representer Name, char









	representer_city:

		Representer City, char









	warranty_product_id:

		Related Warranty Product, many2one, required









	initial_pages:	Initial Number of Pages, integer, required









	state:	State, selection, required, readonly









	representer_address:

		Representer Address, char









	insurer_agreement:

		Insurer Agreement, char









	double_signature:

		Double Signature, boolean









	additional_pages:

		Additional Number of Pages, integer









	goods_value:	Goods Value, float, required









	holder_name:	Holder Name, char









	sub_total:	Subtotal of Extra Products, float, readonly









	validity_date:	Validity Date, date, required









	holder_city:	Holder City, char









	product_ids:	Products, one2many









	holder_address:	Holder Address, char









	letter_ids:	Letters, one2many









	goods:	Goods, char









	name:	Name, char, required









	invoice_id:	Invoice, many2one









	partner_insurer_id:

		Insurer ID of the Partner, float, readonly









	return_date:	Date of Return, date









	own_risk:	Own Risks, boolean








Object: cci_missions.letters_log (cci_missions.letters_log)





	date:	Date of Sending, date, required









	letter_type:	Type of Letter, selection, required









	ata_carnet_id:	Related ATA Carnet, many2one, required








Object: Product Lines (product.lines)





	uos_id:	Unit, many2one









	name:	Description, char, required









	product_line_id:

		Product Ref, many2one









	price_unit:	Unit Price, float, required









	price_subtotal:	Subtotal, float, readonly









	dossier_product_line_id:

		Product Ref, many2one









	quantity:	Quantity, float, required









	product_id:	Product, many2one, required









	account_id:	Account, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI Partner (cci_partner)





	Module:	cci_partner


	Name:	CCI Partner


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_partner


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Specific module for cci project which will inherit partner module








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_partner.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_partner.zip]









Dependencies



	base

	base_vat

	cci_base_contact

	account_l10nbe_domiciliation

	cci_country









Reports



	Count invoices









Menus



	Partners/Configuration/States

	Partners/Configuration/States/Activity State

	Partners/Configuration/States/Customer State

	Partners/Configuration/Partner Activity

	Partners/Configuration/Partner Activity/Activity

	Partners/Configuration/Partner Activity/Activity Relation

	Partners/Configuration/Partner Activity/Activity List

	Partners/Configuration/Zip

	Partners/Configuration/Zip/Zip

	Partners/Configuration/Zip/Zip Group

	Partners/Configuration/Zip/Group Type

	Partners/Configuration/Article

	Partners/Configuration/Article/Article

	Partners/Configuration/Article/Article Keyword

	Partners/Configuration/Article/Article Reviews

	Partners/Configuration/Link Type/Partner Link Type









Views



	* INHERIT res.company.form (form)

	res.partner.state.form (form)

	res.partner.state2.form (form)

	res.partner.activity.form (form)

	res.partner.activity.tree (tree)

	res.partner.activity.relation.form (form)

	res.partner.activity.relation.tree (tree)

	res.partner.activity.list.form (form)

	res.partner.activity.list.tree (tree)

	res.partner.zip.form (form)

	res.partner.zip.tree (tree)

	res.partner.zip.group.form (form)

	res.partner.zip.group.tree (tree)

	res.partner.zip.group.type.form (form)

	res.partner.zip.group.type.tree (tree)

	res.partner.article.form (form)

	res.partner.article.tree (tree)

	res.partner.article.keywords.form (form)

	res.partner.article.keywords.tree (tree)

	res.partner.article.review.form (form)

	res.partner.article.review.tree (tree)

	res.partner.relation.type.form (form)

	res.partner.relation.tree (tree)

	res.partner.relation.form (form)

	* INHERIT res.partner.contact.form (form)

	* INHERIT res.partner.contact.form (form)

	* INHERIT res.partner.contact.form (form)

	* INHERIT res.partner.job.form.inherit1 (form)

	* INHERIT Partner addresses inherited (form)

	* INHERIT res.partner.form (form)

	* INHERIT res.partner.form (form)

	* INHERIT res.partner.form (form)

	* INHERIT res.partner.form (form)

	* INHERIT res.partner.form (form)

	* INHERIT res.partner.form (form)

	* INHERIT Partner form inherited (form)









Objects


Object: res.partner.state (res.partner.state)





	name:	Partner Status, char, required








Object: res.partner.state2 (res.partner.state2)





	name:	Customer Status, char, required








Object: res.partner.article.review (res.partner.article.review)





	date:	Date, date, required









	article_ids:	Articles, one2many









	name:	Name, char, required








Object: res.partner.article (res.partner.article)





	picture:	Picture, boolean









	subtitle:	Subtitle, text









	review_id:	Review, many2one









	canal_id:	Reference, char






A text with or without a link incorporated






	press_review:	In the next press review, boolean






Must be inserted on the next press review






	data:	Data, boolean









	title:	Title, char, required









	summary:	Summary, text









	source_id:	Source, char









	contact_ids:	Contacts, many2many









	keywords_ids:	Keywords, many2many









	graph:	Graph, boolean









	date:	Date, date, required









	partner_ids:	Partners, many2many









	article_length:	Length, float









	article_id:	Article, char









	page:	Page, integer








Object: res.partner.article.keywords (res.partner.article.keywords)





	article_ids:	Articles, many2many









	name:	Name, char, required








Object: res.partner.zip.group.type (res.partner.zip.group.type)





	name:	Name, char, required








Object: res.partner.zip.group (res.partner.zip.group)





	name:	Name, char, required









	type_id:	Type, many2one








Object: res.partner.zip (res.partner.zip)





	post_center_id:	Post Center, char









	city:	City, char









	user_id:	Salesman Responsible, many2one









	name:	Zip Code, char, required









	groups_id:	Areas, many2many









	post_center_special:

		Post Center Special, boolean









	partner_id:	Master Cci, many2one









	distance:	Distance, integer






Distance (km) between zip location and the cci.





Object: res.partner.activity.list (res.partner.activity.list)





	abbreviation:	Abbreviation, char









	name:	Code list, char, required








Object: res.partner.activity (res.partner.activity)





	code_relations:	Related codes, many2many









	code:	Code, char, required









	list_id:	List, many2one, required









	description:	Description, text









	label:	Label, char, required








Object: res.partner.activity.relation (res.partner.activity.relation)





	importance:	Importance, selection, required









	activity_id:	Activity, many2one









	partner_id:	Partner, many2one








Object: res.partner.relation.type (res.partner.relation.type)





	name:	Contact, char, required








Object: res.partner.relation (res.partner.relation)





	percent:	Ownership, float









	current_partner_id:

		Partner, many2one, required









	partner_id:	Partner, many2one, required









	description:	Description, text









	type_id:	Type, many2one, required








Object: res.partner.country.relation (res.partner.country.relation)





	country_id:	Country, many2one









	frequency:	Frequency, selection









	partner_id:	Partner, many2one









	type:	Types, selection
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI Purchase (cci_purchase)





	Module:	cci_purchase


	Name:	CCI Purchase


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_purchase


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

specific module for cci project which will use purchase module








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_purchase.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_purchase.zip]









Dependencies



	base

	purchase









Reports

None




Menus

None




Views



	* INHERIT purchase.order.form.inherit (form)

	* INHERIT purchase.order.form.inherit.note (form)

	* INHERIT purchase.order.form.inherit.cancel (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI Sales (cci_sales)





	Module:	cci_sales


	Name:	CCI Sales


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_sales


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

A Specific Module for CCI which will make the use of Sale module..








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_sales.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_sales.zip]









Dependencies



	sale_advertising

	crm









Reports

None




Menus

None




Views



	* INHERIT sale.order.form.inherit.cci.sales (form)

	* INHERIT sale.order.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI Security (cci_security)





	Module:	cci_security


	Name:	CCI Security


	Version:	False


	Author:	Tiny, CCILV


	Directory:	cci_security


	Web:	http://www.openerp.com, http://www.ccilv.be


	Official module:

		no


	Quality certified:

		no






Description

This module just adds some user groups for the management
        of users rights specific to the CCI domain








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_security.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_security.zip]









Dependencies



	profile_cci









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI Timesheet (cci_timesheet)





	Module:	cci_timesheet


	Name:	CCI Timesheet


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_timesheet


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

A Customised timesheet module.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_timesheet.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_timesheet.zip]









Dependencies



	base

	cci_partner

	cci_crm

	cci_base_contact









Reports

None




Menus



	Timesheet

	Timesheet/Configuration

	Timesheet/Timesheet

	Timesheet/Configuration/Grant

	Timesheet/Timesheet/Timesheet

	Timesheet/Timesheet/Timesheet Lines

	Timesheet/Timesheet/Timesheet Affectation

	Timesheet/Reporting

	Timesheet/Reporting/Timesheets per Employee

	Timesheet/Create Timesheet Lines









Views



	cci_timesheet.grant.form (form)

	cci_timesheet.grant.tree (tree)

	cci_timesheet.form (form)

	cci_timesheet.tree (tree)

	cci_timesheet.line.form (form)

	cci_timesheet.line.tree (tree)

	cci_timesheet.affectation.form (form)

	cci_timesheet.affectation.tree (tree)

	Timesheets per Employee (Tree) (tree)

	Timesheets per Employee (Form) (form)

	Timesheets per Employee (Graph) (graph)

	* INHERIT crm.case.form.confidential2 (form)

	* INHERIT crm.case.form.confidential3 (form)

	* INHERIT project.task.work.form (form)

	* INHERIT project.task.work.form1 (form)

	* INHERIT project.task.work.tree (tree)









Objects


Object: CCI Timesheet Grant (cci_timesheet.grant)





	line_ids:	Timesheet Lines, one2many









	affectation_ids:

		Affectation Lines, one2many









	name:	Grant Name, char, required








Object: CCI Timesheet (cci.timesheet)





	name:	Name, char, required, readonly









	date_from:	From Date, date, required









	sending_date:	Sending Date, date









	asked_amount:	Asked Amount, float









	state:	State, selection, required, readonly









	date_to:	To Date, date, required









	line_ids:	Timesheet Lines, one2many









	grant_id:	Grant, many2one, required, readonly









	accepted_amount:

		Accepted Amount, float








Object: CCI Timesheet Line (cci_timesheet.line)





	suppl_cost:	Supplementary Cost, float









	user_id:	User, many2one, required









	description:	Description, text









	diff_hours:	Hour To - Hour From, float, readonly









	zip_id:	Zip, many2one









	grant_id:	Grant, many2one









	contact_id:	Contact, many2one









	day_date:	Date of the Day, date, required









	hour_from:	Hour From, float, required









	hour_to:	Hour To, float, required









	timesheet_id:	Timesheet, many2one









	kms:	Kilometers, integer









	partner_id:	Partner, many2one









	name:	Name, char, required








Object: Timesheet Affectation (cci_timesheet.affectation)





	hours_per_week:	Hours Per Week, float, required









	user_id:	User, many2one, required









	name:	Name, char, required









	grant_id:	Grant, many2one, required









	rate:	Rate, float, required









	date_to:	To Date, date, required









	percentage:	Percentage, float, required









	date_from:	From Date, date, required








Object: Report on Timesheet and Affectation (report.timesheet.affectation)





	hours_per_week:	Hours Per Week, float









	description:	Description, text









	diff_hours:	Hours, float









	date_from:	From Date, date









	th_percentage:	Percentage, float









	affectation_name:

		Affectation, char









	day_date:	Date of the Day, date









	rate:	Rate, float









	hour_from:	Hour From, float









	hour_to:	Hour To, float









	date_to:	To Date, date









	timesheet_id:	Timesheet Ref, integer









	grant_name:	Grant, char









	user_name:	Employee, char









	name:	Name, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CCI Translation (cci_translation)





	Module:	cci_translation


	Name:	CCI Translation


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	cci_translation


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

cci translation








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/cci_translation.zip]

	trunk [http://www.openerp.com/download/modules/trunk/cci_translation.zip]









Dependencies



	base

	cci_account









Reports

None




Menus



	Translation

	Translation/Translation Dossier

	Translation/Credit Line

	Translation/Letter of Credence









Views



	translation.folder.form (form)

	translation.folder.tree (tree)

	credit.line.form (form)

	credit.line.tree (tree)

	letter.credence.form (form)

	letter.credence.tree (tree)

	* INHERIT res.partner.form.translation (form)









Objects


Object: Credit line (credit.line)





	from_date:	From Date, date, required









	customer_credit:

		Customer Max Credit, float, required









	to_date:	To Date, date, required









	name:	Name, char, required









	global_credit:	Global Credit, float, required








Object: Translation Folder (translation.folder)





	awex_amount:	AWEX Amount, float, readonly









	credit_line_id:	Credit Line, many2one, readonly









	name:	Name, text, required









	invoice_id:	Invoice, many2one









	order_desc:	Description, char, required









	base_amount:	Base Amount, float, required, readonly









	purchase_order:	Purchase Order, many2one









	awex_eligible:	AWEX Eligible, boolean, readonly









	state:	State, selection, readonly









	order_date:	Order Date, date, required









	partner_id:	Partner, many2one, required








Object: Letter of Credence (letter.credence)





	emission_date:	Emission Date, date, required









	asked_amount:	Asked Amount, float, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Module for Chemical Industries (chemical)





	Module:	chemical


	Name:	Module for Chemical Industries


	Version:	5.0.1.0


	Author:	H&D


	Directory:	chemical


	Web:	http://www.hu-div.fr


	Official module:

		yes


	Quality certified:

		yes






Description

Module for Chemical Industries








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/chemical.zip]

	trunk [http://www.openerp.com/download/modules/trunk/chemical.zip]









Dependencies



	base

	account

	product

	stock









Reports

None




Menus



	Products/Configuration/Chimie

	Products/Configuration/Chimie/product risque

	Products/Configuration/Chimie/product securite

	Products/Configuration/Chimie/product danger









Views



	* INHERIT product.normal.form (form)

	product.risque.tree (tree)

	product.risque.form (form)

	product.securite.tree (tree)

	product.securite.form (form)

	product.danger.tree (tree)

	product.danger.form (form)









Objects


Object: Risques Produits (product.risque)





	libelle:	libelle, char, required









	name:	Risque, char, required








Object: Securite Produits (product.securite)





	libelle:	libelle, char, required









	name:	Security, char, required








Object: Dangers Product (product.danger)





	libelle:	libelle, char, required









	name:	Danger, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account Period Sum (chricar_account_period_sum)





	Module:	chricar_account_period_sum


	Name:	Account Period Sum


	Version:	5.0.0.9.5


	Author:	ChriCar Beteiligungs und Beratungs GmbH


	Directory:	chricar_account_period_sum


	Web:	http://www.chricar.at/ChriCar


	Official module:

		no


	Quality certified:

		no






Description

This module adds period sums for moves_lines
        of account_moves with state posted
        *) on update from draft to posted
           hence: account_move_lines must NOT be added to account_moves with state posted.
        *) balance carried forward is calculated for all subsequent fiscal years
           no account_move_lines are generated for these sums
           these sums always represent the balance of the preceding fiscal year.
        *) on creation of new fiscal years -> balance carried forward
        *) on change of deferral_method in general accounts
           it's subject to another check if and when changes of this field are allowed.
           IMHO not if at least one fiscal year is closed.
        *) the name of fiscal years not ending on Dec 31st is year-period (YYYY-MM) of the end of the fiscal year
        *) for every fiscal year beginning in the same calendar year a period sum with the name YYYY00 will be created,
           but associated to the correct fiscal year.
        *) the period sums will be deleted if the matching account_periods are deleted.

    standardizes account_period name generation to comply with this naming.

    In respect of functionality of the sums it's feature complete but must be tested

    Things to come:
    * eventually - adapting the accounting reporting to use this sums (2c2?)








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	account

	chricar_view_id









Reports

None




Menus



	Financial Management/Charts/Accounts with Postings









Views



	account.account_with_postings.tree_chricar_1 (tree)

	account.account_with_postings.form_chricar_1 (form)









Objects


Object: Account Period Sum (account.account_period_sum)





	name:	Period, char









	sum_fy_period_id:

		Account FY id, integer, required, readonly









	credit:	Credit, float, required, readonly









	period_id:	Period, many2one, required, readonly









	debit:	Debit, float, required, readonly









	account_id:	Account, many2one, required, readonly








Object: Account Fiscalyear Period Sum (account.account_fy_period_sum)





	date_stop:	Date Stop, date, readonly









	name:	Period, char, readonly









	sum_fy_period_id:

		Account FY id, integer, readonly









	date_start:	Date Start, date, readonly









	credit:	Credit, float, readonly









	move_line_ids:	Account_moves, one2many









	period_id:	Period, many2one, readonly









	debit:	Debit, float, readonly









	balance:	Balance, float, readonly









	account_id:	Account, many2one, readonly








Object: Account Fiscalyear Sum (account.account_fiscalyear_sum)





	date_stop:	Date Stop, date, readonly









	account_id:	Account, many2one, readonly









	sum_fy_period_ids:

		Fiscal Year Period Sum, one2many









	date_start:	Date Start, date, readonly









	credit:	Credit, float, readonly









	fiscalyear_id:	Fiscal Year, many2one, readonly









	debit:	Debit, float, readonly









	balance:	Balance, float, readonly









	name:	Fiscal Year, char, readonly








Object: Accounts with Postings (account.account_with_postings)





	code:	Code, char, readonly









	name:	Name, char, readonly









	sum_fy_period_ids:

		Sum Fiscal Year Periods, one2many









	sum_period_ids:	Sum Periods, one2many









	shortcut:	Shortcut, char, readonly









	sum_fiscalyear_ids:

		Sum Fiscal Years, one2many









	type:	Account Type, selection, readonly








Object: triggger (triggger)
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Partner Parent Companies (chricar_partner_parent_companies)





	Module:	chricar_partner_parent_companies


	Name:	Partner Parent Companies


	Version:	5.0.0.2


	Author:	ChriCar Beteiligungs- und Beratungs- GmbH


	Directory:	chricar_partner_parent_companies


	Web:	http://www.chricar.at/ChriCar


	Official module:

		no


	Quality certified:

		no






Description

This module allows to define owners of a partner.
    The owner has to be defined in OpenERP as partner.
    Currently no check is made if max 100% of the capital is defined here
    Contract date+number
    legal and fiscal relevant periods
    Added Participation tab to partners to show Parent and Participations








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/chricar_partner_parent_companies.zip]

	trunk [http://www.openerp.com/download/modules/trunk/chricar_partner_parent_companies.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	* INHERIT res.partner.form.parent_company (form)

	res.partner.parent_company.form (form)

	res.partner.parent_company.tree (tree)









Objects


Object: res.partner.parent_company (res.partner.parent_company)





	valid_until:	Valid Until, date









	comment:	Notes, text









	valid_from:	Valid From, date









	name:	Share, float, required









	contract_date:	Contract Date, date









	consolidation:	Consolidation, boolean









	partner_parent_id:

		Parent, many2one, required









	state:	State, char









	valid_fiscal_until:

		Fiscal Valid Until, date









	active:	Active, boolean









	percentage:	Percentage, float









	valid_fiscal_from:

		Fiscal Valid From, date









	partner_id:	Partner, many2one, required









	contract_number:

		Contract Number, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product GTIN EAN8 EAN13 UPC JPC Support (chricar_product_gtin)





	Module:	chricar_product_gtin


	Name:	Product GTIN EAN8 EAN13 UPC JPC Support


	Version:	5.0.1.1


	Author:	ChriCar Beteiligungs- und Beratungs- GmbH


	Directory:	chricar_product_gtin


	Web:	http://www.chricar.at/ChriCar


	Official module:

		no


	Quality certified:

		no






Description

Replaces the EAN13 code completion with a checkroutine for EAN13, EAN8, JPC, UPC and GTIN
    makes EAN visible in simplified view








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/chricar_product_gtin.zip]

	trunk [http://www.openerp.com/download/modules/trunk/chricar_product_gtin.zip]









Dependencies



	product









Reports

None




Menus

None




Views



	* INHERIT product.gtin.form.view1 (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product Image (chricar_product_image)





	Module:	chricar_product_image


	Name:	Product Image


	Version:	5.0.1.1


	Author:	ChriCar Beteiligungs- und Beratungs- GmbH


	Directory:	chricar_product_image


	Web:	http://www.chricar.at/ChriCar


	Official module:

		no


	Quality certified:

		no






Description

Adds an image tab to products
sorts the products by code








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/chricar_product_image.zip]

	trunk [http://www.openerp.com/download/modules/trunk/chricar_product_image.zip]









Dependencies



	product









Reports

None




Menus

None




Views



	* INHERIT product.image.form.view1 (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







ChriCar unique View ID (chricar_view_id)





	Module:	chricar_view_id


	Name:	ChriCar unique View ID


	Version:	5.0.0.2


	Author:	Network Gulf IT - India


	Directory:	chricar_view_id


	Web:	http://www.chricar.at/ChriCar/index.html


	Official module:

		no


	Quality certified:

		no






Description

This module is funded by
ChriCar Beteiligungs- und Beratungs- GmbH
http://www.chricar.at/ChriCar/index.html

Developed by
Network Gulf IT - India
http://www.networkgulf.com/

usage: get_id('your_view_name',param1,param2,param3,param4)
this function will always return the SAME unique id for a
certain combination of parameters for a view.

Hint 1: You do not need this function if the unique ID can be easily
calculated during the grouping. Example
- easy: group by product_id
- more complex: group by account_id, period_id
- very complex: group by account_id, period_id, currency_id

Hint 2: for large tables (100000 rec)
performance gain of factor 10x and more
split the grouping operation and the get_id into 2 views

slow:
select get_id(tablename,param1,param2,...), param1, param2, ... sum(field1), ...
from
group by get_id(tablename,param1,param2,...) ,param1,param2,...

fast:
1) view1:
select ....
from
group by param1,param2,...
2) view 2
select get_id('view1',param1,param2,...),* from view1;
(no group by here)








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base









Reports

None




Menus

None




Views

None




Objects


Object: chricar_view_id (chricar_view_id)





	name:	Name, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







City-Helps to keep homogeneous address data in the Database (city)





	Module:	city


	Name:	City-Helps to keep homogeneous address data in the Database


	Version:	5.0.1.0


	Author:	Pablo Rocandio


	Directory:	city


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Creates a model for storing cities
Zip code, city, state and country fields are replaced with a location field in partner and partner contact forms.
This module helps to keep homogeneous address data in the database.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/city.zip]

	trunk [http://www.openerp.com/download/modules/trunk/city.zip]









Dependencies



	base









Reports

None




Menus



	Partners/Configuration/Localisation/Cities









Views



	* INHERIT partners_form_add_location (form)

	* INHERIT partners_form_del_city (form)

	* INHERIT partners_form_del_citycity (form)

	* INHERIT partners_form_del_zip (form)

	* INHERIT partners_form_del_state (form)

	* INHERIT partners_form_add_location1 (form)

	* INHERIT partners_form_del_city1 (form)

	* INHERIT partners_form_del_zip1 (form)

	* INHERIT partners_form_del_country1 (form)

	* INHERIT partners_form_add_location2 (form)

	* INHERIT partners_form_del_city2 (form)

	* INHERIT partners_form_del_zip2 (form)

	* INHERIT partners_form_del_country2 (form)

	* INHERIT view_country_state_form2 (form)

	city.city.tree (tree)

	city.city.form (form)









Objects


Object: City (city.city)





	state_id:	State, many2one, required









	name:	City, char, required









	zipcode:	ZIP, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Civil Engineering (civil_engineering)





	Module:	civil_engineering


	Name:	Civil Engineering


	Version:	5.0.0.1


	Author:	Zikzakmedia


	Directory:	civil_engineering


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Civil Engineering Works:

* Adds a new menu to manage civil engineering works: Location, agents and other consultancies, work data, structure data and assignments to projects.

* New entities for civil engineering works (all these entities have an hierarchical structure and a tree view, civil engineering works can be filtered from the tree view):
    * Work Class
    * Work Use
    * Structure Type
    * Foundation Type
    * Structural Model Abstraction
    * Structural Modeling Software.

* Adds a new tab in the project, sale, and purchase forms to relate these objects to civil engineering works








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	project

	sale

	purchase









Reports

None




Menus



	Civil Engineering

	Civil Engineering/Configuration

	Civil Engineering/Configuration/Categories

	Civil Engineering/Configuration/Categories/Work Classes

	Civil Engineering/Configuration/Categories/Work Uses

	Civil Engineering/Configuration/Structure

	Civil Engineering/Configuration/Structure/Structure Types

	Civil Engineering/Configuration/Structure/Foundation Types

	Civil Engineering/Configuration/Structure/Structural Model Abstractions

	Civil Engineering/Configuration/Structure/Structural Modeling Software

	Civil Engineering/Configuration/Civil Engineering Areas

	Civil Engineering/Civil Engineering Works

	Civil Engineering/Civil Engineering Works/Works by Work Class

	Civil Engineering/Civil Engineering Works/Works by Work Use

	Civil Engineering/Civil Engineering Works/Structure

	Civil Engineering/Civil Engineering Works/Structure/Works by Structure Type

	Civil Engineering/Civil Engineering Works/Structure/Works by Foundation Type

	Civil Engineering/Civil Engineering Works/Structure/Works by Model Abstraction

	Civil Engineering/Civil Engineering Works/Structure/Works by Modeling Software

	Civil Engineering/Work Project Assignments









Views



	civil_engineering.work.form (form)

	civil_engineering.work.tree (tree)

	civil_engineering.area.form (form)

	civil_engineering.area.tree (tree)

	civil_engineering.work.project.form (form)

	civil_engineering.work.project.tree (tree)

	civil_engineering.civil_engineering.workclassform (form)

	civil_engineering.civil_engineering.workclass.list (tree)

	civil_engineering.civil_engineering.workclass.tree (tree)

	civil_engineering.civil_engineering.workuseform (form)

	civil_engineering.civil_engineering.workuse.list (tree)

	civil_engineering.civil_engineering.workuse.tree (tree)

	civil_engineering.civil_engineering.structuretypeform (form)

	civil_engineering.civil_engineering.structuretype.list (tree)

	civil_engineering.civil_engineering.structuretype.tree (tree)

	civil_engineering.civil_engineering.foundationtypeform (form)

	civil_engineering.civil_engineering.foundationtype.list (tree)

	civil_engineering.civil_engineering.foundationtype.tree (tree)

	civil_engineering.civil_engineering.modelabstractionform (form)

	civil_engineering.civil_engineering.modelabstraction.list (tree)

	civil_engineering.civil_engineering.modelabstraction.tree (tree)

	civil_engineering.civil_engineering.modelingsoftwareform (form)

	civil_engineering.civil_engineering.modelingsoftware.list (tree)

	civil_engineering.civil_engineering.modelingsoftware.tree (tree)

	* INHERIT sale.order.form.civilengineering (form)

	* INHERIT purchase.order.form.civilengineering (form)

	* INHERIT project.project.form.civilengineering (form)









Objects


Object: Civil Engineering Work Class (civil_engineering.workclass)





	active:	Active, boolean






The active field allows you to hide the work class without removing it.






	parent_id:	Parent Work Class, many2one









	child_ids:	Child Work Class, one2many









	complete_name:	Full Name, char, readonly









	name:	Name, char








Object: Civil Engineering Work Use (civil_engineering.workuse)





	active:	Active, boolean






The active field allows you to hide the Work Use without removing it.






	parent_id:	Parent Work Use, many2one









	child_ids:	Child Work Use, one2many









	complete_name:	Full Name, char, readonly









	name:	Name, char








Object: Civil Engineering Structure Type (civil_engineering.structuretype)





	active:	Active, boolean






The active field allows you to hide the Structure Type without removing it.






	parent_id:	Parent Structure Type, many2one









	child_ids:	Child Structure Type, one2many









	complete_name:	Full Name, char, readonly









	name:	Name, char








Object: Civil Engineering Foundation Type (civil_engineering.foundationtype)





	active:	Active, boolean






The active field allows you to hide the Foundation Type without removing it.






	parent_id:	Parent Foundation Type, many2one









	child_ids:	Child Foundation Type, one2many









	complete_name:	Full Name, char, readonly









	name:	Name, char








Object: Civil Engineering Model Structural (civil_engineering.modelabstraction)





	active:	Active, boolean






The active field allows you to hide the Structural Model Abstraction without removing it.






	parent_id:	Parent Structural Model Abstraction, many2one









	child_ids:	Child Structural Model Abstraction, one2many









	complete_name:	Full Name, char, readonly









	name:	Name, char








Object: Civil Engineering Modeling Software (civil_engineering.modelingsoftware)





	active:	Active, boolean






The active field allows you to hide the Modeling Software without removing it.






	parent_id:	Parent Modeling Software, many2one









	child_ids:	Child Modeling Software, one2many









	complete_name:	Full Name, char, readonly









	name:	Name, char








Object: Civil Engineering Area (civil_engineering.area)





	name:	Name, char, required








Object: Civil Engineering Work (civil_engineering.work)





	floors_above_ground_level:

		Floors above ground level, integer









	structuretype_id:

		Structure Type, many2one









	workclass_id:	Work Class, many2one, required









	workuse_id:	Work Use, many2one, required









	work_builder:	Work builder, many2one









	project_manager:

		Project manager, many2one









	civil_engineer:	Civil engineer, many2one









	modelabstraction_id:

		Structural Model Abstraction, many2one









	geotechnics:	Geotechnics, many2one









	constructed_area:

		Constructed area, float









	city:	City, char









	project_ids:	Project, one2many









	country_id:	Country, many2one









	foundationtype_id:

		Foundation Type, many2one









	location:	Location, char









	work_safety:	Work safety, many2one









	structure_construction_cost:

		Structure construction cost, float









	work_owner:	Work owner, many2one









	floors_under_ground_level:

		Floors under ground level, integer









	work_construction_cost:

		Work construction cost, float









	plant_engineering:

		Plant engineering, many2one









	modelingsoftware_id:

		Structure Modeling Software, many2one









	main_city:	Main city, char









	name:	Work description, char, required









	structural_engineering:

		Structural engineering, many2one









	architecture:	Architecture, many2one









	state_id:	State, many2one









	distance_between_supports:

		Distance between supports, float








Object: Civil Engineering Work Project (civil_engineering.work.project)





	area_id:	Area, many2one, required









	project_id:	Project, many2one, required









	work_id:	Work, many2one, required









	sequence:	Sequence, integer
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sale agent Information (commission_pricelist)





	Module:	commission_pricelist


	Name:	Sale agent Information


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	commission_pricelist


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Sale agent Info








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	product

	sale









Reports



	Basic Info.









Menus



	Sales Management

	Sales Management/Commissions/Sales agent

	Sales Management/Reporting

	Sales Management/Reporting/This Month

	Sales Management/Reporting/This Month/Commissions of This Month

	Sales Management/Reporting/All Commissions

	Sales Management/Reporting/All Commissions/Commissions









Views



	saleagent.info.tree (tree)

	saleagent.info.form (form)

	* INHERIT res.partner.form.inherit (form)

	commission.month.form (form)

	commission.month.form.tree (tree)

	commission.all.form (form)

	commission.all.form.tree (tree)









Objects


Object: Sale agent sale info (sale.agent)





	customer:	Customer, one2many









	active:	Active, boolean









	partner_id:	Partner, many2one, required









	name:	Saleagent Name, char, required









	comprice_id:	commission price list, many2one, required








Object: Commission of month (report.commission.month)





	inv_total:	Invoice Amount, float, readonly









	name:	Sales Agent Name, char, readonly









	pdate:	Invoice Paid Date, date, readonly









	productname:	Product Name, char, readonly









	comrate:	Commission Rate (%), float, readonly









	sono:	Sales Order No, integer, readonly









	commission:	Commissions Amount, float, readonly









	state:	Invoice State, char, readonly









	invno:	Invoice Number, integer, readonly









	product_quantity:

		Product Quantity, integer, readonly









	in_date:	Invoice Date, date, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sale Agent Information (commission_rate)





	Module:	commission_rate


	Name:	Sale Agent Information


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	commission_rate


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Sale agent Info








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	product

	sale









Reports

None




Menus



	Sales Management

	Sales Management/Commissions

	Sales Management/Commissions/Sales agent

	Sales Management/Commissions/Reporting

	Sales Management/Commissions/Reporting/This Month

	Sales Management/Commissions/Reporting/This Month/All Commissions

	Sales Management/Commissions/Reporting/This Month/Commissions with Opened Invoices

	Sales Management/Commissions/Reporting/This Month/Commissions with Paid Invoices

	Sales Management/Commissions/Reporting/All Months

	Sales Management/Commissions/Reporting/All Months/All Commissions

	Sales Management/Commissions/Reporting/All Months/Commissions with Opened Invoices

	Sales Management/Commissions/Reporting/All Months/Commissions with Paid Invoices









Views



	saleagent.info.tree (tree)

	saleagent.info.form (form)

	* INHERIT res.partner.form.inherit (form)

	commission.month.form (form)

	commission.month.form.tree (tree)

	commission.all.form (form)

	commission.all.form.tree (tree)









Objects


Object: Sale agent sale info (sale.agent)





	customer:	Customer, one2many, readonly









	active:	Active, boolean









	partner_id:	Partner, many2one, required









	name:	Saleagent Name, char, required









	commission_rate:

		Commission Rate, float, required








Object: Commission of month (report.commission.month)





	inv_total:	Invoice Amount, float, readonly









	name:	Sales Agent Name, char, readonly









	pdate:	Invoice Paid Date, date, readonly









	productname:	Product Name, char, readonly









	comrate:	Commission Rate (%), float, readonly









	sono:	Sales Order No, char, readonly









	commission:	Commissions Amount, float, readonly









	state:	Invoice State, selection









	invno:	Invoice Number, char, readonly









	product_quantity:

		Product Quantity, integer, readonly









	in_date:	Invoice Date, date, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sale agent Information (commission)





	Module:	commission


	Name:	Sale agent Information


	Version:	0.1


	Author:	Tiny


	Directory:	commission


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Sale agent Info




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/commission.zip]









Dependencies



	base

	product

	sale









Reports



	Sale Agent









Menus

None




Views



	* INHERIT res.partner.form.inherit (form)









Objects



	report.commission.month

	report.commission.month.rate

	sale.agent
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







ERP Comparisons (comparison)





	Module:	comparison


	Name:	ERP Comparisons


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	comparison


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module manages the backend of a collaborative comparison website amongst
different products.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/comparison.zip]

	trunk [http://www.openerp.com/download/modules/trunk/comparison.zip]









Dependencies



	base









Reports

None




Menus



	ERP Comparison

	ERP Comparison/Configuration

	ERP Comparison/Configuration/Users

	ERP Comparison/Configuration/Items

	ERP Comparison/Configuration/Criterias

	ERP Comparison/Criterias Structure

	ERP Comparison/Reporting

	ERP Comparison/Reporting/Results of the Comparisons

	ERP Comparison/Configuration/Vote Values(Criterias)

	ERP Comparison/Votes

	ERP Comparison/Votes/New Vote

	ERP Comparison/Suggestions

	ERP Comparison/Suggestions/New Suggestion

	ERP Comparison/Configuration/Item Packs

	ERP Comparison/Periodical Processing

	ERP Comparison/Periodical Processing/Criterias

	ERP Comparison/Periodical Processing/Votes

	ERP Comparison/Periodical Processing/Ponderation Suggestions

	ERP Comparison/Periodical Processing/Criterias/Draft Criterias

	ERP Comparison/Periodical Processing/Criterias/Cancelled Criterias

	ERP Comparison/Periodical Processing/Votes/Draft Votes

	ERP Comparison/Periodical Processing/Votes/Cancelled Votes

	ERP Comparison/Periodical Processing/Ponderation Suggestions/Draft Suggestions

	ERP Comparison/Periodical Processing/Ponderation Suggestions/Cancelled Suggestions

	ERP Comparison/Periodical Processing/Recompute All Evaluations









Views



	comparison.user.form (form)

	comparison.user.tree (tree)

	comparison.item.form (form)

	comparison.item.tree (tree)

	comparison.factor.form (form)

	comparison.factor.list (tree)

	comparison.factor.tree (tree)

	comparison.factor.result.tree (tree)

	comparison.vote.values.form (form)

	comparison.vote.values.tree (tree)

	comparison.vote.form (form)

	comparison.vote.tree (tree)

	comparison.ponderation.suggestion.form (form)

	comparison.ponderation.suggestion.tree (tree)

	evaluation.pack.form (form)

	evaluation.pack.tree (tree)









Objects


Object: comparison.user (comparison.user)





	name:	Name, char, required









	suggestion_ids:	Ponderation Suggestions, one2many









	vote_ids:	Votes, one2many









	factor_ids:	Factors, one2many









	active:	Active, boolean









	password:	Password, char, required









	email:	Email, char, required








Object: comparison.item (comparison.item)





	load_default:	Load by Default, boolean






This option if checked, will let the Item display on Evaluation Matrix, by default.






	code:	Code, char, required









	user_id:	User, many2one









	name:	Software, char, required









	result_ids:	Results, one2many









	sequence:	Sequence, integer









	note:	Description, text









	state:	Status, selection, required









	version:	Version, char, required








Object: comparison.factor (comparison.factor)





	user_id:	User, many2one









	name:	Factor Name, char, required









	result_ids:	Results, one2many









	sequence:	Sequence, integer









	child_ids:	Child Factors, one2many









	note:	Note, text









	parent_id:	Parent Factor, many2one









	state:	Status, selection, required









	ponderation:	Ponderation, float









	pond_computed:	Computed Ponderation, float, readonly









	type:	Type, selection, required








Object: comparison.vote.values (comparison.vote.values)





	name:	Vote Type, char, required









	factor:	Factor, float, required








Object: comparison.vote (comparison.vote)





	user_id:	User, many2one









	factor_id:	Factor, many2one, required









	note:	Note, text









	state:	Status, selection, required, readonly









	score_id:	Value, many2one, required









	item_id:	Item, many2one, required








Object: comparison.factor.result (comparison.factor.result)





	item_id:	Item, many2one, required, readonly









	factor_id:	Factor, many2one, required, readonly









	votes:	Votes, float, readonly









	result:	Goodness(%), float, readonly








Object: comparison.ponderation.suggestion (comparison.ponderation.suggestion)





	user_id:	User, many2one, required









	factor_id:	Factor, many2one, required









	effect:	Ponderation Effect, selection






Select Positive if your suggestion has greater poderation value than the current value, negative otherwise.






	note:	Suggestion, text









	state:	State, selection, readonly









	ponderation:	Ponderation, float, required








Object: Evaluation Pack for Easy Comparison (evaluation.pack)





	name:	Name, char, required









	item_ids:	Items, many2many
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Bayesian Filter (crm_bayes)





	Module:	crm_bayes


	Name:	Bayesian Filter


	Version:	1.0


	Author:	Tiny


	Directory:	crm_bayes


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows automated actions to be performed on customers request, based on bayes. First we need to train some email contents in bayes to related category then after guess the email content using bayes and then send an email template to the customer. If you try to categorise without training no result is produced and the system cannot send an email template to the responsible customer to correct category.
For example, suppose you receive French, English and Spanish emails into one account. First we must train some content into each category. Any new emails will then filter correctly and send an email template to the correct category and responsible person.
Suppose a received email is in French, then it will automatically send email template in French.

Required Package:-     -> python-reverend




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/crm_bayes.zip]









Dependencies



	crm_configuration

	base









Reports

None




Menus

None




Views



	crm_bayes_group (form)

	crm_bayes_group (tree)

	crm_bayes_categories (form)

	crm_bayes_categories (tree)

	* INHERIT crm_case_rule (form)

	* INHERIT crm_case_bayes_form_oppor (form)

	* INHERIT crm_case_bayes_form_leads (form)

	* INHERIT crm_case_bayes_form_claims (form)

	* INHERIT crm_case_bayes_form_support (form)

	report.crm.bayes.statistic.tree (tree)

	report.crm.bayes.statistic.form (form)

	report.crm.bayes.statistic.graph (graph)









Objects



	crm.bayes.group

	crm.bayes.categories

	crm.bayes.test.guess

	crm.bayes.test.train

	crm.bayes.train.message

	report.crm.bayes.statistic
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Customer Relationship Management (crm_configuration)





	Module:	crm_configuration


	Name:	Customer Relationship Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	crm_configuration


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

The OpenERP case and request tracker enables a group of
people to intelligently and efficiently manage tasks, issues,
and requests. It manages key tasks such as communication,
identification, prioritization, assignment, resolution and notification.

This module provide screens like: jobs hiring process, leads, business
opportunities, fund raising tracking, support & helpdesk, calendar of
meetings, eso.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/crm_configuration.zip]

	trunk [http://www.openerp.com/download/modules/trunk/crm_configuration.zip]









Dependencies



	crm

	report_crm

	process









Reports

None




Menus



	CRM & SRM/Configuration/Cases/Stages

	CRM & SRM/Reporting/This Month/Cases by Section and Type

	CRM & SRM/Reporting/All Months/Cases by Section and Type

	CRM & SRM/Reporting/This Month/Cases by Section and Stage

	CRM & SRM/Reporting/All Months/Cases by Section and Stage

	CRM & SRM/Reporting/This Month/Cases by Section, Category and Stage

	CRM & SRM/Reporting/All Months/Cases by Section, Category and Stage

	CRM & SRM/Reporting/This Month/Cases by Section, Category and Type

	CRM & SRM/Reporting/All Months/Cases by Section, Category and Type









Views



	Configure Menu for Sections (form)

	CRM -Graph (graph)

	crm.case.stage.tree (tree)

	crm.case.stage.form (form)

	CRM - Bug Tracker Form (form)

	CRM - Bug Tracker Tree (tree)

	CRM - Bug Tracker Calendar (calendar)

	CRM - Jobs Requests Tree (tree)

	CRM - Jobs Requests Form (form)

	CRM - Jobs Requests Calendar (calendar)

	CRM - Leads Form (form)

	CRM - Leads Tree (tree)

	CRM - Leads Calendar (calendar)

	CRM - Meetings Form (form)

	CRM - Meetings Tree (tree)

	CRM - Meetings Calendar (calendar)

	CRM - Opportunities Form (form)

	CRM - Opportunities Tree (tree)

	CRM - Opportunities Calendar (calendar)

	CRM - Funds Tree (tree)

	CRM - Funds Form (form)

	CRM - Funds Calendar (calendar)

	CRM - Funds Graph (graph)

	CRM - Claims Tree (tree)

	CRM - Claims Form (form)

	CRM - Claims Calendar (calendar)

	CRM - Phone Calls Tree (tree)

	CRM - Phone Call Form (form)

	CRM - Phone Calls Calendar (calendar)

	CRM Report - Sections and Type(Tree) (tree)

	CRM Report - Sections and Type(Form) (form)

	CRM Report - Sections and Type(Graph) (graph)

	CRM Report - Sections and Stage(Tree) (tree)

	CRM Report - Sections and Stage(Form) (form)

	CRM Report - Sections and Stage(Graph) (graph)

	CRM Report - Section, Category and Stage(Tree) (tree)

	CRM Report - Section, Category and Stage(Form) (form)

	CRM Report - Section, Category and Type(Tree) (tree)

	CRM Report - Section, Category and Type(Form) (form)









Objects


Object: Category2 of case (crm.case.category2)





	name:	Case Category2 Name, char, required









	section_id:	Case Section, many2one








Object: Stage of case (crm.case.stage)





	sequence:	Sequence, integer









	section_id:	Case Section, many2one









	name:	Stage Name, char, required








Object: crm.menu.config_wizard (crm.menu.config_wizard)





	jobs:	Jobs Hiring Process, boolean






Help you to organise the jobs hiring process: evaluation, meetings, email integration...






	name:	Name, char









	lead:	Leads, boolean






Allows you to track and manage leads which are pre-sales requests or contacts, the very first contact with a customer request.






	document_ics:	Shared Calendar, boolean






Will allow you to synchronise your OpenERP calendars with your phone, outlook, Sunbird, ical, ...






	helpdesk:	Helpdesk, boolean






Manages an Helpdesk service.






	phonecall:	Phone Calls, boolean






Help you to encode the result of a phone call or to plan a list of phone calls to process.






	bugs:	Bug Tracking, boolean






Used by companies to track bugs and support requests on software






	fund:	Fund Raising Operations, boolean






This may help associations in their fund raising process and tracking.






	meeting:	Calendar of Meetings, boolean






Manages the calendar of meetings of the users.






	claims:	Claims, boolean






Manages the supplier and customers claims, including your corrective or preventive actions.






	opportunity:	Business Opportunities, boolean






Tracks identified business opportunities for your sales pipeline.





Object: Cases by section and category2 (report.crm.case.section.categ2)





	stage_id:	Stage, many2one, readonly









	user_id:	User, many2one, readonly









	name:	Month, date, readonly









	nbr:	# of Cases, integer, readonly









	section_id:	Section, many2one, readonly









	state:	State, selection, readonly









	amount_revenue:	Est.Revenue, float, readonly









	category2_id:	Type, many2one, readonly









	delay_close:	Delay Close, char, readonly








Object: Cases by section and stage (report.crm.case.section.stage)





	stage_id:	Stage, many2one, readonly









	user_id:	User, many2one, readonly









	name:	Month, date, readonly









	nbr:	# of Cases, integer, readonly









	section_id:	Section, many2one, readonly









	state:	State, selection, readonly









	amount_revenue:	Est.Revenue, float, readonly









	delay_close:	Delay Close, char, readonly









	categ_id:	Category, many2one, readonly








Object: Cases by section, Category and stage (report.crm.case.section.categ.stage)





	stage_id:	Stage, many2one, readonly









	user_id:	User, many2one, readonly









	name:	Month, date, readonly









	nbr:	# of Cases, integer, readonly









	section_id:	Section, many2one, readonly









	state:	State, selection, readonly









	delay_close:	Delay Close, char, readonly









	categ_id:	Category, many2one, readonly








Object: Cases by section, Category and Category2 (report.crm.case.section.categ.categ2)





	stage_id:	Stage, many2one, readonly









	user_id:	User, many2one, readonly









	name:	Month, date, readonly









	nbr:	# of Cases, integer, readonly









	section_id:	Section, many2one, readonly









	state:	State, selection, readonly









	category2_id:	Type, many2one, readonly









	delay_close:	Delay Close, char, readonly









	categ_id:	Category, many2one, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CRM Configuration Timesheet (crm_configuration_timesheet)





	Module:	crm_configuration_timesheet


	Name:	CRM Configuration Timesheet


	Version:	5.0.5.0


	Author:	Syleam


	Directory:	crm_configuration_timesheet


	Web:	http://www.Syleam.fr


	Official module:

		no


	Quality certified:

		no






Description

Add timesheet on CRM configuration (the same method as task's project),
    On partner form, CRM Analytic tab, define analytic account by CRM Section
    Define the default analytic account on each section
    Fill your summary work on the crm configuration.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/crm_configuration_timesheet.zip]









Dependencies



	base

	crm

	crm_configuration

	hr_timesheet

	crm_timesheet









Reports

None




Menus

None




Views



	* INHERIT CRM - Bugs Form - Add Timesheet (form)

	* INHERIT CRM - Claims Form - Add Timesheet (form)

	* INHERIT CRM - Fund Form - Add Timesheet (form)

	* INHERIT CRM - Jobs Form - Add Timesheet (form)

	* INHERIT CRM - Lead Form - Add Timesheet (form)

	* INHERIT CRM - Meetings Form - Add Timesheet (form)

	* INHERIT CRM - Opportunities Form - Add Timesheet (form)

	* INHERIT CRM - Phone Calls Form - Add Timesheet (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CRM - Livechat Jabber Client (crm_livechat)





	Module:	crm_livechat


	Name:	CRM - Livechat Jabber Client


	Version:	False


	Author:	Tiny


	Directory:	crm_livechat


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows you to configure and manage a livechat on your website.
So that your salesman can directly talk with your users in your website, using
their normal jabber account. This project includes two parts:
* An OpenERP module to manage everything
* A python Ajax client to set on your website for the end-user interface.

It allows you to define:
* XMPP (Jabber) Accounts for your users
* XMPP Accounts for anonymous customers

Then based one some events (a customer visiting some pages), it can open a
window so that the visitor can directly talk with your teams. It goes to a
jabber user according to what you configured in the OpenERP interface.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/crm_livechat.zip]

	trunk [http://www.openerp.com/download/modules/trunk/crm_livechat.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







crm_profiling management (crm_profiling)





	Module:	crm_profiling


	Name:	crm_profiling management


	Version:	5.0.1.3


	Author:	Tiny


	Directory:	crm_profiling


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows users to perform segmentation within partners.
    It uses the profiles criteria from the earlier segmentation module and improve it. Thanks to the new concept of questionnaire. You can now regroup questions into a questionnaire and directly use it on a partner.

    It also has been merged with the earlier CRM & SRM segmentation tool because they were overlapping.

    The menu items related are in "CRM & SRM\Configuration\Segmentations"


    * Note: this module is not compatible with the module segmentation, since it's the same which has been renamed.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/crm_profiling.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/crm_profiling.zip]

	trunk [http://www.openerp.com/download/modules/trunk/crm_profiling.zip]









Dependencies



	base

	crm









Reports

None




Menus



	CRM & SRM/Configuration/Segmentations/Questionnaires

	CRM & SRM/Configuration/Segmentations/Questions









Views



	Questionnaires (tree)

	Questionnaires (form)

	Answers (tree)

	Answers (form)

	Questions (tree)

	Questions (form)

	* INHERIT res.partner.profile.form (form)

	crm.segmentation.tree (tree)









Objects


Object: Question (crm_profiling.question)





	answers_ids:	Available answers, one2many









	name:	Question, char, required








Object: Questionnaire (crm_profiling.questionnaire)





	description:	Description, text, required









	name:	Questionnaire, char, required









	questions_ids:	Questions, many2many








Object: Answer (crm_profiling.answer)





	name:	Answer, char, required









	question_id:	Question, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Customer & Supplier Relationship Management (crm)





	Module:	crm


	Name:	Customer & Supplier Relationship Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	crm


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

The generic OpenERP Customer Relationship Management
system enables a group of people to intelligently and efficiently manage
leads, opportunities, tasks, issues, requests, bugs, campaign, claims, etc.
It manages key tasks such as communication, identification, prioritization,
assignment, resolution and notification.

OpenERP ensures that all cases are successfully tracked by users, customers and
suppliers. It can automatically send reminders, escalate the request, trigger
specific methods and lots of others actions based on your enterprise own rules.

The greatest thing about this system is that users don't need to do anything
special. They can just send email to the request tracker. OpenERP will take
care of thanking them for their message, automatically routing it to the
appropriate staff, and making sure all future correspondence gets to the right
place.

The CRM module has a email gateway for the synchronisation interface
between mails and OpenERP.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/crm.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/crm.zip]

	trunk [http://www.openerp.com/download/modules/trunk/crm.zip]









Dependencies



	base









Reports



	Business Opportunities









Menus



	CRM & SRM

	CRM & SRM/Configuration

	CRM & SRM/Configuration/Cases

	CRM & SRM/Configuration/Cases/Sections

	CRM & SRM/All Cases

	CRM & SRM/All Cases/Cases by section

	CRM & SRM/Configuration/Cases/Categories

	CRM & SRM/Configuration/Cases/Rules

	CRM & SRM/All Cases/All Cases

	CRM & SRM/All Cases/All Cases/Open Cases

	CRM & SRM/All Cases/My cases

	CRM & SRM/All Cases/My cases/My Open Cases

	CRM & SRM/All Cases/Cases Histories

	CRM & SRM/All Cases/Cases Histories/All Histories

	CRM & SRM/All Cases/Cases Histories/My Histories

	CRM & SRM/Configuration/Segmentations

	CRM & SRM/Configuration/Segmentations/Segmentations

	CRM & SRM/Configuration/Create menus for a case section









Views



	res.partner.events.form (tree)

	crm.case.section.form (form)

	crm.case.section.tree (tree)

	crm.case.categ.form (form)

	crm.case.categ.tree (tree)

	crm.case.rule.form (form)

	crm.case.rule.tree (tree)

	crm.case.log.tree (tree)

	crm.case.history.tree (tree)

	crm.case.calendar (calendar)

	crm.case.tree (tree)

	crm.case.form (form)

	crm.case.history.form (form)

	crm.segmentation.line.tree (tree)

	crm.segmentation.line.form (form)

	crm.segmentation.form (form)

	crm.segmentation.tree (tree)









Objects


Object: Case Section (crm.case.section)





	code:	Section Code, char









	user_id:	Responsible User, many2one









	name:	Case Section, char, required









	sequence:	Sequence, integer









	child_ids:	Child Sections, one2many









	parent_id:	Parent Section, many2one









	reply_to:	Reply-To, char






The email address put in the ‘Reply-To’ of all emails sent by OpenERP about cases in this section






	allow_unlink:	Allow Delete, boolean






Allows to delete non draft cases






	active:	Active, boolean








Object: Category of case (crm.case.categ)





	name:	Case Category Name, char, required









	probability:	Probability (%), float, required









	section_id:	Case Section, many2one








Object: Case Rule (crm.case.rule)





	trg_categ_id:	Category, many2one









	trg_section_id:	Section, many2one









	sequence:	Sequence, integer









	act_remind_partner:

		Remind Partner, boolean






Check this if you want the rule to send a reminder by email to the partner.






	trg_max_history:

		Maximum Communication History, integer









	trg_date_range_type:

		Delay type, selection









	act_section_id:	Set section to, many2one









	trg_date_range:	Delay after trigger date, integer









	act_remind_user:

		Remind responsible, boolean






Check this if you want the rule to send a reminder by email to the user.






	trg_priority_from:

		Minimum Priority, selection









	trg_date_type:	Trigger Date, selection









	act_method:	Call Object Method, char









	act_email_cc:	Add watchers (Cc), char






These people will receive a copy of the future communication between partner and users by email






	act_priority:	Set priority to, selection









	trg_state_to:	Button Pressed, selection









	act_mail_to_email:

		Mail to these emails, char









	act_remind_attach:

		Remind with attachment, boolean






Check this if you want that all documents attached to the case be attached to the reminder email sent.






	trg_user_id:	Responsible, many2one









	act_state:	Set state to, selection









	act_mail_to_partner:

		Mail to partner, boolean









	trg_priority_to:

		Maximum Priority, selection









	active:	Active, boolean









	act_mail_to_watchers:

		Mail to watchers (Cc), boolean









	name:	Rule Name, char, required









	trg_state_from:	Case State, selection









	act_user_id:	Set responsible to, many2one









	act_mail_to_user:

		Mail to responsible, boolean









	trg_partner_id:	Partner, many2one









	trg_partner_categ_id:

		Partner Category, many2one









	act_mail_body:	Mail body, text








Object: Case (crm.case)





	date_closed:	Closed, datetime, readonly









	history_line:	Communication, one2many, readonly









	create_date:	Created, datetime, readonly









	probability:	Probability (%), float









	canal_id:	Channel, many2one









	partner_address_id:

		Partner Contact, many2one









	som:	State of Mind, many2one









	date:	Date, datetime









	planned_revenue:

		Planned Revenue, float









	id:	ID, integer, readonly









	date_action_next:

		Next Action, datetime, readonly









	user_id:	Responsible, many2one









	partner_id:	Partner, many2one









	priority:	Priority, selection









	state:	Status, selection, readonly









	email_cc:	Watchers Emails, char









	ref:	Reference, reference









	log_ids:	Logs History, one2many, readonly









	description:	Your action, text









	date_action_last:

		Last Action, datetime, readonly









	planned_cost:	Planned Costs, float









	ref2:	Reference 2, reference









	section_id:	Section, many2one, required









	active:	Active, boolean









	categ_id:	Category, many2one









	name:	Description, char, required









	date_deadline:	Deadline, datetime









	email_last:	Latest E-Mail, text, readonly









	email_from:	Partner Email, char








Object: Case Communication History (crm.case.log)





	user_id:	User Responsible, many2one, readonly









	name:	Action, char









	canal_id:	Channel, many2one









	som:	State of Mind, many2one









	section_id:	Section, many2one









	case_id:	Case, many2one, required









	date:	Date, datetime








Object: Case history (crm.case.history)





	description:	Description, text









	canal_id:	Channel, many2one









	som:	State of Mind, many2one









	section_id:	Section, many2one









	date:	Date, datetime









	user_id:	User Responsible, many2one, readonly









	name:	Action, char









	log_id:	Log, many2one









	note:	Description, text, readonly









	case_id:	Case, many2one, required









	email:	Email, char








Object: Partner Segmentation (crm.segmentation)





	description:	Description, text









	som_interval_max:

		Max Interval, integer






The computation is made on all events that occurred during this interval, the past X periods.






	partner_id:	Max Partner ID processed, integer









	som_interval_default:

		Default (0=None), float






Default state of mind for period preceding the ‘Max Interval’ computation. This is the starting state of mind by default if the partner has no event.






	segmentation_line:

		Criteria, one2many, required









	som_interval_decrease:

		Decrease (0>1), float






If the partner has not purchased (or bought) during a period, decrease the state of mind by this factor. It’s a multiplication






	state:	Execution Status, selection, readonly









	sales_purchase_active:

		Use The Sales Purchase Rules, boolean






Check if you want to use this tab as part of the segmentation rule. If not checked, the criteria beneath will be ignored






	exclusif:	Exclusive, boolean






Check if the category is limited to partners that match the segmentation criterions. If checked, remove the category from partners that doesn’t match segmentation criterions






	categ_id:	Partner Category, many2one, required






The partner category that will be added to partners that match the segmentation criterions after computation.






	som_interval:	Days per Periode, integer






A period is the average number of days between two cycle of sale or purchase for this segmentation. It’s mainly used to detect if a partner has not purchased or bought for too long a time, so we suppose that their state of mind has changed because they probably bought goods from another supplier. Use this functionality for recurring businesses.






	name:	Name, char, required






The name of the segmentation.





Object: Segmentation line (crm.segmentation.line)





	expr_operator:	Operator, selection, required









	expr_value:	Value, float, required









	expr_name:	Control Variable, selection, required









	segmentation_id:

		Segmentation, many2one









	operator:	Mandatory / Optional, selection, required









	name:	Rule Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Telemarketing Management (crm_telemarketing)





	Module:	crm_telemarketing


	Name:	Telemarketing Management


	Version:	5.0.1.0


	Author:	Syleam


	Directory:	crm_telemarketing


	Web:	http://www.syleam.fr


	Official module:

		no


	Quality certified:

		no






Description

Add a new functionality on Questionnaire
New wizard on CRM Case to create a new case








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/crm_telemarketing.zip]

	trunk [http://www.openerp.com/download/modules/trunk/crm_telemarketing.zip]









Dependencies



	crm

	crm_configuration

	crm_profiling









Reports

None




Menus



	Partners/Create phone call list









Views



	* INHERIT Questionnaires form inherited (form)

	* INHERIT Questions from inherited (form)

	* INHERIT Questions from inherited (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CRM Timesheet (crm_timesheet)





	Module:	crm_timesheet


	Name:	CRM Timesheet


	Version:	5.0.1.0.2


	Author:	Syleam


	Directory:	crm_timesheet


	Web:	


	Official module:

		no


	Quality certified:

		yes






Description

Add timesheet on CRM (the same method as task's project),
    On partner form, CRM Analytic tab, define analytic account by CRM Section
    Define the default analytic account on each section
    Fill your summary work on the crm case.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/crm_timesheet.zip]









Dependencies



	base

	crm

	hr_timesheet









Reports

None




Menus

None




Views



	* INHERIT crm.case.case.work.form (form)

	* INHERIT res.partner.crm.analytic.form (form)

	* INHERIT crm.case.section.analytic.form (form)









Objects


Object: CRM Partner Analytic Account (res.partner.crm.analytic)





	partner_id:	Partner, many2one, required









	section_id:	Section, many2one, required









	account_id:	Analytic Account, many2one








Object: CRM summary work (crm.case.work)





	user_id:	Done by, many2one, required









	name:	Work summary, char









	hours:	Time spent, float









	case_id:	Case, many2one, required









	date:	Date, datetime









	hr_analytic_timesheet_id:

		Related Timeline Id, integer
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CRM Verticalisation (crm_vertical)





	Module:	crm_vertical


	Name:	CRM Verticalisation


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	crm_vertical


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Simplification of the interface for CRM.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/crm_vertical.zip]

	trunk [http://www.openerp.com/download/modules/trunk/crm_vertical.zip]









Dependencies



	crm_configuration









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Currency Rates (currency_rate)





	Module:	currency_rate


	Name:	Currency Rates


	Version:	5.0.1.0


	Author:	Axelor


	Directory:	currency_rate


	Web:	http://www.axelor.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/currency_rate.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/currency_rate.zip]

	trunk [http://www.openerp.com/download/modules/trunk/currency_rate.zip]









Dependencies



	base

	multi_company_currency









Reports

None




Menus



	Administration/Configuration/Base/Get Currency Rate









Views

None




Objects

None
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Module for custom developments (custom)





	Module:	custom


	Name:	Module for custom developments


	Version:	1.0


	Author:	Tiny


	Directory:	custom


	Web:	http://www.tinyerp.com


	Official module:

		no


	Quality certified:

		no






Description

Sample custom module where you can put your customer specific developments.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/custom.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Carriers and deliveries (delivery)





	Module:	delivery


	Name:	Carriers and deliveries


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	delivery


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Allows you to add delivery methods in sales orders and packing. You can define your own carrier and delivery grids for prices. When creating invoices from picking, OpenERP is able to add and compute the shipping line.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/delivery.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/delivery.zip]

	trunk [http://www.openerp.com/download/modules/trunk/delivery.zip]









Dependencies



	sale

	purchase

	stock









Reports

None




Menus



	Stock Management/Configuration/Delivery

	Stock Management/Configuration/Delivery/Delivery Method

	Stock Management/Configuration/Delivery/Delivery Pricelist

	Stock Management/Outgoing Products/Packing to be invoiced

	Stock Management/Incoming Products/Generate Draft Invoices On Receptions









Views



	delivery.carrier.tree (tree)

	delivery.carrier.form (form)

	delivery.grid.tree (tree)

	delivery.grid.form (form)

	delivery.grid.line.form (form)

	delivery.grid.line.tree (tree)

	* INHERIT delivery.sale.order_withcarrier.form.view (form)

	* INHERIT delivery.stock.picking_withcarrier.out.form.view (form)

	* INHERIT stock.picking_withweight.in.form.view (form)

	* INHERIT stock.picking_withweight.internal.form.view (form)

	* INHERIT delivery.stock.picking_withcarrier.delivery.form.view (form)

	* INHERIT res.partner.carrier.property.form.inherit (form)









Objects


Object: Carrier and delivery grids (delivery.carrier)





	product_id:	Delivery Product, many2one, required









	price:	Price, float, readonly









	grids_id:	Delivery Grids, one2many









	active:	Active, boolean









	partner_id:	Carrier Partner, many2one, required









	name:	Carrier, char, required








Object: Delivery Grid (delivery.grid)





	name:	Grid Name, char, required









	sequence:	Sequence, integer, required









	state_ids:	States, many2many









	country_ids:	Countries, many2many









	carrier_id:	Carrier, many2one, required









	active:	Active, boolean









	zip_from:	Start Zip, char









	line_ids:	Grid Line, one2many









	zip_to:	To Zip, char








Object: Delivery line of grid (delivery.grid.line)





	list_price:	Sale Price, float, required









	name:	Name, char, required









	price_type:	Price Type, selection, required









	max_value:	Maximum Value, float, required









	standard_price:	Cost Price, float, required









	grid_id:	Grid, many2one, required









	variable_factor:

		Variable Factor, selection, required









	operator:	Operator, selection, required









	type:	Variable, selection, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Online Demo Setup Module (demo_setup)





	Module:	demo_setup


	Name:	Online Demo Setup Module


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	demo_setup


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Module to set the configuration of the online demo of Tiny ERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/demo_setup.zip]

	trunk [http://www.openerp.com/download/modules/trunk/demo_setup.zip]









Dependencies



	base









Reports

None




Menus



	Administration









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Discount on Marketing Campaigns (discount_campaign)





	Module:	discount_campaign


	Name:	Discount on Marketing Campaigns


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	discount_campaign


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Marketing management module








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/discount_campaign.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/discount_campaign.zip]

	trunk [http://www.openerp.com/download/modules/trunk/discount_campaign.zip]









Dependencies



	base

	sale









Reports

None




Menus



	Sales Management/Configuration/Discount Campaign









Views



	* INHERIT discountcampaign.sale.order.form.view (form)

	* INHERIT discount.campaign.partner.form.view (form)

	discount.campaign.form (form)

	discount.campaign.tree (tree)

	discount.campaign.line.form (form)

	discount.campaign.line.tree (tree)









Objects


Object: discount.campaign (discount.campaign)





	line_ids:	Discount Lines, one2many









	date_stop:	Stop Date, date, required









	date_start:	Start Date, date, required









	name:	Name, char









	state:	State, selection, readonly








Object: discount.campaign.line (discount.campaign.line)





	condition_sale:	Sale Condition, char









	name:	Name, char









	sequence:	Sequence, integer, required









	discount_id:	Discount Lines, many2one









	discount:	Discount, float









	condition_category_id:

		Category, many2one









	condition_quantity:

		Min. Quantity, float









	condition_product_id:

		Product, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Direct Marketing (dm)





	Module:	dm


	Name:	Direct Marketing


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Marketing Campaign Management Module

        This module allows to :

        * Commercial Offers :
            - Create  Multimedia Commercial Offers
            - View a graphical representation of the offer steps
            - Create offers from offer models and offer ideas

        * Marketing Campaign
            - Plan your Marketing Campaign and Commercial Propositions
            - Generate the Retro planning (automatically creates all the tasks necessary to launch your campaign)
            - Assign automatic prices to the items of your commercial propositions
            - Auto generate the purchase orders for all the items of the campaign
            - Manage Customers Fils, segments and segmentation criteria
            - Create campaigns from campaign models
            - Manage copywriters, brokers, dealers, addresses deduplicators and cleaners








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm.zip]
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	project_retro_planning
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	sale
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	Offer
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	PreOffer
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	Campaign
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Objects


Object: dm.media (dm.media)





	code:	Code, char, required









	name:	Name, char, required








Object: dm.trademark (dm.trademark)





	code:	Code, char, required









	media_id:	Media, many2one









	name:	Name, char, required









	header:	Header (.odt), binary









	signature:	Signature, binary









	logo:	Logo, binary









	partner_id:	Partner, many2one








Object: dm.offer.category (dm.offer.category)





	child_ids:	Childs Category, one2many









	parent_id:	Parent, many2one









	complete_name:	Category, char, readonly









	name:	Name, char, required








Object: dm.offer.production.cost (dm.offer.production.cost)





	name:	Name, char, required








Object: dm.offer (dm.offer)





	code:	Code, char, required









	purchase_note:	Purchase Notes, text









	production_category_ids:

		Production Categories, many2many









	last_modification_date:

		Last Modification Date, char, readonly









	keywords:	Keywords, text









	preoffer_type:	Type, selection









	offer_origin_id:

		Original Offer, many2one









	production_cost_id:

		Production Cost, many2one









	copywriter_id:	Copywriter, many2one









	forbidden_state_ids:

		Forbidden States, many2many









	category_ids:	Categories, many2many









	preoffer_original_id:

		Original Offer Idea, many2one









	state:	Status, selection, readonly









	version:	Version, float









	history_ids:	History, one2many, readonly









	type:	Type, selection









	lang_orig_id:	Original Language, many2one









	purchase_category_ids:

		Purchase Categories, many2many









	name:	Name, char, required









	recommended_trademark_id:

		Recommended Trademark, many2one









	child_ids:	Childs Category, one2many









	preoffer_offer_id:

		Offer, many2one









	translation_ids:

		Translations, one2many, readonly









	active:	Active, boolean









	order_date:	Order Date, date









	legal_state:	Legal State, selection









	quotation:	Quotation, char









	step_ids:	Offer Steps, one2many









	offer_responsible_id:

		Responsible, many2one









	notes:	General Notes, text









	fixed_date:	Fixed Date, date









	planned_delivery_date:

		Planned Delivery Date, date









	forbidden_country_ids:

		Forbidden Countries, many2many









	delivery_date:	Delivery Date, date








Object: dm.offer.translation (dm.offer.translation)





	date:	Date, date









	language_id:	Language, many2one









	offer_id:	Offer, many2one, required









	notes:	Notes, text









	translator_id:	Translator, many2one








Object: dm.offer.step.type (dm.offer.step.type)





	name:	Name, char, required









	code:	Code, char, required









	description:	Description, text









	flow_stop:	Flow Stop, boolean









	flow_start:	Flow Start, boolean








Object: dm.offer.step.action (dm.offer.step.action)





	sms_server:	SMS Server, many2one









	code:	Python Code, text






Python code to be executed






	media_id:	Media, many2one, required









	sequence:	Sequence, integer






Important when you deal with multiple actions, the execution order will be decided based on this, low number is higher priority.






	child_ids:	Other Actions, many2many









	trigger_name:	Trigger Name, selection






Select the Signal name that is to be used as the trigger.






	record_id:	Create Id, many2one






Provide the field name where the record id is stored after the create operations. If it is empty, you can not track the new record.






	write_id:	Write Id, char






Provide the field name that the record id refers to for the write operation. If it is empty it will refer to the active id of the object.






	srcmodel_id:	Model, many2one






Object in which you want to create / write the object. If it is empty then refer to the Object field.






	message:	Message, text






Specify the message. You can use the fields from the object. e.g. `Dear [[ object.partner_id.name ]]`






	dm_action:	Action, boolean









	email_server:	Email Server, many2one









	model_id:	Object, many2one, required






Select the object on which the action will work (read, write, create).






	subject:	Subject, char






Specify the subject. You can use fields from the object, e.g. `Hello [[ object.partner_id.name ]]`






	loop_action:	Loop Action, many2one






Select the action that will be executed. Loop action will not be available inside loop.






	fields_lines:	Field Mappings., one2many









	trigger_obj_id:	Trigger On, many2one






Select the object from the model on which the workflow will executed.






	name:	Action Name, char, required






Easy to Refer action by name e.g. One Sales Order -> Many Invoices






	mobile:	Mobile No, char






Provides fields that be used to fetch the mobile number, e.g. you select the invoice, then `object.invoice_address_id.mobile` is the field which gives the correct mobile number






	expression:	Loop Expression, char






Enter the field/expression that will return the list. E.g. select the sale order in Object, and you can have loop on the sales order line. Expression = `object.order_line`.






	server_action_id:

		Server Action, many2one









	sms:	SMS, char









	wkf_model_id:	Workflow On, many2one






Workflow to be executed on this model.






	state:	Action Type, selection, required






Type of the Action that is to be executed






	condition:	Condition, char, required






Condition that is to be tested before action is executed, e.g. object.list_price > object.cost_price






	usage:	Action Usage, char









	type:	Action Type, char, required









	email:	Email Address, char






Provides the fields that will be used to fetch the email address, e.g. when you select the invoice, then `object.invoice_address_id.email` is the field which gives the correct address






	action_id:	Client Action, many2one






Select the Action Window, Report, Wizard to be executed.





Object: dm.offer.step (dm.offer.step)





	incoming_transition_ids:

		Incoming Transition, one2many, readonly









	manufacturing_constraint_ids:

		Mailing Manufacturing Products, many2many









	purchase_note:	Purchase Notes, text









	seq:	Step Type Sequence, integer









	type_id:	Type, many2one, required









	flow_start:	Flow Start, boolean









	code:	Code, char, required









	item_ids:	Items, many2many









	origin_id:	Origin, many2one









	parent_id:	Parent, many2one









	state:	Status, selection, readonly









	outgoing_transition_ids:

		Outgoing Transition, one2many









	desc:	Description, text









	trademark_note:	Trademark Notes, text









	action_id:	Action, many2one, required









	document_ids:	DTP Documents, one2many









	media_id:	Media, many2one, required









	offer_id:	Offer, many2one, required









	production_note:

		Production Notes, text









	doc_number:	Number of documents of the mailing, integer









	split_mode:	Split mode, selection









	mailing_at_dates:

		Mailing at dates, boolean









	legal_state:	Legal State, char









	quotation:	Quotation, char









	dtp_category_ids:

		DTP Categories, many2many









	name:	Name, char, required









	floating_date:	Floating date, boolean









	notes:	Notes, text









	trademark_category_ids:

		Trademark Categories, many2many









	dtp_note:	DTP Notes, text









	interactive:	Interactive, boolean









	planning_note:	Planning Notes, text








Object: dm.offer.step.transition.trigger (dm.offer.step.transition.trigger)





	in_act_cond:	Action Condition, text, required









	code:	Code, char, required









	name:	Trigger Name, char, required









	gen_next_wi:	Auto Generate Next Workitems, boolean








Object: dm.offer.step.transition (dm.offer.step.transition)





	delay:	Offer Delay, integer, required









	delay_type:	Delay type, selection, required









	step_to_id:	To Offer Step, many2one, required









	condition_id:	Trigger Condition, many2one, required









	step_from_id:	From Offer Step, many2one, required








Object: dm.overlay.payment_rule (dm.overlay.payment_rule)





	account_id:	Account, many2one









	move:	Move, selection









	country_id:	Country, many2one









	journal_id:	Journal, many2one









	currency_id:	Currency, many2one









	country_default:

		Default for Country, boolean








Object: dm.campaign.group (dm.campaign.group)





	code:	Code, char, readonly









	name:	Campaign group name, char, required









	campaign_ids:	Campaigns, one2many, readonly









	quantity_wanted_total:

		Total Wanted Quantity, char, readonly









	quantity_usable_total:

		Total Usable Quantity, char, readonly









	project_id:	Project, many2one, readonly









	purchase_line_ids:

		Purchase Lines, one2many









	quantity_delivered_total:

		Total Delivered Quantity, char, readonly








Object: dm.campaign.type (dm.campaign.type)





	code:	Code, char, required









	name:	Description, char, required









	description:	Description, text








Object: dm.overlay (dm.overlay)





	trademark_id:	Trademark, many2one, required









	dealer_id:	Dealer, many2one, required









	country_ids:	Country, many2many, required









	code:	Code, char, readonly









	payment_method_rule_ids:

		Payment Method Rules, many2many









	bank_account_id:

		Account, many2one








Object: dm.campaign (dm.campaign)





	code:	Account Code, char









	cleaner_id:	Cleaner, many2one






The cleaner is a partner responsible for removing bad addresses from the customers list






	contact_id:	Contact, many2one









	address_ids:	Partners Contacts, many2many









	crossovered_budget_line:

		Budget Lines, one2many









	quantity_usable_total:

		Total Usable Quantity, char, readonly









	proposition_ids:

		Proposition, one2many









	last_worked_date:

		Date of Last Cost/Work, date, readonly






Date of the latest work done on this account.






	dealer_id:	Dealer, many2one






The dealer is the partner the campaign is planned for






	manufacturing_cost_ids:

		Manufacturing Costs, one2many









	company_id:	Company, many2one, required









	parent_id:	Parent Analytic Account, many2one









	pricelist_id:	Sale Pricelist, many2one









	project_id:	Project, many2one, readonly






Generating the Retro Planning will create and assign the different tasks used to plan and manage the campaign






	ca_to_invoice:	Uninvoiced Amount, float, readonly






If invoice from analytic account, the remaining amount you can invoice to the customer based on the total costs.






	cust_file_task_ids:

		Customer Files tasks, one2many









	payment_method_ids:

		Payment Methods, many2many









	child_ids:	Child Accounts, one2many









	quantity_wanted_total:

		Total Wanted Quantity, char, readonly









	user_ids:	User, many2many, readonly









	campaign_group_id:

		Campaign group, many2one









	item_task_ids:	Items Procurement tasks, one2many









	theorical_margin:

		Theorical Margin, float, readonly






Computed using the formula: Theorial Revenue - Total Costs






	dtp_task_ids:	DTP tasks, one2many









	name:	Account Name, char, required









	notes:	Notes, text









	translation_state:

		Translation Status, selection, readonly









	quantity_planned_total:

		Total planned Quantity, char, readonly









	remaining_hours:

		Remaining Hours, float, readonly






Computed using the formula: Maximum Quantity - Hours Tot.






	last_worked_invoiced_date:

		Date of Last Invoiced Cost, date, readonly






If invoice from the costs, this is the date of the latest work or cost that have been invoiced.






	manufacturing_product_id:

		Manufacturing Product, many2one









	customer_file_state:

		Customers Files Status, selection, readonly









	last_invoice_date:

		Last Invoice Date, date, readonly






Date of the last invoice created for this analytic account.






	dtp_purchase_line_ids:

		DTP Purchase Lines, one2many









	package_ok:	Used in Package, boolean









	partner_id:	Associated Partner, many2one









	analytic_account_id:

		Analytic Account, many2one









	revenue_per_hour:

		Revenue per Hours (real), float, readonly






Computed using the formula: Invoiced Amount / Hours Tot.






	total_cost:	Total Costs, float, readonly






Total of costs for this account. It includes real costs (from invoices) and indirect costs, like time spent on timesheets.






	country_id:	Country, many2one, required






The language and currency will be automatically assigned if they are defined for the country






	state:	State, selection, required









	debit:	Debit, float, readonly









	amount_invoiced:

		Invoiced Amount, float, readonly






Total invoiced






	planning_state:	Planning Status, selection, readonly









	user_product_ids:

		Users/Products Rel., one2many









	manufacturing_responsible_id:

		Responsible, many2one









	overlay_id:	Overlay, many2one









	active:	Active, boolean









	mail_service_ids:

		Mailing Service, one2many









	real_margin_rate:

		Real Margin Rate (%), float, readonly






Computes using the formula: (Real Margin / Total Costs) * 100.






	credit:	Credit, float, readonly









	month_ids:	Month, many2many, readonly









	line_ids:	Analytic Entries, one2many









	items_state:	Items Status, selection, readonly









	trademark_id:	Trademark, many2one









	amount_max:	Max. Invoice Price, float









	dtp_state:	DTP Status, selection, readonly









	user_id:	Account Manager, many2one









	dtp_responsible_id:

		Responsible, many2one









	manufacturing_purchase_line_ids:

		Manufacturing Purchase Lines, one2many









	type:	Account Type, selection









	offer_id:	Offer, many2one, required






Choose the commercial offer to use with this campaign, only offers in ready to plan or open state can be assigned






	ca_invoiced:	Invoiced Amount, float, readonly






Total customer invoiced amount for this account.






	campaign_type_id:

		Type, many2one









	hours_quantity:	Hours Tot, float, readonly






Number of hours you spent on the analytic account (from timesheet). It computes on all journal of type ‘general’.






	manufacturing_state:

		Manufacturing Status, selection, readonly









	ca_theorical:	Theorical Revenue, float, readonly






Based on the costs you had on the project, what would the revenue have been if all these costs were invoiced at the normal sale price given by the pricelist.






	currency_id:	Currency, many2one









	dtp_making_time:

		Making Time, float, readonly









	to_invoice:	Reinvoice Costs, many2one






Check this field if you plan to automatically generate invoices based on the costs in this analytic account: timesheets, expenses, ...You can configure an automatic invoice rate on analytic accounts.






	balance:	Balance, float, readonly









	quantity_delivered_total:

		Total Delivered Quantity, char, readonly









	item_responsible_id:

		Responsible, many2one









	quantity_max:	Maximum Quantity, float









	deduplicator_id:

		Deduplicator, many2one






The deduplicator is a partner responsible for removing identical addresses from the customers list






	company_currency_id:

		Currency, many2one, readonly









	hours_qtt_non_invoiced:

		Uninvoiced Hours, float, readonly






Number of hours (from journal of type ‘general’) that can be invoiced if you invoice based on analytic account.






	files_responsible_id:

		Responsible, many2one









	date_start:	Date Start, date









	forwarding_charge:

		Forwarding Charge, float









	lang_id:	Language, many2one









	complete_name:	Full Account Name, char, readonly









	real_margin:	Real Margin, float, readonly






Computed using the formula: Invoiced Amount - Total Costs.






	hours_qtt_invoiced:

		Invoiced Hours, float, readonly






Number of hours that can be invoiced plus those that already have been invoiced.






	router_id:	Router, many2one






The router is the partner who will send the mailing to the final customer






	description:	Description, text









	manufacturing_task_ids:

		Manufacturing tasks, one2many









	remaining_ca:	Remaining Revenue, float, readonly






Computed using the formula: Max Invoice Price - Invoiced Amount.






	responsible_id:	Responsible, many2one









	date:	Date End, date









	item_purchase_line_ids:

		Items Purchase Lines, one2many









	code1:	Code, char, readonly









	cust_file_purchase_line_ids:

		Customer Files Purchase Lines, one2many









	journal_rate_ids:

		Invoicing Rate per Journal, one2many









	quantity:	Quantity, float, readonly








Object: dm.campaign.proposition (dm.campaign.proposition)





	initial_proposition_id:

		Initial proposition, many2one









	code:	Account Code, char









	last_worked_invoiced_date:

		Date of Last Invoiced Cost, date, readonly






If invoice from the costs, this is the date of the latest work or cost that have been invoiced.






	ca_to_invoice:	Uninvoiced Amount, float, readonly






If invoice from analytic account, the remaining amount you can invoice to the customer based on the total costs.






	quantity_max:	Maximum Quantity, float









	quantity_wanted:

		Wanted Quantity, char, readonly






The wanted quantity is the number of addresses you wish to get for that segment.
This is usually the quantity used to order Customers Lists
The wanted quantity could be AAA for All Addresses Available






	contact_id:	Contact, many2one









	company_currency_id:

		Currency, many2one, readonly









	date:	Date End, date









	last_invoice_date:

		Last Invoice Date, date, readonly






Date of the last invoice created for this analytic account.






	crossovered_budget_line:

		Budget Lines, one2many









	amount_max:	Max. Invoice Price, float









	package_ok:	Used in Package, boolean









	hours_qtt_non_invoiced:

		Uninvoiced Hours, float, readonly






Number of hours (from journal of type ‘general’) that can be invoiced if you invoice based on analytic account.






	keep_prices:	Keep Prices At Duplication, boolean









	partner_id:	Associated Partner, many2one









	proposition_type:

		Type, selection









	analytic_account_id:

		Analytic Account, many2one









	last_worked_date:

		Date of Last Cost/Work, date, readonly






Date of the latest work done on this account.






	starting_mail_price:

		Starting Mail Price, float









	user_id:	Account Manager, many2one









	item_ids:	Catalogue, one2many









	to_invoice:	Reinvoice Costs, many2one






Check this field if you plan to automatically generate invoices based on the costs in this analytic account: timesheets, expenses, ...You can configure an automatic invoice rate on analytic accounts.






	total_cost:	Total Costs, float, readonly






Total of costs for this account. It includes real costs (from invoices) and indirect costs, like time spent on timesheets.






	date_start:	Date Start, date









	company_id:	Company, many2one, required









	segment_ids:	Segment, one2many









	parent_id:	Parent Analytic Account, many2one









	state:	State, selection, required









	quantity_planned:

		Planned Quantity, integer






The planned quantity is an estimation of the usable quantity of addresses you  will get after delivery, deduplication and cleaning
This is usually the quantity used to order the manufacturing of the mailings






	complete_name:	Full Account Name, char, readonly









	real_margin:	Real Margin, float, readonly






Computed using the formula: Invoiced Amount - Total Costs.






	debit:	Debit, float, readonly









	forwarding_charge:

		Forwarding Charge, float









	pricelist_id:	Sale Pricelist, many2one









	type:	Account Type, selection









	quantity:	Quantity, float, readonly









	manufacturing_costs:

		Manufacturing Costs, float









	journal_rate_ids:

		Invoicing Rate per Journal, one2many









	payment_method_ids:

		Payment Methods, many2many









	description:	Description, text









	amount_invoiced:

		Invoiced Amount, float, readonly






Total invoiced






	forwarding_charges:

		Forwarding Charges, float









	credit:	Credit, float, readonly









	child_ids:	Child Accounts, one2many









	user_product_ids:

		Users/Products Rel., one2many









	ca_invoiced:	Invoiced Amount, float, readonly






Total customer invoiced amount for this account.






	sale_rate:	Sale Rate (%), float






This is the planned sale rate (in percent) for this commercial proposition






	user_ids:	User, many2many, readonly









	remaining_ca:	Remaining Revenue, float, readonly






Computed using the formula: Max Invoice Price - Invoiced Amount.






	quantity_delivered:

		Delivered Quantity, char, readonly






The delivered quantity is the number of addresses you receive from the broker.






	code1:	Code, char, readonly









	hours_qtt_invoiced:

		Invoiced Hours, float, readonly






Number of hours that can be invoiced plus those that already have been invoiced.






	active:	Active, boolean









	hours_quantity:	Hours Tot, float, readonly






Number of hours you spent on the analytic account (from timesheet). It computes on all journal of type ‘general’.






	theorical_margin:

		Theorical Margin, float, readonly






Computed using the formula: Theorial Revenue - Total Costs






	quantity_usable:

		Usable Quantity, char, readonly






The usable quantity is the number of addresses you have after delivery, deduplication and cleaning.






	ca_theorical:	Theorical Revenue, float, readonly






Based on the costs you had on the project, what would the revenue have been if all these costs were invoiced at the normal sale price given by the pricelist.






	force_sm_price:	Force Starting Mail Price, boolean









	sm_price:	Starting Mail Price, float









	keep_segments:	Keep Segments, boolean









	name:	Account Name, char, required









	customer_pricelist_id:

		Product Pricelist, many2one









	notes:	Notes, text









	address_ids:	Partners Contacts, many2many









	real_margin_rate:

		Real Margin Rate (%), float, readonly






Computes using the formula: (Real Margin / Total Costs) * 100.






	revenue_per_hour:

		Revenue per Hours (real), float, readonly






Computed using the formula: Invoiced Amount / Hours Tot.






	month_ids:	Month, many2many, readonly









	quantity_real:	Real Quantity, char, readonly






The real quantity is the actual number of addresses you get in the file.






	price_prog_use:	Price Progression, boolean









	line_ids:	Analytic Entries, one2many









	balance:	Balance, float, readonly









	camp_id:	Campaign, many2one, required









	remaining_hours:

		Remaining Hours, float, readonly






Computed using the formula: Maximum Quantity - Hours Tot.





Object: The origin of the addresses of a list (dm.customers_list.recruit_origin)





	code:	Code, char, required









	name:	Name, char, required








Object: Type of the adress list (dm.customers_list.type)





	code:	Code, char, required









	name:	Name, char, required








Object: A list of addresses proposed by an addresses broker (dm.customers_list)





	other_cost:	Other Cost, float









	selection_cost:	Selection Cost Per Thousand, float









	broker_cost:	Broker Cost, float






The amount given to the broker for the list renting






	code:	Code, char, required









	list_type_id:	Type, many2one









	per_thousand_price:

		Price per Thousand, float









	update_frq:	Update Frequency, integer









	currency_id:	Currency, many2one









	country_id:	Country, many2one









	name:	Name, char, required









	broker_discount:

		Broker Discount (%), float









	recruiting_origin_id:

		Recruiting Origin, many2one






Origin of the recruiting of the addresses






	broker_id:	Broker, many2one









	delivery_cost:	Delivery Cost, float









	invoice_base:	Invoicing based on, selection






Net or raw quantity on which the final invoice is based depending on the term negotiated with the broker.
Net : Usable quantity after deduplication
Raw : Delivered quantity
Real : Realy used quantity






	owner_id:	Owner, many2one









	notes:	Description, text









	product_id:	Product, many2one, required








Object: A File of addresses (dm.customers_file)





	address_ids:	Customers File Addresses, many2many









	code:	Code, char, required









	name:	Name, char, required









	case_ids:	CRM Cases, many2many









	note:	Notes, text









	source:	Source, selection, required









	customers_list_id:

		Customers List, many2one









	delivery_date:	Delivery Date, date









	segment_ids:	Segments, one2many, readonly








Object: A subset of addresses coming from a customers file (dm.campaign.proposition.segment)





	code:	Account Code, char









	last_worked_invoiced_date:

		Date of Last Invoiced Cost, date, readonly






If invoice from the costs, this is the date of the latest work or cost that have been invoiced.






	ca_to_invoice:	Uninvoiced Amount, float, readonly






If invoice from analytic account, the remaining amount you can invoice to the customer based on the total costs.






	analytic_account_id:

		Analytic Account, many2one









	quantity_cleaned_cleaner:

		Cleaned Quantity, integer






The quantity of wrong addresses removed by the cleaner.






	segmentation_criteria:

		Segmentation Criteria, text









	quantity_dedup_cleaner:

		Deduplication Quantity, integer






The quantity of duplicated addresses removed by the cleaner.






	quantity_max:	Maximum Quantity, float









	quantity_usable:

		Usable Quantity, integer, readonly






The usable quantity is the number of addresses you have after delivery, deduplication and cleaning.






	contact_id:	Contact, many2one









	company_currency_id:

		Currency, many2one, readonly









	date:	Date End, date









	last_invoice_date:

		Last Invoice Date, date, readonly






Date of the last invoice created for this analytic account.






	crossovered_budget_line:

		Budget Lines, one2many









	amount_max:	Max. Invoice Price, float









	package_ok:	Used in Package, boolean









	hours_qtt_non_invoiced:

		Uninvoiced Hours, float, readonly






Number of hours (from journal of type ‘general’) that can be invoiced if you invoice based on analytic account.






	partner_id:	Associated Partner, many2one









	all_add_avail:	All Addresses Available, boolean






Used to order all addresses available in the customers list based on the segmentation criteria






	split_id:	Split, many2one









	note:	Notes, text









	last_worked_date:

		Date of Last Cost/Work, date, readonly






Date of the latest work done on this account.






	start_census:	Start Census, integer






The recency is the time since the last purchase.
For example : A 0-30 recency means all the customers that have purchased in the last 30 days






	user_id:	Account Manager, many2one









	to_invoice:	Reinvoice Costs, many2one






Check this field if you plan to automatically generate invoices based on the costs in this analytic account: timesheets, expenses, ...You can configure an automatic invoice rate on analytic accounts.






	total_cost:	Total Costs, float, readonly






Total of costs for this account. It includes real costs (from invoices) and indirect costs, like time spent on timesheets.






	quantity_purged:

		Purged Quantity, integer, readonly






The purged quantity is the number of addresses removed from deduplication and cleaning.






	date_start:	Date Start, date









	customers_file_id:

		Customers File, many2one









	company_id:	Company, many2one, required









	proposition_id:	Proposition, many2one









	reuse_id:	Reuse, many2one









	parent_id:	Parent Analytic Account, many2one









	state:	State, selection, required









	customers_list_id:

		Customers List, many2one









	complete_name:	Full Account Name, char, readonly









	real_margin:	Real Margin, float, readonly






Computed using the formula: Invoiced Amount - Total Costs.






	debit:	Debit, float, readonly









	pricelist_id:	Sale Pricelist, many2one









	type_src:	Type, selection









	type:	Account Type, selection









	quantity:	Quantity, float, readonly









	quantity_cleaned_dedup:

		Cleaned Quantity, integer






The quantity of wrong addresses removed by the deduplicator.






	journal_rate_ids:

		Invoicing Rate per Journal, one2many









	description:	Description, text









	amount_invoiced:

		Invoiced Amount, float, readonly






Total invoiced






	quantity_planned:

		planned Quantity, integer






The planned quantity is an estimation of the usable quantity of addresses you  will get after delivery, deduplication and cleaning
This is usually the quantity used to order the manufacturing of the mailings






	credit:	Credit, float, readonly









	child_ids:	Child Accounts, one2many









	user_product_ids:

		Users/Products Rel., one2many









	ca_invoiced:	Invoiced Amount, float, readonly






Total customer invoiced amount for this account.






	user_ids:	User, many2many, readonly









	remaining_ca:	Remaining Revenue, float, readonly






Computed using the formula: Max Invoice Price - Invoiced Amount.






	quantity_delivered:

		Delivered Quantity, integer






The delivered quantity is the number of addresses you receive from the broker.






	code1:	Code, char, readonly









	hours_qtt_invoiced:

		Invoiced Hours, float, readonly






Number of hours that can be invoiced plus those that already have been invoiced.






	active:	Active, boolean









	hours_quantity:	Hours Tot, float, readonly






Number of hours you spent on the analytic account (from timesheet). It computes on all journal of type ‘general’.






	deduplication_level:

		Deduplication Level, integer






The deduplication level defines the order in which the deduplication takes place.






	theorical_margin:

		Theorical Margin, float, readonly






Computed using the formula: Theorial Revenue - Total Costs






	ca_theorical:	Theorical Revenue, float, readonly






Based on the costs you had on the project, what would the revenue have been if all these costs were invoiced at the normal sale price given by the pricelist.






	quantity_wanted:

		Wanted Quantity, integer






The wanted quantity is the number of addresses you wish to get for that segment.
This is usually the quantity used to order Customers Lists
The wanted quantity could be AAA for All Addresses Available






	type_census:	Census Type, selection









	name:	Account Name, char, required









	end_census:	End Census, integer









	address_ids:	Partners Contacts, many2many









	real_margin_rate:

		Real Margin Rate (%), float, readonly






Computes using the formula: (Real Margin / Total Costs) * 100.






	revenue_per_hour:

		Revenue per Hours (real), float, readonly






Computed using the formula: Invoiced Amount / Hours Tot.






	quantity_dedup_dedup:

		Deduplication Quantity, integer






The quantity of duplicated addresses removed by the deduplicator.






	month_ids:	Month, many2many, readonly









	quantity_real:	Real Quantity, integer






The real quantity is the actual number of addresses in the customers file (by counting).






	line_ids:	Analytic Entries, one2many









	balance:	Balance, float, readonly









	remaining_hours:

		Remaining Hours, float, readonly






Computed using the formula: Maximum Quantity - Hours Tot.





Object: dm.campaign.proposition.item (dm.campaign.proposition.item)





	product_id:	Product, many2one, required









	price:	Sale Price, float









	qty_real:	Real Quantity, integer









	proposition_id:	Commercial Proposition, many2one









	qty_planned:	Planned Quantity, integer









	item_type:	Product Type, selection









	offer_step_type_id:

		Offer Step Type, many2one









	notes:	Notes, text








Object: dm.campaign.purchase_line (dm.campaign.purchase_line)





	type_document:	Document Type, selection









	campaign_group_id:

		Campaign Group, many2one









	product_id:	Product, many2one, required









	togroup:	Apply to Campaign Group, boolean









	product_category:

		Product Category, selection









	trigger:	Trigger, selection









	notes:	Notes, text









	date_planned:	Scheduled date, datetime, required









	campaign_id:	Campaign, many2one









	date_delivery:	Delivery Date, datetime, readonly









	uom_id:	UOM, many2one, required









	desc_from_offer:

		Insert Description from Offer, boolean









	state:	State, selection, readonly









	type_quantity:	Quantity Type, selection









	quantity_warning:

		Warning, char, readonly









	purchase_order_ids:

		Campaign Purchase Line, one2many









	date_order:	Order date, datetime, readonly









	type:	Type, selection









	quantity:	Total Quantity, integer, required








Object: dm.campaign.manufacturing_cost (dm.campaign.manufacturing_cost)





	amount:	Amount, float









	name:	Description, char, required









	campaign_id:	Campaign, many2one








Object: dm.campaign.proposition.prices_progression (dm.campaign.proposition.prices_progression)





	percent_prog:	Percentage Prices Progression, float









	fixed_prog:	Fixed Prices Progression, float









	name:	Name, char, required








Object: dm.campaign.document.type (dm.campaign.document.type)





	code:	Code, char, required









	name:	Name, char, required








Object: dm.campaign.document (dm.campaign.document)





	segment_id:	Segment, many2one, required









	name:	Name, char, required









	type_id:	Format, many2one, required








Object: dm.order (dm.order)





	customer_code:	Customer Code, char









	zip:	Zip Code, char









	segment_code:	Segment Code, char









	country:	Country, char









	offer_step_code:

		Offer Step Code, char









	title:	Title, char









	customer_firstname:

		First Name, char









	customer_add4:	Address4, char









	state:	Status, selection, readonly









	zip_summary:	Zip Summary, char









	customer_lastname:

		Last Name, char









	customer_add1:	Address1, char









	raw_datas:	Raw Data, char









	distribution_office:

		Distribution Office, char









	customer_add2:	Address2, char









	customer_add3:	Address3, char








Object: Sale Order (dm.customer.order)





	origin:	Origin, char









	order_line:	Order Lines, one2many, readonly









	picking_policy:	Packing Policy, selection, required






If you don’t have enough stock available to deliver all at once, do you accept partial shipments or not?






	order_policy:	Shipping Policy, selection, required, readonly






The Shipping Policy is used to synchronise invoice and delivery operations.
- The ‘Pay before delivery’ choice will first generate the invoice and then generate the packing order after the payment of this invoice.
- The ‘Shipping & Manual Invoice’ will create the packing order directly and wait for the user to manually click on the ‘Invoice’ button to generate the draft invoice.
- The ‘Invoice on Order After Delivery’ choice will generate the draft invoice based on sale order after all packing lists have been finished.
- The ‘Invoice from the packing’ choice is used to create an invoice during the packing process.






	invoice_ids:	Invoice, many2many






This is the list of invoices that have been generated for this sale order. The same sale order may have been invoiced in several times (by line for example).






	shop_id:	Shop, many2one, required, readonly









	client_order_ref:

		Customer Ref, char









	date_order:	Date Ordered, date, required, readonly









	partner_id:	Customer, many2one, readonly









	invoiced:	Paid, boolean, readonly









	note:	Notes, text









	fiscal_position:

		Fiscal Position, many2one









	user_id:	Salesman, many2one









	payment_term:	Payment Term, many2one









	amount_tax:	Taxes, float, readonly









	offer_step_id:	Offer Step, many2one









	state:	Status, selection, readonly









	abstract_line_ids:

		Order Lines, one2many, readonly









	invoiced_rate:	Invoiced, float, readonly









	pricelist_id:	Pricelist, many2one, required, readonly









	advertising_agency:

		Advertising Agency, many2one









	project_id:	Analytic Account, many2one, readonly









	incoterm:	Incoterm, selection









	published_customer:

		Published Customer, many2one









	partner_order_id:

		Ordering Contact, many2one, required, readonly






The name and address of the contact that requested the order or quotation.






	picked_rate:	Picked, float, readonly









	partner_invoice_id:

		Invoice Address, many2one, required, readonly









	amount_untaxed:	Untaxed Amount, float, readonly









	picking_ids:	Related Packing, one2many, readonly






This is the list of picking list that have been generated for this invoice






	amount_total:	Total, float, readonly









	customer_id:	Customer, many2one









	name:	Order Description, char, required









	partner_shipping_id:

		Shipping Address, many2one, required, readonly









	segment_id:	Segment, many2one









	price_type:	Price method, selection, required









	shipped:	Picked, boolean, readonly









	invoice_quantity:

		Invoice on, selection, required






The sale order will automatically create the invoice proposition (draft invoice). Ordered and delivered quantities may not be the same. You have to choose if you invoice based on ordered or shipped quantities. If the product is a service, shipped quantities means hours spent on the associated tasks.






	discount_campaign:

		Discount Campaign, many2one









	margin:	Margin, float, readonly








Object: dm.customer.gender (dm.customer.gender)





	code:	Code, char, readonly









	name:	Name, char









	to_gender_id:	To Gender, many2one, required









	lang_id:	Language, many2one









	from_gender_id:	From Gender, many2one









	description:	Description, text








Object: workitem (dm.workitem)





	action_time:	Action Time, datetime









	address_id:	Customer Address, many2one









	segment_id:	Segments, many2one









	source:	Source, selection, required









	state:	Status, selection









	case_id:	CRM Case, many2one









	tr_from_id:	Source Transition, many2one









	step_id:	Offer Step, many2one









	error_msg:	System Message, text








Object: Segmentation (dm.customer.segmentation)





	customer_date_criteria_ids:

		Customers Date Criteria, one2many









	order_text_criteria_ids:

		Customers Order Textual Criteria, one2many









	code:	Code, char, required









	name:	Name, char, required









	notes:	Description, text









	order_boolean_criteria_ids:

		Customers Order Boolean Criteria, one2many









	order_numeric_criteria_ids:

		Customers Order Numeric Criteria, one2many









	customer_numeric_criteria_ids:

		Customers Numeric Criteria, one2many









	customer_boolean_criteria_ids:

		Customers Boolean Criteria, one2many









	sql_query:	SQL Query, text









	order_date_criteria_ids:

		Customers Order Date Criteria, one2many









	customer_text_criteria_ids:

		Customers Textual Criteria, one2many








Object: Customer Segmentation Textual Criteria (dm.customer.text_criteria)





	operator:	Operator, selection









	segmentation_id:

		Segmentation, many2one









	field_id:	Customers Field, many2one









	value:	Value, char








Object: Customer Segmentation Numeric Criteria (dm.customer.numeric_criteria)





	operator:	Operator, selection









	segmentation_id:

		Segmentation, many2one









	field_id:	Customers Field, many2one









	value:	Value, float








Object: Customer Segmentation Boolean Criteria (dm.customer.boolean_criteria)





	operator:	Operator, selection









	segmentation_id:

		Segmentation, many2one









	field_id:	Customers Field, many2one









	value:	Value, selection








Object: Customer Segmentation Date Criteria (dm.customer.date_criteria)





	operator:	Operator, selection









	segmentation_id:

		Segmentation, many2one









	field_id:	Customers Field, many2one









	value:	Date, date








Object: Customer Order Segmentation Textual Criteria (dm.customer.order.text_criteria)





	operator:	Operator, selection









	segmentation_id:

		Segmentation, many2one









	field_id:	Customers Field, many2one









	value:	Value, char








Object: Customer Order Segmentation Numeric Criteria (dm.customer.order.numeric_criteria)





	operator:	Operator, selection









	segmentation_id:

		Segmentation, many2one









	field_id:	Customers Field, many2one









	value:	Value, float








Object: Customer Order Segmentation Boolean Criteria (dm.customer.order.boolean_criteria)





	operator:	Operator, selection









	segmentation_id:

		Segmentation, many2one









	field_id:	Customers Field, many2one









	value:	Value, selection








Object: Customer Order Segmentation Date Criteria (dm.customer.order.date_criteria)





	operator:	Operator, selection









	segmentation_id:

		Segmentation, many2one









	field_id:	Customers Field, many2one









	value:	Date, date








Object: dm.offer.history (dm.offer.history)





	date:	Drop Date, date









	offer_id:	Offer, many2one, required









	code:	Code, char









	campaign_id:	Name, many2one









	responsible_id:	Responsible, many2one








Object: dm.event (dm.event)





	address_id:	Address, many2one









	segment_id:	Segment, many2one, required









	campaign_id:	Campaign, many2one









	source:	Source, selection, required









	trigger_type_id:

		Trigger Condition, many2one, required









	step_id:	Offer Step, many2one, required








Object: dm.ddf.plugin (dm.ddf.plugin)





	model_id:	Object, many2one









	code:	Code, char, required









	name:	DDF Plugin Name, char









	store_value:	Store Value, boolean









	field_id:	Customers Field, many2one









	note:	Description, text









	argument_ids:	Argument List, one2many









	file_id:	File Content, binary









	file_fname:	Filename, char









	type:	Type, selection, required








Object: Argument List (dm.plugin.argument)





	name:	Argument Name, char, required









	stored_plugin:	Value from plugin, boolean









	value:	Argument Value, text









	note:	Description, text, readonly









	plugin_id:	Plugin, many2one









	custome_plugin_id:

		Plugin For Value, many2one








Object: dm.document.template (dm.document.template)





	plugin_ids:	Plugin, many2many









	note:	Description, text









	name:	Template Name, char








Object: dm.plugins.value (dm.plugins.value)





	date:	Date, date









	plugin_id:	Plugin, many2one









	customer_id:	Customer Name, many2one









	value:	Value, char








Object: dm.offer.document.category (dm.offer.document.category)





	parent_id:	Parent, many2one









	complete_name:	Category, char, readonly









	name:	Name, char, required








Object: dm.offer.document (dm.offer.document)





	gender_id:	Gender, many2one









	code:	Code, char, required









	media_id:	Media, char









	name:	Name, char, required









	document_template_plugin_ids:

		Dynamic Plugins, many2many









	lang_id:	Language, many2one









	content:	Content, text









	state:	Status, selection, readonly









	copywriter_id:	Copywriter, many2one









	editor:	Editor, selection









	has_attachment:	Has Attachment, char, readonly









	document_template_id:

		Document Template, many2one









	step_id:	Offer Step, many2one









	category_id:	Category, many2one









	note:	Description, text









	subject:	Subject, char








Object: dm.mail_service (dm.mail_service)





	unit_interval:	Interval Unit, selection









	media_id:	Media, many2one









	action_interval:

		Interval, integer









	default_for_media:

		Default Mail Service for Media, boolean









	action_id:	Server Action, many2one









	partner_id:	Partner, many2one









	name:	Name, char, readonly








Object: dm.campaign.mail_service (dm.campaign.mail_service)





	offer_step_id:	Offer Step, many2one









	mail_service_id:

		Mail Service, many2one









	campaign_id:	Campaign, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







After-Sale Service wizards for DM (dm_after_sale)





	Module:	dm_after_sale


	Name:	After-Sale Service wizards for DM


	Version:	1.0


	Author:	Tiny


	Directory:	dm_after_sale


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


This module manages after-sale wizard.





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/dm_after_sale.zip]









Dependencies



	dm_sale









Reports

None




Menus

None




Views



	dm.after.sale.action.form1 (form)

	dm.after.sale.action.form2 (form)









Objects

None
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enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







DM Reject Payment Method (dm_as_reject_paymethod)





	Module:	dm_as_reject_paymethod


	Name:	DM Reject Payment Method


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_as_reject_paymethod


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module manages payments of Rejects.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_as_reject_paymethod.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_as_reject_paymethod.zip]









Dependencies



	dm_as_reject









Reports

None




Menus

None




Views



	* INHERIT dm.as.reject.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







DM Reject Trademark (dm_as_reject_trademark)





	Module:	dm_as_reject_trademark


	Name:	DM Reject Trademark


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_as_reject_trademark


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module manages rejects of trademark after sale.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_as_reject_trademark.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_as_reject_trademark.zip]









Dependencies



	dm_as_reject









Reports

None




Menus

None




Views



	* INHERIT dm.as.reject.inherit (form)

	* INHERIT dm.address.segmentation.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Base Contact extension For DM (dm_base_contact)





	Module:	dm_base_contact


	Name:	Base Contact extension For DM


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_base_contact


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows the use of the base_contact module with dm.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_base_contact.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_base_contact.zip]









Dependencies



	dm_partner_address

	base_contact









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Campaign Group Management for DM (dm_campaign_group)





	Module:	dm_campaign_group


	Name:	Campaign Group Management for DM


	Version:	1.0


	Author:	Tiny


	Directory:	dm_campaign_group


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


This module adds the possibility to manage groups of campaigns.





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/dm_campaign_group.zip]









Dependencies



	dm









Reports

None




Menus

None




Views



	dm.campaign.group.form (form)

	dm.campaign.group.tree (tree)

	* INHERIT dm.campaign.group.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







DM CRM  (dm_crm)





	Module:	dm_crm


	Name:	DM CRM


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_crm


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module manages crm case for dm








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_crm.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_crm.zip]









Dependencies



	dm

	crm









Reports

None




Menus

None




Views



	* INHERIT dm.crm.case.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Carriers and deliveries for DM (dm_delivery)





	Module:	dm_delivery


	Name:	Carriers and deliveries for DM


	Version:	1.0


	Author:	Tiny


	Directory:	dm_delivery


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


“Allows you to add delivery methods in sales orders and packing.





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/dm_delivery.zip]









Dependencies



	delivery

	dm









Reports

None




Menus

None




Views



	* INHERIT sale.order.line.form.inherit (form)

	* INHERIT sale.order.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Documents for DM (dm_document)





	Module:	dm_document


	Name:	Documents for DM


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_document


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module manages documents for Direct Marketing.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_document.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_document.zip]









Dependencies



	dm









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Direct Marketing For Emails (dm_email)





	Module:	dm_email


	Name:	Direct Marketing For Emails


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_email


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module deals with emails.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_email.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_email.zip]









Dependencies



	dm









Reports

None




Menus

None




Views



	* INHERIT dm.offer.document.form.inherit (form)

	* INHERIT dm.offer.document.media.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Direct Marketing For EmailVision (dm_emailvision)





	Module:	dm_emailvision


	Name:	Direct Marketing For EmailVision


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_emailvision


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module deals with emails.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_emailvision.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_emailvision.zip]









Dependencies



	dm









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







DM Extract (dm_extract)





	Module:	dm_extract


	Name:	DM Extract


	Version:	1.0


	Author:	Tiny


	Directory:	dm_extract


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/dm_extract.zip]









Dependencies



	dm









Reports

None




Menus

None




Views



	dm.address.segmentation.form (form)

	dm.address.segmentation.tree (tree)

	* INHERIT dm_campaign_proposition_segments (form)

	* INHERIT dm_campaign_proposition_segments_start_census (form)

	* INHERIT dm_campaign_proposition_segments_end_census (form)

	* INHERIT dm_campaign_proposition_segments_type_census (form)









Objects



	dm.address.segmentation

	dm.address.text_criteria

	dm.address.numeric_criteria

	dm.address.boolean_criteria

	dm.address.date_criteria
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







DM Extract Auto (dm_extract_auto)





	Module:	dm_extract_auto


	Name:	DM Extract Auto


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_extract_auto


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Allows to schedule automatic extractions of customers with the dm_extract module








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_extract_auto.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_extract_auto.zip]









Dependencies



	dm_extract









Reports

None




Menus

None




Views



	* INHERIT dm_campaign_proposition_segments_auto (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







DM Extract Sale (dm_extract_sale)





	Module:	dm_extract_sale


	Name:	DM Extract Sale


	Version:	1.0


	Author:	Tiny


	Directory:	dm_extract_sale


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/dm_extract_sale.zip]









Dependencies



	dm_sale

	dm_extract









Reports

None




Menus

None




Views



	* INHERIT dm.address.segmentation.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







DM FTP (dm_ftp)





	Module:	dm_ftp


	Name:	DM FTP


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_ftp


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_ftp.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_ftp.zip]









Dependencies



	dm









Reports

None




Menus

None




Views



	* INHERIT dm.mail_service.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Direct Marketing For Leads (dm_lead)





	Module:	dm_lead


	Name:	Direct Marketing For Leads


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_lead


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module deals with lead generation.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_lead.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_lead.zip]









Dependencies



	crm_configuration

	dm









Reports

None




Menus

None




Views



	* INHERIT dm.customers.file.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Direct Marketing - Offer Live Update (dm_offer_live_update)





	Module:	dm_offer_live_update


	Name:	Direct Marketing - Offer Live Update


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_offer_live_update


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Permits to modify an offer after it has been opened.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_offer_live_update.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_offer_live_update.zip]









Dependencies



	dm









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







DM Order Entry Filter (dm_order_entry_filter)





	Module:	dm_order_entry_filter


	Name:	DM Order Entry Filter


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_order_entry_filter


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows you to filter customer order entries.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_order_entry_filter.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_order_entry_filter.zip]









Dependencies



	dm_order_entry_session

	dm_payment_method









Reports

None




Menus

None




Views



	* INHERIT dm.order.session.form.inherit (form)

	* INHERIT dm.order.form.inherit (form)









Objects

None
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Partner Address Extension For DM (dm_partner_address)





	Module:	dm_partner_address


	Name:	Partner Address Extension For DM


	Version:	1.0


	Author:	Tiny


	Directory:	dm_partner_address


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Extend partner address for advanced Direct Marketing.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_partner_address.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_partner_address.zip]









Dependencies



	dm









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







DM Multi Price (dm_price_multi)





	Module:	dm_price_multi


	Name:	DM Multi Price


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_price_multi


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds multi prices to campaign proposition.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	dm_sale









Reports

None




Menus

None




Views



	* INHERIT dm.campaign.proposition.price.multi.inherit (form)

	* INHERIT dm.campaign.proposition.price.multi.inherit1 (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Price Progression for DM (dm_price_progression)





	Module:	dm_price_progression


	Name:	Price Progression for DM


	Version:	1.0


	Author:	Tiny


	Directory:	dm_price_progression


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


This module assigns price progression in campaign propositions for Direct Marketing.





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/dm_price_progression.zip]









Dependencies



	dm_sale









Reports

None




Menus

None




Views



	* INHERIT dm.campaign.proposition.price.inherit (form)

	dm.campaign.proposition.prices_progression.form (form)

	dm.campaign.proposition.prices_progression.tree (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







DM Product Media (dm_product_media)





	Module:	dm_product_media


	Name:	DM Product Media


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	dm_product_media


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Product Media for DM








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_product_media.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_product_media.zip]









Dependencies



	dm









Reports

None




Menus

None




Views



	* INHERIT dm.product.media.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Advanced Purchase Management for DM (dm_purchase_advanced)





	Module:	dm_purchase_advanced


	Name:	Advanced Purchase Management for DM


	Version:	1.0


	Author:	Tiny


	Directory:	dm_purchase_advanced


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


This module adds purchase management for the 4 departments of direct marketing             (manufacturing, files, items and DTP)





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/dm_purchase_advanced.zip]









Dependencies



	dm_purchase

	purchase_tender









Reports

None




Menus

None




Views



	* INHERIT dm.purchase.inherit (form)

	dm.campaign.purchase_line_tree (tree)

	dm.campaign.purchase_line_form (form)

	* INHERIT dm.offer.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Retro-Planning Tasks Management for DM (dm_retro_planning)





	Module:	dm_retro_planning


	Name:	Retro-Planning Tasks Management for DM


	Version:	1.0


	Author:	Tiny


	Directory:	dm_retro_planning


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


This module adds campaign retro-planning tasks management for Direct Marketing.





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/dm_retro_planning.zip]









Dependencies



	dm_purchase_advanced









Reports

None




Menus

None




Views



	* INHERIT dm.campaign.group.project.inherit (form)

	* INHERIT dm.campaign.project.inherit (form)

	* INHERIT dm.campaign.manufacturing.inherit (form)

	* INHERIT dm.campaign.dtp.inherit (form)

	* INHERIT dm.campaign.file.inherit (form)

	* INHERIT dm.campaign.item.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sales Management for DM (dm_sale)





	Module:	dm_sale


	Name:	Sales Management for DM


	Version:	0.1


	Author:	Tiny


	Directory:	dm_sale


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


This module adds sales management for Direct Marketing.





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/dm_sale.zip]









Dependencies



	dm









Reports

None




Menus

None




Views



	* INHERIT sale.order.form.inherit (form)

	* INHERIT dm.workitem.form.inherit (form)

	* INHERIT dm.offer.step.form.inherit (form)

	dm.event.sale.tree (tree)

	dm.event.sale.form (form)

	* INHERIT dm.campaign.proposition.form.inherit (form)









Objects



	dm.event.sale
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Simulation (dm_simulator)





	Module:	dm_simulator


	Name:	Simulation


	Version:	1.0


	Author:	Tiny


	Directory:	dm_simulator


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module is used to launch simulation on other servers.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_simulator.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_simulator.zip]









Dependencies



	dm









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Direct Marketing For Web Site (dm_website)





	Module:	dm_website


	Name:	Direct Marketing For Web Site


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	dm_website


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module deals with website.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/dm_website.zip]

	trunk [http://www.openerp.com/download/modules/trunk/dm_website.zip]









Dependencies



	dm









Reports

None




Menus

None




Views



	* INHERIT dm.campaign.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Extension Module of Document Management System (document_extension)





	Module:	document_extension


	Name:	Extension Module of Document Management System


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	document_extension


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This is an extension module of document management system with
    * Implementation of Versioning and lock system








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/document_extension.zip]

	trunk [http://www.openerp.com/download/modules/trunk/document_extension.zip]









Dependencies



	base

	process

	document









Reports

None




Menus

None




Views



	* INHERIT document.directory (form)

	* INHERIT ir.attachment (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Support for iCal based on Document Management System (document_ics)





	Module:	document_ics


	Name:	Support for iCal based on Document Management System


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	document_ics


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Allows to synchronise calendars with others applications.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/document_ics.zip]

	trunk [http://www.openerp.com/download/modules/trunk/document_ics.zip]









Dependencies



	document

	crm_configuration









Reports

None




Menus

None




Views



	* INHERIT document.directory (form)

	* INHERIT crm.case.code.form (form)

	* INHERIT crm.case.inherit.form1 (form)

	Configure Calendars for Sections (form)









Objects


Object: document.directory.ics.fields (document.directory.ics.fields)





	content_id:	Content, many2one, required









	field_id:	OpenERP Field, many2one, required









	name:	ICS Value, selection, required








Object: document.ics.crm.wizard (document.ics.crm.wizard)





	jobs:	Jobs Hiring Process, boolean






Help you to organise the jobs hiring process: evaluation, meetings, email integration...






	name:	Name, char









	lead:	Prospect, boolean






Allows you to track and manage prospects which are pre-sales requests or contacts, the very first contact with a customer request.






	document_ics:	Shared Calendar, boolean






Will allow you to synchronise your OpenERP calendars with your phone, outlook, Sunbird, ical, ...






	helpdesk:	Helpdesk, boolean






Manages an Helpdesk service.






	phonecall:	Phone Calls, boolean






Help you to encode the result of a phone call or to plan a list of phone calls to process.






	bugs:	Bug Tracking, boolean






Used by companies to track bugs and support requests on software






	fund:	Fund Raising Operations, boolean






This may help associations in their fund raising process and tracking.






	meeting:	Calendar of Meetings, boolean






Manages the calendar of meetings of the users.






	claims:	Claims, boolean






Manages the supplier and customers claims, including your corrective or preventive actions.






	opportunity:	Business Opportunities, boolean






Tracks identified business opportunities for your sales pipeline.
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Document Lock-To lock Attachment (document_lock)





	Module:	document_lock


	Name:	Document Lock-To lock Attachment


	Version:	5.0.0.0.2


	Author:	Tiny SPRL


	Directory:	document_lock


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

The document_lock adds a status on the attachment, allowing you to lock attachments or not.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/document_lock.zip]

	trunk [http://www.openerp.com/download/modules/trunk/document_lock.zip]









Dependencies



	document









Reports

None




Menus

None




Views



	* INHERIT ir.attachment.inherited (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Direct Marketing For Integrated Document Management System (document_no_contentindex)





	Module:	document_no_contentindex


	Name:	Direct Marketing For Integrated Document Management System


	Version:	1.0


	Author:	Tiny


	Directory:	document_no_contentindex


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


This module restricts the indexing of the content of files.





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/document_no_contentindex.zip]









Dependencies



	document









Reports

None




Menus

None




Views



	* INHERIT ir.attachment.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Integrated Document Management System (document)





	Module:	document


	Name:	Integrated Document Management System


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	document


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This is a complete document management system:
    * FTP Interface
    * User Authentication
    * Document Indexation

    ATTENTION:
    - When you install this module in a running company that already has PDF files stored in the database,
      you will lose them all.
    - After installing this module PDF's are no longer stored in the database,
      but in the server's filesystem like /server/bin/filestore.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/document.zip]

	trunk [http://www.openerp.com/download/modules/trunk/document.zip]









Dependencies



	base

	process









Reports

None




Menus



	Document Management

	Document Management/Document Configuration

	Document Management/Document Configuration/Directories

	Document Management/Document Configuration/Directorie’s Structure

	Document Management/Browse Files Using FTP

	Document Management/Search a File









Views



	document.directory (form)

	document.directory (tree)

	ir.attachment (form)

	ir.attachment (tree)

	* INHERIT ir.attachment.view.inherit (form)

	* INHERIT process.node.form (form)

	* INHERIT process.process.form (form)

	Auto Configure Directory (form)









Objects


Object: Document directory (document.directory)





	create_uid:	Creator, many2one, readonly









	domain:	Domain, char






Use a domain if you want to apply an automatic filter on visible resources.






	group_ids:	Groups, many2many









	create_date:	Date Created, datetime, readonly









	ressource_type_id:

		Directories Mapped to Objects, many2one






Select an object here and OpenERP will create a mapping for each of these objects, using the given domain, when browsing through FTP.






	ressource_tree:	Tree Structure, boolean






Check this if you want to use the same tree structure as the object selected in the system.






	file_type:	Content Type, char









	content_ids:	Virtual Files, one2many









	child_ids:	Children, one2many









	file_ids:	Files, one2many









	write_uid:	Last Modification User, many2one, readonly









	parent_id:	Parent Item, many2one









	ressource_parent_type_id:

		Parent Model, many2one






If you put an object here, this directory template will appear bellow all of these objects. Don’t put a parent directory if you select a parent model.






	write_date:	Date Modified, datetime, readonly









	user_id:	Owner, many2one









	ressource_id:	Resource ID, integer









	type:	Type, selection, required









	name:	Name, char, required








Object: Directory Content Type (document.directory.content.type)





	active:	Active, boolean









	code:	Extension, char









	name:	Content Type, char, required








Object: Directory Content (document.directory.content)





	suffix:	Suffix, char









	extension:	Document Type, selection, required









	sequence:	Sequence, integer









	name:	Content Name, char, required









	directory_id:	Directory, many2one









	include_name:	Include Record Name, boolean






Check this field if you want that the name of the file start by the record name.






	report_id:	Report, many2one








Object: document.configuration.wizard (document.configuration.wizard)





	host:	Server Address, char, required






Put here the server address or IP. Keep localhost if you don’t know what to write.
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Extension Module of Document Management System (document_rule)





	Module:	document_rule


	Name:	Extension Module of Document Management System


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	document_rule


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is  module of document management system with
     Implementation of document rule








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/document_rule.zip]

	trunk [http://www.openerp.com/download/modules/trunk/document_rule.zip]









Dependencies



	base

	process

	document









Reports

None




Menus



	Document Management/Document Configuration/Document Rules









Views



	document.rule (form)

	document.rule (tree)









Objects


Object: Document Rule (document.rule)





	act_assign_user_id:

		Assign to User, many2one









	resource_object:

		Resource Name, char









	author:	Author, many2one









	act_assign_partner_id:

		Assign to Partner, many2one









	date_type:	Trigger Date, selection









	sequence:	Sequence, integer









	directory_id:	Directory, many2one









	server_act:	Action, many2one









	act_move_directory_id:

		Move to, many2one









	active:	Active, boolean









	filename:	File, many2one









	partner_id:	Partner, many2one









	act_copy_directory_id:

		Copy to, many2one









	name:	Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Integrated Document Management System using paramiko lib (document_sftp)





	Module:	document_sftp


	Name:	Integrated Document Management System using paramiko lib


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	document_sftp


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This is a document management system using paramiko lib:
    * SFTP protocol








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/document_sftp.zip]

	trunk [http://www.openerp.com/download/modules/trunk/document_sftp.zip]









Dependencies



	base

	document









Reports

None




Menus

None




Views



	* INHERIT res.users.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Integrated Document Management System (document_webdav_old)





	Module:	document_webdav_old


	Name:	Integrated Document Management System


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	document_webdav_old


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This is a complete document management system:
      * WebDav Interface
      * User Authentication
      * Document Indexation








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/document_webdav_old.zip]

	trunk [http://www.openerp.com/download/modules/trunk/document_webdav_old.zip]









Dependencies



	base









Reports

None




Menus



	Document Management

	Document Management/Configuration/Directories

	Document Management/Directorie’s Structure

	Document Management/Search a File









Views



	document.directory (form)

	document.directory (tree)

	ir.attachment (form)

	ir.attachment (tree)

	* INHERIT ir.attachment.view.inherit (form)









Objects


Object: Document directory (document.directory)





	create_uid:	Creator, many2one, readonly









	domain:	Domain, char









	group_ids:	Groups, many2many









	create_date:	Date Created, datetime, readonly









	ressource_type_id:

		Resource Model, many2one









	ressource_tree:	Tree Structure, boolean









	file_type:	Content Type, char









	content_ids:	Virtual Files, one2many









	child_ids:	Childs, one2many









	file_ids:	Files, one2many









	write_uid:	Last Modification User, many2one, readonly









	parent_id:	Parent Item, many2one









	write_date:	Date Modified, datetime, readonly









	user_id:	Owner, many2one









	ressource_id:	Resource ID, integer









	type:	Type, selection, required









	name:	Name, char, required








Object: Directory Content (document.directory.content)





	suffix:	Suffix, char









	extension:	Extension, selection, required









	sequence:	Sequence, integer









	name:	Content Name, char, required









	directory_id:	Directory, many2one









	versioning:	Versioning, boolean









	report_id:	Report, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







E-Commerce (ecommerce)





	Module:	ecommerce


	Name:	E-Commerce


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	ecommerce


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

ecommerce users can order on the website, orders are automatically imported in OpenERP.

You can export products, product's categories, product images and create links between
categories of products, currency and languages to website.

Delivery of products manage by carriers.

Different payment methods are available for users to make payment.

You can display products in table on website using rows and columns specified in webshop.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/ecommerce.zip]

	trunk [http://www.openerp.com/download/modules/trunk/ecommerce.zip]









Dependencies



	delivery









Reports



	Shipping Invoice









Menus



	Ecommerce

	Ecommerce/Configuration

	Ecommerce/Configuration/Web Shop

	Ecommerce/Configuration/New Web Shop

	Ecommerce/Products

	Ecommerce/Products/Ecommerce Products by Category

	Ecommerce/Payment Configuration

	Ecommerce/Payment Configuration/Payment

	Ecommerce/Configuration/Payment method

	Ecommerce/Payment Configuration/Payment Received

	Ecommerce/Payment Configuration/Credit Cards

	Ecommerce/Partners

	Ecommerce/Partners/Partners

	Ecommerce/Partners/Partner Contacts

	Ecommerce/Products/Product Reviews

	Ecommerce/Products/Search Parameters

	Ecommerce/Sales Orders

	Ecommerce/Sales Orders/Ecommerce Sales Orders









Views



	ecommerce.shop.tree (tree)

	Web Shop (form)

	ecommerce.product.category.form (form)

	ecommerce.product.category.tree (tree)

	ecommerce.payment.tree (tree)

	ecommerce.payment.form (form)

	ecommerce.payment.method.tree (tree)

	ecommerce.payment.method.form (form)

	ecommerce.payment.received.tree (tree)

	ecommerce.payment.received.form (form)

	ecommerce.creditcard.tree (tree)

	ecommerce.creditcard.form (form)

	ecommerce.partner.tree (tree)

	ecommerce.partner.form (form)

	ecommerce.partner.address.tree (tree)

	ecommerce.partner.address.form (form)

	* INHERIT product.form (form)

	* INHERIT ecommerce.pricelist.version (form)

	ecommerce.reviews.tree (tree)

	ecommerce.reviews.form (form)

	ecommerce.search.tree (tree)

	ecommerce.search.form (form)

	saleorder.form (form)

	saleorder.tree (tree)

	orderline.form (form)

	orderline.tree (tree)









Objects


Object: ecommerce partner (ecommerce.partner)





	lang:	Language, many2one









	address_ids:	Contacts, one2many









	last_name:	Last Name, char









	name:	Name, char, required






Its ecommerce partner name and address






	category_ids:	Categories, many2many









	company_name:	Company Name, char









	active:	Active, boolean








Object: ecommerce partner address (ecommerce.partner.address)





	username:	Contact Name, char









	city:	City, char









	fax:	Fax, char









	zip:	Zip, char









	mobile:	Mobile, char









	partner_id:	Partner, many2one









	street2:	Street2, char









	country_id:	Country, many2one









	phone:	Phone, char









	street:	Street, char









	state_id:	State, many2one









	type:	Address Type, selection









	email:	E-Mail, char








Object: search parameters (ecommerce.search)





	code:	Product fields, many2one, required









	name:	Name, char, required






Search parameter name which you want to display at website





Object: Reviews about product (ecommerce.product.reviews)





	rating:	Rating, integer









	reviewdate:	Review Date, date









	customer_id:	Customer, many2one, required









	product_id:	Product, many2one, required









	review:	Review, text








Object: payment method (ecommerce.payment.method)





	name:	Name, char, required









	shortcut:	Shortcut, char, required








Object: Credit Cards (ecommerce.creditcard)





	code:	Code, char, required









	name:	Card Name, char, required








Object: ecommerce payment (ecommerce.payment)





	biz_account:	Business E-mail Id, char






Paypal business account Id.






	bank_name:	Bank Name, char









	chequepay_to:	Account Owner, char









	name:	Payment Method, selection, required









	zip:	Zip, char









	city:	City, char









	street2:	Street2, char









	country_id:	Country, many2one









	bic:	BIC number or SWIFT, char









	creditcard_ids:	Credit Cards, many2many









	transaction_dtl_ids:

		Transaction History, one2many






Transaction detail with the uniq transaction id.






	cancel_url:	Cancel URL, char






Cancel url which is set at the paypal account.






	street:	Street, char









	state_id:	State, many2one









	return_url:	Return URL, char






Return url which is set at the paypal account.






	acc_number:	Account Number, char






Bank account number





Object: ecommerce payment received (ecommerce.payment.received)





	saleorder_id:	Sales Order, many2one









	invoice_id:	Invoice, many2one









	paypal_acc_id:	Paypal Account, many2one, required









	transaction_date:

		Date Payment, date, required






Transaction finish date.






	partner_id:	Partner, many2one, required









	transaction_id:	Transaction Id, char, readonly






Its Unique id which is generated from the paypal.





Object: ecommerce shop (ecommerce.shop)





	column_configuration:

		No. of Columns, integer






Add number of columns for products which you want to configure at website






	search_ids:	Search On, many2many






Add the search parameters which you are allow from the website.






	delivery_ids:	Delivery, many2many






Add the carriers which you use for the shipping.






	payment_method_ids:

		Payment Methods, many2many









	language_ids:	Language, many2many






Add the language options for the online customers.






	currency_ids:	Currency, many2many






Add the currency options for the online customers.






	company_id:	Company, many2one









	shop_id:	Sale Shop, many2one, required









	image_width:	Width in Pixel, integer






Add product image width in pixels.






	image_height:	Height in Pixel, integer






Add product image height in pixels.






	category_ids:	Categories, one2many






Add the product categories which you want to displayed on the website.






	row_configuration:

		No. of Rows, integer






Add number of rows for products which you want to configure at website






	name:	Name, char, required






Name of the shop which you are configure at website.





Object: ecommerce category (ecommerce.category)





	child_ids:	Child Categories, one2many









	category_id:	Tiny Category, many2one






It display the product which are under the openerp category.






	web_id:	Web Shop, many2one









	name:	E-commerce Category, char, required






Add the category name which you want to display at the website.






	parent_category_id:

		Parent Category, many2one








Object: ecommerce saleorder (ecommerce.saleorder)





	epartner_add_id:

		Contact Address, many2one









	web_id:	Web Shop, many2one, required









	name:	Order Reference, char, required









	epartner_shipping_id:

		Shipping Address, many2one









	order_id:	Sale Order, many2one









	note:	Notes, text









	orderline_ids:	Order Lines, one2many









	epartner_id:	Ecommerce Partner, many2one, required









	pricelist_id:	Pricelist, many2one, required









	date_order:	Date Ordered, date, required









	epartner_invoice_id:

		Invoice Address, many2one








Object: ecommerce order line (ecommerce.order.line)





	product_id:	Product, many2one









	order_id:	eOrder Ref, many2one









	product_uom_id:	Product UOM, many2one, required









	price_unit:	Unit Price, float, required









	product_qty:	Quantity, float, required









	name:	Description, char, required
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Module for ‘Eco participation’ (ecotaxe)





	Module:	ecotaxe


	Name:	Module for ‘Eco participation’


	Version:	1.0


	Author:	Sednacom


	Directory:	ecotaxe


	Web:	http://www.sednacom.fr


	Official module:

		no


	Quality certified:

		no






Description

'Eco participation' management

This module adds the management of 'Eco participation' in TinyERP.

'Eco participation', mostly known as 'Ecotaxe', is French specific; its purpose is to finance recycling of products with a high cost of treatment.

Install this module if you need to manage 'Eco participation' in your business.

Module features:
 - amount of 'Eco participation' for product by producer
 - 'Eco participation' management in sale orders, purchases orders and invoices.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/ecotaxe.zip]

	trunk [http://www.openerp.com/download/modules/trunk/ecotaxe.zip]









Dependencies



	base

	product

	sale

	purchase

	l10n_fr









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







EDI (edi)





	Module:	edi


	Name:	EDI


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	edi


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Used for the communication with others proprietary ERP's. Has been tested in the food industries process, communicating with SAP. This module is able to import order and export delivery notes.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/edi.zip]

	trunk [http://www.openerp.com/download/modules/trunk/edi.zip]









Dependencies



	sale









Reports

None




Menus



	Sales Management/Edi

	Sales Management/Edi/View Logs









Views



	edi.log.line.tree (tree)

	edi.log.tree (tree)

	edi.log.form (form)

	* INHERIT sale.order.form.pvc (form)

	* INHERIT sale.order.line.form.pvc (form)









Objects


Object: EDI log (edi.log)





	name:	Log name, char, required









	log_line:	Log Lines, one2many, readonly








Object: EDI Log Line (edi.log.line)





	sender:	Partner, many2one, readonly









	log_id:	Log Ref, many2one









	timestamp:	Order date, char









	logdesc:	Description, text









	order_num:	Edi Order Id, char









	name:	Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Electronic Intrastat Reporting - To export intrastat data into .SDV format (electronic_report_intrastat)





	Module:	electronic_report_intrastat


	Name:	Electronic Intrastat Reporting - To export intrastat data into .SDV format


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	electronic_report_intrastat


	Web:	http://tinyerp.com


	Official module:

		no


	Quality certified:

		no






Description

A module that export intrastat data into .SDV format








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/electronic_report_intrastat.zip]

	trunk [http://www.openerp.com/download/modules/trunk/electronic_report_intrastat.zip]









Dependencies



	report_intrastat









Reports

None




Menus



	Stock Management/Reporting/Intrastat Export Logs









Views



	report.intrastat.export.log.form (form)

	export.log.tree (tree)









Objects


Object: report.intrastat.export.log (report.intrastat.export.log)





	date_create:	Export Time, datetime









	nbr:	Total lines Exported, integer









	note:	Notes, text









	user_id:	User, many2one









	name:	Name, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Email Invoice - Use to Send Customers or Suppliers the selected invoices attachment by Email. (email_account)





	Module:	email_account


	Name:	Email Invoice - Use to Send Customers or Suppliers the selected invoices attachment by Email.


	Version:	5.0.1.0


	Author:	Zikzakmedia SL


	Directory:	email_account


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Use Email client module to send to customers or suppliers
the selected invoices attached by Email.

  * The sale order, invoice and shipping emails addresses are proposed
  * An email subject and text with the user signature are proposed
  * Later, the emails addresses, subject and text can be modified
  * A partner event is created with information of the email (partner,
    description, channel, document, user)
  * Historical and statistical data is recorded in the smtpclient module








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/email_account.zip]

	trunk [http://www.openerp.com/download/modules/trunk/email_account.zip]









Dependencies



	smtpclient

	account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







E-mail Purchase (email_purchase)





	Module:	email_purchase


	Name:	E-mail Purchase


	Version:	5.0.1.0


	Author:	NaN


	Directory:	email_purchase


	Web:	www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

Use Email client module to send to suppliers the selected purchase orders attached by Email.

  * The invoice and contact emails addresses are proposed
  * An email subject and text with the user signature are proposed
  * Later, the emails addresses, subject and text can be modified
  * A partner event is created with information of the email (partner,
    description, channel, document, user)
  * Historical and statistical data is recorded in the smtpclient module

  The modules has been implemented based on email_sale. Indeed the code is almost the same.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	smtpclient

	purchase









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Email Sale - Use to Send Customers the selected sale orders attachment by Email (email_sale)





	Module:	email_sale


	Name:	Email Sale - Use to Send Customers the selected sale orders attachment by Email


	Version:	5.0.1.0


	Author:	Zikzakmedia SL


	Directory:	email_sale


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Use Email client module to send to customers
the selected sale orders attached by Email.

  * The invoice and contact emails addresses are proposed
  * An email subject and text with the user signature are proposed
  * Later, the emails addresses, subject and text can be modified
  * A partner event is created with information of the email (partner,
    description, channel, document, user)
  * Historical and statistical data is recorded in the smtpclient module








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/email_sale.zip]

	trunk [http://www.openerp.com/download/modules/trunk/email_sale.zip]









Dependencies



	smtpclient

	sale









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







EZ Publish eCommerce Interface (esale_ez)





	Module:	esale_ez


	Name:	EZ Publish eCommerce Interface


	Version:	False


	Author:	Tiny


	Directory:	esale_ez


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Module to interface with the EZ Publish ecommerce system.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/esale_ez.zip]

	trunk [http://www.openerp.com/download/modules/trunk/esale_ez.zip]









Dependencies



	product

	stock

	sale









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







eSale Interface - Joomla (esale_joomla)





	Module:	esale_joomla


	Name:	eSale Interface - Joomla


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	esale_joomla


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Joomla (Virtuemart) eCommerce interface synchronisation.
Users can order on the website, orders are automatically imported into OpenERP.

You can export products, product categories, account taxes, stock level and create links between
categories of products, taxes and languages.

If your product has an image attached, it sends the image to the Joomla website.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/esale_joomla.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/esale_joomla.zip]

	trunk [http://www.openerp.com/download/modules/trunk/esale_joomla.zip]









Dependencies



	product

	stock

	sale

	account

	account_tax_include









Reports

None




Menus



	Sales Management/eSale

	Sales Management/eSale/Definition

	Sales Management/eSale/Definition/Web Shop

	Sales Management/eSale/Definition/Web Product

	Sales Management/eSale/eSale Orders

	Sales Management/eSale/eSale Orders/Draft eSale Orders

	Sales Management/eSale/Synchronisation

	Sales Management/eSale/Synchronisation/Website Export log

	Sales Management/eSale/Synchronisation/Export Product Categories

	Sales Management/eSale/Synchronisation/Export Tax

	Sales Management/eSale/Synchronisation/Export Products

	Sales Management/eSale/Synchronisation/Export Inventory Level

	Sales Management/eSale/Synchronisation/Import eSales Orders









Views



	* INHERIT product.normal.form (form)

	esale_joomla.web.form (form)

	esale_joomla.product.form (form)

	esale_joomla.product.tree (tree)

	esale_joomla.order.tree (tree)

	esale_joomla.order.form (form)

	esale_joomla.order.line.form (form)

	esale_joomla.order.line.tree (tree)

	esale_joomla.web.exportlog.form (form)

	esale_joomla.web.exportlog.tree (tree)









Objects


Object: eCommerce Website (esale_joomla.web)





	taxes_included_ids:

		Taxes included, many2many









	name:	Name, char, required









	url:	URL, char, required









	language_id:	Language, many2one









	category_ids:	Categories, one2many









	shop_id:	Sale Shop, many2one, required









	product_ids:	Products, one2many









	active:	Active, boolean









	tax_ids:	Taxes, one2many








Object: eSale Tax (esale_joomla.tax)





	web_id:	Website, many2one









	name:	Tax name, char, required









	esale_joomla_id:

		eSale id, integer









	tax_id:	Tax, many2one








Object: eSale Category (esale_joomla.category)





	include_childs:	Include Childs, boolean






If checked, OpenERP will also export products from categories that are children of this one.






	category_id:	Category, many2one









	web_id:	Website, many2one









	name:	Name, char, required









	esale_joomla_id:

		Web ID, integer, required, readonly








Object: eSale Product (esale_joomla.product)





	esale_joomla_tax_id:

		eSale tax, many2one









	web_id:	Web Ref, many2one









	name:	Name, char, required









	esale_joomla_id:

		eSale product id, integer









	product_id:	Product, many2one, required








Object: eSale Language (esale_joomla.lang)





	web_id:	Website, many2one









	name:	Name, char, required









	esale_joomla_id:

		Web ID, integer, required









	language_id:	Language, many2one








Object: eShop Partner (esale_joomla.partner)





	city:	City, char









	address_id:	Partner Address, many2one









	name:	Name, char, required









	zip:	Zip, char









	country:	Country, char









	state:	State, char









	esale_id:	eSale ID, char









	address:	Address, char









	email:	Mail, char








Object: esale_joomla.order (esale_joomla.order)





	web_id:	Web Shop, many2one, required









	name:	Order Description, char, required









	epartner_shipping_id:

		Joomla Shipping Address, many2one, required









	order_id:	Sale Order, many2one









	partner_id:	Contact Address, many2one









	web_ref:	Web Ref, integer









	note:	Notes, text









	state:	Order State, selection









	partner_shipping_id:

		Shipping Address, many2one









	partner_invoice_id:

		Invoice Address, many2one









	date_order:	Date Ordered, date, required









	epartner_invoice_id:

		Joomla Invoice Address, many2one, required









	order_lines:	Order Lines, one2many








Object: eSale Order line (esale_joomla.order.line)





	product_id:	Product, many2one









	order_id:	eOrder Ref, many2one









	product_uom_id:	Unit of Measure, many2one, required









	price_unit:	Unit Price, float, required









	product_qty:	Quantity, float, required









	name:	Order Line, char, required








Object: eSale webshop Synchronisation log (esale_joomla.web.exportlog)





	log_date:	Log date, datetime, required









	user_id:	Exported By, many2one, required









	web_id:	Web Ref, many2one









	name:	Synchronisation Log, char, required









	log_type:	Export type, selection, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







OScommerce Interface / ZenCart (esale_osc)





	Module:	esale_osc


	Name:	OScommerce Interface / ZenCart


	Version:	5.0.1.0


	Author:	Axelor/Zikzakmedia


	Directory:	esale_osc


	Web:	www.aulaerp.com/cursos-aulaerp/configuracion-y-funcionamiento-del-conector-openerp-oscommerce.html


	Official module:

		no


	Quality certified:

		no






Description

OSCommerce (Zencart) eCommerce interface synchronisation.

Syncro Oscommerce to Openerp
 1. Import/upgrade categories.
 2. Import/upgrade products.
 3. Import Orders on selected status. On importing order, if not exists, customer is created automatically

Syncro Openerp to Oscommerce
 1. Export products, prices, image, specials.
 2. Export Stocks.
 3. Change Oscommerce Order status and include comments. Upload Osc Status and comments.

Developed by Tiny, Axelor, Zikzakmedia and Ana Juaristi








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/esale_osc.zip]

	trunk [http://www.openerp.com/download/modules/trunk/esale_osc.zip]









Dependencies



	product

	stock

	sale

	account_payment









Reports

None




Menus



	Sales Management/Internet Sales

	Sales Management/Internet Sales/Websites

	Sales Management/Internet Sales/Web sale orders

	Sales Management/Internet Sales/Web sale orders/New order

	Sales Management/Internet Sales/Web sale orders/Request for quotation

	Sales Management/Internet Sales/Web sale orders/Waiting invoice

	Sales Management/Internet Sales/Web sale orders/In progress

	Sales Management/Internet Sales/Invoices

	Sales Management/Internet Sales/Invoices/Draft

	Sales Management/Internet Sales/Invoices/PRO-FORMA

	Sales Management/Internet Sales/Invoices/Opened

	Sales Management/Internet Sales/Synchronize products and stocks to all OScommerce web shops

	Sales Management/Internet Sales/Update stocks to all OScommerce web shops

	Sales Management/Internet Sales/Import sale orders from all OScommerce web shops

	Sales Management/Internet Sales/Manufacturers









Views



	esale.oscom.web.form (form)

	esale.oscom.web.form (tree)

	esale.oscom.language.web.form (form)

	esale.oscom.language.web.tree (tree)

	esale.oscom.tax.web.form (form)

	esale.oscom.tax.web.tree (tree)

	esale.oscom.pay.typ.form (form)

	esale.oscom.pay.typ.tree (tree)

	esale.oscom.status.form (form)

	esale.oscom.status.tree (tree)

	esale.oscom.category.web.form (form)

	esale.oscom.category.web.v (tree)

	esale.oscom.product.web.form (form)

	esale.oscom.saleorder.tree (tree)

	* INHERIT esale.oscom.saleorder.form (form)

	* INHERIT esale.oscom.product.add.oscom.fields (form)

	esale.oscom.product.maufacturer.view.form (form)

	esale.oscom.product.maufacturer.view.tree (tree)









Objects


Object: esale.oscom.web (esale.oscom.web)





	pay_typ_ids:	Payment types, one2many









	name:	Name, char, required









	download_number:

		Download number, integer






Osc product number to download by block. You should find the optimum block to download for your shop






	url:	URL, char, required









	language_ids:	Languages, one2many









	category_ids:	Categories, one2many









	esale_account_id:

		Dest. account, many2one, required






Payment account for web invoices.






	shop_id:	Sale shop, many2one, required









	intermediate:	Intermediate Status, many2one






Select intermediate status for Osc downloaded Orders






	product_ids:	Web products, one2many









	active:	Active, boolean









	date_download_from:

		Date Download From, date






Specify date since you want to download modified or new products






	price_type:	Price type, selection, required









	status_ids:	Osc Status, one2many









	tax_ids:	Taxes, one2many








Object: esale_oscom Tax (esale.oscom.tax)





	web_id:	Website, many2one









	name:	Tax name, char, required, readonly









	esale_oscom_id:	OScommerce Id, integer









	tax_id:	OpenERP tax, many2one








Object: esale_oscom Status (esale.oscom.status)





	download:	Download Orders on Status, boolean









	web_id:	Website, many2one









	name:	Status name, char, required, readonly









	esale_oscom_id:	OScommerce Id, integer









	language_id:	Language Id, integer








Object: esale_oscom Category (esale.oscom.category)





	category_id:	OpenERP category, many2one









	web_id:	Website, many2one









	name:	Name, char, required, readonly









	esale_oscom_id:	OScommerce Id, integer, required








Object: esale_oscom PayType (esale.oscom.paytype)





	payment_id:	OpenERP payment, many2one









	paytyp:	Payment type, selection









	web_id:	Website, many2one









	name:	Name, char, required, readonly









	journal_id:	OpenERP payment journal, many2one









	esale_oscom_id:	OScommerce Id, integer, required








Object: esale_oscom Language (esale.oscom.lang)





	web_id:	Website, many2one









	name:	Name, char, required, readonly









	esale_oscom_id:	OScommerce Id, integer, required









	language_id:	OpenERP language, many2one








Object: esale_oscom Product (esale.oscom.product)





	web_id:	Website, many2one









	name:	Name, char, required, readonly









	esale_oscom_id:	OScommerce product Id, integer









	product_id:	OpenERP product, many2one








Object: Product Manufacturer that produces the product (product.manufacturer)





	manufacturer_url:

		URL, char









	name:	Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







ETL system (etl_interface)





	Module:	etl_interface


	Name:	ETL system


	Version:	False


	Author:	Tiny


	Directory:	etl_interface


	Web:	http://openerp.com


	Official module:

		no


	Quality certified:

		no






Description

ETL system- Extract Transfer Load system








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/etl_interface.zip]

	trunk [http://www.openerp.com/download/modules/trunk/etl_interface.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Event Certificate (event_certificate)





	Module:	event_certificate


	Name:	Event Certificate


	Version:	0.1


	Author:	Tiny


	Directory:	event_certificate


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Events Certificate.     This module allow you         * to print certificate related to your events and their registrations




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/event_certificate.zip]









Dependencies



	event









Reports



	Certificate









Menus

None




Views



	* INHERIT events.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Event - Project (event_project)





	Module:	event_project


	Name:	Event - Project


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	event_project


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Organization and management of events.

    This module allow you to create retro planning for managing your events.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/event_project.zip]

	trunk [http://www.openerp.com/download/modules/trunk/event_project.zip]









Dependencies



	project_retro_planning

	event









Reports

None




Menus

None




Views



	* INHERIT Events (form)

	* INHERIT Events (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Event (event)





	Module:	event


	Name:	Event


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	event


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Organization and management of events.

    This module allow you
        * to manage your events and their registrations
        * to use emails to automatically confirm and send acknowledgements for any registration to an event
        * ...

    Note that:
    - You can define new types of events in
                Events / Configuration / Types of Events
    - You can access predefined reports about number of registration per event or per event category in :
                Events / Reporting








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/event.zip]

	trunk [http://www.openerp.com/download/modules/trunk/event.zip]









Dependencies



	crm

	base_contact

	account









Reports

None




Menus



	Events Organisation

	Events Organisation/Configuration

	Events Organisation/Configuration/Types of Events

	Events Organisation/Events by Categories

	Events Organisation/New event

	Events Organisation/All Events

	Events Organisation/All Events/Draft Events

	Events Organisation/All Events/Confirmed Events

	Events Organisation/All Registrations

	Events Organisation/All Registrations/Unconfirmed Registrations

	Events Organisation/All Registrations/Confirmed Registrations

	Events Organisation/Reporting

	Events Organisation/Reporting/Events On Registrations

	Events Organisation/Reporting/Registration By Event Types









Views



	Event type (form)

	Event type (tree)

	Events (form)

	event.event.tree (tree)

	event.registration.tree (tree)

	event.registration.form (form)

	report.event.registration.tree (tree)

	report.event.registration.graph (graph)

	report.event.type.registration.tree (tree)

	report.event.type.registration.graph (graph)









Objects


Object: Event type (event.type)





	name:	Event type, char, required








Object: Event (event.event)





	code:	Section Code, char









	sequence:	Sequence, integer









	date_end:	Ending date, datetime, required









	register_max:	Maximum Registrations, integer









	mail_registr:	Registration Email, text






This email will be sent when someone subscribes to the event.






	mail_auto_confirm:

		Mail Auto Confirm, boolean






Check this box if you want ot use the automatic confirmation emailing or the reminder






	user_id:	Responsible User, many2one









	mail_auto_registr:

		Mail Auto Register, boolean






Check this box if you want to use the automatic mailing for new registration






	register_min:	Minimum Registrations, integer









	parent_id:	Parent Section, many2one









	state:	Status, selection, required, readonly









	mail_confirm:	Confirmation Email, text






This email will be sent when the event gets confirmed or when someone subscribes to a confirmed event. This is also the email sent to remind someone about the event.






	register_prospect:

		Unconfirmed Registrations, float, readonly









	type:	Type, many2one









	child_ids:	Child Sections, one2many









	section_id:	Case section, many2one, required









	active:	Active, boolean









	date_begin:	Beginning date, datetime, required









	product_id:	Product, many2one, required









	name:	Case Section, char, required









	register_current:

		Confirmed Registrations, float, readonly









	reply_to:	Reply-To, char






The email address put in the ‘Reply-To’ of all emails sent by OpenERP about cases in this section






	allow_unlink:	Allow Delete, boolean






Allows to delete non draft cases





Object: Event Registration (event.registration)





	date_closed:	Closed, datetime, readonly









	history_line:	Communication, one2many, readonly









	ref2:	Reference 2, reference









	create_date:	Created, datetime, readonly









	description:	Your action, text









	probability:	Probability (%), float









	canal_id:	Channel, many2one









	date_action_last:

		Last Action, datetime, readonly









	planned_cost:	Planned Costs, float









	partner_address_id:

		Partner Contact, many2one









	som:	State of Mind, many2one









	section_id:	Section, many2one, required









	contact_id:	Partner Contact, many2one









	active:	Active, boolean









	badge_title:	Badge Title, char









	badge_name:	Badge Name, char









	date:	Date, datetime









	tobe_invoiced:	To be Invoiced, boolean









	nb_register:	Number of Registration, integer, readonly









	planned_revenue:

		Planned Revenue, float









	id:	ID, integer, readonly









	date_action_next:

		Next Action, datetime, readonly









	invoice_id:	Invoice, many2one









	user_id:	Responsible, many2one









	name:	Description, char, required









	date_deadline:	Deadline, datetime









	partner_invoice_id:

		Partner Invoiced, many2one









	event_id:	Event Related, many2one, required









	partner_id:	Partner, many2one









	categ_id:	Category, many2one









	unit_price:	Unit Price, float









	badge_partner:	Badge Partner, char









	priority:	Priority, selection









	state:	Status, selection, readonly









	case_id:	Case, many2one









	email_last:	Latest E-Mail, text, readonly









	email_cc:	Watchers Emails, char









	invoice_label:	Label Invoice, char, required









	ref:	Reference, reference









	email_from:	Partner Email, char









	log_ids:	Logs History, one2many, readonly








Object: Events on registrations (report.event.registration)





	date_begin:	Beginning date, datetime, required









	name:	Event, char









	confirm_state:	Confirm Registration, integer









	draft_state:	Draft Registration, integer









	date_end:	Ending date, datetime, required









	register_max:	Maximum Registrations, integer








Object: Event type on registration (report.event.type.registration)





	draft_state:	Draft Registrations, integer









	confirm_state:	Confirm Registrations, integer









	name:	Event Type, char









	nbevent:	Number Of Events, integer
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Tiny TERP fashion module (fashion)





	Module:	fashion


	Name:	Tiny TERP fashion module


	Version:	5.0.1.0


	Author:	Manou


	Directory:	fashion


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Product characteristics








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/fashion.zip]

	trunk [http://www.openerp.com/download/modules/trunk/fashion.zip]









Dependencies



	base

	product

	mrp









Reports

None




Menus



	Production

	Production/Definitions

	Production/Definitions/Characteristics

	Production/Definitions/Characteristics/Characteristic Groups

	Production/Definitions/Characteristics/Characteristic









Views



	mrp.characteristic.group.tree (tree)

	mrp.characteristic.group.form (form)

	mrp.characteristic.tree (tree)

	mrp.characteristic.form (form)

	* INHERIT product.variant.form (form)

	* INHERIT product.template.product.form (form)

	* INHERIT mrp.bom.form (form)

	mrp.bom.variation.form (form)

	mrp.bom.variation.tree (tree)









Objects


Object: Characteristic Group (mrp.characteristic.group)





	axis:	Preferred axis for layout, selection









	description:	Description, text









	name:	Characteristic Group, char, required








Object: Characteristic (mrp.characteristic)





	group_id:	Characteristic Group, many2one, required









	name:	Characteristic, char, required









	magnitude:	Magnitude, float









	description:	Description, text








Object: BOM characteristic variation (mrp.bom.variation)





	product_characteristic_id:

		Component Characteristic, many2one









	characteristic_id:

		Parent Characteristic, many2one









	product_qty:	Product Qty, float









	bom_id:	BOM, many2one, required









	exclude:	Exclude, boolean









	characteristic_group_id:

		characteristic group, string, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Auction module - Flagey Customs (flagey)





	Module:	flagey


	Name:	Auction module - Flagey Customs


	Version:	5.0.1.0


	Author:	


	Directory:	flagey


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/flagey.zip]

	trunk [http://www.openerp.com/download/modules/trunk/flagey.zip]









Dependencies



	auction









Reports



	Fiches Lots









Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Help managing maintenance contracts related to product fleet (fleet_maintenance)





	Module:	fleet_maintenance


	Name:	Help managing maintenance contracts related to product fleet


	Version:	5.0.0.3


	Author:	Smile for Anevia (Anevia.com)


	Directory:	fleet_maintenance


	Web:	http://www.smile.fr


	Official module:

		no


	Quality certified:

		no






Description

Manage the maintenance contracts of a product fleet (streaming servers originally).

Now partners have fleets and sub-fleets for which they can buy products that can eventually
be covered by paid maintenance contracts.

Fleet: a stock.location for which all products have the same maintenance end date anniversary.
Indeed, it's useful to have several maintenance contracts for a given partner with a single anniversary date
for an eventual renewal.
Meaning that if the customer wants a different end date anniversaries for two maintenance contracts,
then he should have several Fleets.
Products don't go in the Fleets actually, they go in their Sub-Fleets instead.

Sub-Fleet: a stock.location child of a Fleet which might contains some purchased products.
In a sub-fleet, ALL the maintenance contracts of the products have exactly the same start date and end date.
Meaning that if a customer need several different start date or some years offset for the end date,
then he should have several Sub-Fleets.

This module also take care of proposing ideal maintenance dates given a few rules that might
be changed in your specific case (Ideally they wouldn't be hardcoded or at least have some
parameters externalized to the database).

Finally, this module also takes care of after sale incidents, extending the native CRM and thus
preserving all the CRM power.
Given a product serial number (prodlot), it's able to retrieve the Fleet and Partner and know if a product is still covered
by a maintenance contract or not. It also deals with reparation movements in a simple manner, that
might later on made compatible with the mrp_repair module which was too complex for our first use here.

This module is also fully compliant with the native prodlot tracking of OpenERP to know
where is a serial number, be it a finished product or only a part, and even after a replacement
if movements are properly entered in the crm incident. For a better tracking experience, it's
advised to use it along with the mrp_prodlot_autosplit module.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/fleet_maintenance.zip]

	trunk [http://www.openerp.com/download/modules/trunk/fleet_maintenance.zip]









Dependencies



	base

	product

	stock

	sale

	crm_configuration

	account

	delivery









Reports

None




Menus



	Fleets

	Fleets/Fleet Maintenance Contracts

	Fleets/Fleets

	Fleets/Fleet Extensions

	Fleets/Production Lots

	Fleets/Fleets/All Fleets

	Fleets/Fleets/New Fleet

	Fleets/Fleet Extensions/All Sub Fleets

	Fleets/Fleet Extensions/New Fleet Extension

	Fleets/Fleet Maintenance Contracts/All Maintenance Orders

	Fleets/Fleet Maintenance Contracts/New Maintenance quotation

	Fleets/Fleet Incidents

	Fleets/Fleet Incidents/All Fleet Incidents

	Fleets/Fleet Incidents/New Fleet Incident









Views



	* INHERIT product.form.fleet_maintenance.inherit (form)

	* INHERIT product.form.fleet_maintenance.inherit2 (form)

	* INHERIT product.form.fleet_maintenance.inherit3 (form)

	* INHERIT sale.order.form.fleet_maintenance.inherit (form)

	* INHERIT sale.order.form.fleet_maintenance2.inherit (form)

	* INHERIT sale.order.form.fleet_maintenance3.inherit (form)

	* INHERIT sale.order.form.fleet_maintenance4.inherit (form)

	* INHERIT sale.order.form.fleet_maintenance5.inherit (form)

	* INHERIT account.invoice.line.form.fleet_maintenace.inherit (form)

	* INHERIT account.invoice.line.tree.fleet_maintenace.inherit (tree)

	account.invoice.line.calendar.fleet_maintenace.inherit (calendar)

	stock.location.fleet.form.fleet_maintenance (form)

	stock.location.fleet.form.sub_fleet_maintenance (form)

	fleet_maintenance.tree (tree)

	sub_fleet.tree (tree)

	* INHERIT stock.location.tree (tree)

	stock.picking.incident.form (form)

	* INHERIT res.partner.form.fleet_maintenance.inherit (form)

	* INHERIT account.analytic.line.fleet_form (form)

	crm.case.form.fleet_maintenance (form)

	crm.case.tree.fleet_maintenance (tree)









Objects

None
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Fleet Management System (fleet_manager)





	Module:	fleet_manager


	Name:	Fleet Management System


	Version:	1.0


	Author:	Sharoon Thomas


	Directory:	fleet_manager


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

The module is a vertical for fleet operations management








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/fleet_manager.zip]

	trunk [http://www.openerp.com/download/modules/trunk/fleet_manager.zip]









Dependencies



	base

	account

	hr

	account_voucher

	stock_location









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Scenario of games (game_scenario)





	Module:	game_scenario


	Name:	Scenario of games


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	game_scenario


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Allows to check the scenario of games








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/game_scenario.zip]

	trunk [http://www.openerp.com/download/modules/trunk/game_scenario.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Game Scenario

	Administration/Game Scenario/Configuration

	Administration/Game Scenario/Configuration/Scenario Steps

	Administration/Game Scenario/Configuration/Scenario









Views



	game.scenario.step.tree (tree)

	game.scenario.step.form (form)

	game.scenario.tree (tree)

	game.scenario.form (form)









Objects


Object: game.scenario (game.scenario)





	note:	Note, text









	state:	State, selection, required









	name:	Name, char, required








Object: game.scenario.step (game.scenario.step)





	menu_id:	Menu, many2one, required









	post_process_object:

		Postprocess Object, char









	description:	Description, text









	pre_process_method:

		Preprocess Method, char









	error:	Error, text









	tip:	Tip, text









	scenario_id:	Scenario, many2one, required









	name:	Name, char, required









	state:	State, selection, required









	post_process_method:

		Postprocess Method, char









	step_next_ids:	Next Steps, many2many









	pre_process_object:

		Preprocess Object, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







generalize account report module (generalize_account_report)





	Module:	generalize_account_report


	Name:	generalize account report module


	Version:	5.0.0.1


	Author:	Tiny/Axelor


	Directory:	generalize_account_report


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module to handle account in generalize manner and print the report.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	account_voucher









Reports



	Final Horizontal Report

	Final Vertical Report









Menus



	Financial Management/Legal Statements/Generalize Account Report

	Financial Management/Legal Statements/Generalize Account Report/Generalize Account Report









Views



	generalize_account_report.tree (tree)

	generalize_account_report.form (form)

	group.detail.configuration.tree (tree)

	group.detail.configuration.form (form)









Objects


Object: Generalize Account Report (generalize.account.report)





	name:	Name, char, required









	end_date:	End Date, date









	gr_detail:	Documents, one2many









	Loss_tran_acc:	Loss Transfer Account, many2one









	company_id:	Company, many2one, required









	fiscal_year:	Fiscal Year, many2one, required









	st_date:	Start Date, date









	profit_tran_acc:

		Profit Transfer Account, many2one









	type:	Report type, selection, required









	final_type:	Final Account Type, selection, required








Object: Group Configuration (group.detail.configuration)





	acc_gr_name:	Account, many2one, required









	pos_name:	Position Name, selection, required









	name:	Name, char, required









	gdc_id:	Geralize Account, many2one









	sequence:	Sequence, integer, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Module for Import from file (gnucash)





	Module:	gnucash




	Name:	Module for Import from file




	Version:	5.0.0.1




	Author:	
	Christeas






	Directory:	gnucash




	Web:	


	Official module:

		no




	Quality certified:

		no








Description

Gnucash Import from file








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/gnucash.zip]

	trunk [http://www.openerp.com/download/modules/trunk/gnucash.zip]









Dependencies



	base

	account

	product









Reports

None




Menus



	Administration/GnuCash

	Administration/GnuCash/Gnucash Mappings

	Administration/GnuCash/Import GnuCash File









Views



	gnucash.index.form (form)

	gnucash.index.tree (tree)









Objects


Object: gnucash.index (gnucash.index)





	noupdate:	Non Updatable, boolean









	parent_book:	Parent book, many2one









	date_init:	Init Date, datetime









	date_update:	Update Date, datetime









	module:	Module, char, required









	to_delete:	Should be deleted, boolean, required









	model:	Object, char, required









	guid:	Gnucash UID, char, required









	res_id:	Resource ID, integer
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Google Blogger (google_blogger)





	Module:	google_blogger


	Name:	Google Blogger


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	google_blogger


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module creates wizard in Project Management/Tasks/Export to blog
            - which export user's tasks to blog provided blog id and password in user's form








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/google_blogger.zip]

	trunk [http://www.openerp.com/download/modules/trunk/google_blogger.zip]









Dependencies



	project









Reports

None




Menus



	Project Management/Blogger

	Project Management/Blogger/Export to Blog









Views



	* INHERIT res.users.blogger.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Google calendar (google_calendar)





	Module:	google_calendar


	Name:	Google calendar


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	google_calendar


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Export events (crm) to google calendar








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/google_calendar.zip]

	trunk [http://www.openerp.com/download/modules/trunk/google_calendar.zip]









Dependencies



	event









Reports

None




Menus



	Events Organisation/Google Import-Export

	Events Organisation/Google Import-Export/Synchronize Events









Views



	* INHERIT res.users.google.form (form)

	* INHERIT event.event.google.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Google Earth/Map Module (google_earth)





	Module:	google_earth


	Name:	Google Earth/Map Module


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	google_earth


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This Module will includes following :

            * Layers with characteristics by regions (menu: Partners/Google Map/Earth)
            * Display customers, whom country has colors by turnover (menu: Partners/Google Map/Earth)
            * Most frequent delivery routes (menu: on stock.picking)








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/google_earth.zip]

	trunk [http://www.openerp.com/download/modules/trunk/google_earth.zip]









Dependencies



	sale









Reports

None




Menus



	Partners/Google Map/Earth

	Partners/Google Map/Earth/Customer on Map with Turnover

	Partners/Google Map/Earth/Layers of Category of Regions









Views

None




Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Google Map (google_map)





	Module:	google_map


	Name:	Google Map


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	google_map


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

The module adds google map field in partner address
so that we can directly open google map from the
url widget.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/google_map.zip]

	trunk [http://www.openerp.com/download/modules/trunk/google_map.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	* INHERIT res.partner.address.form1.inheritg (form)

	* INHERIT res.partner.address.form2.inheritg (form)

	* INHERIT res.partner.form.inheritg (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Google translation (google_translate)





	Module:	google_translate


	Name:	Google translation


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	google_translate


	Web:	http://tinyerp.com


	Official module:

		no


	Quality certified:

		no






Description

Module translate the tiny terms available in translation using google








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/google_translate.zip]

	trunk [http://www.openerp.com/download/modules/trunk/google_translate.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Translations/Application Terms/All terms/Need review terms









Views



	* INHERIT ir.translation.inherit.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Tiny TERP Health Management (health)





	Module:	health


	Name:	Tiny TERP Health Management


	Version:	5.0.0.9.3


	Author:	EVI


	Directory:	health


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Health Management System








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/health.zip]

	trunk [http://www.openerp.com/download/modules/trunk/health.zip]









Dependencies



	base

	product

	account









Reports



	Present

	Entry Exit

	Semester Movement

	Birthday

	Fund Regime









Menus



	EHPAD

	EHPAD/Configuration

	EHPAD/Fund Regime

	EHPAD/Residents

	EHPAD/Applicants

	EHPAD/Medicaments

	EHPAD/Events

	EHPAD/AGGIR

	EHPAD/Prescriptions

	EHPAD/Billing

	EHPAD/Absences

	EHPAD/Rooms

	EHPAD/Configuration/Rooms Rate

	EHPAD/Configuration/Fund Regime

	EHPAD/Configuration/Localisation

	EHPAD/Care

	EHPAD/Configuration/Medicament form

	EHPAD/Configuration/Care

	EHPAD/Configuration/Rate Dependance

	EHPAD/Configuration/Situations

	EHPAD/Configuration/Religions

	EHPAD/Configuration/Events type

	EHPAD/Configuration/Pathos

	EHPAD/Configuration/Pathos/States Pathologique

	EHPAD/Configuration/Pathos/Profiles

	EHPAD/Configuration/Pathos/Category States

	EHPAD/Configuration/Absences

	EHPAD/Configuration/Semesters









Views



	health.semestre.form (form)

	health.semestre.tree (tree)

	health.absences.fiche-simple (form)

	health.absences.arbre-simple (tree)

	health.tarif.absences.tree (tree)

	health.tarif.absences.form (form)

	health.absences.tree (tree)

	health.absences.form (form)

	health.prescription.fiche-simple (form)

	health.prescription.arbre-simple (tree)

	health.facturation.tree (tree)

	health.facturation.form (form)

	health.prescription.tree (tree)

	health.prescription.form (form)

	health.aggir.tree (tree)

	health.aggir.form (form)

	health.evenement.type.tree (tree)

	health.evenement.type.form (form)

	health.patient.evenement.tree (tree)

	health.patient.evenement.tree-simple (tree)

	health.patient.evenement.form (form)

	health.patient.evenement.form-simple (form)

	health.droits.tree (tree)

	health.droits.form (form)

	health.religion.tree (tree)

	health.religion.form (form)

	health.situation.tree (tree)

	health.situation.form (form)

	health.care.tree (tree)

	health.care.form (form)

	health.drug.form (form)

	health.drug.tree (tree)

	health.drugform.tree (tree)

	health.drugform.form (form)

	health.tarif.dependance.tree (tree)

	health.tarif.apa.form (form)

	health.patient.tree (tree)

	health.patient.form (form)

	health.room.tarif.tree (tree)

	health.room.tarif.form (form)

	health.room.localisation.tree (tree)

	health.room.localisation.form (form)

	health.room.tree (tree)

	health.room.form (form)

	health.pathosprofils.tree (tree)

	health.pathosprofils.form (form)

	health.pathosetatspatho.tree (tree)

	health.pathosetatspatho.form (form)

	health.pathoscategetats.tree (tree)

	health.pathoscategetats.form (form)

	health.regime.tree (tree)

	health.regime.tree (tree)

	health.regime.form (form)









Objects


Object: Semestre (health.semestre)





	fiscalyear_id:	Fiscal Year, many2one, required









	code:	Code, char









	date_stop:	End of period, date, required









	date_start:	Start of period, date, required









	name:	Semester, char, required








Object: religion (health.religion)





	name:	name, char








Object: situation (health.situation)





	name:	name, char








Object: Room Rate (health.room.tarif)





	type:	Room type, selection









	age:	Age Limit, selection









	ref:	reference, char









	name:	Fare type, char









	prix:	Prix, float








Object: Localisation (health.room.localisation)





	nbrchambre:	Number of room, integer









	name:	Code, char









	designation:	Designation, char








Object: Chambres (health.room)





	localisation:	Localisation, many2one









	type:	Room type, selection









	name:	Name of Room, char









	bed:	Number of bed, integer








Object: Rate Dependence (health.tarif.dependance)





	name:	GIR, char









	montant:	Rate Dependence, float








Object: Drug Form (health.drugform)





	name:	name, char








Object: Drug Family (health.drugfamilly)





	name:	name, char








Object: Profils Pathos (health.pathosprofils)





	definition:	Definition, text









	name:	Profile, char









	description:	Description, char








Object: Category States Pathologique Pathos (health.pathoscategetats)





	name:	Category States Pathologique, char








Object: States Patholohgique Pathos (health.pathosetatspatho)





	definition:	Definition, text









	categorie:	Category, many2one









	name:	Etats Pathologique, char









	profils:	Profils, many2many









	description:	Description, char








Object: Facturation (health.facturation)





	aidesociale:	Social Assistance, char









	absences:	Personal absences, char









	name:	Resident, many2one, required









	decomptes:	No. of days for the period, char









	allocation:	Allocation Logement, char









	hebergement:	Accommodation Rates, float









	period_id:	Billing period, many2one, required









	datefacturation:

		Invoice Date, date









	hospitalisation:

		Absences Hospitalization, char









	commentaire:	Comment, text









	dependance:	Tarida Dependence, float









	ticketmoderateur:

		Moderator Ticket, float









	apa:	A.P.A., char









	chambre:	Rooms, many2one









	absautres:	Other absences, char








Object: Aggir (health.aggir)





	cuisine:	Kitchen, selection









	alimentation:	Food, selection









	orientation:	Orientation, selection









	menage:	Menage, selection









	achats:	Procurement, selection









	communication:	Communication to alert, selection









	coherence:	Coherence, selection









	transports:	Transport, selection









	toilette:	Toilet, selection









	name:	Resident, many2one









	activite:	Free time, selection









	resultat:	AG-GIR, char









	moveint:	Internal displacement, selection









	gestion:	Management, selection









	traitement:	monitoring treatment, selection









	elimination:	Elimination, selection









	habillage:	Dressing, selection









	transferts:	Transfers, selection









	deplacementexterieur:

		Deplacement External, selection









	gir:	GIR, char








Object: Drugs (health.drug)





	vidal:	vidal, boolean









	atc:	ATC, char









	forme:	Shape, many2one









	commentaire:	Comments, text









	description:	Description, text









	volume:	Volume, float









	uom_id:	Unit, many2one, required









	ucd:	UCD, char









	cip:	CIP, char









	categ_id:	Category, many2one, required









	famille:	family, many2one









	name:	name, char, required








Object: category (health.category)





	name:	name, char, required








Object: soins (health.care)





	name:	Care, char








Object: Type Evenement (health.evenement.type)





	name:	Event Type, char, required









	creator:	Users, many2one








Object: evenement (health.patient.evenement)





	date:	Date, datetime









	user_id:	User, many2one









	partner_id:	Patient, many2one









	description:	Description, text, required









	type_evenements:

		Event Type, many2one








Object: prescription (health.prescription)





	partner_id:	Patient, many2one









	user_id:	For seizure, many2one









	commentaire:	Comments, text









	prescripteur:	Doctor, many2one









	au:	to, date









	medicament:	Medicaments, many2one









	du:	from, date









	heure:	Time, char









	nbrprise:	Number per dose, char








Object: Tarif Absences (health.tarif.absences)





	name:	Reason of Absence, selection









	montant:	Absences Rate, float








Object: Regime (health.regime)





	parent_id:	parent, many2one









	code:	Regime Code, char









	child_ids:	Childs Category, one2many









	name:	Social security, char








Object: Output Type (health.exit)





	name:	reason, char








Object: absences (health.absences)





	user_id:	For seizure, many2one









	commentaire:	Comments, text









	facture:	Billed, boolean









	nbrjour:	Number of days, float, readonly









	au:	to, date









	categorie:	Category, selection









	du:	from, date









	partner_id:	Resident, many2one








Object: Resident (health.patient)





	ean13:	EAN, char






Barcode number for EAN8 EAN13 UPC JPC GTIN






	property_account_position:

		Fiscal Position, many2one






The fiscal position will determine taxes and the accounts used for the partner.






	nomusage:	Name use, char









	excise:	Exices Number, char









	ref_companies:	Companies that refers to partner, one2many









	pharmacie:	Pharmacy, many2one









	alddu:	from, date









	aidelogementndossier:

		File No., char









	property_product_pricelist:

		Sale Pricelist, many2one






This pricelist will be used, instead of the default one,                     for sales to the current partner






	property_account_payable:

		Account Payable, many2one, required






This account will be used instead of the default one as the payable account for the current partner






	title:	Title, selection









	vat_no:	VAT Number, char









	caissedu:	from, date









	participation_ids:

		Participations, one2many









	parent_id:	Main Company, many2one









	photo:	Resident Photo, binary









	ergo:	Ergonomist, many2one









	respcivil:	Civil Liability, char









	nom:	Name, char









	child_ids:	Partner Ref., one2many









	congregation:	Congregation, boolean









	date_liberation:

		Release date of the Board, date









	aidelogementdestinataire:

		Addressee, selection









	invaau:	to, date









	name:	Name, char, required









	debit_limit:	Payable Limit, float









	incineration:	Incineration, boolean









	aldtaux:	RATE A.L.D, float









	property_account_receivable:

		Account Receivable, many2one, required






This account will be used instead of the default one as the receivable account for the current partner






	date_sortie:	Date Release, date









	evenements:	events, one2many









	div:	Division, char









	ncpaiement:	Number Payment Center, char









	numerosecu:	Social Security Number, char









	aidesocialendossier:

		No Dossier, char









	logo:	Logo, binary









	invadu:	from, date









	religion:	Religion, many2one









	room_id:	Rooms, many2one









	aidesocialemontant:

		amount, float









	debit:	Total Payable, float, readonly






Total amount you have to pay to this supplier.






	supplier:	Supplier, boolean






Check this box if the partner is a supplier. If unchecked, purchasing staff will not see it when encoding a purchase order.






	ref:	Code, char, readonly









	obseque:	Obseques, char









	apamontant:	amount, float









	prescriptions:	prescriptions, one2many









	respau:	to, date









	address:	Contacts, one2many









	aidesocialeau:	to, date









	cmu:	C.M.U, many2one









	cst_no:	CST Number, char









	care:	Care, many2many









	aidelogementdu:	from, date









	prenom:	First Name, char









	country:	Country, many2one









	admission_date:	Date of admission, date









	credit:	Total Receivable, float, readonly






Total amount this customer owes you.






	range:	Range, char









	apadu:	from, date









	mutdu:	from, date









	signature:	Signature, binary









	comment:	Notes, text









	hopital:	Hopital, many2one









	aidesocialedestinataire:

		Addressee, selection









	header:	Header (.odt), binary









	motif_sortie:	Reason for Release, many2one









	apa:	APA, many2one









	aidelogementmontant:

		amount, float









	city:	City, char









	user_id:	Dedicated Salesman, many2one






The internal user that is in charge of communicating with this partner if any.






	nomreligieux:	Religious Name, char









	provenance:	Provenance, char









	cmundossier:	Nr File, char









	partner_ids:	Parent Companies, one2many









	vat:	VAT, char






Value Added Tax number. Check the box if the partner is subjected to the VAT. Used by the VAT legal statement.






	website:	Website, char









	aidesociale:	Social Assistance, many2one









	apadestinataire:

		Addressee, selection









	mutndossier:	Nr File, char









	pacemaker:	Pace Maker / C.I., boolean









	respdu:	from, date









	answers_ids:	Answers, many2many









	caisse:	Fund, many2one









	active:	Active, boolean









	cmudu:	from, date









	aldau:	to, date









	customer:	Customer, boolean






Check this box if the partner is a customer.






	apandossier:	Nr File, char









	kine:	Kine, many2one









	invalidite:	Disability, char









	situation:	Family situation, many2one









	birthdaydate:	Date of Birth, date









	relation_ids:	Relations, one2many









	medecin:	Doctor, many2one









	aidesocialedu:	from, date









	aidelogementau:	to, date









	regime:	Regime, many2one









	mutuelle:	Mutual, many2one









	absences:	Absences, one2many









	mutau:	to, date









	assure:	Assuree, many2one









	aidelogement:	Housing assistance, many2one









	pan_no:	PAN Number, char









	cmuau:	to, date









	note:	notes, text









	doncorps:	Body donation, boolean









	lieunaissance:	Place of birth, char









	girage:	GIR Billing, selection









	turnover_id:	Turnover, one2many









	donorganes:	Organ Donation, boolean









	events:	Events, one2many









	obsinformations:

		Informations, char









	bank_ids:	Banks, one2many









	laboratoire:	Laboratory, many2one









	ser_tax:	Service Tax Number, char









	apaau:	to, date









	date:	Date, date









	lang:	Language, selection






If the selected language is loaded in the system, all documents related to this partner will be printed in that language. If not, it will be English.






	caisseau:	to, date









	credit_limit:	Credit Limit, float









	hopitalant:	Hopital Ant., many2one









	psy:	psy, many2one









	livretremis:	Booklet Remis, boolean









	hospitalisation:

		In Hospitalization, boolean









	ambulance:	Ambulance, many2one









	property_payment_term:

		Payment Term, many2one






This payment term will be used instead of the default one for the current partner






	category_id:	Categories, many2many
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HeoFAX (hnm_heofax)





	Module:	hnm_heofax


	Name:	HeoFAX


	Version:	0.01


	Author:	Heonium


	Directory:	hnm_heofax


	Web:	http://www.heonium.com/contributions/developpement/envoyer-des-fax-avec-openerptinyerp.html


	Official module:

		no


	Quality certified:

		no






Description

Add a possibility (wizard) to FAX any documents (PDF/PS/Text) from OpenERP.
It get fax number and other information from OpenERP's partners database. To use this module
YOU NEED to decompress it in 'addons' directory. This is because you need to have a 'coverpage'
directory accessible to use it

Currently you can
---------------
- Send PDF/PS/TIFF documents (only one by one) from partner environment
to one or more recipient (mass fax mailing) (beware to disk space on hylafax
server).
- Send sale documents directly by FAX.
- Using or not FaxCover when sending.
- Define FaxCover by user or group.
- Chose FaxCover when you send fax.
- Possibility to record this operation in partner event.
- You receive by mail the status of your send (success or error)
- Send by fax sales doc. (sale order, confirmation order,  ...).'
- Send by fax purchases doc. (purchase order, confirmation purchase order,  ...).'

Install
-------
See README for details.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hnm_heofax.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hnm_heofax.zip]









Dependencies



	base

	sale

	purchase









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Hotel Housekeeping Management (hotel_housekeeping)





	Module:	hotel_housekeeping


	Name:	Hotel Housekeeping Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	hotel_housekeeping


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module for Hotel/Hotel Housekeeping. You can manage:
    * Housekeeping process
    * Housekeeping history room wise

      Different reports are also provided, mainly for hotel statistics.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hotel_housekeeping.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hotel_housekeeping.zip]









Dependencies



	hotel









Reports



	Activity Detail









Menus



	Hotel Management/Housekeeping

	Hotel Management/Housekeeping/New HouseKeeping

	Hotel Management/Configuration/Activity Types

	Hotel Management/Configuration/Activity Types/Activities

	Hotel Management/Reports/Activity Report









Views



	hotel.housekeeping.form (form)

	hotel.housekeeping.tree (tree)

	hotel_housekeeping_activity_type_form (form)

	hotel_housekeeping_activity_type_list (tree)

	h.activity.form (form)

	h.activity.tree (tree)









Objects


Object: Activity Type (hotel.housekeeping.activity.type)





	property_account_expense_categ:

		Expense Account, many2one






This account will be used to value outgoing stock for the current product category






	property_stock_journal:

		Stock journal, many2one






This journal will be used for the accounting move generated by stock move






	isroomtype:	Is Room Type, boolean









	activity_id:	category, many2one, required









	name:	Name, char, required









	sequence:	Sequence, integer









	isservicetype:	Is Service Type, boolean









	property_stock_account_input_categ:

		Stock Input Account, many2one






This account will be used to value the input stock






	parent_id:	Parent Category, many2one









	complete_name:	Name, char, readonly









	isactivitytype:	Is Activity Type, boolean









	property_account_income_categ:

		Income Account, many2one






This account will be used to value incoming stock for the current product category






	child_id:	Child Categories, one2many









	isamenitype:	Is amenities Type, boolean









	property_stock_account_output_categ:

		Stock Output Account, many2one






This account will be used to value the output stock





Object: Housekeeping Activity (h.activity)





	warranty:	Warranty (months), float









	property_stock_procurement:

		Procurement Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated by procurements






	uos_id:	Unit of Sale, many2one






Used by companies that manages two unit of measure: invoicing and stock management. For example, in food industries, you will manage a stock of ham but invoice in Kg. Keep empty to use the default UOM.






	list_price:	Sale Price, float






Base price for computing the customer price. Sometimes called the catalog price.






	ean13:	EAN13, char









	incoming_qty:	Incoming, float, readonly






Quantities of products that are planned to arrive in selected locations or all internal if none have been selected.






	standard_price:	Cost Price, float, required






The cost of the product for accounting stock valuation. It can serves as a base price for supplier price.






	mes_type:	Measure Type, selection, required









	code:	Code, char, readonly









	property_account_income:

		Income Account, many2one






This account will be used instead of the default one to value incoming stock for the current product






	qty_available:	Real Stock, float, readonly






Current quantities of products in selected locations or all internal if none have been selected.






	cost_method:	Costing Method, selection, required






Standard Price: the cost price is fixed and recomputed periodically (usually at the end of the year), Average Price: the cost price is recomputed at each reception of products.






	uos_coeff:	UOM -> UOS Coeff, float






Coefficient to convert UOM to UOS
uos = uom * coeff






	seller_delay:	Supplier Lead Time, integer, readonly






This is the average delay in days between the purchase order confirmation and the reception of goods for this product and for the default supplier. It is used by the scheduler to order requests based on reordering delays.






	purchase_ok:	Can be Purchased, boolean






Determine if the product is visible in the list of products within a selection from a purchase order line.






	product_manager:

		Product Manager, many2one









	company_id:	Company, many2one









	loc_rack:	Rack, char









	pricelist_sale:	Sale Pricelists, text, readonly









	type:	Product Type, selection, required






Will change the way procurements are processed. Consumables are stockable products with infinite stock, or for use when you have no stock management in the system.






	property_stock_account_input:

		Stock Input Account, many2one






This account will be used, instead of the default one, to value input stock






	track_incoming:	Track Incoming Lots, boolean






Force to use a Production Lot during receptions






	property_stock_production:

		Production Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated by production orders






	supplier_taxes_id:

		Supplier Taxes, many2many









	volume:	Volume, float






The volume in m3.






	outgoing_qty:	Outgoing, float, readonly






Quantities of products that are planned to leave in selected locations or all internal if none have been selected.






	procure_method:	Procure Method, selection, required






‘Make to Stock’: When needed, take from the stock or wait until re-supplying. ‘Make to Order’: When needed, purchase or produce for the procurement request.






	property_stock_inventory:

		Inventory Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated when you do an inventory






	variants:	Variants, char









	partner_ref:	Customer ref, char, readonly









	rental:	Rentable Product, boolean









	packaging:	Logistical Units, one2many






Gives the different ways to package the same product. This has no impact on the packing order and is mainly used if you use the EDI module.






	sale_delay:	Customer Lead Time, float






This is the average time between the confirmation of the customer order and the delivery of the finished products. It’s the time you promise to your customers.






	pricelist_purchase:

		Purchase Pricelists, text, readonly









	name:	Name, char, required









	description_sale:

		Sale Description, text









	property_stock_account_output:

		Stock Output Account, many2one






This account will be used, instead of the default one, to value output stock






	seller_ids:	Partners, one2many









	isroom:	Is Room, boolean









	isservice:	Is Service id, boolean









	track_production:

		Track Production Lots, boolean






Force to use a Production Lot during production order






	supply_method:	Supply method, selection, required






Produce will generate production order or tasks, according to the product type. Purchase will trigger purchase orders when requested.






	weight:	Gross weight, float






The gross weight in Kg.






	price_extra:	Variant Price Extra, float









	uom_id:	Default UoM, many2one, required






Default Unit of Measure used for all stock operation.






	description_purchase:

		Purchase Description, text









	default_code:	Code, char









	iscategid:	Is categ id, boolean









	virtual_available:

		Virtual Stock, float, readonly






Future stock for this product according to the selected location or all internal if none have been selected. Computed as: Real Stock - Outgoing + Incoming.






	isact:	Is Activity, boolean









	track_outgoing:	Track Outgoing Lots, boolean






Force to use a Production Lot during deliveries






	product_tmpl_id:

		Product Template, many2one, required









	state:	Status, selection






Tells the user if he can use the product or not.






	h_id:	Product_id, many2one









	uom_po_id:	Purchase UoM, many2one, required






Default Unit of Measure used for purchase orders. It must be in the same category as the default unit of measure.






	weight_net:	Net weight, float






The net weight in Kg.






	description:	Description, text









	price:	Customer Price, float, readonly









	active:	Active, boolean









	loc_row:	Row, char









	sale_ok:	Can be sold, boolean






Determine if the product can be visible in the list of product within a selection from a sale order line.






	loc_case:	Case, char









	produce_delay:	Manufacturing Lead Time, float






Average time to produce this product. This is only for the production order and, if it is a multi-level bill of material, it’s only for the level of this product. Different delays will be summed for all levels and purchase orders.






	property_account_expense:

		Expense Account, many2one






This account will be used instead of the default one to value outgoing stock for the current product






	categ_id:	Category, many2one, required









	lst_price:	List Price, float, readonly









	taxes_id:	Customer Taxes, many2many









	price_margin:	Variant Price Margin, float








Object: Reservation (hotel.housekeeping)





	room_no:	Room No, many2one, required









	quality:	Quality, selection, required









	current_date:	Today’s Date, date, required









	activity_lines:	Activities, one2many









	state:	state, selection, required, readonly









	inspect_date_time:

		Inspect Date Time, datetime, required









	inspector:	Inspector, many2one, required









	clean_type:	Clean Type, selection, required








Object: Housekeeping Activities  (hotel.housekeeping.activities)





	a_list:	unknown, many2one









	housekeeper:	Housekeeper, many2one, required









	clean_start_time:

		Clean Start Time, datetime, required









	clean_end_time:	Clean End Time, datetime, required









	dirty:	Dirty, boolean









	clean:	Clean, boolean









	activity_name:	Housekeeping Activity, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Hotel Reservation Management (hotel_reservation)





	Module:	hotel_reservation


	Name:	Hotel Reservation Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	hotel_reservation


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module for Hotel/Resort/Property management. You can manage:
    * Guest Reservation
    * Group Reservation
      Different reports are also provided, mainly for hotel statistics.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hotel_reservation.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hotel_reservation.zip]









Dependencies



	hotel









Reports



	Reservation Detail

	CheckOut Detail

	Max Room Detail









Menus



	Hotel Management/All Reservation

	Hotel Management/All Reservation/New Reservation

	Hotel Management/All Reservation/All Draft Reservation

	Hotel Management/All Reservation/All Confirm Reservation

	Hotel Management/All Reservation/All Done Reservation

	Hotel Management/Reports/Hotel Reservation Report









Views



	hotel.reservation.form (form)

	hotel.reservation.tree (tree)

	hotel.reservation.graph (graph)

	Room Reservation (calendar)









Objects


Object: Reservation (hotel.reservation)





	dummy:	Dummy, datetime









	childs:	Childs, integer, readonly









	adults:	Adults, integer, readonly









	partner_shipping_id:

		Shipping Address, many2one, required, readonly









	folio_id:	Folio, many2many









	checkin:	Expected-Date-Arrival, datetime, required, readonly









	reservation_line:

		Reservation Line, one2many









	partner_order_id:

		Ordering Contact, many2one, required, readonly






The name and address of the contact that requested the order or quotation.






	state:	State, selection, readonly









	shop_id:	Shop, many2one, required, readonly









	checkout:	Expected-Date-Departure, datetime, required, readonly









	partner_invoice_id:

		Invoice Address, many2one, required, readonly









	pricelist_id:	Pricelist, many2one, required, readonly









	date_order:	Date Ordered, datetime, required, readonly









	partner_id:	Guest Name, many2one, required, readonly









	reservation_no:	Reservation No, char, required








Object: Reservation Line (hotel_reservation.line)





	line_id:	unknown, many2one









	categ_id:	Room Type, many2one









	reserve:	unknown, many2many
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Hotel Restaurant Management (hotel_restaurant)





	Module:	hotel_restaurant


	Name:	Hotel Restaurant Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	hotel_restaurant


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module for Hotel/Resort/Restaurant management. You can manage:
    * Configure Property
    * Restaurant Configuration
    * table reservation
    * Generate and process Kitchen Order ticket,
    * Payment

    Different reports are also provided, mainly for Restaurant.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hotel_restaurant.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hotel_restaurant.zip]









Dependencies



	base

	hotel









Reports



	Kitchen Order Tickets

	Customer Bill

	Table Reservation List









Menus



	Hotel Management/Restaurant

	Hotel Management/Configuration/Tables

	Hotel Management/Restaurant/Table Booking

	Hotel Management/Restaurant/Orders

	Hotel Management/Restaurant/Table Order

	Hotel Management/Restaurant/KOT

	Hotel Management/Configuration/FoodItem Types

	Hotel Management/Configuration/FoodItem Types/Food Items

	Hotel Management/Reports/Table Reservation List









Views



	hotel_restaurant_tables.form (form)

	hotel_restaurant_tables.tree (tree)

	hotel_restaurant_reservation.form (form)

	hotel_restaurant_reservation.tree (tree)

	hotel_reservation_order.form (form)

	hotel_reservation_order.tree (tree)

	hotel_restaurant_order.form (form)

	hotel_restaurant_order.tree (tree)

	hotel_restaurant_kitchen_order_tickets.form (form)

	hotel_restaurant_kitchen_order_tickets.tree (tree)

	hotel_menucard_type_form (form)

	hotel_menucard_type_list (tree)

	hotel.menucard.form (form)

	hotel.menucard.tree (tree)









Objects


Object: amenities Type (hotel.menucard.type)





	menu_id:	category, many2one, required









	property_account_expense_categ:

		Expense Account, many2one






This account will be used to value outgoing stock for the current product category






	property_stock_journal:

		Stock journal, many2one






This journal will be used for the accounting move generated by stock move






	isroomtype:	Is Room Type, boolean









	name:	Name, char, required









	ismenutype:	Is Menu Type, boolean









	sequence:	Sequence, integer









	isservicetype:	Is Service Type, boolean









	property_stock_account_input_categ:

		Stock Input Account, many2one






This account will be used to value the input stock






	parent_id:	Parent Category, many2one









	complete_name:	Name, char, readonly









	property_account_income_categ:

		Income Account, many2one






This account will be used to value incoming stock for the current product category






	child_id:	Child Categories, one2many









	isamenitype:	Is amenities Type, boolean









	property_stock_account_output_categ:

		Stock Output Account, many2one






This account will be used to value the output stock





Object: Hotel Menucard (hotel.menucard)





	warranty:	Warranty (months), float









	property_stock_procurement:

		Procurement Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated by procurements






	uos_id:	Unit of Sale, many2one






Used by companies that manages two unit of measure: invoicing and stock management. For example, in food industries, you will manage a stock of ham but invoice in Kg. Keep empty to use the default UOM.






	list_price:	Sale Price, float






Base price for computing the customer price. Sometimes called the catalog price.






	ean13:	EAN13, char









	incoming_qty:	Incoming, float, readonly






Quantities of products that are planned to arrive in selected locations or all internal if none have been selected.






	standard_price:	Cost Price, float, required






The cost of the product for accounting stock valuation. It can serves as a base price for supplier price.






	mes_type:	Measure Type, selection, required









	code:	Code, char, readonly









	property_account_income:

		Income Account, many2one






This account will be used instead of the default one to value incoming stock for the current product






	qty_available:	Real Stock, float, readonly






Current quantities of products in selected locations or all internal if none have been selected.






	cost_method:	Costing Method, selection, required






Standard Price: the cost price is fixed and recomputed periodically (usually at the end of the year), Average Price: the cost price is recomputed at each reception of products.






	uos_coeff:	UOM -> UOS Coeff, float






Coefficient to convert UOM to UOS
uos = uom * coeff






	seller_delay:	Supplier Lead Time, integer, readonly






This is the average delay in days between the purchase order confirmation and the reception of goods for this product and for the default supplier. It is used by the scheduler to order requests based on reordering delays.






	purchase_ok:	Can be Purchased, boolean






Determine if the product is visible in the list of products within a selection from a purchase order line.






	product_manager:

		Product Manager, many2one









	company_id:	Company, many2one









	loc_rack:	Rack, char









	pricelist_sale:	Sale Pricelists, text, readonly









	ismenucard:	Is Room, boolean









	type:	Product Type, selection, required






Will change the way procurements are processed. Consumables are stockable products with infinite stock, or for use when you have no stock management in the system.






	property_stock_account_input:

		Stock Input Account, many2one






This account will be used, instead of the default one, to value input stock






	track_incoming:	Track Incoming Lots, boolean






Force to use a Production Lot during receptions






	property_stock_production:

		Production Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated by production orders






	supplier_taxes_id:

		Supplier Taxes, many2many









	volume:	Volume, float






The volume in m3.






	outgoing_qty:	Outgoing, float, readonly






Quantities of products that are planned to leave in selected locations or all internal if none have been selected.






	procure_method:	Procure Method, selection, required






‘Make to Stock’: When needed, take from the stock or wait until re-supplying. ‘Make to Order’: When needed, purchase or produce for the procurement request.






	property_stock_inventory:

		Inventory Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated when you do an inventory






	variants:	Variants, char









	partner_ref:	Customer ref, char, readonly









	rental:	Rentable Product, boolean









	product_id:	Product_id, many2one









	packaging:	Logistical Units, one2many






Gives the different ways to package the same product. This has no impact on the packing order and is mainly used if you use the EDI module.






	sale_delay:	Customer Lead Time, float






This is the average time between the confirmation of the customer order and the delivery of the finished products. It’s the time you promise to your customers.






	pricelist_purchase:

		Purchase Pricelists, text, readonly









	name:	Name, char, required









	description_sale:

		Sale Description, text









	property_stock_account_output:

		Stock Output Account, many2one






This account will be used, instead of the default one, to value output stock






	seller_ids:	Partners, one2many









	isroom:	Is Room, boolean









	isservice:	Is Service id, boolean









	track_production:

		Track Production Lots, boolean






Force to use a Production Lot during production order






	supply_method:	Supply method, selection, required






Produce will generate production order or tasks, according to the product type. Purchase will trigger purchase orders when requested.






	weight:	Gross weight, float






The gross weight in Kg.






	price_extra:	Variant Price Extra, float









	uom_id:	Default UoM, many2one, required






Default Unit of Measure used for all stock operation.






	description_purchase:

		Purchase Description, text









	default_code:	Code, char









	iscategid:	Is categ id, boolean









	virtual_available:

		Virtual Stock, float, readonly






Future stock for this product according to the selected location or all internal if none have been selected. Computed as: Real Stock - Outgoing + Incoming.






	track_outgoing:	Track Outgoing Lots, boolean






Force to use a Production Lot during deliveries






	product_tmpl_id:

		Product Template, many2one, required









	state:	Status, selection






Tells the user if he can use the product or not.






	uom_po_id:	Purchase UoM, many2one, required






Default Unit of Measure used for purchase orders. It must be in the same category as the default unit of measure.






	weight_net:	Net weight, float






The net weight in Kg.






	description:	Description, text









	price:	Customer Price, float, readonly









	active:	Active, boolean









	loc_row:	Row, char









	sale_ok:	Can be sold, boolean






Determine if the product can be visible in the list of product within a selection from a sale order line.






	loc_case:	Case, char









	produce_delay:	Manufacturing Lead Time, float






Average time to produce this product. This is only for the production order and, if it is a multi-level bill of material, it’s only for the level of this product. Different delays will be summed for all levels and purchase orders.






	property_account_expense:

		Expense Account, many2one






This account will be used instead of the default one to value outgoing stock for the current product






	categ_id:	Category, many2one, required









	lst_price:	List Price, float, readonly









	taxes_id:	Customer Taxes, many2many









	price_margin:	Variant Price Margin, float








Object: Includes Hotel Restaurant Table (hotel.restaurant.tables)





	capacity:	Capacity, integer









	name:	Table number, char, required








Object: Includes Hotel Restaurant Reservation (hotel.restaurant.reservation)





	room_no:	Room No, many2one









	end_date:	End Date, datetime, required









	tableno:	Table number, many2many









	partner_address_id:

		Address, many2one









	state:	state, selection, required, readonly









	cname:	Customer Name, many2one, required









	reservation_id:	Reservation No, char, required









	start_date:	Start Date, datetime, required








Object: Includes Hotel Restaurant Order (hotel.restaurant.kitchen.order.tickets)





	tableno:	Table number, many2many









	room_no:	Room No, char, readonly









	w_name:	Waiter Name, char, readonly









	kot_date:	Date, datetime









	orderno:	Order Number, char, readonly









	resno:	Reservation Number, char









	kot_list:	Order List, one2many








Object: Includes Hotel Restaurant Order (hotel.restaurant.order)





	order_no:	Order Number, char, required









	room_no:	Room No, many2one









	tax:	Tax (%) , float









	table_no:	Table number, many2many









	amount_subtotal:

		Subtotal, float, readonly









	o_date:	Date, datetime, required









	order_list:	Order List, one2many









	amount_total:	Total, float, readonly









	waiter_name:	Waiter Name, many2one, required








Object: Reservation Order (hotel.reservation.order)





	date1:	Date, datetime, required









	waitername:	Waiter Name, many2one









	amount_subtotal:

		Subtotal, float, readonly









	reservationno:	Reservation No, char









	tax:	Tax (%) , float









	order_list:	Order List, one2many









	order_number:	Order No, char









	table_no:	Table number, many2many









	amount_total:	Total, float, readonly








Object: Includes Hotel Restaurant Order (hotel.restaurant.order.list)





	o_list:	unknown, many2one









	item_qty:	Qty, char, required









	name:	Item Name, many2one, required









	kot_order_list:	unknown, many2one









	price_subtotal:	Subtotal, float, readonly









	o_l:	unknown, many2one









	item_rate:	Rate, float
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Hotel Management (hotel)





	Module:	hotel


	Name:	Hotel Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	hotel


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module for Hotel/Resort/Property management. You can manage:
    * Configure Property
    * Hotel Configuration
    * Check In, Check out
    * Manage Folio
    * Payment

    Different reports are also provided, mainly for hotel statistics.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hotel.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hotel.zip]









Dependencies



	base

	product

	sale









Reports



	Folio Total









Menus



	Hotel Management

	Hotel Management/Configuration

	Hotel Management/Reports

	Hotel Management/Configuration/Floor

	Hotel Management/Configuration/Amenity Types

	Hotel Management/Configuration/Amenity Types/Amenities

	Hotel Management/Configuration/Room Types

	Hotel Management/Configuration/Room Types/Rooms

	Hotel Management/Configuration/Service Types

	Hotel Management/Configuration/Service Types/Services

	Hotel Management/All Folio

	Hotel Management/All Folio/Generate Folio

	Hotel Management/Configuration/Room Types/Room by Category

	Hotel Management/Configuration/Amenity Types/Amenities by Category

	Hotel Management/Configuration/Service Types/Services by Category

	Hotel Management/Reports/Hotel Folio Report









Views



	hotel.floor.form (form)

	hotel.floor.tree (tree)

	hotel.room_amenities_type_form (form)

	hotel.room_amenities_type_list (tree)

	hotel.room_amenities_form (form)

	hotel.room_amenities_list (tree)

	hotel.room_type.form (form)

	hotel.room_type.tree (tree)

	hotel.room.form (form)

	hotel.room.tree (tree)

	hotel.service_type.form (form)

	hotel.service_type.tree (tree)

	.hotel.services.form (form)

	hotel.services.tree (tree)

	hotel.folio.form (form)

	hotel.folio.tree (tree)









Objects


Object: Floor (hotel.floor)





	name:	Floor Name, char, required









	sequence:	Sequence, integer








Object: Room Type (hotel.room_type)





	property_account_expense_categ:

		Expense Account, many2one






This account will be used to value outgoing stock for the current product category






	property_stock_journal:

		Stock journal, many2one






This journal will be used for the accounting move generated by stock move






	isroomtype:	Is Room Type, boolean









	name:	Name, char, required









	sequence:	Sequence, integer









	cat_id:	category, many2one, required









	isservicetype:	Is Service Type, boolean









	property_stock_account_input_categ:

		Stock Input Account, many2one






This account will be used to value the input stock






	parent_id:	Parent Category, many2one









	complete_name:	Name, char, readonly









	property_account_income_categ:

		Income Account, many2one






This account will be used to value incoming stock for the current product category






	child_id:	Child Categories, one2many









	isamenitype:	Is amenities Type, boolean









	property_stock_account_output_categ:

		Stock Output Account, many2one






This account will be used to value the output stock





Object: amenities Type (hotel.room_amenities_type)





	property_account_expense_categ:

		Expense Account, many2one






This account will be used to value outgoing stock for the current product category






	property_stock_journal:

		Stock journal, many2one






This journal will be used for the accounting move generated by stock move






	isroomtype:	Is Room Type, boolean









	name:	Name, char, required









	sequence:	Sequence, integer









	cat_id:	category, many2one, required









	isservicetype:	Is Service Type, boolean









	property_stock_account_input_categ:

		Stock Input Account, many2one






This account will be used to value the input stock






	parent_id:	Parent Category, many2one









	complete_name:	Name, char, readonly









	property_account_income_categ:

		Income Account, many2one






This account will be used to value incoming stock for the current product category






	child_id:	Child Categories, one2many









	isamenitype:	Is amenities Type, boolean









	property_stock_account_output_categ:

		Stock Output Account, many2one






This account will be used to value the output stock





Object: Room amenities (hotel.room_amenities)





	warranty:	Warranty (months), float









	property_stock_procurement:

		Procurement Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated by procurements






	uos_id:	Unit of Sale, many2one






Used by companies that manages two unit of measure: invoicing and stock management. For example, in food industries, you will manage a stock of ham but invoice in Kg. Keep empty to use the default UOM.






	list_price:	Sale Price, float






Base price for computing the customer price. Sometimes called the catalog price.






	ean13:	EAN13, char









	incoming_qty:	Incoming, float, readonly






Quantities of products that are planned to arrive in selected locations or all internal if none have been selected.






	standard_price:	Cost Price, float, required






The cost of the product for accounting stock valuation. It can serves as a base price for supplier price.






	mes_type:	Measure Type, selection, required









	code:	Code, char, readonly









	property_account_income:

		Income Account, many2one






This account will be used instead of the default one to value incoming stock for the current product






	qty_available:	Real Stock, float, readonly






Current quantities of products in selected locations or all internal if none have been selected.






	cost_method:	Costing Method, selection, required






Standard Price: the cost price is fixed and recomputed periodically (usually at the end of the year), Average Price: the cost price is recomputed at each reception of products.






	uos_coeff:	UOM -> UOS Coeff, float






Coefficient to convert UOM to UOS
uos = uom * coeff






	seller_delay:	Supplier Lead Time, integer, readonly






This is the average delay in days between the purchase order confirmation and the reception of goods for this product and for the default supplier. It is used by the scheduler to order requests based on reordering delays.






	purchase_ok:	Can be Purchased, boolean






Determine if the product is visible in the list of products within a selection from a purchase order line.






	product_manager:

		Product Manager, many2one









	company_id:	Company, many2one









	loc_rack:	Rack, char









	pricelist_sale:	Sale Pricelists, text, readonly









	type:	Product Type, selection, required






Will change the way procurements are processed. Consumables are stockable products with infinite stock, or for use when you have no stock management in the system.






	property_stock_account_input:

		Stock Input Account, many2one






This account will be used, instead of the default one, to value input stock






	track_incoming:	Track Incoming Lots, boolean






Force to use a Production Lot during receptions






	property_stock_production:

		Production Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated by production orders






	supplier_taxes_id:

		Supplier Taxes, many2many









	volume:	Volume, float






The volume in m3.






	outgoing_qty:	Outgoing, float, readonly






Quantities of products that are planned to leave in selected locations or all internal if none have been selected.






	procure_method:	Procure Method, selection, required






‘Make to Stock’: When needed, take from the stock or wait until re-supplying. ‘Make to Order’: When needed, purchase or produce for the procurement request.






	property_stock_inventory:

		Inventory Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated when you do an inventory






	variants:	Variants, char









	partner_ref:	Customer ref, char, readonly









	rental:	Rentable Product, boolean









	packaging:	Logistical Units, one2many






Gives the different ways to package the same product. This has no impact on the packing order and is mainly used if you use the EDI module.






	sale_delay:	Customer Lead Time, float






This is the average time between the confirmation of the customer order and the delivery of the finished products. It’s the time you promise to your customers.






	pricelist_purchase:

		Purchase Pricelists, text, readonly









	name:	Name, char, required









	description_sale:

		Sale Description, text









	property_stock_account_output:

		Stock Output Account, many2one






This account will be used, instead of the default one, to value output stock






	seller_ids:	Partners, one2many









	amenity_rate:	Amenity Rate, integer









	isroom:	Is Room, boolean









	isservice:	Is Service id, boolean









	track_production:

		Track Production Lots, boolean






Force to use a Production Lot during production order






	supply_method:	Supply method, selection, required






Produce will generate production order or tasks, according to the product type. Purchase will trigger purchase orders when requested.






	weight:	Gross weight, float






The gross weight in Kg.






	price_extra:	Variant Price Extra, float









	uom_id:	Default UoM, many2one, required






Default Unit of Measure used for all stock operation.






	description_purchase:

		Purchase Description, text









	default_code:	Code, char









	iscategid:	Is categ id, boolean









	virtual_available:

		Virtual Stock, float, readonly






Future stock for this product according to the selected location or all internal if none have been selected. Computed as: Real Stock - Outgoing + Incoming.






	track_outgoing:	Track Outgoing Lots, boolean






Force to use a Production Lot during deliveries






	product_tmpl_id:

		Product Template, many2one, required









	state:	Status, selection






Tells the user if he can use the product or not.






	uom_po_id:	Purchase UoM, many2one, required






Default Unit of Measure used for purchase orders. It must be in the same category as the default unit of measure.






	weight_net:	Net weight, float






The net weight in Kg.






	description:	Description, text









	price:	Customer Price, float, readonly









	rcateg_id:	Amenity Category, many2one









	room_categ_id:	Product Category, many2one, required









	active:	Active, boolean









	loc_row:	Row, char









	sale_ok:	Can be sold, boolean






Determine if the product can be visible in the list of product within a selection from a sale order line.






	loc_case:	Case, char









	produce_delay:	Manufacturing Lead Time, float






Average time to produce this product. This is only for the production order and, if it is a multi-level bill of material, it’s only for the level of this product. Different delays will be summed for all levels and purchase orders.






	property_account_expense:

		Expense Account, many2one






This account will be used instead of the default one to value outgoing stock for the current product






	categ_id:	Category, many2one, required









	lst_price:	List Price, float, readonly









	taxes_id:	Customer Taxes, many2many









	price_margin:	Variant Price Margin, float








Object: Hotel Room (hotel.room)





	warranty:	Warranty (months), float









	property_stock_procurement:

		Procurement Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated by procurements






	uos_id:	Unit of Sale, many2one






Used by companies that manages two unit of measure: invoicing and stock management. For example, in food industries, you will manage a stock of ham but invoice in Kg. Keep empty to use the default UOM.






	list_price:	Sale Price, float






Base price for computing the customer price. Sometimes called the catalog price.






	ean13:	EAN13, char









	incoming_qty:	Incoming, float, readonly






Quantities of products that are planned to arrive in selected locations or all internal if none have been selected.






	standard_price:	Cost Price, float, required






The cost of the product for accounting stock valuation. It can serves as a base price for supplier price.






	mes_type:	Measure Type, selection, required









	code:	Code, char, readonly









	room_amenities:	Room Amenities, many2many









	property_account_income:

		Income Account, many2one






This account will be used instead of the default one to value incoming stock for the current product






	qty_available:	Real Stock, float, readonly






Current quantities of products in selected locations or all internal if none have been selected.






	cost_method:	Costing Method, selection, required






Standard Price: the cost price is fixed and recomputed periodically (usually at the end of the year), Average Price: the cost price is recomputed at each reception of products.






	maxAdult:	Max Adult, integer









	uos_coeff:	UOM -> UOS Coeff, float






Coefficient to convert UOM to UOS
uos = uom * coeff






	seller_delay:	Supplier Lead Time, integer, readonly






This is the average delay in days between the purchase order confirmation and the reception of goods for this product and for the default supplier. It is used by the scheduler to order requests based on reordering delays.






	purchase_ok:	Can be Purchased, boolean






Determine if the product is visible in the list of products within a selection from a purchase order line.






	product_manager:

		Product Manager, many2one









	company_id:	Company, many2one









	loc_rack:	Rack, char









	pricelist_sale:	Sale Pricelists, text, readonly









	type:	Product Type, selection, required






Will change the way procurements are processed. Consumables are stockable products with infinite stock, or for use when you have no stock management in the system.






	property_stock_account_input:

		Stock Input Account, many2one






This account will be used, instead of the default one, to value input stock






	track_incoming:	Track Incoming Lots, boolean






Force to use a Production Lot during receptions






	property_stock_production:

		Production Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated by production orders






	supplier_taxes_id:

		Supplier Taxes, many2many









	volume:	Volume, float






The volume in m3.






	outgoing_qty:	Outgoing, float, readonly






Quantities of products that are planned to leave in selected locations or all internal if none have been selected.






	procure_method:	Procure Method, selection, required






‘Make to Stock’: When needed, take from the stock or wait until re-supplying. ‘Make to Order’: When needed, purchase or produce for the procurement request.






	property_stock_inventory:

		Inventory Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated when you do an inventory






	variants:	Variants, char









	partner_ref:	Customer ref, char, readonly









	rental:	Rentable Product, boolean









	product_id:	Product_id, many2one









	packaging:	Logistical Units, one2many






Gives the different ways to package the same product. This has no impact on the packing order and is mainly used if you use the EDI module.






	sale_delay:	Customer Lead Time, float






This is the average time between the confirmation of the customer order and the delivery of the finished products. It’s the time you promise to your customers.






	pricelist_purchase:

		Purchase Pricelists, text, readonly









	name:	Name, char, required









	description_sale:

		Sale Description, text









	floor_id:	Floor No, many2one









	property_stock_account_output:

		Stock Output Account, many2one






This account will be used, instead of the default one, to value output stock






	seller_ids:	Partners, one2many









	isroom:	Is Room, boolean









	isservice:	Is Service id, boolean









	track_production:

		Track Production Lots, boolean






Force to use a Production Lot during production order






	supply_method:	Supply method, selection, required






Produce will generate production order or tasks, according to the product type. Purchase will trigger purchase orders when requested.






	weight:	Gross weight, float






The gross weight in Kg.






	maxChild:	Max Child, integer









	price_extra:	Variant Price Extra, float









	uom_id:	Default UoM, many2one, required






Default Unit of Measure used for all stock operation.






	description_purchase:

		Purchase Description, text









	default_code:	Code, char









	iscategid:	Is categ id, boolean









	virtual_available:

		Virtual Stock, float, readonly






Future stock for this product according to the selected location or all internal if none have been selected. Computed as: Real Stock - Outgoing + Incoming.






	track_outgoing:	Track Outgoing Lots, boolean






Force to use a Production Lot during deliveries






	product_tmpl_id:

		Product Template, many2one, required









	state:	Status, selection






Tells the user if he can use the product or not.






	uom_po_id:	Purchase UoM, many2one, required






Default Unit of Measure used for purchase orders. It must be in the same category as the default unit of measure.






	weight_net:	Net weight, float






The net weight in Kg.






	description:	Description, text









	price:	Customer Price, float, readonly









	active:	Active, boolean









	loc_row:	Row, char









	sale_ok:	Can be sold, boolean






Determine if the product can be visible in the list of product within a selection from a sale order line.






	loc_case:	Case, char









	produce_delay:	Manufacturing Lead Time, float






Average time to produce this product. This is only for the production order and, if it is a multi-level bill of material, it’s only for the level of this product. Different delays will be summed for all levels and purchase orders.






	property_account_expense:

		Expense Account, many2one






This account will be used instead of the default one to value outgoing stock for the current product






	categ_id:	Category, many2one, required









	lst_price:	List Price, float, readonly









	taxes_id:	Customer Taxes, many2many









	avail_status:	Room Status, selection









	price_margin:	Variant Price Margin, float








Object: hotel folio new (hotel.folio)





	origin:	Origin, char









	incoterm:	Incoterm, selection









	checkin_date:	Check In, datetime, required, readonly









	order_line:	Order Lines, one2many, readonly









	picking_policy:	Packing Policy, selection, required






If you don’t have enough stock available to deliver all at once, do you accept partial shipments or not?






	order_policy:	Shipping Policy, selection, required, readonly






The Shipping Policy is used to synchronise invoice and delivery operations.
- The ‘Pay before delivery’ choice will first generate the invoice and then generate the packing order after the payment of this invoice.
- The ‘Shipping & Manual Invoice’ will create the packing order directly and wait for the user to manually click on the ‘Invoice’ button to generate the draft invoice.
- The ‘Invoice on Order After Delivery’ choice will generate the draft invoice based on sale order after all packing lists have been finished.
- The ‘Invoice from the packing’ choice is used to create an invoice during the packing process.






	checkout_date:	Check Out, datetime, required, readonly









	partner_order_id:

		Ordering Contact, many2one, required, readonly






The name and address of the contact that requested the order or quotation.






	picked_rate:	Picked, float, readonly









	invoice_ids:	Invoices, many2many






This is the list of invoices that have been generated for this sale order. The same sale order may have been invoiced in several times (by line for example).






	shop_id:	Shop, many2one, required, readonly









	client_order_ref:

		Customer Ref, char









	partner_invoice_id:

		Invoice Address, many2one, required, readonly









	user_id:	Salesman, many2one









	date_order:	Date Ordered, date, required, readonly









	partner_id:	Customer, many2one, required, readonly









	picking_ids:	Related Packing, one2many, readonly






This is the list of picking list that have been generated for this invoice






	invoiced:	Paid, boolean, readonly









	note:	Notes, text









	fiscal_position:

		Fiscal Position, many2one









	amount_untaxed:	Untaxed Amount, float, readonly









	name:	Order Reference, char, required









	partner_shipping_id:

		Shipping Address, many2one, required, readonly









	payment_term:	Payment Term, many2one









	shipped:	Picked, boolean, readonly









	amount_tax:	Taxes, float, readonly









	order_id:	order_id, many2one, required









	state:	Order State, selection, readonly






Gives the state of the quotation or sale order. The exception state is automatically set when a cancel operation occurs in the invoice validation (Invoice Exception) or in the packing list process (Shipping Exception). The ‘Waiting Schedule’ state is set when the invoice is confirmed but waiting for the scheduler to run on the date ‘Date Ordered’.






	invoice_quantity:

		Invoice on, selection, required






The sale order will automatically create the invoice proposition (draft invoice). Ordered and delivered quantities may not be the same. You have to choose if you invoice based on ordered or shipped quantities. If the product is a service, shipped quantities means hours spent on the associated tasks.






	invoiced_rate:	Invoiced, float, readonly









	service_lines:	unknown, one2many









	pricelist_id:	Pricelist, many2one, required, readonly









	amount_total:	Total, float, readonly









	project_id:	Analytic Account, many2one, readonly









	room_lines:	unknown, one2many








Object: hotel folio1 room line (hotel_folio.line)





	property_ids:	Properties, many2many, readonly









	product_uos_qty:

		Quantity (UoS), float, readonly









	procurement_id:	Procurement, many2one









	checkin_date:	Check In, datetime, required









	product_uom:	Product UoM, many2one, required, readonly









	sequence:	Sequence, integer









	order_id:	Order Ref, many2one, required, readonly









	price_unit:	Unit Price, float, required, readonly









	product_uom_qty:

		Quantity (UoM), float, required, readonly









	price_subtotal:	Subtotal, float, readonly









	discount:	Discount (%), float, readonly









	product_uos:	Product UoS, many2one









	price_net:	Net Price, float, readonly









	number_packages:

		Number Packages, integer, readonly









	invoiced:	Invoiced, boolean, readonly









	delay:	Delivery Lead Time, float, required, readonly






Number of days between the order confirmation and the shipping of the products to the customer






	product_id:	Product, many2one









	invoice_lines:	Invoice Lines, many2many, readonly









	folio_id:	folio_id, many2one









	notes:	Notes, text









	name:	Description, char, required, readonly









	move_ids:	Inventory Moves, one2many, readonly









	state:	Status, selection, required, readonly









	order_partner_id:

		Customer, many2one









	th_weight:	Weight, float, readonly









	product_packaging:

		Packaging, many2one









	checkout_date:	Check Out, datetime, required









	tax_id:	Taxes, many2many, readonly









	type:	Procure Method, selection, required, readonly









	order_line_id:	order_line_id, many2one, required









	address_allotment_id:

		Allotment Partner, many2one








Object: hotel Service line (hotel_service.line)





	property_ids:	Properties, many2many, readonly









	product_uos_qty:

		Quantity (UoS), float, readonly









	procurement_id:	Procurement, many2one









	product_uom:	Product UoM, many2one, required, readonly









	sequence:	Sequence, integer









	order_id:	Order Ref, many2one, required, readonly









	price_unit:	Unit Price, float, required, readonly









	product_uom_qty:

		Quantity (UoM), float, required, readonly









	price_subtotal:	Subtotal, float, readonly









	service_line_id:

		service_line_id, many2one, required









	discount:	Discount (%), float, readonly









	product_uos:	Product UoS, many2one









	price_net:	Net Price, float, readonly









	number_packages:

		Number Packages, integer, readonly









	invoiced:	Invoiced, boolean, readonly









	delay:	Delivery Lead Time, float, required, readonly






Number of days between the order confirmation and the shipping of the products to the customer






	product_id:	Product, many2one









	invoice_lines:	Invoice Lines, many2many, readonly









	folio_id:	folio_id, many2one









	notes:	Notes, text









	name:	Description, char, required, readonly









	move_ids:	Inventory Moves, one2many, readonly









	state:	Status, selection, required, readonly









	order_partner_id:

		Customer, many2one









	th_weight:	Weight, float, readonly









	product_packaging:

		Packaging, many2one









	tax_id:	Taxes, many2many, readonly









	type:	Procure Method, selection, required, readonly









	address_allotment_id:

		Allotment Partner, many2one








Object: Service Type (hotel.service_type)





	property_account_expense_categ:

		Expense Account, many2one






This account will be used to value outgoing stock for the current product category






	property_stock_journal:

		Stock journal, many2one






This journal will be used for the accounting move generated by stock move






	isroomtype:	Is Room Type, boolean









	name:	Name, char, required









	sequence:	Sequence, integer









	ser_id:	category, many2one, required









	isservicetype:	Is Service Type, boolean









	property_stock_account_input_categ:

		Stock Input Account, many2one






This account will be used to value the input stock






	parent_id:	Parent Category, many2one









	complete_name:	Name, char, readonly









	property_account_income_categ:

		Income Account, many2one






This account will be used to value incoming stock for the current product category






	child_id:	Child Categories, one2many









	isamenitype:	Is amenities Type, boolean









	property_stock_account_output_categ:

		Stock Output Account, many2one






This account will be used to value the output stock





Object: Hotel Services and its charges (hotel.services)





	warranty:	Warranty (months), float









	property_stock_procurement:

		Procurement Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated by procurements






	uos_id:	Unit of Sale, many2one






Used by companies that manages two unit of measure: invoicing and stock management. For example, in food industries, you will manage a stock of ham but invoice in Kg. Keep empty to use the default UOM.






	list_price:	Sale Price, float






Base price for computing the customer price. Sometimes called the catalog price.






	ean13:	EAN13, char









	incoming_qty:	Incoming, float, readonly






Quantities of products that are planned to arrive in selected locations or all internal if none have been selected.






	standard_price:	Cost Price, float, required






The cost of the product for accounting stock valuation. It can serves as a base price for supplier price.






	mes_type:	Measure Type, selection, required









	code:	Code, char, readonly









	property_account_income:

		Income Account, many2one






This account will be used instead of the default one to value incoming stock for the current product






	qty_available:	Real Stock, float, readonly






Current quantities of products in selected locations or all internal if none have been selected.






	cost_method:	Costing Method, selection, required






Standard Price: the cost price is fixed and recomputed periodically (usually at the end of the year), Average Price: the cost price is recomputed at each reception of products.






	uos_coeff:	UOM -> UOS Coeff, float






Coefficient to convert UOM to UOS
uos = uom * coeff






	seller_delay:	Supplier Lead Time, integer, readonly






This is the average delay in days between the purchase order confirmation and the reception of goods for this product and for the default supplier. It is used by the scheduler to order requests based on reordering delays.






	purchase_ok:	Can be Purchased, boolean






Determine if the product is visible in the list of products within a selection from a purchase order line.






	product_manager:

		Product Manager, many2one









	company_id:	Company, many2one









	loc_rack:	Rack, char









	pricelist_sale:	Sale Pricelists, text, readonly









	type:	Product Type, selection, required






Will change the way procurements are processed. Consumables are stockable products with infinite stock, or for use when you have no stock management in the system.






	property_stock_account_input:

		Stock Input Account, many2one






This account will be used, instead of the default one, to value input stock






	track_incoming:	Track Incoming Lots, boolean






Force to use a Production Lot during receptions






	property_stock_production:

		Production Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated by production orders






	supplier_taxes_id:

		Supplier Taxes, many2many









	volume:	Volume, float






The volume in m3.






	outgoing_qty:	Outgoing, float, readonly






Quantities of products that are planned to leave in selected locations or all internal if none have been selected.






	procure_method:	Procure Method, selection, required






‘Make to Stock’: When needed, take from the stock or wait until re-supplying. ‘Make to Order’: When needed, purchase or produce for the procurement request.






	property_stock_inventory:

		Inventory Location, many2one






For the current product (template), this stock location will be used, instead of the default one, as the source location for stock moves generated when you do an inventory






	variants:	Variants, char









	partner_ref:	Customer ref, char, readonly









	rental:	Rentable Product, boolean









	packaging:	Logistical Units, one2many






Gives the different ways to package the same product. This has no impact on the packing order and is mainly used if you use the EDI module.






	sale_delay:	Customer Lead Time, float






This is the average time between the confirmation of the customer order and the delivery of the finished products. It’s the time you promise to your customers.






	pricelist_purchase:

		Purchase Pricelists, text, readonly









	name:	Name, char, required









	description_sale:

		Sale Description, text









	property_stock_account_output:

		Stock Output Account, many2one






This account will be used, instead of the default one, to value output stock






	seller_ids:	Partners, one2many









	service_id:	Service_id, many2one









	isroom:	Is Room, boolean









	isservice:	Is Service id, boolean









	track_production:

		Track Production Lots, boolean






Force to use a Production Lot during production order






	supply_method:	Supply method, selection, required






Produce will generate production order or tasks, according to the product type. Purchase will trigger purchase orders when requested.






	weight:	Gross weight, float






The gross weight in Kg.






	price_extra:	Variant Price Extra, float









	uom_id:	Default UoM, many2one, required






Default Unit of Measure used for all stock operation.






	description_purchase:

		Purchase Description, text









	default_code:	Code, char









	iscategid:	Is categ id, boolean









	virtual_available:

		Virtual Stock, float, readonly






Future stock for this product according to the selected location or all internal if none have been selected. Computed as: Real Stock - Outgoing + Incoming.






	track_outgoing:	Track Outgoing Lots, boolean






Force to use a Production Lot during deliveries






	product_tmpl_id:

		Product Template, many2one, required









	state:	Status, selection






Tells the user if he can use the product or not.






	uom_po_id:	Purchase UoM, many2one, required






Default Unit of Measure used for purchase orders. It must be in the same category as the default unit of measure.






	weight_net:	Net weight, float






The net weight in Kg.






	description:	Description, text









	price:	Customer Price, float, readonly









	active:	Active, boolean









	loc_row:	Row, char









	sale_ok:	Can be sold, boolean






Determine if the product can be visible in the list of product within a selection from a sale order line.






	loc_case:	Case, char









	produce_delay:	Manufacturing Lead Time, float






Average time to produce this product. This is only for the production order and, if it is a multi-level bill of material, it’s only for the level of this product. Different delays will be summed for all levels and purchase orders.






	property_account_expense:

		Expense Account, many2one






This account will be used instead of the default one to value outgoing stock for the current product






	categ_id:	Category, many2one, required









	lst_price:	List Price, float, readonly









	taxes_id:	Customer Taxes, many2many









	price_margin:	Variant Price Margin, float
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Attendances of Employees in Projects (hr_attendance_project)





	Module:	hr_attendance_project


	Name:	Attendances of Employees in Projects


	Version:	5.0.1.0


	Author:	Zikzakmedia


	Directory:	hr_attendance_project


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

This module aims to manage employee's attendances in Projects.

Adds a new wizard to sign in/sign out. In the sign out, an analytic account or a project must be given, and a task of this analytic account or project. A work for this task with user, start date and hour information is created.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	account

	hr_attendance

	project

	project_timesheet

	hr_timesheet









Reports

None




Menus



	Human Resources/Attendances/Sign in / Sign out by task project

	Human Resources/Attendances/Sign in / Sign out by my task project









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Attendances Of Employees (hr_attendance)





	Module:	hr_attendance


	Name:	Attendances Of Employees


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	hr_attendance


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module aims to manage employee's attendances.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hr_attendance.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_attendance.zip]









Dependencies



	base

	hr









Reports



	Attendance Error Report









Menus



	Human Resources/Attendances

	Human Resources/Attendances/Attendances

	Human Resources/Configuration/Attendance Reasons

	Human Resources/Attendances/Sign in / Sign out









Views



	hr.attendance.form (form)

	hr.attendance.tree (tree)

	hr.attendance.tree (tree)

	hr.action.reason.form (form)

	hr.action.reason.tree (tree)

	* INHERIT hr.employee.form1 (form)









Objects


Object: Action reason (hr.action.reason)





	name:	Reason, char, required









	action_type:	Action’s type, selection








Object: Attendance (hr.attendance)





	action:	Action, selection, required









	employee_id:	Employee, many2one, required









	name:	Date, datetime, required









	action_desc:	Action reason, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Human Resources/Change password (hr_change_password)





	Module:	hr_change_password


	Name:	Human Resources/Change password


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	hr_change_password


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Module for human resource management. You can manage:
    * Change the password of user

    Different reports are also provided, mainly for attendance statistics.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hr_change_password.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_change_password.zip]









Dependencies



	base









Reports

None




Menus



	User Maintenance

	User Maintenance/Change My Password









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Human Resources Contracts - Human resources Reservations Management (hr_contract_available)





	Module:	hr_contract_available


	Name:	Human Resources Contracts - Human resources Reservations Management


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	hr_contract_available


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module is a reservation system on employees.

    You can assign an employee to a poste or a department for a
    defined period. This module is used to track availability and
    reservations on human resources.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hr_contract_available.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_contract_available.zip]









Dependencies



	hr_contract









Reports

None




Menus

None




Views



	* INHERIT hr.hr.employee.view.form2 (form)

	* INHERIT hr.employee.available.tree (tree)









Objects


Object: Allocations (hr.allocation)





	function:	Function, many2one









	employee_id:	Employee, many2one, required









	name:	Allocation Name, char, required









	date_end:	End Date, date






Keep empty for unlimited allocation.






	date_start:	Start Date, date, required









	state:	State, selection, required









	department_id:	Department, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Human Resources Contracts (hr_contract)





	Module:	hr_contract


	Name:	Human Resources Contracts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	hr_contract


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Add all information on the employee form to manage contracts:
    * Martial status,
    * Security number,
    * Place of birth, birth date, ...

    You can assign several contracts per employee.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/hr_contract.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/hr_contract.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_contract.zip]









Dependencies



	hr









Reports

None




Menus



	Human Resources/Configuration/Contract

	Human Resources/Configuration/Contract/Contract Wage Type

	Human Resources/Configuration/Contract/Wage period

	Human Resources/Configuration/Marital Status

	Human Resources/Contract









Views



	hr.contract.wage.type.period.view.form (form)

	hr.hr.employee.marital.status (form)

	hr.contract.wage.type.view.form (form)

	hr.contract.wage.type.view.tree (tree)

	* INHERIT hr.hr.employee.view.form2 (form)

	hr.contract.type.view.form (form)

	hr.contract.view.form (form)

	hr.contract.type.view.tree (tree)

	hr.contract.view.tree (tree)









Objects


Object: Employee Marital Status (hr.employee.marital.status)





	name:	Marital Status, char, required









	description:	Status Description, text








Object: Wage Period (hr.contract.wage.type.period)





	name:	Period Name, char, required









	factor_days:	Hours in the period, float, required






This field is used by the timesheet system to compute the price of an hour of work based on the contract of the employee





Object: Wage Type (hr.contract.wage.type)





	type:	Type, selection, required









	period_id:	Wage Period, many2one, required









	name:	Wage Type Name, char, required









	factor_type:	Factor for hour cost, float, required






This field is used by the timesheet system to compute the price of an hour of work based on the contract of the employee





Object: Contract (hr.contract)





	function:	Function, many2one









	wage_type_id:	Wage Type, many2one, required









	employee_id:	Employee, many2one, required









	name:	Contract Name, char, required









	date_end:	End Date, date









	date_start:	Start Date, date, required









	wage:	Wage, float, required









	notes:	Notes, text









	working_hours_per_day:

		Working hours per day, integer
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Human Resources Timesheets on contracts (hr_contract_timesheet)





	Module:	hr_contract_timesheet


	Name:	Human Resources Timesheets on contracts


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	hr_contract_timesheet


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Compute the cost of an employee for his timesheets according
        to his contract definitions. If no contract are defined, it
        uses the product costs linked to the employee.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hr_contract_timesheet.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_contract_timesheet.zip]









Dependencies



	hr_contract

	hr_timesheet









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Human Resources Evaluation (hr_evaluation)





	Module:	hr_evaluation


	Name:	Human Resources Evaluation


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	hr_evaluation


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Ability to create employees evaluation.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	hr









Reports

None




Menus



	Human Resources/Evaluations

	Human Resources/Evaluations/HR Responsible

	Human Resources/Evaluations/HR Responsible/Evaluations

	Human Resources/Evaluations/HR Responsible/Next Evaluations

	Human Resources/Evaluations/HR Responsible/My Next Evaluations

	Human Resources/Evaluations/My Preceeding Evaluations

	Human Resources/Evaluations/Configuration

	Human Resources/Evaluations/Configuration/Evaluation Criterions









Views



	hr_evaluation.quote.form (form)

	hr_evaluation.quote.tree (tree)

	hr_evaluation.evaluation.form (form)

	hr_evaluation.evaluation.tree (tree)

	hr_evaluation.evaluation.form.ro (form)

	hr_evaluation.type.tree (tree)

	hr_evaluation.type.form (form)









Objects


Object: Employee Evaluation (hr_evaluation.evaluation)





	info_improve:	To Improve, text









	employee_id:	Employee, many2one, required









	user_id:	Evaluation User, many2one, required









	name:	Summary, char, required









	info_employee:	Employee Response, text









	state:	State, selection









	score:	Score, float









	date:	Date, date, required









	info_bad:	Bad Points, text









	info_good:	Good Points, text









	quote_ids:	Quotes, one2many








Object: Employee Evaluation Type (hr_evaluation.type)





	info:	Information, text









	name:	Evaluation Criterion, char, required









	value_ids:	Values, one2many









	category_ids:	Applicable Role, many2many









	score:	Score, float









	active:	Active, boolean








Object: Evaluation Type Value (hr_evaluation.type.value)





	score:	Score, float









	name:	Value, char, required









	type_id:	Evaluation Type, many2one, required








Object: Employee Evaluation Quote (hr_evaluation.quote)





	evaluation_id:	Evaluation, many2one, required









	value_id:	Value, many2one









	score:	Score, float









	name:	Quote, char









	type_id:	Type, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Human Resources Expenses Tracking (hr_expense)





	Module:	hr_expense


	Name:	Human Resources Expenses Tracking


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	hr_expense


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module aims to manage employee's expenses.

    The whole workflow is implemented:
    * Draft expense
    * Confirmation of the sheet by the employee
    * Validation by his manager
    * Validation by the accountant and invoice creation
    * Payment of the invoice to the employee

    This module also use the analytic accounting and is compatible with
    the invoice on timesheet module so that you will be able to automatically
    re-invoice your customer's expenses if your work by project.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/hr_expense.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/hr_expense.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_expense.zip]









Dependencies



	hr

	account

	account_tax_include









Reports



	Print HR expenses









Menus



	Human Resources/Expenses

	Human Resources/Expenses/All expenses

	Human Resources/Expenses/All expenses/Draft expenses

	Human Resources/Expenses/All expenses/Expenses waiting validation

	Human Resources/Expenses/All expenses/Expenses waiting invoice

	Human Resources/Expenses/All expenses/Expenses waiting payment

	Human Resources/Expenses/My Expenses

	Human Resources/Expenses/New Expenses Sheet

	Human Resources/Expenses/My Expenses/My Draft expenses

	Human Resources/Expenses/My Expenses/My expenses waiting validation









Views



	hr.expense.line.tree (tree)

	hr.expense.expense.tree (tree)

	hr.expense.form (form)

	* INHERIT product.product.expense.form (form)









Objects


Object: Expense (hr.expense.expense)





	note:	Note, text









	employee_id:	Employee, many2one, required









	user_id:	User, many2one, required









	name:	Expense Sheet, char, required









	account_move_id:

		Account Move, many2one









	invoice_id:	Invoice, many2one









	journal_id:	Force Journal, many2one









	id:	Sheet ID, integer, readonly









	currency_id:	Currency, many2one, required









	user_valid:	Validation User, many2one









	state:	State, selection, readonly









	date_valid:	Date Validated, date









	date:	Date, date









	line_ids:	Expense Lines, one2many, readonly









	amount:	Total Amount, float, readonly









	ref:	Reference, char









	date_confirm:	Date Confirmed, date








Object: Expense Line (hr.expense.line)





	product_id:	Product, many2one









	sequence:	Sequence, integer









	description:	Description, text









	name:	Short Description, char, required









	date_value:	Date, date, required









	uom_id:	UoM, many2one









	expense_id:	Expense, many2one









	unit_amount:	Unit Price, float









	unit_quantity:	Quantities, float









	ref:	Reference, char









	analytic_account:

		Analytic account, many2one









	total_amount:	Total, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







HR Expenses Supplier (hr_expenses_supplier)





	Module:	hr_expenses_supplier


	Name:	HR Expenses Supplier


	Version:	5.0.1.0


	Author:	SYLEAM Info Services


	Directory:	hr_expenses_supplier


	Web:	http://www.Syleam.fr


	Official module:

		no


	Quality certified:

		no






Description

Add supplier on expenses lines for generate invoice supplier
    if the employee didn't pay the expenses but the company








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	hr_expense









Reports

None




Menus

None




Views



	* INHERIT hr.expense.supplier.form (form)

	* INHERIT hr.expense.supplier.line.tree (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Human Resources: Holidays management (hr_holidays_cci)





	Module:	hr_holidays_cci


	Name:	Human Resources: Holidays management


	Version:	False


	Author:	Axelor


	Directory:	hr_holidays_cci


	Web:	http://www.axelor.com/


	Official module:

		no


	Quality certified:

		no






Description

Human Resources: Holidays summary printing functionality


NOTICE: This Module is Deprecated. Please install hr_holidays for the latest functionality.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hr_holidays_cci.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_holidays_cci.zip]









Dependencies



	hr_holidays









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Hr holidays evaluation (hr_holidays_evaluation)





	Module:	hr_holidays_evaluation


	Name:	Hr holidays evaluation


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	hr_holidays_evaluation


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Computation of holidays for employee








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hr_holidays_evaluation.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_holidays_evaluation.zip]









Dependencies



	hr_holidays

	hr_contract

	hr_attendance









Reports

None




Menus



	Human Resources/Holidays Management/Holidays Evaluation

	Human Resources/Holidays Management/Holidays Evaluation/Count Holiday For Employee









Views



	Notes (form)

	Notes (tree)

	* INHERIT hr.holidays.per.user.form.inherited (form)

	Holidays Evaluation Wizard (form)









Objects


Object: Holidays note (hr.holidays.note)





	employee_id:	Employee Name, many2one









	prev_number:	Previous Holiday Number, float









	holiday_per_user_id:

		Holiday Status, many2one, required









	date:	Date, char, required









	diff:	Difference, float, readonly









	new_number:	New Holiday Number, float, required








Object: wizard.hr.holidays.evaluation (wizard.hr.holidays.evaluation)





	hr_timesheet_group_id:

		Timesheet Group, many2one, required






This field allow you to filter on only the employees that have a contract using this working hour.






	float_time:	Time, float, required






This time depicts the amount per day earned by an employee working a day. The computation is: total earned = time * number of working days






	holiday_status_id:

		Holiday Status, many2one, required






This is where you specify the holiday type to synchronize. It will create the “holidays per employee” accordingly if necessary, or replace the value “Max leaves allowed” into the existing one.






	date_current:	Date, date






This field allow you to choose the date to use, for forecast matter e.g
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







HR Holiday Request (hr_holidays_request)





	Module:	hr_holidays_request


	Name:	HR Holiday Request


	Version:	5.0.1.0


	Author:	Tiny & Axelor


	Directory:	hr_holidays_request


	Web:	http://www.axelor.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hr_holidays_request.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_holidays_request.zip]









Dependencies



	base

	hr

	hr_holidays









Reports



	Holidays Report

	Holidays Report Form









Menus



	Human Resources/Holidays Request

	Human Resources/Holidays Request/All Validated Holidays

	Human Resources/Holidays Request/Public Holidays

	Human Resources/Holidays Request/All Holidays Requests

	Human Resources/Holidays Request/Holiday History

	Human Resources/Holidays Request/My Holidays Request

	Human Resources/Holidays Request/My Holidays Request/Draft

	Human Resources/Holidays Request/My Holidays Request/Waiting confirmation

	Human Resources/Holidays Request/My Holidays Request/Validated

	Human Resources/Holidays Request/My Holidays Request/Refused

	Human Resources/Holidays Request/My Holidays Request/Request waiting validation

	Human Resources/Holidays Request/My Holidays Request/Holidays Report









Views



	* INHERIT Holidays (form)

	* INHERIT hr.holidays.tree (tree)

	holidays.days.list (tree)

	Holidays_hr (form)

	holidays.days.history.list (tree)

	holidays.days.history.list (form)

	holidays.days.list (form)

	public.holidays.days.list (form)

	hr.holidays.tree.2 (tree)

	hr.holidays.tree.2.history (tree)

	ask.holiday.history (form)









Objects


Object: Holidays history (hr.holidays.history)





	employee_id:	Employee, many2one, readonly









	user_id:	Employee_id, many2one, readonly









	name:	Description, char, readonly









	date_to1:	To, date, readonly









	notes:	Notes, text, readonly









	date_from1:	From, date, readonly









	contactno:	Contact no, char, readonly









	state:	State, selection, readonly









	total_full:	Total Full Leave, integer, readonly









	manager_id:	Holiday manager, many2one, readonly









	holiday_id:	Holiday’s days list, one2many, readonly









	total_hour:	Total Hours, integer, readonly









	total_half:	Total Half Leave, integer, readonly









	validated_id:	Validated By, many2one, readonly








Object: Holidays history (days.holidays.days)





	date1:	Date, date, required, readonly









	user_id:	User_id, many2one, readonly









	name:	Date, char









	public_h:	Public Holiday, boolean, readonly









	state:	State, selection, readonly









	hourly_leave:	Hourly Leave, float, readonly









	holiday_id:	Holiday Ref, many2one









	half_day:	Half Leave, boolean, readonly









	full_day:	Full Leave, boolean, readonly









	holiday_status:	Holiday’s Status, many2one








Object: Public Holidays (public.holidays.days)





	reason:	Reason, text, required









	name:	Date, date, required








Object: Holidays history (days.holidays.days.history)





	date1:	Date, date, readonly









	user_id:	User_id, many2one, readonly









	name:	Date, char, readonly









	public_h:	Public Holiday, boolean, readonly









	state:	State, selection, readonly









	hourly_leave:	Hourly Leave, float, readonly









	holiday_id:	Holiday Ref, many2one, readonly









	half_day:	Half Leave, boolean, readonly









	full_day:	Full Leave, boolean, readonly









	holiday_status:	Holiday’s Status, selection, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Human Resources: Holidays management (hr_holidays)





	Module:	hr_holidays


	Name:	Human Resources: Holidays management


	Version:	5.0.1.1


	Author:	Tiny & Axelor


	Directory:	hr_holidays


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Human Resources: Holidays tracking and workflow

    This module allows you to manage holidays and holidays requests. For each employee, you can also define a number of available holidays per holiday status.

    Note that:
    - A synchronisation with an internal agenda (use of the CRM module) is possible: to automatically create a case when a holiday request is accepted, you must link the holidays status to a case section. You can set up this info and your colour preferences in
                HR / Configuration / Holidays Status
    - An employee can make a negative holiday request (holiday request of -2 days for example), this is considered by the system as an ask for more off-days. It will increase his total of that holiday status available (if the request is accepted).
    - There are two ways to print the employee's holidays:
        * The first will allow to choose employees by department and is used by clicking the menu item located in
                HR / Holidays Request / Print Summary of Holidays
        * The second will allow you to choose the holidays report for specific employees. Go on the list
                HR / Employees / Employees
            then select the ones you want to choose, click on the print icon and select the option
                'Print Summary of Employee's Holidays'
    - The wizard allows you to choose if you want to print either the Confirmed & Validated holidays or only the Validated ones. These states must be set up by a user from the group 'HR' and with the role 'holidays'. You can define these features in the security tab from the user data in
                Administration / Users / Users
            for example, you maybe will do it for the user 'admin'.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/hr_holidays.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/hr_holidays.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_holidays.zip]









Dependencies



	hr

	crm_configuration

	process









Reports



	Summary Of Holidays









Menus



	Human Resources/Configuration/Holiday Status

	Human Resources/Holidays Management

	Human Resources/Holidays Management/New Holidays Request

	Human Resources/Holidays Management/All Holidays Requests

	Human Resources/Holidays Management/My Holidays Requests

	Human Resources/Holidays Management/My Holidays Requests/My Draft Holidays Requests

	Human Resources/Holidays Management/My Holidays Requests/My Awaiting Confirmation Holidays Requests

	Human Resources/Holidays Management/My Holidays Requests/My Validated Holidays Requests

	Human Resources/Holidays Management/My Holidays Requests/My Refused Holidays Requests

	Human Resources/Holidays Management/All Holidays Requests/Holidays Requests Awaiting for Validation

	Human Resources/Configuration/Holidays Per Employee

	Human Resources/Reporting/My Available Holidays

	Human Resources/Reporting/Print Summary of Holidays









Views



	hr.holidays.form (form)

	hr.holidays.tree (tree)

	hr.holidays.status.form (form)

	hr.holidays.status.tree (tree)

	hr.holidays.per.user.form (form)

	hr.holidays.per.user.tree (tree)

	hr.holidays.per.user.graph (graph)









Objects


Object: Holidays Status (hr.holidays.status)





	active:	Active, boolean









	color_name:	Color of the status, selection, required









	limit:	Allow to override Limit, boolean









	name:	Holiday Status, char, required









	section_id:	Section, many2one








Object: Holidays Per User (hr.holidays.per.user)





	employee_id:	Employee, many2one, required









	user_id:	User, many2one









	notes:	Notes, text









	holiday_ids:	Holidays, one2many









	max_leaves:	Maximum Leaves Allowed, float, required









	leaves_taken:	Leaves Already Taken, float, readonly









	active:	Active, boolean









	remaining_leaves:

		Remaining Leaves, float, readonly









	holiday_status:	Holiday’s Status, many2one, required








Object: Holidays (hr.holidays)





	employee_id:	Employee, many2one, readonly









	user_id:	Employee_id, many2one, readonly









	name:	Description, char, required, readonly









	date_from:	Vacation start day, datetime, required, readonly









	state:	Status, selection, readonly









	case_id:	Case, many2one









	manager_id:	Holiday manager, many2one, readonly









	holiday_user_id:

		Holiday per user, many2one









	date_to:	Vacation end day, datetime, required, readonly









	number_of_days:	Number of Days in this Holiday Request, float, required, readonly









	notes:	Notes, text, readonly









	holiday_status:	Holiday’s Status, many2one, required, readonly








Object: hr.holidays.log (hr.holidays.log)





	holiday_req_id:	Holiday Request ID, char









	employee_id:	Employee, many2one, readonly









	name:	Action, char, readonly









	nb_holidays:	Number of Holidays Requested, float









	holiday_user_id:

		Holidays user, many2one









	date:	Date, datetime









	holiday_status:	Holiday’s Status, many2one, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Human Resources (Interview Evaluation) (hr_interview)





	Module:	hr_interview


	Name:	Human Resources (Interview Evaluation)


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	hr_interview


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module stores all the educational and professional details of candidates who appear for interview. While taking an interview, the interviewers can evaluate the candidate's performance on the basis of categories. The candidate is evaluated based on different evaluations, which are related to categories.

Example: Candidate X to be evaluated for Y Category(Category reflects the recruitment criteria). Category Y has several question types: DBMS questions, OOP questions, Communication skills, etc.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hr_interview.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_interview.zip]









Dependencies



	base

	hr

	crm

	smtpclient









Reports



	Candidate’s Summary









Menus



	Human Resources/Configuration/Candidate Categories

	Human Resources/Interview

	Human Resources/Interview/All Interviews

	Human Resources/Interview/New Interview

	Human Resources/Interview/All Interviews/Selected Candidates

	Human Resources/Interview/All Interviews/Cancel Candidates

	Human Resources/Interview/All Interviews/Rejected Candidates

	Human Resources/Interview/All Interviews/Scheduled Candidates

	Human Resources/Configuration/Candidate Experience









Views



	cand.categ.search (form)

	cand.categ.tree (tree)

	hr.interview.tree (tree)

	hr.interview.form (form)

	technical.skill.form (form)

	technical.skill.tree (tree)

	candidate.experience.form (form)

	candidate.experience.tree (tree)

	category.question.form (form)

	category.question.tree (tree)

	hr.interview.log.form (form)

	hr.interview.log.tree (tree)









Objects


Object: Category Of Candidate (candidate.category)





	code:	Code, char, required









	question_ids:	Question, one2many









	name:	Name, char, required








Object: Question Category (Question Belongs to Which Category) (category.question)





	tot_marks:	Total Marks, integer, required









	name:	Question, char, required









	category_id:	Category, many2one








Object: Candidate Experience (candidate.experience)





	code:	Code, char, required









	name:	Name, char, required









	special:	Specialization, char








Object: Interview Evaluation (hr.interview)





	evaluator_ids:	Evaluator, many2many









	history_log_ids:

		Interview Logs, one2many, readonly









	name:	Candidate Name, char, required









	performance:	Performance (%), float, readonly









	tech_skills_ids:

		Technology Skills, one2many









	mobile_no:	Mobile, char









	category_id:	Category, many2one









	remarks:	Remarks, text









	state:	State, selection, readonly









	reference_id:	Reference, many2one









	experience_id:	Experience, many2one









	date:	Scheduled Date, datetime









	exam_date:	Exam On, datetime









	crm_case_id:	Case, many2one









	education:	Education, selection









	email:	E-mail, char, required









	hr_id:	Interview ID, char








Object: Technical Skill Of Candidate (technical.skill)





	remarks:	Remarks, text









	obt_marks:	Obtained Marks, float









	tot_marks:	Total Marks, float, required









	candidate_id:	Candidate ID, many2one









	name:	Category, char, required








Object: HR interview log (hr.interview.log)





	date:	Date, datetime









	history_id:	History ID, many2one









	user_id:	User Name, many2one









	state:	State, char
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Human Resources Medical Exam (hr_medical)





	Module:	hr_medical


	Name:	Human Resources Medical Exam


	Version:	1.0


	Author:	Sednacom


	Directory:	hr_medical


	Web:	http://www.sednacom.fr


	Official module:

		no


	Quality certified:

		no






Description

Advanced management for Medical Exam








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hr_medical.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_medical.zip]









Dependencies



	hr

	hr_contract









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Performance Review (hr_performance)





	Module:	hr_performance


	Name:	Performance Review


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	hr_performance


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

A module that Check Performance For the Company Employees.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hr_performance.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_performance.zip]









Dependencies



	base

	hr









Reports



	Performance report









Menus



	Human Resources/Performance Review/Performance HR

	Human Resources/Performance Review/Review Attributes HR









Views



	hr.performance.form (form)

	hr.performance.tree (tree)

	hr.attribute.line.form (form)

	hr.attribute.line.tree (tree)

	hr.performance.line.attribute.form (form)

	hr.performance.line.attribute.tree (tree)









Objects


Object: Employee Performance  (hr.performance)





	user_id:	User, many2one, readonly









	name:	Description, char









	reviewer_id:	Employee, many2one, readonly









	date_from:	Date From, date, required









	state:	State, selection, readonly









	date_to:	Date To, date, required









	performance_id:	Performance, one2many








Object: Performance Review Points (hr.performance.line)





	employee_id:	Employee, many2one, required, readonly









	name:	Description, char









	attribute_line:	Attributes, one2many









	performance:	Performance in (%), float, readonly









	total:	Total, float, readonly









	performance_id:	Review Point, many2one








Object: Review Attributes (hr.performance.line.attribute)





	note:	Description, text









	name:	Attribute Name, char, required









	total_point:	Total Point, integer, required








Object: Attributes Lines (attribute.line)





	total_marks:	Total Marks, float, readonly









	name:	Description, char









	obtained_marks:	Obtained Marks, float, required









	attribute_id:	Attribute, many2one, required, readonly









	performance_line_id:

		Performance Line, many2one, readonly









	description:	Description, text
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Human Resources (hr)





	Module:	hr


	Name:	Human Resources


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	hr


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Module for human resource management. You can manage:
    * Employees and hierarchies
    * Work hours sheets
    * Attendances and sign in/out system

    Different reports are also provided, mainly for attendance statistics.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/hr.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/hr.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr.zip]









Dependencies



	base

	process









Reports

None




Menus



	Human Resources

	Human Resources/Reporting

	Human Resources/Configuration

	Human Resources/Employees

	Human Resources/Employees/Employees Structure

	Human Resources/Employees/All Employees

	Human Resources/Employees/New Employee

	Human Resources/Configuration/Working Time Categories

	Human Resources/Configuration/Categories of Employee

	Human Resources/Configuration/Categories of Employee/Categories structure

	Administration/Users/Departments

	Administration/Users/Departments/Departments









Views



	hr.employee.form (form)

	hr.employee.tree (tree)

	hr.employee.tree (tree)

	hr.timesheet.group.form (form)

	hr.timesheet.tree (tree)

	hr.timesheet.form (form)

	hr.employee.category.form (form)

	hr.employee.category.list (tree)

	hr.employee.category.tree (tree)

	hr.department.form (form)

	hr.department.tree (tree)

	* INHERIT res.users.form (form)









Objects


Object: Working Time (hr.timesheet.group)





	timesheet_id:	Working Time, one2many









	manager:	Workgroup manager, many2one









	name:	Group name, char, required








Object: Employee Category (hr.employee.category)





	parent_id:	Parent Category, many2one









	child_ids:	Child Categories, one2many









	name:	Category, char, required








Object: Employee (hr.employee)





	company_id:	Company, many2one









	otherid:	Other ID, char









	country_id:	Nationality, many2one









	user_id:	Related User, many2one









	work_location:	Office Location, char









	name:	Employee, char, required









	parent_id:	Manager, many2one









	work_phone:	Work Phone, char









	gender:	Gender, selection









	ssnid:	SSN No, char









	child_ids:	Subordinates, one2many









	address_id:	Working Address, many2one









	marital:	Marital Status, selection









	sinid:	SIN No, char









	birthday:	Birthday, date









	active:	Active, boolean









	category_id:	Category, many2one









	work_email:	Work Email, char









	notes:	Notes, text









	address_home_id:

		Home Address, many2one








Object: Timesheet Line (hr.timesheet)





	dayofweek:	Day of week, selection









	name:	Name, char, required









	tgroup_id:	Employee’s timesheet group, many2one









	date_from:	Starting date, date









	hour_from:	Work from, float, required









	hour_to:	Work to, float, required








Object: hr.department (hr.department)





	member_ids:	Members, many2many









	name:	Department Name, char, required









	child_ids:	Child Departments, one2many









	company_id:	Company, many2one, required









	note:	Note, text









	parent_id:	Parent Department, many2one









	manager_id:	Manager, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Skill Management (hr_skill)





	Module:	hr_skill


	Name:	Skill Management


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	hr_skill


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Generic and powerfull skill management system. This module allows you to manage your company and employees skills, interviews, ...








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hr_skill.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_skill.zip]









Dependencies



	hr









Reports



	Evaluation report









Menus



	Human Resources/Configuration/Skills Management

	Human Resources/Configuration/Skills Management/Skills

	Human Resources/Configuration/Skills Management/Skills Structure

	Human Resources/Configuration/Skills Management/Positions

	Human Resources/Configuration/Skills Management/Profiles

	Human Resources/Configuration/Skills Management/Weight Categories

	Human Resources/Configuration/Skills Management/Weights

	Human Resources/Configuration/Skills Management/Experience Categories

	Human Resources/Configuration/Skills Management/Experiences

	Human Resources/Configuration/Skills Management/Evaluations

	Human Resources/Configuration/Skills Management/Languages

	Human Resources/Configuration/Skills Management/Scale Grade

	Human Resources/Configuration/Skills Management/Employees Status









Views



	hr_skill.skill.form (form)

	hr_skill.skill.tree (tree)

	hr_skill.position.form (form)

	hr_skill.profile.form (form)

	hr_skill.weight.category.form (form)

	hr_skill.weight.form (form)

	hr_skill.experience.category.form (form)

	hr_skill.experience.form (form)

	hr_skill.evaluation.form (form)

	hr_skill.evaluation.tree (tree)

	* INHERIT hr.employee.form (form)

	Languages (form)

	Languages (tree)

	Languages (form)

	Languages (tree)

	* INHERIT employee.grade.form1.inherit (form)

	Pay Scales (form)

	Pay Scales (tree)

	employee.status.form (form)









Objects


Object: hr_skill.weight.category (hr_skill.weight.category)





	name:	Name, char, required








Object: hr_skill.weight (hr_skill.weight)





	category_id:	Category, many2one, required









	name:	Name, char, required









	value:	Numerical value, float, required








Object: hr_skill.skill (hr_skill.skill)





	name:	Name, char, required









	weight:	Weight, float, required









	child_ids:	Childs, one2many









	parent_id:	Parent, many2one









	weight_category_id:

		Weight Category, many2one









	active:	Active, boolean









	view:	Skill, selection, required








Object: hr_skill.experience.category (hr_skill.experience.category)





	name:	Name, char, required








Object: hr_skill.experience (hr_skill.experience)





	skill_ids:	Skills, one2many









	category_id:	Category, many2one









	name:	Name, char, required









	sequence:	Sequence, integer








Object: hr_skill.evaluation.category (hr_skill.evaluation.category)





	name:	Name, char, required








Object: hr_skill.evaluation (hr_skill.evaluation)





	experience_ids:	Experience, one2many









	employee_id:	Evaluated Employee, many2one









	name:	Evaluation name, char, required









	reference:	Reference, char









	skill_ids:	Skill, one2many









	interviewer_name:

		Evaluator, char, required









	interviewee_name:

		Evaluated People, char, required









	note:	Notes, text









	date:	Date, date, required









	category_id:	Category, many2one








Object: hr_skill.profile (hr_skill.profile)





	skill_ids:	Skills, one2many









	name:	Name, char, required








Object: hr_skill.position (hr_skill.position)





	status:	Status, selection









	profile_ids:	Profiles, one2many









	employee_id:	Assigned Employee, many2one









	name:	Name, char, required








Object: hr_skill.position.profile (hr_skill.position.profile)





	position_id:	Position, many2one, required









	weight_id:	Weight, many2one, required









	profile_id:	Profile, many2one, required









	name:	Name, char








Object: hr_skill.experience.skill (hr_skill.experience.skill)





	weight_id:	Weight, many2one, required









	experience_id:	Experience, many2one, required









	name:	Name, char, required









	skill_id:	Skill, many2one, required








Object: hr_skill.profile.skill (hr_skill.profile.skill)





	weight_id:	Weight, many2one, required









	profile_id:	Profile, many2one, required









	name:	Name, char









	skill_id:	Skill, many2one, required








Object: hr_skill.evaluation.experience (hr_skill.evaluation.experience)





	weight_id:	Weight, many2one, required









	evaluation_id:	Evaluation, many2one, required









	name:	Name, char, required









	experience_id:	Experience, many2one, required








Object: hr_skill.evaluation.skill (hr_skill.evaluation.skill)





	weight_id:	Weight, many2one, required









	evaluation_id:	Evaluation, many2one, required









	name:	Name, char









	skill_id:	Skill, many2one, required








Object: Languages (hr.lang)





	name:	Language, char








Object: Languages (emp.lang)





	read:	Read, boolean









	write:	Write, boolean









	speak:	Speak, boolean









	name:	Language, many2one









	ii_id:	languages known, many2one








Object: Pay Scales (hr.scale)





	code:	Code, char









	name:	Name, char









	increase:	Step Increase, integer









	min_sal:	Minimum Salary, integer









	max_sal:	Maximum Salary, integer









	cur:	Currency, selection








Object: employee.status (employee.status)





	name:	Status Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Complete timesheet from an iCal server (hr_timesheet_ical)





	Module:	hr_timesheet_ical


	Name:	Complete timesheet from an iCal server


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	hr_timesheet_ical


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Import iCal events (for eg, Outlook) to auto-complete timesheets.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/hr_timesheet_ical.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_timesheet_ical.zip]









Dependencies



	hr_timesheet









Reports

None




Menus



	Human Resources/Hours Encoding

	Human Resources/Hours Encoding/Import Icalendar









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Invoice on analytic lines (hr_timesheet_invoice)





	Module:	hr_timesheet_invoice


	Name:	Invoice on analytic lines


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	hr_timesheet_invoice


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Module to generate invoices based on costs (human resources, expenses, ...).
You can define price lists in analytic account, make some theoretical revenue
reports, eso.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/hr_timesheet_invoice.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/hr_timesheet_invoice.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_timesheet_invoice.zip]









Dependencies



	account

	hr_timesheet









Reports



	Cost Ledger

	Timesheet Profit









Menus



	Financial Management/Periodical Processing/Entries to invoice

	Financial Management/Periodical Processing/Entries to invoice/Uninvoiced Entries

	Financial Management/Periodical Processing/Entries to invoice/My Uninvoiced Entries

	Financial Management/Configuration/Analytic Accounting/Analytic Accounts/Analytic Chart of Accounts/Open Analytic Accounts

	.../Configuration/Analytic Accounting/Analytic Accounts/Analytic Chart of Accounts/Open Analytic Accounts/Unclosed Invoiceable Accounts

	Financial Management/Configuration/Analytic Accounting/Analytic Accounts/Analytic Chart of Accounts/Draft Analytic Accounts

	Financial Management/Configuration/Analytic Accounting/Analytic Accounts/Analytic Chart of Accounts/Pending Analytic Accounts

	Financial Management/Configuration/Analytic Accounting/Analytic Accounts/Types of Invoicing

	Human Resources/Reporting/Timesheet Profit









Views



	* INHERIT account.analytic.account.invoice.form (form)

	* INHERIT hr.analytic.timesheet.form (form)

	* INHERIT hr.analytic.timesheet.form2 (form)

	* INHERIT hr.analytic.timesheet.tree (tree)

	* INHERIT hr.analytic.timesheet.tree2 (tree)

	* INHERIT account.analytic.line.tree.to_invoice (tree)

	* INHERIT account.analytic.line.form.to_invoice (form)

	hr_timesheet_invoice.factor.form (form)

	hr_timesheet_invoice.factor.tree (tree)









Objects


Object: Invoice rate (hr_timesheet_invoice.factor)





	factor:	Discount (%), float, required









	name:	Internal name, char, required









	customer_name:	Visible name, char
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Human Resources (Timesheet encoding from project tasks) (hr_timesheet_project)





	Module:	hr_timesheet_project


	Name:	Human Resources (Timesheet encoding from project tasks)


	Version:	1.0


	Author:	Tiny


	Directory:	hr_timesheet_project


	Web:	http://tinyerp.com/module_hr.html


	Official module:

		no


	Quality certified:

		no






Description

Auto-complete timesheet based on tasks made on the project management module.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/hr_timesheet_project.zip]









Dependencies



	project

	hr_timesheet









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Human Resources (Timesheet encoding) (hr_timesheet)





	Module:	hr_timesheet


	Name:	Human Resources (Timesheet encoding)


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	hr_timesheet


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module implement a timesheet system. Each employee can encode and
track their time spent on the different projects. A project is an
analytic account and the time spent on a project generate costs on
the analytic account.

Lots of reporting on time and employee tracking are provided.

It is completely integrated with the cost accounting module. It allows you
to set up a management by affair.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/hr_timesheet.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/hr_timesheet.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_timesheet.zip]









Dependencies



	account

	hr

	base

	hr_attendance

	process









Reports



	Employee timesheet

	Employees Timesheet









Menus



	Human Resources/Working Hours

	Human Resources/Working Hours/My Working Hours

	Human Resources/Working Hours/My Working Hours/My Working Hours of The Day

	Human Resources/Working Hours/Working Hours

	Human Resources/Working Hours/Working Hours/Working Hours of The Day

	Human Resources/Reporting/Timesheet

	Human Resources/Reporting/Timesheet/Employee Timesheet

	Human Resources/Reporting/Timesheet/Print My Timesheet

	Human Resources/Reporting/Timesheet/Employees Timesheet

	Human Resources/Attendances/Sign in / Sign out by project









Views



	hr.analytic.timesheet.tree (tree)

	hr.analytic.timesheet.form (form)

	* INHERIT hr.timesheet.employee.extd_form (form)









Objects


Object: Timesheet line (hr.analytic.timesheet)





	code:	Code, char









	user_id:	User, many2one









	account_id:	Analytic Account, many2one, required









	general_account_id:

		General Account, many2one, required









	product_uom_id:	UoM, many2one









	journal_id:	Analytic Journal, many2one, required









	name:	Description, char, required









	line_id:	Analytic line, many2one









	amount:	Amount, float, required









	unit_amount:	Quantity, float









	date:	Date, date, required









	ref:	Ref., char









	move_id:	Move Line, many2one









	product_id:	Product, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Timesheets (hr_timesheet_sheet)





	Module:	hr_timesheet_sheet


	Name:	Timesheets


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	hr_timesheet_sheet


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module help you easily encode and validate timesheet and attendances
within the same view. The upper part of the view is for attendances and
track (sign in/sign out) events. The lower part is for timesheet.

Others tabs contains statistics views to help you analyse your
time or the time of your team:
* Time spent by day (with attendances)
* Time spent by project

This module also implement a complete timesheet validation process:
* Draft sheet
* Confirmation at the end of the period by the employee
* Validation by the project manager

The validation can be configured in te company:
* Period size (day, week, month, year)
* Maximal difference between timesheet and attendances








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/hr_timesheet_sheet.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/hr_timesheet_sheet.zip]

	trunk [http://www.openerp.com/download/modules/trunk/hr_timesheet_sheet.zip]









Dependencies



	hr_timesheet

	hr_timesheet_invoice

	process









Reports

None




Menus



	Human Resources/Timesheets

	Human Resources/Timesheets/Timesheets

	Human Resources/Timesheets/My timesheets

	Human Resources/Timesheets/My timesheets/My timesheets to confirm

	Human Resources/Timesheets/My Department’s Timesheet

	Human Resources/Timesheets/My Department’s Timesheet/My Department’s Timesheet to Validate

	Human Resources/Timesheets/My Department’s Timesheet/My Department’s Timesheet to Confirm

	Human Resources/Timesheets/My timesheets/My Current Timesheet

	Human Resources/Timesheets/Timesheets/Timesheets To Confirm

	Human Resources/Timesheets/Timesheets/Timesheets To Validate

	Human Resources/Timesheets/Timesheets/Unvalidated Timesheets









Views



	hr.timesheet.sheet.tree (tree)

	hr.timesheet.account.form (form)

	hr.timesheet.account.tree (tree)

	hr.timesheet.day.form (form)

	hr.timesheet.day.tree (tree)

	hr.timesheet.sheet.form (form)

	* INHERIT res.company.sheet (form)

	* INHERIT hr.analytic.timesheet.form (form)

	* INHERIT hr.attendance.form (form)

	* INHERIT hr.attendance.tree (tree)

	hr.timesheet.sheet.tree.simplified (tree)









Objects


Object: hr_timesheet_sheet.sheet (hr_timesheet_sheet.sheet)





	total_attendance:

		Total Attendance, float, readonly









	timesheet_ids:	Timesheet lines, one2many, readonly









	user_id:	User, many2one, required









	name:	Description, char









	total_timesheet:

		Total Timesheet, float, readonly









	date_from:	Date from, date, required, readonly









	date_to:	Date to, date, required, readonly









	attendances_ids:

		Attendances, one2many, readonly









	period_ids:	Period, one2many, readonly









	total_difference:

		Difference, float, readonly









	total_difference_day:

		Difference, float, readonly









	state:	Status, selection, required, readonly









	total_attendance_day:

		Total Attendance, float, readonly









	account_ids:	Analytic accounts, one2many, readonly









	date_current:	Current date, date, required









	state_attendance:

		Current Status, selection, readonly









	total_timesheet_day:

		Total Timesheet, float, readonly








Object: Timesheets by period (hr_timesheet_sheet.sheet.day)





	total_attendance:

		Attendance, float, readonly









	total_difference:

		Difference, float, readonly









	sheet_id:	Sheet, many2one, readonly









	total_timesheet:

		Project Timesheet, float, readonly









	name:	Date, date, readonly








Object: Timesheets by period (hr_timesheet_sheet.sheet.account)





	total:	Total Time, float, readonly









	sheet_id:	Sheet, many2one, readonly









	name:	Analytic Account, many2one, readonly









	invoice_rate:	Invoice rate, many2one, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Tiny ERP Huissiers (huissier)





	Module:	huissier


	Name:	Tiny ERP Huissiers


	Version:	False


	Author:	Tiny


	Directory:	huissier


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Module for 'Maison de Vente des Huissiers de Justice'








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/trunk/5.0.zip]

	trunk [http://www.openerp.com/download/modules/trunk/huissier.zip]









Dependencies



	base

	account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Idea Manager (idea)





	Module:	idea


	Name:	Idea Manager


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	idea


	Web:	http://openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows your user to easily and efficiently participate in the innovation of the enterprise. It allows everybody to express ideas about different subjects. Then, others users can comment these ideas and vote for particular ideas. Each idea as a score based on the different votes. The managers can obtain an easy view on best ideas from all the users. Once installed, check the menu 'Ideas' in the 'Tools' main menu.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/idea.zip]

	trunk [http://www.openerp.com/download/modules/trunk/idea.zip]









Dependencies



	base









Reports

None




Menus



	Tools

	Tools/Configuration

	Tools/Configuration/Ideas

	Tools/Configuration/Ideas/Categories

	Tools/Ideas

	Tools/Ideas/Ideas by Categories

	Tools/Ideas/All Ideas

	Tools/Ideas/All Ideas/Open Ideas

	Tools/Ideas/My Ideas

	Tools/Ideas/My Ideas/My Draft Ideas

	Tools/Ideas/My Ideas/My Open Ideas

	Tools/Ideas/Reporting

	Tools/Ideas/Reporting/Vote Statistics

	Tools/Configuration/Ideas/All Votes









Views



	idea.category.form (form)

	idea.category.tree (tree)

	idea.stat.form (form)

	idea.vote.tree (tree)

	idea.vote.form (form)

	idea.idea.form (form)

	idea.idea.tree (tree)

	idea.comment.tree (tree)

	idea.vote_stat.graph (graph)

	idea.vote.stat.form (form)

	idea.vote.stat.tree (tree)









Objects


Object: Category for an idea (idea.category)





	parent_id:	Parent Categories, many2one









	child_ids:	Child Categories, one2many









	name:	Category, char, required









	summary:	Summary, text








Object: idea.idea (idea.idea)





	comment_ids:	Comments, one2many









	create_date:	Creation date, datetime, readonly









	description:	Description, text, required






Content of the idea






	title:	Idea Summary, char, required









	my_vote:	My Vote, selection









	vote_avg:	Average Score, float, readonly









	vote_ids:	Vote, one2many









	state:	Status, selection, readonly









	stat_vote_ids:	Statistics, one2many, readonly









	count_comments:	Count of comments, integer, readonly









	user_id:	Creator, many2one, required, readonly









	category_id:	Category, many2one, required









	count_votes:	Count of votes, integer, readonly








Object: Comments (idea.comment)





	content:	Comment, text, required









	idea_id:	Idea, many2one, required









	create_date:	Creation date, datetime, readonly









	user_id:	User, many2one, required








Object: idea.vote (idea.vote)





	idea_id:	Idea, many2one, required









	score:	Score, selection, required









	user_id:	User, many2one








Object: Idea Votes Statistics (idea.vote.stat)





	nbr:	Number of Votes, integer, readonly









	score:	Score, selection, readonly









	idea_id:	Idea, many2one, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Module for Import Export Business Management (import_export)





	Module:	import_export


	Name:	Module for Import Export Business Management


	Version:	5.0.1.0


	Author:	Axelor


	Directory:	import_export


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module helps users configure OpenERP for a product-selling company doing
Import Export business
Take care for the Taxes according to the govt policy for
Local Sale
With in Country Sale
or Sales Outside the Country








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/import_export.zip]

	trunk [http://www.openerp.com/download/modules/trunk/import_export.zip]









Dependencies



	base

	product

	account

	sale









Reports

None




Menus

None




Views



	* INHERIT res.partner.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi-Currency Invoice (invoice_multi_currency)





	Module:	invoice_multi_currency


	Name:	Multi-Currency Invoice


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	invoice_multi_currency


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Multi-Currency Invoice
    that will allows user to change the invoice currency.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/invoice_multi_currency.zip]

	trunk [http://www.openerp.com/download/modules/trunk/invoice_multi_currency.zip]









Dependencies



	account









Reports

None




Menus

None




Views



	* INHERIT account.invoice.line.form.inherit (form)

	* INHERIT account.invoice.supplier.form.inherit (form)









Objects

None
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Invoice Numbering (invoice_numbering)





	Module:	invoice_numbering


	Name:	Invoice Numbering


	Version:	1.0


	Author:	Tiny


	Directory:	invoice_numbering


	Web:	http://tinyerp.com/module_invoice_numbering.html


	Official module:

		no


	Quality certified:

		no






Description

This Module handles the Invoice sequences so that the invoices made in the new year(i.e. January onwards)
will have the predefined sequences.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/invoice_numbering.zip]









Dependencies



	base

	account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Invoice lines with sequence number (invoice_sequence)





	Module:	invoice_sequence


	Name:	Invoice lines with sequence number


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	invoice_sequence


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Prodide a new field on the invoice line form, allowing to manage the lines order.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/invoice_sequence.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/invoice_sequence.zip]

	trunk [http://www.openerp.com/download/modules/trunk/invoice_sequence.zip]









Dependencies



	account

	base









Reports

None




Menus

None




Views



	* INHERIT Invoice Line (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Belgium - Plan Comptable Minimum Normalise (l10n_be)





	Module:	l10n_be


	Name:	Belgium - Plan Comptable Minimum Normalise


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	l10n_be


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This is the base module to manage the accounting chart for Belgium in OpenERP.

    After Installing this module, the Configuration wizard for accounting is launched.
    * We have the account templates which can be helpful to generate Charts of Accounts.
    * On that particular wizard, you will be asked to pass the name of the company, the chart template to follow, the number of digits to generate the code for your account and Bank account, currency to create Journals.
        Thus, the pure copy of Chart Template is generated.
    * This is the same wizard that runs from Financial Management/Configuration/Financial Accounting/Financial Accounts/Generate Chart of Accounts from a Chart Template.

    Wizards provided by this module:
    * Enlist the partners with their related VAT and invoiced amounts. Prepares an XML file format. Path to access : Financial Management/Reporting/Listing of VAT Customers.
    * Prepares an XML file for Vat Declaration of the Main company of the User currently logged in. Path to access : Financial Management/Reporting/Listing of VAT Customers.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/l10n_be.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/l10n_be.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_be.zip]









Dependencies



	account

	account_report

	base_vat

	base_iban

	account_chart









Reports

None




Menus



	Financial Management/Legal Statements/Belgium Statements

	Financial Management/Legal Statements/Belgium Statements/Annual Listing of VAT-Subjected Customers

	Financial Management/Legal Statements/Belgium Statements/Periodical VAT Declaration

	Financial Management/Legal Statements/Belgium Statements/Partner VAT intra









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Canada - Quebec Chart of Accounts (l10n_ca-qc)





	Module:	l10n_ca-qc


	Name:	Canada - Quebec Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_ca-qc


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Canada-Quebec for General Profile in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_ca-qc.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_ca-qc.zip]









Dependencies



	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Austria - Chart of Accounts (l10n_chart_at)





	Module:	l10n_chart_at


	Name:	Austria - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_at


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Austria in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_at.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_at.zip]









Dependencies



	account_chart

	base_vat









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Australia - Chart of Accounts (l10n_chart_au)





	Module:	l10n_chart_au


	Name:	Australia - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_au


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Australia in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_au.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_au.zip]









Dependencies



	account

	base_iban

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Belgium - French & Dutch (l10n_chart_be_frnl)





	Module:	l10n_chart_be_frnl


	Name:	Belgium - French & Dutch


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_be_frnl


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Belgium (French and Dutch Profile) in OpenERP .








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/l10n_chart_be_frnl.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_be_frnl.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_be_frnl.zip]









Dependencies



	account

	base_vat

	base_iban

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Brazil - Chart of Accounts (l10n_chart_br)





	Module:	l10n_chart_br


	Name:	Brazil - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_br


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Brazil in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_br.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_br.zip]









Dependencies



	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Canadian - English - Chart of Accounts (l10n_chart_ca_en)





	Module:	l10n_chart_ca_en


	Name:	Canadian - English - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_ca_en


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Canada for English Profile in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_ca_en.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_ca_en.zip]









Dependencies



	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Canadian - French - Chart of Accounts (l10n_chart_ca_fr)





	Module:	l10n_chart_ca_fr


	Name:	Canadian - French - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_ca_fr


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Canada for French Profile in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_ca_fr.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_ca_fr.zip]









Dependencies



	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Switzerland - German Chart of Accounts (l10n_chart_ch_german)





	Module:	l10n_chart_ch_german


	Name:	Switzerland - German Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_ch_german


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Switzerland (German Profile) in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_ch_german.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_ch_german.zip]









Dependencies



	account

	account_chart

	base_vat









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







China - Chart of Accounts (l10n_chart_cn)





	Module:	l10n_chart_cn


	Name:	China - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_cn


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for China in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_cn.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_cn.zip]









Dependencies



	account

	account_chart









Reports

None




Menus

None




Views

None




Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







China Traditional - Chart of Account (l10n_chart_cn_traditional)





	Module:	l10n_chart_cn_traditional


	Name:	China Traditional - Chart of Account


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_cn_traditional


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for China (Traditional Profile) in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_cn_traditional.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_cn_traditional.zip]









Dependencies



	account

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Colombia - Chart of Accounts (l10n_chart_co)





	Module:	l10n_chart_co


	Name:	Colombia - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_co


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Colombia in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_co.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_co.zip]









Dependencies



	account

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Czech Republic - Chart of Accounts (l10n_chart_cz)





	Module:	l10n_chart_cz


	Name:	Czech Republic - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_cz


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Czech Republic in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_cz.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_cz.zip]









Dependencies



	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Denmark Chart of Accounts (l10n_chart_da)





	Module:	l10n_chart_da


	Name:	Denmark Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_da


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Denmark in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_da.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_da.zip]









Dependencies



	account

	base_iban

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







German - SKR03 Chart of Accounts (l10n_chart_de_skr03)





	Module:	l10n_chart_de_skr03


	Name:	German - SKR03 Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_de_skr03


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Germany (SKR03 Profile) in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_de_skr03.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_de_skr03.zip]









Dependencies



	base_iban

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Ecuador - Chart of Accounts (l10n_chart_ec)





	Module:	l10n_chart_ec


	Name:	Ecuador - Chart of Accounts


	Version:	5.0.1.0


	Author:	Cristian Salamea


	Directory:	l10n_chart_ec


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Ecuador in OpenERP.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Hungary - Chart of Accounts (l10n_chart_hu)





	Module:	l10n_chart_hu


	Name:	Hungary - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_hu


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Hungary in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_hu.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_hu.zip]









Dependencies



	base_iban

	account_chart

	base_vat









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Indian Chart of Account (l10n_chart_in)





	Module:	l10n_chart_in


	Name:	Indian Chart of Account


	Version:	5.0.1.0


	Author:	Tiny & Axelor


	Directory:	l10n_chart_in


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Indian Accounting : chart of Account








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_in.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_in.zip]









Dependencies



	account

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Italy - CC2424 - Chart of Accounts (l10n_chart_it_cc2424)





	Module:	l10n_chart_it_cc2424


	Name:	Italy - CC2424 - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_it_cc2424


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Italy (CC2424 Profile) in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_it_cc2424.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_it_cc2424.zip]









Dependencies



	account

	base_iban

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Italy - Chart of Accounts (l10n_chart_it)





	Module:	l10n_chart_it


	Name:	Italy - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_it


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Italy in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_it.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_it.zip]









Dependencies



	account

	base_vat

	base_iban

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Latvia - Chart of Accounts (l10n_chart_lv)





	Module:	l10n_chart_lv


	Name:	Latvia - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_lv


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Latvia in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_lv.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_lv.zip]









Dependencies



	account

	base_iban

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Netherlands - Chart of Accounts (l10n_chart_nl)





	Module:	l10n_chart_nl


	Name:	Netherlands - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_nl


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Netherlands in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_nl.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_nl.zip]









Dependencies



	account

	base_iban

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Netherlands - Standard Chart of Account (l10n_chart_nl_standard)





	Module:	l10n_chart_nl_standard


	Name:	Netherlands - Standard Chart of Account


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_nl_standard


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Netherlands (Standard Profile) in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_nl_standard.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_nl_standard.zip]









Dependencies



	account

	base_iban

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Norway - Chart of Accounts (l10n_chart_no)





	Module:	l10n_chart_no


	Name:	Norway - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_no


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Norway in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_no.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_no.zip]









Dependencies



	account

	base_iban

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Panama - Chart of Account (l10n_chart_pa)





	Module:	l10n_chart_pa


	Name:	Panama - Chart of Account


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_pa


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Panama in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_pa.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_pa.zip]









Dependencies



	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Poland - Chart of Accounts (l10n_chart_pl)





	Module:	l10n_chart_pl


	Name:	Poland - Chart of Accounts


	Version:	5.0.1.1


	Author:	Tiny and Grzegorz Grzelak (Cirrus)


	Directory:	l10n_chart_pl


	Web:	http://www.cirrus.pl


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Poland in OpenERP.
     Module is based on original Tiny l10n_chart_pl module version 1.0.

     To jest moduł do tworzenia wzorcowego planu kont i podstawowych ustawień do podatków
     VAT 0%, 7% i 22%. Moduł ustawia też konta do kupna i sprzedaży towarów zakładając,
     że wszystkie towary są w obrocie hurtowym.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_pl.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_pl.zip]









Dependencies



	account

	base_iban

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Romania - Chart of Accounts (l10n_chart_ro)





	Module:	l10n_chart_ro


	Name:	Romania - Chart of Accounts


	Version:	1.1


	Author:	filsys


	Directory:	l10n_chart_ro


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart, VAT structure and Registration Number for Romania in OpenERP.








Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_ro.zip]









Dependencies



	account_chart

	base_vat









Reports

None




Menus

None




Views



	* INHERIT res.partner.form.ro (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sweden - Church Chart of Account (l10n_chart_se_church)





	Module:	l10n_chart_se_church


	Name:	Sweden - Church Chart of Account


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_se_church


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Sweden (Church Profile) in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_se_church.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_se_church.zip]









Dependencies



	account

	base_iban

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sweden - Food industries - Chart of Accounts (l10n_chart_se_food)





	Module:	l10n_chart_se_food


	Name:	Sweden - Food industries - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_se_food


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Sweden (Food Industries' Profile) in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_se_food.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_se_food.zip]









Dependencies



	account

	base_iban

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sweden - Chart of Accounts (l10n_chart_se)





	Module:	l10n_chart_se


	Name:	Sweden - Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_se


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Sweden in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_se.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_se.zip]









Dependencies



	account

	base_iban

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Spain - Chart of Account (l10n_chart_sp)





	Module:	l10n_chart_sp


	Name:	Spain - Chart of Account


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_sp


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Spain in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_sp.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_sp.zip]









Dependencies



	account

	base_vat

	base_iban

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







United Kingdom - minimal (l10n_chart_uk_minimal)





	Module:	l10n_chart_uk_minimal


	Name:	United Kingdom - minimal


	Version:	5.0.1.1


	Author:	Seath Solutions Ltd


	Directory:	l10n_chart_uk_minimal


	Web:	http://www.seathsolutions.com


	Official module:

		yes


	Quality certified:

		yes






Description

This is the base module to manage the accounting chart for United Kingdom in OpenERP.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/l10n_chart_uk_minimal.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_uk_minimal.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_uk_minimal.zip]









Dependencies



	base

	account

	base_iban

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







United Kingdom Chart of Accounts (l10n_chart_uk)





	Module:	l10n_chart_uk


	Name:	United Kingdom Chart of Accounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_uk


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for United Kingdom in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_uk.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_uk.zip]









Dependencies



	account

	base_iban

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







United States - Chart of Accounts for General Profile (l10n_chart_us_general)





	Module:	l10n_chart_us_general


	Name:	United States - Chart of Accounts for General Profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_us_general


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for United States of America (General Profile) in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_us_general.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_us_general.zip]









Dependencies



	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







United States - Chart of Accounts for Manufacturing Profile (l10n_chart_us_manufacturing)





	Module:	l10n_chart_us_manufacturing


	Name:	United States - Chart of Accounts for Manufacturing Profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_us_manufacturing


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for United States of America (Manufacturing Profile) in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_us_manufacturing.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_us_manufacturing.zip]









Dependencies



	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







United States - Chart of Accounts for Services (l10n_chart_us_service)





	Module:	l10n_chart_us_service


	Name:	United States - Chart of Accounts for Services


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_us_service


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for United States of America (Service Profile) in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_us_service.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_us_service.zip]









Dependencies



	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







United States -Chart of Accounts for UCOA EZ Profile (l10n_chart_us_ucoa_ez)





	Module:	l10n_chart_us_ucoa_ez


	Name:	United States -Chart of Accounts for UCOA EZ Profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_us_ucoa_ez


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for United States of America (UCOA EZ Profile) in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_us_ucoa_ez.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_us_ucoa_ez.zip]









Dependencies



	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







United States - Chart of Accounts for UCOA (l10n_chart_us_ucoa)





	Module:	l10n_chart_us_ucoa


	Name:	United States - Chart of Accounts for UCOA


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_chart_us_ucoa


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for United States of America (UCOA Profile) in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_us_ucoa.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_us_ucoa.zip]









Dependencies



	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Venezuela -Chart of Account (l10n_chart_ve)





	Module:	l10n_chart_ve


	Name:	Venezuela -Chart of Account


	Version:	False


	Author:	Tiny


	Directory:	l10n_chart_ve


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Venezuela in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_chart_ve.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_chart_ve.zip]









Dependencies



	account

	base_vat

	account_chart









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Suisse - Plan comptable general pour PME STERCHI (l10n_ch_chart_c2c_pcg)





	Module:	l10n_ch_chart_c2c_pcg


	Name:	Suisse - Plan comptable general pour PME STERCHI


	Version:	5.0.1.0


	Author:	Camptocamp


	Directory:	l10n_ch_chart_c2c_pcg


	Web:	camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Swiss account chart that add also tax template definition








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_ch_chart_c2c_pcg.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_ch_chart_c2c_pcg.zip]









Dependencies



	account

	account_chart

	l10n_ch









Reports

None




Menus

None




Views



	account.tax.template.todo (form)









Objects


Object: account.tax.template.todo (account.tax.template.todo)





	account_paid_id:

		Refund Tax Account, many2one






You can set                                             here the refund tax account






	name:	Tax to set, many2one, readonly






The tax template you are currently editing






	account_collected_id:

		Invoice Tax Account, many2one






You can set                                                 here the invoice tax account
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Plan comptable général pour les PME (l10n_ch_pcg)





	Module:	l10n_ch_pcg


	Name:	Plan comptable général pour les PME


	Version:	1.0


	Author:	Camptocamp


	Directory:	l10n_ch_pcg


	Web:	http://tinyerp.com/module_account.html


	Official module:

		no


	Quality certified:

		no






Description

Plan comptable général pour les PME








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/l10n_ch_chart_c2c_pcg.zip]









Dependencies



	account

	l10n_ch









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Switzerland localisation corrected by Camptocamp (l10n_ch)





	Module:	l10n_ch


	Name:	Switzerland localisation corrected by Camptocamp


	Version:	5.0.5.0


	Author:	Camptocamp SA


	Directory:	l10n_ch


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Swiss localisation :
 - DTA generation for a lot of paiment types
 - BVR management (number generation, report, etc..)
 - Import account move from the bank file (like v11 etc..)
 - Simplify the way you handle the bank statement for reconciliation

You can also add with this module one of the following account plan:
 - l10n_ch_c2c_pcg



------------------------------------------------------------------------

Module incluant la localisation Suisse de TinyERP revu et corrigé par Camptocamp. Cette nouvelle version
comprend la gestion et l'émissionde BVR, le paiement électronique via DTA (pour les banques, le système postal est en développement)
et l'import du relevé de compte depuis la banque de manière automatisée.
De plus, nous avons intégré la définition de toutes les banques Suisses(adresse, swift et clearing).

Par ailleurs, conjointement à ce module, nous proposons 1 plan comptables issus de l'USAM :


 - l10n_ch_c2c_pcg

--------------------------------------------------------------------------
TODO :
- Implement bvr import partial reconciliation
- Replace wizard by osv_memory when possible
- Add missing HELP
- Finish code comment
- Improve demo data








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/l10n_ch.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/l10n_ch.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_ch.zip]









Dependencies



	base

	account

	base_vat

	base_iban

	account_payment

	account_tax_include









Reports



	BVR A4 Sheet

	Invoice with BVR









Menus

None




Views



	* INHERIT partner - bank inherit (form)

	* INHERIT partner - bank inherit (form)

	* INHERIT account.bank.statement.form.inherit (form)

	* INHERIT res.company.form.inherit.bvr (form)

	* INHERIT account.invoice.supplier.form.inherit (form)

	* INHERIT account.invoice.supplier.form.inherit (form)

	* INHERIT account.invoice.form.inherit (form)

	* INHERIT res.bank.form (form)

	* INHERIT res.bank.tree (tree)

	* INHERIT res.partner_partner_bank.form (form)

	account.journal.todo.form (form)









Objects


Object: account.journal.todo (account.journal.todo)





	default_debit_account_id:

		Default Debit Account, many2one






The Default Debit Account of the account journal






	default_credit_account_id:

		Default Credit Account, many2one






The Default Credit Account of the account journal






	name:	Journal to set, many2one, readonly






the currently edited account journal
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Switzerland - VAT Brut (l10n_ch_vat_brut)





	Module:	l10n_ch_vat_brut


	Name:	Switzerland - VAT Brut


	Version:	False


	Author:	Tiny


	Directory:	l10n_ch_vat_brut


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_ch_vat_brut.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_ch_vat_brut.zip]









Dependencies



	l10n_ch









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Switzerland - VAT Forfait (l10n_ch_vat_forfait)





	Module:	l10n_ch_vat_forfait


	Name:	Switzerland - VAT Forfait


	Version:	False


	Author:	Tiny


	Directory:	l10n_ch_vat_forfait


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_ch_vat_forfait.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_ch_vat_forfait.zip]









Dependencies



	l10n_ch









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Switzerland - VAT Net (l10n_ch_vat_net)





	Module:	l10n_ch_vat_net


	Name:	Switzerland - VAT Net


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_ch_vat_net


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_ch_vat_net.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_ch_vat_net.zip]









Dependencies



	l10n_ch









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Switzerland localisation bank and zip data Camptocamp (l10n_ch_zip_and_bank)





	Module:	l10n_ch_zip_and_bank


	Name:	Switzerland localisation bank and zip data Camptocamp


	Version:	5.0.5.0


	Author:	Camptocamp SA


	Directory:	l10n_ch_zip_and_bank


	Web:	http://www.camptocamp.com


	Official module:

		no


	Quality certified:

		no






Description

Swiss localisation :
 Swiss banks and zip codes initialisation








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_ch_zip_and_bank.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_ch_zip_and_bank.zip]









Dependencies



	l10n_ch

	base









Reports

None




Menus

None




Views

None




Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







France - Generation de compte comptable tiers (l10n_fr_account_generation)





	Module:	l10n_fr_account_generation


	Name:	France - Generation de compte comptable tiers


	Version:	5.0.1.0


	Author:	SISTHEO


	Directory:	l10n_fr_account_generation


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Add a button in partners form for creating the payable and receive accounts in general account.

Credits: Sistheo Zeekom








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_fr_account_generation.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_fr_account_generation.zip]









Dependencies



	base

	account

	account_chart









Reports

None




Menus



	Financial Management/Configuration/Account generation config









Views



	* INHERIT res.partner.form (form)

	account.generation.config.form (form)









Objects


Object: Account Generation Configuration (account.generation.config)





	customer:	Global Customer, many2one









	supplier:	Global Supplier, many2one









	name:	Configuration Name, char, required









	nbcar:	Char size, integer






Number of character for the creation of accounts
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







France - Export ecritures (l10n_fr_export)





	Module:	l10n_fr_export


	Name:	France - Export ecritures


	Version:	5.0.1.0


	Author:	SISTHEO


	Directory:	l10n_fr_export


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This is the module to export entries lines for one fiscal year.

Credits: Sistheo Zeekom CrysaLEAD








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_fr_export.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_fr_export.zip]









Dependencies



	base

	account

	account_chart

	document









Reports

None




Menus



	Financial Management/Configuration/Financial Accounting/Export Fiscal Year









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







France - Plan Comptable Général (l10n_fr_pcg)





	Module:	l10n_fr_pcg


	Name:	France - Plan Comptable Général


	Version:	False


	Author:	Simon JAILLET - CrysaLEAD


	Directory:	l10n_fr_pcg


	Web:	http://www.crysalead.com


	Official module:

		no


	Quality certified:

		no






Description

This module is deprecated... Please use l10n_fr from the addons instead.

Thanks.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/l10n_fr_pcg.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/l10n_fr_pcg.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_fr_pcg.zip]









Dependencies



	base

	account

	account_chart

	base_vat









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







France - Plan Comptable Général (l10n_fr)





	Module:	l10n_fr


	Name:	France - Plan Comptable Général


	Version:	5.0.1.0


	Author:	OpenERP


	Directory:	l10n_fr


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This is the module to manage the accounting chart for France in OpenERP.

Credits: Sistheo Zeekom CrysaLEAD








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/l10n_fr.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/l10n_fr.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_fr.zip]









Dependencies



	base

	account

	account_chart

	account_report

	base_vat









Reports



	Compte de resultat

	Bilan









Menus

None




Views

None




Objects


Object: Report for l10n_fr (l10n.fr.report)





	line_ids:	Lines, one2many









	code:	Code, char









	name:	Name, char








Object: Report Lines for l10n_fr (l10n.fr.line)





	definition:	Definition, char









	code:	Variable Name, char









	name:	Name, char









	report_id:	Report, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







France - Franchise de TVA (ex: Micro Entreprise, etc.) (l10n_fr_tva_franchise)





	Module:	l10n_fr_tva_franchise


	Name:	France - Franchise de TVA (ex: Micro Entreprise, etc.)


	Version:	False


	Author:	Simon JAILLET - CrysaLEAD


	Directory:	l10n_fr_tva_franchise


	Web:	http://www.crysalead.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/l10n_fr_tva_franchise.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/l10n_fr_tva_franchise.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_fr_tva_franchise.zip]









Dependencies



	base

	account

	account_chart

	l10n_fr

	l10n_fr_pcg









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







France - Régime réel de TVA (l10n_fr_tva_reel)





	Module:	l10n_fr_tva_reel


	Name:	France - Régime réel de TVA


	Version:	False


	Author:	Simon JAILLET - CrysaLEAD


	Directory:	l10n_fr_tva_reel


	Web:	http://www.crysalead.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/l10n_fr_tva_reel.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/l10n_fr_tva_reel.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_fr_tva_reel.zip]









Dependencies



	base

	account

	account_chart

	l10n_fr

	l10n_fr_pcg









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Luxembourg - Plan Comptable Minimum Normalise (l10n_lu)





	Module:	l10n_lu


	Name:	Luxembourg - Plan Comptable Minimum Normalise


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_lu


	Web:	http://openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module installs:

    *the KLUWER Chart of Accounts,
    *the Tax Code Chart for Luxembourg
    *the main taxes used in Luxembourg








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_lu.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_lu.zip]









Dependencies



	account

	account_report

	base_vat

	base_iban









Reports



	Luxembourg VAT Declaration









Menus



	Financial Management/Legal Statements/Luxembourg

	Financial Management/Legal Statements/Luxembourg/VAT Declaration









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Maroc Plan comptable général pour les sociétés (l10n_ma)





	Module:	l10n_ma


	Name:	Maroc Plan comptable général pour les sociétés


	Version:	5.0.1.0


	Author:	SISatlas


	Directory:	l10n_ma


	Web:	http://comptabilite.erp-libre.info


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Morocco in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_ma.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_ma.zip]









Dependencies



	base

	account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Simple Account Chart (l10n_simple)





	Module:	l10n_simple


	Name:	Simple Account Chart


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	l10n_simple


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This is the module to manage the accounting chart for Europe in OpenERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/l10n_simple.zip]

	trunk [http://www.openerp.com/download/modules/trunk/l10n_simple.zip]









Dependencies



	account_chart









Reports

None




Menus

None




Views



	Tax Configure wizard (form)









Objects


Object: tax.config.wizard (tax.config.wizard)





	name:	Tax(%) On Invoice, float






Normal tax percent to apply on invoices
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Partner labels (label)





	Module:	label


	Name:	Partner labels


	Version:	5.0.1.0


	Author:	Zikzakmedia SL


	Directory:	label


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Flexible partner labels:
  * Definition of page sizes, label manufacturers and label formats
  * Flexible label formats (page size, portrait or landscape, manufacturer, rows, columns, width, height, top margin, left margin, ...)
  * Initial data for page sizes and label formats (from Avery and Apli manufacturers)
  * Wizard to print labels. The label format, the printer margins, the font type and size, the first label (row and column) to print on the first page can be set.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/label.zip]

	trunk [http://www.openerp.com/download/modules/trunk/label.zip]









Dependencies



	base









Reports

None




Menus



	Partners/Configuration/Page Sizes

	Partners/Configuration/Label Manufacturers

	Partners/Configuration/Label Formats









Views



	report.pagesize.tree (tree)

	report.pagesize (form)

	report.label.tree (tree)

	report.label (form)









Objects


Object: report.pagesize (report.pagesize)





	width:	Width, char, required






Numeric width of the page ended with the unit (cm or in). For example, A4 is 21cm and letter is 8.5in






	name:	Name, char, required









	height:	Height, char, required






Numeric height of the page ended with the unit (cm or in). For example, A4 is 29.7cm and letter is 11in





Object: report.label.manufacturer (report.label.manufacturer)





	name:	Name, char, required








Object: report.label (report.label)





	rows:	Number of Rows, integer, required









	description:	Description, text









	label_height:	Label Height, char, required






Numeric value ended with the unit (cm or in). For example 29.7cm or 11in






	label_width:	Label Width, char, required






Numeric value ended with the unit (cm or in). For example 29.7cm or 11in






	pagesize_id:	Page Size, many2one, required









	cols:	Number of Columns, integer, required









	width_incr:	Width Increment, char, required






Width between start positions of 2 labels. Numeric value ended with the unit (cm or in). For example 29.7cm or 11in






	margin_top:	Top Margin, char, required






Numeric value ended with the unit (cm or in). For example 29.7cm or 11in






	margin_left:	Left Margin, char, required






Numeric value ended with the unit (cm or in). For example 29.7cm or 11in






	height_incr:	Height Increment, char, required






Height between start positions of 2 labels. Numeric value ended with the unit (cm or in). For example 29.7cm or 11in






	manufacturer_id:

		Manufacturer, many2one









	landscape:	Landscape, boolean






No check -> Portrait. Check -> Landscape






	name:	Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Labo stock create Progenus project (labo_stock)





	Module:	labo_stock


	Name:	Labo stock create Progenus project


	Version:	1.0


	Author:	Tiny


	Directory:	labo_stock


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Progenus project Labo stock object




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/labo_stock.zip]









Dependencies



	base

	account

	product

	stock

	sale









Reports



	Composition Mix









Menus

None




Views



	Mix (tree)

	Mix (form)

	Category (form)

	Category (tree)

	Category (form)

	Category (tree)

	Amorces (tree)

	Reactives (form)

	Reactives (tree)

	Reactives (form)

	History (tree)

	History (form)

	Mix (form)

	Mix (tree)

	Form mix (form)

	Form mix (tree)

	labo_stock_article_view_tree (tree)

	labo_stock_article_view_form (form)

	* INHERIT product.category.form (form)









Objects



	mix.category

	amorces.category

	labo.article.category

	labo.amorces

	labo.article

	labo.type.reactives

	stock.reactives

	reactive.history

	form.mix

	labo.mix
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Labo tools create Progenus project (labo_tool)





	Module:	labo_tool


	Name:	Labo tools create Progenus project


	Version:	1.0


	Author:	Tiny


	Directory:	labo_tool


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Progenus project Labo tools object




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/labo_tool.zip]









Dependencies



	base

	account

	product

	stock

	sale

	crm









Reports

None




Menus

None




Views



	labo.log.form (form)

	labo.log.tree (tree)

	Equipment (tree)

	Equipment (form)

	Intervention (form)

	Intervention (tree)









Objects



	labo.tool

	labo.log

	labo.intervention
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Library Management (library)





	Module:	library


	Name:	Library Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	library


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module to manage library.
    Books Information,
    Publisher and Author Information,
    Book Rack Tracking etc...








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/library.zip]

	trunk [http://www.openerp.com/download/modules/trunk/library.zip]









Dependencies



	point_of_sale

	report_intrastat

	mrp

	delivery









Reports

None




Menus



	Products/Authors

	Products/Authors/New Author

	Products/Books

	Products/Books/Books to return before 30 days

	Sales Management/Orders of the day

	Sales Management/Orders of the day/My orders of the day

	Partners/Editor - Suppliers Relations

	Products/Books/New Book

	Books/Configuration/Price Categories









Views



	product.product.tree (tree)

	library.author.form (form)

	library.author.tree (tree)

	Library Rack (form)

	product.book.tree.view (tree)

	product.book.form.view (form)

	sale.order.tree (tree)

	account.invoice.tree (tree)

	stock.picking.tree (tree)

	library.price.category (tree)

	library.price.category (form)

	library.editor.supplier (form)

	Editor - supplier relations (tree)

	* INHERIT mrp.procurement.form (form)

	* INHERIT Stock packing (form)

	* INHERIT Stock packing (form)

	* INHERIT purchase.order.line.form (form)

	* INHERIT sale.order.form (form)

	* INHERIT Sale line (form)

	* INHERIT Sale Lines (tree)

	* INHERIT product.supplierinfo.form.view (form)

	* INHERIT purchase.order.line.tree (tree)

	* INHERIT account.invoice.line.form (form)









Objects


Object: Book Price Category (library.price.category)





	price:	Price, float, required









	name:	Category, char, required









	product_ids:	Books, one2many, readonly








Object: Library Rack (library.rack)





	active:	Active, boolean









	code:	Code, char









	name:	Name, char, required








Object: Library Collection (library.collection)





	code:	Code, char









	name:	Name, char, required








Object: Author (library.author)





	first_name:	First Name, char









	name:	Name, char, required









	editor_ids:	Editors, many2many









	book_ids:	Books, many2many









	death_date:	Date of death, date









	note:	Notes, text









	born_date:	Date of birth, date









	biography:	Biography, text








Object: author.book.rel (author.book.rel)





	author_id:	Author, many2one









	product_id:	Book, many2one








Object: many2many view for editor relations (library.editor.supplier)





	junk:	, text, readonly









	supplier_id:	Supplier, many2one









	name:	Editor, many2one









	sequence:	Sequence, integer
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Loan Management (loan)





	Module:	loan


	Name:	Loan Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	loan


	Web:	http://tinyerpindia.com


	Official module:

		no


	Quality certified:

		no






Description

Loan Management System
    Integrated with the Payroll System








Download links

You can download this module as a zip file in the following version:


	5.0 [http://www.openerp.com/download/modules/5.0/loan.zip]






Dependencies



	base

	account









Reports



	Loan Paper









Menus



	Financial Management/Configuration/Loan/Proof Type

	Financial Management/Configuration/Loan/Loan Period

	Financial Management/Loan/Personal Loan

	Financial Management/Loan/Personal Loan/Apprived Loans

	Financial Management/Loan/Personal Loan/Small Loans

	Financial Management/Loan/Personal Loan/Medium Loans

	Financial Management/Loan/Personal Loan/Large Loans

	Financial Management/Loan/Cheque

	Financial Management/Loan/Cheque/Draft

	Financial Management/Loan/Cheque/Posted

	Financial Management/Loan/Installment

	Financial Management/Configuration/Loan/Interest/Interest List

	Financial Management/Configuration/Loan/Interest/Interest Version

	Financial Management/Loan/Report Of Partner Loan









Views



	account.loan.proof.type.form (form)

	account.loan.proof.type.tree (tree)

	loan.installment.period.form (form)

	loan.installment.period.tree (tree)

	* INHERIT res.partner.form.inherit (form)

	account.loan.proof.tree (tree)

	account.loan.installment.tree (tree)

	account.loan.proof.form (form)

	account.loan.tree (tree)

	account.loan.form (form)

	account.loan.bank.cheque.form (form)

	account.loan.bank.cheque.tree (tree)

	account.loan.installment.form (form)

	account.loan.installment.tree (tree)

	account.loan.loantype.form (form)

	account.loan.loantype.tree (tree)

	account.loan.loantype.interestversion.form (form)

	account.loan.loantype.interestversion.tree (tree)

	account.loan.loantype.interestversionline.form (form)

	account.loan.loantype.interestversionline.tree (tree)









Objects


Object: account.loan (account.loan)




Object: account.loan.proof.type (account.loan.proof.type)




Object: account.loan.proof (account.loan.proof)




Object: account loan type  (account.loan.loantype)




Object: account.loan.loantype.interestversion (account.loan.loantype.interestversion)




Object: account.loan.loantype.interestversionline (account.loan.loantype.interestversionline)




Object: Bank Account Cheque (account.loan.bank.cheque)




Object: account.loan.installment (account.loan.installment)




Object: loan.installment.period (loan.installment.period)
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Lunch Module (lunch)





	Module:	lunch


	Name:	Lunch Module


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	lunch


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/lunch.zip]

	trunk [http://www.openerp.com/download/modules/trunk/lunch.zip]









Dependencies



	base









Reports



	Print Order









Menus



	Tools

	Tools/Lunch

	Tools/Lunch/Configuration

	Tools/Lunch/Make order

	Tools/Lunch/Make order/Order of the day

	Tools/Lunch/Configuration/CashBox

	Tools/Lunch/Cash Moves

	Tools/Lunch/Configuration/Products

	Tools/Lunch/Configuration/Products/Category of product

	Tools/Lunch/Box Amount by User









Views



	Order (form)

	Order (tree)

	CashBox (form)

	CashBox (tree)

	CashMove (form)

	CashMove (tree)

	Category of product  (form)

	Category (tree)

	Products (form)

	Products (tree)

	Lunch amount (tree)

	Lunch amount (form)









Objects


Object: Category (lunch.category)





	name:	Name, char, required








Object: lunch.product (lunch.product)





	active:	Active, boolean









	price:	Price, float









	category_id:	Category, selection









	name:	Name, char, required









	description:	Description, char








Object: lunch.cashbox (lunch.cashbox)





	manager:	Manager, many2one









	name:	Name, char, required









	sum_remain:	Remained Total, float, readonly








Object: lunch.cashmove (lunch.cashmove)





	box:	Box Name, many2one, required









	create_date:	Created date, datetime, readonly









	name:	Name, char









	user_cashmove:	User Name, many2one, required









	amount:	Amount, float









	active:	Active, boolean








Object: lunch.order (lunch.order)





	product:	Product, many2one, required, readonly









	user_id:	User Name, many2one, required, readonly









	price:	Price, float, readonly









	descript:	Description Order, char, readonly









	state:	State, selection, readonly









	date:	Date, date, readonly









	cashmove:	CashMove, many2one, readonly








Object: Amount available by user and box (report.lunch.amount)





	box:	Box Name, many2one, readonly









	amount:	Amount, float, readonly









	user_id:	User Name, many2one, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Magento Synchro Smile (magento_openerp_synchro)





	Module:	magento_openerp_synchro


	Name:	Magento Synchro Smile


	Version:	5.0.0.9.9


	Author:	Smile


	Directory:	magento_openerp_synchro


	Web:	http://code.google.com/p/magento-openerp-smile-synchro/


	Official module:

		no


	Quality certified:

		no






Description

Magento OpenERP Interface - This module allows product catalog
and sale orders synchronization between OpenERP and Magento.
This module is contributed by the Smile French IT company (www.smile.fr)
and Zikzakmedia (www.zikzakmedia.com)








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/magento_openerp_synchro.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/magento_openerp_synchro.zip]

	trunk [http://www.openerp.com/download/modules/trunk/magento_openerp_synchro.zip]









Dependencies



	product

	stock

	sale

	account

	account_tax_include









Reports

None




Menus



	Magento

	Magento/Magento Web

	Magento/Synchronization

	Magento/Synchronization/Synchronize products and stocks

	Magento/Synchronization/Synchronize categories

	Magento/Synchronization/Import sale orders

	Magento/Synchronization/Correct sale orders

	Magento/Synchronization/Update sale orders









Views



	* INHERIT product.product.form.magento (form)

	* INHERIT product.product.tree.magento (tree)

	* INHERIT product.category.form.magento (form)

	* INHERIT product.category.tree.magento (tree)

	* INHERIT product.pricelist.form.magento (form)

	* INHERIT product.pricelist.tree.magento (tree)

	* INHERIT sale.order.form.magento (form)

	* INHERIT sale.order.tree.magento (tree)

	* INHERIT res.partner.form.magento (form)

	* INHERIT res.partner.tree.magento (tree)

	* INHERIT sale.shop.tree.magento (tree)

	* INHERIT sale.shop.form.inherit (form)

	magento.web.form (form)

	magento.web.tree (tree)









Objects


Object: Magento Web (magento.web)





	api_pwd:	Magento Api Password, char









	api_user:	Magento Api User, char









	auto_update:	Auto update products and categories, boolean






If auto update is checked, when you create, modify or delete products and categories in OpenERP, they are automatically created, modified or deleted in Magento. Also, if a existing product or category in OpenERP is checked as exportable, it is created in Magento. And when is unchecked as exportable, it is deleted in Magento.






	magento_url:	Magento Url, char






URL to Magento shop ending with /






	magento_flag:	Magento web flag, boolean






The Magento active web must have this box checked.






	magento_name:	Magento web name, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Maintenance Editor (maintenance_editor)





	Module:	maintenance_editor


	Name:	Maintenance Editor


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	maintenance_editor


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

module to manage maintenance contracts:








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/maintenance_editor.zip]

	trunk [http://www.openerp.com/download/modules/trunk/maintenance_editor.zip]









Dependencies



	base

	product

	crm









Reports



	Basic Contract

	SMB Contract

	Corporate Contract









Menus



	Administration/Modules Management/Maintenance Editor

	Administration/Modules Management/Maintenance Editor/Maintenance Contracts

	Administration/Modules Management/Maintenance Editor/Maintenance Modules

	Administration/Modules Management/Maintenance Editor/Maintenance Contract Types

	Administration/Modules Management/Maintenance Editor/Maintenance Modules/Refresh Module List









Views



	maintenance.maintenance.tree (tree)

	maintenance.maintenance.form (form)

	maintenance.maintenance.module.tree (tree)

	maintenance.maintenance.module.form (form)

	maintenance.contract.type.form (form)









Objects


Object: maintenance modules (maintenance.maintenance.module)





	path:	Path, char, readonly









	version:	Version, char, readonly









	name:	Name, char, required, readonly









	certificate:	Certificate Code, char, required, readonly








Object: maintenance.contract.type (maintenance.contract.type)





	crm_case_categ_id:

		CRM Case Category, many2one, required









	name:	Name, char, required









	crm_case_section_id:

		CRM Case Section, many2one, required









	product_id:	Product, many2one








Object: maintenance contract (maintenance.maintenance)





	name:	Contract ID, char, required









	type_id:	Contract Type, many2one, required









	module_ids:	Modules, many2many









	date_from:	Date From, date, required









	note:	Note, text









	state:	State, selection, readonly









	date_to:	Date To, date, required









	partner_invoice_id:

		Address, many2one









	password:	Password, char, required









	partner_id:	Partner, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Marketing Campaigns (marketing)





	Module:	marketing


	Name:	Marketing Campaigns


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	marketing


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Marketing management module








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/marketing.zip]

	trunk [http://www.openerp.com/download/modules/trunk/marketing.zip]









Dependencies



	base









Reports

None




Menus



	Marketing Operations

	Marketing Operations/Campaigns

	Marketing Operations/Configuration

	Marketing Operations/Configuration/Campaign Definition









Views



	campaign.campaign.view (tree)

	campaign.campaign.view (form)

	campaign.step.tree (tree)

	campaign.step.form (form)

	campaign.partner.tree (tree)

	campaign.partner.form (form)

	campaign.partner.history.form (form)

	campaign.partner.history.tree (tree)









Objects


Object: campaign.campaign (campaign.campaign)





	info:	Description, text









	date_stop:	Stop Date, date









	name:	Name, char, required









	date_start:	Start Date, date









	planned_costs:	Planned Costs, float









	costs:	Initial Costs, float









	step_id:	Campaign Steps, one2many









	planned_revenue:

		Planned Revenue, float








Object: campaign.step (campaign.step)





	info:	Description, text









	name:	Step Name, char, required









	procent:	Success Rate (0<x<1), float









	stop_date:	Stop Date, date









	campaign_id:	Campaign, many2one









	priority:	Sequence, integer, required









	costs:	Step Costs, float









	active:	Active, boolean









	max_try:	Max Attempts, integer









	start_date:	Start Date, date








Object: campaign.partner (campaign.partner)





	part_adr_id:	Partner Address, many2one, required









	info:	Comments, text









	state:	State, selection, readonly









	user_id:	Salesman, many2one









	name:	Name / Reference, char, required









	date_recall:	Call again on, datetime









	notes:	Prospect Notes, text









	campaign_id:	Campaign, many2one









	priority:	Priority, selection, required









	active:	Active, boolean









	step:	Step, many2one, required









	contact:	Partner Contact, char









	history_ids:	History, one2many









	partner_id:	Partner, many2one, required








Object: campaign.partner.history (campaign.partner.history)





	info:	Comments, text









	name:	History, char, required









	camp_partner_id:

		Prospect, many2one, readonly









	step_attempt:	Attempt, integer, readonly









	date:	Date, datetime, readonly









	step_id:	Step, many2one, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Pilot Human Resource Management (md_hr_contract)





	Module:	md_hr_contract


	Name:	Pilot Human Resource Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	md_hr_contract


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Contract Module for human resource management. You can manage:
    * Contract of the employee
    * Availability of the employee
    and many more.................








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/md_hr_contract.zip]

	trunk [http://www.openerp.com/download/modules/trunk/md_hr_contract.zip]









Dependencies



	base

	hr

	hr_contract









Reports

None




Menus

None




Views



	* INHERIT md.hr.contract.form1 (form)

	* INHERIT md.hr.contract.form2 (form)

	* INHERIT md.hr.contract.form3 (form)

	* INHERIT md.hr.contract.form4 (form)

	* INHERIT md.hr.contract.form5 (form)

	* INHERIT md.hr.employee.form1 (form)

	md.hr.contract.availability.form (form)

	md.hr.contract.availability.tree (tree)

	* INHERIT hr.department.form (form)









Objects


Object: HR Contract Availability (md.hr.contract.availability)





	to_hour:	To, time









	from_hour:	From, time









	contract_id:	Contract, many2one









	day:	Day, selection
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Pilot Human Resources (md_hr_course)





	Module:	md_hr_course


	Name:	Pilot Human Resources


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	md_hr_course


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/md_hr_course.zip]

	trunk [http://www.openerp.com/download/modules/trunk/md_hr_course.zip]









Dependencies



	hr









Reports

None




Menus



	Human Resources

	Human Resources/Courses

	Human Resources/Courses/Courses

	Human Resources/Courses/Courses by Employee









Views



	md.hr.course.form (form)

	md.hr.course.tree (tree)

	md.hr.course.student.form (form)

	md.hr.course.student.tree (tree)









Objects


Object: Course (md.hr.course)





	code:	Code, char, required









	name:	Course title, char, required








Object: Course Student (md.hr.course.student)





	payback_clause_ends:

		Pay back clause ends, date









	employee_id:	Employee, many2one









	date:	Date followed, date









	state:	State, selection









	course_id:	Course, many2one









	amount:	Amount, float









	payback_clause:	Pay back clause (in %), float









	personal_contribution:

		Personal Contribution, boolean
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Pilot Human Resources (md_hr_employee)





	Module:	md_hr_employee


	Name:	Pilot Human Resources


	Version:	False


	Author:	Tiny


	Directory:	md_hr_employee


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/md_hr_employee.zip]

	trunk [http://www.openerp.com/download/modules/trunk/md_hr_employee.zip]









Dependencies



	base

	hr

	hr_holidays_request

	md_hr_contract

	hr_evaluation









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Membership card (membership_card)





	Module:	membership_card


	Name:	Membership card


	Version:	5.0.1.0


	Author:	Zikzakmedia SL


	Directory:	membership_card


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Adds a photo field to partner contact.
Prints membership cards with name, number, bar code and photo of contacts.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/membership_card.zip]

	trunk [http://www.openerp.com/download/modules/trunk/membership_card.zip]









Dependencies



	base









Reports



	Membership card

	Membership card









Menus

None




Views



	* INHERIT res.partner.address.form1.mcard (form)

	* INHERIT res.partner.form.mcard (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Membership (membership)





	Module:	membership


	Name:	Membership


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	membership


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows you to manage all operations for managing memberships.
It supports different kind of members:
* Free member
* Associated member (ex: a group subscribe for a membership for all
  subsidiaries)
* Paid members,
* Special member prices, ...

It is integrated with sales and accounting to allow you to automatically
invoice and send propositions for membership renewal.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/membership.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/membership.zip]

	trunk [http://www.openerp.com/download/modules/trunk/membership.zip]









Dependencies



	base

	product

	account

	process









Reports

None




Menus



	Membership

	Membership/Configuration

	Membership/Configuration/Membership products

	Membership/Current members

	Membership/Current members/Paid members

	Membership/Current members/Free members

	Membership/Current members/Associated members

	Membership/Current members/Invoiced members

	Membership/Future members (invoice not confirmed)

	Membership/Old members

	Membership/Reporting

	Membership/Reporting/Membership by Years

	Membership/Reporting/New Membership by Years









Views



	Membership products (tree)

	Membership products (form)

	* INHERIT Membership product (form)

	Current members (tree)

	associate members (tree)

	* INHERIT res.partner.tree.form.inherit (form)

	* INHERIT res.partner.form.inherit (form)

	report.partner_member.year.tree (tree)

	report.partner_member.year.tree (tree)

	report.partner_member.year.graph1 (graph)

	report.partner_member.year.graph2 (graph)

	report.partner_member.year_new.tree (tree)

	report.partner_member.year_new.tree (tree)

	report.partner_member.year_new.graph1 (graph)

	report.partner_member.year_new.graph2 (graph)

	* INHERIT product.normal.form (form)









Objects


Object: Member line (membership.membership_line)





	date_from:	From, date









	state:	State, selection, readonly









	account_invoice_line:

		Account Invoice line, many2one









	date_to:	To, date









	partner:	Partner, many2one









	date_cancel:	Cancel date, date








Object: Membership by Years (report.partner_member.year)





	waiting_number:	Waiting, integer, readonly









	paid_amount:	Paid, float, readonly









	invoiced_amount:

		Invoiced, float, readonly









	paid_number:	Paid, integer, readonly









	canceled_number:

		Cancelled, integer, readonly









	currency:	Currency, many2one, readonly









	invoiced_number:

		Invoiced, integer, readonly









	year:	Year, char, readonly









	waiting_amount:	Waiting, float, readonly









	canceled_amount:

		Cancelled, float, readonly








Object: New Membership by Years (report.partner_member.year_new)





	waiting_number:	Waiting, integer, readonly









	paid_amount:	Paid, float, readonly









	invoiced_amount:

		Invoiced, float, readonly









	paid_number:	Paid, integer, readonly









	canceled_number:

		Cancelled, integer, readonly









	currency:	Currency, many2one, readonly









	invoiced_number:

		Invoiced, integer, readonly









	year:	Year, char, readonly









	waiting_amount:	Waiting, float, readonly









	canceled_amount:

		Cancelled, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Merge Picking (merge_picking)





	Module:	merge_picking


	Name:	Merge Picking


	Version:	5.0.1.0


	Author:	Axelor


	Directory:	merge_picking


	Web:	www.axelor.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/merge_picking.zip]

	trunk [http://www.openerp.com/download/modules/trunk/merge_picking.zip]









Dependencies



	base

	stock









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.




Environment Management System (mgmtsystem_environment)





	Module:	mgmtsystem_environment


	Name:	Environment Management System


	Version:	6.0.0.0.1


	Author:	Savoir-faire Linux


	Directory:	mgmtsystem_environment


	Web:	http://www.savoirfairelinux.com


	Official module:

		no


	Quality certified:

		no






Description

Environment Management System provides you with all the required applications to manage:

* Manual, environment aspects, targets and programs
* Audits with report and verification list
* Non-conformities with causes and origins
* Immediate, corrective and preventive actions
* Improvement opportunities








Download links

This module is available in extra-trunk:



	trunk [https://code.launchpad.net/~openerp-commiter/openobject-addons/trunk-extra-addons]









Dependencies



	mgmtsystem

	mgmtsystem_action

	mgmtsystem_audit

	mgmtsystem_nonconformity

	wiki_environment_manual

	wiki_environmental_aspect









Reports



	Audit reports

	Verification lists









Menus



	Management System

	Management System/Audits

	Management System/Nonconformities

	Management System/Actions

	Management System/Configuration

	Management System/Configuration/Causes

	Management System/Configuration/Origins









Views



	mgmtsystem.action.form (form)

	mgmtsystem.action.tree (tree)

	mgmtsystem.audit.form (form)

	mgmtsystem.audit.tree (tree)









Objects


Object: mgmtsystem.action





	reference:	Reference, char, required


	type_action:	Type of Action, selection


	message_ids:	Message Ids, one2many(mailgate.message)
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.




Quality Management System (mgmtsystem_quality)





	Module:	mgmtsystem_quality


	Name:	Quality Management System


	Version:	6.0.0.0.1


	Author:	Savoir-faire Linux


	Directory:	mgmtsystem_quality


	Web:	http://www.savoirfairelinux.com


	Official module:

		no


	Quality certified:

		no






Description

Quality Management System provides you with all the required applications to manage:

* Manuals, procedures and work instructions
* Audits with report and verification list
* Non-conformities with causes and origins
* Immediate, corrective and preventive actions
* Improvement opportunities








Download links

This module is available in extra-trunk:



	trunk [https://code.launchpad.net/~openerp-commiter/openobject-addons/trunk-extra-addons]









Dependencies



	mgmtsystem

	mgmtsystem_action

	mgmtsystem_audit

	mgmtsystem_nonconformity

	wiki_quality_manual

	wiki_procedure









Reports



	Audit reports

	Verification lists









Menus



	Management System

	Management System/Audits

	Management System/Nonconformities

	Management System/Actions

	Management System/Configuration

	Management System/Configuration/Causes

	Management System/Configuration/Origins









Views



	mgmtsystem.action.form (form)

	mgmtsystem.action.tree (tree)

	mgmtsystem.audit.form (form)

	mgmtsystem.audit.tree (tree)









Objects


Object: mgmtsystem.action





	reference:	Reference, char, required


	type_action:	Type of Action, selection


	message_ids:	Message Ids, one2many(mailgate.message)
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







BoM Customization (mrp_bom_customization)





	Module:	mrp_bom_customization


	Name:	BoM Customization


	Version:	False


	Author:	Smile.fr


	Directory:	mrp_bom_customization


	Web:	http://www.smile.fr


	Official module:

		no


	Quality certified:

		no






Description

TODO!








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/mrp_bom_customization.zip]

	trunk [http://www.openerp.com/download/modules/trunk/mrp_bom_customization.zip]









Dependencies



	mrp

	sale

	product_variant_multi

	sale_product_multistep_configurator









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







MRP JIT (mrp_jit)





	Module:	mrp_jit


	Name:	MRP JIT


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	mrp_jit


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows Just In Time computation of all procurement.

    If you install this module, you will not have to run the regular procurement
    scheduler anymore (but you still need to run the minimum order point rule
    scheduler, or for example let it run daily.)
    All procurement orders will be processed immediately, which could in some
    cases entail a small performance impact.

    It may also increase your stock size because products are reserved as soon
    as possible and the scheduler time range is not taken into account anymore.
    In that case, you can not use priorities any more on the different picking.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/mrp_jit.zip]

	trunk [http://www.openerp.com/download/modules/trunk/mrp_jit.zip]









Dependencies



	mrp

	sale









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Workcenter Production start end workflow (mrp_operations)





	Module:	mrp_operations


	Name:	Workcenter Production start end workflow


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	mrp_operations


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module adds state, date_start,date_stop in production order operation lines
     (in the "Workcenters" tab)
     State: draft, confirm, done, cancel
     When finishing/confirming,cancelling production orders set all state lines to the according state
     Create menus:
         Production Management > All Operations
         Production Management > All Operations > Operations To Do (state="confirm")
     Which is a view on "Workcenters" lines in production order,
     editable tree

    Add buttons in the form view of production order under workcenter tab:
    * start (set state to confirm), set date_start
    * done (set state to done), set date_stop
    * set to draft (set state to draft)
    * cancel set state to cancel

    When the production order becomes "ready to produce", operations must
    become 'confirmed'. When the production order is done, all operations
    must become done.

    The field delay is the delay(stop date - start date).
    So that we can compare the theoretic delay and real delay.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/mrp_operations.zip]

	trunk [http://www.openerp.com/download/modules/trunk/mrp_operations.zip]









Dependencies



	stock

	hr

	purchase

	product

	mrp









Reports



	Workcenters Barcode

	Start/Stop Barcode









Menus



	Manufacturing/All Work Orders

	Manufacturing/All Work Orders/Work Orders to Do

	Manufacturing/All Work Orders/Future Work Orders

	Manufacturing/All Work Orders/Work Orders Planning

	Manufacturing/Configuration/Start - Stop Codes

	Manufacturing/Work Order Events Using Bar Codes









Views



	mrp.production.workcenter.line.tree (tree)

	mrp.production.workcenter.line.form (form)

	mrp.production.workcenter.line.calendar (calendar)

	mrp.production.workcenter.line.gantt (gantt)

	mrp.production.code.tree (tree)

	mrp.production.code.form (form)

	mrp.production.operation.tree (tree)

	graph.in.hrs.workcenter (graph)

	* INHERIT mrp.production.allow_reorder.form (form)

	mrp.perations.calendar (calendar)









Objects


Object: mrp_operations.operation.code (mrp_operations.operation.code)





	start_stop:	Status, selection, required









	code:	Code, char, required









	name:	Operation Name, char, required








Object: mrp_operations.operation (mrp_operations.operation)





	code_id:	Code, many2one, required









	date_finished:	End Date, datetime









	date_start:	Start Date, datetime









	production_id:	Production, many2one, required









	order_date:	Order Date, date, readonly









	workcenter_id:	Workcenter, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Unique serial number management (mrp_prodlot_autosplit)





	Module:	mrp_prodlot_autosplit


	Name:	Unique serial number management


	Version:	5.0.0.9.0


	Author:	Raphaël Valyi


	Directory:	mrp_prodlot_autosplit


	Web:	http://www.akretion.com


	Official module:

		no


	Quality certified:

		no






Description

Turns production lot tracking numbers into unique per product instance code (serial number).
    Moreover, it
    1) adds a new checkbox on the product form to enable or disable this behavior (you should also enable in/out tracking)
    2) then forbids to perform a move if a move involves more than one product instance
    3) automagically splits up picking list movements into one movement per product instance
    4) turns incoming pickings into an editable grid where you can directly type the code
    of a new production number/code to create and associate to the move (it also checks it
    doesn't exist yet)

    Important Note 1: serial numbers are more easily encode using an editable tree grid, including a special field with new serial to be created.
    However, there is currently a limitation in the OpenObject framework preventing from easily changing non editable trees to editable trees
    by simple extension. Rather than overwriting all views, we prefer give only one example: the active customised view for easy serial encoding
    is available using Stock Management > Incoming Products. Looking at that view definition, the same thing is easily achieved in
    other picking list, like out going products for instance. However it's not "on" by default, you would need to work it out for your case.
    Meanwhile, we hope Tiny add a third "merge_attributes" view extension point to the 3 existing ones: "before", "after" and "replace".
    It would basically simply merge the attributes given (redefined) in the original view XML and let inner content unchanged.
    Blueprint is registered here: https://blueprints.launchpad.net/openobject-server/+spec/merge-attributes-view-extension-point

    Important Note 2: this module doesn't split product bill of materials in MRP since they don't use pickings
    A good workaround when generating production orders manually one by one is to define several lines of individual products in nomemclatures
    and produce 1 by 1 (if possible) to make it easier to encode unique prodlot in production orders too.
    We would also like to extend this module to split automatic production orders (from MRP engine) into several individual production orders in order
    to make it easy to encode the serial numbers in the production. Let us know if you would like that simple extension to be made.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/mrp_prodlot_autosplit.zip]

	trunk [http://www.openerp.com/download/modules/trunk/mrp_prodlot_autosplit.zip]









Dependencies



	product

	stock









Reports

None




Menus

None




Views



	* INHERIT product.normal.stock.form.unique_production_number.inherit (form)

	* INHERIT view.picking.in.form.unique_production_number (form)

	* INHERIT view_production_lot_form_unique_production_number (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Production Report (mrp_production_report)





	Module:	mrp_production_report


	Name:	Production Report


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	mrp_production_report


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

On this module,
    ** Add partner on procurement form which set when Sale order confirm.
    ** Add link between production and procurement.
    ** New report for production.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/mrp_production_report.zip]

	trunk [http://www.openerp.com/download/modules/trunk/mrp_production_report.zip]









Dependencies



	base

	mrp

	sale









Reports



	Production Order









Menus

None




Views



	* INHERIT mrp.production.form.inherit (form)

	* INHERIT mrp.production.form.inherit (form)

	* INHERIT mrp.procurement.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Products Repairs Module (mrp_repair)





	Module:	mrp_repair


	Name:	Products Repairs Module


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	mrp_repair


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

The aim is to have a complete module to manage all products repairs. The following topics should be covered by this module:
           * Add/remove products in the reparation
           * Impact for stocks
           * Invoicing (products and/or services)
           * Warranty concept
           * Repair quotation report
           * Notes for the technician and for the final customer








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/mrp_repair.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/mrp_repair.zip]

	trunk [http://www.openerp.com/download/modules/trunk/mrp_repair.zip]









Dependencies



	base

	sale

	account









Reports



	Quotation / Order









Menus



	Manufacturing/Repairs

	Manufacturing/Repairs/Repairs in quotation

	Manufacturing/Repairs/Repairs in progress

	Manufacturing/Repairs/Repairs Ready to Start

	Manufacturing/Repairs/Repairs to be invoiced

	Manufacturing/Repairs/New Repair









Views



	mrp.repair.form (form)

	mrp.repair.tree (tree)









Objects


Object: Repairs Order (mrp.repair)





	operations:	Operation Lines, one2many, readonly









	address_id:	Delivery Address, many2one









	internal_notes:	Internal Notes, text









	quotation_notes:

		Quotation Notes, text









	partner_id:	Partner, many2one






This field allow you to choose the partner that will be invoiced and delivered






	invoiced:	Invoiced, boolean, readonly









	amount_untaxed:	Untaxed Amount, float, readonly









	location_id:	Current Location, many2one, required, readonly









	amount_tax:	Taxes, float, readonly









	state:	Repair State, selection, readonly






Gives the state of the Repair Order






	pricelist_id:	Pricelist, many2one






The pricelist comes from the selected partner, by default.






	amount_total:	Total, float, readonly









	prodlot_id:	Lot Number, many2one









	partner_invoice_id:

		Invoicing Address, many2one









	move_id:	Move, many2one, required, readonly









	name:	Repair Ref, char, required









	product_id:	Product to Repair, many2one, required, readonly









	guarantee_limit:

		Guarantee limit, date






The guarantee limit is computed as: last move date + warranty defined on selected product. If the current date is below the guarantee limit, each operation and fee you add will be set as ‘not to invoiced’ by default. Note you can manually change this later.






	deliver_bool:	Deliver, boolean






Check this box if you want to manage the delivery once the product is repaired. If checked, it will create a packing with selected product. Note that you can select the locations in the Info tab, if you have the extended view.






	invoice_method:	Invoice Method, selection, required, readonly






This field allow you to change the workflow of the repair order. If value selected is different from ‘No Invoice’, it also allow you to select the pricelist and invoicing address.






	location_dest_id:

		Delivery Location, many2one, readonly









	invoice_id:	Invoice, many2one, readonly









	fees_lines:	Fees Lines, one2many, readonly









	repaired:	Repaired, boolean, readonly









	picking_id:	Packing, many2one, readonly








Object: Repair Operations Lines (mrp.repair.line)





	name:	Description, char, required









	product_uom:	Product UoM, many2one, required









	repair_id:	Repair Order Ref, many2one









	type:	Type, selection, required









	price_unit:	Unit Price, float, required









	product_uom_qty:

		Quantity (UoM), float, required









	price_subtotal:	Subtotal, float, readonly









	to_invoice:	To Invoice, boolean









	state:	Status, selection, required, readonly









	product_id:	Product, many2one, required









	location_dest_id:

		Dest. Location, many2one, required









	invoiced:	Invoiced, boolean, readonly









	location_id:	Source Location, many2one, required









	invoice_line_id:

		Invoice Line, many2one, readonly









	move_id:	Inventory Move, many2one, readonly









	tax_id:	Taxes, many2many








Object: Repair Fees line (mrp.repair.fee)





	name:	Description, char, required









	product_uom:	Product UoM, many2one, required









	repair_id:	Repair Order Ref, many2one, required









	price_unit:	Unit Price, float, required









	product_uom_qty:

		Quantity, float, required









	price_subtotal:	Subtotal, float, readonly









	to_invoice:	To Invoice, boolean









	invoiced:	Invoiced, boolean, readonly









	tax_id:	Taxes, many2many









	invoice_line_id:

		Invoice Line, many2one, readonly









	product_id:	Product, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Manufacturing Resource Planning (mrp)





	Module:	mrp


	Name:	Manufacturing Resource Planning


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	mrp


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This is the base module to manage the manufacturing process in OpenERP.

    Features:
    * Make to Stock / Make to Order (by line)
    * Multi-level BoMs, no limit
    * Multi-level routing, no limit
    * Routing and workcenter integrated with analytic accounting
    * Scheduler computation periodically / Just In Time module
    * Multi-pos, multi-warehouse
    * Different reordering policies
    * Cost method by product: standard price, average price
    * Easy analysis of troubles or needs
    * Very flexible
    * Allows to browse Bill of Materials in complete structure
        that include child and phantom BoMs
    It supports complete integration and planning of stockable goods,
    consumable of services. Services are completely integrated with the rest
    of the software. For instance, you can set up a sub-contracting service
    in a BoM to automatically purchase on order the assembly of your production.

    Reports provided by this module:
    * Bill of Material structure and components
    * Load forecast on workcenters
    * Print a production order
    * Stock forecasts








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/mrp.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/mrp.zip]

	trunk [http://www.openerp.com/download/modules/trunk/mrp.zip]









Dependencies



	stock

	hr

	purchase

	product

	process









Reports



	BOM Structure

	Production Order









Menus



	Manufacturing/Compute All Schedulers

	Manufacturing

	Stock Management/Automatic Procurements

	Manufacturing/Configuration

	Manufacturing/Configuration/Properties

	Manufacturing/Configuration/Properties/Property Categories

	Manufacturing/Configuration/Properties/Properties

	Manufacturing/Configuration/Workcenters

	Manufacturing/Configuration/Routings

	Manufacturing/Configuration/Bill of Materials

	Manufacturing/Configuration/Bill of Materials/Bill of Material Structure

	Manufacturing/Configuration/Bill of Materials/New Bill of Materials

	Manufacturing/Configuration/Bill of Materials Components

	Manufacturing/Production Orders

	Manufacturing/Production Orders/Production Orders Planning

	Manufacturing/Production Orders/Production Orders To Start

	Manufacturing/Production Orders/Production Orders in Progress

	Manufacturing/Production Orders/Production Orders Waiting Products

	Manufacturing/Production Orders/New Production Order

	Manufacturing/Procurement Orders

	Manufacturing/Procurement Orders/Unscheduled procurements

	Stock Management/Automatic Procurements/Exceptions Procurements

	Stock Management/Automatic Procurements/Exceptions Procurements/Exceptions Procurements to Fix

	Stock Management/Automatic Procurements/Exceptions Procurements/Temporary Procurement Exceptions

	Manufacturing/Procurement Orders/New Procurement

	Stock Management/Automatic Procurements/Minimum Stock Rules

	Manufacturing/Compute All Schedulers/Compute Procurements Only

	Manufacturing/Compute All Schedulers/Compute Stock Minimum Rules Only









Views



	mrp.property.group.form (form)

	mrp.property.tree (tree)

	mrp.property.form (form)

	mrp.workcenter.tree (tree)

	mrp.workcenter.form (form)

	mrp.routing.workcenter.tree (tree)

	mrp.routing.workcenter.form (form)

	mrp.routing.form (form)

	mrp.routing.tree (tree)

	mrp.bom.form (form)

	mrp.bom.tree (tree)

	mrp.bom.revision (tree)

	mrp.bom.revision (form)

	mrp.production.tree (tree)

	mrp.production.calendar (calendar)

	mrp.production.gantt (gantt)

	mrp.production.graph (graph)

	mrp.production.form (form)

	mrp.production.lot.line.form (form)

	mrp.production.lot.line.tree (tree)

	mrp.production.product.line.form (form)

	mrp.production.product.line.tree (tree)

	mrp.procurement.tree (tree)

	mrp.procurement.form (form)

	stock.warehouse.orderpoint.tree (tree)

	stock.warehouse.orderpoint.form (form)

	* INHERIT res.company.mrp.config (form)









Objects


Object: Workcenter (mrp.workcenter)





	costs_cycle_account_id:

		Cycle Account, many2one






Complete this only if you want automatic analytic accounting entries on production orders.






	time_efficiency:

		Time Efficiency, float






Factor that multiplies all times expressed in the workcenter.






	code:	Code, char









	time_start:	Time before prod., float






Time in hours for the setup.






	name:	Workcenter Name, char, required









	time_stop:	Time after prod., float






Time in hours for the cleaning.






	capacity_per_cycle:

		Capacity per Cycle, float






Number of operation this workcenter can do in parallel. If this workcenter represent a team of 5 workers, the capacity per cycle is 5.






	type:	Type, selection, required









	costs_journal_id:

		Analytic Journal, many2one









	note:	Description, text






Description of the workcenter. Explain here what’s a cycle according to this workcenter.






	costs_hour:	Cost per hour, float









	costs_hour_account_id:

		Hour Account, many2one






Complete this only if you want automatic analytic accounting entries on production orders.






	costs_cycle:	Cost per cycle, float









	timesheet_id:	Working Time, many2one






The normal working time of the workcenter.






	active:	Active, boolean









	costs_general_account_id:

		General Account, many2one









	time_cycle:	Time for 1 cycle (hour), float






Time in hours for doing one cycle.





Object: Property Group (mrp.property.group)





	name:	Property Group, char, required









	description:	Description, text








Object: Property (mrp.property)





	group_id:	Property Group, many2one, required









	composition:	Properties composition, selection, required






Not used in computations, for information purpose only.






	name:	Name, char, required









	description:	Description, text








Object: Routing (mrp.routing)





	workcenter_lines:

		Workcenters, one2many









	code:	Code, char









	name:	Name, char, required









	note:	Description, text









	active:	Active, boolean









	location_id:	Production Location, many2one






Keep empty if you produce at the location where the finished products are needed. Set a location if you produce at a fixed location. This can be a partner location if you subcontract the manufacturing operations.





Object: Routing workcenter usage (mrp.routing.workcenter)





	cycle_nbr:	Number of Cycle, float, required






A cycle is defined in the workcenter definition.






	name:	Name, char, required









	sequence:	Sequence, integer









	note:	Description, text









	routing_id:	Parent Routing, many2one









	workcenter_id:	Workcenter, many2one, required









	hour_nbr:	Number of Hours, float, required








Object: Bill of Material (mrp.bom)





	property_ids:	Properties, many2many









	product_uos_qty:

		Product UOS Qty, float









	date_stop:	Valid Until, date






Validity of this BoM or component. Keep empty if it’s always valid.






	code:	Code, char









	product_uom:	Product UOM, many2one, required









	sequence:	Sequence, integer









	child_complete_ids:

		BoM Hierarchy, many2many, readonly









	product_qty:	Product Qty, float, required









	product_uos:	Product UOS, many2one









	date_start:	Valid From, date






Validity of this BoM or component. Keep empty if it’s always valid.






	routing_id:	Routing, many2one






The list of operations (list of workcenters) to produce the finished product. The routing is mainly used to compute workcenter costs during operations and to plan future loads on workcenters based on production planning.






	bom_lines:	BoM Lines, one2many









	type:	BoM Type, selection, required






Use a phantom bill of material in raw materials lines that have to be automatically computed in on eproduction order and not one per level. If you put “Phantom/Set” at the root level of a bill of material it is considered as a set or pack: the products are replaced by the components between the sale order to the picking without going through the production order. The normal BoM will generate one production order per BoM level.






	method:	Method, selection, readonly









	child_ids:	BoM Hierarchy, many2many, readonly









	bom_id:	Parent BoM, many2one









	revision_type:	indice type, selection









	active:	Active, boolean









	product_efficiency:

		Product Efficiency, float, required






Efficiency on the production. A factor of 0.9 means a loss of 10% in the production.






	product_id:	Product, many2one, required









	product_rounding:

		Product Rounding, float






Rounding applied on the product quantity. For integer only values, put 1.0






	name:	Name, char, required









	revision_ids:	BoM Revisions, one2many









	position:	Internal Ref., char






Reference to a position in an external plan.





Object: Bill of material revisions (mrp.bom.revision)





	indice:	Revision, char









	name:	Modification name, char, required









	bom_id:	BoM, many2one









	last_indice:	last indice, char









	date:	Modification Date, date









	author_id:	Author, many2one









	description:	Description, text








Object: Production (mrp.production)





	origin:	Origin, char









	product_uos_qty:

		Product UoS Qty, float, readonly









	product_uom:	Product UOM, many2one, required, readonly









	sale_ref:	Sale Ref, char, readonly









	product_qty:	Product Qty, float, required, readonly









	product_uos:	Product UoS, many2one, readonly









	date_planned_date:

		Scheduled Date, date, readonly









	sale_name:	Sale Name, char, readonly









	location_src_id:

		Raw Materials Location, many2one, required






Location where the system will look for products used in raw materials.






	cycle_total:	Total Cycles, float, readonly









	date_start:	Start Date, datetime









	priority:	Priority, selection









	state:	Status, selection, readonly









	product_lines:	Scheduled goods, one2many









	bom_id:	Bill of Material, many2one









	move_lines:	Products Consumed, many2many









	date_planned_end:

		Scheduled End, date, readonly









	routing_id:	Routing, many2one









	date_finished:	End Date, datetime









	move_created_ids:

		Moves Created, one2many









	product_id:	Product, many2one, required









	workcenter_lines:

		Workcenters Utilisation, one2many









	name:	Reference, char, required









	move_prod_id:	Move product, many2one, readonly









	date_planned:	Scheduled date, datetime, required









	hour_total:	Total Hours, float, readonly









	location_dest_id:

		Finished Products Location, many2one, required






Location where the system will stock the finished products.






	picking_id:	Packing list, many2one, readonly






This is the internal picking list take bring the raw materials to the production plan.





Object: Work Orders (mrp.production.workcenter.line)





	name:	Work Order, char, required









	hour:	Nbr of hour, float









	sequence:	Sequence, integer, required









	production_id:	Production Order, many2one









	workcenter_id:	Workcenter, many2one, required









	cycle:	Nbr of cycle, float








Object: Production scheduled products (mrp.production.product.line)





	product_uos_qty:

		Product UOS Qty, float









	name:	Name, char, required









	product_uom:	Product UOM, many2one, required









	production_id:	Production Order, many2one









	product_qty:	Product Qty, float, required









	product_uos:	Product UOS, many2one









	product_id:	Product, many2one, required








Object: Procurement (mrp.procurement)





	origin:	Origin, char






Reference of the document that created this procurement.
This is automatically completed by OpenERP.






	product_uos_qty:

		UoS Quantity, float, readonly









	purchase_id:	Purchase Order, many2one









	product_id:	Product, many2one, required









	product_uom:	Product UoM, many2one, required, readonly









	date_planned:	Scheduled date, datetime, required









	close_move:	Close Move at end, boolean, required









	priority:	Priority, selection, required









	property_ids:	Properties, many2many









	date_close:	Date Closed, datetime









	note:	Note, text









	procure_method:	Procurement Method, selection, required, readonly






If you encode manually a procurement, you probably want to use a make to order method.






	state:	Status, selection, required









	product_qty:	Quantity, float, required, readonly









	product_uos:	Product UoS, many2one, readonly









	message:	Latest error, char









	location_id:	Location, many2one, required









	bom_id:	BoM, many2one









	move_id:	Reservation, many2one









	name:	Name, char, required








Object: Orderpoint minimum rule (stock.warehouse.orderpoint)





	product_max_qty:

		Max Quantity, float, required






When the virtual stock goes belong the Min Quantity, OpenERP generates a procurement to bring the virtual stock to the Max Quantity.






	product_min_qty:

		Min Quantity, float, required






When the virtual stock goes belong the Min Quantity, OpenERP generates a procurement to bring the virtual stock to the Max Quantity.






	qty_multiple:	Qty Multiple, integer, required






The procurement quantity will by rounded up to this multiple.






	procurement_id:	Purchase Order, many2one









	name:	Name, char, required









	product_uom:	Product UOM, many2one, required









	warehouse_id:	Warehouse, many2one, required









	logic:	Reordering Mode, selection, required









	active:	Active, boolean









	location_id:	Location, many2one, required









	product_id:	Product, many2one, required













          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Manufacturing Resource Planning - Change Flow (mrp_state)





	Module:	mrp_state


	Name:	Manufacturing Resource Planning - Change Flow


	Version:	1.1


	Author:	Tiny


	Directory:	mrp_state


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


This is the base module to manage the manufacturing process in OpenERP.      Features:     * Make to Stock / Make to Order (by line)     * Multi-level BoMs, no limit     * Multi-level routing, no limit     * Routing and workcenter integrated with analytic accounting     * Scheduler computation periodically / Just In Time module     * Multi-pos, multi-warehouse     * Different reordering policies     * Cost method by product: standard price, average price     * Easy analysis of troubles or needs     * Very flexible     * Allows to browse Bill of Materials in complete structure         that include child and phantom BoMs     It supports complete integration and planning of stockable goods,     consumable of services. Services are completely integrated with the rest     of the software. For instance, you can set up a sub-contracting service     in a BoM to automatically purchase on order the assembly of your production.      Reports provided by this module:     * Bill of Material structure and components     * Load forecast on workcenters     * Print a production order     * Stock forecasts





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/mrp_state.zip]









Dependencies



	mrp









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







MRP Sub Product (mrp_subproduct)





	Module:	mrp_subproduct


	Name:	MRP Sub Product


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	mrp_subproduct


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows you to produce several products from one production order.
You can configure sub-products in the bill of material.
Without this module:
    A + B + C -> D
With this module:
    A + B + C -> D + E








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/mrp_subproduct.zip]

	trunk [http://www.openerp.com/download/modules/trunk/mrp_subproduct.zip]









Dependencies



	base

	mrp









Reports

None




Menus

None




Views



	* INHERIT mrp.bom.sub.product (form)









Objects


Object: Mrp Sub Product (mrp.subproduct)





	bom_id:	BoM, many2one









	subproduct_type:

		Quantity Type, selection, required









	product_id:	Product, many2one, required









	product_uom:	Product UOM, many2one, required









	product_qty:	Product Qty, float, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi company for accounting module (multi_company_account)





	Module:	multi_company_account


	Name:	Multi company for accounting module


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	multi_company_account


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module to handle multi company accounting.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/multi_company_account.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/multi_company_account.zip]

	trunk [http://www.openerp.com/download/modules/trunk/multi_company_account.zip]









Dependencies



	base

	account_budget

	account

	multi_company









Reports

None




Menus

None




Views



	* INHERIT Account Tree add Company (tree)

	* INHERIT account.move.line.form.inherit (form)

	* INHERIT account.move.form.inherit (form)

	* INHERIT account.journal.form (form)

	* INHERIT account.journal.tree (tree)

	* INHERIT account.analytic.journal.form (form)

	* INHERIT account.budget.post.tree.company (tree)

	* INHERIT account.budget.post.form (form)

	* INHERIT account.fiscalyear.form (form)

	* INHERIT account.period.form (form)

	* INHERIT account.invoice.line.form (form)

	* INHERIT account.invoice.supplier.form (form)

	* INHERIT account.invoice.supplier.form (form)

	* INHERIT account.invoice.form (form)

	* INHERIT account.invoice.form (form)

	* INHERIT account.invoice.supplier.form (form)

	* INHERIT Invoice Tree add Company (tree)

	* INHERIT account.journal.period.tree (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi Currency for Multi Company (multi_company_currency)





	Module:	multi_company_currency


	Name:	Multi Currency for Multi Company


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	multi_company_currency


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Multi Currency for the Multi company Supported Module








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/multi_company_currency.zip]

	trunk [http://www.openerp.com/download/modules/trunk/multi_company_currency.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	* INHERIT res.currency.form.inherit (form)

	* INHERIT res.currency.form.inherit (form)

	* INHERIT res.currency.form.inherit (form)

	* INHERIT res.currency.tree.inherit (tree)

	* INHERIT res.company.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi company Human Resources (Timesheet groups) (multi_company_hr_timesheet_sheet)





	Module:	multi_company_hr_timesheet_sheet


	Name:	Multi company Human Resources (Timesheet groups)


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	multi_company_hr_timesheet_sheet


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/multi_company_hr_timesheet_sheet.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/multi_company_hr_timesheet_sheet.zip]

	trunk [http://www.openerp.com/download/modules/trunk/multi_company_hr_timesheet_sheet.zip]









Dependencies



	hr_timesheet_sheet

	base

	multi_company









Reports

None




Menus

None




Views



	* INHERIT hr.timesheet.sheet.form.multicompany (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







MultiCompany Product (multi_company_product)





	Module:	multi_company_product


	Name:	MultiCompany Product


	Version:	5.0.1.1


	Author:	Axelor


	Directory:	multi_company_product


	Web:	http://www.axelor.com


	Official module:

		no


	Quality certified:

		no






Description

The Module allows to define each product for many companies with their cost price and sale price
    and that update cost price and sale price as per userwise company, for the purpose of multicompany








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/multi_company_product.zip]

	trunk [http://www.openerp.com/download/modules/trunk/multi_company_product.zip]









Dependencies



	base

	product









Reports

None




Menus

None




Views



	* INHERIT product.supplierinfo.form.view (form)

	* INHERIT product.supplierinfo.tree.view (tree)

	company.wise.cost.price.form (form)

	company.wise.cost.price.tree (tree)

	company.wise.sale.price.form (form)

	company.wise.sale.price.tree (tree)

	* INHERIT product.normal.form (form)









Objects


Object: Company Wise Cost Price (company.wise.cost.price)





	currency_id:	Currency, many2one, readonly









	standard_price:	Cost Price, float, required






The cost of the product for accounting stock valuation. It can serves as a base price for supplier price.






	product_id:	Product Id, many2one









	company_id:	Company, many2one








Object: Company Wise Sale Price (company.wise.sale.price)





	currency_id:	Currency, many2one, readonly









	list_price:	Sale Price, float, required






Base price for computing the customer price. Sometimes called the catalog price.






	product_id:	Product Id, many2one









	company_id:	Company, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi company Project Management (multi_company_project)





	Module:	multi_company_project


	Name:	Multi company Project Management


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	multi_company_project


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/multi_company_project.zip]

	trunk [http://www.openerp.com/download/modules/trunk/multi_company_project.zip]









Dependencies



	project

	base

	multi_company









Reports

None




Menus

None




Views



	* INHERIT project.project.form.multicompany (form)

	* INHERIT project.task.form.multicompany (form)









Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







MultiCompany Purchase Order (multi_company_purchase)





	Module:	multi_company_purchase


	Name:	MultiCompany Purchase Order


	Version:	5.0.1.1


	Author:	Axelor


	Directory:	multi_company_purchase


	Web:	http://www.axelor.com


	Official module:

		no


	Quality certified:

		no






Description

The Module allows to define company wise Purchase Order








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	purchase









Reports

None




Menus

None




Views



	* INHERIT Purchase Order Form add Company (form)

	* INHERIT Purchase Order Tree add Company (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi company base module (multi_company)





	Module:	multi_company


	Name:	Multi company base module


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	multi_company


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module to handle multi company.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/multi_company.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/multi_company.zip]

	trunk [http://www.openerp.com/download/modules/trunk/multi_company.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







MultiCompany Sequence (multi_company_sequence)





	Module:	multi_company_sequence


	Name:	MultiCompany Sequence


	Version:	5.0.1.1


	Author:	Axelor


	Directory:	multi_company_sequence


	Web:	http://www.axelor.com


	Official module:

		no


	Quality certified:

		no






Description

Multi company Sequence Module








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/multi_company_sequence.zip]

	trunk [http://www.openerp.com/download/modules/trunk/multi_company_sequence.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	* INHERIT ir.sequence.form (form)

	* INHERIT ir.sequence.tree (tree)

	* INHERIT res.users.tree (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multi company Stock Management (multi_company_stock)





	Module:	multi_company_stock


	Name:	Multi company Stock Management


	Version:	0.1


	Author:	Tiny


	Directory:	multi_company_stock


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Multi company Stock Management




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/multi_company_stock.zip]









Dependencies



	mrp

	multi_company_account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Multilogin portal (multilogin_portal)





	Module:	multilogin_portal


	Name:	Multilogin portal


	Version:	5.0.1.0


	Author:	Ferme Urbaine


	Directory:	multilogin_portal


	Web:	http://www.lafermedusart.com


	Official module:

		no


	Quality certified:

		no






Description

Allows xmlrpc queries from partners email+password as:
      - Customer standard user
      - Provider standard user

Allows xmlrpc queries from computers (IP automatically recognized) as:
      - Computer standard user

Standard users are set into res.company.
For multi-company, please alter this code.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/multilogin_portal.zip]

	trunk [http://www.openerp.com/download/modules/trunk/multilogin_portal.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Configuration/Computers









Views



	* INHERIT res.company.form (form)

	res.computer.tree (tree)









Objects


Object: Computers (res.computer)





	active:	Active, boolean









	state:	State, selection, required









	ip_address:	IP address, char, required









	name:	Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







External Prices (nan_external_prices)





	Module:	nan_external_prices


	Name:	External Prices


	Version:	5.0.1.0


	Author:	NaN


	Directory:	nan_external_prices


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds new fields in sale orders and invoice lines to store untaxed and tax amounts as created by an external application or online shop. This avoids rounding differences between both applications.

A flag in both sale orders and invoices allows the user to decide what values to use the one of the external application or the ones calculated by OpenERP.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	sale

	account

	account_tax_include









Reports

None




Menus

None




Views



	* INHERIT account.invoice.form.use_external_prices (form)

	* INHERIT account.invoice.line.form.external_prices (form)

	* INHERIT sale.order.form.use_external_prices (form)

	* INHERIT sale.order.form.external_prices (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Procurement Cheapest Supplier (nan_mrp_procurement_cheapest_supplier)





	Module:	nan_mrp_procurement_cheapest_supplier


	Name:	Procurement Cheapest Supplier


	Version:	5.0.0.1


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_mrp_procurement_cheapest_supplier


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

This module selects the cheapest supplier for a product when purchase orders are created from procurements. By default OpenERP will select the partner with lowest sequence number.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	mrp

	nan_product_supplier_info_extended









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Production Merge (nan_mrp_production_merge)





	Module:	nan_mrp_production_merge


	Name:	Production Merge


	Version:	5.0.0.1


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_mrp_production_merge


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds a new wizard that allows merging two or more production orders.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	mrp









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Production Split (nan_mrp_production_split)





	Module:	nan_mrp_production_split


	Name:	Production Split


	Version:	5.0.0.1


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_mrp_production_split


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds a new wizard that allows splitting a production order into two.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	mrp









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Partner Risk Insurance (nan_partner_risk_insurance)





	Module:	nan_partner_risk_insurance


	Name:	Partner Risk Insurance


	Version:	5.0.0.1


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_partner_risk_insurance


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds a new tab in the partner form to introduce risk insurance information.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base









Reports

None




Menus

None




Views



	* INHERIT res.partner.form.risk_insurance (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Partner Risk Analysis (nan_partner_risk)





	Module:	nan_partner_risk


	Name:	Partner Risk Analysis


	Version:	5.0.0.1


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_partner_risk


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds a new button in the partner form to analyze current state of a partner risk.
It reports current information regarding amount of debt in invoices, orders, etc.

It also modifies the workflow of sale orders by adding a new step when partner's risk is exceeded.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	account

	sale

	account_payment









Reports

None




Menus



	Sales Management/Sales Orders/Waiting Risk Approval









Views



	* INHERIT res.partner.form.risk (form)

	* INHERIT sale.order.form.risk (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product Pack (nan_product_pack)





	Module:	nan_product_pack


	Name:	Product Pack


	Version:	5.0.0.1


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_product_pack


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

Allows configuring products as a collection of other products. If such a product is added in a sale order, all the products of the pack will be added automatically (when storing the order) as children of the pack product.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	sale









Reports

None




Menus

None




Views



	* INHERIT product.product.pack.form (form)

	product.pack.line.form (form)

	product.pack.line.tree (tree)









Objects


Object: product.pack.line (product.pack.line)





	product_id:	Product, many2one, required









	parent_product_id:

		Parent Product, many2one, required









	quantity:	Quantity, float, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product Sequence (nan_product_sequence)





	Module:	nan_product_sequence


	Name:	Product Sequence


	Version:	5.0.1.0


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_product_sequence


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds an automatic sequence to product codes.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	product









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product Supplier Info Extended (nan_product_supplier_info_extended)





	Module:	nan_product_supplier_info_extended


	Name:	Product Supplier Info Extended


	Version:	5.0.0.1


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_product_supplier_info_extended


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

Product Supplier Info Extended








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	product









Reports

None




Menus

None




Views



	* INHERIT product.supplierinfo.form.extended1 (form)

	* INHERIT product.supplierinfo.form.extended2 (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Quality Control (nan_quality_control)





	Module:	nan_quality_control


	Name:	Quality Control


	Version:	5.0.0.1


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_quality_control


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module provides a generic infrastructure for quality tests. The idea is that it can be later be reused for doing quality tests in production lots but also in any other areas a company may desire.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	product









Reports

None




Menus



	Quality Control

	Quality Control/Configuration

	Quality Control/Configuration/Method

	Quality Control/Configuration/Test Template

	Quality Control/Configuration/Proof

	Quality Control/Test Lines

	Quality Control/Tests









Views



	qc.proof.method.form (form)

	qc.proof.method.tree (tree)

	qc.posible.value.form (form)

	qc.posible_value.tree (tree)

	qc.proof.synonym (form)

	qc.proof.synonym.tree (tree)

	qc.proof.form (form)

	qc.proof.tree (tree)

	qc.test.template.form (form)

	qc.test.template_tree (tree)

	qc.test.template.form2 (form)

	qc.test.template.line.form (form)

	qc.test.template,line.tree (tree)

	qc.test.set.template.wizard (form)

	qc.test.form (form)

	qc.test.tree (tree)

	qc.test.line.form (form)

	qc.test.line.tree (tree)









Objects


Object: Method (qc.proof.method)





	active:	Active, boolean









	name:	Name, char, required








Object: qc.posible.value (qc.posible.value)





	active:	Active, boolean









	name:	Name, char, required








Object: qc.proof (qc.proof)





	name:	Name, char, required









	posible_values_ids:

		Possible Values, many2many









	ref:	Code, char









	synonyms:	Synonyms, char, readonly









	synonym_ids:	Synonyms, one2many









	active:	Active, boolean









	type:	Type, selection, required








Object: qc.proof.synonym (qc.proof.synonym)





	proof_id:	Proof, many2one, required









	name:	Name, char, required








Object: qc.test.template.category (qc.test.template.category)





	active:	Active, boolean






The active field allows you to hide the category without removing it.






	parent_id:	Parent Category, many2one









	child_ids:	Child Categories, one2many









	complete_name:	Full Name, char, readonly









	name:	Category Name, char, required








Object: Test Template (qc.test.template)





	name:	Name, char, required









	fill_correct_values:

		Fill With Correct Values, boolean









	object_id:	Reference Object, reference









	active:	Active, boolean









	category_id:	Category, many2one









	type:	Type, selection









	test_template_line_ids:

		Lines, one2many








Object: qc.test.template.line (qc.test.template.line)





	proof_id:	Proof, many2one, required









	min_value:	Min, float









	method_id:	Method, many2one









	test_template_id:

		Test Template, many2one









	max_value:	Max, float









	notes:	Notes, text









	sequence:	Sequence, integer, required









	valid_value:	Valid Value, many2one









	uom_id:	Uom, many2one









	type:	Type, selection, readonly








Object: qc.test (qc.test)





	test_internal_note:

		Internal Note, text









	name:	Date, datetime, required, readonly









	success:	Success, boolean, readonly






This field will be active if all tests have succeeded.






	test_template_id:

		Test, many2one









	enabled:	Enabled, boolean, readonly






If a quality control test is not enabled it means it can not be moved from “Quality Success” or “Quality Failed” state.






	object_id:	Reference, reference, readonly









	state:	State, selection, readonly









	test_external_note:

		External Note, text









	test_line_ids:	Test Lines, one2many








Object: qc.test.line (qc.test.line)





	proof_id:	Proof, many2one, readonly









	min_value:	Min, float, readonly






Minimum valid value if it is a quantitative proof.






	method_id:	Method, many2one, readonly









	success:	Success?, boolean, readonly









	actual_value_qt:

		Qt.Value, float






Value of the result if it is a quantitative proof.






	max_value:	Max, float, readonly






Maximum valid value if it is a quantitative proof.






	notes:	Notes, text, readonly









	test_template_line_id:

		Test Template Line, many2one, readonly









	test_id:	Test, many2one









	valid_value:	Valid Value, many2one, readonly






Value that should have the result to be valid if it is a qualitative proof.






	uom_id:	Uom, many2one, readonly






UoM for minimum and maximum values if it is a quantitative proof.






	proof_type:	Proof Type, selection, readonly









	test_uom_id:	Uom Test, many2one






UoM of the value of the result if it is a quantitative proof.






	actual_value_ql:

		Ql.Value, many2one






Value of the result if it is a qualitative proof.





Object: qc.test.set.template.wizard (qc.test.set.template.wizard)





	test_template_id:

		Template, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sale Recent Product (nan_sale_product_recent)





	Module:	nan_sale_product_recent


	Name:	Sale Recent Product


	Version:	5.0.0.1


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_sale_product_recent


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds a new field in sale order lines to allow choosing only the products the partner has ordered sometime in the past. This is useful for companies in which partners tend to ask always the same products but don't know the code or remember the exact model.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	sale









Reports

None




Menus

None




Views



	* INHERIT sale.view_order_form.recent_product (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Stock Move Filters (nan_stock_move_filters)





	Module:	nan_stock_move_filters


	Name:	Stock Move Filters


	Version:	5.0.0.1


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_stock_move_filters


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds filters to stock moves so only available locations, products and lots are shown in searches, easing the selection of the appropriate ones to the user.

This module provides a useful infrastructure for specific filters to be implemented in new modules.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	stock









Reports

None




Menus

None




Views



	* INHERIT stock.move.form.location_id (form)

	* INHERIT stock.move.form.location_dest_id (form)

	* INHERIT stock.move.form.product_id (form)

	* INHERIT stock.picking.form.location_id (form)

	* INHERIT stock.picking.form.location_dest_id (form)

	* INHERIT stock.picking.in.form.location_id (form)

	* INHERIT stock.picking.in.form.location_dest_id (form)

	* INHERIT stock.picking.out.form.location_id (form)

	* INHERIT stock.picking.out.form.location_dest_id (form)

	* INHERIT stock.picking.delivery.form.location_id (form)

	* INHERIT stock.picking.delivery.form.location_dest_id (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Production Lot Cost (nan_stock_production_lot_cost)





	Module:	nan_stock_production_lot_cost


	Name:	Production Lot Cost


	Version:	5.0.0.1


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_stock_production_lot_cost


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds cost information to production lots.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	stock

	mrp

	purchase









Reports

None




Menus

None




Views



	* INHERIT stock.production.lot.form.cost (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Production Lot Quality Control (nan_stock_production_lot_quality_control)





	Module:	nan_stock_production_lot_quality_control


	Name:	Production Lot Quality Control


	Version:	5.0.0.1


	Author:	NaN for Trod y Avia, S.L.


	Directory:	nan_stock_production_lot_quality_control


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module adds two quality controls to production lots on arrival and after production. The idea is that the first
test will be 'Generic' and check for things like correct packaging. The second will be specific to the product in question.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	stock

	nan_quality_control









Reports

None




Menus



	Quality Control/Production Lot Tests

	Quality Control/Production Lot Tests/Draft Tests

	Quality Control/Production Lot Tests/Confirmed Tests

	Quality Control/Production Lot Tests/Valid Tests

	Quality Control/Production Lot Tests/Invalid Tests









Views



	* INHERIT product.product.form.quality (form)

	* INHERIT stock.production.lot.form.workflow (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Network Management Extension (network_extension)





	Module:	network_extension


	Name:	Network Management Extension


	Version:	5.0.1.0.1


	Author:	Zikzakmedia SL


	Directory:	network_extension


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Organize your software and configurations.
    - Additional network information: IP, domain, DNS, gateway
    - Protocols
    - Services
    - Ports
    - Public and private URLs
    - Password encryption

System dependency: package python-crypto required.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/network_extension.zip]

	trunk [http://www.openerp.com/download/modules/trunk/network_extension.zip]









Dependencies



	network









Reports

None




Menus



	Tools/Network/Software

	Tools/Network/Logins/Passwords

	Tools/Network/Services

	Tools/Network/Configuration/Protocol

	Tools/Network/Configuration/Encrypt/Decrypt password









Views



	* INHERIT network.network.tree.ext1 (form)

	* INHERIT network.network.form.ext1 (form)

	* INHERIT network.network.form.ext2 (form)

	* INHERIT network.network.form.ext3 (form)

	* INHERIT network.network.form.ext4 (form)

	* INHERIT network.network.form.ext5 (form)

	* INHERIT network.material.tree.ext1 (form)

	* INHERIT network.material.form.ext1 (form)

	* INHERIT network.material.form.ext2 (form)

	* INHERIT network.view.software.tree.ext1 (form)

	* INHERIT network.software.form.ext1 (form)

	* INHERIT network.software.form.ext2 (form)

	* INHERIT network.password.tree.ext1 (form)

	* INHERIT network.password.tree.ext2 (form)

	* INHERIT network.password.form.ext1 (form)

	* INHERIT network.password.form.ext2 (form)

	network.service.tree (tree)

	network.service.form (form)

	network.protocol.tree (tree)

	network.protocol.form (form)

	network.encrypt.password.tree (tree)

	network.encrypt.password.form (form)









Objects


Object: Protocol (network.protocol)





	protocol:	Protocol, selection, required









	description:	Description, char









	name:	Name, char, required









	port:	Port, integer, required






Default port defined see(http://www.iana.org/assignments/port-numbers)





Object: Service Network (network.service)





	material:	Material, many2one, readonly









	name:	Name, char









	protocol_id:	Protocol, many2one









	public_port:	Public port, integer






Sometimes public and private ports are different.






	public_url:	Public URL, char









	private_url:	Private URL, char









	path:	Path, char









	software_id:	Software, many2one, required









	port:	Port, integer, required








Object: Password encryption (network.encrypt.password)





	name:	Encrypt/Decrypt password, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Network Management (network)





	Module:	network


	Name:	Network Management


	Version:	5.0.1.0.1


	Author:	Tiny


	Directory:	network


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

A simple module to encode your networks and materials:
    - networks and connections between networks
    - hardware and software with:
        - versions, access rights, warranties

    You can print interventions form for technical people.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/network.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/network.zip]

	trunk [http://www.openerp.com/download/modules/trunk/network.zip]









Dependencies



	base









Reports

None




Menus



	Tools

	Tools/Network

	Tools/Network/Configuration

	Tools/Network/Configuration/Software

	Tools/Network/Configuration/Software/Types

	Tools/Network/Configuration/Hardware

	Tools/Network/Configuration/Hardware/Types

	Tools/Network/Network List

	Tools/Network/Networks

	Tools/Network/All Materials

	Tools/Network/Top Materials

	Tools/Network/Material List









Views



	network.material.form (form)

	network.material.tree (tree)

	network.material.tree (tree)

	network.software.type.form (form)

	network.hardware.type.form (form)

	network.software.logpass.form (form)

	network.software.logpass.tree (tree)

	network.software.form (form)

	network.software.tree (tree)

	network.network.tree (tree)

	network.network.form (form)

	network.changes.form (form)

	network.changes.tree (tree)









Objects


Object: Hardware type (network.hardware.type)





	name:	Type of material, char, required









	networkable:	Networkable hardware, boolean








Object: Network (network.network)





	material_ids:	Members, one2many









	range:	Address range, char









	user_id:	Onsite Contact person, many2one









	name:	Network name, char, required









	contact_id:	Partner, many2one, required








Object: Material (network.material)





	warranty:	Warranty deadline, date









	ip_addr:	IP Address, char









	name:	Device Name, char, required









	network_id:	Network, many2one









	change_id:	Changes on this machine, one2many









	note:	Notes, text









	parent_id:	Parent Material, many2one









	date:	Installation Date, date









	child_id:	Childs Materials, one2many









	supplier:	Supplier, many2one









	type:	Hardware type, many2one, required









	software_id:	Installed Software, one2many








Object: Network changes (network.changes)





	date:	Change date, datetime









	machine_id:	Machine, many2one









	user_id:	User, many2one, required









	name:	Short Description, char, required









	description:	Long Description, text








Object: Software type (network.software.type)





	note:	Notes, text









	name:	Composant Name, char, required








Object: Software (network.software)





	name:	Composant Name, char, required









	logpass:	Login / Password, one2many









	material_id:	Material, many2one









	note:	Notes, text









	version:	Software version, char









	date:	Installation Date, date









	type:	Software Type, many2one, required









	email:	Contact Email, char








Object: Software login (network.software.logpass)





	login:	Login, char, required









	password:	Password, char, required









	software_id:	Software, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







olap_crm (olap_crm)





	Module:	olap_crm


	Name:	olap_crm


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	olap_crm


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Sale module will load the data in olap tables








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/olap_crm.zip]

	trunk [http://www.openerp.com/download/modules/trunk/olap_crm.zip]









Dependencies



	olap









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Module to  extracts the schema structure (olap_extract)





	Module:	olap_extract


	Name:	Module to  extracts the schema structure


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	olap_extract


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Extracts the schema structure.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/olap_extract.zip]

	trunk [http://www.openerp.com/download/modules/trunk/olap_extract.zip]









Dependencies



	olap









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Olap Schemes Management (olap)





	Module:	olap


	Name:	Olap Schemes Management


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	olap


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Base module to manage Olap schemas. Cube designer.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/olap.zip]

	trunk [http://www.openerp.com/download/modules/trunk/olap.zip]









Dependencies



	base









Reports

None




Menus



	Business Intelligence

	Business Intelligence/Configuration

	Business Intelligence/Configuration/Fact Databases

	Business Intelligence/Configuration/Known Application

	Business Intelligence/Configuration/Olap Cubes

	Business Intelligence/Configuration/Tools

	Business Intelligence/Cube Browser

	Business Intelligence/Cube Designer

	Business Intelligence/Configuration/Tools/Clear Logs

	Business Intelligence/Server Parameters

	Business Intelligence/Configuration/Olap Cubes/Olap Schema

	Business Intelligence/Configuration/Olap Cubes/Olap Cubes Table

	Business Intelligence/Configuration/Olap Cubes/Olap Cubes

	Business Intelligence/Configuration/Olap Cubes/Olap Dimension

	Business Intelligence/Configuration/Olap Cubes/Olap Hierarchy

	Business Intelligence/Configuration/Olap Cubes/Olap Level

	Business Intelligence/Configuration/Olap Cubes/Olap Measures

	Business Intelligence/Configuration/Tools/Olap Saved Query

	Business Intelligence/Configuration/Tools/All Logs

	Business Intelligence/Configuration/Tools/All Logs/My Logs

	Business Intelligence/Configuration/Fact Databases/Databases

	Business Intelligence/Configuration/Fact Databases/Tables

	Business Intelligence/Configuration/Fact Databases/Columns

	Business Intelligence/Configuration/Known Application/Application

	Business Intelligence/Configuration/Known Application/Application Table

	Business Intelligence/Configuration/Known Application/Application Field









Views



	bi.load.db.form (form)

	Parameters Configuration (form)

	bi.auto.configure.form (form)

	olap.schema.tree (tree)

	olap.schema.form (form)

	olap.cube.table.form (form)

	olap.cube.tree (tree)

	olap.cube.form (form)

	olap.dimension.tree (tree)

	olap.dimension.form (form)

	olap.hierarchy.tree (tree)

	olap.hierarchy.form (form)

	olap.level.tree (tree)

	olap.level.form (form)

	olap.measure.tree (tree)

	olap.measure.form (form)

	olap.saved.query.tree (tree)

	olap.saved.query.mdx (mdx)

	olap.saved.query.form (form)

	olap.query.logs (tree)

	olap.query.logs.form (form)

	olap.query.logs (mdx)

	olap.query.logs.form (form)

	olap.fact.database.tree (tree)

	olap.fact.database.form (form)

	olap.database.tables.tree (tree)

	olap.database.tables.form (form)

	olap.database.columns.tree (tree)

	olap.database.columns.tree.m20 (tree)

	olap.database.columns.form (form)

	olap.application.tree (tree)

	olap.application.form (form)

	olap.application.table.tree (tree)

	olap.application.table.form (form)

	olap.application.field.tree (tree)

	olap.application.field.form (form)









Objects


Object: Olap Fact Database (olap.fact.database)





	connection_type:

		Connection type, selection, required









	connection_url:	Connection URL, char, readonly









	name:	Fact name, char, required









	db_password:	Database password, char, required






Password for the login.






	table_ids:	Tables, one2many









	db_port:	Database port, integer, required






Port to be used in connection






	db_name:	Database name, char, required






Name of the database to be used for analysis.






	db_login:	Database login, char, required






Login for the database name specified.






	loaded:	Loaded, boolean, readonly









	type:	Database type, selection, required









	db_host:	Database host, char, required






Give hostname to make connection to the database.





Object: Olap Schema (olap.schema)





	name:	Schema name, char, required









	app_detect:	Connection URL, char, readonly









	database_id:	Database Connection, many2one, required









	note:	Schema description, text









	ready:	Ready, boolean, readonly









	state:	Schema State, selection, readonly









	cube_ids:	Cubes, one2many









	loaded:	Loading Datastructure, boolean, readonly









	configure:	Configuring Datastructure, boolean, readonly








Object: Olap Database Tables (olap.database.tables)





	hide:	Hidden, boolean









	name:	End-User Name, char, required









	fact_database_id:

		Database Id, many2one, required, readonly









	table_db_name:	Table Name, char, required, readonly









	active:	Active, boolean









	columns:	Columns, one2many








Object: Olap Database Columns (olap.database.columns)





	hide:	Hidden, boolean









	name:	Column Name, char, required









	related_to:	Related To, many2one, readonly









	table_id:	Table Id, many2one, required, readonly









	active:	Active, boolean









	type:	Type, selection, required, readonly









	column_db_name:	Column DBName, char, required, readonly









	primary_key:	Primary Key, boolean








Object: Olap cube table (olap.cube.table)





	available_table_ids:

		Available Tables, many2many, readonly









	line_ids:	Database Tables, one2many, required









	schema_id:	Schema id, many2one









	name:	Table name, char, required









	column_link_id:	Relational Column, many2one, required








Object: Olap cube table (olap.cube.table.line)





	field_id:	Link Field, many2one









	cube_table_id:	Cube Table, many2one, required









	table_id:	Database Table, many2one, required








Object: Olap cube (olap.cube)





	measure_ids:	Measures, one2many









	name:	Cube name, char, required









	dimension_ids:	Dimensions, one2many









	query_ids:	Queries, one2many









	schema_id:	Schema, many2one, readonly









	table_id:	Fact table, many2one, required






Table(s) for cube.






	query_log:	Query Logging, boolean






Enabling  this will log all the queries in the browser





Object: Olap query logs (olap.query.logs)





	query:	Query, text, required









	result_size:	Result Size, integer, readonly









	user_id:	OpenERP User, many2one









	cube_id:	Cube, many2one, required









	time:	Time, datetime, required








Object: Olap dimension (olap.dimension)





	name:	Dimension name, char, required









	cube_id:	Cube, many2one, required









	hierarchy_ids:	Hierarchies, one2many








Object: Olap hierarchy (olap.hierarchy)





	name:	Hierarchy name, char, required









	sequence:	Sequence, integer, required









	dimension_id:	Dimension, many2one, required









	primary_key_table:

		Primary key table, char









	table_id:	Fact table(s), many2one, required






Table(s) to make hierarchy on the cube.






	level_ids:	Levels, one2many









	primary_key:	Primary key, char








Object: Olap level (olap.level)





	column_id_name:	Column ID, char, required









	name:	Level name, char, required









	sequence:	Sequence, integer, required









	table_name:	Table name, char, required






The name of the table on which the column is defined. If False, take the table from the hierarchy.






	hierarchy_id:	Hierarchy, many2one, required









	type:	Level class, selection, required









	column_name:	Columns Name, many2one, required








Object: Olap measure (olap.measure)





	value_sql:	SQL Expression, char






You can provide valid sql expression. Make sure it have function with fully qualified column name like (sum,avg ...)(tablename.columnname (+,- ...) tablename.columnname)






	name:	Measure name, char, required









	cube_id:	Cube, many2one, required









	datatype:	Datatype, selection, required









	formatstring:	Format string, selection, required






Let you specify how the measure to be displayed in cube browser






	value_column:	Fact Table Column, many2one









	agregator:	Agregator, selection, required









	table_name:	Table name, char






The name of the table on which the column is defined. If False, take the table from the cube.






	measure_type:	Measure Type, selection, required






Select between auto column or sql expression for the measures






	value_column_id_name:

		Column ID, char








Object: Olap application (olap.application)





	query:	Application Query, text









	field_ids:	Fields, one2many









	name:	Application name, char, required









	table_ids:	Tables, one2many








Object: Olap application table (olap.application.table)





	application_id:	Application Id, many2one, required









	is_hidden:	Hidden, boolean









	table_name:	Table name, char, required









	name:	Application table name, char, required








Object: Olap application field (olap.application.field)





	field_name:	Field name, char









	is_hidden:	Hidden, boolean









	table_name:	Application table name, char









	name:	Application field name, char, required









	application_id:	Application Id, many2one, required








Object: olap.saved.query (olap.saved.query)





	user_id:	User, many2one









	name:	Query Name, text









	cube_id:	Cube, many2one, required









	schema_id:	Schema, many2one, required









	time:	Time, datetime, required









	query:	Query, text, required








Object: bi.load.db.wizard (bi.load.db.wizard)





	db_name:	Database Name, char, readonly









	fact_table:	Fact Name, char, readonly








Object: bi.auto.configure.wizard (bi.auto.configure.wizard)





	name:	Fact Name, char, readonly








Object: Olap Server Parameters (olap.parameters.config.wizard)





	host_port:	Port, char, required






Put the port for the server. Put 8080 if                 its not clear.






	host_name:	Server Name, char, required






Put here the server address or IP                 Put localhost if its not clear.
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Load Sale Module data in Olap Tables (olap_sale)





	Module:	olap_sale


	Name:	Load Sale Module data in Olap Tables


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	olap_sale


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Sale module will load the data in olap tables








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/olap_sale.zip]

	trunk [http://www.openerp.com/download/modules/trunk/olap_sale.zip]









Dependencies



	olap









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Partner Credit Limit (partner_credit_limit)





	Module:	partner_credit_limit


	Name:	Partner Credit Limit


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	partner_credit_limit


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Partner Credit Limit'
    Checks for all over due payment and already paid amount
    if the difference is positive and acceptable then Salesman
    able to confirm SO








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/partner_credit_limit.zip]

	trunk [http://www.openerp.com/download/modules/trunk/partner_credit_limit.zip]









Dependencies



	base

	account

	sale









Reports

None




Menus

None




Views



	* INHERIT partner.over.credit.limit.form.inherit (form)









Objects

None
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Partner Credit (partner_credit)





	Module:	partner_credit


	Name:	Partner Credit


	Version:	1.0


	Author:	Tiny SPRL


	Directory:	partner_credit


	Web:	www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows to control the credit of your partners.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/partner_credit.zip]









Dependencies



	base

	account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Partner informations (partner_informations)





	Module:	partner_informations


	Name:	Partner informations


	Version:	5.0.0.1


	Author:	Sistheo


	Directory:	partner_informations


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Add turnover and manpower information on partner definition.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/partner_informations.zip]

	trunk [http://www.openerp.com/download/modules/trunk/partner_informations.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	* INHERIT res.partner.form.inherit (form)









Objects


Object: Partner turnover (res.partner.turnover)





	currency_id:	Currency, many2one









	manpower:	Manpower, float









	partner_id:	Partner, many2one









	name:	Period, char









	turnover:	Turn over (Value), float
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Partner Layout (partner_layout)





	Module:	partner_layout


	Name:	Partner Layout


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	partner_layout


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/partner_layout.zip]

	trunk [http://www.openerp.com/download/modules/trunk/partner_layout.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	* INHERIT res.partner.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Partner extension to synchronize TinyERP with ldap (partner_ldap)





	Module:	partner_ldap


	Name:	Partner extension to synchronize TinyERP with ldap


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	partner_ldap


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Synchronise partners through a LDAP module. Has been used to synchronise partners in Outlook and Tiny ERP.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/partner_ldap.zip]

	trunk [http://www.openerp.com/download/modules/trunk/partner_ldap.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Partner NACE informations (partner_nace)





	Module:	partner_nace


	Name:	Partner NACE informations


	Version:	5.0.0.1


	Author:	Sistheo


	Directory:	partner_nace


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Add NACE information in categories list.

The Statistical Classification of Economic Activities in the European Community
commonly referred to as NACE, is a European industry standard classification
system consisting of a 6 digit code.

NACE is equivalent to the SIC and NAICS system:

    * Standard Industrial Classification
    * North American Industry Classification System

The first four digits of the code, which is the first four level of the
classification system, are the same in all European countries. The fifth digit
might vary from country to country and further digits are sometimes placed by
suppliers of databases.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/partner_nace.zip]

	trunk [http://www.openerp.com/download/modules/trunk/partner_nace.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







SMS and Email spam to partner (partner_spam)





	Module:	partner_spam


	Name:	SMS and Email spam to partner


	Version:	5.0.1.0


	Author:	Zikzakmedia SL


	Directory:	partner_spam


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Improved SMS and Email spam to partner:
  * Spam to partners and to partner.address (contacts)
  * Choice to spam all partner addresses or partner default addresses
  * The email field can contain several email addresses separated by ,
  * A maximum of 3 files can be attached to emails
  * Clickatell gateway to send SMS can be configured by http or by email
  * The spam text can include special [[field]] tags to create personalized messages (they will be replaced by the corresponding values of each partner contact):
      [[partner_id]] -> Partner name
      [[name]] -> Contact name
      [[function]] -> Function
      [[title]] -> Title
      [[street]] -> Street
      [[street2]] -> Street 2
      [[zip]] -> Zip code
      [[city]] -> City
      [[state_id]] -> State
      [[country_id]] -> Country
      [[email]] -> Email
      [[phone]] -> Phone
      [[fax]] -> Fax
      [[mobile]] -> Mobile
      [[birthdate]] -> Birthday








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/partner_spam.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/partner_spam.zip]

	trunk [http://www.openerp.com/download/modules/trunk/partner_spam.zip]









Dependencies



	base

	smtpclient









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Personal Base (personal_base)





	Module:	personal_base


	Name:	Personal Base


	Version:	5.0.1.1


	Author:	Sandas


	Directory:	personal_base


	Web:	www.sandas.eu


	Official module:

		no


	Quality certified:

		no






Description

Sandas Personal Financials base module.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/personal_base.zip]

	trunk [http://www.openerp.com/download/modules/trunk/personal_base.zip]









Dependencies



	base

	account









Reports

None




Menus



	Administration/Personal

	Financial Management/Account Entries

	Financial Management/Account Entries/New Account Entry

	Financial Management/Account Entries/Confirmed Account Entries

	Financial Management/Account Entries/Draft Account Entries

	Financial Management/Account Entries/Confirmed Account Entries/Confirmed Account Lines

	Financial Management/Accounts Definition

	Financial Management/Chart of Accounts

	Administration/Personal/Account Types

	Administration/Personal/Create Account Types

	Administration/Personal/Actions After Login









Views



	personal.base.account.entry.tree (tree)

	personal.base.account.entry.form (form)

	personal.base.account.entry.line.tree (tree)

	personal.base.account.entry.line.tree (tree)

	personal.base.account.entry.line.form (form)

	personal.base.account.form (form)

	personal.base.account.tree (tree)

	personal.base.account.tree (tree)

	personal.base.account.type.tree (tree)

	personal.base.account.type.form (form)









Objects


Object: Account Type (personal.base.account.type)





	name:	Acc. Type Name, char, required









	sign:	Sign, selection, required








Object: Account (personal.base.account)





	currency_id:	Currency, many2one, required









	user_id:	User, many2one, required









	name:	Name, char, required









	type_id:	Account Type, many2one, required









	child_ids:	Childs Codes, one2many









	note:	Note, text









	parent_id:	Parent Code, many2one









	unit_test:	unit_test, boolean









	balance:	Balance, float, readonly








Object: Account Entry (personal.base.account.entry)





	currency_id:	Currency, many2one









	created_in_model_id:

		Created in Model, many2one, required, readonly









	user_id:	User, many2one, required









	name:	Description, char, required









	note:	Note, text









	state:	State, selection, required, readonly









	unit_test:	unit_test, boolean









	date:	Date, date, required









	line_ids:	Entries, one2many








Object: Account Entry Line (personal.base.account.entry.line)





	user_id:	User, many2one, required









	account_id:	Account, many2one, required









	debit_amount:	Debit Amount, float









	credit_amount:	Credit Amount, float









	amount_base_with_sign:

		Amount, float, readonly









	amount_base:	Amount Base, float









	currency_id:	Currency, many2one, required









	parent_id:	Entry, many2one, required









	state:	State, selection, required, readonly









	unit_test:	unit_test, boolean









	currency_rate:	Currency Rate, float, required









	date:	Date, date, required









	balance:	Balance, float, readonly









	name:	Description, char








Object: personal.base.action.login (personal.base.action.login)





	name:	Name, char









	action_id:	Action, many2one, required













          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Point Of Sale Extension (point_of_sale_extension)





	Module:	point_of_sale_extension


	Name:	Point Of Sale Extension


	Version:	5.0.1.0


	Author:	Zikzakmedia SL


	Directory:	point_of_sale_extension


	Web:	http://www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

* Only it allows delete draft or cancelled POS orders and POS order lines.
* If POS order has a partner, the partner is stored in:
    - The stock.picking created by the pos order.
    - The account.move.line created by the pos order.
* POS orders with amount_total==0 no creates account moves (it gives error).
* Shows the payment type (journal) in the payments list in the second tab of the POS.
* The journals used to pay with the POS can be chosen (in the configuration tab of the company: Administration / Users / Companies).
* Product prices with or without taxes included (select in the configuration tab of the company).
* Shows a warning in the payment wizard (but you can continue) if:
    - A product added in the POS order has already been requested by the partner (the partner has a sale order with this product), so the user can decide if is better to do a POS order from a sale order.
    - There is not enough virtual stock in any of the products.
  These two warnings can be activated/deactivated (in the configuration tab of the company).
* List and search POS order lines by number of order, partner and state.
* If product_visible_discount module is installed and visible discount field in price list is checked, computes discounts in point of sale order lines.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	point_of_sale









Reports

None




Menus

None




Views



	* INHERIT res.company.pos.config (form)

	* INHERIT pos.order.form.ext1 (form)

	* INHERIT pos.order.form.ext2 (form)

	* INHERIT pos.order.form.ext3 (form)

	* INHERIT pos.order.form.ext4 (form)

	* INHERIT pos.order.form.ext5 (form)

	* INHERIT pos.order.form.ext6 (form)

	* INHERIT pos.order.form.ext7 (form)

	* INHERIT pos.order.form.ext8 (form)

	* INHERIT Sales ext1 (tree)

	* INHERIT Sale lines ext1 (tree)

	* INHERIT Sale lines ext2 (tree)

	* INHERIT Sale lines ext3 (tree)









Objects


Object: Change path to rml file to get a better POS receipt (pos.report.change)
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Point Of Sale (point_of_sale)





	Module:	point_of_sale


	Name:	Point Of Sale


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	point_of_sale


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Main features :
 - Fast encoding of the sale.
 - Allow to choose one payment mode (the quick way) or to split the payment between several payment mode.
 - Computation of the amount of money to return.
 - Create and confirm picking list automatically.
 - Allow the user to create invoice automatically.
 - Allow to refund former sales.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/point_of_sale.zip]

	trunk [http://www.openerp.com/download/modules/trunk/point_of_sale.zip]









Dependencies



	sale

	purchase

	account

	account_tax_include









Reports



	Receipt

	Invoice

	Details of Sales

	Sales (summary)

	Pos Lines









Menus



	Point of Sale/Configuration

	Point of Sale

	Point of Sale/Point of Sale

	Point of Sale/Configuration/Default journals

	Point of Sale/Point of Sale/Orders of the day

	Point of Sale/Point of Sale/All orders

	Point of Sale/POS Lines

	Point of Sale/POS Lines/POS Lines of the day

	Point of Sale/Reporting

	Point of Sale/Reporting/Sales of the day

	Point of Sale/Reporting/Sales of the month

	Point of Sale/Reporting/All the sales









Views



	pos.order (form)

	Sales (tree)

	Sale lines (tree)

	Sale line (form)

	report.trans.pos.user.form (form)

	Sales by user (tree)









Objects


Object: Point of Sale journal configuration. (pos.config.journal)





	code:	Code, char









	name:	Description, char









	journal_id:	Journal, many2one








Object: Point of Sale (pos.order)





	sale_journal:	Journal, many2one, required, readonly









	date_validity:	Validity Date, date, required









	account_move:	Account Entry, many2one, readonly









	date_order:	Date Ordered, datetime, readonly









	partner_id:	Partner, many2one, readonly









	last_out_picking:

		Last Output Picking, many2one, readonly









	nb_print:	Number of Print, integer, readonly









	note:	Notes, text









	user_id:	Logged in User, many2one, readonly






This is the logged in user (not necessarily the salesman).






	pickings:	Picking, one2many, readonly









	invoice_wanted:	Create Invoice, boolean









	amount_tax:	Taxes, float, readonly









	state:	State, selection, readonly









	pricelist_id:	Pricelist, many2one, required, readonly









	amount_return:	unknown, float, readonly









	account_receivable:

		Default Receivable, many2one, required, readonly









	amount_paid:	unknown, float, readonly









	amount_total:	Total, float, readonly









	name:	Order Description, char, required, readonly









	invoice_id:	Invoice, many2one, readonly









	lines:	Order Lines, one2many, readonly









	salesman_id:	Salesman, many2one






This is the salesman actually making the order.






	shop_id:	Shop, many2one, required, readonly









	payments:	Order Payments, one2many, readonly








Object: Lines of Point of Sale (pos.order.line)





	create_date:	Creation Date, datetime, readonly









	name:	Line Description, char









	order_id:	Order Ref, many2one









	price_unit:	Unit Price, float, required









	price_subtotal:	Subtotal, float, readonly









	qty:	Quantity, float









	discount:	Discount (%), float









	product_id:	Product, many2one, required








Object: Pos Payment (pos.payment)





	payment_id:	Payment Term, many2one









	payment_date:	Payment Date, date, required









	payment_name:	Payment Name, char









	name:	Description, char









	order_id:	Order Ref, many2one, required









	journal_id:	Journal, many2one, required









	amount:	Amount, float, required









	payment_nb:	Piece Number, char








Object: transaction for the pos (report.transaction.pos)





	user_id:	User, many2one, readonly









	no_trans:	Number of Transaction, float, readonly









	invoice_id:	Invoice, many2one, readonly









	journal_id:	Journal, many2one, readonly









	date_create:	Date, char, readonly









	amount:	Amount, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Portal Management - Account (portal_account)





	Module:	portal_account


	Name:	Portal Management - Account


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	portal_account


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Portal Management - Account specific data.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/portal_account.zip]

	trunk [http://www.openerp.com/download/modules/trunk/portal_account.zip]









Dependencies



	base

	portal

	account

	mrp









Reports

None




Menus



	Portal/Customer Portal/Account

	Portal/Customer Portal/Account/Invoices

	Portal/Customer Portal/Account/Invoices/Your Invoices

	Portal/Customer Portal/Account/Invoices/Customer Refund

	Portal/Customer Portal/Account/Payables & Receivables









Views



	account.invoice.tree (tree)

	account.invoice.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Portal Management - Analytic Entries (portal_analytic_package)





	Module:	portal_analytic_package


	Name:	Portal Management - Analytic Entries


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	portal_analytic_package


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Potal Management - Service company specific data for analytic accounting.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/portal_analytic_package.zip]

	trunk [http://www.openerp.com/download/modules/trunk/portal_analytic_package.zip]









Dependencies



	portal

	account_analytic_package

	account_analytic_analysis

	hr_timesheet_invoice









Reports

None




Menus



	Portal/Customer Portal/Operations

	Portal/Customer Portal/Operations/Analytic Operations









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Portal Management - Analytic Entries (portal_analytic)





	Module:	portal_analytic


	Name:	Portal Management - Analytic Entries


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	portal_analytic


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Potal Management - Service company specific data for analytic accounting.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/portal_analytic.zip]

	trunk [http://www.openerp.com/download/modules/trunk/portal_analytic.zip]









Dependencies



	portal

	account_analytic_package

	account_analytic_analysis

	hr_timesheet_invoice









Reports

None




Menus



	Portal/Customer Portal/Contracts

	Portal/Customer Portal/Contracts/Open Contracts

	Portal/Customer Portal/Contracts/Closed Contracts









Views



	portal.account.analytic.account.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Project Portal (portal_project)





	Module:	portal_project


	Name:	Project Portal


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	portal_project


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Synchronize between :
                  - Project
                  - Analytic Account
                  - CRM Section Project task and CRM Case.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/portal_project.zip]

	trunk [http://www.openerp.com/download/modules/trunk/portal_project.zip]









Dependencies



	base

	project

	crm_configuration









Reports

None




Menus



	CRM & SRM/All Announces

	CRM & SRM/All Announces/New Announce









Views



	* INHERIT project.portal.form (form)

	CRM - Announce Tree (tree)

	CRM - Announce Form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Portal Management (portal)





	Module:	portal


	Name:	Portal Management


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	portal


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Base module to manage portal:
    - define new menu entry with associated actions.
    - add/delete menu entry easily.
    - on-the-fly rules and access control creation.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/portal.zip]

	trunk [http://www.openerp.com/download/modules/trunk/portal.zip]









Dependencies



	base









Reports

None




Menus



	Portal

	Portal/Configuration

	Portal/Customer Portal

	Portal/Configuration/Portals

	Portal/Configuration/Available Models

	Portal/Configuration/Create Menu









Views



	Portal (form)

	Portal (tree)

	Portal Model (form)

	* INHERIT ir.actions.report.custom.form.inherit (form)

	* INHERIT ir.actions.report_xml.form.inherit (form)

	* INHERIT ir.actions.wizards.form.inherit (form)

	* INHERIT ir.actions.windows.form.inherit (form)

	Portal : Install extra modules (form)









Objects


Object: Portal (portal.portal)





	menu_id:	Main Menu, many2one, required









	menu_action_id:	User Menu Action, many2one, readonly






Default main menu for the users of the portal. This field is auto-completed at creation.






	name:	Portal Name, char, required









	company_id:	Company, many2one, required









	home_action_id:	User Home Action, many2one






Complete this field to provide a Home menu different from the Main menu.






	group_id:	Associated Group, many2one, required








Object: Portal Model (portal.model)





	model_id:	Model, many2one, required









	rule_group_id:	Rule group, many2one









	view_ids:	Views, many2many









	name:	Name, char








Object: portal.config.install_modules_wizard (portal.config.install_modules_wizard)





	portal_service:	Portal for Service Module, boolean









	portal_sale:	Portal for Sale Module, boolean









	portal_account:	Portal for Account Module, boolean









	portal_analytic:

		Portal for Analytic Account Module, boolean
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Portal Sale Management (portal_sale)





	Module:	portal_sale


	Name:	Portal Sale Management


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	portal_sale


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/portal_sale.zip]

	trunk [http://www.openerp.com/download/modules/trunk/portal_sale.zip]









Dependencies



	base

	portal

	sale









Reports

None




Menus



	Portal/Customer Portal/Order

	Portal/Customer Portal/Order/Sale Order









Views



	portal order (tree)

	portal order (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Portal Management - Service (portal_service)





	Module:	portal_service


	Name:	Portal Management - Service


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	portal_service


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Potal Management - Service company specific data.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/portal_service.zip]

	trunk [http://www.openerp.com/download/modules/trunk/portal_service.zip]









Dependencies



	base

	portal

	project

	crm

	account_analytic_analysis

	hr_timesheet_invoice

	scrum









Reports

None




Menus



	Portal/Customer Portal/Your Projects

	Portal/Customer Portal/Your Projects/Your Projects

	Portal/Customer Portal/Support

	Portal/Customer Portal/Support/All Support Cases

	Portal/Customer Portal/Support/All Support Cases/Opened Cases

	Portal/Customer Portal/Support/All Support Cases/Closed Cases









Views



	crm.case.section.tree (tree)

	* INHERIT Available Cases List (tree)

	* INHERIT Available Case (form)

	* INHERIT scrum.project.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Training Portal (portal_training)





	Module:	portal_training


	Name:	Training Portal


	Version:	5.0.0.0.1


	Author:	Tiny SPRL


	Directory:	portal_training


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Training Portals








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/portal_training.zip]

	trunk [http://www.openerp.com/download/modules/trunk/portal_training.zip]









Dependencies



	portal

	board

	training









Reports

None




Menus



	Portal/Training Portals

	Portal/Training Portals/Supplier Portal

	Portal/Training Portals/Supplier Portal/Purchase Management

	Portal/Training Portals/Supplier Portal/Purchase Management/Your Purchase Order Lines

	Portal/Training Portals/Supplier Portal/Training Management

	Portal/Training Portals/Supplier Portal/Training Management/Seances

	Portal/Training Portals/Partner Portal

	Portal/Training Portals/Partner Portal/Training Management

	Portal/Training Portals/Partner Portal/Training Management/Subscriptions

	Portal/Training Portals/Partner Portal/Training Management/Subscriptions/New Subscription

	Portal/Training Portals/Partner Portal/Survey

	Portal/Training Portals/Partner Portal/Survey/Old Subscriptions

	Portal/Training Portals/Partner Portal/Financial Management

	Portal/Training Portals/Partner Portal/Financial Management/Customer Invoices

	Portal/Training Portals/SkateHolder Portal

	Portal/Training Portals/SkateHolder Portal/Training Management

	Portal/Training Portals/SkateHolder Portal/Training Management/Participations of the Participants

	Portal/Training Portals/SkateHolder Portal/Training Management/Evaluation Form









Views



	purchase.order.line.form.portal (form)

	view.portal.supplier.training.seance.list (tree)

	view.portal.partner.subscription.tree (tree)

	board.portal.training.supplier (form)









Objects


Object: portal.training.subscription (portal.training.subscription)





	session_id:	Session, many2one, readonly









	note:	Note, text, readonly









	course_id:	Course, many2one, readonly









	contact_id:	Contact, many2one, readonly









	seance_id:	Seance, many2one, readonly









	date:	Date, date, readonly









	examen:	Is Examen, boolean, readonly









	partner_id:	Partner, many2one, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Invoices and prices with taxes included (pos_tax_include)





	Module:	pos_tax_include


	Name:	Invoices and prices with taxes included


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	pos_tax_include


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Allow the user to work tax included prices.
Especially useful for b2c businesses.

This module implement the modification on the pos order form.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/pos_tax_include.zip]

	trunk [http://www.openerp.com/download/modules/trunk/pos_tax_include.zip]









Dependencies



	point_of_sale









Reports

None




Menus

None




Views



	* INHERIT pos.order.qty.view.form (form)

	* INHERIT pos.order.exlcuded.view.form (form)

	* INHERIT pos.order.qty.view.form (form)

	* INHERIT pos.order.qty.view.form (form)

	* INHERIT pos.order.discount.view.form (form)

	* INHERIT pos.order.discount.view.form (form)

	* INHERIT pos.order.price_ded.view.form (form)

	* INHERIT pos.order.price_ded.view.form (form)









Objects

None
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Pricing policy module (pricing_policy)





	Module:	pricing_policy


	Name:	Pricing policy module


	Version:	1.0


	Author:	Sednacom


	Directory:	pricing_policy


	Web:	http://www.sednacom.fr


	Official module:

		no


	Quality certified:

		no






Description

Pricing policy module. Install this module to enable a strong link between sale and purchase prices.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/pricing_policy.zip]

	trunk [http://www.openerp.com/download/modules/trunk/pricing_policy.zip]









Dependencies



	sale

	purchase









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Enterprise Process (process)





	Module:	process


	Name:	Enterprise Process


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	process


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows you to manage your process for the end-users.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/process.zip]

	trunk [http://www.openerp.com/download/modules/trunk/process.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Customization/Enterprise Processes

	Administration/Customization/Enterprise Processes/Process

	Administration/Customization/Enterprise Processes/Process Nodes

	Administration/Customization/Enterprise Processes/Process Transitions









Views



	process.process.form (form)

	process.process.tree (tree)

	process.node.tree (tree)

	process.node.form (form)

	process.transition.tree (tree)

	process.transition.form (form)









Objects


Object: Process (process.process)





	active:	Active, boolean









	model_id:	Object, many2one









	note:	Notes, text









	name:	Name, char, required









	node_ids:	Nodes, one2many








Object: Process Nodes (process.node)





	menu_id:	Related Menu, many2one









	model_id:	Object, many2one









	kind:	Kind of Node, selection, required









	name:	Name, char, required









	subflow_id:	Subflow, many2one









	condition_ids:	Conditions, one2many









	note:	Notes, text









	process_id:	Process, many2one, required









	model_states:	States Expression, char









	transition_out:	Ending Transitions, one2many









	help_url:	Help URL, char









	transition_in:	Starting Transitions, one2many









	flow_start:	Starting Flow, boolean








Object: Condition (process.condition)





	model_id:	Object, many2one









	node_id:	Node, many2one, required









	model_states:	Expression, char, required









	name:	Name, char, required








Object: Process Transitions (process.transition)





	role_ids:	Roles, many2many









	transition_ids:	Workflow Transitions, many2many









	name:	Name, char, required









	note:	Description, text









	target_node_id:	Target Node, many2one, required









	source_node_id:	Source Node, many2one, required









	action_ids:	Buttons, one2many








Object: Process Transitions Actions (process.transition.action)





	action:	Action ID, char









	state:	Type, selection, required









	name:	Name, char, required









	transition_id:	Transition, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product Catalog - Print Report of product catalog with product image (product_catalog_report)





	Module:	product_catalog_report


	Name:	Product Catalog - Print Report of product catalog with product image


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	product_catalog_report


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module use to print report of product catalog with product image, list price








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_catalog_report.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_catalog_report.zip]









Dependencies



	base

	product









Reports

None




Menus

None




Views

None




Objects

None
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Product code by Category (product_code_category)





	Module:	product_code_category


	Name:	Product code by Category


	Version:	1.0


	Author:	Syleam Info Services


	Directory:	product_code_category


	Web:	http://www.syleam.fr/


	Official module:

		no


	Quality certified:

		no






Description

Add product code by Category








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/product_code_category.zip]









Dependencies



	base

	product









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Products Sequence (product_ean13)





	Module:	product_ean13


	Name:	Products Sequence


	Version:	5.0.0.1


	Author:	Ana Juaristi


	Directory:	product_ean13


	Web:	www.openerpsite.com


	Official module:

		no


	Quality certified:

		no






Description

This module:
  * Adds a wizard on product form to generate valid EAN13 product codes.
  * By default EAN13 will be generated with Spanish country code (84) and 11111 company code.
Each company should change these values on administration/sequences to their country and company code.

Este módulo:
  * Añade un asistente al producto para crear un código EAN13 con formato válido.
  * Por defecto, el código EAN13 será generado con la secuencia de país 84 y el código de empresa 1111.
Cada compañía deberá adecuar estos valores por defecto a los de su país y empresa en Administración/Personalización/Secuencias.
La secuencia de productos por defecto se inicia en 1 (y relleno de 5 dígitos tal como recomienda AECOC)








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	product









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Products Attributes & Manufacturers (product_electronic)





	Module:	product_electronic


	Name:	Products Attributes & Manufacturers


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	product_electronic


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

A module that add manufacturers and attributes on the product form








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/product_electronic.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/product_electronic.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_electronic.zip]









Dependencies



	base

	account

	product

	stock









Reports

None




Menus

None




Views



	* INHERIT product.normal.form (form)

	product.electronic.attribute.tree (tree)

	product.electronic.attribute.form (form)









Objects


Object: Product attributes (product.electronic.attribute)





	name:	Attribute, char, required









	value:	Value, char









	product_id:	Product, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Products date of expiry (product_expiry)





	Module:	product_expiry


	Name:	Products date of expiry


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	product_expiry


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Track different dates on products and lots. Used, for example, in food industries: expiry date, alert date, date of removal, eso.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_expiry.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_expiry.zip]









Dependencies



	base

	account

	product

	stock









Reports

None




Menus

None




Views



	* INHERIT stock.production.lot.form (form)

	* INHERIT product.normal.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product extension to track sales and purchases (product_extended)





	Module:	product_extended


	Name:	Product extension to track sales and purchases


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	product_extended


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Product extension. This module adds:
  * Last purchase order for each product supplier
  * New functional field: Available stock (real+outgoing stock)
  * Computes standard price from the BoM of the product (optional for each product)
  * Standard price is shown in the BoM and it can be computed with a wizard








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_extended.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_extended.zip]









Dependencies



	product

	purchase

	sale









Reports

None




Menus

None




Views



	* INHERIT product_extended.supplierinfo.form.view (form)

	* INHERIT product_extended.supplierinfo.tree.view (tree)

	* INHERIT product_extended.product.form.view (form)

	* INHERIT product_extended.product.form.view (form)

	* INHERIT mrp.bom.form.product_extended (form)

	* INHERIT mrp.bom.tree.product_extended (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product GTIN EAN UPC JPC Support (product_gtin)





	Module:	product_gtin


	Name:	Product GTIN EAN UPC JPC Support


	Version:	5.0.1.0


	Author:	ChriCar Beteiligungs- und Beratungs- GmbH


	Directory:	product_gtin


	Web:	http://www.chricar.at/ChriCar


	Official module:

		no


	Quality certified:

		no






Description

Replaces the EAN13 code completion with a checkroutine for EAN13, EAN8, UPC and GTIN.
It allows to support different types of barcodes systems.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_gtin.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_gtin.zip]









Dependencies



	product









Reports

None




Menus

None




Views

None




Objects

None
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Product Hardware Revision (product_hardware_revision)





	Module:	product_hardware_revision


	Name:	Product Hardware Revision


	Version:	0.1


	Author:	Smile.fr


	Directory:	product_hardware_revision


	Web:	http://www.smile.fr


	Official module:

		no


	Quality certified:

		no






Description

Product Hardware Revision: every product can have n revisions and
also have a current default revision. Then when receiving a product, in the incoming picking,
if a stock.production.lot (eg serial number here) is to be created, then a first line of stock.production.lot.revision
is created in the stock.production.lot with values copied from the product default revision.
The user can still choose an other revision manually before it gets copied. This is really useful
to track the exact hardware of a product with electronic products fro instance.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_hardware_revision.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_hardware_revision.zip]









Dependencies



	product

	stock

	mrp_prodlot_autosplit









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product Image Gallery (product_images_olbs)





	Module:	product_images_olbs


	Name:	Product Image Gallery


	Version:	5.0.0.1


	Author:	Sharoon Thomas, Open Labs Business Solutions


	Directory:	product_images_olbs


	Web:	http://openlabs.co.in/


	Official module:

		no


	Quality certified:

		no






Description

This Module implements an Image Gallery for products.
    You can add images against every product.

    This module is generic but built for Magento ERP connector and
    the upcoming e-commerce system for OpenERP by Open Labs








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	product









Reports

None




Menus

None




Views



	product.images.form (form)

	product.images.tree (tree)

	* INHERIT product.product.images (tree)









Objects


Object: Products Image gallery (product.images)





	product_id:	Product, many2one









	image:	Image, binary









	comments:	Comments, text









	filename:	File Location, char









	link:	Link?, boolean






Images can be linked from files on your file system or remote (Preferred)






	preview:	unknown, binary, readonly









	name:	Image Title, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Manage indexes on products prices (product_index)





	Module:	product_index


	Name:	Manage indexes on products prices


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	product_index


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_index.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_index.zip]









Dependencies



	product









Reports

None




Menus



	Products/Configuration/Indexes

	Products/Configuration/Indexes/New index









Views



	product.index.tree (tree)

	product.index.form (form)

	* INHERIT product.normal.form (form)









Objects


Object: Index (product.index)





	rate_ids:	Rates, one2many









	code:	Index code, char









	name:	Index name, char, required









	rounding:	Rounding factor, float









	rate:	Current rate, float, readonly









	active:	Active, boolean








Object: Index Rate (product.index.rate)





	rate:	Rate, float, required









	index_id:	index, many2one, readonly









	name:	Date, date, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Analyse the productivity of OpenERP users (productivity_analysis)





	Module:	productivity_analysis


	Name:	Analyse the productivity of OpenERP users


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	productivity_analysis


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

A module which analyses users' productivity in terms of creation and modification of objects. It is able to render graphs, compare users, eso.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/productivity_analysis.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/productivity_analysis.zip]

	trunk [http://www.openerp.com/download/modules/trunk/productivity_analysis.zip]









Dependencies



	base









Reports



	Users Productivity Analysis









Menus



	Reporting

	Reporting/Productivity Analysis

	Reporting/Productivity Analysis/Definition

	Reporting/Productivity Analysis/Definition/Available Models

	Reporting/Productivity Analysis/Productivity Analysis









Views



	productivity_analysis.models.form (form)









Objects


Object: Objects for Productivity Analysis (productivity_analysis.models)





	active:	Active, boolean









	model:	Model, char, required









	name:	Model Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product listprice upgrade (product_listprice_upgrade)





	Module:	product_listprice_upgrade


	Name:	Product listprice upgrade


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	product_listprice_upgrade


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

The aim of this module is to allow the automatic upgrade of the field 'List Price' on each product.
    * added a new price type called 'Internal Pricelist' (currently, we have only 2 price types: Sale and Purchase Pricelist)
    * Created a wizard button in the menu Products>Pricelist called 'Upgrade Product List Price'
    * When we have completed the wizard and click on 'Upgrade', it will change the field 'List Price' for all products contained in the categories that we have selected in the wizard








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_listprice_upgrade.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_listprice_upgrade.zip]









Dependencies



	base

	product









Reports

None




Menus



	Products/Pricelists

	Products/Pricelists/Upgrade Product List price









Views

None




Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
  

Product Loan - work in progress (product_loan)





	Module:	product_loan


	Name:	Product Loan - work in progress


	Version:	0.1


	Author:	Smile.fr


	Directory:	product_loan


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Loan module - work in progress








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_loan.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_loan.zip]









Dependencies



	stock

	sale









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Products Lot Foundry (product_lot_foundry)





	Module:	product_lot_foundry


	Name:	Products Lot Foundry


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	product_lot_foundry


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Lots management for a metal company: cutting, heatcode, sizes








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_lot_foundry.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_lot_foundry.zip]









Dependencies



	base

	account

	product

	stock

	sale









Reports

None




Menus



	Inventory Control

	Inventory Control/Heat Codes

	Inventory Control/Heat Codes/Draft Heat Codes









Views



	* INHERIT stock.production.lot.form (form)

	product.lot.foundry.heatcode.tree (tree)

	product.lot.foundry.heatcode.form (form)

	* INHERIT product.normal.form (form)

	sale.order.form (form)









Objects


Object: Heat Code (product.lot.foundry.heatcode)





	name:	Heat Code, char, required









	lot_ids:	Lots, one2many









	mecanical_ids:	Mechanical Properties, one2many









	state:	State, selection, required









	date:	Date, date, required









	chemical_ids:	Chemical Properties, one2many








Object: Mechanical Properties (product.lot.foundry.heatcode.mecanical)





	heatcode_id:	Heatcode, many2one









	name:	Property, char, required









	value:	Value, char, required








Object: Chemical Properties (product.lot.foundry.heatcode.chemical)





	heatcode_id:	Heatcode, many2one









	name:	Property, char, required









	value:	Value, char, required








Object: stock.production.lot.reservation (stock.production.lot.reservation)





	name:	Reservation, char









	size_x:	Width, float









	size_y:	Length, float









	size_z:	Thickness, float









	date:	Date, date









	lot_id:	Lot, many2one, required








Object: stock.production.lot.all (stock.production.lot.all)





	lot_id:	Lot, many2one









	name:	Quantity, float









	line_id:	Order Line, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product - Many Categories (product_m2mcategories)





	Module:	product_m2mcategories


	Name:	Product - Many Categories


	Version:	5.0.1.0.2


	Author:	Sharoon Thomas


	Directory:	product_m2mcategories


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module Extends the existing functionality of OpenERP Products (One product - One Category)
    to One product -> Many Categories

    *Note: This module was built generically but in focus of the Magento OpenERP connector








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_m2mcategories.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_m2mcategories.zip]









Dependencies



	base

	product









Reports

None




Menus

None




Views



	* INHERIT product.normal.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Margins in Product (product_margin)





	Module:	product_margin


	Name:	Margins in Product


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	product_margin


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Adds a reporting menu in products that computes sales, purchases, margins
and others interesting indicators based on invoices. The wizard to launch
the report has several options to help you get the data you need.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_margin.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_margin.zip]









Dependencies



	base

	product

	account









Reports

None




Menus



	Products/Reporting

	Products/Reporting/Product Margins









Views



	product.margin.graph (graph)

	product.margin.form.inherit (form)

	product.margin.tree (tree)









Objects

None
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Product Decay - work in progress (product_price_decay)





	Module:	product_price_decay


	Name:	Product Decay - work in progress


	Version:	0.1


	Author:	Smile.fr


	Directory:	product_price_decay


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Product Decay
the goal of this module, is to estimate the average price of the remaining product stock using the following assertions:
- the remaining stock is based on the invoiced products only (from purchases and sales)
- everything happen like if we sale first the more expensive remaining products

So it's a bit like FIFO (if prices were always falling it would look like FIFO) but it's certainly not a
legal way of valuing your stocks.

Actually this module only gives you an indicative price that you could base your sale margin upon, so that:
- you always ensure a given margin
- you make sure your sale price will follow the market, meaning decay hopefully








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_price_decay.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_price_decay.zip]









Dependencies



	product

	account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Price list discount and tax handling (product_pricelist_discount_and_tax)





	Module:	product_pricelist_discount_and_tax


	Name:	Price list discount and tax handling


	Version:	5.0.1.1


	Author:	Gábor Dukai


	Directory:	product_pricelist_discount_and_tax


	Web:	http://exploringopenerp.blogspot.com


	Official module:

		no


	Quality certified:

		no






Description

A complete solution for those companies who use discounts and/or
    product prices with tax included extensively.

    This module is like product_visible_discount but improved in many ways:
      -Properly calculates discounts for any price type, not only list_price.
      -It's able to add/subtract tax from the price before calculating the discount.
      This means you can have for example a 'shop price' calculated with tax included
      and define a price list like 'shop price net -5%' easily.
      -It works with product_price_update that module can mass calculate and
      update product prices with tax included.
      -A simpler override of the SO's product_id_change, 2 browses and 2 reads less.
      -Purchase Orders can also use discounts if the supplier defines his prices
      with discounts.
      -Even PO's generated with MRP will have the discounts defined in the
      supplier price list.

    Compatibility: tested with OpenERP v5.0








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	sale

	purchase_discount









Reports

None




Menus

None




Views



	* INHERIT product.price.type.form.pricelist_tax_include (form)

	* INHERIT product.pricelist.tree.pricelist_tax_include (form)

	* INHERIT product.pricelist.form.pricelist_tax_include1 (form)

	* INHERIT product.pricelist.form.pricelist_tax_include2 (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product price update (product_price_update)





	Module:	product_price_update


	Name:	Product price update


	Version:	5.0.1.1


	Author:	Gábor Dukai


	Directory:	product_price_update


	Web:	http://exploringopenerp.blogspot.com


	Official module:

		no


	Quality certified:

		no






Description

You can think of this module as product_listprice_upgrade v2.

    The aim of this module is to allow the automatic update of the price fields of products.
    * added a new pricelist type called 'Internal Pricelist' (currently, we have only 2 pricelist types: Sale and Purchase Pricelist)
    * Created a wizard button in the menu Products>Pricelist called 'Update Product Prices'
    * After filling in the wizard form and clicking on 'Update', it will change the selected price field of all products in the categories that we were selected in the wizard.

    Compatibility: tested with OpenERP v5.0








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_price_update.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_price_update.zip]









Dependencies



	product

	product_pricelist_discount_and_tax









Reports

None




Menus



	Products/Pricelists/Update Product Prices









Views



	Updated the price of products (form)

	Update Product Prices (form)









Objects


Object: product.price.update.wizard (product.price.update.wizard)





	pricelist_id:	Select a Pricelist, many2one, required









	upgrade:	Update child categories, boolean









	categ_ids:	Select Product Categories, many2many, required









	price_type_id:	Price to Update, many2one, required








Object: product.price.update.wizard.done (product.price.update.wizard.done)





	updated_field:	Updated price type, char, readonly









	updated_products:

		Number of updated products, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Products & Pricelists- Define quality control and testing parameters in product (product_qt)





	Module:	product_qt


	Name:	Products & Pricelists- Define quality control and testing parameters in product


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	product_qt


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module add quality control and testing parameters in product
    1> configure QC parameters for particular product.
    2> QC testing on purchased raw material.
    3> QC testing during production.
    3> QC testing on finished goods.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_qt.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_qt.zip]









Dependencies



	base

	mrp_operations









Reports

None




Menus



	Stock Management/Testing Result

	Stock Management/Testing Result/Testing Result









Views



	quality.testing.form (form)

	quality.testing.tree (tree)

	quality.testing.config.tree (tree)

	quality.testing.config.form (form)

	* INHERIT product.testing.form (form)

	* INHERIT quality.testing.form (form)

	* INHERIT quality.testing.move.form (form)

	testing_result.tree (tree)

	testing_result.form (form)

	* INHERIT quality.testing.mrp.production.form (form)

	* INHERIT quality.testing.mrp.production.form (form)

	* INHERIT quality.testing.mrp.production.tree (tree)

	* INHERIT quality.testing.mrp.form (form)









Objects


Object: quality testings (quality.test)





	name:	Test Case, char









	description:	Description, text








Object: testing.result (testing.result)





	product:	Product, many2one, readonly









	type:	Testing Type, selection, readonly









	test_date:	Testing Date, date









	test_case:	Cases, one2many









	tester:	Tested By, many2one








Object: quality test configuration (quality.test.config)





	product_idf:	Product, many2one









	max_limit:	Max Limit, float






Maximum Limit of measure






	actual_val:	Actual Value, float









	name:	Test Case, many2one









	min_limit:	Min Limit, float






Minimum Limit of measure






	state:	Status, selection, readonly









	product_idr:	Product, many2one









	product_idp:	Product, many2one









	test_id:	Test Result, many2one









	uom:	UOM, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Products & Pricelists (product)





	Module:	product


	Name:	Products & Pricelists


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	product


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This is the base module for managing products and pricelists in OpenERP.

    Products support variants, different pricing methods, suppliers
    information, make to stock/order, different unit of measures,
    packaging and properties.

    Pricelists support:
    * Multiple-level of discount (by product, category, quantities)
    * Compute price based on different criteria:
        * Other pricelist,
        * Cost price,
        * List price,
        * Supplier price, ...
    Pricelists preferences by product and/or partners.

    Print product labels with barcode.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/product.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/product.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product.zip]









Dependencies



	base

	process









Reports



	Products Labels

	Product Pricelist









Menus



	Products

	Products/Configuration

	Products/Products

	Products/Products by Category

	Products/Configuration/Products Categories

	Products/Configuration/Units of Measure

	Products/Configuration/Units of Measure/Units of Measure

	Products/Configuration/Units of Measure/Units of Measure Categories

	Products/Configuration/Packaging

	Products/Pricelists

	Products/Pricelists/Pricelist Versions

	Products/Pricelists/Pricelists

	Products/Configuration/Prices Computations

	Products/Configuration/Prices Computations/Prices Types

	Products/Configuration/Prices Computations/Pricelists Types









Views



	product.product.tree (tree)

	product.normal.form (form)

	product.category.form (form)

	product.category.list (tree)

	product.category.tree (tree)

	product.uom.tree (tree)

	product.uom.form (form)

	product.uom.categ.form (form)

	product.ul.form.view (form)

	product.ul.tree (tree)

	product.packaging.tree.view (tree)

	product.packaging.form.view (form)

	product.supplierinfo.form.view (form)

	product.supplierinfo.tree.view (tree)

	product.variant.form (form)

	product.variant.tree (tree)

	product.template.product.tree (tree)

	product.template.product.form (form)

	product.pricelist.version.form (form)

	product.pricelist.version.tree (tree)

	product.pricelist.item.tree (tree)

	product.pricelist.item.form (form)

	product.pricelist.tree (tree)

	product.pricelist.form (form)

	product.price.type.form (form)

	product.pricelist.type.form (form)

	* INHERIT res.partner.product.property.form.inherit (form)









Objects


Object: Product uom categ (product.uom.categ)





	name:	Name, char, required








Object: Product Unit of Measure (product.uom)





	name:	Name, char, required









	factor_inv:	Factor, float, readonly






The coefficient for the formula:
coeff (base unit) = 1 (this unit). Factor = 1 / Rate.






	rounding:	Rounding Precision, float, required






The computed quantity will be a multiple of this value. Use 1.0 for products that can not be split.






	factor:	Rate, float, required






The coefficient for the formula:
1 (base unit) = coeff (this unit). Rate = 1 / Factor.






	active:	Active, boolean









	category_id:	UoM Category, many2one, required






Unit of Measure of a category can be converted between each others in the same category.






	factor_inv_data:

		Factor, float








Object: Shipping Unit (product.ul)





	type:	Type, selection, required









	name:	Name, char, required








Object: Product Category (product.category)





	parent_id:	Parent Category, many2one









	child_id:	Child Categories, one2many









	complete_name:	Name, char, readonly









	name:	Name, char, required









	sequence:	Sequence, integer








Object: Product Template (product.template)





	warranty:	Warranty (months), float









	supply_method:	Supply method, selection, required






Produce will generate production order or tasks, according to the product type. Purchase will trigger purchase orders when requested.






	uos_id:	Unit of Sale, many2one






Used by companies that manages two unit of measure: invoicing and stock management. For example, in food industries, you will manage a stock of ham but invoice in Kg. Keep empty to use the default UOM.






	list_price:	Sale Price, float






Base price for computing the customer price. Sometimes called the catalog price.






	weight:	Gross weight, float






The gross weight in Kg.






	standard_price:	Cost Price, float, required






The cost of the product for accounting stock valuation. It can serves as a base price for supplier price.






	mes_type:	Measure Type, selection, required









	uom_id:	Default UoM, many2one, required






Default Unit of Measure used for all stock operation.






	description_purchase:

		Purchase Description, text









	uos_coeff:	UOM -> UOS Coeff, float






Coefficient to convert UOM to UOS
uos = uom * coeff






	seller_delay:	Supplier Lead Time, integer, readonly






This is the average delay in days between the purchase order confirmation and the reception of goods for this product and for the default supplier. It is used by the scheduler to order requests based on reordering delays.






	purchase_ok:	Can be Purchased, boolean






Determine if the product is visible in the list of products within a selection from a purchase order line.






	product_manager:

		Product Manager, many2one









	company_id:	Company, many2one









	state:	Status, selection






Tells the user if he can use the product or not.






	loc_rack:	Rack, char









	uom_po_id:	Purchase UoM, many2one, required






Default Unit of Measure used for purchase orders. It must be in the same category as the default unit of measure.






	type:	Product Type, selection, required






Will change the way procurements are processed. Consumables are stockable products with infinite stock, or for use when you have no stock management in the system.






	loc_case:	Case, char









	description:	Description, text









	weight_net:	Net weight, float






The net weight in Kg.






	volume:	Volume, float






The volume in m3.






	procure_method:	Procure Method, selection, required






‘Make to Stock’: When needed, take from the stock or wait until re-supplying. ‘Make to Order’: When needed, purchase or produce for the procurement request.






	cost_method:	Costing Method, selection, required






Standard Price: the cost price is fixed and recomputed periodically (usually at the end of the year), Average Price: the cost price is recomputed at each reception of products.






	loc_row:	Row, char









	sale_ok:	Can be sold, boolean






Determine if the product can be visible in the list of product within a selection from a sale order line.






	rental:	Rentable Product, boolean









	sale_delay:	Customer Lead Time, float






This is the average time between the confirmation of the customer order and the delivery of the finished products. It’s the time you promise to your customers.






	name:	Name, char, required









	description_sale:

		Sale Description, text









	categ_id:	Category, many2one, required









	produce_delay:	Manufacturing Lead Time, float






Average time to produce this product. This is only for the production order and, if it is a multi-level bill of material, it’s only for the level of this product. Different delays will be summed for all levels and purchase orders.






	seller_ids:	Partners, one2many








Object: Product (product.product)





	warranty:	Warranty (months), float









	ean13:	EAN13, char









	supply_method:	Supply method, selection, required






Produce will generate production order or tasks, according to the product type. Purchase will trigger purchase orders when requested.






	uos_id:	Unit of Sale, many2one






Used by companies that manages two unit of measure: invoicing and stock management. For example, in food industries, you will manage a stock of ham but invoice in Kg. Keep empty to use the default UOM.






	list_price:	Sale Price, float






Base price for computing the customer price. Sometimes called the catalog price.






	weight:	Gross weight, float






The gross weight in Kg.






	incoming_qty:	Incoming, float, readonly









	standard_price:	Cost Price, float, required






The cost of the product for accounting stock valuation. It can serves as a base price for supplier price.






	price_extra:	Variant Price Extra, float









	mes_type:	Measure Type, selection, required









	uom_id:	Default UoM, many2one, required






Default Unit of Measure used for all stock operation.






	code:	Code, char, readonly









	description_purchase:

		Purchase Description, text









	default_code:	Code, char









	qty_available:	Real Stock, float, readonly









	variants:	Variants, char









	uos_coeff:	UOM -> UOS Coeff, float






Coefficient to convert UOM to UOS
uos = uom * coeff






	product_tmpl_id:

		Product Template, many2one, required









	virtual_available:

		Virtual Stock, float, readonly









	seller_delay:	Supplier Lead Time, integer, readonly






This is the average delay in days between the purchase order confirmation and the reception of goods for this product and for the default supplier. It is used by the scheduler to order requests based on reordering delays.






	purchase_ok:	Can be Purchased, boolean






Determine if the product is visible in the list of products within a selection from a purchase order line.






	product_manager:

		Product Manager, many2one









	company_id:	Company, many2one









	name:	Name, char, required









	active:	Active, boolean









	state:	Status, selection






Tells the user if he can use the product or not.






	loc_rack:	Rack, char









	uom_po_id:	Purchase UoM, many2one, required






Default Unit of Measure used for purchase orders. It must be in the same category as the default unit of measure.






	type:	Product Type, selection, required






Will change the way procurements are processed. Consumables are stockable products with infinite stock, or for use when you have no stock management in the system.






	price:	Customer Price, float, readonly









	description:	Description, text









	weight_net:	Net weight, float






The net weight in Kg.






	volume:	Volume, float






The volume in m3.






	outgoing_qty:	Outgoing, float, readonly









	procure_method:	Procure Method, selection, required






‘Make to Stock’: When needed, take from the stock or wait until re-supplying. ‘Make to Order’: When needed, purchase or produce for the procurement request.






	cost_method:	Costing Method, selection, required






Standard Price: the cost price is fixed and recomputed periodically (usually at the end of the year), Average Price: the cost price is recomputed at each reception of products.






	partner_ref:	Customer ref, char, readonly









	loc_row:	Row, char









	sale_ok:	Can be sold, boolean






Determine if the product can be visible in the list of product within a selection from a sale order line.






	rental:	Rentable Product, boolean









	packaging:	Logistical Units, one2many






Gives the different ways to package the same product. This has no impact on the packing order and is mainly used if you use the EDI module.






	sale_delay:	Customer Lead Time, float






This is the average time between the confirmation of the customer order and the delivery of the finished products. It’s the time you promise to your customers.






	loc_case:	Case, char









	description_sale:

		Sale Description, text









	categ_id:	Category, many2one, required









	lst_price:	List Price, float, readonly









	produce_delay:	Manufacturing Lead Time, float






Average time to produce this product. This is only for the production order and, if it is a multi-level bill of material, it’s only for the level of this product. Different delays will be summed for all levels and purchase orders.






	seller_ids:	Partners, one2many









	price_margin:	Variant Price Margin, float








Object: Packaging (product.packaging)





	code:	Code, char






The code of the transport unit.






	product_id:	Product, many2one, required









	weight:	Total Package Weight, float






The weight of a full of products palet or box.






	sequence:	Sequence, integer









	ul_qty:	Package by layer, integer









	ean:	EAN, char






The EAN code of the package unit.






	qty:	Quantity by Package, float






The total number of products you can put by palet or box.






	ul:	Type of Package, many2one, required









	length:	Length, float






The length of the package






	rows:	Number of Layer, integer, required






The number of layer on a palet or box






	weight_ul:	Empty Package Weight, float






The weight of the empty UL






	height:	Height, float






The height of the package






	width:	Width, float






The width of the package






	name:	Description, char








Object: Information about a product supplier (product.supplierinfo)





	pricelist_ids:	Supplier Pricelist, one2many









	product_id:	Product, many2one, required









	sequence:	Priority, integer









	qty:	Minimal Quantity, float, required






The minimal quantity to purchase for this supplier, expressed in the default unit of measure.






	delay:	Delivery Delay, integer, required






Delay in days between the confirmation of the purchase order and the reception of the products in your warehouse. Used by the scheduler for automatic computation of the purchase order planning.






	product_code:	Partner Product Code, char






Code of the product for this partner, will be used when printing a request for quotation. Keep empty to use the internal one.






	product_name:	Partner Product Name, char






Name of the product for this partner, will be used when printing a request for quotation. Keep empty to use the internal one.






	name:	Partner, many2one, required






Supplier of this product





Object: pricelist.partnerinfo (pricelist.partnerinfo)





	min_quantity:	Quantity, float, required









	price:	Unit Price, float, required









	suppinfo_id:	Partner Information, many2one, required









	name:	Description, char








Object: Price type (product.price.type)





	active:	Active, boolean









	field:	Product Field, selection, required






Associated field in the product form.






	currency_id:	Currency, many2one, required






The currency the field is expressed in.






	name:	Price Name, char, required






Name of this kind of price.





Object: Pricelist Type (product.pricelist.type)





	name:	Name, char, required









	key:	Key, char, required






Used in the code to select specific prices based on the context. Keep unchanged.





Object: Pricelist (product.pricelist)





	active:	Active, boolean









	currency_id:	Currency, many2one, required









	type:	Pricelist Type, selection, required









	name:	Pricelist Name, char, required









	version_id:	Pricelist Versions, one2many








Object: Pricelist Version (product.pricelist.version)





	items_id:	Price List Items, one2many, required









	name:	Name, char, required









	date_end:	End Date, date






Ending date for this pricelist version to be valid.






	date_start:	Start Date, date






Starting date for this pricelist version to be valid.






	active:	Active, boolean






When a version is duplicated it is set to non active, so that the dates do not overlaps with original version. You should change the dates and reactivate the pricelist






	pricelist_id:	Price List, many2one, required








Object: Pricelist item (product.pricelist.item)





	price_round:	Price Rounding, float






Sets the price so that it is a multiple of this value.
Rounding is applied after the discount and before the surcharge.
To have prices that end in 9.99, set rounding 10, surcharge -0.01






	name:	Rule Name, char






Explicit rule name for this pricelist line.






	base_pricelist_id:

		If Other Pricelist, many2one









	sequence:	Sequence, integer, required









	price_max_margin:

		Max. Price Margin, float









	price_version_id:

		Price List Version, many2one, required









	product_tmpl_id:

		Product Template, many2one






Set a template if this rule only apply to a template of product. Keep empty for all products






	product_id:	Product, many2one






Set a product if this rule only apply to one product. Keep empty for all products






	base:	Based on, selection, required






The mode for computing the price for this rule.






	min_quantity:	Min. Quantity, integer, required






The rule only applies if the partner buys/sells more than this quantity.






	price_surcharge:

		Price Surcharge, float









	price_min_margin:

		Min. Price Margin, float









	categ_id:	Product Category, many2one






Set a category of product if this rule only apply to products of a category and his children. Keep empty for all products






	price_discount:	Price Discount, float
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Products Search Reference (product_search_reference)





	Module:	product_search_reference


	Name:	Products Search Reference


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	product_search_reference


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Add search by partner reference on product








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_search_reference.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_search_reference.zip]









Dependencies



	product









Reports

None




Menus

None




Views



	* INHERIT product.product.tree.inherit (tree)

	* INHERIT product.normal.form.inherit (form)









Objects

None
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Product Sequence (product_sequence)





	Module:	product_sequence


	Name:	Product Sequence


	Version:	1.0


	Author:	Syleam Info Services


	Directory:	product_sequence


	Web:	http://www.syleam.fr/


	Official module:

		no


	Quality certified:

		no






Description

Add a product sequence on create, only when default_code is blank.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/product_sequence.zip]









Dependencies



	base

	product









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Partner Product Series (product_series)





	Module:	product_series


	Name:	Partner Product Series


	Version:	5.0.0.1


	Author:	Thymbra - Torre de Hanoi


	Directory:	product_series


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

It relates partners to product series.

This module adds a new object and a field on the product view.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_series.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_series.zip]









Dependencies



	base

	product









Reports

None




Menus



	Products/Configuration/Products Series









Views



	product.series.form (form)

	product.series.tree (tree)

	* INHERIT product.normal.form (form)









Objects


Object: Partner Product Series (product.series)





	code:	Code, char









	partner_id:	Manufacturer, many2one, required









	name:	Name, char









	description:	Description, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sizes of lots (width, length, thickness) (product_size)





	Module:	product_size


	Name:	Sizes of lots (width, length, thickness)


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	product_size


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Manage 3 dimensions size on lots.
Implements demo data for a complex workflow on steel.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_size.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_size.zip]









Dependencies



	base

	account

	product

	stock

	mrp

	sale









Reports

None




Menus

None




Views



	* INHERIT stock.production.lot.form (form)

	* INHERIT stock.production.lot.tree (tree)

	* INHERIT product.normal.form (form)









Objects

None
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Product Tax Include (product_tax_incl)





	Module:	product_tax_incl


	Name:	Product Tax Include


	Version:	0.1


	Author:	Smile.fr


	Directory:	product_tax_incl


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Product Tax Include
Allows to compute the based sale untaxed amount given a taxed amount entry (change the list_price on on_change)








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_tax_incl.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_tax_incl.zip]









Dependencies



	product

	account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Product Tax Include (product_tax_include)





	Module:	product_tax_include


	Name:	Product Tax Include


	Version:	5.0.0.0.1


	Author:	SYLEAM Info Services


	Directory:	product_tax_include


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Add new field for tax include in product

 OpenERP version : 5.0
 Creation : 2009-12-05
 Last update : 2009-12-05








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	product

	account_tax_include









Reports

None




Menus

None




Views



	* INHERIT res.company.product.config (form)

	* INHERIT product.tax.include (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Products with multi-level variants configurator (product_variant_configurator)





	Module:	product_variant_configurator


	Name:	Products with multi-level variants configurator


	Version:	5.0.0.5


	Author:	Smile.fr


	Directory:	product_variant_configurator


	Web:	http://www.smile.fr


	Official module:

		no


	Quality certified:

		no






Description

Product Variant Configurator. Assists the product variant selection in the sale order form.
For each product template dimension a dimension value is asked. Then the matching product variants
are proposed for selection.
Should be used along with the product_variant_multi module.
Might not work well in the web-client due to web-client current limitations.

Please notice that the product configurator user interface could me more user friendly
if some OpenObject framework enhancements were implemented, especially:
- allow select box widget to select dimension values instead of many2one popups:
https://blueprints.launchpad.net/openobject-server/+spec/dynamic-domain-on-selection-widget
- automatically select the product variant if unique once dimensions are set:
https://blueprints.launchpad.net/openobject-server/+spec/form-parent-field-update-on-change








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_variant_configurator.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_variant_configurator.zip]









Dependencies



	product_variant_multi

	sale

	sale_product_multistep_configurator









Reports

None




Menus

None




Views



	view_product_variant_configurator (form)

	* INHERIT product_variant_configurator.sale_order_form_view (form)

	* INHERIT product_variant_configurator.sale_order_line_form_view (form)









Objects


Object: sale.order.line.dimension_custom_values (sale.order.line.dimension_custom_values)





	mrp_production_id:

		Production Order, many2one









	sale_order_line_id:

		Sale Order Line, many2one









	custom_value:	Custom Value, char









	dimension_type_id:

		Dimension Type, many2one








Object: product_variant_configurator.line (product_variant_configurator.line)





	dimension_type_id:

		Dimension Type, many2one









	dimension_custom_value:

		Custom Value, char









	allow_custom_value:

		Allow custom values ?, boolean









	dimension_type_value_id:

		Dimension Value, many2one









	configurator_id:

		product_variant_configurator Test, many2one








Object: product_variant_configurator.configurator (product_variant_configurator.configurator)





	product_tmpl_id:

		Product Template, many2one









	dimension_configuration_line_ids:

		Configurator Lines, one2many









	product_variant_id:

		Product Variant, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Products with multi-level variants (product_variant_multi)





	Module:	product_variant_multi


	Name:	Products with multi-level variants


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	product_variant_multi


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

OpenERP is already supporting a product variants at the core level. But
without this module, variants are only mono-axial. OpenERP indeed uses the product.template
as the model object and the product.variant as the instance variant.
Using this module, you can now easily deal with multi-axial variants.
A product.template, now has a set of dimensions (like Color, Size, anything you want).
For each dimension, a product.template has a set of dimension values (like Red, Green
for the Color dimension). For each dimension, you can accept or not custom dimension
values. The sale interface product configurator will take it into account.
Once the product.template is set up, you can use a 'generator' button that will populate
the space of the variants. You could also choose to populate only some combinations
by hand instead.
Each variant can have an extra price that will be taken into account when computing
the base listed price. Yet to be implemented: a price extra per variant dimension value.
Finally, this module is better used along with the product_variant_configurator which
will help the salesman selecting the appropriate variant in the sale order line
using dimension criteria instead of having to crawl the full space of variants.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_variant_multi.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_variant_multi.zip]









Dependencies



	base

	product









Reports

None




Menus



	Products/Products/Product Templates

	Products/Products/Product Variants

	Products/Configuration/Variant Dimensions

	Products/Configuration/Variant Dimensions/Dimension Types

	Products/Configuration/Variant Dimensions/Dimension Values









Views



	product_variant_multi.variant_value.tree (tree)

	product_variant_multi.variant_value.form (form)

	product_variant_multi.variant_type.tree (tree)

	product_variant_multi.variant_type.form (form)

	* INHERIT product_variant_multi.product.template.form (form)

	* INHERIT product_variant_multi.product.product.form (form)









Objects


Object: Dimension Type (product.variant.dimension.type)





	product_tmpl_id:

		Product Template, many2one, required









	allow_custom_value:

		Allow Custom Value, boolean






If true, custom values can be entered in the product configurator






	name:	Dimension, char









	value_ids:	Dimension Values, one2many









	sequence:	Sequence, integer






The product ‘variants’ code will use this to order the dimension values





Object: Dimension Value (product.variant.dimension.value)





	name:	Dimension Value, char, required









	sequence:	Sequence, integer









	dimension_id:	Dimension Type, many2one, required









	dimension_sequence:

		Related Dimension Sequence, float









	price_extra:	Price Extra, float









	product_tmpl_id:

		Product Template, many2one









	price_margin:	Price Margin, float
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Visible Discount (product_visible_discount)





	Module:	product_visible_discount


	Name:	Visible Discount


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	product_visible_discount


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module lets you calculate discounts on Sale Order lines and Invoice lines base on the partner's pricelist.
    To this end, a new check box named "Visible Discount" is added to the pricelist form.
    Example:
        For the product PC1 and the partner "Asustek": if listprice=450, and the price calculated using Asustek's pricelist is 225
        If the check box is checked, we will have on the sale order line: Unit price=450, Discount=50,00, Net price=225
        If the check box is unchecked, we will have on Sale Order and Invoice lines: Unit price=225, Discount=0,00, Net price=225








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/product_visible_discount.zip]

	trunk [http://www.openerp.com/download/modules/trunk/product_visible_discount.zip]









Dependencies



	base

	product

	account

	sale









Reports

None




Menus

None




Views



	* INHERIT product.pricelist.tree (form)

	* INHERIT product.pricelist.form (form)









Objects

None
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produit_pharmaceutique (produit_pharmaceutique)





	Module:	produit_pharmaceutique


	Name:	produit_pharmaceutique


	Version:	1.0


	Author:	Tiny


	Directory:	produit_pharmaceutique


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Produits Pharmaceutique








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/produit_pharmaceutique.zip]

	trunk [http://www.openerp.com/download/modules/trunk/produit_pharmaceutique.zip]









Dependencies



	product

	base









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Indian Accounting Profile (profile_account_india)





	Module:	profile_account_india


	Name:	Indian Accounting Profile


	Version:	5.0.1.0


	Author:	Tiny & Axelor


	Directory:	profile_account_india


	Web:	http://tinyerpindia.com


	Official module:

		no


	Quality certified:

		no






Description

Profile Indian Accounting
    * Chart of Account
    * Payment Receipt methods
    * Accounting Reports
    * Indian Payroll and Loan Management








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/profile_account_india.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_account_india.zip]









Dependencies



	account_base

	account_voucher

	account_voucher_payment

	account_voucher_workflow

	account_invoice_india

	account_reports_india









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Accounting only profile (profile_accounting)





	Module:	profile_accounting


	Name:	Accounting only profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	profile_accounting


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Profile for Accounting








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/profile_accounting.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/profile_accounting.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_accounting.zip]









Dependencies



	account

	report_analytic

	board_account

	account_followup









Reports

None




Menus

None




Views



	Accounting Profile : Install extra modules (form)









Objects


Object: profile.accounting.config.install_modules_wizard (profile.accounting.config.install_modules_wizard)





	account_analytic_analysis:

		Analytic Accounting, boolean









	name:	Name, char









	account_asset:	Asset Management, boolean









	hr_timesheet_invoice:

		Invoice on Analytic Entries, boolean









	account_budget:	Budgets, boolean






Helps you to manage financial and analytic budgets.






	account_analytic_plans:

		Multiple Analytic Plans, boolean









	board_document:	Document Management, boolean






The Document Management System of OpenERP allows you to store, browse, automatically index, search and preview all kind of documents (internal documents, printed reports, calendar system). It opens an FTP access for the users to easily browse association’s document.






	account_payment:

		Suppliers Payment Management, boolean
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







AMPCO profile (profile_ampco)





	Module:	profile_ampco


	Name:	AMPCO profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	profile_ampco


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/profile_ampco.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_ampco.zip]









Dependencies



	product_lot_foundry

	profile_manufacturing

	mrp_jit

	sale_intercompany_auto









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Association profile (profile_association)





	Module:	profile_association


	Name:	Association profile


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	profile_association


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Profile for Associates








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/profile_association.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_association.zip]









Dependencies



	membership

	board_association









Reports

None




Menus

None




Views



	Association Profile : Install extra modules (form)









Objects


Object: profile.association.config.install_modules_wizard (profile.association.config.install_modules_wizard)





	wiki:	Wiki, boolean






An integrated wiki content management system. This is really usefull to manage FAQ, quality manuals, etc.






	hr_expense:	Expenses Tracking, boolean






Tracks the personal expenses process, from the employee expense encoding, to the reimbursement of the employee up to the reinvoicing to the final customer.






	segmentation:	Segmentation, boolean









	project_gtd:	Getting Things Done, boolean






GTD is a methodology to efficiently organise yourself and your tasks. This module fully integrates GTD principle with OpenERP’s project management.






	crm_configuration:

		Partner Relation & Calendars, boolean









	project:	Project Management, boolean









	board_document:	Document Management, boolean






The Document Management System of OpenERP allows you to store, browse, automatically index, search and preview all kind of documents (internal documents, printed reports, calendar system). It opens an FTP access for the users to easily browse association’s document.
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Auction house profile (profile_auction)





	Module:	profile_auction


	Name:	Auction house profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	profile_auction


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Profile for Auction house








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/profile_auction.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_auction.zip]









Dependencies



	auction

	board_auction

	account

	hr_timesheet_sheet









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Business Intelligence profile (profile_bi)





	Module:	profile_bi


	Name:	Business Intelligence profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	profile_bi


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/profile_bi.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_bi.zip]









Dependencies



	olap









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Bookstore Profile (profile_bookstore)





	Module:	profile_bookstore


	Name:	Bookstore Profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	profile_bookstore


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Profile for book store and library management.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/profile_bookstore.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_bookstore.zip]









Dependencies



	library

	bookstore

	point_of_sale

	stock

	delivery

	sale

	purchase

	sale_wo_production

	mrp_jit

	account

	account_tax_include

	sale_tax_include

	mrp

	purchase_approve









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Business Game (profile_business_game)





	Module:	profile_business_game


	Name:	Business Game


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	profile_business_game


	Web:	


	Official module:

		no


	Quality certified:

		yes






Description

This business game will help you to discover OpenERP and it's enterprise management processes.
The game is based on a company called 'GoodSound' selling audio and video hardware and organising sonorisation events.

The game is structured into two phases:
   1. You will discover the OpenERP interface through a complete sale flow: from the quotation to the invoice,
   2. The goal of the next phase is to make some strategic choices in the system to increase company's profitability
      within a few turns of one year each.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/profile_business_game.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_business_game.zip]









Dependencies



	board

	base

	account

	game_scenario

	purchase_approve

	sale

	sale_wo_production

	stock_planning

	crm_configuration

	mrp_jit

	l10n_fr

	account_budget

	sale_forecast

	product_margin









Reports

None




Menus



	Dashboards/Business Game

	Dashboards/Business Game/Business Game Scenario









Views



	bank.loan.wiz (form)

	bank.loan.tree (tree)

	profile.game.phase2.form (form)

	profile.game.phase2.tree (tree)

	Configuration of Business Game (form)

	profile.game.phase1.form (form)

	profile.game.phase1.tree (tree)

	* INHERIT account.budget.inherit (form)









Objects


Object: profile.game.phase1 (profile.game.phase1)





	step1_so_id:	Quotation / Sale Order, many2one, readonly









	state:	State, selection, required, readonly









	step10:	Print Customer Invoice, boolean, readonly









	step7:	Receive Products from Supplier, boolean, readonly









	step6:	Confirm Request for Quotation, boolean, readonly









	step5:	Change Supplier Price, boolean, readonly









	step4:	Print Request for Quotation, boolean, readonly









	step3:	Confirm Sale Order, boolean, readonly









	step2:	Print Customer Quotation, boolean, readonly









	step1:	Create Quotation, boolean, readonly









	step9:	Confirm Draft Invoice, boolean, readonly









	step8:	Deliver Products to Customer, boolean, readonly








Object: Bank Loan (bank.loan)





	reimburse_principle_amt_with_int:

		Reimburse amount [with Interest], float






Reimburse loan amount per month with interest






	name:	Name, char









	months_left:	# of months left, float






Number of months left






	fiscal_year:	Fiscal Year, many2one, required, readonly






Year in which loan is taken






	interest_per_month:

		Interest amount per month, float






Interest amount per month






	rate:	Interest Rate, float, readonly






Interest Rate






	loan_duration:	# of Years, float






Loan duration in years






	reimburse_principle_amt_without_int:

		Reimburse amount[without Interest], float






Reimburse loan amount per month without interest






	loan_amount:	Loan Amount, float






Loan Amount






	total_amount:	Total Amount, float, readonly






Total Amount to be paid





Object: profile.game.phase2 (profile.game.phase2)





	logistic_user_id:

		Name of Logistic Manager, many2one, readonly









	loan_total_reimburse:

		Total to Reimburse, float, readonly






Total loan amount to reimburse






	last_turnover:	Turnover in last year, float, readonly






Turnover in last year






	years:	Number of Turns, selection









	last_total_sale:

		Total Sales in Last Year, float, readonly






Total Sales in Last Year






	margin_forcast:	Margin Forecast, float, readonly






Margin Forecast






	turnover_growth:

		Turnover Growth, float, readonly






Turnover Growth






	cy_traceback:	Traceback [Current Year], text









	sales_user_id:	Name of Sales Manager, many2one, readonly









	products_growth:

		Growth Products, float, readonly






Growth Products






	objectives:	Objectives, selection









	avg_stock_forcast:

		Avg. Stock Forecast, float, readonly






Avg. Stock Forecast






	state:	Number of Players, selection









	current_treasury:

		Current treasury, float, readonly






Balance of all Cash Accounts






	last_total_purchase:

		Total Purchases in Last year, float, readonly






Total Purchases in Last year






	warn_error:	Warnings & Errors, text









	sale_forcast:	Sales Forecast, float, readonly






Sales Forecast






	total_reimburse:

		Total to Reimburse, float, readonly






Total to Reimburse






	difficulty:	Difficulty, selection









	loan_total_reimburse_this_year:

		Total to Reimburse this year, float, readonly






Total loan amount to reimburse this year






	finance_user_id:

		Name of Financial Manager, many2one, readonly









	hr_user_id:	Name of HR Manager, many2one, readonly









	name:	Name, char









	cost_purchase_forcast:

		Costs of Purchases Forecast, float, readonly






Costs of Purchases Forecast






	total_sold_products:

		# of Products Sold, float, readonly






# of Products Sold






	hr_budget:	HR Budget, float, readonly






HR Budget






	total_benefit:	Total Benefits, float, readonly






Total Benefits






	benefits_growth:

		Benefits Growth, float, readonly






Benefits Growth






	ay_traceback:	Traceback [All Years], text








Object: profile.game.config.wizard (profile.game.config.wizard)





	logistic_email:	Email of Logistic Manager, char









	sale_name:	Name of Sales Manager, char, required









	sale_email:	Email of Sales Manager, char









	logistic_name:	Name of Logistic Manager, char, required









	objectives:	Objectives, selection, required









	years:	Number of Turns, selection, required









	difficulty:	Difficulty, selection, required









	state:	Number of Players, selection, required









	hr_email:	Email of Human Resource Manager, char, readonly









	finance_name:	Name of Financial Manager, char, required









	finance_email:	Email of Financial Manager, char









	hr_name:	Name of Human Resource Manager, char, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Profile Chamber of Commerce (profile_cci)





	Module:	profile_cci


	Name:	Profile Chamber of Commerce


	Version:	False


	Author:	Tiny


	Directory:	profile_cci


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/profile_cci.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_cci.zip]









Dependencies



	project_retro_planning

	purchase_tender

	base_module_record

	base_report_creator

	account_analytic_package

	sale_expected_invoice_date

	account_payment

	l10n_be

	account_budget

	account_l10nbe_domiciliation

	hr_holidays

	cci_base_contact

	cci_partner

	cci_crm_profile

	cci_membership

	cci_event

	cci_mission

	cci_account

	cci_sales

	cci_purchase

	cci_translation

	cci_crm

	cci_timesheet









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CRM profile (profile_crm)





	Module:	profile_crm


	Name:	CRM profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	profile_crm


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Profile for CRM








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/profile_crm.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_crm.zip]









Dependencies



	crm_vertical

	board_crm_configuration









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Direct Marketing profile (profile_dm)





	Module:	profile_dm


	Name:	Direct Marketing profile


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	profile_dm


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Profile module for advanced Direct Marketing management








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/profile_dm.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_dm.zip]









Dependencies



	dm_website

	dm_sale

	dm_crm

	report_dm









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Hotel Management profile (profile_hotel)





	Module:	profile_hotel


	Name:	Hotel Management profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	profile_hotel


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Profile module for Hotel Management System








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/profile_hotel.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_hotel.zip]









Dependencies



	hotel









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Manufacturing industry profile (profile_manufacturing)





	Module:	profile_manufacturing


	Name:	Manufacturing industry profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	profile_manufacturing


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Profile for manufacturing industries








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/profile_manufacturing.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/profile_manufacturing.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_manufacturing.zip]









Dependencies



	mrp

	sale

	delivery

	board_manufacturing

	product_margin

	sale_delivery_report









Reports

None




Menus

None




Views



	Manufacturing Profile: Install Extra Modules (form)









Objects


Object: profile.manufacturing.config.install_modules_wizard (profile.manufacturing.config.install_modules_wizard)





	mrp_repair:	Repair, boolean






Allow to manage product repairs. Handle the guarantee limit date and the invoicing of products and services.






	mrp_jit:	Just in Time Scheduling, boolean






The JIT module allows you to not run the scheduler periodically. It’s easier and faster for real time stock computation but, in counter-part, it manages less efficiently priorities in procurements.






	sale_journal:	Manage by Journals, boolean






This module  allows you to manage your sales, invoicing and picking by journals. You can define journals for trucks, salesman, departments, invoicing date delivery period, etc.






	mrp_subproduct:	Mrp Sub Product, boolean






This module allows you to add sub-products in mrp bom.






	sale_margin:	Margins on Sales Order, boolean






Display margins on the sale order form.






	stock_location:	Advanced Locations, boolean






Allows you to manage an advanced logistic with different locations. You can define, by product: default locations, path of locations for different operations, etc. This module is often used for: localisation of products, managing a manufacturing chain, a quality control location, product that you rent, etc.






	warning:	Warning, boolean






Able you to set warnings on products and partners.






	portal:	Portal, boolean






This module allows you to manage a Portal system.






	point_of_sale:	Point of Sale, boolean






This module allows you to manage a point of sale system. It offers a basic form for pos operations. You must also check our frontend point of sale for a perfect interface with touchscreen materials and payment processing hardware.






	sale_crm:	CRM and Calendars, boolean






This installs the customer relationship features like: leads and opportunities tracking, shared calendar, jobs tracking, bug tracker, and so on.






	mrp_operation:	Manufacturing Operations, boolean






This module allows you to not only manage by production order but also by work order/operation. You will be able to plan, analyse the cost, check times, ... on all operations of each manufacturing order






	board_document:	Document Management, boolean






The Document Management System of OpenERP allows you to store, browse, automatically index, search and preview all kind of documents (internal documents, printed reports, calendar system). It opens an FTP access for the users to easily browse association’s document.
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Service company profile (profile_service)





	Module:	profile_service


	Name:	Service company profile


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	profile_service


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Profile for service companies








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/profile_service.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/profile_service.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_service.zip]









Dependencies



	hr

	project

	board_project

	account_analytic_analysis









Reports

None




Menus

None




Views



	Service Profile : Install extra modules (form)









Objects


Object: profile.service.config.install_modules_wizard (profile.service.config.install_modules_wizard)





	wiki:	Wiki, boolean






An integrated wiki content management system. This is really usefull to manage FAQ, quality manuals, etc.






	hr_expense:	Expenses Tracking, boolean






Tracks the personal expenses process, from the employee expense encoding, to the reimbursement of the employee up to the reinvoicing to the final customer.






	project_gtd:	Getting Things Done, boolean






GTD is a methodology to efficiently organise yourself and your tasks. This module fully integrates GTD principle with OpenERP’s project management.






	hr_timesheet_invoice:

		Invoice on Timesheets, boolean






There are different invoicing methods in OpenERP: from sale orders, from shipping, ... Install this module if you plan to invoice your customers based on time spent on projects.






	base_contact:	Advanced Contacts Management, boolean






Allows you to manage partners (enterprises), addresses of partners and contacts of these partners (employee/people). Install this if you plan to manage your relationships with partners and contacts, with contacts having different jobs in different companies.






	project_mrp:	Sales Management, boolean






Manages quotation and sales orders. It allows you to automatically create and invoice tasks on fixes prices from quotations.






	scrum:	Scrum Methodology, boolean






Scrum is an ‘agile development methodology’, mainly used in IT projects. It helps you to manage teams, long term roadmaps, sprints, and so on.






	crm_configuration:

		CRM & Calendars, boolean






This installs the customer relationship features like: leads and opportunities tracking, shared calendar, jobs tracking, bug tracker, and so on.






	project_timesheet:

		Timesheets, boolean






Timesheets allows you to track time and costs spent on different projects, represented by analytic accounts.






	account_budget_crossover:

		Analytic Budgets, boolean






Allows you to manage analytic budgets by journals. This module is used to manage budgets of your projects.






	hr_holidays:	Holidays Management, boolean






Tracks the full holidays management process, from the employee’s request to the global planning.






	portal:	Portal, boolean






This module allows you to manage a Portal system.






	board_document:	Document Management, boolean






The Document Management System of OpenERP allows you to store, browse, automatically index, search and preview all kind of documents (internal documents, printed reports, calendar system). It opens an FTP access for the users to easily browse association’s document.
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Profile Training (profile_training)





	Module:	profile_training


	Name:	Profile Training


	Version:	5.0.0.0.1


	Author:	Tiny SPRL


	Directory:	profile_training


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Profile for the training management.
With this profile the training management will be installed and you can have
the choice to install the exam management and the room management








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/profile_training.zip]

	trunk [http://www.openerp.com/download/modules/trunk/profile_training.zip]









Dependencies



	training

	document_lock









Reports

None




Menus



	Partners/Teams/Contacts By Team









Views



	Training Profile : Install extra modules (form)









Objects


Object: profile.training.config.install_modules_wizard (profile.training.config.install_modules_wizard)





	portal_training:

		Portal Training, boolean









	training_room:	Training Rooms, boolean









	name:	Name, char









	training_exam:	Training Exams, boolean
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Pro-forma invoices and their payments Management (proforma_followup)





	Module:	proforma_followup


	Name:	Pro-forma invoices and their payments Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	proforma_followup


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Once a pro-forma invoice is created, the module sends automatically mail
        and call actions after X days.
        It's the same principle than account_followup but for proforma invoice only.
        Only followups by email, no need to do reports.
        Also, at each steps, we should be able to call several functions.
        (for example, if a pro-forma is cancelled, it will close a delivery order)








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/proforma_followup.zip]

	trunk [http://www.openerp.com/download/modules/trunk/proforma_followup.zip]









Dependencies



	account









Reports

None




Menus



	Financial Management/Configuration/Proforma Followups









Views



	proforma.proforma.line.tree (tree)

	proforma.proforma.line.form (form)

	proforma.proforma.form (form)

	account.proforma.tree (tree)









Objects


Object: proforma.followup_step (proforma.followup_step)





	proforma_line:	Proforma Follow-Up Line, one2many









	state:	Status, selection









	description:	Description, text









	name:	Name, char, required









	company_id:	Company, many2one








Object: PRO-Forma Followup Criteria (proforma.followup.line)





	function:	Function, char









	name:	Name, char, required









	call_function:	Call function?, boolean









	sequence:	Sequence, integer









	args:	Arguments, text









	days:	Days of delay, integer









	email_body:	E-mail Body, text









	send_email:	Send E-mail?, boolean









	cancel_invoice:	Cancel Invoice?, boolean









	model:	Object, char









	followup_id:	Proforma step, many2one, required









	subject:	Subject, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Project Contact Management (project_contact)





	Module:	project_contact


	Name:	Project Contact Management


	Version:	5.0.1.0


	Author:	Syleam


	Directory:	project_contact


	Web:	http://www.syleam.com


	Official module:

		no


	Quality certified:

		yes






Description

Module to managed contact on project when base_contact module is installed.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/project_contact.zip]

	trunk [http://www.openerp.com/download/modules/trunk/project_contact.zip]









Dependencies



	base

	base_contact

	project









Reports

None




Menus

None




Views



	* INHERIT Project Contact Form Inherited (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Project CRM Management - Project and CRM Integration . (project_crm)





	Module:	project_crm


	Name:	Project CRM Management - Project and CRM Integration .


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	project_crm


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Synchronize between Project task and CRM Case.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/project_crm.zip]

	trunk [http://www.openerp.com/download/modules/trunk/project_crm.zip]









Dependencies



	base

	crm

	project

	crm_configuration









Reports

None




Menus

None




Views



	* INHERIT project.task.crm.form (form)

	* INHERIT project.task.crm.tree (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Project Event (project_event)





	Module:	project_event


	Name:	Project Event


	Version:	1.0


	Author:	Tiny


	Directory:	project_event


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allow track events on project and perform particular action in event   - event on create/modify task   - event on document upload




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/project_event.zip]









Dependencies



	base

	project









Reports

None




Menus

None




Views



	* INHERIT project.project (form)

	Project Event Configuration (form)

	Project Event Configuration (tree)

	Project Event Type (form)

	Project Event Type (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Getting Things Done - Time Management Module (project_gtd)





	Module:	project_gtd


	Name:	Getting Things Done - Time Management Module


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	project_gtd


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module implements all concepts defined by the Getting Things Done
methodology. This world-wide used methodology is used for personal
time management improvement.

Getting Things Done (commonly abbreviated as GTD) is an action management
method created by David Allen, and described in a book of the same name.

GTD rests on the principle that a person needs to move tasks out of the mind by
recording them externally. That way, the mind is freed from the job of
remembering everything that needs to be done, and can concentrate on actually
performing those tasks.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/project_gtd.zip]

	trunk [http://www.openerp.com/download/modules/trunk/project_gtd.zip]









Dependencies



	project









Reports

None




Menus



	Project Management/Configuration/Time Management

	Project Management/Configuration/Time Management/Contexts

	Project Management/Configuration/Time Management/Timeboxes

	Project Management/Configuration/Time Management/Timeboxes/My Timeboxes

	Project Management/Time Management

	Project Management/Time Management/My Inbox

	Project Management/Time Management/My Timeboxes

	Project Management/Time Management/My Daily Timebox









Views



	project.gtd.context.tree (tree)

	project.gtd.context.form (form)

	project.gtd.timebox.tree (tree)

	project.gtd.timebox.form (form)

	project.task.gtd.inbox.tree (tree)

	project.gtd.timebox.treelist (tree)

	* INHERIT project.task.form.timebox (form)









Objects


Object: Contexts (project.gtd.context)





	project_default_id:

		Default Project, many2one, required









	name:	Context, char, required









	sequence:	Sequence, integer








Object: project.gtd.timebox (project.gtd.timebox)





	context6_id:	Context 6, many2one









	task1_ids:	Tasks, one2many









	col_effective_hours:

		Effective Hours, boolean









	task3_ids:	Tasks, one2many









	task6_ids:	Tasks, one2many









	task_ids:	Tasks, one2many









	user_id:	User, many2one, required









	context4_id:	Context 4, many2one









	parent_id:	Parent Timebox, many2one









	task2_ids:	Tasks, one2many









	col_project:	Project, boolean









	type:	Type, selection, required









	col_date_start:	Date Start, boolean









	col_priority:	Priority, boolean









	task4_ids:	Tasks, one2many









	child_ids:	Child Timeboxes, one2many









	context2_id:	Context 2, many2one









	task5_ids:	Tasks, one2many









	context3_id:	Context 3, many2one









	name:	Timebox, char, required









	context5_id:	Context 5, many2one









	context1_id:	Context 1, many2one, required









	col_planned_hours:

		Planned Hours, boolean









	col_deadline:	Deadline, boolean
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Getting Things Done - Idea Management Module (project_idea)





	Module:	project_idea


	Name:	Getting Things Done - Idea Management Module


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	project_idea


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module links all ideas to project








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/project_idea.zip]

	trunk [http://www.openerp.com/download/modules/trunk/project_idea.zip]









Dependencies



	project

	idea









Reports

None




Menus

None




Views



	* INHERIT project.project.form1 (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Project Management - MRP and Sale Integration (project_mrp)





	Module:	project_mrp


	Name:	Project Management - MRP and Sale Integration


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	project_mrp


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module is used to automatically create tasks based on different
procurements: sales order, manufacturing order, ...

It is mainly used to invoices services based on tasks automatically
created by sales orders.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/project_mrp.zip]

	trunk [http://www.openerp.com/download/modules/trunk/project_mrp.zip]









Dependencies



	project

	mrp

	sale

	mrp_jit









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Project Retro planning (project_retro_planning)





	Module:	project_retro_planning


	Name:	Project Retro planning


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	project_retro_planning


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

- Stop date of project is change will change all the tasks of that project to same number of days








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/project_retro_planning.zip]

	trunk [http://www.openerp.com/download/modules/trunk/project_retro_planning.zip]









Dependencies



	base

	project









Reports

None




Menus

None




Views

None




Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Project Management (project)





	Module:	project


	Name:	Project Management


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	project


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Project management module that track multi-level projects, tasks,
works done on tasks, eso. It is able to render planning, order tasks, eso.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/project.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/project.zip]

	trunk [http://www.openerp.com/download/modules/trunk/project.zip]









Dependencies



	product

	account

	hr

	process









Reports



	Gantt Representation

	Gantt Representation









Menus



	Project Management/Configuration

	Project Management/Projects/New Project

	Project Management

	Project Management/Tasks

	Project Management/Projects

	Project Management/Projects/All projects

	Project Management/Projects/All projects/Running projects

	Project Management/Configuration/Template of Projects

	Project Management/Projects/My Projects

	Project Management/Projects/My Projects/My Running Projects

	Project Management/Projects/Projects Structure

	Project Management/Tasks/All Tasks

	Project Management/Tasks/My Tasks

	Project Management/Tasks/My Tasks/My Pending Tasks

	Project Management/Tasks/My Tasks/My Current Tasks

	Project Management/Tasks/My Tasks/My Current Tasks/My Tasks in Progress

	Project Management/Tasks/My Tasks/My Current Tasks/My Draft Tasks

	Project Management/Tasks/New Task

	Project Management/Tasks/All Tasks/Tasks in Progress

	Project Management/Tasks/All Tasks/Unassigned Tasks

	Project Management/Configuration/Task Types









Views



	project.project.form (form)

	project.project.list (tree)

	project.project.tree (tree)

	project.task.work.form (form)

	project.task.work.tree (tree)

	project.project.tree (tree)

	Compute Remaining Hours  (form)

	project.task.form (form)

	project.task.tree (tree)

	my.pending.task.tree (tree)

	project.task.calendar (calendar)

	project.task.gantt (gantt)

	project.task.graph (graph)

	project.task.type.form (form)

	project.task.type.tree (tree)

	* INHERIT res.company.task.config (form)









Objects


Object: Project (project.project)





	tasks:	Project tasks, one2many









	date_end:	Expected End, date









	contact_id:	Contact, many2one









	timesheet_id:	Working Time, many2one






Timetable working hours to adjust the gantt diagram report






	manager:	Project Manager, many2one









	child_id:	Subproject, one2many









	planned_hours:	Planned Time, float, readonly






Sum of planned hours of all tasks related to this project.






	partner_id:	Partner, many2one









	warn_footer:	Mail Footer, text






Footer added at the beginning of the email for the warning message sent to the customer when a task is closed.






	warn_manager:	Warn Manager, boolean






If you check this field, the project manager will receive a request each time a task is completed by his team.






	warn_customer:	Warn Partner, boolean






If you check this, the user will have a popup when closing a task that propose a message to send by email to the customer.






	date_start:	Starting Date, date









	priority:	Sequence, integer









	parent_id:	Parent Project, many2one






If you have [?] in the name, it means there are no analytic account linked to project.






	state:	State, selection, required, readonly









	complete_name:	Project Name, char, readonly









	members:	Project Members, many2many






Project’s member. Not used in any computation, just for information purpose.






	effective_hours:

		Time Spent, float, readonly






Sum of spent hours of all tasks related to this project.






	active:	Active, boolean









	name:	Project Name, char, required









	notes:	Notes, text






Internal description of the project.






	warn_header:	Mail Header, text






Header added at the beginning of the email for the warning message sent to the customer when a task is closed.






	total_hours:	Total Time, float, readonly






Sum of total hours of all tasks related to this project.






	category_id:	Analytic Account, many2one






Link this project to an analytic account if you need financial management on projects. It enables you to connect projects with budgets, planning, cost and revenue analysis, timesheets on projects, etc.






	progress_rate:	Progress, float, readonly






Percent of tasks closed according to the total of tasks todo.





Object: Project task type (project.task.type)





	name:	Type, char, required









	description:	Description, text








Object: Tasks (project.task)





	sequence:	Sequence, integer









	effective_hours:

		Hours Spent, float, readonly






Computed using the sum of the task work done.






	planned_hours:	Planned Hours, float, required






Estimated time to do the task, usually set by the project manager when the task is in draft state.






	partner_id:	Partner, many2one









	user_id:	Assigned to, many2one









	date_start:	Starting Date, datetime









	priority:	Importance, selection









	parent_id:	Parent Task, many2one









	state:	Status, selection, required, readonly









	progress:	Progress (%), float, readonly






Computed as: Time Spent / Total Time.






	project_id:	Project, many2one






If you have [?] in the project name, it means there are no analytic account linked to this project.






	type:	Type, many2one









	description:	Description, text









	child_ids:	Delegated Tasks, one2many









	work_ids:	Work done, one2many









	active:	Active, boolean









	delay_hours:	Delay Hours, float, readonly






Computed as: Total Time - Estimated Time. It gives the difference of the time estimated by the project manager and the real time to close the task.






	delegated_user_id:

		Delegated To, many2one









	name:	Task summary, char, required









	date_deadline:	Deadline, datetime









	notes:	Notes, text









	date_close:	Date Closed, datetime, readonly









	total_hours:	Total Hours, float, readonly






Computed as: Time Spent + Remaining Time.






	history:	Task Details, text, readonly









	remaining_hours:

		Remaining Hours, float






Total remaining time, can be re-estimated periodically by the assignee of the task.





Object: Task Work (project.task.work)





	date:	Date, datetime









	hours:	Time Spent, float









	user_id:	Done by, many2one, required









	name:	Work summary, char









	task_id:	Task, many2one, required








Object: config.compute.remaining (config.compute.remaining)





	remaining_hours:

		Remaining Hours, float






Total remaining time, can be re-estimated periodically by the assignee of the task.
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Project Timesheet on Contract (project_timesheet_contract)





	Module:	project_timesheet_contract


	Name:	Project Timesheet on Contract


	Version:	1.1


	Author:	Tiny


	Directory:	project_timesheet_contract


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Project Contract Timesheet is a module that allows user to configure the      cost of the employee working based on either Product price or on Contract price




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/project_timesheet_contract.zip]









Dependencies



	hr_timesheet

	hr_contract

	project









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Project Timesheet (project_timesheet)





	Module:	project_timesheet


	Name:	Project Timesheet


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	project_timesheet


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module lets you transfer the entries under tasks defined for Project Management to
        the Timesheet line entries for particular date and particular user  with the effect of creating, editing and deleting either ways.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/project_timesheet.zip]

	trunk [http://www.openerp.com/download/modules/trunk/project_timesheet.zip]









Dependencies



	base

	project

	hr_timesheet









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Purchase Analytic Distribution Management (purchase_analytic_plans)





	Module:	purchase_analytic_plans


	Name:	Purchase Analytic Distribution Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	purchase_analytic_plans


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

The base module to manage analytic distribution and purchase orders.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/purchase_analytic_plans.zip]

	trunk [http://www.openerp.com/download/modules/trunk/purchase_analytic_plans.zip]









Dependencies



	purchase

	account_analytic_plans









Reports

None




Menus

None




Views



	* INHERIT purchase.order.line.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Approve PO automatically when confirmed. (purchase_approve)





	Module:	purchase_approve


	Name:	Approve PO automatically when confirmed.


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	purchase_approve


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Automatically approve purchase orders when they are confirmed.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/purchase_approve.zip]

	trunk [http://www.openerp.com/download/modules/trunk/purchase_approve.zip]









Dependencies



	purchase









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Confirm all selected purchase order at once (purchase_confirm)





	Module:	purchase_confirm


	Name:	Confirm all selected purchase order at once


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	purchase_confirm


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Add a wizard on PO to confirm a whole list at once.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/purchase_confirm.zip]

	trunk [http://www.openerp.com/download/modules/trunk/purchase_confirm.zip]









Dependencies



	purchase









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Carriers and deliveries For Purchase Order (purchase_delivery)





	Module:	purchase_delivery


	Name:	Carriers and deliveries For Purchase Order


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	purchase_delivery


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Allows adding of delivery methods in purchase order and packings. You can define your own carrier and delivery grids for prices. When creating invoices from pickings, OpenERP is able to add and compute the shipping line.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/purchase_delivery.zip]

	trunk [http://www.openerp.com/download/modules/trunk/purchase_delivery.zip]









Dependencies



	sale

	purchase

	stock

	delivery









Reports

None




Menus

None




Views



	* INHERIT delivery.purcahse.order_withcarrier.form.view (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Purchase Order Lines With Discounts (purchase_discount)





	Module:	purchase_discount


	Name:	Purchase Order Lines With Discounts


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	purchase_discount


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/purchase_discount.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/purchase_discount.zip]

	trunk [http://www.openerp.com/download/modules/trunk/purchase_discount.zip]









Dependencies



	stock

	purchase









Reports

None




Menus

None




Views



	* INHERIT purchase_discount.order.line.form (form)

	* INHERIT purchase_discount.order.line.tree (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Purchase Email - Use to Send email (purchase_email)





	Module:	purchase_email


	Name:	Purchase Email - Use to Send email


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	purchase_email


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	purchase

	smtpclient









Reports

None




Menus

None




Views



	* INHERIT res.partner.address.form.inherit.cust (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Managing sales and deliveries by journal (purchase_journal)





	Module:	purchase_journal


	Name:	Managing sales and deliveries by journal


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	purchase_journal


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/purchase_journal.zip]

	trunk [http://www.openerp.com/download/modules/trunk/purchase_journal.zip]









Dependencies



	stock

	purchase









Reports

None




Menus



	Purchase Management/Configuration

	Purchase Management/Configuration/Purchases Journals

	Purchase Management/Purchases by Journal

	Purchase Management/Purchases by Journal/My Open Journals

	Purchase Management/Purchases by Journal/All Open Journals

	Purchase Management/Reporting

	Purchase Management/Reporting/This Month

	Purchase Management/Reporting/This Month/Purchases by Journal

	Purchase Management/Reporting/All Months

	Purchase Management/Reporting/All Months/Purchases by Journal









Views



	* INHERIT stock.picking.journal.view.form (form)

	* INHERIT stock.picking.purchase.journal.view.tree (tree)

	purchase_journal.purchase.journal.form (form)

	purchase_journal.purchase.journal.tree (tree)

	* INHERIT purchase.order.journal.view.form (form)

	* INHERIT purchase.order.journal.view.tree (tree)

	purchase_journal.purchase.stats.tree (tree)

	purchase_journal.purchase.stats.form (form)









Objects


Object: purchase Journal (purchase_journal.purchase.journal)





	code:	Code, char, required









	user_id:	Responsible, many2one, required









	name:	Journal, char, required









	note:	Note, text









	state:	Creation date, selection, required









	purchase_stats_ids:

		purchase Stats, one2many, readonly









	date:	Journal date, date, required









	date_created:	Creation date, date, required, readonly









	date_validation:

		Validation date, date, readonly








Object: Purchases Orders by Journal (purchase_journal.purchase.stats)





	count:	# of Lines, integer, readonly









	price_total:	Total Price, float, readonly









	name:	Month, date, readonly









	state:	Order State, selection, readonly









	journal_id:	Journal, many2one, readonly









	price_average:	Average Price, float, readonly









	quantity:	Quantities, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Purchase Management - Manual Control of Invoice (purchase_manual)





	Module:	purchase_manual


	Name:	Purchase Management - Manual Control of Invoice


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	purchase_manual


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Module for purchase management, manual control of invoice








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/purchase_manual.zip]









Dependencies



	purchase









Reports

None




Menus



	Purchase Management/Purchase Order Lines

	Purchase Management/Purchase Order Lines/Uninvoiced Purchase Order Lines









Views



	* INHERIT purchase.order.form (form)

	* INHERIT purchase.order.line.form (form)

	* INHERIT purchase.order.line.tree (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Purchase Number (purchase_number)





	Module:	purchase_number


	Name:	Purchase Number


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	purchase_number


	Web:	http://tinyerp.com/module_sale.html


	Official module:

		no


	Quality certified:

		no






Description

Remove the drawback of the purchase numbering,
    and add new feature that will create number on
    confirmation of the purchase order








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/purchase_number.zip]

	trunk [http://www.openerp.com/download/modules/trunk/purchase_number.zip]









Dependencies



	purchase

	account_base

	base_vat









Reports



	Print Purchase Order









Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Purchase Management (purchase)





	Module:	purchase


	Name:	Purchase Management


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	purchase


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Module for purchase management
    Request for quotation, Create Supplier Invoice, Print Order...








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/purchase.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/purchase.zip]

	trunk [http://www.openerp.com/download/modules/trunk/purchase.zip]









Dependencies



	base

	account

	stock

	process









Reports



	Request for Quotation

	Purchase Order









Menus



	Purchase Management

	Purchase Management/Purchase Orders

	Purchase Management/Purchase Orders/Request For Quotations

	Purchase Management/Purchase Orders/Purchase Order Waiting Approval

	Purchase Management/Purchase Orders/Purchase Orders in Progress

	Purchase Management/New Purchase Order









Views



	purchase.order.calendar (calendar)

	purchase.order.graph (graph)

	purchase.order.form (form)

	purchase.order.tree (tree)

	purchase.order.line.form (form)

	purchase.order.line.tree (tree)

	* INHERIT Packing list (form)

	* INHERIT res.partner.purchase.property.form.inherit (form)









Objects


Object: Purchase order (purchase.order)





	origin:	Origin, char






Reference of the document that generated this purchase order request.






	order_line:	Order Lines, one2many









	invoiced_rate:	Invoiced, float, readonly









	partner_address_id:

		Address, many2one, required









	date_order:	Date, date, required






Date on which this document has been created.






	partner_id:	Supplier, many2one, required









	invoiced:	Invoiced & Paid, boolean, readonly









	dest_address_id:

		Destination Address, many2one






Put an address if you want to deliver directly from the supplier to the customer. In this case, it will remove the warehouse link and set the customer location.






	fiscal_position:

		Fiscal Position, many2one









	amount_untaxed:	Untaxed Amount, float, readonly









	location_id:	Destination, many2one, required









	amount_tax:	Taxes, float, readonly









	state:	Order Status, selection, readonly






The state of the purchase order or the quotation request. A quotation is a purchase order in a ‘Draft’ state. Then the order has to be confirmed by the user, the state switch to ‘Confirmed’. Then the supplier must confirm the order to change the state to ‘Approved’. When the purchase order is paid and received, the state becomes ‘Done’. If a cancel action occurs in the invoice or in the reception of goods, the state becomes in exception.






	pricelist_id:	Pricelist, many2one, required






The pricelist sets the currency used for this purchase order. It also computes the supplier price for the selected products/quantities.






	warehouse_id:	Warehouse, many2one









	shipped_rate:	Received, float, readonly









	partner_ref:	Partner Ref., char









	picking_ids:	Picking List, one2many, readonly






This is the list of picking list that have been generated for this purchase






	date_approve:	Date Approved, date, readonly









	amount_total:	Total, float, readonly









	name:	Order Reference, char, required









	invoice_id:	Invoice, many2one, readonly









	notes:	Notes, text









	invoice_method:	Invoicing Control, selection, required






From Order: a draft invoice will be pre-generated based on the purchase order. The accountant will just have to validate this invoice for control.
From Picking: a draft invoice will be pre-generated based on validated receptions.
Manual: no invoice will be pre-generated. The accountant will have to encode manually.






	shipped:	Received, boolean, readonly









	validator:	Validated by, many2one, readonly









	minimum_planned_date:

		Planned Date, datetime






This is computed as the minimum scheduled date of all purchase order lines’ products.





Object: Purchase Order lines (purchase.order.line)





	name:	Description, char, required









	product_uom:	Product UOM, many2one, required









	date_planned:	Scheduled date, datetime, required









	order_id:	Order Ref, many2one, required









	price_unit:	Unit Price, float, required









	price_subtotal:	Subtotal, float, readonly









	move_ids:	Reservation, one2many, readonly









	taxes_id:	Taxes, many2many









	move_dest_id:	Reservation Destination, many2one









	product_qty:	Quantity, float, required









	account_analytic_id:

		Analytic Account, many2one









	notes:	Notes, text









	product_id:	Product, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Purchases with taxes included (purchase_tax_include)





	Module:	purchase_tax_include


	Name:	Purchases with taxes included


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	purchase_tax_include


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows you to use purchase order with prices including or excluding taxes.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/purchase_tax_include.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/purchase_tax_include.zip]

	trunk [http://www.openerp.com/download/modules/trunk/purchase_tax_include.zip]









Dependencies



	purchase

	account_tax_include









Reports

None




Menus

None




Views



	* INHERIT purchase.order.exlcuded.view.form (form)

	* INHERIT purchase.order.line.tree (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Purchase - Purchase Tender (purchase_tender)





	Module:	purchase_tender


	Name:	Purchase - Purchase Tender


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	purchase_tender


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows you to manage your Purchase Tenders. When a purchase order is created, you now have the opportunity to save the related tender.
    This new object will regroup and will allow you to easily keep track and order all your purchase orders.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/purchase_tender.zip]

	trunk [http://www.openerp.com/download/modules/trunk/purchase_tender.zip]









Dependencies



	purchase









Reports

None




Menus



	Purchase Management/Purchase Tenders

	Purchase Management/Purchase Tenders/Purchase Tenders

	Purchase Management/Purchase Tenders/Purchase Tenders/Draft Purchase Tenders

	Purchase Management/Purchase Tenders/Purchase Tenders/Open Purchase Tenders

	Purchase Management/Purchase Tenders/New Purchase Tenders









Views



	* INHERIT purchase.order.tree.inherit (tree)

	* INHERIT purchase.order.form.inherit (form)

	purchase.tender.form (form)

	purchase.tender.tree (tree)









Objects


Object: Purchase Tender (purchase.tender)





	user_id:	Responsible, many2one









	name:	Tender Reference, char, required









	date_end:	Date End, datetime









	date_start:	Date Start, datetime









	state:	State, selection, required









	purchase_ids:	Purchase Orders, one2many









	description:	Description, text
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







TV & Radio Program Grid Module (radiotv)





	Module:	radiotv


	Name:	TV & Radio Program Grid Module


	Version:	5.0.1.1


	Author:	Zikzakmedia


	Directory:	radiotv


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows control of TV & Radio channels, programs, grid of date/time of broadcasting and podcasts

channel <--n---m--> program <--1---n--> broadcast <--1---n--> podcast

Features:
    * Menu entries to see daily and weekly broadcasts
    * The end date/time of each broadcast is automatically calculated
    * The broadcasts can be copied from one range of days to another
    * A cron is provided to copy broadcasts daily
    * Several broadcasting reports are included
    * Several wizards to synchronise the channels, programs and broadcasts to a
      mysql-php web site are included. They can be also synchronized automatically.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/radiotv.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/radiotv.zip]

	trunk [http://www.openerp.com/download/modules/trunk/radiotv.zip]









Dependencies



	base









Reports



	Radio TV broadcast report

	Radio TV broadcast compact report

	Radio TV broadcast declaration report









Menus



	Radio TV/Channels

	Radio TV/Program categories

	Radio TV/Programs

	Radio TV/Programs/Archive programs

	Radio TV/Programs/Published programs

	Radio TV/Programs/Unpublished programs

	Radio TV/Broadcasts

	Radio TV/Broadcasts/Yesterday broadcasts

	Radio TV/Broadcasts/Today broadcasts

	Radio TV/Broadcasts/Tomorrow broadcasts

	Radio TV/Broadcasts/Previous week broadcasts

	Radio TV/Broadcasts/This week broadcasts

	Radio TV/Broadcasts/Next week broadcasts

	Radio TV/Podcasts

	Radio TV/Configuration/Website configuration

	Radio TV/Copy broadcasts from a day to other

	Radio TV/Export channels and programs

	Radio TV/Export broadcasts

	Radio TV/Export podcasts

	Radio TV/Broadcasts compact report

	Radio TV/Broadcasts declaration report









Views



	radiotv.channel.tree (tree)

	radiotv.channel (form)

	radiotv.program.tree (tree)

	radiotv.program (form)

	radiotv.category.tree (tree)

	radiotv.category (form)

	radiotv.broadcast.tree (tree)

	radiotv.broadcast (form)

	radiotv.podcast.tree (tree)

	radiotv.podcast (form)

	radiotv.web.tree (tree)









Objects


Object: radiotv.program (radiotv.program)





	production_year:

		Production year, integer









	description:	Description, text









	classification:	Classification, selection, required









	introduction:	Introduction, text, required









	channel_ids:	Channels, many2many









	approx_duration:

		Approx. duration, integer






Approximate duration in minutes






	production_country_id:

		Production country, many2one









	broadcast_language:

		Broadcast language, char









	original_language:

		Original language, char









	state:	State, selection, required









	production_type:

		Production type, selection, required









	editor:	Editor, char









	team:	Team, text









	category_id:	Category, many2one









	email:	Email, char









	name:	Name, char, required








Object: radiotv.category (radiotv.category)





	program_ids:	Programs, one2many









	name:	Name, char, required









	description:	Description, text








Object: radiotv.broadcast (radiotv.broadcast)





	dt_end:	End, datetime









	description:	Description, text









	url:	URL, text









	dt_start:	Start, datetime, required









	program_id:	Program, many2one, required









	channel_id:	Channel, many2one, required








Object: radiotv.channel (radiotv.channel)





	program_ids:	Programs, many2many









	name:	Name, char, required









	description:	Description, text








Object: radiotv.podcast (radiotv.podcast)





	category:	Category, char









	subtitle:	Subtitle, char









	description:	Description, text









	author:	Author, char









	file_name:	File name, char, required









	explicit:	Explicit, boolean









	duration:	Duration, char









	broadcast_id:	Broadcast, many2one, required









	keywords:	Keywords, char









	pub_date:	Publication, datetime, required, readonly









	block:	Block, boolean









	name:	Name, char, required








Object: RadioTV website configuration (radiotv.web)





	url:	URL, char, required









	active:	Active, boolean









	name:	Name, char, required









	sync:	Synchronize, boolean






The changes in channels, programs and broadcasts are synchronized automatically to the website
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Account Reporting - Reporting (report_account)





	Module:	report_account


	Name:	Account Reporting - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_account


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

A module that adds new reports based on the account module.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_account.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/report_account.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_account.zip]









Dependencies



	account









Reports

None




Menus



	Financial Management/Reporting/Balance by Type of Account









Views



	report.account.receivable.graph (graph)

	report.account.receivable.tree (tree)

	report.account.receivable.form (form)

	report.aged.receivable.graph (graph)

	report.aged.receivable.tree (tree)

	report.invoice.created.tree (tree)









Objects


Object: Receivable accounts (report.account.receivable)





	credit:	Credit, float, readonly









	balance:	Balance, float, readonly









	type:	Account Type, selection, required









	name:	Week of Year, char, readonly









	debit:	Debit, float, readonly








Object: A Temporary table used for Dashboard view (temp.range)





	name:	Range, char








Object: Aged Receivable Till Today (report.aged.receivable)





	balance:	Balance, float, readonly









	name:	Month Range, char, readonly








Object: Report of Invoices Created within Last 15 days (report.invoice.created)





	origin:	Origin, char, readonly









	currency_id:	Currency, many2one, readonly









	date_due:	Due Date, date, readonly









	create_date:	Create Date, datetime, readonly









	name:	Description, char, readonly









	partner_id:	Partner, many2one, readonly









	residual:	Residual, float, readonly









	number:	Invoice Number, char, readonly









	date_invoice:	Date Invoiced, date, readonly









	state:	State, selection, readonly









	amount_untaxed:	Untaxed, float, readonly









	type:	Type, selection, readonly









	amount_total:	Total, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Overdue Payments Control Call Center (report_analisys_due)





	Module:	report_analisys_due


	Name:	Overdue Payments Control Call Center


	Version:	5.0.0.1


	Author:	Netquatro


	Directory:	report_analisys_due


	Web:	http://wiki.openerp.org.ve/


	Official module:

		no


	Quality certified:

		no






Description

Report for payment out of date,
You can see the link to print on Partner Views








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	account









Reports



	Pagos atrasados









Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Analytic Accounts - Reporting (report_analytic2)





	Module:	report_analytic2


	Name:	Analytic Accounts - Reporting


	Version:	5.0.1.0


	Author:	OpenErp


	Directory:	report_analytic2


	Web:	http://www.openerp.com/


	Official module:

		no


	Quality certified:

		no






Description

Reporting for data related to analytic accounts








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/report_analytic2.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_analytic2.zip]









Dependencies



	account

	hr_timesheet

	hr_timesheet_invoice









Reports

None




Menus



	Financial Management/Reporting/Analytic/All Months/Analytic Amount by year

	Financial Management/Reporting/Analytic/All Months/Analytic Amounts by month

	Financial Management/Reporting/Analytic/All Months/Analytic Amounts by product









Views



	Amounts by year (tree)

	Amounts by year (form)

	Amounts by months (tree)

	Amounts by month (form)

	Amounts By products (tree)

	Amounts by products (form)









Objects


Object: Reporting by accounts/ by year (report.analytic.by.year)





	amount:	Amount, float, readonly









	year:	Year, integer, readonly








Object: Reporting by accounts/ by month (report.analytic.by.month)





	amount:	Amount, float, readonly









	year:	Year, integer, readonly









	month:	Month, integer, readonly








Object: Reporting by accounts/ by product (report.analytic.by.product)





	amount:	Amount, float, readonly









	name:	Product Name, char, readonly









	year:	Year, integer, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Analytic lines - Reporting (report_analytic_line)





	Module:	report_analytic_line


	Name:	Analytic lines - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_analytic_line


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

A report on analytic lines, costs by products, months and accounts.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_analytic_line.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/report_analytic_line.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_analytic_line.zip]









Dependencies



	account

	hr_timesheet_invoice









Reports

None




Menus



	Financial Management/Reporting/Analytic/All Months/Analytic Lines to Invoice









Views



	report.account.analytic.line.to.invoice (form)

	report.account.analytic.line.to.invoice (tree)

	report.account.analytic.line.to.invoice.graph (graph)









Objects


Object: Analytic lines to invoice report (report.account.analytic.line.to.invoice)





	account_id:	Analytic account, many2one, readonly









	product_uom_id:	UoM, many2one, readonly









	amount:	Amount, float, readonly









	product_id:	Product, many2one, readonly









	unit_amount:	Units, float, readonly









	sale_price:	Sale price, float, readonly









	name:	Month, date, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Analytic planning - Delegation in the hierarchy (report_analytic_planning_delegate)





	Module:	report_analytic_planning_delegate


	Name:	Analytic planning - Delegation in the hierarchy


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_analytic_planning_delegate


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Planning on analytic accounts, delegation in the hierarchy.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/report_analytic_planning_delegate.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_analytic_planning_delegate.zip]









Dependencies



	report_analytic_planning









Reports

None




Menus

None




Views



	* INHERIT report.account.analytic.planning.form.inherit_assign (form)

	* INHERIT report.account.analytic.planning.form.inherit_delegate (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







report_analytic_planning_long_term (report_analytic_planning_long_term)





	Module:	report_analytic_planning_long_term


	Name:	report_analytic_planning_long_term


	Version:	False


	Author:	Tiny


	Directory:	report_analytic_planning_long_term


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This modules is an improvement of the basic planning module and offers additional functionality for long term planning, such as:
        - planning of the functions that will be needed
        - additional data for planned resources: the start and end dates








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/report_analytic_planning_long_term.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_analytic_planning_long_term.zip]









Dependencies



	report_analytic_planning









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Analytic planning - Reporting (report_analytic_planning)





	Module:	report_analytic_planning


	Name:	Analytic planning - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_analytic_planning


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Planning on analytic accounts.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_analytic_planning.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/report_analytic_planning.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_analytic_planning.zip]









Dependencies



	account

	hr_timesheet_invoice

	project

	report_analytic_line









Reports



	Planning









Menus



	Human Resources/Planning

	Human Resources/Planning/Planning

	Human Resources/Planning/My Planning

	Human Resources/Planning/My Planning/My Current Planning

	Human Resources/Planning/Planning/Current Planning

	Human Resources/Planning/New Planning

	Human Resources/Reporting/Planning

	Human Resources/Reporting/Planning/Planning Statistics

	Human Resources/Reporting/Planning/My Planning Statistics

	Human Resources/Reporting/Planning/Planning Statistics of My Projects









Views



	report.account.analytic.planning.tree (tree)

	report.account.analytic.planning.form (form)

	report.account.analytic.planning.stat.form (form)

	report.account.analytic.planning.stat.tree (tree)

	report.account.analytic.planning.stat.graph (graph)









Objects


Object: Planning (report_account_analytic.planning)





	user_id:	Responsible, many2one, required









	name:	Planning Name, char, required









	date_from:	Start Date, date, required









	line_ids:	Planning lines, one2many









	stat_ids:	Planning analysis, one2many, readonly









	state:	Status, selection, required









	date_to:	End Date, date, required









	stat_account_ids:

		Planning by account, one2many, readonly









	stat_user_ids:	Planning by user, one2many, readonly








Object: Planning Line (report_account_analytic.planning.line)





	user_id:	User, many2one









	account_id:	Analytic account, many2one, required









	planning_id:	Planning, many2one, required









	amount_unit:	Qty UoM, many2one, required









	note:	Note, text









	amount:	Quantity, float, required








Object: Planning account stat (report_account_analytic.planning.stat.account)





	sum_amount_real:

		Timesheet, float, readonly









	account_id:	Analytic Account, many2one, required









	planning_id:	Planning, many2one









	quantity:	Planned, float, required








Object: Planning stat (report_account_analytic.planning.stat)





	user_id:	User, many2one









	account_id:	Account, many2one, required









	planning_id:	Planning, many2one









	sum_amount_real:

		Timesheet, float, readonly









	sum_amount:	Planned hours, float, required









	manager_id:	Manager, many2one









	sum_amount_tasks:

		Tasks, float, readonly








Object: Planning user stat (report_account_analytic.planning.stat.user)





	sum_amount_real:

		Timesheet, float, readonly









	user_id:	User, many2one









	planning_id:	Planning, many2one, required









	quantity:	Planned, float, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Analytic Account Reporting (report_analytic)





	Module:	report_analytic


	Name:	Analytic Account Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_analytic


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

A module that adds new reports based on analytic accounts.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_analytic.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/report_analytic.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_analytic.zip]









Dependencies



	account

	hr_timesheet_invoice









Reports

None




Menus



	Financial Management/Reporting/Analytic/All Months/Expired analytic accounts









Views



	report.analytic.account.close.form (form)

	report.analytic.account.close.tree (tree)

	report.analytic.account.close.graph (graph)









Objects


Object: Analytic account to close (report.analytic.account.close)





	name:	Analytic account, many2one, readonly









	date_deadline:	Deadline, date, readonly









	quantity_max:	Max. Quantity, float, readonly









	state:	State, char, readonly









	balance:	Balance, float, readonly









	partner_id:	Partner, many2one, readonly









	quantity:	Quantity, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Auction Management - Reporting (report_auction)





	Module:	report_auction


	Name:	Auction Management - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_auction


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

A module that adds new reports based on Auction.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/report_auction.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_auction.zip]









Dependencies



	auction

	hr_timesheet_sheet









Reports

None




Menus



	Auction Management/Reporting/Manager

	Auction Management/Reporting/Manager/Auction Adjudication

	Auction Management/Reporting/Member

	Auction Management/Reporting/Member/Auction Adjudication

	Auction Management/Reporting/Member/Auction Adjudication

	Auction Management/Reporting/Manager/Customer Per Seller

	Auction Management/Reporting/Member/My Latest 10 Deposit

	Auction Management/Reporting/Member/My Latest 10 Objects

	Auction Management/Reporting/Member/Object Per Day

	Auction Management/Reporting/Manager/Object Per Day

	Auction Management/Reporting/Member/This Month

	Auction Management/Reporting/Member/This Month/Estimation

	Auction Management/Reporting/Member/This Month/Estimation/Adjudication

	Auction Management/Reporting/Manager/This Month

	Auction Management/Reporting/Manager/This Month/Estimation

	Auction Management/Reporting/Manager/This Month/Estimation/Adjudication

	Auction Management/Reporting/Member/Summary of Sign_in Sign_out

	Auction Management/Reporting/Manager/Summary of Sign_in Sign_out









Views



	Auction adjudication (tree)

	Auction adjudication (form)

	report.auction.adjudication.graph1 (graph)

	report.per.seller.customer.tree (tree)

	Seller/customer (form)

	report.per.seller.customer.graph (graph)

	Latest deposit  (form)

	Latest deposit (tree)

	report.latest.objects.tree (tree)

	Latest objects (form)

	Object date (tree)

	Object date (form)

	report.auction.object.date.graph1 (graph)

	report.auction.estimation.adj.category.tree1 (tree)

	report.auction.estimation.adj.category.graph1 (graph)

	report.auction.user.pointing.tree (tree)

	report.auction.user.pointing.graph (graph)









Objects


Object: report_auction_adjudication (report.auction.adjudication1)





	name:	Auction date, char, required









	adj_total:	Total Adjudication, float









	auction1:	First Auction Day, date, required









	buyer_costs:	Buyer Costs, many2many









	auction2:	Last Auction Day, date, required









	seller_costs:	Seller Costs, many2many








Object: Customer per seller (report.per.seller.customer)





	partner_id:	Partner, many2one









	no_of_buyer:	Buyer, integer









	name:	Seller, char, required








Object: Latest 10 Deposits (report.latest.deposit)





	info:	Description, char









	specific_cost_ids:

		Specific Costs, one2many









	user_id:	User, many2one









	name:	Depositer Inventory, char, required









	date_dep:	Deposit date, date, required









	total_neg:	Allow Negative Amount, boolean









	lot_id:	Objects, one2many









	partner_id:	Seller, many2one, required









	method:	Withdrawned method, selection, required









	tax_id:	Expenses, many2one








Object: Latest 10 Objects (report.latest.objects)





	user_id:	User, many2one









	obj_num:	Catalog Number, integer









	obj_comm:	Commission, boolean









	obj_price:	Adjudication price, float









	bord_vnd_id:	Depositer Inventory, many2one, required









	obj_ret:	Price retired, float









	auction_id:	Auction Date, many2one









	partner_id:	Seller, many2one, required









	obj_desc:	Object Description, text








Object: Objects per day (report.auction.object.date1)





	obj_ret:	Price retired, float









	obj_num:	Catalog Number, integer









	obj_comm:	Commission, boolean









	obj_price:	Adjudication price, float









	bord_vnd_id:	Depositer Inventory, many2one, required









	lot_type:	Object Type, selection









	state:	State, selection, required









	auction_id:	Auction Date, many2one









	lot_num:	Quantity, integer, required









	date:	Name, char, required









	obj_desc:	Object Description, text









	name:	Short Description, char, required








Object: comparison estimate/adjudication  (report.auction.estimation.adj.category1)





	obj_ret:	Price retired, float









	name:	Short Description, char, required









	obj_comm:	Commission, boolean









	obj_price:	Adjudication price, float









	obj_desc:	Object Description, text









	lot_type:	Object Type, selection









	adj_total:	Total Adjudication, float









	state:	State, selection, required









	auction_id:	Auction Date, many2one









	lot_num:	Quantity, integer, required









	date:	Name, char, required









	lot_est1:	Minimum Estimation, float









	lot_est2:	Maximum Estimation, float









	bord_vnd_id:	Depositer Inventory, many2one, required









	obj_num:	Catalog Number, integer








Object: user pointing  (report.auction.user.pointing1)





	total_timesheet:

		Project Timesheet, float









	sheet_id:	Sheet, many2one









	user_id:	User, char, required









	name:	Date, date
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CRM Management - Reporting (report_crm)





	Module:	report_crm


	Name:	CRM Management - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_crm


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

A module that adds new reports based on CRM cases.
    Case By section, Case By category








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_crm.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/report_crm.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_crm.zip]









Dependencies



	crm









Reports

None




Menus



	CRM & SRM/Reporting

	CRM & SRM/Reporting/This Month

	CRM & SRM/Reporting/This Month/Cases by user and section (this month)

	CRM & SRM/Reporting/All Months

	CRM & SRM/Reporting/All Months/Cases by User and Section

	CRM & SRM/Reporting/This Month/My cases by section (this month)

	CRM & SRM/Reporting/All Months/My cases by section

	CRM & SRM/Reporting/This Month/Cases by categories and section (this month)

	CRM & SRM/Reporting/All Months/Cases by Categories and Section









Views



	report.crm.case.user.tree (tree)

	report.crm.case.user.form (form)

	report.crm.case.user.graph (graph)

	report.crm.case.categ.tree (tree)

	report.crm.case.categ.form (form)

	report.crm.case.section.tree (tree)

	report.crm.case.section.graph (graph)

	report.crm.case.service.dashboard.tree (tree)

	report.crm.case.service.dashboard.tree (tree)









Objects


Object: Cases by user and section (report.crm.case.user)





	amount_revenue_prob:

		Est. Rev*Prob., float, readonly









	amount_costs:	Est.Cost, float, readonly









	user_id:	User, many2one, readonly









	name:	Month, date, readonly









	probability:	Avg. Probability, float, readonly









	nbr:	# of Cases, integer, readonly









	section_id:	Section, many2one, readonly









	state:	Status, selection, readonly









	amount_revenue:	Est.Revenue, float, readonly









	delay_close:	Delay to close, char, readonly








Object: Cases by section and category (report.crm.case.categ)





	amount_revenue_prob:

		Est. Rev*Prob., float, readonly









	amount_costs:	Est.Cost, float, readonly









	name:	Month, date, readonly









	probability:	Avg. Probability, float, readonly









	nbr:	# of Cases, integer, readonly









	section_id:	Section, many2one, readonly









	state:	Status, selection, readonly









	amount_revenue:	Est.Revenue, float, readonly









	delay_close:	Delay Close, char, readonly









	categ_id:	Category, many2one, readonly








Object: Cases by Section (report.crm.case.section)





	nbr_cases:	# of Cases, integer, readonly









	delay_close:	Delay to close, char, readonly









	section_id:	Section, many2one, readonly









	perc_cancel:	%Cancel, float, readonly









	avg_answers:	Avg. Answers, integer, readonly









	perc_done:	%Done, float, readonly









	name:	Month, date, readonly








Object: Report of Closed and Open CRM Cases within past 15 days (report.crm.case.service.dashboard)





	date_closed:	Date Closed, datetime, readonly









	create_date:	Create Date, datetime, readonly









	name:	Description, char, readonly









	date_deadline:	Deadline, datetime, readonly









	planned_revenue:

		Planned Revenue, float, readonly









	planned_cost:	Planned Costs, float, readonly









	priority:	Priority, char, readonly









	state:	Status, selection, readonly









	date:	Date, datetime, readonly









	user_id:	Responsible, many2one, readonly









	partner_id:	Partner, many2one, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Direct Marketing - Reporting (report_dm_advanced)





	Module:	report_dm_advanced


	Name:	Direct Marketing - Reporting


	Version:	1.0


	Author:	Tiny


	Directory:	report_dm_advanced


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


This module allows to see statistic of marketing





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/report_dm_advanced.zip]









Dependencies



	dm

	dm_sale

	report_dm









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Direct Marketing - Reporting (report_dm)





	Module:	report_dm


	Name:	Direct Marketing - Reporting


	Version:	1.0


	Author:	Tiny


	Directory:	report_dm


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


This module allows to see statistic of marketing





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/report_dm.zip]









Dependencies



	dm

	dm_sale









Reports

None




Menus

None




Views



	report.dm.sale.per.month.form (form)

	report.dm.sale.per.month.tree (tree)

	report.dm.sale.per.month.form (graph)

	report.dm.sale.per.day.form (form)

	report.dm.sale.per.day.tree (tree)

	report.dm.sale.per.day.form (graph)

	report.dm.sale.offer.step.per.month.form (form)

	report.dm.sale.offer.step.per.month.tree (tree)

	report.dm.sale.offer.step.per.month.form (graph)

	report.dm.sale.offer.step.per.day.form (form)

	report.dm.sale.offer.step.per.day.tree (tree)

	report.dm.sale.per.offer.step.day.form (graph)

	report.dm.sale.segment.per.month.form (form)

	report.dm.sale.segment.per.month.tree (tree)

	report.dm.sale.segment.per.month.form (graph)

	report.dm.sale.segment.per.day.form (form)

	report.dm.sale.segment.per.day.tree (tree)

	report.dm.sale.segment.per.day.form (graph)









Objects



	report.dm.sale.per.month

	report.dm.sale.per.day

	report.dm.sale.offer.step.per.month

	report.dm.sale.offer.step.per.day

	report.dm.sale.segment.per.month

	report.dm.sale.segment.per.day
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Document Management - Reporting (report_document)





	Module:	report_document


	Name:	Document Management - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_document


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Reporting for the Document Management module:
    * My Files
    * All users Files








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/report_document.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_document.zip]









Dependencies



	document









Reports

None




Menus



	Document Management

	Document Management/Reporting

	Document Management/Reporting/This Month

	Document Management/Reporting/This Month/My files

	Document Management/Reporting/All Months

	Document Management/Reporting/All Months/My files

	Document Management/Reporting/This Month/All Users files

	Document Management/Reporting/All Months/All Users files

	Document Management/Reporting/Wall of Shame









Views



	report.document.user.form (form)

	report.document.user.tree (tree)

	report.document.wall.form (form)

	report.document.wall.tree (tree)

	report.document.resource.graph (graph)

	report.document.user.graph (graph)

	report.document.user.tree (tree)

	report.file.month.graph (graph)

	report.file.month.tree (tree)

	report.document.user.graph (graph)

	view.files.partner.graph (graph)

	view.files.partner.tree (tree)









Objects


Object: Files details by Users (report.document.user)





	partner:	Partner, char, readonly









	file_title:	File Name, char, readonly









	user_id:	Owner, integer, readonly









	name:	Month, date, readonly









	nbr:	# of Files, integer, readonly









	month:	Month, char, readonly









	directory:	Directory, char, readonly









	user:	User, char, readonly









	file_size:	File Size, integer, readonly









	change_date:	Modified Date, datetime, readonly









	create_date:	Date Created, datetime, readonly









	type:	Directory Type, char, readonly








Object: Files details by Partners (report.files.partner)





	file_title:	File Name, char, readonly









	create_date:	Date Created, datetime, readonly









	name:	Month, date, readonly









	nbr:	# of Files, integer, readonly









	change_date:	Modified Date, datetime, readonly









	file_size:	File Size, integer, readonly









	directory:	Directory, char, readonly









	partner:	Partner, char, readonly









	type:	Directory Type, char, readonly








Object: Files details by Directory (report.document.file)





	nbr:	# of Files, integer, readonly









	month:	Month, char, readonly









	file_size:	File Size, integer, readonly








Object: Users that did not inserted documents since one month (report.document.wall)





	user_id:	Owner, many2one, readonly









	name:	Month, date, readonly









	file_name:	Last Posted File Name, char, readonly









	month:	Month, char, readonly









	user:	User, char, readonly









	last:	Last Posted Time, datetime, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Hotel Reservation Management - Reporting (report_hotel_reservation)





	Module:	report_hotel_reservation


	Name:	Hotel Reservation Management - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_hotel_reservation


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module shows the status of room reservation
     * Current status of reserved room
     * List status of room as draft or done state








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/report_hotel_reservation.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_hotel_reservation.zip]









Dependencies



	hotel_reservation









Reports

None




Menus



	Hotel Management/Reports/This Month

	Hotel Management/Reports/This Month/States By Reservation









Views



	report.hotel.reservation.status.tree (tree)

	report.hotel.reservation.status.form (form)

	report.hotel.reservation.status.graph (graph)

	report.hotel.reservation.status.graph (graph)









Objects


Object: Reservation By State (report.hotel.reservation.status)





	nbr:	Reservation, integer, readonly









	state:	State, selection, readonly









	reservation_no:	Reservation No, char, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Restaurant Management - Reporting (report_hotel_restaurant)





	Module:	report_hotel_restaurant


	Name:	Restaurant Management - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_hotel_restaurant


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Module shows the status of restaurant reservation
     * Current status of reserved tables
     * List status of tables as draft or done state








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/report_hotel_restaurant.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_hotel_restaurant.zip]









Dependencies



	hotel_restaurant









Reports

None




Menus



	Hotel Management/Reports/This Month

	Hotel Management/Reports/This Month/States By Restaurant









Views



	report.hotel.restaurant.status.tree (tree)

	report.hotel.restaurant.status.form (form)

	report.hotel.restaurant.status.graph (graph)

	report.hotel.restaurant.status.graph (graph)









Objects


Object: Reservation By State (report.hotel.restaurant.status)





	nbr:	Reservation, integer, readonly









	state:	State, selection, readonly









	reservation_id:	Reservation No, char, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Intrastat Reporting - Reporting (report_intrastat)





	Module:	report_intrastat


	Name:	Intrastat Reporting - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_intrastat


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

A module that adds intrastat reports.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_intrastat.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/report_intrastat.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_intrastat.zip]









Dependencies



	base

	product

	stock

	sale

	purchase









Reports



	Invoice Intrastat









Menus



	Products/Configuration/Intrastat Code

	Stock Management/Reporting/This Month

	Stock Management/Reporting/This Month/Intrastat (this month)

	Stock Management/Reporting/All Months

	Stock Management/Reporting/All Months/Intrastat









Views



	* INHERIT res.country.tree (form)

	* INHERIT res.country.form (form)

	* INHERIT product.normal.form (form)

	report.intrastat.code.tree (tree)

	report.intrastat.code.form (form)

	report.intrastat.view (tree)









Objects


Object: Intrastat code (report.intrastat.code)





	name:	Intrastat Code, char









	description:	Description, char








Object: Intrastat report (report.intrastat)





	code:	Country code, char, readonly









	name:	Period, many2one, readonly









	weight:	Weight, float, readonly









	type:	Type, selection









	value:	Value, float, readonly









	currency_id:	Currency, many2one, readonly









	intrastat_id:	Intrastat code, many2one, readonly









	ref:	Origin, char, readonly









	supply_units:	Supply Units, float, readonly













          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







MRP Management - Reporting (report_mrp)





	Module:	report_mrp


	Name:	MRP Management - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_mrp


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

A module that adds new reports based on MRP cases.
    Workcenter loads, Weekly Stock value variation








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_mrp.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/report_mrp.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_mrp.zip]









Dependencies



	mrp









Reports

None




Menus



	Manufacturing/Reporting

	Manufacturing/Reporting/Workcenter Loads

	Manufacturing/Reporting/Weekly Stock Value Variation









Views



	report.workcenter.load.tree (tree)

	report.workcenter.load.graph (graph)

	report.workcenter.load.form (form)

	report.mrp.inout.tree (tree)

	report.mrp.inout.form (form)

	report.mrp.inout.graph (graph)









Objects


Object: Workcenter Load (report.workcenter.load)





	workcenter_id:	Workcenter, many2one, required









	name:	Week, char, required









	hour:	Nbr of hour, float









	cycle:	Nbr of cycle, float








Object: Stock value variation (report.mrp.inout)





	date:	Week, char, required









	value:	Stock value, float, required













          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sales Management - Reporting (report_project)





	Module:	report_project


	Name:	Sales Management - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_project


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

A module that adds some reports on projects.
    Closed Tasks (By User and By Project), Finished Task (By User and By Project)








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_project.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/report_project.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_project.zip]









Dependencies



	project

	report_task









Reports

None




Menus



	Project Management/Reporting/This Month

	Project Management/Reporting/This Month/Tasks finished by project and user (this month)

	Project Management/Reporting/All Months/Tasks Closed by Project and User

	Project Management/Reporting/This Month/Tasks finished by project (this month)

	Project Management/Reporting/All Months/Tasks Closed by Project









Views



	report.project.task.user.form (form)

	report.project.task.user.tree (tree)

	report.project.task.form (form)

	report.project.task.tree (tree)









Objects


Object: Tasks by user and project (report.project.task.user)





	hours_effective:

		Effective Hours, float, readonly









	user_id:	User, many2one, readonly









	name:	Month, date, readonly









	closing_days:	Avg Closing Delay, char, readonly









	task_closed:	Task Closed, integer, readonly









	project_id:	Project, many2one, readonly









	hours_delay:	Avg. Plan.-Eff., float, readonly









	hours_planned:	Planned Hours, float, readonly








Object: Tasks by project (report.project.task)





	hours_effective:

		Effective Hours, float, readonly









	name:	Month, date, readonly









	closing_days:	Avg Closing Delay, char, readonly









	task_closed:	Task Closed, integer, readonly









	project_id:	Project, many2one, readonly









	hours_delay:	Avg. Plan.-Eff., float, readonly









	hours_planned:	Planned Hours, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Purchase Management - Reporting (report_purchase)





	Module:	report_purchase


	Name:	Purchase Management - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_purchase


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Module to add views like
    Purchase By Product, Purchase By Category of Product, All Months, Current Month.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_purchase.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/report_purchase.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_purchase.zip]









Dependencies



	purchase









Reports

None




Menus



	Purchase Management/Reporting

	Purchase Management/Reporting/This Month

	Purchase Management/Reporting/This Month/Purchases by Products (this month)

	Purchase Management/Reporting/All Months

	Purchase Management/Reporting/All Months/Purchases by Products

	Purchase Management/Reporting/This Month/Purchases by Category of Product (this month)

	Purchase Management/Reporting/All Months/Purchases by Category of Products









Views



	report.purchase.order.product.form (form)

	product.month.graph (graph)

	report.purchase.order.product.tree (tree)

	report.purchase.order.category.form (form)

	product.category.graph (graph)

	report.purchase.order.category.tree (tree)









Objects


Object: Purchases Orders by Products (report.purchase.order.product)





	count:	# of Lines, integer, readonly









	price_total:	Total Price, float, readonly









	name:	Month, date, readonly









	state:	Order State, selection, readonly









	price_average:	Average Price, float, readonly









	product_id:	Product, many2one, readonly









	quantity:	# of Products, float, readonly








Object: Purchases Orders by Categories (report.purchase.order.category)





	count:	# of Lines, integer, readonly









	price_total:	Total Price, float, readonly









	name:	Month, date, readonly









	state:	Order State, selection, readonly









	price_average:	Average Price, float, readonly









	category_id:	Categories, many2one, readonly









	quantity:	# of Products, float, readonly













          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sales Management - Reporting (report_sale)





	Module:	report_sale


	Name:	Sales Management - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_sale


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Reporting for the sale module:
    * Sales order by product (my/this month/all)
    * Sales order by category of product (my/this month/all)

    Some predefined lists:
    * Sales of the month
    * Open quotations
    * Uninvoiced Sales
    * Uninvoiced but shipped Sales








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_sale.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/report_sale.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_sale.zip]









Dependencies



	sale









Reports

None




Menus



	Sales Management/Reporting

	Sales Management/Reporting/This Month

	Sales Management/Reporting/This Month/Sales by Product (this month)

	Sales Management/Reporting/All Months

	Sales Management/Reporting/All Months/Sales by Product

	Sales Management/Reporting/This Month/Sales by Category of Product (this month)

	Sales Management/Reporting/All Months/Sales by Category of Products

	Sales Management/Reporting/This Month/Sales of the Month

	Sales Management/Reporting/All Months/Graphs

	Sales Management/Reporting/All Months/Graphs/Monthly Sales Turnover Over One Year

	Sales Management/Reporting/All Months/Graphs/Daily Sales Turnover Over One Year

	Sales Management/Reporting/All Months/Graphs/Monthly Cumulated Sales Turnover Over One Year









Views



	report.sale.order.product.form (form)

	report.sale.order.product.tree (tree)

	report.sale.order.product.graph (graph)

	report.sale.order.category.form (form)

	report.sale.order.category.tree (tree)

	report.sale.order.category.graph (graph)

	sale.order.graph (graph)

	sale.order.dashboard.graph (graph)

	report.turnover.per.month.tree (tree)

	report.turnover.per.month.graph (graph)

	report.turnover.per.product.tree (tree)

	report.turnover.per.product.graph (graph)

	report.sale.order.created.tree (tree)









Objects


Object: Sales Orders by Products (report.sale.order.product)





	count:	# of Lines, integer, readonly









	price_total:	Total Price, float, readonly









	name:	Month, date, readonly









	state:	Order State, selection, readonly









	price_average:	Average Price, float, readonly









	product_id:	Product, many2one, readonly









	quantity:	# of Products, float, readonly








Object: Sales Orders by Categories (report.sale.order.category)





	count:	# of Lines, integer, readonly









	price_total:	Total Price, float, readonly









	name:	Month, date, readonly









	state:	Order State, selection, readonly









	price_average:	Average Price, float, readonly









	category_id:	Categories, many2one, readonly









	quantity:	# of Products, float, readonly








Object: Turnover Per Month (report.turnover.per.month)





	name:	Month, date, readonly









	turnover:	Total Turnover, float, readonly








Object: Turnover Per Product (report.turnover.per.product)





	product_id:	Product, many2one, readonly









	turnover:	Total Turnover, float, readonly








Object: Report of Created Sale Order (report.sale.order.created)





	create_date:	Create Date, datetime









	name:	Order Reference, char, readonly









	partner_shipping_id:

		Shipping Address, many2one, readonly









	state:	Order State, selection, readonly









	amount_untaxed:	Untaxed Amount, float, readonly









	date_order:	Date Ordered, date, readonly









	partner_id:	Customer, many2one, readonly
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Stock report (report_stock)





	Module:	report_stock


	Name:	Stock report


	Version:	1.0


	Author:	Tiny


	Directory:	report_stock


	Web:	http://tinyerp.com/


	Official module:

		no


	Quality certified:

		no






Description

This module adds new reports based on the stock module.

It create a new menu to get products by production lots within
the different locations:
        Inventory Control/Reporting/Traceability/Stock by production lots








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_stock.zip]









Dependencies



	stock

	product









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Report on tasks by user for projects (report_task)





	Module:	report_task


	Name:	Report on tasks by user for projects


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_task


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Gives statistics on tasks by user on projects to check the pipeline of users.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_task.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/report_task.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_task.zip]









Dependencies



	base

	project

	hr_timesheet_sheet









Reports

None




Menus



	Project Management/Reporting

	Project Management/Reporting/All Months

	Project Management/Reporting/All Months/Tasks by User

	Human Resources/Reporting/Timesheet / Task Hours Per Month









Views



	report.project.task.form (form)

	report.project.task.graph (graph)

	report.project.task.tree (tree)

	report.closed.task.tree (tree)

	report.timesheet.task.user.tree (tree)









Objects


Object: Tasks by user and project (report.task.user.pipeline.open)





	user_id:	User, many2one, readonly









	task_progress:	Task Progress, float, readonly









	task_hrs:	Task Hours, float, readonly









	task_nbr:	Task Number, float, readonly









	company_id:	Company, many2one









	task_state:	Status, selection, readonly








Object: Closed Task Report (report.closed.task)





	planned_hours:	Planned Hours, float, readonly









	user_id:	Assigned to, many2one, readonly









	name:	Task summary, char, readonly









	date_deadline:	Deadline, datetime, readonly









	sequence:	Sequence, integer, readonly









	date_close:	Date Closed, datetime, readonly









	priority:	Importance, selection, readonly









	state:	Status, selection, readonly









	progress:	Progress (%), float, readonly









	project_id:	Project, many2one, readonly









	delay_hours:	Delay Hours, float, readonly









	remaining_hours:

		Remaining Hours, float, readonly








Object: report.timesheet.task.user (report.timesheet.task.user)





	task_hrs:	Task Hours, float, readonly









	user_id:	User, many2one, readonly









	name:	Month, date, readonly









	timesheet_hrs:	Timesheet Hours, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Timesheet - Reporting (report_timesheet)





	Module:	report_timesheet


	Name:	Timesheet - Reporting


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_timesheet


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

Module to add timesheet views like
    All Month, Timesheet By User, Timesheet Of Month, Timesheet By Account








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/report_timesheet.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/report_timesheet.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_timesheet.zip]









Dependencies



	hr_timesheet

	hr_timesheet_invoice









Reports

None




Menus



	Human Resources/Reporting/This Month

	Human Resources/Reporting/This Month/Timesheet by user (this month)

	Human Resources/Reporting/This Month/My Timesheet of the Month

	Human Resources/Reporting/All Months

	Human Resources/Reporting/All Months/Timesheet by User

	Human Resources/Reporting/All Months/Timesheet by Invoice

	Human Resources/Reporting/This Month/My timesheets to invoice

	Human Resources/Reporting/All Months/Daily Timesheet by Account

	Human Resources/Reporting/This Month/My daily timesheets by account

	Human Resources/Reporting/All Months/Timesheet by Account

	Human Resources/Reporting/This Month/My timesheets by account









Views



	report_timesheet.user.graph (graph)

	report_timesheet.timesheet.user.form (form)

	report_timesheet.timesheet.user.tree (tree)

	report_timesheet.account.date.graph (graph)

	report_timesheet.invoice.graph (graph)

	report_timesheet.timesheet.invoice.form (form)

	report_timesheet.timesheet.invoice.tree (tree)

	report_timesheet.account.date.tree (tree)

	report_timesheet.account.date.graph (graph)

	report_timesheet.timesheet.account.date.form (form)

	report_timesheet.account.tree (tree)

	report_timesheet.account.graph (graph)

	report_timesheet.timesheet.account.form (form)

	report.random.timesheet.tree (tree)

	random.timesheet.lines.tree (tree)









Objects


Object: Timesheet per day (report_timesheet.user)





	cost:	Cost, float, readonly









	user_id:	User, many2one, readonly









	name:	Date, date, readonly









	quantity:	Quantity, float, readonly








Object: Timesheet per account (report_timesheet.account)





	quantity:	Quantity, float, readonly









	user_id:	User, many2one, readonly









	name:	Month, date, readonly









	account_id:	Analytic Account, many2one, readonly








Object: Daily timesheet per account (report_timesheet.account.date)





	quantity:	Quantity, float, readonly









	user_id:	User, many2one, readonly









	name:	Date, date, readonly









	account_id:	Analytic Account, many2one, readonly








Object: Costs to invoice (report_timesheet.invoice)





	amount_invoice:	To invoice, float, readonly









	quantity:	Quantity, float, readonly









	user_id:	User, many2one, readonly









	manager_id:	Manager, many2one, readonly









	account_id:	Project, many2one, readonly








Object: Random Timesheet Report (report.random.timesheet)





	analytic_account_id:

		Analytic Account, many2one, readonly









	date:	Date, date, readonly









	user_id:	User, many2one, readonly









	name:	Description, char, readonly









	quantity:	Quantity, float, readonly








Object: Random Timesheet Lines (random.timesheet.lines)





	analytic_account_id:

		Analytic Account, many2one, readonly









	user_id:	User, many2one, readonly









	product_id:	Product, many2one, readonly









	general_account_id:

		General Account, many2one, readonly









	uom_id:	UoM, many2one, readonly









	name:	Description, char, readonly









	to_invoice:	Invoicing, many2one, readonly









	amount:	Amount, float, readonly









	date:	Date, date, readonly









	quantity:	Quantity, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Report for timesheet (report_timesheet_user)





	Module:	report_timesheet_user


	Name:	Report for timesheet


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	report_timesheet_user


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

New report for timesheet








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/report_timesheet_user.zip]

	trunk [http://www.openerp.com/download/modules/trunk/report_timesheet_user.zip]









Dependencies



	hr_timesheet_sheet

	multi_company









Reports

None




Menus



	Project

	Project/Reporting

	Project/Reporting/This Month

	Project/Reporting/This Month/Timesheets by user and company

	Project/Reporting/This Month/Timesheets by user and company/My Timesheets by company

	Project/Reporting/All Months

	Project/Reporting/All Months/Timesheets by user and company

	Project/Reporting/All Months/Timesheets by user and company/My task by company

	Project/Reporting/This Month/Timesheets by company

	Project/Reporting/All Months/Timesheets by company









Views



	view.report.timesheet.user.user.form (form)

	view.report.timesheet.user.user.tree (tree)

	view.report.timesheet.user.form (form)

	view.report.timesheet.user.tree (tree)









Objects


Object: Tasks by user and company (report.timesheet.user.user)





	user_id:	User, many2one, readonly









	name:	Month, date, readonly









	total_cost:	Task Cost, float, readonly









	company_id:	Company Name, many2one, readonly









	total_hours:	Task Hours, float, readonly









	user_company_id:

		User’s Company, many2one, readonly








Object: Tasks by company (report.timesheet.user)





	total_cost:	Task Cost, float, readonly









	total_hours:	Task Hours, float, readonly









	user_company_id:

		User’s Company, many2one, readonly









	name:	Month, date, readonly









	company_id:	Company Name, many2one, readonly
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Res Config (res_config)





	Module:	res_config


	Name:	Res Config


	Version:	1.0


	Author:	Syleam Info Services


	Directory:	res_config


	Web:	http://www.syleam.fr/


	Official module:

		no


	Quality certified:

		no






Description

Add a generic configuration module, with similar concept of INI file








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/res_config.zip]









Dependencies



	base









Reports

None




Menus

None




Views

None




Objects

None
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Roll Management (rollmanagement)





	Module:	rollmanagement


	Name:	Roll Management


	Version:	1.0


	Author:	Sednacom


	Directory:	rollmanagement


	Web:	http://www.sednacom.fr


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/res_config.zip]

	trunk [http://www.openerp.com/download/modules/trunk/res_config.zip]









Dependencies



	base

	stock

	purchase

	sale









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sales: Advertising Sales (sale_advertising)





	Module:	sale_advertising


	Name:	Sales: Advertising Sales


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	sale_advertising


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allow you to use the Sale Management to encode your advertising sales ... TODO








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_advertising.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_advertising.zip]









Dependencies



	sale









Reports

None




Menus



	Sales Management/Advertising

	Sales Management/Advertising/Advertising Issue

	Sales Management/Advertising/Advertising Proof

	Sales Management/Advertising/All Advertising Sale Orders









Views



	* INHERIT sale.order.form.inherit (form)

	* INHERIT sale.order.form.inherit.line (form)

	* INHERIT sale.order.line.form.inherit.line2 (form)

	sale.advertising.issue.form (form)

	sale.advertising.issue.tree (tree)

	sale.advertising.proof.form (form)

	sale.advertising.proof.tree (tree)

	* INHERIT product.product.form.inherit (form)









Objects


Object: Sale Advertising Issue (sale.advertising.issue)





	issue_date:	Issue Date, date, required









	medium:	Medium, many2one, required









	name:	Name, char, required









	default_note:	Default Note, text









	state:	State, selection








Object: Sale Advertising Proof (sale.advertising.proof)





	address_id:	Delivery Address, many2one, required









	target_id:	Target, many2one, required









	name:	Name, char, required









	number:	Number of Copies, integer, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sales Analytic Distribution Management (sale_analytic_plans)





	Module:	sale_analytic_plans


	Name:	Sales Analytic Distribution Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_analytic_plans


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

The base module to manage analytic distribution and sales orders.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_analytic_plans.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_analytic_plans.zip]









Dependencies



	sale

	account_analytic_plans









Reports

None




Menus

None




Views



	* INHERIT sale.order.form.inherit (form)

	* INHERIT sale.order.form.inherit2 (form)

	* INHERIT sale.order.line.form2.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sale Order Line With Categories (sale_category)





	Module:	sale_category


	Name:	Sale Order Line With Categories


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_category


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_category.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_category.zip]









Dependencies



	sale









Reports



	Sales Orders By Categories









Menus

None




Views



	* INHERIT sale_category.sale.order_withtopnotes.form.view (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sale CRM Stuff (sale_crm)





	Module:	sale_crm


	Name:	Sale CRM Stuff


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_crm


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

This module adds a shortcut on one or several cases in the CRM.
This shortcut allows you to generate a sale order based on the selected case.
If different cases are open (a list), it generates one sale order by
case.
The case is then closed and linked to the generated sale order.

It also add a shortcut on one or several partners.
This shortcut allows you to generate a CRM case for the partners.

We suggest you to install this module if you installed both the sale and the
crm_configuration modules.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/sale_crm.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/sale_crm.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_crm.zip]









Dependencies



	sale

	crm_configuration









Reports

None




Menus

None




Views



	* INHERIT CRM - Opportunities - Quote Inherit (form)









Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Print Delivery Order (sale_delivery_report)





	Module:	sale_delivery_report


	Name:	Print Delivery Order


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_delivery_report


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Allows to print a delivery order.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_delivery_report.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_delivery_report.zip]









Dependencies



	sale

	delivery









Reports



	Delivery order









Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sale Delivery Planning (sale_delivery)





	Module:	sale_delivery


	Name:	Sale Delivery Planning


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_delivery


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/sale_delivery.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/sale_delivery.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_delivery.zip]









Dependencies



	sale









Reports

None




Menus

None




Views



	* INHERIT sale.delivery.form.inherit (form)

	* INHERIT sale.delivery.form.inherit (form)

	* INHERIT sale.order.line.form1 (tree)









Objects


Object: sale.delivery.line (sale.delivery.line)





	priority:	Priority, integer









	product_id:	Product, many2one, required









	product_uom:	Product UoM, many2one, required









	date_planned:	Date Planned, datetime, required









	order_id:	Order Ref, many2one, required









	product_qty:	Product Quantity, float, required









	note:	Note, text









	packaging_id:	Packaging, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sale Expected Invoice Date (sale_expected_invoice_date)





	Module:	sale_expected_invoice_date


	Name:	Sale Expected Invoice Date


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	sale_expected_invoice_date


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

* add one field on sale order line








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_expected_invoice_date.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_expected_invoice_date.zip]









Dependencies



	sale









Reports

None




Menus

None




Views



	* INHERIT sale.order.inherit.form (form)

	* INHERIT sale.order.inherit.tree (form)

	* INHERIT sale.order.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sales Forecasts, goals and statistics (sale_forecast)





	Module:	sale_forecast


	Name:	Sales Forecasts, goals and statistics


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_forecast


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allows manager to do their sales forecast.
Different reports are set up for forecast and sales analysis.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_forecast.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_forecast.zip]









Dependencies



	account

	account_invoice_salesman

	crm

	sale









Reports



	Sale Forecast

	Sales Forecast By Salesman









Menus



	Sales Management/Sales Forecasts

	Sales Management/Sales Forecasts/New Sales Forecasts

	Sales Management/Sales Forecasts/My Managing Sales Forecast

	Sales Management/Sales Forecasts/Current Sales Forecast

	Sales Management/Sales Forecasts/Forecast Reports

	Sales Management/Sales Forecasts/Forecast Reports/Number Of Invoice

	Sales Management/Sales Forecasts/Forecast Reports/Amount Invoiced

	Sales Management/Sales Forecasts/Forecast Reports/Cases

	Sales Management/Sales Forecasts/Forecast Reports/Amount Sales

	Sales Management/Sales Forecasts/Forecast Reports/Number of Sales order









Views



	sale_forecast.tree (tree)

	sale_forecast.form (form)

	sale.forecast.line.graph (graph)









Objects


Object: Sales Forecast (sale.forecast)





	user_id:	Responsible, many2one, required









	name:	Sales Forecast, char, required









	date_from:	Start Period, date, required









	line_ids:	Forecast lines, one2many









	note:	Notes, text









	state:	State, selection, required









	date_to:	End Period, date, required









	forecast_rate:	Progress (%), float, readonly








Object: Forecast Line (sale.forecast.line)





	state_cancel:	Cancel, boolean









	computation_type:

		Computation Base On, selection, required









	state_draft:	Draft, boolean









	feedback:	Feedback Comment, text









	user_id:	Salesman, many2one, required









	state_confirmed:

		Confirmed, boolean









	crm_case_categ:	Case Category, many2many









	note:	Note, text









	amount:	Value Forecasted, float









	computed_amount:

		Real Value, float, readonly









	final_evolution:

		Performance, selection









	forecast_rate:	Progress (%), float, readonly









	state_done:	Done, boolean









	product_categ:	Product Category, many2many









	product_product:

		Products, many2many









	crm_case_section:

		Case Section, many2many









	forecast_id:	Forecast, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sale Inter-Company - Fully Automatic (sale_intercompany_auto)





	Module:	sale_intercompany_auto


	Name:	Sale Inter-Company - Fully Automatic


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_intercompany_auto


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module automatically generates inter-company documents, without
    confirmations or validation steps. When a purchase order is confirmed,
    if the partner exist in one of the company <> from the current one, it
    generates a SO.

    Company C1: Sale order -> Purchase Order (MTO)
    Inter-Co : Confirm Purchase Order (C1)
    Inter-Co : Purchase Order (C1) -> Sale Order (C2)
    Inter-Co : Confirm Sale Order (C2)
    Company C2: Continue... picking/production/C3

    It also works in cascade if you installed the mrp_jit module.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_intercompany_auto.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_intercompany_auto.zip]









Dependencies



	sale

	purchase









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sale Inter-Company (sale_intercompany)





	Module:	sale_intercompany


	Name:	Sale Inter-Company


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_intercompany


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds a shortcut on the purchase order to automatically
    create an associated sale order.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_intercompany.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_intercompany.zip]









Dependencies



	sale

	crm

	product

	account









Reports

None




Menus

None




Views

None




Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Managing sales and deliveries by journal (sale_journal)





	Module:	sale_journal


	Name:	Managing sales and deliveries by journal


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_journal


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

The sale journal modules allows you to categorise your
    sales and deliveries (packing lists) between different journals.
    This module is very helpful for bigger companies that
    works by departments.

    You can use journal for different purposes, some examples:
    * isolate sales of different departments
    * journals for deliveries by truck or by UPS

    Journals have a responsible and evolves between different status:
    * draft, open, cancel, done.

    Batch operations can be processed on the different journals to
    confirm all sales at once, to validate or invoice packing, ...

    It also supports batch invoicing methods that can be configured by
    partners and sales orders, examples:
    * daily invoicing,
    * monthly invoicing, ...

    Some statistics by journals are provided.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/sale_journal.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/sale_journal.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_journal.zip]









Dependencies



	stock

	sale









Reports

None




Menus



	Sales Management/Configuration/Invoicing Methods

	Sales Management/Configuration/Sales Journals

	Sales Management/Sales by Journal

	Sales Management/Sales by Journal/My Open Journals

	Sales Management/Sales by Journal/All Open Journals

	Sales Management/Reporting

	Sales Management/Reporting/This Month

	Sales Management/Reporting/This Month/Sales by Journal

	Sales Management/Reporting/All Months

	Sales Management/Reporting/All Months/Sales by Journal

	Stock Management/Configuration/Packing Journals

	Stock Management/Packing by Journal

	Stock Management/Packing by Journal/My Open Journals

	Stock Management/Packing by Journal/All Open Journals

	Stock Management/Outgoing Products/Packing to Invoice

	Stock Management/Outgoing Products/Packing to Invoice/Packing by Invoice Method

	Stock Management/Reporting/Packing Journal

	Stock Management/Reporting/Packing Journal/This Month

	Stock Management/Reporting/Packing Journal/This Month/Packing by Invoice Method

	Stock Management/Reporting/Packing Journal/All Months

	Stock Management/Reporting/Packing Journal/All Months/Packing by Invoice Method

	Stock Management/Reporting/Packing Journal/This Month/Packing by Journal

	Stock Management/Reporting/Packing Journal/All Months/Packing by Journal









Views



	sale_journal.invoice.type.form (form)

	sale_journal.invoice.type.tree (tree)

	sale_journal.sale.journal.form (form)

	sale_journal.sale.journal.tree (tree)

	* INHERIT sale.order.journal.view.form (form)

	* INHERIT sale.order.journal.view.tree (tree)

	* INHERIT stock.picking.journal.view.form (form)

	* INHERIT stock.picking.journal.view.tree (tree)

	* INHERIT stock.picking.journal.view.form (form)

	* INHERIT stock.picking.journal.view.tree (tree)

	* INHERIT stock.picking.journal.view.form (form)

	* INHERIT stock.picking.journal.view.tree (tree)

	* INHERIT stock.picking.journal.view.form (form)

	* INHERIT stock.picking.journal.view.tree (tree)

	sale_journal.sale.stats.tree (tree)

	sale_journal.sale.stats.form (form)

	* INHERIT res.partner.journal.property.form.inherit (form)

	sale_journal.picking.journal.form (form)

	sale_journal.picking.journal.tree (tree)

	sale_journal.invoice.type.stats.form (form)

	sale_journal.invoice.type.stats.tree (tree)

	sale_journal.picking.stats.form (form)

	sale_journal.picking.stats.tree (tree)









Objects


Object: Invoice Types (sale_journal.invoice.type)





	active:	Active, boolean









	note:	Note, text









	invoicing_method:

		Invoicing method, selection, required









	name:	Invoice Type, char, required








Object: Sale Journal (sale_journal.sale.journal)





	code:	Code, char, required









	user_id:	Responsible, many2one, required









	name:	Journal, char, required









	note:	Note, text









	sale_stats_ids:	Sale Stats, one2many, readonly









	state:	State, selection, required









	date:	Journal date, date, required









	date_created:	Creation date, date, required, readonly









	date_validation:

		Validation date, date, readonly








Object: Packing Journal (sale_journal.picking.journal)





	code:	Code, char, required









	user_id:	Responsible, many2one, required









	name:	Journal, char, required









	note:	Note, text









	state:	Creation date, selection, required









	picking_stats_ids:

		Journal Stats, one2many, readonly









	date:	Journal date, date, required









	date_created:	Creation date, date, required, readonly









	date_validation:

		Validation date, date, readonly








Object: Sales Orders by Journal (sale_journal.sale.stats)





	count:	# of Lines, integer, readonly









	price_total:	Total Price, float, readonly









	name:	Month, date, readonly









	state:	Order State, selection, readonly









	journal_id:	Journal, many2one, readonly









	price_average:	Average Price, float, readonly









	quantity:	Quantities, float, readonly








Object: Stats on packing by invoice method (sale_journal.invoice.type.stats)





	count:	# of Lines, integer, readonly









	price_total:	Total Price, float, readonly









	name:	Month, date, readonly









	state:	State, selection, readonly









	invoice_state:	Invoice state, selection, readonly









	price_average:	Average Price, float, readonly









	invoice_type_id:

		Invoicing method, many2one, readonly









	quantity:	Quantities, float, readonly








Object: Packing lists by Journal (sale_journal.picking.stats)





	count:	# of Lines, integer, readonly









	price_total:	Total Price, float, readonly









	name:	Month, date, readonly









	state:	State, selection, readonly









	journal_id:	Journal, many2one, readonly









	price_average:	Average Price, float, readonly









	quantity:	Quantities, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sale Order Layout Improvement (sale_layout)





	Module:	sale_layout


	Name:	Sale Order Layout Improvement


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_layout


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module provides some features to improve the layout of the Sale Order.

    It gives you the possibility to
        * order all the lines of an sale order
        * add titles, comment lines, sub total lines
        * draw horizontal lines and put page breaks








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_layout.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_layout.zip]









Dependencies



	base

	sale









Reports



	Order with Layout









Menus

None




Views



	* INHERIT sale.order.line.form2.inherit_1 (form)

	* INHERIT sale.order.line.tree.inherit_1 (tree)

	* INHERIT sale.order.form.inherit_1 (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Margins in Sale Delivery Lines (sale_margin_delivery)





	Module:	sale_margin_delivery


	Name:	Margins in Sale Delivery Lines


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_margin_delivery


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/sale_margin_delivery.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/sale_margin_delivery.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_margin_delivery.zip]









Dependencies



	sale_delivery









Reports

None




Menus

None




Views



	* INHERIT sale.delivery.form.inherit1 (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Margins in Sale Orders (sale_margin_old)





	Module:	sale_margin_old


	Name:	Margins in Sale Orders


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_margin_old


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	sale

	account









Reports

None




Menus



	Financial Management/Reporting/Invoice

	Financial Management/Reporting/Invoice/This Month

	Financial Management/Reporting/Invoice/This Month/Invoices by Product

	Financial Management/Reporting/Invoice/All Months

	Financial Management/Reporting/Invoice/All Months/Invoices by Product

	Financial Management/Reporting/Invoice/This Month/Invoices by Category

	Financial Management/Reporting/Invoice/All Months/Invoices by Category

	Financial Management/Reporting/Invoice/This Month/Invoices by Partner

	Financial Management/Reporting/Invoice/All Months/Invoices by Partner

	Financial Management/Reporting/Invoice/This Month/Invoices by Partner and Product

	Financial Management/Reporting/Invoice/All Months/Invoices by Partner and Product

	Financial Management/Reporting/Invoice/This Month/Invoices

	Financial Management/Reporting/Invoice/All Months/Invoices









Views



	* INHERIT sale.order.margin.view.form (form)

	* INHERIT sale.order.margin.view.tree (tree)

	* INHERIT sale.order.margin.line.view.tree (tree)

	* INHERIT picking.margin.view.form (form)

	report.account.invoice.product.tree (tree)

	report.account.invoice.category.tree (tree)

	report.account.invoice.partner.tree (tree)

	report.account.invoice.partner.product.tree (tree)

	report.account.invoice (tree)









Objects


Object: report.account.invoice.product (report.account.invoice.product)





	product_id:	Product, many2one, readonly









	margin:	Margin, float, readonly









	state:	State, selection, readonly









	name:	Month, date, readonly









	amount:	Amount, float, readonly









	quantity:	Quantity, float, readonly









	type:	Type, selection, readonly









	cost_price:	Cost Price, float, readonly








Object: report.account.invoice.category (report.account.invoice.category)





	name:	Month, date, readonly









	categ_id:	Categories, many2one, readonly









	state:	State, selection, readonly









	amount:	Amount, float, readonly









	margin:	Margin, float, readonly









	quantity:	Quantity, float, readonly









	type:	Type, selection, readonly









	cost_price:	Cost Price, float, readonly








Object: report.account.invoice.partner (report.account.invoice.partner)





	name:	Month, date, readonly









	partner_id:	Partner, many2one, readonly









	state:	State, selection, readonly









	amount:	Amount, float, readonly









	margin:	Margin, float, readonly









	quantity:	Quantity, float, readonly









	type:	Type, selection, readonly









	cost_price:	Cost Price, float, readonly








Object: report.account.invoice.partner.product (report.account.invoice.partner.product)





	product_id:	Product, many2one, readonly









	quantity:	Quantity, float, readonly









	partner_id:	Partner, many2one, readonly









	state:	State, selection, readonly









	amount:	Amount, float, readonly









	margin:	Margin, float, readonly









	cost_price:	Cost Price, float, readonly









	type:	Type, selection, readonly









	name:	Month, date, readonly








Object: report.account.invoice (report.account.invoice)





	name:	Month, date, readonly









	margin:	Margin, float, readonly









	amount:	Amount, float, readonly









	state:	State, selection, readonly









	quantity:	Quantity, float, readonly









	type:	Type, selection, readonly









	cost_price:	Cost Price, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Margins (amount and percent) in Sale Orders (sale_margin)





	Module:	sale_margin


	Name:	Margins (amount and percent) in Sale Orders


	Version:	5.0.1.0


	Author:	Everlibre & SYLEAM


	Directory:	sale_margin


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/sale_margin.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/sale_margin.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_margin.zip]









Dependencies



	base

	sale

	account









Reports

None




Menus



	Financial Management/Reporting/Invoice

	Financial Management/Reporting/Invoice/This Month

	Financial Management/Reporting/Invoice/This Month/Invoices by Product

	Financial Management/Reporting/Invoice/All Months

	Financial Management/Reporting/Invoice/All Months/Invoices by Product

	Financial Management/Reporting/Invoice/This Month/Invoices by Category

	Financial Management/Reporting/Invoice/All Months/Invoices by Category

	Financial Management/Reporting/Invoice/This Month/Invoices by Partner

	Financial Management/Reporting/Invoice/All Months/Invoices by Partner

	Financial Management/Reporting/Invoice/This Month/Invoices by Partner and Product

	Financial Management/Reporting/Invoice/All Months/Invoices by Partner and Product

	Financial Management/Reporting/Invoice/This Month/Invoices

	Financial Management/Reporting/Invoice/All Months/Invoices









Views



	* INHERIT sale.order.margin.view.form (form)

	* INHERIT sale.order.margin.view.tree (tree)

	* INHERIT sale.order.margin.view.form (form)

	* INHERIT sale.order.margin.view.form2 (form)

	* INHERIT sale.order.margin.view.form3 (form)

	* INHERIT sale.order.margin.view.form4 (form)

	* INHERIT sale.order.margin.line.view.tree (tree)

	* INHERIT picking.margin.view.form (form)

	report.account.invoice.product.tree (tree)

	report.account.invoice.category.tree (tree)

	report.account.invoice.partner.tree (tree)

	report.account.invoice.partner.product.tree (tree)

	report.account.invoice (tree)









Objects


Object: report.account.invoice.product (report.account.invoice.product)





	product_id:	Product, many2one, readonly









	margin:	Margin, float, readonly









	state:	State, selection, readonly









	name:	Month, date, readonly









	amount:	Amount, float, readonly









	quantity:	Quantity, float, readonly









	type:	Type, selection, readonly









	cost_price:	Cost Price, float, readonly








Object: report.account.invoice.category (report.account.invoice.category)





	name:	Month, date, readonly









	categ_id:	Categories, many2one, readonly









	state:	State, selection, readonly









	amount:	Amount, float, readonly









	margin:	Margin, float, readonly









	quantity:	Quantity, float, readonly









	type:	Type, selection, readonly









	cost_price:	Cost Price, float, readonly








Object: report.account.invoice.partner (report.account.invoice.partner)





	name:	Month, date, readonly









	partner_id:	Partner, many2one, readonly









	state:	State, selection, readonly









	amount:	Amount, float, readonly









	margin:	Margin, float, readonly









	quantity:	Quantity, float, readonly









	type:	Type, selection, readonly









	cost_price:	Cost Price, float, readonly








Object: report.account.invoice.partner.product (report.account.invoice.partner.product)





	product_id:	Product, many2one, readonly









	quantity:	Quantity, float, readonly









	partner_id:	Partner, many2one, readonly









	state:	State, selection, readonly









	amount:	Amount, float, readonly









	margin:	Margin, float, readonly









	cost_price:	Cost Price, float, readonly









	type:	Type, selection, readonly









	name:	Month, date, readonly








Object: report.account.invoice (report.account.invoice)





	name:	Month, date, readonly









	margin:	Margin, float, readonly









	amount:	Amount, float, readonly









	state:	State, selection, readonly









	quantity:	Quantity, float, readonly









	type:	Type, selection, readonly









	cost_price:	Cost Price, float, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Confirm Sale Order add Sale Number (sale_numbers)





	Module:	sale_numbers


	Name:	Confirm Sale Order add Sale Number


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_numbers


	Web:	http://tinyerp.com/module_sale.html


	Official module:

		no


	Quality certified:

		no






Description

remove the drawback of the sales numbering,
    and add new feature that will create number on
    confirmation of the sales order








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_numbers.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_numbers.zip]









Dependencies



	sale

	account_base

	base_vat









Reports



	Print Sale Order









Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sale payment type (sale_payment)





	Module:	sale_payment


	Name:	Sale payment type


	Version:	5.0.1.0


	Author:	Zikzakmedia


	Directory:	sale_payment


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Adds payment type and bank account to sale process.

The sale order inherits payment type and bank account (if the payment type is related to bank accounts) from partner as default. Next, the invoice based on this sale order inherits the payment information from it.

Also computes payment type and bank account of invoices created from picking lists (extracted from partner info).

Based on previous work of Readylan (version for 4.2).








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_payment.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_payment.zip]









Dependencies



	account_payment

	account_payment_extension

	sale

	stock









Reports

None




Menus

None




Views



	* INHERIT sale.order.form.sale_paytype (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







MultiStep Product Configurator (sale_product_multistep_configurator)





	Module:	sale_product_multistep_configurator


	Name:	MultiStep Product Configurator


	Version:	5.0.0.5


	Author:	Smile


	Directory:	sale_product_multistep_configurator


	Web:	http://www.smile.fr


	Official module:

		no


	Quality certified:

		no






Description

Generic Multistep configurator








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_product_multistep_configurator.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_product_multistep_configurator.zip]









Dependencies



	sale









Reports

None




Menus



	Products/Configuration/Configurator Steps









Views



	product_multistep_configurator_step_list_view_form (form)

	product_multistep_configurator_step_list_view_tree (tree)

	* INHERIT sale.order.form.configurator.inherit (form)

	* INHERIT sale.order.form.configurator.inherit2 (form)

	* INHERIT sale.order.form.configurator.inherit2 (form)

	* INHERIT sale_order_line_form_configurator2 (form)

	* INHERIT sale_order_line_form_configurator3 (form)









Objects


Object: sale_product_multistep_configurator.configurator.step (sale_product_multistep_configurator.configurator.step)





	model_id:	Object ID, many2one, required









	name:	Value Name, char









	sequence:	Sequence, integer






Determine in which order step are executed
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sales Management extended with rebates (sale_rebate)





	Module:	sale_rebate


	Name:	Sales Management extended with rebates


	Version:	False


	Author:	Tiny


	Directory:	sale_rebate


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_rebate.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_rebate.zip]









Dependencies



	base

	sale









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sales Management (sale)





	Module:	sale


	Name:	Sales Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

The base module to manage quotations and sales orders.

    * Workflow with validation steps:
        - Quotation -> Sale order -> Invoice
    * Invoicing methods:
        - Invoice on order (before or after shipping)
        - Invoice on delivery
        - Invoice on timesheets
        - Advance invoice
    * Partners preferences (shipping, invoicing, incoterm, ...)
    * Products stocks and prices
    * Delivery methods:
        - all at once, multi-parcel
        - delivery costs








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/sale.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/sale.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale.zip]









Dependencies



	product

	stock

	mrp

	process









Reports



	Quotation / Order









Menus



	Sales Management/Configuration

	Sales Management

	Sales Management/Configuration/Shop

	Sales Management/Sales Orders

	Sales Management/Sales Orders/My Sales Order

	Sales Management/Sales Orders/All Sales Order

	Sales Management/Sales Orders/New Quotation

	Sales Management/Sales Orders/All Sales Order/Sales in Exception

	Sales Management/Sales Orders/All Sales Order/Sales Order To Be Invoiced

	Sales Management/Sales Orders/All Sales Order/Sales Order in Progress

	Sales Management/Sales Orders/All Sales Order/All Quotations

	Sales Management/Sales Orders/My Sales Order/My sales in shipping exception

	Sales Management/Sales Orders/My Sales Order/My sales order waiting Invoice

	Sales Management/Sales Orders/My Sales Order/My sales order in progress

	Sales Management/Sales Orders/My Sales Order/My Quotations

	Sales Management/Sales Order Lines

	Sales Management/Sales Order Lines/Uninvoiced Lines

	Sales Management/Sales Order Lines/Uninvoiced Lines/Uninvoiced and Delivered Lines









Views



	sale.shop (form)

	sale.shop (tree)

	sale.order.calendar (calendar)

	sale.order.graph (graph)

	sale.order.tree (tree)

	sale.order.form (form)

	sale.order.line.graph (graph)

	sale.order.line.tree (tree)

	sale.order.line.form2 (form)

	Configure Picking Policy for Sale Order  (form)

	* INHERIT stock.picking.form (form)









Objects


Object: Sale Shop (sale.shop)





	payment_account_id:

		Payment Accounts, many2many









	name:	Shop Name, char, required









	warehouse_id:	Warehouse, many2one









	pricelist_id:	Pricelist, many2one









	project_id:	Analytic Account, many2one









	payment_default_id:

		Default Payment Term, many2one, required








Object: Sale Order (sale.order)





	origin:	Origin, char









	order_line:	Order Lines, one2many, readonly









	picking_policy:	Packing Policy, selection, required






If you don’t have enough stock available to deliver all at once, do you accept partial shipments or not?






	order_policy:	Shipping Policy, selection, required, readonly






The Shipping Policy is used to synchronise invoice and delivery operations.
- The ‘Pay before delivery’ choice will first generate the invoice and then generate the packing order after the payment of this invoice.
- The ‘Shipping & Manual Invoice’ will create the packing order directly and wait for the user to manually click on the ‘Invoice’ button to generate the draft invoice.
- The ‘Invoice on Order After Delivery’ choice will generate the draft invoice based on sale order after all packing lists have been finished.
- The ‘Invoice from the packing’ choice is used to create an invoice during the packing process.






	invoice_ids:	Invoices, many2many






This is the list of invoices that have been generated for this sale order. The same sale order may have been invoiced in several times (by line for example).






	shop_id:	Shop, many2one, required, readonly









	client_order_ref:

		Customer Ref, char









	date_order:	Date Ordered, date, required, readonly









	partner_id:	Customer, many2one, required, readonly









	invoiced:	Paid, boolean, readonly









	amount_tax:	Taxes, float, readonly









	fiscal_position:

		Fiscal Position, many2one









	amount_untaxed:	Untaxed Amount, float, readonly









	payment_term:	Payment Term, many2one









	note:	Notes, text









	state:	Order State, selection, readonly






Gives the state of the quotation or sale order. The exception state is automatically set when a cancel operation occurs in the invoice validation (Invoice Exception) or in the packing list process (Shipping Exception). The ‘Waiting Schedule’ state is set when the invoice is confirmed but waiting for the scheduler to run on the date ‘Date Ordered’.






	invoiced_rate:	Invoiced, float, readonly









	pricelist_id:	Pricelist, many2one, required, readonly









	project_id:	Analytic Account, many2one, readonly









	incoterm:	Incoterm, selection









	partner_order_id:

		Ordering Contact, many2one, required, readonly






The name and address of the contact that requested the order or quotation.






	picked_rate:	Picked, float, readonly









	partner_invoice_id:

		Invoice Address, many2one, required, readonly









	user_id:	Salesman, many2one









	picking_ids:	Related Packing, one2many, readonly






This is the list of picking list that have been generated for this invoice






	amount_total:	Total, float, readonly









	name:	Order Reference, char, required









	partner_shipping_id:

		Shipping Address, many2one, required, readonly









	shipped:	Picked, boolean, readonly









	invoice_quantity:

		Invoice on, selection, required






The sale order will automatically create the invoice proposition (draft invoice). Ordered and delivered quantities may not be the same. You have to choose if you invoice based on ordered or shipped quantities. If the product is a service, shipped quantities means hours spent on the associated tasks.





Object: Sale Order line (sale.order.line)





	property_ids:	Properties, many2many, readonly









	product_uos_qty:

		Quantity (UoS), float, readonly









	product_uom:	Product UoM, many2one, required, readonly









	sequence:	Sequence, integer









	price_unit:	Unit Price, float, required, readonly









	product_uom_qty:

		Quantity (UoM), float, required, readonly









	price_subtotal:	Subtotal, float, readonly









	product_uos:	Product UoS, many2one









	number_packages:

		Number Packages, integer, readonly









	invoiced:	Invoiced, boolean, readonly









	move_ids:	Inventory Moves, one2many, readonly









	delay:	Delivery Lead Time, float, required, readonly






Number of days between the order confirmation and the shipping of the products to the customer






	state:	Status, selection, required, readonly









	order_partner_id:

		Customer, many2one









	product_packaging:

		Packaging, many2one









	tax_id:	Taxes, many2many, readonly









	type:	Procure Method, selection, required, readonly









	procurement_id:	Procurement, many2one









	order_id:	Order Ref, many2one, required, readonly









	discount:	Discount (%), float, readonly









	price_net:	Net Price, float, readonly









	product_id:	Product, many2one









	name:	Description, char, required, readonly









	invoice_lines:	Invoice Lines, many2many, readonly









	notes:	Notes, text









	th_weight:	Weight, float, readonly









	address_allotment_id:

		Allotment Partner, many2one








Object: sale.config.picking_policy (sale.config.picking_policy)





	picking_policy:	Packing Default Policy, selection, required









	order_policy:	Shipping Default Policy, selection, required









	step:	Steps To Deliver a Sale Order, selection, required






By default, OpenERP is able to manage complex routing and paths of products in your warehouse and partner locations. This will configure the most common and simple methods to deliver products to the customer in one or two operations by the worker.






	name:	Name, char
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Very Simplified Point Of Sale (sale_simple_pos)

The module has been renamed to point_of_sale in addons-extra, in launchpad.









	Module:	sale_simple_pos


	Name:	Very Simplified Point Of Sale


	Version:	0.1


	Author:	Smile.fr


	Directory:	sale_simple_pos


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Very Simplified Point Of Sale; if you are not sure about using the official pos module...








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_simple_pos.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_simple_pos.zip]









Dependencies



	sale

	account









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sales Purchase Sequence Management (sales_purchase_seq)





	Module:	sales_purchase_seq


	Name:	Sales Purchase Sequence Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sales_purchase_seq


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Module for avoid holes between sales and purchase orders sequence.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sales_purchase_seq.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sales_purchase_seq.zip]









Dependencies



	sale

	purchase









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sales Server Action (sales_server_action)





	Module:	sales_server_action


	Name:	Sales Server Action


	Version:	5.0.5.0


	Author:	Tiny


	Directory:	sales_server_action


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Server Action for Sales Management
You will get 2 actions, for the demonstration for the Server Action
that will helps you to customize the Business process
* One Invoice / Each Sales Order Line
* Two Invoice for One Sales Order
** Invoice for the Stockable products
** Invoice for the Service product








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sales_server_action.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sales_server_action.zip]









Dependencies



	sale









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Automates direct delivery between a supplier and a customer (sale_supplier_direct_delivery)





	Module:	sale_supplier_direct_delivery


	Name:	Automates direct delivery between a supplier and a customer


	Version:	5.0.0.9


	Author:	Smile.fr for Loyalty Expert


	Directory:	sale_supplier_direct_delivery


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Enable to send goods directly form supplier to customer taking special care of:
- making only one picking from supplier location to customer location and using that picking in the sale_order workflow
- copying the sale order shipping address to the generate purchase order line (so merging purchase orders later on will still work)

Also take note of the following points:
1) We set automatically a Sale Order line to direct delivery if there isn't enough product in the stock.
2) We don't try to split such a line, but we set it entirely to direct delivery even if some products are available
3) In a sale order, some lines can be set to direct while some others are on stock at the same time
4) When we look if there is enough product on virtual stock for a line, we look at the time the sale order is confirmed,
we don't try to anticipate if there will be enough virtual stock is the future if the sale order is planned for later.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_supplier_direct_delivery.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_supplier_direct_delivery.zip]









Dependencies



	base

	product

	sale

	purchase









Reports

None




Menus



	Stock Management/Supplier Direct Delivery









Views



	* INHERIT product.supplierinfo.tree.direct_delivery.inherit (tree)

	* INHERIT product.supplierinfo.form.direct_delivery.inherit (form)

	* INHERIT sale.order.tree.direct_delivery (tree)

	* INHERIT sale.order.line.form.direct_delivery (form)

	* INHERIT sale.order.line.tree.direct_delivery (form)

	* INHERIT purchase.order.tree.direct_delivery (tree)

	* INHERIT purchase.order.line.form.direct_delivery (form)

	* INHERIT purchase.order.line.tree.direct_delivery (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Invoices and prices with taxes included (sale_tax_include)





	Module:	sale_tax_include


	Name:	Invoices and prices with taxes included


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sale_tax_include


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Allow the user to work tax included prices.
Especially useful for b2c businesses.

This module implement the modification on the sale order form.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/sale_tax_include.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/sale_tax_include.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_tax_include.zip]









Dependencies



	sale

	account_tax_include









Reports

None




Menus

None




Views



	* INHERIT sale.order.exlcuded.view.form (form)

	* INHERIT sale.order.exlcuded.view.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sales without prices (sale_wo_prices)





	Module:	sale_wo_prices


	Name:	Sales without prices


	Version:	5.0.1.0


	Author:	Zikzakmedia SL


	Directory:	sale_wo_prices


	Web:	www.zikzakmedia.com


	Official module:

		no


	Quality certified:

		no






Description

Hides prices in sales and product forms. Only sale manager can see them. Normal salesmen can do sales without seeing the product prices.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_wo_prices.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_wo_prices.zip]









Dependencies



	sale

	product









Reports

None




Menus

None




Views



	* INHERIT product.normal.form.wop1 (form)

	* INHERIT product.product.tree.wop1 (tree)

	* INHERIT product.product.tree.wop2 (tree)

	* INHERIT product.product.tree.wop3 (tree)

	* INHERIT sale.order.form.wop1 (form)

	* INHERIT sale.order.form.wop2 (form)

	* INHERIT sale.order.form.wop3 (form)

	* INHERIT sale.order.form.wop4 (form)

	* INHERIT sale.order.form.wop5 (form)

	* INHERIT sale.order.form.wop6 (form)

	* INHERIT sale.order.tree.wop1 (tree)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sales Without production (sale_wo_production)





	Module:	sale_wo_production


	Name:	Sales Without production


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	sale_wo_production


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Provide the scheduler wizard, the procurement and
the exception sub-menu from the mrp menu in the inventory control menu. This allow to hide easily the Mrp menu.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sale_wo_production.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sale_wo_production.zip]









Dependencies



	sale

	mrp









Reports

None




Menus



	Stock Management/









Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Sandwich Module (sandwich)





	Module:	sandwich


	Name:	Sandwich Module


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	sandwich


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sandwich.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sandwich.zip]









Dependencies



	base

	product









Reports



	Sandwichs order









Menus



	Tools

	Tools/Sandwich

	Tools/Sandwich/Configuration

	Tools/Sandwich/Configuration/Type of Product

	Tools/Sandwich/Configuration/Product

	Tools/Sandwich/Order Lines

	Tools/Sandwich/Order Lines/My Order Lines

	Tools/Sandwich/Order Lines/My Order Lines/My Order Lines of the Day

	Tools/Sandwich/Order Lines/Order Lines of the Day

	Tools/Sandwich/Today’s Orders

	Tools/Sandwich/Create Order









Views



	sandwich.product.type (form)

	sandwich.product.type (tree)

	sandwich.product (tree)

	sandwich.product (form)

	sandwich.order.line.tree (tree)

	sandwich.order.line.form (form)

	sandwich.order.tree (tree)

	sandwich.order.form (form)









Objects


Object: sandwich.product.type (sandwich.product.type)





	name:	Name of the type, char, required









	description:	Type’s description, char








Object: sandwich.product (sandwich.product)





	price:	Product price, float









	name:	Product name, char, required









	product_type_id:

		Type of product, many2one








Object: sandwich.order (sandwich.order)





	date:	Order date, date









	note:	Notes, text









	partner:	Partner, many2one, required









	name:	Name, char, required









	order_lines:	Order lines, one2many








Object: sandwich.order.line (sandwich.order.line)





	user_id:	User id, many2one, required









	name:	Description, char, required









	order_id:	Order, many2one









	product_id:	Product, many2one









	date:	Date, date









	quantity:	Quantity, integer, required









	product_type_id:

		Product type, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Scrum, Agile Development Method (scrum)





	Module:	scrum


	Name:	Scrum, Agile Development Method


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	scrum


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This modules implements all concepts defined by the scrum project
    management methodology for IT companies:
    * Project with sprints, product owner, scrum master
    * Sprints with reviews, daily meetings, feedback
    * Product backlog
    * Sprint backlog

    It adds some concepts to the project management module:
    * Mid-term, long-term road-map
    * Customers/functional requests VS technical ones

    It also create a new reporting:
    * Burn-down chart

    The scrum projects and tasks inherits from the real projects and
    tasks, so you can continue working on normal tasks that will also
    include tasks from scrum projects.

    More information on the methodology:
    * http://controlchaos.com








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/scrum.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/scrum.zip]

	trunk [http://www.openerp.com/download/modules/trunk/scrum.zip]









Dependencies



	project

	process









Reports

None




Menus



	Project Management/Scrum

	Project Management/Scrum/Projects

	Project Management/Scrum/Projects/Edit Projects

	Project Management/Scrum/Backlogs

	Project Management/Scrum/Backlogs/Draft Backlogs

	Project Management/Scrum/Backlogs/Opened Backlogs

	Project Management/Scrum/Sprint

	Project Management/Scrum/Sprint/Opened Sprints

	Project Management/Scrum/Sprint/Draft Sprints

	Project Management/Scrum/Sprint/Sprints Done

	Project Management/Scrum/Sprint/My Sprints (Product Owner)

	Project Management/Scrum/Sprint/My Sprints (Scrum Master)

	Project Management/Scrum/Sprint/My Sprints (Product Owner)/My opened sprints (Product Owner)

	Project Management/Scrum/Sprint/My Sprints (Scrum Master)/My opened sprints (Scrum Master)

	Project Management/Scrum/Scrum Meeting

	Project Management/Scrum/All Tasks

	Project Management/Scrum/All Tasks/My tasks

	Project Management/Scrum/All Tasks/My tasks/My opened tasks

	Project Management/Tasks/All Tasks/Opened tasks









Views



	* INHERIT scrum.project.form (form)

	scrum.project.tree (tree)

	scrum.product.backlog.tree (tree)

	scrum.product.backlog.form (form)

	scrum.sprint.tree (tree)

	scrum.sprint.form (form)

	scrum.meeting.tree (tree)

	Scrum Meeting (form)

	* INHERIT scrum.task.form (form)









Objects


Object: Scrum Team (scrum.team)





	users_id:	Users, many2many









	name:	Team Name, char








Object: Scrum Project (scrum.project)





	tasks:	Scrum Tasks, one2many









	date_end:	Expected End, date









	contact_id:	Contact, many2one









	effective_hours:

		Time Spent, float, readonly






Sum of spent hours of all tasks related to this project.






	manager:	Project Manager, many2one









	child_id:	Subproject, one2many









	planned_hours:	Planned Time, float, readonly






Sum of planned hours of all tasks related to this project.






	partner_id:	Partner, many2one









	warn_footer:	Mail Footer, text






Footer added at the beginning of the email for the warning message sent to the customer when a task is closed.






	warn_manager:	Warn Manager, boolean






If you check this field, the project manager will receive a request each time a task is completed by his team.






	warn_customer:	Warn Partner, boolean






If you check this, the user will have a popup when closing a task that propose a message to send by email to the customer.






	date_start:	Starting Date, date









	priority:	Sequence, integer









	parent_id:	Parent project, many2one









	state:	State, selection, required, readonly









	complete_name:	Project Name, char, readonly









	timesheet_id:	Working Time, many2one






Timetable working hours to adjust the gantt diagram report






	scrum:	Is Scrum, integer









	members:	Project Members, many2many






Project’s member. Not used in any computation, just for information purpose.






	active:	Active, boolean









	sprint_size:	Sprint Days, integer









	name:	Project Name, char, required









	notes:	Notes, text






Internal description of the project.






	warn_header:	Mail Header, text






Header added at the beginning of the email for the warning message sent to the customer when a task is closed.






	total_hours:	Total Time, float, readonly






Sum of total hours of all tasks related to this project.






	product_owner_id:

		Product Owner, many2one









	category_id:	Analytic Account, many2one






Link this project to an analytic account if you need financial management on projects. It enables you to connect projects with budgets, planning, cost and revenue analysis, timesheets on projects, etc.






	progress_rate:	Progress, float, readonly






Percent of tasks closed according to the total of tasks todo.





Object: Scrum Sprint (scrum.sprint)





	date_stop:	Ending Date, date, required









	planned_hours:	Planned Hours, float, readonly









	name:	Sprint Name, char, required









	retrospective:	Sprint Retrospective, text









	backlog_ids:	Sprint Backlog, one2many









	review:	Sprint Review, text









	date_start:	Starting Date, date, required









	scrum_master_id:

		Scrum Master, many2one, required









	state:	Status, selection, required









	meetings_id:	Daily Scrum, one2many









	effective_hours:

		Effective hours, float, readonly









	progress:	Progress (0-100), float, readonly









	project_id:	Project, many2one, required









	product_owner_id:

		Product Owner, many2one, required








Object: Product Backlog (scrum.product.backlog)





	priority:	Priority, selection









	planned_hours:	Planned Hours, float, readonly









	user_id:	User, many2one









	name:	Feature, char, required









	tasks_id:	Tasks Details, one2many









	sequence:	Sequence, integer









	note:	Note, text









	effective_hours:

		Effective hours, float, readonly









	state:	Status, selection, required









	sprint_id:	Sprint, many2one









	active:	Active, boolean









	progress:	Progress (0-100), float, readonly









	project_id:	Scrum Project, many2one, required








Object: Scrum Task (scrum.task)





	sequence:	Sequence, integer









	effective_hours:

		Hours Spent, float, readonly






Computed using the sum of the task work done.






	planned_hours:	Planned Hours, float, required






Estimated time to do the task, usually set by the project manager when the task is in draft state.






	partner_id:	Partner, many2one









	user_id:	Assigned to, many2one









	date_start:	Starting Date, datetime









	priority:	Importance, selection









	parent_id:	Parent Task, many2one









	state:	Status, selection, required, readonly









	progress:	Progress (%), float, readonly






Computed as: Time Spent / Total Time.






	project_id:	Project, many2one






If you have [?] in the project name, it means there are no analytic account linked to this project.






	type:	Type, many2one









	description:	Description, text









	scrum:	Is Scrum, integer









	child_ids:	Delegated Tasks, one2many









	work_ids:	Work done, one2many









	active:	Active, boolean









	delay_hours:	Delay Hours, float, readonly






Computed as: Total Time - Estimated Time. It gives the difference of the time estimated by the project manager and the real time to close the task.






	delegated_user_id:

		Delegated To, many2one









	name:	Task summary, char, required









	date_deadline:	Deadline, datetime









	notes:	Notes, text









	date_close:	Date Closed, datetime, readonly









	total_hours:	Total Hours, float, readonly






Computed as: Time Spent + Remaining Time.






	product_backlog_id:

		Product Backlog, many2one









	history:	Task Details, text, readonly









	remaining_hours:

		Remaining Hours, float






Total remaining time, can be re-estimated periodically by the assignee of the task.





Object: Scrum Meeting (scrum.meeting)





	question_blocks:

		Blocks encountered, text









	question_yesterday:

		Tasks since yesterday, text









	name:	Meeting Name, char, required









	question_today:	Tasks for today, text









	question_backlog:

		Backlog Accurate, text









	sprint_id:	Sprint, many2one, required









	date:	Meeting Date, date, required
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Sednacom tools (sednacom_extras)





	Module:	sednacom_extras


	Name:	Sednacom tools


	Version:	1.0


	Author:	Sednacom


	Directory:	sednacom_extras


	Web:	http://www.sednacom.fr


	Official module:

		no


	Quality certified:

		no






Description

New views to improve use of TinyERP:
 * shortcuts view
 * sequence view
 * module view
 * email object
 * Zarafa tools








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/sednacom_extras.zip]

	trunk [http://www.openerp.com/download/modules/trunk/sednacom_extras.zip]









Dependencies



	base

	crm









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Segmentation Management (segmentation)





	Module:	segmentation


	Name:	Segmentation Management


	Version:	False


	Author:	Tiny


	Directory:	segmentation


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module allow users to create profile and compute automatically which partners do fit the profile criteria.

    In this version the new concept of questionnaire allow you to regroup questions into a questionnaire and directly use it on a partner.


NOTICE: This Module is Deprecated. Please install crm_profiling for the latest functionality.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/segmentation.zip]

	trunk [http://www.openerp.com/download/modules/trunk/segmentation.zip]









Dependencies



	base

	crm_profiling









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







SMS Client (smsclient)





	Module:	smsclient


	Name:	SMS Client


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	smsclient


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

SMS Client module that provides:
    Sending SMS
    Use Multiple Gateways








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/smsclient.zip]

	trunk [http://www.openerp.com/download/modules/trunk/smsclient.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Configuration/SMS Gateway

	Administration/Configuration/SMS Gateway/Gateway List

	Administration/Configuration/SMS Gateway/SMS Gateway History

	Administration/Configuration/SMS Gateway/Message Queue









Views



	sms.smsclient.form (form)

	sms.smsclient.history.tree (tree)

	sms.smsclient.history.form (form)

	sms.smsclient.queue.tree (tree)

	sms.smsclient.history.form (form)

	* INHERIT ir.actions.server.form.inherit (form)









Objects


Object: SMS Client (sms.smsclient)





	property_ids:	Parameters, one2many









	history_line:	History, one2many









	code:	Verification Code, char









	name:	Gateway Name, char, required









	url:	Gateway URL, char, required









	body:	Message, text






The message text that will be send along with the email which is send through this server






	users_id:	Users Allowed, many2many









	state:	Gateway Status, selection, readonly









	method:	API Method, selection








Object: SMS Queue (sms.smsclient.queue)





	gateway_id:	SMS Gateway, many2one, readonly









	name:	SMS Request, text, required, readonly









	mobile:	Mobile No, char, required, readonly









	date_create:	Date, datetime, readonly









	state:	Message Status, selection, readonly









	error:	Last Error, text, readonly









	msg:	SMS Text, text, required, readonly








Object: SMS Client Properties (sms.smsclient.parms)





	gateway_id:	SMS Gateway, many2one









	type:	API Method, selection









	name:	Property name, char, required









	value:	Property value, char, required








Object: SMS Client History (sms.smsclient.history)





	gateway_id:	SMS Gateway, many2one, required









	user_id:	Username, many2one, readonly









	name:	Description, char, required, readonly









	sms:	SMS, text, readonly









	date_create:	Date, datetime, readonly









	to:	Mobile No, char, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Email Client (smtpclient)





	Module:	smtpclient


	Name:	Email Client


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	smtpclient


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Email Client module that provides:
    Sending Email
    Use Multiple Server
    Multi Threading
    Multi Attachment








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/smtpclient.zip]

	trunk [http://www.openerp.com/download/modules/trunk/smtpclient.zip]









Dependencies



	base









Reports

None




Menus



	Administration/Configuration/Email Servers

	Administration/Configuration/Email Servers/SMTP Server

	Administration/Configuration/Email Servers/Email Server History

	Administration/Configuration/Email Servers/Message Queue









Views



	* INHERIT ir.actions.server.form.inherit (form)

	report.smtp.server.tree (tree)

	report.smtp.server.form (form)

	* INHERIT smtp.company.form (form)

	email.smtpclient.form (form)

	email.smtpclient.form (tree)

	email.smtpclient.history.tree (tree)

	email.smtpclient.history.form (form)

	email.smtpclient.queue.tree (tree)

	email.smtpclient.queue.form (form)









Objects


Object: Email Client (email.smtpclient)





	body:	Message, text






The message text that will be send along with the email which is send through this server






	history_line:	History, one2many









	code:	Verification Code, char









	name:	Server Name, char, required









	use_debug:	Show debugging information, boolean









	test_email:	Test Message, text









	server:	SMTP Server, char, required, readonly









	from_email:	Email From, char, required, readonly









	date_create:	Date Create, date, required, readonly









	ssl:	Use SSL?, boolean, readonly









	state:	Server Status, selection, readonly









	email:	Email Address, char, required, readonly









	server_statistics:

		Statistics, one2many









	user:	User Name, char, readonly









	active:	Active, boolean









	verify_email:	Verify Message, text, readonly









	password:	Password, char, readonly









	type:	Server Type, selection, required









	port:	SMTP Port, char, required, readonly









	use_auth:	Use Authentication, boolean, readonly









	users_id:	Users Allowed, many2many








Object: Email Client History (email.smtpclient.history)





	server_id:	Smtp Server, many2one, required, readonly









	user_id:	Username, many2one, readonly









	name:	Description, text, required, readonly









	resource_id:	Resource ID, integer, readonly









	date_create:	Date, datetime, readonly









	model:	Model, many2one, readonly









	email:	Email, char, readonly








Object: Email Queue (email.smtpclient.queue)





	body:	Email Text, text, readonly









	server_id:	SMTP Server, many2one, readonly









	serialized_message:

		Message, text, readonly









	name:	Subject, char, readonly









	cc:	CC to, char, readonly









	bcc:	BCC to, char, readonly









	date_create:	Date, datetime, readonly









	to:	Mail to, char, readonly









	state:	Message Status, selection, readonly









	error:	Last Error, text, readonly








Object: Server Statistics (report.smtp.server)





	server_id:	Server ID, many2one, readonly









	no:	Total No., integer, readonly









	name:	Server, char, readonly









	history:	History, char, readonly








Object: res.company.address (res.company.address)





	email:	Email Address, many2one, required









	name:	Address Type, selection, required









	company_id:	Company, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Stock Delivery Packages (stock_delivery_packages)





	Module:	stock_delivery_packages


	Name:	Stock Delivery Packages


	Version:	5.0.0.1


	Author:	NaN


	Directory:	stock_delivery_packages


	Web:	http://www.NaN-tic.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds a new field to outgoing pickings to store the number of packages to be delivered.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	delivery









Reports

None




Menus

None




Views



	* INHERIT picking.out.form.packets (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Invoice Picking Directly (stock_invoice_directly)





	Module:	stock_invoice_directly


	Name:	Invoice Picking Directly


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	stock_invoice_directly


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

When you send or deliver goods, this module automatically launch
        the invoicing wizard if the delivery is to be invoiced.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/stock_invoice_directly.zip]

	trunk [http://www.openerp.com/download/modules/trunk/stock_invoice_directly.zip]









Dependencies



	delivery

	stock









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Stock Location Paths (stock_location_pull)





	Module:	stock_location_pull


	Name:	Stock Location Paths


	Version:	1.0


	Author:	Tiny


	Directory:	stock_location_pull


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description


Manages product’s path in locations.  This module may be useful for different purposes: * Manages the product in his whole manufacturing chain * Manages different default locations by products * Define paths within the warehouse to route products based on operations:    - Quality Control    - After Sales Services    - Supplier Return * Manage products to be rent.





Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/stock_location_pull.zip]









Dependencies



	multi_company_stock









Reports

None




Menus

None




Views



	stock.location.path.tree (tree)

	stock.location.path.form (form)

	Product Pull (form)

	* INHERIT product.product.form (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Stock Location Paths (stock_location)





	Module:	stock_location


	Name:	Stock Location Paths


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	stock_location


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Manages product's path in locations.

This module may be useful for different purposes:
* Manages the product in his whole manufacturing chain
* Manages different default locations by products
* Define paths within the warehouse to route products based on operations:
   - Quality Control
   - After Sales Services
   - Supplier Return
* Manage products to be rent.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/stock_location.zip]

	trunk [http://www.openerp.com/download/modules/trunk/stock_location.zip]









Dependencies



	stock









Reports

None




Menus

None




Views



	stock.location.path.tree (tree)

	stock.location.path.form (form)

	* INHERIT product.product.form (form)









Objects


Object: stock.location.path (stock.location.path)





	location_from_id:

		Source Location, many2one









	product_id:	Products, many2one









	auto:	Automatic Move, selection, required






This is used to define paths the product has to follow within the location tree.
The ‘Automatic Move’ value will create a stock move after the current one that will be validated automatically. With ‘Manual Operation’, the stock move has to be validated by a worker. With ‘Automatic No Step Added’, the location is replaced in the original move.






	delay:	Delay (days), integer






Number of days to do this transition






	location_dest_id:

		Destination Location, many2one









	name:	Operation, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Stock No Auto-Picking (stock_no_autopicking)





	Module:	stock_no_autopicking


	Name:	Stock No Auto-Picking


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	stock_no_autopicking


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

This module allows an intermediate picking process to provide raw materials
    to production orders.

    One example of usage of this module is to manage production made by your
    suppliers (sub-contracting). To achieve this, set the assembled product
    which is sub-contracted to "No Auto-Picking" and put the location of the
    supplier in the routing of the assembly operation.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/stock_no_autopicking.zip]

	trunk [http://www.openerp.com/download/modules/trunk/stock_no_autopicking.zip]









Dependencies



	mrp









Reports

None




Menus

None




Views



	* INHERIT product.normal.auto_pick.form (form)









Objects

None
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Stock periods (stock_period)





	Module:	stock_period


	Name:	Stock periods


	Version:	1.0


	Author:	Sednacom


	Directory:	stock_period


	Web:	http://www.sednacom.fr


	Official module:

		no


	Quality certified:

		no






Description

manage stocks in time period








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/stock_period.zip]

	trunk [http://www.openerp.com/download/modules/trunk/stock_period.zip]









Dependencies



	base

	stock









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Master Procurement Schedule (stock_planning)





	Module:	stock_planning


	Name:	Master Procurement Schedule


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	stock_planning


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module allows you to manage the planning of procurements based on sales
forecasts, confirmed orders (customers and suppliers), stock movements, etc.
You can plan expected outputs and inputs for each warehouses. It also works
to manage all kind of procurements like purchase orders. That's why it is
called Master Procurement Schedule instead of the classic Master Production
Schedule terminology.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/stock_planning.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/stock_planning.zip]

	trunk [http://www.openerp.com/download/modules/trunk/stock_planning.zip]









Dependencies



	stock

	sale









Reports

None




Menus



	Sales Management/Configuration/Create Sales Periods

	Sales Management/Configuration/Stock and Sales Periods

	Stock Management/Procurement Forecast

	Sales Management/Sales Forecasts

	Sales Management/Sales Forecasts/All Sales Forecasts

	Sales Management/Sales Forecasts/All Sales Forecasts/Sales Forecast of Current Period

	Sales Management/Sales Forecasts/My Sales Forecasts

	Sales Management/Sales Forecasts/My Sales Forecasts/My Forecasts of Current Period

	Stock Management/Procurement Forecast/Master Procurement Schedule









Views



	stock.planning.period.form (form)

	stock.period.form (form)

	stock.period.tree (tree)

	stock.planning.sale.prevision.form (form)

	stock.planning.sale.prevision.tree (tree)

	stock.planning.sale.prevision.graph (graph)

	stock.planning.form (form)

	stock.planning.tree (tree)









Objects


Object: stock.planning.period (stock.planning.period)





	date_stop:	End Date, date, required









	date_start:	Start Date, date, required









	name:	Period Name, char









	period_ids:	Periods, one2many








Object: stock.period (stock.period)





	date_stop:	End Date, datetime, required









	date_start:	Start Date, datetime, required









	name:	Period Name, char









	state:	State, selection








Object: stock.planning.sale.prevision (stock.planning.sale.prevision)





	user_id:	Salesman, many2one, readonly









	name:	Name, char









	product_uom:	Product UoM, many2one, required, readonly









	state:	State, selection, readonly









	period_id:	Period, many2one, required









	product_qty:	Product Quantity, float, required, readonly









	product_amt:	Product Amount, float, readonly









	amt_sold:	Real Amount Sold, float, readonly









	product_id:	Product, many2one, required, readonly








Object: stock.planning (stock.planning)





	outgoing:	Confirmed Out, float, readonly









	line_time:	Past/Future, char, readonly









	incoming:	Confirmed In, float, readonly









	product_id:	Product, many2one, required









	product_uom:	UoM, many2one, required









	incoming_left:	Delta In, float, readonly









	warehouse_id:	Warehouse, many2one









	stock_start:	Stock Simulation, float, readonly









	state:	State, selection, readonly









	outgoing_left:	Delta Out, float, readonly









	period_id:	Period, many2one, required









	planned_outgoing:

		Forecast Out, float, required









	to_procure:	Forecast In, float, required









	planned_sale:	Sales Forecast, float, readonly









	name:	Name, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







stock rma (stock_rma)





	Module:	stock_rma


	Name:	stock rma


	Version:	5.0.0.1


	Author:	Akretion.com


	Directory:	stock_rma


	Web:	http://www.akretion.com


	Official module:

		no


	Quality certified:

		no






Description

Return Material Authorization








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	stock

	crm

	crm_configuration

	sale









Reports

None




Menus



	CRM & SRM/RMA

	CRM & SRM/RMA/All RMA

	CRM & SRM/RMA/New RMA









Views



	crm.rma.form.rma (form)

	crm.rma.tree.rma (tree)

	stock.picking.rma.form (form)









Objects


Object: crm.rma (crm.rma)





	date_closed:	Closed, datetime, readonly









	history_line:	Communication, one2many, readonly









	create_date:	Created, datetime, readonly









	outgoing_picking_id:

		Outgoing Picking, many2one









	probability:	Probability (%), float









	canal_id:	Channel, many2one









	partner_address_id:

		Partner Contact, many2one









	som:	State of Mind, many2one









	date:	Date, datetime









	warning:	Warning, char, readonly









	category2_id:	Category Name, many2one









	duration:	Duration, float









	out_supplier_picking_id:

		Return From Supplier Picking, many2one









	planned_revenue:

		Planned Revenue, float









	id:	ID, integer, readonly









	date_action_next:

		Next Action, datetime, readonly









	note:	Note, text









	user_id:	Responsible, many2one









	partner_name:	Employee Name, char









	partner_id:	Partner, many2one









	priority:	Priority, selection









	state:	Status, selection, readonly









	case_id:	Related Case, many2one









	rma_ref:	Incident Ref, char, required









	in_supplier_picking_id:

		Return To Supplier Picking, many2one









	new_invoice_id:	Invoice, many2one









	email_cc:	Watchers Emails, char









	incoming_picking_id:

		Incoming Picking, many2one









	ref:	Reference, reference









	log_ids:	Logs History, one2many, readonly









	description:	Your action, text









	date_action_last:

		Last Action, datetime, readonly









	planned_cost:	Planned Costs, float









	ref2:	Reference 2, reference









	section_id:	Section, many2one, required









	prodlot_id:	Serial / Lot Number, many2one









	partner_name2:	Employee Email, char









	partner_mobile:	Mobile, char









	active:	Active, boolean









	categ_id:	Category, many2one









	product_id:	Product, many2one









	invoice_id:	Invoice, many2one









	stage_id:	Stage, many2one









	related_incoming_picking_state:

		Related Picking State, char, readonly









	name:	Description, char, required









	date_deadline:	Deadline, datetime









	email_last:	Latest E-Mail, text, readonly









	related_outgoing_picking_state:

		Related Picking State, char, readonly









	partner_phone:	Phone, char









	extra_note:	Note, text









	guarantee_limit:

		Warranty limit, date, readonly






The warranty limit is computed as: invoice date + warranty defined on selected product.






	email_from:	Partner Email, char









	crm_id:	CRM case, many2one, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Stock Routings (stock_routings)





	Module:	stock_routings


	Name:	Stock Routings


	Version:	5.0.1.1


	Author:	Axelor


	Directory:	stock_routings


	Web:	http://www.axelor.com


	Official module:

		no


	Quality certified:

		no






Description

This Module allows user to define different routings for goods from PO.
                      Goods will transport from one location to another as defined in routings








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	stock

	purchase









Reports

None




Menus



	Stock Management/Configuration/Routings









Views



	* INHERIT Purchase Order Form add Manager Group Cancel Button (form)

	* INHERIT Purchase Order Form State in Confirm Button (form)

	* INHERIT Purchase Order Form add RFQ Button (form)

	* INHERIT Purchase Order Form replace delivery page position (form)

	* INHERIT Picking Form add btn for change planned date (form)

	* INHERIT Picking Form add State in date fields (form)

	* INHERIT Picking Form add Transport Page in Incoming (form)

	* INHERIT Moves Form add btn for change planned date (form)

	* INHERIT Moves Form add Picking And System date (form)

	* INHERIT Internal Move From view Add Picking Date (form)

	* INHERIT Incoming Prod Internal Move From view Add Picking Date (form)

	* INHERIT Moves Form make planned date readonly (form)

	* INHERIT Picking Form add Transport Page in Internal Move (form)

	stock.routing.tree (tree)

	stock.routing.form (form)

	stock.history.tree (tree)

	stock.history.form (form)









Objects


Object: stock.routing (stock.routing)





	kind_transport:	Kind Of Transport, selection









	name:	Routing Name, char, required









	segment_sequence_ids:

		Segment Sequence, one2many









	port_of_loading:

		Incoming Goods Location, many2one









	id:	id, integer









	description:	Description, char








Object: segment.sequence (segment.sequence)





	kind_transport:	Kind Of Transport, selection









	name:	Segment Name, char









	sequence:	Sequence, integer









	chained_delay:	Chained Delay (days), integer









	port_of_loading:

		Depart From, many2one, required









	routing_id:	Routing, many2one









	port_of_destination:

		Destination, many2one, required








Object: stock.history (stock.history)





	description:	Description/Explanation, char









	new_plan_date:	New Planned Date, date









	prev_plan_date:	Previous Planned Date, date









	user:	User, char









	date:	Date, date









	history_id:	History, many2one
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Stock Management (stock)





	Module:	stock


	Name:	Stock Management


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	stock


	Web:	http://www.openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

OpenERP Stock Management module can manage multi-warehouses, multi and structured stock locations.
Thanks to the double entry management, the inventory controlling is powerful and flexible:
* Moves history and planning,
* Different inventory methods (FIFO, LIFO, ...)
* Stock valuation (standard or average price, ...)
* Robustness faced with Inventory differences
* Automatic reordering rules (stock level, JIT, ...)
* Bar code supported
* Rapid detection of mistakes through double entry system
* Traceability (upstream/downstream, production lots, serial number, ...)








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/stock.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/stock.zip]

	trunk [http://www.openerp.com/download/modules/trunk/stock.zip]









Dependencies



	product

	account









Reports



	Future Stock Forecast

	Packing list

	Print Item Labels

	Location Overview

	Lots by location

	Location Content (With children)









Menus



	Stock Management

	Stock Management/Configuration

	Stock Management/Periodical Inventory

	Stock Management/Periodical Inventory/Draft Periodical Inventories

	Stock Management/Periodical Inventory/New Periodical Inventory

	Stock Management/Traceability

	Stock Management/Traceability/Tracking Lots

	Stock Management/Traceability/Production Lots

	Stock Management/Configuration/Locations

	Stock Management/Stock Locations Structure

	Stock Management/Configuration/Warehouses

	Stock Management/Delivery Orders

	Stock Management/Delivery Orders/Delivery Orders to Process

	Stock Management/Delivery Orders/Future Delivery Orders

	Stock Management/Delivery Orders/Calendar of Deliveries

	Stock Management/Outgoing Products

	Stock Management/Outgoing Products/Available Packing

	Stock Management/Outgoing Products/Confirmed Packing Waiting Availability

	Stock Management/Incoming Products

	Stock Management/Incoming Products/Packing to Process

	Stock Management/Incoming Products/New Reception Packing

	Stock Management/Internal Moves

	Stock Management/Internal Moves/Available Packing

	Stock Management/Internal Moves/Confirmed Packing Waiting Availability

	Stock Management/Internal Moves/New Internal Packing

	Stock Management/Traceability/Low Level

	Stock Management/Traceability/Low Level/Stock Moves

	Stock Management/Traceability/Low Level/Stock Moves/Draft Moves

	Stock Management/Traceability/Low Level/Stock Moves/Available Moves

	Stock Management/Traceability/Low Level/Packing

	Stock Management/Configuration/Incoterms

	Stock Management/Reporting

	Stock Management/Reporting/Traceability

	Stock Management/Reporting/Traceability/Stock by Lots

	Stock Management/Reporting/Dates of Inventories

	Stock Management/Reporting/Locations’ Values









Views



	stock.inventory.line.tree (tree)

	stock.inventory.line.form (form)

	stock.inventory.tree (tree)

	stock.inventory.form (form)

	stock.tracking.form (form)

	stock.tracking.tree (tree)

	stock.tracking.tree (tree)

	stock.production.lot.revision.form (form)

	stock.production.lot.revision.tree (tree)

	stock.production.lot.form (form)

	stock.production.lot.tree (tree)

	Stock Moves (tree)

	Stock Moves (tree)

	stock.location.form (form)

	stock.location.tree (tree)

	stock.location.tree (tree)

	stock.warehouse (form)

	stock.warehouse.tree (tree)

	stock.picking.move.wizard.form (form)

	stock.picking.calendar (calendar)

	stock.picking.tree (tree)

	stock.picking.form (form)

	stock.picking.delivery.tree (tree)

	stock.picking.delivery.form (form)

	stock.picking.out.tree (tree)

	stock.picking.out.form (form)

	stock.picking.in.tree (tree)

	stock.picking.in.form (form)

	stock.move.tree (tree)

	stock.move.form (form)

	stock.incoterms.tree (tree)

	stock.incoterms.form (form)

	* INHERIT product.category.stock.property.form.inherit (form)

	* INHERIT product.template.stock.property.form.inherit (form)

	* INHERIT product.normal.stock.acc.property.form.inherit (form)

	* INHERIT product.normal.stock.form.inherit (form)

	* INHERIT product.normal.stock.property.form.inherit (form)

	* INHERIT res.partner.stock.property.form.inherit (form)

	stock.report.prodlots.view (tree)

	report.stock.lines.date.tree (tree)

	report.stock.lines.date.form (form)

	stock.location.tree (tree)









Objects


Object: Incoterms (stock.incoterms)





	active:	Active, boolean









	code:	Code, char, required









	name:	Name, char, required








Object: Location (stock.location)





	comment:	Additional Information, text









	address_id:	Location Address, many2one









	stock_virtual_value:

		Virtual Stock Value, float, readonly









	allocation_method:

		Allocation Method, selection, required









	location_id:	Parent Location, many2one









	chained_location_id:

		Chained Location If Fixed, many2one









	complete_name:	Location Name, char, readonly









	usage:	Location Type, selection, required









	stock_real_value:

		Real Stock Value, float, readonly









	chained_location_type:

		Chained Location Type, selection, required









	account_id:	Inventory Account, many2one









	child_ids:	Contains, one2many









	chained_delay:	Chained Delay (days), integer









	stock_virtual:	Virtual Stock, float, readonly









	posz:	Height (Z), integer









	posx:	Corridor (X), integer









	posy:	Shelves (Y), integer









	active:	Active, boolean









	icon:	Icon, selection









	parent_right:	Right Parent, integer









	name:	Location Name, char, required









	chained_auto_packing:

		Automatic Move, selection, required






This is used only if you selected a chained location type.
The ‘Automatic Move’ value will create a stock move after the current one that will be validated automatically. With ‘Manual Operation’, the stock move has to be validated by a worker. With ‘Automatic No Step Added’, the location is replaced in the original move.






	parent_left:	Left Parent, integer









	stock_real:	Real Stock, float, readonly








Object: Stock Tracking Lots (stock.tracking)





	active:	Active, boolean









	move_ids:	Moves Tracked, one2many









	serial:	Reference, char









	date:	Date Created, datetime, required









	name:	Tracking, char, required








Object: Packing List (stock.picking)





	origin:	Origin Reference, char









	address_id:	Partner, many2one









	type:	Shipping Type, selection, required









	move_lines:	Move lines, one2many









	date_done:	Date Done, datetime









	name:	Reference, char









	move_type:	Delivery Method, selection, required









	invoice_state:	Invoice Status, selection, required, readonly









	min_date:	Planned Date, datetime









	note:	Notes, text









	date:	Date Order, datetime









	state:	Status, selection, readonly









	location_dest_id:

		Dest. Location, many2one









	max_date:	Max. Planned Date, datetime









	auto_picking:	Auto-Packing, boolean









	active:	Active, boolean









	location_id:	Location, many2one









	backorder_id:	Back Order, many2one








Object: Production lot (stock.production.lot)





	stock_available:

		Available, float, readonly









	product_id:	Product, many2one, required









	date:	Created Date, datetime, required









	revisions:	Revisions, one2many









	ref:	Internal Ref, char









	name:	Serial, char, required








Object: Production lot revisions (stock.production.lot.revision)





	indice:	Revision, char









	name:	Revision Name, char, required









	date:	Revision Date, date









	lot_id:	Production lot, many2one









	author_id:	Author, many2one









	description:	Description, text








Object: Stock Move (stock.move)





	product_uos_qty:

		Quantity (UOS), float









	address_id:	Dest. Address, many2one









	product_uom:	Product UOM, many2one, required









	price_unit:	Unit Price, float









	product_qty:	Quantity, float, required









	product_uos:	Product UOS, many2one









	location_id:	Source Location, many2one, required









	priority:	Priority, selection









	auto_validate:	Auto Validate, boolean









	note:	Notes, text









	state:	Status, selection, readonly









	product_packaging:

		Packaging, many2one









	move_history_ids:

		Move History, many2many









	prodlot_id:	Production Lot, many2one






Production lot is used to put a serial number on the production






	move_dest_id:	Dest. Move, many2one









	date:	Date Created, datetime









	product_id:	Product, many2one, required









	move_history_ids2:

		Move History, many2many









	name:	Name, char, required









	date_planned:	Date, datetime, required






Scheduled date for the movement of the products or real date if the move is done.






	location_dest_id:

		Dest. Location, many2one, required









	tracking_id:	Tracking Lot, many2one






Tracking lot is the code that will be put on the logistical unit/pallet






	picking_id:	Packing List, many2one








Object: Inventory (stock.inventory)





	name:	Inventory, char, required, readonly









	date_done:	Date done, datetime









	move_ids:	Created Moves, many2many









	state:	Status, selection, readonly









	date:	Date create, datetime, required, readonly









	inventory_line_id:

		Inventories, one2many, readonly








Object: Inventory line (stock.inventory.line)





	inventory_id:	Inventory, many2one









	location_id:	Location, many2one, required









	product_id:	Product, many2one, required









	product_uom:	Product UOM, many2one, required









	product_qty:	Quantity, float








Object: Warehouse (stock.warehouse)





	lot_input_id:	Location Input, many2one, required









	partner_address_id:

		Owner Address, many2one









	lot_output_id:	Location Output, many2one, required









	name:	Name, char, required









	lot_stock_id:	Location Stock, many2one, required








Object: stock.picking.move.wizard (stock.picking.move.wizard)





	move_ids:	Move lines, many2many, required









	address_id:	Dest. Address, many2one









	name:	Name, char









	picking_id:	Packing list, many2one








Object: Dates of Inventories (report.stock.lines.date)





	create_date:	Latest Date of Inventory, datetime









	id:	Inventory Line Id, integer, readonly









	product_id:	Product Id, integer, readonly








Object: Stock report by production lots (stock.report.prodlots)





	prodlot_id:	Production lot, many2one, readonly









	location_id:	Location, many2one, readonly









	name:	Quantity, float, readonly









	product_id:	Product, many2one, readonly
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Subscription and recurring operations (subscription)





	Module:	subscription


	Name:	Subscription and recurring operations


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	subscription


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Module allows to create new documents and add subscription on that document.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/subscription.zip]

	5.0 [http://www.openerp.com/download/modules/5.0/subscription.zip]

	trunk [http://www.openerp.com/download/modules/trunk/subscription.zip]









Dependencies



	base









Reports

None




Menus



	Tools

	Tools/Subscriptions

	Tools/Subscriptions/Configuration

	Tools/Subscriptions/All Subscriptions

	Tools/Subscriptions/Configuration/Document Types









Views



	subscription.subscription.form (form)

	subscription.subscription.tree (tree)

	subscription.subscription.history.tree (tree)

	subscription.subscription.history.form (form)

	subscription.document.form (form)

	subscription.document.tree (tree)

	subscription.document.fields.form (form)

	subscription.document.fields.tree (tree)









Objects


Object: Subscription document (subscription.document)





	active:	Active, boolean









	model:	Object, many2one, required









	name:	Name, char, required









	field_ids:	Fields, one2many








Object: Subscription document fields (subscription.document.fields)





	field:	Field, many2one, required









	document_id:	Subscription Document, many2one









	value:	Default Value, selection








Object: Subscription (subscription.subscription)





	cron_id:	Cron Job, many2one









	user_id:	User, many2one, required









	name:	Name, char, required









	partner_id:	Partner, many2one









	notes:	Notes, text









	interval_type:	Interval Unit, selection









	exec_init:	Number of documents, integer









	state:	Status, selection









	doc_lines:	Documents created, one2many, readonly









	doc_source:	Source Document, reference, required









	interval_number:

		Interval Qty, integer









	date_init:	First Date, datetime









	active:	Active, boolean








Object: Subscription history (subscription.subscription.history)





	date:	Date, datetime









	subscription_id:

		Subscription, many2one









	document_id:	Source Document, reference, required
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Supplier products list (supplier_product)





	Module:	supplier_product


	Name:	Supplier products list


	Version:	1.0


	Author:	Sednacom


	Directory:	supplier_product


	Web:	http://www.sednacom.fr


	Official module:

		no


	Quality certified:

		no






Description

Automatic pricelist for product's supplier








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/supplier_product.zip]

	trunk [http://www.openerp.com/download/modules/trunk/supplier_product.zip]









Dependencies



	base

	product









Reports

None




Menus

None




Views

None




Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Survey Module (survey)





	Module:	survey


	Name:	Survey Module


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	survey


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module is used for surveys. It depends on the answers or reviews of some questions by different users.
    A survey may have multiple pages. Each page may contain multiple questions and each question may have multiple answers.
    Different users may give different answers of question and according to that survey is done.
    Partners are also sent mails with user name and password for the invitation of the survey








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base









Reports



	Survey Analysis Report1









Menus



	Survey Management

	Survey Management/Configuration

	Survey Management/Configuration/Surveys

	Survey Management/Configuration/Surveys/New Survey

	Survey Management/Configuration/Survey Pages

	Survey Management/Configuration/Survey Pages/New Survey Page

	Survey Management/Configuration/Survey Questions

	Survey Management/Configuration/Survey Questions/New Survey Question

	Survey Management/Give Survey Response









Views



	survey_form (form)

	survey_tree (tree)

	survey_page_form (form)

	survey_page_tree (tree)

	survey_question_form (form)

	survey_question_tree (tree)

	survey_answer_form (form)

	survey_answer_tree (tree)

	survey_response_form (form)

	survey_response_tree (tree)

	survey_response_answer_form (form)

	survey_response_answer_tree (tree)

	survey_question_column_heading_form (form)

	survey_question_column_heading_tree (tree)

	* INHERIT view.res.users.form (form)

	Survey Question (form)

	Survey (form)









Objects


Object: Survey (survey)





	users:	Users, many2many









	date_open:	Survey Open Date, datetime, readonly









	title:	Survey Title, char, required









	responsible_id:	Responsible, many2one









	page_ids:	Page, one2many









	tot_comp_survey:

		Total Completed Survey, integer, readonly









	date_close:	Survey Close Date, datetime, readonly









	note:	Description, text









	state:	Status, selection, readonly









	max_response_limit:

		Maximum Response Limit, integer









	tot_start_survey:

		Total Started Survey, integer, readonly









	response_user:	Maximum Response per User, integer






Set to one if  you require only one response per user






	history:	History Lines, one2many, readonly








Object: Survey History (survey.history)





	date:	Date started, datetime, readonly









	survey_id:	Survey, many2one









	user_id:	User, many2one, readonly








Object: Survey Pages (survey.page)





	note:	Description, text









	survey_id:	Survey, many2one









	sequence:	Sequence, integer









	question_ids:	Question, one2many









	title:	Page Title, char, required








Object: Survey Question (survey.question)





	comment_maximum_float:

		Maximum decimal number, float









	required_type:	Respondent must answer, selection









	comment_valid_type:

		Text Validation, selection









	comment_maximum_date:

		Maximum date, date









	make_comment_field_err_msg:

		Error message, text









	numeric_required_sum_err_msg:

		Error message, text









	tot_resp:	Total Response, float, readonly









	req_ans:	#Required Answer, integer









	validation_valid_err_msg:

		Error message, text









	rating_allow_one_column_require:

		Allow Only One Response per Column (Forced Ranking), boolean









	validation_minimum_date:

		Minimum date, date









	comment_minimum_date:

		Minimum date, date









	req_error_msg:	Error Message, text









	sequence:	Sequence, integer









	question:	Question, char, required









	validation_maximum_date:

		Maximum date, date









	comment_field_type:

		Comment Field Type, selection









	is_require_answer:

		Required Answer, boolean









	comment_minimum_no:

		Minimum number, integer









	validation_maximum_no:

		Maximum number, integer









	make_comment_field:

		Make Comment Field an Answer Choice, boolean









	type:	Question Type, selection, required









	column_heading_ids:

		Column heading, one2many









	response_ids:	Response, one2many, readonly









	minimum_req_ans:

		Minimum Required Answer, integer









	comment_minimum_float:

		Minimum decimal number, float









	comment_valid_err_msg:

		Error message, text









	in_visible_single_text:

		Is Single Text Invisible?, boolean









	validation_maximum_float:

		Maximum decimal number, float









	validation_minimum_no:

		Minimum number, integer









	answer_choice_ids:

		Answer, one2many









	descriptive_text:

		Descriptive Text, text









	maximum_req_ans:

		Maximum Required Answer, integer









	comment_maximum_no:

		Maximum number, integer









	numeric_required_sum:

		Sum of all choices, integer









	in_visible_menu_choice:

		Is Menu Choice Invisible?, boolean









	validation_minimum_float:

		Minimum decimal number, float









	page_id:	Survey Page, many2one, required









	validation_type:

		Text Validation, selection









	comment_label:	Field Label, char









	survey:	Survey, many2one









	in_visible_rating_weight:

		Is Rating Scale Invisible?, boolean









	allow_comment:	Allow Comment Field, boolean








Object: Survey Question Column Heading (survey.question.column.heading)





	in_visible_menu_choice:

		Is Menu Choice Invisible??, boolean









	title:	Column Heading, char, required









	rating_weight:	Weight, integer









	in_visible_rating_weight:

		Is Rating Scale Invisible ??, boolean









	menu_choice:	Menu Choice, text









	question_id:	Question, many2one








Object: Survey Answer (survey.answer)





	answer:	Answer, char, required









	average:	#Avg, float, readonly









	sequence:	Sequence, integer









	response:	#Response, float, readonly









	question_id:	Question, many2one








Object: Survey Response (survey.response)





	comment:	Notes, text









	response_answer_ids:

		Response Answer, one2many









	single_text:	Text, char









	in_visible_single_text:

		Is Single Text Invisible??, boolean









	date_create:	Create Date, datetime, required









	state:	Status, selection, readonly









	response_id:	User, many2one









	response_type:	Response Type, selection









	question_id:	Question, many2one








Object: Survey Response Answer (survey.response.answer)





	answer:	Value, char









	comment:	Notes, text









	value_choice:	Value Choice, char









	response_id:	Response, many2one









	answer_id:	Answer, many2one, required








Object: survey.name.wiz (survey.name.wiz)





	transfer:	Page Transfer, boolean









	note:	Description, text









	store_ans:	Store Answer, text









	survey_id:	Survey, selection, required









	page:	Page Position, char









	page_no:	Page Number, integer








Object: survey.question.wiz (survey.question.wiz)





	name:	Number, integer
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Syleam POS (syleam_pos)





	Module:	syleam_pos


	Name:	Syleam POS


	Version:	1.0


	Author:	Tiny, Syleam


	Directory:	syleam_pos


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Main features :
 - Fast encoding of the sale.
 - Allow to choose one payment mode (the quick way) or to split the payment between several payment mode.
 - Computation of the amount of money to return.
 - Create and confirm picking list automatically.
 - Allow the user to create invoice automatically.
 - Allow to refund former sales.








Download links

You can download this module as a zip file in the following version:



	4.2 [http://www.openerp.com/download/modules/4.2/syleam_pos.zip]









Dependencies



	res_config

	sale

	purchase

	account

	account_tax_include









Reports

None




Menus

None




Views

None




Objects

None







          

      

      

    


    
         Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

    
      Navigation

      
        	
          index

        	
          next |

        	
          previous |

        	OpenERP v6 

          	目录 

          	模块技术指南: Introspection report on objects 
 
      

    


    
      
          
            
    



Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Test New Features (test_44)





	Module:	test_44


	Name:	Test New Features


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	test_44


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

The module adds google map field in partner address
so that we can directly open google map from the
url widget.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/test_44.zip]

	trunk [http://www.openerp.com/download/modules/trunk/test_44.zip]









Dependencies



	base

	sale









Reports

None




Menus



	Testing

	Testing/Testing









Views



	Testing Temporal Data (form)









Objects


Object: test.temporal (test.temporal)





	line_ids:	Lines, one2many









	state:	State, selection









	partner_id:	Partner, many2one









	partner_ids:	Partners, many2many









	name:	Name, char, required








Object: test.temporal.line (test.temporal.line)





	temporal_id:	Temporal, many2one









	length:	Size, integer









	name:	Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Tiny purchase (tiny_purchase)





	Module:	tiny_purchase


	Name:	Tiny purchase


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	tiny_purchase


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

Very simple purchase module.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/tiny_purchase.zip]

	trunk [http://www.openerp.com/download/modules/trunk/tiny_purchase.zip]









Dependencies



	base









Reports



	Print Order









Menus



	Tools

	Tools/Tiny Purchase

	Tools/Tiny Purchase/Purchase line

	Tools/Tiny Purchase/Configuration

	Tools/Tiny Purchase/Configuration/Purchase product

	Tools/Tiny Purchase/Purchase Order









Views



	tiny_purchase.line.form (form)

	tiny_purchase.product.form (form)

	tiny_purchase.order.form (form)









Objects


Object: tiny_purchase.product (tiny_purchase.product)





	price:	Price, float









	name:	Name, char








Object: tiny_purchase.order (tiny_purchase.order)





	line_ids:	Lines, one2many









	state:	State, selection









	user_id:	User, many2one, required









	name:	Date, date








Object: tiny_purchase.line (tiny_purchase.line)





	order_id:	Order, many2one, required









	price:	Price, float, readonly









	product_id:	Product, many2one, required









	comments:	Comments, text









	quantity:	Quantity, integer
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Training Exam (training_exam)





	Module:	training_exam


	Name:	Training Exam


	Version:	0.0.1


	Author:	Tiny SPRL


	Directory:	training_exam


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module adds the exam management for the training management




Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/training_exam.zip]

	trunk [http://www.openerp.com/download/modules/trunk/training_exam.zip]









Dependencies



	training









Reports



	Training Cancellation

	Training Confirmation









Menus

None




Views



	* INHERIT training.course.form.with.questionnaires (form)

	training.question.form (form)

	training.question.tree (tree)

	training.questionnaire.form (form)

	training.questionnaire.tree (tree)

	training.planned_exam.form (form)

	training.planned_exam.tree (tree)

	training.planned_exam.calendar (calendar)

	* INHERIT training.offer.form.with.questionnaires (form)

	training.exam_answer.form (form)

	training.exam_answer.tree (tree)

	training.exam.result.form (form)

	training.exam.result.tree (tree)

	training.exam_answer.form (form)

	training.exam_answer.tree (tree)

	* INHERIT training.subscription.line.form.inherited (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Module Training Room - Helps to manage the training location (training_room)





	Module:	training_room


	Name:	Module Training Room - Helps to manage the training location


	Version:	5.0.0.0.1


	Author:	Tiny SPRL


	Directory:	training_room


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

The module training_room helps the user to manage the training's location








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/training_room.zip]

	trunk [http://www.openerp.com/download/modules/trunk/training_room.zip]









Dependencies



	training









Reports

None




Menus



	Training Management/Configuration/Locations

	Training Management/Configuration/Locations/New Location









Views



	view.training.location.form (form)

	view.training.location.tree (tree)









Objects


Object: Location (training.location)





	address_id:	Address, many2one, required









	name:	Name, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Training Management (training)





	Module:	training


	Name:	Training Management


	Version:	5.0.0.0.1


	Author:	Tiny SPRL


	Directory:	training


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

From the conception of a project to the elaboration of your catalog, our training management allows you to create easily courses and to organize the sessions.
With the analytic account support, you can know the costs of your training.

* Manage the subscriptions
* Manage the courses
* Manage the offers (for a planning)
* Manage the sessions
* Manage the support of course








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/training.zip]

	trunk [http://www.openerp.com/download/modules/trunk/training.zip]









Dependencies



	account

	base_contact_team

	base_iban

	product

	mrp









Reports



	Support Booking

	Presence List

	Classroom Booking

	Cancellation Letter

	Validation Letter

	Presence Certificate

	Course Description

	Financial Statistics

	Support Delivery

	Seance - Cancellation

	Session - Cancellation

	Training Hiring Form

	Evaluation From SkateHolder

	Evaluation From Participant









Menus



	Partners/Configuration/Contacts

	Partners/Configuration/Contacts/Technical Skills

	Training Management

	Training Management/Configuration

	Training Management/Configuration/Library

	Training Management/Configuration/Library/Types

	Training Management/Configuration/Library/Product Lines

	Training Management/Library

	Training Management/Library/Courses

	Training Management/Library/Courses/Courses

	Training Management/Library/Courses/Courses/Current Courses

	Training Management/Library/Courses/Courses/Draft Courses

	Training Management/Library/Courses/Courses/Deprecated Courses

	Training Management/Library/Courses/Courses/New course

	Training Management/Library/Courses/Courses By Category

	Training Management/Library/Offers

	Training Management/Library/Offers/Open Offers

	Training Management/Library/Offers/New Offer

	Training Management/Catalogs

	Training Management/Catalogs/Catalogs

	Training Management/Catalogs/Catalogs/Old Catalogs

	Training Management/Catalogs/Catalogs/Current Catalogs

	Training Management/Catalogs/Catalogs/New Catalog

	Training Management/Plannings

	Training Management/Plannings/Sessions

	Training Management/Plannings/Sessions/Draft Sessions

	Training Management/Plannings/Sessions/Sessions - Report

	Training Management/Plannings/Sessions/Sessions to Confirm

	Training Management/Plannings/Sessions/Sessions to Deduplicate

	Training Management/Plannings/Sessions/New Session

	Training Management/Plannings/Seances

	Training Management/Plannings/Seances/Seances - Report

	Training Management/Plannings/Seances/Calendar of Seances

	Training Management/Plannings/Seances/Seances to Confirm

	Training Management/Plannings/Seances/Seances to Deduplicate

	Training Management/Plannings/Seances/New Seance

	Training Management/Subscriptions

	Training Management/Subscriptions/Subscriptions

	Training Management/Subscriptions/Subscriptions/Subscriptions to Validate

	Training Management/Subscriptions/Subscriptions to Treat

	Training Management/Subscriptions/Subscriptions/Subscriptions to Invoice

	Training Management/Subscriptions/New Subscription

	Training Management/Subscriptions/Subscription Lines

	Training Management/Subscriptions/Subscription Lines/Uninvoiced Subscription Lines

	Training Management/Participation

	Training Management/Participation/Participations of the Participants

	Training Management/Participation/Evaluation Form

	Dummy

	Dummy/Support Deliveries









Views



	res.partner.contact.technical.skill.tree (tree)

	res.partner.contact.technical.skill.form (form)

	* INHERIT res.partner.team.form.inherited (form)

	* INHERIT res.partner.view.form.inherited (form)

	* INHERIT res.partner.contact.form.inherit (form)

	* INHERIT res.partner.contact.form.inherit (form)

	* INHERIT res.partner.contact.form.inherit3 (form)

	training.course_category.form (form)

	training.course_category.tree (tree)

	training.course_type.form (form)

	training.course_type.tree (tree)

	training.course.form (form)

	training.course.list (tree)

	training.catalog.form (form)

	training.catalog.tree (tree)

	training.session.form (form)

	training.session.tree (tree)

	training.session.tree (tree)

	training.session.tree (tree)

	training.session.calendar (calendar)

	training.seance.form (form)

	training.seance.tree (tree)

	training.seance.tree (tree)

	training.seance.calendar (calendar)

	training.subscription.form (form)

	training.subscription.tree (tree)

	training.subscription.tree (tree)

	training.subscription.line.tree (tree)

	training.offer.form (form)

	training.offer.tree (tree)

	training.participation.form (form)

	training.participation.tree (tree)

	training.participation.skateholder.form (form)

	training.participation.skateholder.tree (tree)

	view.dummy.support.delivery.form (form)









Objects


Object: res.partner.contact_technical_skill (res.partner.contact_technical_skill)





	name:	Name, char, required








Object: training.course_category (training.course_category)





	code:	Account Code, char









	description:	Description, text






Description of the course category






	child_ids:	Children, one2many, readonly









	quantity_max:	Maximum Quantity, float









	contact_id:	Contact, many2one









	company_currency_id:

		Currency, many2one, readonly









	date:	Date End, date









	active:	Active, boolean









	partner_id:	Associated Partner, many2one









	analytic_account_id:

		Analytic Account, many2one









	user_id:	Account Manager, many2one









	name:	Account Name, char, required









	credit:	Credit, float, readonly









	date_start:	Date Start, date









	company_id:	Company, many2one, required









	parent_id:	Parent Analytic Account, many2one









	state:	State, selection, required









	complete_name:	Full Account Name, char, readonly









	debit:	Debit, float, readonly









	line_ids:	Analytic Entries, one2many









	balance:	Balance, float, readonly









	type:	Account Type, selection









	quantity:	Quantity, float, readonly








Object: The type of a course (training.course_type)





	objective:	Objective, text






Allows to the user to write the objectives of the course type






	min_limit:	Minimum Threshold, integer, required






The minimum threshold is the minimum for this type of course






	max_limit:	Maximum Threshold, integer, required






The maximum threshold is the maximum for this type of course






	name:	Name, char, required






The course type’s name






	description:	Description, text






Allows to the user to write the description of the course type





Object: training.course (training.course)





	code:	Account Code, char









	course_type_id:	Type, many2one, required









	description:	Description, text









	total_duration:	Total Duration, float, readonly






The total duration is computed if there is any subcourse






	child_ids:	Child Accounts, one2many









	duration:	Duration, float, required






The duration for a standalone course






	quantity_max:	Maximum Quantity, float









	contact_id:	Contact, many2one









	lecturer_ids:	Lecturers, many2many






The lecturers who give the course






	company_currency_id:

		Currency, many2one, readonly









	date:	Date End, date









	reference_id:	Master Course, many2one






The master course is necessary if the user wants to link certain courses together to simplify management






	active:	Active, boolean









	display_name:	Display Name, char






Allows to show a short name for this course






	offer_ids:	Offers, many2many






The offers containing the course






	partner_id:	Associated Partner, many2one









	children:	Children, one2many






A course can be completed with some subcourses






	internal_note:	Note, text






The user can write some internal note for this course






	analytic_account_id:

		Account, many2one









	has_support:	Has Support, boolean, readonly









	user_id:	Account Manager, many2one









	name:	Account Name, char, required









	credit:	Credit, float, readonly









	target_public:	Target Public, char






Allows to the participants to select a course whose can participate






	purchase_line_ids:

		Supplier Commands, one2many






The purchase line helps to create a purchase order for the seance






	date_start:	Date Start, date









	p_id:	Parent Course, many2one, readonly






The parent course






	company_id:	Company, many2one, required









	sequence:	Sequence, integer






The sequence can help the user to reorganize the order of the courses






	parent_id:	Parent Analytic Account, many2one









	state:	State, selection, required









	lang_id:	Language, many2one, required






The language of the course






	complete_name:	Full Account Name, char, readonly









	state_course:	State, selection, required, readonly






The state of the course






	debit:	Debit, float, readonly









	line_ids:	Analytic Entries, one2many









	balance:	Balance, float, readonly









	type:	Account Type, selection









	complementary_course_ids:

		Complementary Courses, many2many









	preliminary_course_ids:

		Preliminary Courses, many2many









	quantity:	Quantity, float, readonly








Object: training.course.purchase_line (training.course.purchase_line)





	course_id:	course, many2one, required






The course attached to this purchase line






	product_uom_id:	Product UoM, many2one, required






The unit of measure for this product






	product_id:	Product, many2one, required






The product for this purchase line






	product_qty:	Quantity, integer, required






The quantity of this product





Object: training.offer (training.offer)





	analytic_account_id:

		Analytic Account, many2one









	kind:	Kind, selection, required









	description:	Description, text






Allows to write the description of the course






	profit:	Profit, float, readonly









	course_ids:	Courses, many2many






An offer can contain some courses






	profit_margin:	Profit Margin, float, readonly









	state:	State, selection, required, readonly






The status of the course






	costs:	Costs, float, readonly









	objective:	Objective, text






Allows to write the objectives of the course






	revenues:	Revenues, float, readonly









	product_id:	Product, many2one






An offer can be a product for invoicing






	name:	Name, char, required






The name’s offer





Object: Catalog (training.catalog)





	note:	Note, text






Allows to write a note for the catalog






	state:	State, selection, required, readonly






The status of the catalog






	session_ids:	Sessions, one2many






The sessions in the catalog






	year:	Year, integer, required






The year when the catalog has been published





Object: training.seance (training.seance)





	max_limit:	Maximum Limit, integer









	reserved:	Reserved, boolean









	presence_form:	Presence Form, boolean









	duration:	Duration, float









	invoice:	Invoice, boolean









	participant_ids:

		Participants, many2many









	course_id:	Course, many2one, required









	purchase_line_ids:

		Supplier Commands, one2many









	draft_seats:	Draft Seats, integer









	user_id:	Responsible, many2one, required









	min_limit:	Minimum Limit, integer









	state:	State, selection, required, readonly









	location:	Location, char









	partner_ids:	StakeHolders, many2many









	evaluation:	Evaluation, boolean









	participant_count:

		Number of Participants, integer, readonly









	available_seats:

		Available Seats, integer









	session_ids:	Sessions, many2many









	date:	Date, datetime









	layout:	Layout, char









	room:	Room, char









	support_received:

		Support Received, boolean, readonly









	name:	Name, char, required









	group_id:	Group, many2one








Object: Session (training.session)





	seance_ids:	Seances, many2many






List of the events in the session






	name:	Name, char, required






The session’s name






	offer_id:	Offer, many2one, required






Allows to select a validated offer for the session






	draft_seats:	Draft Seats, integer









	available_seats:

		Available Seats, integer









	state:	State, selection, required, readonly






The status of the session






	catalog_id:	Catalog, many2one






Allows to select a published catalog






	date:	Date, datetime, required






The date of the planned session






	user_id:	Responsible, many2one, required









	purchase_line_ids:

		Supplier Commands, one2many






The supplier commands will create a purchase order for each command for the session






	is_intra:	Is Intra, boolean, readonly








Object: training.session.purchase_line (training.session.purchase_line)





	product_uom_id:	Product UoM, many2one, required






The unit of measure for the product






	product_id:	Product, many2one, required






The product for the purchase order






	session_id:	Session, many2one, required






The session for this purchase order






	product_qty:	Quantity, integer, required






The quantity of the product for the purchase order





Object: Mass Subscription Wizard (wizard.training.mass.subscription)





	partner_ids:	Partners, many2many, required









	session_ids:	Sessions, many2many, required








Object: Group (training.group)





	name:	Name, char, required






The group’s name





Object: training.subscription (training.subscription)





	origin:	Origin, char









	address_id:	Invoice Address, many2one, required









	create_date:	Creation Date, datetime, readonly









	name:	Reference, char, required, readonly






The unique identifier is generated by the system (customizable)






	notification_text:

		Kind, char, readonly









	payment_term_id:

		Payment Term, many2one









	subscription_line_ids:

		Subscription Lines, one2many









	draft_seats:	Draft Seats, integer









	max_seats:	Maximum Seats, integer









	state:	State, selection, required, readonly









	rest_seats:	Rest Seats, integer









	responsible_id:	Responsible, many2one, required









	pricelist_id:	Pricelist, many2one









	partner_id:	Partner, many2one, required









	notification_active:

		Active, boolean








Object: Participation (training.participation)





	contact_id:	Contact, many2one, readonly









	seance_id:	Seance, many2one, required, readonly









	date:	Date, datetime, readonly









	subscription_id:

		Subscription, many2one, required, readonly









	partner_id:	Partner, many2one, readonly









	present:	Present, boolean






Allows to know if a participant was present or not





Object: training.seance.purchase_line (training.seance.purchase_line)





	product_uom_id:	Product UoM, many2one, required









	procurement_id:	unknown, many2one, readonly









	product_id:	Product, many2one, required









	seance_id:	Seance, many2one, required









	product_qty:	Quantity, integer, required








Object: Subscription Line (training.subscription.line)





	contact_id:	Contact, many2one, required









	invoice_id:	Invoice, many2one









	paid:	Paid, boolean









	contact_email:	Email, char









	session_id:	Session, many2one, required









	subscription_id:

		Subscription, many2one, required









	group_id:	Group, many2one









	partner_id:	unknown, many2one









	invoiced:	Invoiced, boolean








Object: training.participation.skateholder (training.participation.skateholder)





	partner_id:	Partner, many2one









	skateholder_id:	Contact, many2one









	date:	Date, datetime, readonly









	seance_id:	Seance, many2one









	payment_mode:	Payment Mode, selection









	evaluation:	Evaluation, integer









	course_id:	Course, many2one, readonly








Object: dummy.support.delivery (dummy.support.delivery)





	name:	Name, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Travel Management (travel)





	Module:	travel


	Name:	Travel Management


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	travel


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

None








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/travel.zip]

	trunk [http://www.openerp.com/download/modules/trunk/travel.zip]









Dependencies



	base

	product









Reports

None




Menus



	Travel Agency

	Travel Agency/Hostels

	Travel Agency/Rooms

	Travel Agency/Rooms/Single Rooms

	Travel Agency/Rooms/Double Rooms

	Travel Agency/Airports

	Travel Agency/Flights









Views



	travel.flight (form)

	travel.room (form)

	travel.room (tree)

	travel.hostel (form)









Objects


Object: Partner (travel.hostel)





	comment:	Notes, text









	ean13:	EAN13, char









	rooms_id:	Rooms, one2many









	active:	Active, boolean









	property_product_pricelist:

		Sale Pricelist, many2one






This pricelist will be used, instead of the default one,                     for sales to the current partner






	quality:	Quality, char









	city:	City, char









	user_id:	Dedicated Salesman, many2one






The internal user that is in charge of communicating with this partner if any.






	title:	Title, selection









	parent_id:	Main Company, many2one









	supplier:	Supplier, boolean






Check this box if the partner is a supplier. If unchecked, purchasing staff will not see it when encoding a purchase order.






	ref:	Code, char









	events:	Events, one2many









	vat:	VAT, char






Value Added Tax number. Check the box if the partner is subjected to the VAT. Used by the VAT legal statement.






	website:	Website, char









	lang:	Language, selection






If the selected language is loaded in the system, all documents related to this partner will be printed in that language. If not, it will be English.






	bank_ids:	Banks, one2many









	child_ids:	Partner Ref., one2many









	address:	Contacts, one2many









	date:	Date, date









	customer:	Customer, boolean






Check this box if the partner is a customer.






	credit_limit:	Credit Limit, float









	name:	Name, char, required









	country:	Country, many2one









	category_id:	Categories, many2many








Object: travel.airport (travel.airport)





	city:	City, char









	name:	Airport name, char









	country:	Country, many2one








Object: Product (travel.room)





	warranty:	Warranty (months), float









	ean13:	EAN13, char









	supply_method:	Supply method, selection, required






Produce will generate production order or tasks, according to the product type. Purchase will trigger purchase orders when requested.






	uos_id:	Unit of Sale, many2one






Used by companies that manages two unit of measure: invoicing and stock management. For example, in food industries, you will manage a stock of ham but invoice in Kg. Keep empty to use the default UOM.






	list_price:	Sale Price, float






Base price for computing the customer price. Sometimes called the catalog price.






	weight:	Gross weight, float






The gross weight in Kg.






	incoming_qty:	Incoming, float, readonly









	standard_price:	Cost Price, float, required






The cost of the product for accounting stock valuation. It can serves as a base price for supplier price.






	price_extra:	Variant Price Extra, float









	mes_type:	Measure Type, selection, required









	uom_id:	Default UoM, many2one, required






Default Unit of Measure used for all stock operation.






	hostel_id:	Hostel, many2one









	code:	Code, char, readonly









	description_purchase:

		Purchase Description, text









	default_code:	Code, char









	qty_available:	Real Stock, float, readonly









	variants:	Variants, char









	uos_coeff:	UOM -> UOS Coeff, float






Coefficient to convert UOM to UOS
uos = uom * coeff






	product_tmpl_id:

		Product Template, many2one, required









	virtual_available:

		Virtual Stock, float, readonly









	seller_delay:	Supplier Lead Time, integer, readonly






This is the average delay in days between the purchase order confirmation and the reception of goods for this product and for the default supplier. It is used by the scheduler to order requests based on reordering delays.






	purchase_ok:	Can be Purchased, boolean






Determine if the product is visible in the list of products within a selection from a purchase order line.






	product_manager:

		Product Manager, many2one









	company_id:	Company, many2one









	name:	Name, char, required









	active:	Active, boolean









	state:	Status, selection






Tells the user if he can use the product or not.






	loc_rack:	Rack, char









	uom_po_id:	Purchase UoM, many2one, required






Default Unit of Measure used for purchase orders. It must be in the same category as the default unit of measure.






	type:	Product Type, selection, required






Will change the way procurements are processed. Consumables are stockable products with infinite stock, or for use when you have no stock management in the system.






	price:	Customer Price, float, readonly









	description:	Description, text









	weight_net:	Net weight, float






The net weight in Kg.






	volume:	Volume, float






The volume in m3.






	outgoing_qty:	Outgoing, float, readonly









	procure_method:	Procure Method, selection, required






‘Make to Stock’: When needed, take from the stock or wait until re-supplying. ‘Make to Order’: When needed, purchase or produce for the procurement request.






	cost_method:	Costing Method, selection, required






Standard Price: the cost price is fixed and recomputed periodically (usually at the end of the year), Average Price: the cost price is recomputed at each reception of products.






	partner_ref:	Customer ref, char, readonly









	loc_row:	Row, char









	sale_ok:	Can be sold, boolean






Determine if the product can be visible in the list of product within a selection from a sale order line.






	rental:	Rentable Product, boolean









	packaging:	Logistical Units, one2many






Gives the different ways to package the same product. This has no impact on the packing order and is mainly used if you use the EDI module.






	sale_delay:	Customer Lead Time, float






This is the average time between the confirmation of the customer order and the delivery of the finished products. It’s the time you promise to your customers.






	loc_case:	Case, char









	description_sale:

		Sale Description, text









	categ_id:	Category, many2one, required









	beds:	Nbr of Beds, integer









	lst_price:	List Price, float, readonly









	produce_delay:	Manufacturing Lead Time, float






Average time to produce this product. This is only for the production order and, if it is a multi-level bill of material, it’s only for the level of this product. Different delays will be summed for all levels and purchase orders.






	seller_ids:	Partners, one2many









	view:	Room View, selection









	price_margin:	Variant Price Margin, float








Object: Product (travel.flight)





	warranty:	Warranty (months), float









	ean13:	EAN13, char









	supply_method:	Supply method, selection, required






Produce will generate production order or tasks, according to the product type. Purchase will trigger purchase orders when requested.






	uos_id:	Unit of Sale, many2one






Used by companies that manages two unit of measure: invoicing and stock management. For example, in food industries, you will manage a stock of ham but invoice in Kg. Keep empty to use the default UOM.






	list_price:	Sale Price, float






Base price for computing the customer price. Sometimes called the catalog price.






	weight:	Gross weight, float






The gross weight in Kg.






	incoming_qty:	Incoming, float, readonly









	standard_price:	Cost Price, float, required






The cost of the product for accounting stock valuation. It can serves as a base price for supplier price.






	price_extra:	Variant Price Extra, float









	mes_type:	Measure Type, selection, required









	uom_id:	Default UoM, many2one, required






Default Unit of Measure used for all stock operation.






	code:	Code, char, readonly









	description_purchase:

		Purchase Description, text









	default_code:	Code, char









	qty_available:	Real Stock, float, readonly









	partner_id:	Partner, many2one









	variants:	Variants, char









	uos_coeff:	UOM -> UOS Coeff, float






Coefficient to convert UOM to UOS
uos = uom * coeff






	product_tmpl_id:

		Product Template, many2one, required









	date:	Departure Date, datetime









	seller_delay:	Supplier Lead Time, integer, readonly






This is the average delay in days between the purchase order confirmation and the reception of goods for this product and for the default supplier. It is used by the scheduler to order requests based on reordering delays.






	purchase_ok:	Can be Purchased, boolean






Determine if the product is visible in the list of products within a selection from a purchase order line.






	product_manager:

		Product Manager, many2one









	company_id:	Company, many2one









	name:	Name, char, required









	active:	Active, boolean









	state:	Status, selection






Tells the user if he can use the product or not.






	loc_rack:	Rack, char









	uom_po_id:	Purchase UoM, many2one, required






Default Unit of Measure used for purchase orders. It must be in the same category as the default unit of measure.






	type:	Product Type, selection, required






Will change the way procurements are processed. Consumables are stockable products with infinite stock, or for use when you have no stock management in the system.






	price:	Customer Price, float, readonly









	description:	Description, text









	weight_net:	Net weight, float






The net weight in Kg.






	volume:	Volume, float






The volume in m3.






	airport_from:	Airport Departure, many2one









	outgoing_qty:	Outgoing, float, readonly









	procure_method:	Procure Method, selection, required






‘Make to Stock’: When needed, take from the stock or wait until re-supplying. ‘Make to Order’: When needed, purchase or produce for the procurement request.






	virtual_available:

		Virtual Stock, float, readonly









	cost_method:	Costing Method, selection, required






Standard Price: the cost price is fixed and recomputed periodically (usually at the end of the year), Average Price: the cost price is recomputed at each reception of products.






	partner_ref:	Customer ref, char, readonly









	loc_row:	Row, char









	sale_ok:	Can be sold, boolean






Determine if the product can be visible in the list of product within a selection from a sale order line.






	rental:	Rentable Product, boolean









	packaging:	Logistical Units, one2many






Gives the different ways to package the same product. This has no impact on the packing order and is mainly used if you use the EDI module.






	sale_delay:	Customer Lead Time, float






This is the average time between the confirmation of the customer order and the delivery of the finished products. It’s the time you promise to your customers.






	loc_case:	Case, char









	description_sale:

		Sale Description, text









	categ_id:	Category, many2one, required









	lst_price:	List Price, float, readonly









	produce_delay:	Manufacturing Lead Time, float






Average time to produce this product. This is only for the production order and, if it is a multi-level bill of material, it’s only for the level of this product. Different delays will be summed for all levels and purchase orders.






	seller_ids:	Partners, one2many









	airport_to:	Airport Arrival, many2one









	price_margin:	Variant Price Margin, float
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







On Demand Open Object - Subscription Control (use_control)





	Module:	use_control


	Name:	On Demand Open Object - Subscription Control


	Version:	5.0.1.1


	Author:	Tiny


	Directory:	use_control


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This module provides reports to control your on demand subscription.
You can not uninstall or delete it.








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base









Reports

None




Menus



	Administration/On Demand Control

	Administration/On Demand Control/Hours per User

	Administration/On Demand Control/Hours per Month









Views



	use.control.time.month.user.graph (graph)

	use.control.time.month.user.form (form)

	use.control.time.month.user.tree (tree)

	use.control.time.month.graph (graph)

	use.control.time.month.tree (tree)









Objects


Object: use.control.time (use.control.time)





	date:	Date, datetime









	duration:	Duration, float









	user_id:	User, many2one









	uploaded:	Uploaded, boolean








Object: Time of Use per Month (use.control.time.month.user)





	date:	Month, date









	duration:	Duration, float









	user_id:	User, many2one








Object: Time of Use per Month (use.control.time.month)





	date:	Month, date









	duration:	Duration, float








Object: Containt the blocking message (use.control.db.block)





	name:	Block message, text
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







CTG points Management (user_ctg)





	Module:	user_ctg


	Name:	CTG points Management


	Version:	0.0.5


	Author:	Tiny


	Directory:	user_ctg


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

This Module is managed User CTG points (called CTG points as ‘Contribution To Growth points’) for * DMS: Added CTG points to Document’s Author  when sent feedback by other people after downloading document through the DMS * Developments: Added CTG points to Developer  based on LP karma  * Marketing: Added CTG points to Marketing  base on number of incoming visitors on our website * Sales: Added CTG points to Saleman  that sold something and points accordingly to amount sold * Customer Satisfaction: Added CTG points to responsible person of project when customer send feedback for a service/an integration




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/user_ctg.zip]









Dependencies



	base

	sale

	document

	account_invoice_salesman

	project









Reports

None




Menus

None




Views



	ctg.type.tree (tree)

	ctg.type.form (form)

	ctg.line.tree (tree)

	ctg.line.form (form)

	* INHERIT users.inherit.form (form)

	* INHERIT users.inherit.form (form)

	report.ctg.line.tree (tree)

	report.ctg.line.form (form)

	CTG Line -Graph (graph)

	ctg.feedback.tree (tree)

	ctg.feedback.form (form)

	user.history.tree (tree)

	user.history.form (form)









Objects



	ctg.line

	report.ctg.line

	ctg.feedback
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Authenticate users with ldap server (users_ldap)





	Module:	users_ldap


	Name:	Authenticate users with ldap server


	Version:	5.0.0.1


	Author:	Tiny


	Directory:	users_ldap


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Add support for authentication by ldap server








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/users_ldap.zip]

	trunk [http://www.openerp.com/download/modules/trunk/users_ldap.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	* INHERIT res.company.form.inherit.users_ldap (form)









Objects


Object: res.company.ldap (res.company.ldap)





	sequence:	Sequence, integer









	ldap_password:	LDAP password, char, required









	ldap_server:	LDAP Server address, char, required









	company:	Company, many2one, required









	ldap_base:	LDAP base, char, required









	create_user:	Create user, boolean






Create the user if not in database






	ldap_server_port:

		LDAP Server port, integer, required









	user:	Model user, many2one






Model used for user creation






	ldap_binddn:	LDAP binddn, char, required









	ldap_filter:	LDAP filter, char, required
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Allow attachments to be checked via virustotal.com (virustotal)





	Module:	virustotal


	Name:	Allow attachments to be checked via virustotal.com


	Version:	5.0.1.0


	Author:	Christophe Simonis


	Directory:	virustotal


	Web:	


	Official module:

		no


	Quality certified:

		no






Description

This module allows users to send any attachment to virustotal.com to be checked with latest antivirus engines








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/virustotal.zip]

	trunk [http://www.openerp.com/download/modules/trunk/virustotal.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	* INHERIT ir.attachment.view (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Module for Warnings form onchange Event (warning)





	Module:	warning


	Name:	Module for Warnings form onchange Event


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	warning


	Web:	


	Official module:

		yes


	Quality certified:

		yes






Description

Module for Warnings form onchange Event.








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/warning.zip]

	trunk [http://www.openerp.com/download/modules/trunk/warning.zip]









Dependencies



	base

	sale









Reports

None




Menus

None




Views



	* INHERIT res.partner.warning.form.inherit (form)

	* INHERIT product.warning.form.inherit (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Webmail (webmail)





	Module:	webmail


	Name:	Webmail


	Version:	5.0.1.0


	Author:	Tiny


	Directory:	webmail


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Webmail module covers:
        - Mail server configuration.
        - Sending and Receiving mail








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/webmail.zip]

	trunk [http://www.openerp.com/download/modules/trunk/webmail.zip]









Dependencies



	base









Reports

None




Menus



	Webmail

	Webmail/Configuration

	Webmail/Configuration/Server

	Webmail/Compose Mail









Views



	webmail.server.tree (tree)

	webmail.server.form (form)

	webmail.tiny.user.form (form)

	webmail.mailbox.tree (tree)

	webmail.email.compose.form (form)

	webmail.email.read.form (form)









Objects


Object: User Configuration (webmail.tiny.user)





	server_conf_id:	Configuration, one2many









	user_id:	User, many2one








Object: Mail Server Configuration (webmail.server)





	iconn_port:	Port, integer









	server_id:	Mail Client, many2one









	iserver_type:	Server Type, selection









	name:	Name, char, required









	oconn_type:	SSL, boolean









	oconn_port:	Port, integer









	iserver_name:	Server Name, char, required









	oserver_name:	Server Name, char, required









	iconn_type:	SSL, boolean









	password:	Password, char, required









	user_name:	User Name, char, required








Object: User Mailbox (webmail.mailbox)





	parent_id:	Parent Folder, many2one









	child_id:	Child Folder, one2many









	user_id:	User, many2one









	name:	Name, char, required









	account_id:	Server, many2one








Object: Email Tag (webmail.tags)





	user_id:	User, many2one









	name:	Tag Name, char









	account_id:	Server, many2one








Object: User Email (webmail.email)





	body:	Body, text









	user_id:	User, many2one









	account_id:	Server, many2one









	cc:	Cc, char









	tag_id:	Tags, many2one









	bcc:	Bcc, char









	to:	To, char









	folder_id:	Folder, many2one









	from_user:	From, char









	date:	Date, datetime









	active:	Active, boolean









	message_id:	Message Id, char









	subject:	Subject, char
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Document Management - Wiki Extension (wiki_extension)





	Module:	wiki_extension


	Name:	Document Management - Wiki Extension


	Version:	5.0.1.0


	Author:	SYLEAM Info Services


	Directory:	wiki_extension


	Web:	http://Syleam.fr


	Official module:

		no


	Quality certified:

		no






Description

The base module to manage documents(wiki)

    Add new features :
    - members in wiki groups
    - state in page wiki (Running, Raed Only, Obsolete)
    - improvement view








Download links

You can download this module as a zip file in the following version:

(No download links available)




Dependencies



	base

	wiki









Reports

None




Menus

None




Views



	* INHERIT wiki.groups.form.extension (form)

	* INHERIT wiki.wiki.form.extension text_area (form)

	* INHERIT wiki.wiki.form.extension state (form)









Objects

None
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Document Management - Wiki (wiki)





	Module:	wiki


	Name:	Document Management - Wiki


	Version:	5.0.1.0


	Author:	Tiny & Axelor


	Directory:	wiki


	Web:	http://openerp.com


	Official module:

		yes


	Quality certified:

		yes






Description

The base module to manage documents(wiki)

    keep track for the wiki groups, pages, and history








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/wiki.zip]

	trunk [http://www.openerp.com/download/modules/trunk/wiki.zip]









Dependencies



	base









Reports

None




Menus



	Document Management

	Document Management/Wiki Configuration

	Document Management/Wiki

	Document Management/Wiki Configuration/Wiki Groups

	Document Management/Wiki/Wiki Groups

	Document Management/Wiki/Wiki Pages

	Document Management/Wiki Configuration/All Page Histories









Views



	wiki.groups.tree (tree)

	wiki.groups.form (form)

	wiki.wiki.tree (tree)

	wiki.wiki.form (form)

	wiki.wiki.history.tree (tree)

	wiki.wiki.history.form (form)

	Differences (form)









Objects


Object: wiki.wiki (wiki.wiki)





	create_uid:	Author, many2one









	group_id:	Wiki Group, many2one









	create_date:	Created on, datetime









	name:	Title, char, required









	tags:	Tags, char









	minor_edit:	Minor edit, boolean









	history_id:	History Lines, one2many









	summary:	Summary, char









	text_area:	Content, text









	write_date:	Modification Date, datetime









	review:	Need Review, boolean









	toc:	Table of Contents, boolean









	write_uid:	Last Author, many2one









	section:	Section, char






Use page section code like 1.2.1





Object: Wiki Groups (wiki.groups)





	create_date:	Created Date, datetime









	name:	Wiki Group, char, required









	notes:	Description, text









	child_ids:	Child Groups, one2many









	parent_id:	Parent Group, many2one









	page_ids:	Pages, one2many









	template:	Wiki Template, text









	home:	Pages, many2one









	section:	Make Section ?, boolean








Object: Wiki Groups Links (wiki.groups.link)





	group_id:	Parent Group, many2one









	action_id:	Menu, many2one








Object: Wiki History (wiki.wiki.history)





	create_date:	Date, datetime









	minor_edit:	This is a major edit ?, boolean









	write_uid:	Modify By, many2one









	text_area:	Text area, text









	wiki_id:	Wiki Id, many2one









	summary:	Summary, char








Object: wizard.wiki.history.show_diff (wizard.wiki.history.show_diff)





	diff:	Diff, text
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Default Access Control (wizard_access_rules)





	Module:	wizard_access_rules


	Name:	Default Access Control


	Version:	1.1


	Author:	Tiny


	Directory:	wizard_access_rules


	Web:	http://www.openerp.com


	Official module:

		no


	Quality certified:

		no






Description

Create a default Access Control if for any nodel it is not defined




Download links

You can download this module as a zip file in the following version:



	trunk [http://www.openerp.com/download/modules/trunk/wizard_access_rules.zip]









Dependencies



	base









Reports

None




Menus

None




Views



	wizard.acl.list.form (form)









Objects



	wizard.acl.list

	wizard.acl
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Tip

This module is part of the OpenERP software, the leading Open Source
enterprise management system. If you want to discover OpenERP, check our
screencasts [http://openerp.tv] or download
OpenERP [http://openerp.com] directly.







Zarafa Integration (zarafa)





	Module:	zarafa


	Name:	Zarafa Integration


	Version:	5.0.1.0


	Author:	Sednacom


	Directory:	zarafa


	Web:	http://www.sednacom.fr


	Official module:

		no


	Quality certified:

		no






Description

New objects and views to improve use of OpenERP:
 * shortcuts view
 * module view
 * email object
 * Zarafa tools








Download links

You can download this module as a zip file in the following version:



	5.0 [http://www.openerp.com/download/modules/5.0/zarafa.zip]

	trunk [http://www.openerp.com/download/modules/trunk/zarafa.zip]









Dependencies



	base

	crm









Reports

None




Menus



	Administration/Modules Management/Modules by Sednacom

	Tools/Shortcuts

	Tools/Import contact from Zarafa

	Tools/Emails









Views



	* INHERIT res.users.form.zarafa (form)

	* INHERIT res.partner.address.tree.email (tree)

	sednacom.email.form (form)

	sednacom.email.tree (tree)









Objects


Object: sednacom.email (sednacom.email)





	body:	Message, text, readonly









	name:	Title, char, required, readonly









	recipients:	Contacts, many2many, readonly









	datetime:	Date, datetime, readonly









	to:	To, char, readonly









	state:	State, selection, readonly









	exp:	From, char, required, readonly









	crm_case:	Case, many2one, readonly








Object: Contacts, with features to import from Zarafa server (zarafa.contact)





	fax:	Fax, char









	name:	Name, char, required









	mobile:	Mobile, char









	company:	Company, char









	state:	State, selection, readonly









	phone:	Phone, char









	zid:	Z-Id, char, required









	email:	Email, char, required
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Odoo: 随时随地在线管理

Odoo是一个完整的解决方案，包括：特价软件，维护，主机托管和技术支持。给你一个通过互联网快速访问你应用以及全部保护你的数据安全解决方案。


文档

文档很快就就绪了，有点儿耐心嘛亲……




手册

你可以使用在线手册: OpenERP 用户手册
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Defining Level


Level It specifies the actual data to be displayed. It
specifies the depth for the hierarchy. Now taking the same example for the
Products. We need it to be two level depth.




		Product Category


		Product Name









Lets start with making the levels. Details like hierarchy name, level name
filled by default according the schema we are in. We need to specify the column
to be used for filling the level. We open the column name and it will show all
the fields from tables defined in the hierarchy.  We select name from the
product category
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We want more level for displaying the name of the products. In the column name
we will select the column name from the product_template. The main thing is to
change the sequence to 2. This will show the products category wise on the
browser.
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BI(Business Intelligence)商业智能化



Part 1 : 简介



Experimental Application


本章介绍了一个体检性的商业智能化应用，它并不在OpenERP当前通过质量认证的发行版中。
这个商业智能化模块可以在OPENERP应用商店里找到： <http://apps.openerp.com>`_, 但是目前还不
符合实际生产使用。
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Defining Hierarchy


Hierarchy is the arrangements of objects, peoples etc .. in a ranked or some series. The hierarchy are the way of arranging the dimensions.


It need the fact table.


Lets take the Example of Products.


We want our sales cube to work on the products - we want to see the products sold. We have divided the products into categories. So we will make the Product Hierarchy display products by category.


Lets see the new hierarchy. Some values, such as hierarchy name and dimension, may be set by default.


[image: ../../_images/hier1.png]
We now define the fact table for the hierarchy. Relational column will show the all fields of the sale_order_line and sale_order as these are the fact tables for the cube. We select product_id from sale_order_line which is related to product_product


[image: ../../_images/hier2.png]
We want to get both product name and category. We know the product_category will give category and product_template will give the name.
Now the list is filtered accordingly for adding the join tables


[image: ../../_images/hier3.png]
After selecting the product_tmpl_id we select the category table.


[image: ../../_images/hier4.png]
So final fact table for the Product Category will be


[image: ../../_images/hier5.png]
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Database Introspection
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Defining Cube


Cube as we discussed in The Cube


For making the cube we need



		Cube Name : Meaningful name for the cube


		Schema: Configuring Schema


		Query Logging : It will decides whether the query will be logged or not.


		Fact Table : A table that contains the facts (measures) and the link to the other tables that in turn qualifies for the dimensions. The fact table can be a join of two or more tables.





For example :
To analyse the sales data we will take join of sale_order and sale_order_line as a fact table.


So we start making the cube. The screen shows the new cube window. The schema name will be filled by default depending on the schema we are browsing in the tree. The initial window will show the relational column for fact table which will open the search box of all the fact  table created so far.


[image: ../../_images/cube1.png]
We create the new fact table. In the relational column it will show all the primary keys for all tables loaded in the introspection.
We select sale_order_line table with primary key id. Once we are done with the selection we will join the table.


[image: ../../_images/cube2.png]
Join Table will open all the tables that are referenced from the sale_order_line, according to the table name from the relational column. We select order_id as it is the field related to the sale_order. Hence, we made the join of the sale_order_line and sale_order


[image: ../../_images/cube3.png]
If we want more tables to be joined we can do that by adding more on Join Tables. Now the search will be on all the reference from sale_order and sale_order_line


[image: ../../_images/cube4.png]
Finally the cube page will look like


[image: ../../_images/cube5.png]
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定义衡量


Measure are the fact or quantitative values. It comes from the fact table configured in the cube.


我们将使测量相同的例子。测量类型指定是否将列基地或基于sql表达式。


基础列:


[image: ../../_images/measure1.png]
基于SQL表达式:


[image: ../../_images/measure2.png]
基础列建立衡量我们将看到选择事实表列的列的事实表定义的多维数据集即销售订单和出售订单行。
.. i18n: .. image::  images/measure3.png
.. i18n:    :scale: 65
..


[image: ../../_images/measure3.png]
所以将看最后措施:


[image: ../../_images/measure4.png]
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定义维度


维度 必须要一个名字进行识别. Cube 将根据默认的模式进行填充.


[image: ../../_images/dimension.png]
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Goal of Cube Designer


目标是开发一个用户友好的立方体设计师为开放对象- BI,用户可以通过定义和/或修改一个OLAP多维数据集定义从任何数据库。(Oracle、MySQL、PostgreSQL)。这是用户友好的,这样一个终端用户可以定义自己的多维数据集在他自己的数据库没有任何发展知识。



Basic features


这个立方体的设计师OpenObject - BI解决方案可以帮助用户创建新的多维数据集和修改现有的。一旦用户连接到数据库,他们可以以两种方式创建多维数据集
#Wizard Flow
#Generic Flow.



向导流


在向导中流动向导指导用户通过多维数据集创建的整个过程。导航可以通过一个和下一个按钮。



Note


点击“保存”按钮在每个表单使数据被写入数据库,同时“下一步”按钮被激活和用户导航到接下来的形式。Next按钮不会被激活,直到数据是“保存”。







Generic Flow


多维数据集可以修改/用户创建的以正常方式。






		Modify / Create A Schema:


		 		







用户指定所需的模式名称。
他们选择所需的数据库或创建的帮助[新]。
他们指定schema描述。
他们保存模式。






		Modify / Create A Fact Table:


		 		







用户做了一个特定类型的事实表
他们选择所需的数据库或模式为一个特定的事实表,或创建一个使用[new]按钮。






		Modify / Create A Database:


		 		







用户指定的“通用参数”
他指定了“连接参数”,指定哪个数据库和端口号将用于连接。
他测试连接错误和“连接URL”是生成的。
在连接字符串被正确创建新的数据库。






		Modify / Create A Cube:


		 		







用户提供所需的多维数据集名称以及事实表和模式名称。
用户可以选择先前创建的事实表通过一个下拉框或创建一个新的事实表可以通过点击[new]。同样的模式太。
将维度和测度将是空的,因为他们没有被建立出来






		Modify / Create  A Dimension:


		 		







用户提供的维度名称。


给定的多维数据集的名字将出现在这个下拉框。他们可以选择一个多维数据集的名字从名单中或创建一个新的多维数据集通过点击[new]。
层次缺席
.






		Modify / Create A Hierarchies:


		 		







用户提供的层次结构的名字
维度的名字将出现在这个下拉框。
用户可以创建一个新维度通过点击 [new].
用户将提供层次字段名、序列、层次结构类型,所有成员和默认成员字段.
用户会给事实表中选择它从一个下拉框或通过创建一个新的事实表完全被点击 [new]






		Modify / Create A Levels:


		 		







用户必须指定级别名称、列名、列id、水平类,表名、序列和层次结构。层次结构将出现中的下拉框。
他可以创建一个新的层次结构通过点击[new].



Note


点击“保存”按钮在每个表单使数据被写入数据库。
双击打开修改的行窗口各自的记录。








		Modify / Create  A Measures:


		 		








用户提供了测量的名字。
给定的多维数据集的名字将出现在这个下拉框。他们可以选择一个多维数据集的名字从名单中或创建一个新的多维数据集通过单击[new]。
它定义了所有的计算/聚合与事实列名。
这里所有的计算/聚合是相互依赖的领域的事实列名,聚合器、数据类型和格式的字符串。
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定义XML结构



		XML是一种元语言，用来描述文件的结构和内容。


		虽然XML是文档标记语言，但在网络上已经越来越多地用于数据交换。








Defining Schema in XML



		
Why XML for Schema?


		






		XML is a meta language used to describe the structure and content of documents.


		XML, although originally a document markup language, is increasingly used for data exchange on the Web.


		The application of XML as a standard data exchange format makes it attractive to use in conjunction with OLAP tools.


		An XML document has both structure and content, and XML provides a means for separating one from the other in the electronic document.


		The structure of a document is through use of matching tag pairs (termed an element) and the information between matching tags is referred to as the content of the element. Furthermore, an element is permitted to have additional attributes, where values are assigned to the attributes in the start tag of the element.


		XML documents can also contain a description of their logical structure, which is called a document type definition (DTD). A DTD is a context free grammar defining, in terms of element content specifications, all allowable elements, their attributes, and the elements nesting structure. Given a DTD it can be verified that an XML document conforms to the DTD, and if so, the XML document is said to be valid.





All these features make XML attractive when making a schema.
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多维浏览


多维度浏览是一个可以让用户通过基于WEB环境自己设计报表的Open Object-BI平台.


它为用户提供了一个友好层来创建多维分析于之前设计的联机分析Cubes上，而只需要点击几下鼠标，以及在简单易懂的表单里检索所需信息，他们可以重新布局，去钻取更精细的信息，很容易的去了解企业商务趋势和商业机遇.


如果用户不需要全功能的查询功能，他们可以简单地在现有的报告格式及数据交互中探索信息，以满足他们的报告需求。



多维浏览背后的目标


向用户提供一个瘦客户端，以使报告更为有效.
让用户使用强大的MDXAlchemy引擎.
查询过程设计的简单步骤：点击，拖拽和放下.
保持界面简单但功能强大的报告工具。
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看几个例子来编写MDX查询


编写一个简单的销售MDX:


select
  {[partner_country].[all]} on rows,
  {[measures].[Items Sold]} on columns
from sale_order_line






输出结果为,








		/
		Items Sold





		All partner_country
		[43.0]







我们改变MDX，扩展合作伙伴国家到子分类.:


select
   {[partner_country].[all],[partner_country].children} on rows,
   {[measures].[Items Sold]} on columns
from sale_order_line






输出结果为,








		/
		Items Sold





		All partner_country
		[43.0]



		Belgium
		[30.0]



		China
		[4.0]



		France
		[9.0]







切片例子:


select
  {[date_order].children,[date_order].[2008].children,[date_order].[2008].[Q2].children},
  {[measures].[Items Sold]}
from sale_order_line
where ([date_order].[2008])






输出结果为:








		/
		Items Sold





		2008.0
		[43.0]



		Q1
		[43.0]
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拖放方式创建你的报表


Cube Browser 使用基本的拖放操作添加数据到一个报表.
Measures 代表储存类别的值; Dimensions 代表OLAP类别的信息


所有的UI控件自动更新其内容,查询结果显示在OLAP表格里.


在标记有可以拖拉区域的下拉框里，你可以通过拖动一个选项来新建一个查询。


让我们在表格后面可拖动区域中移动所有的产品种类，
一个类别被拖动后马上就会建立新的查询结果，就可以利用工具条来查看。
查询结果生成之后马上就会用表格显示出来，第一个被拖动的总是出现在行中。


[image: ../../_images/d_browsr4.png]

当拖动一个选项到蓝色区域时将会添加第二个主干，马上就会看到结果的变化。每个用户改变动作或者执行查询后马上就会显示出结果。在项目表格旁边都有方向与删除键，我们可以从查询汇总表格中删除一个因素。在最上面我们还可以看到是否应用到哪些过滤条件。



[image: ../../_images/d_browsr5.png]
我们可以通过点选工具栏上的MDX按扭来查询，就会在当前表格中弹出显示MDX查询结果。


[image: ../../_images/data_browser11.png]
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行列互换


报告一旦以多维方式生成，我们通过移动行到列的区域或者移动列到行的区域来交换行和列。这种操作同样适用于查询部分。


我们可以通过拖拉建立查询生成报告。


[image: ../../_images/data_browser8.png]


报告一经生成，我们通过调换然后就建立了如下所示的报告：


[image: ../../_images/data_browser9.png]
经过交换之后，我们可以拖入建立查询列表，并生成报告
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多维度的加载


Cube 浏览器提供了多维架构的选项，通过自带的工具栏一次点击就可以完成大部分常见的操作。


[image: ../../_images/data_browser1.png]
在工具栏的帮助下我们可以撤销重建查询，我们可以在图形示图和表格示图中来回切换，也可以展开全部内容或者分解各个元素。


架构组合框中可以显示所以的架构类型。


[image: ../../_images/d_browser1.png]
如果我们选择一个架构，架构组合框马上就会显示出属于这个架构的所有的多维数组。


[image: ../../_images/d_browser2.png]
当我们选择多维模式后，马上就会在下面空白处载入列表示图，我们也可以分解每个节点，然后依配置的级别显示出不同深度的内容。


[image: ../../_images/d_browser3.png]
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添加切片机


一个切片是过滤经过MDX查询被取出的数据。


可以通过点击右侧过滤器上的成员图像添加切片。


过滤器是提供给用户用来切分多维数据的强大工具，方便用户重组以及分析更加详细的信息。


这个数据过滤器允许用户以最低标准获取所需信息，并通过分析立体的多维数据获取最佳使用体验。


[image: ../../_images/data_browser10.png]
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图表


图表就把所呈现的表格结果以图形化的方式显示到绘制的轴线上。


让我们举一个例子：


[image: ../../_images/data_browser10.png]
针对上面的表格我们如果以图形化显示就变成如下效果：


[image: ../../_images/data_browser12.png]
当一个类别有子目录时，而另一个类别还没有生成结果时，将会有两个图形列表显示如下：


[image: ../../_images/data_browser17.png]
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上/下钻取



成员下钻


向下钻取的过程是成员扩大到子成员的目的，得到更广泛的分析数据.
用户可以可以通过下钻来定位成员.
仅仅是点击父成员去显示它的子成员.


[image: ../../_images/data_browser15.png]



成员上钻


上钻导致成员收起所有的子成员，当子成员在显示状态.
仅仅是点击父成员即可收起它的子成员.


[image: ../../_images/data_browser16.png]
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XML in open object



Introduction to the OpenObject Module


The OLAP  module is used to validate, run and format the output of MDXExamples/MDX Queries


The general flow is of OLAP module is shown in following diagram:


[image: ../../_images/Cube_olap_schema.png]



Explanation of the components






		Web-Services:		







This is the layer provided by the base of OpenERP, protocols: NET-RPC (fast binary), XML-RPC, over HTTP or HTTPS






		Services:		







Layer provided by OpenERP that provides: authentication (normal/ldap), user management, access rights, workflows, module management, ...






		MDX Parser:		







It parses the MDX query and converts it to the form of python objects. It uses Python’s pyparsing module to do this. It splits the query into form of objects of axis, level, sub level, slicer (if any) and measures.






		MDX Validator:		







Parses all the objects created and maps it to the browse object of OpenERP resource. For example, the axis object will receive a link to the OpenERP browse record on the related olap.axis object.






		MDX Runner:		







It will run the query on the basis of objects using SQLAlchemy and return different subsets.
On the basis of it the cube is made in matrix form.
And it fills the cube by values using axis mapping






		RDBMS connectors:


		 		







The layer provided by SQL Alchemy, it supports: mysql, postgresql, oracle, ...


The schema definition is in the OpenERP database.
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Creating Cube Definition using XML file



		
Things to know


		





Before going through XML details it is good to have an idea of all Terminologies  of OLAP.


Lets understand XML file in detail


Step: 1. The first step is to specify the database to use with parameters such as name, database name , database login and database password


<record model="olap.fact.database" id="fact_databases_BI">
     <field name="name">Tiny ERP databases</field>
     <field name="db_name">Sales</field>
     <field name="db_login">postgres</field>
     <field name="db_password">postgres</field>
</record>







		This will create the parameters needed to connect to the database.





Step: 2. Defining Schema


<record model="olap.schema" id="schema_main_sales">
     <field name="name">tinysales</field>
     <field name="state">none</field>
     <field name="database_id" ref="fact_databases_BI"/>
</record>







		This will create schema name tinysales for fact_database_BI made in step 1





Step: 3. Defining fact table to be used (In this case, sale_order_line)


<record model="olap.cube.table" id="table_sales_order_line">
     <field name="name">sale_order_line</field>
             <field name='schema_id' ref='schema_main_sales'/>
</record>






Step: 4. Making Cube on fact_table


<record model="olap.cube" id="cube_sales_order_line">
     <field name="name">sale_order_line</field>
     <field name="table_id" ref="table_sales_order_line"/>
     <field name="schema_id" ref="schema_main_sales"/>
</record>







		This will create the cube named sale_order_line





Step: 5. Creating Dimension product



		This will be used to fetch and make MDX Query on all the product





 <record model="olap.dimension" id="dimension_product_template">
      <field name="name">Products</field>
      <field name="cube_id" ref="cube_sales_order_line"/>
</record>

 <record model="olap.cube.table" id="table_product_template">
      <field name="name">product_product</field>
 </record>






Step: 5a. Creating Hierarchy for the Dimension Product


 <record model="olap.hierarchy" id="hierarchy_product_template">
      <field name="name">All Products</field>
      <field name="dimension_id" ref="dimension_product_template"/>
      <field name="primary_key_table">product_product</field>
      <field name="table_id" ref="table_product_template"/>
</record>






Step: 5b  Creating Level for the Dimension Product


First, we create column.


<record model="olap.database.columns" id="columns_product_product_default_code">
        <field name="name">default_code</field>
        <field name="column_db_name">default_code</field>
        <field name="type">varchar</field>
        <field name="table_id" ref="table_product_template>
        <field name="active">True</field>
</record>






Now, level.


 <record model="olap.level" id="level_product_template">
     <field name="name">default_code</field>
     <field name="column_name" ref="columns_product_product_default_code"></field>
     <field name="hierarchy_id" ref="hierarchy_product_template"/>
     <field name="table_name">res_partner</field>
     <field name="column_id_name">name</field>
</record>






Step: 6  Creating Dimension date_order up to the quarters


<record model="olap.dimension" id="dimension_sales_order">
    <field name="name">Order Date</field>
    <field name="cube_id" ref="cube_sales_order_line"/>
 </record>

 <record model="olap.cube.table" id="table_sales_order">
    <field name="name">sale_order</field>
 </record>

 <record model="olap.hierarchy" id="hierarchy_sales_order">
    <field name="name">Order Date</field>
    <field name="dimension_id" ref="dimension_sales_order"/>
    <field name="primary_key_table">sale_order</field>
    <field name="table_id" ref="table_sales_order"/>
 </record>

 <record model="olap.database.columns" id="columns_sale_order_date_order">
    <field name="name">date_order</field>
    <field name="column_db_name">date_order</field>
    <field name="type">date</field>
    <field name="table_id" ref="table_sale_order"/>
    <field name="active">True</field>
  </record>






Making levels in Order Date so to get details as per year, quarters and months.


<record model="olap.level" id="level_sales_order">
   <field name="name">date_order</field>
   <field name="column_name" ref="columns_sale_order_date_order"></field>
   <field name="column_id_name">date_order</field>
   <field name="type">date_year</field>
   <field name="sequence">1</field>
   <field name="table_name">sale_order</field>
   <field name="hierarchy_id" ref="hierarchy_sales_order"/>
</record>

<record model="olap.level" id="level_sales_order_q">
   <field name="name">date_order</field>
   <field name="column_name" ref="columns_sale_order_date_order"></field>
   <field name="column_id_name">date_order</field>
   <field name="type">date_quarter</field>
   <field name="sequence">2</field>
   <field name="table_name">sale_order</field>
   <field name="hierarchy_id" ref="hierarchy_sales_order"/>
</record>
<record model="olap.level" id="level_sales_order_m">
   <field name="name">date_order</field>
   <field name="column_name" ref="columns_sale_order_date_order"></field>
   <field name="column_id_name">date_order</field>
   <field name="type">date_month</field>
   <field name="sequence">3</field>
   <field name="table_name">sale_order</field>
   <field name="hierarchy_id" ref="hierarchy_sales_order"/>
</record>






Step: 7  Creating Dimension res_country


 <record model="olap.cube.table" id="table_sale_order">
   <field name="name">sale_order</field>
           <field name='schema_id' ref='schema_main_sales'/>
</record>

<record model="olap.cube.table" id="table_partner_address_0">
   <field name="name">res_partner_address</field>
   <field name='schema_id' ref='schema_main_sales'/>
</record>
<record model="olap.cube.table" id="table_partner_address_1">
   <field name="name">res_country</field>
   <field name='schema_id' ref='schema_main_sales'/>
</record>

<record model="olap.cube.table" id="table_partner_address">
   <field name="name">res_partner_address</field>
   <field name='schema_id' ref='schema_main_sales'/>
</record>

<record model="olap.cube.table" id="table_partner_country">
   <field name="name">sale_order_country</field>
   <field name='schema_id' ref='schema_main_sales'/>
</record>

<record model="olap.dimension" id="dimension_partner_country">
   <field name="name">Sales From Partners</field>
   <field name="cube_id" ref="cube_sales_order_line"/>
</record>

<record model="olap.hierarchy" id="hierarchy_partner_country">
   <field name="name">partner_country</field>
   <field name="dimension_id" ref="dimension_partner_country"/>
   <field name="primary_key_table">sale_order</field>
   <field name="table_id" ref="table_partner_country"/>
</record>

<record model="olap.level" id="level_partner_country">
   <field name="name">country_id</field>
   <field name="column_name" ref="columns_sale_order_date_order"></field>
   <field name="column_id_name">name</field>
   <field name="table_name">res_country</field>
   <field name="hierarchy_id" ref="hierarchy_partner_country"/>
</record>






Step: 8  Creating Dimension res_partner_address


  <record model="olap.database.columns" id="columns_res_partner_address">
            <field name="name">name</field>
            <field name="column_db_name">name</field>
            <field name="type">varchar</field>
            <field name="table_id" ref="table_sales_order"/>
            <field name="active">True</field>
</record>
 <record model="olap.cube.table" id="table_address">
    <field name="name">res_partner_address</field>
    <field name='schema_id' ref='schema_main_sales'/>
 </record>

 <record model="olap.cube.table" id="table_address_country">
    <field name="name">sale_order_country</field>
    <field name='schema_id' ref='schema_main_sales'/>
 </record>

 <record model="olap.dimension" id="dimension_partner_address_country">
    <field name="name">Sales by Order Address</field>
    <field name="cube_id" ref="cube_sales_order_line"/>
 </record>

 <record model="olap.hierarchy" id="hierarchy_partner_address_country">
    <field name="name">address_country</field>
    <field name="dimension_id" ref="dimension_partner_address_country"/>
    <field name="primary_key_table">sale_order</field>
    <field name="table_id" ref="table_address_country"/>
 </record>

 <record model="olap.level" id="level_address_country">
    <field name="name">country_id</field>
    <field name="sequence">1</field>
    <field name="column_name" ref="columns_res_partner_address"></field>
    <field name="column_id_name">country_id</field>
    <field name="table_name">res_partner_address</field>
    <field name="hierarchy_id" ref="hierarchy_partner_address_country"/>
 </record>

 <record model="olap.level" id="level_address_partner">
    <field name="name">partner_id</field>
    <field name="sequence">2</field>
    <field name="column_name" ref="columns_res_partner_address"></field>
    <field name="column_id_name">partner_id</field>
    <field name="table_name">res_partner_address</field>
    <field name="hierarchy_id" ref="hierarchy_partner_address_country"/>
  </record>






Step: 9  Creating Dimension res_user


 <record model="olap.database.columns" id="columns_res_user_name">
   <field name="name">name</field>
   <field name="column_db_name">name</field>
   <field name="type">varchar</field>
   <field name="table_id" ref="table_sales_order"/>
   <field name="active">True</field>
</record>

<record model="olap.dimension" id="dimension_sales_user">
   <field name="name">user</field>
   <field name="cube_id" ref="cube_sales_order_line"/>
</record>

<record model="olap.cube.table" id="table_sales_res_users">
   <field name="name">res_users</field>
</record>

<record model="olap.hierarchy" id="hierarchy_sales_user">
   <field name="name">user</field>
   <field name="dimension_id" ref="dimension_sales_user"/>
   <field name="primary_key_table">res_users</field>
   <field name="table_id" ref="table_sales_res_users"/>
</record>

<record model="olap.level" id="hierarchy_sales_user_level">
   <field name="name">name</field>
   <field name="column_name" ref="columns_res_user_name""></field>
   <field name="hierarchy_id" ref="hierarchy_sales_user"/>
</record>






Step: 10  Creating Measures Item Sold and Total Sold


  <record model="olap.database.columns" id="columns_sale_order_line_product_uom_qty">
              <field name="name">product_uom_qty</field>
              <field name="column_db_name">product_uom_qty</field>
              <field name="type">numeric</field>
              <field name="table_id" ref="table_sale_order_line"/>
              <field name="active">True</field>
  </record>

 <record model="olap.measure" id="measure_item_sold">
      <field name="name">Items Sold</field>
      <field name="cube_id" ref="cube_sales_order_line"/>
      <field name="value_column" ref="columns_sale_order_line_product_uom_qty"></field>
      <field name="value_column_id_name">product_uom_qty</field>
      <field name="table_name">sale_order_line</field>
      <field name="agregator">sum</field>
 </record>
 <record model="olap.measure" id="measure_total_sales">
      <field name="name">Total Sold</field>
      <field name="cube_id" ref="cube_sales_order_line"/>
      <field name="value_column" ref="columns_sale_order_line_price_unit"></field>
      <field name="value_column_id_name">price_unit</field>
      <field name="table_name">sale_order_line</field>
      <field name="agregator">sum</field>
</record>
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OLAP


Online Analytical Processing (OLAP) means analysing large quantities of data in real-time. Unlike Online Transaction Processing (OLTP), where typical operations read and modify individual and small numbers of records, OLAP deals with data in bulk, and operations are generally read-only. The term ‘online’ implies that even though huge quantities of data are involved — typically many millions of records, occupying several gigabytes — the system must respond to queries fast enough to allow an interactive exploration of the data. As we shall see, that presents considerable technical challenges.


OLAP performs multidimensional analysis of business data and provides the capability for complex calculations, trend analysis, and sophisticated data modeling. Whereas a relational database stores all data in the form of rows and columns, a multidimensional dataset consists of axes and cells.
Consider the dataset













		Year
		2000
		 
		2001
		 
		Growth
		 





		Product
		Dollar sales
		Unit sales
		Dollar sales
		Unit sales
		Dollar sales
		Unit sales



		Total
		$7,073.00
		2693
		$7,636.00
		3008
		8.00%
		12.00%



		Books
		$2,753.00
		824
		$3,331.00
		966
		21.00%
		17.00%



		Fiction
		$1,341.00
		424
		$1,202.00
		380
		-10.00%
		-10.00%



		Non-fiction
		$1,412.00
		400
		$2,129.00
		586
		51.00%
		47.00%



		Magazines
		$2,753.00
		824
		$2,426.00
		766
		-12.00%
		-7.00%



		Greetings cards
		$1,567.00
		1045
		$1,879.00
		1276
		20.00%
		22.00%







The rows axis consists of the members ‘All products’, ‘Books’, ‘Fiction’, and so forth, and the columns axis consists of the cartesian product of the years ‘2000’ and ‘2001’, and the calculation ‘Growth’, and the measures ‘Unit sales’ and ‘Dollar sales’. Each cell represents the sales of a product category in a particular year; for example, the dollar sales of Magazines in 2001 were $2,426.


This is a richer view of the data than would be presented by a relational database. The members of a multidimensional dataset are not always values from a relational column. ‘Total’, ‘Books’ and ‘Fiction’ are members at successive levels in a hierarchy, each of which is rolled up to the next. And even though it is alongside the years ‘2000’ and ‘2001’, ‘Growth’ is a calculated member, which introduces a formula for computing cells from other cells.


The dimensions used here — products, time, and measures — are just three of many dimensions by which the dataset can be categorized and filtered. The collection of dimensions, hierarchies and measures is called a cube.


The above simple example or outlook shows how one can get the smallest details from the data stored for years in the database in form of relation. It helps in managing resources, forming policies , budgeting , Business Process Management, designing strategic marketing policies, forecasting and many more. The options are endless.


The multidimensional is above all a way of presenting data. Although some multidimensional databases store the data in multidimensional format, I shall argue that it is simpler to store the data in relational format and manipulate it using OLAP.



Who uses OLAP and Why?


OLAP applications span a variety of organizational functions. Finance departments use OLAP for applications such as budgeting, activity-based costing (allocations), financial performance analysis, and financial modeling. Sales analysis and forecasting are two of the OLAP applications found in sales departments. Among other applications, marketing departments use OLAP for market research analysis, sales forecasting, promotions analysis, customer analysis, and market/customer segmentation. Typical manufacturing OLAP applications include production planning and defect analysis.


Important to all of the above applications is the ability to provide managers with the information they need to make effective decisions about an organisation’s strategic directions. The key indicator of a successful OLAP application is its ability to provide information as needed, i.e., its ability to provide “just-in-time” information for effective decision-making. This requires more than a base level of detailed data.


Just-in-time information is computed data that usually reflects complex relationships and is often calculated on the fly. Analyzing and modeling complex relationships are practical only if response times are consistently short. In addition, because the nature of data relationships may not be known in advance, the data model must be flexible. A truly flexible data model ensures that OLAP systems can respond to changing business requirements as needed for effective decision making. Although OLAP applications are found in widely divergent functional areas, they all require the following key features:



		Multidimensional views of data


		Calculation-intensive capabilities


		Time intelligence






Multidimensional views of data


Multidimensional views are inherently representative of an actual business model. Rarely is a business model limited to fewer than three dimensions. Managers typically look at financial data by scenario (for example, actual vs. budget), organization, line items and at sales data by product, geography, channel, and time.


A multidimensional view of data provides more than the ability to “slice and dice”; it provides the foundation for analytical processing through flexible access to information. Database design should not prejudice which operations can be performed on a dimension or how rapidly those operations are performed. Managers must be able to analyze data across any dimension, at any level of aggregation, with equal functionality and ease. OLAP software should support these views of data in a natural and responsive fashion, insulating users of the information from complex query syntax. After all, managers should not have to understand complex table layouts, elaborate table joins, and summary tables.


Whether a request is for the weekly sales of a product across all geographical areas or the year-to-date sales in a city across all products, an OLAP system must have consistent response times. Basic aggregation is performed on some of the dimensions (product, customer, and channel). More complex calculations are performed on other dimensions. The measure dimension computes ratios and averages. Variances are computed along the scenario dimension. A complex model based on historical performance is used to compute the forecast scenario. Consistently quick response times to these kinds of queries are key to establishing a server’s ability to provide multidimensional views of information.





Calculation-intensive capabilities


The real test of an OLAP database is its ability to perform complex calculations. OLAP databases must be able to do more than simple aggregation. While aggregation along a hierarchy is important, there is more to analysis than simple data roll-ups. Examples of more complex calculations include share calculations (percentage of total) and allocations (which use hierarchies from a top-down perspective).


Key performance indicators often require involved algebraic equations. Sales forecasting uses trend algorithms such as moving averages and percentage growth. Analyzing the sales and promotions of a given company and its competitors requires modeling complex relationships among the players. The real world is complicated – the ability to model complex relationships is key in analytical processing applications.


Whereas transaction processing systems are judged on their ability to collect and manage data, analytical processing systems are judged on their ability to create information from data.





Time intelligence


Time is an integral component of almost any analytical application. Time is a unique dimension because it is sequential in character (January always comes before February). True OLAP systems understand the sequential nature of time. Business performance is almost always judged over time, for example, this month vs. last month, this month vs. the same month last year.  The time hierarchy is not always used in the same manner as other hierarchies. For example, a manager might ask to see the sales for May or the sales for the first five months of 1995. The same manager might also ask to see the sales for blue shirts but   would never ask to see the sales for the first five shirts. Concepts such as year-to-date and period over period comparisons must be easily defined in an OLAP system.


In addition, OLAP systems must understand the concept of balances over time. For example, if a company sold 10 shirts in January, five shirts in February, and 10 shirts in March, then the total balance sold for the quarter would be 25 shirts. If, on the other hand, a company had a head count of 10 employees in January, only five employees in February, and 10 employees again in March, what was the company’s employee head count for the quarter? Most companies would use an average balance. In the case of cash,    most companies use an ending balance.
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项目的目标


用简单的话来说，商业智能，简称BI，是获取原始数据的行为，然后将数据转化为可深化挖掘及应用的信息，用以提高业务水平。因此，BI的目标是，使决策者们能够更好，更快地决策。毕竟**选择决定命运！**


一般而言，任何商业智能解决方案都必须提供：



		商业智能面临的第一个挑战如何收集有关业务所需的数据。采集数据过程的关键是要使其自动化。以往收集数据是比较费时费力的，但使用现代的计算机系统，能够更容易地从各种渠道收集到数据。


		商业智能的第二个任务是对收集到的数据进行分析，并从中提取信息。然后将提取到的信息变成业务知识。


		商业智能的第三个也是最后的任务是使用新收集的业务知识来提高业务水平。





关于OpenObject BI我们的目标是提供基于Python的BI解决方案，它可以：



		提供了所有的BI功能。


		以最少的步骤快速地创建Cube。


		访问任意类型的数据库来生成 Schema 和 Cube.


		报告在OpenOffice中直接可以使用。


		使一切成为易于扩展的对象。
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术语


本页对所有术语进行定义。 在OLAP多维数据集的对象使用本约定。



Schema


A schema is a collection of N dimensions. It’s the meta description
of cubes..





Hierarchy


A schema is divided in hierarchy, which are divided in dimensions.
The main use of hierarchy is to check that different axis can not
use dimensions of the same hierarchy.





Dimension


A dimension is an attribute, or set of attributes, by which you can
divide measures into sub-categories. It’s a tree structure that
define the axis of the cube. They can be explicitly defined:
partner_id.country_id.state_ids or recursive ‘parent_id’.
A dimension is divided in levels.





Level


One level of sub-categories defined by dimensions.





Measure


Meta data of the quantity your are measuring. (value)
A measure may be complex, ex: the tuple (quantity,uom)
Attributes which are also objects:



Agregator: an SQL function that define how we aggregate measures
“sum”, “count”, “min”, “max”, “avg”, and “distinct-count”
FormatString
DataType (the measure/value datatype)






Cube


A cube is a collection of N axis. A cube is an instance of a schema.
A cube is mapped to a ‘SQL’ query through the use of his axis. (or several)





Member


A member is a point within a dimension determined by a particular set of
attribute values. (instances) A member is able to compute a part of the
SQL query.





Axis


An axis is composed by one or a set of members. In others terms, the axis is
defined by the part of the query preceding the “on rows”, “on columns”,
“on pages”... The MDX result is also a cube composed of axis.





Value


A value is an instance of a measure. (one particular case of the cube).
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配置接口


主要目标的任何用户连接到OpenObject BI是获取数据从数据库使用强大的MDX查询。


运行任何MDX查询需要作出一个立方体,用户可以定义/配置他们自己的自定义多维数据集使用两个接口:



介绍


默认情况下,立方体设计师显示所有模式在树形式和提供选项来添加新模式


[image: ../../_images/1.png]


创建模式:模式定义了数据库的数据被取出。它给了一个有意义的名称到数据库的连接:


[image: ../../_images/2.png]


数据库连接参数指定用于连接到数据库。它通常包含类型的数据库(postgres、oracle、mysql)、用户名、密码、数据库使用:


[image: ../../_images/3.png]


一旦我们配置数据库连接下一步是加载数据库使用内省。这将加载数据库的结构。通过结构我们意味着表、列和关系。这将帮助定义多维数据集很容易。随着结构被加载将没有对数据库的查询一次又一次的:


[image: ../../_images/4.png]


下一步是配置加载数据库。这是有用的隐藏不必要的表和列。如果数据库是OpenERP它可以自动配置:


[image: ../../_images/4a.png]


一旦创建多维数据集模式是我们可以开始创建多维数据集:


[image: ../../_images/5.png]


立方体是结构,基于模式(数据库),它将配置如何检索数据:


[image: ../../_images/6.png]


多维数据集需要事实表定义。事实表是关键的表中存储,我们可以措施部门其他表的其他参数。例如,我们可以定义销售订单销售作为我们的事实表,因为它会给销售的细节。事实表的表可以加入。
事实表是给出一个有意义的名字:


[image: ../../_images/7.png]


这个立方体屏幕将会是:


[image: ../../_images/8.png]


我们可以决定在多维数据集的维度用于多维数据集。例如我们要看产品销售、日期、城市等方法分析了相应的销售。
我们决定要使用的措施,例如项目出售。所以我们可以决定维度和措施:


[image: ../../_images/9.png]


添加维度的产品。所以我们将能够看到产品明智的项目出售:


[image: ../../_images/10.png]
我们将解释如何在维度获取产品详细信息的层次结构。这需要配置事实表:


[image: ../../_images/12.png]


在添加层次我们决定从哪个字段产品名称将:


[image: ../../_images/14.png]


完全配置多维数据集的树将看起来像:


[image: ../../_images/15.png]



连接至现有数据库


一个可以很容易地连接到一个现有的数据库。要求的细节是



		Fact Name : Logical Name of the database


		Database Name: Physical Database name to be used


		Database type : Type of the database it can be PostgreSQL, MySQL, Oracle etc.


		Connection type : Port or Socket


		Database Host : Server name like localhost


		Database Port : Port to be used for making connection to the database


		Database Login: Login name for accessing a database


		Database Password:Password for the user in login







Giving this detail will generate a string like ‘’postgres://postgres:postgres@localhost:5432/terp’‘




生成的字符串,是一个连接字符串让连接到数据库。





写作模式



		
What is Schema ?


		





模式意味着形状,或更普遍而言,计划。上下文中的OpenObject BI它定义了逻辑模型,由立方体、层次结构和成员,和一个映射到该模型的物理模型。


逻辑模型包括构造用于编写查询MDX语言:立方体、维度、层次结构的水平,和成员。


物理模型数据的来源,提出了逻辑模型。这通常是一个星型模式,这是一组关系数据库表中;之后,我们将看到其他类型的映射的例子。



制造模式


在OpenObject BI架构在一个XML文件表示。它可以被设计OpenERP的方式做。XML文件的细节可以看到在 创建XML
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对用户意味什么?


Open Object Business Intelligence系统的目标是成为一个全功能的用Python编写的开源商业智能系统。 It implements a HOLAP (Hybrid OLAP = ROLAP + MOLAP) cube and a MDX query engine based on SQLAlchemy.


相对当前市面上大多数的business intelligence 软件, 我们的目的是生产一个针对中端市场的BI。 它意味着:



对最终用户而言:



		使用起来方便及快捷: 简单的web界面，不需依赖其它软件，并且可以集成到所有软件中。它应该保留一个OpenOffice接口以创建复杂的报表。


		容易安装: 在Windows和Linux中都可自动化安装，极少依赖其它软件。


		在OpenERP中集成，但并不被依赖。








对管理员用户而言:



		OpenERP内部的全方面设计器


		容易配置: Automatic cube definition (5 clicks, using introspection on database),


		容易维护: The application must be sufficiently intelligent that it requires no fine tuning in cube definition,
runs well on bad indices, with no need for explicitly defined aggregated tables, or defined axes.


		无需开发者干预: 最终用户可以通过界面完成所有事情。








对开发者而言:



		就像OpenERP一样，所有东西 (dimensions, ) 必须是一个模块中面向对象的，允许你自己增加代码来扩展软件。


		它必须支持主流的数据库引擎并且可集合多个数据库: PostgreSQL, MySQL, Oracle, MSSQL 等等... 使任意应用都能取得数据以生成报表。
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运行一个自动分析案例


我们可以在命令行上核对所有的查询 CLI


例如我们可以创建 一个名为*test_query* 的类似下面内容的文件




DATABASE='terp'






./tinybi.py -d ${DATABASE} -H localhost -U admin -W admin -p 8069 -s "tinyerp" -c "select <br />{[user].[all]} on rows, {[measures].[credit_limit],[measures].[count]} <br />on columns from res_partner"






./tinybi.py -d ${DATABASE} -H localhost -U admin -W admin -p 8069 -s "tinyerp" -c "select <br /> {[measures].[credit_limit],[measures].[count]} on rows, {[user].[all],[user].children} <br /> on columns from res_partner"








这个文件可以在命令提示符下运行.就会输出成功或失败的错误信息


通过多维示例视窗可以查看test_query的输出结果
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命令行界面



命令行界面引言


CLI－命令行界面


命令行界面类似于psql，但在cube上被用来MDX查询。
例如：


Welcome to OpenObject BI , the interactive terminal.
Communication: XML-RPC.
Type: \? for help with MDX commands
     \e for execute the MDX query
     \d for quit
BI-terp=#






通常我们可以使用CLI测试不同的查询，它也可以被用来运行自动测试。


基本的测试查询语法是:


./tinybi.py -d <<Database Name>> -H localhost -U <<User Name> -W <<Password>> -p <<Port Number>> -s <<Schema Name>> -c <<MDX Query>>


你可以通过输入如下内容核对所有参数


$python tinybi.py –help


Usage: tinybi.py [options]


参数:


--version             show program's version number and exit
-h, --help            show this help message and exit






常用参数:
  -c COMMAND, --command=COMMAND
                      The query to execute
  -s SCHEMA, --schema=SCHEMA
                      The schema to use for the query






连接参数:
  -d DATABASE, --database=DATABASE
                      Database name
  -H HOSTNAME, --hostname=HOSTNAME
                      Server hostname
  -U USERNAME, --username=USERNAME
                      Username
  -W PASSWORD, --password=PASSWORD
                      Password
  -p PORT, --port=PORT
                      Server port










		示例:		







./tinybi.py -d “terp” -H localhost -U admin -W admin -p 8069 -s “tinyerp” -c “select {[user].[all]} on rows, {[measures].[credit_limit],[measures].[count]} on columns from res_partner”


将会在命令行界面输出如下结果:









		 
		credit_limit
		count





		All user
		[66700.0]
		[21.0]
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报告


下面是一个测试查询所生成的报告样式：


                            贷方限度                 总计数
所有的用户                   [66700.0]               [21.0]






             所有的用户
             Root                                 Administrator      Demo User
贷方限度      [66700.0]                            [2700.0]           [49000.0]
计数         [21.0]                               [2.0]              [6.0]
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网络服务接口


开源项目的另珍上要素是 - BI, 允许应用程序通过网络服务接收三维数据. Applications issue XML-based queries across a Web-based connection using XML-RPC. Support is focused on XML query languages rather than on OLAP language.


By providing a flexible, platform-neutral method to render diverse data types, XML has become a standard for exchanging information across heterogeneous applications. Web services, a set of XML based protocols for finding and communicating between loosely-coupled, internet callable application “services” have therefore become the preferred mechanism for integrating heterogeneous applications and enabling service architectures.


The use of XML and Web services for data exchange and integration provides significant IT benefits including flexibility, interoperability and reach.
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MDXOverview


MDX stands for Multidimensional Expressions. You use it to query OLAP databases. In a nutshell, MDX is to OLAP databases as SQL queries are to relational databases.


OLAP databases primarily consist of OLAP cubes, which store fact tables, measures (such as sales, purchase, etc.) and dimensions/hierarchies. An OLAP database is often an aggregation of a relational database; as a result, you can write MDX queries to retrieve key calculations that measure company performance, often with less code than standard SQL.


Because of the nature of OLAP databases, we need to write MDX code to retrieve data in far fewer lines of code than would be required using SQL. This is a segue into the role that OLAP databases and MDX play in the world of business intelligence.


MDXAlchemy is developed taking care of all the aspects of becoming a complete OLAP Engine, to execute MDX query and fetch data efficiently. MDXAlchemy is a complete MDX engine that provides your database with full MDX capabilities.


MDXAlchemy use the services of SQLAlchemy to provide some of the important features that makes MDXAlchemy a fully capable MDX Engine. The major is removing the clause of database dependency.


The dimensional meta data facility addresses the issue that although the application stores dimensional data in relational tables (usually in the form of fact and dimension tables), the user does not have to be aware of the dimensionality, or OLAP semantics, of this data. It provides a comprehensive meta data facility to define these semantics and an XML capability to enable meta data interchange with other external OLAP products.



Independent yet Integrated to OpenERP


MDXAlchemy engine is totally independent of OpenERP and does not rely on OpenERP modules for its functionality.
Yet being so diversified from OpenERP, it is fully integrated to OpenERP.


MDXAlchemy can be installed/integrated as an internal module of OpenERP and make itself available to assist OpenERP.


It is made of two major components, a cube engine and SQL Alchemy. It uses SQL Alchemy for connecting to the database while the cube engine processes the data to form the cube for the user.





Supported Databases


OpenObject BI takes care of independent database functionality.


It supports connectivity with most of the leading Database programs.


Just a compatible Dialect and valid connection parameters are all that is needed to use a database.


The Dialect is used to describe how to talk to a specific kind of database. Dialects are included with SQLAlchemy for SQLite, Postgres, MySQL, MS-SQL, Firebird, Informix, and Oracle; these can be described as Python modules present in the sqlalchemy.databases package. Each dialect requires the appropriate DBAPI drivers to be installed separately.


Downloads for each DBAPI to connect to supported Databases are as follows:



		Postgres: psycopg2 [http://www.initd.org/tracker/psycopg/wiki/PsycopgTwo]


		SQLite  : pysqlite [http://initd.org/tracker/pysqlite]


		MySQL   : MySQLDB [http://sourceforge.net/projects/mysql-python]


		Oracle  : cx_Oracle [http://www.cxtools.net/default.aspx?nav=home]


		MS-SQL  : pyodbc [http://pyodbc.sourceforge.net]  (recommended) adodbapi pymssql


		Firebird:  kinterbasdb [http://kinterbasdb.sourceforge.net/]


		Informix:  informixdb [http://informixdb.sourceforge.net/]
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菜单组织规则


菜单应该适应一个业务应用。每个用户应该都能看到他所需要的菜单。用户应该可以只用在一个菜单中完成他们的工作。这也是所有业务应用的目标。用户应该能够在一个菜单中完成他所有的工作流程，使他的工作变得更容易，更快速和更友好的导航。


菜单应该定义为某种方式，让用户的工作更加容易。因此，用户应该看到按照逻辑顺序排列的所有菜单，以方便导航和使用。如一位销售代表在作出报价之前，并不需要看到发票。


主菜单的组织同样也是为了方便经理工作。实际上在中小企业中，经理往往需要访问许多应用：销售、项目管理、人力资源、市场营销和财务。当他打开 OpenERP 之后，他应该看到井井有条的菜单。
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应用套件介绍


一个完整复杂的 ERP 系统通常包含了大量的功能。而根据他们在公司的工作岗位的不同，大多数用户往往只能用到少量一些功能。为了保持简单易用，这些功能分成不同的模块应用。


其主要思想是用户往往在一个特定岗位工作（如为某个项目工作，会计分录等）。当这个用户处于这样的情况下，他应该直接看到有关这方面的全部功能。我们试图创建各个不同的模块，按照用户的工作职位划分：业务员，项目用户，采购商，会计师等。



Note


注意OpenERP的模块和应用套件之间的区别。模块是从技术上将一组功能打包在一起。应用套件则包括了所有的功能，根据该公司在一个特定的角色创建一系列的菜单。一个应用程序通常是由数个模块组成。




这些业务应用定义了工作场景和相关的全部术语，因此就很容易理解：采购员可以看到订购相关的屏幕，而一个会计也许可以在财务会计屏幕中看到相同的数据（自动匹配术语、自动匹配菜单、每个屏幕自动匹配默认值）


例如，采购员可以看到以下菜单：



		
		采购


		
		询价单


		采购订单














		
		地址薄


		
		供应商














		
		发票管理


		
		供应商发票














		
		库存管理


		
		收货

















应用套件显示在红色的顶部菜单栏，相关的菜单显示在屏幕左侧。



[image: ../../_images/1.1menu_application.png]


这就意味着一个特定用户可以只需要在一个菜单工作。


不同的菜单可能指向一个相同的视图（自动匹配默认值），因为可能会被不同的应用套件使用。如，仓库管理员应该看到以下菜单：



		
		仓库管理


		
		入库


		内部调拨


		送货单

















上例中，“入库” 菜单在 ”仓库管理“ 和 ”采购管理“ 中都是可用的。”供应商“ 菜单在”会计“套件中被视为 ”合作伙伴“，而”合作伙伴“是包含供应商和客户的。这样，在不同的应用套件中该术语是自动匹配的。
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模块介绍
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OpenERP 视图
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日历视图
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Form 视图
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列表视图
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搜索视图 （注：OE7搜索视图巨变，此章暂且不译）



简介


As previously  mentioned, OpenERP is developing within a business framework and vision. OpenERP’s users can find business applications, in which they can surf on some of the business oriented views. In this search view they will also find that it facilitates the work and the search of the user.


Search views in OpenERP allow the responsible user to search in only one view. Indeed, a Sales Responsible user, can see, in the same view, his created documents (sale orders) and, if he is allowed, the one created by his colleagues. So, in Sales Order menuitem, he can see all quotations, current sales and sales to invoice.



Note


search views are present in some of the types of views. There is a search part in calendar view, in list view and  in statistic reports.




The terminology used to qualify each element of the search view are related to both the application and business context. For example, in sale order, there are buttons to filter different states. Instead of using a state label “Draft”, we use a more suitable label for the sales context which is “Quotations”.





搜索视图组件


许多选项提供给用户以优化他们的搜索.按钮用来快速进行重要单据的过滤、分组。 通常,一个按钮用来选择单据类型. 我们可以看看一个例子,在销售订单,用户能快速地看到他所需的报价单这点非常重要.


在所有的搜索视图中，也有一些可选的搜索字段. 这些字段通常选择有关对象的重点 (关联到列表视图的列). 例如我们看到的，在销售订单视图, 销售员能看到只有一个客户相关的销售。



[image: ../../_images/3.1.main_fields.png]


有些按钮允许用户按元素分组，例如，销售员能根据客户分组和查看他们所制作的每个客户的所有销售单。



[image: ../../_images/3.2group_by.png]


Finally, OpenERP allows users to search following most of the elements we can find in form view with personal filter. Thanks to these filters, we can lighten and clear the view. If users want see all leads that come from one state in the United-States, they can add a filter easily and then save it as a preference, this is especially useful if they have to use it often.



[image: ../../_images/3.3.other_fields.png]



Note


In extended view, in some search views, there are extended filters. These are used to allow user filtering on important elements but are not specific to a              list view. For example, in Leads, there is not the Lead’s country in the Lead list view, but, it regularly happens that Salesman want to filter all Leads               by a specific country. It also allows you to modify columns of the list view by adding one. This kind of field is only on the extended interface and not in all                 search views. Our goal is to simplify, so if it is not necessary, there are no extended filters. A user can always use a personal filter.





[image: ../../_images/3.4.extended_filters.png]
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© Cancel Purchase Order

& print
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多公司结构



多公司


我们定义三个公司。其中一个是母公司(OpenERP)，另外两个是子公司(OpenERP Belgium 和 OpenERP France)。


一方面，两个子公司用来供应商品。另一方面，母公司用来聚合OpenERP France 和 OpenERP Belgium 的不同信息。



[image: ../../../../_images/company_structure.png]
公司结构





Tip


用户组


要查看公司的结构，你必须把用户加入到组  易用性/多公司 中.




对于母公司和子公司有不同的配置（对于子公司，不要忘记加入到上级公司中）：



[image: ../../../../_images/child_company.png]
多公司基本配置







会计科目表


对每个公司，你必须定义一个会计设置。要做到这点，进入 会计 ‣
配置 ‣ 财务会计 ‣ 新公司财务设置.



[image: ../../../../_images/accounting_charts.png]
创建会计科目表





Note


会计计划


每个公司能拥有他们自己的特殊的会计科目表。







用户,供应商与客户


用户 是用来登录进系统，给了每个人适当的访问权限。这个概念不同于在人力资源模块创建的员工。


每个公司需要一个用户来管理不同的操作完成这些流程。你能为每个公司创建一个用户，但是不要忘记，在 公司 标签加入公司后，在用户表单
的 联系人  中 选择适当的公司。



[image: ../../../../_images/user_1tab.png]
Defining Users part 1





[image: ../../../../_images/user_2tab.png]
Defining Users part 2




In addition to the user, the companies need suppliers and customers. For OpenERP France, you can define one customer who will
order the product that will be defined later, and for OpenERP Belgium, you can define one supplier who will deliver the product to
the company.


The customers and suppliers go in the same object called Partners which can be classified in three ways: customer, supplier and
customer and supplier. This has the advantage that you have to update address data only once.




		Customer: log in with the user of OpenERP France, then go to Sales ‣ Address Book ‣ Customers










[image: ../../../../_images/customer_1tab.png]
客户定义 第1部分





[image: ../../../../_images/customer_2tab.png]
客户定义 第2部分





		Supplier: log in with the user of OpenERP Belgium, then go to Purchases ‣ Address Book ‣ Suppliers














[image: ../../../../_images/supplier_1tab.png]
定义供应商 第1部分





[image: ../../../../_images/supplier_2tab.png]
定义供应商 第2部分
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管理仓储


In our configuration, we have to define the way in which we will store the products.


The stock will be managed by OpenERP Belgium that will share the products with the other companies. OpenERP France will manage the
sales part for these products.


OpenERP France will “transfer” the sales order to OpenERP Belgium that will ship the goods to the customer.


By default, OpenERP creates some locations and warehouses for the first company. As a consequence, we have to create
the other warehouses and locations for our child companies. We will start by creating the warehouses, then we will define
specific locations and we will finish by setting up the of shops.



仓库


In OpenERP, a warehouse represents your places of physical stock. A warehouse can be structured into several locations at multiple
levels.


We have to create three new warehouses. One for OpenERP, one for OpenERP Belgium and one for OpenERP France.



[image: ../../../../_images/warehouse.png]
仓库




Go to Warehouse ‣ Configuration ‣ Warehouse Management ‣ Warehouses and create the different warehouses
according to the parameters shown in picture Warehouse Parameters.



[image: ../../../../_images/warehouse_fr.png]
Warehouse Parameters







库位


Locations are used to manage all types of storage places, such as at the customer and production counterparts.


In order to store products, we will create one location for the two child companies. It will support the flow of goods between
those companies.



[image: ../../../../_images/locations.png]
库位定义




Go to Warehouse ‣ Configuration ‣ Warehouse Management ‣ Locations and create the different locations with
the parameters defined in the picture Location Parameters.



[image: ../../../../_images/location_fr.png]
Location Parameters







门店


OpenERP France needs a shop. The objective of this shop is to allow OpenERP France to receive orders from customers and then send
it to OpenERP Belgium for the delivery of the products.



[image: ../../../../_images/shop_fr.png]
门店定义




Go to Sales ‣ Configuration ‣ Sales ‣ Shop to define a shop for OpenERP France.
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产品



基础数据


目前我们可以定义不同的角色，可以将计划在法国销售的产品存储在比利时，进入菜单选项，选择销售->产品-> 然后根据下列的详细参数创建一个新产品



[image: ../../../../_images/product1.png]
Defining Products




In the Suppliers tab, you can select the supplier defined above. In the tab Logistical Flows, we will define
the different flows in order to share the different objects between the companies. To order the product in Belgium from a sales order made in France, we will define a Pull flow.





Flows


In our process, we have to create a pull flow, because the process begins with a need from OpenERP France. OpenERP France needs some
products ordered by the customers.


The flow will go through our two child companies. The starting point is OpenERP Belgium that will supply OpenERP France that will
supply the goods to the customer.


We can draw the process like this: Customer <– [OpenERP France] <– [OpenERP Belgium] <– Supplier



[image: ../../../../_images/pull_flow_def.png]
Pull Flow Definition
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Web 服务安装


要安装 BI 的Web服务，需要准备下面这些来搭建运行环境:



		Turbogears 扩展的最新版本


		BI-Web服务的源代码
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BI 安装


BI 需要安装 OpenERP Server 并且最好使用 OpenERP GTK 客户端。




		安装 OpenERP 服务器及 OLAP 模块


		Web 服务安装
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Introduction to the OpenObject Module


The OLAP module is used to validate, run and format the output of MDXExamples


The following diagram shows the general flow of the OLAP module:


[image: ../../_images/Cube_olap_schema1.png]

Explanation of the components



Web-Services


This is the layer provided by the base of OpenERP, protocols: NET-RPC (fast binary), XML-RPC, over HTTP or HTTPS





Services


Layer provided by OpenERP that provides: authentication (normal/ldap), user management, access rights, workflows, module management, ...





MDX Parser


It parses the MDX query and converts it to the form of python objects. It uses Python’s pyparsing module to do this. It splits the query into form of objects of axis, level, sub level, slicer (if any) and measures.





MDX Validator


Parses all the objects created and maps it to the browse object of OpenERP resource. For example, the axis object will receive a link to the OpenERP browse record on the related olap.axis object.





MDX Runner


It will run the query on the basis of objects using SQLAlchemy and return different subsets.
On the basis of it the cube is made in matrix form.
And it fills the cube by values using axis mapping





RDBMS connectors


The layer provided by SQL Alchemy, it supports: mysql, postgresql, oracle, ...


The schema definition is in the OpenERP database.
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安装 Open Object


安装BI需要 :



		获得然后运行 OpenERP Server [http://openerp.com/wiki/index.php/InstallationManual/HomePage]


		获得 SQLAlchemy-0.3.11 [http://sourceforge.net/projects/sqlalchemy/SQLAlchemy-0.3.11]





Once everything is working i.e. OpenERP Server and OpenERP Client we need to add OLAP module in Server.


Steps to install OLAP modules.



For server module:





		First install the Bazaar on your Linux box (apt-get install bzr) then “cd” to /usr/
local/src folder or other, as you work usually.


		Get the Launchpad’s BI branch with the command:
From : https://code.launchpad.net/~openerp/openobject-addons/trunk bzr branch lp:openobject-addons This openobject-addons
contain the bi in Olap modules










BI WEB客户端:



		https://code.launchpad.net/~openerp-dev/openobject-client-web/trunk-dev-web-bi


		bzr branch for client-web-bi lp:~openerp-dev/openobject-client-web/trunk-dev-web-bi


		Get SQLAlchemy-x.x.x.tar.gz from sourceforge.net and untar (tar –xzvf file_name) it to
the /usr/local/src folder then cd to /usr/local/src/ SQLAlchemy-x.x.x and run ‘’python
setup.py install’’


		The SQLAlchemy install will push all that we need to the /usr/lib/python2.5/site-
packages/SQLAlchemy-0.5.2-py2.5.egg, ‘’cd’’ to this folder and do the “zip” like this:


		zip /somewhere/sqlalchemy.zip -r sqlalchemy


		Move or copy (mv or cp) the sqlachemy.zip to the openerp-server addons folder (/usr/lib
/python2.5/site-packages/openerp -server/addons) and unzip the file within.


		Check also the owner and the rights of ~/addons folder, as I run the openerp-server
with postgres user I switched the ~/addons owner to ‘’chown -R postgres addons’’


		Retrieve all the olap’s ‘’zip’’ files and import/install them to OpenERP v5.










Windows环境安装包:



		http://bazaar.launchpad.net/~openerp/openerp/win-installer-trunk/files/head%3A/dependencies/
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架构


[image: ../../_images/Bi_arch.png]



组件



The Cube


cube 基于以下组件:



		
		MDX解析器将把MDX表达式转换为RDBMs查询:


		
		
		使用交叉混合计算:


		
		使用星型/雪花模式，在mondrian里 (基于joins)


		使用空间层次切割，比如在cubulus里


























		
		内存缓存系统


		
		空间层次 (空间纬度切割)














		
		聚合系统


		
		能够创建汇总表，以加快查询速度 (自动的或者用户定义的)


		查询将计算事实数据表或汇总表














		一条（或几条）MDX 输出结果








cube将使用:



		所有数据库通信：SQLAlchemy


		扩展接口：XML-RPC


		MDX解析：PyParser








CLI 接口


CLI命令行接口允许用户测试MDX查询. 简单的python脚本
将发送XML -RPC查询并显示出结果.





Cube 定义


定义Cube的元数据将被保存在OpenERP的数据库里.在OpenERP里通过用户界面去编辑Cube. 我们将使用一个相同的概念定义在标准的XML文件里. 因此，我们将能够在将来某阶段，导入这种文件.


这必须不依赖OpenERP的任何模块，所以，假如Cubes已经定义，如果你想独立使用BI库，您可能无法使用OpenERP，假如Cubes还没有定义,你只需要最小安装OpenERP其中包括：olap 模块、用户管理、工作流管理、,账户权限管理, ... (这些基本模块)


我们的目标是用户没有自己建立cubes. 我们将创建一个来计算基于RDBM’s的cubes向导反思. 步骤向导:



		选择数据库 (数据库类型, 像OpenERP的登录选择框)


		选择事实表 (选择框)


		选择度量和他们的属性 (选择框, 聚合功能)


		选举纬度 (点击树状结构)





然后便已完成, cube 已经被计算. 聚合表也已经被 OpenERP自动计算完成.


我们的目标是当用户需要从OpenERP的任意对象建立一个新的cube，也将作为在线演示服务器服务.


创建的Cube可以被存储在服务器内存一段时间.





Web 客户端


Web客户端是一个Web服务，显示浏览cubes和提供浏览工具，它必须至少提供以下操作:



		切换视图


		不同类型的图表


		乡下钻取


		切片


		切块








OpenOffice 插件


Similar to Palo but all operation of construction and manipulation of cubes remains in OpenERP to limit development on OOo. The development on OOo just contains functions to:



		Insert new data (based on selection of dimensions and filters)


		Drill up/down functions


		Slice function








OpenERP 接口


From OpenERP, you should be able to right click/drag and drop any field to trigger the cube definition wizard to create your own cube on demand. For this, we will use the web client of the bi system.


We will integrate this on the gtk and web clients of OpenERP. The GTK client will open the browser to browse the cube.







额外的库


我们将使用以下库:



		Cube浏览Web客户端：Turbogears


		图形渲染：Mathplotlib


		MDX表达式解析：PyParsing


		SQL 查询创建和RDBMS 连接：SQLAlchemy


		Cube服务器通信：XMLRPC


		OOo整合：PÿUNO





我们将在所有的对象上使用对象关系映射系统: 纬度, ...
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辅助核算


使用辅助核算可以协助你更好地管理采购. 一般只需要在采购单的明细上设置对应的辅助核算项. 这时, 一但确认并开出供应商发票后,
这一笔采购相关的辅助核算成本就会被记录下来.


The hr_timesheet_invoice module lets you re-invoice the analytic costs automatically using
parameters in the analytic accounts such as sale pricelist, associated partner company, and maximum amount.


So you can put an invoice order with a defined invoice workflow in place based on the analytic accounts. If you are
working Make to Order, the workflow will be:



		客户下订单,


		给供应商下达采购订单,


		供应商送货并开具供应商发票,


		发货给客户并开具客户发票.





When re-invoicing based on costs you would get the following workflow:



		Enter the customer contract conditions from the analytic accounts,


		Purchase raw materials and write the services performed into the timesheets,


		Receive the supplier invoice and the products,


		Invoice these costs to the customer.






Tip


辅助核算方案


如果你有几种辅助核算方案, 你就需要安装模块 purchase_analytic_plans. 这个模块可以实现将采购单的明细再
按你设定的核算方案进行拆分.
参阅 辅助核算 了解更多关于辅助核算的内容.
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功能


打开对象模块，你会在这里发现OpenERP重要的功能列表
超过350个可用的模块，下面仅仅总结了其中的一些。



企业管理




		Sales Management


		Invoicing


		Point of Sales


		Purchases


		Services Management


		Management System










Logistic




		Manufacturing


		Product Pricelists


		Quality Management


		Shipping Management


		仓库管理










财务会计




		会计


		Analytic Accounting


		固定资产管理


		银行接口


		Budgets


		支付管理










人力资源




		Attendances


		Expenses


		Holidays Management


		PayRoll


		Point of Sales


		Skills Management










CRM(客户关系管理) & SRM(供应商关系管理)




		Customer Relationship Management


		Direct Marketing


		Mail Gateway


		Phone Calls


		Portals










项目管理




		Financial Project Management


		Operational Management


		Timesheets










Daily Productivity




		日历


		Getting Things Done


		Document Management System


		Outlook / Thunderbird










Efficient Communication




		提醒


		Dashboards


		Webmail


		Wiki 引擎










Business Process Management




		Business Process Management


		工作流引擎










Association Management




		Events Organisation


		Fund Raising


		Membership










IT Tools




		Bug Tracker


		Scrum Methodology










Fully customizable




		可配置的动作


		Report Designer


		View Editor


		工作流编辑器










Ergonomy




		Web应用程序接口


		Gantt Charts


		Dynamic Graphs


		Integrated Documentation










Flexibility




		Module System


		Web 服务










eCommerce




		Integrated E-commerce


		Integrated Systems


		EDI










Business Intelligence




		Olap Database


		立体图表设计器


		Cube Browser










Miscellaneous Tools




		Networks


		Ideas Box


		Lunch


		VOIP








Verticalisations







Services




		Auction


		Medical










Public




		Training Organisation


		商会










Manufacturing




		Food Industries


		书店


		Repairs Management
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提醒


OpenERP 具备一个完善的提醒系统. 你可以在任何操作的任何步骤上配置提醒功能. 终端用户将在不同的事件上收到提醒. 我们可以
在屏幕上弹出提醒,或通系统内部通信系统收到这些提醒. 它会
适时的在每件事上提醒用户. 公司内部人员也可以通过它来进行简单的通信.


[image: ]
关键字:



		预配置提醒模块,


		给产品、合作伙伴配置提示消息.


		完全可配置.








整合的益处:



		同一个提示可以被不同的操作触发: 销售, 发票, 库存调拨.


		提醒系统是通用的概念,可以用于任何一个模块.








链接:



		Example



		模块: 提醒
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Auction


The auction house profile contains everything you need to manage an auction house.
It allows you to manage objects and sellers, bids and buyers, to set-up exhibitions
and generate catalogues. It is integrated with the other OpenERP modules to provide
automatic invoicing, cost control using timesheets, etc.


[image: ]
Key Points:



		Manages all operations of an auction house


		Fully integrated and very complete








Integration Benefits:



		Integrated with accounting and invoicing


		Integrated with human resources modules








Links:



		Demonstration



		Module: profile_auction,auction
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Business Process Management


OpenERP supports technical workflow and end-user processes.
It provides an easy and visual way to manage the different processes of your
business and improve your quality manual.


[image: ]
Key Points:



		Integrated process designer to customize or integrate your methodology,


		Helps the user understand the globality of the company,








Integration Benefits:



		Integrated to the document management system to provide samples of documents at any step


		Integrated with workflow to evolve in real time according to the reported document








Links:



		Modules: process
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Services Management


Service management allows you to manage your company’s projects and tasks
without any limitations. It provides tools to manage multi-level sub-projects,
control tasks from project manager, alert customers by e-mail for project
support, schedule and prioritize the tasks assigned,  etc.


[image: ]
Key points:



		Specific menus for specific users according to their roles


		History of interventions for each task and project


		Schedule control








Integration benefits:



		Completely integrated to the cost accounting


		Automatic completion of timesheets


		Reports and dashboards incorporated








Links:



		Module:  profile_service






		Demonstration
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Mail Gateway


E-mail gateways can automatize and update cases in the CRM via e-mails. Users can
create, assign or update cases to the CRM simply by sending or receiving e-mails
without going into OpenERP interface. This module is a very useful tool
to manage all from generic e-mails from the company (info, sales, support,...) and
is dedicated to allow users to assign cases.


[image: ]
Key points:



		Compatible with most of mail clients and servers.


		Mails are automatically classified by the system


		Multi Users








Integration benefits:



		Totally integrated to the CRM modules








Links:



		Module:
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Report Designer


This plugin connects Open Office with OpenERP to ensure that useful
information are coordinated and shared across the company. With a few simple
clicks, users can open reports and lists in an Open Office document and modify it
from their favorite document application. It can be included into various
OpenERP modules, including :  Accounts, Opportunities, Leads, Cases, Contacts and
more.


[image: ]
Key points:



		Link between users and open office documents on mailings


		Creation and design of reports from Open Office


		Easy to install and use








Integration benefits:



		Easy customisation of all existing OpenERP documents


		Create new documents and save them as modules for easy deployment and distribution


		Automate frequent document composition tasks


		Integrated to marketing campaigns management








Links:



		Module:  base_report_designer
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Webmail


Open Object 集成了一个完整的网页邮件。它可以使人们通过一个单一的界面包含了所有服务于公司的工作，
管理和阅读电子邮件。这是一个完全集成的系统，具有一个拖放界面，并充分利用了Ajax的速度。


这是第一个可扩展的webmail系统。附带Open Object 视图设计器，
您可以自定义每一个接口，满足您的特定需求，并提高您的工作效率。


[image: ]
关键点:



		支持 POP, IMAP 和 SMTP


		自动连接到您的现有帐户








整合的好处:



		附加文件，从DMS 附加OpenERP的报表或文件。


		在您的电子邮件中链接的任何系统文件（销售订单确认，从项目管理的文件，等等）


		使用对象和视图设计器扩展的电子邮件界面，根据您的需要定制。


		单点访问权限的管理。








链接:



		模块: webmail
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Product Pricelists


OpenERP pricelists are extremely powerful and easy to use. They allows you to
efficiently manages promotions, customers special prices, segmentation of
customers contracts made with customers or suppliers, etc. You can set fixed
prices or work by rules to auto-compute prices according to the cost, the
date, the currency, the category of product, etc.


[image: ]
Key Points:



		A powerful rule system to allows all kinds of automatic computations


		Easy or extended mode of work


		Manages long term and short term contracts and conditions








Integration Benefits:



		Integrated with sales, point of sales, and end of campaign discounts


		Use them for costs or sales controls








Links:



		Module:  product
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Invoicing


OpenERP supports lots of different methods for invoicing automation: from
the sales orders, from costs (timesheets, purchases, etc.), from tasks, from
recurring subscriptions, etc.


[image: ]
Key Points:



		A powerful pricelist system


		A very useful follow-up module








Integration Benefits:



		No double encoding


		Automatic generation of invoices according to different workflows


		Integrated with analytic accounting for profitability








Links:



		Module: account
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Quality Management


OpenERP provides a module to manage the quality of your products or
your services. The ‘repairs management’ module allows to organise
after-sales services.


[image: ]
Key Points:



		Complete after-sales services integrated


		Traceability of all operations








Integration Benefits:



		Integrated with cost accounting for cost control of the quality


		Integrated with stocks to organise repairs and traceability








Links:



		Module:  base_module_quality
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Wiki 引擎


OpenERP的Wiki允许您管理您企业的文件，使用wiki重组文件的内容。
该模块提供了一个协作的方式来管理企业内部的常见问题，质量手册，技术参考等。


[image: ]
关键点:



		与MediaWiki有相同的格式风格,


		wiki组的任何数量用于不同的目的,


		在所有页面上有详细历史修改,


		与文档管理系统集成.








为什么你应该使用OpenERP集成Wiki维基系统而不是一个单独的？



		允许链接到系统的任何文件，


		使用OpenERP的独特的访问控制进行访问权限管理，


		用它来描述一个项目，任务，产品，


		与客户门户网站集成，提供有限制外部访问，


		质量手册链接到用户进程。








要获取更多信息:



		Basic Wiki Editing


		Wiki Documentation


		The OpenERP website








链接:



		模块: wiki
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Module System


OpenERP (and the Open Object framework) is probably the most advanced and
flexible framework in the world. All features of OpenERP are packaged as
independent modules, allowing you to install only what you need.
They are able to work independently and, if installed together, they integrate
perfectly to automate all tasks and avoid duplication of data.


You can generate your own modules without custom coding, using
our customization tools: workflow editor, object editor, view designer,
report designer, BI reports, customizable actions, etc. All customisations
made on the server can be saved as a module to easily deploy, redistribute and
share.


[image: ]
Key Points:



		Integrated ORM, Workflow Engine, BPM, BI,


		Model View Control with lots of available views,


		A very fast engine.








Links:



		List of modules [http://openobject.com]
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Holidays Management


This module’s main task is to control the holiday’s schedule of your company.
It allow employees to requests holidays. Then, managers can review requests for
holiday, and control the overall holiday’s planning for the company or department.


[image: ]
Key points:



		Validation system included


		Customisable workflow for validation


		Support all kinds of leaves (sickness, holidays, paid days, ...)


		Calendar view








Integration benefits:



		Integrated to the company calendar


		Integrated with the payroll system for automatic computation








Links:



		Module: hr_holidays
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工作流编辑器


OpenERP集成业务流程管理引擎部分，工作流编辑器允许您按照您的企业
需求定义所有文件处理的流程。该系统的灵活性，让你的公司每天的需求
与软件处理同步。


您可以触发任何活动的工作流的动作：发送电子邮件/短信，打印报表，
统计或修改对象，引发其他的工作流程，关联外部服务，等等。


[image: ]
关键点:



		通过打开对象的智能迁移技术可以自动迁移新版本


		图形拖放方式的编辑简化了用户操作界面








整合的好处:



		您可以适应现有模块的所有流程的逻辑


		集成与用户友好的流程和文档
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Integrated Systems


Introduction two or three lines.
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Key Points:



		Key point 1


		Key point 2








Integration Benefits:



		Integration 1


		Integration 2








Links:



		Module
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Membership


The membership module helps associations manage their members, from the
searching of new members to the periodic invoicing of current members. It’s
linked to the portal module, which allows you to provide online access to members
on your system: calendar of events, current projects, members lists, etc.


[image: ]
Key Points:



		Free members, fixed price, associated members, price management.


		Automatic invoicing and propositions


		Configurable workflow








Integration Benefits:



		Integrated with accounting for membership invoicing


		Integrated with pricelists to provide specific prices for members


		Integrated with portal to provide access to members








Links:



		Module: membership
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Dashboards


Dashboards provide an overview of all the information important to you
on a single page. The menu gives you access to predefined boards for
Accounting, Production and Project Management.


Unlike most other ERP systems and classic statistically-based systems, OpenERP
can provide dashboards to all users, not just to
directors and accountants.


[image: ]
Key points:



		Dashboards are dynamic, letting you navigate easily around the entire information base.


		Dashboards are adaptable to the needs of each user and each company.








Integration benefits:



		Each user can have their own dashboard to enable them to manage their own work efficiently.








Links:



		Module : board






		Demonstration
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Networks


OpenERP includes modules which help manage and maintain your IT infrastructure.
You can manage your software, licences, hardware, warranties and control interventions
on the different components. Components can be linked to design your
network infrastructure.


[image: ]
Key Points:



		Manages networks, hardware and software


		Track changes and interventions on components








Integration Benefits:



		Install the module in three clicks


		Access controls related to users rights








Links:



		Modules: network
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Training Organisation


OpenERP is used by one of the most prestigious training organisations in
France: l’ENA (Ecole Nationale d’Administration). OpenERP provides different
modules to organise training: resources management (classes), teachers, planning,
training material, etc.


[image: ]
Key Points:



		Portal for teachers and students


		A dynamic gantt view to plan resources


		Fits all needs of a training organisation








Integration Benefits:



		Integrated with document management system for training material


		Based on analytic accounting to manage costs and revenues per course


		Integrated with invoicing, sales, CRM, etc.








Links:



		Module
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Analytic Accounting


The analytic accounting is the core of all management modules of OpenERP.  It
is perfectly integrated with all operations that have a (direct or indirect) cost
or revenue. As an example, for services companies, the analytic accounting is
used as the financial part of project management.


As all tools are integrated, it gives you full control and automates
your company:



		Plannings are integrated with budgets,


		Project management is integrated with contracts and affairs management, etc.





[image: ]
Key Points:



		Work with one or multiple analytic plans,


		About 40+ modules available to integrate best management practices,


		Nearly all transactions are automated to simplify encodings, etc.








Integration Benefits:


Fully integrated to all modules of OpenERP, here are the main ones:



		Timesheets or tasks are analytic costs on projects,


		Manufacturing operation reports costs on cost centers,


		Sales, purchases and invoices are also costs on analytic accounts,


		Holidays, expenses tracking, etc.








Links:



		Module: account_analytic_default
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Sales Management


Sales modules allow you to manage and classify your sales orders on a
structural and hierarchical system. It gives you the ability to create new
orders and review existing orders in their various states. Confirmation
of an order can trigger delivery of the goods, and invoicing timing is defined by
a setting in each individual order.
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Keypoints:



		Get all information needed by the salesman to do their quotes in one screen


		Complete follow-up and control of sales orders, deliveries and invoicing


		Traceability of all customers operations








Integration benefits:



		Integrated with point of sales


		Automatic accounting (financial and analytic) entries creation,


		Integrated with contracts, projects, master production schedule,


		Integrated with different eCommerce platforms for online selling.


		Design templates of reusable offers with the report designer








Links:



		Module: sale
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EDI


The Open Object framework provides many tools which help synchronise your
databases or import new data into OpenERP. Tools dedicated to some software
(ecommerce, crm, etc.) are also provided. The EDI module allows you to synchronise
orders and deliveries with your suppliers and customers.


It is used to synchronise OpenERP with SAP in distribution and food industry
companies.


[image: ]
Key Points:



		Operational in a few clicks








Integration Benefits:


One module to synchronise different documents:



		Sales orders, purchases, deliveries, etc.








Links:



		Module : edi






Open Object
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Integrated E-commerce


OpenERP provides modules that synchronise automatically with popular open source
eCommerce systems: OSCommerce, eZpublish, Magento, Joomla. It allows you to
streamline and automate the sales process, from the online order to the
delivery and the invoicing.


To benefit from all the power of OpenERP (pricelists management, complex
taxes, warehouse integration, etc.), you can also use our own eCommerce system
that automatically plugs in an existing website. Add a few lines of HTML in your
website and OpenERP converts it to a full featured eCommerce platform.


[image: ]
Key Points:



		Portal access for customers to manage their accounts and orders,


		Integrated with most popular eCommerce or builtin existing module








Integration Benefits:



		Streamline your sales process, from the website to the delivery


		Effective stock visibility and customer special prices computations


		Use marketing campaigns and CRM integration to increase your sales








Links:



		Module: ecommerce











          

      

      

    


    
        © Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

_images/config_wiz_holidays.png
Human Resources Application Configuration -

Hoidays / Leaves Management ? Expenses ?: []
Recruitment Process ? : [ Timeshests ? : [
Employee's Contracts ? : | Attendances ? : [
Periodic Evaluatons ? : [ Payrol ?: [

PayrollAccounting ? : [

Q sup & configure





features/web_application_interface.html


    
      Navigation


      
        		
          index


        		OpenERP v6 »

 
      


    


    
      
          
            
  
Web应用程序接口


OpenERP的提供了一个完整的Ajax，Web 2.0的Web客户端，其中包括拖放、甘特图、
可编辑的流程，等等。Web接口允许远程访问和很容易的部署客户端


[image: ]
关键点:



		支持多种不同的视图：甘特图，日历，工作流等.


		通过 模板引擎来定制具有您的企业形象的外观和感觉


		具有非常友好的用户界面：拖放，支持AJAX，动态图形,


		快速和Ajax技术








整合的好处:



		OpenERP的所有的模块开发工作直接在网络上的应用程序接口上.


		增加新的功能无需重新启动服务器








链接:



		Demonstration
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银行接口


OpenERP 通过不同的模块支持电子银行和电子发票.
可以自动地将付款单提交给银行,银行自动的将结算单传回.


目前支持 CODA (比利时+卢森堡),
BVR/V11/DTA (瑞士), Check printing (美国), EDI (和 SAP).


[image: ]
关键词:



		付款准备系统 (预付, 优先级, 出纳),


		自动对账入口








整合益处:



		财务一体化使你不必录入任何其他东西,


		依据采购、销售、发票等生成付款案,


		支付的来源可以是CRM,销售等模块.








链接:



		模块:   account_coda, account_coda_2_1_d
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Attendances


This module allows you to manage your employees’ attendance their leaves and
absences requests, plan the company’s calendar and shows the time attended to
projects. It gives you access to your employees’ schedules and the
right to complete and validate their timesheets. The main objective of this
module is to follow working hours of current projects and costs implications.


[image: ]
Key points:



		Validation system included


		Personalized menu for each user


		Follow up of profitability for each project








Integration benefits:



		Integrated to analytic accounting


		Integrated with accounting for automatic invoicing


		Possibility to get invoices per customer


		Dashboards and reports included








Links:



		Modules: hr_attendance
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会计


OpenERP 提供完整的会计模块 包括财务会计, 会计分析, 第三方管理(供应商与客户的应收应付?), 税务管理,
预算管理, 资产管理等. OpenERP 有超过50个扩展模块来适应不同的会计准则: 电子银行转账, 资产管理,
自动生产发票, 分析控制, 财务指标, 会计报表等. Multi-company system and account simulation journals(account_simulation module)
can be used in a parallel accounting scenarios (maintaining multiple G/L’s using different sets of accounting rules)


[image: ]
关键点:



		多公司, 多币别, 多维度,


		即时合并多个科目表,


		界面友好，让你更快的录入发票的单据,


		综合的财务/成本分析,


		大量的可自定义报表.








整合的益处:



		不用重复录入，所有单据预先生成,


		会计人员的设定可以影响整个系统,


		和其他模块生成交叉报表.








连接:



		Demonstration



		模块: 会计
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Purchases


Purchase management enables you to track your supplier’s price quotations and
convert them into Purchase Orders. OpenERP has several methods
of monitoring invoices and tracking the receipt of ordered goods.


You can handle partial deliveries in OpenERP, so you can keep track of items
that are still to be delivered on your orders, and you can issue reminders
automatically.


OpenERP’s replenishment management rules enable the system to generate draft
purchase orders automatically, or you can configure it to run a lean process
driven entirely by current production needs.


[image: ]
Keypoints:



		Purchase tender management,


		Integrates best practices: MTS / MTO, JIT, MPS, Kanban,


		Invoices, delivered products and services control.








Integration Benefits:



		Automatic procurement propositions based on different logistics,


		Perfectly integrated with accounting, stock, manufacturing and project management.








Links:



		Module: purchase
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Operational Management


OpenERP integrates a powerful multi-level project management system. It
allows management of tasks allocation, short and long term planning, delegations,
etc. It’s fully integrated with sales or purchases.


[image: ]
Key Points:



		Dynamic Gantt view to organise projects and tasks


		Retro-Planning computations


		Integrates best practices: GTD, Scrum








Integration Benefits:



		Integrated with analytic accounting for financial part


		Integrated with sales and invoicing to automates tasks


		Integrated with HR modules for the organisation of the resources








Links:



		Module: project
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工作流引擎


通过OpenERP的功能强大的工作流引擎管理的所有文件的完整逻辑。
这个系统是非常灵活的，你可以定制应用，以满足您的需求。


[image: ]
关键点:



		子流程管理


		事件触发系统


		适应使用工作流编辑器的工作流程








整合的好处:



		同最终用户流程集成


		无需开发就可以修改每一个模块的逻辑


		服务器操作界面
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可配置的动作


Open Object 引擎允许你通过几次点击来自定义所有系统动作。你可以轻易地定义新的对象、修改工作流、改变动作的结果、打开新的窗口或报表等等。


[image: ]
关键点:



		不用开发就可以完全自定义软件的每个部分


		集成模块记录器来保存你自定义的过程








集成的益处:



		从任何地方触发运行：工作流、视图、按钮等。


		根据需要用工作流和视图设计器来适应屏幕。








链接:



		Module : base






		Open Object
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Financial Project Management


OpenERP integrates financial project management allowing you to stay in
control of your different activities. It keeps track of costs, budgets,
automatic invoicing based on tasks achieved, profitability reports, etc.


[image: ]
Key Points:



		Based on the analytic accounting


		Fully integrated with human resources for cost control








Integration Benefits:



		Planning automatically impacts budgets and treasury


		Tasks and timesheets are fully integrated


		Sales orders and tasks control are integrated





Links:



		Module : profile_accounting






Example




		Module: example
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Web 服务


应用程序的每一个对象或服务可以通过不同的网络服务协议：XML-RPC，XML-RPC通过HTTPS或Python NET-RPC
，以便快速地访问。它可以让你轻松地将任何应用程序或OpenERP服务的计算机，实现最高生产率.


[image: ]
关键点:



		XML-RPC 适用于任何语言: .NET, Java, PHP, etc.


		支持三个不同的协议


		支持HTTPS


		默认情况下，系统的每个对象








整合的好处:


这种灵活的技术使最常用的开源软件自动同步模块：电子商务，电子邮件，移动电话，数据同步等。...
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商会


在比利时有50%的商会使用OpenERP。超过10个模块支持商会业务功能：高级CRM、联系人管理、会员管理、
培训和会议的组织、大使馆的文件夹(embassy folders)、等。


[image: ]
关键点:



		功能支持很完整


		涉及10个可选模块








集成益处:



		与会计集成提供自动开发票功能


		与CRM集成查看整体概观


		与文档管理系统集成








链接:



		演示












          

      

      

    


    
        © Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

features/repairs_management.html


    
      Navigation


      
        		
          index


        		OpenERP v6 »

 
      


    


    
      
          
            
  
Repairs Management


OpenERP provides a module to manage the quality of your products or
your services. The ‘repairs management’ module allows to organise
after-sales services.


[image: ]
Key Points:



		Complete after-sales services integrated


		Traceability of all operations








Integration Benefits:



		Integrated with cost accounting for cost control of the quality


		Integrated with stocks to organise repairs and traceability








Links:



		Module: mrp_repair
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Cube Browser


The Business Intelligence cube browser helps end-users easily navigate
through the information and statistics of the company and design customised
reports with a few drag and drop operations. You can consolidate, drill up, drill down, slice
and filter data from a very user-friendly report interface.


The power of Business Intelligence becomes available to all users of the
system to extract the exact information needed. It is also
able to analyse other databases, allowing you to consolidate data in a
single user interface.
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Key Points:



		User-friendly: drag & drop, easy to use, pre-configured.


		Complete: slice, filter, drill up, drill down, relate, etc.


		Real time analysis.








Integration Benefits:



		Use the powerful Business Intelligence engine to report on all modules,


		Schema for OpenERP modules are already pre-configured,


		Respects OpenERP access rights to simplify configuration.








Links:



		Open Object
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仓库管理


T该模块提供的功能来管理多仓库，和结构化的库位。
对于每一个仓库，输入位置，可以定义出货的库位和
库存库位。
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关键点:



		轻松创建多仓库与库位。





		
		由于复式记账的库存管理，库存控制是强大而灵活。


		(库存移动的历史和计划，库存值，盘点差异，自动补货规则，
条形码支持，通过复式记账快速检测库存移动的错误，以及可追溯性， ...)

















整合的好处:



		跟踪仓库之间的库存变动(货物从那里来到哪里去).


		与库存模块集成。








链接:



		模块: stock
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立体图表设计器


商业智能立体图表设计器让你对任何关系数据库的数据自定义立体图表（Oracle, MySQL, PostgreSQL 等）。用户操作友好的立体图表设计器将帮助你在几分钟内设计一个完整的图表轮廓。
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关键点:



		通过内查自动检测每个结构，


		支持用一个应用程序字典来自动配置安装程序，


		在5分钟内让一个全功能的智能商业套件上线运行，


		支持大量预定义好的面积和尺寸单位，


		通过一个集中控制中心获取所有应用的报表。








集成的作用:



		OpenERP 的表现轮廓是预配置好的，不需要再定义一个立体图表轮廓了，


		立体图表浏览器允许最终用户引导到任何查询，


		每套OpenERP数据资料都可以为立体图表浏览器所打开分析。








链接:



		Open Object
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Integrated Documentation


OpenERP is the world’s most documented enterprise management software.
Our books are Amazon best-sellers for all computer software categories and
all management related categories. They not only cover how to use the software
but also integrate best-practices and how to apply them in your enterprise
with the help of OpenERP.


All documentation is provided online and linked to any screen of the
software which helps all users work efficiently.
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Key Points:



		Books are integrated in OpenERP for contextual help


		Documentation for users, integrator, developers and the community








Integration Benefits:



		Covers main modules of OpenERP and how they fit together








Links:



		Documentation
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Fund Raising


The fund raising module lets you manage your fund raising
operations. From the searching of investors/donors to tracking how
the money is used across your different projects and resources.


[image: ]
Key Points:



		Independent of or integrated with the association management module,


		Pre-configured and easy to start with,


		Lots of dashboards and reporting available.








Integration Benefits:



		Fully integrated with CRM tools: automatic segmentation, report designer, campaign management, email gateway, etc.


		Integrated with analytic accounting to track how the money is used.








Links:



		Module: crm_configuration
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VOIP


The asterisk module allows to interface your Voice Over IP system with OpenERP.
When a customer calls you, it can automatically present the partner
form linked to this phone number.
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Key Points:



		Asterisk interface








Integration Benefits:



		Integrated with the phone tools of the CRM


		Link on any document to call a partner








Links:



		Module: asterisk
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Point of Sales


Manage your point of sales directly with OpenERP. It allows you to easily
manage all point of sales operations: selling, stock, encashment, invoicing,
etc.
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Key Points:



		Very easy and complete touchscreen interface for end-users


		Multiple payments systems


		Support for direct invoicing


		Support for reimbursements and product exchanges


		12 types of supported barcodes








Integration Benefits:



		Integrated with stocks and accounting to avoid double entries


		Integrated with sales management


		Fully customizable








Links:



		Module:  point_of_sale
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Gantt Charts


Every object of the system can be viewed as a dynamic Gantt chart for
easy resource management and planning. You can organise
your resources using drag and drop in the timeline or between different
consolidations.
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Key Points:



		Browse at the resource or the consolidation level


		Fully supports drag and drop horizontal (time) or vertical (across resources)


		Support filters and efficient zoom in or out








Integration Benefits:



		Supply chain organisation and planning


		Streamline manufacturing operations and work at the workcenter consolidation level


		Easily plan resources on your projects and detect bottlenecks








Links:



		Module:
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View Editor


The OpenERP view editor lets you design and adapt all screens of
the application to your specific need. You can modify the look or add/remove
new fields in seconds.
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Key Points:



		Modify views but also the object structure


		Works with inheritance of views to not change official version


		Ability to save all modifications in a reusable module








Integration Benefits:



		This customisation tool works on all modules
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Direct Marketing


The direct marketing modules manages and automatizes the development, execution and
monitoring of campaigns across multiple channels. It provides tools to manage
offers, campaigns, steps, workflows, etc. The report composition engine allows
you to create bulk documents.
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Key Points:



		Multi-channel: email, sms, paper, phone.


		Barcode support for paper propositions,


		Configurable Workflows,


		Offers management,


		Complete statistics and dashboards,


		Fast orders encoding.








Integration Benefits:



		Integrated with analytic accounting for cost control


		Integrated with helpdesk and after-sales services


		Automatic procurements (purchases, production) on campaigns


		Integrated with sales and CRM modules








Links:



		Module:  profile_dm, dm
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Ideas Box


Sometimes the smallest modules are the most useful. The “ideas” module
was developed in 3 hours. It allows employees to suggest ideas, sorted in
different boxes or subjects. People can then rate the proposed ideas and
discuss the different points.
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Key Points:



		Very simple module to track employees’ ideas,


		A workflow allows to track ideas efficiently,


		A discussion system on ideas,


		A rating system.








Integration Benefits:



		Integrated with the wiki to easily describe ideas








Links:



		Module: idea
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Bug Tracker


The OpenERP bug tracker allows you to manage bugs and features requests.
It manages the different revisions, milestones, status of bugs, link bugs to tasks
in the project management module, etc.
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Key Points:



		Email Integration (send mail to open bugs)


		Configurable rules to automate actions


		Powerful dashboards


		Multi-Projects








Integration Benefits:



		Integrated with the Wiki (to manage bugs like the Trac software)


		Integrated with timesheets for costs and time control


		Linked to project management for fixes organizing and planning


		Link bugs to others resources like sales, claims, products, etc.








Links:



		Module: crm
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Outlook / Thunderbird


This plugin connects Outlook/Thunderbird with important CRM data to ensure
information is coordinated and shared across the company. With a few simple
clicks, users can file Outlook/Thunderbird email, contacts and calendar
information into various OpenERP modules, including Accounts, Opportunities,
Leads, Cases, Contacts and more.
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Key points:



		Link between e-mail and list of partners,


		Configure messages on partners, products, etc.








Integration benefits:



		Possibility of creating a partner directly from an e-mail address








Links:



		Screencast
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Medical


Medical provides an universal Electronic Medical Record (EMR), so doctors and
institutions all over the world, regardless of their economic status, will
benefit from a centralized, high quality, secure and scalable system.
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Key Points:



		100% paperless patient examination and history taking


		Patient Administration (creation, evaluations / consultations, history ... )


		Strong focus on family medicine and Primary Health Care


		Doctor Administration


		Lab Administration


		Medicine / Drugs information (vademécum)


		Medical stock and supply chain management


		Demographics and other statistical reports


		Financial Administration (Invoicing, ...).


		Designed with industry standards in mind








Links:



		Medical Website



		Module:
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Events Organisation


The event module allows you efficiently organise events and related tasks:
planning, registration tracking, invoicing, attendances, getting the
payments, etc.  It is completely integrated with the CRM and accounting
modules. You can also use the mail gateway to get information requests or
registrations directly by email.


[image: ]
Key Points:



		calendar view and customer portal to make online registrations,


		Email integration to automatically confirm and send acknowledgements for any event registration,


		automatic invoicing based on registrations.








Integration Benefits:



		Integrated to the project management module for retro-planning of tasks,


		Integrated to the CRM to sell to track customers and opportunities or invite them the events,


		Automatic invoicing through the accounting modules.








Links:



		Modules: event
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PayRoll


This module is still under development...
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Links:



		Module: payroll
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Document Management System


The document management system allows you to store, classify, and search your
enterprise’s documents. This module provides FTP access to all your ERP’s
resources.  For dynamic and efficient classification, the folder structure
is provided by other objects.  It is useful to track documents related
to projects, products, sales, contracts, etc.
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Keypoints:



		FTP access for authenticated users,


		Automatic indexing of PDF, DOC, ODT, SXW, TXT.


		Virtual files and folders to automate any kind of document generation








Integration Benefits:



		Automatically stores ERP reports


		Automatic classification of resources


		Shared access rights for DMS and ERP


		Store emails with outlook Plugin








Links:



		Module:  document
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Olap Database


OpenERP’s Olap module supports a fully-featured hybrid OLAP database, which
can connect to any relational database to perform multi-dimensional analysis.
MDX queries are supported by the web-services provided
by Open Object.


[image: ]
Key Points:



		Design schema in a few minutes with the cube designer


		Use the cube browser or CLI client to analyse the results








Integration Benefits:



		OpenERP modules have pre-configured schema to help start analysing your data directly


		Perform queries from OpenERP or any other software








Links:



		Module : olap






		Open Object
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Getting Things Done


This module implement David Allen’s methodology: “Getting Things Done”. It
provides tools that help users organise their time and tasks efficiently.
GTD rests on the principle that a person needs to move tasks out of the mind by
recording them externally. That way, the mind is freed from the job of
remembering everything that needs to be done, and can concentrate on actually
performing those tasks.
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Key points:



		Implements: contexts, timeboxes, inbox, etc.


		Provide a tool that helps you run all concept of the methodology in OpenERP








Integration benefits:



		Completely integrated with service and project management


		Integrated with timesheet to control time and cost








Links:



		Module: project_gtd
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书店


OpenERP 提供一个已经配置好为卖书商店的模块. 它提供书、作者、编辑、供应商的管理功能.
销售方式为网站销售和销售点销售，并使用条形码进行管理.


[image: ]
关键词:



		整合一个销售书的商店的所有功能


		开箱即用.








整合的益处:



		整合开具发票和财务处理


		整合Joomla








链接:



		模块 : 卖书的商店






		Demonstration
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Shipping Management


The OpenERP warehouse management system provides lots of tools
to efficiently organise your customer and suppliers shipments.
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Key Points:



		Dynamic gantt or calendar views for planning


		Allows to manage by journal or department


		Good ergonomics for fast encoding








Integration Benefits:



		Deliveries costs and orders are computed automatically


		Automatic invoicing based on deliveries


		Integrated with the quality management system








Links:


Module:
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Budgets


OpenERP预算模块是您能够管理财务及分析预算。
根据使用者身份的不同，您可以从三个不同的方面对相同的预算实施管理：



		会计人员：致力于主要及统一的预算


		工程经理：致力于其工程的分析预算


		部门经理：从预算的角度得到一致的看法





[image: ]
主要要点：



		预算流程图(事先：在发起项目之前预算必须有效)，


		对同一预算的三种不同意见


		分析及财务预算整合


		多条轴线








整合的优点:



		将采购、销售、进度及费用通知整合


		分析预算整合到项目管理模块之中








链接:



		模块：会计预算
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Portals


The portal module allows you to provide system access to customers
or suppliers. Show only a part of your OpenERP application without exposing
all modules of your system. It is a useful module to allow customers, partners,
suppliers, ... to use your system for particular tasks.


[image: ]
Key points:



		Rights management included to the portal


		All functionality of OpenERP can be included into your portal


		Allow your collaborators to manage your system directly and safely








Integration benefits:



		Every OpenERP feature can be included into your portal


		Integrated with analytic account management system








Links:



		Module: portal
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Manufacturing


The manufacturing modules of OpenERP manage all the best-practices concerning
manufacturing industries: multi-level BoM and routings, JIT, different
costs methods available, phantom BoMs, configurable products, workcenter
operations, integrates sales forecasts, etc.  It supports several methods to
automate productions or purchases propositions: MTS/MTO, Master Production
Schedule, Minimum Stock Rules.


The scheduler will compute the best proposed planning according to the different
constraints on products, customers, orders or workcenters. The production manager
will be able to use our gantt views to organise the different resources or orders.


[image: ]
Key Points:



		Double-entry stock operations for powerful traceability,


		Support all best-practices and standards,


		Control costs and margins on orders, projects, products, partners,


		Easy to setup and run.








Integration Benefits:



		Schedule on products, services, sub-contracting


		Integrated with accounting for automatic transactions


		Integrated to HR management to get the availability of resources








Links:



		Module : mrp






		Demonstration



		Module: profile_manufacturing
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Lunch


OpenERP has many modules to simplify and automate your daily activities.
The lunch module helps track employee orders for lunch time, their
preferences, the cost of their lunch, etc. It automatically prepares orders
for the suppliers and manages employees preferences.


[image: ]
Key Points:



		Cost control and amount due per employee if they have to pay for their lunch,


		Automatic orders to suppliers,


		Consolidation of the requests for the whole company,


		Cashbox management.








Integration Benefits:



		Linked with invoicing for accounting control





Links:



		Modules: lunch
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支付管理


为了帮助你管理资金和支付供应商款项，OpenERP所提供的工具可以帮助您准备付款，他们支持工作流，所以在这个准备付款的过程中你
可以分配不同的职责。


[image: ]
关键点：



		不同角色完成付款编码，审批支付并且转到银行


		通过不同的银行账户来管理你的资金


		便捷的多货币管理


		支持电子银行格式及支票打印








整合优势:



		完全集成的会计系统，以避免双重编码


		当录入银行对账单后，自动生余额调节表








链接:



		模块：会计_支付
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Scrum Methodology


This modules implements all concepts of the scrum project management
methodology for IT companies: projects with sprints, product owner, scrum
master, sprints reviews, daily meetings, feedback, product backlog, sprint
backlog, etc.


The scrum module allows to easily manage long-term roadmaps, frequent
evaluation of works, customers interaction, etc. It provides interesting
reports like the burndown chart. The scrum methodology is used by Microsoft
and Google to manage all their new products.


[image: ]
Key Points:



		All scrum concepts implemented


		Helps you to keep control of your development project








Integration Benefits:



		Integrated with project management to manage scrum and non-scrum projects at a central place


		Integrated with gantt and calendar views








Links:



		Module: scrum






		Website



		Module:














          

      

      

    


    
        © Copyright .
      Last updated on 2015-01-09 17:25:01.
      Created using Sphinx 1.2.2.
    

  

features/assets_management.html


    
      Navigation


      
        		
          index


        		OpenERP v6 »

 
      


    


    
      
          
            
  
固定资产管理


对于炼钢厂、制药厂这样的行业，用OpenERP来追踪其复杂的固定资产库存真的很容易。一个好的固定资产管理模块会让你避免税务过度支付、不符合规定、以及低效率带来的百万计美元损失。


用OpenERP管理你的资产很容易。这个模块与财务和辅助记账模块完全整合，以期最大效能。


[image: ]
关键点:



		各种成本方法,


		符合IFRS （国际财务报告准则）,








整合的益处:



		与财务和辅助记账模块完全整合


		从OpenERP的任何文件追踪固定资产变化








链接:



		模块:  account_asset
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Phone Calls


OpenERP provides tools to organise phone campaigns. You can configure
different workflows for the operator. It’s fully integrated with the CRM so
that you can use relationship management facilities: segmentation of
customers, automated rules, escalation of cases, transform phone calls to
opportunities, questionnaires, etc.


[image: ]
Key Points:



		Rules on: held, not held, multiple temptatives, questionnaires,


		Segmentation tools to help you select and filter on prospects,


		Multiple phone operators allocation,


		Statistics on results, efficiency of campaigns and productivity.








Integration Benefits:



		Integrated with email marketing campaigns and segmentation tools


		Integrated with direct marketing modules








Links:



		Module:
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Dynamic Graphs


OpenERP’s graphical reports provide the right
information to the user according to the context.  All graphs and dashboards in
OpenERP are fully dynamic, you can click on any part of the graph, drag and
drop in dashboards, switch to calendar or gantt views, etc.


With OpenERP, powerful reporting is available to all users, not
restricted to managers. Over 200 reports satisfy every employee’s
need and improve performance by providing the right information.


[image: ]
Key Points:



		6 views on all objects: list, form, graph, calendar, gantt, process


		Good ergonomics, full Ajax, clickable and drag and drop enabled,


		All graphs are fully customizable using the view designer.








Integration Benefits:


All OpenERP document may be seen as a graph, gantt, process or calendar view.
Here are a few examples: manage manufacturing chains with gantt, calendar of
consolidated CRM events, customized dashboard for managers, planning of
deliveries, etc.


Links



		Modules:
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Management System


Management System provides all the applications required to manage your management system for Quality (ISO 9001), Environment (ISO 14001) or Security (ISO 27001).



Key Points:



		Manuals, procedures, environment aspects and work instructions





		Audits with report and verification list





		Non-conformities





		Actions:




		Immediate


		Corrective


		Preventive












		Improvement opportunities











Links:



		Modules:
		mgmtsystem


		mgmtsystem_action


		mgmtsystem_nonconformity


		mgmtsystem_nonconformity_project


		mgmtsystem_audit


		mgmtsystem_quality


		mgmtsystem_environment


		wiki_procedure


		wiki_environmental_aspect


		wiki_environment_manual
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Timesheets


The timesheet system allows you to record time spent by employees on projects
or activities. Its integration with the analytic accounting allows you to manage
budgets, planning, costs and reinvoicing of human resources.


Different working methods are provided according to the need:



		Sign in/out by projects


		Simple timesheet encoding


		Full timesheet integrated with attendances and validation process by manager





[image: ]
Key Points:



		Fast encoding of activities on tasks or globally


		Easy and fast project selection, supporting alerts


		Fully customizable workflow


		Multi unit of measure: hours, days, weeks.








Integration Benefits:



		Integrated with analytic accounting for cost control of employee’s time on projects


		Accounting integration to reinvoice based on time spent automatically


		Integrated with tasks from project management, calendar for meetings


		Integrated with attendances tracking system to spread worked time on projects








Links:



		Module: hr_timesheet
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Expenses


This module allows you to manage your company’s daily expenses. It gives you
access to your employees’ notes fees and access to complete,
validate or refuse the notes of a period. After validation it creates
an invoice for the employee.


Employee can encode their own expenses and the validation flow puts it
automatically in the accounting after management validation.


[image: ]
Keypoints:



		Customisable workflow


		Validation system included








Integration benefits:



		Allows you to re-invoice expenses to your clients


		Integrated with financial and analytic accounting for costs control








Links:



		Module: hr_expense
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日历


这个模块可以让你快速了解你的企业日历。 你可以将你的日历与许多其它模块相关联，比如：工时单、
项目管理、任务、会议、商机......在大量准则之上对数据进行过滤，让你直接看到你需要的内容。


[image: ]
关键点:



		多用户、多公司、多组


		强大的搜索和过滤功能


		内置确认功能








集成的益处:



		所有管理对象都能在日历中展示


		可连接到公司的所有层次关系中（整个公司、部门、员工......）








链接:



		Module: calendar
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Customer Relationship Management


The generic OpenERP Customer Relationship Management
system enables a group of people to intelligently and efficiently manage
leads, opportunities, tasks, issues, requests, bugs, campaign, claims, etc.
It manages key tasks such as communication, identification, prioritization,
assignment, resolution and notification.


OpenERP ensures that all cases are successfully tracked by users, customers and
suppliers. It can automatically send reminders, escalate the request, trigger
specific methods and lots of others actions based on your enterprise own rules.


[image: ]
Key Points:



		Automatic incoming and outgoing email processing using the mail gateway,


		A generic and fully customizable system,


		A configuration wizard to help you setup it as per your requirements.








Integration Benefits:



		Integrated with the enterprise calendars,


		Integrated with sales, purchases and after-sales services,


		Get your enterprise processes running through workflows.








Links:



		Module: crm
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Food Industries


OpenERP provides different modules for food industry companies. It
is able to manage a full traceability of the products, from the supplier
to the customer, including specific data on each lot. The master production
schedule allows accurate tuning of your automatic procurements.


[image: ]
Key Points:



		Master Production Schedule for accurate procurement planning


		Upstream and downstream graphical traceability


		Lot management system adapted to food industries


		Management of consumables








Integration Benefits:



		Sales triggers validity dates on lots,


		Traceability from purchases to sales








Links:



		Demonstration



		Module:
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Skills Management


OpenERP provides about 20 modules related to human resources management.
Some modules will allow you to manage the skills of your employees, you
can relate these to the periodical evaluation or the contract.


[image: ]
Key Points:



		Unique skill referential


		Ability to perform computations on skills








Integration Benefits:



		Integrated with periodical evaluations


		You can use the portal so that employees can consult their own data








Links:



		Module:  hr_skill
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